Some examples and graphics depicted herein are provided for illustration only. No real association or connection to ServiceNow products or services is intended or should be inferred.

If you have comments about this documentation, submit your feedback to: docfeedback@servicenow.com
# Table of Contents

## IT Business Management

- Organizational plugins for IT Business Management .......................................................... 13
- Machine learning solutions for IT Business Management .................................................. 14
- Predictive Intelligence for Application Portfolio Management .......................................... 15
- Predictive Intelligence for Demand Management ............................................................ 20
- Predictive Intelligence for Project Management ............................................................... 22

## Application Portfolio Management

- Activate Application Portfolio Management .................................................................... 26
- Installed with Application Portfolio Management .............................................................. 28
- Business stakeholder role for APM .................................................................................... 33
- Application Portfolio Management portal .......................................................................... 35
- Application portfolio administration ................................................................................... 38
- Management of business applications ............................................................................... 50
- Business Application Lifecycle Management services .................................................... 66
- Application assessment ..................................................................................................... 70
- Application strategy ......................................................................................................... 101
- Management of business capability .................................................................................. 111
- Technology Portfolio Management .................................................................................... 132
- Information portfolio ........................................................................................................ 166
- Risk management for business applications .................................................................... 171
- Domain separation in Application Portfolio Management ............................................... 175
- Quick start tests for Application Portfolio Management .................................................. 178
- Visualize APM reports using CMDB Query Builder .......................................................... 178
- Application Portfolio Management Analytics and Reporting Solutions .......................... 193

## Project Portfolio Management

- PPM Standard (Project Portfolio Management) ................................................................. 196
- Create and manage waterfall projects .............................................................................. 244
- Create and manage agile projects ..................................................................................... 246
- Test Management 2.0 integration with Project Portfolio Management ............................ 249
- Agile Development 2.0 integration with Project Portfolio Management .......................... 250
- Demand Management ...................................................................................................... 254
- Innovation Management .................................................................................................... 314
- Portfolio Management ....................................................................................................... 334
- Program Management ....................................................................................................... 402
- Project Management .......................................................................................................... 423
- Resource Management ....................................................................................................... 620
- Multicurrency in Project Management ............................................................................... 695
- Rate Models ........................................................................................................................ 718
- Domain separation in Project Portfolio Management ....................................................... 725
- Quick start tests for Project Portfolio Management .......................................................... 726

## Financial Management

- Activate Financial Modeling ............................................................................................... 731
- Installed with Financial Management ............................................................................... 732
- Read-only roles for Financial Management ....................................................................... 737
- Domain separation and Financial Management .............................................................. 738
- Financial Management for licensed APM users .............................................................. 738
- Financial Management for licensed SPM users .............................................................. 744
- Financial Modeling ........................................................................................................... 749
- Financial Charging ............................................................................................................ 894
- Quick start test for Financial Management ....................................................................... 916
Financial Management Analytics and Reporting Solutions ......................................................... 916
Investment Funding .................................................................................................................... 940
Activate Investment Funding .................................................................................................... 941
Investment Funding administration .......................................................................................... 943
Create a top-level investment ..................................................................................................... 946
Create an investment .................................................................................................................. 948
Request funds for an investment ............................................................................................... 949
Plan fund allocations for investments ....................................................................................... 950
Allocate funds to an investment .................................................................................................. 951
Enter actual spends for an investment ....................................................................................... 952
Reject a fund request ................................................................................................................... 953
Review the use of your funds ..................................................................................................... 953
View past funding details .......................................................................................................... 954
Domain separation in Investment Funding ............................................................................... 954
Quick start tests for Investment Funding .................................................................................. 955

Time Card Management ........................................................................................................... 955
Activate Time Card Management ............................................................................................. 956
Time sheet policies ...................................................................................................................... 957
Create a project time category .................................................................................................... 962
Create a rate type ....................................................................................................................... 962
Time Sheet Portal ....................................................................................................................... 963
Time Sheets ............................................................................................................................... 975
Time cards ................................................................................................................................. 980
Record time worked ................................................................................................................... 988
Manage costs .............................................................................................................................. 989
Project Manager Dashboard ..................................................................................................... 990
User Manager Dashboard ......................................................................................................... 994
Performance Analytics dashboard for Time Card Management ............................................. 998
Domain separation in Time Card Management ......................................................................... 998
Mobile Time Sheets .................................................................................................................... 998

Enterprise Release Management .............................................................................................. 1005
Installed with Enterprise Release Management ......................................................................... 1006
Define an enterprise release ..................................................................................................... 1008
Define a deployment pipeline .................................................................................................... 1011
Create a build ............................................................................................................................ 1014
Create a commit ......................................................................................................................... 1016
Define a product release ........................................................................................................... 1017

Agile Development .................................................................................................................... 1017
Migration from Agile Development 1.0 to Agile Development 2.0 ......................................... 1019
Agile Development 2.0 ............................................................................................................. 1045
Mobile experience for Agile Development 2.0 ....................................................................... 1102
Scrum Programs for Agile Development 2.0 .......................................................................... 1115
Atlassian Jira Integration for Agile Development .................................................................... 1126
Microsoft Azure DevOps Integration for Agile Development ............................................... 1147
Agile Development 2.0 — Unified Backlog ............................................................................ 1167
Performance Analytics Content Pack for Agile Development .............................................. 1169
Work Progress Status for Agile Teams ...................................................................................... 1208

Scaled Agile Framework (SAFe) ............................................................................................. 1211
Domain separation in Scaled Agile Framework (SAFe) .......................................................... 1211
Essential SAFe ......................................................................................................................... 1212
Portfolio SAFe .......................................................................................................................... 1253
SAFe — Unified Backlog .......................................................................................................... 1262
Performance Analytics Content Pack for Essential SAFe ..................................................... 1284
Work Progress Status for SAFe .............................................................................................. 1313

Test Management applications ............................................................................................... 1316
Domain separation in Test Management .................................................................................. 1317
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test Management 1.0</td>
<td>1318</td>
</tr>
<tr>
<td>Test Management 2.0</td>
<td>1347</td>
</tr>
<tr>
<td>Migration from Test Management 1.0 to Test Management 2.0</td>
<td>1368</td>
</tr>
<tr>
<td>Business Planning Portal</td>
<td>1384</td>
</tr>
<tr>
<td>Business units</td>
<td>1386</td>
</tr>
<tr>
<td>Create an enterprise strategy</td>
<td>1387</td>
</tr>
<tr>
<td>Create a business unit strategy</td>
<td>1388</td>
</tr>
<tr>
<td>Cost Management</td>
<td>1389</td>
</tr>
<tr>
<td>Cost Management components</td>
<td>1389</td>
</tr>
<tr>
<td>Cost Management roles</td>
<td>1395</td>
</tr>
<tr>
<td>Activate Cost Management</td>
<td>1395</td>
</tr>
<tr>
<td>Cost overview module</td>
<td>1395</td>
</tr>
<tr>
<td>CI rate cards</td>
<td>1398</td>
</tr>
<tr>
<td>Task and labor rate cards</td>
<td>1402</td>
</tr>
<tr>
<td>Budgets and cost centers</td>
<td>1405</td>
</tr>
<tr>
<td>Using distribution costs and rules</td>
<td>1406</td>
</tr>
<tr>
<td>Use business services with expenses</td>
<td>1409</td>
</tr>
<tr>
<td>Cost Management Demo Data</td>
<td>1411</td>
</tr>
<tr>
<td>Cost sources</td>
<td>1415</td>
</tr>
<tr>
<td>CI relationships</td>
<td>1421</td>
</tr>
<tr>
<td>Allocating expenses</td>
<td>1423</td>
</tr>
<tr>
<td>Budgets and cost centers example</td>
<td>1426</td>
</tr>
<tr>
<td>Budget related records</td>
<td>1427</td>
</tr>
<tr>
<td>Domain separation and Cost Management</td>
<td>1428</td>
</tr>
<tr>
<td>Index</td>
<td>1429</td>
</tr>
</tbody>
</table>
Align work with business goals to deliver product and services in a way that supports your strategic priorities. IT Business Management (ITBM) helps IT demonstrate value to the organization and rationalize investments to focus more on innovation. ITBM also helps transform the delivery of new products and services through lean execution methodologies.

IT Business Management helps you deliver what the business needs, when they need it.

IT Business Management makes it easy to anticipate critical business requirements, allocate resources, and evaluate the value of your portfolio. It also enables you to prioritize new requests and deliver products efficiently. Assess related top-level investments, and adapt to make adjustments on an ongoing basis. Manage strategic and operational work in one place and reduce bottlenecks to get to market faster.
ITBM helps you to align your IT investment and work with the organization's goals for better outcomes and respond more rapidly to change.

View and download the full infocard for a highlight of IT Business Management features.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Align applications with business goals and priorities</td>
<td>With ServiceNow® Application Portfolio Management (APM), get visibility into your applications to manage costs, ensure alignment, and easily adapt to change.</td>
</tr>
<tr>
<td>Align work to goals and strategy to ensure you work on the right projects</td>
<td>Project Portfolio Management (PPM) manages your entire project life cycle from idea to execution across your technology and business portfolios. This comprehensive solution includes applications to help you manage your project portfolio, resources, demands, time cards, ideas, and agile delivery.</td>
</tr>
<tr>
<td>Engage employees for the next big idea</td>
<td>With Innovation Management, enable your employees to submit ideas for new products and features. Track and convert ideas to demands, projects, stories, and other SAFe work items to deliver business outcomes with speed and agility, all from one location.</td>
</tr>
<tr>
<td>Simplify your funding workflow</td>
<td>Enhanced and simplified processes for top-down and bottom-up funding makes it easier for you to request and allocate funds to investments.</td>
</tr>
<tr>
<td>Gain visibility into the software development life cycle</td>
<td>The ServiceNow® Agile Development and Scaled Agile Framework (SAFe) applications enable you to manage scrum, hybrid, or waterfall development efforts throughout the life cycle, from inception through testing and deployment.</td>
</tr>
</tbody>
</table>
Align applications with business goals and priorities

APPLICATION PORTFOLIO MANAGEMENT

Business Portfolio
- 156 Capabilities
- 90 Assessed
- 66 Not Assessed
- 19 Major Gap

Information Portfolio
- 9 Data Domains
- 6 Information Objects
- 2 Database Catalogs
- 0 Unstructured DB Catalogs

Application Portfolio
- 57 No. of Applications
- 0 My Applications
- 48 COTS
- 9 Homegrown

Technology Portfolio
- 5 Biz App SW Models
- 4 High-risk SW Models
- 0 Biz App HW Models
- 0 High-risk HW Models

Opportunities & Solutions
- 10 No. of Goals
  - View
  - Create
- 13 No. of Demands
  - View
  - Create
- 4 No. of Programs
  - View
  - Create

Notifications
- 7 Software Models are in Moderate/High Risk
  - Based on the age of the software models, 1 software model will reach moderate/high risk
- 0 Hardware Models are in Moderate/High Risk
  - Based on the age of the hardware models, 0 hardware models will reach moderate/high risk
- 1 Orphaned Business Capabilities

Recent Activity
- Wed Oct 23 2019
  - Created goal
    - You have created goal Increase Standards Compliance by 30% by FY21
- Wed Oct 23 2019
  - Created goal
    - You have created goal Decrease Capex by $10,000,000 by FY20
- Wed Oct 17 2018
  - Created goal
    - You have created goal Increase Cloud Applications by 20 by FY20
- Wed Oct 23 2019
  - Created demand
Application Portfolio Management enables you to build a comprehensive inventory of business applications in use to help you assess your portfolio. This inventory goes beyond the technical descriptions that come from discovery, and includes details such as which functional modules are in use and the significance of an application to the organization. Dashboards present a broad array of indicators, including cost, quality, risk, user satisfaction, business alignment, and more.

**Align work to goals and strategy to ensure you work on the right projects**

Create and manage a wide range of projects from a few small tasks to large portfolios of projects containing complex activities with various relationships and dependencies. Track and manage incidents, problems, and change requests from a single system of record to ensure that all project activities are captured. Manage your product release from development and testing phases through its release to
customers. Improve your visibility into projects and project portfolios across your entire enterprise with personalized dashboards and timeline visualizations.

Engage employees for the next big idea

Employees can be an amazing source of innovative ideas. With Innovation Management, you can capture, vote on, vet, and track ideas using a single portal. Engage your employees and encourage innovation to deliver business outcomes with speed and agility, all from one location.
Simplify your funding workflow

With Investment Funding, support a continuous planning process in a changing environment. Continuously prioritize and fund all your investments such as projects, epics, products, and teams. Flexible top-down and bottom-up funding processes help you to request or allocate funds to investments in a simpler way.
Gain visibility into the entire software development life cycle
Manage your product development efforts throughout its life cycle using Agile software development methods.

The ServiceNow® Agile Development 2.0 application provides an Agile software development environment for product-based or project-based efforts using the Scrum framework. It offers you the flexibility to implement a pure agile approach over the entire life cycle of a product, or a hybrid approach using Agile methods within a traditional project structure.

The ServiceNow® Scaled Agile Framework (SAFe) application helps you apply lean and Agile principles to your large enterprise, enabling you to develop and deliver software products with fewer defects in the shortest viable lead time.

**Get started**

- For information about how to deliver business outcomes with speed and agility leveraging ServiceNow ITBM, see the Customer Success Center.
- For information on ITBM organizational level plugins, see the Organizational level plugins for IT Business Management.
- Integrate risks, issues, decisions, actions, and change requests with RIDAC. For more information, see RIDAC overview.
- With ITBM, you can manage the project financials in your local currency. To learn more, see Multicurrency in Project Management.

**Applications and features**

- Machine learning solutions for IT Business Management
- Application Portfolio Management
- Project Portfolio Management
- Financial Management
- Investment Funding
- Innovation Management
- Time Card Management
- Enterprise Release Management
- Agile Development
- Scaled Agile Framework (SAFe)
- Test Management applications
- Business Planning Portal
- Cost Management

**Organizational plugins for IT Business Management**

IT Business Management offerings help you better manage demand, balance resources, manage agile and waterfall projects, perform budget planning, and map costs to technical and business services. IT runs more like a business unit and aligns better with the rest of the organization.

**Plugins at the organization level**

Watch this three-minute video for an overview of the ServiceNow IT Business Management product.

**Organization Extension (com.snc.organization_extension) plugin**
Organization Extension (com.snc.organization_extension) plugin activates Goals, Business unit, Enterprise strategy, and Business unit strategy entities. It is available on zBoot to all customers with demo data.

Business Units, Goals, Enterprise Strategy, and Business Unit Strategy modules are available in the Organization application menu.

Business Applications and Business Capabilities modules are also available within the Organization application menu, however, their related tables are moved to Configuration Management (CMDB) (com.snc.cmdb) plugin, which is available on zBoot but without demo data.

**Business Stakeholder (com.snc.business_stakeholder) plugin**

Business Stakeholder (com.snc.business_stakeholder) plugin is activated at the ITBM business unit level and contains business stakeholder read-only role (child) plugins at ITBM product levels. Activating the child plugins at the product level enables the read-only access role at the respective product level. Users with this role can view and approve reports at their product level. Following are the child plugins activated at the product levels:

| ITBM plugins |
|--------------|------------------|

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read only roles for Application Portfolio Management (com.snc.apm_read_roles) plugin</td>
<td>The plugin provides read only roles for Application Portfolio Management users to view or read records of tables that are used to retrieve data for reports and dashboards. For plugin upgrade information and the levels of accessibility, see Business stakeholder role for APM.</td>
</tr>
</tbody>
</table>
| Read only roles for PPM Standard (com.snc.pmo_read_roles) plugin | • The plugin provides the Read only roles for Financial Management (sn_itfm_read). Users with this role can access Financial Management dashboards. For more information on the list of dashboards and the levels of accessibility on the underlying tables, see Read only roles for Financial Management.  
• The plugin provides the Read only roles for Project Portfolio Management (PPM) and Timecard (sn_ppm_read). Users with this role can access Portfolio, Program, and Timecard dashboards along with the Resources report. For more information on the list of dashboards and the levels of accessibility on the underlying tables, see Read only roles for PPM. |

**Machine learning solutions for IT Business Management**

Machine learning in IT business management helps to enhance business measurability and improve business operations for organizations.

Businesses face a challenge with growing volumes of data, in extracting meaningful information from a huge set of raw data, and in deriving meaningful business insights. Machine learning can serve as a solution to various business complexities as its algorithm is built using historical data. It helps avoid
Duplicate and inaccurate data being entered into the database and enables businesses to compute and process information much faster.

**Predictive Intelligence for Application Portfolio Management**

The Predictive Intelligence for Application Portfolio Management uses machine-learning algorithms to predict, suggest, and drive the data outcome of the new application that is on boarded.

The application similarity machine-learning solution predicts and suggests the category of the business application when you enter the name and the benefit of the business application in the Register a Business Application form.

Predictive Intelligence for Application Portfolio Management has the following benefits:

- Uses the data in your instance and hence the suggestions of the machine-learning solution are more accurate.
- Provides similarity definition for new applications based on the name and description of the existing applications in the Business Application table [cmdb_ci_business_app].
- Suggests categories for the application that you are onboarding to help you sort it into an appropriate category. It is important to categorize an application as it defines its purpose and key business function in the APM inventory.
- Enhances the Register a Business Application feature offered by Business Application Lifecycle Management services.

**Solution definitions for Predictive Intelligence of Application Portfolio Management**

The solution definitions for the predictive intelligence of Application Portfolio Management are available in the Application Portfolio Management – Predictive Intelligence plugin (com.snc.apm.predictive_intelligence). For more information, see Activate Application Portfolio Management.

<table>
<thead>
<tr>
<th>Solution Definition</th>
<th>Solution Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Application Similarity</td>
<td>Similarity</td>
<td>Predicts the Category of the business application field from the Name of the business application field and the description provided in the Benefit of the business application field.</td>
</tr>
</tbody>
</table>

**Maintaining prediction accuracy**

If your business applications table has more diversified data, then the chances of the machine-learning solution to collect and compare your existing records with new similar records are more. Therefore, the prediction results of categorizing the business application from the name and the description entered by the requester may be more accurate.

You can manage prediction drift by retraining the similarity definition of a business application similarity model provided by the base system. Once your machine-learning solutions are trained, you can call on the Predictive Intelligence API to make a solution prediction.
Train the similarity solution for APM to categorize applications while registering

Train the business application similarity definition included within the Predictive Intelligence for Application Portfolio Management to suggest a category for a business application when it is being registered or on-boarded.

Ensure that the Application Portfolio Management – Predictive Intelligence plugin (com.snc.apm.predictive_intelligence) is activated.

Role required: ml_admin

1. Navigate to Predictive Intelligence > Similarity > Solution Definitions.
2. In the Similarity Definitions [ML view], click the Business Application Similarity (ml_sn_sn_apm_ml_global_ba_similarity) label.
3. On the Similarity Definition Business Application Similarity [ML view] form, verify the default values for business application similarity. For more information on the Similarity Definition form fields, see Create and train a similarity solution.

   Note: Set the application scope to Application Portfolio Management – Predictive Intelligence to edit the form. Click the word here at the end of the warning message that appears.

   ![Similarity Definition form](image)

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Unique name for your similarity definition.</td>
</tr>
<tr>
<td>Word Corpus</td>
<td>Collection of words and phrases related to the name and description of the business application that functions as the vocabulary the system uses to compare your instance records based on their textual similarity.</td>
</tr>
<tr>
<td>Processing Language</td>
<td>Dominant language of the dataset that you are training on the solution definition. If the dataset language is Italian, choose Italian.</td>
</tr>
<tr>
<td></td>
<td>Note: English processing is applied to all datasets by default.</td>
</tr>
<tr>
<td>Stopwords</td>
<td>Existing word corpus that is relevant to your solution. You can also add stopwords to the list, for example, words like Application.</td>
</tr>
<tr>
<td>Training Frequency</td>
<td>Option to retrain from once daily or every 30 days in three months increments up to 180 days.</td>
</tr>
<tr>
<td>Update Frequency</td>
<td>Frequency at which you want to refresh the data you use to retrieve your similarity results.</td>
</tr>
</tbody>
</table>

4. Click **Update & Retrain**.

You can create a similarity solution with words and phrases related to the name and description of the business application that triggers a prediction. You can also set a training frequency for your machine-learning solution to collect and compare existing records with new records for a similarity definition.

Use the similarity solution to categorize an application while it is on-boarded.
Use similarity solution to categorize applications and integrate with service catalog

Use the machine-learning engine to suggest a category for a business application that you are registering into the APM inventory.

Role required: sn_apm.apm_user

Using the Register a Business Application form to on-board an application in APM is similar to requesting an item from Service Catalog category.

2. Click the Register a Business Application card to register a new business application.
3. Enter the details in the Register a Business Application form. Mandatory fields have a red asterisk (*) beside them.

Register a Business Application form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter the name of the business application</td>
<td>Name of the business application that you are requesting or registering.</td>
</tr>
<tr>
<td>Benefit or use of the business application</td>
<td>Purpose of the business application.</td>
</tr>
<tr>
<td>IT Owner of the Business Application</td>
<td>Name of the IT owner of the application.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>Business Owner of the Business Application</td>
<td>Name of the business owner of the application.</td>
</tr>
</tbody>
</table>
Register a Business Application

Register a new business application into Application Portfolio Management

* Enter the name of the business application
  PeopleSoft HR - Training & Development

* Benefit or use of the business application
  PeopleSoft HR - Training & Development

* IT Owner of the Business Application
  Business Owner of the Business Application

* Category of the business application
  WorkFlow

Type of application
  COTS
As you enter the name and the benefit of the business application, the similarity solution of the machine-learning algorithm is triggered to search for a similar business application from the business applications table [cmdb_ci_business_app]. Once the engine finds similar records, you can see a message on top of the form indicating that the ML found similar records in the applications table. Based on the findings the engine suggests a category for the application that you are registering. It also displays the suggested category in the **Category of the business application** field under which the business application can possibly be grouped.

If you choose to select the category predicted and suggested by the machine-learning solution, then the application category is stored in the **ML Predicted Category** field of the Business Application Requests table [business_app_request] for future analysis.

4. Select the ML suggested category if it is suitable.

5. Click **Submit**.

**Predictive Intelligence for Demand Management**

The Predictive Intelligence for Demand Management capability uses machine-learning algorithms to search and display similar demands while creating a demand in the Demand form.

Predictive Intelligence for Demand Management has the following benefits:

- Improves the quality of your database by avoiding duplicate demand.
- Helps you in planning your demand. You can view details of similar demands that were submitted and executed in the past.

**Solution definition for Predictive Intelligence for Demand Management**

The solution definition for Predictive Intelligence for Demand Management capability is available in the Predictive Intelligence for PPM plugin (com.snc.ppm_ml). For more information about Predictive Intelligence, see Predictive Intelligence and Contextual search.
### Solution Definition for Demand Management

<table>
<thead>
<tr>
<th>Solution Definition</th>
<th>Solution Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Similar Demands</td>
<td>Similarity</td>
<td>View similar demands based on the Short description fields. You can see the results in the Similar demands section on the Demand form</td>
</tr>
</tbody>
</table>

**Note:** This solution definition is available as a template on instances where the following plugins are active:
- Predictive Intelligence for Contextual Search plugin (com.snc.contextual_search_ml)
- PPM Standard plugin (com.snc.financial_planning_pmo)
- Predictive Intelligence for PPM plugin (com.snc.ppm_ml)

---

### Train the similarity solution for Demand Management to find similar demands

Train the Similar Demands solution definition included within the Predictive Intelligence for PPM capability to find related demands when creating a demand.

Ensure that the Predictive Intelligence for Contextual Search plugin (com.snc.contextual_search_ml), PPM Standard plugin (com.snc.financial_planning_pmo), and Predictive Intelligence for PPM plugin (com.snc.ppm_ml) are activated. For more information about Predictive Intelligence, see Predictive Intelligence.

**Role required:** admin

1. Navigate to **Predictive Intelligence > Similarity > Solution Definitions**.
2. In the Similarity Definitions list, search for and select the Similar Demands solution definition (ml_sn_global_global_similar_demands).
3. On the Similarity Definition form, verify the default field values for demands. For more information about the Similarity Definition form fields, see #unique_15.
4. Click **Update & Retrain**.
5. Open the Similarity Definition form for the Similar Demands solution definition (ml_sn_global_global_similar_demands).
6. In the ML Solutions related list, view the training solution progress in the **Progress** column.

**Note:** Alternatively, you can click the link for the solution in the **Active** column. On the ML Solution form, click the **Show training progress** related link to check the training solution progress.

When the solution is complete, the similar demands appear in the Similar demands section on the Demand form.
• Review similarity examples: On the Similarity Definition form, in the ML Solutions related list, when Progress is 100%, in the Active column, click the link for the solution. On the ML Solution form, click the Similarity Examples related link to view the Similarity Examples list.

• Update the similarity score threshold: On the ML Solution form, on the Solution Statistics tab, enter the required value in the Similarity Score Threshold field. Right-click the ML Solution form and click Save.

• Test the prediction output for the records: On the ML Solution form, on the Test solution tab, enter your text in the Short description field and the maximum number of expected results in the Top N field, and then click Run test. The results above the similarity score threshold value are displayed.

Predictive Intelligence for Project Management

The Predictive Intelligence for Project Management capability uses machine-learning algorithms to search and display similar projects while defining a new project using the project form. You can also search for existing projects and compare similar projects for project planning.

Predictive Intelligence for Project Management has the following benefits:

• Improves the quality of your database by avoiding duplicate projects.
• Helps you in planning your project. You can view planning details of similar projects that were created and executed in the past.

Solution definitions for Predictive Intelligence for Project Management

The solution definition for Predictive Intelligence for Project Management capability is available in the Predictive Intelligence for PPM plugin (com.snc.ppm_ml). For more information about Predictive Intelligence, see Predictive Intelligence and Contextual search.

Solution Definition for Project Management

<table>
<thead>
<tr>
<th>Solution Definition</th>
<th>Solution Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Similar Projects</td>
<td>Similarity</td>
<td>View similar projects based on the Short description and Description fields. You can see the results in the Similar projects section on the Project form.</td>
</tr>
</tbody>
</table>

Note: This solution definition is available as a template on instances where the following plugins are active:

• Predictive Intelligence for Contextual Search plugin (com.snc.contextual_search_ml)
• PPM Standard plugin (com.snc.financial_planning_pmo)
• Predictive Intelligence for PPM plugin (com.snc.ppm_ml)
Train the similarity solution for Project Management to find similar projects

Train the Similar Projects solution definition included within the Predictive Intelligence for PPM capability to find related projects when defining a project.

Ensure that the Predictive Intelligence for Contextual Search plugin (com.snc.contextual_search_ml), PPM Standard plugin (com.snc.financial_planning_pmo), and Predictive Intelligence for PPM plugin (com.snc.ppm_ml) are activated. For more information about Predictive Intelligence, see Predictive Intelligence.

Role required: admin

1. Navigate to Predictive Intelligence > Similarity > Solution Definitions.
2. In the Similarity Definitions list, search for and select the Similar Projects solution definition (ml_sn_global_global_similar_projects).
3. On the Similarity Definition form, verify the default field values for projects. For more information about the Similarity Definition form fields, see #unique_15.
4. Click Update & Retrain.
5. Open the Similarity Definition form for the Similar Projects solution definition (ml_sn_global_global_similar_projects).
6. In the ML Solutions related list, view the training solution progress in the Progress column.

Note: Alternatively, you can click the link for the solution in the Active column. On the ML Solution form, click the Show training progress related link to check the training solution progress.

When the solution is complete, the similar projects appear in the Similar projects section on the Project form.

- Review similarity examples: On the Similarity Definition form, in the ML Solutions related list, when Progress is 100%, in the Active column, click the link for the solution. On the ML Solution form, click the Similarity Examples related link to view the Similarity Examples list.
- Update the similarity score threshold: On the ML Solution form, on the Solution Statistics tab, enter the required value in the Similarity Score Threshold field. Right-click the ML Solution form and click Save.
- Test the prediction output for the records: On the ML Solution form, on the Test solution tab, enter your text in the Short description field and the maximum number of expected results in the Top N field, and then click Run test. The results above the similarity score threshold value are displayed.

Application Portfolio Management

Use the ServiceNow® Application Portfolio Management (APM) application to gain a comprehensive understanding of the applications used in your organization so you can identify redundancies, and decrease budgetary costs. By consolidating applications within the same business function, you can identify applications to modernize or upgrade. APM also helps you decide whether to invest, sustain, or replace applications based on the business need aligned towards the organization goal.

You can address business challenges such as:

- Redundant applications for similar functions.
- Increasing cost of owning and maintaining applications.
- Increasing demand to upgrade the existing applications for new functions.
- Conflict between in-house legacy applications and that of the vendors.
- Inadequate performance because of outdated applications.
Overcome these challenges, improve business functions in an efficient and smooth manner, and optimize cost with these APM processes:

**Identify**
Build a comprehensive inventory of the business applications in use.

**Measure**
Determine the usage of the applications by gathering metrics such as cost, usage, risk, and quality.

**Evaluate**
Assess the value of each application by evaluating their significance and usage based on the metrics.

**Decide**
Decide whether to invest in the application, maintain it as it is or replace it with another application, or retire the application.

**Take action**
Implement your decision by retaining, upgrading, or retiring the applications.
APM uses the following key solution components:

- Application Classification
  - Focuses on Enterprise Business Applications, which can also include functional modules part of a larger ERP suite.
  - Provides additional attributes to classify applications in a new CI class, Business application, which extends the base Configuration Management Database (CMDB) configuration item.

The configuration items used in APM are related by establishing a CMDB relationship with each other.

APM CI relationship

- Captures phased rollout/deployment of applications by business unit or geography.
• Captures attributes from the referenced Software Model.

Applications Assessment Framework
• Indicators to assess the application across dimension such as cost, quality, risk, user satisfaction, and business alignment.
• Common indicators from ServiceNow applications like Financial Management for costs, ITSM for support issues, PPM for investment details.

Reports and Dashboards
• Application Landscape Dashboard
• Application 360 Dashboard
• Application Assessment Dashboard
• Application Strategy Recommendation (bubble chart)
• Applications Rationalization Roadmap

Integration with other applications
• Integrates with Project Portfolio Suite (PPS) to track execution of strategic goals and recommendations.
• Integrates with Financial Management to assess applications costs and associated breakdowns.
• Integrates with PPS to assess planned investments for applications.
• Integrates with ITSM to assess the incidents, problems, and changes for the applications.
• Integrates with Service Administration to generate an assessment questionnaire to a user or user group who use the business application and can assess its performance.

Activate Application Portfolio Management

An administrator can activate the Application Portfolio Management plugin (com.snc.apm).
Role required: admin

The Application Portfolio Management (com.snc.apm) plugin is the basic plugin for the application.
The Application Portfolio Management plugin activates the following related plugins if they are not already active:

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Portfolio Management – Predictive Intelligence (com.snc.apm.predictive_intelligence)</td>
<td>To predict application category by applying algorithms like similarity on business applications related data.</td>
</tr>
<tr>
<td>Business Planner (com.snc.apm.business_planner)</td>
<td>To access the Business Planning portal.</td>
</tr>
<tr>
<td>Demand Core (com.snc.demand_core)</td>
<td>To activate the basic core components of Demand Management.</td>
</tr>
<tr>
<td>Fiscal Calendar (com.snc.fiscal_calendar)</td>
<td>To create and manage the fiscal calendar.</td>
</tr>
</tbody>
</table>

Note: APM supports only the Fiscal Calendar type, Standard.
You require the following plugins for specific features in the APM module:

**Application Portfolio Management – ATF Tests plugin (com.snc.apm.atf) plugin**
To validate Application Portfolio Management and that it works after you make any configuration change such as apply an upgrade or develop an application.

**Read only roles for Application Portfolio Management plugin (com.snc.apm_read_roles)**
To view or read records of tables that are used to retrieve data for reports and dashboards.

**Application Portfolio Management Core plugin (com.snc.apm_core)**
To register a new business application. The plugin is in base application and activating the Application Portfolio Management plugin (com.snc.apm) enhances the Register a Business Application feature to predict and suggest an application category using the machine-learning solution when you on-board an application in to the APM inventory.

**Domain Support – Domain Extensions Installer system plugin**
To enable the domain separation feature for APM.

**Performance Analytics Premium for APM (com.snc.pa.premium.apm) plugin**
To retrieve historic data that are older than six months.

Activate the following plugins for additional features:

**PPM Standard (com.snc.financial_planning_pmo)**
To activate an integrated set of applications for project portfolio management and IT software development.

**Financial Management For APM (com.snc.financial_management_for_apm)**

To integrate Financial Management with Application Portfolio Management providing preconfigured Business Application Costing cost model and cost indicators.

This plugin also activates the following plugin:

**Performance Analytics — Content Pack — Financial Management for Application Portfolio Management (com.snc.pa.fm.apm) plugin**

To enable Performance Analytics dashboards for Financial Management associated with Application Portfolio Management.

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in **Request a plugin**.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Use the **APM Guided Setup** to set up the Application Portfolio Management.

**Installed with Application Portfolio Management**

Several types of components are installed with Application Portfolio Management.

**Tables installed with Application Portfolio Management**

Tables are added with activation of Application Portfolio Management.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Bubble Chart [apm_bubble_chart]</td>
<td>Bubble chart configuration.</td>
</tr>
</tbody>
</table>
| Application Service Risk
  [sn_apm_tpm_business_service_risk]         | Stores risks on an application service for TPM.                             |
| Application Category [apm_application_category] | Application category to which the business application belongs to.          |
| Application Category Group
  [apm_application_category_group]          | Group of application categories.                                            |
| Application Family [apm_application_family] | All application families.                                                   |
| Indicator [apm_metric]                    | Indicator definition to capture the indicator scores.                      |
| Indicator Score [apm_app_indicator_score]  | Indicator scores calculated by the engine based on the profile.             |
| Scoring Profile [apm_application_profile]  | Scoring profile definition.                                                |
### Table

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile Indicator [apm_application_profile_indicator]</td>
<td>Application profile indicator having the weightage the indicator has to calculate the overall score of business application.</td>
</tr>
<tr>
<td>CI Score [apm_app_score]</td>
<td>Overall application score calculated by the engine based on the application profile.</td>
</tr>
<tr>
<td>Application Service Software Model [sn_apm_tpm_service_software_model]</td>
<td>Stores the software models (technologies) underlying each application service.</td>
</tr>
<tr>
<td>Goal Contribution Target [goal_contribution_target]</td>
<td>Goal contribution of a program for the target fiscal year.</td>
</tr>
<tr>
<td>Demand Action [apm_idea_action]</td>
<td>Actions available for submitting a demand.</td>
</tr>
<tr>
<td>Risk Parameter [sn_apm_tpm_risk_parameter]</td>
<td>Stores the risk parameters in TPM.</td>
</tr>
<tr>
<td>Risk Parameter Score [sn_apm_tpm_risk_param_score]</td>
<td>Stores the risk parameter scores for each software model in TPM. For example, if there are four parameters, then for each software model there are four records stored in the table.</td>
</tr>
<tr>
<td>Software Model Risk [sn_apm_tpm_software_model_risk]</td>
<td>Stores risk on the software models in TPM.</td>
</tr>
</tbody>
</table>

### Roles installed with Application Portfolio Management

Roles are added with activation of Application Portfolio Management.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_apm.apm_admin</td>
<td>Create or update application records and access administration activities</td>
<td>Includes sn_apm.apm_user, assessment_admin, certification_admin roles.</td>
</tr>
</tbody>
</table>

- Create/update/delete application categories.
- Create/update/delete application families.
- Create/update/delete business processes.
- Create/update/delete application indicators.
- Create/update/delete application score profile.
- Create/update/delete bubble charts.
- View application indicator scores and application scores.
- View application assessment dashboard.
<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_apm.apm_analyst</td>
<td>Create applications and access landscape, dashboards, roadmaps, strategy program workbench, and associated pages.</td>
<td>Includes it_demand_manager, sn_apm.apm_admin, and treemap_user roles.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> Activate PPM Standard (com.snc.financial_planning_pmo) plugin to create project/ program in Capability-Based Planning (CBP) and Technology Portfolio Management (TPM). For information on PPM roles, see Activation of PPM Standard plugin.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Create/update/delete applications.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- View/update/delete application indicator scores.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- View/update/delete application scores.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Create/update/delete APM programs and targets.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Create/update/delete goals.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Access the APM Service Portal pages for program navigation, category analysis, bubble chart view, application comparisons.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Create demand with application strategy related attributes.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- View Application 360 dashboard.</td>
</tr>
<tr>
<td>sn_apm.apm_user</td>
<td>Access to update applications, view landscape, and roadmap.</td>
<td>Includes demand_manager, pa_viewer, and certification roles.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> Activate PPM Standard (com.snc.financial_planning_pmo) plugin to create project/ program in CBP and TPM. For information on PPM roles, see Activation of PPM Standard plugin.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- View/update applications.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Request to create business applications.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Create/update/delete application rollouts.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- View application landscape reports and dashboards.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- View applications roadmap.</td>
</tr>
<tr>
<td>Role</td>
<td>Description</td>
<td>Contains roles</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>sn_apm.apm_read</td>
<td>Access to view APM dashboards provided by the base system and the underlying tables from where the data for the dashboards are retrieved.</td>
<td>Includes pa_viewer and cmdb_read roles.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View Application 360 dashboard, Application Landscape dashboard, Application Assessments dashboard.</td>
</tr>
</tbody>
</table>

**UI policies installed with Application Portfolio Management**

UI policies are added with activation of Application Portfolio Management.

<table>
<thead>
<tr>
<th>UI policy</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>When data source is not PA</td>
<td>Application Indicator [apm_metric]</td>
<td>Shows the <strong>Custom Script</strong> field when the data source is custom script.</td>
</tr>
<tr>
<td>When query condition is data source</td>
<td>Application Indicator [apm_metric]</td>
<td>Shows the <strong>Query table</strong>, <strong>Consolidate</strong>, <strong>Aggregate type</strong>, <strong>Aggregate</strong>, <strong>Conditions and Group By</strong> fields when the data source is custom script.</td>
</tr>
<tr>
<td>When Assessments and Surveys are data source</td>
<td>Application Indicator [apm_metric]</td>
<td>Shows the <strong>Metric Type</strong> and <strong>Metric Category</strong> fields when the data source is assessments.</td>
</tr>
<tr>
<td>When PA is data source</td>
<td>Application Indicator [apm_metric]</td>
<td>Shows the <strong>Source PA indicator</strong> and <strong>Frequency and Default breakdown</strong> fields when the data source is custom script.</td>
</tr>
<tr>
<td>When data source is custom script</td>
<td>Application Indicator [apm_metric]</td>
<td>Shows the <strong>Custom Script</strong> field when the data source is custom script.</td>
</tr>
</tbody>
</table>

**Scheduled jobs installed with Application Portfolio Management**

Scheduled jobs are added with activation of Application Portfolio Management.

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Application Certification On Demand</td>
<td>Schedules a certification task and the certification schedule is run on demand.</td>
</tr>
<tr>
<td>Business Application Certification Quarterly</td>
<td>Schedules a certification task and the certification schedule is run periodically every quarter.</td>
</tr>
<tr>
<td>Business Applications not related to any Business Capability audit</td>
<td>Checks the CI relationship [cmdb_rel_ci] table for business applications that are not related to any business capability.</td>
</tr>
<tr>
<td>Business Applications not related to any Software Model</td>
<td>Checks the CI relationship [cmdb_rel_ci] table for business applications that are not related to any software model.</td>
</tr>
<tr>
<td>Scheduled job</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Business Applications related to multiple Business Capabilities in the same hierarchy</td>
<td>Checks the CI relationship <code>cmdb_rel_ci</code> table for a possibility where the same business application is tied to multiple business capabilities at the same level of the hierarchy.</td>
</tr>
<tr>
<td>Load Application Indicators and compute Application Scores</td>
<td>Populates application indicator score and calculates application scores based on the scoring profile attached to the business application.</td>
</tr>
<tr>
<td>Load TPM Risk Parameters and compute Application Service Risks</td>
<td>Calculates the software model risk and the business application risk.</td>
</tr>
<tr>
<td>Orphaned Business Capabilities</td>
<td>Checks for capabilities that have neither parent capability nor child capabilities, and do not have any business applications related to it.</td>
</tr>
<tr>
<td>Software Models with no lifecycle data</td>
<td>Retrieves software model records used by the business applications that have no lifecycle data.</td>
</tr>
<tr>
<td>Update Business Capability Levels and Hierarchy IDs</td>
<td>Updates the order and hierarchy of the business capabilities in the Capability map.</td>
</tr>
</tbody>
</table>

### Client scripts installed with Application Portfolio Management

Client scripts are added with activation of Application Portfolio Management.

<table>
<thead>
<tr>
<th>Client script</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mark Goal mandatory with respect to APM view</td>
<td>Program [pm_program]</td>
<td>Marks Goal mandatory with respect to APM view.</td>
</tr>
<tr>
<td>Defaulting comments for scripted indicator</td>
<td>Application Indicator [apm_metric]</td>
<td>If the Data Source field is Custom script, then the Custom script field is populated with the sample custom script.</td>
</tr>
<tr>
<td>Set view in APM to true</td>
<td>Program [pm_program]</td>
<td>Sets the Used by APM check box to true.</td>
</tr>
<tr>
<td>Set mandatory attributes for APM goals</td>
<td>Goal [goal]</td>
<td>Sets mandatory attributes for APM goals.</td>
</tr>
<tr>
<td>Restrict Sustain</td>
<td>Demand Action [apm_idea_action]</td>
<td>Restricts sustain from the list of strategies.</td>
</tr>
</tbody>
</table>

### Business rules installed with Application Portfolio Management

Business rules are added with activation of Application Portfolio Management.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Populate Short Description</td>
<td>Goal [goal]</td>
<td>Populates Short Description of the goal based on the attributes provided.</td>
</tr>
<tr>
<td>PA Indicator frequency check</td>
<td>Indicator [apm_metric]</td>
<td>Checks the frequency of the performance analytic indicators.</td>
</tr>
</tbody>
</table>
### Business stakeholder role for APM

For APM users, Business Stakeholder (com.snc.business_stakeholder) plugin contains the business stakeholder role for APM. Users with this role can approve, view or read records of tables that are used to retrieve data for reports and dashboards. Customers can assign this role to any user who is a business stakeholder to review and approve reports.

### Upgrade information

**Upgrade customer**

If you are upgrading to Paris, the business stakeholder role for APM is available only when you activate Read only roles for Application Portfolio Management (com.snc.apm_read_roles) plugin.

**New customer**

If new customer, the Read only roles for Application Portfolio Management (com.snc.apm_read_roles) plugin is activated on zBoot. However, the business stakeholder role for APM is available only when you install APM plugin.

### Why business stakeholder read-only role?

Analyst (sn_apm.apm_analyst) role in Application Portfolio Management is a licensable role that requires subscription. Users with this role can access all APM dashboards, roadmaps, program workbench, and all the associated pages and tables. Moreover, this role contains IT program manager, IT portfolio manager, IT demand manager, and APM administrator roles who have different levels of access not only to read but to approve and update information data. Organizations procure this licensable role in limited numbers as it comes with a price. Business stakeholder role comes with a similar function but access is controlled at read-only level. Users with this role can access reports to review and approve only.

### Share dashboards with business stakeholder read-only users

APM users with Business stakeholder role for APM (sn_apm.apm_read) role have read-only access to dashboards and reports and all the underlying tables of the dashboards.

The base system provides access to users with this role to view Application Landscape, Application 360, and Application Assessments dashboards. You can also access all the tables from where the data are retrieved for these dashboard reports.

However, you can also configure your custom-created dashboards and reports to provide users with business stakeholder role. To provide read-only access to a business stakeholder, follow the steps in Share a responsive dashboard

### Share widgets in dashboards with business stakeholders

To share individual widgets in the dashboard with the user who has the business stakeholder read-only role,
1. Navigate to **Application Portfolio Management** > **Application Portfolio Analysis** > **Dashboard**

2. Click the add widgets icon (+)

3. Click the edit content icon ( ) of the widget that you want to share.

4. Click the sharing icon ( ).

5. Click the **Share** option in the Sharing section.

6. Search for `business_stakeholder` in the search field and click to add the role in the Sharing settings window.

7. Click **OK**.

**APM tables accessible to users with business stakeholders role**

Users with Business stakeholder role for APM can access the following tables that store the data to load the widgets in the APM dashboards:

**APM tables**

<table>
<thead>
<tr>
<th>Label</th>
<th>Table name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Application</td>
<td><code>cmdb_ci_business_app</code></td>
</tr>
<tr>
<td>Business Capability</td>
<td><code>cmdb_ci_business_capability</code></td>
</tr>
<tr>
<td>CMDB Relationship</td>
<td><code>cmdb_rel_ci</code></td>
</tr>
<tr>
<td>CI Score</td>
<td><code>apm_app_score</code></td>
</tr>
<tr>
<td>Indicator Score</td>
<td><code>apm_app_indicator_score</code></td>
</tr>
<tr>
<td>Indicators</td>
<td><code>apm_metric</code></td>
</tr>
<tr>
<td>Fiscal Year</td>
<td><code>fiscal_period</code></td>
</tr>
<tr>
<td>Business Process</td>
<td><code>cmdb_ci_business_process</code></td>
</tr>
<tr>
<td>Application Family</td>
<td><code>apm_application_family</code></td>
</tr>
<tr>
<td>Application Category</td>
<td><code>apm_application_category</code></td>
</tr>
<tr>
<td>Application Category Groups</td>
<td><code>apm_application_category_group</code></td>
</tr>
<tr>
<td>Scoring Profiles</td>
<td><code>apm_application_profile</code></td>
</tr>
<tr>
<td>Portfolio</td>
<td><code>pm_portfolio</code></td>
</tr>
</tbody>
</table>
Application Portfolio Management portal

The Application Portfolio Management portal gives you an enterprise-wide applications landscape view of the number of applications and other key metrics. As an enterprise architect (EA), you can view and access all the APM modules from this portal.

You can navigate to the Application Portfolio Management portal page by clicking Application Portfolio Management > Home. The role required is sn_apm.apm_analyst.

The Application Portfolio Management portal consists of four sections. The sections provide a quick access to view the portfolios of business capability, information, application, technology, and create goals, demands, and programs.
View the number of business capabilities defined by your organization that have been assessed and are yet to be assessed, and the number of business applications that support the capabilities but are at a major risk. Click Hierarchy Map to view the capability map in a new tab that displays the business capabilities and sub-capabilities in a hierarchy. Click Business Planning to navigate to the business planning portal.

Information Portfolio

Capture the information from the assets of your organization as information objects. You can connect the information object to your business applications to have a portfolio of application information, ready and accessible to use at any time. The entities in the information portfolio are either configuration items or columns of tables. They are structurally designed to relate to each other either by CMDB CI relationship or by referencing the data columns of tables.

The numbers below each entity of Information Portfolio represent the following data:

- **Data Domains**: Total number of records in the Data Domain [sn_apm_data_domain] table.
- **Information Objects**: Total number of records in the Information Object [cmdb_ci_information_object] table.
- **Database Catalogs**: Total number of records in the Database Catalog [cmdb_ci_db_catalog] table.
- **Unstructured DB Catalogs**: Total number of records in the configuration item tables such as:
  - configuration file (cmdb_ci_config_file)
  - file system (cmdb_ci_file_system)
  - exchange mail box (cmdb_ci_exchange_mailbox)

**Note:**
Your enterprise might have any number of database catalogs, but only the number of database catalogs that are linked to the information objects, which in turn are related to the business applications, are displayed as counts in each of the information portfolio sections. Similarly, only those numbers of database instances that are referenced in the database catalogs are summed up as database instances.

Click the **Information Objects** link to view the details of the information objects that are related to the business applications in your enterprise. See: Information Portfolio.

**Note:**
The information objects must be related to the business application for you to view them in the Information Objects page that opens.

Application Portfolio

Track the applications that support your business capabilities and manage them effectively to fulfill the goals of your organization. The portfolio provides a list of applications with information such as their category, manufacturer, and type. Click Applications to navigate to the list view of business applications in your organization. Analyze your applications by category or family and group them the way you want them to be in the application Landscape view. Click Analyze to navigate to the Group Analysis page to analyze the applications and their scores.

Technology Portfolio

View the number of hardware models and software models that are linked to your business applications. You can also get a count of the number of these models that are at high risk. Click the Technology
Portfolio link to go to the TPM timeline view and know the status of the hardware and software models lifecycle.

**Opportunities & Solutions**

View the number and click to view the list of goals, demands, and programs. Click any goal, demand, or program in the list to update its details. Use the **Create** link to directly create a goal, demand, or program.

- **Create a goal** to track, align, and report the progress of the work towards it. For example, a goal could be set to reduce Capex or reduce the number of applications within a target date.
- **Create a demand** to capture your strategic goal for the application.

To create a demand from the application menu, navigate to Application Portfolio Management > Application Portfolio Analysis > Demands

- **Create a program** to meet the goals. APM takes you through a process to add targets and identify opportunities.

**Note:** You can view and create programs from the Program section only when you activate PPM Standard (com.snc.financial_planning_pmo) plugin.

**Notifications**

View the results of desired and scripted audits, the number of hardware and software models that face high and moderate risks, expiring on the current date and in the next 90 days, and pending certification instances that are open and not 100% complete. Click the notification to open the related task or the related data certification schedule instance to view the record details.

**Recent Activity**

View your most recent activity of creating a goal, demand, or program for a fiscal period.

**Application portfolio administration**

With the sn_apm.apm_admin role, you can classify the applications used in the business enterprise. You can also provide privileges to users to do specific tasks, set up indicators to assess application usability, and create bubble charts to help define strategies to maintain applications.

With administrative privileges, you can set up application classification attributes to group applications, users and roles to provide level of access and assign tasks, applications assessment indicators to assess applications, and bubble charts to recommend an application strategy. Such a setup helps you to classify your applications and maintain an inventory, provide privileges to users to do specific tasks, assess the application usability by its indicators, and recommend a strategy to plan and execute organization goals.

**Application classification**

Classifying applications into groups and categories helps your organization track and compare the applications. You can identify relationships and redundancies between the applications more easily. You can also build a complete applications inventory and map the applications to the business functions.

Set up these attributes for classifying and grouping applications:

**Application category**

This attribute is mandatory. It is a grouping attribute which you can use to make application rationalization decisions. Typically you can use this attribute to group applications used in a business process or department. The applications can have overlapping or complementary capabilities, but they are a part of the same business function and must be reviewed together during an application rationalization exercise.
The summarized information at the application category level enables you to compare applications within a category using various metrics.

**Category group**
This attribute is optional. It is a grouping attribute for filtering and reporting of application categories.

**Application family**
You can use this optional attribute to group the applications by the manufacturers classification of their products into various product suites.

**Business Process**
This attribute is an optional attribute that is primarily used for filtering and reporting. Level one (L1) of a business process is a high-level representation that outlines the business operations of an organization. Ideally L1 business process can be tagged. For example, Oracle Order Management can be tagged to the business process ‘Quote to Cash’. The detailed mapping between the application and the business processes can be created using the CI relationship.

**Software Model**
This attribute is available with the base instance and contains the specifications of the software such as the manufacturer, version, release date, and end of life date. Business application references the corresponding software model record to automatically pull in the software specifications.

**Application classification example**

<table>
<thead>
<tr>
<th>Business Application</th>
<th>Business Process (L1)</th>
<th>Application Category Group</th>
<th>Application Category</th>
<th>Application Family</th>
<th>Software Models</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle EBS Order Management</td>
<td>Quote to Cash</td>
<td>Sales and Distribution</td>
<td>Order Management</td>
<td>Oracle EBS SCM</td>
<td>Oracle EBS R12.2 Order Management</td>
</tr>
<tr>
<td>Oracle EBS General Ledger</td>
<td>Financial Plan to Report</td>
<td>Financials</td>
<td>General Ledger</td>
<td>Oracle EBS Financials</td>
<td>Oracle EBS R12.2 Financials</td>
</tr>
</tbody>
</table>

**Add or edit an application category group**

An application category group is a collection of application categories. Category groups help with filtering and reporting of the application categories. You can create an application category group or edit an existing one to align it with your business requirements.

Role required: sn_apm.apm_admin

1. Navigate to Application Portfolio Management > Administration > Application Category Groups.
2. Click New to create a new category group or click the name of an existing category group that you want to edit.
3. Enter a name and description for the application category group.
4. Click Submit or Update.

**Add or edit an application category**

An application category is a grouping of applications by their purpose and function, fields, or areas. Such a categorization helps you to consolidate applications and rationalize decisions. You can create an application category or edit an existing one to align it with your business requirements.

Role required: sn_apm.apm_admin

Each application should have an application category defined. This field is used to describe the purpose of the application, and the key business function this application supports. You can keep the categorization at
a high level, like a business function. For example, Sales, HR, Marketing, and Manufacturing. Application
category field is used to filter Analysis dashboards (2x2 matrix plotting business value versus technical
risk).

1. Navigate to Application Portfolio Management > Administration > Application Categories.
2. Click New to create a new category or click the name of an existing category that you want to modify.
3. Enter a name and description for the application category.
4. If you want to add the category to a category group, look up and select the group from the Category
group field.
5. Click Submit or Update.

Add or edit an application family

An application family is an attribute to group a set of related applications based on manufacturer
classification of their products into product suites. You can create an application family or modify an
existing one to align it with your business requirements.

Role required: sn_apm.apm_admin

1. Navigate to Application Portfolio Management > Administration > Application Families.
2. Click New to create a new application family or click the name of an existing family that you want to edit.
3. Enter a name and description for the application family.
4. Click Submit or Update.

Add or edit an application business process

A business process is a method of related structured tasks performed to accomplish a specific application
service. The business capabilities of a business application can be modeled as a business process. Create
a business process to group applications that help accomplish a specific application service. You can create
a business process or modify an existing one to align it with your business requirements.

Role required: sn_apm.apm_admin

Business process or capability hierarchy is an ordered grouping of business processes in a hierarchical
fashion. For example, L0 and L1 processes.

Based on the requirements, business capability hierarchy can be modeled using the business process
relationship. You can edit the business process records using the CI relationships to create a business
process hierarchy.

1. Navigate to Application Portfolio Management > Administration > Business Processes.
2. Click New to create a new business process or click the name of an existing process that you want to edit.
3. Fill in the fields.

Business Process form

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the business process.</td>
</tr>
<tr>
<td>Asset tag</td>
<td>Alphanumeric tag assigned by the organization to the asset.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Person using or responsible for the item.</td>
</tr>
<tr>
<td>Category</td>
<td>Category of the business process.</td>
</tr>
<tr>
<td>Fault count</td>
<td>Number of faults.</td>
</tr>
</tbody>
</table>
4. Right-click the form header and select **Save**.
5. If you want to add items to this business process, use the Related Items **CI relations formatter**.
6. Click **Submit** or **Update**.

### Create an application portfolio

A portfolio is a collection of related projects and demands. You can create a project and execute it to rationalize and modernize the application portfolio. Create a portfolio of applications, and set demands and goals to measure the effort and progress of several projects and also create reports on these projects for analysis.

Role required: sn_apm.apm_admin

1. Navigate to Application Portfolio Management > Administration > Portfolio.
2. Click **New**.
3. Enter a name and description for the portfolio.
4. In the **Portfolio manager** field, search for and select the name of the manager for this portfolio.
5. Click **Create Portfolio**.

### Add a strategy for managing applications

Demand actions are strategic decisions that you want to execute for an application. Application Portfolio Management provides preconfigured actions that help you enhance the capability of the applications. You can add new demand actions as per your requirements.

Role required: sn_apm.apm_admin

Create demand actions that are aligned to the application strategy.

1. Navigate to Application Portfolio Management > Administration > Demand Actions.
2. Click **New**.
3. Fill in the fields.

#### Demand Actions form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>Decision taken on the application.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the action.</td>
</tr>
<tr>
<td>Strategy</td>
<td>Plan to implement the action.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

### Schedule a data certification task

Keep your business applications inventory up-to-date by certifying the data in the business applications table periodically. Keeping your business application data current helps you to assess your business applications precisely as there are indicators that are dependent on these business applications.

Role required: sn_apm.apm_admin
As a system administrator with the APM admin role you can create and assign the data certification tasks to the system owners for them to certify the business applications data. You also require certification_filter_admin role to set filter to those fields that require certification.

Inventory of business applications is created one time. But the data on a business applications table are highly dynamic and keep changing over time. Hence, it is imperative to keep the data complete, accurate, and current. Data certification is a platform feature that helps you to keep the data up-to-date.

The Application Portfolio Management with Data Certification (com.snc.apm_dc) plugin for data certification also installs the APM plugin and requires no separate subscription.

Two preconfigured certification schedules are available for the system administrator to schedule data certification tasks. One is **Business Application Certification On Demand** to schedule as and when required, and the other is **Business Application Certification Quarterly** for every quarter. Use either of the schedules as per the specified time interval or on demand. The certification schedule generates a set of certification tasks based on set conditions.

1. Navigate to Application Portfolio Management > Administration > Certification Schedules.
2. Click **New** to create a new record of certification schedule.

You can also click the preconfigured certification schedules to review the record and update the details, if necessary.

### Certification Schedule form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the certification schedule.</td>
</tr>
<tr>
<td>Filter</td>
<td>Select a filter for the table data.</td>
</tr>
<tr>
<td>Table</td>
<td>The table consisting the data that is to be certified. Defaults to cmdb_ci_business_application table.</td>
</tr>
</tbody>
</table>

**Note:** Data certification can be applied only on one table at a time. Create another table if you require data certification on that table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display fields</td>
<td>Select the fields to be displayed from the business application.</td>
</tr>
</tbody>
</table>

**Note:** Display fields cannot be the same as Certification fields. They are mutually exclusive.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Certification fields</td>
<td>Select fields to be displayed that require individual field certification. Specify the fields that you want to be certified.</td>
</tr>
</tbody>
</table>

**Application URL, Business criticality, Data classification, Contract end date, Active, Active user count, Status, User base,** and **Last change applied date** are some of the fields preconfigured for data certification.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Assignment type | Select a user reference field from the target table.  
|               | - **User field**: Select and assign a specific field in the Business application table in the **Assign to** field.  
|               | - **Specific User**: Select and assign a specific user in the **User** field.  
|               | - **Group Field**: Assign the certification schedule to a group in the **Assign to group** field.  
|               | - **Specific Group**: Select and assign the certification schedule to a group in the **Group** field. |
| Assign to     | Owner of the application who is responsible for certifying the data of the business application.                                      |
| User          | Select a user to whom all the unassigned tasks will be assigned to.                                                                        |
| Assign to group | Select a group from the business application table.                                                                                   |
| Group         | Select a group from the choice list.                                                                                                    |
| Assign to empty | Select a value from the choice list:  
|               | - **Do Not Create Task**: Certification task is not created for these records.  
|               | - **Create Unassigned Task**: Certification task is created but is unassigned.  
|               | - **Create Assigned Task**: Certification task is created and assigned to the specific user or group.                               |

**Note**: The field is available only when you select the **Assignment type** as **User Field** or **Group Field**.

<table>
<thead>
<tr>
<th>Days to complete</th>
<th>Enter the number of days by which you require the certification to be completed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>The job is inactive by default. Select the check box to run the scheduled job.</td>
</tr>
<tr>
<td>Run</td>
<td>Frequency with which the certification task is performed: Daily, Weekly, Monthly, Periodically, Once, On Demand.</td>
</tr>
<tr>
<td>Last run date</td>
<td>Defaults to the prior date when the certification was run. The field cannot be edited if the certification schedule is a new record.</td>
</tr>
<tr>
<td>Task description</td>
<td>Brief description of the certification task.</td>
</tr>
<tr>
<td>Instructions</td>
<td>Detailed instruction to the application owner about the task.</td>
</tr>
<tr>
<td>Certification Instances</td>
<td>Number of the certification instance.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Certification Schedule</td>
<td>Defines the information that requires certification and the frequency of execution. Defaults to the certification schedule that you selected.</td>
</tr>
<tr>
<td>State</td>
<td>Status of the certification: <strong>Work in Progress</strong> or <strong>Complete</strong>.</td>
</tr>
<tr>
<td>Created</td>
<td>Created date of the certification instance.</td>
</tr>
<tr>
<td>Complete by</td>
<td>The date on which the certification task is to be completed. <strong>Days to complete</strong> is added to the <strong>Created</strong> date.</td>
</tr>
<tr>
<td>Percent complete</td>
<td>For each field (out of the total number of certification fields) that the application owner certifies the percent is calculated. The system administrator can track the progress of the data certification task.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the certification instance.</td>
</tr>
</tbody>
</table>

### Certification Tasks

<table>
<thead>
<tr>
<th>Number</th>
<th>Number assigned to the certification task.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigned to</td>
<td>Owner of the application to whom the task is assigned and who is authorized to certify the data.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Task can also be assigned to users of a group.</td>
</tr>
<tr>
<td>Escalation</td>
<td>Defaults to Normal.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.
4. Click **Update** to save the changes or **Execute Now** to execute the schedule.

When you click **Execute Now**, a certification instance is created and as a system administrator you can view it in the **Certification Instances** related list. You can also track the certification instance and the percentage of its completion.

Related certification tasks (to verify and certify the data of a business application record) are created in the **Certification Tasks** related list and is assigned to the application owner. As a system administrator you can also track the data certification progress assigned to the application owner.

When a certification task is newly assigned, reassigned, or is about to expire, you can notify the task owners about the pending status of the task at hand by an email.

Preconfigured email notifications such as **APM DC task assignment**, **APM DC task reassign**, and **APM DC task expiry** are available that you can trigger depending on the certification task when you execute a schedule by clicking **Execute Now**.

These email notifications are inactive by default, which you must activate by setting it to true.

5. To activate the email notifications, navigate to **Service Creator > Notifications**.
6. Click open the APM related notification record.
7. Enable the **Active** check box to activate the email notification.

You can review the certification tasks and update them if necessary.
View and update the application certifications

A certification instance is a collection of certification tasks to execute a certification schedule. Review the application tasks that you created and update them if necessary.

Role required: sn_apm.apm_admin

1. Navigate to Application Portfolio Management > Application Portfolio > Application Certifications.
2. Click a Certification Instance in the Certification Instances list.
3. View and update the certification task details, if required.
4. Click a certification task in the Certification Tasks related list.

You can view all the business applications that require certifications and belong to this specific certification task. As a system administrator you can also track the data certifying process and view the certification fields of the business application record that have been certified as checked and those that have failed in certification. The IT_application_owner certifies the certification fields.

Certify data in business applications table

As an application owner with the certification role you can view the certification tasks assigned to you and certify the required fields. You can also update the data in the fields and then certify them.

Role required: certification_admin

1. Navigate to Data Certification > Tasks > My Tasks.
2. Click the task number in the Certification Tasks list that requires your certification.
3. Click the check box to certify the fields.
   You can certify the data in the fields by any of the following methods:
   • Field wise by selecting the field level check box.
   • Column wise to certify the particular data element for all business applications by selecting the
     column level check box.
   • Row wise to certify all data elements for a particular business application by selecting the row level
     check box.
   • Entire table to certify all data elements for all business applications selecting the check box that
     selects all rows.
Methods to select fields and certify the data

4. Click the field to update the data if it is not current.
5. Enter your comment for the fields that you have certified and click the green check mark to certify the checked elements.

A message appears to confirm your certification.

Run audits to determine invalid and missing configuration data

Run the scripted audits and desired state audit to know the missing information in the configuration data. These audits help to find the gaps in business capability, business application, software models, and the lifecycle information.

Role required: sn_apm.apm_admin

You can identify records that have gaps in their relationship with other configuration items by running the scripted audits. Such breaks in establishing the relationship between the business capability and the business application, between the business application and the software models, and the software models with no lifecycle data cannot give you a realistic appraisal of the business capabilities and the business applications they are tied to.

As an enterprise architect, you require all the configuration items to be related and tied appropriately to assess your business applications and estimate and evaluate the business capabilities of your enterprise.

1. Navigate to Application Portfolio Management > Administration > Desired State Audits or Scripted Audits.
2. Click the audit name.
3. Click Run Audit button.

Running the following audits helps you to:

- Identify the records that match the respective criteria.
- Create tasks to address the disparity in the records.
- Communicate to the owners of the IT business application, software model, and the business capability through an email notification to resolve the gap or certify the data.

To facilitate addressing these notifications and to access the applications data, the IT business application owners, software model owners, and the business capability owners are granted sn_apm.apm_user role. Users with this role can navigate to Compliance > My Follow On Tasks to update the data.

Hardware Models with no lifecycle data

The scripted audit retrieves records of hardware models that do not have lifecycle data but are used by an application service and are related to a business application. The audit generates tasks and sends email notifications to the hardware model owner.

Software Models with no lifecycle data

The scripted audit retrieves software model records used by the business applications that do not have lifecycle data such as lifecycle type, its phase, beginning and end dates of the lifecycle phase, and risk. The audit generates tasks and sends email notifications to the software model owner.

Note: The system checks only the lifecycle data for production instances of the business application. That is, it does not consider non-production instances such as development and test.
Note: The system checks for the lifecycle data only for production instances of the business application. That is, it does not consider non-production instances such as development and test.

Orphaned business capabilities

The scripted audit checks the CI relationship [cmdb_rel_ci] table for capabilities that have neither parent capability nor child capabilities, and capabilities without any business applications tied to it. A task is created and the owner of the business capability is notified through an email about the assigned task.

Business applications related to multiple business capabilities in the same hierarchy

The scripted audit checks the CI relationship [cmdb_rel_ci] table for a possibility where the same business application is tied to multiple business capabilities at the same level in the hierarchy. For example, BA1 is tied to Cap 1.1.2 and is also tied to Cap 1.1.2.1. You can understand the hierarchy level of the capability from the Business Capability [cmdb_ci_business_capability] table.

Business applications not related to any software model

The audit checks the CI relationship [cmdb_rel_ci] table for business applications that are not related to any software model. The scripted audit considers only the production instances of business services. A notification is sent to the IT application owner.

Note: The system checks only for production instances of the business application and does not consider non-production instances such as development or test.

Business applications not related to any business capability

The desired state audit checks the CI relationship [cmdb_rel_ci] table for business applications that are not related to any business capability.

Information Objects not related to any Business Application

The desired state audit checks the Information Object [cmdb_ci_information_object] table for information objects that are not tied to any business application. You can run such audits on demand. If there is any unrelated information object found, then a notification is sent to the owner of the information object mentioned in the Assign to field.

In addition, whenever a certification schedule either On Demand or Quarterly is executed a notification is shown on the Application Portfolio Management Home page. For each certification schedule that is executed a notification entry appears in the home page correspondingly. The notification shows certification instances that are open and are not complete 100%. Conversely, the Home page section does not display certification instances that are 100% complete and have not been generated at all.

Notifications are also shown for software models that are at high and moderate risks as on the current date and within the next 90 days. The risk factors of software models tied to business applications that are related to production instances are only considered. Click the notification to open the related records from the software model table.

The scripted and desired state audit results are also posted in the Notification section of the Application Portfolio Management Home page. Click the notification to open the related tasks or the related data certification tasks.
Management of business applications

A business application is software used by business users to perform a business function. Classify the applications to maintain an inventory and consolidate the business applications. Analyze, assess, and evaluate the applications across various dimensions and determine the action that you can take for each application.

You can record the details of a business application manually or import the list of applications from a spreadsheet or a third-party tool. To import data, define a data source and transform map, and run or schedule an import.

Assessment of Business applications

In APM, add any business application that you want to assess and track for costs, usage, business value, functional fitment, and risks.

Modeling platform applications and platforms

Use the Business Application form to create a record and capture the details of a platform application just as you create a record for a business application. Use the same form to create individual records of all business applications that run on the platform. This structure gives you a hierarchy of business applications associated to the platform host. The **Architecture type** field values help you to distinguish between the platform host and platform application data.

The architecture type values help in the following business cases:

- Assess the performance of the platform as a whole as well as assess the performance of individual applications running on it.
- Platform may be owned by a business owner who may not be the owner of the applications running on that platform. In such a scenario, the platform owner can assess the performance of the platform independent of the application owners, who assess the applications associated to the platform.

For example, you can create a business application record for ServiceNow® platform. Then, create individual business application records such as Application Portfolio Management, Financial Management, and Project Portfolio Management and associate these applications to ServiceNow® platform. The distinction between the records whether it is a business application running on a host or a platform hosting the applications lies in the **Architecture type** values of platform application and platform host.

Add or edit a business application

Use the Business application form to add the applications that your organization uses based on their functions and the business process they fulfill. In APM, add any business application that is used to assess and track costs, usage, business value, functional fitment, and risks.

If you have an APM user role (sn_apm.apm_user), use the Business Application Lifecycle Management services to request, add, or retire a business application.

Role required: sn_apm.apm_analyst

1. Navigate to Application Portfolio Management > Application Portfolio > All Business Applications.
2. Click New to add a new application or click the name of an existing application that you want to edit.
3. On the form, fill in the fields.

**Business Applications form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the business application.</td>
</tr>
<tr>
<td>Number</td>
<td>Unique, auto-generated identification number with a configurable prefix for the business application record.</td>
</tr>
<tr>
<td>Business process</td>
<td>Business process for which the application is used.</td>
</tr>
<tr>
<td>Portfolio</td>
<td>Name of the portfolio to which the application belongs.</td>
</tr>
<tr>
<td></td>
<td>This field appears when you activate the PPM Standard (com.snc.financial_planning_pmo) plugin.</td>
</tr>
<tr>
<td>Application type</td>
<td>Indicates whether the application is custom or commercial.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Homegrown</strong>: Application that is built in-house.</td>
</tr>
<tr>
<td></td>
<td>• <strong>COTS</strong>: Application is a commercial application purchased from another company.</td>
</tr>
<tr>
<td>Architecture type</td>
<td>Type of application architecture.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Client Server</strong>: Application structure that divides tasks between the service providers and service requesters.</td>
</tr>
<tr>
<td></td>
<td>• <strong>N-Tier</strong>: A multi-layered architecture where presentation, processing, and data management exist as physically separate layers.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Web-based</strong>: Applications accessed over a network connection.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Other</strong>: Any other type of architecture.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Platform Host</strong>: Hardware or software that hosts the business application.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Platform Application</strong>: Application that runs on a platform and can be associated to a host.</td>
</tr>
<tr>
<td></td>
<td>In this case, the business application relies on the platform for standard operations such as development tools, execution services, and data services.</td>
</tr>
<tr>
<td>Platform Host</td>
<td>A hardware or software that hosts the business application.</td>
</tr>
<tr>
<td></td>
<td>This field is required if you select the Platform Application value in Architecture type field.</td>
</tr>
<tr>
<td>Install type</td>
<td>Type of install.</td>
</tr>
<tr>
<td>Platform</td>
<td>Applications hosted by platform.</td>
</tr>
<tr>
<td>Business Unit</td>
<td>Attach a business application to the business unit organizational structure.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Department</td>
<td>Attach a business application to the departmental organizational structure.</td>
</tr>
<tr>
<td>Status</td>
<td>Operational status of the application.</td>
</tr>
<tr>
<td></td>
<td>Auditing is enabled and hence, whenever a user updates the value in this field, the Activities field in the Activities tab displays the update.</td>
</tr>
<tr>
<td>Application scoring profile</td>
<td>The profile used to calculate the application score for strategy.</td>
</tr>
<tr>
<td>Application category</td>
<td>The application purpose and function. Use this information to rationalize or consolidate applications.</td>
</tr>
<tr>
<td>Application family</td>
<td>A set of related applications that have a common platform or vendor.</td>
</tr>
<tr>
<td>Technology stack</td>
<td>Technology stack on which the application was built.</td>
</tr>
<tr>
<td>User base</td>
<td>Number of users using the applications.</td>
</tr>
<tr>
<td></td>
<td>Auditing is enabled and hence, whenever a user updates the record in this field, the Activities field in the Activities tab displays the update.</td>
</tr>
<tr>
<td>Active user count</td>
<td>Number of active users out of the overall user base. Auditing is enabled for the field.</td>
</tr>
<tr>
<td>Last change applied date</td>
<td>Date on which the application was last updated. Auditing is enabled for the field.</td>
</tr>
<tr>
<td>Description</td>
<td>Unique description of the application.</td>
</tr>
<tr>
<td>Contract</td>
<td>Vendor details of the application.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Vendor who currently supports the application.</td>
</tr>
<tr>
<td>Support vendor</td>
<td>Expiry date of the subscription contract or the support contract. Auditing is enabled for the field.</td>
</tr>
<tr>
<td>Contract end date</td>
<td>Expiry date of the subscription contract or the support contract. Auditing is enabled for the field.</td>
</tr>
<tr>
<td>Owners</td>
<td>Owner of the portfolio, typically from IT.</td>
</tr>
<tr>
<td></td>
<td>This field appears when you activate the PPM Standard plugin (com.snc.financial_planning_pmo).</td>
</tr>
<tr>
<td>Portfolio manager</td>
<td>Person who owns the application from the business side. Every application should have an assigned business owner.</td>
</tr>
<tr>
<td>Business owner</td>
<td>Person who owns the application from the business side. Every application should have an assigned business owner.</td>
</tr>
<tr>
<td>IT Application owner</td>
<td>Person who owns the application from the IT side.</td>
</tr>
<tr>
<td></td>
<td>The business application must have an owner assigned to it.</td>
</tr>
<tr>
<td></td>
<td>If you are designated as the IT Application owner, then you can view all the applications for which you are the owner in the My Applications menu.</td>
</tr>
<tr>
<td>Last updated by</td>
<td>Person who last updated the application record.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Supported by</td>
<td>User supporting the business application.</td>
</tr>
<tr>
<td>Support group</td>
<td>User group supporting the business application.</td>
</tr>
<tr>
<td>Compliance</td>
<td></td>
</tr>
<tr>
<td>Business criticality</td>
<td>How critical the application is to the business. Auditing is enabled for the field.</td>
</tr>
<tr>
<td>Emergency tier</td>
<td>Actions or plans executed for the application in an emergency situation.</td>
</tr>
<tr>
<td>Data classification</td>
<td>Security level for the data in the application. This attribute determines which Governance, Risk, and Compliance (GRC) policies are applicable to the application. Auditing is enabled for the field.</td>
</tr>
<tr>
<td>Certified</td>
<td>Status of the application that it meets requirements or complies with the policies of your organization.</td>
</tr>
</tbody>
</table>

4. Click **Submit** or **Update**.

5. To view the roadmap of the business application and its related data, click the **View Application Roadmap** button.

6. To get all the available and significant information of a business application, click the **Application 360** button.

7. To know the application cost in the last period, manage application cost as percentage of total spend, determine its future trend, and provide a cost-effective business application, click Application TCO button. See **Application TCO**.

   **Note:**

   The link to Application TCO dashboard works when you use the preconfigured **Business Application Costing** cost model. The integration works when you activate the Application Portfolio Management plugin (com.snc.apm). This plugin activates Financial Management For APM (com.snc.financial_management_for_apm) plugin, which in turn activates Performance Analytics – Content Pack – Application Portfolio Management (com.snc.pa.apm) plugin.

8. To raise a demand for the business application, click the **Create Demand** button. The Demand form that opens up populates the related business application in the **Business Applications** field.

9. To retrieve software models associated to the business application, click the **Manage Technology Models** button. It also retrieves the log of software models that the software models suggestion engine retrieved when the scheduled job was last executed.

10. To navigate to the timeline view of the business application and to view the timeline of all its associated epics, stories, enhancements, other stories, projects, and demands, click the additional actions icon (≡) and configure UI actions to display the **View Application Backlog** button. Click the button to go to the Application backlog view of the timeline.

   For more information on this timeline view, see **Application Backlog view**.

To have a complete view of the business applications, click the **Application 360 dashboard**.
Business application relationship with CIs for application information

Business application is a new CMDB CI class. You can create relationships between the business application and other CIs. Functionally, two applications can be integrated or connected to each other to establish a relationship between them. You can relate your business applications to other infrastructural CIs like database and web servers.

To get reports about a business application, there must be an association between the application and the CIs that make up the application. Hence, business applications have to be integrated with the other CIs to examine the CI and its relationship from a CI relation formatter.

CMDB dependency views

Dependency view graphically displays an infrastructure view for a configuration item (CI) and the business application or business services that it is part of and that it supports.

In APM, you can see the dependency views by clicking the show dependency views icon ( ) in the related items of the Business Application form.

In addition to the existing APM-specific configuration items based on references versus relationships, a relationship is established between the Business Capability configuration item and the Business Application configuration item. A reference is also created between the Parent related field attribute of the Business Capability table [cmdb_ci_business_capability] and the Platform Host related field attribute of the Business Application table [cmdb_ci_business_app].

To view the mapping of the related items, navigate to Dependency Views > Map Related Items. The table provides a list of configuration items that are related to each other by a referenced related field, because of which the dependency view is rendered.

Integrate with Governance, Risk, and Compliance to identify application risks and controls

Application Portfolio Management (APM) integrates with Governance, Risk, and Compliance (GRC) to help identify and assess risks on business applications.

Role required: admin

Using GRC application, you can analyze the risks associated with assets such as hardware, software, and business application. You can also identify and test controls associated with those risks as well as look at the audits that were conducted on those assets. This analysis helps the application owners to understand the risk of the business application effectively.

The application owner can identify significant risks and compliance issues that the business applications are exposed to, without having to engage an external auditing system and run the applications through the auditing process.

Activate the following plugins to integrate APM with GRC.

1. Navigate to System Definition > Plugins.
2. Install the GRC: GRC Profile Dependencies (com.snc.grc_profile_dep) plugin.
3. Install the GRC: Vendor Risk Management Dependencies (com.snc.grc_vrm_dep) plugin.
4. Install GRC: Policy and Compliance Management Dependencies (com.snc.grc_policy_dep) plugin. This also requires installation of app-compliance from the ServiceNow app store.

**Note:** The integration also requires certain applications that should be installed from the ServiceNow app store. See Request apps on the Store for instructions to download and activate them.

Create an entity referencing the business application. Attach the entity to an audit.

**Create an entity for audit referencing business application**

Create an entity with reference to the business application table and its specific application record. Use the entity to scope risk exposure and perform risk assessments on business applications.

**Role required:** sn_audit.admin or sn_audit.manager

GRC uses the term, *entity*, instead of profile. An entity can be anything such as a database, server, or a business application that can be audited.

1. Navigate to **Audit > Scoping > All Entities**.
2. Click **New**.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the profile.</td>
</tr>
<tr>
<td>Owned by</td>
<td>Owner of the profile.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Business application table where all the business application records are stored.</td>
</tr>
<tr>
<td></td>
<td>In the dialog box that opens up, enter the business application table in the <strong>Table name</strong> field and the business application record in the <strong>Document</strong> field.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to activate the entity.</td>
</tr>
<tr>
<td>Class</td>
<td>Profile class to which the application belongs.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

For more information, see:
- Create a profile.
- Establish profile types, profile classes, and profiles.

**Associate a risk to the entity**

Attach the entity to a risk and create a risk record. Assess and identify risks that can adversely affect your business applications.

**Role required:** sn_risk.admin and sn_risk.manager

1. Navigate to **Risk > Risk Register > All Risks**.
2. Create a risk in the Risk form.

See: Create a risk manually.
Add business application entity to an engagement

The entities are assessed and evaluated for audit engagement. After which the entities that are scoped for audit engagement and validated are associated to an audit.

Role required: sn_audit.manager or sn_audit.admin

To add a business application entity to an engagement, you should have created an entity referencing the business application in the Entity field of the Entity form. See: Create an entity for audit referencing business application.

1. Navigate to Audit > Engagements > All Engagements.
2. To add the business application entity to the engagement, click Add button in the Entities related list.

Add a control to the business application entity

Associate a control to a business application entity that might be at risk. It is mandatory that you set effective control on the business applications to mitigate risks and protect your business. As you upgrade your business applications, you can replace your outdated controls.

You should have created an entity before associating a control to it. Controls are created in GRC.

To create a control and add an entity to the control, see Create a control.

- The entity that you select from the Controls [sn_compliance_control] table must be a business application and the entity Class of the record must be application.
- The control record can be either in the Draft or Retired state. However, controls in such states are not visible in Application Portfolio Management to be associated to a business application.

View Governance, Risk, and Compliance risks and engagements for business application

As an application owner, you can view the risks that a business application is exposed to. Governance, Risk, and Compliance (GRC) audits the business application entity and the audited risks and engagements are captured as scripted related lists in the business application form.

Role required: sn_apm.apm_user, sn_apm.business_stakeholder_apm_user

1. Navigate to Application Portfolio Management > Application Portfolio > All Business Applications.
2. Click GRC Risks related item.
3. View the name of the risk statement, its description, the category of risk (legal, financial, operational, and so on), inherent impact that indicates the levels of risk, and inherent likelihood that indicates the likelihood of the risk occurring.

See: Manage risks, risk statements, and risk frameworks

4. Click Engagements related item.
5. View the name of the engagement, the user to whom it is assigned, the state in which the engagement is, planned start date on which the activity should begin, its end date, the percentage of engagement completed, and the actual cost of the engagement.

See: Manage engagements

6. Click Controls related item.

7. View the name of the control, its owner, status of the control whether it is compliant or not, the classification of the control whether it is preventive, corrective, or detective, and the attestation frequency at which the scheduled job runs.

See: Manage controls
8. Click display/hide hierarchical lists arrow beside a risk record in the GRC Risks related list to view all the controls that you have associated to the risk of the business application.

When you associate a control to a risk, the control with its associated risk is created in Risk to Control [sn_risk_m2m_risk_control] table.
View business application roadmap

Use the graphical, high-level overview of the application roadmap to view the investments made in the business application.

Note: Activate PPM Standard (com.snc.financial_planning_pmo) plugin to view the business application roadmap.

The projects and demands must be tied to business applications for the investment portal view to work.

Role required: sn_apm.apm_user

The application roadmap takes you to an investment portal of the business application. The portal is exclusive to Application Portfolio Management.

1. Navigate to the Application Roadmap using one of the following options:
   - To view the roadmap of any specific business application, navigate to Application Portfolio Management > Application Portfolio > All Business Applications.
     a. Click the name of the business application to open it in form view.
     b. Click the View Application Roadmap button to open the business application record within a portal with all its investment details.
• To view the roadmap of the applications that you own, navigate to **Application Portfolio Management > Application Portfolio > My Applications Roadmap.**

### Application roadmap in an investment portal

2. Use the widgets on the top panel to view the following details:
   - The total number of investments planned on the business application, which also indicates the number of projects and demands separately.
   - The total number of projects and demands that impact the business application in the current and future fiscal years.
   - The color-coded status of the projects and demands indicating high, medium, and low risks correspond to the colors red, yellow, and green, respectively.
3. To configure the view in the portal, click the configuration widget

a) Select the check box in the ITEM COLUMNS to add the columns that you require. Clear the check box to remove columns from the portal view.

4. To save your configurations, click the save icon

Your preferences are set when you open the investment portal the next time to view the application roadmap. The settings are retained not only for the original business application for which you configured, but also for any other business application that you open.

5. Use the **Overview** tab to view the:
   - Names of the projects and demands the application is tied to.
   - Program that the projects and demands are part of. Projects and demands may or may not be associated to a project.
   - Business units to which the projects and demands are attached.
   - Business capabilities to which the projects and demands render support.
   - Strategies and goals of the projects and demands.
   - Planned start and completion dates.
   - Overall status of the projects and demands.

6. Use the **Timeline** tab of the portal to view the timeline in a:
   - Grid view that shows start and end dates, possible risks, and issues.
   - Gantt view that indicates the schedule of the projects and demands.

**Suggestions to relate technology models to an application service**

Use the software models that the suggestions engine identifies and relate them to your application service, instead of manually searching and mapping them.

The business applications used in your organization consume application services to fulfill a business capability for the business enterprise.

- Various application instances of a business application run on hardware that require necessary software models to provide the business capability.
- A cmdb relationship establishes an association between the business application and the application service. But then, an application owner is required to manually associate an application service to a software model.
- For the association to be precise, your software model data for the business application must be maintained up-to-the-minute.

To avoid manual intervention and prevent association to a software model that has non-current data, the software model suggestion engine suggests possible software models to an application service. You can use the suggested software models, select those models that are appropriate, and associate them to your application services. This suggestion helps you to configure and maintain software model data for your business applications.
Working model of the software model suggestions engine

The software model suggestions engine:

- Scans hardware configuration items consumed by Application Services. A CMDB API retrieves all hardware CIs for an application service, and a Service Mapping API retrieves the hardware CIs for application service.
- Retrieves the new software models installed on the hardware since the last run of the scheduled job.
- Populates the Retrieved Software Models [sn_apm_service_software_model_suggestion] table with the discovered software models.
- Evaluates and compares the current software model suggestions status with the previous extracted suggestion results from the last run in the Technology Models Retrieval Logs [sn_apm_suggestion_engine_run_log] association table.
- The Technology Models Retrieval Logs [sn_apm_suggestion_engine_run_log] table also stores the count of hardware models on which the application service is running.
- Updates status accordingly as New, Associated, Ignored, or Deleted.

Associate suggested technology models to an application service

As an application owner, you can run the software model suggestions engine to fetch software models. These models can be related to an application service instead of mapping them manually.

Role required: sn_apm.apm_user

The APM user has read-only permission to access the following tables:

- Hardware [cmdb_ci_hardware]
- Hardware Model [cmdb_hardware_product_model]
- Hardware Model Lifecycle [cmdb_hardware_model_lifecycle]
- Software Discovery Model [cmdb_sam_sw_discovery_model]
- Software Installation [cmdb_sam_sw_install]
- Software Model [cmdb_software_product_model]
- Software Model Lifecycle [sam_sw_model_lifecycle]

1. Navigate to Application Portfolio Management > Application Portfolio > All Business Applications. You can follow one of the following options:
   - Right-click the name of a business application and click Manage Technology Models option.
   - Click the name of the business application to open the record in the form view. Then click Manage Technology Models button.

2. Right-click the application service record in the Technology Models Retrieval Logs list.

3. Click Fetch Product Models option.

4. To fetch all the hardware models on which the business application runs, select the Hardware Models Only check box in the Fetch Product Models pop-up that opens. The technology models suggestions engine retrieves only the hardware models.

5. To fetch all the hardware and the software, select the Hardware and Software Models check box.

Note:

The Hardware and Software Models check box appears when you activate Software Asset Management Professional (com.snc.samp) plugin.

The hardware product models that are associated to the application service are listed in the Application Service Hardware Models [sn_apm_tpm_app_service_hardware_model] mapping
table. The Technology Models Retrieval Logs [sn_apm_suggestion_engine_run_log] table lists the number of hardware models on which an application service runs. The software models associated to the application service are listed in Application Service Software Models [sn_apm_tpm_service_software_model] database table.

By default, the technology models suggestion engine checks only the hardware and hardware installed with new software installs since the last run of the job. However, if you require the engine to check all hardware irrespective of its last run, then enforce a check on all installs.

6. Select the **Force Check All Installs** check box to check all hardware irrespective of the check until the last run of the job.

The engine retrieves different application instances for that business application.

**Force Check All Installs** option also scans and suggests updated software models when there are variations in the mapping between the discovery model and the software models. Variations occur when the software models are either updated manually or through normalization rules.

7. Click **OK**.

In the Technology Models Retrieval Logs list, you can view the:

- Progress of the engine in the **Percent Complete** column corresponding to the application service record. A message, *Progress Worker to Fetch models is submitted successfully for Attendance Management Service* is also displayed at the top.
- Number of the software models that the engine suggests in the **Software Model Suggestions Count** column.
- Number of hardware models on which an application service runs in the **Hardware Model Count** column.

8. Check the **Status** for the selected application service. The **Percent Complete** should be 100%. Or, click the information icon (i) to view the log status of the application service.

9. Click the application service record in the Technology Models Retrieval Logs list view.

**Retrieved Software Models** tab lists all the software models retrieved from the associated hardware of the application instance in the Technology Models Retrieval view. You can also view the total number and names of the software models that the engine suggests associating with the application service.
10. Select the check box adjacent to the software model and click **Associate Software Models** action from the **Action on selected rows** list to associate the software model to the application service.

The status of the software model changes to **Associated**. A record is created in the Application Service Software Models mapping table. You can also view the associated software models in the **TPM timeline** view.

When you run the job for the first time, all the extracted software models are in status **New**. However, the status of the suggested software model changes based on the actions taken on the previous run of the job.

In the Actions choice list below the software model list, you can select an action.

**Status of the Software models**

<table>
<thead>
<tr>
<th>First run of the job</th>
<th>Second run of the job</th>
<th>Conditions of association</th>
<th>New status of the software model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Found</td>
<td>Found</td>
<td>Yes</td>
<td><strong>Associated</strong>: Associates the selected software model to the application service. The status is prefixed with a green bubble. In the subsequent run of the job, these software models are still in Associated state. You may choose to dissociate the software model if it has been removed or uninstalled from the hardware on which the application service runs.</td>
</tr>
<tr>
<td>Found</td>
<td>Found</td>
<td>No</td>
<td><strong>Ignored</strong>: If no action is taken on the software models in the prior run of the job, then they are identified as <strong>Ignored</strong> (prefixed with a gray bubble) in the current run of the status.</td>
</tr>
<tr>
<td>Not found</td>
<td>Found</td>
<td>Not applicable</td>
<td><strong>New</strong>: The software models that are identified in the first run of the job, and those software models that have been added after the last run but before the current run are marked with status <strong>New</strong> prefixed with a yellow bubble. You can associate or dissociate such software models.</td>
</tr>
<tr>
<td>First run of the job</td>
<td>Second run of the job</td>
<td>Conditions of association</td>
<td>New status of the software model</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------</td>
<td>---------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>Found</td>
<td>Not found</td>
<td>Yes</td>
<td><strong>Delete</strong>: You can delete a software model that is in Associated, Ignored, or New status. This action deletes the software model from the list of the retrieved software models, which is Retrieved Software Models [sn_apm_service_software_model_suggestion] table but not from the Application Service Software Model [sn_apm_tpm_service_software_model] table.</td>
</tr>
</tbody>
</table>

| Found                | Not found             | No                        | Delete |

11. Click the **Application Service Software Models** tab to view the list of software models associated to the application service. To delete an application service software model record, select the record to mark for deletion and click delete in the **Action on selected rows** list. To associate an application service to a software model, see **Associate an application service to a software model**.

12. Click the **Application Service Hardware Models** tab to view the hardware product models that are associated to the application service. The Application Service Hardware Models [sn_apm_tpm_app_service_hardware_model] mapping table stores the data. To associate an application service to a hardware model, see **Associate an application service to hardware model**.

**Monitor business applications with the application landscape dashboard**

View the application landscape dashboard for an overview of all the applications used in your business enterprise. The dashboard provides pre-configured reports on applications, grouped by categories. You can also configure and add reports.

You must have the Performance Analytics – Content Pack – Application Portfolio Management (com.snc.pa.apm) plugin activated to use the Application landscape dashboard.

Role required: sn_apm.apm_user

On the dashboard, you can view the following reports:

- Top 10 applications actively used, grouped by application category and application family.
- Applications grouped based on install type, platform, application category, manufacturer, technology stack, and so on.
- Details of number of applications by category versus the manufacturer details.
- Number of applications by application category versus the age of the applications.

- Navigate to **Application Portfolio Management > Application Portfolio Analysis > Landscape Analysis**.

To modify the data and generate charts based on **Portfolio, Application Category, Install Type, Application Type, Business Process**, and **Business Unit**, make the appropriate selections from the dashboard filters.

**Note:**
Activate PPM Standard (com.snc.financial_planning_pmo) plugin to apply the portfolio filter.

To save a chart in JPG or PNG format, point to the chart and then select the appropriate option from the menu that appears.

Business Application Lifecycle Management services

You can order a business application for your enterprise like any other service catalog item and register it as a new application in the application portfolio.

Application Portfolio Management (APM) integrates with Service Catalog to create a service catalog category called Business Application Lifecycle Management Services.

Use this service catalog category to request and register a business application in APM. As you on-board a new application into the APM inventory, the machine-learning business application solution predicts and suggests an appropriate category for the application. For more information, see Predictive Intelligence for Application Portfolio Management.

Furthermore, you can also use this service catalog category to request a review of a technology change in the business application with the IT Architecture Review Board.

You can also use the business application lifecycle management service catalog to decommission an application that you no longer require. Proper decommissioning of an application takes care of:

- Archival of data generated when the application was in use.
- Uninstall all related software that the application depended on.
- Removal of any hardware dependency for the software.

Use Business Application Lifecycle Management to request or retire an application

If you are an APM user, you should use the Business Application Lifecycle Management services to request or register a new business application for your business. You can request a business application like you place an order for any other service catalog item.

Role required: sn_apm.apm_user

The base system also offers Register a Business Application as a service to all Now Platform customers. The Application Portfolio Management Core plugin (com.snc.apm_core) provides this service and the plugin is available on new and restarted instances. Customers who do not have the Application Portfolio Management application can avail this service to request a new business application. However, activating the Application Portfolio Management plugin (com.snc.apm) enhances this service to predict and set application category using the machine-learning solution.

For more information on the plugin, see Activate Application Portfolio Management. See Predictive Intelligence for Application Portfolio Management to know more about machine-learning solution for business applications.


   Business Application Lifecycle Management Services opens in a service catalog page.

2. Click the Register a Business Application card or click View Details in the Register a Business Application card to register a new business application.

3. Enter the details in the Register a Business Application form.

   Name of the business application is mandatory. Mandatory fields have a red asterisk (*) beside them.
4. Click Submit.
The system validates your request to check if a business application with the same name exists. If yes, then an error message is displayed. If no, then a flow is triggered and a request to register a business application is created.

Once the approver approves your request and the requested business application is created as a record in the business application table, you are notified through an email.

5. To retire a business application that you no longer require, click the Retire a Business Application card or click View Details in the Retire a Business Application card.
a) Select the name of the application from the list of values in the Retire a Business Application form.

**Conditions to retire a business application**
- Only if you are an IT owner of the application, business owner, or a user who supports the application, you can request to retire an application.
- You require sn_apm.apm_user or sn_apm.apm_analyst role to retire a business application.
- As an APM user, you cannot delete a business application record or mark the application as Inactive. However, you can raise a new request to decommission an application.
- The business application that you choose to retire must not be in Retired status nor the application record False (inactive) in the Active field.

b) Click Submit.

**Manage Business Application Lifecycle Management service requests**
You can approve requests raised by an APM user either for a new business application or retire an application that the user no longer requires.

Role required: sn_apm.apm_analyst

To approve a Register a Business Application service request, user must be a part of Business Application Registration Approval Group. To approve a Retire a Business Application service request, user must be a part of Enterprise Architect Group.

To add or modify the members in the group, navigate to Application Portfolio Management > Administration > Services Approval Group.

1. Navigate to Application Portfolio Management > Business Application Lifecycle Management > Service Requests.
   All requests related to the Business Application Lifecycle Management services are stored as tasks in the Business Application Requests table [business_app_request].
   
   Note the tasks that are in your queue for your approval.
2. Click the task number.
3. Scroll down to the Approvers related items.
4. Click the state of the approval task.
5. Select the appropriate state from the list in the State field.
6. Enter a comment if required.
7. Click Update.
   Once you approve or reject a request, a corresponding flow is triggered. Click the Show flow engine context related link to view the flow engine context of the request. You can also navigate to
If you approve a Register a Business Application request

- The approved business application is created as a record with an identification number in the business applications table [cmdb_ci_business_app]. The status of the application is in the Implementing state.
- An email is sent to the requester notifying the approval of the business application.

If you approve a Retire a Business Application request

- Based on the value selected in the system property, `sn_apm.retireBusinessApplicationTaskType`, a project or demand is created. If the value is set as project, then a project template defined in the system property, `sn_apm.retireBusinessAppProjectTemplate`, is applied.

The base system of Application Portfolio Management offers a project template called Retire Business Application with eight different pre-defined project template tasks for proper decommissioning of the application.

After the project is created and a project manager is assigned to the project, the project manager can review, edit, or add tasks as required. For more information on project templates, see Project templates. To understand the project tasks, see Project tasks.

- If the value in the `sn_apm.retireBusinessApplocationTaskType` system property is set as demand, then a demand is created.

Unlike a project, APM does not generate a demand from a template with pre-configured demand tasks. Instead the demand is created with certain values auto-populated in mandatory fields.

To view the demand that is created to retire an application, navigate to Application Portfolio Management > Application Portfolio Analysis > Demands.

Mandatory fields in the Demand form:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>Retire Application.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the business application to be retired.</td>
</tr>
<tr>
<td>Category</td>
<td>Operational.</td>
</tr>
<tr>
<td>Type</td>
<td>Project.</td>
</tr>
</tbody>
</table>

- If you approve a request for which a project or demand is already in place, then another project or demand will not be created for the request.
- If the request to retire an application is rejected, then an email notification is sent to the requester. However, the status of the business application is not updated irrespective of it being approved or rejected.
- You can delete a business application record or mark an application as Inactive as an APM admin or analyst.
Use Business Application Lifecycle Management to request an architecture review

You can request a review of your new architecture design proposal on the technology of a business application by presenting it to the architecture review board.

Role required: sn_apm.apm_user

As an application owner you can propose a modification to the underlying technology of a business application, modification to network design, or propose a new service, solution, or hardware standard.

Your design proposal is reviewed by a team of enterprise architects forming an Architecture Review Board with goals to:

- Align development with IT strategies.
- Improve the product quality through the design review process.
- Provide guidance on recommended practices for specific design questions.
- Act as a referral team for security, performance, UI design to review upcoming features that may be impacted.

2. Click the Request Architecture Review link or View Details in the Request Architecture Review card to request an architecture review.
3. On the form, fill in the fields.

   Name of the business application is mandatory. Mandatory fields have a red asterisk (*) beside them.

   Note:
   You must be the business owner, IT Application owner, or one who supports the application to request an architecture review.

Request Architecture Review form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Application</td>
<td>Name of the business application for which an architecture review is requested.</td>
</tr>
<tr>
<td>Project</td>
<td>Project that you can tie to this business application for which the architecture review is requested.</td>
</tr>
<tr>
<td>Short Description</td>
<td>A short description explaining the reason for the architecture review.</td>
</tr>
</tbody>
</table>
| Architecture Review Requested Date | Date to hold the architecture review.  
The architecture review date must be in the future.  
You can attach blueprints or supporting documents for the review. |
4. Click **Submit**.

On submission, an approval request is sent to the members of the Enterprise Architect Group. An email notification is sent to you as soon as your request is approved by the review board. You shall be notified even if your request is rejected.

**Approve architecture review requests**

You can approve an architecture review request if you are part of the Enterprise Architect Group.

Role required: sn_apm.apm_analyst

To approve an architecture review request, user must be a part of Enterprise Architect Group. Any user added to this group gets the sn_apm.apm_analyst role.

To add or modify the members in the group, navigate to **Application Portfolio Management > Administration > Services Approval Group**.

1. Navigate to **Application Portfolio Management > Business Application Lifecycle Management > Service Requests**.
2. Click the task number.
3. Scroll down to the Approvers related list and click the state of the approval.
4. Select **Approved** or **Rejected** in the **State** field.
5. Click **Update**.

The requester receives an email notification once you approve or reject an ARB request. An automated flow designer process is also created. You can navigate to **Application Portfolio Management > Administration > Services Flow Designer** to see the flow.

**Application assessment**

Set up indicators to measure the usability, cost, quality, performance, and risk of applications. Evaluate and score your business applications based on qualitative inputs. You can translate abstract information of applications based on surveys and assessments into more tangible concrete metrics. These assessments help you make strategic decisions on whether to replace or upgrade applications.

You can use existing assessment metric types or configure them per your requirements.

**Framework setup for application assessment**

You can create indicators and score profiles based on which you can assess your applications. Application indicators are business metrics that help derive application scores.

Application Portfolio Management is integrated with key applications in the ServiceNow platform to provide a deep insight into the applications. These integrations help you:

**Identify cost saving opportunities**

The Hierarchy of Segments in the Financial Management application tracks the cost allocations at the application level, which provides a complete cost breakdown for the application.

**Organize applications to determine their rationalization**

You can identify multiple applications assigned to the same application category, region, or business. This information helps you to know who is using the applications, the usage frequency, the application status, and make informed decisions.

**Identify opportunities for modernizing and investing in application**
You can identify applications that have contracts to renew, low usage, or low customer satisfaction based on surveys results.

Use the preconfigured indicators or create your indicators to assess applications with dimensions such as cost, quality, technical risk, investments, user satisfaction, and business value. Preconfigured indicators are sourced from Financial Management, IT Service Management, project portfolio management, surveys, assessments, SQL queries, performance analytics, and custom scripts.

Note: APM supports only the Fiscal Calendar type, Standard.

Create or edit an indicator to assess an application

Application indicators are business metrics that assess the applications across dimensions such as cost, quality, technical risk, investments, user satisfaction, and business value.

Role required: sn_apm.apm_admin

Each indicator periodically captures related application data which is used to calculate the application score. The assessment of applications is done on an extensible framework, which is based on the various configured indicators. If you require indicators other than the preconfigured ones to calculate the application score, then you can create an indicator based on your business requirements.

1. Navigate to Application Portfolio Management > Administration > Application Indicators.
2. Click New or click an existing application indicator to edit.
3. On the form, fill in the fields.

### Indicator form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the application indicator.</td>
</tr>
<tr>
<td>Unit</td>
<td>A number, currency, time, duration in minutes, hours, days, month, or quarter, or rate. You can also create units as per your requirements.</td>
</tr>
<tr>
<td>Frequency</td>
<td>Frequency determines the interval at which the data for the indicator source should be collected. The Frequency field is not available when Performance Analytics is selected from the Data source list.</td>
</tr>
<tr>
<td>Target maximum</td>
<td>Maximum value for the indicator. The Target maximum field is not available when Assessments is selected from the Data source list.</td>
</tr>
<tr>
<td>Active</td>
<td>Select the Active option to enable the indicator.</td>
</tr>
<tr>
<td>CI Class</td>
<td>CI type for which the score is generated.</td>
</tr>
<tr>
<td>Direction</td>
<td>Business application with maximum or minimum values. Select Minimize if lower values are better. Select Maximize if higher values are better.</td>
</tr>
<tr>
<td>Target minimum</td>
<td>Minimum value for the indicator. The Target minimum field is not available when Assessments is selected from the Data source list.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Short description</td>
<td>Short summary of the application indicator.</td>
</tr>
<tr>
<td>Datasource Configuration</td>
<td><strong>Data source</strong>&lt;br&gt;Defines the location from which the indicator receives data.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Performance Analytics</strong>: Collects scores from indicators created in Performance Analytics. See Performance Analytics indicators.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Custom Script</strong>: Allows you to write a script that collects data from another application. Beneath the <strong>Data Source</strong> field, a sample script appears. Customize the script as needed.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Query Condition</strong>: Allows you to select a table to run filters on to obtain data.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Assessments</strong>: Allows you to evaluate, score, and rank records by assessing records in a table. See Create metric types and generate assessable records. To view results of survey assessments within APM, see Generate survey assessments and view results within APM.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Indicators</strong>: Allows you to add dependent child indicators. Through the child indicators, data is gathered to the parent indicator. For example, if the parent indicator is number of issues, the dependent indicators can be number of incident counts, number of problems, and changes. These dependent indicators are child indicators and the number of incidents, problems, and changes recorded are consolidated up to the parent indicator as the number of issues.</td>
</tr>
</tbody>
</table>

**Indicator**<br>The **Indicator** field appears when **Performance Analytics** is selected from the **Data source** list. Indicators are statistics that are used to measure current conditions and forecast trends.

![Note: If the collection frequency of the application indicator is not greater than the frequency at which the data of the Performance Analytic indicator are generated, then the system displays an error message: Frequency of the indicator must always be greater than or equal to the frequency of the datasource configuration indicator.](image)

**Default breakdown**<br>Name of the Performance Analytics breakdown.
4. Click **Submit**.

5. To regenerate the indicator score of an application, click open an indicator.
   a) Click the **Regenerate indicator score** option in the context menu.
      The action deletes the existing scores and generates new scores instead of just updating the existing scores for that indicator. This indicator may be attached to one or more scoring profiles, and therefore recalculates the scores of all business applications that are associated to this scoring profile.
   b) Select the Fiscal Period in the Regenerate application indicator scores dialog box.
   c) Click **OK**.
   d) Click **Update**.

6. To create a dependent indicator, click open the indicator.
   If you had selected Indicators in the **Data source** field, when you open that indicator record, the Indicator Dependencies related list is displayed.
   
   **Note:** An indicator which has its data source as indicator cannot be added as a dependent child indicator.
   
   a) Click **New** in the Indicator Dependencies related list. The parent indicator auto-populates in the Parent Indicator field.
   b) Select a dependent indicator in the **Child Indicator** field.
   c) Click **Submit**.

7. To assess the business application, click **Generate Assessments**.

   Use the preconfigured indicators to assess the applications based on cost, quality, and risk.

   **Generate survey assessments and view results within APM**
   Within APM you can assign an assessment questionnaire to a user who uses a business application and get the feedback about the application.

   Role required: sn_apm.apm_admin
APM integrates with Assessments and Surveys to evaluate business applications and business capabilities based on assessment metric types. Application indicators that are sourced from assessments can only be assessed using the assessment metric.

An **assessment metric** is a trait or value that is used to evaluate a business application. Related metrics are grouped under an **assessment metric category**, which can be used to evaluate business applications for that category only. Whereas a **metric type** can comprise many metric categories that define a set of criteria an organization uses to evaluate its business applications.

For example, an organization may employ assessment metric types such as customer satisfaction, business value, technical risk, and functional fit to evaluate its business applications. Further, the organization can assess a group of business applications based on one assessment metric category, such as CSAT category for customer satisfaction. Within this CSAT category, you can define an actual assessment metric such as a question in an assessment questionnaire, **How likely is it that you would recommend this application to others?**

Your business application is the assessable record and it is linked to a metric type. Use the custom UI to set conditions based on the columns of the business application table that meet your criteria and filter the applications. Select either a user group or selective users as target assessors and send out the questionnaires for them to take the survey. View the assessments and their status in the **Assessment Instances**, and the results in the **Metric Category Results** tabs of the **Indicator** related lists.

1. Navigate to **Application Portfolio Management > Administration > Application Indicators**.
2. Click open an indicator whose data source is assessments.
3. Click the **Generate Assessments** button.
4. To filter the business applications that should be assessed, set your conditions in the **Field**, **Operator**, and **Value** fields of the condition builder in the Generate Assessment UI that opens up.
Generate Assessment

Conditions

Table  Business Application

Preview

All of these conditions must be met

AND

Active is true

Application type is COTS

OR

AND

OR

New Criteria

Select Target Assessors

By User Group  By User Field

[U] All Users

Available

Antoine Thierauf
Application Portfolio Analyst
Approver User
Aqib Mushtaq
Armando Kolm
Armando Papik
Arya Hajarha
Ashley Leonesio
Asset Manager
ATF Change Management
ATF User

Selected

Abel Tuter
Application Portfolio Administrator
Application Portfolio User
Your filter criteria are applied on all records in the business application [cmdb_ci_business_app] table and you can filter applications by any column of the table.

5. To add dependent condition, click AND or OR next to the condition.

6. To add a top-level condition or multiple filter criteria, click the New Criteria button.

7. To clear existing filter conditions and set a new condition, click the Clear All button.

8. Select users in the Select Target Assessors region to send the assessment questions.

You can either select a user group or move individual application users to the Assessors list.

9. Click Send Assessments.

10. Click OK to confirm in the Send Assessment dialog box.

The user can view and take the assigned assessments by navigating to Self-Service > My Assessments & Surveys.

For more information, see Take a survey.

After the user submits the assessments, the State of the assessment instance in the Assessments Instances tab changes to Complete.

11. Click the Assessments Instances tab to view the instances of assessments that have been created, the total number of assessments that have been sent out to users who fit in the filter criteria, and the status of the assessment instances. Each occurrence of a questionnaire assigned to one user is an assessments instance.

Note:
Indicator score and the corresponding application score are calculated only when all the users in the assessment group have completed the assessment.

12. Click the Metric Category Results tab to view the weight, rating, and normalized value of each business application that was assessed by the user or the user group. See View an assessment category result to know how the assessment results are calculated.

Preconfigured indicators and their source applications

The preconfigured Application Portfolio Management indicators and the applications they have been sourced from help you to assess the applications across dimensions such as cost, quality, and risk. You can create additional indicators, apart from the preconfigured indicators, by copying and modifying them.

<table>
<thead>
<tr>
<th>Indicator name</th>
<th>Frequency</th>
<th>Type</th>
<th>Source</th>
<th>How is it calculated?</th>
<th>Description</th>
<th>Jobs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Facilities cost</td>
<td>Quarter</td>
<td>Custom Script ITFM product. ITFM_Allocation table</td>
<td>Data will be available in the ITFM tables only after the financial modeling process is completed</td>
<td>Facilities cost for business application</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Indicator name</td>
<td>Frequency</td>
<td>Type</td>
<td>Source</td>
<td>How is it calculated?</td>
<td>Description</td>
<td>Jobs</td>
</tr>
<tr>
<td>----------------</td>
<td>-----------</td>
<td>---------------</td>
<td>---------------------------------------</td>
<td>---------------------------------------------------------------------------------------</td>
<td>-------------------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>Hardware cost</td>
<td>Quarter</td>
<td>Custom Script</td>
<td>ITFM product. ITFM_Allocation table</td>
<td>Data will be aggregated in the ITFM tables only after the financial modeling process is completed</td>
<td>Hardware cost for business application</td>
<td></td>
</tr>
<tr>
<td>Labor cost</td>
<td>Quarter</td>
<td>Custom Script</td>
<td>ITFM product. ITFM_Allocation table</td>
<td>Data will be aggregated in the ITFM tables only after the financial modeling process is completed</td>
<td>Labor cost for business application</td>
<td></td>
</tr>
<tr>
<td>Other cost</td>
<td>Quarter</td>
<td>Custom Script</td>
<td>ITFM product. ITFM_Allocation table</td>
<td>Data will be aggregated in the ITFM tables only after the financial modeling process is completed</td>
<td>Other cost for business application</td>
<td></td>
</tr>
<tr>
<td>Services cost</td>
<td>Quarter</td>
<td>Custom Script</td>
<td>ITFM product. ITFM_Allocation table</td>
<td>Data will be aggregated in the ITFM tables only after the financial modeling process is completed</td>
<td>Services cost for business application</td>
<td></td>
</tr>
<tr>
<td>Software cost</td>
<td>Quarter</td>
<td>Custom Script</td>
<td>ITFM product. ITFM_Allocation table</td>
<td>Data will be aggregated in the ITFM tables only after the financial modeling process is completed</td>
<td>Software cost for business application</td>
<td></td>
</tr>
<tr>
<td>Indicator name</td>
<td>Frequency</td>
<td>Type</td>
<td>Source</td>
<td>How is it calculated?</td>
<td>Description</td>
<td>Jobs</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------</td>
<td>--------------</td>
<td>------------</td>
<td>------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Application TCO</td>
<td>Quarter</td>
<td>Custom Script</td>
<td>ITFM product. ITFM_Allocation table</td>
<td>Data will be available only after the financial modeling process is completed</td>
<td>Total application cost from all the buckets</td>
<td></td>
</tr>
<tr>
<td>Application's Incident Count</td>
<td>Quarter</td>
<td>Custom Script</td>
<td>incident</td>
<td>Data will be available in the incident table only after the business application is associated to the incident.</td>
<td>Indicator that gets the count of all incidents associated to the business application tied to the scoring profile of which the indicator is part.</td>
<td></td>
</tr>
<tr>
<td>Indicator name</td>
<td>Frequency</td>
<td>Type</td>
<td>Source</td>
<td>How is it calculated?</td>
<td>Description</td>
<td>Jobs</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>-----------</td>
<td>-----------------</td>
<td>--------------</td>
<td>--------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Application's Instance – Incident Count</td>
<td>Quarter</td>
<td>Custom Script</td>
<td>incident</td>
<td>Gets incident count attached to all Application Instances, which are mapped to a business application and rolls it up to application.</td>
<td>Indicator that gets the count of all incidents associated with application instances. The application instances, in turn, are associated to a business application tied to a scoring profile of which the indicator is a part. The incident count is calculated first at the application instance or application service level, and then it is rolled up to the business application level.</td>
<td></td>
</tr>
<tr>
<td>Usage</td>
<td>Month</td>
<td>Query Condition</td>
<td>APM product. cmdb_ci_business table</td>
<td>Calculated from the Active User Count field</td>
<td>Number of user sessions and users for the application for a given fiscal period.</td>
<td></td>
</tr>
<tr>
<td>Indicator name</td>
<td>Frequency</td>
<td>Type</td>
<td>Source</td>
<td>How is it calculated?</td>
<td>Description</td>
<td>Jobs</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------</td>
<td>-----------</td>
<td>-------------------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------</td>
<td>-------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Number of incidents    | Daily    | Performance Analytics | Mapped to Performance Analytics > Indicators > Automated Indicators > Number of new incidents  
Source = Incidents.New (Incident table) | Number of incidents opened today                                                              | Number of new incidents. Daily and historic data collection                           | [PA Incident] Daily Data Collection  
[PA Incident] Historic Data Collection |
| Number of problems     | Daily    | Performance Analytics | Mapped to Performance Analytics > Indicators > Automated Indicators > Number of new problems  
Source = Problems.New (Problem table)                                                        | Problems created today                                                                  | Number of problems opened today. Daily and historic data collection                 | [PA Problem] Daily Data Collection  
[PA Problem] Historic Data Collection |
| Number of changes      | Daily    | Performance Analytics | Mapped to Performance Analytics > Indicators > Automated Indicators > Number of new changes  
Source = Changes.New (change_request table)                                                   | Number of changes with a registration date (change_request.opened_at)                   | Number of changes opened today. Daily and historic data collection                  | [PA Change] Daily Data Collection  
[PA Change] Historic Data Collection |
| Customer satisfaction (CSAT) | Quarter | Assessments | Assessment Metric Type: Customer Satisfaction Assessment 
Metric Category: CSAT                                                                         | Template NPS                                                                         | Template NPS | Template NPS |
<table>
<thead>
<tr>
<th>Indicator name</th>
<th>Frequency</th>
<th>Type</th>
<th>Source</th>
<th>How is it calculated?</th>
<th>Description</th>
<th>Jobs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Functional fit</td>
<td>Month</td>
<td>Assessments</td>
<td>Assessment Metric Type: Functional Fit Assessment Metric Category: Functional Fit</td>
<td>Template Net Promoter Score (NPS)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Technical risk</td>
<td>Month</td>
<td>Assessments</td>
<td>Assessment Metric Type: Technical Risk Assessment Metric Category: Performance</td>
<td>Technical risk captured through survey for the fiscal period. Template NPS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Business value</td>
<td>Quarter</td>
<td>Assessments</td>
<td>Assessment Metric Type: Business Value Assessment Metric Category: Business Value</td>
<td>Template NPS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Indicator name</td>
<td>Frequency</td>
<td>Type</td>
<td>Source</td>
<td>How is it calculated?</td>
<td>Description</td>
<td>Jobs</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-----------</td>
<td>-------------------</td>
<td>------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Total change hours</td>
<td>Month</td>
<td>Performance Analytics</td>
<td>Mapped to Performance Analytics &gt; Indicators &gt; Automated Indicators &gt; Summed duration of closed changes</td>
<td>Script: Change.CloseTime.Hours. All Change Requests closed today considered</td>
<td>Summed duration of closed changes for an application for the given fiscal period. Time taken to close the changes in hours. Daily and historical data collection.</td>
<td>• [PA Change] Daily Data Collection</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• [PA Change] Historic Data Collection</td>
</tr>
</tbody>
</table>

Financial Modeling indicators to measure application cost
Application Portfolio Management integrates with Financial Management, providing you a preconfigured APM cost model. It uses the application cost breakdown and planned investment functionalities from Financial Management to derive the cost data of an application.

Cost indicators to retrieve cost data from ITFM buckets
Indicators are used to determine the cost incurred for business applications. Defining cost models and allocation rules in Financial Management help you to set up financial modeling indicators in Application Portfolio Management. To learn more about indicators and their sources, see Preconfigured indicators.

Use the FM cost metrics to assess the performance of business applications. Apply unique cost indicators to retrieve cost data from specific buckets in the cost model that is used. With this process, you can determine the exact amount that is allocated from a cost bucket to a business application in L2 Costing – Business Applications cost model. As the FM allocation engine runs, the data for the cost indicators are retrieved.

Note: The preconfigured cost indicators work only with L2 Costing – Business Applications cost model. If you use a different cost model or modify the L2 Costing – Business Applications cost model, then you must modify the custom script of the indicators accordingly.
The cost indicators that retrieve cost allocated to business applications from the respective buckets are:

**Facilities cost**
Retrieves cost from the Facilities bucket of L2 Costing – Business Applications cost model.

**Hardware cost**
Retrieves cost from the hardware bucket of L2 Costing – Business Applications cost model.

**Labor cost**
Retrieves cost from the Labor bucket of L2 Costing – Business Applications cost model.

**Other cost**
Retrieves cost from the Other bucket of L2 Costing – Business Applications cost model.

**Services cost**
Retrieves cost from the Services bucket of L2 Costing – Business Applications cost model.

**Software cost**
Retrieves cost from the Software bucket of L2 Costing – Business Applications cost model.

**Application TCO**
Total application cost is the sum of all costs from all the buckets (Facilities, Hardware, Labor, Other, Services, Software).

**Performance Analytic indicators to measure application performance**
Use performance analytic (PA) indicators to know the count of incidents, problems, and changes logged against a business application and use this insight to improve the performance of your applications.

Application Portfolio Management uses indicators that are sourced from Performance Analytics (PA). These indicators give a count of incidents, problems, changes, and the number of change requests that were closed on a given day. Follow the given order to run the PA jobs at the scheduled time, and get the scores of the indicators to evaluate the performance of your business applications.

**Order in which to run PA jobs and generate scores**

You should run the scheduled jobs in the following order:

1. [PA Incident] Daily Data Collection.
2. [PA Change] Daily Data Collection.
4. [APM Scheduled job] Load Application Indicators and compute Application Scores.

If there are historic data, then run them in the following order:

**Note:**
You require Performance Analytics Premium for APM (com.snc.pa.premium.apm) plugin to retrieve historic data that are older than six months.

1. [PA Incident] Historic Data Collection.
2. [PA Change] Historic Data Collection.
4. Regenerate APM scores for required time period. This action deletes the existing scores including daily scores and generates new scores instead of just updating the existing scores.

**Frequency at which indicator scores are generated**

Scores are generated as per the scheduled run of the job that executes the script. If the indicator frequency is:

- **Monthly**
  scores are generated only on the last day of a month.

- **Quarter**
  scores are generated only on the last day of a quarter.

- **Yearly**
  scores are generated only on the last day of a year.

**Note:** Fiscal periods should be generated in the same time zone in which the scores are generated.

**Collection of PA indicator score data**

The period unit (days, weeks, or month) at which the PA indicator scores are collected and preserved depends on the frequency of the data source indicator. However, the frequency at which the application indicator collects the PA indicator data source scores varies.

In APM, the frequency of the application indicator must be greater than or equal to the frequency of the data source indicator.

The following table describes the frequency at which APM collects data from the data source indicators after the job runs:

<table>
<thead>
<tr>
<th>APM data collection frequency</th>
<th>Data source indicator frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monthly</td>
<td>Monthly</td>
</tr>
<tr>
<td>Quarterly</td>
<td>Monthly and Quarterly</td>
</tr>
<tr>
<td>Yearly</td>
<td>Monthly, Quarterly, and Yearly</td>
</tr>
</tbody>
</table>

If you are an APM customer, who has upgraded to the Paris release, then the **Daily** frequency of Performance Analytics data source indicator is not available. The `RemoveDailyFreqAndUpdatePAIndicator` fix script automatically removes the **Daily** frequency of PA indicators and updates the frequency to **Monthly**.

**Limitations to display application breakdowns in PA scoresheet**

If there is a large number of business applications installed, then all the breakdowns are not displayed in the **Performance Analytics > Scoresheet**, as there is a limitation set in the system properties:
com.snc.pa.scoresheet.max_elements and com.snc.pa.scorecards.max_breakdown_elements. To reconfigure the property limitation:

1. Navigate to Performance Analytics > System > Properties.
2. Enter the maximum number in the **Maximum number of elements of a breakdown in Scoresheet** field. The number must be greater than or equal to the number of business applications installed in your system.
Performance Analytics

Maximum number of periods prior to today for which scores are collected and kept. The number of periods varies according to the score collection frequency, as follows: daily; weekly; bi-weekly; four weeks; monthly; bi-monthly; quarterly; fiscal quarterly; half-yearly; yearly; fiscal yearly.

Maximum number of periods prior to today for which lists of records (snapshots) related to a score are collected and kept. The number of periods varies according to the score collection frequency, as follows: daily; weekly; bi-weekly; four weeks; monthly; bi-monthly; quarterly; fiscal quarterly; half-yearly; yearly; fiscal yearly.

Start of the fiscal year of your company

Default indicator target color scheme

Default chart color scheme

Default Unit

Maximum number of elements of a breakdown in Scoresheet

Breakdown element cut-off point in visualizations

Maximum number of breakdown elements in scorecard list
3. Enter the maximum number in the **Maximum number of breakdown elements in scorecard lists** field.

4. Click **Save**.

**Create an application score profile and attach profile indicators**

You can create an application score profile and update the default application profile with new profile indicators per your requirements. After you create a score profile, you have to associate it with indicators.

Role required: sn_apm.apm_admin

You can create or update the scoring profile with new indicators and associate it with the business application. You can also use the same indicators within many scoring profiles, which generate indicator scores unique to that scoring profile.

1. Navigate to **Application Portfolio Management > Administration > Scoring Profiles**.
2. Click **New**.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Scoring Profile form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Name of the application profile.</td>
</tr>
<tr>
<td><strong>Readjust Weightage</strong></td>
<td>Option to adjust the weightage proportionately among the relevant indicators of the business application.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Description of the application profile.</td>
</tr>
<tr>
<td><strong>CI Class</strong></td>
<td>Configuration item type for which the score is generated.</td>
</tr>
</tbody>
</table>

**Readjust Weightage** is an option that you can use to adjust the weights among the relevant indicators. For example, a business application internal to an organization may not require web security. Whereas web security as an indicator is still listed in the profile indicators for the business application. However, the indicator has no value to it as it is not relevant to that business application. In such a case, you can readjust the weightage among the relevant indicators by setting the Readjust Weightage flag to true.

For instance, if there are three indicators I1, I2, and I3 and each with a weightage of 20%, 40%, and 40%, respectively. If I2 is not relevant for BA1, then the weights can be readjusted between I1 (20/ (20+40)) and I3 (40/(20+40)) as 33.3% and 66.6%, respectively. Readjusting weights can be done at the scoring profile level by setting the Readjust Weightage flag to true.

4. Right-click the form header and click **Save**.

After creating a score profile, you must associate a profile indicator to the score profile.

5. In the Profile Indicators related list, add indicators.
   a) Click **New**.
   b) On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Profile Indicator form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Profile</strong></td>
<td>Name of the application profile.</td>
</tr>
<tr>
<td><strong>Indicator</strong></td>
<td>Name of the application indicator.</td>
</tr>
</tbody>
</table>
**Field** | **Description**
---|---
Evaluate within Application Scoring Profile | Option for considering the business applications tied to the selected scoring profile in the evaluation of scores. Clearing the check box entails evaluation of all business applications within the enterprise or across all scoring profiles.

**Domain** | The domain to which this indicator belongs.

**Used in CI score calculation** | Option for using the application indicator in calculating the application score.

**Weightage** | Numeral for the indicator. Weightage provided in the application score profile for an indicator contributes to the total score of the application.

An indicator that is added to the profile can be a parent indicator with dependent child indicators. When such a parent indicator is added to a scoring profile, then all its dependent child indicators are also added with weightage 0, if they are not already present in the scoring profile.

For more information on how to create a dependent indicator, see Create or edit an indicator to assess an application.

c) Click **Submit**.

**Regenerate scores**: Click the **Regenerate scores** button to regenerate the scores of all the indicators attached to the scoring profile. This action deletes the existing scores and generates new scores instead of just updating the existing scores. Therefore, the scores of all the business applications that are associated to this scoring profile are also recalculated.

You can **schedule a job to calculate application scores** periodically.

**Job schedule to compute application scores**

After you set up indicators, create score profile, and attach profile indicators, schedule a job to periodically compute the application scores.

Understand how the system calculates application scores and create your application score profile per your requirements.

The assessment framework calculates the application score for each application on a scale of 1–10, where 10 is a good score and 1 is a low score. Assessments are based on various configured indicators, which you can configure. Each of these indicators periodically captures the related application data, which is used to derive the application score. These indicators with their respective value (weightage) are added to an application profile. The application is then associated with the application profile, which calculates the application score.

**Schedule a job to compute application scores**

Enable the **Load Application Indicators and compute Application Scores** scheduled job to regularly compute the application and indicator scores.

Role required: admin

The job recalculates the scores of all indicators, the scoring profiles to which these indicators are attached, and the business applications that are associated to these scoring profiles.
The job generates scores for indicators according to the time period that is set in the **Frequency** field of the Indicator form. The job generates scores on the last day of the fiscal period set as frequency. That is, if the current day is the last day of the fiscal period, only then it generates the scores.

For example, if the **Frequency** option set for the **Functional Fit** indicator is monthly, then the scores for this indicator are generated on the last day of the month. If the frequency set for the **CSAT** indicator is quarter, then the scores for CSAT are generated on the last day of that quarter. Similarly, if the frequency for **Business Value** indicator is set as year, then the scores are generated on the last day of the year.

**Note:** If your frequency is yearly, then the scores of the indicators are generated on the last day of the year. Furthermore, scores are generated for the last quarter and the last month of the year as well, which are also inclusive of the last day of the year when the scores are generated.

However, if you want to generate scores, on demand, on any day and for a particular period of time, then you can generate scores using the **Regenerate Indicator score** option in the Indicator form of a particular indicator. This action does not update the existing scores but deletes them and generates new scores.

See: Create or edit an indicator to assess an application. You can also use the **Regenerate scores** option of the Scoring Profile form that generates scores for all indicators attached to that scoring profile. See: Create an application score profile and attach profile indicators.

1. Navigate to **System Definition > Scheduled Jobs**.
2. Find and select the **Load Application Indicators and compute Application Score** scheduled job.
3. On the form, fill in the fields.

### Scheduled Script Execution form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name to identify this scheduled script execution.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the script at the scheduled date and time. By default the job is inactive.</td>
</tr>
<tr>
<td>Run</td>
<td>The type of schedule to execute the script on. Choices are:</td>
</tr>
<tr>
<td></td>
<td>• Daily</td>
</tr>
<tr>
<td></td>
<td>• Weekly</td>
</tr>
<tr>
<td></td>
<td>• Monthly</td>
</tr>
<tr>
<td>Day</td>
<td>If you select Weekly or Monthly from the Run list, then the Day field appears.</td>
</tr>
<tr>
<td></td>
<td>• If Run is Weekly, then the day of the week.</td>
</tr>
<tr>
<td></td>
<td>• If Run is Monthly, then the day of the month.</td>
</tr>
<tr>
<td>Time</td>
<td>Time at which the script runs on a 24-hour clock.</td>
</tr>
<tr>
<td></td>
<td>If Run is Weekly or Monthly, the value includes the time of day.</td>
</tr>
<tr>
<td>Conditional</td>
<td>Option for executing only if certain conditions are met.</td>
</tr>
<tr>
<td>Run this script</td>
<td>The script to run at the scheduled date and time. You need not edit the script.</td>
</tr>
<tr>
<td>Run as</td>
<td>Select another user to run the script execution as. Configure the form to add this field if it is not present.</td>
</tr>
</tbody>
</table>
4. Right-click the form header and click Save.
5. Click Execute Now. The job executes at the scheduled date and time.

Understand what the job does and how the assessment framework normalizes the application scores.

**Normalization of application scores**

The indicators and their respective weights are used to calculate application score profiles for each configuration item. Use the score profile to calculate application scores and assess the applications. Apply these scores to compare applications and make strategic decisions about which ones to keep, replace, maintain, or invest more in.

The preconfigured indicators or the indicators that you created retrieve their related data based on the frequency set at the indicator definition stage. This data is captured in the **Application weight** column of the Application Indicator Score [apm_app_indicator_score] table. The **Target maximum** and **Target minimum** that are set while creating an application indicator are for calculating the applications normalized value.

**Note:**

The **Target maximum** and **Target minimum** are not available when the data source is Assessments.

The normalized value of the application score, which is measured on a scale of 1–10, is derived from the following formula:

\[
\frac{(\text{Application Weight} - \text{Target minimum})}{(\text{Target maximum} - \text{Target minimum})} \times 9 + 1
\]

**Note:**

If the **Target maximum** and **Target minimum** are not set, then the maximum value within the range of applications is taken as the target maximum value. Similarly, the minimum value within the range of applications is taken as the target minimum value.

The **Application Weight** that is lesser than or equal to the target minimum is given the lower score, which is 1.

The **Application Weight** that is greater than or equal to the target maximum is given the maximum score, which is 10.

When you set the application indicators, you can also configure the **Direction** as Maximize or Minimize. The application with the maximum value gets the minimum score when the direction is Minimize. The application with the minimum value gets the maximum score when the direction is Maximize.

If the **Direction** in the indicator is **Minimize**:

\[
(10 - \text{above calculated Normalized value})
\]

Application profile weightage is then applied on the Normalized value to derive the **Indicator Score**:

\[
\text{Normalized Value} \times \text{Weightage as in application score profile} \%
\]

After the indicator score is calculated for each of the indicators, the application score is calculated by summing up all the indicator scores used in the profile.

If the source of the indicator is **Indicators** in the **Data source** field, then the application weight is calculated as the sum of the normalized scores of all its dependent indicators.
**Note:**
The normalized score of the parent indicators is then calculated in a similar manner as it is calculated for all the other indicators. The normalized value, indicator score, application weight, target maximum, target minimum, and total weight are all rounded to two decimal places only.

In the figure, since the Cost and Incident indicators are set to minimize, the applications with lower costs and lower number of incidents have higher scores.

<table>
<thead>
<tr>
<th>Business Application</th>
<th>Indicator</th>
<th>Application Weight</th>
<th>Normalized Value (NV)</th>
<th>Indicator Score (NV * 30%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application A</td>
<td>Cost</td>
<td>100</td>
<td>10</td>
<td>3</td>
</tr>
<tr>
<td>Application B</td>
<td>Cost</td>
<td>150</td>
<td>4.5</td>
<td>1.35</td>
</tr>
<tr>
<td>Application C</td>
<td>Cost</td>
<td>200</td>
<td>1</td>
<td>0.3</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Business Application</th>
<th>Indicator</th>
<th>Application Weight</th>
<th>Normalized Value (NV)</th>
<th>Indicator Score (NV * 50%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application A</td>
<td>Incidents</td>
<td>10</td>
<td>10</td>
<td>5</td>
</tr>
<tr>
<td>Application B</td>
<td>Incidents</td>
<td>80</td>
<td>1</td>
<td>0.5</td>
</tr>
<tr>
<td>Application C</td>
<td>Incidents</td>
<td>100</td>
<td>1</td>
<td>0.5</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Business Application</th>
<th>Indicator</th>
<th>Application Weight</th>
<th>Normalized Value (NV)</th>
<th>Indicator Score (NV * 20%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application A</td>
<td>CSAT</td>
<td>10</td>
<td>10</td>
<td>2</td>
</tr>
<tr>
<td>Application B</td>
<td>CSAT</td>
<td>2</td>
<td>1</td>
<td>0.2</td>
</tr>
<tr>
<td>Application C</td>
<td>CSAT</td>
<td>3</td>
<td>2.125</td>
<td>0.425</td>
</tr>
</tbody>
</table>

**Sample application scores**
Visualization of application performance

Visualization of the performance of applications in different dimensions on a bubble chart, in a dashboard, and in an application 360 view helps you to take decisions on the applications.

Having set up indicators and attaching application score profiles and running the scheduled job to calculate its scores periodically, your application scores are now ready for viewing.

- Use bubble charts to visualize your business application data plotted on a chart in three dimensions, which helps you to compare and evaluate applications based on their indicator scores.
- Use Application 360 to focus on the business applications that require your attention.
- Use Application Assessments dashboard to view the trends of indicators for different applications.

View application indicator scores

View the application indicator scores that are sourced and computed based on the sourcing setup defined for the application indicators. The assessment framework calculates the score only for those indicators which are attached to at least one scoring profile. The indicator scores help you to evaluate the applications and make strategic decisions on them.

Role required: sn_apm.apm_analyst

You can view the application indicator score details of the business applications for a fiscal period.

1. Navigate to Application Portfolio Management > Application Ratings > Indicator Scores.
   The applications are listed showing the indicators, indicator scores, normalized value, application weight, and total weight for each fiscal period. The normalized value, indicator score, application weight, target maximum, target minimum, and total weight are all rounded to two decimal places.
2. Click a business application in the list to view the details of the application.

View all application scores

View the application scores that are computed as a weighted sum of the application indicators on the application scoring profile. The application scores help to evaluate the applications and make strategic decisions on them.

You can create the scores manually, but it is recommended that the assessment framework computes the scores.

Role required: sn_apm.apm_analyst

You can view the application score for a particular business application in a fiscal period.

1. Navigate to Application Portfolio Management > Application Ratings > All Application Scores.
   The applications are listed with their respective scores for each fiscal period. The scores are rounded to two decimal places.
2. Click a business application in the list to have a detailed view of the application.

Analyze application scores in a bubble chart

Bubble charts are interactive graphs that help you identify strategies by plotting application indicator scores. You can evaluate applications for a category and decide whether to invest, sustain, or to replace an application by configuring multiple combinations of indicators in the bubble chart.

Role required: sn_apm.apm_analyst

Use the bubble chart to plot the indicator scores of the applications in X and Y axes. You can then use these scores to strategize goals and create a demand to invest in, replace, or sustain the application.

1. Navigate to Application Portfolio Management > Application Portfolio Analysis > Analyze.
2. Select a Application Category in the Group Analysis page.
The bubble chart page has the following sections:

**Assessment Period**

The fiscal period for which the analysis of applications is done.

**Filter Apps**

Helps filter the application categories based on the criteria set on the application indicator scores.

**Bubble chart**

Based on the filter criteria, the interactive bubble chart dynamically plots the metrics of the application indicator scores that fall within the filtered values.

**Application Analysis**

Helps compare applications with the selected indicators. It shows the total score of the application rounded to two decimals, along with contract renewal details, its life-time details, and the different costs associated with the application. You can analyze to know which applications to invest further and that which are not really useful. To view the business application record details in the Business Application form, click the name of an application in the list. To view the application details in a dashboard view, click the Application 360 tab in the Business Application form.

3.

To change the configurations of the bubble chart, click the configuration icon ( ) icon and then fill in the fields on the Select Chart Dimensions form.

**Select Chart Dimensions form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Dimension</th>
</tr>
</thead>
<tbody>
<tr>
<td>X and Y</td>
<td>Dimension of the indicators that fall in the X and Y axes.</td>
</tr>
<tr>
<td></td>
<td>Along with the pre-configured dimensions, you can also view the bubble chart that you create using the Application bubble chart form.</td>
</tr>
<tr>
<td>Bubble Size</td>
<td>Indicator scores determine the size of the bubble.</td>
</tr>
<tr>
<td>Field</td>
<td>Dimension</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Display bubble labels</td>
<td>Enable to display the bubble labels in the Bubble chart.</td>
</tr>
<tr>
<td></td>
<td>Helps to have a clear display of bubbles, uncluttered by their labels when there are many bubbles in a quadrant.</td>
</tr>
</tbody>
</table>
Point to the bubble in the chart and click the application or right-click the bubble and select **Create Demand** to create a demand for the application.

**Create or edit a bubble chart for application strategies**

Set up a bubble chart to compare and evaluate the relative standing of applications in selected categories. The chart helps you determine which applications to invest more in, keep, replace, or eliminate.

Role required: sn_apm.apm_admin

If you require new indicators, create the application indicators before you create the application bubble chart for which the application framework calculates the scores.

You can configure existing application bubble charts or create them to align with your business needs.

1. Navigate to **Application Portfolio Management > Administration > Bubble chart**.
2. Click **New** to create a new chart or click the name of an existing chart that you want to edit.
3. On the form, fill in the fields.

**Application bubble chart form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the application bubble chart.</td>
</tr>
<tr>
<td>Top left label</td>
<td>Application strategy in the top left label.</td>
</tr>
<tr>
<td>Top right label</td>
<td>Application strategy in the top right label.</td>
</tr>
<tr>
<td>Bottom right label</td>
<td>Application strategy in the bottom right label.</td>
</tr>
<tr>
<td>Bottom left label</td>
<td>Application strategy in the bottom left label.</td>
</tr>
<tr>
<td>Top left color</td>
<td>Color for the bubble in the top left quadrant.</td>
</tr>
<tr>
<td></td>
<td>The color fields accept string inputs including hex code or RGB notation.</td>
</tr>
<tr>
<td>Top right color</td>
<td>Color for the bubble in the top right quadrant.</td>
</tr>
<tr>
<td></td>
<td>The color fields accept string inputs including hex code or RGB notation.</td>
</tr>
<tr>
<td>Bottom right color</td>
<td>Color for the bubble in the bottom right quadrant.</td>
</tr>
<tr>
<td></td>
<td>The color fields accept string inputs including hex code or RGB notation.</td>
</tr>
<tr>
<td>Bottom left color</td>
<td>Color for the bubble in the bottom left quadrant.</td>
</tr>
<tr>
<td></td>
<td>The color fields accept string inputs including hex code or RGB notation.</td>
</tr>
<tr>
<td>Quadrant label color</td>
<td>Color for the label.</td>
</tr>
<tr>
<td></td>
<td>The color fields accept string inputs including hex code or RGB notation.</td>
</tr>
<tr>
<td>X Indicator</td>
<td>An application indicator for the X axis.</td>
</tr>
<tr>
<td></td>
<td>You can also create an application indicator by clicking the <strong>New</strong> button in the Application Indicators form.</td>
</tr>
<tr>
<td>Y Indicator</td>
<td>An application indicator for the Y axis.</td>
</tr>
<tr>
<td>Z Indicator</td>
<td>An application indicator for the Z axis.</td>
</tr>
</tbody>
</table>
Monitor performance, costs, and workloads in Application 360

Application 360 dashboard performs as a reporting tool and uses Performance Analytics to provide a decision-making approach to Application Portfolio Management by identifying which business application requires focus and attention. The dashboard helps you to analyze the indicator scores and execute effective decisions.

In the Business Application choice list, select an application to monitor its performance, costs, and workload in the following tabs and sections within the application 360 dashboard:

- **Overview**: Review the overall application score for the fiscal period.
  - **Application Indicator Scores**: View the trend and distribution for the different indicators of the selected fiscal period.

- **Costs**:
  - **Total Costs Fiscal Quarterly**: View the details of the total cost incurred in the quarterly fiscal period.
  - **Scorecard**: Ascertain the cost details and ratings over time, comparing them over different quarters.

- **Workload**: View the graphical illustration of the number of new incidents, problems, and changes over the selected fiscal period and the workload trend.
Role required: sn_apm.apm_analyst

Navigate to Application Portfolio Management > Application Portfolio Analysis > Application 360.

Application indicator scores

Assess the performance of applications in the dashboard

Use the Application Assessments dashboard for an overview of reports on the performance of the business applications. The spline chart gives you a trend of the application indicators against the normalized value over different quarters in a fiscal period.

You must have the Performance Analytics – Content Pack – Application Portfolio Management (com.snc.pa.apm) plugin activated before you can use the Application assessments dashboard. The plugin gives you access to the APM application indicator scores used in Performance Analytics (PA) reports and dashboards.
Role required: sn_apm.apm_user

Application Portfolio Management provides preconfigured reports in the Application Assessments dashboard. You can configure these reports using dashboards. You can also filter data on the dashboard.

The Application Assessments dashboard is a responsive dashboard that provides a complete view of applications. You can share widgets with different indicators and indicator scores. The PA widgets on the dashboard visualize data over time, helping you analyze business processes and identify areas for improvement.

The following reports are provided on the dashboard to help you analyze trends:

- **Customer satisfaction trend**: Level of customer satisfaction over time with the various applications that belong to the application family. The normalized value is derived by computing the maximum and minimum application weight values.
- **Usage trend**: usage of applications over time.
- **Business value trend**: business value of the applications over time.
- **Cost of support trend**: cost of the applications over time.
- **Total changes trend**: total changes over time.
- **Technical Risk Trend**: Technical risk the applications may have over time.

1. Navigate to Application Portfolio Management > Application Portfolio Analysis > Dashboard.
2. To save a chart as a JPG or PNG file, point to the chart and click the menu icon that appears.
3. To filter the data in the spline charts, select options from the Application Category, Portfolio, Business Process, and Business Unit lists.

   **Note**: Activate PPM Standard (com.snc.financial_planning_pmo) plugin to apply the portfolio filter.

### Application strategy

Formulate your decisions and align them with your organizational goals as Application Portfolio Management collects metrics on applications across various dimensions.

An application strategy portal takes you through a step-by-step process to identify opportunities to cut down the cost and create strategies for applications. It helps you to:

- Decide which application to invest, consolidate, migrate, sustain, replace, or retire based on the organization goals, application score, or indicator scores.
- Create strategic goals and track demands and programs. For example, you can set a goal and create a program to cut down the capital expense (CAPEX) of an application by 40%.
- Estimate or determine the applications assessment scores. For example, if an application score is low because of low business value and low customer satisfaction, then you can initiate a demand to invest in the application.

### Create a goal for an application strategy

After assessing the applications and deciding on strategies, set concrete goals to maximize or minimize depending on the indicators for the selected fiscal period.

Role required: user_admin, pps_admin
To understand how your organizational strategies are performing, see the Strategic Spend Tracking for PPM dashboard topic. It provides comprehensive visualization to help you understand how the planned costs, actual costs, and benefits for projects aligned to your organization’s strategies trend over time.

1. Navigate to Application Portfolio Management > Home and click Create in the Opportunities & Solutions, Goals section.

   You can also navigate by any of the following steps:
   • Application Portfolio Management > Application Portfolio Analysis > Goals and click New.
   • Organization > Goals and click New.

2. Fill in the form fields.

   **New Goal form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direction</td>
<td>Direction towards the goal, either maximize or minimize.</td>
</tr>
<tr>
<td>Target</td>
<td>Target achievement number.</td>
</tr>
<tr>
<td>Target Fiscal year</td>
<td>Target fiscal period.</td>
</tr>
<tr>
<td>Status Indicator</td>
<td>Color to indicate the status of the goal.</td>
</tr>
<tr>
<td>Goal Indicator</td>
<td>Indicators to achieve the goal.</td>
</tr>
<tr>
<td>Unit</td>
<td>Appropriate name of the unit for the selected target. For example, if your goal is to minimize Capex by 10%, then the unit must be %.</td>
</tr>
<tr>
<td>Owner</td>
<td>Person who owns the goal.</td>
</tr>
<tr>
<td>Task</td>
<td>Related tasks assigned to achieve the goal.</td>
</tr>
<tr>
<td>State</td>
<td>Status of the goal whether Pending, Achieved, or Not Achieved.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to enable the record active.</td>
</tr>
<tr>
<td>Short description</td>
<td>Short summary of the goal.</td>
</tr>
</tbody>
</table>

3. Click Save.

4. In the Recent Goals section, click the goal that you created and update the following fields:

   **Update Goal form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planned achievement</td>
<td>Percentage of the target that you plan to achieve.</td>
</tr>
<tr>
<td>Actual achievement till date</td>
<td>Current percentage achieved.</td>
</tr>
<tr>
<td>Comments</td>
<td>Comments, if any.</td>
</tr>
</tbody>
</table>

5. Click Save.

   You can view all the goals from the list in the Recent Goals section of the portal by clicking View all.

   You can create a program to execute the goal.
Create a demand towards achievement of goal

Use a demand as a step to identify cost saving opportunities on the applications and to meet the target. The strategy that you associate with the demand action decides the strategy for the application.

Role required: sn_apm.apm_analyst

Create a demand to capture details like action, start and target fiscal period, application, program, and so on.

1. Navigate to Application Portfolio Management > Application Portfolio Analysis > Demands and click New.

   You can also navigate to the Demand form from any of the following portals:
   • Application Portfolio Management Home page
   • Capability Based Planning map
   • Bubble chart
   • Technology Portfolio Management timeline

2. On the form, fill in the fields.

<p>| Demand form |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>Course of action for the new demand.</td>
</tr>
<tr>
<td>Note: The Action field is available only when you launch the form within the Application Portfolio Management module and that is when the APM plugin is activated.</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Name of the demand.</td>
</tr>
<tr>
<td>Category</td>
<td>Category of the demand.</td>
</tr>
<tr>
<td>• Strategic</td>
<td></td>
</tr>
<tr>
<td>• Operational</td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>Type of demand:</td>
</tr>
<tr>
<td>• Project</td>
<td></td>
</tr>
<tr>
<td>• Enhancement</td>
<td></td>
</tr>
<tr>
<td>• Change</td>
<td></td>
</tr>
<tr>
<td>• Defect</td>
<td></td>
</tr>
<tr>
<td>The Category field selection determines the options available in the Type field.</td>
<td></td>
</tr>
<tr>
<td>Number</td>
<td>Unique, auto-generated identification number for the demand.</td>
</tr>
<tr>
<td>Start date</td>
<td>Start date of the demand.</td>
</tr>
<tr>
<td>Due date</td>
<td>Requested completion date of the demand.</td>
</tr>
<tr>
<td>Details</td>
<td></td>
</tr>
<tr>
<td>Portfolio</td>
<td>Portfolio indicating the business focus of the demand.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Program</td>
<td>Name of the program to which the demand belongs.</td>
</tr>
<tr>
<td>Demand manager</td>
<td>Name of the demand manager.</td>
</tr>
<tr>
<td>Collaborators</td>
<td>Users who can edit or contribute to the demand. A demand requester can select any user as a collaborator.</td>
</tr>
<tr>
<td>Department</td>
<td>Department in a business unit to which the demand submitter belongs. If no value is chosen in this field, it is auto-populated with the name of the department to which the submitter belongs.</td>
</tr>
<tr>
<td>Business Unit</td>
<td>Business unit to which the demand submitter belongs.</td>
</tr>
<tr>
<td>Impacted Business Units</td>
<td>Business unit which is impacted by the submitted demand.</td>
</tr>
<tr>
<td>Business Capabilities</td>
<td>One or more business capabilities to associate the demand with.</td>
</tr>
<tr>
<td>Business Applications</td>
<td>Add a business application to the demand. You can select any business application in your enterprise, irrespective of it being related or not related to the capability that you have selected in the Business Capabilities field above.</td>
</tr>
</tbody>
</table>

3. To submit the record and go back to the list view, click **Submit**.
4. Click **Save** to save the record and remain on the same form to add more details to the demand.

### Create a program for an application goal

Create a program, link it to the goal that you created, and associate a program manager to the program. After you create a goal, you should have a program to achieve the goal that you created.

**Note:**

You can create a program only when you activate PPM Standard (com.snc.financial_planning_pmo) plugin.

Role required: sn_apm.apm_analyst

1. Navigate to Application Portfolio Management > Home.
   
   You can also navigate to Application Portfolio Management > Application Portfolio Analysis > Programs and click New.

2. Click **Create** in the Opportunities & Solutions, Programs section.
3. On the form, fill in the fields.

**New Program form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program Name</td>
<td>Unique name for the program.</td>
</tr>
</tbody>
</table>
### Field

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Goal</td>
<td>Target goal that is to be achieved for the program.</td>
</tr>
<tr>
<td>Program manager</td>
<td>Name of the program manager.</td>
</tr>
<tr>
<td>Portfolio</td>
<td>Portfolio to which the program belongs.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the program.</td>
</tr>
<tr>
<td>Dates</td>
<td></td>
</tr>
<tr>
<td>Planned start date</td>
<td>Intended date for the program to begin.</td>
</tr>
<tr>
<td>Planned end date</td>
<td>Intended date for the program to end.</td>
</tr>
<tr>
<td>Planned duration</td>
<td>Expected duration of the program in days and hours.</td>
</tr>
<tr>
<td>Actual start date</td>
<td>Date on which the program actually begins.</td>
</tr>
<tr>
<td>Actual end date</td>
<td>Date on which the program actually ends.</td>
</tr>
<tr>
<td>Actual duration</td>
<td>Duration of the program in days and hours, from its start to closure.</td>
</tr>
<tr>
<td>Financials</td>
<td></td>
</tr>
<tr>
<td>Estimated cost</td>
<td>An estimate of the cost of the program.</td>
</tr>
<tr>
<td>Actual cost</td>
<td>Actual cost of the program.</td>
</tr>
<tr>
<td>Budget cost</td>
<td>Budgeted cost of the program.</td>
</tr>
<tr>
<td>Planned benefit</td>
<td>Benefit received from the program.</td>
</tr>
</tbody>
</table>

4. Click **Save**.
   
   You can view all the programs in the Programs list section of the portal.

   **Learn about** and **create a guided plan** to execute the program that you have created or any other program in the list.

#### Guided plan to execute a program

After you create a program, you can use the guided plan to formulate steps in executing the program that you have created.

**Note:**

You can use the guided plan to execute a program only when you activate PPM Standard (com.snc.financial_planning_pmo) plugin.

You can select a specific program by clicking the view link of the programs in the Opportunities & Solutions section of the Application Portfolio Management portal to open the guided program navigation page. The Program Navigation page guides you in creating a step-by-step plan to set a goal target, identify opportunities and create demands, and track the project.
Program navigation page
The Program Navigation page is divided into these sections:

**Fiscal Period**

**Select Fiscal Period to start planning** is the fiscal period for which you set your goal, implement the demands, and achieve the target.

**Program Steps**

The section takes you through a guided step-by-step workflow to complete the tasks and achieve the target goal.

**Step 1: Set Goal Contribution Target**

Use the link to set the goal contribution target for the fiscal period.

**Step 2: Identify Opportunities**

Identify opportunities to meet the target by analyzing the application scores and indicator scores.

The Group Analysis page consolidates the application details by category and helps you narrow down target applications by filtering them with the application indicator scores and values.

Click open an application category. Based on the indicator scores in the bubble chart, you can create a demand to achieve your goal. Demand is an imperative rightful request created by demand managers and demand users. The user submits a demand and the demand manager approves the demand.
<table>
<thead>
<tr>
<th>Application Category</th>
<th>Number of Apps</th>
<th>Cloud</th>
<th>On Premise</th>
<th>Apps With Expiring Contract</th>
<th>Apps With EOL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Intelligence - ETL</td>
<td>2</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Business Intelligence - Reports</td>
<td>4</td>
<td>1</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Contracts</td>
<td>2</td>
<td>-</td>
<td>-</td>
<td>1</td>
<td>-</td>
</tr>
<tr>
<td>Customer Support</td>
<td>4</td>
<td>1</td>
<td>1</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Finance</td>
<td>4</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Human Capital Management</td>
<td>3</td>
<td>1</td>
<td>2</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Inventory Management</td>
<td>4</td>
<td>-</td>
<td>1</td>
<td>1</td>
<td>-</td>
</tr>
<tr>
<td>IT Portfolio Management</td>
<td>3</td>
<td>1</td>
<td>1</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>IT Service Management</td>
<td>3</td>
<td>3</td>
<td>-</td>
<td>1</td>
<td>-</td>
</tr>
<tr>
<td>Logistics</td>
<td>4</td>
<td>-</td>
<td>1</td>
<td>2</td>
<td>-</td>
</tr>
<tr>
<td>Manufacturing</td>
<td>4</td>
<td>-</td>
<td>1</td>
<td>1</td>
<td>-</td>
</tr>
<tr>
<td>Marketing</td>
<td>3</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Procurement</td>
<td>3</td>
<td>-</td>
<td>1</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Sales</td>
<td>4</td>
<td>-</td>
<td>1</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Sourcing</td>
<td>2</td>
<td>-</td>
<td>-</td>
<td>2</td>
<td>-</td>
</tr>
</tbody>
</table>
Select Fiscal Period to start Analysis in the Group Analysis page is the fiscal period for which you have assessed the applications. Based on these assessments you can create goals and demands, and implement them for the planned fiscal period, which is Select Fiscal Period to start planning.

Filter Applications
Use the Filter Applications pane to filter the applications based on the application indicators and scores.

To clear all the existing filters in the Filter Apps column in one click, instead of clearing each filter attribute field individually, click Clear all filters. You can then set your filter criteria to sort the applications for display.

Application Categories
The Application Categories section lists the applications by their category names and the number of applications that fall within each category.

1. Click the header of a column.
2. To sort the application categories in alphabetical or reverse alphabetical order, click the arrow that appears.
3. In the other application columns, click the arrow to list the values in either ascending or descending order.

Sorting helps to find the information quickly in the list, display higher values first, and also group the applications that have similar values.

Bulb icon (💡)
Lists the number of demands created, view them individually, and edit them in the demand form.

Step 4: Track Project
Track the status of the projects as the demands are approved and the projects are executed.

Program Overview section
Gives a brief summary about the planned start and end dates of the program, the manager who drives the program, the goal that is linked to the program with the target percentage set to achieve by the marked fiscal year. In addition, it also displays the following details:

- **Estimated Goal Contribution**: Estimated percentage of the goal that the proposed program targets to achieve.
- **Estimated % contribution**: Percentage of the goal targeted to be achieved in the selected planned fiscal period.
- **Number of impacted Applications**: Number of applications impacted by the program.

Demands Column
A stacked chart that represents the demands at the top layer and displays the number of demands created for the program. The middle layer displays and represents the number of demands that have been converted into projects. The bottom layer displays the number of projects created exclusively for the program, and not the demands that are converted into projects.

You can print the chart in any format using the Chart context menu at the top-right corner of the Demands Column.

Recent Demands
Displays the number and the name of the demands that are created for the program. To edit a demand, click the demand hypertext to open the demand in the Demand form.

If you have a long list of demands, then displaying all of them on the Recent Demands section may have a space limitation. Use the pagination preferences to display a short list and then click the arrows either to progress down or up the list of demands.

Create a guided plan to execute a program

Create a guided plan by setting goals, identifying opportunities, creating demands, and tracking the projects. The guided plan helps you to implement the program that you created.

You can create a guided plan to execute a program only when you activate PPM Standard (com.snc.financial_planning_pmo) plugin.

You should have created a program before you create a guided plan for the program.

Role required: sn_apm.apm_analyst

The Program Navigation page guides you in setting a goal target for the fiscal years to achieve the goal. You can also view the application rationalization roadmap at any stage of creating the program.

1. Navigate to Application Portfolio Management > Home.
2. Click View in the No. of Programs pane of the Opportunities & Solutions section.
3. Click a program in the Programs list.
4. Click the Select Fiscal Period to start planning choice list in the Fiscal Period section and select the financial year to start with the program steps.

• Step 1: Set Goal Contribution Target
  a) Click Set target.
  b) On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Goal Contribution Target form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td></td>
</tr>
<tr>
<td>Program</td>
<td>Name of the program.</td>
</tr>
<tr>
<td>Fiscal Year</td>
<td>Fiscal period for which the goal is set.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to enable the program.</td>
</tr>
<tr>
<td>Target Goal Contribution %</td>
<td>Percentage of the target goal contribution for the selected fiscal period.</td>
</tr>
<tr>
<td>Comment</td>
<td>Description that explains the target goal contribution for the program.</td>
</tr>
</tbody>
</table>

c) Click Save.

The Step 1: Set Goal Contribution Target shows the percentage of the goal that you want to achieve in the selected fiscal period. For example, if your goal is to maximize cloud applications by 40% in FY18 and you set the Target Goal Contribution % as 50%, then the Set Goal Contribution Target displays 20%.

• Step 2: Identify Opportunities
  a) Click Identify Opportunity in the Program Navigation page.

On the Group Analysis page, review the assessment period, analyze the application categories, and assess the number of applications against each category.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
b) Click the **Select Fiscal Period to start Analysis** choice list in the **Assessment Period** section and select a fiscal period for which you would like to analyze the applications.

c) Use the **Filter Apps** pane to set your filter conditions based on the application indicators and scores.

d) Compare and analyze the applications by category name in the **Application Categories** section.

e) Click an item in the **Category Name** column.

f) Right-click a bubble in the bubble chart and click the **Create Demand** prompt to create a demand. For example, if your goal is to invest more on a category, then click the invest bubble to achieve that goal.

After you save the demand, the bulb icon on the top-right corner of the page displays the number of demands that are created.

• **Step 3: Track Project**

  a) Click the projects link to track the status of the project anytime.

  The **Program Workbench** opens up, which is a central location for creating and managing projects. As the demand manager approves the demands and the projects are executed, you can navigate to the program workbench to track the status of the projects.

**Management of business capability**

Business capability is the ability of an organization to do its business activity successfully and fulfill its business goals. Use the business capability mapping to establish a CI relationship between the business capability and the business applications. Establish a similar relationship between business capabilities and the application technologies to ascertain the risks involved in using them.

As business organizations grow, it is imperative for an enterprise architect to constantly assess the business capabilities to know how to strengthen the business processes. Business capabilities are the abilities required to support a business process. They are assessed by indicators to provide indicator scores.

The indicator framework is enhanced to support assessment of business capabilities in addition to supporting business applications. Capture business capability as a CI type for which the score is generated.

Use the following capability assessments set of application menus to configure assessment. Access the scores for business capability, in a similar manner that you access and assess the scores of business applications:

• Create and assess CI Score for a fiscal period: **Application Portfolio Management > Capability Ratings > Capability Scores**.

• Create and update indicator scores: **Application Portfolio Management > Capability Ratings > Capability Indicator Scores**.

• Create a scoring profile and associate it with a business capability CI: **Application Portfolio Management > Administration > Scoring Profiles**.

• Create an indicator and configure the data source: **Application Portfolio Management > Administration > Capability Indicators**.

If the data source is of **Assessments** type, then you can generate survey assessments for the business capabilities in the Indicator form by clicking the **Generate Assessments** button. Apply filter conditions to the business capability table and select the users in the Generate Assessment UI. You can view
the status of assessments instances in the **Assessments Instances** tab and the results in the **Metric Category Results** tab. See: Generate survey assessments and view results within APM.

- Access business process capability map: **Application Portfolio Management > Capability Ratings > Capability Map.**

### Assess business capability

Assess the business capabilities within the indicator framework and based on the score you can make strategic decisions on the business applications that support the business capability.

Each business application and business capability have a unique identity as a configuration item (CI). Such a distinction helps to establish a relationship between these independent configuration items. The CI relationship helps to establish a parent-child relationship between business capability and business application, and business application and business capability.

The configuration items must be associated to a set of indicators to generate a weighted score for evaluation. Preconfigured indicators such as people, process, and technology are used to assess business capability.

![Business Application/Capability scoring framework](image)

**Business Application/Capability scoring framework**

The indicator scoring framework also supports scoring of business capability in addition to business application. Within this framework the preconfigured indicators including people, process, and technology, as well as the indicators that you have created, are evaluated to give the indicator scores. For business
applications you can create multiple scoring profiles. Each scoring profile can contain multiple indicators. But for capabilities you can create only one scoring profile and not multiple scoring profiles.

1. Create CI relationships or edit the existing relationships using CI relationships in the CMDB.
2. Relate business capabilities and business applications using the following pre-determined CI relationship types:

<table>
<thead>
<tr>
<th>Parent</th>
<th>Type</th>
<th>Child</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Capability</td>
<td>Provided By::Provides</td>
<td>Business Application</td>
</tr>
<tr>
<td>Business Application</td>
<td>Provides::Provided by</td>
<td>Business Capability</td>
</tr>
</tbody>
</table>

**Note:** Both the business capability and the business application are configuration item entities. The parent column of the capabilities table is used to create the capability hierarchy.

Create a business capability and relate the capability to a business application using the CI relationship editor.

Create business capability and relate the capability with an application

Business capabilities are the abilities of an organization to do an activity to fulfill its business goals. Align your organization goals with business capabilities by creating capabilities.

Role required: sn_apm.apm_admin

Use the Business Capability form to create and update a business capability. If you add a new capability, update an existing capability, delete a capability at a leaf node level, then the levels of all the capabilities and the leaf node in that hierarchy must be updated accordingly. Click the **Update Capability Level** and **HierarchyID** related link to update the levels in the hierarchy so that the capability map reflects the updates. The **Leaf Node** and the **Level** fields are rendered uneditable to you, yet you can view the level of the capability if it is at leaf node and its position in the hierarchy.

Following are the conditions to update or delete a capability:

- When you add a capability, the level of the new capability in the hierarchy is automatically assigned based on the level of the parent capability that is attached.
- If a parent capability is updated in the hierarchy, then the levels of all its child capabilities are recalculated. Otherwise, a capability can only be updated of its name, description, or parent.
- While adding or updating a capability the total number of levels cannot exceed more than six in the hierarchy. For example, the levels can be from 0 to 5, where 0 is the root level.
- You can delete capabilities that are at the leaf node level only. Or, a capability that does not have a child capability of its own.
- Do not create circular relationships. In creating a parent capability, a child capability cannot be its parent.

1. Navigate to **Application Portfolio Management** > **Administration** > **Business Capabilities**.

You can also navigate to **Organization** > **Business Capabilities**.
2. Fill in the form fields.

### Business Capability form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the business capability.</td>
</tr>
<tr>
<td>Parent</td>
<td>Select the parent capability for the capability that you are creating. When a parent capability is assigned, the business capability becomes a child capability. If no parent is assigned or the parent is null, then the capability is a root node capability. If the parent field is made null, then a message prompts you to run a scheduled job to update the business capability levels.</td>
</tr>
<tr>
<td>Level</td>
<td>View the level at which the capability is in the hierarchy. If there is no parent capability then the level is 0, which indicates that the capability is at the root level. Up to six levels are supported. If you add a capability or update it by changing its parent, then run the Update Business Capability Levels job, on demand. The job determines the capability level and updates all the capabilities with the level information. Note: The system updates the field and the user cannot.</td>
</tr>
<tr>
<td>Business Unit</td>
<td>Attach a business capability to the business unit organizational structure.</td>
</tr>
<tr>
<td>Order</td>
<td>Assign any integer value. Applicable only for level-0 capability. The number you assign determines the position of the capability in the sequential order of all other business capabilities in that capability hierarchy. The Order field is available only for root node or level-0 capabilities. The scheduled job checks for conditions such as order values entered for non-root capabilities, duplicate order values, and null value and eliminates such values. It calculates and sets the level and hierarchy ID for each capability.</td>
</tr>
<tr>
<td>Department</td>
<td>Attach a business capability to the departmental organizational structure.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Leaf Node</td>
<td>If the check box is enabled, then it means that it does not have child capability. Capability follows a parent-child hierarchy. Leaf node attribute in the capability denotes that it is not a parent of any other capability.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The system updates the field and the user cannot.</td>
</tr>
<tr>
<td>Hierarchy ID</td>
<td>For level 0 capability hierarchy ID is generated based on the order. For all non-root capabilities the hierarchy ID is generated based on the hierarchy ID of its parent. The number is prefixed to the business capability and you can view it in the capability hierarchy map. The capabilities are structured vertically according to their hierarchy IDs. Whenever a capability is updated such as if a parent is added or deleted then the hierarchy ID is automatically updated.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> By default, the system updates the field. Hence you cannot edit the field. However, if you prefer a different number or value for the hierarchy ID from what the system generates, you can reset the system property flag to True. Setting the property to true makes the Hierarchy ID field editable in the Business Capability form and you can enter the value. By this action, the system default logic of generating the hierarchy ID is overridden by your custom hierarchy ID.</td>
</tr>
<tr>
<td>Asset tag</td>
<td>Tag assigned to track the asset. It is an attribute of the parent capability that is inherited by the child.</td>
</tr>
<tr>
<td>Description</td>
<td>A short description of the business capability.</td>
</tr>
</tbody>
</table>

3. **Click Submit.**

If a root or a level-0 capability is created or if the parent field of a capability is rendered null, then a message prompts you to run the business capability update levels job to recalculate the hierarchy IDs.
4. To make the Hierarchy ID field editable, navigate to System Properties > All Properties.
   a) Click the `use_business_capability_custom_hierarchy_id` system property in the `sys_properties.list`.
   b) Enter true in the Value field.
   c) Click `Update`.

   **Note:** Since the hierarchy ID is customized, the system does not check for any conflicts in the number or value that you set.

5. To create child capabilities for the capability that you created, open the record and click New button in the Capabilities related list of the Business Capability form.

6. In the related links, click Update Capability Level and HierarchyID to update the levels in the hierarchy. Clicking the Update Capability Level and HierarchyID link executes the Update Capability Level and HierarchyID scheduled script. You can view the updated hierarchy in the capability map.

   If you had navigated to the Capability Hierarchy Map after updating the parent, order, or hierarchy ID but without running the update capability levels job, then a message prompts you to run the Update Capability Levels job and relaunch the page to render the capability hierarchy map with the latest change.

7. To relate the capability with an application, click open the business capability.

8. Click the Add CI relationship (+) icon in the Related Items section of the business capability form to launch the relationship editor and create the CI relationship.

   The relation between a business capability and business application must always be of type provided by::provides.

   View capability based planning to understand the hierarchy of capabilities mapped with its related applications and plan investments in applications if the technology of the applications is at a risk.

**Overview of business capability planning**

Capability based planning directs towards planning, designing, and delivering effective plans of action to improve business capabilities in a business enterprise. The effective implementation of capability based planning lies with the roles of business personas such as the business owner, application portfolio owner, and capability planner in understanding the existing capabilities and in planning to fill the technical gaps.

Capability based planning is a mechanism to better understand how to map strategic plans to your investments. If your capabilities are well defined, then your organization structure aligns to those capabilities, because the capability defines what the organization does.

Business capability is a configuration item (CI) that helps to understand how the business capability is supported by the related applications and services.

Capability based planning is structured as a hierarchy and supports up to six levels of capabilities in its series, which means a parent capability can have six levels of sub-capabilities beneath its level. However, a capability in each level of the hierarchy can have as many capabilities as its siblings at its own level and each one can have one-to-many relationships between the levels.
Personas governing capability based planning

Following are the personas with appropriate roles to use capability based planning:

**Business owner**

As a business owner it is important that you perceive the existing capabilities and work out strategies to identify the areas that need investments to plan for better allocation of expenses on projects.

**Application portfolio owner**

As an application portfolio owner, you have to identify those capabilities that impact your business applications and address them, so that the business applications function effectively.

**Capability planner**

As a capability planner, you have to establish capabilities in the light of the industry norms of applying procedures that have been termed as a best practice, being most effective and yielding best results.

What to do next

Use the capability map for planning investments in applications.

Use capability map for planning

Capability-based planning helps you to understand your business capabilities, and the business applications that support them, to achieve your business goals.

Role required: sn_apm.apm_analyst

Capability map is a pictorial representation of the capability-based planning displaying capabilities in a hierarchy. The hierarchical structure helps you to easily drill down to the lowest level and identify major and minor gaps. With this map, you get a complete view of all the capabilities, the applications associated to each of the capabilities, and the indicator scores of each business application in association with the capability.

The capabilities are color coded which enables you to identify, in a glimpse, those capabilities that have major, medium, and minor gaps. Since you have visibility of the business applications that support the capabilities, you can create goals, demands, or programs to improve the performance of the applications.

1. Navigate to Application Portfolio Management > Capability Ratings > Capability Map.

   The left pane lists all parent capabilities in the hierarchy. By default, the first business capability in the hierarchy at level 0 expands to display its immediate child capabilities at level 1. For subsequent business capabilities and child capabilities, click the icon to expand and view its sub-capabilities at each level. This view is similar across Business Capability, Technology Risk, and also in Manage Capability Hierarchy views.

   The left pane also displays the total count of sub-capabilities below each parent capability, the total number of business applications directly related to each capability, and their capability score. Similarly,
on expanding a parent capability, you can see the number of subcapabilities, the total count of business applications that are directly related to the sub-capability at that level.

The right pane displays the overall capability summary of the business capabilities in your enterprise with the following details. It shows the overall capability risk summary if you toggle to the technology risk view.
Capability Details

- 1.0 Develop and Manage Products and Services (16)
  - 1.1 Generate and define new product/service ideas (2)
    - 1.1.1 Generate new product/service concepts (1)
      - 1.1.1.1 Gather new product/service concepts (1)

- 1.2 Develop products and services (4)
- 1.3 Govern and manage product/service development program (7)

- 2.0 Market and Sell Products and Services (25)
- 3.0 Deliver Services (5)
- 4.0 Manage Information Technology (12)
- 5.0 Develop and Manage Human Capital (22)
- 6.0 Deliver Physical Products (21)
- 7.0 Manage Customer Service (13)
Total number of business capabilities that are displayed in the list on the left pane. The total number of capabilities is displayed for both **Business Capability** and **Technology Risk** views.

**Leaf Capabilities**
Total number of capabilities at the leaf level (that has no child capabilities of its own) in all the hierarchies of the business capabilities listed in the left pane.

**Assessed**
Total number of assessed business capabilities.

**Not Assessed**
Total number of capabilities that have not been assessed.

**Major Gap**
Total number of capabilities whose score fall within the range of 1-4.

The Technology Risk view displays the number of capabilities that use applications whose technologies are at a greater risk.

**Medium Gap**
Total number of capabilities whose score fall within the range of 4-7.

For Technology Risk view, it displays the number of capabilities that use applications whose technologies are at a medium risk.

**No Gap**
Total number of capabilities whose score fall within the range of 7-10.

For Technology Risk view, it displays the number of capabilities that use applications whose technologies have no risk at all.

2. By default the overall summary of capabilities is displayed. Use one of the following choices to configure the view, and the details that you want to see in the capability map:

- **Business Capability** view: Selecting **Business Capability** enables the scores view. It displays the capabilities and applications associated with it.
  
  With this view, you have the following search option:
  
  - **Fiscal period**: Select a fiscal period to view the capability scores generated for that fiscal period. If the capability is not assessed for the fiscal period, then it displays as **Not Assessed**. Conversely, you must also select a fiscal period to view the capability details, otherwise the system alerts you with an error message.

- **Technology Risk** view: Select the **Technology Risk** view to know the capabilities that are at risk due to their end of life or expired technologies. It displays the overall summary of business capabilities and the technology risk of each business application. It also shows the capabilities that are impacted as a result of the technology risk. The technology risk on the capability is derived from the technology risk on a business application.

**Enter Search Capabilities**
Use the **Enter Search Capabilities** field to enter a text and search a business capability that you are looking for.

Legend (i)
Lists the categories in color legends and the corresponding description. Also lists icons used in the map.

**Create**

Click the list to create a demand, a goal, or a program for the capability that you have currently selected.

Similarly, toggle over to the technology risk view to raise a demand, create a goal, or a program for the underlying technology of an application if the technology is at risk.

**Note:** The Program option is available only when you activate the PPM Standard (com.snc.financial_planning_pmo) plugin.

**Manage Capability Hierarchy**

Enables you to create a level-0 capability, add a child capability, edit an existing capability, and also to delete a leaf-level capability in the capability map. You can manage all the business capability relationship in the UI without having to navigate to the Business Capability form to do these functions.

3. Expand each business capability to view the capability details and technology risk details. See View business capability details in capability map and View technology risk details in capability map.

*View business capability details in capability map*

Use the capability map to assess capabilities on dimensions such as people, process, and technologies and plan investments accordingly. View the current trend of your business applications and plan to potentiate them by creating goals, demands, and programs and track their progress in the map.

Role required: sn_apm.apm_analyst

1. Navigate to Application Portfolio Management > Capability Ratings > Capability Map.
2. Select the Business Capability view.
3. Click each capability to view the sub-capabilities and their details.

The left pane of the map displays the capabilities along with the following information:

**Number of sub-capabilities**

At each capability level, the total count of sub-capabilities and their subsequent level of sub-capabilities is listed within brackets next to the name of the capability. That is, at the parent capability level, the total number of child capabilities and their direct child capabilities is listed.

**Number of applications linked to the capability**

The applications icon ( ) displays the total count of applications that are related to that capability.

**Capability score**

The capability score for the business capability, rounded to two decimal places only, is displayed in a color-coded box next to the application count. The colors indicate:

- Major gap: red color, scores in the range of 1–4.
- Medium gap: orange color, scores in the range of 4–7.
- No gap: green color, scores in the range of 7–10.

The capability is assessed for the selected fiscal period of the business capability and the score data is retrieved from the apm_app_score table.

The overall score of parent capability is the average sum of the scores of all the direct child capabilities. That is,
Score of parent capability = Score of all child capabilities / total number of child capabilities

If the parent capability is not assessed and displays (n/a) instead of a score, then it means that all its child capabilities are not assessed. However, if one of the child capabilities is not assessed, then the parent capability score is calculated based on the scores of the other child capabilities that have been assessed.

Capability levels and assessment

The map displays capabilities up to six levels. The capability that is at the lowest level or the capability that does not have a child is called the leaf level. Only the leaf level capabilities are assessed on the dimensions of people, process, and technology. The capability in the hierarchy that does not have a parent is the level 0 or root capability.

The right pane of the map displays the details of the capability selected on the left pane, and all the business applications that are related to that capability.

Details

With the Business Capability view, all the data of the selected capability are displayed in the Details tab.
Capability based planning

- Capability based planning

  - Capability: Displays the name of the business capability that is selected. Click the capability name to navigate to the Business Capability form and view the record details of the selected capability.

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
- **Capability Score**: Displays the capability score of the selected business capability and the individual indicator scores based on the dimensions of people, process, and technology.

  **Note:** If the business capability is at the leaf level, with no sub-capabilities, then the capability score is clickable. On clicking the link, the CI Scores form opens to display the score of the business capability configuration item for the fiscal period selected in the capability map.

  Similarly, the indicator scores of People, Process, and Technology are clickable if they are for the leaf capabilities only. Clicking each of these links opens the Indicator Scores form of the business capability configuration item for the relevant indicator and the fiscal period selected in the capability map.

- **Project**: Displays the total number of projects that the selected business capability is part of. The project attached to a sub-capability rolls up to its parent. Likewise, the projects of all the sub-capabilities in a hierarchy rolls up to the root, level 0, capability.

  Clicking the number of projects opens the Projects form with the project details for the business capability.

- **Demand**: Displays the total number of demands created for the selected business capability. The demand created for a sub-capability rolls up to its parent. Like manner, the demands attached to all the sub-capabilities in a hierarchy rolls up to its root, level 0, capability in the hierarchy.

  When you select a capability or a sub-capability in the left pane of the map, the total number of demands and projects created or added to the capability, sub-capability, or its technology is displayed on the right pane. Selecting a parent capability displays the consolidated total number of demands created either for the parent or for its child capabilities.

  Clicking the number of demands opens the Demands form showing the demand details for the business capability.

- **Total Project Investments**: Displays the total amount invested on the selected business capability in the selected fiscal period. Total project investments are the consolidated amount of investments made on the capability through one or more projects. You can create a project to achieve an objective of one or more business capabilities. Similarly, you can have a business capability tied to more than one project to achieve the goal of the business capability.

  **Note:** The Project and Total Project Investments details are available only when you activate the PPM Standard (com.snc.financial_planning_pmo) plugin.

  If a project is created to achieve the goals of any two business capabilities, then the **Total planned cost** of the cost plans attached to the project is split equally between the two business capabilities. For example, if $100 is invested on project P1, which impacts business capabilities BC1 and BC2, then the invested amount of $100 is split as $50 each between BC1 and BC2, respectively.

  The investment made on a child capability rolls up to its parent. Likewise, the investments made on all the sub-capabilities in a hierarchy rolls up to the level 0 capability in the hierarchy.

**Business Applications**

Displays the names of the applications that are directly and indirectly related to the capability and their overall scores.

Directly related applications are those applications that are directly related to the capability. Indirectly related applications are those applications that are related to another capability in that capability hierarchy. That is, the application is related to either any of the parents or any of the children in that hierarchy.
Both the **Business Capability** and **Technology Risk** views have the option to display direct and indirect business applications. However, the details displayed regarding the applications slightly vary.

- **Business Capability** view: Displays the names of the business applications on the right pane, which are related to the selected business capability on the left pane, and the overall score of each individual application.

![Business application overall score view](image)

**Business application overall score view**

Click the business application hypertext to navigate to the Business Application form and view the record details.

Click the information icon

![Information icon](image)

of an application to view the following details:
Business application indicator score

- **Project Investments**: Displays the total amount invested in the selected business application for the stipulated fiscal period. Project investments are the consolidated amount of investments made on a business application through one or many projects. You can create a project to fulfill an objective of one or more business applications. Similarly, you can have a business application tied to more than one project to achieve the goal of the business application.

If a project impacts one or more business applications, then the **Total planned cost** of the cost plans attached to the project is split equally among the business applications. For example, if $100 is invested on project P1, which impacts business applications, BA1 and BA2, then the invested amount of $100 is split equally as $50 each between BA1 and BA2, respectively. Similarly, you can invest in one or more projects that can be tied to one business application (BA1). The invested amount is split equally among the applications tied to each of these projects. The resultant consolidated amount from different projects is the project investment of the business application (BA1).

**Note**: The Project Investments and Projects are available only when you activate the PPM Standard (com.snc.financial_planning_pmo) plugin. You cannot roll up cost in the case of business applications as it is an independent entity and is not hierarchical, whereas investment rollup is possible in business capabilities.
Project investments cannot be made for both business capability and business application within a project. Total planned cost of a project is considered either for business capabilities if you are investing in business capabilities or for business applications if you are investing in business application, and not for both.

- **Production Instances**: Number of application services of the production type that the business application is related to.
  
The data is retrieved from the CI Relationships [cmdb_rel_ci] table based on the consumes::consumed by relationship between the business application and the application service.

- **Demands and Projects**: The number of demands and projects created at the business application level.

- **Score indicators**: The number of indicators on which the business application is assessed. It also displays the individual score of each indicator.

- **Capabilities supported**: Scrolling down in the pop-up you can also view the number of capabilities the business application supports and the name of each of the capabilities.
  
The association between the business capability and the business application is based on the provided by::provides relationship type in the CI relationships table.

Use the pagination option to display business applications attached to the business capability that you select on the left pane. You can view a maximum number of 10 business application records related directly and indirectly to the capability. Click the left or right arrow to continue to view the previous or next set of records. The pagination option is available for all levels of a capability. The option is helpful to view the business applications of all the capabilities consolidated at the root level capability, especially when there are many applications attached to it.

**Services**

The tab displays the names of the services that are related to the selected parent business capability on the left pane. You can sort services in alphabetical or reverse order, search for a service, and view only a selected number of services using the pagination option.

Click the service hypertext to navigate to the service record and edit the record. The business capability is related to the service by establishing Provided by::Provides CI relationship.

**View technology risk details in capability map**

Use the technology risk view of the capability map to know the risk profiles of the technologies that support the business capability.

Role required: sn_apm.apm_analyst

Enabling the **Technology Risk** view displays the number of underlying technologies of the selected business capability that are at low, medium, and high risks.

1. Navigate to **Application Portfolio Management > Capability Ratings > Capability Map**.
2. Select the **Technology Risk** view.

   The **Technology Risk** view displays the business capabilities (on the left pane) with the overall capability risk summary (on the right pane). Expand the parent capability to view its sub-capabilities and its associated risk details on the right pane.
The tab shows the number of technologies underlying the selected capability at high, medium, and low risks. Click the capability name to navigate to the Business Capability form and view the record details of the selected capability.
Business Applications

You can view the technology risk at a business application level. The risk profile of the business application is stored and retrieved from the Business Application Risk [sn_apm_tpm_business_application_risk] table.

Business application risk profile

- Click the information icon ( ) of an application to view the number of capabilities the business application supports and the names of the capabilities.
- To view the application record details, click the business application hypertext and navigate to the Business Application form.
- Click the view list of related technologies icon ( ) to navigate to the Technology Portfolio Management timeline view to view the risk profile of the business application. Filter the applications to take an active measure on the underlying technologies that are at risk.

Services

The tab displays the names of the services that are related to the selected parent business capability on the left pane. You can sort the services in alphabetical or reverse order, search for a service, and view only a selected number of services using the pagination option.

Click a service hypertext to navigate to the service record form to edit the record. The business capability is related to the service by establishing Provided by::Provides CI relationship.
Manage capability hierarchy in the capability map
Create a root-level capability, add a child capability to a parent, edit a capability, and delete a leaf capability, and manage the relationships between the capabilities in the capability map.

Role required: sn_apm.apm_analyst

When you add a child capability or update its order in the hierarchy you can view the effect of your changes immediately in the hierarchical tree view of the capability map by refreshing or reloading the page. Whereas, when you add or edit a level-0 capability the Update Business Capability Levels scheduled job that updates the business capability levels is automatically executed to update the order and hierarchy of the capabilities in the map. Updating your business capabilities in the capability map saves your time and gives quick access to the updated data in the map.

1. Navigate to Application Portfolio Management > Capability Ratings > Capability Map.
2. Click Manage Capability Hierarchy button.
   The capability map opens up in the edit mode.
3. To create a level-0 capability, click New Capability button.
4. On the form, fill in the fields.

   Business Capability New Record form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the business capability.</td>
</tr>
<tr>
<td>Description</td>
<td>Short description of the business capability.</td>
</tr>
<tr>
<td>Parent</td>
<td>If the capability is to be a root level capability or at level 0, then leave the field blank. Adding a parent renders the capability as a child and not as a root capability.</td>
</tr>
</tbody>
</table>

5. Click Submit.
6. To add a child to a root capability, click the ellipses (…) icon adjacent to the root-level business capability for which you intend to add a child capability.
7. Click the Add Capability button and fill in the Business Capability New Record form fields.

   Note: The Parent field is auto-filled with the name of the selected root capability.
8. Click Submit.
9. To edit a capability, click the … icon adjacent to the root-level business capability.
10. Click the Edit Capability button and fill in the Edit Business Capability form fields.

   Note: The Name field is auto-filled with the name of the root capability. You can do the following with the edit option:
   • Edit the name and description of a capability.
   • Move a root-level capability as child capability in a different hierarchy.
   • Edit a child capability to make it as a new root-level capability.
   • Move a child capability from one root to another root.

   You can either enter a new name or keep the same name to the capability and add a parent to move the root-level capability from the existing hierarchy to a different hierarchy as a child capability. In a business scenario, this functionality is especially useful when you have to move
a business capability from one business unit to another. For example, if your organization decides to move the Reward and Retain employees business capability from Finance to HR, then the business capability (along with its child capabilities) can be moved from Finance and appended in the HR business capability hierarchy.

11. Click Submit.

12. To delete a leaf capability, go to the leaf capability click the icon adjacent to the leaf capability.

13. Click the Delete Capability button.

**Note:** The Delete Capability button is available only for a leaf-level capability. A leaf-level capability is the one that does not have a child of its own.

14. Click Delete.

**Note:** Delete action removes the capability from the business capability [cmdb_ci_business_capability] table. It also removes the relationship that the capability has with the other configuration items in the CI relationship table.

15. Refresh or reload the page, for the map to reflect the changes that you made.

Technology Portfolio Management

The underlying technologies of the business applications used in your business enterprise have a shelf life that must be actively managed and diligently monitored to track their versions and lifecycle. Use the timeline view of the Technology Portfolio Management to track their dates and thereafter create a demand or a project to upgrade or retire them.

The technology of a business application is also known as a software model. A software model is a specific version or configuration of a software.

The software models used in your business applications can be operating systems, database management systems, development tools, and middleware, each of which has a lifecycle. If these lifecycle stages are not tracked, there are risks where the vendor may not support them any longer and the business applications that run on these technologies are at stake.

Creating an inventory of all technologies used in the enterprise helps to:

- Track the versions of the software and manufacturer support dates for the software.
- Set an internal lifecycle guidance for the software.
- Assess risk in using outdated software.
- Plan to retire them just like the applications they support, at a definite date.
- Support upgrade processes.

Internal and external lifecycle stages of the software model

The business applications used in your organization are all linked to one or more application services. Each of the application services run on one or more technologies or software models.

**Note:** In the context of Application Portfolio Management, an application instance is an application service.
The software model has a sequence of lifecycle stages/phases from their installation to retirement. Internally, business organizations set a date based on the lifecycle phase of the software models. These phases can be Early Adopter, Mainstream, Declining use, and Retired.

The vendor also sets a date for the software based on the vendor lifecycle phases such as Pre-release, General Availability, End of Life, and Obsolete. The support from the vendor may vary depending on the phase of the technology. When the software model reaches the stage of obsolescence, the vendor may stop supporting the technology.

**Note:** The Publisher choice type of the Lifecycle type field in the Software Model Lifecycle form is the same as the External Lifecycle that is being used in APM.

As a software asset management user or a software model manager you can add the software model lifecycle details to the software model. To use TPM screen with data on the timeline, ensure that the software lifecycle data is populated in the software model table. Similarly, ensure that the hardware lifecycle data is populated in the hardware model table after the technology models suggestion engine runs.

**Integration with Service Mapping to use Technology Portfolio Management**

Create application instances in Mapped Application Service [cmdb_ci_discovered_service] table and relate business applications to corresponding application services.

APM no longer integrates with Service Mapping through the Instances tab. The application Instances tab has been removed and the apm_app_instance table has been deprecated, which is replaced by the Mapped Application Service [cmdb_ci_discovered_service] table. Any data existing in the application instances table must be migrated to the application service table. If you are upgrading to the Madrid release, then contact the ServiceNow personnel for migrating the data.

**Note:** If you are using Mapped Application Service [cmdb_ci_service_discovered] table for application instances, then you can proceed to upgrade from Kingston. However, if you are using the deprecated apm_app_instance table to store application instances, then migrate the data in apm_app_instance table to Mapped Application Service [cmdb_ci_service_discovered] table.
Connecting software lifecycles to business application

TPM depends on SAM to retrieve the technology information of the software product

You can use Technology Portfolio Management even if you do not have Software Asset Management (SAM) installed. A preconfigured Software Product Model table is available to all TPM users. You can create a list of all software models that your organization uses either manually or import from existing database or source.
Using TPM depends on SAM plugins and the dependency is as follows:

**With SAM Premium plugin**

To access the Product Classification [samp_sw_product] table, you require the Software Asset Management Premium plugin. Reference to samp_sw_product_classification is in samp_sw_product table. This content table is referenced in the Software Product Model [cmdb_software_product_model] table to retrieve the technology information. Subscribing to SAM Premium plugin enables you to view the applications by Business Applications as well as by Product Classification in the TPM timeline.
TPM timeline showing By Product Classification view

Without SAM plugin

Product classification is not available without this plugin and hence view by Product Classification is not available in the TPM timeline view. Software model information is retrieved from SW Product Model [cmdb_software_product_model] table. Populate this table manually or export the content from an excel sheet.
View technology risks in timeline

View the internal and external life-cycle phases of all technologies or the product models that are used in your organization in the Technology Portfolio Management timeline. You can identify the stages at which the technology is, in terms of the risk factor by their color code.

To view your data in the TPM timeline view:

- Create an inventory of business applications.
- Relate the business application with an application service.
- Associate the application service with the software models.
- Associate the application service with the hardware models.

The Enterprise Architect (EA) can use the timeline view to track the versions and life cycles of technologies, and the number of applications running on those technologies. EA can assess risks on a business application due to its end of life, and create demands and projects as needed.

The lines in the TPM screen indicate the life cycles of the product models. The lines are color coded, which indicates the stages of risk the software model is in, at that quarter or year.

Note: In the context of Application Portfolio Management, business services are referred to as application services. Application services are created based on the service [cmdb_ci_service] table.

Role required: sn_apm.apm_user

1. Navigate to Application Portfolio Management > Technology Portfolio Management (TPM) > Technology Lifecycles.
2. Select a view grouped By Business Application, By Product Classification, By Software Model, or Application Backlog. See views in TPM timeline.
3. By default, the Quarterly button is enabled to show the timeline for the four quarters of a year. Click the Monthly button to toggle and view the timeline across all the months in a year. The monthly view helps you to track the risk stage of an application for any specific month in a year.
4. Click the production icon ( ) to view the production instances that are liable to risks in the current quarter or month.
5. Click show all lifecycle data sources icon ( ) to display the timelines of all the sources of a software model related to a business application. Use the icon to toggle between show and hide the data sources.

You can view the timelines of life-cycle data sources in By Business Application, By Product Classification, By Software Model views, and Application Backlog view. All available sources for a software model are queried and retrieved from the Software Model Lifecycle [sam_sw_model_lifecycle] table. The Choices [sys_choice_list] table lists all the sources of the software models corresponding to the Software Model Lifecycle [sam_sw_model_lifecycle] table.

The sources of software life-cycle data can be internal and can also come from multiple external sources. The life-cycle phase information of the internal data with one external publisher data, with the least sequence number from the Choices [sys_choice] table, is collated and displayed for each of the software models in the timeline. The other external publisher data sources, if present, are not shown in the timeline. Moreover, the overlapping of internal and the external publisher information in the software model timeline can make the phases indistinguishable between the two sources.

Showing all lifecycle data sources helps in displaying all the publisher data sources for the product model as separate timelines instead of one with the least sequence number. The life-cycle information
for each of the sources, whether internal or external, are shown separately. In the presence of more than one external publisher source, the sources displayed are in alphabetical order. As the life-cycle phase information is not merged or collated, the phase details for each source are comprehensible on the timeline.

6. Click the legend icon (i) to understand the indications of the markings on the timeline, and the color-coded lines.

The gradation in color denotes risks, gradually phasing out from one stage to the phasing in of the next stage. You can view the legend for projects only when you activate the PPM Standard (com.snc.financial_planning_pmo) plugin.

7. Click Create list to create a demand or a project.

Note:
Project in the list appears only when you activate the PPM Standard (com.snc.financial_planning_pmo) plugin.

8. To view and edit the application services, hardware and software models, projects, and create demands associated with the business application, click to expand a business application in the Application column. See Perform application-related tasks from timeline.

Note:
You can create a project for a business application only when you activate the PPM Standard (com.snc.financial_planning_pmo) plugin.

9. Point to the risk bubble in the Risk column to view the risk of each business application. You can also view the underlying technology risk status of a business application in the By Business Application view.

Risk information is retrieved from the business application risk table.

Risk is calculated for all business applications that are active. A business application that consumes an application service is said to be active, and the relationship between the two is established in the CI Relationships [cmdb_rel_ci] table. The engine evaluates the risk of each application service (of production type only). It also evaluates the risks of all the application services consumed by a business application collectively from the Application Service Risk [sn_apm_tpm_business_service_risk] table. If the risk of any one of the application services is at a higher level, then the overall risk is high.

Formerly business application risks were calculated dynamically while loading the TPM timeline. To reduce the load to the risk engine, the engine now calculates the risk of each business application and stores the information in a Business Application Risk [sn_apm_tpm_business_application_risk] table.

Run the Load TPM Risk Parameters and compute Application Service Risks scheduled job daily to obtain the risk status of the application services on which the business applications run.
10. Click the risk bubble of a software model to view the scores at the risk parameter level. 

**TPM risk profile of software model**

You can configure the scripts of the preconfigured risk parameters to evaluate your own risk values, which are stored in the `Risk Parameter Score [sn_apm_tpm_risk_param_score]` table.

11. Click the risk bubble of a hardware model to view the breakdown of its risks. 

**TPM risk profile of hardware model**

12. Use the pagination option to populate the first 15 business applications, along with their related application services and software models.

As a maintenance user, you can configure it to load up to 20 or 25 business applications in the Application column.

a) Navigate to **System Properties > All Properties.**

b) Click `sn_apm.noOfBusinessAppsPerTPMPage` to update the value.

c) Click **Update.**

13. Click the life-cycle phase icon ( ) on the hardware or software timeline to view the life-cycle information of the hardware or software model in a pop-up.

The vertical line on the timeline indicates the current quarter that you are in. See **Software model lifecycle data on the timeline.**

**Multiple views in TPM**

Multiple views within a TPM timeline screen facilitate users to view the risks of business applications in the way they want. Views can be a simple list of applications, categorizing the applications by products based on their functions, or by the underlying technology of the applications.
In each of these views, you can drill down to the respective underlying application service that is supported by the application, the underlying technology on which the application runs, or the business application that is used.
Technology Portfolio Management timeline view

- Employee Engagement Service APAC
  - Software Models (2)
    - Oracle DB Server 12c: R1 Enterprise
    - Oracle DB Server 11g R2 Standard
  - Hardware Models (2)
    - APC 42U 3100 SP1 NetShelter Rack
    - Dell Inc. PowerEdge T410
  - Employee Engagement Service USA
    - Software Models (2)
      - Oracle DB Server 11g R2 Standard
      - Oracle DB Server 12c: R1 Enterprise
    - Hardware Models (1)
      - Dell Inc. PowerEdge T110 II
  - Projects (5)
    - Managed HR Documents Implementation
  - Domains (5)
    - Implement Sales Quoting system
**By Business Application view**

The By Business Application view displays all the software models and hardware models that are tied to the application services of a business application.

By Business Application view displays the Business Applications > Application Services > Software Models, and Hardware Models or the technology structure in a succession. You can also view the applications by their manufacturers (for example, Oracle, SAP).

In the By Business Application view, you can do the following:
Use the business application risk filter to filter the business applications based on their risk factor.
High Risk. Select Show All Risks option to display business applications with all types of risks (high, medium, low, and not assessed). You can also filter business applications that have not been assessed. Based on the filtered criteria, you can view most or all business applications in the Application column.

- Use the filter icon (🔍) to search and filter applications using any attribute that is present in the business application table. Use the condition builder in the Set Business Application filter dialog box to define the filter. You can set as many conditions that you may require to filter the records appropriately using the New Criteria button. If you log in again with the same user credentials, your filter preferences are saved for future, unless you edit or clear the filter conditions.
- Add a new demand or project to the business application. Point to the business application and click the add new project or demand icon (➕) that appears next to the application name. The demand or the project form has the name of the business application populated in the Business Applications field for which you are creating the demand or project.

Note: You can add a project to the business application only when you activate PPM Standard (com.snc.financial_planning_pmo) plugin.

By Product Classification view
With the By Product Classification view, you can see the technology Category > Software Models > Business Applications > Application Services structure in a succession.

This view also lists applications by technology category. For example, data technology, server technology, network technology, and application technology.

This view displays all software models including those software models that are not associated with a business application.

You can select this view to dynamically load all technology categories. Expand a technology category to load all the software models associated to the category. Similarly, expand a software model to view its associated business applications, and expand a business application to view its related application services, demands, and projects.

Note:
You can view projects only when you activate PPM Standard (com.snc.financial_planning_pmo) plugin.

With the By Product Classification view, you can perform the following search:
By Product Classification view

- Use the **Enter Search Software Model** field to enter the name and search a software model from the list in the **Category** column.
**By Software Model view**

The By Software Model view displays the **Software Models > Business Applications > Application Services**.

By this view you can view the list of all software models. When you click to expand the software model, you can view all the business applications that run on that software model. On further expansion of the business application, you can view all the application services that the business applications support.

There is no direct cmdb CI relationship between a business application and a software model. Whereas a business application and an application service are related by cmdb relationship. For the application service, there are related software models that are stored and retrieved from the Application Service Software Models [sn_apm_tpm_service_software_model] table. Hence, the advantage of the By Software Model view is that you can directly view all the business applications that run on that software model.

By this view, you can only view the software models that have at least one or more business applications running on it.
### Technology Portfolio Management

**By Software Model view**

<table>
<thead>
<tr>
<th>Software Model</th>
<th>Risk</th>
<th>2019</th>
<th>2020</th>
<th>2021</th>
<th>2022</th>
<th>2023</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft SQL Server 2016 Enterprise</td>
<td>🟧</td>
<td>☢️</td>
<td>☢️</td>
<td>☢️</td>
<td>☢️</td>
<td>☢️</td>
</tr>
<tr>
<td>Big Splash</td>
<td>🟧</td>
<td>☢️</td>
<td>☢️</td>
<td>☢️</td>
<td>☢️</td>
<td>☢️</td>
</tr>
<tr>
<td>Application Services (2)</td>
<td>🟧</td>
<td>☢️</td>
<td>☢️</td>
<td>☢️</td>
<td>☢️</td>
<td>☢️</td>
</tr>
<tr>
<td>BOBJ</td>
<td>🟧</td>
<td>☢️</td>
<td>☢️</td>
<td>☢️</td>
<td>☢️</td>
<td>☢️</td>
</tr>
<tr>
<td>Microsoft SQL Server 2016 Standard</td>
<td>🟧</td>
<td>☢️</td>
<td>☢️</td>
<td>☢️</td>
<td>☢️</td>
<td>☢️</td>
</tr>
<tr>
<td>Business Applications (2)</td>
<td>🟧</td>
<td>☢️</td>
<td>☢️</td>
<td>☢️</td>
<td>☢️</td>
<td>☢️</td>
</tr>
<tr>
<td>Microsoft/Windows Server 2008 R2 Standard</td>
<td>🟧</td>
<td>☢️</td>
<td>☢️</td>
<td>☢️</td>
<td>☢️</td>
<td>☢️</td>
</tr>
<tr>
<td>Microsoft/Windows Server 2012R2 Standard</td>
<td>🟧</td>
<td>☢️</td>
<td>☢️</td>
<td>☢️</td>
<td>☢️</td>
<td>☢️</td>
</tr>
<tr>
<td>Oracle DB Server 11g R2 Standard</td>
<td>🟧</td>
<td>☢️</td>
<td>☢️</td>
<td>☢️</td>
<td>☢️</td>
<td>☢️</td>
</tr>
<tr>
<td>Oracle DB Server 12c R1 Enterprise</td>
<td>🟧</td>
<td>☢️</td>
<td>☢️</td>
<td>☢️</td>
<td>☢️</td>
<td>☢️</td>
</tr>
<tr>
<td>Oracle WebLogic Server 12c R2 Enterprise</td>
<td>🟧</td>
<td>☢️</td>
<td>☢️</td>
<td>☢️</td>
<td>☢️</td>
<td>☢️</td>
</tr>
</tbody>
</table>
You can also do the following:

- Search the software models.
- Set conditions to filter the software models.
- Display a selected number of software model records using the incremental pagination option.
- Add a demand or project to the software model. Point to the software model and click the icon that appears next to the software model name. The demand or the project form that opens has the names of the business applications that run on the selected software model, populated in the Business Application field.

**Note:** You can add a project to the software model only when you activate PPM Standard (com.snc.financial_planning_pmo) plugin.

**Application Backlog view**

As an enterprise architect this view helps you to understand the epics, stories, and enhancements, which are the units of work in scrum, that impact your business application.

**Note:** Activate Agile Development 2.0 (com.snc.sdlc.agile.2.0) plugin to get the Application Backlog view in the TPM timeline.

Application Backlog view helps you to look into the centralized backlog of records that are of different task types such as epics, stories, and enhancements. This view facilitates prioritizing and sequencing of different task type records in one location, saving you from sorting and filtering them in many steps. In this view, you can:

- View all applications (first column) that are at a high risk by default, however you can filter based on the intensity of their risk in the second column.
- Filter the application records by any attribute in the business application table. Switch to either quarterly or monthly view of the timeline (third column).
- Create a project or demand to add to the application.
- Paginate the number of applications to be displayed in a single view.
- Expand the business application to view its unified backlog of epics, stories, enhancements, projects, and demands attached to the application. You can also see the total number of these entities within brackets.

You can view the following application backlog entities on the timeline in addition to the projects and demands attached to the application:
<table>
<thead>
<tr>
<th>Application Backlog</th>
<th>Risk</th>
<th>2016</th>
<th>2017</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Q4</td>
<td>Q1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Q2</td>
<td>Q3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Q4</td>
<td>Q1</td>
</tr>
<tr>
<td>Avid Employee Engagement System</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Epics (11)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Customer Portal</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Employee Portal</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Executive Portal</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- HR Career Development</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Stories (7)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- HR Survey Management</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Stories (5)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- HR Training</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Incident Management Portal</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Line Manager Portal</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Network health check</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Supplier Portal</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Web diagnostics</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Others (8)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Enhancements (4)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Projects (1)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Demands (1)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The high-level business goal of the application is broken down into one or more epics. Epics organize the work required to complete parts of the application goal in small pieces. Epics are further broken down to stories, which are fundamental units of work, that describe the business requirement briefly and can be completed within a sprint. The timeline for the epics is displayed based on the planned start date and planned end date of the epic. The status of epics must not be in Complete or Canceled state.

Stories

Stories usually are part of an epic. The stories contained in the epic attached to the business application that are not in Complete or Canceled state are displayed in the timeline. The timeline starts with the planned start date and ends with the planned end date of the sprint to which the story is tagged.

Others

There can be stories that are not attached to an epic but directly associated to the business application itself. Such stories are listed within the epics as Others and displayed in the timeline.

Enhancements

Enhancements are special requests that come from users with non-scrum role. A scrum product owner reviews these requests and creates one or more user stories. Enhancements in Closed Complete, On Hold, and Canceled state are not displayed in the timeline. The enhancement timeline runs from the Planned start date to its end date when the sprint work is scheduled to begin and end.

Projects

If the PPM Standard (com.snc.financial_planning_pmo) plugin is activated, then you can add a project to the business application.

Demands

If the PPM Standard plugin is not activated, then by default, a demand is created.

Note: For the timeline to display the epics, stories, and enhancements, each of these records should reference the business application attached to it. See Associate epic to business application for more information.

Application column

All the epics, stories, enhancements, projects, and demands listed in the application column are clickable. Clicking each of them opens the record in a new tab that the clickable field points to.

Risk column

Shows the risks of the business applications only and not the risks of epics, stories, enhancements, projects, or demands.

Timeline column

The start and end dates of the units of work attached to the business application are plotted as a continuous line. However, if only one date is present, either the start or end date, then just that date is plotted as a filled circle.

Associate epic to business application for Application Backlog view
An epic must reference the business application for it to be displayed in the Application Backlog view of the timeline.

Role required: admin, scrum_user, or scrum_admin

1. Navigate to Agile Development > Epics.
2. Click update personalized list icon (gear) in the Epics list view.
3. Move Business Application to the Selected list.
4. Click OK.
5. Double-click the Business Application column of the epic and add the business application.
6. Click the Save icon.

In a similar way, you can add a business application to Stories and Enhancements in their respective list view of the Agile Development application.

Use timeline to execute your application strategy

Application column of the By Business Application view lists all the business applications that are used in your organization. If you toggle to the By Product Classification view, you can view all the technologies in the Category column. In the By Software Model view, you can view all the software models.

Role required: sn_apm.apm_user

By default, the TPM timeline view expands the first business application in the list to display its associated application services at the first level. It then displays the software and hardware models underlying the application service at the next level.

For the subsequent list of business applications, click to expand the arrow of the business application label to see the count and list of application services that are tied to the application. You can also view the underlying software and hardware models that are associated to the business application.

Application Services, Software Models, and Hardware Models headers are in bold font to distinguish them from the application service, software, and hardware model labels that are in hypertext.

1. To navigate to the Business Application form and view the record details and update, click the business application label.
2. To navigate to the Application Service form and update the record details, click the application service label.
3. To navigate to the Software Model form directly from the TPM timeline, click the software model label. You can modify the lifecycle details of the software model in the form.
4. To navigate to the Hardware form and to add or update the hardware lifecycle details in the Hardware Model Lifecycles related list, click the hardware label.
5. To add a demand or project to a particular business application (in the By Business Application view) or to a software model (in the By Software Model view), point to the application or the software model and click the add new project or demand icon (gear) that appears next to the application or software model name.

**Note:**

You can create a project for a business application only when you activate PPM Standard (com.snc.financial_planning_pmo) plugin.

In the New Demand form, you can see the business application name being auto-populated in the Business Applications field.

You can add a demand to more than one business application. A demand (that may or may not be initially attached to a business application) can be attached to another business application as well.
To add a demand to a business application, and view the demand in the timeline view of the TPM page:

a. Navigate to Application Portfolio Management > Application Portfolio Analysis > Demands.

b. Click open the demand.

c. Select the business application in the Business Applications choice list of the Demand form to which you want the demand to be added.

d. Save or Update the record.

e. Navigate to Application Portfolio Management > Technology Portfolio Management (TPM) > Technology Lifecycles and refresh the timeline view of the TPM page.

You can view the number of demands that are added to the business application. Click the arrow to expand and view the demand names.

**Note:** The start and end date of the demand that is attached to a business application is plotted on the demand timeline. If only one date of the demand is present, either the start or end date, then that date is plotted as a point.

**Product model lifecycle data on the timeline**

The lifecycle data of hardware and software models depend on its type, phase, source, dates, and the associated risk. Understand the conditions and considerations applied to denote the software model risks on the timeline. This knowledge enables you to decode the characters on the timeline.

**Lifecycle phases on the timeline**

The timeline depicts two types of lifecycles, which are publisher and internal. The Publisher Lifecycle information that is shown on the pop-up of the timeline are retrieved from the Software Model Lifecycles [sam_sw_model_lifecycle] table for the software and Hardware Model Lifecycle [cmdb_hardware_model_lifecycle] table for the hardware. This information is denoted as characters such as S and I on the timeline. S, for example, denotes ServiceNow and I for Internal Lifecycle.

**Note:** Both the hardware and software models are together referred to as product model.
As a SAM user or software model manager, you can add the software model lifecycle to the software model. This table holds the information to the software model, its lifecycle type (internal or external), lifecycle phases, start date of the phase, and the risk.

As a hardware model manager, you can add lifecycle data to a hardware model.

**Note:** The start date of a subsequent lifecycle phase marks the end of the previous lifecycle phase. Hence there is no phase end date specified in the lifecycle information pop-up.

If you do not want a lifecycle phase to be rendered on the TPM timeline, then set the **Active** flag of that software model lifecycle record to false. For example, you can have **General Availability**, **End of Extended Support**, and **End of Support** lifecycle phases as three records for **Oracle DB Server** software model in the Software Model Lifecycles list. However, if you do not want **General Availability** phase to be shown on the timeline, you can clear the **Active** check box in the Software Model Lifecycle form for that lifecycle phase record. As a result, the timeline starts with the End of Support phase. Although the lifecycle phase record exists for the software model lifecycle, the lifecycle data will not be rendered on the timeline. Because only active lifecycle records are considered and plotted in the TPM timeline.

**Lifecycle sources on the timeline**

The sources of the publisher and internal lifecycle types are generated externally and internally, respectively. The records that are created internally are marked as ![I](image) on the timeline and you cannot edit such product model lifecycle source. But, if the publisher is external and if there are more than one publisher source for the same product model, then you can configure your preferred publisher source using the **field mapping functionality** to the **Sequence** field in the Choices [sys_choice_list] table.
Publisher lifecycle information

The timeline shows the publisher sources that fulfill the following conditions:

- The publisher source with the least sequence number is prioritized and plotted on the timeline.
- If a product model has multiple publisher sources for its lifecycle phases, then the source with the least Sequence number alone is plotted on the timeline and the rest of the phases are not considered.
- The first alphabet in the name of the publisher source is plotted on the timeline. However, if there is more than one source beginning with the same letter, then the character is appended with a positive integer. For example, C1 for Central, C2 for Corporate.

Date range configuration for the lifecycle phases

If you are a maintenance user, then you can configure the date ranges.

1. To configure the date ranges, navigate to System Properties > All Properties.
2. Click startRangeOfTPMLifecycle property name to open the record.
3. Enter a positive value of your choice for the start range of TPM lifecycle in the timeline.
4. Click Update.
5. Click endRangeOfTPMLifecycle property name to open the record.
6. Enter a positive value of your choice for the end range of TPM lifecycle.
7. Click Update.

Date conditions

<table>
<thead>
<tr>
<th>Date conditions</th>
<th>Timeline in TPM screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current date, Current date –10 years, Current date + 3 years.</td>
<td>Default dates. Timelines of product models that fulfill the default date conditions are shown.</td>
</tr>
<tr>
<td>Date conditions</td>
<td>Timeline in TPM screen</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>All phases that start before the current date –10 years and continues to the</td>
<td>Product models with such date conditions are shown and the timeline expands itself</td>
</tr>
<tr>
<td>present time.</td>
<td>automatically from the default (–10 years to +3 years) to accommodate the past years.</td>
</tr>
<tr>
<td>Phases that start before the current date –10 years and continue beyond the</td>
<td>Product models with such phases are shown until current date + 3 years.</td>
</tr>
<tr>
<td>current date and may still be in progress</td>
<td></td>
</tr>
<tr>
<td>Lifecycle phases that start and end before the current date –10 years</td>
<td>Product models with such phases are NOT shown.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lifecycle phase of record</th>
<th>Conditions for plotting the dates on TPM timeline</th>
</tr>
</thead>
<tbody>
<tr>
<td>One internal and one publisher</td>
<td>All dates are plotted on the timeline.</td>
</tr>
<tr>
<td>Multiple publishers</td>
<td>Only one publisher date is plotted. The publisher that is selected for plotting depends</td>
</tr>
<tr>
<td></td>
<td>on the sequence property in the source column. All sources have a sequence number</td>
</tr>
<tr>
<td></td>
<td>attached to them. The source with the least sequence number is selected. If the source</td>
</tr>
<tr>
<td></td>
<td>with the least sequence number does not have any lifecycle records, then the source with</td>
</tr>
<tr>
<td></td>
<td>the next least sequence number is selected.</td>
</tr>
<tr>
<td>One internal and multiple publishers</td>
<td>The internal date is plotted, but only one publisher date is plotted. The publisher</td>
</tr>
<tr>
<td></td>
<td>record that is selected for plotting depends on the sequence property.</td>
</tr>
<tr>
<td>Overlapping dates of two phases</td>
<td>Only one line is shown.</td>
</tr>
<tr>
<td>Gaps in dates</td>
<td>A continuous line with no gap in the timeline.</td>
</tr>
</tbody>
</table>

**Color-coded timeline to identify product model risks**

- If there are internal as well as publisher records for a phase, then internal overrides the publisher for that phase.

![Example of timeline where internal overrides external](image)

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
• The last phase in the timeline takes the risk color and source of the previous phase that is not overridden.

Example of last phase acquiring the risk color of the previous phase that is not overridden

Relate business application to application service using CI relationship editor

Business applications can have multiple instances. Application instances are nothing but application services. Relate business applications to instances by relating business applications to application services. Business application and application service are two different configuration items which must be related through a CI relationship.

Role required: sn_apm.apm_user

1. Navigate to Application Portfolio Management > All Business Applications > Business Applications.
2. To relate the business application with an application service, click open a business application.
3. Click the Add CI relationship icon in the Related Items section of the business application form to launch the relationship editor and create the CI relationship.
4. Select one or more application services from the Configuration Items section.
   Integration with Service Mapping is through the CI relationship editor creating direct relationship between the configuration items.
5. Click the icon in the Relationships section.
   By default Consumes::Consumed by relationship type is selected.
   You can relate two configuration items using the suggested relationship type of CMDB. It not only selects the relationship type automatically but also ensures consistency in the relationship. The suggested relationship is established between capability and application AND between application and service.
6. Click Save and Exit.

You have created a relationship between a business application and an application service, you can now associate the application service to a software model.

Associate an application service to hardware model

Track your equipment assets such as computers and servers using hardware models.

Role required: sn_apm.apm_user

Hardware models are configuration items with specifications for a given device model. Specifications can be size, depth, image, model, and power of the device.

Note: In Application Portfolio Management, only computers and servers are tracked as hardware or hardware models. Other types of hardware such as printers, network gear, peripherals, or UPS are not tracked for an application service.
Your business applications may run on multiple application services, which in turn can be installed on different types of hardware. Therefore associating application services with hardware models helps to know the risk on the Application Service due to underlying hardware.

When you run the Fetch Product Models job, the application service is automatically associated with a hardware model. The application service and the hardware product model are mapped and a record is created in the Application Service Hardware Models [sn_apm_tpm_app_service_hardware_model] table. However, you can also manually associate an application service to all hardware models, including the hardware.

After the Load TPM Risk Parameters and compute Application Service Risks scheduled job is executed, the technology risk data of the hardware model are generated and stored in Hardware Model Risks [sn_apm_tpm_hardware_model_risk] table.

Note: As an APM user, your access to the hardware product model risk table is limited to read-only. However, if you are an APM administrator you can create, modify, and delete the hardware model risks in the table. Access is also read-only to Hardware [cmdb_ci_hardware], Hardware Model [cmdb_hardware_product_model], and Hardware Model Lifecycle [cmdb_hardware_model_lifecycle] tables.

1. Navigate to **Application Portfolio Management > Technology Portfolio Management (TPM) > Application Services**.
2. Click the service record, which is the application service, to which you want to associate a hardware model.
3. Click the **Application Service Hardware Models** related list.
4. Click **New**.

   The Application service hardware models database table stores the application service hardware model information. You can also navigate directly to the Application Service Hardware Models table from the application navigator.

5. On the form, fill in the fields.

   **Application Service Hardware Models form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Service</td>
<td>Name of the application service.</td>
</tr>
<tr>
<td>Ignore Technical Risk</td>
<td>Option to ignore the technical risk of the hardware model.</td>
</tr>
<tr>
<td>Hardware Product Model</td>
<td>Name of the model category.</td>
</tr>
</tbody>
</table>

6. Click **Submit**.

**Associate an application service to a software model**

Business applications have multiple instances such as development, QA, and production. Instances are nothing but application services. Hence application services must be associated with software models to know the risk of the application service.

Role required: sn_apm.apm_user

1. Navigate to **Application Portfolio Management > Technology Portfolio Management (TPM) > Application Services**.
2. Click the service record, which is the application service, to which you want to associate the software models.
3. Click the **Application Service Software Models** related list.
4. Click **New**.

   The Application Service Software Models [sn_apm_tpm_service_software_model] database table stores the application service software model information. You can also navigate directly to the Application Service Software Models table from the application navigator. Data from this table is rendered as the software model timeline in the By Software Model view of TPM screen.

5. On the form, fill in the fields.

   **Application Service Software Model form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Service</td>
<td>Name of the application service.</td>
</tr>
<tr>
<td>Ignore Technical Risk</td>
<td>Check box to ignore the technical risk of the software model. The risk of an application service is high even if one of its underlying software models risk is high. Hence, use this check box to ignore the risk of a software model if it is insignificant and does not contribute much to the risk of the application service.</td>
</tr>
<tr>
<td>Primary Software Model</td>
<td>Check box to make the software model as a primary one.</td>
</tr>
<tr>
<td>Software Model</td>
<td>The software model that underlies the application service.</td>
</tr>
</tbody>
</table>

6. Click **Submit**.

   **Create risk parameter scores** to evaluate the risk of the software model. Based on the risk of the software model you can calculate the risk of the application service. Finally, based on the risk of the application service you can evaluate the risk of the business application.

**Create a risk parameter**

The risk on a software model is calculated based on four preconfigured parameters such as external aging risk, internal aging risk, external stage risk, and internal stage risk.

Role required: sn_apm.apm_admin

In addition to the preconfigured parameters, you can also create risk parameters as per your business application requirements and the software models that it is based on. However, if you create a parameter, then you must also write a script with the logic to calculate that parameter risk.

1. Navigate to **Application Portfolio Management > Administration > TPM Risk Parameters**.
2. Click **New** or open a record.
3. Fill in the form fields.

   **Risk Parameter form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the risk parameter.</td>
</tr>
<tr>
<td>Description</td>
<td>A short description of the risk parameter.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable the check box to make the risk parameter active.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Script</td>
<td>Create a script that calculates the risk of the software model and the risk of the business application and schedule it to run daily.</td>
</tr>
</tbody>
</table>

4. Click **Submit** or **Update**.

After creating the risk parameters run the TPM risk engine to load the risk parameters and compute the application service risks.

**Technology risk calculation**

Assess the technology risks of your business applications by calculating their risks at the software model level and then at the business application level.

Technology risks are calculated at the hardware and software model levels to determine the risk at the business application level.

**Lifecycle stage: Internal and External**

The range set for a risk value at each level such as very high, late, moderate, low, and none vary from one organization to another. You can set the risk value for each lifecycle phase based on your organizational requirements. Use the software model lifecycle form to associate the lifecycle phase for each software model with a risk. Based on the selected risk the parameter risk is determined.

The risk values in the lifecycle table are very high, high, moderate, low, and none. Accordingly the risk is also very high, high, moderate, low, or none.

For lifecycle stage parameters, only the risk value is considered irrespective of the lifecycle phase.

**Aging: Internal and External**

Similarly, the aging internal and external has the following risk values:

- 0–90 days is high risk.
- 90–180 days is moderate risk.
- More than 180 days is low risk.

Based on the internal and publisher lifecycle stages and the internal and publisher aging stages, the risk of the hardware and software models are calculated as follows:

- If there is a single High risk, then the risk of the software model is High.
- If there is a single Moderate risk, then the risk of the software model is Moderate.
- The risk of the software model is Low only if the risk of all the underlying components are Low.
- If there is a single High risk, then the risk of the hardware model is High.
- If there is a single Moderate risk, then the risk of the hardware model is Moderate.
- The risk of the hardware model is Low only if the risk of all the underlying components are Low.

**Note:** The engine first calculates the risk at the hardware and software models, it then calculates risk at the application service level, based on the risks of all the underlying hardware and software models. Finally it calculates the risk at the business application level based on the risk of the production instances which are nothing but production application service.
The risk calculation for aging parameters are scripted and you can edit as required.

Parameters to determine software model risk

![](image)

- **Lifecycle stage**
  - Internal
  - Publisher

- **Aging**
  - Internal
  - Publisher

The current phase of the software model is determined based on the phase dates. The risk set for the lifecycle phase is picked up after the phase is determined.

Calculate distance from End of Life (EOL date – current date)

- < 90 days = High
- 90 – 179 days = Moderate
- ≥ 180 days = Low

Parameters to determine risk at software model level

Risk on a software model is calculated based on four parameters, namely internal lifecycle stage, external lifecycle stage, internal aging, and external aging.
Parameters to determine hardware model risk

Risk on a hardware model is calculated based on four parameters. The parameters are internal stage risk, publisher stage risk, internal aging risk, and publisher aging risk.

Calculating technology risk at business application level

A business application can run on many software models. The risk of a business application due to its underlying software models is derived from the risk of the individual software models.
Calculating risk at the business application level

Risk at hardware model level

Based on the four hardware risk parameters, the technology model suggestion engine calculates the risk of the hardware model and the highest risk value is assigned to the hardware model. If the risk of hardware is high, then the risk of the application service, which runs on the hardware, is evaluated to be high. The engine stores the risk data of the hardware model in the Hardware Model Risks [sn_apm_tpm_hardware_model_risk] table.

Risk at software model level

Based on the four software risk parameters, the technology model suggestion engine calculates the risk of the software model. If the risk of software is high, then the risk of the application service, which runs on the software, is evaluated to be high. The engine stores the risk data of the software model in the Software Model Risks [sn_apm_tpm_software_model_risk] table. This data is rendered on the software model timeline.

Risk at application service level

If any of the hardware or software models on which the application service runs is evaluated to be on high risk, then the application service is determined to be at a high risk.

Risk at business application level

If the application service is of high risk, then the business application which runs on the application service is also high.

- If one of the software models is at High risk, then the business application is at High risk.
- If one of the software models is at Medium risk, then the business application is at Medium risk.
- The risk of the business application is Low only if all the underlying software models have a Low risk.
You can customize the script that is executed to calculate the risks at the product model risk level (hardware and software models), application service risk level, and business application risk level. For more information, see Configure risk bubble up logic.

**Configure script to customize risk calculation**

Configure the risk calculation script at the extension points where the risks bubble up to the next level. With such configuration, the risk engine ignores the default logic of risk calculation and looks for the custom logic.

Role required: script_include_admin

There are three API extension points, at which the risks bubble up to the next level based on the script.

You can configure the script at the following levels:

- **sn_apm.productModelCustomRiskCalculation** – Product model (hardware and software models) risk level from the risks parameters level: The level at which the risks bubble up from the risks parameters level to the product model risk level.
- **sn_apm.AppBusinessServicesCustomRiskCalculation** – Application service risk level from the product models risk level: The level at which the risks bubble up from the product model risk level to the application service risk level.
- **sn_apm.BusinessApplicationCustomRiskCalculation** – Business application risk level from the application service risk level: The level at which the risks bubble up from the application service risk level to the business application risk level.

1. Navigate to **System Extension Points > Scripted Extension Points**.
2. Filter Application Portfolio Management applications in the **Application** column.
3. Click the API Name.
4. Scroll down to the Implementations section and click the extension point.
5. Click the preview this record icon

( next to the **Class** field.)
6. In the Script Include pop-up, click **Open Record** button.

By default, the sys_id of the function returns **False** for each of the API name and the risk engine follows the APM logic in calculating the risk.

```javascript
var productModelCustomRiskCalculation = Class.create();
productModelCustomRiskCalculation.prototype = {
    initialize: function() {},

    useCustomRiskForProductModel: function(productModelSysID) {
        return false;
    },

    /*
     * productModelJson formats is as follows:
     *
     * {'productType': 'software_model/hardware_model',
     *   'riskParamJson': {'riskParamSysID1': 'riskValue',
     *                    'riskParamSysID2': 'riskValue',
     *                    'riskParamSysID3': 'riskValue',
     *                    'riskParamSysID4': 'riskValue'}
     */

    getProductModelRisk: function(productModelSysID, productModelJson) {
    },

    type: 'productModelCustomRiskCalculation'
};
```

Configure custom script to calculate risks, for example, sn_apm.AppBusinessServicesCustomRiskCalculation

7. Configure the function to return **True** based on the sys_id of the API at the product model level, application service level, or business application level.

The risk engine then calls the API for the custom logic and calculates the risk in line with this logic, which bubbles up to the next level of risk calculation.

8. Click **Update**.

**Run scheduled job to generate risk values**

The risks on the product model and business application is time dependent. Based on the external and internal lifecycles the risk changes every day, hence the risk must be calculated daily. A scheduled job is created that runs daily and calculates the risks of the software model and the business application.

Role required: admin
Load TPM Risk Parameters and compute Application Service Risks scheduled job must be run daily to calculate the product model risk. The scheduled job executes the script generating the application service risk values. You can configure the time in the script as per your preference. Run the back-end job to get the real-time status of the applications risk and store the risk data in the business application risk table.

1. Navigate to System Definition > Scheduled Jobs.
2. Select the Load TPM Risk Parameters and compute Application Service Risks scheduled job.

   **Note:**
   The job is inactive by default. Select the Active check box to run the scheduled job at the scheduled time.

3. Click Execute Now.
   a) To configure the time in the script, navigate to System Scheduler > Scheduled Jobs > Scheduled Jobs.
      If a job is active, then you can schedule a time to run the job.
   b) Select Load TPM Risk Parameters and compute Bus.
   c) Click Configure Job Definition related link.
   d) Click the link at the top panel to edit the record.
   e) Click Execute Now.
      After executing the scheduled job, the engine automatically stores the risk values in the Business Application Risk [sn_apm_tpm_business_application_risk] table. It updates the values in the table each time after you run the job.
   f) Navigate to Application Portfolio Management > Technology Portfolio Management (TPM) > Business Application Risk Values.
   g) View the risk record of each business application in the table.

The risk values are:

- **High**
  One or more than one associated application service is at high risk.

- **Medium**
  One or more than one associated application service is at medium risk.

- **Low**
  One or all the associated application services are at low risk.

- **Not Assessed**
  Either the business application does not have any application service associated to it or the associated application service is not of production type.

The TPM risk engine loads the risk parameters, runs, and generates the risk parameter scores, software model risk values, hardware model risk values, and application service risk values.

Navigate to the following tables to view the risk values and scores:

- Navigate to Application Portfolio Management > Technology Portfolio Management (TPM) > Risk Parameter Scores to view the scores of the risk parameters.
- Navigate to Application Portfolio Management > Technology Portfolio Management (TPM) > Hardware Model Risk Values to view the risks of the hardware models.
• Navigate to Application Portfolio Management > Technology Portfolio Management (TPM) > Software Model Risk Values to view the risks of the software models.

• Navigate to Application Portfolio Management > Technology Portfolio Management (TPM) > Application Service Risk Values to view the risks of the application services.

The risk values of the business applications, application services, hardware, and software models are rendered on the Technology Portfolio Management timeline.

**Information portfolio**

Use the information portfolio to capture information from the assets of your organization as information objects. You can categorize the information assets and determine its business application use. You can also connect the different layers where data exists and map the layers. Mapping helps to retrieve the information and track the information flow.

**Information portfolio data model**

The basic data model of information portfolio is in the introduction of two tables, which are Information Object and Data Domain.

• Information object is a configuration item that displays information in an organized form. The purpose of the information object is to logically describe the type of data (or the information) that is interchanged between the application and the database. The database being the one that serves the application with data.

• Data domain is to classify or categorize the information objects.

Application Portfolio Management (APM) integrates with information portfolio by relating a business application with the database. The database provides the information to the application using an intermediary cmdb CI class called information object [cmdb_ci_information_object] table.

The business application is related with the information object by establishing Uses::Used by cmdb CI relationship. The information object, in turn, is linked to the database catalog and instances by establishing Depends on::Used by cmdb CI relationship.
Information portfolio data model

APM integrates with ServiceNow Discovery that finds database applications, database instances, and database catalog. The database catalog lists all the catalog objects, or databases, discovered for an instance of a database.

Plugin activation procedure

CMDB plugin has the Information Object (cmdb_ci_information_object) CI. When APM plugin is activated, the data domain field gets added to the cmdb_ci_information_object table. The data domain field references the Data Domain table, which is included in the APM plugin.

Create a data domain

Data domain is a collection of information objects. Relate an information object to the database catalog of a database instance to collect the physical data. ServiceNow Discovery finds database catalog that lists all the catalog objects, or databases, discovered for an instance of a database.

Role required: sn_apm.apm_user

Although an Application Portfolio Management user (sn_apm.apm_user) can create a data domain, the access control on the Data Domain [sn_apm_data_domain] table is limited to its different users.

• The Application Portfolio Analyst and Application Portfolio Administrator with sn_apm.apm_admin role have create, write, and delete privileges.
- The Application Portfolio User with sn_apm.apm_user role has read access only.

1. Navigate to Application Portfolio Management > Information Portfolio > Data Domains.
2. Click New.
3. On the form, fill in the fields.

**Data Domain form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the data domain.</td>
</tr>
<tr>
<td>Description</td>
<td>Short description of the data domain.</td>
</tr>
<tr>
<td>Parent</td>
<td>Parent domain of the data domain. This is used to create a data domain hierarchy.</td>
</tr>
<tr>
<td>Leaf Node</td>
<td>Indicator that the data domain is at the lowest level of the hierarchy.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Create an information object and link the data domain with the information object.

**Create an information object referencing data domain**

Create an information object to capture the logical data for the business application. This data becomes information when it is applied to the business application.

Role required: sn_apm.apm_user

The Application Portfolio Analyst and Application Portfolio User can create information object, relate business application to information object, and relate information object to database catalog.

1. Navigate to Application Portfolio Management > Information Portfolio > Information objects.
2. Click New.
3. On the form, fill in the fields.

**Information Objects form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the information object.</td>
</tr>
<tr>
<td>Data classification</td>
<td>Category of data. The base system provides Internal, Public, Confidential, and Highly Sensitive categories.</td>
</tr>
<tr>
<td>Owned by</td>
<td>User who owns the information object.</td>
</tr>
<tr>
<td>Business Unit</td>
<td>Business unit that owns the information object.</td>
</tr>
<tr>
<td>Department</td>
<td>Department in the business unit that actually owns the information.</td>
</tr>
<tr>
<td>Description</td>
<td>Short description of the information object.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Data domain</td>
<td>Reference to Data Domain table that holds the categorized conceptual data. The relationship between the conceptual and the logical data layers is simply established by referencing data domain in the Information Object table.</td>
</tr>
</tbody>
</table>

4. **Click Submit.**

After creating an information object, you must relate a business application to the information object with the cmdb CI suggested relationship.

**Relate a business application to the information object**

Relate business application to an information object using CMDB CI (cmdb_rel_ci) relationship of type Uses::Used by. Use this suggested relationship to get the logical data of the information object, which can be used to leverage business application.

Role required: sn_apm.apm_user

**Note:**

Use the custom-built Add Relationship UI to relate the business application with the information object as this UI also captures the attributes in the relationship between the two configuration items. It is NOT recommended to use the CMDB relationship editor to associate the two configuration items because the create, read, update, and delete (CRUD) attributes of the relationship cannot be captured in the relationship editor.

1. Navigate to **Application Portfolio Management > Application Portfolio > All Business Applications**.
2. Click open a business application record.
3. To relate the business application with an information object, click **Related Information Objects** related list.
4. To add an information object, click the **Add** button.
5. On the form, fill in the fields.

**Add Relationship form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Application</td>
<td>Name of the business application that auto-populates in the field.</td>
</tr>
<tr>
<td>Relationship</td>
<td>Type of suggested cmdb CI relationship between the business application and the information object. The field is auto-populated with Uses::Used by relationship.</td>
</tr>
<tr>
<td>Select Information Object</td>
<td>Table with the logical data that the business application uses.</td>
</tr>
</tbody>
</table>
By adding an information object to the business application, not only a record is created in the CI relationship [cmdb_ci_rel] table, but the CRUD attributes are also captured in the CI Relation Attributes [cmdb_rel_attributes] table.

6. Click Save.
7. To edit the CRUD relationship of an information object, select the record and click Edit button. Update the details in the Manage Relationship pop-up.
8. To delete the relationship between the business application and an information object record, select the record and click Delete Relationship button. This action deletes the relationship record from the CI relationship table and also deletes the qualifier properties, if any, set in this relationship between the business application and the information object, which are captured in the CI Relation Attributes table.

To check for information objects that are not linked to any business applications, run the Information Objects not related to any Business Application desired state audit on demand. See Information Objects not related to any Business Application.

Relate the information object to the database catalog.

Relate the information object to the database catalog

The information object draws the physical data from the database catalog, which references the database instances. Hence, create a relationship that is suggested between the information object and the database catalog.

Role required: sn_apm.apm_user

Suggested cmdb CI relationship, Depends on::Used by, relates the information object to the database catalog. The relationship works by drawing the physical data from the database and stores it as logical data in the information object table, which references the data domain.

For example, employee payroll details depends on Oracle database instance. If the relationship is reversed between the configuration items, then Oracle database instance is used by employee payroll.

- IT Operations Management Discovery discovers all servers, instances, and databases.
- Database Catalog is a list of all the databases.
- The Database Catalog (cmdb_ci_db_catalog) lists all the catalog objects or databases that are discovered from an instance of a database. For example, Oracle catalog and MySQL catalog are child tables of the database catalog.
- The Database Instance (cmdb_ci_db_instance) is the parent table. Oracle Instance (cmdb_ci_db_ora_instance) and MySQL instance are child tables of the Database Instance.
- The reference between a database instance and a database catalog is one to many.
- Since the database instance is hosted on the Server (cmdb_ci_server), it can access all the underlying configuration items.

Note:
You may have applications, the data of which are not stored in a conventional database. You can also track such unstructured data stored in configuration item tables such as configuration file (cmdb_ci_config_file), file system (cmdb_ci_file_system), and exchange mail box (cmdb_ci_exchange_mailbox). Use the same Depends On::Used by relationship type between the information object and the unstructured data sources to track the data.

1. Navigate to Application Portfolio Management > Information Portfolio > Information Objects.
2. To create a suggested relationship between the information object and the database catalog, click open the information object record.
3. Click the add CI relationship icon ( ) in the related items section of the Information Object form to launch the relationship editor and create the CI relationship. Filter is automatically applied on the database catalog.
4. Select the Depends on::Used By suggested relationship type.
5. Select the record in the Configuration Items section that is of a catalog class.
6. Click icon in the Relationships section.
7. Click Save and Exit.

Ensure that the database catalog table has a reference of the database instance.

Click the show dependency views icon ( ) in the Information Object related items to view the dependency of the business application that is using the information object, which is running on a database server.

Dependency view of the information object

Apply the information portfolio for auditing. Integrate with GRC (Governance, Risk, and Compliance) and use the information object as an entity. GRC uses any entity such as a database, server, or a business application to audit. Associating the information object as an audit entity gives you the complete profile of the business application that uses the information object and its source of data.

Risk management for business applications

Integrate Application Portfolio Management (APM) with Governance, Risk, and Compliance (GRC) to simplify the work of application owners and risk managers by identifying the risks associated with business applications and adding the controls necessary to mitigate the risks.

ServiceNow® Application Portfolio Management integration with Risk Management enables you to determine the inherent and comprehensive risk on a business application and identify tasks to mitigate the risk.
ServiceNow® Application Portfolio Management integration with Policy and Compliance enables you to view the controls determined on a business application, verify whether those controls are compliant, and determine the tasks required to make the business application compliant with the controls.

The key benefits of this integration are:

• Reduces the time spent by risk managers and application owners on digital risks.
• Provides faster and efficient communication between the application owners and risk managers.
• Provides an overview of the digital risk posture of business applications.

High-level workflow of the GRC and APM integration solution

The high-level workflow of the GRC and APM integration solution is as follows:

1. A business application is created.
2. Based on the GRC Profile Generation scheduled job that runs in the background, GRC detects a new business application and creates an entity in GRC.
3. When the new application is created as a GRC entity, a new risk identification record is created.
4. The risk manager can modify the configuration record and determine the workflow of the assessment. After a risk identification configuration is published, the risk manager can modify only some fields in the configuration record.
5. A questionnaire is initiated to collect details about the application from the application manager.
6. The application owner responds to the questionnaire.
7. The risk manager reviews the responses and sends the questionnaire back if further information or clarification is needed.
   
   **Note:** The application owner's responses are retained when the questionnaire is sent back.

8. When the risk manager is satisfied with the responses, the inherent assessment is initiated based on the risk assessment methodology configuration in GRC. For more information, see Configure inherent assessment.

9. GRC maps the risks and compliance objects based on the entity types.
10. The risk manager reviews the information object mapping.
11. The system executes the recommendation engine based on the algorithm selected in the configuration.
12. The risk manager reviews and maps the recommended risks, policies, and citations based on the associated information objects.
13. The recommended controls based on associated citation policies and risks are associated.
14. The application owner manages the control life cycle by working with relevant stakeholders to implement controls.

Install GRC - Application Risk Assessment Configuration and GRC - Application Controls Configuration

Install GRC - Application Risk Assessment Configuration and GRC - Applications Controls Configuration from the ServiceNow Store.

Role required: admin
Before installing GRC - Application Risk Assessment Configuration and GRC - Applications Controls Configuration, download and activate the GRC application from the ServiceNow Store. For more information, see the Download a GRC application from the ServiceNow Store for the first time topic.

Activate the following plugins:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GRC - Application Risk Assessment</td>
<td>Activates the Application Portfolio Management integration with the GRC Risk Management plugin.</td>
</tr>
<tr>
<td>(com.snc.apm_risk_assessment)</td>
<td></td>
</tr>
<tr>
<td>GRC - Applications Controls Configuration</td>
<td>Activates the Application Portfolio Management integration with the GRC Controls plugin.</td>
</tr>
<tr>
<td>(com.snc.apm_control_management)</td>
<td></td>
</tr>
</tbody>
</table>

1. Navigate to System Applications > All Available Applications > All.
2. Find the application using the filter criteria and search bar.
   You can search for the application by its name or ID. If you cannot find an application, you may have to request it from ServiceNow store.
   Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
3. Click Install.
4. In the Application installation dialog box, review the application dependencies.
   Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If there are any plugins or applications that need to be installed, you must install them before you can install GRC - Application Risk Assessment.
5. Optional: If demo data is available and you want to install it, click Load demo data.
   Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.

   Important: If you don't load the demo data during installation, it's unavailable to load later.
6. Click Install.

GRC roles required for APM

Add roles to the sn_apm.apm_user role to be able to access GRC information from APM.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>risk_reader</td>
<td>Enables read access to GRC Risks, Risk Summary, Risk Response Tasks tabs.</td>
</tr>
<tr>
<td>compliance_reader</td>
<td>Enables read access to Controls, GRC Issues, and GRC Issue Remediation Tasks.</td>
</tr>
<tr>
<td>sn_audit.user</td>
<td>Enables read access to Audit Engagements.</td>
</tr>
<tr>
<td>grc_business_user</td>
<td>Enables you to respond to risk assessment questionnaires and control attestation surveys.</td>
</tr>
</tbody>
</table>
Assessment form for risk and control information

Risk managers use assessment forms to gather information about an application's risks and controls. System administrators must make the forms accessible through the business application so that application managers can respond.

Questionnaires initiated by risk managers are the basis for assessment forms sent to application managers to collect risk or control details about their applications. For information for risk managers about how to configure the business application form, see Configure the business application form for risk management. For information for application managers about how to respond to the questionnaire, see the Respond to a risk assessment questionnaire and Take the control attestation survey topics.

Configure the business application form for risk management

Configure the business application form to enable application managers to provide risk and control information associated with a business application through a risk assessment questionnaire or a control attestation survey.

Role required: admin

1. Navigate to Application Portfolio Management > Application Portfolio > All Business Applications.
2. Open a business application.
3. Click the Additional actions icon and select Configure > Related Lists.
4. Add GRC Risks, Risk Questionnaire, Risk Summary, Risk Response Tasks, Controls, Control Attestations, GRC Issues, and GRC Issue Remediation Tasks to the Selected list and click Save.
5. Add the Take attestation column to the Risk Questionnaire and Control Attestations related lists.
   a) Click either the Risk Questionnaire or Control Attestations tab to access the associated related list.
   b) Click any of the columns and select Configure > List Layout.
   c) Add Take attestation to the Selected list and click Save.
   d) Repeat the steps for the other related list.

Respond to a risk assessment questionnaire

Respond to a risk assessment questionnaire

Respond to a risk questionnaire to provide risk-related information for your business application to a risk manager.

Role required: grc_business_user

1. Navigate to Application Portfolio Management > Application Portfolio > All Business Applications.
2. Open a business application.
3. Select the Risk Questionnaire related list.
4. Click the Take assessment link.
5. Enter your responses in the form.
6. Click Submit

Take the control attestation survey

Take the control attestation survey

Return the control attestation survey to provide information to verify that a control is implemented for a business application.
Role required: grc_business_user

1. Navigate to Application Portfolio Management > Application Portfolio > All Business Applications.
2. Open a business application.
3. Select the Control Attestations related list.
4. Click the Take assessment link.
5. Enter your responses in the form.
6. Click Submit

Domain separation in Application Portfolio Management

This is an overview of domain separation as it pertains to Application Portfolio Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Support level: Basic

- Business logic: Ensure that data goes into the proper domain for the application’s service provider use cases.
- The application supports domain separation at run time. This includes domain separation from the user interface, cache keys, reporting, rollups, and aggregations.
- The owner of the instance must set up the application to function across multiple tenants.

Use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

How domain separation works in Application Portfolio Management

While domain separation in APM is at the “Data only” level, there are a few factors to help you in your use of domain separation:

- Data can be domain separated.
- The domain column is present for base system application tables and APM tables.
- Domains are created and domain-specific configuration is managed by instance owner.
- Tenant domains can manage their own application data.
- Application properties are tied to the domain.
- Business logic and processes can be domain-separated by instance owner. Business rules and policies can be created in specific domains by tenants.
- Business logic and processes can be administered by tenant domain.

Set up domain separation for APM users

Application Portfolio Management supports domain separation for managed service providers (MSPs) to protect the sensitive data of each customer. The protection also ensures inability to view business application data of one customer by another customer and also secures the data within the domain.

Role required: admin
Illustration of a sample domain map

1. Install the Domain Support – Domain Extensions Installer system plugin to enable the domain separation feature for APM.
2. Create an administrator role at each domain level.
   The administrator can only configure and run the scheduled jobs.
3. Create all your application portfolio data entities in the domain, specific to the enterprise, and not at the global level.
4. Create indicators at the domain level.
   Do not create them at the global level and reuse the indicators for every customer under the parent level. Data is not visible at the global level.
5. Create user groups and assign roles to users at the domain level, so that they can view only the data of the enterprise they belong to.
6. Execute jobs for domain separated data.

You can execute scheduled jobs, certification schedules, and assessments of indicators and scores at the domain level using the Run as role. Configure the Scheduled Script Execution form layout to add the Run as field from the Context menu.
Quick start tests for Application Portfolio Management

Validate that Application Portfolio Management still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

quick start tests require enabling the – ATF Tests plugin (com.snc.apm.atf).

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>APM: Create Business Application</td>
<td>Verify creation of an application category and then creation of a business application with user having apm_user role.</td>
<td></td>
</tr>
<tr>
<td>APM: Create Business Capability</td>
<td>Verify the creation of a parent and child business capability and verify its field values.</td>
<td></td>
</tr>
<tr>
<td>APM: Test relating Business Service, Business Application, and Software Models</td>
<td>Verify creation of a business application, business service, using the existing software model, and a relationship between them.</td>
<td></td>
</tr>
<tr>
<td>APM: Test for Indicator Score and Application Score generation</td>
<td>Verify creation of indicator, scoring profile, and generation of indicator scores and application scores.</td>
<td></td>
</tr>
</tbody>
</table>

Visualize APM reports using CMDB Query Builder

APM uses CMDB Query Builder to query on a list of configuration items used in Application Portfolio Management and visualize them as reports.

Role required: sn_apm.apm_user

APM takes advantage of CMDB Query Builder to build complex queries and retrieve data from CMDB CI classes, APM tables, and configuration items that are associated to each other by different CMDB CI relationships.

Before launching the reports that fetch data from the tables and CMDB CI classes, you must run the respective scheduled jobs. These jobs are set as active with frequency as On Demand. However, update the frequency as per your requirement to daily, weekly, monthly, periodically, once, on demand, Business Calendar – entry start, or entry end, based on how often the data for the report should be updated. Set the frequency of these scheduled jobs accordingly. For more information, see Run scheduled jobs for CMDB Query Builder reports.

Note: Ensure to run these scheduled jobs from Global scope only. Only a system administrator can run these scheduled jobs from global scope. However, as an APM user you can view the reports.

1. Navigate to Application Portfolio Management > CMDB Query Builder.

All reports that the base system offers are provided as menu options in the application navigator under CMDB Query Builder.
2. Click the relevant CMDB query builder name for which you want to view the report.

   The report opens in a new tab and is rendered as a bar chart, by default. You can view and save the report for future use.

   **Note:** The data displayed on the report is retrieved from the latest execution of the scheduled job run on demand.

3. Click each option to view the respective report.

   **Note:** You must activate the PPM Standard plugin to generate Projects on a Business Application CMDB query builder report.

APM base system provides the following list of queries to generate APM reports:

**Business Capabilities provided by Business Application**
Table: BAs providing a Business Capability-Query Results

![](image)

Business Capabilities provided by Business Application

Report showing business capabilities provided by business application

Application Services consumed by Business Application
Report showing application services consumed by business application

Business Applications providing a Business Capability
### Table: BAs providing a Business Capability-Query Results

All > Query Sys ID = 0a5e6e6b31b8810107a0bdf861aebcbea

<table>
<thead>
<tr>
<th>Business Applications providing a Business Capability</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other</td>
<td>50</td>
</tr>
<tr>
<td>other</td>
<td>40</td>
</tr>
<tr>
<td>other</td>
<td>30</td>
</tr>
<tr>
<td>other</td>
<td>20</td>
</tr>
<tr>
<td>other</td>
<td>10</td>
</tr>
<tr>
<td>other</td>
<td>0</td>
</tr>
</tbody>
</table>

Report showing business applications providing a business capability
Business Services provided by a Business Capability
Report showing business services provided by a business capability
Table: Information objects used by a BA-Query Results

All > Query Sys ID = 3eaf6af7db0810108979186c1396194e

Business Applications using an Information Object

Information objects used by a BA-Query Results Count

- Application Folders
- Employee Appraisals
- Employee Benefits
- Employee Contracts
- Employee Payroll
- Employee Time & Li.
- Employee Work Acts

Information objects used by a BA-Query Results

Report showing business applications using an information object
Information Objects used by a Business Application
Table: Information objects used by a BA-Query Results

All > Query Sys ID = 3eaf6af7db0810108979186c1396194e

Information Objects used by a Business Application

- Avid Employee Eng...
- Attendance & Payr...

Report showing information objects used by a business application
Demands on a Business Application
Report showing demands on a business application
Projects on a Business Application
Report showing projects on a business application
Run scheduled jobs for CMDB Query Builder reports

Schedule a job to run at a scheduled time or on a recurring schedule for CMDB query. Ensure to do this action in global scope.

Role required: sys_admin

1. Navigate to System Definition > Scheduled Jobs.
2. Search and click the relevant scheduled job.
3. Select the frequency at which to run the scheduled job in the Run field.
4. Click Execute Now.

**Note:** As a system administrator you must run these scheduled jobs from Global scope only.

Select and run the scheduled jobs for the following CMDB Query Builder reports that the base system offers:

- Business Capabilities provided by Business Application
- Application Services consumed by Business Application
- Business Applications providing a Business Capability
- Business Services provided by a Business Capability
- Business Applications using an Information Object
- Information Objects used by a Business Application
- Demands on a Business Application
- Projects on a Business Application

Application Portfolio Management Analytics and Reporting Solutions

Analytics and Reporting Solutions contain preconfigured dashboards. These dashboards contain actionable data visualizations that help you improve your business processes and practices.

Analytics and Reporting Solutions

Use the widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With s, you can get value from for your application with minimal setup. You can always create your own objects as well.

**Important:** Set up and test s on a non-production instance before enabling them in production.

**Note:** s provide all the configuration records required to analyze default applications. Customize these records for use in your production environment. For more information, see Configure s.

To enable the solution plugin for Application Portfolio Management, an admin can navigate to System Definitions > Plugins and activate the Performance Analytics - Content Pack - Application Portfolio Management plugin.
Project Portfolio Management

Project Portfolio Management provides a simplified, team-oriented approach to Project Portfolio Management and IT development by combining several individual applications.

Project Portfolio Management (PPM) includes the following applications:

Note: Customers who already have Project Portfolio Management can upgrade to PPM Standard. New customers must purchase PPM Standard.

<table>
<thead>
<tr>
<th>Application</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand Management</td>
<td>An application used for assessing ideas and promoting accepted ideas to strategic and operational demands.</td>
</tr>
<tr>
<td>Project Management</td>
<td>A suite of tools used to manage projects, task, and resources.</td>
</tr>
<tr>
<td>Program Management</td>
<td>An application used to manage program and tasks.</td>
</tr>
<tr>
<td>Portfolio Management</td>
<td>An application that enables you to manage your projects and programs in different portfolios.</td>
</tr>
<tr>
<td>Resource Management</td>
<td>An application that enables resource requesters to create resource plans and request resources.</td>
</tr>
<tr>
<td>Ideas</td>
<td>An application that enables you to gather and evaluate ideas and promote accepted ideas to demand, story, epic, or project.</td>
</tr>
<tr>
<td>Time Card</td>
<td>An application that enables you to track time on a daily basis against tasks</td>
</tr>
</tbody>
</table>
Process Overview

The project manager (project_manager) role for Project Portfolio Management includes all the manager roles for the applications included in the suite.

Domain separation in Project Portfolio Management

Domain separation provides complete data isolation for domain-specific users. Project Portfolio Management is domain separation compliant with few limitations.
PPM Standard (Project Portfolio Management)

The ServiceNow® PPM Standard, earlier known as Project Portfolio Suite with Financials, application integrates Financial Management and Project Portfolio Management.

PPM Standard automatically activates Financial Management if it is not already active.

The integration enables project and portfolio managers to perform the following activities:

- Determine overall cost requirements for all demands and projects in portfolios
- Establish resource requirements and track costs for demands and projects
- Track actual amounts spent compared to an approved budget

Upgrades and new customers

Customers who already have Project Portfolio Suite with Financials can upgrade to PPM Standard. New customers must purchase PPM Standard.

PPM Standard applications

The PPM Standard plugin installs Financial Management and Project Portfolio Suite. The following diagram illustrates the applications that are available.
Applications installed with PPM Standard

PPM Standard additions

PPM Standard adds the portfolio workbench, that you can use to perform all aspects of financial planning. You can also perform financial planning and budgeting using UI actions on related lists, but the workbench is the preferred method. See Legacy portfolio workbench for more information. See Legacy: Plan the portfolio for information on how to plan end-to-end finances for projects and portfolios, including tracking actual costs and creating budgets as part of the Financial Management application.
Activate PPM Standard (Project Portfolio Management)

As an administrator, you can activate the PPM Standard plugin (com.snc.financial_planning_pmo) to install the Project Portfolio Management applications.

Role required: admin

The PPM Standard is the basic plugin for the PPM (Project Portfolio Management) applications.

- To use the PMO (Project Management Office) dashboard for PPM, you can activate the Performance Analytics - Content Pack - PPM Standard plugin (com.snc.pa.pmo_dashboards).
- To use Investment Funding for PPM, you can activate the Investment Funding for PPM plugin (com.snc.investment_planning_pmo).

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Installed with PPM Standard (Project Portfolio Management)

Several components are installed with the activation of PPM Standard plugin.

Demo data is available with Project Portfolio Management Standard. The demo data provides sample projects, demands, programs, portfolios, expense lines. The demo data also provides sample cost plans and budget plans for the sample projects and demands.

**Plugins installed with PPM Standard (Project Portfolio Management)**

Plugins are installed with activation of PPM Standard plugin, if they are not already active.

PPM Standard plugins

PPM Standard adds the following plugins.

<table>
<thead>
<tr>
<th>Plugin Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Portfolio Suite</td>
<td>Activates an integrated set of applications for project portfolio management and IT software development.</td>
</tr>
<tr>
<td>[com.snc.project_portfolio_suite]</td>
<td></td>
</tr>
<tr>
<td>Financial Planning</td>
<td>Enables financial analysts to assemble spending data, build cost models, and generate reports to show how funds are being allocated.</td>
</tr>
<tr>
<td>[com.snc.financial_planning]</td>
<td></td>
</tr>
<tr>
<td>Rate Model</td>
<td>Delivers date-effective hourly rates for a specific set of criteria coming from the project, demand, or time card being processed.</td>
</tr>
<tr>
<td>[com.snc.rate_model]</td>
<td></td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Ideation with PPM</td>
<td>Enables your organization to collect new ideas, collaborate on ideas, and identify great ideas for implementation. Convert selected ideas to demands, stories, projects, and epics.</td>
</tr>
<tr>
<td>[com.snc.ppm_innovation_management]</td>
<td></td>
</tr>
</tbody>
</table>

**Project Portfolio Suite plugins**

Project Portfolio Suite adds the following plugins.

<table>
<thead>
<tr>
<th>Plugin Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand Management</td>
<td>Enables capturing the demands and provide tools to screen, assess and prioritize them.</td>
</tr>
<tr>
<td>[com.snc.demand_management]</td>
<td></td>
</tr>
<tr>
<td>Project Management</td>
<td>Enables planning, organizing and managing projects and resources in order to setup, execute, and complete a project faster and easier.</td>
</tr>
<tr>
<td>[com.snc.project_management_v3]</td>
<td></td>
</tr>
<tr>
<td>Resource Management</td>
<td>Enables resource requesters and resource managers to plan, organize, and manage resources for both planned and operational work.</td>
</tr>
<tr>
<td>[com.snc.resource_management]</td>
<td></td>
</tr>
</tbody>
</table>

**Demand management plugins**

Demand management adds the following plugins.

<table>
<thead>
<tr>
<th>Plugin Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Flow Formatter</td>
<td>Summarize multiple pieces of information about a process and display the stages graphically at the top of a form.</td>
</tr>
<tr>
<td>[com.snc.process_flow_formatter]</td>
<td></td>
</tr>
<tr>
<td>Assessment</td>
<td>Evaluate, score, and rank records from tables in the system. Evaluate results using unique graphical views designed to highlight key performance information.</td>
</tr>
<tr>
<td>[com.snc.assessment_core]</td>
<td></td>
</tr>
<tr>
<td>Timeline Visualization</td>
<td>Provide a high-level graphical representation of your strategic and operational activities for your organization such as incidents, problems, changes, and projects.</td>
</tr>
<tr>
<td>[com.snc.timeline_visualization]</td>
<td></td>
</tr>
</tbody>
</table>

**Project management plugins**

Project management adds the following plugins.

<table>
<thead>
<tr>
<th>Plugin Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Checklist</td>
<td>Checklists for tasks.</td>
</tr>
<tr>
<td>[com.glide.ui.checklist]</td>
<td></td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cost Management</td>
<td>Enables the definition and tracking of configuration item costs. Uses rate cards with CIs, contracts, and projects.</td>
</tr>
<tr>
<td>[com.snc.cost_management]</td>
<td></td>
</tr>
<tr>
<td>Process Flow Formatter</td>
<td>Displays the different stages in a linear process flow across the top of a record.</td>
</tr>
<tr>
<td>[com.snc.process_flow_formatter]</td>
<td></td>
</tr>
<tr>
<td>Skills Management</td>
<td>Enables an administrator to assign configured competencies, called skills, to groups or individual users.</td>
</tr>
<tr>
<td>[com.snc.skills_management]</td>
<td></td>
</tr>
<tr>
<td>Timeline Visualization</td>
<td>Enables graphical representation of activities over time.</td>
</tr>
<tr>
<td>[com.snc.timeline_visualization]</td>
<td></td>
</tr>
<tr>
<td>Time card management</td>
<td>Enables the creation of linear timelines for any activity that is bounded by two dates, such as the actual start and end dates on a project task.</td>
</tr>
<tr>
<td>[com.snc.time_card]</td>
<td></td>
</tr>
</tbody>
</table>

**Resource management plugins**

Project management adds the following plugins.

<table>
<thead>
<tr>
<th>Plugin Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost Management</td>
<td>Enables the definition and tracking of configuration item costs. Uses rate cards with CIs, contracts, and projects.</td>
</tr>
<tr>
<td>[com.snc.cost_management]</td>
<td></td>
</tr>
<tr>
<td>Process Flow Formatter</td>
<td>Displays the different stages in a linear process flow across the top of a record.</td>
</tr>
<tr>
<td>[com.snc.process_flow_formatter]</td>
<td></td>
</tr>
</tbody>
</table>

*Tables installed with PPM Standard (Project Portfolio Management)*

Tables are added with activation of PPM Standard plugin.

**PPM Standard tables**

PPM Standard adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost Plan</td>
<td>Cost plan for the resources required for the project.</td>
</tr>
<tr>
<td>[cost_plan]</td>
<td></td>
</tr>
<tr>
<td>Cost Plan Breakdown</td>
<td>Cost breakdown of resources based on project, program, or portfolio. These records are rollups of all costs. Project task cost plans are not rolled up to the project.</td>
</tr>
<tr>
<td>[cost_plan_breakdown]</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cost Type Definition</td>
<td>Definitions of cost types, which specify either an operating expense or capital expense, and can link accounts in the General Ledger [itfm_gl_accounts] table. The General Ledger table is installed with the Financial Management application.</td>
</tr>
<tr>
<td>Project Funding</td>
<td>Project or demand target and budget expense values for both capital and operating expenses. The records in this table are for a single fiscal year.</td>
</tr>
<tr>
<td>Benefit Plan</td>
<td>Benefit plan for the potential benefits that the project or demand can accrue.</td>
</tr>
<tr>
<td>Benefit Breakdown</td>
<td>Benefit breakdown for the project or demand. These records are rollups of all benefits.</td>
</tr>
<tr>
<td>Budget Reference Rates</td>
<td>The exchange rates that budgets use.</td>
</tr>
</tbody>
</table>

### Project Portfolio Suite tables

Project Portfolio Suite adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Stakeholder</td>
<td>Stores all stakeholders who are associated with one or more projects.</td>
</tr>
<tr>
<td>Project Time Card Exception</td>
<td>Stores time card information such as Week starts on, User, Project, and State of the time cards.</td>
</tr>
<tr>
<td>Project Time Category</td>
<td>Stores project sub-categories created for time cards.</td>
</tr>
<tr>
<td>Time Sheet Exception</td>
<td>Stores time sheet information such as Week starts on, User, and State of the time sheets.</td>
</tr>
</tbody>
</table>

### Demand management tables

Demand management adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand</td>
<td>Stores all demands.</td>
</tr>
<tr>
<td>Decision</td>
<td>Stores all decisions.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------------------------------------------------------------</td>
</tr>
<tr>
<td>Stakeholder Register</td>
<td>Stores all stakeholders.</td>
</tr>
<tr>
<td>[dmn_stakeholder_register]</td>
<td></td>
</tr>
<tr>
<td>Requirement</td>
<td>Stores all requirements.</td>
</tr>
<tr>
<td>[dmn_requirement]</td>
<td></td>
</tr>
<tr>
<td>Demand Stakeholder</td>
<td>Stores all stakeholders who are associated with one or more demands.</td>
</tr>
<tr>
<td>[dmn_m2m_demand_stakeholder]</td>
<td></td>
</tr>
<tr>
<td>Demand Stage Config</td>
<td>Stores the images displayed in the demand stage pop-up window.</td>
</tr>
<tr>
<td>[dmn_stage_config]</td>
<td></td>
</tr>
<tr>
<td>Idea</td>
<td>Stores all ideas.</td>
</tr>
<tr>
<td>[idea]</td>
<td></td>
</tr>
</tbody>
</table>

### Project management tables

Project management adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Goal</td>
<td>Project goals.</td>
</tr>
<tr>
<td>[goal]</td>
<td></td>
</tr>
<tr>
<td>Issue</td>
<td>Project issues.</td>
</tr>
<tr>
<td>[issue]</td>
<td></td>
</tr>
<tr>
<td>Personalize Workbench</td>
<td>Configuration settings for each user that utilizes the workbench.</td>
</tr>
<tr>
<td>[workbench_config_user]</td>
<td></td>
</tr>
<tr>
<td>Portfolio</td>
<td>Portfolios.</td>
</tr>
<tr>
<td>[pm_portfolio]</td>
<td></td>
</tr>
<tr>
<td>Portfolio Project</td>
<td>Portfolio projects.</td>
</tr>
<tr>
<td>[pm_portfolio_project]</td>
<td></td>
</tr>
<tr>
<td>Portfolio Project Goal</td>
<td>Portfolio project goals.</td>
</tr>
<tr>
<td>[pm_portfolio_goal]</td>
<td></td>
</tr>
<tr>
<td>Portfolio Project Issue</td>
<td>Portfolio project issues.</td>
</tr>
<tr>
<td>[pm_portfolio_issue]</td>
<td></td>
</tr>
<tr>
<td>Portfolio Project Relationships</td>
<td>All relationships between a portfolio and each project in the portfolio.</td>
</tr>
<tr>
<td>[pm_m2m_portfolio_project]</td>
<td></td>
</tr>
<tr>
<td>Portfolio Project Risk</td>
<td>Portfolio project risks.</td>
</tr>
<tr>
<td>[pm_portfolio_risk]</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Project [pm_project]</td>
<td>All projects.</td>
</tr>
<tr>
<td>Project Task [pm_project_task]</td>
<td>All tasks used in projects.</td>
</tr>
<tr>
<td>Project Task Link [pm_project_task_link]</td>
<td>All records for linked changes (installed with the v3 plugin).</td>
</tr>
<tr>
<td>Project Template [project_template]</td>
<td>Project templates.</td>
</tr>
<tr>
<td>Project Template Configuration [project_template_config]</td>
<td>Configuration settings for project templates.</td>
</tr>
<tr>
<td>Project Template Task [project_template_task]</td>
<td>Tasks in project templates.</td>
</tr>
<tr>
<td>Risk [risk]</td>
<td>Project risks.</td>
</tr>
<tr>
<td>Project Change Request [project_change_request]</td>
<td>Project change requests.</td>
</tr>
<tr>
<td>Status Report [project_status]</td>
<td>Project status reports.</td>
</tr>
<tr>
<td>Teamspace [pm_app_config]</td>
<td>All teamspaces, which refer to the tables that are created for the teamspaces. See Installed with teamspaces for a list of teamspace tables.</td>
</tr>
<tr>
<td>Planned task Relationship [planned_task_rel_planned_task]</td>
<td>Predecessor and successor tasks in a dependent relationship, including task lag values.</td>
</tr>
<tr>
<td>Baseline [planned_task_baseline]</td>
<td>All baselines.</td>
</tr>
<tr>
<td>Baseline Item [planned_task_baseline_item]</td>
<td>All tasks that are part of baselines.</td>
</tr>
<tr>
<td>Task Relationship [task_rel_task]</td>
<td>Predecessor and successor tasks in a dependent relationship.</td>
</tr>
<tr>
<td>Planned task Recalculation Exclusions [planned_task_recalculation_exclusions]</td>
<td>Defines tables that are excluded from recalculation (start and end dates). For example, the table is used for all sub tables under planned_task to exclude tables from being recalculated. This table allows you to configure the tables from which you would not like to perform the recalculation from.</td>
</tr>
</tbody>
</table>
Program management tables

Program management adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program Task</td>
<td>All the tasks in program</td>
</tr>
<tr>
<td>[pm_program_task]</td>
<td></td>
</tr>
<tr>
<td>Program</td>
<td>All programs</td>
</tr>
<tr>
<td>[pm_program]</td>
<td></td>
</tr>
</tbody>
</table>

Resource management tables

Resource management adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Resource Roles</td>
<td>Stores the resource roles for the groups with pps_resource_role. The roles in this table are populated from the User Resource Role [user_has_resource_role] table of the users that are part of a group. The table is read-only.</td>
</tr>
<tr>
<td>group_has_resource_role</td>
<td></td>
</tr>
<tr>
<td>Requested Allocation Daily</td>
<td>Stores day-level breakdown for requested allocations. The table is read-only.</td>
</tr>
<tr>
<td>[requested_allocation_daily]</td>
<td></td>
</tr>
<tr>
<td>Resource Allocation</td>
<td>Allocations for resources.</td>
</tr>
<tr>
<td>[resource_allocation]</td>
<td></td>
</tr>
<tr>
<td>Resource Allocation Daily</td>
<td>On a day-to-day basis, stores the events that are created through a resource plan. Also stores:</td>
</tr>
<tr>
<td>[resource_allocation_daily]</td>
<td>• User created calendar events as records.</td>
</tr>
<tr>
<td></td>
<td>• Actual hours that a user has spent on a task, project, or any other type of activity, such as meeting or admin work.</td>
</tr>
<tr>
<td>Resource Aggregate Daily</td>
<td>On a day-to-day basis, stores aggregated values, such as capacity, allocated hours in a project, confirmed hours in a project, non-project time, actual hours, and availability of every user.</td>
</tr>
<tr>
<td>[resource_aggregate_daily]</td>
<td></td>
</tr>
<tr>
<td>Resource Aggregate Weekly</td>
<td>On a weekly basis, stores aggregated values, such as capacity, allocated hours in a project, confirmed hours in a project, non-project time, actual hours, and availability of every user. The values in the table are asynchronously updated on every insert/update/delete to the Resource Allocation Daily [resource_allocation_daily] table.</td>
</tr>
<tr>
<td>[resource_aggregate_weekly]</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Resource Aggregate Monthly</td>
<td>On a monthly basis, stores aggregated values, such as capacity, allocated hours in a project, confirmed hours in a project, non-project time, actual hours, and availability of every user. The values in the table are asynchronously updated on every insert/update/delete to the Resource Allocation Daily table.</td>
</tr>
<tr>
<td>Requested Allocation</td>
<td>Allocations for resource plans.</td>
</tr>
<tr>
<td>Resource Event</td>
<td>Stores events that are created for a user.</td>
</tr>
<tr>
<td>Resource Event Color</td>
<td>The colors that the application displays for each event type.</td>
</tr>
<tr>
<td>Resource Plan</td>
<td>All resource plans. These columns were added for Helsinki: top_task, program, portfolio.</td>
</tr>
<tr>
<td>Resource Plan Logs</td>
<td>Stores errors and warning that might occur during the resource allocation for a resource plan.</td>
</tr>
<tr>
<td>Resource Report</td>
<td>Resource reports that you can generate and save.</td>
</tr>
<tr>
<td>Resource Report Chart</td>
<td>This table is not used.</td>
</tr>
<tr>
<td>Resource Report Daily</td>
<td>Daily resource reports that you can generate and save.</td>
</tr>
<tr>
<td>Resource Report Monthly</td>
<td>Monthly resource reports that you can generate and save.</td>
</tr>
<tr>
<td>Resource Role</td>
<td>Stores project specific roles.</td>
</tr>
<tr>
<td>User Resource Role</td>
<td>Stores the resource roles for a user.</td>
</tr>
<tr>
<td>User Calendar Event</td>
<td>Stores events that are created in the calendar of a user.</td>
</tr>
<tr>
<td>User Schedule</td>
<td>Stores the schedule for a user.</td>
</tr>
</tbody>
</table>
Innovation management tables

Innovation Management adds the following tables:

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Idea [im_idea_core]</td>
<td>Default table which stores all the information related to the Idea portal. Extends the Task table.</td>
</tr>
<tr>
<td>Idea Category [im_category]</td>
<td>Stores the list of static idea categories.</td>
</tr>
<tr>
<td>Idea Category Configuration [im_category_config]</td>
<td>Stores idea category definition information such as the table to use, field name, and hierarchy of the idea category. Also stores mapping information between idea categories table and the Idea module.</td>
</tr>
<tr>
<td>Idea Categories [im_m2m_idea_category]</td>
<td>Stores mapping information between idea categories and ideas.</td>
</tr>
<tr>
<td>Idea Module [im_module]</td>
<td>Configuration for the Idea portal such as module name, module id, and idea table to use. Create a separate table for each Idea module.</td>
</tr>
</tbody>
</table>

Time card management tables

Time card management adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Card [time_card]</td>
<td>Stores time logged by the user against a category such as a task, meeting, or training.</td>
</tr>
<tr>
<td>Time Sheet [time_sheet]</td>
<td>Groups all time cards for the user for a week.</td>
</tr>
<tr>
<td>Time Sheet Policy time_sheet_policy</td>
<td>Stores all time sheet policies.</td>
</tr>
<tr>
<td>Time Card Daily [time_card_daily]</td>
<td>Stores the time logged in a time card on daily basis.</td>
</tr>
</tbody>
</table>

Rate model tables

Rate model add the following tables.
<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rate Model [rate_model]</td>
<td>Stores rate model definition.</td>
</tr>
<tr>
<td>Rate Model Entity [rate_model_entity]</td>
<td>List of entities from which the attributes can be selected.</td>
</tr>
<tr>
<td>Rate Model Entity Attribute [rate_model_entity_attribute]</td>
<td>List of attributes in the entities.</td>
</tr>
<tr>
<td>Rate Model Line [rate_model_line]</td>
<td>Stores rate line values.</td>
</tr>
<tr>
<td>Rate Model Line Attribute [rate_model_line_attribute]</td>
<td>Stores rate line attributes that are added from the entities.</td>
</tr>
<tr>
<td>Rate Line Import Set [imp_rate_model_line]</td>
<td>Stores import sets that you imported into the instance.</td>
</tr>
</tbody>
</table>

Roles installed with PPM Standard (Project Portfolio Management)
Roles are added with activation of PPM Standard plugin.

Project Portfolio Suite roles
Project Portfolio Suite adds the following roles.

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Portfolio manager [it_portfolio_manager] | Has access to all portfolios. Has the same access permissions as a project user and a demand user. Also has budget owner role is added as part of Financial Management. | • it_demand_user
• it_project_manager
• it_project_user
• portfolio_manager
• it_demand_manager
• it_project_portfolio_user |
| PPS admin [it_pps_admin] | Can view and modify the preferences, configurations, and settings for projects, demands, programs, portfolios, resources, time cards, agile development, and timeline visualization. | • it_program_manager
• it_portfolio_manager
• it_project_manager
• it_demand_manager
• pps_admin
• timeline_admin
• rate_model_admin |

Demand management roles
Demand management adds the following roles.
### Demand manager

**[it_demand_manager]**

Can access all the modules of the Demand Management application.

- it_project_user
- resource_user
- timeline_user
- demand_manager
- it_demand_user
- rate_model_user

### Demand user

**[it_demand_user]**

Can access the Demand and Stakeholders modules of the Demand Management application.

- demand_user
- pps_resource

### Project management roles

Project management adds the following roles.

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portfolio user</td>
<td>User who can view IT Portfolio Project records.</td>
<td>• project_portfolio_user</td>
</tr>
<tr>
<td>[it_project_portfolio_user]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Project user</td>
<td>Can only view Project form fields. Can modify</td>
<td>• it_project_portfolio_user&lt;br&gt;• project_user</td>
</tr>
<tr>
<td>[it_project_user]</td>
<td>additional fields on the Project Task form, such</td>
<td></td>
</tr>
<tr>
<td></td>
<td>as Time constraint and State.</td>
<td></td>
</tr>
<tr>
<td>Project manager</td>
<td>Has configuration access right to all Project</td>
<td>• resource_user&lt;br&gt;• it_demand_manager&lt;br&gt;• it_project_user&lt;br&gt;• project_manager&lt;br&gt;</td>
</tr>
<tr>
<td>[it_project_manager]</td>
<td>Management application features and functionality.</td>
<td>The project_manager role also contains the timecard_approver role.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• timeline_user&lt;br&gt;• rate_model_user</td>
</tr>
</tbody>
</table>

### Program management roles

Program management adds the following roles.

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program manager</td>
<td>Program managers have access to all programs.</td>
<td>• resource_user&lt;br&gt;• it_project_user&lt;br&gt;• program_manager&lt;br&gt;it_demand_user</td>
</tr>
<tr>
<td>[it_program_manager]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Resource management roles

Resource management adds the following roles.

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource manager [resource_manager]</td>
<td>Users with this role can:</td>
<td>• resource_user&lt;br&gt;• timecard_approver&lt;br&gt;• skill_admin&lt;br&gt;• rate_model_user</td>
</tr>
<tr>
<td></td>
<td>• Review resource plans, confirm, and allocate resources to tasks.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Create skills and view them in the User Skills list.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Read schedules.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Create and update a group of type pps_resource.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Add members to a group of type pps_resource.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Update group name, group email, parent, description, manager, average daily FTE hours/hours per person day, and hourly rate.</td>
<td></td>
</tr>
<tr>
<td>Resource user [resource_user]</td>
<td>Users with this role can create resource plans and request resources.</td>
<td>• None</td>
</tr>
<tr>
<td></td>
<td>Project managers are typically given this role. Resource users cannot make changes to plans in the Confirmed or Allocated state.</td>
<td></td>
</tr>
<tr>
<td>PPS resource [pps_resource]</td>
<td>Only users with the PPS Resource role are considered for resource planning, and only users or groups with the PPS resource role appear in resource plans.</td>
<td>• None</td>
</tr>
</tbody>
</table>

Innovation management roles

Innovation Management adds the following roles:

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Idea admin [idea_admin]</td>
<td>• Creates idea module.&lt;br&gt;• Defines idea categories.&lt;br&gt;• Configures mapping of idea categories with idea module.&lt;br&gt;• Manages ideas and creates tasks such as story, epic, feature, project, or demand from an idea.</td>
<td>• idea_manager</td>
</tr>
<tr>
<td>Role title [name]</td>
<td>Description</td>
<td>Contains roles</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>Idea manager</td>
<td>Manages ideas and creates tasks such as project or demand from an idea.</td>
<td>• None</td>
</tr>
<tr>
<td>Idea manager professional</td>
<td>Manages ideas and creates tasks such as story, epic, feature, project, or demand from an idea.</td>
<td>• None</td>
</tr>
</tbody>
</table>

**Time card management roles**

Time card management adds the following roles.

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time card admin</td>
<td>Has write access to all time cards.</td>
<td>• timecard_user</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• timecard_approver</td>
</tr>
<tr>
<td>Time card approver</td>
<td>Approves or rejects time cards for time card users.</td>
<td>• timecard_user</td>
</tr>
<tr>
<td>Time card user</td>
<td>Creates time cards for self.</td>
<td>• None</td>
</tr>
</tbody>
</table>

**Rate model roles**

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rate model admin</td>
<td>Manages rate models and rate lines. Has all privileges within rate model, including configuring attributes, export and import of rate lines, and administration.</td>
<td>• rate_model_user</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• import_set_loader</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• import_transformer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• import_admin</td>
</tr>
<tr>
<td>Rate model user</td>
<td>View rate model and rate lines.</td>
<td>• None</td>
</tr>
</tbody>
</table>

**Activate Investment Funding for PPM**

Activate the Investment Funding for PPM plugin (com.snc.investment_planning_pmo) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Role required: admin

The Investment Funding for PPM plugin enables you to request or allocate funds for your projects and demands.

The plugin activates the related plugins if they are not already active. It also adds the investment_user role to the following roles:
• project_manager
• demand_manager
• portfolio_manager
• program_manager

Plugins for Investment Funding for PPM

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PPM Standard [com.snc.financial_planning_pmo]</td>
<td>Enables you to manage your demands, resources, portfolios and projects. It also helps you plan, track, and manage the costs and budget of projects and demands in a portfolio to maintain a balance between investment and returns.</td>
</tr>
</tbody>
</table>

1. Navigate to **System Applications > All Available Applications > All.**
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate.**

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise they will receive the following error: **Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.**

**Currencies and budget reference rates**
The support for use of multiple currencies provides conversions for budget items in different currencies.

**Currency support**
The application can use a base currency, also called the reporting currency that you specify with system properties. You can also specify other currencies for budgets and budget items.

**Currency usage**

<table>
<thead>
<tr>
<th>Item</th>
<th>Currency used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Budget plan</td>
<td>A currency that you specify on the Budget Plan form. When the plan is converted to a forecast, the application converts the currency to the reporting currency.</td>
</tr>
<tr>
<td>Budget plan items</td>
<td>A currency that you specify on the Budget Item form. If the budget plan item has currency different from the budget plan currency, the budget plan item amount is converted to the budget plan currency.</td>
</tr>
<tr>
<td>Budget forecast</td>
<td>The reporting currency.</td>
</tr>
</tbody>
</table>
Budget reference rates

Budget reference rates are exchange rates between currencies. Each reference rate is valid for a specified time period. The application uses budget reference rates when budget items are in a different currency from the budget plan and forecast. The application automatically converts budget item currency values to a global system currency value when it calculates the Budget Amount on a Budget Plan, and when it shows values on budget forecasts.

Note: Currency support is for budgets only. You cannot create allocations in multiple currencies.

Related lists added for financials

PPM Standard adds several related lists to both the Project and Portfolio forms.

Portfolio related lists

This table explains the related lists and how to create or use the records in these lists in the portfolio workbench.

<table>
<thead>
<tr>
<th>Portfolio form related lists</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost Plans</td>
<td>Lists the cost plans of projects and demands that are part of the portfolio.</td>
</tr>
<tr>
<td>Benefit Plans</td>
<td>Lists the benefit plans of projects and demands that are part of the portfolio. To create a benefit plan, click <strong>New</strong>.</td>
</tr>
<tr>
<td>Portfolio Target</td>
<td>Lists the portfolio capital and operational expense target for different fiscal years. The values are displayed from the project_funding table. Set these values in the <strong>Set Target stage</strong> of the portfolio workbench. You can create targets for different financial periods.</td>
</tr>
<tr>
<td>Planning &amp; Budgeting</td>
<td>According to the fiscal years, lists projects and demands that are part of the portfolio. You can include or exclude a project or demand from the portfolio budget plan. When you select the project or demand in the <strong>Select Project and Demands step</strong> of the portfolio workbench and move to the next stage, the <strong>Planned</strong> value changes to <strong>true</strong>.</td>
</tr>
</tbody>
</table>
Project related lists for financials

This table explains the related lists for financials in a project record.

<table>
<thead>
<tr>
<th>Project form related lists</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost Plans</td>
<td>Costs of the project for a specific fiscal period. Cost plans can also have an associated expense line.</td>
</tr>
<tr>
<td>Benefit Plans</td>
<td>Potential benefits which can be accrued by the project spanning one or more fiscal periods, if the project is executed.</td>
</tr>
<tr>
<td>Project Budget</td>
<td>Lists the project budget by fiscal year. Click the amounts in the list to revise them.</td>
</tr>
<tr>
<td>Expense Lines</td>
<td>Aggregated actual costs associated with a specific source, such as a user, fixed asset, or a CI.</td>
</tr>
</tbody>
</table>

Business stakeholder role for PPM

For PPM users, the Business Stakeholder (com.snc.business_stakeholder) plugin contains the business stakeholder roles for APM, ITFM, and PPM. Users with this role can read records of the tables that are used to retrieve data for reports and dashboards and can approve demands and timecards. You can assign this role to any user who is a business stakeholder.

Upgrade information

If you have upgraded, the business stakeholder role for PPM is available only when you activate Read only roles for PPM Standard plugin (com.snc.pmo_read_roles).

If you are a new customer, the Read only roles for PPM Standard plugin (com.snc.pmo_read_roles) is activated on zBoot. However, the business stakeholder role for PPM is available only when you install the PPM Standard plugin.

Demand and Timecard approver roles

The Read only roles for PPM Standard plugin (com.snc.pmo_read_roles) installs the sn_ppm_read role. The sn_ppm_read role provides read-only access to the Portfolio, Program, and Timecard dashboards along with the Resources report to the assigned users. The sn_ppm_read role also contains the timecard_approver and demand_approver roles, which allow the assigned users to approve demands and timecards.

PPM tables accessible to users with the business stakeholder role

Users with the business stakeholder role for PPM can access the following tables that store the data to load the widgets in the Portfolio dashboard, Program dashboard, and Time Sheet dashboard, and Resource reports:
Strategic Spend Tracking for PPM

Strategic Spend Tracking for PPM enables project or demand managers to evaluate the strategic value of organization’s projects and demands. You can identify the purpose and benefits of executing demands and projects and how they contribute to achieving company’s strategies and goals.

Strategic Spend Tracking for PPM enables demand and project managers to determine how and where funding is being spent during the execution of a demand or project.

Organizations generally determine and approve investment budgets that represent the funds allocated to achieve their goals. Strategic Spend Tracking for PPM focuses on allocating your investment budget through demands and projects, and tracking the expenditure to achieve your organizational goals.

Each demand and project contributes to achieving one or multiple organizational goals. You can use the Strategic Spend Tracking for PPM to perform the following tasks:

- Associate multiple strategies and goals with a demand or project.
- Allocate a percentage of the demand or project’s total cost and benefits towards achieving one or more strategies and goals.
- Generate strategy and goal allocation breakdowns for a demand or project for the fiscal year.
• View the roll up of strategy and goal breakdowns from different demands and projects in the strategy and goal record.
• Use the Strategic Spend Tracking for PPM dashboard to view how the planned costs, actuals costs, and benefits for projects aligned to the organization's goals and strategies trend over time in order to accurately understand the financial performance of your organization.

Install Strategic Spend Tracking for PPM

Install the Strategic Spend Tracking for PPM application from ServiceNow Store applications. Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Complete the following setup checklist for a smooth installation and configuration.

<table>
<thead>
<tr>
<th>Setup tasks</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify that PPM Standard plugin (com.snc.financial_planning_pmo) is activated.</td>
<td>Navigate to Subscription Management &gt; Subscriptions in your instance. The list displays the subscriptions that your organization has purchased.</td>
</tr>
</tbody>
</table>

Role required: admin

Activate the PPM Standard plugin (com.snc.financial_planning_pmo) in your ServiceNow instance before you install Strategic Spend Tracking for PPM. For more information see, Activate PPM Standard (Project Portfolio Management).

1. Navigate to System Applications > All Available Applications > All.
2. Find the application using the filter criteria and search bar.
   You can search for the application by its name or ID. If you cannot find an application, you may have to request it from the ServiceNow Store. Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
3. Click Install.
4. In the Application installation dialog box, review the application dependencies.
   Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If there are any plugins or applications that need to be installed, you must install them before you can install the ServiceNow Store application.
5. Optional: If demo data is available and you want to install it, click Load demo data.
   Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.

   **Important:** If you don't load the demo data during installation, it's unavailable to load later.

6. Click Install.

Components installed with Strategic Spend Tracking for PPM
Several types of components are installed with activation of Strategic Spend Tracking for PPM, including tables and scheduled jobs.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.
Scheduled jobs installed

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PPM Strategic Spend Tracking - Generate Strategy/Goal Allocation Breakdowns</td>
<td>Generates breakdown of strategy and goal allocation for the associated projects and demands.</td>
</tr>
<tr>
<td>PPM Strategic Spend Tracking - Update projects and Demands with strategy and</td>
<td>Updates strategy and goal allocations for the associated projects and demands.</td>
</tr>
<tr>
<td>Demand allocations</td>
<td></td>
</tr>
</tbody>
</table>

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BO Job Execution Log [sn_ppm_sst_run_log]</td>
<td>Stores information about execution of the scheduled jobs such as time of execution and tasks there were included.</td>
</tr>
<tr>
<td>Goal Allocation [sn_ppm_sst_task_goal]</td>
<td>Stores goal allocation details for a project or demand. The details include project or demand number, strategy name, % allocated towards the strategy, budget, planned cost, actual cost, and benefit amount.</td>
</tr>
<tr>
<td>Goal Allocation Breakdown [sn_ppm_sst_goal_allocation_breakdown]</td>
<td>Stores goal breakdown details for a project or demand. The details include fiscal year, strategy allocation amount, cost details (planned and actual), and capex and opex amounts (planned and actual).</td>
</tr>
<tr>
<td>Strategy Allocation [sn_ppm_sst_task_strategy]</td>
<td>Stores strategy allocation details for a project or demand. The details include project or demand number, strategy name, % allocated towards the strategy, budget, planned cost, actual cost, and benefit amount.</td>
</tr>
<tr>
<td>Strategy Allocation Breakdown [sn_ppm_sst_strategy_allocation_breakdown]</td>
<td>Stores strategy breakdown details for a project or demand. The details include fiscal year, strategy allocation amount, cost details (planned and actual), and capex and opex amounts (planned and actual).</td>
</tr>
</tbody>
</table>

Allocate or modify the strategy and goal percentage for a project

Allocate the percentage of a project's total cost, benefit, and budget to help achieve the strategic objectives that the project fulfills. You can also view the breakdown of the project's financial data based on the allocated percentage.

You should have an existing project.

Execute the following scheduled jobs:

- PPM Strategic Spend Tracking - Update projects and demands with strategy and goal allocations
- PPM Strategic Spend Tracking - Generate Strategy/Goal Allocation Breakdowns for Projects and Demands
Role required: it_project_manager

1. Navigate to Project > Projects > All.
2. Select the project to which you want to add or update allocation percentages.
3. In the Business Case tab, add or update the strategies and goals with which the project is associated.
   For more information, see the Business Case field descriptions in the Create a project documentation topic.
4. Click Save.
   The selected strategies and goals appear in the Strategy Allocations and Goal Allocations related lists.
5. Update strategy and goal allocations.
   a) In the Strategy Allocations related list, click the % Allocation field and enter the percentage that this project contributes towards the selected organizational strategy.
   b) In the Goal Allocations related list, click the % Allocation field and enter the percentage that this project contributes towards the selected organizational goal.
   
   **Note:** The sum of strategy or goal allocations for a project must not exceed 100%.

6. Click the Recalculate Strategy and Goal Allocation related link to update cost field values in the allocation tabs.
7. Click Update.
8. Optional: In the Strategy or Goal Allocations related list, click the preview icon (i), and then click Open Record to view the breakdown of the strategy or goal allocation.
9. Optional: View the trends for planned costs, actual costs, and benefits over time using the Strategic Spend Tracking for PPM dashboard.

Allocate or modify the strategy and goal percentage for a demand

Allocate the percentage of a demand's total cost, benefit, and budget towards achievement of strategic objectives that the demand fulfills. You can also view the breakdown of the demand's financial data based on the allocated percentage.

You should have an existing demand.

Execute the following scheduled jobs:

- PPM Strategic Spend Tracking - Update projects and demands with strategy and goal allocations
- PPM Strategic Spend Tracking - Generate Strategy/Goal Allocation Breakdowns for Projects and Demands

Role required: it_demand_manager

1. Navigate to Demand > Demands > All.
2. Select the demand to which you want to add or update allocation percentages.
3. In the Business Case tab, add or update the strategies and goals with which the demand is associated.
   For more information, see the Business Case field descriptions in the Create a demand documentation topic.
4. Click Save.
   The selected strategies and goals appear in the Strategy Allocations and Goal Allocations related lists.
5. Update strategy and goal allocations.
   a) In the Strategy Allocations related list, click the % Allocation field and enter the percentage that this demand contributes towards the selected organizational strategy.
b) In the Goal Allocations related list, click the % Allocation field and enter the percentage that this demand contributes towards the selected organizational goal.

**Note:** The sum of strategy or goal allocations for a demand must not exceed 100%.

6. Click the **Recalculate Strategy and Goal Allocation** related link to update cost field values in the allocation tabs.

7. Click **Update**.

8. Optional: In the Strategy or Goal Allocations related list, click the preview icon (i), and then click **Open Record** to view the breakdown of the strategy or goal allocation.

9. Optional: View the trends for planned costs, actual costs, and benefits over time using the **Strategic Spend Tracking for PPM dashboard**.

**Strategic Spend Tracking for PPM dashboard**

The Strategic Spend Tracking for PPM dashboard provides comprehensive visualization to the business planners to help them understand how the planned costs, actual costs, and benefits for projects aligned to the organization's goals and strategies trend over time. It helps you to accurately understand the financial performance of your organization. You can analyze the total expenses, and drill down to what is contributing to the cost, and which departments and business units are spending.
### Strategy Overview tab

<table>
<thead>
<tr>
<th>Projects</th>
<th>Aligned Projects</th>
<th>Planned Cost</th>
<th>Planned Cost - Aligned Projects</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><img src="image1" alt="Pie Chart" /></td>
<td><img src="image2" alt="Pie Chart" /></td>
<td><img src="image3" alt="Pie Chart" /></td>
</tr>
<tr>
<td></td>
<td>33</td>
<td>$6M</td>
<td>$193k</td>
</tr>
<tr>
<td></td>
<td><img src="image4" alt="Pie Chart" /></td>
<td><img src="image5" alt="Pie Chart" /></td>
<td><img src="image6" alt="Pie Chart" /></td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>$7M</td>
<td>$94k</td>
</tr>
<tr>
<td></td>
<td><img src="image7" alt="Pie Chart" /></td>
<td><img src="image8" alt="Pie Chart" /></td>
<td><img src="image9" alt="Pie Chart" /></td>
</tr>
<tr>
<td></td>
<td><img src="image10" alt="Pie Chart" /></td>
<td><img src="image11" alt="Pie Chart" /></td>
<td><img src="image12" alt="Pie Chart" /></td>
</tr>
<tr>
<td></td>
<td><img src="image13" alt="Pie Chart" /></td>
<td><img src="image14" alt="Pie Chart" /></td>
<td><img src="image15" alt="Pie Chart" /></td>
</tr>
<tr>
<td></td>
<td><img src="image16" alt="Pie Chart" /></td>
<td><img src="image17" alt="Pie Chart" /></td>
<td><img src="image18" alt="Pie Chart" /></td>
</tr>
<tr>
<td></td>
<td><img src="image19" alt="Pie Chart" /></td>
<td><img src="image20" alt="Pie Chart" /></td>
<td><img src="image21" alt="Pie Chart" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Total Benefit</th>
<th>Total Benefit - Aligned Projects</th>
<th>Actuals</th>
<th>Actuals - Aligned Projects</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image22" alt="Pie Chart" /></td>
<td><img src="image23" alt="Pie Chart" /></td>
<td><img src="image24" alt="Pie Chart" /></td>
<td><img src="image25" alt="Pie Chart" /></td>
</tr>
<tr>
<td>$7M</td>
<td><img src="image26" alt="Pie Chart" /></td>
<td><img src="image27" alt="Pie Chart" /></td>
<td>$0</td>
</tr>
<tr>
<td>$300k</td>
<td><img src="image28" alt="Pie Chart" /></td>
<td><img src="image29" alt="Pie Chart" /></td>
<td>$94k</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Strategy Detail tab
Goal Overview tab
Goal Detail tab

End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Planner: Needs visibility into strategies and goals for projects and demands in the organization.</td>
<td>business_planner</td>
</tr>
</tbody>
</table>

Indicators

The dashboard contains the following indicators for strategies:

Projects

Comparison of aligned and unaligned projects for strategies.

Aligned Projects

Count of the projects aligned to strategies.
Unaligned Projects
Count of the projects not aligned to strategies.

Planned Cost
Comparison of aligned and unaligned planned cost for strategies.

Planned Cost - Aligned Projects
Total planned cost for all projects aligned to strategies.

Planned Cost - Unaligned Projects
Total planned cost for all projects not aligned to strategies.

Total Benefit
Comparison of aligned and unaligned benefit amount for strategies.

Total Benefit - Aligned Projects
Total benefit amount for all projects aligned to strategies.

Total Benefit - Unaligned Projects
Total benefit amount for all projects not aligned to strategies.

Actuals
Comparison of aligned and unaligned actual cost for strategies.

Actuals - Aligned Projects
Total actual cost for all projects aligned to strategies.

Actuals - Unaligned Projects
Total actual cost for all projects not aligned to strategies.

The dashboard contains the following indicators for goals:

Projects
Comparison of aligned and unaligned projects for goals.

Aligned Projects
Count of the projects aligned to goals.

Unaligned Projects
Count of the projects not aligned to goals.

Planned Cost
Comparison of aligned and unaligned planned cost for goals.

Planned Cost - Aligned Projects
Total planned cost for all projects aligned to goals.

Planned Cost - Unaligned Projects
Total planned cost for all projects not aligned to goals.

Total Benefit
Comparison of aligned and unaligned benefit amount for goals.

Total Benefit - Aligned Projects
Total benefit amount for all projects aligned to goals.
Total Benefit - Unaligned Projects
Total benefit amount for all projects not aligned to goals.

Actuals
Comparison of aligned and unaligned actual cost for goals.

Actuals - Aligned Projects
Total actual cost for all projects aligned to goals.

Actuals - Unaligned Projects
Total actual cost for all projects not aligned to goals.

Breakdowns
The dashboard includes the following breakdowns:
• Strategy
• Goal
• Project Cost
• Project Benefit
• Actuals

Reports
The dashboard includes the following reports for strategies:

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Cost</td>
<td>Bar</td>
<td>Comparison of total planned and actual costs for all projects grouped by fiscal period for strategies.</td>
</tr>
<tr>
<td>Project Benefit</td>
<td>Bar</td>
<td>Comparison of total planned and actual benefits for all projects grouped by fiscal period for strategies.</td>
</tr>
<tr>
<td>Project Distribution</td>
<td></td>
<td>Breakdown of the distribution of projects by strategy.</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Planned Cost Distribution</td>
<td>Bar</td>
<td>Breakdown of the distribution of planned cost of projects by strategy.</td>
</tr>
<tr>
<td>Planned Benefit Distribution</td>
<td>Bar</td>
<td>Breakdown of the distribution of planned benefit of projects by strategy.</td>
</tr>
</tbody>
</table>

The dashboard includes the following reports for goals:

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Cost</td>
<td>Bar</td>
<td>Comparison of total planned and actual costs for all projects grouped by fiscal period for goals.</td>
</tr>
<tr>
<td>Project Benefit</td>
<td>Bar</td>
<td>Comparison of total planned and actual benefits for all projects grouped by fiscal period for goals.</td>
</tr>
<tr>
<td>Project Distribution</td>
<td>Bar</td>
<td>Breakdown of the distribution of projects by goals.</td>
</tr>
<tr>
<td>Planned Cost Distribution</td>
<td>Bar</td>
<td>Breakdown of the distribution of planned cost of projects by goals.</td>
</tr>
<tr>
<td>Planned Benefit Distribution</td>
<td>Bar</td>
<td>Breakdown of the distribution of planned benefit of projects by goals.</td>
</tr>
</tbody>
</table>
Project Portfolio Management Analytics and Reporting Solutions

Analytics and Reporting Solutions contain preconfigured dashboards. These dashboards contain actionable data visualizations that help you improve your business processes and practices.

Analytics and Reporting Solutions

Use the widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With these solutions, you can get value from your application with minimal setup. You can always create your own objects as well.

Important: Set up and test solutions on a non-production instance before enabling them in production.

Note: Solutions provide all the configuration records required to analyze default applications. Customize these records for use in your production environment. For more information, see Configure Solutions.

To enable the solution for Project Portfolio Management, log in as an admin and navigate to Performance Analytics > Guided Setup. Click Get Started, then scroll to the section for PPM Standard Dashboards. The guided setup takes you through the entire setup and configuration process.

Alternatively, activate the Performance Analytics – Content Pack – PPM Standard plugin (com.snc.pa.pmo_dashboards).

Activation of com.snc.pa.pmo_dashboards plugin also activates the following plugins:

- PPM Standard (com.snc.financial_planning_pmo)
- Performance Analytics – Content Pack – Project Portfolio Suite Dashboards (com.snc.pps_dashboards)

Access the PMO dashboard using either of the following navigation links:

- Project > Portfolios > Portfolio Dashboard.
- Project > Programs > Program Dashboard.
- Self-Service > Dashboards. Search for PMO Dashboard using the search field.
- Time Sheets > Time Sheet Portal > Time Sheet Dashboard.

The dashboard displays the data based on the navigation link used to open it.

Domain separation and 'Run As' user

By default, System Administrator is the Run As user for data collection jobs in the Analytics and Reporting Performance Analytics Solutions. Verify that this user exists on the instance, and whether this user has the appropriate level of access. An inappropriate Run As user can cause errors or limit the data that is collected. This setting only has an effect if domain separation is enabled.

Older version of this solution

This solution replaces the Project Portfolio Suite (com.snc.pa.ppm) Solution. If you activated an earlier version of the solution and then upgraded your instance, you still have and can still use the earlier solution. You can also activate the newer version without losing data from existing indicators and breakdowns. If you activate the newer version, run a historical data collection job to populate new indicators and breakdowns for the Time Sheet dashboard.
PMO dashboard

The PMO dashboard provides comprehensive reports to the portfolio and program managers. The dashboard uses Performance Analytics to provide a trend of historical data as well as regular reports. It gives an overview of your investments, provides a pipeline view of upcoming intake and a calendar view of upcoming dates.

Summary tab
Project Health tab

End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portfolio manager: Needs visibility into programs, projects, and demands in their</td>
<td>it_portfolio_manager</td>
</tr>
<tr>
<td>portfolio and actions that should be taken.</td>
<td></td>
</tr>
<tr>
<td>End user and goal</td>
<td>Required role</td>
</tr>
<tr>
<td>----------------------------------------------------------------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Program manager: Needs visibility into projects and demands in their programs and actions that should be taken.</td>
<td>it_program_manager</td>
</tr>
<tr>
<td>Project manager: Has access to the dashboards.</td>
<td>it_project_manager</td>
</tr>
</tbody>
</table>

**Indicators**

The Summary, Pipeline, and Project Health tabs in the dashboard contain widgets with the following indicators. The data for projects is collected from the [pm_project] table, the data for demands is collected from the [dmn_demand] table, and the data for ideas is collected from the [idea] table.

**PPM – Number of Active Projects**
Count of active projects. Projects are considered active where actual end date is <after today> or <empty>.

**Note:** If the Actual End Date for a project is in the future but the project is in Closed state, the reports still pick up the project as active.

**PPM – Allocated Hours less than Planned Hours**
Count of active projects that have resource plans where the allocated hours is less than the planned hours.

**PPM – Active Projects in Open, Pending, Work in Progress state**
Count of active projects in Open, Pending, or Work in Progress state.

**PPM – Number of Active Red Projects**
Count of active projects that have an overall red status.

**PPM – Total age of Open Project**
Total age of all active projects in days. It is the difference between the planned start date of the active project and the date when the indicator score is collected. The indicator is used to calculate the average age of open projects.

**PPM – Planned Cost**
Total planned cost for all the active projects.

**PPM – Actual Cost**
Total actual cost for all the active projects.

**PPM – Number of Active Projects with negative ROI**
Count of active projects with a negative Return on Investment.

**PPM – Estimate at Completion**
Total estimated cost at completion for all active projects.

**PPM – Number of Projects with High Risks**
Count of active projects that have a Risk in Pending state and Probability as Absolute or High.

**PPM – Number of Projects with Critical Issues**
Count of active projects that have an Issue with state Open or Work in Progress and priority as Critical.
PPM – Number of Projects with Missed Milestones
Count of active projects that have a milestone with planned end date due before today.

PPM – Number of Active Overdue Projects
Count of active projects that have Planned end date before today.

PPM – Unallocated Resources
Count of projects in state Work in Progress that have resource plans in Planning, Requested, or Confirmed state.

PPM – Allocated Hours less than Actual Hours
Count of active projects that have resource plans where the actual hours is greater than the allocated hours.

PPM – Planned Benefits
Total planned benefit for all active projects.

PPM – Actual Benefits
Total actual benefit for all active projects.

PPM – Number of Projects with critical Change Requests
Count of active projects that have a Project Change Request with state as Open and priority as Critical.

PPM – Number of Total Demands this Month
Count of demands in the given month with state other than Draft.

PPM – Number of Demands with Projects this Month
Count of demands that are converted to projects in the given month.

PPM – Open Demands Submitted, Screening, Qualified or Approved
Count of demands in Submitted, Screening, Qualified, or Approved state.

PPM – Total Age of Open Demand in Submitted, Screening, Qualified, Approved state
Total age (in days) of active demands in Submitted, Screening, Qualified, or Approved state. It is the difference between the creation date of the demand and the date when the indicator score is collected. The indicator is used to calculate the average age of open demands.

PPM – Total Age of Demand to Project this Month
Total age (in days) of all demands that are converted to projects in the given month. It is sum of the difference between the creation date of demands and the creation date of corresponding projects. The indicator is used to calculate the average age of Demand to Project.

PPM – Number of Open Ideas
Count of ideas in Submitted state and no Demand associated.

PPM – Total Age of Open Idea
Total number of days an idea is in state Submitted before conversion to demand.

PPM – Number of Total Ideas this Month
Count of ideas other than Draft state and created in the given month.

PPM – Number of Ideas with Demands this Month
Count of ideas converted to demands in the given month.
The dashboard also uses the following formula indicators. The formula indicators are based on few of the preceding indicators.

**PPM – Average age open project**
Average number of days a project is in state Pending, Open, or Work in Progress. The indicator is calculated using the PPM – Total Age of Open Project and PPM – Number of Active Projects indicators.

**PPM – Percentage of Ideas to Demands last 12 months**
Percentage of ideas converted to demands in last 12 months.

**PPM – Average age Demand to Project last 12 months**
Average number of days before a demand has been converted to a project.

**PPM – Percentage of Demand to Project last 12 months**
Percentage of demands converted to projects in last 12 months.

**PPM – Average age open demand**
Average number of days a demand is in state Submitted, Screen, Qualified, or Approved and has not been converted to project.

**PPM – Average age open idea**
Average number of days an idea is in state Submitted before conversion to demand.

**PPM – Portfolio Health**
Percentage of portfolio health based on active projects in overall red status, active projects that are overdue, and active projects with critical issues.

**Breakdowns**

- Business Unit
- Demand Category
- Demand Manager
- Demand State
- Demand Type
- Department
- Impact
- Portfolio
- Portfolio Manager
- Priority
- Program
- Program Manager
- T-Shirt Size
- Execution Type
- Investment Class
- Investment Type
- Project Manager
- Project Phase
- Project State
- Project Status
- Overall Health
# Reports

The dashboard includes the following reports:

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Benefit Plans by Category</td>
<td>Donut</td>
<td>Breakdown of the number of benefit plans in each category for active projects.</td>
</tr>
<tr>
<td>Projects Planned Benefits by Category</td>
<td>Horizontal bar</td>
<td>Total planned benefits in each category for active projects.</td>
</tr>
<tr>
<td>Projects by Business Unit</td>
<td>Donut</td>
<td>Breakdown of the number of active projects in each business unit.</td>
</tr>
<tr>
<td>Projects by Investment Type</td>
<td>Donut</td>
<td>Breakdown of the number of active projects grouped by investment type.</td>
</tr>
<tr>
<td>Projects by Investment Class</td>
<td>Donut</td>
<td>Breakdown of the number of active projects grouped by investment class.</td>
</tr>
<tr>
<td>Projects by Priority</td>
<td>Horizontal bar</td>
<td>Breakdown of the number of active projects grouped by priority.</td>
</tr>
<tr>
<td>Hours by Project Time Category</td>
<td>Line</td>
<td>Trend of total hours reported in time cards for each Project Time Category. The trend is displayed from the beginning of last quarter until the end of next quarter.</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active Demands</td>
<td>Single score</td>
<td>Number of demands in Submitted, Screened, Qualified, and Approved state with no project associated.</td>
</tr>
<tr>
<td>Demands – No Manager</td>
<td>Single score</td>
<td>Number of active demands with no associated demand manager.</td>
</tr>
<tr>
<td>Demands – No Business Case</td>
<td>Single score</td>
<td>Number of active demands with no business case.</td>
</tr>
<tr>
<td>Demands – No Planned Cost</td>
<td>Single score</td>
<td>Number of active demands with zero total planned cost.</td>
</tr>
<tr>
<td>Demands – No Start Date</td>
<td>Single score</td>
<td>Number of active demands with no start date.</td>
</tr>
<tr>
<td>Demands – No Investment Class</td>
<td>Single score</td>
<td>Number of active demands with no associated investment class.</td>
</tr>
<tr>
<td>Demands – No Budget Cost</td>
<td>Single score</td>
<td>Number of active demands with zero capital and zero operating budget.</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Demands – No Due Date</td>
<td>Single score</td>
<td>Number of active demands with no due date.</td>
</tr>
<tr>
<td>Demands – No Investment Type</td>
<td>Single score</td>
<td>Number of active demands with no associated investment type.</td>
</tr>
<tr>
<td>Demands – No Financial Benefits</td>
<td>Single score</td>
<td>Number of active demands with no or zero financial benefit.</td>
</tr>
<tr>
<td>Demands – No Portfolio</td>
<td>Single score</td>
<td>Number of active demands with no associated portfolio.</td>
</tr>
<tr>
<td>Demands – No Program</td>
<td>Single score</td>
<td>Number of active demands with no associated program.</td>
</tr>
<tr>
<td>Demands – No ROI</td>
<td>Single score</td>
<td>Number of active demands with no Return on Investment.</td>
</tr>
<tr>
<td>Active Projects</td>
<td>Single score</td>
<td>Number of projects with actual end date &lt;after today&gt; or &lt;empty&gt;.</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Projects – No Manager</td>
<td>Single score</td>
<td>Number of active projects with no associated project manager.</td>
</tr>
<tr>
<td>Projects – No Business Case</td>
<td>Single score</td>
<td>Number of active projects with no business case.</td>
</tr>
<tr>
<td>Projects – No Planned Cost</td>
<td>Single score</td>
<td>Number of active projects with zero total planned cost.</td>
</tr>
<tr>
<td>Projects – No Task</td>
<td>Single score</td>
<td>Number of active projects with no associated project tasks.</td>
</tr>
<tr>
<td>Projects – No Investment Class</td>
<td>Single score</td>
<td>Number of active projects with no associated investment class.</td>
</tr>
<tr>
<td>Projects – No Budget Cost</td>
<td>Single score</td>
<td>Number of active projects with zero budget cost.</td>
</tr>
<tr>
<td>Projects – No Description</td>
<td>Single score</td>
<td>Number of active projects that have no description.</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Projects – No Investment Type</td>
<td>Single score</td>
<td>Number of active projects with no associated investment type.</td>
</tr>
<tr>
<td>Projects – No Planned Benefit</td>
<td>Single score</td>
<td>Number of active projects with zero planned benefit.</td>
</tr>
<tr>
<td>Projects – No Portfolio</td>
<td>Single score</td>
<td>Number of active projects with no associated portfolio.</td>
</tr>
<tr>
<td>Projects – No Program</td>
<td>Single score</td>
<td>Number of active projects with no associated program.</td>
</tr>
<tr>
<td>Projects – No ROI</td>
<td>Single score</td>
<td>Number of active projects with no planned Return on Investment.</td>
</tr>
<tr>
<td>Planned vs Budget vs Actual Cost</td>
<td>Bar</td>
<td>Comparison of total planned, budget, and actual costs for active projects grouped by fiscal period.</td>
</tr>
<tr>
<td>Allocated vs Actual Hours</td>
<td>Step</td>
<td>Monthly trends of total allocated and actual hours for resource plans associated with active projects.</td>
</tr>
</tbody>
</table>
### Title, Type, Description

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planned vs Actual Benefits</td>
<td>Bar</td>
<td>Comparison of total planned and actual benefits for active projects grouped by fiscal period.</td>
</tr>
<tr>
<td>Planned vs Actual Benefits by Category</td>
<td>Bar</td>
<td>Comparison of total planned and actual benefits in each benefit plan category for active projects.</td>
</tr>
<tr>
<td>Project Completion Calendar</td>
<td>Calendar</td>
<td>Calender view of planned end dates of projects, project tasks, and milestones.</td>
</tr>
</tbody>
</table>

### Time Sheet dashboard

The Time Sheet dashboard provides comprehensive time sheet activities and reports to the time card approvers and time card users. The dashboard uses Performance Analytics to provide a trend of historical data and regular reports. It gives an overview of the time sheet activities of resources, time sheet approval and rejection rate, over-allocated and under-allocated resource counts.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Overview tab
### Delinquent Activity tab

#### Time Sheet Metrics

- **Users Missing Time Sheets This Week:** 76
- **Total Time Sheet Users:** 102
- **% Users Missing Time Sheets This Week:** 74.51%

#### User Breakdown

<table>
<thead>
<tr>
<th>User</th>
<th>May 08</th>
<th>Change</th>
<th>Trend</th>
<th>Distribution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abel Turt (Architect)</td>
<td>1</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Adri Cervertaz</td>
<td>1</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Aileen Mottern (Product Owner)</td>
<td>1</td>
<td>0</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Analysis tab

End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portfolio manager: Needs visibility into time sheet activities of resources and actions that should be taken.</td>
<td>it_portfolio_manager</td>
</tr>
<tr>
<td>End user and goal</td>
<td>Required role</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>Program manager: Needs visibility into time sheet activities of resources and actions that should be taken.</td>
<td>it_program_manager</td>
</tr>
<tr>
<td>Project manager: Has access to the dashboards.</td>
<td>it_project_manager</td>
</tr>
<tr>
<td>Time card approver: Needs visibility into time sheet activities of resources and actions that should be taken.</td>
<td>timecard_approver</td>
</tr>
<tr>
<td>Business stakeholder for PPM: Needs visibility into time sheet activities of resources and actions that should be taken.</td>
<td>sn_ppm_read</td>
</tr>
</tbody>
</table>

**Indicators**

The Overview, Delinquent Activity, and Analysis tabs in the dashboard contain widgets with the following indicators. The data for time sheets and time cards is collected from the [time_sheet] table and the data for users is collected from the [users] table.

**PPM – Active Time Sheet Users**

Count of active users with the timecard_user role.

**PPM – % Late This Year**

Percentage of time sheets late this year.

**PPM – % Late This Week**

Percentage of time sheets late this week.

**PPM – % Late This Quarter**

Percentage of time sheets late this quarter.

**PPM – % Late This Month**

Percentage of time sheets late this month.

**PPM – Late Time Sheets This Month**

Count of late time sheets this month. The indicator includes time sheets of the current month until the past week that are not in the Approved or Processed state.

**PPM – Late Time Sheets This Quarter**

Count of late time sheets this quarter. The indicator includes time sheets of the current quarter until the past week that are not in the Approved or Processed state.

**PPM – Late Time Sheets This Week**

Count of late time sheets this week. The indicator includes time sheet of the past week that are not in the Approved or Processed state.

**PPM – Late Time Sheets This Year**

Count of late time sheets this year. The indicator includes time sheets of the current year until the past week that are not in the Approved or Processed state.

**PPM – Total Time Sheets Last Week**

Total number of time sheets for the past week.
PPM – Total Time Sheets This Month
Total number of time sheets for the weeks in the current month.

PPM – Total Time Sheets This Quarter
Total number of time sheets for the weeks in the current quarter.

PPM – Total Time Sheets This Year
Total number of time sheets for the weeks in the current year.

PPM – Time Sheets Approved This Week
Count of time sheets approved this week. The indicator includes time sheets in the Approved or Processed state.

PPM – Time Sheets Missing This Week
Count of users with the timecard_user role who did not submit time sheet for the current week.

PPM – Time Sheets Pending This Week
Count of time sheets pending this week. The indicator includes time sheets for the current week in the Pending state.

PPM – Time Sheets Recalled This Week
Count of time sheets recalled this week. The indicator includes time sheets for the current week in the Recalled state.

PPM – Time Sheets Rejected This Week
Count of time sheets rejected this week. The indicator includes time sheets for the current week in the Rejected state.

PPM – Time Sheets Submitted This Week
Count of time sheets submitted this week. The indicator includes time sheets for the current week in the Submitted state.

Breakdowns

- User
- Manager
- Department
- Cost Center
- Portfolio
- Program
- Project
## Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rejected</td>
<td>Single score</td>
<td>Number of time cards that are in the Rejected state for the last 30 days.</td>
</tr>
<tr>
<td>Late</td>
<td>Single score</td>
<td>Number of time cards that were submitted late in the last 30 days.</td>
</tr>
<tr>
<td>Pending Approvals</td>
<td>Single score</td>
<td>Number of time cards that have approval pending in the last 30 days.</td>
</tr>
<tr>
<td>By State</td>
<td>Bar</td>
<td>Number of time cards in the last 30 days, grouped by their state.</td>
</tr>
<tr>
<td>By Category</td>
<td>Heatmap</td>
<td>Breakdown of time spent (hours) by a resource across different project time categories in the last 30 days.</td>
</tr>
<tr>
<td>By Resource</td>
<td>List</td>
<td>The list of time cards submitted by a resource in 30 days.</td>
</tr>
<tr>
<td>Total Hours</td>
<td>Bar</td>
<td>Total time (hours) spent on by different categories.</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>---------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Total Hours by Week Starts On</td>
<td>Time series line</td>
<td>Weekly trend of the total time (hours) spent on different categories over a period of time.</td>
</tr>
<tr>
<td>Time Sheets Over 40 Hours</td>
<td>Bar</td>
<td>Count of time sheets over 40 hours indicating over-allocated resources. This report does not refresh when you select portfolio, program, or project.</td>
</tr>
<tr>
<td>Allocated vs Actual Hours</td>
<td>Time series step</td>
<td>Monthly trend comparing the total allocated hours versus actual hours for all time card users.</td>
</tr>
<tr>
<td>Time Cards By Expense Type</td>
<td>Bar</td>
<td>Time cards grouped by expense types: Capital Expense (Capex) and Operating Expense (Opex).</td>
</tr>
</tbody>
</table>

### Create and manage waterfall projects

An overview of the tasks involved in creating a waterfall project.

The following tables, arranged by task group, list the tasks involved in creating a waterfall project.

#### Create a new project

<table>
<thead>
<tr>
<th>Task</th>
<th>How do I do this?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new project</td>
<td>• Navigate to Project &gt; Projects &gt; Create New.</td>
</tr>
<tr>
<td></td>
<td>• Navigate to Project &gt; Projects &gt; Workbench and click New Project.</td>
</tr>
</tbody>
</table>
Open an existing project

<table>
<thead>
<tr>
<th>Task</th>
<th>How do I do this?</th>
</tr>
</thead>
</table>
| Open a project in the project workbench | - Click the *Project Workbench* related link on the Project form.  
- Navigate to *Project > Projects > Workbench* and select the project from the *Select Projects* choice list in the workbench header. |

Add phases to a project from the project workbench

<table>
<thead>
<tr>
<th>Task</th>
<th>How do I do this?</th>
</tr>
</thead>
</table>
| Create a waterfall phase for a project | Click the Add phase icon  
and select *Waterfall* from the Phase Type choice list. |
| Create a test phase for a project | Click the Add phase icon  
and select *Test* from the Phase Type choice list. |

Edit a project phase from the project workbench

<table>
<thead>
<tr>
<th>Task</th>
<th>How do I do this?</th>
</tr>
</thead>
</table>
| Edit a waterfall phase for a project | Click the Edit phase icon  
on a project phase and make the required changes in the details of the project phase. |
| Edit a test phase for a project | Click the Edit phase icon  
on the test phase and make the required changes in the details of the test phase. |

Add milestones to a project from the project workbench

<table>
<thead>
<tr>
<th>Task</th>
<th>How do I do this?</th>
</tr>
</thead>
</table>
| Add milestones to a project | Click the Add phase icon  
and then click *Milestone* at the top of the Add Phase pop-up window. |
Set up manual testing

<table>
<thead>
<tr>
<th>Task</th>
<th>How do I do this?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a test plan</td>
<td>Navigate to Test Management &gt; Test Execution &gt; Test Plans &gt; New.</td>
</tr>
<tr>
<td>Add test cases to a test plan</td>
<td>Click the Add Test Cases from Test Suite related link on the Test Plan form.</td>
</tr>
<tr>
<td>Create a test phase</td>
<td>Click the Add Phase button on the project workbench.</td>
</tr>
<tr>
<td>Add a test plan to a test phase</td>
<td>Click the Edit Phase icon (库里) for the test phase and enter the name of the Test Plan.</td>
</tr>
<tr>
<td>Assign test cases to testers</td>
<td>Select a user in the Assigned to field on the Test Case form.</td>
</tr>
<tr>
<td>Notify testers to start testing</td>
<td>Click the Notify testers to start testing related link on the Test Plan form.</td>
</tr>
<tr>
<td>Tester performs tests and submits results</td>
<td>Navigate to Self-Service &gt; My Tests or Self-Service &gt; My Assessments.</td>
</tr>
<tr>
<td>Monitor the testing progress</td>
<td>The Test Plans list, Test Plan form, and Test Case form all display results for test cases and individual tests.</td>
</tr>
<tr>
<td>Testing sign-off</td>
<td>Click the Sign-off Test Plan related link on Test Plan form.</td>
</tr>
</tbody>
</table>

Create and manage agile projects

An overview of the tasks involved in creating an agile project.

The following tables, arranged by task group, list the tasks involved in creating an agile project.

Set up a development group

<table>
<thead>
<tr>
<th>Task</th>
<th>How do I do this?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define an agile group</td>
<td>Navigate to Agile Development &gt; Create Agile Group and click New.</td>
</tr>
<tr>
<td>Add group members</td>
<td>Navigate to the Group members related list on the Group form and click Edit.</td>
</tr>
<tr>
<td>Decide the capacity of a group</td>
<td>Navigate to Agile Development &gt; Groups, select the desired group, and enter a number in the Group capacity (points) field.</td>
</tr>
</tbody>
</table>

Create sprints

<table>
<thead>
<tr>
<th>Task</th>
<th>How do I do this?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a sprint</td>
<td>Use the Create Sprints related link on the Group form to create multiple sprints or use the Sprints related list to create individual sprints.</td>
</tr>
<tr>
<td>View the created sprints</td>
<td>Use the Sprints related list on the Group form.</td>
</tr>
</tbody>
</table>
## Create a new project

<table>
<thead>
<tr>
<th>Task</th>
<th>How do I do this?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a project</td>
<td>• Navigate to Project &gt; Projects &gt; Create New.</td>
</tr>
<tr>
<td></td>
<td>• Navigate to Project &gt; Projects &gt; Project Workspace and click New Project.</td>
</tr>
</tbody>
</table>

## Open an existing project

<table>
<thead>
<tr>
<th>Task</th>
<th>How do I do this?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open an existing project</td>
<td>• Click the Project Workspace related link on the Project form.</td>
</tr>
<tr>
<td></td>
<td>• Navigate to Project &gt; Projects &gt; Project Workspace and select the project from the Select Projects choice list in the workspace header.</td>
</tr>
</tbody>
</table>

## Add phases to a project from the project workbench

<table>
<thead>
<tr>
<th>Task</th>
<th>How do I do this?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create an agile phase for a project</td>
<td>Click the Add phase icon and select Agile from the Phase Type choice list.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This option appears only when both the Project Portfolio Management and Agile Development 2.0 applications are installed.</td>
</tr>
<tr>
<td>Create a test phase for a project</td>
<td>Click the Add phase icon and select Test from the Phase Type choice list.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This option appears only when both the Project Portfolio Management and Test Management 2.0 applications are installed.</td>
</tr>
</tbody>
</table>

## Add details to a project phase from the project workbench

<table>
<thead>
<tr>
<th>Task</th>
<th>How do I do this?</th>
</tr>
</thead>
<tbody>
<tr>
<td>View phase details in list view or VTB</td>
<td>Click the List or VTB button in the project workbench header.</td>
</tr>
<tr>
<td>Assign a group to an agile phase</td>
<td>Edit the Agile phase and select a group in the Group field.</td>
</tr>
<tr>
<td>Select sprints for an agile phase</td>
<td>Edit the Agile phase, ensure that a group has been assigned, and select a Start Sprint and End Sprint.</td>
</tr>
</tbody>
</table>
### Task: Create stories for an agile phase
**How do I do this?**
Click the Agile phase in the project workbench and click **New** in the detail view header.

### Task: Refine stories for one project
**How do I do this?**
Click the **Manage Stories** button to open the Manage Stories dialog box.

**Note:** You can also use the Agile Planning & Tracking related link on the Project form to view your backlog, assign stories to the projects, or create new stories for the project.

### Task: Refine stories across multiple projects
**How do I do this?**
Click the **Manage Stories** related link on Group form.

### Task: Assign a group to an agile phase
**How do I do this?**
Click the Agile phase edit icon and select the group from the **Group** choice list.

### Task: Add milestones to a project from the project workbench

<table>
<thead>
<tr>
<th>Task</th>
<th>How do I do this?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add milestones to a project</td>
<td>Click the Add phase icon and then click <strong>Milestone</strong> at the top of the Add Phase pop-up window.</td>
</tr>
</tbody>
</table>

### Task: Plan sprints

<table>
<thead>
<tr>
<th>Task</th>
<th>How do I do this?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start sprint planning</td>
<td>Navigate to Agile Development &gt; Groups, open the desired group, and click the Sprint Planning related link.</td>
</tr>
<tr>
<td>Add stories to the sprint</td>
<td>Navigate to Agile Development &gt; Groups, open the desired group, click the Sprint Planning related link, and click <strong>Create story</strong>.</td>
</tr>
</tbody>
</table>

### Testing process (Only when Test Management 1.0 is activated)

<table>
<thead>
<tr>
<th>Task</th>
<th>How do I do this?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a test plan</td>
<td>Navigate to Test Management &gt; Test Execution &gt; Test Plans &gt; New.</td>
</tr>
<tr>
<td>Add test cases to a test plan</td>
<td>Click the Add Test Cases from Test Suite related link on the Test Plan form.</td>
</tr>
<tr>
<td>Assign test cases to testers</td>
<td>Select a user in the <strong>Assigned to</strong> field on the Test Case form.</td>
</tr>
<tr>
<td>Notify testers to start testing</td>
<td>Click the <strong>Notify testers</strong> to start testing related link on the Test Plan form.</td>
</tr>
<tr>
<td>Tester performs tests and submits results</td>
<td>Navigate to Self-Service &gt; My Tests or Self-Service &gt; My Assessments.</td>
</tr>
</tbody>
</table>
Task | How do I do this?
---|---
Monitor the testing progress | The Test Plans list, Test Plan form, and Test Case form all display results for test cases and individual tests.
Testing sign-off | Click the **Sign-off Test Plan** related link on Test Plan form.

**Testing process (Only when Test Management 2.0 is activated)**

<table>
<thead>
<tr>
<th>Task</th>
<th>How do I do this?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a test execution suite</td>
<td>Navigate to <strong>Test Management 2.0 &gt; Test Execution Suites</strong>, and click <strong>New</strong>.</td>
</tr>
<tr>
<td>Add tests to a test execution suite</td>
<td>Open a test execution suite, and click <strong>Add tests</strong>. From the <strong>Tests</strong> list, select the required tests and click <strong>Add to Execution Suite</strong>.</td>
</tr>
<tr>
<td>Assign tests to testers</td>
<td>Open a test execution suite. In the <strong>Test execution assignments</strong> related list, assign tests to testers.</td>
</tr>
<tr>
<td>Tester performs tests and submits results</td>
<td>Navigate to <strong>Test Management 2.0 &gt; Tests Assigned to me</strong>. Select the required tests and click <strong>Run</strong>.</td>
</tr>
</tbody>
</table>

**Test Management 2.0 integration with Project Portfolio Management**

Test Management 2.0 integration with Project Portfolio Management enables you to carry out testing activities on projects.

After activating both the Test Management 2.0 and Project Portfolio Management applications, you can:

- Add a test phase to a project.
- Assign a test execution suite to the test phase.
- View the tests associated with the test execution suite.
- Assign tests to testers.
- Perform tests and record results.
- Track the progress using the **Percentage complete** field in the timeline.

As testers perform tests and record results, the information is updated to the test, test phase, and then to the project.

**Note**: If you’re an existing user, the integration between Project Portfolio Management and Test Management 1.0 continues to work the same. You can still create test phases, associate test phases to a test plan, and perform testing activities.
Agile Development 2.0 integration with Project Portfolio Management

Project Portfolio Management leverages the Agile Development 2.0 application to combine the Scrum methodology with project-based IT development.

IT organizations typically work on multiple projects with shorter time schedules. The project planning and tracking is done using waterfall, but the group prefers scrum methodologies to carry out their work. It then becomes a challenge to track project status when there is an agile development phase. This integration between Agile Development 2.0 with Project Portfolio Management facilitates a combination of waterfall and agile methods for project management and development.

The flow described below is applicable when Agile Development 2.0 is activated along with Project Portfolio Management.

- Create a group to represent a Scrum team.
- Add members to the group.
- Create sprints.
- Assign groups to projects from the Project Workbench.
- Maintain group and project backlogs. Multiple projects can be under development and groups can be assigned to multiple projects. Each project and each group has its own backlog. The project backlog includes all stories related to a project. The group backlog includes stories from multiple projects that have been assigned to the group.
- Perform group sprint planning. The group refines the combined backlog, ranks the stories and assigns points, and adds stories to sprints based on priority.
- Create stories, including one-off stories that are not related to projects.
- Track progress in stories, phases, and projects.

Define an agile group

Create an agile group to later assign the work of an agile project.

1. Navigate to Agile Development > Groups.
2. Click New.
3. On the form, fill in the fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the group.</td>
</tr>
<tr>
<td>Manager</td>
<td>Select the manager of the group.</td>
</tr>
<tr>
<td>Group capacity (points)</td>
<td>Enter the projected capacity of the group in story points for each sprint.</td>
</tr>
<tr>
<td>Group email</td>
<td>Email address of the group.</td>
</tr>
<tr>
<td>Description</td>
<td>A brief description of the group.</td>
</tr>
<tr>
<td>Related Links</td>
<td>Access the Create Sprints for Team dialog box. Fill in the fields and then click OK to create multiple sprints for the current group. The new sprints are added to the Sprints related list.</td>
</tr>
<tr>
<td>Create Sprints</td>
<td>Access the Create Sprints for Team dialog box. Fill in the fields and then click OK to create multiple sprints for the current group. The new sprints are added to the Sprints related list.</td>
</tr>
<tr>
<td>Sprint Planning</td>
<td>Access the Sprint Planning tab on the Agile Board.</td>
</tr>
</tbody>
</table>
4. Click **Submit**.

### Add group members

Add members to the group who are later assigned tasks of an agile project.

1. Navigate to **Agile Development > Groups**.
2. Open the desired group.
3. Click **New** in the **Group Members** related list.
4. Add the name of the group member in the **Name** field.
5. Select a **Scrum Role** for the group member.
6. Click **Submit**.

### Decide the capacity of a group

Decide the capacity of a group based on the historical velocity of the group for each sprint.

Role required: **scrum_master**

1. Navigate to **Agile Development > Groups**.
2. Open the desired group.
3. Decide the group capacity in points and enter the number in the **Group capacity (points)** field.
4. Click **Update**.

### Convert a release team to an agile group

Convert a release team to an agile group to later assign the work of an agile project.

Role required: **project_manager**

This section is applicable only if you have upgraded from Agile Development 1.0 to Agile Development 2.0.

1. Navigate to **Agile Development > Groups**.
2. Click the **Convert Release Teams to Groups** related link.
3. Select the team that you want to convert to an agile group.
4. Click **Convert to Group**.

### Create a sprint

Create a sprint to plan the work for an agile phase of a project.

1. Navigate to **Agile Development > Groups**.
2. Open the desired group.
3. Click **New** in the Sprints related list.
4. Fill in the following fields on the Sprint form:
   - **Short description**: Name or a brief description of the sprint
   - **Planned start date**: Start date for this sprint
   - **Planned end date**: End date for this sprint
   - **Group capacity (points)**: Projected capacity of the group in story points
5. Click Submit.

Create multiple sprints

Create multiple sprints to plan the work for an assignment group.

1. Navigate to Agile Development > Groups.
2. Open the desired team.
3. Click the Create Sprints related link to open the Create Sprints for Team dialog box.
4. In the Sprint form, fill in the fields:
   • Name: the name of the sprint.
   • Starting Number: the number of the first sprint to be created.
   • Start date: the start date for the first sprint to be created.
   • Duration: the number of days in a sprint.
   • Number of sprints: the number of sprints to be created.
5. Click OK.

The new sprints are added to the Sprints related list on the Team form.

Assign a group to a project

Assign a group to a project from the Project Workbench. The group later works on the tasks of the assigned project.

A project can have multiple development phases and each development phase can have a group assigned to it.

Create a development phase in the project timeline or edit an existing Agile phase and assign a group by selecting the group from the Group field.

Create stories

Create stories associated with a project, and one-off stories that are not associated to either a product or a project.

• The stories list displays current active stories. You can create a story from this list or view the story form for a current story. You can also add scrum tasks from the story form and view the story and task progress boards.
• Stories can be associated to projects, but is not mandatory. While creating a story, if a project has only one phase then the story automatically gets tagged to the only phase.
• One-off stories can be created without a link to a product or a project. One-off stories are created with only a short description, and can be assigned to a group.

1. Navigate to Agile Development > Stories.
2. Click New.
3. In the Story form, fill in the fields.
4. Click Submit.

Manage stories

Manage the stories for a group from the Project Workbench.

Click the Manage Stories button on the Project Workbench header. The Manage Stories form displays the backlog for the currently selected project.
The upper section of the Manage Stories form displays the backlog across all the phases of the project, including the total number of points. The lower section of this form displays stories of the project that are not assigned to any sprint.

**Plan sprints**

Streamline your sprint planning and completion activities using the **Sprint Planning** tab.

1. Navigate to **Agile Development > Groups**.
2. Open the desired group.
3. Click the **Plan Sprints** related link.
   
   The Agile Board, **Sprint Planning** tab appears.

4. View all the active stories assigned to the team, but not assigned to any sprint in the Backlog section. Use either of the following options to arrange stories:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the drag feature</td>
<td>This option can be used to move stories within the backlog, move stories from the backlog to any sprint, or move stories from one sprint to another.</td>
</tr>
<tr>
<td></td>
<td>Point to a story in the backlog and drag it to the required location.</td>
</tr>
</tbody>
</table>

| Using the keyboard    | This option can be used to move stories only within a backlog or a sprint.                                                                       |

**Note:**

- If the backlog contains more than 50 stories, then pagination control appears at the bottom of the list enabling you to navigate to the previous, next, first, or last pages in the list.
- Rearranging stories in the backlog changes the ranking of stories. Ranks are stored in the global_rank column in the Story [rm_story] table. When you move a story within a backlog, its rank changes relative to the stories within the same backlog. Thus, if the story exists in some other backlog, its ranking might change but position in the backlog would remain the same.

5. To start a sprint, click **Start** that appears at right-corner of the first or top sprint. The **Sprint Tracking** tab appears.

6. To complete a sprint, click **Complete Sprint** that appears at right-corner of the first or top sprint. A dialog box appears indicating the number of completed and incomplete stories in the sprint.
   
   a) Move incomplete stories, if any, to the backlog or a future sprint.
   
   b) Click **Complete**. The sprint disappears from the **Sprint Planning** tab and appears in the Sprint list as complete.

**Track progress**

Track the progress of an agile phase from the Project Workbench timeline. Stories are assigned to a project and are tied to an agile development phase in the Project Workbench. As stories are completed, the story points and the story status get rolled up to the sprint and project phase. In turn, the phase gets rolled up to the project. In the Project Workbench timeline, the color in the phase bar increases to show progress and the **Percentage complete** field is updated.
Demand Management

The Demand Management application consists of tools for capturing, centralizing, and assessing strategic and operational demands. It also provides a single location for managing all the demand information.

As a demand manager, assess the ideas submitted through the Idea Portal or ideation module and promote the feasible ideas to demands.

You can track the progress of an accepted idea as it moves through the demand life cycle (idea to a demand, to a project, enhancement, change, or defect).

A typical workflow for you as the demand manager is as follows:

• Work on a demand to assess the feasibility, effort, and cost of the demand and create a business case for approval of the demand.
• Create demand tasks, such as an initial feasibility review, cost estimate, and effort estimate, to delegate activities to specialized resources or groups. For example, a demand manager can create demand tasks for assessing the cost associated with a software upgrade and the resources required.
• Assign demand tasks to a business analyst, resource user, or an appropriate group. The assigned resource or group then creates a cost and resource plan to help the demand manager assess and qualify the demand. For more information, see Demand tasks.

Watch this six-minute video to learn about the purpose of Demand Management, the Demand workflow, engaging stakeholders, prioritizing demands, and the decision workflow.

Basics of Demand Management

• Set up the application: Plan, create stakeholders and assessment categories, and create bubble charts.
• Assess ideas: Review and analyze submitted ideas before promoting ideas to demands.
• Create and add details to the demands: Create demands and add demand tasks, stakeholders and assessments, and evaluate and qualify demands.
• Use the Demand Management application or the demand workbench to compare and assess demands, and promote demands to projects, enhancements, changes, or defects.

Demand Management key terms

Important terms in Demand Management are listed in the table.

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portfolio</td>
<td>A collection of demands managed as a group to achieve strategic and operational objectives.</td>
</tr>
<tr>
<td>Assessable record</td>
<td>A demand record that you want to evaluate for metric type demand. You evaluate the assessable records with metric categories and metrics, which define traits and values to assess.</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Metric</td>
<td>A trait or value used to evaluate assessable records. A metric can measure subjective values in an assessment questionnaire or gather objective values in a database query run by a script. Examples of metrics include perceived value of demands and return on investment for a demand.</td>
</tr>
<tr>
<td>Metric type</td>
<td>A characteristic that defines a set of records you want to evaluate. Demand management comes with the metric type demand, which uses records from the Demand [dmn_demand] table.</td>
</tr>
<tr>
<td>Metric category</td>
<td>A theme for evaluating assessable records. Categories contain one or more individual metrics, which define specific traits or values that comprise the theme. Examples of categories include return on investment and cost. Set filter conditions to control which assessable records to evaluate for the metrics in a category.</td>
</tr>
<tr>
<td>Stakeholder</td>
<td>A person affected by the demand or who has interest in the demand.</td>
</tr>
<tr>
<td>Scorecard</td>
<td>A visual breakdown on performance of an assessable record based on assessment results. Use scorecards to view various data summaries for one assessable record and to compare the ratings with other assessable records.</td>
</tr>
<tr>
<td>Requirement</td>
<td>An extra item that must be present or an extra action item that must be finished before a demand request closes.</td>
</tr>
<tr>
<td>Demand Task</td>
<td>A unit of work, created within a demand, to break down initial planning activities before converting the demand into a project. A demand task is not a planned task like a project task.</td>
</tr>
</tbody>
</table>

### Planning for Demand Management

Items requiring planning for Demand Management is listed.

#### Demand Management Planning

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roles</td>
<td>Determine who has the demand manager [it_demand_manager] and demand user [it_demand_user] roles.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Portfolios</td>
<td>Determine how you want to group or categorize demands, and then have a user with the project manager [it_project_manager] role create portfolios based on those groupings.</td>
</tr>
<tr>
<td>Stakeholders</td>
<td>Identify individuals who have the appropriate domain knowledge to evaluate demands related to each portfolio. Then make them stakeholders for that portfolio.</td>
</tr>
<tr>
<td>Assessments</td>
<td>Consider using assessments to facilitate the information gathering process. Define metric categories and assessment metrics to develop and distribute assessments to the appropriate audience.</td>
</tr>
<tr>
<td>Bubble chart definitions</td>
<td>Identify metrics that are important to stakeholders, departments, and the organization. Use these metrics to create bubble charts that visually compare demands. For example, when considering which projects to undertake many organizations compare metrics such as risk rating, return on investment, and cost.</td>
</tr>
<tr>
<td>Resource plans</td>
<td>Consider developing resource plans to help the organization understand the time and resource costs associated with the demand. Any resource plans attached to the demand propagate to the project. Resource plans require that the Resource Management application is active.</td>
</tr>
<tr>
<td>Enhancement and defect requests</td>
<td>Determine if you need the ability to manage enhancement and defect requests as demands. This functionality requires that the Agile Development application is active.</td>
</tr>
</tbody>
</table>
Demand Management process flow

The Demand Management process flow consists of the following tasks.

### Demand Management Process Flow

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Submitting ideas</td>
<td>Any user can submit ideas from the following locations:</td>
</tr>
<tr>
<td></td>
<td>• Service Catalog &gt; Can We Help You &gt; Submit Idea.</td>
</tr>
<tr>
<td></td>
<td>• Self-Service &gt; Ideas &gt; Create New.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Submitters or collaborators can edit their ideas as long the idea is in the Submitted state.</td>
</tr>
<tr>
<td>Creating demands</td>
<td>Demand managers and demand users can create demands using the Demand Management application.</td>
</tr>
<tr>
<td></td>
<td>Alternatively, any user can create demands from the following locations:</td>
</tr>
<tr>
<td></td>
<td>• Service Catalog &gt; Can We Help You &gt; Create a new demand.</td>
</tr>
<tr>
<td></td>
<td>• Self-Service &gt; Demands &gt; Create New.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requesters or collaborators can edit their demands as long as the demand is in the Draft state.</td>
</tr>
<tr>
<td>Adding details to demands</td>
<td>Demand managers can add details to a demand request by adding demand tasks, stakeholders, requirements, risks, decisions, and resource plans.</td>
</tr>
<tr>
<td>Assessing demands</td>
<td>Decision makers can use assessment results and the demand backlog when determining which demands to approve or reject.</td>
</tr>
<tr>
<td></td>
<td>Demand managers can decide if the assessment should be triggered for the demand using the <strong>Assessment Required</strong> field on the demand form.</td>
</tr>
<tr>
<td>Completing demands</td>
<td>Demand managers can set a demand to Completed when work on the demand is complete.</td>
</tr>
<tr>
<td></td>
<td>You can cancel the future resource plans and complete the allocated resource plans for a Completed or Deferred demand.</td>
</tr>
</tbody>
</table>
Demand workbench

The demand workbench provides a central location for viewing and assessing business demands.

The demand workbench makes it easy to manage demands by presenting multiple interactive views of demand information on one page. The workbench is split into two panes: the top pane presents an interactive bubble chart for assessing demands and the bottom pane displays the demand details in a list view.

The demand workbench provides real-time interaction between the two panes. Modifying a demand in the bubble chart automatically updates the values in the demand record. Similarly, changes made to a demand record are automatically reflected in the bubble chart.

By default, the workbench displays demands screened by stakeholders or qualified by the demand manager. With the demand manager role, you can use the workbench to:

- View, evaluate, and update demands
- Create demands
- Create artifacts from demands, including projects, enhancements, changes, and defects

With the demand manager role, you can view and evaluate demands.
Demand Workbench

The demand workbench includes the following components:

- The top pane displays demands in a bubble chart.
- The bottom pane displays demands in a list view.
- The header includes a back button ( ) that opens the Demands list.
Demand workbench bubble chart

The interactive bubble chart on the demand workbench is a dynamically updated graph that plots metrics for multiple demand records.

Demand managers can use bubble charts to visualize, compare, and evaluate the relative standing of demands in three categories: risk, value, and size. The X-axis represents the risk of a demand, the Y-axis represents the value, and the Z-axis represents the size. Demands are plotted as circles, or bubbles, which vary in size according to the size of the demand. All three measurements are based on values between 0 through 10. This scale allows demand managers to see how one demand compares to other demands in the chart.

The bubble chart contains four quadrants, with each quadrant representing the value versus risk tradeoff for the demand. The quadrants are labeled along the edges of the bubble chart to represent this combination of value versus risk. The color of the bubbles displayed in each quadrant also represents the value versus risk tradeoff.

- The upper left quadrant, labeled Resource, contains demands with high value and low risk. Green bubbles represent demands in this quadrant.
- The lower left and upper right quadrants, labeled Consider, contain demands that require further evaluation. The lower left quadrant contains demands with low risk but low value while the upper right quadrant contains demands with high value but high risk. Orange bubbles represent demands in these quadrants.
- The lower right quadrant, labeled Re-evaluate, contains demands with low value and high risk. Red bubbles represent demands in this quadrant.

Each bubble also includes a label with the name of the demand.

From the demand workbench bubble chart, you can perform the following actions:

- Point to a bubble to view a summary of the demand, including the demand name and the risk, value, and size.
- Click a bubble to open a sizing window and change the size of the demand.
- Click and drag a bubble to increase or decrease the risk or value of the demand.
- Right-click a bubble to view the demand, create an artifact, or view an artifact that has been created from a demand.

**Note:** You will not find the options to create an enhancement or a defect if Agile Development 2.0 is not activated.

Changes made to a demand in the bubble chart are automatically updated in the demand record.

Demand workbench list view

The lower pane of the demand workbench displays a list of the demands shown in the bubble chart.

The bubble chart list view displays up to 20 demands at a time. Page forward and back through the list to display additional demands.

The Demand column displays the demand number which provides a link to the Demand form. The Stage column displays the status or progress of the demand. For more information, see Stage Fields.

The interactive bubble chart is updated whenever you change a demand in the list view. If you create a new demand from the demand workbench, it is created in a qualified state and appears on the bubble chart. When a demand is promoted to a project, enhancement, change request, or defect, it is removed from the bubble chart.

Performing the following tasks in the list view affects the demands displayed in the bubble chart:
• Searching or filtering the records in the list view displays the bubbles for those demands that meet the search or filter criteria.
• Adding or deleting records in the list view adds or deletes the corresponding bubbles.
• Paginating the list view by clicking any of the page arrow icons displays the bubbles for the demands that appear on the current page.

**Use Demand Management**

Users with the demand manager role can create, view, and modify demands using the Demand Management application.

You can also approve demands and create the following artifacts from the approved demands:

- Project
- Change
- Enhancement
- Defect

The type of artifact created from a demand depends on the selections in the **Category** and **Type** fields on the Demand form. Enhancements and defects can be created when the system administrator has activated the SDLC-SCRUM plugin.

**Demand Management Life Cycle**

The demand management life cycle can be simplified as follows:

- **Creating a demand**: The user submits an idea and the demand manager approves the idea, automatically creating a demand from that idea.
- **Viewing a list of demands**: The demand manager views demands on the demand workbench or from a list view.
- **Enhancing a demand**: The demand manager can send the demand to screening, which sends assessments to stakeholders.
- **Assessing a demand**:
  - The demand manager can screen the demand and send surveys to stakeholders to complete assessments.
  - The demand manager can set the state of the demand to qualify, defer, or incomplete.
  - Demands can be analyzed and approved using the demand workbench.
- **Creating an artifact**: The demand manager creates a project, enhancement, change, or defect.

In demand management, a demand can be in any of the following states.

The demand management application uses the following simplified demand states.
## Demand States

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Draft** | The demand manager accepts a submitted idea. After reviewing or editing the record, click one of these buttons:  
  - **Update**: The demand record is updated, but the demand remains in the current state.  
  - **Submit demand**: The demand is moved to the submitted state.  
  - **Delete**: The demand record is deleted. |
| **Submitted** | An accepted idea creates a demand record and the demand manager submits the demand. After reviewing or editing the record, click one of these buttons:  
  - **Update**: The demand record is updated, but the demand remains in the current state.  
  - **Screen**: The demand is moved to the screening state.  
  - **Qualify**: The demand is moved to the qualified state.  
  - **Defer**: The demand is moved to the deferred state.  
  - **Incomplete**: The demand is moved to the incomplete state.  
  - **Delete**: The demand record is deleted. |
| **Screening** | The demand initiates assessments for the demand. After reviewing or editing the record, click one of these buttons:  
  - **Update**: The demand record is updated, but the demand remains in the current state.  
  - **Qualify**: The demand is moved to the qualified state.  
  - **Defer**: The demand is moved to the deferred state.  
  - **Delete**: The demand record is deleted. |
| **Qualified** | The demand has been qualified and is ready for review. After reviewing the record, click one of these buttons:  
  - **Update**: The demand record is updated, but the demand remains in the current state.  
  - **Approve**: The demand is moved to the approved state.  
  - **Defer**: The demand is moved to the deferred state.  
  - **Delete**: The demand record is deleted. |
<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
</table>
| Deferred  | The demand has been put on hold. The demand can be revisited in future and reviewed. After reviewing the record, click one of these buttons:  
  • **Update**: The demand record is updated, but the demand remains in the current state.  
  • **Approve**: The demand is moved to the approved state.  
  • **Reset to Draft**: The demand is moved back to the draft state.  
  • **Delete**: The demand record is deleted. |
| Approved  | The demand is approved  
  After reviewing or editing the record, click one of these buttons:  
  • **Update**: The demand record is updated, but the demand remains in the current state.  
  • **Close**: The demand is moved to the closed state.  
  • **Delete**: The demand record is deleted. |
| Completed | The demand is moved to the completed state. |

These states appear in the process flow indicator at the top of the Demand form. The process flow indicator:

- Highlights the current state of the demand.
- Checks off the states that a demand has passed through.
- Leaves blank the states that have been skipped.

In this example, the demand is in the **Approved** state. It passed through the **Draft, Submitted**, and **Qualified** states but skipped the **Screening** state.

---

### Submit an idea from Self-Service or Service Catalog

All users can submit ideas from the Service Catalog or from the Ideas module in Self-Service.

**Role required**: none

1. Navigate to an idea form by using one of the following methods.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>From Self-Service</strong></td>
<td>a. Navigate to <em>Self-Service</em> &gt; <em>Ideas</em> &gt; <em>Create New</em>.</td>
</tr>
</tbody>
</table>
Option | Description
---|---
**From Service Catalog** | 
| a. Navigate to **Self-Service > Service Catalog**.  
| b. Click **Can We Help You?**  
| c. Click **Submit Idea**.

2. **On the form, fill in the fields.**

### Idea form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Title</strong></td>
<td>Title of the idea.</td>
</tr>
</tbody>
</table>
| **Department** | Department in a business unit to which the idea submitter belongs.  
If no value is chosen in this field, it is auto-populated with the name of the department to which the submitter belongs. |
| **Business Unit** | Business unit to which the idea submitter belongs. |
| **Collaborators** | Users who can edit or contribute to the idea.  
An idea submitter can select any user as a collaborator. |
| **Impacted Business Units** | Business unit which is impacted by the submitted idea. |
| **Description** | Details of the idea. |
| **Business Capabilities** | ![Note: Configure the form to see this field.](attachment:note.png)  
If the idea is to change, enhance, or add one or more business capabilities, they can be associated to the idea. **Business capabilities** are defined in the Application Portfolio Management module. |
| **Business Applications** | ![Note: Configure the form to see this field.](attachment:note.png)  
If the idea is to change, enhance, or add one or more business applications, they can be associated to the idea. **Business applications** are defined in the Application Portfolio Management module.  
This field displays all the business applications that are related to the business capability selected in the **Business Capabilities** field. |

3. Click **Submit** to submit the idea.

**Note:** Submitters or collaborators can edit their ideas as long as the idea is in the Submitted state.
Assess demands

The Demand Management application comes with two demand visualization tools that can aid decision makers with demand assessment.

The demand workbench provides a single point of engagement for assessing and approving demands and creating projects, enhancements, changes, or defects. This page combines multiple views of demand information, including an interactive bubble chart and a detail area that displays the list of current demands. The demand roadmap is a visual representation of demands over time for an organization.

Using the Demand Workbench

A bubble chart is a graph that plots multiple demands based on three categories: risk, value, and size. Each demand is represented on the bubble chart by a circle which varies in size and color depending on the average of the scores for these categories. The bubble chart in the demand workbench displays all qualified demands and is dynamically updated as demands are created and assessed. This chart makes a useful tool for demand managers, stakeholders, and decision makers to visually assess and compare demands.

The list view on the demand workbench displays a list of the qualified demands that appear in the bubble chart. Selecting a demand from this list highlights the demand in the bubble chart and displays the demand form. The list view is also integrated with Live Feed so users can see current activity for a demand.

To access the demand workbench, navigate to Demand > Demands > Workbench.

Using the Roadmap

The roadmap is an interactive visualization tool that shows all demands that are currently in an active state. You can modify the look of the backlog using the Settings pane. The Settings pane allows you to change between the two-dimensional (2D) and three-dimensional (3D) view, filter demands by portfolio, or open the demands in a list view. While in list view, you can reassign panel colors, create filters to limit the records that are used for lanes and panels, and apply sorting. To use the roadmap, navigate to Demand > Roadmap.

Demand tasks

A demand task is a unit of work, created within a demand, to break down initial planning activities before converting the demand into a project, change, enhancement, or defect.

You create a demand task to delegate activities that are helpful for assessing the feasibility of a demand. Demand tasks differ from project tasks in the following aspects:

- Planned dates, actual dates, and original dates are part of project tasks not demand tasks.
- The due date indicates the date on which the task is targeted for completion and does not affect the demand workflow. Project tasks, however, affect the project completion dates if the planned dates and actual dates are changed.
- Do not support creation of nested demand tasks.
- Do not support task constraints such as the settings Start ASAP and Start on specific date.
- Do not support an execution type such as Agile, Waterfall, or Hybrid.

Resource assignment

Assign resources for a demand task using the Assigned to, Additional Assignee list, and Assignment Group fields. Do not create and use resource plans for allocating resources or groups to a demand task.
or to submit the time spent on the demand. If you associate a resource plan with a demand task, the associated resource plan is not transferred to the work entity created from that demand.

The resource plans are not associated with the demand by default. Make sure that you do not use the resource plans that you created for the future work entity created from the demand to submit the time spent on a demand.

When you submit a time card for a demand, the time and cost incurred are not transferred to the work entity created from the demand and remain within the demand as the demand cost and effort.

If you manually associate a resource plan with a demand, the actual effort and cost remain within the demand and are not transferred to the work entity created from the demand.

Resources assigned to a demand task can submit the time spent on it using a time card. For more information, see **Submit a time card for a demand task**.

**Actual cost and effort for a demand task**

The actual effort of the work performed on the demand task is derived from the time card. The actual cost is derived from the hourly resource rate defined in the rate model, default labor rate, or default system property. The actual cost and effort for a demand task are then rolled up to derive the actual cost and effort for the associated demand. For more information, see **Actual cost and effort calculation for a demand and demand task**.

**Add work items to a Demand**

Based on the selected demand task category and role assigned to you, you can use the demand task form to:

- Add a cost plan to a Demand
- Add a resource plan to a Demand
- Add a benefit plan to a Demand
- Add risks to a Demand

**Actual cost and effort calculation for a demand and demand task**

The actual cost and effort are realized cost incurred and time spent for the work performed on a demand and demand task during a specific time period. Actual cost and effort are calculated based on the approved time cards and hourly rate for the resources and vary based on how the hourly rate for the resource is derived.

Working on a demand task and demand involves cost and time, which add to the overall expenditure of converting a demand to a product, feature, or enhancement. Demand managers therefore need to know the actual cost and effort incurred in assessing and planning activities for a demand. The calculation for actual cost is derived by multiplying the hours reported in the time card by the hourly rate of the resource. The actual effort for a demand task is calculated based on the hours reported in the time card.

The actual effort and cost for the demand tasks are then rolled up for calculating actual effort and cost for the demand. The calculation of the actual cost and hourly rate for a resource is derived as follows:

- If a rate model is associated with the demand, the actual cost is calculated based on the hourly rate defined in the rate model.
- If a rate model is absent or if an hourly rate is not found in the rate model, then the hourly rate is derived from the default labor rate.
- If an hourly rate is not found in the default labor rate, then the hourly rate is derived from the default system property.
Do not create and use resource plans for allocating resources or groups to a demand task. The resource plans that you create in the demand are used for the resource estimation of the work entity that would be created from the demand. These resource plans are automatically moved to the resulting work entity when a demand is qualified and converted.

Because the resource plans are not associated with the demand by default, when you submit a time card for a demand the actual effort and cost are not reflected in the resource plan. The actual cost and actual effort for the demand remain with the demand and are not transferred to the project created from the demand even if you manually associate a resource plan with the demand.

If a resource spends extra hours working on a demand that are not associated with demand tasks, then this time must also be recorded. The resource submits the time card for recording the extra hours spent on the demand using the Time Sheet Portal. This extra cost and effort is added to the demand but is not reflected in the actual cost and effort for the demand tasks.

The actual cost and actual effort for the demand as derived from the time card data is added to the total actual cost and effort for the demand tasks. The values in the Demand Actual Cost and Demand Actual Effort fields are calculated as follows:

- **Demand Actual Cost**: actual cost of all the demand tasks + actual cost of extra activities
- **Demand Actual Effort**: actual effort of all the demand tasks + actual effort of extra activities

The following example demonstrates the actual cost and effort calculation for a demand task and its rollup to the demand.

**Actual cost and effort calculation based on demand tasks**

For a demand (D1), the demand manager delegates activities such as initial assessment, cost estimate, and effort estimate. To delegate these activities, the demand manager creates three demand tasks (DT1, DT2, and DT3) and assigns resources R1, R2, and R3 to each demand task respectively.

The hourly rate defined for the resources in the rate model, default labor rate, and default system property are listed in the following table.

<table>
<thead>
<tr>
<th>Resource</th>
<th>Hourly rate in the rate model</th>
<th>Hourly rate in the default labor rate</th>
<th>Hourly rate in the system property</th>
</tr>
</thead>
<tbody>
<tr>
<td>R1</td>
<td>$200</td>
<td>$150</td>
<td>$50</td>
</tr>
<tr>
<td>R2</td>
<td>$250</td>
<td>$200</td>
<td>$50</td>
</tr>
<tr>
<td>R3</td>
<td>$150</td>
<td>$100</td>
<td>$50</td>
</tr>
</tbody>
</table>

Each resource spends a total of eight hours while working on the assigned demand task and submits a time card.

**Actual cost and effort calculation for demand task**: The demand task actual cost and effort are calculated and displayed on the **Demand Task** form. The totals differ depending on the method used to derive them.

**Scenario 1** shows how the total is calculated if the resource hourly rate is derived from the rate model.

<table>
<thead>
<tr>
<th>Rate derived from the rate model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand task DT1</td>
</tr>
<tr>
<td>Actual effort</td>
</tr>
<tr>
<td>Actual cost</td>
</tr>
</tbody>
</table>
Scenario 2 shows how the total is calculated if the rate model is not associated with the demand and the resource hourly rate is derived from the default labor rate.

**Rate derived from the default labor rate**

<table>
<thead>
<tr>
<th>Demand task DT1</th>
<th>Demand task DT2</th>
<th>Demand task DT3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actual effort</td>
<td>8 hours</td>
<td>8 hours</td>
</tr>
<tr>
<td>Actual cost</td>
<td>150 * 8 = $1200</td>
<td>200 * 8 = $1600</td>
</tr>
</tbody>
</table>

Scenario 3 shows how the total is calculated if the rate model is not associated with the demand and the resource hourly rate is derived from the default system property.

**Rate derived from the default system property**

<table>
<thead>
<tr>
<th>Demand task DT1</th>
<th>Demand task DT2</th>
<th>Demand task DT3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actual effort</td>
<td>8 hours</td>
<td>8 hours</td>
</tr>
<tr>
<td>Actual cost</td>
<td>50 * 8 = $400</td>
<td>50 * 8 = $400</td>
</tr>
</tbody>
</table>

**Actual cost and effort roll up to a demand**

The Demand Actual Cost and Demand Actual Effort fields on the Financials tab of the Demand form are populated with the sum of actual costs and actual effort of all the demand tasks.

1. If the resource rate for demand task is derived from rate model (Scenario 1), the value in the Demand Actual Cost field is displayed as $4800. The value in the Demand Actual Effort field is displayed as 24 hours.

2. If the resource rate for demand task is derived from the default labor rate (Scenario 2), the value in the Demand Actual Cost field is displayed as $3600. The value in the Demand Actual Effort field is displayed as 24 hours.

3. If the resource rate for demand task is derived from the default system property (Scenario 3), the value in the Demand Actual Cost field is displayed as $1200. The value in the Demand Actual Effort field is displayed as 24 hours.

**Create a demand**

Create demands to capture your strategic and operational demands.

Role required: demand_manager

The demand manager can also create a demand from the demand workbench. Demands created from the demand workbench are created in a qualified state.

1. Navigate to Demand > Demands > Create New. Alternatively, any user can create a demand from the following locations:
   - Service Catalog > Can We Help You > Create a new demand.
   - Self-Service > Demands > Create New.

2. On the Demand form, fill in the fields.
### Demand form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the demand.</td>
</tr>
<tr>
<td>Category</td>
<td>Category of the demand:</td>
</tr>
<tr>
<td></td>
<td>• Strategic</td>
</tr>
<tr>
<td></td>
<td>• Operational</td>
</tr>
<tr>
<td>Type</td>
<td>Type of demand:</td>
</tr>
<tr>
<td></td>
<td>• Project</td>
</tr>
<tr>
<td></td>
<td>• Enhancement</td>
</tr>
<tr>
<td></td>
<td>• Story</td>
</tr>
<tr>
<td></td>
<td>• Epic</td>
</tr>
<tr>
<td></td>
<td>• SAFe Story</td>
</tr>
<tr>
<td></td>
<td>• SAFe Feature</td>
</tr>
<tr>
<td></td>
<td>• SAFe Epic</td>
</tr>
<tr>
<td></td>
<td>• Change</td>
</tr>
<tr>
<td></td>
<td>• Defect</td>
</tr>
<tr>
<td></td>
<td>• No Conversion</td>
</tr>
</tbody>
</table>

The **Category** field selection determines the selections available in this field.

The **Story**, **Epic**, **Enhancement**, and **Defect** options only appear if the administrator has activated the Agile Development 2.0 plugin.

The **SAFe Story**, **SAFe Feature**, and **SAFe Epic** options only appear if the administrator has activated either the Essential SAFe or Portfolio SAFe plugin.

You can select **No Conversion** if you want to use your demand to fund a large project that includes one or more projects, epic, or programs.

The selections in the **Category** and **Type** field also determine the fields that are displayed in the **Assessment Data** related list.

The **Category** and **Type** fields become read-only when a work entity is created from a demand. If you delete the created work entity, these fields become editable.

<table>
<thead>
<tr>
<th>Project</th>
<th>Name of the project created from this demand.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>This field is visible only when you convert the demand into a project. Any</td>
</tr>
<tr>
<td></td>
<td>resource plans that are attached to the demand propagate to the project.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Enhancement</th>
<th>Number of the enhancement created from this demand.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Change</th>
<th>Number of the change created from this demand.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Defect</th>
<th>Number of the defect created from this demand.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Number</td>
<td>Unique, auto-generated identification number for the demand.</td>
</tr>
<tr>
<td>Start date</td>
<td>Start date for the demand. This date is changed to <strong>Approved start date</strong> when the demand is converted to a project.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When you change planned start date of a demand or project, the associated cost and resource plans also change. The project property <strong>Change Resource Plan and Cost Plan Start Date with Demand or Project Start Date Change</strong> controls the behavior for demand date change. This property is not enabled by default.</td>
</tr>
<tr>
<td>Due Date</td>
<td>Requested completion date for the demand. This date is changed to <strong>Approved end date</strong> when the demand is converted to a project.</td>
</tr>
<tr>
<td>Similar demands</td>
<td>Displays demands that have similar values for the <strong>Short description</strong> fields using predictive intelligence and machine-learning algorithms. For more information, see Predictive Intelligence for Demand Management.</td>
</tr>
<tr>
<td>Related Search</td>
<td>Displays search results matching the <strong>Name</strong> field by default. You can use this field to search for matching demands using other terms also.</td>
</tr>
<tr>
<td>Details</td>
<td></td>
</tr>
<tr>
<td>Portfolio</td>
<td>Portfolio indicating the business focus of the demand.</td>
</tr>
<tr>
<td>Program</td>
<td>Name of the program to which the demand belongs.</td>
</tr>
<tr>
<td>Investment Class</td>
<td>Type of investment class category assigned to the demand:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Run</strong>: Investment made to sustain the existing business.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Change</strong>: Investment made to implement a change in business.</td>
</tr>
<tr>
<td>Investment Type</td>
<td>Investment type of the demand.</td>
</tr>
<tr>
<td>Submitted by</td>
<td>User submitting the demand.</td>
</tr>
<tr>
<td>Demand Manager</td>
<td>Name of the demand manager.</td>
</tr>
<tr>
<td>Collaborators</td>
<td>Users who can edit or contribute to the demand. A demand requester can select any user as a collaborator.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Department</td>
<td>Department in a business unit to which the demand submitter belongs.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: If you do not select a department, the value defaults as the name of the department to which the submitter belongs.</td>
</tr>
<tr>
<td>Project Manager</td>
<td>Project manager that would be assigned to the project created from this demand. When a project is created, this field becomes read-only. This field appears if the <strong>Category</strong> field is set to Strategic and the <strong>Type</strong> field is set to Project. If you delete the project created from this demand, this field becomes editable.</td>
</tr>
<tr>
<td>Business Unit</td>
<td>Business unit to which the demand submitter belongs.</td>
</tr>
<tr>
<td>Impacted Business Units</td>
<td>Business unit which is impacted due to the submitted demand.</td>
</tr>
<tr>
<td>Idea</td>
<td>Unique identification number of the idea from which the demand was created.</td>
</tr>
<tr>
<td>Business Capabilities</td>
<td>If the demand is to change, enhance, or add one or more business capabilities, they can be associated to the demand. <strong>Business capabilities</strong> are defined in the Application Portfolio Management module.</td>
</tr>
<tr>
<td>Business Applications</td>
<td>If the demand is to change, enhance, or add one or more business applications, they can be associated to the demand. <strong>Business applications</strong> are defined in the Application Portfolio Management module. You can select any business application in your enterprise, irrespective of it being related or not related to the capability that you have selected in the <strong>Business Capabilities</strong> field.</td>
</tr>
</tbody>
</table>

**Business Case**

<p>| Strategies            | Strategic objectives of the organization that the demand fulfills. A demand can fulfill multiple strategic objectives.                                                                                                                                                                                                                     |
|                       | If a <strong>Business Unit</strong> for the demand is selected in <strong>Details</strong> tab, then the choice list displays the business strategies for the selected business unit along with other enterprise strategies.                                                                                                                                                    |
| Goals                 | Goals associated to the selected strategy. A demand can fulfill multiple goals.                                                                                                                                                                                                                                                           |
|                       | If a strategy is not selected, then all goals are displayed in the list.                                                                                                                                                                                                                                                                   |
| Business case         | Business arguments that support the demand.                                                                                                                                                                                                                                                                                               |
| Risk of performing    | Risks if the demand is approved and implemented.                                                                                                                                                                                                                                                                                           |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Risk of not performing</td>
<td>Risks if the demand is not approved, for example, risk of loss of opportunity.</td>
</tr>
<tr>
<td>Enablers</td>
<td>Key enablers for the demand.</td>
</tr>
<tr>
<td>Barriers</td>
<td>Major barriers to the demand.</td>
</tr>
<tr>
<td>In scope</td>
<td>Scope of the demand. It is the set of boundaries that define the extent of a demand.</td>
</tr>
<tr>
<td>Out of scope</td>
<td>Activities or deliverables that are not in the scope of the demand. Anything which is not defined in the scope is out of scope.</td>
</tr>
<tr>
<td>Assumptions</td>
<td>Assumptions made for the demand. Assumptions help to define scope and risks, and fine-tune the estimates for time and cost.</td>
</tr>
<tr>
<td><strong>Financials</strong></td>
<td></td>
</tr>
<tr>
<td>Rate Model</td>
<td>Rate model assigned to the demand. The rate model is used to derive hourly rates for the associated resource plans and time cards.</td>
</tr>
<tr>
<td></td>
<td>Note: If the rate model assigned to the demand is changed or removed, the cost fields on the associated resource plans are not recalculated.</td>
</tr>
<tr>
<td>Capital expense</td>
<td>Capital expenditure (Capex) for the demand.</td>
</tr>
<tr>
<td>Operating expense</td>
<td>Operational expenditure (Opex) for the demand.</td>
</tr>
<tr>
<td>Total planned costs</td>
<td>Result is calculated based on values in the Capital expense and Operating expense fields.</td>
</tr>
<tr>
<td>Financial return</td>
<td>Result is calculated based on values in the Total costs and Financial benefit fields.</td>
</tr>
<tr>
<td>Financial benefit</td>
<td>Estimate of revenue if the demand is approved. This value is rolled up from the benefit breakdown of the demand. You can also enter the value manually. Select a currency icon and enter a value.</td>
</tr>
<tr>
<td>ROI %</td>
<td>Result is calculated based on values in the Total costs and Financial return fields. The value in this field is updated when a cost plan, benefit plan, or resource plan is created or updated for the demand in Qualified or Approved state.</td>
</tr>
<tr>
<td>Capital budget</td>
<td>Total capital budget allocated to the demand across all fiscal years. The value is rolled up from the capex budget of the demand.</td>
</tr>
<tr>
<td>Operating budget</td>
<td>Total operational budget allocated to the demand across all fiscal years. The value is rolled up from the opex budget of the demand.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Discount Rate %</td>
<td>Demand discount rate. The discount rate is the interest rate to determine the present value of future cash flows.</td>
</tr>
<tr>
<td>Net present value</td>
<td>Present value of future cash based on the given annual interest rate.</td>
</tr>
<tr>
<td></td>
<td>It is a measure for comparing money spent today against future expected financial benefits. It helps when evaluating the overall investment performance.</td>
</tr>
<tr>
<td></td>
<td>For example, at 12% discount rate, $1.00 today is worth $0.80 in two years. Therefore, receiving $1.00 in two years, is the same as receiving $0.80 today.</td>
</tr>
<tr>
<td></td>
<td>Net present value (NPV) is calculated from total costs per year, financial benefit per year and the discount rate for the demand.</td>
</tr>
<tr>
<td>Internal rate of return %</td>
<td>Annual interest rate required to achieve an NPV of zero.</td>
</tr>
<tr>
<td></td>
<td>Internal rate of return (IRR) helps to determine which demands can deliver higher rate of return in terms of revenue.</td>
</tr>
<tr>
<td>Demand Actual Cost</td>
<td>Total cost incurred while working on a demand and demand tasks. Demand actual cost comes after the assignee of the demand task creates and submits a time card. When the time card is approved, the resource rate derived from the rate card, labor rate, or system properties is used to populate this field.</td>
</tr>
<tr>
<td></td>
<td>Note:</td>
</tr>
<tr>
<td></td>
<td>If you are upgrading to New York, this field remains blank for existing demands. To populate this field, run the Update Demand Actual Cost and Actual Effort schedule job.</td>
</tr>
<tr>
<td>Demand Actual Effort</td>
<td>Time accrued or spent by a resource while working on a demand or demand task as derived from the submitted and approved time cards. This field is not available on the Demand form by default. Configure the form to add this field if required.</td>
</tr>
<tr>
<td></td>
<td>Note:</td>
</tr>
<tr>
<td></td>
<td>If you are upgrading to New York, this field remains blank for existing demands. To populate this field, run the Update Demand Actual Cost and Actual Effort schedule job.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Impact</td>
<td>Level of business impact created by the demand.</td>
</tr>
<tr>
<td>Risk</td>
<td>Risk value calculated from the demand assessment.</td>
</tr>
<tr>
<td>Value</td>
<td>Business value of the demand calculated from the <strong>Impact</strong> and <strong>Financial return</strong> fields.</td>
</tr>
<tr>
<td>T-Shirt size</td>
<td>Size of the demand.</td>
</tr>
<tr>
<td></td>
<td>Before using <strong>T-Shirt size</strong> as an indicator of demand size, consider creating and publishing definitions for each option, outside the application. This process ensures that the values are interpreted correctly and consistently across the organization or department.</td>
</tr>
<tr>
<td>Score</td>
<td>Demand score is calculated based on <strong>risk</strong>, <strong>value</strong>, and <strong>size</strong> attributes in the base system. The value of the <strong>risk</strong>, <strong>value</strong>, and <strong>size</strong> attributes are derived from the assessment metric category results. For more information, see Assessment metric categories and their results. • When the <strong>risk</strong> and <strong>size</strong> are high, the score of the demand is low. • When the <strong>value</strong> is high, the score of the demand is high.</td>
</tr>
<tr>
<td>Assessment Required</td>
<td>Check box for enabling the assessments for the demand.</td>
</tr>
<tr>
<td></td>
<td>By default the field is selected. When clear, the assessment questionnaire is not triggered for the demand. Only a demand manager can update the field when the demand is in Draft or Submitted state.</td>
</tr>
</tbody>
</table>

**Note:** When this field is clear, and you reset the demand to draft, the value for **Assessment Required** is retained as clear.

**Note:** The values in **Value** and **Score** fields are updated when a cost plan, benefit plan, or resource plan is created or updated for the demand in Qualified or Approved state. The values in the fields are updated only until an artifact such as project, enhancement, defect, or change is created from the demand.

<table>
<thead>
<tr>
<th>Notes</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Watch list</td>
<td>List of groups and users who are subscribed to the demand and who can view the Additional comments.</td>
</tr>
<tr>
<td>Work notes list</td>
<td>List of groups and users who are subscribed to the demand and who can view Work notes.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Work notes</td>
<td>Information about the demand. Not visible to customers. Work notes are added throughout the demand management life cycle to communicate with other users associated with the demand.</td>
</tr>
<tr>
<td>Preferences</td>
<td></td>
</tr>
<tr>
<td>Project Currency</td>
<td>Currency that is used to run the project once the project is created from this demand.</td>
</tr>
<tr>
<td></td>
<td>You can select any active currency from the list of values that are listed in the Currency [fx_currency] table.</td>
</tr>
<tr>
<td></td>
<td>After you create a project in the selected project currency, you can't change the project currency in the Project form if the demand contains a cost plan, a benefit plan, and a project budget. If the demand does not have any plans or budget attached to it, then you can change the project currency in the Project form.</td>
</tr>
<tr>
<td>Note:</td>
<td>The value of this field defaults to the Project currency field of the Financials tab in the project currency view of the Project form as well.</td>
</tr>
<tr>
<td>Close Demand</td>
<td>Specify when to close a demand automatically when it is converted into a project.</td>
</tr>
<tr>
<td></td>
<td>• None: Select this option if you want the demand to remain in Open state after it's converted to a project.</td>
</tr>
<tr>
<td></td>
<td>• On creation of project: Closes the demand when a demand is converted to a project.</td>
</tr>
<tr>
<td></td>
<td>• On closure of project: Closes the demand when the project created from the demand is closed.</td>
</tr>
<tr>
<td>Note:</td>
<td>The On creation of project and On closure of project options appear on when the value for the Type field is set as Project. If the Type field is set as Enhancement, then None appears as the default option.</td>
</tr>
</tbody>
</table>

3. Click Save to save the record.

**Note:** Requesters or collaborators can edit their demand as long as the demand is in the Draft state.

Use the following related links and lists:

**Demand form related links and lists**

**Related Links**
<table>
<thead>
<tr>
<th>ServiceNow</th>
<th>DocVersion</th>
<th>IT Business Management</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allocate Funds</td>
<td>If your demand is a large multi-year investment, use it as an approved demand to fund one or more projects, epic, or programs from the demand directly. This link appears only if you have the Investment Funding activated, an existing corresponding investment record for this demand, and the investment_user role.</td>
<td></td>
</tr>
<tr>
<td>Create Demand Budget</td>
<td>Allows you to allocate the budget to the demand.</td>
<td></td>
</tr>
<tr>
<td>Create Baseline</td>
<td>Allows you to create a baseline of a demand. A baseline is a snapshot of the demand's current financial plans, which includes cost and benefit plans, but not actuals.</td>
<td></td>
</tr>
<tr>
<td>Create Project</td>
<td>This link appears if the Category field is set to Strategic and the Type field is set to Project. To create a project record for this demand, click this link. The number of the project record is displayed in the Project field.</td>
<td></td>
</tr>
<tr>
<td>Create Enhancement</td>
<td>This link appears if the Category field is set to Strategic and the Type field is set to Enhancement. To create an enhancement record for this demand, click this link. The number of the enhancement record is displayed in the Enhancement field.</td>
<td></td>
</tr>
<tr>
<td>Create Story</td>
<td>This link appears if the Category field is set to Strategic and the Type field is set to Story. To create a story record for this demand, click this link. A Demand reference field is created in the Agile Development 2.0 Story form.</td>
<td></td>
</tr>
<tr>
<td>Create Epic</td>
<td>This link appears if the Category field is set to Strategic and the Type field is set to Epic. To create an epic record for this demand, click this link. A Demand reference field is created in the Agile Development 2.0 Epic form.</td>
<td></td>
</tr>
</tbody>
</table>
| Create SAFe Story | This link appears if the Category field is set to Strategic and the Type field is set to SAFe Story. To create a SAFe story record for this demand, click this link. A Demand reference field is created in the SAFe Story form.  
Note: You need the safe_art_user role to create a SAFe story. |
| Create SAFe Feature | This link appears if the Category field is set to Strategic and the Type field is set to SAFe Feature. To create a SAFe feature record for this demand, click this link. A Demand reference field is created in the SAFe Feature form.  
Note: You need the safe_art_user role to create a SAFe feature. |
| Create SAFe Epic | This link appears if the Category field is set to Strategic and the Type field is set to SAFe Epic. To create a SAFe Epic record for this demand, click this link. A Demand reference field is created in the SAFe Epic form.  
Note: You need the safe_art_user role to create a SAFe epic. |
| Create Change | This link appears if the Category field is set to Operational and the Type field is set to Change. To create a change record for this demand, click this link. The number of the change record is displayed in the Change field. |
| Create Defect | This link appears if the Category field is set to Operational and the Type field is set to Defect. To create a defect record for this demand, click this link. The number of the defect record is displayed in the Defect field. |
### View RIDAC
View the Risks, Issues, Decisions, Actions, and Request Changes (RIDAC) entries for the demand. For more information, see RIDAC (Risk, Issue, Decision, Action, and Request Changes) record entries for a demand.

### Recalculate Strategy and Goal Allocation
Recalculate and update cost field values in the Strategy and Goal Allocation tabs. Use this link to update the demand's total cost and benefits when strategy and goal allocations for the demand are changed. For more information, see Strategic Spend Tracking for PPM.

**Note:** This related link is available only if the Strategic Spend Tracking for PPM is installed. You must switch to the Strategic Alignment view to see this related link. If this related link is not available on the form view that you are using, ask your administrator to configure the demand form to add this related link.

### Related Lists

#### Demand Tasks
Lists the tasks created for the demand.
- To create a new demand task, click **New**.
- To modify an existing demand task, click **Edit**.

#### Stakeholders
Lists the stakeholders for the demand.
- To create a new stakeholder, click **New**.
- To add existing stakeholders to the demand, click **Edit**.

**Note:** If the portfolio associated with the demand has stakeholders, the portfolio stakeholders are automatically added to the demand.

#### Requirements
Lists the requirements for the demand.
- To create a new requirement, click **New**.

#### Risks
Lists the risks for the demand.
- To create a new risk, click **New** For more information, see Add risks for a demand.

The demand risks are added to the parent program and portfolio.

#### Issues
Lists the issues included in the demand.
- To create a new issue, click **New**. For more information, see Add issues for a demand.

#### Decisions
Lists the decisions for the demand.
- To create a new decision, click **New**. For more information, see Add decisions for a demand.

#### Actions
Lists the action items identified for the demand.
- To create a new action, click **New**. For more information, see Add actions for a demand.

#### Request Changes
Lists changes related to the resource, scope, cost, and schedule for the current demand.
- To create a new demand request change, click **New**. For more information, see Add Request Changes to a demand.
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Plans</td>
<td>Lists the resource plans for the demand. To create a resource plan and manage existing resource plans, click New or Manage.</td>
</tr>
<tr>
<td>Cost Plans</td>
<td>Lists the cost plans for the demand. To create a new cost plan, click New or click Manage to modify an existing plan. The demand cost plans are added to the parent program and portfolio. The cost plan breakdowns that specify the estimated cost and actual cost at a granular level for a fiscal period of the demand cost plan are recalculated in the project currency. Similarly, the estimated breakdown amounts of the planned benefit and actual benefit of the demand benefit plans are recalculated in the project currency. The project currency amounts are then rolled up to the cost plan, benefit plan, and the project records.</td>
</tr>
<tr>
<td>Benefit Plans</td>
<td>Lists the benefit plans for the demand. To create a new benefit plan, click New or click Manage to modify an existing plan.</td>
</tr>
<tr>
<td>Demand Budget</td>
<td>Lists the demand budget by fiscal year. Click the amounts in the list to revise them.</td>
</tr>
<tr>
<td>Stories</td>
<td>Lists the stories for the demand. To create a new story, click New. To add or modify the existing story, click Edit.</td>
</tr>
<tr>
<td>Assessment Instances</td>
<td>The assessment instances for this demand. For more information, see View an assessment instance.</td>
</tr>
<tr>
<td>Assessment Results</td>
<td>Results of the assessments that the stakeholders submitted for this demand.</td>
</tr>
<tr>
<td>Strategy Allocations</td>
<td>Lists the percentage of demand's total cost and benefits allocated towards achievement of strategies associated with the demand. For more information, see Allocate or modify the strategy and goal percentage for a demand.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This related list appears only when Strategic Spend Tracking for PPM is installed. This application is available on ServiceNow Store. You must switch to the Strategic Alignment view to see this related list. If this related list is not available on the form view that you are using, ask your administrator to configure the demand form to add this related list. For more information, see Install Strategic Spend Tracking for PPM.</td>
</tr>
</tbody>
</table>
Goal Allocations  Lists the percentage of demand's total cost and benefits allocated towards achievement of goals associated with the demand. For more information, see Allocate or modify the strategy and goal percentage for a demand.

Note: This related list appears only when Strategic Spend Tracking for PPM is installed. This application is available on ServiceNow Store. You must switch to the Strategic Alignment view to see this related list. If this related list is not available on the form view that you are using, ask your administrator to configure the demand form to add this related list. For more information, see Install Strategic Spend Tracking for PPM.

Create a new qualified demand
The demand manager can create a new qualified demand from the demand workbench list view.

Saving the demand adds it to the Demands list and adds a bubble representing the demand in the bubble chart.

1. Navigate to Demand > Demands > Workbench.
2. Click New at the top of the list view.
3. Fill in the fields on the Demand form.
   For information about the fields, see Creating Demands.

Create a demand task
Create tasks for a demand to delegate cost, effort, risk, and benefit assessment activities. Assign a resource or group to the demand task to track the actual time and effort spent on performing the specified activities.

Role required: it_demand_manager

You create demand tasks to plan the work for demands rather than for the target work entity such as a project, change, defect, or enhancement. For more information, see Demand tasks.

- Planned dates, actual dates, and original dates are part of project tasks not demand tasks.
- The due date indicates the date on which the task is targeted for completion and does not affect the demand workflow. Project tasks, however, affect the project completion dates if the planned dates and actual dates are changed.
- Do not support creation of nested demand tasks.
- Do not support task constraints such as the settings Start ASAP and Start on specific date.
- Do not support an execution type such as Agile, Waterfall, or Hybrid.
- You assign resources for a demand task use the Assigned to field, Additional Assignee list, and Assignment Group fields.

Note: If you associate a resource plan with a demand task, the associated resource plan is not transferred to the work entity created from that demand. Therefore, do not create and use resource plans for allocating resources or groups to a demand task.

Resources assigned to a demand task can submit the time spent on it using a time card.

1. Navigate to Demand > Demands > All.
2. Select the demand to which you want to add tasks.
3. From the Demand Tasks related list, click New.
4. On the Demand Task form, fill in the fields.

**Demand Task form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Name of the demand task.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group assigned to the demand task.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Primary resource assigned to the demand task.</td>
</tr>
<tr>
<td></td>
<td>The following conditions apply:</td>
</tr>
<tr>
<td></td>
<td>• If an assignment group is defined, only users in the assignment group are listed.</td>
</tr>
<tr>
<td></td>
<td>• If skills are defined, only users with those skills are listed.</td>
</tr>
<tr>
<td></td>
<td>• If no assignment groups or skills are defined, only users with one of the Project Management application user roles are listed.</td>
</tr>
<tr>
<td></td>
<td>• Users with timecard_user role are also listed.</td>
</tr>
<tr>
<td>Additional assignee list</td>
<td>Users assigned to the demand task in addition to the single primary resource defined in the Assigned to field.</td>
</tr>
<tr>
<td>Category</td>
<td>Category of the demand task:</td>
</tr>
<tr>
<td></td>
<td>• Initial review</td>
</tr>
<tr>
<td></td>
<td>• Effort estimate</td>
</tr>
<tr>
<td></td>
<td>• Cost estimate</td>
</tr>
<tr>
<td></td>
<td>• Benefit estimate</td>
</tr>
<tr>
<td></td>
<td>• Risk assessment</td>
</tr>
<tr>
<td></td>
<td>The Category field selection determines the links available in the related links. For example, the Add Resource Plan to Demand related link appears when you set the Category value to Effort estimate. Users must have the appropriate role to use these related links.</td>
</tr>
<tr>
<td>Actual effort</td>
<td>The actual time spent working on the demand task, which is derived from the approved time card for this demand task.</td>
</tr>
<tr>
<td></td>
<td>Because this field does not appear by default on the Demand Task form, you must add it by personalizing the form.</td>
</tr>
<tr>
<td>Description</td>
<td>Brief description of the demand task.</td>
</tr>
<tr>
<td>Number</td>
<td>System-generated ID number with a configurable prefix.</td>
</tr>
<tr>
<td>Priority</td>
<td>Sequence in which the task needs to be completed based on impact and urgency.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the demand task. The states include Pending, Open, Work in Progress, Closed Complete, Closed Incomplete, and Closed Skipped.</td>
</tr>
<tr>
<td>Due date</td>
<td>The date by which the task is targeted for completion.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Actual cost</td>
<td>The actual cost of the demand task derived from the number of hours worked and hourly rate of the resource as defined in the rate card. In the absence of a rate card, the hourly rate is derived from the default labor rate card or default system property.</td>
</tr>
<tr>
<td>Notes</td>
<td>Work notes</td>
</tr>
<tr>
<td></td>
<td>Information about the demand task. Work notes are added throughout the demand management life cycle to communicate with other users associated with the demand.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

Add a cost plan, resource plan, benefit plan, and risks to the demand depending on your role. Use the following related links to access these tasks.

**Demand Task form related links**

<table>
<thead>
<tr>
<th>Related Links</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Cost Plan to Demand</td>
<td>Add a cost plan to capture the costs of demands. Create a cost plan to specify the unit cost of a cost type for a fiscal period. This link appears if the <strong>Category</strong> value is set to Cost estimate and the user has the <code>it_project_manager</code> or <code>it_demand_manager</code> role. Click the link to open the cost plan form and fill in the details. For more information, see create a cost plan.</td>
</tr>
<tr>
<td>Add Resource Plan to Demand</td>
<td>Create a resource plan to find the availability of resources and add the resource plan to the demand. This link appears if the <strong>Category</strong> value is set to Effort estimate and the user has the <code>it_resource_user</code> role. Click the link to navigate to the Resource Plans page and request resources. For more information, see create a resource plan.</td>
</tr>
<tr>
<td>Add Benefit Plan to Demand</td>
<td>Create a benefit plan to capture the potential benefits accrued by the demand when the demand is executed. This link appears if the <strong>Category</strong> value is set to Benefit estimate and the user has <code>it_project_manager</code> or <code>it_demand_manager</code> role. Click the link to open the benefit plan form and fill in the details. For more information, see create a new benefit plan.</td>
</tr>
<tr>
<td>Add Risk to Demand</td>
<td>Add risks that can potentially impact the success or outcome of the execution of the demand. This link appears if the <strong>Category</strong> value is set to Risk estimate and the user has <code>it_project_manager</code> or <code>it_demand_manager</code> role. Click the link to open the risk form and fill in the details. For more information see, add a risk.</td>
</tr>
</tbody>
</table>
Submit a time card for a demand task
The resources assigned to a demand task create and submit a time card or time sheet to record the time spent on a demand task. The reported hours are used to calculate the actual cost and effort for a demand task.

Role required: timecard_user
The resource submits the time card or time sheet to record and track the work performed on a demand task. An appropriate approver then has to approve the submitted time card or time sheet.

1. **Navigate to Time Sheets > Time Sheet Portal.**
2. **Create a time card.**

<table>
<thead>
<tr>
<th>Demand task assignment</th>
<th>To create a time card</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>If a demand task is assigned to you</strong></td>
<td>a. Navigate to the task that you want to add to the time sheet.</td>
</tr>
<tr>
<td></td>
<td>b. Click the Add to Time Sheet link in the task.</td>
</tr>
<tr>
<td><strong>If a demand task is assigned to you as an</strong></td>
<td>a. Click the Add unassigned tasks to Time Sheet link next to Logged Time Cards</td>
</tr>
<tr>
<td><strong>additional assignee</strong></td>
<td>b. In the Add unassigned tasks to Time Sheet window, search for and select the demand task from the Select a Task list.</td>
</tr>
</tbody>
</table>

3. **Fill in the hours for each day spent working on the demand task.**
4. **Click Submit.**

Create an artifact from a demand
Create an artifact, such as a work item, from a demand so that you can start work on these artifacts in a methodology of your choice.

- **Create a demand.**
- To convert a demand into an enhancement or a defect, activate the Project Portfolio Suite plugin.
- To convert a demand into Agile Development entities (story or epic), activate the Agile Development 2.0 plugin.
- To convert a demand into SAFe entities (story, feature, or epic), activate the Essential SAFe or the Portfolio SAFe plugin.

When you create a demand, you specify a category and a type for that demand. The selections that you make from the **Category** and **Type** fields determine the artifact that you can create from a demand. The available artifact types are project, enhancement, change, defect, or scrum and SAFe entities such as epic, story, or feature.

1. **Navigate to a demand using any of the following options:**
   - Demand > Demands > All
   - If you activated the Investment Funding plugin, navigate to Demand (Investment Request) > Demands (Investment Requests) > All
2. **Open the demand that you want to convert into an artifact.**
3. **From the Category list, select a category.**
4. **From the Type list, select an artifact type.**
   The options in the Type list change according to the category that you select.
5. **Click Update.**
6. Click the related link to create the artifact.  
You can see one of the following related links depending on the values that you have selected from the Category and Type lists.

<table>
<thead>
<tr>
<th>Related link</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Project</td>
<td>Creates a project that is associated with this demand. The number of the project record is displayed in the Project field.</td>
</tr>
<tr>
<td>Create Enhancement</td>
<td>Creates an enhancement that is associated with this demand. The number of the enhancement record is displayed in the Enhancement field.</td>
</tr>
<tr>
<td>Create Epic</td>
<td>Creates an Agile Development 2.0 epic that is associated with this demand. A Demand reference field is created in the Agile Development 2.0 Epic form.</td>
</tr>
<tr>
<td>Create Story</td>
<td>Creates an Agile Development 2.0 story that is associated with this demand. A Demand reference field is created in the Agile Development 2.0 Story form.</td>
</tr>
<tr>
<td>Create SAFe Story</td>
<td>Creates a SAFe story that is associated with this demand. A Demand reference field is created in the SAFe Story form.</td>
</tr>
<tr>
<td>Create SAFe Epic</td>
<td>Creates a SAFe epic that is associated with this demand. A Demand reference field is created in the SAFe Epic form.</td>
</tr>
<tr>
<td>Create SAFe Feature</td>
<td>Creates a SAFe feature that is associated with this demand. A Demand reference field is created in the SAFe Feature form.</td>
</tr>
<tr>
<td>Create Change</td>
<td>Creates a change that is associated with this demand. The number of the change record is displayed in the Change field.</td>
</tr>
<tr>
<td>Create Defect</td>
<td>Creates a defect that is associated with this demand. The number of the defect record is displayed in the Defect field.</td>
</tr>
</tbody>
</table>

Create a demand benefit plan
Demand benefit plans capture the potential benefits accrued by the demand when the demand is executed. Create a benefit plan to specify the estimated benefit in a category for a fiscal period.

Role required: it_demand_manager

The benefit plan breakdown records are automatically created when you save the benefit plan. The benefit plan breakdown records specify the estimated and actual benefits at a granular level for specific fiscal periods, such as FY16: April and FY16: May. The Benefit Breakdown related list shows the aggregated benefits for estimated and actual benefits for each fiscal period for the demand.

Note: Converting a demand to a project transfers the benefit plan from the demand to the target project.

1. Navigate to Demand > Demands > All.
2. Open the required demand form.
3. Click the Benefit Plans related list.
4. To view the Financials Summary page in a grid, click Manage.
5. To create a benefit plan, click New.
6. On the form, fill in the fields.

### Benefit Plan form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive name of the benefit plan.</td>
</tr>
<tr>
<td>Project/Demand</td>
<td>Demand number to which the benefit plan belongs.</td>
</tr>
<tr>
<td>Sponsor</td>
<td>Sponsor for the demand.</td>
</tr>
<tr>
<td>Category</td>
<td>Type of benefit:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Hard</strong>: Benefits that can be measured in terms of revenue.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Soft</strong>: Benefits that are measured in terms of value.</td>
</tr>
<tr>
<td>Sub category</td>
<td>Sub-categories of hard and soft benefits.</td>
</tr>
<tr>
<td></td>
<td>The selection in <strong>Category</strong> field determines the selections available in this field.</td>
</tr>
<tr>
<td>Offset type</td>
<td>Offset type field indicates when the benefits start realizing.</td>
</tr>
<tr>
<td></td>
<td>If the value in the selected offset type changes, the benefit plan start date shifts accordingly. For example, if the offset type is set to <strong>End Date</strong> and the due date of the demand changes, the benefit plan start date shifts to align with the new due date of the demand.</td>
</tr>
<tr>
<td>Project/Demand start date</td>
<td>Start date of the demand. The field appears if you select <strong>Start Date</strong> in the <strong>Offset type</strong> field.</td>
</tr>
<tr>
<td>Project/Demand end date</td>
<td>End date of the demand. The field appears if you select <strong>End Date</strong> in the <strong>Offset type</strong> field.</td>
</tr>
<tr>
<td>Offset</td>
<td>Number of periods before or after the offset type when the benefit plan starts. For example, if the offset type is set to <strong>End Date</strong> and the offset is -2, the benefit plan is two periods prior to the demand end date. If the demand end date shifts, the benefit plan start date shifts to two periods prior to the new demand due date.</td>
</tr>
<tr>
<td>Duration in periods</td>
<td>The length, in periods, of the benefit plan.</td>
</tr>
<tr>
<td>Start fiscal period</td>
<td>Starting fiscal period. Populated based on the value in the Offset field relative to the selected Project or Demand start date or Project or Demand end date, and the Duration in period values.</td>
</tr>
<tr>
<td></td>
<td>The field is editable if you select <strong>None</strong> in the <strong>Offset type</strong> field.</td>
</tr>
<tr>
<td></td>
<td>When you change the start fiscal period, the associated benefit breakdown values also change.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>End fiscal period</td>
<td>Ending fiscal period. When you change the end fiscal period, the associated benefit breakdown values also change.</td>
</tr>
</tbody>
</table>

### Financials

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Currency</td>
<td>Currency for the benefit plan. If the selected currency is different from the default currency configured in the Financial Management application, the budget reference rate is used to calculate the financial benefit of the demand.</td>
</tr>
<tr>
<td>Planned benefit</td>
<td>Estimated amount of the potential benefit. Any change in the planned benefit on the benefit plan updates the associated benefit breakdown values for future fiscal periods.</td>
</tr>
<tr>
<td>Total planned benefit</td>
<td>Total benefit value that is rolled up from the benefit breakdown.</td>
</tr>
<tr>
<td>Actual benefit</td>
<td>Actual benefit value that is rolled up from the actual benefit in the benefit breakdown.</td>
</tr>
<tr>
<td>Recurring</td>
<td>Check box to indicate if the benefit is recurring for each fiscal period in the benefit breakdown.</td>
</tr>
</tbody>
</table>

**Note:** When you move the demand dates, the associated benefit plans also change accordingly based on whether the benefit plan is tied to the demand start date, or end date. The project property **Change Resource Plan, Cost Plan and Benefit Plan Start Date with Demand or Project Start Date Change** controls the behavior for demand date changes.

7. **Click Submit.**

On the demand form, view the benefit breakdown by fiscal period in the **Benefit Breakdown** related list. **Create a demand cost plan**

Demand cost plans capture the costs of demands. Create a cost plan to specify the unit cost of a cost type for a fiscal period.

Role required: it_demand_manager

The application automatically creates cost plan breakdown records when you save the cost plan. The cost plan breakdowns are records that specify the estimated and actual costs and the budget at a granular level for specific fiscal periods, such as FY16: April and FY16: May.

**Note:** Cost plans are automatically created for resource plans that are associated to demands.

If you want to use multiple currencies, create a new cost plan for another currency.

1. Open the required demand form.
2. In the related links, click **Cost Plans.**
3. To view the Financials Summary page in a grid, click **Manage.**
4. To create a cost plan, click **New.**
5. Fill in the cost plan form.

### Demand plan form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive name for the cost plan.</td>
</tr>
<tr>
<td>Project/Demand</td>
<td>Demand number to which the cost plan belongs.</td>
</tr>
<tr>
<td>Start fiscal period</td>
<td>Starting fiscal period. When you change the start fiscal period, the associated cost breakdown values also change.</td>
</tr>
<tr>
<td>End fiscal period</td>
<td>Ending fiscal period. When you change the end fiscal period, the associated cost breakdown values also change.</td>
</tr>
</tbody>
</table>

### Financials

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Currency</td>
<td>Currency for the cost plan. You can select a currency different from the functional currency. If the selected currency is different from the default currency configured in the Financial Management application, the budget reference rate is used to calculate the cost of the demand.</td>
</tr>
<tr>
<td>Resource plan</td>
<td>Resource plan number associated with the cost plan. The field appears for the cost plans originating from resource plans. The Cost type value is Labor.</td>
</tr>
<tr>
<td>Product model</td>
<td>Product for which the cost plan is created. The field appears if you select Hardware or Software as the Cost type.</td>
</tr>
<tr>
<td>Unit cost</td>
<td>Cost of single unit of the resource.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Quantity of resource required.</td>
</tr>
<tr>
<td>Recurring</td>
<td>Indicates if the cost is recurring for each fiscal period. Quantity x Unit cost value is incurred for every fiscal period.</td>
</tr>
<tr>
<td>Cost type</td>
<td>Cost type. See Create a cost type definition.</td>
</tr>
<tr>
<td>Total planned cost</td>
<td>Total planned costs of the cost plan. If the cost is recurring, the calculation is Quantity x Unit cost x number of fiscal periods. If the cost is non-recurring, the calculation is Quantity x Unit cost. This value is rolled up from cost breakdown.</td>
</tr>
<tr>
<td>Total actual cost</td>
<td>Total actual costs of the cost plan. This value is rolled up from cost breakdown.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Forecast</td>
<td>Sum of all actuals for past periods plus estimated cost for future periods.</td>
</tr>
</tbody>
</table>

**Note:** When you change the planned start date of a demand, the associated cost plans and resource plan also change. The project property **Change Resource Plan and Cost Plan Start Date with Demand or Project Start Date Change** controls the behavior for demand date change.

6. Click **Submit**.

- On the Demand form, view the breakdowns by fiscal period in the **Cost Breakdown** related list.
- To recalculate the value in the **Forecast** field, use the **Calculate Forecast Amount** related link.

Create and manage resource plans for a demand

As a resource requester, find the availability of the resources, and create and manage the resource plans for a demand.

Role required: it_demand_manager

The Resource Plans page shows the resource plans for the selected demand in an editable grid view. The page consists of the following sections:

**Resource grid**

It is the top section on the page that enables you to:

- Create resource plans for a demand. You can create a resource plan at a group, role, or user level.
- View and manage all the resource plans for the demand in one place.
- View resource allocations for each resource plan in a grid view.

Use the grid view on the page to:

- Edit the planned and allocated hours inline without opening the record in a form.
- Expand or hide certain columns as per your requirement.

**Resource Finder**

The section is available at the bottom of the page. The section is hidden by default and can be made visible by clicking resource finder icon ( ) in the top right of the page. It enables you to:

- Search the resources and their availability. You can search the resources by group, role, or user.
- Add resource plans for the searched resources to the demand.

When you select a resource plan in the resource grid section, the availability details of that resource are displayed in the resource finder section. For example, if a group resource plan is selected, the availability details of the group and its members is displayed in the Finder section. When you change the selection, the finder is automatically updated based on the current selection.

1. Navigate to **Demand > Demands > All**.
2. Open the required demand form.
3. Click the **Resource Plans** related list and click **Manage**.
   - To create a resource plan, click **New**.
   - To view the allocations in weekly or monthly format in the grid, click **Week** or **Month** button.
     The time duration in the grid is displayed based on the earliest start date of the demand or resource plans, and the last end date of the demand or resource plans.
   - To view the allocations in hours, FTE, or person days format in the grid, click **Hours**, **FTE**, or **Person Days** option in the list. The selected option changes the grid view in both the resource grid section and resource finder section.
   - To search the resources and create a resource plan for them, click the resource finder icon (  ).
   - To show or hide certain columns from the grid view, click the configuration icon (  ). Hiding or displaying an item column does not update the table. Grouped columns cannot be hidden.
   - To view the resource allocations at user level, expand a resource plan in the grid. The user level allocations are listed only for Group and Role resource plans.
   - To edit the planned and allocated hours inline in the grid, double-click a row. You can update the planned hours for future period for resource plans in Requested, Confirmed, and Allocated state.
   - To view and update the resource plan details in a form, click the information icon (  ) in the beginning of the resource plan row.
   - To request a resource plan, in the **Actions** column, click the actions icon (  ) and select **Request**.
   - To delete a resource plan, in the **Actions** column, click the actions icon (  ) and select **Delete**.
   - To request all the resource plans created for the demand, in the **Actions** column, click the actions icon (  ) in the demand row and select **Request All**. The icon is enabled when at least one of the listed resource plans for the demand is in the Planning or Rejected state.

Recalculate costs of resource plans of a demand

Recalculate the costs of all active resource plans of a demand whenever the hourly rates change in the associated rate model so that the plan costs are up to date.

Ensure the following setup:
   - The demand must be active.
   - The demand must have an active rate model assigned.
   - The resource plans must be in the Planned, Requested, Confirmed, or Allocated state.

Role required: demand_manager
This option recalculates the costs of all resource plans of the demand at once. You can also open a resource plan from the Resource Plans related list to recalculate the resource costs of an individual resource plan.

1. Navigate to Demand > Demands > All.
2. Open a demand.
3. On the Demand form, right-click on the header bar and select the Recalculate Resource Costs.
4. In the Recalculate Resource Cost dialog box, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start date</td>
<td>Start date of the time period for which the costs are recalculated.</td>
</tr>
<tr>
<td></td>
<td>By default, the field shows the current date.</td>
</tr>
<tr>
<td>End date</td>
<td>End date of the time period for which the costs are recalculated.</td>
</tr>
<tr>
<td></td>
<td>By default, the field shows the due date of the demand. If the due date is not specified for the demand, the field is empty.</td>
</tr>
<tr>
<td>Planned costs for Requested Resource plans</td>
<td>Option for recalculating the planned cost of Requested resource plans.</td>
</tr>
<tr>
<td>Confirmed/Allocated costs for Confirmed/Allocated resource plans</td>
<td>Option for recalculating the confirmed or allocated cost of Confirmed or Allocated resource plans.</td>
</tr>
<tr>
<td>Planned costs for Confirmed/Allocated resource plans</td>
<td>Option for including the planned cost of a Confirmed or Allocated plan.</td>
</tr>
<tr>
<td></td>
<td>The option is enabled if the Confirmed/Allocated costs for Confirmed/Allocated resource plans option is selected.</td>
</tr>
<tr>
<td></td>
<td>By default, the option is not selected.</td>
</tr>
</tbody>
</table>

5. Click OK.

- Recalculates the selected resource costs of all the applicable resource plans in the demand based on the latest hourly rates. The hourly rates are derived from the rate model associated with the demand.
- Updates the recalculated resource costs on the respective cost fields on the resource plan form and the Resource Plans related list.
- Reflects the revised values in the respective cost fields of the demand.

Allocate budget to a demand
Set the budget of a demand according to the fiscal years.

Role required: portfolio_manager

1. Open the demand form.
2. In the related links, click Demand Budget. The Demand Budget dialog box opens.
3. Select the fiscal year for which you want to set the budget for the demand.
4. Enter the amounts for Capex Budget and Opex Budget. The Total Budget is updated with the sum of capex and opex amounts.
5. Click OK.

**Note:**
- If the demand does not have a cost plan, start date, and due date, then demand budget is distributed from current month until the end of demand budget fiscal year.
- If the demand does not have a cost plan and a due date but has a start date, then demand budget is distributed from either:
  - Start date (if start date falls in the given budget fiscal year) until the end of the demand budget fiscal year.
  - Start of the demand budget fiscal year until the end of the demand budget fiscal year.
- If the demand does not have a cost plan and a start date but has a due date, then demand budget is distributed from either:
  - Current month until due date (if due date falls in the given budget fiscal year).
  - Current month until the end of demand budget fiscal year.

If the demand has a cost plan associated, then demand budget is distributed by honoring the cost plan fiscal periods.

The demand budget for the selected year appears in the Demand Budget related list. You can click the amounts in the list to revise them.

*Create baseline of a demand*

Create financial baseline of a demand, which captures benefit and financial metric information (snapshot of cost plan, benefit plan, and demand-level financial metrics) at a particular moment in time.

**Role required:** it_demand_manager

You can create as many financial baselines as necessary and review the financials changes that have been made to the demand since the previous baseline. Any financial baseline does not capture the actual cost component of the demand.

1. Navigate to **Demand > Demands > All**.
2. Select the required demand.
3. To create a financial baseline of a demand, use either of the options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>From a related link</td>
<td>a. Click the Create Baseline related link.</td>
</tr>
<tr>
<td></td>
<td>b. In the Create Baseline pop-up, enter a suitable description.</td>
</tr>
<tr>
<td></td>
<td>c. Click Save.</td>
</tr>
<tr>
<td>From a related list</td>
<td>a. Click the Demand Baselines related list.</td>
</tr>
<tr>
<td></td>
<td>b. Click the Create Baseline button.</td>
</tr>
<tr>
<td></td>
<td>c. In the Create Baseline pop-up, enter a suitable description.</td>
</tr>
<tr>
<td></td>
<td>d. Click Save.</td>
</tr>
</tbody>
</table>

*Compare financial baselines of a demand*
You can compare baselines to review the variances in the financial data of a demand and see what changed.

Role required: it_demand_manager

You can create multiple baselines at various stages of a demand’s life cycle, for example, at the end of each phase or after every calendar month or quarter. Each baseline captures the financial data of the demand at a particular moment, providing a basis from which you can identify and review the changes made to the demand. Having multiple baselines and comparing them helps you track the performance of your demand.

1. **To compare financial baselines of a demand, perform one of the following options.**

<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>From the Demand form</strong></td>
<td></td>
</tr>
<tr>
<td>a.</td>
<td>Navigate to Demand &gt; Demands &gt; Workbench.</td>
</tr>
<tr>
<td>b.</td>
<td>Open a demand.</td>
</tr>
<tr>
<td>c.</td>
<td>On the Demand form, click the Cost Plans or Benefit Plans related list.</td>
</tr>
<tr>
<td>d.</td>
<td>Click Manage.</td>
</tr>
<tr>
<td>e.</td>
<td>On the Demand Workbench, click the baseline information icon ( ) and then select Compare Baselines.</td>
</tr>
</tbody>
</table>

   | **From the Baseline form** |       |
   | a.                       | Navigate to Demand > Demands > All. |
   | b.                       | Open a demand. |
   | c.                       | On the Demand form, click the Demand Baselines related list. |
   | d.                       | Open a baseline. |
   | e.                       | On the Baseline form, click the View Financial Baseline related link. |

2. **On the Financial Baseline form, select the baselines you want to compare from the two choice lists.** By default, the current and the most recent baselines are selected.

3. **Click Compare.**

   The comparative data of the baselines display in the following two sections:
   - The Financial Baseline Summary section displays four widgets: the first two widgets contain the financial data of the two baselines, the third widget contains their variance, and the fourth widget contains the actual costs to date of the demand.
   - The Financial Baseline Details section displays the cost plans and benefit plans of the two baselines in two different grids. Each plan type has two rows corresponding to each baseline data.

   **Note:** To see the color code of rows representing each baseline, click the baseline legend icon ( ).

4. **Optional:** Review additional fields or reorganize the comparative data on the form.
   - To show or hide additional fields on the widgets in the Financial Baseline Summary section, click the configuration icon.
and select the field names.

The selected field preferences are saved and are available when you reopen the Financial Baseline form. To reset to the default widget layout, click Reset to defaults.

- To view a cost plan or benefit plan comparative data in yearly, quarterly, or monthly format, click the Year or Quarter or Month views respectively.
- To toggle viewing the Financial Baseline Summary section, click the Collapse icon or Expand icon.

View demands

You can view existing demands at any time.

The demand manager can view demands by navigating to:

- Demand > Demands > Workbench: The bubble chart and the list view on the demand workbench display all qualified demands.
- Demand > Demands > All: Displays the Demands list.

The demand user can view demands by navigating to Demand > Demands > All.

The Number field on the Demands list provides a link to the Demand form.

The Stage field displays the status or progress of a demand. This field is updated as the demand moves through the life cycle, from an idea to a demand to the resulting project, enhancement, change, or defect. At a glance, users can use this field to track the progress of a demand.

Pointing to the Stage field on the Demands list shows the progression of the idea along with the value of the State field for each step in the progression:

- Idea: If an idea is being evaluated, the pop-up window displays the current state of the idea.
- Demand: If an idea is promoted to a demand, the pop-up window displays the current state of the demand as well as the idea.
- Project, Enhancement, Change, or Defect: If a demand is accepted, the pop-up window displays the current state of the resulting artifact in addition to the demand and idea.

Idea Stage Summary pop-up window
Note: Users cannot search or sort the Stage column on the Demands list.

The Project field displays the project name after the demand manager creates a project from the demand. The Risk, Value, and Size fields display assessment metrics for the demand. This information appears on the Demands list.

View an artifact created from a demand
As the demand manager, you can view an artifact created from a demand.

1. Navigate to Demand > Demands > Workbench.
2. Right-click a bubble that has an associated artifact.
3. Click View <artifact>.
   This action displays the artifact form for the selected demand in a new tab.

View a demand summary
Point to a bubble in the demand workbench bubble chart to display a summary of the demand information.

Point to a demand in the bubble chart to highlight the bubble and its label. A bubble summary window also shows the demand name and the risk, value, and size data. Pointing to the bubble also highlights the corresponding demand row in the list view. Pointing to a demand in the list view highlights the corresponding bubble in the bubble chart.

Note: When pointing to a bubble, scroll down in the list view to see the corresponding highlighted demand row. If necessary, adjust the height of the list view or the bubble chart.
For multiple demands, some bubbles or labels overlap and are difficult to see. Point to a label to highlight the corresponding bubble. Use when:

- Two or more bubbles have the same metrics and overlap directly.
- Several bubbles intersect and overlap.
- A bubble is only partially visible on the edge of the bubble chart.

**Add details to demands**

The demand manager typically works with a business relationship manager to identify stakeholders and elicit requirements, risks, and other important information.

The Demand Management application streamlines the stakeholder identification process. Auto-populating the list of stakeholders from the portfolio the user selects when filling out the demand form in the service catalog or in the Demand Management application. The Demand Management application also allows you to use assessments to automate some of the information gathering process.

**Add demand tasks**

Demand managers analyze business demands, approve demands and create projects and enhancements. Many times activities such as effort, cost, risk, and benefit estimates are required to analyze a demand and create a business case for approval of the demand. A demand manager can create demand tasks and assign these tasks to individual resources or a group to perform these activities.

The resources assigned to the demand tasks then post time spent while working on a demand or demand task using time card. The time card data is used to calculate actual effort and cost incurred on the demand task as well as demand.

To create demand tasks, scroll to the Demand Tasks related list on the Demand form and click New to create a record.

**Add stakeholders**

When a demand is submitted, the demand stakeholder list is populated automatically from associated portfolio. You can also add stakeholders. To add a person to the stakeholder list, scroll to the Stakeholders related list on the Demand form, click New to create a record, and fill in the form.

When adding a stakeholder from the demand form, the Portfolio field displays the portfolio that was selected on the Demand form.

A demand can have multiple stakeholders and a stakeholder can be associated with multiple demands.

The newly added stakeholder is automatically associated with the current demand and any other demands that use the same portfolio.

**Add requirements**

Demand managers can create as many requirements as needed, but requirements are not mandatory. Typically, the stakeholders associated with a demand request have input into what the requirements are for a demand request to be completed.

Demand managers use the Requirement form to describe the requirement and assign an owner who is responsible for making sure that the requirement is met. When a requirement is complex, demand managers can associate planned tasks, such as project tasks, with the requirement. The demand manager assigns and tracks the tasks until they are complete.
To add a requirement to a demand, open a Demand form and click New on the Requirements related list (see table for field descriptions).

### Requirement form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique identification number for the requirement. This number is automatically generated when a new requirement record is created.</td>
</tr>
<tr>
<td>Source</td>
<td>User requesting the requirement. This field is automatically populated with the name of the person filling out the form, but the source could be a different person who identified the requirement.</td>
</tr>
<tr>
<td>Owner</td>
<td>User who is responsible for managing the requirement or making sure that the requirement is met.</td>
</tr>
<tr>
<td>Estimated effort</td>
<td>Approximate amount of time to complete the requirement and any associated tasks.</td>
</tr>
<tr>
<td>Priority</td>
<td>Importance of the requirement as it applies to the overall demand.</td>
</tr>
<tr>
<td>State</td>
<td>Status of the requirement can be Pending, Approved, or Rejected.</td>
</tr>
</tbody>
</table>

**Note:** The request state is independent of the demand request state and of the states of any planned tasks associated with the requirement. The request can be closed without the requirement state being closed. Likewise, closing the request does not change the state of the requirement.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Type of requirement can be: Business, Solution (Functional), Solution (Non-Functional), Quality, Stakeholder, or Transition.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the requirement.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the requirement and any associated tasks. For example, you can use this field to describe an expected outcome or result.</td>
</tr>
</tbody>
</table>

### Add resource plans

Resource plans are another source of information that decision makers can use when evaluating demands. You can create resource plans for a demand from the Resource Plan related list, which appears only if the Resource Management application is activated.

To add a resource plans to the demand, scroll to the Resource Plans related list on the Demand form and click Manage to create a record.
RIDAC (Risk, Issue, Decision, Action, and Request Changes) record entries for a demand

RIDAC is an acronym for Risk, Issue, Decision, Action, and Request Changes records. Create a risk record for your demand that you can convert to other records during the demand life cycle to track issues and to avoid having to manually copy relevant details in related records. This conversion and association of records helps you analyze and identify patterns, trends, and probable resolution for planning future demands.

As a demand progresses through the demand life cycle, a risk might result in an issue or a new issue might occur. Once you have a risk record, you convert that record into related records such as issues, actions, or decisions. The ability to convert records provides you with the following advantages:

- Ability to create related records without having to repeatedly manually enter the relevant information.
- Helps you analyze and identify patterns, trends, and probable resolution for planning future demands.
- Enables you to view a consolidated list of all RIDAC records using the View RIDAC related link on the Demand form.

Consider the following points before converting or associating RIDAC records:

- You can convert one record to another only in the RIDAC sequence. For example, you can convert a risk to an issue, decision, action, or request change but you cannot convert an issue to a risk or a decision to an issue. The following diagram illustrates the RIDAC process flow.

![RIDAC process flow diagram]

- You can convert one record into multiple RIDAC records. For example, you can create multiple issue records from one risk record.
- You can associate one record with multiple different records. For example, you can link one issue record to multiple different risk, decision, action, or request change records. For more information, see Associate existing RIDAC (risks, issues, actions, decisions, and request changes) records for a demand.
**Add risks for a demand**

Add a risk to a demand to identify, analyze, prioritize, plan, and track a risk during any phase of the demand life cycle. Assess potential problems and the severity of their impact to take informed decisions about the demand.

Role required: it_demand_manager

A risk is any uncertain event that can potentially impact the success or outcome of a demand. For example, an incorrect estimate of factors like financial outlay or resource assignments can cause schedule slippage. Another example of a risk is a change in demand requirements. Recording risks ensures that decision makers have all relevant information when assessing a demand's progress.

1. Navigate to Demand > Demands > All.
2. Select the demand to which you want to add risks.
3. From the Risks related list, click New.

**Risk form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>System-generated ID number with a configurable prefix.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the risk. All new risks are created in the Pending state.</td>
</tr>
<tr>
<td></td>
<td>The available states are: Pending, Open, Work in Progress, Closed Complete,</td>
</tr>
<tr>
<td></td>
<td>Closed Incomplete, and Closed Skipped</td>
</tr>
<tr>
<td>Risk status</td>
<td>Status of the risk. The available options are: Pending, Achieved, Not</td>
</tr>
<tr>
<td></td>
<td>Achieved, Avoid, Mitigate, Transfer, and Accept.</td>
</tr>
<tr>
<td>Probability</td>
<td>The likelihood that the event described in the risk will occur. The</td>
</tr>
<tr>
<td></td>
<td>available options are: Absolute, High, Moderate, and Low</td>
</tr>
<tr>
<td>Impact</td>
<td>Impact of the risk event on the outcome of the demand.</td>
</tr>
<tr>
<td>Estimated cost</td>
<td>Estimated cost the risk event generates.</td>
</tr>
<tr>
<td>Risk rank</td>
<td>A value and color assigned to the risk. This value is calculated using risk</td>
</tr>
<tr>
<td></td>
<td>probability and impact. You can configure the color and value using</td>
</tr>
<tr>
<td></td>
<td>Risk Value Lookup. For more information, see Configure custom Risk rank</td>
</tr>
<tr>
<td></td>
<td>and Risk value for a demand.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Primary resource assigned to work on the risk.</td>
</tr>
<tr>
<td>Risk value</td>
<td>A value calculated from Risk Value Lookup. For more information see,</td>
</tr>
<tr>
<td></td>
<td>Configure custom Risk rank and Risk value for a demand.</td>
</tr>
<tr>
<td>Due date</td>
<td>Requested date for the assigned resource to resolve the risk or the date</td>
</tr>
<tr>
<td></td>
<td>on which the risk must be closed or addressed if not assigned to any</td>
</tr>
<tr>
<td></td>
<td>resource.</td>
</tr>
<tr>
<td>Task</td>
<td>Demand to which this risk belongs.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the event and its potential impact on the success</td>
</tr>
<tr>
<td></td>
<td>of the demand.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>Description</td>
<td>Details of the event and its potential impact.</td>
</tr>
<tr>
<td>Mitigation plan</td>
<td>Cost generated by the risk event. This information gets added when and if the event occurs.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Brief description of efforts taken to mitigate the risk.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

- Convert an existing risk to an issue, decision, action, or request change and close the risk. For more information, see Convert one RIDAC (Risk, Issue, Decision, Action, and Request Change) record to another for a demand.
- Associate the risk with existing issues so you can track dependencies and recognize trends for future. For more information, see Associate existing RIDAC (risks, issues, actions, decisions, and request changes) records for a demand.

**Configure custom Risk rank and Risk value for a demand**

Configure custom risk rank and value scores (such as High-Medium, Medium-Low, or Absolute-Low) to rate the impact and probability factors for a risk.

**Role required:** pps_admin

Use the Risk Value Lookup module to set up the risk rank and risk value for a specific combination of risk impact and probability. The system uses these values to determine the degree of risk (Absolute, High, Medium, Low) based on the impact and probability factors of a risk.

The value in the **Probability** field is multiplied by the value of the **Impact** field to generate the values for the **Risk rank** and corresponding **Risk value** in the Risk form.

By default, you can use the following impact, value, and probability scores for a risk to create a risk rank and risk value score:

- Absolute
- Low
- Medium or Moderate
- High

For example, a risk might have high probability and medium impact but you might want to consider it as an overall low risk for the demand. In that case, you would configure the Risk Value Matcher form with the following values:

- Impact = 2 Medium
- Risk Rank Color = Green
- Probability = High
- Probability Number = 1
- Risk Value = 3 Low
The following image illustrates the results of this example on the Risk form.

1. Navigate to **Project Administration** > **Settings** > **Risk Value Lookup**.
2. Click **New**.
3. On the form, fill in the fields.

### Risk Value Matcher form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impact</td>
<td>Impact value of the risk. The default values are:</td>
</tr>
<tr>
<td></td>
<td>• 1 = High</td>
</tr>
<tr>
<td></td>
<td>• 2 = Medium</td>
</tr>
<tr>
<td></td>
<td>• 3 = Low</td>
</tr>
<tr>
<td>Application</td>
<td>The application to which these risk values belong.</td>
</tr>
<tr>
<td>Risk Rank Color</td>
<td>Color to indicate the severity of the risk.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip:</strong> You can enter variations of a color to differentiate between risks with similar impact and probability values. For example, you could enter <code>lightgreen</code> to indicate a low-severity risk.</td>
</tr>
<tr>
<td>Risk Value</td>
<td>The value for the specified risk impact and probability combination.</td>
</tr>
<tr>
<td></td>
<td>The options are: High, Medium, and Low.</td>
</tr>
<tr>
<td></td>
<td>This value is displayed in the <strong>Risk value</strong> field of the Risk form.</td>
</tr>
</tbody>
</table>
Add issues for a demand
Add an issue to a demand to escalate a risk or to track an unexpected problem such as a technical malfunction or resource unavailability that occurs during any phase of the demand life cycle. If the issue remains unresolved, unnecessary conflicts, delays, or even a failure can occur.

Role required: it_demand_manager

1. Navigate to Demand > Demands > All.
2. Select the demand to which you want to add an issue.
3. From the Issues related list, click New.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>System-generated ID number with a configurable prefix.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the issue. All new issue records are created in the Open state. The available states are: Pending, Open, Work in Progress, Closed Complete, Closed Incomplete, and Closed Skipped</td>
</tr>
<tr>
<td>Priority</td>
<td>Urgency of resolving or managing the issue based on possible impact.</td>
</tr>
<tr>
<td>Estimated cost</td>
<td>Estimated cost the issue generates.</td>
</tr>
<tr>
<td>Impact</td>
<td>Impact on the outcome of the demand if the issue remains unresolved.</td>
</tr>
<tr>
<td>Due date</td>
<td>Requested date for the assigned resource to resolve the issue or the date on which the issue must be closed or addressed if not assigned to any resource.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Primary resource assigned to work on the issue resolution.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Parent</td>
<td>Demand to which this issue belongs.</td>
</tr>
</tbody>
</table>
| Short description | Brief description of the issue and its potential impact on the success of the demand.  
As you start typing the title for your issue, related issues that potentially match your issue are displayed.  
Click the suggestion icon ( ) to select from the list of predefined issue descriptions. |
| Description | Details of the issue and its potential impact.                                                                                               |
| Work notes  | Information to record and track the work accomplished for resolving the issue.                                                               |

5. Optional: Search in the knowledge base for any article related to the issue.
   a) Click the search knowledge icon ( ).
   b) If you find relevant articles, click the title of an article to view its content.
   c) If you want to include the content of the article in the issue, click Attach to Issue.
      The article content is copied in to the Description field of the Issue form. You can modify the text if necessary.

6. Click Submit.

   • Convert an existing issue to decision, action, or request change and close the issue. For more information, see Convert one RIDAC (Risk, Issue, Decision, Action, and Request Change) record to another for a demand.
   • Associate the issue with your existing risks so you can track dependencies and recognize trends for future. For more information, see Associate existing RIDAC (risks, issues, actions, decisions, and request changes) records for a demand.

Add decisions for a demand
As a demand manager, develop a plan to manage risks and issues proactively with solutions. Add the solution for a risk or issue to a demand in the form of a decision. You can also convert a risk or an issue to a decision or a decision to an action or a request change.

Role required: it_demand_manager

1. Navigate to Demand > Demands > All.
2. Select the demand to which you want to add a decision.
3. From the Decisions related list, click New.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>System-generated ID number with a configurable prefix.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the decision. All new decision records are created with Open state. The available states are: Pending, Open, Work in Progress, Closed Complete, Closed Incomplete, and Closed Skipped</td>
</tr>
<tr>
<td>Priority</td>
<td>Urgency of approving or implementing the decision based on possible impact.</td>
</tr>
<tr>
<td>Decision status</td>
<td>Status of the decision. The available options are: Pending, Approved, and Rejected.</td>
</tr>
<tr>
<td>Impact</td>
<td>Impact on the outcome of the demand if you do not implement the decision.</td>
</tr>
<tr>
<td>Approval required</td>
<td>Option for determining whether approval of the decision is required.</td>
</tr>
<tr>
<td>Estimated Cost</td>
<td>Estimated cost of implementing the decision.</td>
</tr>
<tr>
<td>Due date</td>
<td>Requested date on which the decision must be approved or implemented.</td>
</tr>
<tr>
<td>Requester</td>
<td>Person requesting the decision. The default value is the name of the user creating the decision record.</td>
</tr>
<tr>
<td>Parent</td>
<td>Demand number to which this decision belongs.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the decision such as what the decision is about, who made it, what it affects, and the decision outcome.</td>
</tr>
<tr>
<td></td>
<td>As you start typing the title for your decision, related decisions that potentially match your decision are displayed.</td>
</tr>
<tr>
<td></td>
<td>Click the Suggestion icon ( ) to select a description from the list of predefined decision descriptions.</td>
</tr>
<tr>
<td>Description</td>
<td>Details of the decision and its potential impact.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Information to record and track the status of decision implementation or approvals.</td>
</tr>
</tbody>
</table>

5. Optional: Search in the knowledge base for any article related to the decision.
   a) Click the search knowledge icon ( ).
   b) If you find relevant articles, click the title of an article to view its content.
   c) If you want to include the content of the article in the issue, click Attach to Decision. The article content is copied in to the Description field of the Decision form. You can modify the text if necessary.

6. Click Submit.
• Convert a decision to an action or request change and close the decision. For more information, see Convert one RIDAC (Risk, Issue, Decision, Action, and Request Change) record to another for a demand.
• Associate the decision with your existing issues and risks so you can track dependencies and recognize trends for future. For more information, see Associate existing RIDAC (risks, issues, actions, decisions, and request changes) records for a demand.

Add actions for a demand
Add actions that are required for resolving an issue or risk for a demand. You can also convert a risk, issue, or decision to an action based on your analysis and plan for resolution of a risk or issue.

Role required: it_demand_manager
After analyzing the risks and issues and taking a decision on how to manage those risks and issues, add an action for resolving the risk or issue to a demand.

1. Navigate to Demand > Demands > All.
2. Select the demand to which you want to add an action.
3. From the Actions related list, click New.
4. On the Action form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>System-generated number with a configurable prefix.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the action. All new action records are created with the state set to Open. The available states are: Pending, Open, Work in Progress, Closed Complete, Closed Incomplete, and Closed Skipped</td>
</tr>
<tr>
<td>Priority</td>
<td>Urgency for implementing or approving the action based on impact.</td>
</tr>
<tr>
<td>Estimated Cost</td>
<td>Estimated cost the action generates.</td>
</tr>
<tr>
<td>Impact</td>
<td>The impact on the outcome of the demand if you do not implement the action.</td>
</tr>
<tr>
<td>Approval</td>
<td>Status of approval from the stakeholders for the action. The available options are: Not Yet Requested, Requested, Approved, and Rejected.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Primary resource assigned to implement the action.</td>
</tr>
<tr>
<td>Due date</td>
<td>Requested date on which the action must be approved or implemented.</td>
</tr>
<tr>
<td>Parent</td>
<td>The demand to which this action belongs.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the action such as what the action entails, how to implement the action, who it affects, and the action outcome. As you start typing the title for your action, the related actions that potentially match your action title appear. Click the Suggestion icon ( ) to select a description from the list of predefined actions.</td>
</tr>
<tr>
<td>Description</td>
<td>Details of the action and its potential impact.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Information about the action. Add work notes to communicate about the status of action approval, rejection, or implementation with other users.</td>
</tr>
</tbody>
</table>

5. Optional: If the action requires approval from other stakeholders, request approval with a due date using the Approval and Due date fields.

6. Click Submit.

- Convert an action to a request change and close the action. For more information, see Convert one RIDAC (Risk, Issue, Decision, Action, and Request Change) record to another for a demand.
- Associate the action with your existing risk, issue, and decision records so you can track dependencies and recognize trends for future. For more information, see Associate existing RIDAC (risks, issues, actions, decisions, and request changes) records for a demand.

Add Request Changes to a demand
As a demand manager, you might create a request change as the outcome of the action taken to resolve an issue or mitigate a risk. The request change might result in changing the demand's scope, resource requirement, cost, or schedule to minimize the impact of a risk or issue.

Role required: it_demand_manager

1. Navigate to Demand > Demands > All.
2. Select the demand to which you want to add a request change.
3. From the Request Changes related list, click New.
4. On the Request Change form, fill in the fields.

Request Change form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>System-generated ID number with a configurable prefix.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the request change. All new request change records are created in the Open state. The available states are: Pending, Open, Work in Progress, Closed Complete, Closed Incomplete, and Closed Skipped</td>
</tr>
<tr>
<td>Priority</td>
<td>Urgency for approving the requested changes based on impact.</td>
</tr>
<tr>
<td>Estimated Cost</td>
<td>Estimated cost the requested changes generate.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Impact</td>
<td>Impact on the outcome of the demand if you do not approve the requested changes.</td>
</tr>
<tr>
<td>Approval</td>
<td>Status of approval from the stakeholders for the requested changes.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Primary resource assigned to work on the request change.</td>
</tr>
<tr>
<td>Due date</td>
<td>Requested date to complete the request change.</td>
</tr>
<tr>
<td>Category</td>
<td>Entity for which you are creating the request change. The options are: Resource, Scope, Cost, and Schedule.</td>
</tr>
<tr>
<td>Parent</td>
<td>Demand to which this request change belongs.</td>
</tr>
<tr>
<td>Title</td>
<td>Title for the change request.</td>
</tr>
<tr>
<td>Description</td>
<td>Details of the request change and its potential impact.</td>
</tr>
<tr>
<td>Business Justification</td>
<td>Reason for requesting the proposed change in the demand and its impact on the business.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Additional information to indicate progress on the demand request change.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

Associate the request change with your existing risk, issue, decision, and action records so you can track dependencies and recognize trends for future. For more information, see Associate existing RIDAC (risks, issues, actions, decisions, and request changes) records for a demand

**Convert one RIDAC (Risk, Issue, Decision, Action, and Request Change) record to another for a demand**

Convert one RIDAC record (risk, issue, action, decision, and request changes) to another, in that order, to retain the record information instead of having to create a new record manually and to more easily track the issue.

Role required: it_demand_manager

When you convert a RIDAC record to another record, the values for the **Short description**, **Requester**, and **Assigned to** fields are carried forward.

You can also specify to close the parent record on creation of the new record instead of manually closing the parent record.

You can also view the consolidated list of all RIDAC records using the **View RIDAC** related link on the Demand form and **View RIDAC** in the application navigator of the Demand module.

1. Navigate to **Demand > Demands > All**.
2. Select the demand for which you want to convert a risk, issue, decision, action, or request change record to another RIDAC record.
3. From the Demand form related list, select the risk, issue, decision, action, or request change record to open the form view.
4. Click the **Convert to RIDAC** related link on the form.
5. Optional: On the Convert dialog box, from the Select task type list, select the RIDAC record to which you want to convert the selected record.
   For example, if you wanted to convert a risk to an issue, you would select **Issue**.
6. Optional: Modify the text in the **Short description** field, which is copied from the parent record.
7. Optional: Change the default assignment copied from the parent record in the Assigned to field by clicking the lookup icon ( ) and selecting a different user.

8. Optional: If you want to close the parent RIDAC record on creation of the new record, select the close parent record option.
   The label of the close parent record option changes depending on the parent record type. For example, if the parent record is Risk and you are converting it to an issue record, the close record option would appear as Close Risk.

9. Click OK.

Associate existing RIDAC (risks, issues, actions, decisions, and request changes) records for a demand
Link existing RIDAC records (risks, issues, actions, decisions, and request changes) to one another for your demand. Associating RIDAC records with each other enables you to keep a record of risks or issues and their outcome for analysis at demand closure and planning. It also helps to track the risks and issues throughout the demand life cycle.

Role required: it_demand_manager

You can associate one record with multiple different records. For example, you can link one issue record to multiple risk, decision, action, or request change records.

1. Navigate to Demand > Demands > All.
2. Select the demand for which you want to associate one RIDAC entry to another.
3. In the Demand form related list, select the RIDAC record.
4. On the form, click the Associate RIDAC related link.
5. In the Associate dialog box, from the Select type list, select the RIDAC record to which you want to associate the selected record.
   For example, if you wanted to associate a risk to an issue, you would select Issue.
6. Select the record number to which you want to associate the selected record from the Associate to list.
   For example, if you wanted to associate the selected risk to issue (ISU0010003), you would select ISU0010003.
7. Click OK.

Reset a demand to Draft state

A demand can be moved back to Draft state, if required.

Role required: it_demand_manager

A demand can be set back to Draft state from any of the demand states or until an artifact such as project, enhancement, defect, or change is created from the demand.

1. Navigate to Demand > Demands > All.
2. Open the required demand form.
3. Click Reset to Draft.
   A confirmation message appears if there are:
   - Active assessments pending with stakeholders, or
   - Resource plans in Requested, Confirmed, or Allocated state
4. Select the check box to re-plan the allocated resource plans that have no actual hours reported.
5. Click OK.
   - The demand is moved to Draft state.
   - All the score values in Assessment Data tab are reset to default.
• All active assessments for the demand are canceled. New assessments are triggered when the demand moves to the Screening state and if the **Assessment Required** field on the demand form is set to true.
• All associated resource plans with no actual hours reported are moved to Planning state.

### Delete demands

Demands can be deleted only while in the **Pending** state.

Role required: it_demand_manager or it_demand_user

When you delete a demand, all data related to the demand, such as risks, demand tasks, requirements, and decisions are deleted, but the stakeholders are not deleted from the stakeholder register [dmn_stakeholders_register] table.

If a project is already created from a demand, its reference is removed from the project along with the data related to the demand, however, the project is not deleted from the database.

To delete a demand:

1. Navigate to **Demand > Demands > All**.
2. Do:
   - Click the demand to open the demand form and then click **Delete**.
   - Select the check box next to the demand and then select **Delete** from the **Actions** choice list.

### Move and resize a demand

As the demand manager, you can move and resize bubbles in the bubble chart.

Moving and resizing bubbles in the bubble chart updates the corresponding values for the demands in the list view.

• Clicking and dragging a bubble left or right along the horizontal axis decreases or increases the risk of the demand. The new risk for the demand is updated in the **Risk** column.
• Clicking and dragging a bubble up or down along the vertical or Y axis increases or decreases the value of the demand. The new value for the demand is updated in the **Value** column.
• Clicking a bubble opens a sizing window where you can increase or decrease the size of the bubble. The new size of the demand is updated in the **Size** column.
Stage fields

The Stage field on the Ideas list displays the current state of an idea as it moves through the demand life cycle. The current state includes from an idea to a demand and then to the resulting project, enhancement, change, or defect.

The result of an idea depends on the initial settings in the Category and Type fields on the Demand form. The Stage field also appears on the Demands list. The Stage field is a display only field and cannot be searched or sorted.

A new idea is created in the Submitted state. An accepted idea is updated to the Accepted state and a deferred idea is updated to the Skipped state. When a demand is closed, the associated idea is marked as Complete.

Pointing to the Stage field displays a pop-up window that shows the progression of the idea along with the value of the State field for each step in the progression.

- **Idea**: if an idea is being evaluated, the pop-up window displays the current state of the idea.
- **Demand**: if an idea is promoted to a demand, the pop-up window displays the current state of the demand as well as the idea.
- **Project, Enhancement, Change, or Defect**: if a demand is accepted, the pop-up window displays the current state of the resulting project, enhancement, change, or defect in addition to the demand and idea.

![Idea Stage Summary pop-up window](image)

Composite fields

A composite field combines information from two fields in a table to form a single field.

For example, the Task field on the Project Tasks list displays the short description and the project task number. The short description appears above the project task number. The project task number appears and is a link to the Project Task form.
Use a composite field

- Editing a composite field changes the short description. Editing the short description changes the composite field.
- Sorting on a composite field is based only on the short description and not the number.
- Searching on a composite field is enabled for both the short description and the number:
  - To search by the number using the list header, enter an asterisk (*) before the search term. For example, *PRJTASK0010016.
  - To search by the number using the filter, create a condition similar to: [Task] [contains] [PRJTASK0010016].

Domain separation and Demand Management

This is an overview of domain separation as it pertains to Demand Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Support level: Basic

- Business logic: Ensure that data goes into the proper domain for the application’s service provider use cases.
- The application supports domain separation at run time. This includes domain separation from the user interface, cache keys, reporting, rollups, and aggregations.
- The owner of the instance must set up the application to function across multiple tenants.

Use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.
Domain separation in Service Portfolio Management

This is an overview of domain separation and Service Portfolio Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Support level: Basic*

The support level is Basic but has some exceptions or special conditions.

- Business logic: Ensure data goes into the proper domain for the application’s service provider (SP) use cases.
- In the application, the user interface, cache keys, reporting, rollups, aggregations, and so on, all use domain at production run time.
- The owner of the instance needs to be able to set up the application to function across multiple tenants.

Use case: When an SP uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

Overview

*All components of Service Portfolio Management (SPM) and Service Owner Workspace (SOW) are domain-separated in releases of New York and forward. If using Financial Management for the SPM plugin for estimated spend, there can be only one fiscal calendar defined per instance. When this plugin is activated, there can be only one approach for service offering cost modeling per instance (using either the Financial Management engine or local data. Different domains cannot choose their own spend model.

Set up Demand Management

Perform these tasks to set up Demand Management.

Before using Demand Management, PPS admin performs several setup tasks.

Plan for Demand Management

Consider the following when planning to use the demand management application.

- Roles: Determine who has the demand manager [it_demand_manager] and demand user [it_demand_user] roles.
- Portfolios: Determine how you want to group or categorize demands, and then have a user with the it_project_manager role create portfolios based on those groupings.
- Stakeholders: Identify individuals who have the appropriate domain knowledge to evaluate demands related to each portfolio. Then, make them stakeholders for that portfolio and identify if they are to receive assessments or be demand approvers. Changes made to Approver or Assessment recipient in the demand record update the Demand Stakeholder [dmn_m2m_demand_stakeholder] table.
- Assessments: Consider using assessments to facilitate the information gathering process. Define metric categories and assessment metrics required to develop and distribute assessments to the appropriate audience. The demand managers can decide if the assessment should be triggered for a demand using the Assessment Required field on the demand form. Assessments are automatically sent to the Assessment recipient portfolio stakeholders once the demand is moved into the screening state. An email is also sent to the stakeholders to notify about the assigned assessment.
- Resource plans: Consider developing resource plans to help the organization understand the time and resource costs associated with the demand. Resource plans require that the Resource Management application is active. Resource plans created for approved demands create duplicate resource plans in the project record. Any resource plans attached to the demand propagate to the project.
• Enhancement and defect requests: Determine if you need the ability to manage enhancement and defect requests as demands. This functionality requires that the Agile Development is active.

**Populate the stakeholder registry**

Add users to the stakeholder registry so that demand and project management can automatically populate the stakeholder list when a user creates a demand or project.

Role required: it_pps_admin

1. Navigate to **Project Administration > Settings > Stakeholders**.
   You can also scroll to the **Stakeholders** related list on the Demand or Project form and click **New** to create a record.
2. Click **New** to create a new record.
3. On the stakeholder register form, fill in the fields.

<table>
<thead>
<tr>
<th><strong>Stakeholder Register Form fields</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Number</td>
</tr>
<tr>
<td>User</td>
</tr>
<tr>
<td>Portfolio</td>
</tr>
<tr>
<td>Level of Interest</td>
</tr>
<tr>
<td>Assessment recipient</td>
</tr>
<tr>
<td>Approver</td>
</tr>
<tr>
<td>Influence</td>
</tr>
<tr>
<td>Engagement</td>
</tr>
<tr>
<td>Function</td>
</tr>
</tbody>
</table>

**Note:** When adding a user to the stakeholder registry, the combination of the user and the assigned portfolio must be unique. However, there can be more records for the same user but with different portfolio.

**View an assessment metric category**

View assessment metric categories that are used with assessment metric types and assessment metrics in generating the bubble charts on the Demand Workbench. The bubble charts help the demand managers to visually assess the demands.
Role required: it_pps_admin

The Demand Management application comes with an assessment metric type named **Demand**, five default assessment metric categories, and assessment metrics.

1. Navigate to **Project Administration > Settings > Assessments Metric Categories**.
2. Open an assessment metric category to review it.

The following default assessment metric categories are available with the Demand Management:

**Demand assessment metric categories**

<table>
<thead>
<tr>
<th>Assessment metric category</th>
<th>Data source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>T-Shirt size field on the Demand form.</td>
<td>Assesses demand size relative to the size of other demands.</td>
</tr>
<tr>
<td>Strategic Alignment</td>
<td><strong>Rating</strong> field in the assessment category result for the Strategic Alignment metric category.</td>
<td>Assesses how closely the demand aligns with strategic goals of the organization compared to other demands.</td>
</tr>
<tr>
<td>Risk</td>
<td><strong>Rating</strong> field in the assessment category result for the Risk metric category.</td>
<td>Assesses demand risks compared to other demands.</td>
</tr>
<tr>
<td>ROI</td>
<td><strong>Impact</strong> and <strong>Financial return</strong> fields on the Demand form.</td>
<td>Assesses demand return on investment compared to other demands.</td>
</tr>
<tr>
<td>Cost</td>
<td><strong>Labor costs</strong>, <strong>Capital expense</strong>, and <strong>Operating expense</strong> fields on the Demand form.</td>
<td>Assesses demand cost compared to other demands.</td>
</tr>
</tbody>
</table>

**Configure a widget for the financial metrics of a demand**

Configure a widget to view and track the financial metrics of a demand on the Demand Financials page.

Role required: pps_admin

1. Navigate to **Project Administration > Widgets**.
2. Click **New**.
3. On the form, fill in the fields.

**Widget form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the widget.</td>
</tr>
<tr>
<td>Scripted</td>
<td>Option for indicating the value on the widget is from a code script.</td>
</tr>
<tr>
<td></td>
<td>By default, this option is selected and is read-only.</td>
</tr>
<tr>
<td>Show Label</td>
<td>Option for displaying either the label or the color indicator.</td>
</tr>
<tr>
<td></td>
<td>If you clear the check box, the <strong>Color</strong> field appears and you can set the color.</td>
</tr>
</tbody>
</table>
### Field

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Option for indicating the status of the widget. Only active widgets are shown on the Demand Financials page.</td>
</tr>
<tr>
<td>Parent widget</td>
<td>Widget that is the parent of the current widget. The current widget displays in the Child widgets related list of the selected widget. You can add a maximum of three child widgets for a parent widget.</td>
</tr>
<tr>
<td>Formatter required</td>
<td>Option for specifying whether a currency formatter is required for the widget.</td>
</tr>
<tr>
<td>Script</td>
<td>Code script that returns a requested metric value that is displayed on the widget. In the script, use the context and filter objects. The context object contains all of the demand financial fields, such as total_costs, irr_value, and capital_budget. The following sample script returns the capital budget metric value of a demand to appear on the widget.</td>
</tr>
</tbody>
</table>

```javascript
var context = JSON.parse(context);
var filter = context.filters;
var now_GR = new GlideRecord('dmn_demand');
now_GR.addEncodedQuery(filter['dmn_demand']);
now_GR.query();
if(now_GR.next())
  now_GR.getValue('capital_budget');
```

| Short description | Description of the widget. |

### Associate the widget to the Demand table.

**Associate a widget to the Demand table**

After you configure a widget, associate it with the Demand table to show the financial data of a demand.

You need to configure a widget before you can associate it with the Demand [dmn_demand] table.

Role required: pps_admin

1. Navigate to **Project Administration > Widgets**.
2. Open a widget to associate with the Demand table.
3. In the Widget associations related list, click **New**.
4. On the form, fill in the fields.

**Widget association form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Association ID</td>
<td>Record to associate to the widget. To access the relevant records, you must select the Tables [sys_db_objects] table in the <strong>Table name</strong> list and the Demand [dmn_demand] table in the <strong>Document</strong> list.</td>
</tr>
<tr>
<td>Association table</td>
<td>Table to associate to the widget. You must select the Tables [sys_db_objects] table from the list.</td>
</tr>
<tr>
<td>Widget</td>
<td>Unique name of the widget.</td>
</tr>
<tr>
<td>Order</td>
<td>Position of the widget in relation to other widgets on the Demand Financials page. Widgets appear in numeric order, with the smallest number listed first.</td>
</tr>
<tr>
<td>Display on card</td>
<td>Option to display the widget on the Demand Financials page.</td>
</tr>
<tr>
<td>Include by default</td>
<td>Option to show the widget by default on the Demand Financials page.</td>
</tr>
</tbody>
</table>

**Configure demand workbench**

Update the demand workbench to configure parameters such as bubble chart.

Role required: it_pps_admin

You can configure the parameters of the demand workbench provided with the base system.

Bubble charts are useful for comparing demands based on common metrics such as risk rating, return on investment, and cost. Decision makers can use bubble charts when considering which demands to approve or reject.

1. Navigate to **Project Administration > Settings > Workbench Config - Demand**.
2. Open the **Demand Workbench** record.
3. Update the required settings and click **Update**.

**Innovation Management**

The Ideas application enables you to gather and evaluate ideas efficiently, and to quickly identify and process the ideas with the greatest potential for implementation.

The Idea Portal accelerates and organizes idea gathering, evaluation, selection, and execution. The idea manager or demand manager evaluates submitted ideas and promotes accepted ideas to demands, epics, features, or stories.

**Maintain separate data storage and control access**

You can use the Idea module to do the following:
• Store ideas and categories belonging to different departments, products, or business units separately.
• Store and organize ideas, enable voting, and, if your organization is large, you can configure different portal pages with unique sets of categories, for example, for HR, IT, and Support.
• Control access, allowing only the users of a specific business unit or department to submit and view ideas belonging to a specific category through the Idea Portal by creating access-control lists in the table that you want to use for categories. For example, if you do not want users outside the Payroll department to view the ideas associated with the category Salary, create ACLs with read access, at least, to the employees of Payroll department in the parent table that is used to derive the category Salary. The ACLs restrict the employees outside the Payroll department from viewing the ideas associated with the category Salary. For more information, see Create an Idea module.

Organize idea submissions by using categories

An idea category represents a theme for organizing idea submissions. All ideas submitted through the Idea Portal must be associated with at least one idea category. You can use values from an existing table or create new idea categories for organizing your idea. Users select one or more idea categories, configured by an admin, to associate with their idea when they submit it. For more information, see Create an Idea module, and Idea category configuration.

Submit, view, and subscribe to ideas

The Idea Portal is where you share your product, feature, change, or enhancement ideas. Submit your ideas, view and subscribe to the ideas of other users, and track the progress of a subscribed idea. For more information, see View, filter, and sort ideas and Collaborate on ideas.

Collaborate on ideas

Collaborate on an idea with other submitters and stakeholders. Add comments or reply to comments to request more information or answer questions. Vote for the ideas you would like to see developed. For more information see, Collaborate on ideas.

Manage and evaluate ideas

The idea manager reviews submitted ideas and, if necessary, requests more information, and then chooses to accept or reject the idea. The number of votes on an idea helps in assessing the popularity of and demand for the idea. For more information, see Manage ideas.

Convert the accepted ideas to a demand, epic, story, or feature based on how you would like to execute your idea. Use relevant options such as Epic, SAFe epic, or Improvement initiative based on the plugins installed such as PPM Standard, Agile Development 2.0 and Scaled Agile Framework (SAFe). After creating a demand or a project, change the state of the idea to track its status during different stages of development. For more information, see Evaluate an idea.
Idea workflow

Migrating from the legacy Ideas application to Idea Portal

If you are upgrading to the Paris release, complete the migration tasks after the upgrade to start using the new Idea Portal.

Review the following information and make any necessary changes to your configuration:

Idea States

The new Idea Portal provides new idea states such as Completed, Under Review, and In Backlog, which are mapped with your existing idea states. The following table lists any changes to the existing idea states and the equivalent new states with their values.
### Legacy Ideas application vs. Idea Portal

<table>
<thead>
<tr>
<th>Idea State</th>
<th>Value</th>
<th>Idea State</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft</td>
<td>-5</td>
<td>Draft</td>
<td>-5</td>
</tr>
<tr>
<td>Submitted</td>
<td>1</td>
<td>Submitted</td>
<td>1</td>
</tr>
<tr>
<td>NA</td>
<td>NA</td>
<td>Under Review</td>
<td>-1</td>
</tr>
<tr>
<td>NA</td>
<td>NA</td>
<td>Need more information</td>
<td>-2</td>
</tr>
<tr>
<td>Accepted</td>
<td>2</td>
<td>In Backlog</td>
<td>2</td>
</tr>
<tr>
<td>NA</td>
<td>NA</td>
<td>Planned</td>
<td>4</td>
</tr>
<tr>
<td>NA</td>
<td>NA</td>
<td>In Development</td>
<td>5</td>
</tr>
<tr>
<td>Closed complete</td>
<td>3</td>
<td>Completed</td>
<td>3</td>
</tr>
<tr>
<td>Closed skipped</td>
<td>7</td>
<td>Unlikely to Implement</td>
<td>7</td>
</tr>
<tr>
<td>NA</td>
<td>NA</td>
<td>Duplicate</td>
<td>8</td>
</tr>
<tr>
<td>NA</td>
<td>NA</td>
<td>Already Exists</td>
<td>9</td>
</tr>
</tbody>
</table>

Starting with the Paris release, idea states are stored in and retrieved from the `im_idea_core` table. You can continue to use your existing idea states along with the new idea states. However, if you want to use only these new states for managing your ideas, navigate to the Choice `[sys_choice]` table and delete the old idea states.

### Idea categories

Organize your ideas using categories, for example, to group ideas that are relevant to a particular product, department, or business unit. If your existing ideas are not associated with any category, create new categories or select an existing table to define categories to which you can map your ideas. The Ideas application also installs a set of default new categories to which you can associate your existing ideas.

If your ideas are already associated with categories and you want to use the new categories, you can map your existing idea categories to the default new categories. You then write and use a script to create m2m mapping between existing ideas and categories.

**Note:** You must map an existing idea with appropriate categories for your ideas to appear in the Idea Portal.

### Converting ideas to demands or project, stories, initiatives, and epics

You can convert an idea into work entities other than demands. The **Create Task** button enables you to convert an idea into a project, epic, or story as well as a demand becomes available in the Idea form.

You must have the required Agile plugins Agile Development 2.0 and Scaled Agile Framework (SAFe) and Continual Improvement Management installed to view these options.

If you want to allow conversion of ideas only to a demand, disable the **Create Task** button and continue using the **Accept** button or disable the **Accept** and **Defer** buttons to use other options. For more information see, Using the form designer.
Business rules

Review the existing business rules in the idea table. Set the business rules that you don't want to apply as False.

Navigation for legacy Idea application

To encourage your users to submit ideas through the new Idea Portal, remove navigation for old Idea application from the application menu and deactivate the Submit an Idea option from the Service Catalog. For more information see, Enable or disable an application menu or module.

Idea Portal administration

Idea Portal enables end users to view, submit, filter, sort, comment, and vote on ideas. Idea managers use the Idea Portal to review, evaluate, collaborate on, and manage ideas. An idea admin configures an Idea module, maps idea categories to the Idea module, and adds navigation for the Idea Portal page.

The Idea Portal retrieves data from the Idea module, therefore, you must configure an Idea module first. Consider configuring separate Idea modules for your product, department, or business unit. Review, plan, and identify the following items before configuring an Idea Portal:

- Idea table
- Idea module
- Idea categories
- Navigation to the Idea Portal page

Complete the following tasks to set up and configure an Idea Portal for your product, department, or business unit:

Create an Idea module

An Idea module defines the ideas and categories that are displayed in the Idea Portal. Create an Idea module to store and group ideas, and define categories based on product, department, or business unit.

- Identify an idea table to store your ideas. Use an existing table or create a new table to extend the Idea [im_idea_core] table.
  
  Use a different idea table for each Idea module. Separate idea tables ensure that ideas for different modules are stored separately.
- Role required: idea_admin


<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module name</td>
<td>Name for the module. Use a name that clearly identifies the entity for which you are creating the module. For example if you are creating a module for your departments, use the department name such as HR, Support, and IT.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module Id</td>
<td>Unique identifier for the module used as a parameter in the Idea Portal URL to direct users. For example, if you use <code>hr</code> as the Module Id, the URL to access the Idea Portal would look like the following example: <code>/idea/?id=ideas_list&amp;sysparm_module_id=hr</code></td>
</tr>
<tr>
<td>Idea table</td>
<td>The table to be used to store ideas. This table must extend the Idea [im_core_idea] table.</td>
</tr>
<tr>
<td>Enable downvote</td>
<td>Option for activating the ability to down-vote an idea. Default: Selected</td>
</tr>
<tr>
<td>Active</td>
<td>Option for activating the idea module. Default: Selected</td>
</tr>
<tr>
<td>Category Limit</td>
<td>The maximum number of categories a user can select while submitting an idea. Default: 5</td>
</tr>
<tr>
<td></td>
<td>This field does not appear by default on the Idea module form so you must add it by personalizing the form.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

Define new idea categories or use an existing table to derive the categories from specified columns and map it with your idea module. For more information see, Configure idea categories.

**Define new idea categories**

Create new idea categories that a user can select to associate with a submitted idea. You can also add custom idea categories.

Role required: idea_admin

The default Idea Category [im_category] table stores the user-defined idea categories.

Define new idea categories if you do not want to use an existing table or if you want to use custom idea categories. Create nested idea categories for defining a hierarchy of the idea categories.

You can use multiple idea categories with an Idea module, however, you can map only one category table with an Idea module. For more information about idea categories, see Organize idea submissions by using categories.

1. Navigate to **Ideas > Idea Category > New**.
2. Fill in the fields on the Idea Category form.

### Idea Category form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category name</td>
<td>Name for the idea category. Use a name that clearly identifies the entity for which you are creating the category list. For example if you are creating a category option for your departments, use the department name such as HR, Support, and IT.</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
Active | Option for activating the idea category. If activated, the idea category appears in the Create an Idea form and the Category list of the Idea Portal. Default: Selected
Module | The module to which this idea category belongs.
Parent | The parent idea category for which this category is a subcategory. For example, to list Department 1 and 2 as subcategories of Department A, select Department A in the Parent field for Department 1 and 2.
Domain | The domain to which the idea category belongs.

3. Click **Submit**.

Map idea categories with your idea module. For more information see, [Configure idea categories](#).

**Configure idea categories**

Map an idea category table with an Idea module to specify the category options listed on the Idea Portal and the Create an Idea form.

- Role required: idea_admin
- Identify the Idea module and idea category table that you want to use.

Configuring idea category with the Idea module is required to fetch the list of categories in the Idea Portal. If you have created static categories, use the Idea Category [im_category] table to configure the mapping between the idea module and idea category table.

Use your existing product or department table to define dynamic idea categories. The dynamic categories are derived from specific columns and fields of the parent table. For more information about idea categories, see [Organize idea submissions by using categories](#).

**Note:** You can map only one category table with an Idea module.

1. Navigate to **Ideas > Idea Category Config > New**.
2. Fill in the fields on the Idea Category Configurations form.

**Idea Category Configurations form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category table</td>
<td>The parent table to derive idea categories from. To use static idea categories, select the default Idea Category [im_category] table. To use dynamic idea categories, select an existing table. For example, to use department names as idea categories, select the table that contains details of all the departments.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category Field</td>
<td>Field from the category table from which to derive the idea category. The corresponding value of this field in the category table is listed in the <strong>Category</strong> field on the Idea Portal. For example, to list department names as category options, set the value of this field to <strong>Name</strong>. The system searches for and fetches the department names from the parent table and lists all the department names as category options.</td>
</tr>
<tr>
<td>Parent Field</td>
<td>If you are using nested idea categories, specify the field in the category table to be used to fetch the parent category. <strong>Note:</strong> Leave this field blank if you are not using nested idea categories. For example, to list Department 1 and 2 as subcategories of Department A, set the value of this field as <strong>Parent</strong>. The system searches for and fetches values from the parent table and lists Department 1 and 2 as subcategories of Department A.</td>
</tr>
<tr>
<td>Module</td>
<td>The Idea module to which this idea category belongs.</td>
</tr>
</tbody>
</table>

3. Create filter conditions to determine the idea categories to be listed on the Idea Portal.

4. Click Submit.

### Idea Portal navigation

Configure the Idea Portal URL to enable access to the Idea Portal from the application navigator.

**Role required:** idea_admin

Enable access to the Idea Portal module using the Application Menus module.

1. Open the **Idea** application menu record and add the Idea Portal to the navigation menu.
   
   For information about how to add Idea Portal to the navigation menu, see Create a module.

2. In the Module form, set the value of the **Link type** field as **URL (from arguments)**. Use the Module Id as a parameter in the URL to specify the Idea module that you want to associate with the Idea Portal. For example, if you created an Idea module for your HR department and used `hr` as the **Module Id**, the URL to access the Idea Portal would be as follows: `/idea/?id=ideas_list&sysparm_module_id=hr`.  

### Predictive Intelligence for Innovation Management

The Predictive Intelligence for Innovation Management capability uses machine-learning algorithms to search and display similar ideas while submitting a new idea.

Predictive Intelligence for Innovation Management has the following benefits:

- Improves the quality of your idea database by avoiding duplicate ideas.
- Suggests related ideas to help you identify similar ideas and merge duplicate ideas.
Solution definitions for Predictive Intelligence for Innovation Management

The solution definitions for Predictive Intelligence for Innovation Management capability are available in the Predictive Intelligence for Ideation plugin (com.snc.innovation_management_ml). For more information about Predictive Intelligence, see Predictive Intelligence.

### Solution Definition for Innovation Management

<table>
<thead>
<tr>
<th>Solution Definition</th>
<th>Solution Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| Similar Ideas       | Similarity    | Suggests related ideas based on the Title and Description fields. You can see the results in the following places:  
- The Related Ideas section on the Create an Idea form when creating an idea in the Idea Portal.  

**Note:** This solution definition is available as a template on instances where the following plugins are active:
- Predictive Intelligence
- PPM Standard (com.snc.financial_planning_pmo)
- Predictive Intelligence for Ideation (com.snc.innovation_management_ml)

---

**Train the similarity solution for Innovation Management to find similar ideas**

Train the Similar Ideas solution definition included within the Predictive Intelligence for Ideation capability to find related ideas when submitting an idea or viewing ideas in the Idea Portal.

Ensure that the Predictive Intelligence plugin (com.glide.platform_ml), PPM Standard plugin (com.snc.financial_planning_pmo), and Predictive Intelligence for Ideation plugin (com.snc.innovation_management_ml) are activated. For more information about Predictive Intelligence, see Predictive Intelligence.

Role required: admin

1. Navigate to Predictive Intelligence > Similarity > Solution Definitions.
2. In the Similarity Definitions list, search for and select the Similar Ideas solution definition (ml_sn_global_similar_ideas).
3. On the Similarity Definition form, verify the default field values for ideas. For more information about the Similarity Definition form fields, see #unique_15.
4. Click Update & Retrain.
5. Open the Similarity Definition form for the Similar Ideas solution definition (ml_sn_global_similar_ideas).
6. In the ML Solutions related list, view the training solution progress in the Progress column.

**Note:** Alternatively, you can click the link for the solution in the Active column. On the ML Solution form, click the Show training progress related link to check the training solution progress.

When the solution is complete, the similar ideas appear in the Related Ideas section on the Create an Idea form and Related Ideas section on the Ideas page in the Idea Portal.
• Review similarity examples: On the Similarity Definition form, in the ML Solutions related list, when Progress is 100%, in the Active column, click the link for the solution. On the ML Solution form, click the Similarity Examples related link to view the Similarity Examples list.

• Update the similarity score threshold: On the ML Solution form, on the Solution Statistics tab, enter the required value in the Similarity Score Threshold field. Right-click the ML Solution form and click Save.

• Test the prediction output for the records: On the ML Solution form, on the Test solution tab, enter your text in the Short description field and the maximum number of expected results in the Top N field, and then click Run test. The results above the similarity score threshold value are displayed.

Idea Portal

The Idea Portal is your central location to collect, curate, and promote ideas into demand, project, epic, or story. It enables integration of key feedback and requests into your product planning and development process.

The Idea Portal enables you to do the following:

• View, submit, vote, and subscribe to ideas.
• Collaborate using comments to discuss and exchange information on ideas.
• Users who submit, comment, or subscribe to an idea receive a notification for any state change, comment, or reply to that idea keeping them informed about its status and progress.
• View the details of an idea and ask or answer questions and exchange information about an idea using comments. Comments maintain a trail of discussion and help to identify key contributors for an idea or reasons for its success and failure.

Idea and demand managers use the Idea Portal to do the following:

• Manage submitted ideas.
• Review and evaluate the submitted ideas and select the ideas that meet their requirements.
• Assess the popularity and demand of an idea from the number of votes.

The selected ideas are converted into tasks for planning and then developed into a new product, feature, or enhancement.

Submit an idea

Submit an idea for a product, feature, enhancement, or change in the Idea Portal for others to vote on. Select categories relevant to the idea and, if useful, attach files to add details.

Role required: None

New ideas are created in the Submitted state. You can edit your submitted idea in the Idea Portal after it has been submitted until the state is changed to Completed.

1. Navigate to Ideas > Idea Portal > Create an Idea.
2. Fill in the fields on the Create an Idea form.

Create an Idea form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Brief description of the idea. As you start typing the title for your idea, the Related Ideas section appears and displays existing ideas that potentially match your idea.</td>
</tr>
</tbody>
</table>
### Field
<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
</tr>
<tr>
<td>Description</td>
</tr>
</tbody>
</table>

3. Optional: If you have attachments related to the idea, click **Add attachments** and attach them.

4. Click **Create**.

### View, filter, and sort ideas

View ideas submitted by you or all submitted ideas. Filter and sort the ideas based on idea state, category, or date.

Role required: None

You can view the following information for an idea:

- Title
- Number of votes
- Name of the submitter
- Age
- Current state
- Category to which the idea belongs.

Navigate to **Ideas > Idea Portal**.

#### My Ideas and All Ideas tab

<table>
<thead>
<tr>
<th>Task</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>View your own submitted ideas.</td>
<td>Navigate to <strong>Idea Portal &gt; My Ideas</strong>.</td>
</tr>
<tr>
<td>View all submitted ideas.</td>
<td>Navigate to <strong>Idea Portal &gt; All Ideas</strong>.</td>
</tr>
<tr>
<td>View details of an idea.</td>
<td>Click the title of the idea.</td>
</tr>
<tr>
<td>Filter the ideas based on the idea state.</td>
<td>Select a state from the State list.</td>
</tr>
<tr>
<td>Filter the ideas based on idea categories.</td>
<td>Select a category from the Category list.</td>
</tr>
<tr>
<td>Sort the ideas based on the most recent ideas, the number of votes, or the date of creation.</td>
<td>Select an option from the Sort by list.</td>
</tr>
</tbody>
</table>

### Collaborate on ideas

Use the comment option to discuss ideas and exchange information about ideas. Up-vote or down-vote an idea to register your level of interest and support for an idea. Subscribe to an idea to track its progress.

Role required: None

You cannot comment and vote for ideas that are in the **Completed**, **Unlikely to implement**, **Duplicate**, or **Already exists** state. The Open (
or Closed

icon indicates whether the idea is open or closed for comments and votes.

1. Navigate to Ideas > Idea Portal.
2. Click the title of an idea to view its details.
3. Perform the following actions to collaborate on a selected idea.

<table>
<thead>
<tr>
<th>Action</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Post a comment</td>
<td>a. Click the comment ( ) icon and enter your comment.</td>
</tr>
<tr>
<td></td>
<td>b. Click Comment to post your comment.</td>
</tr>
<tr>
<td>Reply to a comment</td>
<td>a. Click the Reply ( ) icon and enter your reply.</td>
</tr>
<tr>
<td></td>
<td>b. Click Reply to post your reply.</td>
</tr>
<tr>
<td>Edit or delete your comment</td>
<td>You can edit or delete your comment until the idea reaches the Completed state.</td>
</tr>
<tr>
<td></td>
<td>a. Navigate to the comment.</td>
</tr>
<tr>
<td></td>
<td>b. Click the more options ( ) icon, and then click Edit or Delete.</td>
</tr>
<tr>
<td>Vote on an idea</td>
<td>Votes help in assessing the popularity of and demand for an idea.</td>
</tr>
<tr>
<td></td>
<td>• Click the up-vote icon ( ) to indicate support for the idea.</td>
</tr>
<tr>
<td></td>
<td>• Click the down-vote icon ( ) to indicate dislike of the idea.</td>
</tr>
<tr>
<td>Subscribe to an idea</td>
<td>Click Subscribe.</td>
</tr>
</tbody>
</table>

Manage ideas

As an idea manager, manage submitted ideas by reviewing them, making modifications, or deleting outdated ones, identifying duplicates, and updating and tracking their state.

Role required: idea_manager
Change the state of the idea to reflect its status. Changing the state helps in notifying the idea submitter and subscribers about the progress of the idea.

**Note:** The idea submitter and all the subscribers receive a notification email whenever there is a change in the state of an idea. A notification email is also sent whenever a user comments on an idea or replies to a comment.

1. Navigate to **Ideas > Idea Portal**.
2. Click the title of an idea to view its details.
3. Click the more options icon
   (***), and then click the **Open in platform** option to open the idea in the form view.
4. Perform the following actions to manage an idea:

<table>
<thead>
<tr>
<th>Manage ideas</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Action</strong></td>
</tr>
</tbody>
</table>
| Change the title | If you need to change the title of an idea for more clarity or accuracy, do one of the following actions: |}
| | • Enter a new title in the Title field. |}
| | • Click the Suggestions icon to select from the list of predefined titles. |}
<table>
<thead>
<tr>
<th>Action</th>
<th>Steps</th>
</tr>
</thead>
</table>
| Change the state | Change the state of an idea as it moves through different stages of the life cycle. Changing the state of an idea also helps keep the submitter and subscribers of the idea informed. In the State list, select an appropriate state based on the status and priority of the idea. The following options are available:  
  - **Submitted**: Default state when the idea is submitted.  
  - **Under Review**: Pending review from the idea or demand manager.  
  - **Need more information**: More information is required before the idea is promoted and prioritized for development.  
  - **In Backlog**: Accepted but put on hold for possible development in the future.  
  - **Planned**: Accepted, and a project, demand, epic, feature, or story is created from the idea for current implementation.  
  - **In Development**: Work has started on the task created from the idea.  
  - **Unlikely to implement**: Does not meet requirements, is not feasible, or is not popular. The idea becomes inactive and closed for comments and votes.  
  - **Duplicate**: A similar idea exists in the database. The duplicate idea becomes associated with the original idea and is inactive and closed for comments and votes.  
  - **Already exists**: Already developed at the time of idea submission or is close to being developed. |
| Mark as a duplicate | When you mark an idea as a duplicate, one idea is marked as the **Original idea** and the other as a **Duplicate idea**. A comment is logged in both the ideas with this information. The idea marked as a duplicate becomes inactive and closed for comments or votes.  
  a. In the State list, set the status of the idea to **Duplicate**.  
  b. Search for and select the idea that you want to mark as original in the **Duplicate** field.  
  c. Enter a justification in the **Close notes** field. |
### Delete an idea

Remove an idea from the database when it is no longer relevant or becomes old. Deleting an idea removes all its details such as comments, attachments, and votes from the database.

To delete an idea and all the details associated with it:

- Select the idea.
- Click **Delete**.

---

5. Click **Update**.

Convert selected ideas into tasks such as demand, project, stories, and epics.

---

### Evaluate an idea

Review submitted ideas and then accept or reject them.

**Role required:** idea_manager

As an idea manager, evaluate an idea and then decide whether to accept or reject an idea. If an idea cannot be implemented right away, move the idea to the backlog and pick it up later.

Accept the ideas that are feasible for implementation and create a task such as a demand, project, or story from it. Plan and work on these tasks to develop an idea into a new feature, product, or enhancement.

1. Navigate to **Ideas > Idea Portal**.
2. Click the title of an idea to view its details.
3. Open the idea in form view by clicking the more options icon, and selecting the **Open in platform** option.
4. Review the idea details and then choose which action to perform on the idea.

#### Evaluate ideas

<table>
<thead>
<tr>
<th>Action</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept</td>
<td>If the idea seems interesting with the potential for developing into a new feature, product, or enhancement, accept the idea. It then moves to the backlog, from which you can pick it up at an appropriate time. To accept an idea, set the status of the idea to <strong>In Backlog</strong> from the State list. If you want to implement the idea relatively soon, create a task for it. For more information, see Create a task for an idea.</td>
</tr>
<tr>
<td>Request more information</td>
<td>If the information provided with the idea at the time of submission is insufficient request more information about the idea by setting the status <strong>Need more information</strong> from the State list.</td>
</tr>
</tbody>
</table>
**Action** | **Steps**
--- | ---
Reject | If an idea is not feasible or has been already implemented, reject the idea by setting its state to *Unlikely to implement* or *Already exists*. The idea becomes inactive and is closed for comments and votes.
Close an idea when implemented | When an idea is implemented successfully, mark the idea as completed and close the idea for further comments and vote. To mark an idea as completed:

a. Set the status of the idea to *Completed* from the State list.

b. Provide information about how the idea was implemented in the *Close notes* field.

5. Click **Update**.

**Create a task for an idea**

Create a task for planning and developing an accepted idea.

Role required: idea_manager

Create a task such as a demand, project, story, SAFe epic, SAFe feature, or SAFe story for an accepted idea. Plan and work on these tasks to develop an idea into a new feature, product, or enhancement.

1. Navigate to **Ideas > Idea Portal**.
2. Click the title of an idea that you want to create a task for.
3. Open the idea in form view by clicking the more options icon, and selecting the **Open in platform** option.
4. Select an appropriate state for the idea from the State list based on the priority of the idea. For more information about different idea states, see **Manage ideas**.
5. Click **Create Task**.
6. In the **Convert Idea to task** dialog box, select a task type from the Select task type list. The available task types are:

   - Demand
   - Project
   - Epic
   - Story
   - SAFe epic
   - SAFe feature
   - SAFe story

These task options are based on the installed plugins such as PPM Standard, Agile Development 2.0, and Scaled Agile Framework (SAFe).

**Note:** You must also have the appropriate role based on the plugins to create these task types.
Idea Manager dashboard

The Idea Manager dashboard provides summary views of idea metrics and trends such as ideas in different states, age of ideas, categories, and ideas converted to different work entities.

Install Idea Manager dashboard

You can install the Idea Manager dashboard application from ServiceNow Store if you have the admin role. This application includes demo data and installs the related plugins if they are not already installed.

- Ensure that the application and all of its associated store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.
- If the application requires plugins or other store applications, install them first if they are not already installed. For the Idea Manager dashboard application, the following plugins are required:
  - PPM Standard plugin (com.snc.financial_planning.pmo)
    For information on activation steps, see Activate PPM Standard (Project Portfolio Management).

Role required: admin

1. Navigate to System Applications > All Available Applications > All.
2. Find the application using the filter criteria and search bar.
   You can search for the application by its name or ID. If you cannot find an application, you may have to request it from the ServiceNow Store. Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
3. Click Install.
4. In the Application installation dialog box, review the application dependencies.
   Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If there are any plugins or applications that need to be installed, you must install them before you can install the ServiceNow Store application.
5. Optional: If demo data is available and you want to install it, click Load demo data.
   Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.

   Important: If you don’t load the demo data during installation, it’s unavailable to load later.
6. Click Install.

You can access the Idea Manager dashboard by navigating to Ideas > Idea Manager Dashboard.

Run the following Performance Analytics data collector jobs before using the Idea Manager dashboard.

- [PA PPM IMD] Historic Data Collection: Collects historical data related to ideas and runs on demand to update data for dashboard.
- [PA PPM IMD] Daily Data Collection: Collects data for daily indicators and runs daily to update data for dashboard.

Using Idea Manager dashboard

The Idea Manager dashboard provides comprehensive reports to the idea manager and users with read-only roles for ppm (sn_ppm_read). The dashboard uses Performance Analytics to provide a trend of historical data as well as regular reports. It provides you an overview of ideas, number of ideas converted into work entities, and trends based on categories, idea submitters, and votes. It helps you to review and analyze ideas and enables you to take required actions for managing your ideas effectively.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Idea Manager - Needs visibility into ideas in different states, number of ideas created, and age of ideas.</td>
<td>idea_manager</td>
</tr>
<tr>
<td>Read only roles for PPM - Needs visibility into ideas in different states, number of ideas created, and age of ideas.</td>
<td>sn_ppm_read</td>
</tr>
</tbody>
</table>

Use case

The dashboard displays ideas related to Project Portfolio Management.

Only ideas associated with categories are displayed in the dashboard. Ideas marked for deletion are not displayed. By default, the dashboard displays one-year data. Use the interactive date filter to view monthly, quarterly, or yearly data.

You can drill down within an idea indicator data for further analysis by navigating to Idea Portal from the dashboard. For example, to view individual records of Open ideas in the Idea Portal, click the Open ideas indicator value to open the Analytics Hub. In the Analytics Hub, click Show Records to view the list of open ideas, open an idea in the form view, and then click the Idea Portal related link to view the idea record in the Idea Portal.

Indicators

The Summary and Analysis tabs in the dashboard contain the following indicators. The data for ideas is collected from the [idea] table.

**Open Ideas**

Count of the ideas that are in Submitted, Need more information, or Under Review state for the current month.

**Average Age of Open Ideas**

The average age of ideas that are in Submitted, Need more information, or Under Review state since their creation, in days, as calculated by the formula $\frac{\text{[[PPM:Total Age of Open Ideas]]}}{\text{[[PPM:Open Ideas]]}/24}$.

**Ideas Converted**

Count of ideas converted into different work entities such as demand, project, story, or epic based on other plugins.

**% of Ideas Converted**

The percentage of ideas converted into different work entities such as demand, project, story, or epic based on other plugins, as calculated by the formula $\frac{\text{[[PPM:Ideas Converted]]}}{\text{[[PPM:Active Ideas]]}} * 100$.  

**Ideas**
Count of ideas that are in different states. You can view the count of ideas, in different states, created in week, month, quarter, and year.

**Active Ideas**

Count of ideas in Submitted, Need more information, Under review, in backlog, planned and in development state. This indicator is not displayed in dashboard but is used in formula.

**Total Age of Open Ideas**

Total number of days an idea is in state Submitted, Need more information, and Under review before conversion to a work entity. This indicator is not displayed in dashboard but is used in formula.

**Breakdowns**

- PPM - Idea Category
- PPM - Idea State

**Reports**

The dashboard includes the following reports:

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ideas by state</td>
<td>Donut</td>
<td>Breakdown of the number of ideas in each of the different states.</td>
</tr>
<tr>
<td>Ideas converted</td>
<td>Donut</td>
<td>Breakdown of the number of ideas converted into work entities such as demand and project.</td>
</tr>
<tr>
<td>Top 10 ideas by votes</td>
<td>Horizontal bar</td>
<td>Top 10 ideas based on the total number of up-votes.</td>
</tr>
<tr>
<td>Top 10 idea creators</td>
<td>Horizontal bar</td>
<td>Top 10 users based on the number of ideas submitted.</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Ideas trended by categories</td>
<td>Line</td>
<td>Trend of the total number of ideas submitted under various categories. The trend is displayed on a monthly basis.</td>
</tr>
<tr>
<td>Top 10 categories by ideas</td>
<td>Horizontal bar</td>
<td>Top 10 categories based on the number of ideas submitted under each category.</td>
</tr>
</tbody>
</table>

**Portfolio Management**

With the ServiceNow® Portfolio Management application, you can create portfolios which are collections of related programs, projects, and demands. You can then perform financial planning and monitor the status and progress of these portfolios.

You must have the it_portfolio_manager role to manage a portfolio. The Portfolio Management application provides these capabilities to the portfolio manager:

- Create a portfolio by adding related programs, projects, and demands.
- Perform annual portfolio planning by selecting demands, projects, and programs.
- Track the progress and status of all the programs, projects, and demands that are part of the portfolio. You can track the costs, resources, schedules, risks, and issues.

Watch this four-minute video to learn about the portfolio structure, creating a portfolio and program, setting up a stakeholder registry, and the portfolio workbench.

The following diagram provides an overview of Portfolio Management.
Overview of Portfolio Management

Features

Portfolio Management also provides the following features:

Portfolio workbench

The portfolio workbench provides a central location to view and monitor the progress of the program, the projects, and demands that are part of the portfolio. You can also perform annual portfolio planning, create budget and forecast plans for the portfolio.

Annual planning for the portfolio

The annual planning wizard is available in the portfolio workbench. The annual planning process comprises these steps:

1. Determine the overall cost requirements for the portfolio and set the target.
2. Select the demands and projects for a fiscal year based on the budget target and resource availability.
3. Create and promote a budget plan.
4. If required, re-promote the budget plan by performing a what-if analysis by adding or removing projects and demands before the budget is finalized.
Budget forecasting of the portfolio

Using the portfolio workbench, the portfolio managers can re-estimate (forecast) the portfolio budget for future periods based on the actual cost and changed project requirements.

Tracking of the portfolio

Once the financial planning is complete, portfolio workbench allows you to track the progress of a portfolio. This tracking includes the actual amount being spent against the budget, actual hours spent, risks, and issues.

Portfolio Manager dashboard

The Portfolio Manager dashboard provides a central location to generate different graphical reports of the portfolio and portfolio financials.

Scenario-based Portfolio Planning

Install the Scenario Planning for PPM application from ServiceNow Store to help the portfolio managers do a scenario-based portfolio planning with different combinations of demands and projects. You can Compare multiple scenarios in a portfolio and fund only those demands and projects that add financial value to the organization.

Create a portfolio

Create a portfolio to manage related programs, projects, and demands.

• Create demands, programs, and projects to include as part of the portfolio.
• Role required: it_portfolio_manager or admin

1. Navigate to Project > Portfolios > Create New.
   You can also navigate to Project > Portfolios > Workbench, and click Create new.
2. Enter a unique Name that summarizes the programs, projects, and demands included in this portfolio.
3. Enter a Description for the portfolio that adequately explains the various programs, projects, and demands attached to it.
4. Enter the name of the Portfolio Manager.
5. Select a mode for planning.
   
   **Note:** Configure the form to add this field if it is not visible.

   • Simple to perform simple financial planning of projects.
   • Advanced to perform advanced financial planning including budget plan and forecast plan.

6. Click Create Portfolio.

The portfolio is created and the form reopens with additional fields, related links, and related lists.

Fill in the following related links and lists to complete the portfolio:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand Workbench</td>
<td>Link to open Demand Workbench.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portfolio Target</td>
<td>Link to open the Portfolio Target dialog box for you to enter the CAPEX and OPEX target for each fiscal year. This target amount is split equally among the fiscal periods. The portfolio target is included in the Portfolio Target related list.</td>
</tr>
<tr>
<td>Portfolio Workbench</td>
<td>Link to open Portfolio Workbench.</td>
</tr>
<tr>
<td>Portfolio Planning</td>
<td>Link to open Portfolio Planning Workbench for scenario planning. This related link is available when Scenario Planning for PPM is installed in your instance. For more information, see Scenario Planning for PPM.</td>
</tr>
<tr>
<td>Related lists</td>
<td></td>
</tr>
<tr>
<td>Demands</td>
<td>List of demands that are part of the portfolio. To create a demand, click <strong>New</strong>. To add existing demands to the portfolio, click <strong>Edit</strong>.</td>
</tr>
<tr>
<td>Projects</td>
<td>List of projects that are part of the portfolio. To add existing projects to the portfolio, click <strong>Edit</strong>.</td>
</tr>
<tr>
<td>Programs</td>
<td>List of programs that are part of the portfolio. To create a program, click <strong>New</strong>. To add existing programs to the portfolio, click <strong>Edit</strong>.</td>
</tr>
<tr>
<td>Risks</td>
<td>List of risks that are part of the portfolio. The program, project, and demand risks are also displayed in this list. To create a risk, click <strong>New</strong>.</td>
</tr>
<tr>
<td>Issues</td>
<td>List of issues that are part of the portfolio. The portfolio, program, project, and demand issues are also included in this list. To create an issue, click <strong>New</strong>.</td>
</tr>
<tr>
<td>Cost Plans</td>
<td>List of cost plans of <strong>projects</strong> and <strong>demands</strong> that are part of the portfolio.</td>
</tr>
<tr>
<td>Benefit Plans</td>
<td>List of benefit plans of <strong>projects</strong> and <strong>demands</strong> that are part of the portfolio. To create a benefit plan, click <strong>New</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Portfolio Target</td>
<td>List of portfolio capital and operational expense target for different fiscal years. The values are displayed from the project_funding table. Set these values in the Set Target stage of the portfolio workbench. You can create targets for different financial periods.</td>
</tr>
<tr>
<td></td>
<td>Note: The PPS admin can also set the portfolio target by navigating to Project Administration &gt; Enter Portfolio Target.</td>
</tr>
<tr>
<td>Planning &amp; Budgeting</td>
<td>According to the fiscal years, lists projects and demands that are part of the portfolio. You can include or exclude a project or demand from the portfolio budget plan.</td>
</tr>
<tr>
<td></td>
<td>When you select the project or demand in the Select Project and Demands step of the portfolio workbench and move to the next stage, the Planned value changes to true.</td>
</tr>
</tbody>
</table>

**Open a portfolio status list**

Open the status list of a portfolio to see the projects that are included in it.

Role required: it_portfolio_manager

1. Navigate to Project > Portfolios > All.
2. Open a portfolio.
3. Click the Portfolio Status related link.
   - The list of portfolio status records opens.
4. If necessary, you can select a different project associated with the current portfolio.

**Legacy portfolio workbench**

The portfolio workbench provides a central location for viewing a list of associated demands and projects, planning a portfolio, and tracking its progress. Portfolio workbench is deprecated in the Paris release. Portfolio workbench is still available on instances upgraded from a previous release but is not available for new instances.

Note: The content in this topic is applicable for customers upgrading from a previous release to Paris. If you are a new customer, see Scenario Planning for PPM.

You must have the it_portfolio_manager role to use the portfolio workbench for:

- **Portfolio planning**: Perform the planning of the portfolio. You can set the targets, select projects and demands, and create a budget plan in the portfolio.
- **Portfolio budget forecasting**: As part of financial planning, re-estimate (forecast) the portfolio budget for future periods based on the actual costs.
- **Portfolio tracking**: View and monitor the progress of the program and the projects and demands that are part of the portfolio.
Note:

- Portfolio workbench is based on Service Portal which means that you can configure, customize, and extend the workbench per your requirements and organizational workflow. See the Service Portal documentation for more information.
- Portfolio workbench does not support mobile devices.

In addition to the Portfolio Workbench, starting with New York, you can use the Portfolio Planning Workbench do a scenario-based portfolio planning. This scenario-based planning enables you to focus your investment budget and resources on demands and projects that best position your organization.

Scenario Planning for PPM enables you to identify risks and uncertainties that might occur in the future and create possible planning scenarios and pursue whichever scenario becomes a reality. For example, you may have scenario A with all your chosen demands and projects, but you know that there's a risk that might reduce your team's velocity. You can reduce the velocity in scenario B and switch to it when the risk that you identified becomes a reality. For more information, see Scenario Planning for PPM.

The portfolio workbench shows the following sections for an opened portfolio:

- The left section provides the following fields used to plan the portfolio:
  - **Fiscal Year:** The list to select the fiscal year you want to perform the planning for.
    - **Note:** If there is no fiscal year in the list, generate a fiscal calendar.
  - **Planning Steps:** The steps involved in planning the portfolio.
    - Shows the completed and the current planning step number.
    - Checks off the completed planning step.
    - Highlights the current planning step in the portfolio.

In the portfolio workbench example shown, the portfolio is in Step 2 (Select Demands and Projects). It has completed through Step 1 (Set Target).

- The middle section shows a list of all the demands and projects that are part of the portfolio and fall under the selected fiscal year. The green check mark shows the demands and projects that have been selected for execution for the selected fiscal year.

- The lock in the upper-right section indicates that portfolio planning is not yet complete and that the tracking action is not enabled. Once the financial planning is complete, the Track Portfolio action is enabled for portfolio manager to track the progress of the portfolio.
Portfolio workbench example

Access the legacy Portfolio workbench

When you access the portfolio workbench, the dashboard displays a list of all the portfolios.
Required role: it_portfolio_manager

You can access the portfolio workbench in one of these ways:

- Click the **Portfolio Workbench** related link on the Portfolio form.
- Navigate to:
  1. **Project** > **Portfolios** > **Workbench**.
  2. Click the configuration icon and select the colors for projects, tasks, portfolios, and so on. The workbench uses these colors to display the items in the portfolio in the Gantt chart in **timeline view**.

  ![Dashboard configuration](image)

  Dashboard configuration

  3. Click the portfolio you want to open.

**Legacy: Plan the portfolio**

As a portfolio manager, you can perform financial planning for a portfolio for a fiscal year using the portfolio workbench. Portfolio planning can be completed using either simple or advanced mode.

The content in this topic is applicable for customers upgrading from a previous release to Paris. If you are a new customer, see **Scenario Planning for PPM**.

On the Portfolio form, you can set the **Portfolio Planning** field to **Advanced** or **Simple**. Depending on your selection, the **portfolio workbench** is populated with the planning steps.

The following illustration provides a high-level overview of the planning process in advanced and simple planning modes.
Portfolio planning in simple mode

If the portfolio is in simple planning mode, you can perform simple financial planning for the projects and demands in the portfolio. Follow these steps:

1. Select the fiscal period and set targets.
2. Select projects and demands.

After you are finished with planning, track the portfolio performance, compare the planned budgets against the actuals, and review risks and issues.

Portfolio planning in advanced mode

If the portfolio is in advanced planning mode, follow these steps:

1. Select the fiscal year and set targets.
2. Select projects and demands.
3. Create a budget plan.
4. Re-promote a budget plan, if required.
5. Create a forecast plan.

An example portfolio planning flow in advanced mode is shown:
Advanced portfolio planning example

After you are finished with planning, track the portfolio performance, compare the planned budgets against the actuals, and review risks and issues.

Scenario Planning for PPM

Install the Scenario Planning for PPM application from ServiceNow Store to help the portfolio managers do a scenario-based portfolio planning with different combinations of demands and projects. You can compare multiple scenarios in a portfolio and fund only those demands and projects that add financial value to the organization.

Legacy: Planning view in portfolio workbench

View all the demands and projects scheduled for the selected fiscal year with their planned cost, resource requirements, and priorities to finalize them for execution.

These sections are presented in the planning view in the portfolio workbench:
Demands and projects

The demands and projects are presented on two different tabs:

- **Bubble Chart** tab: Shows all qualified or approved demands planned for the selected fiscal year. The demands are scored based on attributes such as planned cost, ROI%, and risk, and are presented in bubble chart format.

  The demands that are selected for execution are highlighted with a blue border.

  ![Bubble Chart](image)

  The number of selected demands versus the total number of demands are displayed as a counter in the top-right corner of the chart.

  ![Counter](image)

  **Note:** The demands may have converted to projects and the projects are in the **Work in Progress** state. These demands are not shown in the bubble chart. View these demands as projects in the timeline view.

- **Timeline View** tab: Shows a list of all the demands and projects that are part of the portfolio. It also shows a Gantt chart of all the projects, demands, and programs in the portfolio over time.

  All demands selected for execution in the bubble chart are shown as selected in the timeline view.

  As a portfolio manager, you can perform the following actions:

  - Configure the colors of the portfolio items in the Gantt chart with **Dashboard Configuration** settings.
  - Select the zoom level in the Gantt chart calendar to **Auto Fit**. The Gantt view fits on one page to view the entire timeline without using the scrollbar.
  - Select or clear a demand or a project for execution by selecting the check box next to each demand or project. The number of selected demands, the total number of demands, the number of selected projects, and the total number of projects are displayed as respective counters:
• Review or revise the Capex and Opex budget for individual projects and demands directly by using the Capex Budget and Opex Budget columns, if required.
• Review the external dependencies between projects in a portfolio.
• Rank demands and projects based on score, currency, numeric attributes, or manual adjustment. Ranks help in prioritizing demands and projects for their approval and execution within a portfolio.

By default, the Rank By Score list ranks demands and projects based on system-generated scores. The list provides the following options:

• **Rank By Visual Sort**: If you want to rank projects and demands based on any currency or number attribute, such as ROI%, priority, and planned cost, you must first sort by the required attribute and perform this action to rank by that attribute.
• **Adjust Rank**: If there are gaps in ranks (for example, if some projects are moved to the next fiscal year or are canceled), you can perform this action to rearrange the projects. For example, if the ranks are 1, 2, 5, 8, this action adjusts the ranks as 1, 2, 3, and 4.

As a portfolio manager, you can also change a rank by editing the Rank field. When the rank of a project or demand is changed, the other ranks are automatically adjusted. For example, if a number 2 ranked project is ranked as 4, the number 3 ranked project automatically assumes rank 2, and the number 4 ranked project automatically assumes rank 3.

**Note**: Rank of an entity is specific to a fiscal year. A project can be ranked as number 3 in FY17, but can be ranked as number 6 in FY18.

**Note**: Key milestones appear as overlays on top of the project timeline.
• An administrator can customize which columns appear in the column filter list in the timeline view.

### Charts

The charts presented represent different aspects of a portfolio to help you plan the portfolio:

• **Cost (Planned vs. Target)**: Displays the planned costs versus the targets that you entered in the Set Target step. Use this chart when you select projects and demands for portfolio planning.

As you select a demand or a project, the cost bar starts filling up, representing the total planned cost for all selected demands and projects. If the total planned cost of all selected demands and projects is more than the target budget, then the exception icon
is shown with the total planned cost.

In this widget, you can:

- Select a fiscal period in the choice list.
- View the planned cost only for Capex, or, Opex, or All.
**Resource Overview and % Utilization:** Use these charts when you select projects and demands for portfolio planning:

- **Resource Overview** tab: Shows the following items in the stacked bar chart. Point to any of the sections on the bar chart to view its details.
  - **Capacity:** The total capacity of all groups or resources requested by selected demands and projects in the portfolio.
  - **Requested hours:** The total number of hours requested by all selected demands and projects of the portfolio. It does not include requested hours by demands or projects of other portfolios.
  - **Confirmed hours:** The number of hours confirmed across all portfolios for the groups requested by selected demands and projects.
  - **Allocated hours:** The number of hours allocated across all portfolios for the groups requested by selected demands and projects.

You can modify the settings of the chart by selecting any of the following options:

- **Hours:** Displays the chart in relation to hours and fiscal periods.
- **FTE:** Displays the chart in terms of FTE and fiscal periods.
- **Person Days:** Displays the chart in relation to person days and fiscal periods.

Ideally, the total resource hours (for all quarters) must be less than or equal to the total capacity of resources. If total hours are more than the capacity of the resources, then you can either defer a few demands or projects or add more resources to increase the capacity.

Clicking a section of the bar chart that shows allocated, or confirmed, or requested opens the associated resource plans.

- **% Utilization** tab: Shows the heat map for the percentage of utilization for all the resources requested by the selected demands and projects in the portfolio. The percentage of utilization for each resource group or role for a group is calculated as follows:

\[
\text{(Total requested hours by selected demands and projects of current portfolio + Total confirmed and allocated hours for the group by selected demands and projects across all portfolios)/Group capacity}
\]

If the percentage of utilization of a group is more than 100%, the portfolio manager can drill down to see requests for demands or projects. You can then exclude low priority demands or projects to balance the utilization.

You can modify the display settings of the heat map by selecting either of the following options:

- **Group:** Displays the heat map for the resource groups requested for the portfolio.
- **Role:** Displays the heat map for the resource roles requested for the portfolio.

Clicking any cell in the heat map drills down to the associated resource plans and shows where the specific group is being requested. For example:
UI actions

The following options are available at the top of the planning view in the portfolio workbench:

- **Refresh** icon
  
  ![Refresh icon](image)

  Manually refreshes the cost and resource charts after a demand or a project is selected or deselected for execution.

- **Auto Refresh** switch: Clicking the configuration icon
  
  ![Auto Refresh switch](image)

  displays the **Auto Refresh** switch. The switch enables the automatic refresh of cost and resource charts when a demand or a project is selected or deselected for execution.
Legacy: Select the fiscal year and set targets
The first step in both Simple and Advanced planning for a portfolio is to select the fiscal period for the data that you want to work with. Next, set the target amounts for both operating and capital expenses.

On the Portfolio form, set the Portfolio Planning field to Simple or Advanced for the portfolio.

Role required: it_portfolio_manager or it_pps_admin

Typically, the target amount is provided by the steering committee or the investment committee. Based on the actual amount spent in the last fiscal year, the target for the planned fiscal year can be 110% of the amount spent in the last year. The target is the starting point for planning projects for the next fiscal year.

Note: The PPS admin can also set the portfolio target by navigating to Project Administration > Enter Portfolio Target.

1. Access the legacy Portfolio workbench and open the portfolio that you want to perform the planning for.
2. In the Fiscal Year choice list, select the year that you want to perform the planning for.
   You can perform financial planning for only one fiscal period at a time.
3. In Step 1: Set Target, click Set Target.
4. Enter the amounts for Capex Target and Opex Target.
   Note: The budget target defined in the portfolio workbench can also be viewed in ITFM.
5. Click Save.
   • The budget target appears in step 1. You can click the target amount to revise the amount.
   • The portfolio capital and operational expense target for different fiscal years are updated in the Portfolio Target related list on the portfolio record.

Legacy: Select demands and projects for portfolio planning.

Legacy: Select demands and projects for portfolio planning
After you select the fiscal period and set budget targets, select the demands and projects to include in budget planning. You can view all the demands and projects lined up for the selected fiscal year with their planned cost and priorities to finalize them for execution.

Role required: it_portfolio_manager

In this stage, you can perform a what-if analysis by including or excluding demands or projects and their planned cost. The planned cost is derived from all the cost plans created for a project or demand. It is the total of all the costs from all cost plans for a given project or demand in the fiscal year.

1. Click Select Demands and Projects under Step 2 in portfolio workbench.
2. In the planning view of portfolio workbench:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>In Bubble Chart</td>
<td>Right-click and select:&lt;br&gt;- View demand to open and view the demand form.&lt;br&gt;- Select for execution to include a demand in portfolio planning.&lt;br&gt;- Remove to exclude a demand from portfolio planning.</td>
</tr>
<tr>
<td>In Timeline View</td>
<td>• Use the check box next to each project or demand in the list to include or exclude it from planning.</td>
</tr>
</tbody>
</table>
3. Review these items in the planning view to select the demands and projects to be included or excluded from planning:
   - Use the **Cost (Planned vs. Target)** chart to see planned costs versus the targets that you entered in the **Set Target** stage. If planned cost is more than the target cost, an exception icon appears with the planned cost.
   - Use the **Resource Overview** chart to see how many resource hours are requested to execute the selected demands and projects. Compare that to how many requested resources have been confirmed/allocated across all portfolios.
   - Use the **% Utilization** heat map for all requested resources by the selected demands and projects in the portfolio.

   **Note:** To bring the planned cost within target budget and resource utilization within 100%, the portfolio manager deselects a few low priority demands or projects. These deselected demands and projects can be moved over to a different fiscal period.

4. Review or revise the capex and opex budget for individual projects and demands directly using **Capex Budget** and **Opex Budget** columns, if required.
   Click the filter icon in timeline view and add **Capex Budget** and **Opex Budget** columns if they are not visible.

5. Once you have finalized the demands and projects, click **Confirm**.

6. On the Confirm dialog box, you can select the two check boxes to perform additional actions on the selected demands and projects.
   Select the first check box either to only approve the selected demands or to convert them to projects. The check box differs depending on whether the project property **Create project(s) on confirming demands from portfolio workbench** is set to true or false:
   - If the project property is true, then the check box is **Convert all the selected demands to projects** and selecting it approved and converts the selected demands to projects.
   - If the project property is false, then the check box is **Approve all the selected demands to projects** and selecting it only approves the selected demands.
   
   Select the second check box **Confirm resources for selected projects and demands** to confirm the resources for selected demands and projects.

7. Click **OK** on the Confirm dialog box.

   Based on the check boxes selected on the Confirm dialog box, the following actions are performed:
   - Selected demands are either approved and converted to projects or only approved.
   - The resources are confirmed for selected demands and projects. All associated resource plans move from **Requested** state to **Confirmed** state.

   **Legacy:** Create and promote a budget plan if **Portfolio Planning** is set to **Advanced**.

   **Legacy:** Change planned start date of a demand or project through Portfolio Workbench
   Balance the cost and resources by changing the start date of a demand or a project and shifting it to a different fiscal period.

   The demands and projects are open in the **timeline view** of portfolio workbench.
Role required: it_portfolio_manager

1. Click Select Demands and Projects under Step 2 in portfolio workbench.
2. In the timeline view, click the filter icon

and add the Planned start date column if it is not visible.

3. To change the planned start date of a demand, double-click the value under the Planned start date column and pick a new date.
4. To change the planned start date of a project, perform the following actions.
   a) Right-click the project and select the Edit option.
   b) On the Project form, right-click the header bar and select the Move project option from the context menu.
   c) In the dialog box, pick a date, and click OK.

Changing the date has the following effects on cost plans and resource plans:

- Cost plans: Cost plan dates are changed with respect to the change in project or demand date. For example, if a demand is shifted by two months, all the associated cost plans are also shifted by two months.
- Resource plans: The resource plan dates are changed regarding the change in project or demand date. The changes in resource plan state are as follows:
  - Allocated state resource plan: The effects on a resource plan in the Allocated state are:
    - If the resource plan has a start date in the future, the resource plan is moved back to the Requested state.
    - If the resource plan has a start date in past, the resource plan is canceled. The hard allocations for the past date are retained, and the future hard allocations are deleted. A new resource plan with new dates is created in the Requested state.
  - Confirmed state resource plan: The soft allocations are deleted and the plan moves to the Requested state.
  - Planning and Requested state resource plans: There is no change in resource plan state.

Note: The project property Change Resource Plan and Cost Plan Start Date with Demand or Project Start Date Change controls the changes in cost and resource plans with respect to the change in the start date of a demand or project.

Legacy: Review external dependencies between projects

Review the external dependencies between projects in a portfolio to track projects that are dependant on each other more closely.

Role required: it_portfolio_manager

Open demands and projects in the timeline view of the portfolio planning workbench.

As a portfolio manager, you may want to know the projects which are dependent on each other so that these projects can be tracked more closely.

For example, project B is dependent on project A (external soft dependency) and you want to make sure that project A is executed on time so that the schedule of project B is not affected. The Dependencies column shows that there is an outgoing external dependency from project A and an incoming external
dependency to project B. You can use the incoming dependency to determine whether a delay in project A will affect project B.

1. Click the show or hide columns in gantt icon

   in the timeline view and add the Dependencies column if it is not visible. The number of incoming and outgoing external dependencies are displayed, if any.

2. Click the external dependency in Dependencies column for the project.

3. In the Dependencies pop-up dialog, click a tab to review the dependency:

   **Inbound tab**
   Tasks that have an incoming dependency from a project are listed.

   **Outbound tab**
   Tasks with an outgoing dependency to the project are listed.

   ![Dependencies dialog](image)

   Example of external dependencies between projects.

4. Click the project number in a tab to open and review the linked project in the planning console view.

Legacy: Create and promote a budget plan
As part of the PPM Standard (Project Portfolio Management) integration, you can create and promote a budget plan for a portfolio.

- Role required: it_portfolio_manager
- The **Portfolio Planning** field for portfolio must be set to **Advanced** on the **Portfolio form**.
- The name of the portfolio manager must be set in **Portfolio Manager** field on Portfolio form.
The budget period for the selected fiscal period must be open to create and promote a budget plan for a portfolio.

Note: PPS admin can also open and close the budget period for a fiscal period from Project Administration > Open/Close Budget Periods.

The budget plan includes costs from all selected projects and demands. The budget plan summary is displayed on portfolio workbench and the details can be seen in Financial Planning. In the advanced planning mode, the creation of a budget plan is mandatory to be able to track the portfolio.

1. Navigate to portfolio workbench and open the portfolio that you want to track.

2. Click Promote Budget Plan under Step 3: Budgeting.

- The budget plan for the portfolio for the selected fiscal year is created and promoted. You can re-promote the budget plan, if required.
- A budget task with the status Pending Approval is created when the portfolio manager promotes the budget plan, the first time in the budgeting period. The status of the task is visible in Portfolio Workbench.

- View the status of the budget plan below the budget plan name under Step 3: Budgeting in portfolio workbench. Click the Status link to view the budget task for the budget plan in financial planning workbench. The finance reviews the portfolio budget plans in the Planning Workbench and approves the plan.
- Legacy: Track the portfolio.
- Legacy: Create and promote a forecast plan.
- If the budget plan is finalized and no more changes are expected, the budget period must be closed.

Legacy: Financial planning workbench
The financial planning workbench is a central location to manage budget tasks, review, and approve the promoted plans. Financial planning workbench is deprecated in the Paris release. Financial planning workbench is still available on instances upgraded from a previous release but is not available for new instances.

Note: The content in this topic is applicable for customers upgrading from a previous release to Paris. If you are a new customer, see Scenario Planning for PPM.

You must have the itfm_plan_analyst role to use the financial planning workbench.

Budget tasks help in streamlining the budget process. It helps finance to converse with budget owners during the budgeting period.

With the IT finance analyst role, you can use the workbench to:

- Generate budget task: Create a budget task for every budget owner.
- Publish the budget task: Publish the budget task for the budget owners to start their work on the plan for the budget period.
- Track the progress of the plan: View and monitor the promoted plans for the budget period.
- Approve the plan: Approve the promoted plan by approving the task.

Note: The planning workbench replaces the budget console that was used in the Jakarta release. Only the IT finance analyst can use the planning workbench and not the budget owner.
The financial planning workbench details are as follows:

- The finance analyst can select the year and the budget plan definition. If budgeting period is open and the plans are not promoted yet, then the analyst has the option to create budget tasks for the budget owners.
- After the budget tasks are generated, the finance analyst can update the targets and enter specific instructions in the budget tasks. The budget tasks are published for the budget owners to work on the plan for the budget period.
- Then the promoted plans for the open budget or forecast period can be seen on the left pane.

A sample of the planning workbench

The right pane of the financial planning workbench provides three types of views:

**Task View**

View the list of tasks for each planner along with its status. Open a task record to add a note to the planner and update the state of the task.

**Plan View**

View the plans that the planners have promoted. Use the grid view to:

- View the data by the columns that you configured in the template.
- Group the columns by any column, for example by cost center or vendor.
- View the budgeted amount, last forecast amount, and the actuals by year, quarter, or month.

**VTB View**
View the budget tasks by its state:

**Draft**
The IT finance analyst has generated the task for a budget period.

**Published**
The IT finance analyst has published the task for the planner to work on the plan task.

**Awaiting Input**
The planner promotes the task to the IT finance analyst, but the analyst updates the task work note for the planner to rework on the budget amount.

**Pending Approval**
The planner has submitted the task and waiting for the IT finance analyst to approve or provide any comments on the plan task.

**Approved**
The IT finance analyst approves the plan.

The **Generate Actuals** button enables you to generate actuals for the budget definition data source to view in the grid.

**What to do next**
Create a budget period to promote a budget plan.

**Legacy: Create a budget period**
The budget period controls the promotion of the budget plans. Budget plans created for a fiscal year can be promoted only if the budget period is open.

**Role required:** itfm_plan_analyst, admin

1. Navigate to **Financial Planning > Administration > Budget Periods**.
2. Click **New** in the Budget Periods list view.
3. Enter a **Budget period** from the choice list.
4. Enable the **Open** check box.
   - Enabling the check box sets the value to true and opens the budget period for you to promote the budget plans created for a fiscal year.
5. Click **Submit**.

**Legacy: Forecast period**
Forecast periods are similar to budget periods that aim to control the promotion of forecast plans.

Forecast periods can be created for a closed budget period. Forecast plans can be promoted only if the forecast fiscal month period is open.

**Note:**
Only one forecast period can be open at any point in time.
Legacy: Create a budget target
A budget target is an estimated amount of money for a specific fiscal period and budget key combination for operating and capital expenses. Use budget targets to set up a financial goal for a budget plan.

Role required: itfm_plan_analyst, admin

2. Fill in the form fields (see table).
3. Click Submit.

<table>
<thead>
<tr>
<th>Budget Target form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Budget Key</td>
</tr>
<tr>
<td>Fiscal period</td>
</tr>
<tr>
<td>Target Currency</td>
</tr>
<tr>
<td>Capital Target</td>
</tr>
<tr>
<td>Operating Target</td>
</tr>
</tbody>
</table>

Legacy: Generated actuals
Account code, or budget key, expenses are records that show general ledger amounts for a budget key. The amounts are aggregated for each fiscal period.

The expenses in the Account Code Expenses [itfm_plan_actuals] table are used by the financial planning workbench for calculations of actual expenses. Normally you do not need to create or modify data in this table.

Finance analysts can access account code expenses from the Financial Planning > Financial Planning > Generated Actuals. The expenses are populated when you click Generate Actuals button on the financial workbench.

Legacy: Use the planning workbench to initiate a budget plan
After you configure the budget process definition, you can initiate a budget. Open the budget period. Use the financial planning workbench, and select the fiscal period and the budget plan definition, and generate a budget task.

Role required: itfm_plan_analyst
An IT finance analyst generates a task for each planner. The planner can view the tasks that the planner owns by navigating to Financial Planning > My Tasks.

2. Select the budget period for which you are planning from the choice list on the top-right of the workbench.
   You can also create a budget period and open it to make it available for budgeting.
3. Select the budget plan definition from the choice list.
4. Click Generate Task.
   If the plan does not exist, and a plan task for the selected fiscal period, then clicking the Generate Task button creates a plan for each plan key. The plan key associated with the planner is considered only while generating the plan. The generated budget task is in Draft state.
5. Open a budget task record from the budget list to review and update if required.
   As an IT finance analyst you can add a note to the planner in the Work notes field.
6. Click **Update** to save your changes.
7. Click **Publish** to publish the tasks.
   - Set a **Start date** and an **End date** as a deadline for the plan in the Publish Planning Tasks pop-up that opens up.
8. Click **Create**.
9. Click the **Plan view**. To hide columns in the view, click the **Configuration** icon.

   Item columns are rendered from the Budget Definition [itfm_plan_definition] table. Hiding or displaying an item column does not update the table. Grouped columns cannot be hidden.
10. Click the **VTB View**.
11. View the budget tasks by its state.
    - If the planner had promoted the plan, then the plan is in **Pending Approval** column. If required, you can review the plan and make a recommendation.
12. To make a recommendation to the budget, click the task in the **Pending Approval** column.
13. Add a comment in the **Add description** field.
14. Close the budget task pop-up.
15. Drag the plan to the **Awaiting Input** column.
    - After the planner updates and promotes the plan, then the state of the task becomes **Pending Approval**.
16. If the planner updates the plan with your recommendation and if the budgeted amount meets the target, then move the plan to the **Approved** column.
    - The budget plan is approved.

As a planner you can update and promote your plans to finance.

**Legacy: Repromote a budget plan**

Repromote the budget plan to reflect the modifications in the portfolio budget that resulted because of a change in demand or project selection planned cost.

- Role required: it_portfolio_manager
- To repromote a budget plan for a portfolio, the budget period for the selected fiscal period must be open.

**Note:** The PPS admin can also open and close the budget period for a fiscal period by navigating to **Project Administration > Open/Close Budget Periods**.

After promoting the portfolio budget plan, as the portfolio manager, you can decide to modify the budget based on the investment committee suggestions. You can work with project and demand managers to modify the cost plans for the demand and project to implement the suggested changes. The budget plan can then be repromoted to reflect the changes in the budget plan.

1. Navigate to portfolio workbench and open the portfolio that you want to track.
2. Click **Re-promote Budget Plan** under **Step 3: Budgeting**.

The budget plan is repromoted as the updated budget for the selected fiscal year.
- View the status of the budget plan below the budget plan name under **Step 3: Budgeting** in the portfolio workbench. To view the budget task for the budget plan in financial planning workbench, click the **Status** link.

![Step 3: Budgeting](image)

- After the budget plan is repromoted and no more changes are expected, the budget period must be closed.

**Legacy: View promoted portfolio budget plans in the planning workbench**

Use the financial planning workbench to view the portfolio budget plan promoted by portfolio manager, which is initiated in Project Portfolio Management and converted as a budget plan in Financial Management.

**Note:** The content in this topic is applicable for customers upgrading from a previous release to Paris. If you are a new customer, see Scenario Planning for PPM.

Role required: itfm_plan_analyst

You require Project Portfolio Suite with Financials [com.snc.financial_planning_pmo] plugin to perform portfolio budgeting and forecasting.

In Project Portfolio Management, portfolio managers use portfolio workbench to plan and promote the portfolio annual budget plan.

**Note:** The budget period or forecast period must be open to promote the portfolio plan.

A budget task with the status **Pending Approval** is created when the portfolio manager promotes the budget plan, the first time in the budgeting period. The status of the task is visible in Portfolio Workbench.
The finance reviews the portfolio budget plans in the Planning Workbench and approves the plan. The planning process between the portfolio managers and the IT finance is entirely automated. The plan promoted in the Portfolio Workbench is available in the Planning Workbench. Finance approves the plan by approving the task, or sends it back to portfolio manager indicating the status as Awaiting Input. The portfolio managers reworks on the IT finance review recommendations and promotes the plan.
Note: The planning workbench replaces the budget console that was used in the Jakarta release.

1. Navigate to **Financial Planning > Workbench**.
2. From the choice list at the top-right of the workbench, select the budget period for which you are doing the planning.
   
   You can also create a budget period and open it to make it available for budgeting.
3. From the choice list, select the **Portfolio Budget Planning** definition.

**Note:** The budget tasks originating from the Portfolio Workbench are initially in the **Pending Approval** state.

![Portfolio budget planning](image)

4. To view the promoted budget amount or last forecast amount, click **Plan View**.
5. Open a budget task record from the budget tasks list. You can also do this task in the VTB View of the workbench.

As an IT finance analyst, you approve the promoted plan details or send it back to the portfolio manager by adding a note in the **Work notes** field and update the **State** field to **Awaiting Input**.

**Forecasting**

The same process applies even for the forecasting period. The plan view shows the last promoted column which is the last promoted forecast plan from portfolio manager. The forecast amount contains actuals until the forecasting month and forecast for remaining period by the portfolio manager.

**Cost plan Actuals**

The actuals column in plan view is based on the cost plan actuals which is generated based on approved expense lines and actuals from timecards from Project Portfolio Management. If you notice a discrepancy in actuals amounts, regenerate actuals from **Generate Actuals** available at the top right corner of workbench.

---

**Legacy: Portfolio budget object configuration**

The planned cost of cost plans in portfolio when promoted by portfolio managers are converted to budget plans. The base system has a seeded read-only budget definition Portfolio Budget Planning Process used for the promotion of portfolio.

**Note:** The content in this topic is applicable for customers upgrading from a previous release to Paris. If you are a new customer, see Scenario Planning for PPM.

The granularity of the promoted budget object is defined in the Define Structure step of the Portfolio Budget Planning Process budget definition. By default, the granularity of Project Definition is **Portfolio**, Project or Demand (**Portfolio Task**), and **Account Number**.
If your organization needs more attributes (such as cost center and cost plan name) in the promoted portfolio budget object, you can define the additional mappings in the cost plan data source. Set up by dot walking the required attribute from the cost plan object. After the mapping is done, select the attribute in Define Structure of Portfolio Budget Planning Process and save it.

The promoted budget would include the selected attribute with **Portfolio**, Project or Demand (**Portfolio Task**), and **Account Number**. This attribute would also be visible in Portfolio Workbench.

**Note:** **GL Account Number** is automatically considered as one of the template columns.
Additional columns in Workbench

While reviewing the promoted portfolios, you can pull the additional dot walked columns to workbench for visibility. Use the Portfolio Budget Planning Process Define structure to pull in the additional dot walked column, such as Portfolio Manager, and save the configuration. Once saved, the column is visible on the workbench.
<table>
<thead>
<tr>
<th>Portfolio Budget Planning Process</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Name and Data Source</td>
</tr>
<tr>
<td>Define Structure</td>
</tr>
<tr>
<td>Assign Planners</td>
</tr>
<tr>
<td><strong>Available Columns</strong></td>
</tr>
<tr>
<td><strong>Selected Columns</strong></td>
</tr>
</tbody>
</table>

Use the key icon to Select assigned ORE to indicate budget key identifier - Columns used to uniquely identify the planners

- Portfolio
- Portfolio Task
- Portfolio manager

Save
Legacy: Forecast the budget for portfolio

As a project or portfolio manager, you can forecast the future costs of projects and portfolios based on the actual cost and changed project requirements. Budget forecast is deprecated in the Paris release. Budget forecast is still available on instances upgraded from a previous release but is not available for new instances.

Note: The content in this topic is applicable for customers upgrading from a previous release to Paris. If you are a new customer, see Scenario Planning for PPM.

After budget planning and approval, during the project execution, as the project manager, you can re-estimate (forecast) the planned costs for future periods. This forecast is based on the actual cost incurred and other changes in projects. The forecasted project costs get rolled-up to the portfolio and, as the portfolio manager, you can create the forecast plan for the portfolio.

An example of the quarterly forecasting process for the April quarter is shown:
Budget forecasting
When the forecast period is open for a given period:

- As the project manager:
  - review actual cost for current and past periods and edit the estimated cost for the forecast period and all future periods. For example, if the forecast period is open for April 2016, the estimated cost for April and future months can be edited.
  
  **Note:** As the project manager, you cannot edit the costs for past periods. For example, in this case, the cost for months prior to April cannot be edited.
  - forecast (re-estimate) the cost plans for the projects, when required. The forecasted project costs are rolled-up to the portfolio.
  
- As the portfolio manager:
  - review the re-estimated costs for all the projects in a portfolio in the portfolio workbench.
  - decide to include new projects or exclude a few projects using portfolio planning view when the budget target changes during the fiscal year.
  - create the forecast plan for the portfolio with changed project estimates, and submits the plan to the investment committee for review.
  - update the forecast plan for the portfolio based on feedback from the investment committee and repromotes it.

As the portfolio manager, you can also view budgeted, actual, and forecasted cost for the projects in the ITFM Planning Workbench.

**Note:**
- The forecast period for the fiscal period must be open to create the forecast plan for a portfolio. For example, open the forecast period for FY17: Apr to create a forecast plan in April. The PPS admin can open the forecast period for a fiscal period by navigating to **Project Administration > Open/Close Forecast Periods**.
- The budget period for a fiscal period must be closed to open a forecast period for the corresponding fiscal period. The PPS admin can close the budget period for a fiscal period by navigating to **Project Administration > Open/Close Budget Periods**.
- Only one forecast period can be open at a time.

**Legacy: Create and promote a forecast plan**

As a portfolio manager, you can re-estimate (forecast) the portfolio budget for future periods based on the actual cost and changed project requirements.

**Note:** The content in this topic is applicable for customers upgrading from a previous release to Paris. If you are a new customer, see Scenario Planning for PPM.

- Role required: it_portfolio_manager
- The **Portfolio Planning** field for the portfolio must be set to Advanced on the Portfolio form.
- The forecast period for the fiscal period must be open to create the forecast plan for a portfolio. For example, the forecast period for FY17: Apr must be open to create a forecast plan in April. The PPS admin can open the forecast period for a fiscal period by navigating to **Project Administration > Open/Close Forecast Periods**.
- The budget period for a fiscal period must be closed to open a forecast period for the corresponding fiscal period. The PPS admin can close the budget period for a fiscal period by navigating to **Project Administration > Open/Close Budget Periods**.
• Only one forecast period can be open at a time.

1. Navigate to portfolio workbench and open the portfolio that you want to track.
2. Click **Promote Forecast Plan** under **Step 4: Forecasting**.

• The forecast plan for the portfolio is created and promoted for the selected forecast period. You can re-promote the forecast plan, if required.
• A task with the status **Pending Approval** is created when the portfolio manager promotes the forecast plan. The status of the task is visible in Portfolio Workbench.

• To view the task for the forecast plan, click the **Status** link. The finance reviews the portfolio forecast plans in the Planning Workbench and approves the plan.
• To view a list of all the promoted forecast plans for the portfolio, click the **All Promoted Forecast Plans** link under step 4: Forecasting. The promoted forecast plans are listed for all forecast periods.
• After the forecast plan is finalized and no further changes are expected, the forecast period must be closed.

**Legacy: Repromote a forecast plan**
If the portfolio forecasted cost has been modified, as the portfolio manager, you can repromote the forecast plan to reflect the changes reflected in the forecast plan.

**Note:** The content in this topic is applicable for customers upgrading from a previous release to Paris. If you are a new customer, see Scenario Planning for PPM.

• Role required: it_portfolio_manager
• To repromote a forecast plan for a portfolio, the **forecast period** for the selected fiscal period must be open.

**Note:** The PPS admin can also open and close the forecast period for a fiscal period by navigating to **Project Administration > Open/Close Forecast Periods**.

After creating the portfolio forecast plan, the investment committee reviews the plan. You can decide to modify the forecast plan for the demand and project to implement the changes suggested by the investment committee. The forecast plan can then be repromoted to reflect the changes in the forecast plan.

1. Navigate to portfolio workbench and open the portfolio that you want to track.
2. Click **Re-promote Forecast Plan** under **Step 4: Forecasting**.

The forecast plan is repromoted as the updated plan for the selected forecast period.

• To view a list of all the promoted forecast plans for the portfolio, click **All Promoted Forecast Plans** link under step 4: Forecasting. The promoted forecast plans are listed for all forecast periods.
• After the forecast plan is re-promoted and no more changes are expected, the forecast period must be closed.

**Legacy: Track the portfolio**
After you complete financial planning, you can start tracking the progress of the portfolio. The portfolio tracking view displays only the selected demands and projects in the portfolio.

Role required: it_portfolio_manager
Note: The content in this topic is applicable for customers upgrading from a previous release to Paris. If you are a new customer, see Scenario Planning for PPM.

Once the financial planning is complete, the Track Portfolio action in the portfolio workbench is enabled to start tracking the progress of the portfolio.

Watch this three-minute video to learn more about tracking your portfolio.

1. Navigate to portfolio workbench, and open the portfolio that you want to track.
2. In the Fiscal Year choice list, select the fiscal year and click Track Portfolio.
3. In the timeline view, right-click a project or a demand and select:
   - Edit to edit the project or the demand.
   - Planning Console to open the project planning console. The option is available only for projects.
   - Status Report to open the most recent project status report. The option is available only for projects.
4. In the timeline view, review the external dependencies between projects in a portfolio.
5. On the Project KPI tab, view the most recent status such as overall health, schedule, cost, resources, and scope of all selected projects in the portfolio.
6. Review these charts:
   - Cost (Planned vs. Actual) to track the actual costs from all selected projects in the portfolio compared to the planned cost.
   - Resource (Allocated vs. Actual) to track the actual resource time spent on all project tasks versus the resource hours allocated to execute the selected projects and demands in the portfolio.
7. To see the risks, issues, and the project change requests across all selected projects in the portfolio, use the Risks, Issues, and Changes tabs.

Legacy: Forecast the budget for portfolio.

Legacy: Tracking view in portfolio workbench
Once the financial planning is complete, the Track Portfolio option in portfolio workbench is enabled. You can track the progress of demands and projects, and monitor the status of cost, resource, schedule, and scope for the selected fiscal period for the portfolio.

Note: The content in this topic is applicable for customers upgrading from a previous release to Paris. If you are a new customer, see Scenario Planning for PPM.

The portfolio workbench comprises the following components in tracking view:

Timeline View: The tab displays a list of the selected demands and projects that are part of the portfolio, and a Gantt chart over time.

On the Timeline View tab, you can:
   - configure the colors of the portfolio items in the Gantt chart with Dashboard Configuration settings.
   - select the zoom level in the Gantt chart calendar to Auto Fit. The Gantt view fits in one page to view entire timeline without using the scrollbar.
   - review the external dependencies between projects in a portfolio.
Note: The admin can customize which columns appear in the column filter list in the timeline view.

Project KPI: The tab displays the most recent status of project KPIs such as overall health, schedule, cost, resources, and scope of all the selected projects in the portfolio. This information is populated from the most recent status report created for the projects.

You can:
- click the name of a project on the tab to open the latest status report created for the project.
- point to a status indicator for a project KPI to view the comments entered for the KPI for that project.

Cost (Planned vs. Actual): The chart displays the actual costs from all selected projects in the portfolio compared to the planned cost. The actual cost for projects is derived from the expense lines.

Note: An expense line can be created manually for a project when a specific expense is incurred. For example, if hardware is procured for a project, an expense line can be created for the amount spent on procuring the hardware. If you receive an item using ServiceNow Procurement, an expense line is created automatically. For resource hours, the expense lines are created automatically when the time cards for the project are approved.

The display settings for the chart can be modified by selecting any of the following from the choice list:
- Capex: Displays the cost chart for capital expense only.
- Opex: Displays the cost chart for operating expense only.
- All: Displays the cost chart for both capital and operating expenses.

Resource (Allocated vs. Actual): The chart displays the actual resource time spent on all project tasks versus the resource hours allocated to execute the selected projects and demands in the portfolio. The actual time spent is taken from processed time cards for the projects.

Risks, Issues, and Changes: The tabs provide the following information:
- Risks: Displays risks concerning all the selected demands and projects in portfolio and their probability. This information is populated from the risks that are part of demands and projects associated with the portfolio.
- Issues: Displays all issues across all selected projects in the portfolio and their priority. This information is populated from the issues that are reported for the projects in a portfolio.
- Changes: Displays all project change requests across all selected projects in the portfolio and their priority. This information is populated from the change requests created for the projects in a portfolio.
### Timeline View

<table>
<thead>
<tr>
<th>Name</th>
<th>Planned</th>
<th>Actual</th>
<th>Variance</th>
<th>Year - 2016</th>
</tr>
</thead>
<tbody>
<tr>
<td>ITBM Implementation Agile</td>
<td>$488K</td>
<td>$498K</td>
<td>-$10K</td>
<td></td>
</tr>
<tr>
<td>Implement Knowledge Management</td>
<td>$711.2K</td>
<td>$126.4K</td>
<td>$584.8K</td>
<td></td>
</tr>
<tr>
<td>Implement Mobile analytics for Financials</td>
<td>$183.3K</td>
<td>$280.8K</td>
<td>$97.5K</td>
<td></td>
</tr>
<tr>
<td>Implement Sales Quoting system</td>
<td>$125.1K</td>
<td>$125.4K</td>
<td>-$0.3K</td>
<td></td>
</tr>
<tr>
<td>Implement Workday-Agile</td>
<td>$893.7K</td>
<td>$102.8K</td>
<td>-$790.9K</td>
<td></td>
</tr>
<tr>
<td>Project Portfolio suite (PPS) Agile</td>
<td>$224.1K</td>
<td>$152.3K</td>
<td>$71.8K</td>
<td></td>
</tr>
<tr>
<td>ServiceNow apps Australia rollout</td>
<td>$120K</td>
<td>$119K</td>
<td>-$1K</td>
<td></td>
</tr>
<tr>
<td>Workforce Planning Tool</td>
<td>$777.8K</td>
<td>$738.8K</td>
<td>$39.0K</td>
<td></td>
</tr>
<tr>
<td>eCommerce through Mobile</td>
<td>$781.7K</td>
<td>$641</td>
<td>$140.0K</td>
<td></td>
</tr>
</tbody>
</table>

### Cost (Planned vs. Actual)

*Graph showing costs with Planned and Actual axes*

### Resource (Allocated vs. Actual)

*Graph showing resource allocation with Allocated and Actual axes*

### Risks

<table>
<thead>
<tr>
<th>Short description</th>
<th>Probability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Availability of new customised report formats</td>
<td>High</td>
</tr>
<tr>
<td>Poor team dynamics</td>
<td>Absolute</td>
</tr>
<tr>
<td>Overly optimistic schedule</td>
<td>Low</td>
</tr>
<tr>
<td>Timeline View</td>
<td>Project KPI</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Name</td>
<td>Overall</td>
</tr>
<tr>
<td>eComms through Mobile</td>
<td></td>
</tr>
<tr>
<td>General Ledger Upgrade</td>
<td></td>
</tr>
<tr>
<td>HR Core Modules Brazil Rollout</td>
<td></td>
</tr>
<tr>
<td>Implement Knowledge Management</td>
<td></td>
</tr>
<tr>
<td>Implement Mobile analytics for Financials</td>
<td></td>
</tr>
<tr>
<td>Implement Sales Quoting system</td>
<td></td>
</tr>
<tr>
<td>Implement Workday Agile</td>
<td></td>
</tr>
<tr>
<td>ITIM Implementation Agile</td>
<td></td>
</tr>
<tr>
<td>Loyalty program phase 2</td>
<td></td>
</tr>
<tr>
<td>Project Portfolio suite (PPO) Agile</td>
<td></td>
</tr>
<tr>
<td>Provide Loyalty Analytics</td>
<td></td>
</tr>
<tr>
<td>Servicenow apps Australia rollout</td>
<td></td>
</tr>
<tr>
<td>Servicenow apps</td>
<td></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Actual project costs

Actual project costs come after you create expense lines for cost plans or after human resources use time cards to create expense lines.

The system captures actual project costs from expense lines:

- **Expense lines from cost plans:** You can create expense lines from a cost plan. Allows you to specify the amount and date when the expense was incurred. The actual amount incurred is included in the cost plan after the expense line is processed.

- **Expense lines from timecards:** Human resources can record time for project work by using time cards. When time cards are approved, the system generates expense lines. After the expense lines are processed, the actual costs are recorded for the project. If you provide a resource plan when creating time cards, the cost plan name is derived from resource plan and cost is captured against the resource plan. If you do not provide a resource plan, the cost is captured against the project.

View actual project costs

When you are using Project Portfolio Management with Financials, you can view actual project costs on cost plans and projects.

Role required: it_project_manager

An expense line has to be processed to be considered for actual cost. The actual cost is recorded against the creation date of the expense line, not the processed date. The expense lines are created only for approved time cards.

Actual costs for projects also roll up to portfolios in the same way.

1. Navigate to Project > Projects > All.
2. Open the project for which you want to view the actual costs.
3. Click the Cost Plans related list.

**Scenario Planning for PPM**

The Scenario Planning for PPM application provides a central location for portfolio managers to create and track the roadmap for project execution for a given fiscal year. Optimize your budget and resource usage by creating and comparing different scenarios for your project and demand roadmap or resources.

A scenario is a collection of demands and projects that serves as a planning instance for the selected fiscal year to support funding decisions.

Eligible demands and projects in the portfolio are collected into a default or existing scenario of the planning cycle. You use the default or existing scenario as a basis to create additional scenarios. A demand or project can belong to more than one scenario in the current planning cycle but it cannot belong to more than one portfolio. For more information, see Create planning scenarios.

**Impact on portfolio planning using Portfolio Workbench**

Portfolio Workbench does not support a scenario-based portfolio planning. You can plan your portfolio in simple or advanced planning modes. In advanced mode, you can repromote budget plan and create a forecast plan. Starting with the Paris release, the Portfolio Workbench has been deprecated for new customers. For more information, see Portfolio Workbench.

With scenario-based planning, you can create multiple scenarios, compare them, and confirm or reconfirm a scenario.

If you are using the Portfolio Workbench for portfolio planning and want to switch to a scenario-based planning, note the following points:
After installing Scenario Planning for PPM, remove the Portfolio Workbench module and related link from the Portfolio form. The de-activation of Portfolio Workbench is required to avoid conflicts with two methods of planning and data corruption. For more information, see Enable or disable an application menu or module.

Use the Portfolio Planning related link or the Portfolio Planning Workbench module to navigate to Portfolio Planning Workbench.

All your existing selections of demands and projects for a portfolio appear as a default scenario when you open the Portfolio Planning Workbench. For more information, see Create planning scenarios.

Features

The Scenario Planning for PPM provides the following capabilities to portfolio managers:

- Plan your portfolio based on resource capacity for a single year or multiple years.
- Break down your multiple year portfolio planning in smaller planning windows for continuous tracking and planning adjustment.
- Allocate budget to demands and projects in your portfolio from Investment Funding.
- Create scenario-based plans for portfolios.
- Apply filters to refine your list of selected demands and projects in your portfolio.
- Experiment with different combinations of demands and projects in planning scenarios.
- View details of demands and projects that are not aligned with your strategic goals.
- Edit the way demands and projects are funded for each scenario.
- Compare different scenarios to assess outcomes of various project and demand combinations.
- Confirm a planning scenario that best aligns with your organizational objectives as your current portfolio plan.
- Override a previously confirmed planning scenario based on changing priorities and environment.
- View budget details such as actual and planned costs, benefits, projects, and demands not aligned to goals and strategies, and actual costs for the projects.
- View resource utilization and allocation.
- View demands and projects with over-allocated resources.

Install Scenario Planning for PPM

Install the Scenario Planning for PPM application from ServiceNow Store applications. Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Complete the following setup checklist for a smooth installation and configuration.

<table>
<thead>
<tr>
<th>Setup tasks</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify the that PPM Standard plugin (com.snc.financial_planning_pmo) is activated.</td>
<td>Navigate to Subscription Management &gt; Subscriptions in your instance. The list displays the subscriptions that your organization has purchased.</td>
</tr>
</tbody>
</table>
### Setup tasks

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify that the Investment Funding for PPM (com.snc.investment_planning_pmo) plugin is activated.</td>
</tr>
</tbody>
</table>

**Note:** This plugin needs to be activated only when you want to retrieve the target amount for a portfolio for annual type of planning from Investment Funding.

### Description

Navigate to **Subscription Management > Subscriptions** in your instance. The list displays the subscriptions that your organization has purchased.

---

**Role required: admin**

Activate the PPM Standard plugin (com.snc.financial_planning_pmo) in your ServiceNow instance before you install Scenario Planning for PPM. For more information see, [Activate PPM Standard (Project Portfolio Management)](#).

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the application using the filter criteria and search bar.
   
   You can search for the application by its name or ID. If you cannot find an application, you may have to request it from ServiceNow store.

   Visit the [ServiceNow Store](#) website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the [ServiceNow Store version history release notes](#).

3. Click **Install**.
4. In the Application installation dialog box, review the application dependencies.
   
   Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If there are any plugins or applications that need to be installed, you must install them before you can install Scenario Planning for PPM.

5. Optional: If demo data is available and you want to install it, click **Load demo data**.
   
   Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.

   **Important:** If you don’t load the demo data during installation, it’s unavailable to load later.

6. Click **Install**.

---

### Components installed with Scenario Planning for PPM

Several types of components are installed with the installation of the Scenario Planning for PPM application, including tables.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see [Find components installed with an application](#).
Tables installed with Scenario Planning for PPM

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portfolio Scenario</td>
<td>Stores portfolio planning scenario information such as name of the scenario, state of the scenario, fiscal year, and name of the portfolio to which the scenario belongs.</td>
</tr>
<tr>
<td>[sn_pw_scenario_pm_portfolio_scenario]</td>
<td></td>
</tr>
<tr>
<td>Portfolio Scenario Funding</td>
<td>Stores the funding information about the portfolio planning scenarios. The funding information includes the name of the scenario, operating budget, capital budget, total budget, and whether a demand or project is selected for execution.</td>
</tr>
<tr>
<td>[sn_pw_scenario_pm_portfolio_scenario_funding]</td>
<td></td>
</tr>
<tr>
<td>Portfolio Planning Window</td>
<td>Stores the planning window information of a portfolio for multi-year and resource capacity-based planning.</td>
</tr>
<tr>
<td>[sn_pw_scenario_pm_planning_window]</td>
<td></td>
</tr>
<tr>
<td>Scenario Planning Configuration</td>
<td>Stores the portfolio planning configuration information such as planning type and scope.</td>
</tr>
<tr>
<td>[sn_pw_scenario_pm_portfolio_scenario_configuration]</td>
<td></td>
</tr>
</tbody>
</table>

Annual and multi-year resource capacity-based planning

Plan your portfolios using scenarios for a single fiscal year or multiple years after analyzing utilization of resources against available capacity. Include demands and projects in all portfolios or a single portfolio to evaluate, prioritize, and select demands and projects that match your business objectives.

Plan your portfolio and select demands and projects that you want to execute within the target budget. Create scenarios to analyze your portfolio's alignment with the organization's business objectives. The Scenario Planning for PPM application enables you to evaluate multiple sets of forecast scenarios and analyze investments consistently.

Annual financial and resource capacity-based planning

Plan your portfolio for a single fiscal year. You can select all your portfolios or a single portfolio for planning. After selecting your portfolio, you can create multiple scenarios to evaluate the demands and projects based on total cost, resource usage and capacity, and strategic objectives.

In the annual planning, you create scenarios with different combinations of demands and projects from a specific portfolio or all portfolios for a specific financial year. Based on your selection of demands and projects, analyze the resource allocation for the selected demands and projects derived from the associated resource plans. After analyzing the resource availability and capacity, modify your selection of demands and projects in different scenarios and confirm a scenario that maximizes your returns and add financial value to the organization.

Important: The default configuration is Annual Financial and Resource Capacity Based Planning and Single Selected Portfolio for new installation or upgrade. You can change the planning configuration to plan for multiple years and all portfolios.

Investment funding integration

Integrate Scenario Planning for PPM with Investment Funding to retrieve the target amount for a portfolio or all portfolios from a top-level investment fund for annual financial and resource capacity-based planning.
If you are planning for a single portfolio, the target amount of that portfolio is retrieved from the New Fund column for that portfolio investment and fiscal period in a top-level investment. If you are planning for all portfolios, you can configure the funding entity for which the organization must be funded, and then the investment planner can add funds for that particular entity in a top-level investment. For example, if your organization is a business unit, you can enable that business unit as the funding entity, and all the funds allocated to that business unit are set as the target for your organization.

**Multi-year, resource capacity-based planning**

Multi-year planning enables you to plan your portfolio using a planning window ranging from three to 24 months. If your portfolio consists of demands and projects spanning more than one year or if you are planning for a longer duration, you can plan your portfolio in smaller planning windows. The multi-year planning enables you to analyze resource usage for different demands and projects during the selected planning window and adjust your priorities to accommodate any changes to budget, resources, or business environment.

In the multi-year planning, you create scenarios similar to the annual planning, but for a specified planning window for a specific portfolio or all portfolios. Based on your selection of demands and projects, analyze the resource allocation for the selected planning window. After analyzing the resource availability and capacity, modify your selection of demands and projects in different scenarios and confirm a scenario that maximizes your returns and add financial value to the organization.

**Configure the scenario planning type and scope**

Configure the scenario planning type and select the scope of portfolios to determine the way you want to plan and work on your portfolios. You can also specify using Investment Funding for funding demands and projects in your portfolios.

**Important:** Modifying the planning type and scope deletes all your existing scenarios and confirmed plans.

Role required: it_pps_admin

The option to use Investment Funding for funding your portfolios is available only when you activate the Investment Funding for PPM plugin.

1. Navigate to **Project > Portfolios > Configure Planning**.
2. Open the scenario planning configuration record.
3. Configure the planning type and scope.

<table>
<thead>
<tr>
<th>Planning type</th>
<th>Steps</th>
</tr>
</thead>
</table>
| If you want to plan for a single fiscal year and single portfolio | a. Select Annual Financial and Resource Capacity Based Planning from the Planning Type list.  
  b. Select Single Selected Portfolio from the Planning Scope list. |
| If you want to plan for a single fiscal year and all portfolios | a. Select Annual Financial and Resource Capacity Based Planning from the Planning Type list.  
  b. Select All Portfolios from the Planning Scope list. |
<table>
<thead>
<tr>
<th>Planning type</th>
<th>Steps</th>
</tr>
</thead>
</table>
| If you want to plan for multiple years and single portfolio | a. Select **Multi-Year Resource Capacity Based Planning** from the Planning Type list.  
|                                                        | b. Select **Single Selected Portfolio** from the Planning Scope list.  
|                                                        | c. Select your default planning duration from the **Default Planning Window** list.  
|                                                        | When you select a planning window, all the demands and projects falling within the selected duration appear on the Portfolio Planning Workbench.  |
|                                                        | **Note:** This option is available only when the Investment Funding for PPM (com.snc.investment_planning_pmo) plugin is active and planning type is selected as **Annual Financial and Resource Capacity Based Planning**.  |
| If you want to plan for multiple years and all portfolios | a. Select **Multi-Year Resource Capacity Based Planning** from the Planning Type list.  
|                                                        | b. Select **All Portfolios** from the Planning Scope list.  
|                                                        | c. Select your default planning duration from the **Default Planning Window** list.  |

4. **Optional:** If you want to enable selection of demands and projects that are in completed or inactive state, select **Allow Selection of Completed Projects**.

5. **Optional:** If you want to retrieve the target amount from Investment Funding, select **Investment Funding Integration**.

6. **Click Update.**

The scenario planning configuration is updated and all scenario plans and confirmed plans are deleted. The configuration changes also updates the Portfolio Planning Workbench to enable you to do scenario planning based on the updated planning type and scope.
Impact of modifying the scenario planning type and scope
Modifying the planning type and scope impacts the demands and project selection in your planning scenarios and portfolio planning. You can change the planning type and scope at any time during portfolio planning.

Changing the planning type

Changing the planning type affects your portfolio planning regardless of whether the portfolio has any confirmed plan or planning scenarios in it at the time of this change.

From annual financial planning to multi-year, resource capacity based planning
This change in the planning type has the following impact on your confirmed plans and planning scenarios:
- Deletes all scenarios and scenario funding records.
- A default scenario is created with the current month as starting month and a default of 3-month planning window.

From multi-year, resource capacity based planning to annual financial planning
This change in the planning type has the following impact on your confirmed plans and planning scenarios:
- Deletes all scenarios and scenario funding records.
- If you were previously using annual planning, the target budget is retrieved. If not, the current fiscal year is set as default and you must set the target budget.

Changing the planning window

Changing the planning window effects all the users involved in planning and has the following impact on your portfolio planning:
- The new planning window applies to all scenarios and the confirmed plan of every portfolio.
- A demand or project outside of the selected planning window cannot be selected or deselected. However, the value of Planned check box for the project or demand will not change. These demands and projects continue to be related to the scenario.
- When you confirm a scenario, only the demands and projects that fall in the planning window are confirmed, the demands and projects outside the planning window are not confirmed.

Changing the planning scope

Changing the planning scope from a single selected portfolio to all portfolios has the following impact on your confirmed plans and planning scenarios:
- In case of annual planning, creates a portfolio planning record in the Tracking state if a confirmed plan exists for any of the portfolios.
- In case of annual planning, creates a confirmed plan for all the fiscal years with at least one confirmed plan for any of the portfolios.
- In case of multi-year planning, your confirmed plans for the portfolios are retained.
- Deletes all existing scenarios and scenario funding records.
**Set target budget for a fiscal year**

When planning for a portfolio or all portfolios, start by selecting the fiscal period for the demands and projects that you want to work with. You then set the target amounts for both operating and capital expenses of portfolios when Scenario Planning is not integrated with Investment Funding.

Role required: it_portfolio_manager or it_pps_admin

Internal groups typically provide the target amount for a fiscal year. The target for the planned fiscal year can be 110% of the amount spent in the last year based on actual expenditure. The target is the starting point for planning projects for the next fiscal year.

**Note:** The PPS admin can set the portfolio target by navigating to Project Administration > Enter Portfolio Target.

If Scenario Planning is integrated with Investment Funding, the target amount is retrieved from the top investment fund allocated for a single portfolio or all portfolios.

For information on how to configure the investment funding settings for a single portfolio or all portfolios, see the Configure the scenario planning type and scope topic.

For information on creating a top level investment and allocating funds, see the Create a top-level investment topic.

1. Navigate to Portfolio Planning Workbench from either of two starting points.

<table>
<thead>
<tr>
<th>Location</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>From application navigator</td>
<td></td>
</tr>
<tr>
<td></td>
<td>a. Navigate to Project &gt; Portfolios &gt; Portfolio Planning Workbench.</td>
</tr>
<tr>
<td></td>
<td>b. From the Portfolio choice list, select the portfolio that you want to perform the planning for.</td>
</tr>
</tbody>
</table>

   | From the portfolio list   |       |
   |                           | a. Navigate to Project > Portfolios > All. |
   |                           | b. Open the portfolio that you want to perform the planning for. |
   |                           | c. In the Portfolio form, click the Portfolio Planning related link. |

2. In the Portfolio Planning Workbench Fiscal Year choice list, select the year that you want to perform the planning for.

   You can perform financial planning for only one fiscal period at a time.

3. Set or update the target budget amount.
   - If you are planning for the selected fiscal year for the first time, click Set Target.
   - If you have already set the target budget amount for the selected fiscal year and you want to change the amount, click Edit Target.

4. In the Set Target dialog box, enter the amounts for **Capex Target** and **Opex Target**.

5. Click Save.

The portfolio capital and operational expense target for different fiscal years are updated in the Portfolio Target related list on the portfolio record.

Start creating scenarios for portfolio planning. For more information, see Create planning scenarios.
Create planning scenarios

Create planning scenarios with different combinations of projects and demands in your portfolio. Experiment with different scenarios to plan your budget expenditure for a fiscal year or planning window.

Ensure that you have set the target budget for the fiscal year for which you want to create a planning scenario for annual type of planning. For more information, see Set target budget for a fiscal year. Setting of target is not required for multi-year resource capacity type of planning.

Role required: it_portfolio_manager

You can create up to four planning scenarios with different combinations of projects and demands for execution. For example, you might create a scenario A and select all the projects and demands with your standard resource allocation. If you’re aware that a risk might affect the business outcome, you can create a scenario B with a reduced number of projects and demands to see whether that strategy might mitigate or avoid the risk. For more information about defining scenarios, see Scenario Planning for PPM.

1. Navigate to the Portfolio Planning Workbench from either of two starting points.

<table>
<thead>
<tr>
<th>Location</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>From application navigator</td>
<td>a. Navigate to Project &gt; Portfolios &gt; Portfolio Planning Workbench.</td>
</tr>
<tr>
<td></td>
<td>b. From the Portfolio choice list, select the portfolio that you want to perform the planning for.</td>
</tr>
<tr>
<td>From the portfolio list</td>
<td>a. Navigate to Project &gt; Portfolios &gt; All.</td>
</tr>
<tr>
<td></td>
<td>b. Open the portfolio that you want to perform the planning for.</td>
</tr>
<tr>
<td></td>
<td>c. In the Portfolio form, click the Portfolio Planning related link.</td>
</tr>
</tbody>
</table>

2. In the Planning Portfolio Workbench, create a scenario for annual financial and resource capacity based planning or multi-year resource capacity based planning.

   • For annual planning, perform the following steps:

   a) Select the fiscal year for which you want to create a planning scenario.

   b) Click the Start Planning button on the Welcome page.

   A default planning scenario is created with all active demands and projects for the selected fiscal year.

   **Note:** If a portfolio plan exists for the selected fiscal year, the Portfolio Planning Workbench displays it as the current plan.

   c) Click the create scenario icon (+).

   d) In the Create Scenario dialog box, enter a name and short description for the scenario.

   e) In the Copy Data From list, select the source for copying data.

   The available options are:

   • **None**: Creates a scenario with no projects or demands selected.

   • **Ongoing projects funded last year**: Creates a scenario using projects funded during the previous year and continuing in the current year selected. This option is available only if an
existing approved plan for the previous year exists. This is the default option when you create an initial scenario for a given fiscal year.

- **A list of other scenarios:** Creates a scenario using projects and demands selected from another existing scenario. This option is available if other scenarios exist for the same portfolio for the same fiscal year.
- **Confirmed Plan:** Creates a scenario with projects and demands selected from the existing approved plan. This option is available only if a confirmed plan exists for the current fiscal year.

f) **Click Save.**

- For multi-year planning, a default plan is automatically created with the current month as the starting month, and the planning window period as configured in the Scenario Planning Configuration page. To create a new scenario, perform the following steps:

a) Click the create scenario icon ( ).

b) In the Create Scenario dialog box, enter a name and short description for the scenario.

c) In the Copy Data From list, select the source for copying data.

The available options are:

- **None:** Creates a scenario with no projects or demands selected.
- **Ongoing projects funded last year:** Creates a scenario using projects funded during the previous year and continuing in the current year selected. This option is available only if an existing approved plan for the previous year exists. This is the default option when you create an initial scenario for a given fiscal year.
- **A list of other scenarios:** Creates a scenario using projects and demands selected from another existing scenario. This option is available if other scenarios exist for the same portfolio for the same fiscal year.
- **Confirmed Plan:** Creates a scenario with projects and demands selected from the existing approved plan. This option is available only if a confirmed plan exists for the current fiscal year.

d) **Click Save.**

The planning scenario is created and displayed in a new tab.

**Select projects and demands for execution** in the planning scenario.

**Select demands and projects for portfolio planning**

After you create a planning scenario, select the demands and projects to include in budget planning. You can view all the demands and projects for the selected fiscal year or planning window with their planned cost and priorities to finalize them for execution.

You should have at least one planning scenario. For more information, see [Create planning scenarios](#).

Role required: `it_portfolio_manager`

You can perform a what-if analysis by including or excluding demands or projects and their planned cost for annual type of planning. The planned cost is derived from all the cost plans created for a project or demand. It is the total of all the costs from all cost plans for a given project or demand in the fiscal year or planning window.
You can perform a what-if analysis by including or excluding demands or projects and their planned cost, budget, and utilization for multi-year resource capacity type of planning.

1. Navigate to Portfolio Planning Workbench from either of two starting points.

<table>
<thead>
<tr>
<th>Location</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>From application navigator</td>
<td>a. Navigate to <strong>Project &gt; Portfolios &gt; Portfolio Planning Workbench.</strong></td>
</tr>
<tr>
<td></td>
<td>b. From the <strong>Portfolio</strong> choice list, select the portfolio that you want to perform the planning for.</td>
</tr>
<tr>
<td>From the portfolio list</td>
<td>a. Navigate to <strong>Project &gt; Portfolios &gt; All.</strong></td>
</tr>
<tr>
<td></td>
<td>b. Open the portfolio that you want to perform the planning for.</td>
</tr>
<tr>
<td></td>
<td>c. In the Portfolio form, click the <strong>Portfolio Planning</strong> related link.</td>
</tr>
</tbody>
</table>

2. In the Portfolio Planning Workbench, click the scenario for which you want to include or exclude demands and projects.

3. Optional: Compare and evaluate the relative standing of demands using the **Bubble Chart** tab. Right-click a demand and select **Select for execution** from the context menu to include a demand in portfolio planning. For more information, see **Demand workbench bubble chart**. You can search for specific demands by applying filters using the **Filter( )** icon.

**Note:** The **Bubble Chart** tab is not available for Multi-year Resource Capacity Based Planning configuration.

4. Include or exclude demands and projects from planning in the **Timeline View** tab by selecting or clearing the check boxes next to each project or demand.

You can search for specific demands and projects in the timeline by applying filters using the **Filter( )** icon.

The number of selected project and demands is updated in the **Selected Items** section of the **Overview** tab.

5. Optional: Review the external dependencies between the selected projects in your portfolio. For more information, see **Review external dependencies between projects.**

6. Review the information in the Overview section on the right, and the **Resources** tab to evaluate and adjust your selection of the demands and projects to be included in the plan.

Review the following sections in the **Overview** tab:

- Total budget versus the targets that you entered in the **Set Target** stage in the **Budget vs. Target** section for annual type planning. If the total budget is more than the target cost, an exception icon
is shown with the total planned cost.

- Total planned cost for all the projects and demands for multi-year type planning in the Total Planned Cost section.
- Potential benefit amount that would accrue on execution of the selected demands and projects in the Benefit Amount section.

**Note:** For multi-year resource capacity type planning, the total value of planned cost and benefit for the entire duration of the projects or demands is displayed irrespective of the selected planning window.

- Strategic alignment of your portfolio by viewing the number of demands and projects that are not associated with any organizational strategy or goal in the Unaligned section.
- Number of assignment groups where, for any quarter of the selected fiscal year, the number of requested hours is greater than the total hours capacity in the Overallocated Groups section.
- Review how much in actuals have been spent on the projects selected for execution and the rest of the projects in your portfolio in the Actuals section.

**Note:** For multi-year resource capacity type planning, the actuals value is displayed in the widget without the selected and unselected project actual legends.

The following image shows an example of how the portfolio information is displayed in the Overview section for annual type planning.
The following image shows an example of how the portfolio information is displayed in the Overview section for multi-year type planning.
Review the following sections of the **Resources** tab:
View percentage of utilization for all the resources requested by the selected demands and projects of the portfolio in a heat map. You can view the percentage utilization of all resource groups or overallocated resource groups in months or quarters.

**Tip:** Click any cell in the heat map to view the project or demand associated with the selected resource group.

The following image shows an example of how the resource information is displayed in the heat map.
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysts</td>
<td>31</td>
<td>34</td>
<td>33</td>
<td>55</td>
<td>102</td>
<td>107</td>
</tr>
<tr>
<td>Architects</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>5</td>
<td>7</td>
<td>13</td>
</tr>
<tr>
<td>Core R&amp;D group</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>10</td>
</tr>
<tr>
<td>Database Admin</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>15</td>
</tr>
<tr>
<td>Java Developers</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>16</td>
<td>30</td>
<td>28</td>
</tr>
<tr>
<td>Network</td>
<td>5</td>
<td>4</td>
<td>4</td>
<td>9</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td>Technical Support</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>8</td>
<td>11</td>
<td>16</td>
</tr>
</tbody>
</table>
Tip: To bring the planned cost within the target budget and the resource utilization within 100%, consider deselecting a few low-priority demands or projects. Deselected demands and projects could then be moved over to a different fiscal period.

7. Optional: Review the capex and opex budget for individual projects and demands directly using **Capex Budget** and **Opex Budget** columns and revise it if necessary.

Note: Click the Show or hide columns ( ) in the **Timeline View** tab and add the **Capex Budget** and **Opex Budget** columns if these columns are not visible.

8. Optional: Update the name and short description by clicking the edit icon ( ) and making the modifications.

9. Optional: Delete the scenario by clicking the delete icon ( ).

10. Optional: Convert the selected scenario to become the current plan by clicking **Confirm**.

11. Optional: Create more planning scenarios to compare them.

12. Optional: Manually refresh the cost and resource widgets after a demand or a project is selected or cleared for execution by clicking the Refresh icon ( ).

Compare planning scenarios to analyze different combinations of projects and demands and select a scenario that best aligns with your organizational goals. For more information, see **Compare planning scenarios**.

**Review external dependencies between projects**

Review the external dependencies between projects in a portfolio to track projects that are dependant on each other more closely.

Role required: it_portfolio_manager

Open demands and projects in the timeline view of the Portfolio Planning Workbench.

As a portfolio manager, you may want to know the projects which are dependent on each other so that these projects can be tracked more closely.

For example, project B is dependent on project A (external soft dependency) and you want to make sure that project A is executed on time so that the schedule of project B is not affected. The **Dependencies** column shows that there is an outgoing external dependency from project A and an incoming external dependency to project B. You can use the incoming dependency to determine whether a delay in project A will affect project B.

1. Click the show or hide columns in gantt icon ( ) in the timeline view and add the **Dependencies** column if it is not visible.

   The number of incoming and outgoing external dependencies are displayed, if any.

2. Click the external dependency in **Dependencies** column for the project.

3. In the **Dependencies** pop-up dialog, click a tab to review the dependency:

   **Inbound tab**

   Tasks that have an incoming dependency from a project are listed.
Outbound tab

Tasks with an outgoing dependency to the project are listed.

Example of external dependencies between projects.

4. Click the project number in a tab to open and review the linked project in the planning console view.

Rank demands and projects

Rank demands and projects to prioritize demands and projects for their approval and execution within a portfolio.

Role required: it_portfolio_manager

By default, the Rank By Score list ranks demands and projects based on system-generated scores. Rank of a demand or project is specific to a fiscal year. A project can be ranked as third in FY17 but ranked sixth in FY18.

1. Navigate to Portfolio Planning Workbench from either of two starting points.

<table>
<thead>
<tr>
<th>Location</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>From application navigator</td>
<td>a. Navigate to Project &gt; Portfolios &gt; Portfolio Planning Workbench.</td>
</tr>
<tr>
<td></td>
<td>b. From the Portfolio list, select the portfolio that you want to perform the planning for.</td>
</tr>
</tbody>
</table>
### Location

#### From the portfolio list

- **a.** Navigate to Project > Portfolios > All.
- **b.** Open the portfolio that you want to perform the planning for.
- **c.** In the Portfolio form, click the **Portfolio Planning** related link.

### 2. Optional: Adjust the rank automatically or manually.

#### Adjust the rank automatically

- **a.** Go to the **Timeline View** tab of the **Plan** tab of the Portfolio Planning Workbench.
- **b.** Sort the projects and demands by the currency or number attribute such as ROI%, priority, and planned cost by which you want to rank the projects and demands.
- **c.** Click **Adjust Rank** to fill gaps in ranks if some projects are moved to the next fiscal year or canceled.

  For example, if the ranks after moving or canceling some projects are 1, 2, and 5, this action adjusts the ranks as 1, 2, and 3.

- **d.** Click **Rank By Visual Sort** to rank projects and demands based on the attribute you chose.

#### Adjust the ranks manually

- **a.** Go to the **Timeline View** tab of the **Plan** tab of the Portfolio Planning Workbench.
- **b.** Edit the **Rank** field.

  When you change the rank of a project or demand, the ranks of other projects or demands adjust automatically. For example, if the rank for a project ranked as number 2 changes to number 4, the project ranked number 3 automatically assumes rank 2.

The following table explains manual adjustment of ranks.

<table>
<thead>
<tr>
<th>Scenario for edit rank</th>
<th>Rank update</th>
<th>Rank before manual edit</th>
<th>Rank after manual edit</th>
</tr>
</thead>
<tbody>
<tr>
<td>If initial rank is 0 or blank and other ranks are present, then after edit, the successive ranks get incremented by 1.</td>
<td>Initial rank: 0&lt;br&gt;Edited rank: 2</td>
<td>Task_1: 0&lt;br&gt;Task_2: 1&lt;br&gt;Task_3: 2&lt;br&gt;Task_4: 3</td>
<td>Task_2: 1&lt;br&gt;<strong>Task_1: 2</strong>&lt;br&gt;Task_3: 3&lt;br&gt;Task_4: 4</td>
</tr>
<tr>
<td>If initial rank &gt; edited rank, then after edit, the successive ranks get incremented by 1.</td>
<td>Initial rank: 4&lt;br&gt;Edited rank: 1</td>
<td>Task_1: 1&lt;br&gt;Task_2: 2&lt;br&gt;Task_3: 3&lt;br&gt;<strong>Task_4: 4</strong></td>
<td><strong>Task_4: 1</strong>&lt;br&gt;Task_1: 2&lt;br&gt;Task_2: 3&lt;br&gt;Task_3: 4</td>
</tr>
</tbody>
</table>
## Scenario for edit rank

<table>
<thead>
<tr>
<th>Scenario for edit rank</th>
<th>Rank update</th>
<th>Rank before manual edit</th>
<th>Rank after manual edit</th>
</tr>
</thead>
<tbody>
<tr>
<td>If initial rank &lt; edited rank and there is no gap in rank sequence, then after edit,</td>
<td>Initial rank: 1</td>
<td>Task_1: 1</td>
<td>Task_2: 1</td>
</tr>
<tr>
<td>the previous ranks get decremented by 1.</td>
<td>Edited rank: 3</td>
<td>Task_2: 2</td>
<td>Task_3: 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Task_3: 3</td>
<td>Task_1: 3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Task_4: 4</td>
<td>Task_4: 4</td>
</tr>
</tbody>
</table>

If initial rank < edited rank and there is a gap in rank sequence, then after edit, the successive ranks get incremented by 1.

<table>
<thead>
<tr>
<th>Scenario for edit rank</th>
<th>Rank update</th>
<th>Rank before manual edit</th>
<th>Rank after manual edit</th>
</tr>
</thead>
<tbody>
<tr>
<td>If initial rank &lt; edited rank and there is a gap in rank sequence, then after edit,</td>
<td>Initial rank: 1</td>
<td>Task_1: 1</td>
<td>Task_2: 2</td>
</tr>
<tr>
<td>the successive ranks get incremented by 1.</td>
<td>Edited rank: 4</td>
<td>Task_2: 2</td>
<td>Task_1: 4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Task_3: 4</td>
<td>Task_3: 5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Task_4: 5</td>
<td>Task_4: 6</td>
</tr>
</tbody>
</table>

### Compare planning scenarios

Compare various planning scenarios with your current or default plan to assess different combinations of projects and demands in your portfolio for execution. You can perform a what-if analysis and determine the planning scenario that optimally achieves the target budget and uses your resources.

Ensure that you have created up to four planning scenarios and selected projects and demands for execution. For more information, see [Create planning scenarios](#) and [Select demands and projects for portfolio planning](#).

**Role required:** it_portfolio_manager

1. Navigate to Portfolio Planning Workbench from either of two starting points.

   **Location** | **Steps**
   --- | ---
   From application navigator | a. Navigate to **Project > Portfolios > Portfolio Planning Workbench**.  
   b. From the **Portfolio** list, select the portfolio that you want to perform the planning for.
   
   From the portfolio list | a. Navigate to **Project > Portfolios > All**.  
   b. Open the portfolio that you want to perform the planning for.  
   c. In the Portfolio form, click the **Portfolio Planning** related link.

2. In the **Plan** tab of the Portfolio Planning Workbench, click **Compare Scenarios**.  
   The Compare Scenarios page displays all the planning scenarios.

3. Compare different aspects of the scenarios such as costs, number of projects and demands, benefit amount, and actuals for the selected projects and demands.

4. Compare the variance between the scenarios for costs, number of projects and demands, benefit amount, actuals for the selected projects and demands, and so on.

   The variance value for different fields is displayed in red or green color. For example, if the planned cost of a scenario is greater than the planned cost of the confirmed plan, the planned cost variance is displayed in red. Or if the benefit amount of a scenario is greater than the benefit amount of the confirmed plan, the benefit amount variance is displayed in green.

Confirm a scenario that best aligns with your organizational objectives, optimally achieves your target budget, and uses your resources. For more information see, [Confirm a planning scenario](#).
Confirm a planning scenario

Select and confirm a scenario to allocate budget and resources for executing the selected demands and projects in a fiscal year.

Ensure that you have created up to four planning scenarios and selected projects and demands for execution. For more information, see Create planning scenarios and Select demands and projects for portfolio planning.

Role required: it_portfolio_manager

1. Navigate to Portfolio Planning Workbench from either of two starting points.

<table>
<thead>
<tr>
<th>Location</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>From application navigator</td>
<td>a. Navigate to Project &gt; Portfolios &gt; Portfolio Planning Workbench.</td>
</tr>
<tr>
<td></td>
<td>b. From the Portfolio list, select the portfolio that you want to perform the planning for.</td>
</tr>
<tr>
<td>From the portfolio list</td>
<td>a. Navigate to Project &gt; Portfolios &gt; All.</td>
</tr>
<tr>
<td></td>
<td>b. Open the portfolio that you want to perform the planning for.</td>
</tr>
<tr>
<td></td>
<td>c. In the Portfolio form, click the Portfolio Planning related link.</td>
</tr>
</tbody>
</table>

2. In the Project Planning Workbench, confirm a scenario as your current plan for the fiscal year using one of the following options:

   - Select a scenario and click Confirm.
   - Click Compare Scenarios and, in the Compare Scenarios page, click Confirm Scenario.
   - If you are overriding an already confirmed plan, click Override.

3. In the Confirm dialog box, set additional options to be performed on the selected demands and projects after the planning scenario is saved.

   **Note:** When a confirmed plan exists, the name of the dialog box is Override Selection rather than Confirm.

   - If the project property Create project(s) on confirming demands from portfolio workbench is set to false, you can choose to approve all the selected demands after the save by selecting Approve all selected demands (if not approved already).
   - If the project property Create project(s) on confirming demands from portfolio workbench is set to true, you can choose to convert the selected demands to projects after the save by selecting Convert all the selected demands to projects.
   - Confirm the resources for selected demands and projects by selecting Confirm resources for selected demands or projects.
   - If the confirmed and allocated resource plans associated with the demands and projects that are newly unselected do not have any actual hours associated with them, then select Unconfirm the resources for the unselected demands and projects (only those resources where there is no actual hours/cost captured will be unconfirmed) to change the state of such resource plans to requested. If the confirmed and allocated resource plans have actuals associated with them,
a notification is send to the project or demand managers specifying that they need to manually release such resources.

- Delete all the unconfirmed working scenarios after confirmation of the selected scenario by selecting **Delete all working scenarios**. This option is selected by default.

4. Click **Save**.

Budget is allocated to selected demands and projects. The remaining demands and projects are removed from execution. However, resources already confirmed for the unselected demands and projects are not removed automatically.

**Track the progress of a portfolio**

After confirming a scenario to complete planning of your portfolio, track the progress of the portfolio. You can also monitor the status of cost, resource, schedule, and scope for the selected fiscal period or planning window for the portfolio.

Role required: it_portfolio_manager

1. Navigate to Portfolio Planning Workbench from either of two starting points.

<table>
<thead>
<tr>
<th>Location</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>From application navigator</td>
<td>a. Navigate to Project &gt; Portfolios &gt; Portfolio Planning Workbench.</td>
</tr>
<tr>
<td></td>
<td>b. From the Portfolio choice list, select the portfolio that you want to perform the planning for.</td>
</tr>
<tr>
<td>From the portfolio list</td>
<td>a. Navigate to Project &gt; Portfolios &gt; All.</td>
</tr>
<tr>
<td></td>
<td>b. Open the portfolio that you want to perform the planning for.</td>
</tr>
<tr>
<td></td>
<td>c. In the Portfolio form, click the Portfolio Planning related link.</td>
</tr>
</tbody>
</table>

2. In the Portfolio Planning Workbench, click the **Track** tab. The status of projects and demands is displayed in the **Timeline View** tab with a Gantt chart over time and a **KPIs** tab.

3. Track the progress of your portfolio by reviewing the status of key parameters in the **Timeline View** tab.

   - Details such as planned and actual costs, variance, planned start and end dates, and priorities for the selected demands and projects.
   - Identify the projects that are dependent on each other by viewing external dependencies between projects in a portfolio. For more information, see **Review external dependencies between projects**.
   - Track the current status of an individual project by viewing the latest project status report by selecting the **Status Report** option.
   - Track the progress of project tasks in an individual project in your portfolio using the **Planning Console** option. This option is available in the context menu for a project.
4. Check status information such as the overall health, schedule, cost, resources, and scope of all selected projects in the portfolio in the Project KPIs tab. The most recent status report created for a project populates this information. Point to a status indicator to view comments entered by the project manager for that KPI.

**Note:** A grey X icon ( ) next to any project KPI indicates that the project manager has not entered any comments for that aspect in the status report.

5. Review cost and resource-related information in the Cost (Budget vs. Actual) and Resource (Allocated vs. Actual) charts.
   - View the comparison of actual costs from all selected projects in the portfolio with the planned cost shown in the Cost (Budget vs. Actual) chart. The actual cost for projects is derived from the expense lines.

**Note:** The Cost (Budget vs. Actual) graph is not available for multi-year type planning.

   - You can view only Capex or Opex or both by selecting the respective option from the list.
   - Check how the allocated resources are being used by viewing the comparison of actual resource time spent on all project tasks with the resource hours allocated to execute the selected projects and demands in the portfolio shown in the Resource (Allocated vs. Actual) chart. The actual time spent is taken from processed time cards for the projects.

6. Track the risks, issues, decisions, actions, and the project change requests across all selected projects in the portfolio by going to the Risks, Issues, Decisions, Actions, and Changes tabs.

**Portfolio Manager Dashboard**

Portfolio Manager Dashboard provides a central location to a portfolio manager to generate different graphical reports of the portfolios managed by them.

Portfolio Manager Dashboard, contains two different tabs to view the portfolio level reports and portfolio financials reports.

- **Portfolio tab:** Provides reports about open risks, open issues, active projects, key milestones, and demand pipeline for the portfolio. It also provides information about total open risks, total open issues, and total key milestones.
- **Portfolio Financial tab:** Provides reports about portfolio costs, and budgets. It also provides information about total programs, projects, and demands that are part of the portfolio.

To view different type of data, you can generate reports by grouping or by stacking. Each report has different categories for grouping and stacking. You can use a combination of **Group by** category and **Stack by** category to generate the reports.

**Access the Portfolio Manager Dashboard**

View different graphical reports on the Portfolio Manager Dashboard

Role required: it_portfolio_manager

Go to **Project > Portfolios > Portfolio Manager Dashboard.** The Portfolio Manager Dashboard is displayed.
Portfolio reports

Portfolio Manager Dashboard provides portfolio level reports about open risks, open issues, active projects, key milestones, and demand pipeline for the portfolio. The dashboard displays reports only for the portfolios managed by the portfolio manager.

To view different type of data, you can generate reports by grouping or by stacking. Each report has different filters for grouping and stacking. You can use a combination of **Group by** filter and **Stack by** filter to generate the reports.

Open Risk report

Provides information about open risks of the programs, projects, and demands that are part of the portfolio.

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top portfolio</td>
<td>Displays open risks by top portfolio.</td>
</tr>
<tr>
<td>Top program</td>
<td>Displays open risks by top programs.</td>
</tr>
<tr>
<td>Task</td>
<td>Displays open risks by tasks.</td>
</tr>
<tr>
<td>Probability</td>
<td>Displays open risks by probability.</td>
</tr>
</tbody>
</table>

Open Issues report

Provides information about open issues of the programs, projects, and demands that are part of the portfolio.

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top Portfolio</td>
<td>Displays open issues by top portfolio.</td>
</tr>
<tr>
<td>State</td>
<td>Displays open issues by state.</td>
</tr>
<tr>
<td>Impact</td>
<td>Displays open issues by impact.</td>
</tr>
<tr>
<td>Priority</td>
<td>Displays open issues by priority.</td>
</tr>
</tbody>
</table>

Active Projects report

Provides information about active projects per portfolio.

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portfolio</td>
<td>Displays the active projects by portfolio.</td>
</tr>
<tr>
<td>Short Description</td>
<td>Displays the active projects by short description.</td>
</tr>
<tr>
<td>Project Manager</td>
<td>Displays the active projects by project managers.</td>
</tr>
</tbody>
</table>

Key Milestones by Program report

Provides information about project and program key milestones per portfolio.
<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top Portfolio</td>
<td>Displays the key milestones by top portfolio.</td>
</tr>
<tr>
<td>State</td>
<td>Displays the key milestones by state.</td>
</tr>
<tr>
<td>Project</td>
<td>Displays the key milestones by projects.</td>
</tr>
</tbody>
</table>

**Demand Pipeline by Portfolio report**

Provides information about demands that are in pipeline per the portfolio according to when the demand was requested to be fulfilled.

**Portfolio financial reports**

Portfolio Manager Dashboard provides portfolio level financial reports related to portfolio costs and portfolio budgets. The dashboard displays reports only for the portfolios managed by a portfolio manager.

To view different type of data, you can generate reports by grouping or by stacking. Each report has different filters for grouping and stacking. You can use a combination of **Group by** filters and **Stack by** filters to generate the reports.

**Estimated Cost by Expense Type report**

Provides information about estimated capital and operational costs of portfolios and of the programs and projects in the respective portfolios.

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expense type</td>
<td>Displays estimated cost of portfolios grouped by the expense types.</td>
</tr>
<tr>
<td>Program</td>
<td>Displays estimated cost of portfolios grouped by programs.</td>
</tr>
<tr>
<td>Task</td>
<td>Displays estimated cost of portfolios grouped by tasks.</td>
</tr>
<tr>
<td>Fiscal period</td>
<td>Displays estimated cost of portfolios grouped by fiscal periods.</td>
</tr>
<tr>
<td>Portfolio</td>
<td>Displays estimated cost grouped by portfolios.</td>
</tr>
</tbody>
</table>

**Estimated Cost by Cost Type report**

Provides information about estimated costs of portfolios, as well as of the programs and projects in the respective portfolios, by the cost types. The examples of cost types are hardware, software, labor, and so on.

**Budget Allocation by Expense Type report**

Provides information about budgeted capital and operational costs of portfolios as well as of the programs and projects in the respective portfolios.
### ServiceNow

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expense type</td>
<td>Displays budget allocation for portfolios grouped by expense types.</td>
</tr>
<tr>
<td>Program</td>
<td>Displays budget allocation for portfolios grouped by programs.</td>
</tr>
<tr>
<td>Task</td>
<td>Displays budget allocation for portfolios grouped by tasks.</td>
</tr>
<tr>
<td>Fiscal period</td>
<td>Displays budget allocation for portfolios grouped by fiscal periods.</td>
</tr>
<tr>
<td>Cost type</td>
<td>Displays budget allocation for portfolios grouped by cost types.</td>
</tr>
<tr>
<td>Portfolio</td>
<td>Displays budget allocations grouped by portfolios.</td>
</tr>
</tbody>
</table>

### Actual Cost by Expense Type report

Provides information about actual capital and operational costs of portfolios as well as of the programs and projects in the respective portfolios.

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expense type</td>
<td>Displays actual cost of portfolios grouped by expense types.</td>
</tr>
<tr>
<td>Program</td>
<td>Displays actual cost of portfolios grouped by programs.</td>
</tr>
<tr>
<td>Task</td>
<td>Displays actual cost of portfolios grouped by tasks.</td>
</tr>
<tr>
<td>Fiscal period</td>
<td>Displays actual cost of portfolios grouped by fiscal periods.</td>
</tr>
<tr>
<td>Cost type</td>
<td>Displays actual cost of portfolio grouped by cost types.</td>
</tr>
<tr>
<td>Portfolio</td>
<td>Displays actual cost grouped by portfolios.</td>
</tr>
</tbody>
</table>

### Program Management

A program helps you to logically group related projects or demands under a single entity. The ServiceNow® Program Management application helps you to manage related projects and demands in coordinated way which is not possible when projects and demands are managed independently.

The it_program_manager role is essential to be able to manage programs. The Program Management application provides the following capabilities to the program manager:

- Create a program by adding related projects and demands.
- Create tasks specific to the program. These tasks are essential for completion of the program but are outside the scope of projects.
- Define key milestones, anticipated risks, and issues for the program.
- Monitor the progress and status and of all the projects and demand that are part of the program. Program manager can track the costs, resources, and schedules.

When you create a program, consider:

- A program can be part of a portfolio or can be a generic standalone program that is not part of any portfolio.
• A program cannot be part of multiple portfolios.
• A project or demand cannot be part of multiple programs.
• You can have projects and demands that can directly be part of a portfolio and not part of a program.

The following diagram illustrates how you can implement programs.

Program implementation

**Basics of Program Management**

When you create a program, you can add multiple projects or demands to it. If you have created cost plans for the projects and demands, certain values are rolled up from the cost breakdown of program. At the same time, the risk and issues of the projects and demands are also included with the program. The following diagram illustrates how information in the program is related to the projects and demands that are part of the program.
Information population in program

Project workbench provides graphical charts to view and monitor the progress of the program and the projects and demands that are part of it. You can also view the progress of a program, projects, and demands against a timeline with the details of milestones and key milestones.

The project manager dashboard provides a central location to a program manager to generate different graphical reports of programs and the program financials.

Create a program to manage projects and demands

Create a program to manage related projects and demands. Define the duration, estimated cost, benefits, and ROI to the organization.

Role required: it_program_manager

1. Navigate to **Project > Programs > Create New**.
2. On the Program form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program Name</td>
<td>Name of the program.</td>
</tr>
<tr>
<td>Program manager</td>
<td>Program manager assigned to the program.</td>
</tr>
<tr>
<td>Number</td>
<td>System-generated number with a configurable prefix.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Portfolio</td>
<td>Portfolio to which the program belongs. If you do not select a portfolio for the program, the program becomes a global program. You can associate the projects and demands in a global program with any portfolio.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority associated with the program.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the program. This information rolls up from the status of all the projects that are part of this program.</td>
</tr>
<tr>
<td>Note:</td>
<td>Set the state of the program to Closed manually. The program state does not roll up to a Closed state when program tasks, projects, and demands move to Closed state.</td>
</tr>
<tr>
<td>Phase</td>
<td>Current phase of the program such as Initiating, Planning, and Executing.</td>
</tr>
<tr>
<td>Business Unit</td>
<td>The business unit to which this program belongs.</td>
</tr>
<tr>
<td>Investment Type</td>
<td>Investment type of the program. The default available options are Cost Reduction, End User Experience, Legal and Regulatory, Revenue Generating, Service Sustaining, and Strategic Enabler.</td>
</tr>
<tr>
<td>Impact Business Units</td>
<td>Business units of the organization that this program affects.</td>
</tr>
<tr>
<td>Strategies</td>
<td>Strategic objectives of the organization that the program fulfills. A program can fulfill multiple strategic objectives.</td>
</tr>
<tr>
<td>Note:</td>
<td>Leave this field empty if the program does not fulfill any strategic objective.</td>
</tr>
<tr>
<td>Goals</td>
<td>Goals associated to the selected strategy. A program can fulfill multiple goals. If you do not select a strategy, then the Goals list displays all goals in the system.</td>
</tr>
<tr>
<td>Note:</td>
<td>Leave this field empty if there are no goals associated with the program.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the program.</td>
</tr>
<tr>
<td>Dates tab</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Planned start date</td>
<td>Intended program start date. If the start date of associated program tasks, projects, and demands is earlier than the program start date, the start date is adjusted to an earlier date. Removal of a demand or project from the program does not affect the planned start date of the program.</td>
</tr>
<tr>
<td>Planned end date</td>
<td>Intended program end date. The end date extends based on the end date of the program tasks, projects, and demands. Removal of a demand or project from the program does not impact the planned start date of the program. If any program tasks, projects, or demands do not start or end within the program end date, adjust the program end date manually.</td>
</tr>
<tr>
<td>Planned duration</td>
<td>Expected duration of this program. The planned duration changes based on the changes in planned start or end date of the program.</td>
</tr>
<tr>
<td>Actual start date</td>
<td>Date on which the program actually starts.</td>
</tr>
<tr>
<td>Actual end date</td>
<td>Date on which the program actually ends.</td>
</tr>
<tr>
<td>Actual duration</td>
<td>Actual duration of the program from program start to program closure.</td>
</tr>
<tr>
<td><strong>Financials tab</strong></td>
<td></td>
</tr>
<tr>
<td>Total planned cost</td>
<td>Estimated cost of the program. If there is operational expenditure and capital expenditure associated to the program, then planned cost is sum of operational expenditure and capital expenditure, which is in functional currency.</td>
</tr>
<tr>
<td>Planned capital</td>
<td>Capital expenditure (Capex) for the program. If there are no cost plans associated to the program, the Capital expense field is editable. Select a currency type and enter a value.</td>
</tr>
<tr>
<td>Planned operating</td>
<td>Operational expenditure (Opex) for the program. If there are no cost plans associated to the program, the Operational expense field is editable. Select a currency type and enter a value.</td>
</tr>
<tr>
<td>Budget cost</td>
<td>Budgeted cost for this program.</td>
</tr>
<tr>
<td>Actual cost</td>
<td>Actual cost of the program. The value rolls up from the cost plan breakdowns from projects and demands in the program.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Planned benefit</td>
<td>Planned benefit value for the program. This value rolls up from the benefit plan breakdowns of the program. You can also enter the value manually. Select a currency from the Currency Type list and enter a value.</td>
</tr>
<tr>
<td>Planned returns</td>
<td>Planned returns is based on the difference between planned benefit and planned cost.</td>
</tr>
<tr>
<td>Planned ROI%</td>
<td>The result is derived from the values in the Planned return and Planned cost fields. The formula is: planned return / planned cost x 100.</td>
</tr>
<tr>
<td>Score</td>
<td>The program score is based on the individual scores of the following attributes: risk score, value score, and size score, which in turn are calculated based on risk, planning ROI%, and estimated cost attributes (on a program) respectively.</td>
</tr>
<tr>
<td>Note:</td>
<td>You can configure the formula for score calculation.</td>
</tr>
<tr>
<td>Risk</td>
<td>Risk associated with the program.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

Use the following related links and lists:

### Program form related links and lists

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Related links</strong></td>
<td></td>
</tr>
<tr>
<td>PMO Dashboard</td>
<td>Access the PMO dashboard to view comprehensive reports of the projects and demands in the program.</td>
</tr>
<tr>
<td>Program Budget</td>
<td>Allows you to allocate the budget to the program.</td>
</tr>
<tr>
<td>Program Workbench</td>
<td>Access the Program workbench to view details of the projects, demands, and program tasks associated with the program.</td>
</tr>
<tr>
<td>Status Report</td>
<td>View the most recent program status report or create a new program status report.</td>
</tr>
<tr>
<td><strong>Related lists</strong></td>
<td></td>
</tr>
<tr>
<td>Program Tasks</td>
<td>View the list of all associated program tasks. To create a new program task, click the <strong>New</strong> button. For more information, see Create a program task.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Projects</td>
<td>View the list of projects included in the program. To create a new project, click <strong>New</strong>. For more information, see Define a project. To add existing project to the program, click <strong>Edit</strong>.</td>
</tr>
<tr>
<td>Demands</td>
<td>View the list of demands included in the program. To create a new demand, click <strong>New</strong>. For more information, see Create a demand. To add existing demand to the program, click <strong>Edit</strong>.</td>
</tr>
<tr>
<td>Risks</td>
<td>View the list of risks associated with the projects and demands of the program or the program itself. To create a new risk, click <strong>New</strong>.</td>
</tr>
<tr>
<td>Issues</td>
<td>View the list of issues associated with the projects and demands of the program or the program itself. To create a new issue, click <strong>New</strong>.</td>
</tr>
<tr>
<td>Cost plans</td>
<td>View the list of all cost plans for projects and demands that are part of the program.</td>
</tr>
<tr>
<td>Benefit Plans</td>
<td>View the list of all benefit plans for projects and demands that are part of the program.</td>
</tr>
<tr>
<td>Program Budget</td>
<td>View the program budget according to fiscal years. Click the amounts in the list to revise them.</td>
</tr>
<tr>
<td>Program Status Reports</td>
<td>View the list of status reports for the program. To generate a new status report, click <strong>New</strong>. For more information, see Create a program status report.</td>
</tr>
</tbody>
</table>

### Create a program task

You can create program tasks from the Program form related lists.

Role required: it_program_manager

1. Navigate to **Project > Programs > All**.
2. Select the program from the list.
3. In the Program Tasks related list, click **New**.
4. Fill out the form fields (see table).
   There are a few fields that are populated after the task is created.
5. Click **Submit**.

The new task appears in the **Program Task** related list on the Program form.

### Program Task form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>[Required] A brief description of the program task.</td>
</tr>
</tbody>
</table>
### Field Descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>A system generated number with a configurable prefix.</td>
</tr>
<tr>
<td>State</td>
<td>The current state of the program. The states include: Pending, Open, Work in Progress, Closed Complete, Closed Incomplete, Closed Skipped.</td>
</tr>
<tr>
<td>Planned start date</td>
<td>The estimated date and time for the program task to start.</td>
</tr>
<tr>
<td>Planned end date</td>
<td>The estimated date and time for the program task to end.</td>
</tr>
<tr>
<td>Planned duration</td>
<td>The estimated length of time (from start time to end time) of the program task.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The user assigned to the program task.</td>
</tr>
<tr>
<td>Milestone</td>
<td>A milestone is a program task with a duration of zero (0). Use milestones to mark key dates in your program, such as key decision points or approvals.</td>
</tr>
<tr>
<td>Key milestone</td>
<td>You can define a milestone as a key milestone to track the program progress. For example, you can create key milestone for completion of deliverables such as a program plan. A key milestone is visible on the program timeline.</td>
</tr>
<tr>
<td>Description</td>
<td>A detailed description of the program task.</td>
</tr>
<tr>
<td>Additional comments</td>
<td>Enter information that you want the users to see.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Enter work notes about the milestones, impediments, or changes as the program progresses.</td>
</tr>
</tbody>
</table>

### Fields populated and updated after the task is created

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actual start date</td>
<td>The date that this program started. This date is populated after you update the program state to Work in Progress.</td>
</tr>
<tr>
<td>Actual end date</td>
<td>The date that this program ended. This date is populated after you update the program state to Closed Complete.</td>
</tr>
<tr>
<td>Actual duration</td>
<td>The actual duration of the program from program start to program closure. As with planned duration, the actual duration shows total program time.</td>
</tr>
</tbody>
</table>

### Allocate budget to a program

Set the budget of a program according to the fiscal years.

Role required: it_portfolio_manager

1. Open the program form.
2. In the related links, click Program Budget.
The Program Budget dialog box opens.

3. Select the year for which you want to set the budget for the program.

4. Enter the amounts for Capex Budget and Opex Budget.
   The Total Budget is updated with the sum of capex and opex amounts.

5. Click OK.

The program budget for the selected year appears in the Program Budget related list. You can click the amounts in the list to revise them.

Create a program status report

Create a program status report periodically to view a status rollup of the projects in the program. When you create a status report, the status for different aspects of the program is rolled up from the project status reports of all projects.

Ensure that the Show on Program Status Report option in the Project form for all the projects that you want to include in the status report is selected.

Role required: it_program_manager

1. Navigate to Project > Programs > All.
2. In the program list, open a program record.
3. In the Program Status Reports related list, click New.
4. On the form, fill in the fields.

![Note:](image)

Changing the status for any aspect in the Program Status Report form also updates the corresponding fields in the Program form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program</td>
<td>Name of the program.</td>
</tr>
<tr>
<td>Status Date</td>
<td>Date until which you want to generate the status report. Default value is the current date.</td>
</tr>
<tr>
<td>Number</td>
<td>System-generated ID number for the status report with a configurable prefix.</td>
</tr>
</tbody>
</table>

**Read-only fields rolled up from the Program form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>Current state of the program such as Pending, Open, or Work in Progress.</td>
</tr>
<tr>
<td>Percent complete</td>
<td>Percentage of the program completed.</td>
</tr>
<tr>
<td>Planned start date</td>
<td>Planned start date of the program.</td>
</tr>
<tr>
<td>Planned end date</td>
<td>Planned end date of the program.</td>
</tr>
<tr>
<td>Actual start date</td>
<td>Actual start date of the program.</td>
</tr>
<tr>
<td>Actual end date</td>
<td>Actual end date of the program.</td>
</tr>
<tr>
<td>Planned cost</td>
<td>Estimated cost of the program.</td>
</tr>
<tr>
<td>Actual cost</td>
<td>Actual cost of the program.</td>
</tr>
</tbody>
</table>

**Overall Status tab**
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overall health</td>
<td>Overall health of the program rolled up from the latest status report of each project in the program. The status is indicated using red, green, and yellow colors as the default.</td>
</tr>
<tr>
<td>Executive Summary</td>
<td>Brief summary and analysis of the program.</td>
</tr>
<tr>
<td>Comments</td>
<td>Comments about the overall status.</td>
</tr>
<tr>
<td>Last Week's Achievements</td>
<td>Description of key tasks completed or any significant progress in the program in the last week.</td>
</tr>
<tr>
<td>Key Activities planned</td>
<td>Next planned activities for the program.</td>
</tr>
<tr>
<td><strong>Schedule tab</strong></td>
<td></td>
</tr>
<tr>
<td>Schedule</td>
<td>Status of the program schedule rolled up from the latest project status report of each project in the program. The status is indicated using red, green, and yellow colors by default.</td>
</tr>
<tr>
<td>Comments on Schedule</td>
<td>Information related to the program schedule.</td>
</tr>
<tr>
<td><strong>Cost tab</strong></td>
<td></td>
</tr>
<tr>
<td>Cost</td>
<td>Status of the program cost rolled-up from the latest project status report of each project in the program. The status is indicated using red, green, and yellow colors by default.</td>
</tr>
<tr>
<td>Comments on cost</td>
<td>Information related to the program cost.</td>
</tr>
<tr>
<td><strong>Resources tab</strong></td>
<td></td>
</tr>
<tr>
<td>Resources</td>
<td>Status of resources rolled-up from the latest project status report of each project in the program. The status is indicated using red, green, and yellow colors by default.</td>
</tr>
<tr>
<td>Comments on Resources</td>
<td>Additional information related to program resources.</td>
</tr>
<tr>
<td><strong>Scope tab</strong></td>
<td></td>
</tr>
<tr>
<td>Scope</td>
<td>Status of the program scope rolled up from the latest project status report of each project in the program. The status is indicated using red, green, and yellow colors by default.</td>
</tr>
<tr>
<td>Comments on Scope</td>
<td>Information related to the program scope.</td>
</tr>
</tbody>
</table>

5. Optional: Select a different status color to override the rolled-up color for various aspects of the program or select **None** if you do not want the status of an aspect to appear in the program status report.

Selecting **None** displays a grey X icon (✘) for that program aspect on the program status report.

The override color that you set is not retained from one report to next. When the next program status report is generated, it takes the color from the associated projects.

6. Click **Submit**.
7. Optional: Print a program status report by clicking the print icon (Printer) in the header of the Status Report tab.

View program status reports

Program status reports provide the up-to-date at-a-glance progress of all the projects in the program in several categories.

Role required: it_program_manager

Use the Program Status Report related list to view the program status reports created for the program. If no report is listed, create a program status report.

1. Navigate to Project > Programs > All.
2. In the program list, open a program record.
3. Click the Status Reports related link.
4. Select a status report from the top-left corner of the page to view its contents.
5. Review the program status in the report.

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>Provides general overview information about the program:</td>
</tr>
<tr>
<td></td>
<td>• Program Name: Name of the program.</td>
</tr>
<tr>
<td></td>
<td>• Program Manager: The program manager.</td>
</tr>
<tr>
<td></td>
<td>• Portfolio: The portfolio to which the program belongs.</td>
</tr>
<tr>
<td></td>
<td>• Business Unit: The business unit to which the program belongs.</td>
</tr>
<tr>
<td></td>
<td>• Investment Type: Investment type of the program.</td>
</tr>
<tr>
<td></td>
<td>• Impacted BU: Business units of the organization that this program affects.</td>
</tr>
<tr>
<td></td>
<td>• State: Current state of the program.</td>
</tr>
<tr>
<td></td>
<td>• Phase: Current phase of the program, for example, Initiating, Planning, and Executing.</td>
</tr>
<tr>
<td></td>
<td>• % Complete: Percentage of the program completed.</td>
</tr>
<tr>
<td></td>
<td>• Planned Start Date: Planned start date of the program.</td>
</tr>
<tr>
<td></td>
<td>• Planned End Date: Planned end date of the program.</td>
</tr>
<tr>
<td></td>
<td>• Planned Cost: Estimated cost of the program.</td>
</tr>
<tr>
<td></td>
<td>• Actual Start Date: Actual start date of the program.</td>
</tr>
<tr>
<td></td>
<td>• Actual End Date: Actual end date of the program.</td>
</tr>
<tr>
<td></td>
<td>• Actual Cost: Actual cost of the program.</td>
</tr>
</tbody>
</table>

This information rolls up from the Program form.
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary</td>
<td>Information about the overall health of the program from the most recent status entered by the program manager for the project.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Executive Summary</strong>: Brief summary and analysis of the program.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Last Week's Achievements</strong>: Progress of the program in the previous week.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Key Activities Planned</strong>: Next planned activities for the program.</td>
</tr>
<tr>
<td>Section</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Current Status</td>
<td>Status of program related to overall health, schedule, cost, resources, and scope that is rolled up from the latest project status reports of all projects in the program. If there are multiple project status reports for each of these projects, the values from the latest project status report of each project are aggregated and rolled up to the program status. For more information, see Program Status Report form. Different colors indicate the status of above aspects. The rolled-up color for the final status is in the order red, yellow, and green by default. If there are projects in red, yellow, and green, then the program status is red. If there are projects only in yellow and green, then the program status is yellow. The following image illustrates the color codes for the program status rolled up from the project.</td>
</tr>
</tbody>
</table>
### Section Description

**Project KPI**
Status of the Key Performance Indicators for overall health, schedule, cost, resources, and scope for each project in the program. Only projects for which the **Show on Program Status Report** option in the Project form is selected are listed. The value of these KPIs roll up and are shown in the Current Status section of the program status report.

**Note:** A grey X icon (✗) next to any project KPI means that the project manager has excluded that aspect from the status report.

---

Optional: If you need a printed copy of the report, click the print icon (Printer) in the header of Status Report tab.

## Program workbench

The program workbench is a central location for viewing details of a program and the projects, demands, and program tasks that are part of the program.

The program manager role can use the program workbench to view and monitor the progress of the program and the projects, demands, and program tasks. Program workbench provides information for only tracking the program.

You can track the progress of demands and projects, and monitor the status of cost, resource, schedule, and scope for the selected fiscal period for the program.

**Note:**
- Program workbench is based on Service Portal which means that you can configure, customize, and extend it as per your requirements and organizational workflow. For more information, see Service Portal documentation.
- Program workbench does not support mobile device.

The program workbench comprises of the following components:

- **Fiscal period**: A choice list on the top-right to select the fiscal year for which you monitor the program.
- **Timeline View**: Shows a list of all the selected demands and projects that are part of the program, and a Gantt chart of all projects and demands over time.

You can:
- configure the colors of the program items in Gantt chart with Dashboard Configuration settings.
- select the zoom level in Gantt chart calendar to **Auto Fit**. The Gantt view fits in one page to view entire timeline in one go without using the scrollbar.
- review the external dependencies between projects in a program. For more information on reviewing external dependencies, see Review external dependencies between projects in a portfolio.

---

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
ServiceNow    DocVersion    IT Business Management

- click the show/hide icon

    to show or hide columns.

Note:
- A demand is included in the timeline view only if the Expected Start and Due Date fields are populated.
- Admin can customize which columns appear in the column filter list when the show/hide columns icon

    is clicked in the timeline view.

Project KPI: The tab displays the most recent status of project KPIs such as overall health, schedule, cost, resources, and scope of all the projects in the program. This information is populated from the most recent status report created for the projects.

You can:
- click the name of a project in the tab to open the latest status report created for the project.
- point to a status indicator for a project KPI to view the comments entered for the KPI for that project.

Cost (Planned vs. Actual): The chart displays the actual costs from all projects in the program compared to the approved budget. The actual cost for projects is derived from the expense lines.

Note: An expense line can be created manually for a project when a specific expense is incurred. For example, if hardware is procured for a project, an expense line can be created for the amount spent on procuring the hardware. If you receive an item using ServiceNow Procurement, an expense line is created automatically. For resource hours, the expense lines are created automatically when the time cards for the project are approved.

The display settings for the chart can be modified by selecting any of the following from the choice list:
- Capex: Displays the cost chart for capital expense only.
- Opex: Displays the cost chart for operating expense only.
- All: Displays the cost chart for both capital and operating expenses.

Resource (Allocated vs. Actual): The chart displays the actual resource time spent on all project tasks versus the resource hours allocated to execute the projects and demands in the program. The actual time spent is taken from processed time cards for the projects.
Access the program workbench

When you access the program workbench, it displays a list of all the programs.

You can access the program workbench in one of the following ways:
• Click the **Program Workbench** related link on the Program form.

• Navigate to

1. **Project** > **Programs** > **Workbench**.
2. Click the configuration icon

![Dashboard Configuration](image)

and select the colors for projects, tasks, programs, and so on. The workbench uses these colors to display the items in the program in the Gantt chart in timeline view.

3. Click the program that you want to open.

   ![Note](image)

   **Note:** The programs that are displayed in the workbench depend on how you launched the program workbench:

   • All programs are available in the workbench using the navigation menu option.
   • Only the associated program displays using the program form.

**Program Manager Dashboard**

The program manager dashboard provides a central location to a program manager to generate different graphical reports of programs and the program financials. The dashboard displays reports only for the programs managed by the program manager.

The dashboard contains tabs that display program level reports and program financials reports.

**Program tab**

• Open risks
• Open issues
• Active projects

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
• Key milestones
• Project level status report that provides status of all projects
• Information about total open risks, total open issues, and total key milestones

Program Financial tab

• Active projects
• Costs
• Budgets
• Information about total active projects, total estimated cost, and total budget.

To view different type of data, you can generate reports by grouping or by stacking. Each report has different categories for grouping and stacking. You can use a combination of Group by category and Stack by category to generate the reports.

Access the Program Manager Dashboard

View different graphical reports on the Program Manager Dashboard.

Role required: it_program_manager

Navigate to Projects > Programs > Program Manager Dashboard.

Program reports

Program manager dashboard provides program level reports about open risks, open issues, active projects, and key milestones. The dashboard displays reports only for the programs managed by a program manager.

To view different type of data, you can generate reports by grouping or by stacking. Each report has different filters for grouping and stacking. You can use a combination of Group by filters and Stack by filters to generate the reports.

Open Risk report

Provides information about open risks for a program as well as for the projects in the program. You can filter the report by grouping or stacking:

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top program</td>
<td>Displays open risks by top program.</td>
</tr>
<tr>
<td>Probability</td>
<td>Displays open risks by probability.</td>
</tr>
<tr>
<td>State</td>
<td>Displays open risks by state.</td>
</tr>
<tr>
<td>Task</td>
<td>Displays open risks by task.</td>
</tr>
</tbody>
</table>

Open Issues report

Provides information about open issues for a program as well as for the projects in the program. You can filter the report by grouping or stacking:

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top program</td>
<td>Displays open issues by top program.</td>
</tr>
</tbody>
</table>
### Active Projects report

Provides information about active projects. You can filter the report by grouping or stacking:

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program</td>
<td>Displays the active projects by program.</td>
</tr>
<tr>
<td>Short Description</td>
<td>Displays the active projects by short description.</td>
</tr>
<tr>
<td>Project Manager</td>
<td>Displays the active projects by project managers.</td>
</tr>
</tbody>
</table>

### Key Milestones by Program report

Provides information about key milestones for the projects in a program. You can filter the report by grouping or stacking:

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top Program</td>
<td>Displays the key milestones by top program.</td>
</tr>
<tr>
<td>State</td>
<td>Displays the key milestones by state.</td>
</tr>
<tr>
<td>Project</td>
<td>Displays the key milestones by projects.</td>
</tr>
<tr>
<td>Top Task</td>
<td>Displays the key milestones by top tasks</td>
</tr>
</tbody>
</table>

### Project status report

Provides information about the status of the projects in a program.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>Name of the project.</td>
</tr>
<tr>
<td>Portfolio</td>
<td>The portfolio to which the project belongs</td>
</tr>
<tr>
<td>State</td>
<td>The state of the project.</td>
</tr>
<tr>
<td>Priority</td>
<td>The priority of the project.</td>
</tr>
<tr>
<td>Risk</td>
<td>The risk level associated with the project.</td>
</tr>
<tr>
<td>Planned start date</td>
<td>The planned start date of the project.</td>
</tr>
<tr>
<td>Planned end date</td>
<td>The planned end date of the project.</td>
</tr>
<tr>
<td>Percent complete</td>
<td>The completion percentage of the project.</td>
</tr>
</tbody>
</table>
Program Financial reports

Program Manager dashboard provides program level financial reports related to program costs and program budgets. The dashboard displays reports only for the programs managed by a program manager.

To view different type of data, you can generate reports by grouping or by stacking. Each report has different filters for grouping and stacking. You can use a combination of Group by filter and Stack by filter to generate the reports.

Estimated Cost by Expense Type report

Provides information about estimated capital and operational costs of programs as well as of the projects in the respective programs.

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expense type</td>
<td>Displays estimated cost of programs grouped by the expense types.</td>
</tr>
<tr>
<td>Portfolio</td>
<td>Displays estimated cost of programs grouped by portfolios.</td>
</tr>
<tr>
<td>Task</td>
<td>Displays estimated cost of programs grouped by tasks.</td>
</tr>
<tr>
<td>Fiscal period</td>
<td>Displays estimated cost of programs grouped by fiscal periods.</td>
</tr>
<tr>
<td>Program</td>
<td>Displays estimated cost grouped by programs.</td>
</tr>
</tbody>
</table>

Estimated Cost by Cost Type report

Provides information about estimated costs of programs, as well as of the projects in the respective programs, by the cost types. The examples of cost types are hardware, software, labor, and so on.

Budget Allocation by Expense Type report

Provides information about budgeted capital and operational costs of programs as well as of the projects in the respective programs.

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expense type</td>
<td>Displays budget allocation for programs grouped by expense types.</td>
</tr>
<tr>
<td>Task</td>
<td>Displays budget allocation for programs grouped by tasks.</td>
</tr>
<tr>
<td>Portfolio</td>
<td>Displays budget allocation for programs grouped by portfolios</td>
</tr>
<tr>
<td>Fiscal period</td>
<td>Displays budget allocation for programs grouped by fiscal periods.</td>
</tr>
<tr>
<td>Cost type</td>
<td>Displays budget allocation for programs grouped by cost types.</td>
</tr>
<tr>
<td>Program</td>
<td>Displays budget allocations grouped by programs.</td>
</tr>
</tbody>
</table>
Actual Cost by Expense Type report

Provides information about actual cost of programs as well as of the projects in the respective programs.

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expense type</td>
<td>Displays actual cost for programs grouped by expense types.</td>
</tr>
<tr>
<td>Task</td>
<td>Displays actual cost for programs grouped by tasks.</td>
</tr>
<tr>
<td>Portfolio</td>
<td>Displays actual cost for programs grouped by portfolios.</td>
</tr>
<tr>
<td>Fiscal period</td>
<td>Displays actual cost for programs grouped by fiscal periods.</td>
</tr>
<tr>
<td>Cost type</td>
<td>Displays actual cost for programs grouped by cost types.</td>
</tr>
<tr>
<td>Program</td>
<td>Displays actual cost grouped by programs.</td>
</tr>
</tbody>
</table>

Project Management

The ServiceNow® Project Management application is a suite of tools that aids in managing projects, tasks, and resources. You can create and manage small projects with a few tasks to large portfolios that contain complex tasks with various relationships and dependencies.

**Explore**
- Paris Release notes
- Upgrade to
- Get started with Project Management
- Basics of Project Management
- Teamspaces

**Set up**
- Activate project task email notifications
- Project Management costing add-on
- Activate teamspaces

**Use**
- Project Workspace
- Define a project
- Update a project in progress
- Planning console
- Project workbench

**Develop**
- Developer training
- Developer documentation
- Properties installed with Project Management
- Installed with teamspaces

**Integrate**
- Project import and export

**Troubleshoot and get help**
- Ask or answer questions in the Business Management Community
- Search the HI knowledge base for known error articles
- Contact ServiceNow Technical Support

Get started with Project Management

Project Management includes tools to help you create, view, and manage projects.

Project Management consists of following features:
- **Project workbench** gives project managers the ability to manage the different aspects of a project from a single page. This workbench supports both Project Management and Application Lifecycle Management applications, allowing for a hybrid approach to project management. Project managers
can create projects that combine both Waterfall and Agile methodologies by using Waterfall, Agile, and Test phases.

- **Project templates** define the basic structure of a project, including project tasks and subtasks, attachments, and other project information. The project template feature gives project managers a simple way to create, save, and reuse this project structure.

Watch this six-minute video to learn more about the purpose of Project Management, the project workspace, the project template, baseline, additional project considerations, and viewing the project in the workspace.

Project Management also includes features that enable you to achieve your project goals in alignment with the other activities your organization is managing, such as:

- Integration with other features and applications on the platform, such as change management, resource management, and reports.

- Easy-to-read Gantt charts and Work Breakdown Structure lists that help you visualize large projects with complex relationships and dependencies.

- Phase formatter at the top of each project record to highlight the current phase of the project.

In this example, the project is in **Delivering** phase. The phase is selected in the **Phase** field on the project record.

![Project phase formatter](image)

**Key terms**

**Project Management Key Terms**

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portfolio</td>
<td>A collection of projects managed as a group to achieve strategic and operational objectives.</td>
</tr>
<tr>
<td>Project</td>
<td>Any planned, collaborative effort that is designed to achieve an objective.</td>
</tr>
<tr>
<td>Agile project</td>
<td>Any planned, collaborative effort that is designed to achieve an objective and uses Agile.</td>
</tr>
<tr>
<td>Project console</td>
<td>A unified graphical interface to the Project Management application, including new WBS hierarchical lists and a new Gantt chart.</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Phase</td>
<td>One stage or one segment of a project. Three types of phases can be added to the timeline in the project workbench:</td>
</tr>
<tr>
<td></td>
<td>• Waterfall phase: contains project tasks. A project can have multiple waterfall phases.</td>
</tr>
<tr>
<td></td>
<td>• Agile phase: contains stories and can also include a group assignment. A project can have multiple agile phases.</td>
</tr>
<tr>
<td></td>
<td>• Test phase: contains test cases and can also be associated to a test plan. A project can have multiple test phases.</td>
</tr>
<tr>
<td>Story</td>
<td>A brief statement of a product requirement or a customer business case that is used in the scrum method of agile software development.</td>
</tr>
<tr>
<td></td>
<td>Typically, stories are expressed in plain language to help the reader understand what the software does.</td>
</tr>
<tr>
<td>Task</td>
<td>A unit of work within a project. Projects typically contain several tasks.</td>
</tr>
<tr>
<td>Test case</td>
<td>A collection of related tests. A test case is saved as part of a test suite and can be added to a test plan.</td>
</tr>
<tr>
<td>Checklist</td>
<td>A list of items that must be performed on a project task.</td>
</tr>
<tr>
<td>Teamspace</td>
<td>A standalone application built on the Project Portfolio Management applications.</td>
</tr>
</tbody>
</table>

**Schedules**

<table>
<thead>
<tr>
<th>Schedules</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Management</td>
<td>The default schedule for all new projects, which is Monday to Friday 8 A.M. to 12 P.M. and 1 P.M. to 5 P.M. (for a total of 8 hours), not including weekends.</td>
</tr>
<tr>
<td>Default MS Project</td>
<td>The default schedule for projects that you import from Microsoft Project. The schedule is Monday to Friday 8 A.M. to 12 P.M. and 1 P.M. to 5 P.M. (for a total of 8 hours), not including weekends.</td>
</tr>
</tbody>
</table>

**Integration with Project Portfolio Management**

You can use Project Management as a separate application or it can be activated as part of the PPM Standard.

This application provides a simplified, team-oriented approach to IT development by combining several individual applications and integrating the different components of the project development life cycle.
Basics of Project Management

A project is any planned, collaborative effort that is designed to achieve an objective. The Project Management application not only helps you plan and track projects, it integrates with other applications.

There are several paths available to manage a project. The best path usually depends on business needs. The phases in the graphic are designed to get a project up and running with the minimum amount of effort:

Project phases

Set up the project

Setting up a project involves deciding on an approach for creating and linking project tasks. It also involves creating the necessary users and groups in ServiceNow so you can assign them to project tasks.

Plan the project

Before creating a project, consider the following questions and issues:

- Do you want a top-down or bottom-up approach to tasking?
  
  Top-down tasking involves creating a project first, then identifying major project phases. Later on, phases can be broken down into tasks and subtasks. The emphasis is on creating estimates for high-level items such as phases and parent tasks and then building the project down from there toward a more detailed level. Use caution when creating tasks for top-down tasking. Creating a task under a project that has a start-on date later than the start date of the project, the project shifts to the later start date. The Project Management application supports bottom-up tasking better.

  Bottom-up tasking involves creating several sets of small tasks and estimating task items such as effort, cost, and duration. These estimations are then aggregated into high-level parent tasks (rollup tasks) and phases. The emphasis is on estimating smaller chunks of work as accurately as possible first, then letting those estimations roll up into parent tasks, phases, and the project itself.

- Is the project part of a larger portfolio of projects?
  
  Also consider portfolio planning and how the project relates to similar projects or initiatives.

- What types of dependencies do the tasks have with other tasks?

  The Project Management application supports various dependencies. See: Project task relationships and dependencies.
• Can milestones and project baselines help manage a project?
  A milestone is a project task with a duration of 0. Use milestones to indicate important dates in a project. If necessary, create dependencies between tasks and milestones so that a task does not start until a milestone has been reached.
  A baseline is a snapshot of the current planned start and end dates at the time the baseline was created for each task. A line appears under each task on the Gantt chart for the original planned start and end dates. The line appears shifted to the left or right depending on whether the task was started early or late. If tasks slip to later dates, the baseline indicator provides an easy way to see how severe the delays are.

• Have the necessary skills, groups, and resources been created in ServiceNow?
  If project tasks are assigned to different groups or individual resources with the required skills, create users and groups and configure the Skills Management application.

• Does an existing incident, problem, or change justify creating a project to track it?
  Of these record types, a change is most likely to lead to activities that are tracked as a project.

• Do you want to track project costs?
  Estimate group resource costs before starting the project. Then track the actual cost of each user resource from time cards. The Project Management application can also calculate the costs of affected CIs in a project. The Project Management Costing add-on is required to track costs.

• What goals do you want the project to achieve?
  Every project has at least one goal. Project goals are saved in the Goal table and can link to any task. In a typical scenario, link one goal to each project and keep the State field of the goal up to date.

Create the project

Create the project in the Project Management application after:
• Choosing an approach
• Gathering initial estimates for the planned start date
• Estimating cost
• Formulating a well-defined business case

Add project tasks, dependencies, and relationships

After creating a project record, create tasks.
• For top-down planning, create a task that you already know includes several child tasks. Then create the child tasks and specify that they are child tasks of the first task you created.
• For bottom-up planning, create tasks for the smallest units of work first. Then you can create intermediary parent tasks that cover a group of related child tasks. For example, if there are five sequential tasks that comprise a phase of a project called install database, create the five tasks first. Then create another task called Database installation and make it the parent task of the five tasks.
  Rollup calculations, such as Planned duration, for the Database installation task are automatically calculated based on the child tasks.

It is easiest to build task relationships and dependencies while creating sets of tasks.
• A dependency means that a task relies on other tasks to be performed (completely or partially) before it can be performed. For information on different types of dependencies that the ServiceNow Technical Supports, see Project task relationships and dependencies.
• A relationship means a parent-child relationship whereby several subtasks are configured under a parent task or phase, which rolls up fields like Planned duration and Estimated cost.

Use the Gantt chart with task forms and related lists to build relationships. Add milestones based on the major events of a project and create dependencies between milestones and tasks, if necessary.

Also set up notifications to alert project task assignees when their tasks move to the Work in Progress state. See Creating Project Tasks for more information on creating tasks.

Assign resources or assignment groups to the tasks
User resources are the individuals in an organization who are assigned to project tasks. You can manage your resources with resource plans in the Resource Management application.

Add the project to a portfolio
A portfolio is a group of related projects. If the project is related to other projects, create a portfolio and add the project. The Project Management application provides a useful portfolio view that makes it easy to report on the status of all projects in a portfolio. Portfolios also include demands.

Manage the Project
After the preceding steps are complete, the project can be started. To measure the project against initial estimates, create a baseline, which is a snapshot of the entire project including all planned dates for all project tasks and milestones. The project manager can manage a project from the project workbench.

Start the Project
Start the project by changing the project state to Work in Progress. When you change the State field on the Project form to Work in Progress, the Actual start date of the project changes to the planned start date.

Monitor the Project and Customize Dashboards
You can update important project status information, such as the number of milestones slipped. You can also view summaries for cost, scope, project risk, and so on. Modify this information as needed with the Portfolio View related list on the Portfolio form and display this information on the Project Overview homepage. In addition, use the project reports installed with the application, such as Active projects or Projects (by priority), to show important project information.

When the project is underway, continue to access project records and edit several items, including costs, priority, schedule, and planned values that are not rollups. Keep detailed project records for risks and issues and refer to them after a project is complete. Also create baselines along the way to easily see if any project phases or tasks are slipping at the time you create the baseline.

Close the Project
When the project is complete, change its state to Closed complete on the project form. When a project is in the closed state, the Project Management application calculates actual values like Actual duration.

Post-project activities include analyzing project baselines and actual values and generating a final project dashboard. You can cancel the future resource plans and complete the allocated resource plans for the closed project.

If the project was successful and can be used as a template for future projects, make a copy of it. If the project was created from a change, incident, or problem record, there are several other activities to perform in ServiceNow.
## Properties installed with Project Management

There are several Project properties that you can configure.

You need the PPS admin role to access the Project properties.

Navigate to **Project Administration > Settings > Preferences - Project** to configure the following properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enable firing of Business Rules on save from Planning Console.</strong> This property will be applicable only during insert and delete of tasks and relations.</td>
<td>If set to true, the project planning console triggers business rules when the <strong>State</strong> field on the Project form is changed. If set to false, the <strong>State</strong> field is not editable. &lt;br&gt;<strong>com.snc.project.fire_brs_from_planning_console</strong>&lt;br&gt;Note: Reload the console if you make changes to this property. Default value: false</td>
</tr>
<tr>
<td><strong>Calculate ROI percentage based on a project’s estimated cost and its net value</strong></td>
<td>If set to true, this property calculates the return on investment using the ((\text{net value/estimated cost}) \times 100) formula. This field is only available from the Advanced view of the Project form. &lt;br&gt;<strong>com.snc.project.calculate_roi</strong>&lt;br&gt;Default value: true</td>
</tr>
<tr>
<td><strong>Enable alter of planned date with Actual for Manual Project</strong></td>
<td>If set to true, the property recalculates the planned end date of a manual project from actual start date and planned duration. &lt;br&gt;<strong>com.snc.project.change_planned_date_from_actual_for_manual</strong>&lt;br&gt;Default value: false</td>
</tr>
<tr>
<td><strong>Enable project cost rollup (estimated and actual) – updating the cost of a project task will update the cost of its parent</strong></td>
<td>If set to true, this property updates the cost of a parent project task if the cost of the child task is updated. &lt;br&gt;<strong>com.snc.project.rollup.cost</strong>&lt;br&gt;Default value: false</td>
</tr>
<tr>
<td><strong>Roll up project start date from tasks</strong></td>
<td>If set to true, the project planned start date rolls up from the planned start date of the earliest task. Disable this property if you want the project planned start date to remain the same despite the start date of the earliest task. &lt;br&gt;<strong>com.snc.project.rollup_project_start_date</strong>&lt;br&gt;Default value: true</td>
</tr>
<tr>
<td><strong>Automatically close project milestone tasks when they change to work state</strong></td>
<td>If set to true, this property closes milestones automatically so you do not have to close them manually. &lt;br&gt;<strong>com.snc.project.auto_close_milestones</strong>&lt;br&gt;Default value: false</td>
</tr>
<tr>
<td><strong>Enable altering of planned date(s) for task in WIP/Closed</strong></td>
<td>If set to true, this property allows you to change the planned start date for tasks even if they are in the Work in progress state or any of the closed states. &lt;br&gt;<strong>com.snc.project.enable_alter_of_planned_dates</strong>&lt;br&gt;Default value: false</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Change Resource Plan, Cost Plan and Benefit Plan Start Date with Demand or Project Start Date change. Benefit Plan Start Date will change only if the offset type for the plan is not None</td>
<td>If set to true, this property changes the start dates for a resource plan, cost plan, and benefit plan when there is a change in the project or demand start dates.</td>
</tr>
<tr>
<td>com.snc.project.date_change_cascade</td>
<td>Default value: false</td>
</tr>
<tr>
<td>Retain users &amp; resource plan state as confirmed / allocated when project moves</td>
<td>If set to true, this property retains the confirmed or allocated state of a resource plan, booked resources, and planned daily contour when a property is moved. On moving the project, the resource plan is reallocated or reconfirmed based on the availability of the resources in the future time period to which the project is moved.</td>
</tr>
<tr>
<td>com.snc.project.date_change_cascade_persist_resource</td>
<td>Default value: true</td>
</tr>
<tr>
<td>Create project(s) on confirming demands from portfolio workbench</td>
<td>If set to true, this property converts all selected demands in a portfolio to projects.</td>
</tr>
<tr>
<td>com.snc.project.portfolio_workbench.confirm_to_create</td>
<td>Default value: false</td>
</tr>
<tr>
<td>List of attributes (comma-separated) that will be copied from the originating project task</td>
<td>By default, the Copy Project and Copy partial project options only copy the short description, planned dates, and duration fields from source project to the target project. If additional columns must be copied, they should be declared in this property.</td>
</tr>
<tr>
<td>com.snc.project.copy.additional_attributes</td>
<td>Default value: blank</td>
</tr>
</tbody>
</table>

The following project properties are available in System Property [sys_properties] table. Only a system administrator can edit these properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retain start on constraint on tasks after adding relations</td>
<td>The property keeps a task's <strong>Start on</strong> selection even after you put the task in a relation to another task, for example, FS relation.</td>
</tr>
<tr>
<td>com.snc.project.allow_start_on_relations</td>
<td>Default value: True</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Max duration (in days) allowed for a project/project task</td>
<td>The property governs the max duration of a project task or the overall project. Default value: 2600</td>
</tr>
<tr>
<td>com.snc.project.task.max_task_duration</td>
<td>Note: If your project includes milestones, the duration is calculated taking holidays and weekends into account.</td>
</tr>
<tr>
<td></td>
<td>Warning: Increasing the value of the property to more than 2600 will have an impact on memory usage of the platform. A very high value causes out of memory error, for example, if you try to create a project or a project task with 15000 days duration.</td>
</tr>
<tr>
<td>Max date span into future or past from the current date for the project/project task</td>
<td>The property governs the max date in future when entering the planned dates of a project or a project task. Default value: 10</td>
</tr>
<tr>
<td>com.snc.project.task.check_date_span_years</td>
<td>Warning: Increasing the value of the property to more than 10 will have an impact on memory usage of the platform. A very high value causes out of memory error.</td>
</tr>
</tbody>
</table>

**Project Workspace**

The Project Workspace enables the project manager to define, plan, track, and monitor a project in a single location. Project managers can also review the status, exceptions, and KPIs in the workspace to take further actions for the project.

**Projects in the My Projects Space page**

The project workspace overview page — **My Projects Space** — displays projects as cards based on filter criteria. A maximum of the 200 most recently updated projects appear on the page. Clicking a card opens the project in the project workspace. You can configure the information that is displayed on a card.

**Project cards on the My Projects Space page**
The components of the workspace are:

**Banner icons**

The following banner icons are available in project workspace:

**Home**

The home icon (🏠) enables you to return to the list of project cards on My Projects Space page.

**Project choice list**

The choice list displays the projects that you can select to open in project workspace. The projects in the choice list appear based on the filter criteria applied in My Projects Space page.

**Project checklist**

The checklist icon (📝) helps you to build the checklist of activities that must be completed in a project.

**Tabs in the project workspace**

The project workspace comprises of the following tabs described at a high level:

**Analytics**

The Analytics tab provides analytics on project aspects such as open risks, open issues, and delayed milestones.
Details
The Details tab opens the project form and enables you to define important aspects of the project.

Planning
The Planning tab opens the project in the planning console. The tab also enables you to navigate to Project workbench and track your project in the workbench.

Resources
The Resources tab enables you to find resources, and create and manage the resources plans for the project and project tasks. The tab is available only to a project manager.

Financials
The Financials tab displays breakdowns of cost components of a project: planned cost, estimated returns, allocated budget, cost plans, and benefit plans. You can create baselines and compare baselines from this tab to track changes occurring during execution of project or demand.

Status Report
The Status Report tab displays the project status reports.
Project workspace example
Access the project workspace

Open the project workspace to display all your projects at a single location.

Role required: it_project_manager

1. Navigate to **Project > Projects > Project Workspace** to open **My Projects Space** page.
2. In the **My Projects Space** page, add filter criteria to display the required projects as cards.

   **Note:** You can configure the information which is displayed on a card.

3. Click a project to open it in project workspace.
4. Click the required tab in project workspace to work in it.

Configure the parameters displayed on a project card

Configure the parameters that are displayed on a project card in **My Projects Space** page of project workspace. A card shows the project summary so that project managers can quickly gauge project status and health by looking at the card.

Role required: pps_admin

The project workspace overview page **My Projects Space** displays the projects as cards based on the filter criteria. The cards have a color band at the top. The color of the band is based on the **Status** field in the respective project record. Each card further displays the following information about the project in three rows:

- Row 1 displays project name, state, project manager name, and important project dates. The displayed project dates are based on the current state of the project:
  - If the project state is Pending or Open, planned start date and planned end date are displayed.
  - If the project state is Work in Progress, actual start date and planned end date are displayed.
  - If the project state is Closed, actual start date and actual end date are displayed.

- Row 2 displays **Status**, **Percent complete**, and **Phase** columns from project **[pm_project]** table. The number of displayed columns in this row is fixed to 3, but the columns to be displayed can be configured in **[pm_home_page_config]** table.

- Row 3 displays the following project information based on the current state of the project:
  - Open risks, open issues, actions, and overdue tasks of the project under **Updates** heading.
  - Date and short description of the last missed milestone task under **Last missed milestone** heading.

The parameters displayed are derived from the records in **[pm_home_page_card]** table. In **[pm_home_page_card]** table, each project state is assigned some parameters to be displayed.
You can configure the information which is displayed in row 2 and row 3 on a card.

1. Navigate to **Project Administration > Project Workspace**.
2. Select a table for which you want to change the card configuration, for example, select `Project [pm_project]`.
3. Set the display columns for row 2 of the card in PM Home Page Configuration `[pm_home_page_config]` table.
   a) Select the columns to be displayed in **Column-1**, **Column-2**, and **Column-3** fields.
   b) Click **Update**.

The selected columns appear in row 2 of the project cards.
4. Set the parameters for row 3 of the card in PM Home Page Card [pm_home_page_card] table. In [pm_home_page_card] table, each project state is assigned the parameters that are required to be displayed on a project card in third row.
   a) Click New in PM Home Page Card related list.
   b) On the form, fill in the fields.

PM Home Page Card form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>Position at which the parameter appears in row 3 of the card.</td>
</tr>
<tr>
<td>State</td>
<td>Project state for which the parameter needs to be added.</td>
</tr>
<tr>
<td>Value</td>
<td>Section to be displayed for the selected state in row 3 such as Updates and Last missed milestone.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Content</td>
<td>JSON field to add the parameters to be displayed under the selected section for the selected state.</td>
</tr>
</tbody>
</table>

The following screenshot shows a JSON example of adding Risks, Issues, Actions, and Overdue tasks parameters under **Updates** heading for Open state.

![JSON Example](image)

**Example JSON for Row 3 configuration**

c) Click **Submit**.

**Note:** Use the same steps to change a display parameter assigned to a state.

The parameter is added or updated for the selected state. It appears under selected section in row 3 on the project cards for the state it was added.

**View the project analytics in project workspace**

View the summary of a project in **Analytics** tab of project workspace.

Role required: **it_project_user**
The **Analytics** tab is a PA dashboard which displays preconfigured widgets and reports to track the progress on various aspects of a project such as open risks, actual cost, and delayed milestones. The information in the reports is rolled up from the project form fields. For information about various widgets and reports for different project types, see [Project analytics widgets and reports](#).

1. Open the required project in **project workspace**.
2. Click the **Analytics** tab to display its contents.
3. Review the displayed reports and take necessary actions, if required.

### Project analytics widgets and reports

Widgets and reports that provide information for the project summary in the **Analytics** tab of the project workspace for Agile, Waterfall, and Hybrid projects.

#### Project widgets and reports

Widgets and reports provide information that enables you to view and track the progress of your Agile, Waterfall, and Hybrid project.

**Note:** You must have the Agile Development 2.0 plugin installed to view the widgets and reports for your Agile and Hybrid projects.

Your system administrator can configure the widgets and reports in the dashboard to display project information on the **Analytics** tab. The following dashboards are available:

<table>
<thead>
<tr>
<th>Project Execution Type</th>
<th>Dashboard Displayed</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hybrid</td>
<td>Project Summary – Hybrid</td>
<td>Contains reports and widgets for hybrid projects.</td>
</tr>
<tr>
<td>Agile</td>
<td>Project Summary – Scrum</td>
<td>Contains reports and widgets for agile projects.</td>
</tr>
<tr>
<td>Waterfall</td>
<td>Project Summary – Waterfall</td>
<td>Contains reports and widgets for waterfall projects.</td>
</tr>
</tbody>
</table>

**Note:** This dashboard was previously known as Project Manager Summary Dashboard.

The project execution type determines the dashboard displayed on the **Analytics** tab.

You can also embed a custom dashboard in the **Analytics** tab. Your system admin can modify the `PMViewDataUtils` script include and configure the variable value for the `dashboards_tabs` in the `getDashboardUrl` method. As a result, you can view the custom dashboard in Project Analytics. For example:

```javascript
var dashboards_tabs =
{
    waterfall: {
        dashboard_sysId: '5d4959dd878003008b9b3a0548cb0bd0',
        tab_sysId: '1d99d5dd878003008b9b3a0548cb0bbd'
    },
    hybrid: {
```

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
The following widgets and reports for all project types are provided in the Analytics tab to help the project manager analyze the project.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agile project</td>
<td></td>
</tr>
<tr>
<td>Stories Missing Acceptance Criteria</td>
<td>Number of stories in the project without acceptance criteria information.</td>
</tr>
<tr>
<td>Stories Missing Points</td>
<td>Number of stories in the project with the Points field blank.</td>
</tr>
<tr>
<td>Stories Acceptance Overdue</td>
<td>Number of stories in the project that are not in the Completed or Cancelled state after the sprint end.</td>
</tr>
<tr>
<td>Team-wise Sprint Status</td>
<td>Track the sprint-wise status of various scrum teams across the release. Click the team name to view sprint details.</td>
</tr>
<tr>
<td>Stories by State</td>
<td>Donut chart showing the number of stories in different stages of development such as Draft, Ready, and WIP. Click the appropriate state to view details of the stories.</td>
</tr>
<tr>
<td>Progress by Points</td>
<td>Track the progress of the project based on points. You can group and stack stories based on any combination of Epic, Assignment group, and State.</td>
</tr>
<tr>
<td>Progress by Stories</td>
<td>Track the progress of the project based on the number of stories. You can group and stack stories based on Epic, Assignment group, and state.</td>
</tr>
<tr>
<td>Waterfall and Hybrid project</td>
<td></td>
</tr>
<tr>
<td>Issues</td>
<td>Number of issues in the Pending, Open, and Work In Progress states included in the project.</td>
</tr>
<tr>
<td>Actions</td>
<td>Number of action items in the Pending, Open, and Work In Progress states for the project.</td>
</tr>
<tr>
<td>Change Requests</td>
<td>Number of change requests in the Pending, Open, and Work In Progress states for the project.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Stories by State</td>
<td>Pie chart showing the number of stories in different stages of development such as Draft, Ready, and WIP. Click the appropriate state to view the details for the stories.</td>
</tr>
<tr>
<td>Note</td>
<td>This widget is applicable for Hybrid projects only.</td>
</tr>
<tr>
<td>Tasks by State</td>
<td>Donut chart showing the number of project tasks in different stages of development such as Pending, Open, Work In Progress, and Closed Complete. Click the appropriate state to view the task details.</td>
</tr>
<tr>
<td>Project Member Allocation Details (Hrs)</td>
<td>Stacked bar chart showing allocated and actual hours of the resources assigned to the project.</td>
</tr>
<tr>
<td>Project Member Allocation Details — Monthly (Hrs)</td>
<td>Pivot chart showing the monthly allocated and actual hours for the resources assigned to the project.</td>
</tr>
<tr>
<td>Task Assignments</td>
<td>Track the state of various project tasks across the release based on the assigned users or group. Click the user or group name to view the details of the assigned tasks.</td>
</tr>
<tr>
<td>Resource Plans by State</td>
<td>Donut chart showing the number of resource plans grouped according to their current state.</td>
</tr>
<tr>
<td>Overdue Tasks and Milestones</td>
<td>List of overdue project tasks and milestones, which are the tasks that satisfy either of the following conditions in the Project Task [pm_project_task] table:</td>
</tr>
<tr>
<td></td>
<td>• The value of the Planned start date is before today's date and the State value is Open or Pending.</td>
</tr>
<tr>
<td></td>
<td>• The value of the Shadow field is set to false.</td>
</tr>
<tr>
<td>Upcoming Tasks (next 2 weeks) with no assignee</td>
<td>List of unassigned Open or Pending project tasks that are planned to start 14 days from the current date.</td>
</tr>
<tr>
<td>Common widgets</td>
<td></td>
</tr>
<tr>
<td>Phase</td>
<td>Current state of the project such as Initiating or Planning.</td>
</tr>
<tr>
<td>Status</td>
<td>Color indicator that signifies the status of the project.</td>
</tr>
<tr>
<td>Percent Complete</td>
<td>Percentage of the project that has been completed.</td>
</tr>
<tr>
<td>Time Elapsed</td>
<td>Amount of time that has passed while working on the project from the actual start date to the planned end date. If the project is in the Open or Pending state, then the time elapsed is calculated based on the Planned start date and the current date.</td>
</tr>
<tr>
<td>Risks</td>
<td>Number of risks in the Pending, Achieved, and Not Achieved states concerning the project.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cost Trend Analysis</td>
<td>Line graph showing a comparison between the planned costs and actual costs on a monthly basis.</td>
</tr>
<tr>
<td>Benefit Trend Analysis</td>
<td>Line graph showing a comparison between planned benefits and actual benefits on a monthly basis.</td>
</tr>
<tr>
<td>Time Cards — Pending Approval</td>
<td>Time cards for the selected project that are submitted but not yet approved.</td>
</tr>
<tr>
<td>Time Card — Exception Report</td>
<td>List of users who did not submit their time cards for the selected project, and time cards that are not yet approved for the selected project. The exception report is generated for users who are assigned to a task in progress, or hard-allocated to the project or task.</td>
</tr>
</tbody>
</table>

**Define a project in project workspace**

Define important aspects of the selected project such as duration, estimated cost, and the net value to the organization in project workspace.

Role required: it_project_user

The **Details** tab in project workspace displays the **project form** for the selected project.

1. Open the required project in **project workspace**.
2. Click the **Details** tab to display the project form.
3. Edit the project record as required.

**Plan a project using planning console in project workspace**

Perform the project planning such as create project schedule, make resource assignments, create baselines, and view critical path, using planning console in the project workspace.

Role required: it_project_user

The **Planning** tab in project workspace displays the selected project in **planning console**.

1. Open the required project in **project workspace**.
2. Click the **Planning** tab to display the project in planning console.

**Note:** If project workbench is already open in **Planning** tab, click the **Project Workbench** selection arrow on the banner and select **Planning Console**.

3. Plan the project using planning console features such as WBS hierarchy and Gantt chart. You can also perform several **tasks on the planning console** that you can perform on lists and forms, such as creating project tasks.

**Track a project using project workbench in project workspace**

As a project manager, track and manage a project in Project Workbench.

Role required: it_project_manager

You can use the **Planning** tab in project workspace to displays the selected project in **project workbench**.

1. Open the required project in **project workspace**.
2. Click the **Planning** tab.
3. To display the project in project workbench, click the Planning Console selection arrow on the banner and select Project Workbench.

4. Track and manage all aspects of the project using project workbench.

Create and manage resource plans for a project

As a resource requester, find the availability of the resources, and create and manage the resource plans for the project and project tasks in the project workspace.

Role required: it_project_manager

The Resources tab in project workspace shows the resource plans for the selected project in an editable grid view. The tab consists of the following sections:

Resource grid

It is the top section on the page that enables you to:

- Create resource plans for the project or its tasks. You can create a resource plan at a group, role, or user level.
- View and manage all the resource plans for the open project and its tasks in one place.
- View resource allocations for each resource plan in a grid view.

Use the grid view in the tab to:

- Edit the planned and allocated hours inline without opening the record in a form.
- Group, hide, or show columns as per your requirement.

Resource Finder

The section is available at the bottom of the page. The section is hidden by default. It can be made visible by clicking the resource finder icon (🔍) in the top right of the page. It enables you to:

- Search the resources and view their availability. You can search the resources by group, role, or user.
- Add resource plans for the searched resources to the project and its tasks.

When you select a resource plan in the resource grid section, the availability details of that resource are displayed in the resource finder section. For example, if a group resource plan is selected, the availability details of the group and its members are displayed in the Finder section. When you change the selection, the finder is automatically updated based on the current selection.

1. Open the required project in project workspace.
2. Click the Resources tab.
   - To create a resource plan, click New.
   - To view the allocations in weekly or monthly format in the grid, click Week or Month button. The selected option changes the grid view in both the resource grid and resource finder sections.
     The time duration in the grid is displayed based on the earliest start date of the project or resource plans, and the last end date of the project or resource plans.
   - To view the allocations in hours, FTE, or person days format in the grid, click Hours, FTE, or Person Days option in the list. The selected option changes the grid view in both the resource grid section and resource finder section.
   - To search the resources and create a resource plan for them, click the resource finder icon ( ).
   - To show or hide certain columns from the grid view, click the configuration icon ( ).
     HIDING OR DISPLAYING AN ITEM COLUMN DOES NOT UPDATE THE TABLE. GROUPED COLUMNS CANNOT BE HIDDEN.
   - To view the resource allocations at user level, expand a resource plan in the grid. The user level allocations are listed only for Group and Role resource plans.
   - To edit the planned and allocated hours inline in the grid, double-click a row. You can update the planned hours for future period for resource plans in Requested, Confirmed, and Allocated state.
   - To view and update resource plan details in a form, click the information icon ( ) in the beginning of the resource plan row.
   - To request a resource plan in the Actions column, click the actions icon ( ) and select Request.
   - To delete a resource plan in the Actions column, click the actions icon ( ) and select Delete.
   - To request all the resource plans created for the project in the Actions column, click the actions icon ( ) in the project row and select Request All. The icon is enabled when at least one of the listed resource plans for the project is in the Planning or Rejected state.

Create and manage cost plans and benefit plans for a project

Use the Financials tab in Project Workspace to capture costs and benefits of a project.

Role required: it_project_manager

The Financials tab provides a detailed breakdown of cost components of a project. The total planned cost, budget cost, actual cost, and planned returns with their breakdowns are displayed in the form of read-only cards, while the cost plans, benefit plans, and their breakdowns are provided in an editable grid view. Using the grid view, you can:

- Group the plan level columns; configure, sort, expand, collapse, and freeze both the plan level and breakdown columns.
• Inline edit the breakdown values of a cost plan or benefit plan without opening the plan in a form. Inline edit is available only in the Monthly view.

• Create a cost plan and benefit plan for the project.

1. Open the required project in project workspace.
2. Click the Financials tab.
3. To create a cost plan:
   a) Select Cost Plans from the list.
   b) Click New.

4. To create a benefit plan:
   a) Select Benefit Plans from the list.
   b) Click New.

5. Optional: Review additional fields, view plan details, or reorganize the comparative data on the form.
   • To create a baseline or compare available baselines, click the baseline information icon

      and then select Create New Baseline or Compare Baselines option respectively.

In the Financial Baseline comparison screen, the top two rows shows all the values in either functional currency or project currency. To display the values in project currency, click the configuration icon and toggle on the Show Widgets in Project Currency view.

The Financial Baseline Details pane indicates the Functional Currency and the Project Currency that has been selected.

The Financial Baseline grid shows the Functional cost, Cost in Project currency, Actuals, and Actuals in Project Currency. You can view the Project currency at the grid level. This view is helpful when there are cost plans of sub-projects that are in different project currency.

• To view a cost plan or benefit plan details in a form, click the

   icon available in the Name column of the grid.

• To view a cost plan or benefit plan details in yearly, quarterly, or monthly format, click the Year or Quarter or Month views respectively.

• To toggle viewing the widgets on the Financial Summary section, click the widgets icon

   and then select the Show Widgets option.

Select an individual widget name to show, clear them to hide.

The selected field preferences are saved and are available when you reopen the Financial tab.

• To show or hide columns in the grid, click the configuration icon

   and select the field names.

You cannot hide the grouped columns. To reset to the default grid column layout, select the Reset to defaults option.

• To view the project costs in project currency, click the configuration icon


and select the five widgets to show project currency amounts. The widgets are Total Planned Cost in Project Currency, Budget Cost in Project Currency, Actual Cost in Project Currency, Planned Return in Project Currency, and Benefit in Project Currency.

You can view both the functional and project currencies in the currency indicator.

In the Financial Summary grid view of the cost plan and benefit plan tabs, all items related to project currencies are configured in the column heads such as Cost in project currency, Project currency, and Total actual cost in project currency.

By default, you can view only the functional currency columns. To view the project currency columns, click the configuration icon and select the project currency column check boxes in the item columns.

The aggregated amount in Cost in project currency field is blank if there are cost plans of sub-projects with different project currency.

**Configure a widget for project financial metrics**

Configure a widget to view and track the financial metrics of a project on the Financials tab of the Project Workspace page.

Role required: pps_admin

1. Navigate to Project Administration > Widgets.
2. Click New.
3. On the form, fill in the fields.

| **Widget form** |
|-----------------|------------------------------------------------|
| Field           | Description                                                                 |
| Name            | Unique name for the widget.                                                  |
| Scripted        | Option for indicating the value on the widget is from a code script.          |
|                 | By default, this option is selected and is read-only.                         |
| Show Label      | Option for displaying either the label or the color indicator.                |
|                 | If you clear the check box, the Color field appears and you can set the color.|
| Active          | Option for indicating the status of the widget.                               |
|                 | Only active widgets can be shown on the Financials tab of the Project Workspace.|
| Parent widget   | Widget that is the parent of the current widget.                             |
|                 | The current widget displays in the Child widgets related list of the selected widget.|
|                 | You can add a maximum of three child widgets for a parent widget.             |
| Formatter required | Option for specifying whether a currency formatter is required for the widget. |
### Associate a widget to the Project table.

After you configure a widget, associate it with the Project table to show the financial data of a project.

You should **configure a widget** before you can associate it with the Project `[pm_project]` table.

**Role required:** `pps_admin`

1. Navigate to **Project Administration > Widgets**.
2. Open a widget to associate with the Project table.
3. In the Widget associations related list, click **New**.
4. On the form, fill in the fields.

### Widget association form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Association ID | Record to associate to the widget.  
To access the relevant records, you must select the Tables `[sys_db_objects]` table in the **Table name** list and the Project `[pm_project]` table in the **Document** list. |

| Association table | Table to associate to the widget.  
You must select Table `[sys_db_objects]` from the list. |

<p>| Widget | Unique name of the widget. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>Position of the widget in relation to other widgets in the <strong>Financials</strong> tab of the Project Workspace. Widgets appear in numeric order with the smallest number listed first.</td>
</tr>
<tr>
<td>Display on card</td>
<td>Option to display the widget in the <strong>Financials</strong> tab.</td>
</tr>
<tr>
<td>Include by default</td>
<td>Option to show the widget by default in the <strong>Financials</strong> tab.</td>
</tr>
</tbody>
</table>

**Request funds for a project**

Request funds for your project investment to work on project activities and meet the business goals.

You can request funds for your project if the following conditions are true:

- The Investment Funding for PPM plugin is active.
- The funding entity for Project is available and is active.

Role required: it_project_manager

If you have added cost plans to your project, you can refer the total planned cost displayed on the column header of each period to determine the amount to request.

1. Navigate to **Project > Projects > Project Workspace**.
2. Click a project for which you want to review or manage funds.
3. On the Project Workspace, click the **Financials** tab.
4. Click the **Funds** tab.
   - The Funds list shows funding sources if you have previously requested funds from them for your project.
5. Click the **Add New Source** link to select the funding source.
6. In the **Select a Source** pane, select one or more source investments from the list, and then click **Add Selected**.
   - The specified funding source is added in the Request Funds grid.
7. In the Request Funds grid, specify the amount in the **CapEx** and **OpEx** columns under **New/Modify Request** of the funding sources from which you want to request funds.
   - The state of all updated funding sources changes to Draft or Planning, which is indicated by highlighted cells.
8. Click **Request**.
9. In the Confirm request dialog box, verify your requests and add a comment if required.
10. Click **Request**

**Enter actuals spent in a project**

Enter actual spends in your project to track the fund utilization.

Role required: it_project_manager

When you spend funds allocated to your project to complete your project activities, record that amount as actuals to review and track your project finances.

**Note:** The actuals in the project record, that is calculated from the expense lines, does not reflect into the actuals of the Funds automatically. Since your actual spends might include labor costs.
and other expenses, you should enter it manually against the corresponding funding source in the Funds list.

1. Navigate to **Project > Projects > Project Workspace**.
2. Click a project for which you want to review or manage funds.
3. On the Project Workspace, click the **Financials** tab.
4. Click the **Funds** tab.
5. In the Funds list, enter the actual amount spent in the project under the **Actual CapEx** and **Actual OpEx** columns for the corresponding funding source.

**Note:** If you do not see the **Actual CapEx** and **Actual OpEx** columns in the list, select them from the configuration icon.

- The entered amount is updated as actuals for the project.

### View a project status report in project workspace

As a project manager, view the project status reports for a project using **Status Report** tab in project workspace.

Role required: it_project_manager

From the **Status Report** tab, you can:

- View and print the status reports available for a project.
- Create a status report.
- Save time when creating a status report by copying fields from existing status reports of the project.

1. **Open** the required project in project workspace.
2. Click the **Status Report** tab. The most recent status report created for the project is displayed.
3. To **create a status report**, click **Create new** button in the top right.
4. To **copy an existing status report**:
   a) Select a status report from the choice list that you want to copy.
   b) Click **Copy** from the choice list next to **Create new**. The option copies the selected status report including all fields into the new report.
   c) Click **Save**.
5. To view the contents of a **status report** available for the project, select a status report from the choice list. The reports are listed in the choice list by their creation date.
6. To print a status report, click the print icon (printing icon) in the top right.

### Define a project

Define important aspects of your Agile, Waterfall, or Hybrid project such as the duration, estimated cost, and net value to the organization to efficiently track the project's progress.

Role required: it_project_manager
You can create a project from the Projects list or from the project planning console. You must have the Agile Development 2.0 plugin to create an Agile or Hybrid project and the Test Management plugin to create a test phase for your project.

**Note:** You can also create a project from the demand workbench.

You can also use the multi-currency feature to create a project in a local currency different from your functional currency. You must enable the PPM Standard Multicurrency plugin (com.snc.ppm_multicurrency) and switch to the Project Currency view for the additional fields in the **Financials** tab of the Project form. For more information, see Multi-currency in project financials.

1. Create a project in any of the following ways.

<table>
<thead>
<tr>
<th>Location</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the Projects list</td>
<td>Navigate to <strong>Project</strong> &gt; <strong>Projects</strong> &gt; <strong>Create New</strong>.</td>
</tr>
<tr>
<td>From the project workspace</td>
<td>a. Navigate to <strong>Project</strong> &gt; <strong>Projects</strong> &gt; <strong>Project Workspace</strong>.</td>
</tr>
<tr>
<td></td>
<td>b. Click the <strong>New Project</strong> button on the My Projects Space page.</td>
</tr>
<tr>
<td></td>
<td>c. In the Create Project dialog box, enter the <strong>Project name</strong> and <strong>Start date</strong> information.</td>
</tr>
<tr>
<td></td>
<td>d. Select a template to use for the project from the Project template list and click <strong>OK</strong>.</td>
</tr>
</tbody>
</table>

2. On the form, fill in the fields.

### Project form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Name</td>
<td>Name of the project. When you create the project from My Projects Space page, the <strong>Project name</strong> field is automatically populated.</td>
</tr>
<tr>
<td>Project manager</td>
<td>Project manager assigned to the project.</td>
</tr>
<tr>
<td>Status</td>
<td>Current status of the project. This information is retrieved from the <strong>Overall health</strong> field in the most recent project status report of the project.</td>
</tr>
<tr>
<td>Number</td>
<td>System-generated number with a configurable prefix.</td>
</tr>
<tr>
<td>Percent complete</td>
<td>Percentage of the project that has been completed.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the project. All new projects begin as <strong>Pending</strong>. The state of the project can be set on the Project form or derived from the task state. The default available states are: Pending, Open, Work in Progress, Closed Complete, Closed Incomplete, and Closed Skipped. You can also create a custom state for each state type by overriding the state dictionary attributes. For example, say for project tasks you have created a custom state called <strong>Testing</strong> for the <strong>Work in Progress</strong> state type. When you update the project task state to <strong>Testing</strong>, the project state is also updated to <strong>Testing</strong>. However, if you have not created a <strong>Testing</strong> state for the <strong>Work in Progress</strong> state type, the project state is updated to the default <strong>Work in Progress</strong> state.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the project.</td>
</tr>
<tr>
<td>Similar projects</td>
<td>Displays projects that have similar values for the <strong>Description</strong> and <strong>Short Description</strong> fields using predictive intelligence and machine-learning algorithms. For more information, see Predictive Intelligence for Project Management.</td>
</tr>
<tr>
<td>Related Search</td>
<td>Displays search results matching the <strong>Name</strong> field by default. You can use this field to search for matching projects using other terms also.</td>
</tr>
<tr>
<td>Dates</td>
<td></td>
</tr>
<tr>
<td>Schedule</td>
<td>Work schedule to be used for this project. Note that the default schedule is an 8-hour work day (from 8 a.m. to 12 p.m. and 1 p.m. to 5 p.m.). A day is considered to be a work day and not a 24-hour day.</td>
</tr>
<tr>
<td>Approved start date</td>
<td>The date to start the project. This field retains the demand start date if the project is converted from a demand. The project schedule is not applied to this date and the date remains unchanged when you add project tasks to your project. This field is highlighted with red color if the date in this field is set to a date later than the <strong>Planned start date</strong> field.</td>
</tr>
<tr>
<td>Approved end date</td>
<td>The date when this project ends. This field retains the demand due date if the project is converted from a demand. The project schedule is not applied to this date and the date remains unchanged when you add project tasks to your project. This field is highlighted with red color if the date in this field is set prior to the date in the <strong>Planned end date</strong> field.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Planned start date</td>
<td>The start date of the project tasks within the project. This date is rolled up from the project tasks. This date is copied from the <strong>Approved start date</strong>. Once planned tasks are added, this value is set to the earliest time that the project schedule allows. For example, if the project task is created at 3 a.m. and the default schedule is in use (which has an 8 a.m. start date), then the default task start is 8 a.m. the next day.</td>
</tr>
</tbody>
</table>

**Note:** The planned start date must be within 10 years of the current date. The project property **Max date span into future or past from the current date** controls the behavior for project planned start date.

When you create the project from My Projects Space page, the **Planned start date** field is automatically populated. You must click the calendar icon and select a date to start the project. Projects do not automatically start on the planned start date.

**Note:** When you change the planned start date of a project, the associated cost plans and resource plan also change. The project property **Change Resource Plan and Cost Plan Start Date with Demand or Project Start Date Change** controls the behavior for project start date change.

**Note:** This field is not available when creating a project by default, use the **Approved start date** field to specify the project start date. Configure the form to display this field. However, this field is available for existing projects and projects converted from a demand.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planned end date</td>
<td>The end date of the project tasks within the project. After you add tasks, the value in the field is calculated from the tasks. For a manual project, any update to the actual start date does not update the planned end date of the project. Enable the project property Enable alter of planned date with Actual for Manual Project to update the planned end date from the actual start date and planned duration.</td>
</tr>
<tr>
<td>Note: This field is not available when creating a project by default, use the Approved end date field to specify the project end date. Configure the form to display this field.</td>
<td></td>
</tr>
<tr>
<td>Planned duration</td>
<td>Expected duration of the tasks within the project. After you add tasks, the value in the field is calculated from the duration of the tasks. The duration also considers the project schedule, accounting for any non-work time in the schedule.</td>
</tr>
<tr>
<td>Note: The project property Max duration (in days) allowed for a project/project task controls the behavior for project planned duration.</td>
<td></td>
</tr>
<tr>
<td>Actual start date</td>
<td>Date on which the planned tasks start. The time component in the actual start and end dates depends on the value of the Derive time component from planned dates field in the Preferences tab when you manually populate the actual dates. However, when you change the State or Percent complete of the project, the actual dates are auto-populated with the time component copied from the planned dates. The value of the Derive time component from planned dates field has no effect on the time component of actual dates in this case.</td>
</tr>
<tr>
<td>Actual end date</td>
<td>Date on which the planned tasks ends.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Actual duration</td>
<td>Duration of the project tasks from project start to project closure. As with the planned duration, the actual duration shows the total project time and takes the project schedule into consideration.</td>
</tr>
<tr>
<td>Actual effort</td>
<td>Actual number of hours charged to the resources on this project. If you are using the Time Cards application, it automatically calculates the value for this field. It uses the totals for the time worked from the approved time cards of all the resources who worked on a project and all its tasks.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The actual effort from the stories for Agile and Hybrid projects is also rolled up to the project's actual effort.</td>
</tr>
<tr>
<td></td>
<td>The field is not editable if the <strong>Update actual effort from time card</strong> field is set to Yes in the <strong>Preferences</strong> tab.</td>
</tr>
</tbody>
</table>

**Details**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portfolio</td>
<td>Primary portfolio to which the project belongs. A project can belong to multiple portfolios.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>• If a project, for which the <strong>Portfolio</strong> field is not set is associated to a portfolio using the portfolio form, then the portfolio name is populated in the <strong>Portfolio</strong> field.</td>
</tr>
<tr>
<td></td>
<td>• If a portfolio is deleted, the portfolio name is removed from the <strong>Portfolio</strong> field on the Project form.</td>
</tr>
<tr>
<td>Program</td>
<td>Program to which the project belongs.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>• If the <strong>Portfolio</strong> field is not set, you can select from the list of all programs in the system. If the <strong>Portfolio</strong> field is set, you cannot select programs that belong to other portfolios.</td>
</tr>
<tr>
<td>Investment Class</td>
<td>Type of investment class category assigned to the project:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Run</strong>: Investment made to sustain the existing business.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Change</strong>: Investment made to implement a change in business.</td>
</tr>
<tr>
<td>Investment Type</td>
<td>Investment type of the project. The default available options are Cost Reduction, End User Experience, Legal and Regulatory, Revenue Generating, Service Sustaining, and Strategic Enabler.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Execution Type           | Execution methodology used to run the project: Waterfall, Agile, and Hybrid. 
The default value is Waterfall. 
The Execution Type field selection determines the related links and related lists that are available. For example, the Agile Planning & Tracking related link appears when you set the Execution Type value to Agile. You must have the appropriate plugins such as Agile Development 2.0 and Test Management to view these related links and related lists. Also, you must have the appropriate role to use these related links and related lists. |
| Demand                   | Demand from which the project was created. The field is visible only if the project has a demand associated to it. |
| Phase                    | Current phase of the project. 
In addition to the Phase field, the different project phases are also shown at the top of each project record. The selected phase is highlighted. 
The default phases are Initiating, Planning, Executing, Delivering, and Closing. |
| Department               | Department in a business unit to which the project belongs. |
| Business Unit            | Business unit to which the project belongs. |
| Impacted Business Units  | Business unit that is impacted by the project. |
| Business Capabilities    | If the project is to change, enhance, or add one or more business capabilities, those capabilities can be associated with the project. Business capabilities are defined in the Application Portfolio Management module. |
| Business Applications    | If the project is to change, enhance, or add one or more business applications, those applications can be associated with the project. Business applications are defined in the Application Portfolio Management module. 
You can select any business application in your enterprise regardless of whether it is related to the capability selected in the Business Capabilities field. |

**Business Case**

**Note:** When a demand gets converted into a project, the data in Business Case tab gets carried forward from demand to project.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Strategies</td>
<td>Strategic objectives of the organization that the project fulfills. A project can fulfill multiple strategic objectives. If a Business Unit for the project is selected in Details tab, then the choice list displays the business strategies for the selected business unit along with other enterprise strategies.</td>
</tr>
<tr>
<td>Goals</td>
<td>Goals associated with the selected strategy. A project can fulfill multiple goals. If a strategy is not selected, then all goals are displayed in the choice list.</td>
</tr>
<tr>
<td>Business case</td>
<td>Business arguments that support the project.</td>
</tr>
<tr>
<td>Risk of performing</td>
<td>Risks associated if the project is carried out.</td>
</tr>
<tr>
<td>Risk of not performing</td>
<td>Risks associated if the project is not carried out, for example, risk of loss of opportunity.</td>
</tr>
<tr>
<td>Enablers</td>
<td>Key enablers for the project.</td>
</tr>
<tr>
<td>Barriers</td>
<td>Major barriers to the project.</td>
</tr>
<tr>
<td>In scope</td>
<td>Scope of the project. The scope is the set of boundaries that define the extent of a project.</td>
</tr>
<tr>
<td>Out of scope</td>
<td>Activities or deliverables that are not in the scope of the project. Anything that is not specifically defined in the scope is out of scope.</td>
</tr>
<tr>
<td>Assumptions</td>
<td>Assumptions made for the project. Assumptions help define scope and risks, and fine-tune the estimates for time and cost.</td>
</tr>
<tr>
<td>Financials</td>
<td></td>
</tr>
<tr>
<td>Rate Model</td>
<td>Rate model assigned to the project. The rate model is used to derive hourly rates for the associated resource plans and time cards. When you create a project from a demand, the rate model is copied from the demand to the project. The subprojects in a project derive their resource plan calculations from the rate model associated with the top task. If the assigned rate model is removed or replaced or the hourly rates in the rate model are changed, the cost fields on the associated resource plans are not recalculated automatically. You must update costs of all resource plans in the project using the Recalculate Resource Costs menu option to reflect new rates from the rate model. You can also update costs of a single resource plan one at a time.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Total planned cost</td>
<td>Estimated cost of the project. If an operational expenditure, capital expenditure, or both are associated with the project, then the planned cost is the sum of the operational expenditure and capital expenditure, which is in the selected currency for the project. For Agile and Hybrid projects, the planned cost for stories is considered when the resource plan is created for Agile assignment group.</td>
</tr>
<tr>
<td></td>
<td>Note: To create a resource plan for Agile assignment group, you must assign the pps_resource role to the group.</td>
</tr>
<tr>
<td></td>
<td>The value of this field is calculated from the values of the Planned capital and Planned operating fields.</td>
</tr>
<tr>
<td></td>
<td>If the currencies in Planned capital and Planned operating fields are different from functional currency, the daily conversion rate is used to convert the amount in your functional currency and value is used for the calculation of the value in the Total planned cost field.</td>
</tr>
<tr>
<td>Planned capital</td>
<td>Capital expenditure (Capex) for the project. If no cost plans are associated with the project, the Planned capital field is editable. Select a currency type and enter a value.</td>
</tr>
<tr>
<td></td>
<td>If the currency is different from your functional currency, the daily conversion rate is used to convert the amount in your functional currency and value is used for the calculation of the value in the Total planned cost field.</td>
</tr>
<tr>
<td>Planned operating</td>
<td>Operational expenditure (Opex) for the project. If no cost plans are associated with the project, the Planned operating field is editable. Select a currency type and enter a value.</td>
</tr>
<tr>
<td></td>
<td>If the currency is different from your functional currency, the daily conversion rate is used to convert the amount in your functional currency and value is used for the calculation of the value in the Total planned cost field.</td>
</tr>
<tr>
<td>Budget cost</td>
<td>Budgeted cost for this project. This field is automatically populated from the project budget breakdowns in the cost plan breakdown table. When project funds are allocated for a fiscal year, the cost plan breakdown stores the budget allocation for each fiscal period. These amounts are rolled up and stored in the budget cost.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Actual cost</td>
<td>Actual cost of this project. You can select a currency different from your functional currency and enter a value until there are no cost plans associated with the project. When an expense line is processed for the project, the value for this field is overridden and rolled up from the expense lines.</td>
</tr>
<tr>
<td>Estimate at completion</td>
<td>Sum of all actuals for past fiscal periods added to the planned cost for future fiscal periods. Note: The current month is considered as a future month for EAC calculation purposes. For example, if the duration of a project is from January 01 to December 31 and you check the Estimate at Completion in the month of May, it is calculated as: Sum of actuals from Jan to April + Sum of planned cost from May to December.</td>
</tr>
<tr>
<td>Planned benefit</td>
<td>Planned benefit for the project. This value is rolled up from the benefit breakdown of the project. You can also enter the value manually. Select a currency icon and enter a value. If the currency is different from your functional currency, the daily conversion rate is used to convert the amount in your functional currency and value is used for the calculation of the value in the Planned return field.</td>
</tr>
<tr>
<td>Planned return</td>
<td>The Planned return value is derived from the difference between the Planned benefit and Total planned cost values: (The value in the Planned benefit field – the value in the Total planned cost field)</td>
</tr>
<tr>
<td>Planned ROI%</td>
<td>The ROI (return on investment) percentage result is calculated based on values in the Planned return and Estimated cost fields. (Planned return/Estimated cost x 100)</td>
</tr>
<tr>
<td>Discount Rate %</td>
<td>Project discount rate. The discount rate is the interest rate to determine the present value of future cash flows.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Net present value         | Present value of future cash based on the given annual interest rate.  
This value is a measure for comparing money spent today against future expected financial benefits. This information is useful when evaluating the overall investment performance.  
For example, at 12% discount rate, $1.00 today is worth $0.80 in two years. Therefore, expecting to receive $1.00 in two years is same as receiving $0.80 today.  
Net present value (NPV) is calculated from the estimated cost per year, the planned benefit per year, and the discount rate for the project. |
| Internal rate of return % | Annual interest rate required to achieve an NPV of zero.  
Internal rate of return (IRR) helps to determine which projects can deliver higher rate of return in terms of revenue.                                                                                                                                                                  |
| Estimate to completion    | Sum of all planned costs for future fiscal periods.  
**Note:** The current month is considered as a future month for ETC calculation purposes.                                                                                                                                                                                      |
| Score                     | Calculated based on the project risk.  
Calculated based on the ROI% of the project.  
Calculated based on the value in the Planned Cost field.  
Score is calculated based on the individual scores of the attributes Risk Score, Value Score, and Size Score, which in turn are calculated based on the risk, planning ROI%, and estimated cost attributes on a project, respectively.                                                                                                                                                                                                 |
|                           | **Note:**  
- You can configure the formula for score calculation.  
- When a demand is converted to a project, the score calculated on the demand is carried forward to the project.                                                                                                                                                                                                                   |
| Notes                     | Users who have subscribed to project notifications.  
Users who have chosen to receive email notifications when the work notes on the project are updated.                                                                                                                                                                                                                                      |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity / Work notes</td>
<td>Information about the milestones, impediments, or changes as the project progresses. Enter the notes in the Activity field and click Work notes. The text appears in the feed.</td>
</tr>
<tr>
<td>Preferences</td>
<td>Level at which the time cards for project tasks can be created:</td>
</tr>
<tr>
<td></td>
<td>- Project only: All time cards for the project are created at the project level only. For example, if a user is assigned to multiple tasks in a project, then the time spent on all tasks is recorded under one time card only for the project.</td>
</tr>
<tr>
<td></td>
<td>Note: In the Time Sheet Portal, tasks of the project are listed in the Tasks tab. For these tasks, the Add to Time Sheet and Add selected to Time Sheet options are not available. Only the Quick Add option is available. On clicking Quick Add, a time card is created against the top project, not against the task.</td>
</tr>
<tr>
<td></td>
<td>- Project tasks only: Separate time cards are created corresponding to each planned task.</td>
</tr>
<tr>
<td></td>
<td>Note: In the Time Sheet Portal, the Add to Time Sheet, Quick Add, and Add selected to Time Sheet options are not available for the project.</td>
</tr>
<tr>
<td></td>
<td>- Project and project tasks: Time cards can be created at the project as well as the project task level. This is the default set value.</td>
</tr>
<tr>
<td></td>
<td>- No time reporting: No time cards are created for the project. If the user submits the time card manually, the business rules prevent the user from submitting the time card.</td>
</tr>
<tr>
<td></td>
<td>Note: In the Time Sheet Portal, the Add to Time Sheet, Quick Add, and Add selected to Time Sheet options are not available for both project and project tasks.</td>
</tr>
<tr>
<td>Update actual effort from time card</td>
<td>Determines whether the Actual effort field on the Dates tab should be updated based on the hours entered in the time cards for the project.</td>
</tr>
<tr>
<td></td>
<td>If the field is set to Yes, then the Actual effort field is not editable. If it is set to No, then the actual hours from time cards are not rolled up to the project and task. By default, it is set to No.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Calculation</td>
<td>Type of calculation to use for task dependencies:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Manual</strong>: Task dates do not reflect any changes made to dependencies.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Automatic</strong>: Task dates are automatically updated to reflect any changes made to dependent or child tasks.</td>
</tr>
<tr>
<td>Show on Program Status Report</td>
<td>Option to specify whether the project and its key aspects such as cost, resource, scope, and schedule should be included in the status report of the program to which the project belongs. Default: Selected</td>
</tr>
<tr>
<td>Constraint date</td>
<td>A read-only field that displays the project’s planned start date. The date in this field is used for calculate the start date of the tasks with <strong>Start ASAP</strong> constraint. Use the <strong>Move Project</strong> related link to change the constraint date. Changing this date also changes the start date for all the tasks with <strong>Start ASAP</strong> constraint. For more information, see Change the planned start date of a project.</td>
</tr>
<tr>
<td>Derive assignee list from resource plan</td>
<td>Option to constrain the resources in the <strong>Assigned to</strong> and <strong>Additional assignee list</strong> fields on the project and project task forms to be derived only from the associated allocated resource plans.</td>
</tr>
<tr>
<td>Recalculate score on project change</td>
<td>Determines whether to recalculate and update the project score.</td>
</tr>
<tr>
<td></td>
<td>• If the value of the field is set to Yes, project score is recalculated when the projects planned ROI%, estimated cost, or risk is modified.</td>
</tr>
<tr>
<td></td>
<td>• If the value of the field is set to No, the project score remains the same even if the project’s planned ROI%, estimated cost, or risk is modified. The value of the field can be set to No when the user wants to preserve the score value while converting the project to a demand.</td>
</tr>
<tr>
<td>Project schedule date format</td>
<td>Determines whether the dates in the planning console should be displayed with the time component. Default: Date.</td>
</tr>
</tbody>
</table>
Derive time component from planned dates

Determines whether the time component in the actual start and end dates should be copied from the time component in the planned start and end dates. By default, it is set to True.

If the Project schedule date format field is set to Date, this option is selected and disabled.

**Note:** When you change the State or Percent complete value for the project, the actual dates are auto-populated with the time component copied from the planned dates. The value of the Derive time component from planned dates field has no effect on the time component of the actual dates in this case. The value of the field affects the time component only when you populate the actual dates manually.

---

**Risk Overview**

**Inherent risk**
Score of inherent risk automatically calculated from risk assessment.

**Residual risk**
Score of residual risk automatically calculated from risk assessment.

**Inherent Heatmap**
Heatmap of the inherent risks.

**Residual Heatmap**
Heatmap of the residual risks.

---

3. **Click Submit.**

Use the information provided by the following related links and related lists to capture the important aspects of the project and complete the project record.

**Project form related links and related lists**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Related Links</td>
<td></td>
</tr>
<tr>
<td>Agile Planning &amp; Tracking</td>
<td>Opens the Backlog tab of the Agile Board for an Agile project. For more information about backlogs, see Manage your product backlog. This related link appears only when the value for the Execution Type field is set to Agile and the Agile Development 2.0 plugin is installed.</td>
</tr>
<tr>
<td>Calculate Completion Estimates</td>
<td>Recalculates the values in the Estimate at Completion field of the project.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Create Agile Phase</td>
<td>Creates an agile phase for the project. An agile phase includes stories in <strong>Stories</strong> related list. This related link appears only when the value for the <strong>Execution Type</strong> field is set to <strong>Agile</strong> and the Agile Development 2.0 plugin is installed.</td>
</tr>
<tr>
<td>Create Test Phase</td>
<td>Creates a test phase for the project. A test phase includes test cases in the <strong>Test Cases</strong> related list. This related link appears only when the value for the <strong>Execution Type</strong> field is set to <strong>Waterfall</strong> or <strong>Hybrid</strong> and the Test Management plugin is installed.</td>
</tr>
<tr>
<td>Planning Console</td>
<td>Opens the <strong>Project Planning console</strong>.</td>
</tr>
<tr>
<td>Recalculate Strategy and Goal Allocation</td>
<td>Recalculate and update cost field values in the Strategy and Goal Allocation tabs. Use this link to update the project's total cost and benefits when strategy and goal allocations for the project are changed. For more information, see Strategic Spend Tracking for PPM.</td>
</tr>
<tr>
<td>View RIDAC</td>
<td>View the Risks, Issues, Decisions, Actions, and Request Changes (RIDAC) entries for the project. For more information, see <strong>RIDAC (Risk, Issue, Decision, Action, and Request Changes) record entries for a project</strong>.</td>
</tr>
<tr>
<td>Project Budget</td>
<td>Option to allocate the budget to the project.</td>
</tr>
<tr>
<td>Project Workbench</td>
<td>Opens the <strong>Project workbench</strong>.</td>
</tr>
<tr>
<td>Status Report</td>
<td>Opens the <strong>Status Report</strong> tab on the Planning Console.</td>
</tr>
<tr>
<td>Create Baseline</td>
<td>Creates a schedule and financial baseline based on your selection.</td>
</tr>
<tr>
<td>Apply Template</td>
<td>Apply one or multiple project templates to the project. For more information, see <strong>Apply template to an existing project</strong>.</td>
</tr>
<tr>
<td>Save as New Template</td>
<td>Saves the current project details such as project tasks and subtasks, attachments, checklists, and other project information as a template. You can create a new project from the templates or apply the template to an existing project. For more information, see <strong>Project templates</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Project Diagnostics</td>
<td>Detects data corruption in the current project. You can check for data related to tasks and invalid or cyclic relations in a project. For more information about project diagnostics, see <a href="#">Use Project Diagnostics to detect corrupt project data</a>.</td>
</tr>
</tbody>
</table>

**Related Lists**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Tasks</td>
<td>Tasks in the current project. Only the next-level tasks (immediate subtasks) appear in this related list. If any external dependencies are created for the project, the corresponding shadow tasks are also listed.</td>
</tr>
<tr>
<td>Agile Phase</td>
<td>Lists the agile phases for the project. An agile phase contains project tasks and stories associated with these project tasks. This related list appears only when the value for the Execution Type field is set to Agile and the Agile Development 2.0 plugin is installed.</td>
</tr>
<tr>
<td>Sub-projects</td>
<td>Child project records of the current project.</td>
</tr>
<tr>
<td>Stories</td>
<td>List of stories in the current project. Click <strong>New</strong> to create and add new stories to the project. Click <strong>Add Existing</strong> to add stories from the Stories module of the Agile application. For more information, see <a href="#">Create stories</a>. This related list appears only when the value for the Execution Type field is set to Agile and the Agile Development 2.0 plugin is installed.</td>
</tr>
<tr>
<td>Epics</td>
<td>List of epics in the current project. This related list appears only when the value for the Execution Type field is selected as Agile and the Agile Development 2.0 plugin is installed.</td>
</tr>
<tr>
<td>Requirements</td>
<td>Lists the project requirements with their status. To create a new requirement, click <strong>New</strong>. To add an existing requirement to the project, click <strong>Edit</strong>.</td>
</tr>
<tr>
<td>Resource Plan</td>
<td>Lists the resource plans of the project and project tasks. To create a resource plan and manage existing resource plans, click <strong>Manage</strong>.</td>
</tr>
<tr>
<td>Cost Plans</td>
<td>Lists the cost plans included in the project. To create a new cost plan, click <strong>New</strong>.</td>
</tr>
<tr>
<td>Benefit Plans</td>
<td>Lists the benefit plans included in the project. To create a new benefit plan, click <strong>New</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Project Budget</td>
<td>Lists the project budget by fiscal year. Click the amounts in the list to revise them.</td>
</tr>
<tr>
<td>Baselines</td>
<td>Collection of all planned dates for all tasks and milestones at the time you create the baseline.</td>
</tr>
<tr>
<td>Status Reports</td>
<td>Lists the status reports for the project. To generate a new status report, click New. See, Create a project status report.</td>
</tr>
<tr>
<td>Risks</td>
<td>Lists the risks that are part of the project. To create a new risk, click New. For more information, see Add risks for a project. Alternatively, you can select risks from an existing risk library by clicking Create From Library</td>
</tr>
<tr>
<td>Note: The option Create From Library appears only when you have the Advanced Risk plugin activated and the Enable Advanced Risk PPM Integration property under Advanced Risk Assessment &gt; Administration &gt; Properties is enabled.</td>
<td></td>
</tr>
<tr>
<td>Note: If the project is a part of another program or portfolio, then any risk added to the project also gets added to the parent program and portfolio.</td>
<td></td>
</tr>
<tr>
<td>Issues</td>
<td>Lists the issues included in the programs. To create a new issue, click New. For more information, see Add issues for a project. Project issues are added with the program and the primary portfolio.</td>
</tr>
<tr>
<td>Decisions</td>
<td>Lists the decisions for the current project. To create a new decision, click New. For more information, see Add decisions for a project.</td>
</tr>
<tr>
<td>Actions</td>
<td>Lists the action items identified for the project. To create a new action, click New. For more information, see Add actions for a project.</td>
</tr>
<tr>
<td>Request Changes</td>
<td>Lists changes related to the resource, scope, cost, and schedule for the current project. To create a new project change request, click New. For more information, see Create a request change.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Stakeholders</td>
<td>Lists the stakeholders for the project.</td>
</tr>
<tr>
<td></td>
<td>To add a stakeholder to the project, click <strong>Edit</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Time Cards</td>
<td>Lists the time cards submitted against the project.</td>
</tr>
<tr>
<td></td>
<td>To create a new time card, click <strong>New</strong>.</td>
</tr>
<tr>
<td>Expense Lines</td>
<td>Lists the expense lines of the project.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Notifications</td>
<td>Lists the external dependency related notifications raised in the successor project. The notifications are triggered as a result of changes made in the predecessor project.</td>
</tr>
<tr>
<td>Strategy Allocations</td>
<td>Lists the percentage of project's total cost and benefits allocated towards achievement of strategies associated with the project. For more information, see Allocate or modify the strategy and goal percentage for a project.</td>
</tr>
</tbody>
</table>
### Field

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Goal Allocations</td>
<td>Lists the percentage of project's total cost and benefits allocated towards achievement of goals associated with the project. For more information, see Allocate or modify the strategy and goal percentage for a project.</td>
</tr>
</tbody>
</table>

**Note:** This related list appears only when Strategic Spend Tracking for PPM is installed. This application is available on ServiceNow Store. You must switch to the Strategic Alignment view to see this related list. If this related list is not available on the form view that you are using, ask your administrator to configure the project form to add this related list. For more information, see Install Strategic Spend Tracking for PPM.

---

**Copy a project**

Another option for creating a project is to copy an existing project with all its tasks and relationships. After you specify the start date for the copy, the system adjusts all task start and end dates automatically.

Role required: it_project_manager

1. On the Project form, right-click the header and select **Copy Project**.
2. Enter the new project name for the new project that you are creating.
3. Select a start date.
4. Click OK. The system creates the project.

Copy partial project, which is available from the Project Task form, provides similar functionality. It copies all task or project relationships and children from the selected project and inserts them into the current project. In this case, a new project record is not created.

Actual duration and the actual start and end dates are reset to null values. The state is set to **New** and percent complete is set to **0**.

By default only the short description, planned dates and duration fields are copied from source project to the target project. If additional columns must be copied, they should be declared in the **project property List of attributes that will be copied from the originating project task**.

**Change default values of copied project**

Reset or change the default values for copied fields in the new copied partial or complete project.

Role required: admin

Child tasks are defined with the same relationships, each lasting for the same duration as the original tasks. All project tasks are set to **Pending**. Actual duration and the actual start and end dates are reset to null values. The state is set to **New** and percent complete is set to 0. Administrators can override the Script Include CopyProjectFieldOverride to determine which fields are reset or to change the default values.

1. Navigate to **System UI > Script Include**.
2. Open the CopyProjectFieldOverride record.
3. Add the method to override the method defined in the CopyProjectFieldOverrideSNC script for resetting or defaulting the values. For example, to copy partial project:

```javascript
/* getResetFieldsForCopyPartialProject method returns the array containing the list of names of fields that need to be erased from the copied project tasks */
* getDefaultObjectForCopyPartialProject method returns the object containing the key, value pairs of field names and values that need to be set on the copied tasks */

var CopyProjectFieldOverride = Class.create();
CopyProjectFieldOverride.prototype = Object.extendObject(CopyProjectFieldOverrideSNC,

getResetFieldsForCopyPartialProject: function() {
    return ['work_start', 'work_end', 'work_duration'];
},

getDefaultObjectForCopyPartialProject: function() {
    return {'state': -5, 'percent_complete: 0'};
},

type: 'CopyProjectFieldOverride'
);
```

To copy complete project:

```javascript
/* getResetFieldsForCopyProject method returns the array containing the list of names of fields that need to be erased from the copied project tasks */
* getDefaultObjectForCopyProject method returns the object containing the key, value pairs of field names and values that need to be set on the copied tasks */

var CopyProjectFieldOverride = Class.create();
CopyProjectFieldOverride.prototype = Object.extendObject(CopyProjectFieldOverrideSNC,

getResetFieldsForCopyProject: function() {
    return ['work_start', 'work_end', 'work_duration'];
},

getDefaultObjectForCopyProject: function() {
    return {'state': -5, 'percent_complete: 0'};
},

type: 'CopyProjectFieldOverride'
);
```

4. Click Update.

Create baseline of a project

Create a schedule baseline and financial baseline of a project. A schedule baseline captures planned dates of all tasks and milestones at a particular moment in time. A financial baseline captures benefit and financial metric information (snapshot of cost plan, benefit plan, and project-level financial metrics) at a particular moment in time.

Role required: it_project_manager

Schedule baseline

You can create as many schedule baselines as necessary and review the changes that have been made to the project since the previous baseline. If a project is not on schedule, you can create a schedule baseline to know how much schedule slippage has occurred. It also helps to view the real-time deviations between actual and planned values.

The baseline appears as a set of gray lines below the bars that represent the actual tasks on the Gantt chart. These baselines represent planned dates, while the task bars represent the actual dates. If the project tasks are shifted to the right of the baselines, the project is running behind schedule.
Financial baseline

You can create as many financial baselines as necessary and compare them to review the financial changes that have been made to the project since the previous baseline. Any financial baseline does not capture actual cost component of the project.

**Note:** Nested projects cannot have baselines. Baselines are allowed for the top-level projects only.

1. Navigate to **Project > Projects > All**.
2. Select the required project.
3. To create schedule and financial baselines of a project, use any of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
</table>
| From the Financials tab | a. Open the **Financials** tab in project workspace.  
                          | b. Click the More Actions icon                                                                                                    |
|                      | (***).                                                                                                                               |
|                      | c. Click **Create new baseline**.                                                                                                    |
|                      | d. In the Create Baseline pop-up, enter a suitable name and description.                                                           |
|                      | e. Click **Save**.                                                                                                                  |
| From the planning console | a. Open the planning console in project workspace.                                                                                   |
|                      | b. Click the More Actions icon                                                                                                    |
|                      | (***).                                                                                                                               |
|                      | c. Click **Create new baseline**.                                                                                                    |
|                      | d. In the Create Baseline pop-up, enter a suitable name and description.                                                           |
|                      | e. Click **Save**.                                                                                                                  |

**Note:** You can create both schedule and financial baselines from the planning console however only schedule baselines appear in it.

| From a related link | a. Click the **Create Baseline** related link.                                                                                     |
|                     | b. In the Create Baseline pop-up, enter a suitable description.                                                                    |
|                     | c. Click **Save**.                                                                                                                 |
**From a related list**

<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>a.</td>
<td>Click the <strong>Baselines</strong> related list.</td>
</tr>
<tr>
<td>b.</td>
<td>Click the <strong>Create Baseline</strong> button.</td>
</tr>
<tr>
<td>c.</td>
<td>In the Create Baseline pop-up, enter a suitable name and description.</td>
</tr>
<tr>
<td>d.</td>
<td>Click <strong>Save</strong>.</td>
</tr>
</tbody>
</table>

**Note:** In the Create Baseline pop-up, the **Create Schedule Baseline** and the **Create Financial Baseline** check boxes are selected by default. Clear a check box if you do not intend to create a specific baseline.

---

**Compare financial baselines of a project**

You can compare baselines to review the variances in the financial data of a project and see what changed.

**Role required:** it_project_manager

You can create multiple baselines at various stages of a project, for example, at the end of each phase or after every calendar month or quarter. Each baseline captures the financial data of the project at a particular moment, providing a basis from which you can identify and review the changes made to the project. Having multiple baselines and comparing them helps you track the performance of your projects.

1. To compare the financial baselines of a project, use one of the following options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>From the Project Workspace</strong></td>
<td>a. Navigate to <strong>Project &gt; Projects &gt; Project Workspace</strong>.</td>
</tr>
<tr>
<td></td>
<td>b. Open a project.</td>
</tr>
<tr>
<td></td>
<td>c. Click the <strong>Financials</strong> tab.</td>
</tr>
<tr>
<td></td>
<td>d. Click the baseline information icon and then select <strong>Compare Baselines</strong>.</td>
</tr>
</tbody>
</table>

<p>| <strong>From the Project form</strong> | a. Navigate to <strong>Project &gt; Projects &gt; All</strong>. |
|                          | b. Open a project.                                                     |
|                          | c. On the Project form, click the <strong>Cost Plans</strong> or <strong>Benefit Plans</strong> related list. |
|                          | d. Click <strong>Manage</strong>.                                                   |
|                          | e. On the <strong>Financials</strong> tab, click the baseline information icon and then select <strong>Compare Baselines</strong>. |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the Baseline form</td>
<td>a. Navigate to Project &gt; Projects &gt; All.</td>
</tr>
<tr>
<td></td>
<td>b. Open a project.</td>
</tr>
<tr>
<td></td>
<td>c. On the Project form, click the Baseline related list.</td>
</tr>
<tr>
<td></td>
<td>d. Open a baseline.</td>
</tr>
<tr>
<td></td>
<td>e. On the Baseline form, click the View Financial Baseline related link.</td>
</tr>
</tbody>
</table>

2. On the Financial Baseline form, select the baselines you want to compare from the two choice lists. By default, the current and the most recent baselines are selected.

3. Click Compare.
The comparative data of the baselines display in the following two sections:

   - The Financial Baseline Summary section displays four widgets: the first two widgets contain the financial data of the two baselines, the third widget contains their variance, and the fourth widget contains the actual costs to date of the project.
   - The Financial Baseline Details section displays the cost plans and benefit plans of the two baselines in two different grids. Each plan type has two rows corresponding to each baseline data.

   **Note:** Click the baseline legend icon (i) to see the color code of rows representing each baseline.

4. Optional: Review additional fields or reorganize the comparative data on the form.

   - To show or hide additional fields on the widgets in the Financial Baseline Summary section, click the configuration icon (⋯)
   and select the field names.

   The selected field preferences are saved and are available when you reopen the Financial Baseline form. To reset to the default widget layout, click Reset to defaults.

   - To view cost plan or benefit plan comparative data in yearly, quarterly, or monthly format, click the Year or Quarter or Month views respectively.

   - To toggle viewing the Financial Baseline Summary section, click the Collapse icon (верху) or Expand icon (внизу).

**Compare schedule baselines of a project**

Compare baselines to review variance between tasks and identify which task has variance from the current planned end date and the baseline end date. The baseline variance column displays the amount of variance between the two date comparisons.

Role required: it_project_manager

**Create schedule baselines** at various stages of a project, for example, at the end of each phase or after every calendar month or quarter. Each baseline captures the schedule information of project tasks at a particular moment. This snapshot provides a basis for comparison and helps you to identify and review
the changes made to the project. Having multiple baselines and comparing them helps you track the performance of your projects.

1. To compare the schedule baselines of a project, use one of the following options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the Planning Console</td>
<td>a. Navigate to Project &gt; Projects &gt; All.</td>
</tr>
<tr>
<td></td>
<td>b. Open the project for which you want to compare baselines.</td>
</tr>
<tr>
<td></td>
<td>c. On the Project form, click the Planning Console related link.</td>
</tr>
<tr>
<td></td>
<td>d. On the Planning Console, click the more actions icon ( ) and then from the Baselines list, select a baseline.</td>
</tr>
<tr>
<td>From the Baseline form</td>
<td>a. Navigate to Project &gt; Projects &gt; All.</td>
</tr>
<tr>
<td></td>
<td>b. Open the project for which you want to compare baselines.</td>
</tr>
<tr>
<td></td>
<td>c. On the Project form, click the Baselines related list.</td>
</tr>
<tr>
<td></td>
<td>d. Open a baseline.</td>
</tr>
<tr>
<td></td>
<td>e. On the Baseline form, click the View Baseline on Planning Console related link.</td>
</tr>
</tbody>
</table>

The Planning Console displays the selected schedule baseline.

2. On the Planning Console, select different baselines to view schedule variance information of project tasks.

The following columns display the baseline information:

- **Baseline start date**: The planned start date for the task.
- **Baseline end date**: The planned end date for the task.
- **Baseline variance**: The difference between the baseline end date and planned end date. The value of this field column if there are any changes made to the project tasks or project. If the planned end date for a task is prior to the baseline date, the variance is shown as a negative value. For example, for a task with the planned end date of April 24 and the baseline created on April 17 means it is past due or late. The Baseline variance column in this case displays a value of -5 days.

![](image)

**Note:** Use the show or hide columns in gantt icon ( ) to add these columns to the Planning Console.
Assign a project schedule

Without an assigned schedule, a project calculates a day as a full 24 work hours. To schedule tasks by a more realistic work day, assign a schedule to the project. If the schedules provided in the base system do not suit your needs, define a new one.

Role required: it_project_manager

1. Open a project.
2. If the Default view is active, right-click the header bar and select View > Advanced.
3. Select a schedule in the Schedule field.

Create a project cost plan

Project cost plans capture the costs of projects. Create a cost plan to specify the unit cost of a cost type for a fiscal period.

Role required: it_project_manager

Application required: Project Portfolio Management with Financials

The application automatically creates cost plan breakdown records when you save the cost plan. Cost plans can also have associated expense lines.

<i>Note: Cost plans are automatically created for resource plans that are associated to projects and project tasks.</i>

To use multiple currencies, create a new cost plan for another currency.

1. Open the project form.
2. In the related links, click Cost Plans.
3. Click New.

<i>Note: To create a cost plan from the Financials tab in Project Workspace, click Manage.</i>

4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Cost Plan form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Descriptive name of the cost plan.</td>
</tr>
<tr>
<td>Project/Demand</td>
<td>Project or demand to which the cost plan belongs.</td>
</tr>
<tr>
<td>Start fiscal period</td>
<td>Indicates the starting fiscal period. When you change the start fiscal period, the associated cost plan breakdowns also change. Start fiscal period also changes when you create cost plan breakdowns earlier than the start fiscal period.</td>
</tr>
<tr>
<td>End fiscal period</td>
<td>Indicates the ending fiscal period. When you change the end fiscal period, the associated cost plan breakdowns also change. End fiscal period also changes when you create cost plan breakdowns later than the end fiscal period.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Financials</strong></td>
<td></td>
</tr>
<tr>
<td>Entered currency</td>
<td>Currency in which you want the cost plan to be created. If the selected currency is different from the functional currency, the corresponding budget reference rate is used to calculate the total planned cost, planned capital, planned operating of the project.</td>
</tr>
<tr>
<td>Unit cost</td>
<td>Cost of a single unit of the resource, which is in terms of entered currency.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Quantity of the resource that is required.</td>
</tr>
</tbody>
</table>
| Recurring         | Option to indicate that the cost is recurring for each fiscal period.  
\[ \text{Quantity} \times \text{Unit cost} \text{ incurred for every fiscal period.} \] |
| Cost type         | Cost type definition.                                                                                                                        |
| Investment        | Name of the investment created for the project.  
This field appears only if Investment Funding for PPM is activated.                        |
| Source type       | Funding entity to associated with the project investment for funding.  
This field appears only if Investment Funding for PPM is activated.                      |
| Source            | Funding entity value from which you request fund.  
The field is available when you select a value in the Source type field.  
This field appears only if Investment Funding for PPM is activated.                       |
| Total planned cost| Total estimated cost of the cost plan.  
If the cost is recurring, the calculation is \[ \text{Quantity} \times \text{Unit cost} \times \text{number of fiscal periods}. \]  
If the cost is non-recurring, the calculation is \[ \text{Quantity} \times \text{Unit cost}. \] |
Field | Description
---|---
Functional currency | Currency that is obtained from the `glide.system.locale` property. For upgraded customers, if the selected currency is different from the functional currency configured in the Financial Management application, the corresponding budget reference rate is used to calculate the total planned cost, planned capital, planned operating of the project.

**Note:** If budget reference rates are not defined, then exchange rate is considered as 1. For example, if functional currency is USD, entered cost is EUR, and no exchange rate is defined, then 1000 USD equals to 1000 EUR.

Cost in functional currency | Value that is rolled up from the Functional cost field of all cost plan breakdowns.

Total actual cost | Value that is rolled up from the Actual cost field of all cost plan breakdowns.

Estimate at Completion | Sum of all actuals for past fiscal periods added to the functional cost for future fiscal periods. For example, the duration of a project is from January 01 to December 31, and if you check the Estimate at Completion in the month of May, it is calculated as: Sum of actuals from Jan to April + Sum of functional cost from May to December.

**Note:** When you change the planned start date of a project, the associated cost plans and resource plan also change. The project property *Change Resource Plan and Cost Plan Start Date with Demand or Project Start Date Change* controls the behavior for project start date change.

5. **Click** Submit.

To recalculate the values in the Estimate at Completion field, use the Calculate Estimate at Completion related link. To view the cost plan breakdowns, click the Cost Plan Breakdowns related list.

*Cost plan breakdown*

A cost plan breakdown captures the estimated cost and actual cost for every fiscal period. Cost plan, project, demand, program, and portfolio are the breakdowns types that are available.

**Requirement**

Requirement corresponds to a single cost plan. For example, for a regular calendar and a cost plan spanning across one year, 12 breakdowns would appear.

**Task**

Task corresponds to a project or a demand. The cost across all the cost plans per period is rolled up to the project or demand level. These records have breakdown type set to Task. There would be only one record of type Task per period. The number of records of type Task that are created depends on the
duration of the project or demand, and the requirements planned in the project or demand. For example, for a regular calendar and a project with three cost plans, 12 breakdowns appear.

**Program**

If a project or a demand is part of a program, the breakdown type of Program provides the aggregate of program level costs per period.

**Portfolio**

If a project or a demand is part of a portfolio, the breakdown type of Portfolio provides the aggregate of portfolio level costs per period.

**Update a cost plan breakdown**

Update a cost plan breakdown record that specifies the estimated and actual cost, at a granular level, for specific fiscal periods.

Role required: it_project_manager

1. Open the required project.
2. Click the **Cost Plan** related list.
3. Click the **Cost Plan Breakdowns** related list.
4. Click the i icon against a cost plan breakdown.
5. Click **Open Record**.
6. In the Cost Plan Breakdown form, view and update the enabled fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task</td>
<td>Task to which the cost plan breakdown belongs.</td>
</tr>
<tr>
<td>Portfolio</td>
<td>Portfolio to which the cost plan breakdown belongs.</td>
</tr>
<tr>
<td>Entered currency</td>
<td>Currency specified in the cost plan.</td>
</tr>
<tr>
<td>Exchange rate</td>
<td>Rate in effect for the period corresponding to the cost plan breakdown.</td>
</tr>
<tr>
<td></td>
<td>When the period corresponding to the cost plan breakdown has multiple rates,</td>
</tr>
<tr>
<td></td>
<td>the rate in effect on the first date of that period is used.</td>
</tr>
<tr>
<td></td>
<td>Exchange rate is used to convert entered cost into functional cost. It is</td>
</tr>
<tr>
<td></td>
<td>obtained from the iftm_fx_rate [budget_reference_rates] table.</td>
</tr>
<tr>
<td>Actual</td>
<td>Actual cost generated from processed expense lines.</td>
</tr>
<tr>
<td>Cost plan</td>
<td>Cost plan to which the cost plan breakdown belongs.</td>
</tr>
<tr>
<td>Fiscal period</td>
<td>Fiscals generated at period level. For information on periods, see fiscal</td>
</tr>
<tr>
<td></td>
<td>calendars.</td>
</tr>
<tr>
<td>Entered cost</td>
<td>Breakdown amount in entered currency.</td>
</tr>
<tr>
<td>Functional cost</td>
<td>Functional cost obtained by multiplying exchange rate with entered cost.</td>
</tr>
<tr>
<td>Exchange rate date</td>
<td>First date of the fiscal period corresponding to the cost plan breakdown.</td>
</tr>
</tbody>
</table>

**Create a project benefit plan**

Project benefit plans capture the potential benefits accrued by the project when the project is executed. Create a benefit plan to specify the estimated benefit in a category spanning one or more fiscal periods.

Role required: it_project_manager
The benefit plan breakdown records are automatically created when you save the benefit plan.

1. Navigate to Project > All.
2. Open the required project.
3. In the Benefit Plans related list, click New.

   **Note:** To create a benefit plan from the Financials tab in Project Workspace, click Manage.


### Benefit Plan form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive name of the benefit plan.</td>
</tr>
<tr>
<td>Project/Demand</td>
<td>Project or demand to which the benefit plan belongs.</td>
</tr>
<tr>
<td>Sponsor</td>
<td>Sponsor for the project.</td>
</tr>
<tr>
<td>Category</td>
<td>Type of benefit:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Hard</strong>: Benefits that can be measured in terms of revenue.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Soft</strong>: Benefits that are measured in terms of value.</td>
</tr>
<tr>
<td>Sub category</td>
<td>Sub-categories of hard and soft benefits. The selection in Category field determines the selections available in this field.</td>
</tr>
<tr>
<td>Offset type</td>
<td>Field to indicate when the benefits start realizing. Select any of the following options:</td>
</tr>
<tr>
<td></td>
<td>• <strong>None</strong>: The default value is None. When you select None, you need to manually enter the benefit plan start and end fiscal periods.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Milestone</strong>: After completion of a milestone.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Start Date</strong>: At the start of the project.</td>
</tr>
<tr>
<td></td>
<td>• <strong>End Date</strong>: After the project ends.</td>
</tr>
<tr>
<td>Milestone</td>
<td>Project milestones to which the benefit plan belongs.</td>
</tr>
<tr>
<td>Milestone start date</td>
<td>Start date of the selected milestone.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project/Demand start date</td>
<td><strong>Note:</strong> The field appears if you select <strong>Start Date</strong> in the <strong>Offset type</strong> field. Start date of the project or demand.</td>
</tr>
<tr>
<td>Project/Demand end date</td>
<td><strong>Note:</strong> The field appears if you select <strong>End Date</strong> in the <strong>Offset type</strong> field. End date of the project or demand.</td>
</tr>
<tr>
<td>Offset</td>
<td>Number of periods before or after the offset type when the benefit plan starts. For example, if the offset type is selected as <strong>End Date</strong> and the offset is -2, the benefit plan is two periods prior to the project end date. If the project end date shifts, the benefit plan start date shifts to two periods prior to the new project due date.</td>
</tr>
<tr>
<td>Duration in periods</td>
<td>The length, in periods, of the benefit plan.</td>
</tr>
<tr>
<td>Start fiscal period</td>
<td>Starting fiscal period. Populated based on the value in the Offset field relative to the selected Milestone, Project or Demand start date, or Project or Demand end date, and Duration in period values. The field is editable if you select <strong>None</strong> in the <strong>Offset type</strong> field. When you change the start fiscal period, the associated benefit breakdown values also change.</td>
</tr>
<tr>
<td>End fiscal period</td>
<td>Ending fiscal period. Populated based on the value in the Offset field relative to the selected Milestone, Project or Demand start date, or Project or Demand end date, and Duration in period values. The field is editable if you select <strong>None</strong> in the <strong>Offset type</strong> field. When you change the end fiscal period, the associated benefit breakdown values also change.</td>
</tr>
</tbody>
</table>

**Financials**

| Entered benefit                    | Benefit incurred from the project or demand specified in terms of entered currency. If the selected currency is different from the functional currency, the corresponding budget reference rate is used to calculate the **Total planned benefit** of the project. |
| Entered currency                   | Currency in which you want the benefit plan to be created.                                                                                  |
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Functional currency</td>
<td>Currency that is obtained from the <code>glide.system.locale</code> property. For upgraded customers, if the selected currency is different from the functional currency configured in the Financial Management application, the corresponding budget reference rate is used to calculate the Total planned benefit of the project.</td>
</tr>
<tr>
<td>Total planned benefit</td>
<td>Estimated amount of potential benefit of the project or demand.</td>
</tr>
<tr>
<td>Benefit in functional currency</td>
<td>Benefit incurred from project or demand in terms of functional currency.</td>
</tr>
<tr>
<td>Actual benefit</td>
<td>Actual benefit that is incurred from the project or demand. This value is rolled up from the Actual benefit field of all the benefit plan breakdowns.</td>
</tr>
<tr>
<td>Recurring</td>
<td>Check box to indicate that the benefit is recurring for all the fiscal periods in the benefit plan.</td>
</tr>
</tbody>
</table>

**Note:** When you move the project or the milestone date, the associated benefit plans also change accordingly based on whether the benefit plan is tied to the project start date, end date, or one of the project milestones. The project property **Change Resource Plan, Cost Plan and Benefit Plan Start Date with Demand or Project Start Date Change** controls the behavior for project date changes.

5. Click **Submit**.

On the project form, view the benefit breakdown by fiscal period in the **Benefit Breakdown** related list.

**Update a benefit plan breakdown**

Update a benefit plan breakdown record that specifies the estimated and actual benefits, at a granular level, for specific fiscal periods.

Role required: **it_project_manager**

1. Open the required project.
2. Click the **Benefit Plan** related list.
3. Click the **Benefit Plan Breakdowns** related list.
4. Click the **i** icon against a benefit plan breakdown.
5. Click **Open Record**.
6. In the Benefit Plan Breakdown form, view and update the enabled fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task</td>
<td>Task to which the benefit plan breakdown belongs.</td>
</tr>
<tr>
<td>Portfolio</td>
<td>Portfolio to which the benefit plan breakdown belongs.</td>
</tr>
<tr>
<td>Entered currency</td>
<td>Currency specified in the benefit plan.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Exchange rate</td>
<td>Rate in effect for the period corresponding to the benefit plan breakdown. When the period corresponding to the benefit plan breakdown has multiple rates, the rate in effect on the first date of that period is used. Exchange rate is used to convert entered benefit into functional benefit. It is obtained from the itfm_fx_rate [budget_reference_rates] table.</td>
</tr>
<tr>
<td>Actual</td>
<td>Actual benefit that is incurred from the project or demand.</td>
</tr>
<tr>
<td>Benefit plan</td>
<td>Benefit plan to which the benefit plan breakdown belongs.</td>
</tr>
<tr>
<td>Fiscal period</td>
<td>Fiscals generated at period level. For information on periods, see fiscal calendars.</td>
</tr>
<tr>
<td>Entered benefit</td>
<td>Benefit in entered currency.</td>
</tr>
<tr>
<td>Functional benefit</td>
<td>Functional benefit obtained by multiplying exchange rate with entered benefit.</td>
</tr>
<tr>
<td>Exchange rate date</td>
<td>First date of the fiscal period corresponding to the benefit plan breakdown.</td>
</tr>
</tbody>
</table>

**Project and portfolio funding**

Specify the amount of money that projects and portfolios are allowed to have.

You can fund projects and portfolios when you activate PPM Standard with Financials.

The funding process follows these steps:

1. Identify the costs for time, such as a financial year, by creating cost plans at the project or demand level. These costs roll up to the portfolio Cost Plans related list. Cost plans automatically include cost plan breakdowns for each fiscal period. See Create a project cost plan and Create a demand cost plan.
2. Enter the target cost values for operational and capital expenses for the portfolio. See Create a portfolio and Legacy: Plan the portfolio.
3. Create budget plans for the projects in your portfolio and promote the plans to forecasts. See Legacy: Create and promote a budget plan and Promote a budget plan.

**Create an expense line**

A project expense line is cost associated with a specific source, such as a user, fixed asset, or a CI. Expense lines are part of project cost plans.

Role required: it_project_manager

Application required: Project Portfolio Management with Financials

Only processed expense lines are considered for projects, project tasks, and demands. You can create multiple expense lines for a project or demand.

1. Open the project form.
2. In the related links, click Cost Plans.
3. Right-click on a cost plan.
4. Click Create Expense Line.
5. Fill out the expense line form (see table).
6. Click Submit.

### Expense line form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Auto generated number.</td>
</tr>
<tr>
<td>Amount</td>
<td>Select a currency type and enter the expense cost.</td>
</tr>
<tr>
<td>Date</td>
<td>Date of the expense generated.</td>
</tr>
<tr>
<td>Process date</td>
<td>Date on which the expense line was processed.</td>
</tr>
<tr>
<td>Source ID</td>
<td>Record that generated the associated cost.</td>
</tr>
<tr>
<td>State</td>
<td>State of the expense line. The state can be Pending or Processed. The cost roll-up happens only if the expense line is processed.</td>
</tr>
<tr>
<td>Cost plan</td>
<td>Name of the cost plan against which you want to create the expense line.</td>
</tr>
<tr>
<td>Summary type</td>
<td>Select the category you want to group the expense under.</td>
</tr>
<tr>
<td>Cost type</td>
<td>Select the <a href="#">cost type</a>.</td>
</tr>
<tr>
<td>Expense type</td>
<td>Select <a href="#">Capex</a> for a capital expense or <a href="#">Opex</a> for an operating expense.</td>
</tr>
<tr>
<td>Short description</td>
<td>Enter a short description of the expense type.</td>
</tr>
<tr>
<td>Sources</td>
<td>Select the records for the sources of the expense line. These sources include:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Assets</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>Fixed assets</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>Contracts</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>Users</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>Configuration items</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>Tasks</strong></td>
</tr>
<tr>
<td></td>
<td>- <strong>Cost centers</strong></td>
</tr>
</tbody>
</table>

Once the expense line is processed, the actual amount incurred becomes part of the cost plan.

The actual amount spent is recorded against the project cost plan under the appropriate expense type: [Capex](#) or [Opex](#). Not providing a cost plan reference when creating an expense line, the actual cost is recorded at the project level in the cost plan related list.

### Create a project status report

You can periodically create project status report from the related lists of the project form. The project status report created for the most recent status date updates the status of the project in portfolios.

Role required: [it_project_manager](#)

The project status report shows snapshot status of RIDAC (Risk, Issues, Decisions, Actions, and Request Changes) records, key milestones, and charts only.

To include RIDAC records in the status report, select the **Show on project status report** option on individual RIDAC forms.
You can also print a project status report from project workspace. To print a report, click the print icon (print icon) in the header of **Status Report** tab.

1. **Create a project status report:**

<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
</table>
| From project workspace        | a. Navigate to Project > Projects > Project Workspace.  
                                | b. In My Projects Space page, click a project to open it in project workspace.  
                                | c. Click the Status Report tab and click Create new in the header.  |

**Note:** Alternatively, select a status report and click **Copy** from the choice list next to Create new. This option copies the selected status report including all fields into the new report.

| From project record | a. Navigate to Project > Projects > All.  
                      | b. In the project list, open a project record.  
                      | c. Click the Status Report related link and click New. |

2. **Fill in the form.**

**Status report form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>Name of the project.</td>
</tr>
<tr>
<td>Status Date</td>
<td>Date until which you want to generate the status report.</td>
</tr>
<tr>
<td>Number</td>
<td>A system generated number for the status report with a configurable prefix.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the project.</td>
</tr>
<tr>
<td>Percent complete</td>
<td>Percentage of the project that has been completed.</td>
</tr>
<tr>
<td>Planned start date</td>
<td>Planned start date of the project.</td>
</tr>
<tr>
<td>Planned end date</td>
<td>Planned end date of the project.</td>
</tr>
<tr>
<td>Actual start date</td>
<td>Actual start date of the project.</td>
</tr>
<tr>
<td>Actual end date</td>
<td>Actual end date of the project.</td>
</tr>
<tr>
<td>Estimated cost</td>
<td>Estimated cost of the project.</td>
</tr>
<tr>
<td>Actual cost</td>
<td>Actual cost of the project.</td>
</tr>
</tbody>
</table>

**Overall Status tab**

| Overall health | Color to signify the status of the overall health of the project in the report. |
### Field | Description
--- | ---
Executive Summary | Brief summary and analysis of the project.
Comments | Comments for the overall status.
Last Week's Achievements | Progress of the project in the last week.
Key Activities planned | Next planned activities for the project.
**Schedule tab**
Schedule | Color to signify the status of the schedule-related information of the project in the report.
Comments on Schedule | Comments related to the project schedule.
**Cost tab**
Cost | Color to signify the status of the cost-related information of the project in the report.
Comments on cost | Comments related to the project cost.
**Resources tab**
Resources | Color to signify the status of the resources-related information of the project in the report.
Comments on Resources | Comments related to the project resources.
**Scope tab**
Scope | Color to signify the status of the scope-related information of the project in the report.
Comments on Scope | Comments related to the project scope.

3. Click **Submit**.

**View project status reports**

Project status reports provide the most recent, at-a-glance progress of a project displayed in several categories.

**Role required: it_project_manager**

The project status report acts as a snapshot, meaning the report preserves the status of various parameters for the date and time when the status report is generated and does not display the status of various parameters dynamically. For example, the project status report created last week retains the same status as it was for that week and does not update the status dynamically.

You can use the project status reports to compare the progress of your project. Generate a new project status report for your recent changes to reflect on the report.
The project status report shows snapshot status of RIDAC (Risk, Issues, Decisions, Actions, and Request Changes) records, key milestones, and charts only.

1. Open a project status report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>From project workspace</td>
<td>a. Navigate to <strong>Project &gt; Projects &gt; Project Workspace</strong>.</td>
</tr>
<tr>
<td></td>
<td>b. In <strong>My Projects Space</strong> page, click a project to open it in the project workspace.</td>
</tr>
<tr>
<td></td>
<td>c. Click the <strong>Status Report</strong> tab.</td>
</tr>
<tr>
<td></td>
<td>d. Select a status report from the list to view its contents.</td>
</tr>
</tbody>
</table>

| From project record         | a. Navigate to **Project > Projects > All**.                          |
|                             | b. In the project list, open a project record.                       |
|                             | c. Click the **Status Report** related link.                         |
|                             | d. Select a status report from the list.                             |

**Note:** You can also open a project status report from the portfolio workbench. Open a portfolio in the portfolio workbench and click **Track Portfolio**. Right-click a project in the **Timeline View** and select **Status Report** from the context menu.
2. Review project status in the following sections.

### Project status report sections

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>Provides a general overview about the project such as:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Project Name</strong>: Name of the project.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Project Manager</strong>: Project manager assigned to the project.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Portfolio</strong>: Primary portfolio to which the project belongs.</td>
</tr>
<tr>
<td></td>
<td>- <strong>State</strong>: Current state of the project.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Phase</strong>: Current phase of the project such as Initiating, Planning, and Executing.</td>
</tr>
<tr>
<td></td>
<td>- <strong>% Complete</strong>: Percentage of the project completed.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Planned Start Date</strong>: Intended date the project begins.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Planned End Date</strong>: Intended date the project ends.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Planned Cost</strong>: Estimated cost of the project.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Actual Start Date</strong>: Date on which the project began.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Actual End Date</strong>: Actual end date of the project.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Actual Cost</strong>: Actual cost of the project.</td>
</tr>
</tbody>
</table>

This information is rolled up from the project form.

If you had set your preference as project currency in the **Status report currency** field of the Project form, then the **Overview** tab displays the following project currency fields:

- **Planned Cost in Project Currency**: Estimated cost of the project in project currency.
- **Actual Cost in Project Currency**: Cost of the project in project currency.

**Note:** The above fields appear when you enable the PPM Standard Multicurrency plugin (com.snc.ppm_multicurrency) and switch to the Project Currency view. For more information, see Multi-currency in project financials.
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
</table>
| Summary                     | Provides information about the overall health of the project. This information is rolled up from the most recent status entered by the project manager for the project.  
  - **Executive Summary**: Brief summary and analysis of the project.  
  - **Last Week's Achievements**: Progress of the project in the previous week.  
  - **Key Activities Planned**: Next planned activities for the project. |
| Cost (Planned vs. Actual) chart | If you have enabled the Project Currency view, then the Cost in Project Currency (Planned vs. Actual) section provides information about the actual cost versus the planned cost in project currency.  
  This information is rolled up from the cost plan for the project.  
  - **Planned**: Approved cost for the project.  
  - **Actual**: Actual cost for the project is derived from the expense line created for the project cost plan and from the time cards created for the project. |
| Resource (Allocated vs. Actual) chart | Provides information about the actual resource hours used versus the allocated hours. This information is rolled up from the resource plan for the project.  
  - **Allocated**: Resource hours that have been allocated to execute the project.  
  - **Actual**: The actual time spent is taken from the processed time cards created for the project. |
| Current Status              | Provides the status related to overall health, schedule, cost, resources, and scope of the project. This information is populated from the most recent status entered by the project manager for the project.  
  - **Status**: Color indicator to signify the status.  
  - **Comments**: Comments for the status. |
| Status History              | Provides the trend of overall health, schedule, cost, resources, and scope of the project. This information is populated up from the last 11 status reports created for the project.  
  - **Date**: Status date of the status reports. The color indicators signify the status of the project on these dates. |
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
</table>
| Key Milestones | Provides information about key milestones in the project. This information is populated from the project tasks identified as key milestones.  
  • **Pending**: List of key milestone tasks in the Pending, Open, and Work in Progress state.  
  • **Completed**: List of key milestone tasks in the Closed state. |
| Risks        | Provides information about risks concerning the project. This information is rolled up from the risks that are part of the project.  
  • **Pending**: List of risks in the Pending state.  
  • **Completed**: List of risks in the Achieved and Not Achieved state.  
  The following information from the Risk record is displayed:  
  • Short description  
  • Probability  
  • Risk status  
  • State  
  • Assigned to  
  • Due date  
  For more information, see Add risks for a project. |
| Issues       | Provides information about issues included in the project. This information is rolled up from the issues reported for the project.  
  • **Pending**: List of issues in the Open and Work in Progress state.  
  • **Completed**: List of issues in the Closed state.  
  The following information from the Issue record is displayed:  
  • Short description  
  • Priority  
  • State  
  • Assigned to  
  • Due date  
  For more information, see Add issues for a project. |
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
</table>
| Decisions | Provides information about decisions included in the project. This information is rolled up from the decisions reported for the project.  
- **Pending**: List of issues in the Open and Work in Progress state.  
- **Completed**: List of issues in the Closed state.  
The following information from the Decision record is displayed:  
- Short description  
- Priority  
- Decision status  
- State  
- Assigned to  
- Due date  
For more information, see Add decisions for a project |
| Actions | Provides information about action items for the project. This information is rolled up from the actions reported for the project.  
- **Pending**: List of actions in the Open and Work in Progress state.  
- **Completed**: List of actions in the Closed state.  
The following information from the Action record is displayed:  
- Short description  
- Priority  
- State  
- Approval  
- Assigned to  
- Due date  
For more information, see Add actions for a project |
Create a cost type definition

Create a cost type definition to associate a cost type, operating, or capital, to an account in the General Ledger from the Financial Management application. Create a cost type definition if you are using Project Portfolio Management with Financials.

Role required: it_pps_admin

1. Navigate to Project Administration > Settings > Cost Type Definitions.
2. Click New.
3. Fill out the form fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name.</td>
</tr>
<tr>
<td>Gl account</td>
<td>Select an account from the General Ledger Account [itfm_gl_accounts] table.</td>
</tr>
<tr>
<td>Expense type</td>
<td>Select Capex if a capital expense or Opex if an operating expense.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Allocate budget to a project

Set the budget of a project according to the fiscal years.

Role required: it_portfolio_manager

1. Open the project form.
2. In the related links, click Project Budget. The Project Budget dialog box opens.
3. Select the fiscal year for which you want to set the budget for the project.
4. Enter the amounts for Capex Budget and Opex Budget. The Total Budget is updated with the sum of capex and opex amounts.

5. Click OK.
   - If the project does not have any cost plan associated, then project budget is distributed by honoring planned start and end dates of the project.
   - If the project has any cost plan associated, then project budget is distributed by honoring the cost plan fiscal periods.

The project budget for the selected year appears in the Project Budget related list. You can click the amounts in the list to revise them.

**RIDAC (Risk, Issue, Decision, Action, and Request Changes) record entries for a project**

RIDAC is an acronym for Risk, Issue, Decision, Action, and Request Changes records. Create a risk record for your project that you can convert to other records during the project life cycle to track issues and to avoid having to manually copy relevant details in related records. This conversion and association of records helps you analyze and identify patterns, trends, and probable resolution for planning future projects.

As a project progresses through the project life cycle, a risk might result in an issue or a new issue might occur. Once you have a risk record, you convert that record into related records such as issues, actions, or decisions. The ability to convert records provides you with the following advantages:

- Ability to create related records without having to repeatedly manually enter the relevant information.
- Helps you analyze and identify patterns, trends, and probable resolution for planning future projects.
- Enables you to view a consolidated list of all RIDAC records using the View RIDAC related link on the Project form.

Consider the following points before converting or associating RIDAC records:

- You can convert one record to another only in the RIDAC sequence. For example, you can convert a risk to an issue, decision, action, or request change but you cannot convert an issue
to a risk or a decision to an issue. The following diagram illustrates the RIDAC process flow.

![RIDAC process flow diagram]

- You can convert one record into multiple RIDAC records. For example, you can create multiple issue records from one risk record.
- You can associate one record with multiple different records. For example, you can link one issue record to multiple different risk, decision, action, or request change records. For more information, see Associate existing RIDAC (Risks, Issues, Actions, Decisions, and Request Changes) records for a project.

Add risks for a project

Add a risk to a project to identify, analyze, prioritize, plan, and track a risk during any phase of the project life cycle. Assess potential problems and the severity of their impact to take informed decisions about the project.

Role required: it_project_manager

A risk is any uncertain event that can potentially impact the success or outcome of a project. For example, an incorrect estimate of factors like financial outlay or resource assignments can cause schedule slippage. Another example of a risk is a change in project requirements. Recording risks ensures that decision makers have all relevant information when assessing a project's progress. A project manager can add risks to a project and assess them. While adding risks, the project manager has the ability to add risks from an existing library of project risks that are applicable for their unique projects.

1. Navigate to **Project > Projects > All**.
2. Select the project to which you want to add risks.
3. In the Risks related list, click **New**.
4. Alternatively, click **Create from Library** if you have the Advanced Risk plugin activated.
   a) Select the risk statements as required.
   b) Click **Create Risks**.

Only the risks statements that belong to the Project category are displayed for the user.
5. On the Risk form, fill in the fields.

**Risk form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>System-generated ID number with a configurable prefix.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the risk. All new risks are created in the Pending state. The available states are: Pending, Open, Work in Progress, Closed Complete, Closed Incomplete, and Closed Skipped</td>
</tr>
<tr>
<td>Risk status</td>
<td>Status of the risk. The available options are: Pending, Achieved, Not Achieved, Avoid, Mitigate, Transfer, and Accept.</td>
</tr>
<tr>
<td>Probability</td>
<td>The likelihood that the event described in the risk will occur. The available options are: Absolute, High, Moderate, and Low</td>
</tr>
<tr>
<td>Impact</td>
<td>Impact of the risk event on the outcome of the project.</td>
</tr>
<tr>
<td>Estimated cost</td>
<td>Estimated cost the risk event generates.</td>
</tr>
<tr>
<td>Risk rank</td>
<td>A value and color assigned to the risk. This value is calculated using risk probability and impact. You can configure the color and value using Risk Value Lookup. For more information, see Configure custom Risk rank and Risk value for a project.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Primary resource assigned to work on the risk.</td>
</tr>
<tr>
<td>Risk value</td>
<td>A value calculated from Risk Value Lookup. For more information see, Configure custom Risk rank and Risk value for a project.</td>
</tr>
<tr>
<td>Due date</td>
<td>Requested date for the assigned resource to resolve the risk or the date on which the risk must be closed or addressed if not assigned to any resource.</td>
</tr>
<tr>
<td>Show on project status report</td>
<td>Option to specify whether the risk information should be included in the project status report.</td>
</tr>
<tr>
<td>Task</td>
<td>Project to which this risk belongs.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the event and its potential impact on the success of the project. If the risk is created from the risk library, then this field displays the Risk Statement name.</td>
</tr>
<tr>
<td>Description</td>
<td>Details of the event and its potential impact. If the risk is created from the risk library, then this field displays the Risk Statement short description.</td>
</tr>
<tr>
<td>Actual cost</td>
<td>Cost generated by the risk event. This information gets added when and if the event occurs.</td>
</tr>
<tr>
<td>Mitigation plan</td>
<td>Brief description of efforts taken to mitigate the risk.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Risk Assessment Summary</td>
<td>![Note: The Risk Assessment Summary section only appears when the Enable Advanced Risk PPM Integration property is enabled.](Note: The Risk Assessment Summary section only appears when the Enable Advanced Risk PPM Integration property is enabled.)</td>
</tr>
<tr>
<td>Inherent risk</td>
<td>This field gets auto-populated with the risk scores when the risk assessor assess the inherent risk.</td>
</tr>
<tr>
<td>Elevated to enterprise risk</td>
<td>This option gets selected automatically when the risk is elevated to enterprise risk by the project manager.</td>
</tr>
<tr>
<td>Residual risk</td>
<td>This field gets auto-populated with the risk scores when the risk assessor assess the residual risk.</td>
</tr>
<tr>
<td>Enterprise inherent risk</td>
<td>This field gets auto-populated with the risk scores when the risk assessor assess the enterprise inherent risk.</td>
</tr>
<tr>
<td>Enterprise residual risk</td>
<td>This field gets auto-populated with the risk scores when the risk assessor assess the enterprise residual risk.</td>
</tr>
</tbody>
</table>

6. Click **Submit**.

- Assess the risks that have been added. For more information, see #unique_376
- Convert an existing risk to an issue, decision, action, or request change and close the risk. For more information, see Convert one RIDAC (Risk, Issue, Decision, Action, and Request Changes) record to another for a project.
- Associate the risk with existing issues so you can track dependencies and recognize trends for future. For more information, see Associate existing RIDAC (Risks, Issues, Actions, Decisions, and Request Changes) records for a project.

**Configure custom Risk rank and Risk value for a project**

Configure custom risk rank and value scores (such as High-Medium, Medium-Low, or Absolute-Low) to rate the impact and probability factors for a risk.

**Role required:** pps_admin

Use the Risk Value Lookup module to set up the risk rank and risk value for a specific combination of risk impact and probability. The system uses these values to determine the degree of risk (Absolute, High, Medium, Low) based on the impact and probability factors of a risk.

The value in the **Probability** field is multiplied by the value of the **Impact** field to generate the values for the **Risk rank** and corresponding **Risk value** in the Risk form.

By default, you can use the following impact, value, and probability scores for a risk to create a risk rank and risk value score:

- **Absolute**
- **Low**
- **Medium or Moderate**
- **High**

For example, a risk might have high probability and medium impact but you might want to consider it as an overall low risk for the project. In that case, you would configure the Risk Value Matcher form with the following values:
• Impact = 2 Medium
• Risk Rank Color = Green
• Probability = High
• Probability Number = 1
• Risk Value = 3 Low

The following image illustrates the results of this example on the Risk form.

1. Navigate to **Project Administration > Settings > Risk Value Lookup.**
2. Click **New.**
3. On the form, fill in the fields.

**Risk Value Matcher form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impact</td>
<td>Impact value of the risk. The default values are:</td>
</tr>
<tr>
<td></td>
<td>• 1 = High</td>
</tr>
<tr>
<td></td>
<td>• 2 = Medium</td>
</tr>
<tr>
<td></td>
<td>• 3 = Low</td>
</tr>
<tr>
<td>Application</td>
<td>The application to which these risk values belong.</td>
</tr>
<tr>
<td>Risk Rank Color</td>
<td>Color to indicate the severity of the risk.</td>
</tr>
</tbody>
</table>

**Tip:** You can enter variations of a color to differentiate between risks with similar impact and probability values. For example, you could enter **lightgreen** to indicate a low-severity risk.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Risk Value</td>
<td>The value for the specified risk impact and probability combination. The options are: High, Medium, and Low. This value is displayed in the Risk value field of the Risk form.</td>
</tr>
<tr>
<td>Probability</td>
<td>Risk probability value to associate with the impact value of the risk. The options are: Absolute, High, Moderate, and Low.</td>
</tr>
</tbody>
</table>
| Probability Number | Numerical value to indicate the probability. This value is multiplied by the value of the Impact field for calculating risk rank. The default values are:  

- 1 = Absolute  
- 1 = High  
- 2 = Moderate  
- 3 = Low  

The calculated risk rank and the risk rank color are displayed in the Risk rank field of the Risk form. |

4. Click Submit.

Add issues for a project

Add an issue to a project to escalate a risk or to track an unexpected problem such as a technical malfunction or resource unavailability that occurs during any phase of the project life cycle. If the issue remains unresolved, unnecessary conflicts, delays, or even a failure can occur.

Role required: it_project_manager

1. Navigate to Project > Projects > All.
2. Select the project to which you want to add an issue.
3. In the Issues related list, click New.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>System-generated ID number with a configurable prefix.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the issue. All new issue records are created in the Open state. The available states are: Pending, Open, Work in Progress, Closed Complete, Closed Incomplete, and Closed Skipped</td>
</tr>
<tr>
<td>Priority</td>
<td>Urgency of resolving or managing the issue based on possible impact.</td>
</tr>
<tr>
<td>Estimated cost</td>
<td>Estimated cost the issue generates.</td>
</tr>
<tr>
<td>Impact</td>
<td>Impact on the outcome of the project if the issue remains unresolved.</td>
</tr>
</tbody>
</table>
### Field | Description
---|---
Due date | Requested date for the assigned resource to resolve the issue or the date on which the issue must be closed or addressed if not assigned to any resource.
Assigned to | Primary resource assigned to work on the issue resolution.
Parent | Project to which this issue belongs.
Show on project status report | Option to specify whether the issue information should be included in the project status report.
Short description | Brief description of the issue and its potential impact on the success of the project.
As you start typing the title for your issue, related issues that potentially match your issue are displayed.
Click the suggestion icon ( ) to select from the list of predefined issue descriptions.
Description | Details of the issue and its potential impact.
Work notes | Information to record and track the work accomplished for resolving the issue.

5. Optional: Search in the knowledge base for any article related to the issue.
   a) Click the search knowledge icon ( ).
   b) If you find relevant articles, click the title of an article to view its content.
   c) If you want to include the content of the article in the issue, click Attach to Issue.
      The article content is copied in to the Description field of the Issue form. You can modify the text if necessary.

6. Click Submit.

- Convert an existing issue to decision, action, or request change and close the issue. For more information, see Convert one RIDAC (Risk, Issue, Decision, Action, and Request Changes) record to another for a project.
- Associate the issue with your existing risks so you can track dependencies and recognize trends for future. For more information, see Associate existing RIDAC (Risks, Issues, Actions, Decisions, and Request Changes) records for a project.

### Add decisions for a project
As a project manager, develop a plan to manage risks and issues proactively with solutions. Add the solution for a risk or issue to a project in the form of a decision. You can also convert a risk or an issue to a decision or a decision to an action or a request change.

Role required: it_project_manager

1. Navigate to Project > Projects > All.
2. Select the project to which you want to add a decision.
3. In the Decisions related list, click **New**.

**Decision form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>System-generated ID number with a configurable prefix.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the decision. All new decision records are created with Open state. The available states are: Pending, Open, Work in Progress, Closed Complete, Closed Incomplete, and Closed Skipped</td>
</tr>
<tr>
<td>Priority</td>
<td>Urgency of approving or implementing the decision based on possible impact.</td>
</tr>
<tr>
<td>Decision status</td>
<td>Status of the decision. The available options are: Pending, Approved, and Rejected.</td>
</tr>
<tr>
<td>Impact</td>
<td>Impact on the outcome of the project if you do not implement the decision.</td>
</tr>
<tr>
<td>Approval required</td>
<td>Option for determining whether approval of the decision is required.</td>
</tr>
<tr>
<td>Estimated Cost</td>
<td>Estimated cost of implementing the decision.</td>
</tr>
<tr>
<td>Due date</td>
<td>Requested date on which the decision must be approved or implemented.</td>
</tr>
<tr>
<td>Requester</td>
<td>Person requesting the decision. The default value is the name of the user creating the decision record.</td>
</tr>
<tr>
<td>Parent</td>
<td>Project number to which this decision belongs.</td>
</tr>
<tr>
<td>Show on project status report</td>
<td>Option to specify whether the decision information should be included in the project status report.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the decision such as what the decision is about, who made it, what it affects, and the decision outcome.</td>
</tr>
<tr>
<td></td>
<td>As you start typing the title for your decision, related decisions that potentially match your decision are displayed.</td>
</tr>
<tr>
<td></td>
<td>Click the Suggestion icon ( ) to select a description from the list of predefined decision descriptions.</td>
</tr>
<tr>
<td>Description</td>
<td>Details of the decision and its potential impact.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Information to record and track the status of decision implementation or approvals.</td>
</tr>
</tbody>
</table>
5. Optional: Search in the knowledge base for any article related to the decision.
   a) Click the search knowledge icon.
   b) If you find relevant articles, click the title of an article to view its content.
   c) If you want to include the content of the article in the issue, click Attach to Decision. The article content is copied into the Description field of the Decision form. You can modify the text if necessary.

6. Click Submit.

   • Convert a decision to an action or request change and close the decision. For more information, see Convert one RIDAC (Risk, Issue, Decision, Action, and Request Changes) record to another for a project.
   • Associate the decision with your existing issues and risks so you can track dependencies and recognize trends for future. For more information, see Associate existing RIDAC (Risks, Issues, Actions, Decisions, and Request Changes) records for a project.

Add actions for a project
Add actions that are required for resolving an issue or risk for a project. You can also convert a risk, issue, or decision to an action based on your analysis and plan for resolution of a risk or issue.

Role required: it_project_manager

After analyzing the risks and issues and taking a decision on how to manage those risks and issues, add an action for resolving the risk or issue to a project.

1. Navigate to Project > Projects > All.
2. Select the project to which you want to add an action.
3. From the Actions related list, click New.
4. On the Action form, fill in the fields.

Action form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>System-generated number with a configurable prefix.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the action. All new action records are created with the state set to Open. The available states are: Pending, Open, Work in Progress, Closed Complete, Closed Incomplete, and Closed Skipped</td>
</tr>
<tr>
<td>Priority</td>
<td>Urgency for implementing or approving the action based on impact.</td>
</tr>
<tr>
<td>Estimated Cost</td>
<td>Estimated cost the action generates.</td>
</tr>
<tr>
<td>Impact</td>
<td>The impact on the outcome of the project if you do not implement the action.</td>
</tr>
<tr>
<td>Approval</td>
<td>Status of approval from the stakeholders for the action. The available options are: Not Yet Requested, Requested, Approved, and Rejected.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Primary resource assigned to implement the action.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Due date</td>
<td>Requested date on which the action must be approved or implemented.</td>
</tr>
<tr>
<td>Parent</td>
<td>The project to which this action belongs.</td>
</tr>
<tr>
<td>Show on project status report</td>
<td>Option to specify whether the action information should be included in the project status report.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the action such as what the action entails, how to implement the action, who it affects, and the action outcome. As you start typing the title for your action, the related actions that potentially match your action title appear. Click the Suggestion icon ( ) to select a description from the list of predefined actions.</td>
</tr>
<tr>
<td>Description</td>
<td>Details of the action and its potential impact.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Information about the action. Add work notes to communicate about the status of action approval, rejection, or implementation with other users.</td>
</tr>
</tbody>
</table>

5. Optional: If the action requires approval from other stakeholders, request approval with a due date using the Approval and Due date fields.

6. Click Submit.

- Convert an action to a request change and close the action. For more information, see Convert one RIDAC (Risk, Issue, Decision, Action, and Request Changes) record to another for a project.
- Associate the action with your existing risk, issue, and decision records so you can track dependencies and recognize trends for future. For more information, see Associate existing RIDAC (Risks, Issues, Actions, Decisions, and Request Changes) records for a project.

**Create a request change**
As a project manager, you might create a request change as the outcome of the action taken to resolve an issue or mitigate a risk. The request change might result in changing the project's scope, resource requirement, cost, or schedule to minimize the impact of a risk or issue.

Role required: it_project_manager

1. Navigate to Project > Projects > All.
2. Select the project to which you want to add a request change.
3. In the Request Changes related list and click New.
4. On the form, fill in the fields.

### Request Change form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>System-generated ID number with a configurable prefix.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the request change. All new request change records are created in the Open state. The available states are: Pending, Open, Work in Progress, Closed Complete, Closed Incomplete, and Closed Skipped</td>
</tr>
<tr>
<td>Priority</td>
<td>Urgency for approving the requested changes based on impact.</td>
</tr>
<tr>
<td>Estimated Cost</td>
<td>Estimated cost the requested changes generate.</td>
</tr>
<tr>
<td>Impact</td>
<td>Impact on the outcome of the project if you do not approve the requested changes.</td>
</tr>
<tr>
<td>Approval</td>
<td>Status of approval from the stakeholders for the requested changes.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Primary resource assigned to work on the request change.</td>
</tr>
<tr>
<td>Due date</td>
<td>Requested date to complete the request change.</td>
</tr>
<tr>
<td>Category</td>
<td>Entity for which you are creating the request change. The options are: Resource, Scope, Cost, and Schedule.</td>
</tr>
<tr>
<td>Parent</td>
<td>Project number to which this request change belongs.</td>
</tr>
<tr>
<td>Show on project status report</td>
<td>Option to specify whether the request change information should be included in the project status report.</td>
</tr>
<tr>
<td>Title</td>
<td>Title for the change request.</td>
</tr>
<tr>
<td>Description</td>
<td>Details of the request change and its potential impact.</td>
</tr>
<tr>
<td>Business Justification</td>
<td>Reason for requesting the proposed change in the project and its impact on the business.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Additional information to indicate progress on the project request change.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

- Associate the request change with your existing risk, issue, decision, and action records so you can track dependencies and recognize trends for future. For more information, see [Associate existing RIDAC (Risks, Issues, Actions, Decisions, and Request Changes) records for a project](#).
- Create tasks for working on the change request. For more information, see [Create a task from an incident, problem, or change request](#).

*Convert one RIDAC (Risk, Issue, Decision, Action, and Request Changes) record to another for a project*

Convert one RIDAC record (risk, issue, action, decision, and request changes) to another, in that order, to retain the record information instead of having to create a new record manually and to more easily track the issue.

Role required: it_project_manager

When you convert a RIDAC record to another record, the values for the **Short description**, **Requester**, and **Assigned to** fields are carried forward.
You can also specify to close the parent record on creation of the new record instead of manually closing the parent record.

You can also view the consolidated list of all RIDAC records using the View RIDAC related link on the Project form and View RIDAC in the application navigator of the Project module.

1. Navigate to Project > Projects > All.
2. Select the project for which you want to convert a risk, issue, decision, action, or request change record to another RIDAC record.
3. From the Project form related list, click the risks, issues, decisions, actions, or request changes record to open the form view.
4. Click the Convert to RIDAC related link on the form.
5. Optional: On the Convert dialog box, from the Select task type list, select the RIDAC record to which you want to convert the selected record.
   For example, if you wanted to convert a risk to an issue, you would select Issue.
6. Optional: Modify the text in the Short description field, which is copied from the parent record.
7. Optional: Change the default assignment copied from the parent record in the Assigned to field by clicking the lookup icon ( ) and selecting a different user.
8. Optional: If you want to close the parent RIDAC record on creation of the new record, select the close parent record option.
   The label of the close parent record option changes depending on the parent record type. For example, if the parent record is Risk and you are converting it to an issue record, the close record option would appear as Close Risk.
9. Click OK.

Associate existing RIDAC (Risks, Issues, Actions, Decisions, and Request Changes) records for a project

Link existing RIDAC records (risks, issues, actions, decisions, and request changes) to one another for your project. Associating RIDAC records with each other enables you to keep a record of risks or issues and their outcome for analysis at project closure and planning. It also helps to track the risks and issues throughout the project life cycle.

Role required: it_project_manager

You can associate one record with multiple different records. For example, you can link one issue record to multiple risk, decision, action, or request change records.

1. Navigate to Project > Projects > All.
2. Select the project for which you want to associate one RIDAC entry to another.
3. In the Project form related list, select the RIDAC record.
4. On the form, click the Associate RIDAC related link.
5. In the Associate dialog box, from the Select type list, select the RIDAC record to which you want to associate the selected record.
   For example, if you wanted to associate a risk to an issue, you would select Issue.
6. Select the record number to which you want to associate the selected record from the Associate to list.
   For example, if you wanted to associate the selected risk to issue (ISU0010003), you would select ISU0010003.
7. Click OK.
Change the planned start date of a project

Adjust the schedule of a project by changing the planned start date of a project and shifting it later or earlier than the current planned schedule.

Role required: it_project_manager

Changing the planned start date of a project to a new date also moves all its tasks and subprojects relative to the updated start date of the project. You can change the planned start date of a project when the following conditions are true:

- The State of the project is Pending or Open.
- No project_funding records are selected for execution.
- The project actual dates are not populated.

Note:
- The Move project option is available for a project only when it has a task or subproject.
- If an agile phase with sprints is associated to the project, then changing the planned start date of the project also clears the start and end dates of the sprints.

1. Change the planned start date of a project using either of the following options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the Planning console</td>
<td></td>
</tr>
<tr>
<td></td>
<td>a. Navigate to Project &gt; Projects &gt; Project Workspace.</td>
</tr>
<tr>
<td></td>
<td>b. Open the project for which you want to change the planned start date.</td>
</tr>
<tr>
<td></td>
<td>c. In the Planning Console, click the more actions icon</td>
</tr>
<tr>
<td></td>
<td>(</td>
</tr>
<tr>
<td></td>
<td>) and then select the Move project option.</td>
</tr>
<tr>
<td>From the Project form</td>
<td></td>
</tr>
<tr>
<td></td>
<td>a. Navigate to Project &gt; Projects &gt; All.</td>
</tr>
<tr>
<td></td>
<td>b. Open a project for which you want to change the planned start date.</td>
</tr>
<tr>
<td></td>
<td>c. On the Project form, click the Move project related link.</td>
</tr>
</tbody>
</table>

2. In the dialog box, pick a date.

3. Click OK.

- The planned start date of the project is updated to the new date.
- Program dates are updated relative to the project start date.
- All project tasks with Start on specific date, Start no earlier than, and Start no later than constraints are moved to a new start date by the same offset as from the earlier project start date. The constraint date is also moved by the same offset.

For example, say a project is starting on November 10 with a Start On task starting on November 15, giving an offset of five days. If you move the project start date to November 20, then the task start date will be moved to November 25, maintaining the five-day offset from the project start date.
• All project tasks with Start ASAP constraint are moved to the new start date based on the **Constraint Date** field on the project form. The tasks must be in the Pending state.

• If the **Change Resource Plan and Cost Plan Start Date with Demand or Project Start Date Change** property is selected, all related entities like cost plan, resource plan, and benefit plans are moved relative to the project start date. For more information on how to set this property, see **Properties installed with Project Management**.

### Pre-date a project task

Move the planned start date of a task prior to the planned start date of a project. Adding a pre-dated task allows you to accommodate tasks which need to start before the planned start date of a project.

You should have created or added project tasks to your project.

Role required: it_project_manager

Before pre-dating a project task, note the following conditions:

• Pre-dating a task's planned start date also moves the project's planned start date.

• The start date of a child task cannot be moved prior to the parent task's start date. For example, if a parent task with Start no earlier than constraint starts on 20th and the child task starts on 30th, the start date of the child task can only be moved up to 20th.

1. Navigate to **Project > Projects > All**.
2. Select the project from the list.
3. On the Project form, update the planned start date for a project task using either of the following options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
</table>
| From the Project Task form | a. In the Project Tasks related list, select the project task which you want to pre-date.  
                             | b. On the Project Task form, click the Dates tab and update the Planned start date for the task. |
| From the Planning Console | a. On the Project form, click the Planning Console related link.      
                              | b. In the Planning Console, update the start date of the project task under the Planned start date column. |

4. In the Move date dialog box, click **OK**.

### Recalculate costs of all resource plans in a project

Recalculate the resource costs of all resource plans in a project whenever the hourly rates change in the associated rate model so that the plan costs are up to date.

Ensure the following setup:

• The project must be active.

• The project must have an active rate model assigned.

• The resource plans must be in the Planned, Requested, Confirmed, or Allocated state.

Role required: project_manager
This option recalculates the costs of all resource plans of the project at once. You can also open a resource plan from the **Resource Plans** related list to recalculate the resource costs of an individual resource plan.

1. Navigate to **Project > Projects > All**.
2. Open a project.
3. On the Project form, right-click on the header bar and select the **Recalculate Resource Costs** option.
4. In the Recalculate Resource Cost dialog box, fill in the fields.

### Recalculate Resource Costs dialog box

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start date</td>
<td>Start date of the time period for which the costs are recalculated. By default, the field shows the current date.</td>
</tr>
<tr>
<td>End date</td>
<td>End date of the time period for which the costs are recalculated. By default, the field shows the end date of the project.</td>
</tr>
<tr>
<td>Planned costs for Requested Resource plans</td>
<td>Option for recalculating the planned cost of Requested resource plans.</td>
</tr>
<tr>
<td>Confirmed/Allocated costs for Confirmed/Allocated resource plans</td>
<td>Option for recalculating the confirmed or allocated cost of Requested resource plans.</td>
</tr>
<tr>
<td>Planned costs for Confirmed/Allocated resource plans</td>
<td>Option for including the planned cost of a Confirmed or Allocated plan. The option is enabled if the Confirmed/Allocated costs for Confirmed/Allocated resource plans option is selected. By default, the option is not selected.</td>
</tr>
</tbody>
</table>

5. Click **OK**.

- Recalculates the selected resource costs of all the applicable resource plans in the project based on the latest hourly rates. The hourly rates are derived from the rate model associated with the project.
- Updates the recalculated resource costs on the respective cost fields on the resource plan form and the Resource Plans related list.
- Reflects the revised values on the respective cost fields of the project.

### Project templates

A project template defines the basic structure of a project.

Project templates can include project tasks and subtasks, attachments, checklists, and other project information. Because projects often get repeated, templates enable you to create, save, and reuse project structure. You can also modify existing templates, create projects from templates, and apply templates to empty projects. A project is considered empty when it does not contain any subtasks.

With the project manager role, you can:
- Create project templates
- Use templates to create a project

With the PPS admin role, you can modify the project template configuration.
Create a project template

You can create a template from an existing template or a project.

Role required: it_project_manager

When you create a template from a project, all the project attachments and checklists are copied to the template. You can add or remove attachments from the template using the Project Template form. A project template created from an off-schedule project honors the off-schedule tasks.

1. Create a template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>From an existing template</td>
<td>a. Navigate to Project &gt; Projects &gt; Templates.</td>
</tr>
<tr>
<td></td>
<td>b. Open the desired project template.</td>
</tr>
<tr>
<td></td>
<td>c. Click the Copy Template related link at the bottom of the form.</td>
</tr>
<tr>
<td></td>
<td>d. The Copy Template dialog box opens. The Template field is auto-filled with the current template name.</td>
</tr>
<tr>
<td>From a project</td>
<td>a. Navigate to Project &gt; Projects &gt; All.</td>
</tr>
<tr>
<td></td>
<td>b. Open the desired project.</td>
</tr>
<tr>
<td></td>
<td>c. Click the Save as New Template related link at the bottom of the form.</td>
</tr>
<tr>
<td></td>
<td>d. The Create Template dialog box opens.</td>
</tr>
</tbody>
</table>

2. Fill in the following fields:

   - **Template name**: enter a unique name for the new template.
   - **Description**: enter a brief description of the new template.

3. Click **OK**.
   The project template form opens for the newly created template.

4. Make any desired changes to the fields on the project template form.
   The top section of the Project Template form includes basic template information, such as the template name and description. The middle section of the project template form defines the specific data included in the template. The information in this section is built from fields on the project [pm_project] table that the user selects and the values for those fields that the user defines.

**Project Template Form Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the project template.</td>
</tr>
<tr>
<td>Table</td>
<td>Display only. Templates are based on the Project table.</td>
</tr>
<tr>
<td>Description</td>
<td>A brief description of the project template.</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
Template | Includes columns of fields and field values to be included in the template. Click a field in the left column and select the desired field name, then click the field in the right column to enter the field value. If additional information for the field is required, a field appears in the third column. For example, to identify the currency in a money field:
  - Click the X to the right of a field to remove that field from the template.
  - Use the blank field at the bottom of the list to add new fields.

Related Links
Create Project | Creates a project from this project template.
Copy Template | Creates a copy of this project template.
Related Lists
Project Template Tasks | The project template task list.
Attachments | The files attached to the template.

5. Click **Update**.

Add an attachment to a project template

Attach a file to a project template just as you can attach a file to a project or task.

Role required: it_project_manager

1. Navigate to **Project > Projects > Templates**.
2. Open the desired template.
3. Click the **Attachments** tab to open the related list.
4. Click **New**.
5. Click **Browse** on the Attachments dialog box and select a file.
6. If desired, click **Add Another Attachment** to select another file.
7. Click **Attach**.
   The selected file appears in the Attachments related list.

Apply a template on the Project form

While creating a project using the Project form, you can apply a project template to include project tasks and subtasks, attachments, checklists, and other project information. You can apply a project template to a new project or an existing project.

Role required: it_project_manager

A project created from the off-schedule project template honors the off-schedule tasks and adjusts the dates according to the given start date.

When applying a template to a project, the project state is set to the default state. Activate the default project state (pm_project.state = -5), and use it as the default value as it is Out Of The Box. You can update the label for the **State** field to meet your requirements if **Pending** doesn't fit well.

- To apply a template on the blank project form:
a) Navigate to Project > Projects > Create New.
b) Click the link next to To create project from a template.
   The Apply Template window appears.
c) Enter the project name, select the start date, and select a project template.

- To apply a template to an existing project without any project tasks or subprojects:
  a) Navigate to Project > Projects > All and select a project.
  b) Click the To apply template click here link.
     The Apply Template window appears.
  c) Select the start date and select a project template.

### Apply template to an existing project

Apply one or multiple project templates to an existing project from the project form or Planning Console.

Role required: it_project_manager

A project created from the off-schedule project template honors the off-schedule tasks and adjusts the dates according to the given start date.

When applying a template to a project, the project state is set to the default state. Activate the default project state (pm_project.state = -5), and use it as the default value as it is Out Of The Box. You can update the label for the State field to meet your requirements if Pending doesn't fit well.

**Important:** Application of template on a project having project tasks does not apply header information and only appends project tasks after the last project task of the project.

1. **Apply project template to an existing project from any of the following locations:**

<table>
<thead>
<tr>
<th>Location</th>
<th>Step</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Project form</td>
<td>a. Navigate to Project &gt; Projects &gt; All.</td>
</tr>
<tr>
<td></td>
<td>b. Open the project to which you want to apply project template.</td>
</tr>
<tr>
<td></td>
<td>c. In the Project form, based on the existing project tasks or subprojects, apply the template using any of the following options:</td>
</tr>
<tr>
<td></td>
<td>• If there are no tasks or subprojects, click the To apply template click here link.</td>
</tr>
<tr>
<td></td>
<td>• If there are tasks or subprojects, click the Apply Template related link.</td>
</tr>
</tbody>
</table>
From Planning Console

a. Navigate to Project > Projects > All.
b. Open the project to which you want to apply project template.
c. In the Project form, click the Planning Console related link.
d. In the Planning Console, click the more actions icon ( ) and select Apply Template option.

2. In the Apply template dialog box, from the Project template list, select a project template.
3. Click Save.
4. Optional: To apply multiple project templates, repeat the steps 1 to 3.
Tasks from the template are added at the end of the last task.

Apply template to a blank project in project workspace

When you create a new project in the project workspace, you can apply a template.

Role required: it_project_manager

A project created from the off-schedule project template honors the off-schedule tasks and adjusts the dates according to the given start date.

When applying a template to a project, the project state is set to the default state. Activate the default project state (pm_project.state = -5), and use it as the default value as it is Out Of The Box. You can update the label for the State field to meet your requirements if Pending doesn't fit well.

1. Navigate to Project > Projects > Project Workspace.
2. In the project workspace header, click New Project button on My Projects Space page.
3. Enter the project name, select the start date, and select a template in Create Project dialog box.
4. Click OK.

Project template configuration

The Project Template Configuration list defines the items that are included in a template.

Navigate to Project Administration > Settings > Template Config to display the Project Template Configuration list. Each item in this list has:

• A defined parent table. The exception is pm_project, which is the root or top-level object in the template.
• A link element. A field that links the parent table and the child table.
• A list of fields to include in the template. The fields defined in this column are the fields that are copied to a project template.

The Project Template Configuration list contains three default template configuration items: project, project task, and project subtask. You can modify these default items or create additional items from this list.

Default Project Template Configuration Items

<table>
<thead>
<tr>
<th>Item</th>
<th>Definition</th>
<th>Parent</th>
<th>Link Element</th>
</tr>
</thead>
<tbody>
<tr>
<td>pm_project</td>
<td>Project object</td>
<td>None. This object does not have a parent because it is the root level.</td>
<td>None. This object does not have a link element because it is at the root level.</td>
</tr>
<tr>
<td>Item</td>
<td>Definition</td>
<td>Parent</td>
<td>Link Element</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------</td>
<td>--------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>pm_project_task</td>
<td>Project task object</td>
<td>pm_project</td>
<td>Parent. Because this task object is one level below the root level, it uses the parent table as a link element.</td>
</tr>
<tr>
<td>pm_project_task</td>
<td>Project subtask object</td>
<td>pm_project_task</td>
<td>Parent. Because this subtask object is two levels below the root level, it uses the parent table as a link element.</td>
</tr>
</tbody>
</table>

Click an item in the Project Template Configuration list to open the project Template Configuration form.

```
<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>The entity to be parameterized in the template.</td>
</tr>
<tr>
<td>Parent table</td>
<td>The parent table for this item.</td>
</tr>
<tr>
<td>Link element</td>
<td>The field that links the table with the parent table.</td>
</tr>
</tbody>
</table>
```

**Project Template Configuration form**

**Project Template Configuration form fields**
<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>A check box that indicates this item is included in a template.</td>
</tr>
<tr>
<td>Elements</td>
<td>A comma-separated list of fields from the table selected in the Table field that are included in the template.</td>
</tr>
</tbody>
</table>

**Add a project template configuration item**
Add a project template configuration item to include in a template.

Role required: it_pps_admin

1. Navigate to **Project Administration > Settings > Template Config**.
2. Click **New**.
3. Fill in the fields on the Project Template Configuration form.
4. Click **Submit**.

For example, to add a requirement object to the project template configuration, fill in the fields as follows:
- **Table**: Requirement [dmn_requirement]
- **Parent table**: Project [pm_project]
- **Link element**: Parent
- **Active**: Enable this check box
- **Elements**: short_description, description, priority, type, state

**Modify a project template configuration item**
Modify a project template configuration item included in a template.

Role required: it_pps_admin

1. Navigate to **Project Administration > Settings > Template Config**.
2. Select a configuration item from the list.
3. Make any desired changes to the fields on the Project Template Configuration form.
4. Click **Update**.

**Delete a project template configuration item**
Do not delete any of the default template configuration items: project, project task, or project subtask. Doing so affects the ability to create project templates.

Role required: it_pps_admin

1. Navigate to **Project Administration > Settings > Template Config**.
2. Select a configuration item from the list.
3. Click **Delete**.

**Project tasks**
Project tasks are the units of work that make up a project.

The size and number of tasks that comprise a project depends on the level of detail you want. For example:
- Part of a task requires a specific skill.
- Other activities in the task do not require the specific skill.
Break down that task further.

**Bottom-up Tasking**

Bottom-up (tactical) tasking means that you plan small, individual units of work that are required, then build a project up to include larger phases. Take this approach when you know what individual tasks are required to be accomplished and you are more flexible about overall project duration and estimated cost. Use this approach to see how much a project costs and how long it takes if you include every task. Project management supports tactical tasking by using rollup calculations on several project fields, such as project duration, so that the project adjusts to the tasks it contains. It is the recommended approach for the Project Management application.

**Top-down Tasking**

Top-down (strategic) tasking means that you plan high-level tasks first, then break down the work into smaller units. Take this approach when you want to build a project with fixed or inflexible time and budgetary constraints and well-defined phases. Establish well-defined milestones and dependencies between tasks that you consider from the beginning. Gradually add smaller tasks to the project later. This approach avoids including all possible tasks in a project and stays flexible with what tasks are included.

**Note:** When you use this method, the Project Management application still rolls up several values, such as task duration. Creating a task with a longer duration than the project, expands to cover the entire duration of the task, and defeats the purpose of using this approach. Values are not rolled down from parent tasks, nor are there any restrictions on creating child tasks that are longer than specified duration of the parent.

**Project task relationships and dependencies**

The Project Management application enables you to create parent-child relationships between tasks and dependencies, such as finish-to-start and finish-to-finish, between tasks.

This table explains the types of task relationships and dependencies that you can create.

<table>
<thead>
<tr>
<th>Concept</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Finish-to-start dependency</td>
<td>A dependency that indicates that a task must not be started until its predecessor finishes.</td>
</tr>
<tr>
<td>Start-to-start dependency</td>
<td>A dependency that indicates that a successor task must not be started until the predecessor task has started.</td>
</tr>
<tr>
<td>Start-to-finish dependency</td>
<td>A dependency that indicates that a successor must not be finished until the predecessor task starts.</td>
</tr>
<tr>
<td>Finish-to-finish dependency</td>
<td>A dependency that indicates that a task must not be finished until another task finishes.</td>
</tr>
<tr>
<td>Lag time</td>
<td>A manually specified time break between predecessor and successor tasks.</td>
</tr>
<tr>
<td>Parent task</td>
<td>A project task with smaller tasks, referred to as child tasks, underneath it. Child tasks break down the work of a parent task into more manageable subsets. Certain fields for child tasks, such as planned end date, roll up and affect the same field in the parent task.</td>
</tr>
</tbody>
</table>
## Concept

<table>
<thead>
<tr>
<th>Concept</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Child task</td>
<td>A project task that is a subset of a larger task. Child task start dates cannot occur before the start date of the parent task.</td>
</tr>
<tr>
<td>Rollup task</td>
<td>Another term for a parent task in the context of aggregating child task items, such as effort or resources, into a larger parent task calculation. All fields on rollup task forms are read-only.</td>
</tr>
<tr>
<td>Roll down</td>
<td>State changes roll down from the project to project tasks, and from parent tasks to child tasks.</td>
</tr>
</tbody>
</table>

### Note: Only one relationship can exist between two tasks.

The Project Management application provides several properties that control how tasks are calculated and behave. See Project property for more information.

**Project task dependencies**

A task dependency is created when one task is prevented from starting or finishing based on its relationship with the preceding and succeeding tasks.

The Project Management application supports several types of dependencies.

### Task time constraints

The Project Task form includes a **Time Constraint** field, which can be one of the following values:

- If a task is set to **Start ASAP**: The task appears on the Gantt chart as starting when the dependency allows it. However, a task can start on a later date when a lag value is set for the relationship.
- If a task is set to **Start on specific date**: The task appears on the Gantt chart as starting on the constraint date. The start date of such a task is not impacted even after you put the task in a relation to another task, for example, FS relation.
- If a task is set to **Start no earlier than**: The task appears on the Gantt chart as starting on or after the constraint date. If the task has no predecessor, the task starts on the specified date. If the task has any predecessor task, the start date changes to a later date based on the predecessor task end date or if the task is in a relation to another task, for example, FS relationship.
- If a task is set to **Start no later than**: The task appears on the Gantt chart as starting on or before the constraint date. If the task has any predecessor task, the dependency on the predecessor task determines when the task can start. A scheduling conflict occurs if the predecessor task attempts to move the task beyond the date specified in the **Constraint date** field.  

### Note: **The project property Retain start on constraint on tasks after adding relations** controls the behavior for **Start on** selection. The property is set to True by default and is not editable.

- A task that is not honoring dependency is indicated with a red calendar icon on the Planning Console. If you want the task to honor the dependency and adjust the start accordingly, change the constraint type of the task to **Start ASAP**.

Create a dependency from the planning console

You can create a dependency between two tasks on the planning console.

Role required: it_project_manager
You can create any type of dependency. See Project task relationships and dependencies for an explanation of each type.

You can also create dependencies by using the Predecessor column on the Planning Console. See Predecessor dependencies in the planning console for more information.

1. Click a task on the Gantt chart portion of the planning console. A white circle appears on either end of the task, one at the start of the task and the other at the end of the task.

2. Click one of the white circles and drag it to the start or end of another task. The dependency is created.

3. Double-click the dependency line to see the dependency on the Planned Task Relationship form.

4. Confirm that your dependency is correct. You can make changes to the dependency as needed.

Modify a project task dependency

You can modify a dependency when editing the tasks that are linked in the dependency, the dependency type, or the lag time.

Role required: it_project_manager

Project task dependencies are saved on the Planned Task Relationship [planned_task_rel_planned_task] table. You can access dependencies from the planning console.

1. Double-click a dependency on the Gantt chart of the planning console.
2. Modify any of the fields (see table).

### Planned Task Relationship form

#### Planned Task Relationship form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Predecessor</td>
<td>The predecessor, or determiner, in the relationship. You can select a new task. However, it is a good practice to delete the relationship and create a new relationship between the correct tasks.</td>
</tr>
<tr>
<td>Successor</td>
<td>The successor in the relationship. The successor depends on the predecessor. You can select a new task. However, it is a good practice to delete the relationship and create a new relationship between the correct tasks.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of relationship, which is always Predecessor of::Successor of. Do not change this value.</td>
</tr>
<tr>
<td>Sub Type</td>
<td>The type of dependency. See Project task relationships and dependencies for a description of each type.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lag</td>
<td>The lag time between the tasks. Enter the days, hours, minutes, and seconds for the lag. Lag time can be positive or negative.</td>
</tr>
</tbody>
</table>

3. **Click Update.**

You can view dependencies in the Project Task related list on a Project or Project Task form and from the Project Tasks list on the workbench. These columns show the dependencies:

- The **Dependency** column shows the successor task in the relationship.
- The **Dependencies** column shows the dependency value. See Predecessor dependencies in the planning console for a description of what you see in this column.

**Remove a dependency**

Use the planning console to remove a dependency that is no longer necessary.

Role required: it_project_manager

Removing the dependency also deletes the dependency record in the Planned Task Relationship table.

1. Open the project in the planning console.
2. Do either of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| On the Gantt chart    | - Right-click the relationship and then click **Delete Link**.  
                        | - Double-click the relationship and then click **Delete** on the Planned Task Relationship form that appears. |
| On the WBS list      | - Delete the value in the **Predecessor** column.  
                        | - Click the value in the **Predecessor** column and then click **Delete** on the Planned Task Relationship form that appears. |

**Parent-child task relationships**

If a task is relatively large and requires several users with different skills to manage, break the task into subtasks and create parent-child relationships. A child task is a relatively smaller, manageable size of work.

When you group child tasks together under a parent, values such as **Estimated cost** aggregate and roll up to the parent task. So the parent task takes on the form of a summary task or rollup task for its child tasks. **Planned start date** and **Planned end date** rollup occurs when you create child tasks: the duration of the parent automatically adjusts to cover its child tasks.

A parent-child relationship is different from a dependency relationship. In a dependency, one task must finish before another begins. In a parent-child relationship, any number of tasks can be nested under a parent task with or without any dependencies. When you create a parent-child relationship, the parent task number is saved in the **Parent** field in the Project Tasks table. All project management tasks have a parent: either another project task or the project itself.

Unlike a dependency, a parent-child relationship is not saved as a record in any table. The only modification that takes place when a parent-child relationship is modified is the **Parent** field in the child task record.

You can create predecessor-successor relationships between child tasks with different parents, between two different parent tasks, or between a child task and another parent task. However, if the predecessor
task finishes after the successor task starts, creating a dependency between child tasks that have different parents is not allowed.

**Note:** On the Gantt chart, you can drag-and-drop the parent task to move the entire hierarchy to a new location on the schedule.

Create a parent-child relationship on the Project Task form

You can create a child task from any project task form.

Role required: it_project_manager

1. Navigate to the parent task in the relationship.
2. In the Project Tasks related list, click New. The same Project Task form appears for all tasks regardless of the parent-child relationship.
3. Create the task and click Submit. The newly created task becomes the child task in the relationship.

To help remember what the parent of any task is, view the breadcrumb at the top of the Project Task form. It is also helpful to configure the form layout to include the Parent field. You can also change the parent task from this field.

Time constraints in parent-child relationships

Parent-child task relationships have several effects on task time constraints.

- When a child task is set to Start ASAP:
  - The child task starts at the same time as the parent task. If Project itself is set as a parent, the Start ASAP tasks starts on the same date as set in the Constraint Date field, as long as it does not have dependencies with other child tasks.

- When a parent task is set to Start ASAP and child tasks are set to Start on specific date:
  - The earliest child task start date determines the start date of the parent, assuming no other dependencies.
  - In this case, the Time constraint field of the parent remains Start ASAP, but the actual start date is changed to the start date of the earliest child task.

- Child precedence also applies to end dates. If the estimated end date of the child task is later than the end date of the parent task, the estimated end date extends to cover the child. For actual values, a parent has the same start date as the earliest start date of its children. The latest actual end date is the latest end date of its children. Assuming the child tasks are Closed Complete. If the child tasks are not in the Closed Complete state, the actual end date of the parent is empty.

- For the planned start date of the parent task:
  - The planned start date is the earliest planned start date of all the children that do not have an actual start date.
  - If all child tasks have actual start dates, the planned start date of the parent task is set to the actual start date.

- For the planned end date of the parent task:
  - The latest planned end date or actual end date of the child tasks determines the planned end date of the parent.

- A task with Start no later than or Start on specific date time constraint cannot be a parent task. When a new child task is added to a task with these time constraints, the time constraint for the parent task is changed to Start ASAP.
**Parent-child rollup task calculations**

Date changes, stage changes, and value calculations roll up from child tasks to parent tasks.

- Date changes involve modifying the planned start or end date of a parent task based on those values in child tasks.
- State changes involve modifying the state of the project record or parent task records when all child records are set to a certain state.
- Calculations involve summing the values of child tasks and then automatically updating the parent to reflect a new total.

The following fields change on rollup tasks:

- **Planned Start date:** Set to read only for parent tasks. Remains editable for the project record (also considered the top-level task).
- **Planned End Date:** Becomes read only.
- **Planned Duration:** Becomes read only.
- **Actual Start Date:** Becomes read only.
- **Actual end date:** Becomes read only.
- **State:** Becomes read only.

**Duration Rollups**

Rollups are calculated for the following items:

- **Planned duration and planned effort:** the sum of all planned duration and planned effort values for all child tasks.
- **Actual duration and actual effort:** the sum of all actual duration and actual effort values. Actual duration and actual effort values are calculated when all child tasks are in the Closed Complete state. Actual effort values can include rollups from time cards.

**Note:** Verify that the time card property Update the task's 'Actual effort' based on the hours entered in the time card is enabled. Navigate to Time cards > Administration > Properties to enable this property.

**Cost Rollups**

Cost calculations roll up when the costing add-on is active.

- **Estimated cost:** The sum of all cost estimates at the beginning of a project. Estimated costs of child tasks roll up to parent tasks and to the project.
- **Actual cost:** By default for the project, the sum of all costs of all the expense lines, and are typically associated with a time card and a labor rate. To track costs, you can derive rates using any of the following options:
  - Associate a rate model to the project.
  - Define rate cards for the task and labor expenses.
  - Associate rate at the resource plan level.

These rates automatically generate expense lines showing actual expenditures, which are associated with the projects. If rate cards are defined, the task expense lines are generated as each project task closes, and labor expense lines are generated when time cards are approved. Expense lines are visible in the Expense Lines related list, which requires the Advanced view on both Project and Project Task forms.
To ensure actual costs of child tasks correctly roll up to the project and added to project expense lines, the following must be true:

- The `com.snc.project.rollup.cost` property must be set to `true`. To enable this property, navigate to **Project Administration > Settings > Preferences - Project** and select the **Enable project cost rollup** check box.
- The `glide.cost_mgmt.process_task_top_task` property must be set to `false`. Go to the costing properties in the Cost Management application. Check the **When creating a task expense line should the system also create expense lines for the task’s top task** box is checked.
- The `glide.cost_mgmt.calc_actual_cost` property must be set to `true`. Go to the costing properties in the Cost Management application. Check the **For planned tasks types, calculate the actual cost field using the total of expense lines for the task** box.

**Project State Rollups and Roll Downs**

Project task states roll up. The state of parent tasks becomes read only, and changes automatically when you change the states of child tasks.

Project task states can roll up if:

- The state of the child task is manually changed and there are no other conditions on the parent task.
- The state of the child task is changed to **Work in Progress** or **Closed**. These states roll up to the parent. **Pending** and **Open** do not roll up to the parent task.

Project states can also roll down. If you change the state of a project to closed, all tasks under it change to the default closed value (**Closed Complete**). If a closed project or closed task is reopened, all tasks under it change as follows:

- Project or parent changed from closed to **Pending** or **Open**: Child tasks change to **Open**.
- Project or parent changed from closed to **Work in Progress**:
  - Child tasks with a **Start on** date that has passed are changed to start **ASAP** and the state is changed to **Work in Progress**.
  - Child tasks with a **Start on** date that has not yet passed retain the same start on date but the state is changed to **Open**.

Enable cost rollup calculations

Enable rollup calculations from the project properties.

Role required: **it_project_manager**

1. Navigate to **Project > Settings > Preferences**.
2. Select **Enable project cost rollup**.
3. Click **Save**.

Rollup values are read-only on forms. Point to the icon beside the field for a tooltip message.
Scheduling conflicts between project tasks

Scheduling conflict helps you to identify project tasks that are not honoring dependencies. A scheduling conflict occurs when one project task prevents another task from starting on the specified date because of dependencies or constraint types.

A scheduling conflict occurs when any action such as applying a dependency, changing constraint type, or constraint date causes the task start date to violate the project's constraint date.

When a scheduling conflict occurs, the system warns you about the conflict. You can choose to cancel the action that is causing the conflict or continue with the conflict. If you choose to continue with the conflict, the constraint date is given highest precedence and dates are recalculated. The start date is moved till allowed by the task constraint date, but dependency is not honored.

For example, consider the following scenario:

For a project with project task's **Constraint date** set as 20 January, there are two tasks:

- T1 with constraint type set to As soon as possible and start date of 20 January.
- T2 with constraint type set to Start no later than and start date of 20 January.

If you add an FS dependency between tasks T1 and T2, the task T2 should start on 21 January, but due to Start no later than constraint, task T2 cannot start on 21 January. This inability of starting task T2 on the specified date is an example of conflict.

In this example, if you choose to proceed with the conflict, the start date of task T2 is moved to 20 January which is the constraint date.

Scheduling conflict between tasks is shown for tasks with **Start no later than** and **Start on specific date** time constraints.

If you want the task to honor the dependency and adjust the start accordingly, change the constraint type of the task to **Start ASAP**.

When a scheduling conflict is identified, you can identify such tasks in the planning console.

- The client-side planning console displays a pop-up message with an option to proceed with the conflict or cancel the action. If you proceed with the conflict, the constraint type is applied or date is changed appropriately to the next feasible date.
- The calendar icon on the client side planning console changes to red to indicate the conflict.
- The calendar icon on the server side planning console changes to red to indicate the conflict.

Create a project task

You can create project tasks in various ways, even from other applications in the instance.

Role required: it_project_manager

You can create a project task:

- Using the Project Tasks related list. This related list is available from both a project record and a project task record. You can use the **New UI action** or insert a new row in the related list.
- Using the planning console.
- Using the **project task creator**. Use a dialog box to create multiple tasks at one time. The project task creator is available from both a project record and a project task record.
- By **copying an existing project or task**. This option copies a selected task, or even a whole project, including all child tasks.
• From an incident, problem, or change request. The Project Task related list is also available from the Incident, Problem, and Change Request forms. The tasks you create from these forms makes the project task a child of the incident, problem, or change, rather than a project.

Create a project task from a project
Create tasks from the Project form. The fields appear when the Project Portfolio Management is active and the Project form is in the Basic view. Configure the form to display the fields.

Role required: it_project_manager
1. Navigate to Project > Projects > All.
2. Select the project from the list.
3. In the Project Tasks related list, click New.
4. On the form, fill in the fields.

Project Task form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Brief description of the project task.</td>
</tr>
<tr>
<td>Number</td>
<td>System-generated number with a configurable prefix.</td>
</tr>
<tr>
<td>Time constraint</td>
<td>When the project task begins:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Start ASAP</strong>: The task starts as soon as possible as determined by the relationships and dependencies. The dates for these tasks are derived from the constraint date of the project.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Start on specific date</strong>: The task starts on a date that you specify. The task dependencies are not considered for date calculation.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Start no earlier than</strong>: The task starts on or after the constraint date.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Start no later than</strong>: The task starts on or before the constraint date. The start date is determined by the relationships and dependencies.</td>
</tr>
</tbody>
</table>

**Note:** If the Calculation field on the Project form is set to Manual, you cannot change the constraint type for such projects. You must change the project to Automatic to change the constraint type.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>Current state of the project. The states include: Pending, Open, Work in Progress, Closed Complete, Closed Incomplete, Closed Skipped.</td>
</tr>
<tr>
<td></td>
<td>The state is automatically rolled up from the project tasks. For more information, see Project calculation and Parent-child rollup task calculations.</td>
</tr>
<tr>
<td>Percent complete</td>
<td>Percentage of the work that has been completed for the project task.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Details tab</strong></td>
<td></td>
</tr>
<tr>
<td>Milestone</td>
<td>Check box to convert the task to a milestone.</td>
</tr>
<tr>
<td>Key milestone</td>
<td>Check box to convert the task to a key milestone.</td>
</tr>
<tr>
<td>Allow dates outside schedule</td>
<td>Indicates whether the project task is set to start and end on a non-schedule day (outside regular project schedule) such as on a weekend. An off-schedule task can start any time during the day and on any day of the week. For example, if you use the project schedule Monday to Friday, 8 am to 5 pm and a project task of duration 2 days should start on Saturday, then an off-schedule task is allowed to be scheduled on Saturday and end on Sunday. Similarly, if a task of duration 3 days starts on Friday, then an off-schedule will end on Sunday as opposed to ending on Tuesday. The option is not enabled for a parent task. The value of this field on the parent task is derived from the child tasks.</td>
</tr>
<tr>
<td>Note:</td>
<td>- There is no difference between an off-schedule and on-schedule task if there is no schedule defined at the project.</td>
</tr>
<tr>
<td></td>
<td>- 1 day is 8 hours for a task in regular schedule and 24 hours for a task outside schedule.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group assigned to the project task.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User assigned to the project task. The following conditions apply:</td>
</tr>
<tr>
<td></td>
<td>- If an assignment group is defined, only users in the assignment group appear in the lookup list.</td>
</tr>
<tr>
<td></td>
<td>- If skills are defined, only users with those skills appear in the lookup list.</td>
</tr>
<tr>
<td></td>
<td>- If no assignment groups or skills are defined, only users with one of the Project Management application user roles appear in the lookup list.</td>
</tr>
<tr>
<td></td>
<td>- Users with <code>timecard_user</code> role also appear in the lookup list.</td>
</tr>
<tr>
<td>Additional assignee list</td>
<td>Additional users assigned to the project task.</td>
</tr>
<tr>
<td>Dates tab</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Planned start date  | Estimated date and time for the project task to start. You can edit this date when the **Time constraint** is **Start on Specific Date**, **Start no earlier than**, or **Start no later than**.  
If the constraint type is **Start ASAP** or **Start no later than**, changing the planned start date for a task changes the constraint type to **Start no earlier than**. |
| Planned end date    | Estimated date and time for the project task to end.  
For a manual project, any update to actual start date does not update the planned end date of the project task. Enable the project property **Enable alter of planned date with Actual for Manual Project** to update planned end date from actual start date and planned duration. |
| Planned duration    | Estimated length of time (from start time to end time) of the project task.                                                                                                                                  |
| Planned effort      | Estimate of how much time it will take to complete this task. After you add child tasks, this field becomes a read-only, roll-up calculation and overwrites any earlier entry that you made.                        |
| Original start date | Original planned date and time for the task to start.                                                                                                                                                        |
| Actual start date   | Date that the project task began. The task is set to **Work in Progress** when the actual start date is populated.  
When you change the State or Percent complete of the task, the actual dates are auto-populated with the date component copied from the planned dates.  
When you populate the actual start and end dates, the time component in actual dates is defaulted to the date component in planned dates when the **Derive time component from planned dates** field on Project form is set to True. |
| Actual end date     | Date that the project task ended. The task is set to **Closed Complete** when the actual end date is populated.                                                                                            |
| Actual duration     | Duration of the task from task start to task closure. As with planned duration, the actual duration shows total task time.                                                                               |
| Actual effort       | Actual number of hours charged from the resources on this project task. If you are using the Time Cards application, the application automatically calculates the value for the field.  
The application uses the totals for the time worked from the approved time cards of all resources who worked on the task. |
<p>| Original end date   | Original planned date and time for the task to end.                                                                                                                                                         |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constraint date</td>
<td>A read-only field that determines the start date for tasks with <strong>Start no earlier than</strong>, <strong>Start no later than</strong>, and <strong>Start on specific date</strong> constraints. Use the Move project related link to change this date. For more information, see Change the planned start date of a project.</td>
</tr>
</tbody>
</table>

**Notes tab**

<table>
<thead>
<tr>
<th>Description</th>
<th>Detailed description of the project task.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity / Work notes / Additional comments</td>
<td>Information about the milestones, impediments, or changes as the project progresses. Enter notes or comments in the <strong>Activity</strong> field and click <strong>Additional comments</strong> or <strong>Work notes</strong>. The text appears in the feed.</td>
</tr>
</tbody>
</table>

**Checklist tab**

<table>
<thead>
<tr>
<th>Checklist</th>
<th>Checklist to track items that must be completed for the task.</th>
</tr>
</thead>
</table>

5. **Click Submit.**

The new task appears in the **Project Task** related list on the Project form. If time cards are in use, the application creates a time card for the resource.

The value in the **Percent complete** field is related to the **State** field in the v3 application. If you change the percentage complete from 0 to any other value, the state of the task changes to **Work in progress** when you save or update the record. Likewise, if you change the state of the task to **Closed complete**, the **Percent complete** field is set to 100 and becomes read-only.

If you change the state of a project task from **Work in progress** to **Closed Skipped** or **Closed Incomplete**, the **Percent complete** field retains the current value and becomes read-only.

The **Percent complete** field appears in the Gantt chart for parent tasks as a light-colored bar (the part of the task that is complete). The bar overlaps the darker, underlying bar (the full task). For example, a Demo project is 5.41% complete as shown in a pop-up window. The **Phase 1** task is about 50% complete (not shown in the pop-up window).

The Project Tasks list and the Project Tasks related list on the Project form include a **Dependency** field. Any dependencies for a task, such as a parent task, are displayed in this field. Click a dependency record. See Predecessor dependencies in the planning console for a description of what you see in this column.

**Create a task from an incident, problem, or change request**

You can create a new project task from the Project Task related list on the Incident, Problem, and Change Request forms. The tasks you create from these forms makes the project task a child of the incident, problem, or change, rather than a project.

Role required: it_project_manager

1. Navigate to the Incident, Problem, or Change Request form.
2. Configure the form to add **Project Task > Parent** if the related list is not already present.
3. In the **Projects** related list, click **New**.
4. Fill in the project form.

The project task becomes a child task of the incident, problem, or change record.
Create tasks from project task creator

Use the project task creator to create multiple tasks at once.

Role required: it_project_manager

1. In the Project form, right-click the header bar and select **Project task creator**.
2. Enter the number of tasks to create.
3. Select the **Create FS dependency** check box to create a finish-to-start dependency between these tasks (when the first task finishes, the next task starts). Clear the check box to create the tasks with no dependencies.
4. Click **OK**.

   The new tasks appear in the **Project Tasks** related list. The application automatically creates a task **Number** and a **Short Description** that starts with **Auto Created Task**, followed by a number when more than one task is created.

Insert a row into the project tasks list

You can create a new project task from the Project Task related list on the Project form. Administrators must enable this task-creation feature.

Role required: it_project_manager

1. In the Project form, navigate to the Project Tasks related list.
2. Double-click **Insert a new row**.
3. Click the green check mark.
4. Open the new task and edit the record as required.

Copy an existing task or project

Save time when building a project by copying tasks from other projects.

Role required: it_project_manager

The **Copy partial project** option copies a selected task and its child tasks into the project, or all project tasks into a sub-project. It also preserves all dependencies and relationships among the copied tasks and their child tasks. Any relationships or dependencies that involve tasks outside of the scope of the copied task are not preserved.

1. In the Project or Project Task form, right-click the header bar and select **Copy partial project**.
2. In the **Task** field, select a project task or project to copy. By default, projects begin with PRJ and project tasks begin with PRJTASK.
3. Enter a **Name** for the new project or task.
4. Click **OK**. The copied task is added to the current task or project. If a project was copied, then all the tasks are inserted into a new sub-project.

The copied tasks are inserted as a child of whatever task or project that you are currently viewing. Actual duration and the actual start and end dates are reset to null values. The state is set to **New** and percent complete is set to **0**.

By default only the short description, planned dates and duration fields are copied from source project to the target project. If additional columns must be copied, they should be declared in the **project property**

**List of attributes that will be copied from the originating project task.**

**Change default values of copied fields**

Change the default values of in the new partial project.

Role required: admin

Actual duration and the actual start and end dates are reset to null values. The state is set to **New** and percent complete is set to **0**. Administrators can modify UI pages to determine which fields are reset or to change the default values.

1. Navigate to **System UI > UI Pages**.
2. Open the copy_partial_project record.
3. Use the following script if in the **Processing script** field:

```javascript
/* resetFields is the array containing the list of names of fields that need to be erased from the copied project tasks
 * defaultFields is the array containing the key, value pairs of field names and values that need to be set on the copied tasks
 */
var resetFields = new Array();
var defaultFields ={};
resetFields.push("work_start", "work_end", "work_duration");
defaultFields["state"] =-5";
defaultFields["percent_complete"] =0"
```

**Create a task from a project task template**

You can save a project task as a template and reuse it when creating a task.

Role required: **it_project_manager**
You must have a template from an existing project task that has the required field values. See Templates for more information on this platform feature.

1. Navigate to Project > Tasks > All.
2. Click New.
3. If the templates do not appear at the bottom, click the ellipsis icon at the top of the form, and select Toggle Template Bar.
4. Click the template link in the template bar at the bottom of the form.

The template is applied to the project.

Create a milestone

A milestone is a project task with a duration of zero (0). Use milestones to mark key dates in your project, such as key decision points, approvals, and holidays. Milestones are treated like any other project task and you can create dependencies between tasks and milestones.

Role required: it_project_manager

**Note:** Milestones cannot be shared between projects unless one project is nested under another project.

1. Create a project task and give the Duration field a value of 0.
2. Open the planning console Gantt chart and verify that it appears as a diamond.

You can also convert a task to milestone through planning console.

Change requests and project tasks

Large-scale changes approved by your change approval board (CAB) require new or existing projects to be implemented.

To bridge the gap between change management and project management, the instance allows you to link one or more change requests to a project task. You can link an existing change request to a project task or create a new change request directly from a project task.

When you link a project task to a change request record, a new project task link record is created. It provides the actual link between the project task record and the change request record. The project task link copies all attributes of the change request record. It then becomes a child task of the project task that
you linked to the change request. The rules that govern the relationship between the project task and the project task link are the same as the rules for all parent and child tasks.

**Project tasks linked to change requests**

**Note:** A project task cannot have both task link records and child project tasks. When a project task is linked to a change request, you cannot also create child tasks for that project task. Likewise, when a project task has child tasks, you cannot link the parent project task to a change record.

The project task link record is read only. You can view the project task links from a related list on the Project Task form.

You can also link multiple change requests to a single project task. In this case, a project task link record is created for each link and all the project task link records become child tasks of the project task.
**Project tasks links**

*Change request project task relationship*

The rules that apply to all parent-child tasks also govern the relationship between project task and the project task link.

**Start and end dates**

The project task link inherits start and end dates from the change request. However, the Project Management application adjusts the dates when these situations occur:

- If the project task and the change request have different planned start dates, the project task link uses the later of the two dates. For example, if the project task starts on October 1 but the change request starts on October 2, the project task link changes to October 2.
- If the change request has an earlier start date, the Time constraint value for the project task link becomes *Start ASAP* when the link is created. The end date remains the same as the end date specified in the change request record.
- If the change request starts and ends before the project start date, the project task link has a duration of zero (0). It also appears as a milestone that occurs when the project starts.
- If a change request is scheduled to start during non-work time according to the project schedule, the planned start date of the project task link ignores the schedule. It also starts at the time specified by the change request. However, the duration of the project task link does take the schedule into consideration. For example: the project uses the default schedule, which specifies that work hours are Monday to Friday from 08:00 to 17:00 with an hour break from noon to 13:00. A change request with a 13-hour duration starts at midnight. The project task link starts at midnight and continues through the start of the schedule at 08:00. It stops at noon for one hour, and continues from 13:00 until 14:00. The total duration would be 13 hours.
**Project Task Duration**

The duration of the change request determines the duration of the project task link. That duration is rolled up to the parent project task just as all child task durations roll up to parent tasks. The **Planned start date** and **Planned end date** in the Change Request form **Schedule** section are the fields that determine the duration. If there are no planned dates on the Change Request form, the default duration is one project day. The project has a schedule or 24 hours when the project has no schedule.

**Multiple Linked Change Requests**

If you link additional change requests to a project task, additional project task links are created. All become child tasks of the project task. The dates roll up to the parent task. For example, if a linked project task is planned to finish on October 30. You link a new change request scheduled to finish on November 30, a new project task link is created. The parent task planned end date extends to November 30 to cover the duration of both project task links. A change request can only be linked to one project task. It cannot be linked to multiple tasks in the same project or across multiple projects. A project task that has one or more child tasks cannot also have a project task link connecting it to a change request.

**Project Task State**

If the state of a change request changes to **Pending**, **Open**, or **Work in Progress**, the state of the project task link changes accordingly. If the state of the change request changes to any of the closed states, the state of the project task link changes to **Closed Complete**.

**How Modifications Propagate Between Change Requests and Project Tasks**

Modifications to a linked change request propagate to the project task link. However, the reverse is not true. You cannot modify the change request record from the Project Management application.

Modifications to the following fields propagate from the change request to the project task link:

- **Planned start date**
- **Planned end date**
- **State**

These change request settings also roll up to the project task that is the parent of the project task link, and also up to the project record. Consider the following example: a project has not yet been started and all its tasks are in the **Pending** state. If you changed the state of a linked change request record from **Open** to **Work in Progress**, the project task link, its parent task, and the project itself all change to **Work in Progress**.

When you start a project, tasks that have **Start ASAP** as the time constraint and have no other start dependencies start immediately. However, project tasks with linked change requests do not start automatically. The project manager must start the task manually by changing the **State** field to **Work in Progress**.

Modifications made in the Project Management application do not propagate to a linked change request record, so closing a project does not close a linked change. When you successfully implement a change and close the project it belongs to, you must go to the change request record and manually change the state to **Closed**.

**Link change requests to a project task**

Link change requests to tasks on the Project Task form. You can link change requests only to project tasks that have no child tasks.

Role required: it_project_manager
You can link any change request record to a project task, regardless of the change request schedule or state. However, as a good practice, consider:

- **Change Schedule:** The change request has a schedule that falls within the time frame of the project it links to. Or, it has no values in the *Planned start date* and *Planned end date* fields in the *Schedule* section of the Change Request form.
- **Change State:** An *Open* or *Pending* state is required when linking a change request. Changes that are already in progress or closed can be stopped and copied to a new change request.

1. Open a project task that does not have any child tasks. Tasks that already have child tasks cannot be linked to change requests.
2. Click one of the following related links:
   - **Link an Existing Change Request to Project Task:**
     In the dialog box that appears, enter or select the change that you want to link.
   - **Create Change and link from Project Task:**
     The Change Request form appears. Enter the information in the form. The short description of the change request is taken from the project task.

  **Note:** These related links are available only when the project task type is waterfall.

- On the Project Task form, a notification appears at the top specifying that the task is linked to one or more change requests.

![](Example for Task designated for linked change requests in the related list)

### Project task checklists

A project task checklist gives you the ability to track activities that must be completed on a task.

For a project task to be considered complete, you can track activities that do not require separate subtasks. For example, you have a human resources-related project that includes a task for interviewing candidates. You can also track booking a meeting room or getting an interview confirmation from the candidate. Create a checklist item for each and mark when they have been completed.

Checklist items do not have start or end dates, nor do they track effort or cost. By default, a checklist item record provides only a name and a *Complete* field, which can be set to true or false. The state of the project task is independent of the state of the *Complete* field on the checklist item.
Checklists, as well as tasks, are copied into a project template. You also have access to all checklist templates from any project task form.

**Note:** Checklists are available for any form that is based on a table extended from the Task table. Administrators can add or remove checklists as needed.

**Use a project task checklist**

You can create a checklist in a project task to track items that must be completed in the task.

Role required: it_project_user, it_project_manager

1. Navigate to a project task.
2. To create a checklist for the project task, click Create new in the Checklist section. Specify a name for the checklist.
3. To remove a checklist from the project task, click the down arrow next to Checklist and select Remove Checklist.
4. **Note:** This option appears when there is at least one checklist in the Checklist section.

To save a checklist as a template, click the down arrow next to Checklist and select Save as Template.

**Save a checklist as a template**

After you create a checklist on a project task, you can save it as a template and reuse it on other tasks.

Role required: it_project_manager

1. Navigate to a project task.
2. Click the down arrow next to Checklist.
3. Select Save as Template.
4. Enter a name for the checklist.
5. Click Save.

**Accept or reject project task notifications**

Approve or reject the changes in a notification for an external soft dependency.

Role required: it_project_manager

The Notifications related list on the project record lists the external dependency related notifications raised in the successor project. The notifications are triggered as a result of changes made in the predecessor project that can impact successor project or task.

- The notifications for the hard dependency have the State set to Processed by default.
- The notifications for the soft dependency have the State set to New by default. As the project manager of the successor project, you can choose to accept or reject the changes in the notification.

1. Open the project form.
2. Click the Notifications related list.
3. Click the reference icon to open the project task notification record for an external soft dependency.
4. Click Approve or Reject.

- The Status of the notification record changes to Accept or Reject.
• The State of the notification record changes to Processed.

**Task resources**

Resources are the individuals or groups assigned to perform tasks and subtasks in Project Management.

You can use Resource Management to set up resource plans, which can be associated with projects. Activate Project Portfolio Management to use Resource Management with Project Management.

**External dependencies**

As a project manager, you can use an external dependency to set up a dependency from a task in one project to a task in another project.

External dependencies help you to see the impact of changes in project schedules when a predecessor project changes.

**How external dependencies work**

To define the external dependency, select a project task from the predecessor project to be linked to the task in the successor project. When an external dependency is added, the system adds shadow tasks in both the successor and predecessor projects.

A shadow task is a read-only task in the respective project. It has the database attribute shadow set to true and orig_sys_id pointing to the sys_id of its original task. The shadow task is kept in sync with its original task whenever the relations are processed.

In addition to the shadow tasks, two shadow relations are also added in the planned_task_rel_planned_task table. These relations are shadows of the original relations.

For example, for two projects, project P1 is the predecessor project, and P2 is the successor project. Project P1 has a task T1, and project P2 has a task T2.

If an external dependency is created from T1 to T2, the following tasks are added in the two projects:

<table>
<thead>
<tr>
<th>Project</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>P1</td>
<td>Shadow of T2</td>
</tr>
<tr>
<td>P2</td>
<td>Shadow of T1</td>
</tr>
</tbody>
</table>

After adding the external dependency, the following shadow relation records are created in the planned_task_rel_planned_task table:

<table>
<thead>
<tr>
<th>Parent</th>
<th>Child</th>
<th>Project</th>
<th>External</th>
</tr>
</thead>
<tbody>
<tr>
<td>T1</td>
<td>T2</td>
<td>P2</td>
<td>False</td>
</tr>
<tr>
<td>Shadow of T1</td>
<td>T2</td>
<td>P2</td>
<td>False</td>
</tr>
<tr>
<td>T1</td>
<td>Shadow of T2</td>
<td>P1</td>
<td>False</td>
</tr>
</tbody>
</table>

**Where:**
- **Parent** is the predecessor project
- **Child** is the successor project
- **Project** is the project where the relation is seen
- **External** is the external dependency
Types of external dependencies

The Project management application supports two types of external dependencies - hard and soft.

The type of external dependency can be set during adding a dependency between two projects tasks on the planning console.

Hard dependencies

In a hard dependency, any changes made in the predecessor project are automatically propagated to the successor project. A notification for the changes made is triggered in the successor project. The following image shows the process flow for a hard dependency type:

![Diagram of hard dependency process]

External hard dependency

Soft dependencies

In a soft dependency, any changes made in the predecessor project trigger a notification in the successor project. As the project manager of the successor project, you can choose to accept or reject the changes in the notification. If you accept the notification changes, the changes in the predecessor project are synced to the successor project and the project is recalculated. If you reject the notification changes, the changes are not propagated to the successor project. The following image shows the process flow for a soft dependency type:
Add an external dependency on planning console

Add an external dependency between two projects on the planning console. Use the work breakdown structure (WBS) column of the planning console to create a dependency between the different projects tasks.

Role required: it_project_manager

1. Right-click a task in the WBS column of the planning console.
2. Click Add External Dependency.
3. On the form, fill in the fields.

Add Dependency form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>The predecessor project that the dependency is added from.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Task</td>
<td>The task in the predecessor project that the dependency is added from.</td>
</tr>
<tr>
<td>Dependency Type</td>
<td>The type of external dependency: <strong>Hard</strong> or <strong>Soft</strong>.</td>
</tr>
</tbody>
</table>

4. Click **OK**.

- A shadow task corresponding to the predecessor task appears in the WBS section of the planning console of the successor project. A similar shadow task corresponding to the successor task appears in the WBS section of the planning console of the predecessor project.

  A shadow task is shown as a grayed out task in WBS column.
- A shadow task corresponding to the predecessor task appears in the **Project Tasks** related list on the successor **project form**. A similar shadow task for the successor task appears in the **Project Tasks** related list on the predecessor project form.
- The **Dependency** column in WBS column of the planning console of the successor project shows the external dependency value between the projects and tasks. The external dependency value has the following format:

  \( (\text{project\_number})\{\text{WBS\_number}\}\{\text{dependency\_type}\}+\{\text{lag\_time}\} \)

  Where
  - `project_number` is the number of the predecessor project.
  - `WBS_number` is the number of the predecessor task in the relationship.
  - `dependency_type` is the **finish to start** dependency type that the application supports.
  - `lag_time` is the amount of time, in days, to delay the start of the dependent task. This value can be positive or negative integers.

**Note:** The external dependencies are displayed only when the **Hide External Dependencies** switch on the planning console is turned off. However, the **Dependency** column in the WBS section of the successor project still shows the value of the external dependency.

In the example below, an external dependency is created between two projects P1 and P2. P1T1 is a shadow task of predecessor project P1, and PRJ0010127\1fs+0 is the external dependency value in the **Dependency** column of the planning console of the successor project P2.

Check for any external dependency related **notifications** that may impact the project or its tasks.
Composite fields

A composite field combines information from two fields in a table to form a single field.

For example, the Task field on the Project Tasks list displays the short description and the project task number. The short description appears above the project task number. The project task number appears and is a link to the Project Task form.

Use a composite field

- Editing a composite field changes the short description. Editing the short description changes the composite field.
- Sorting on a composite field is based only on the short description and not the number.
- Searching on a composite field is enabled for both the short description and the number:
  - To search by the number using the list header, enter an asterisk (*) before the search term. For example, *PRJTASK0010016.
  - To search by the number using the filter, create a condition similar to: [Task] [contains] [PRJTASK0010016].

Start a project

Starting a project is the next step after setting up the project, populating it with tasks, and assigning resources.

Role required: it_project_manager

1. Open the project you want to start.
2. Change the State field to Work in Progress and click Save to save the change.

Note: You can not restart a project (changing the state to Work in Progress) or reopen it after it is closed. Updating the project state from Closed to Work In Progress, Pending, or Open is not allowed. Instead of reopening the project, reopen an existing project task or add a new task to the project. This moves the project from Closed to Work in Progress state without affecting the other closed tasks.
After you start the project:

- The read-only **Actual start date** field of the project is populated with the planned date.
- If a task or set of tasks are scheduled to start immediately upon project start (meaning that their time constraints are set to **Start ASAP** and they have no other start dependencies), the actual start dates of those tasks also get populated with the planned date.
- The planned start dates of all other tasks adjust accordingly based on the time you started the project. Their new planned start dates depend on several factors, including dependent relationships with other tasks and the duration for each task.

**Note:** Once a project is in the **Work in Progress** state, it does not mean that the state of every task will start updating automatically based on planned start date. Other than the project tasks that you schedule to start **ASAP** when the project starts, project tasks are not started automatically. Continue to manage the project and change the state of each task to **Work in Progress**.

**Update a project in progress**

While a project is underway, keep actual values as current as possible. Continue to measure actual values, analyze the impact of any potential project risks, and make adjustments to handle scope, cost, and schedule accordingly.

**Role required:** it_project_manager

1. Open a project in the **Work in Progress** state.
2. Keep the following fields up to date:

   While the status of the project is **Work in Progress**, keep these fields up to date:

   - **Priority**: the priority of the project, especially as it relates to other projects in the portfolio.
   - **Net value**: the value of the project to the company expressed in expected revenue.
   - **Risk cost**: the sum of all costs involved with potential project risks. Although this field is not related to cost management, you can use this field to estimate the costs of risks that arise during the project.
   - **Configuration item**: the CI related to the project.
   - **Schedule**: the type of work schedule.
   - **Work notes**: a useful record of notes and comments related to the project.
   - **Live feed**: a record of the collaboration between various project stakeholders.

   For project tasks, keep these fields up to date:

   - **State**: remember to change project task states to **Work in Progress** when the task should begin (for tasks that have a specified start date) and **Closed** when the task is finished. Task states do not change automatically except when the time constraint of the task is set to **Start ASAP** and the state of the predecessor task is changed to one of the closed states.
   - **Assignment group**: the group of resources currently working on the task.
   - **Assigned to**: the individual assigned to the task.
   - **Time cards**: the amount of time resources work on a project, which roll up into **Actual effort**. If a labor rate is configured for a time card, changes to the time cards affect the **Actual cost** of the project.

3. Click **Update** to save the record.
Track project comments and collaborate with stakeholders

When a project is in progress, you can take advantage of two platform features that help project participants interact and collaborate: journal fields and live feed.

- Two useful journal fields are Comments and Work notes. To add journal fields to a project form:
  a) Configure any project form to show Comments and Work notes.

- To add live feed to a project form:
  a) Navigate to System Definition > Dictionary.
  b) Click the pm_project table name that has no corresponding Column name.
  c) In the Attributes field, enter live_feed=true.
  d) Click Update.
  e) Navigate to System Definition > UI Actions.
  f) Open the Follow on Live Feed list action.
  g) In the Table field, select the [pm_project] table.
  h) Right-click the header and select Insert to create a copy of the UI action for the [pm_project] table.
  i) Repeat the steps for the UI actions for the Show Live Feed form action.
  j) Personalize the Project form and add Activities (filtered), which is the activity formatter, to the desired location on the Project form.

Planning console

The planning console is a centralized interface for the Project Management application.

The planning console gives project managers a comprehensive view of all aspects of a project, including a hierarchical list of sub-projects, if any, project tasks that appear in a work breakdown structure (WBS) list, and the project Gantt chart. The console also integrates with Live Feed so your users can collaborate on projects.

Sections in the planning console

The planning console is divided into the following sections:

- A list of the project tasks if you open the planning console for a project.
- The Gantt chart.
- Banner icons and lists for performing tasks on the console.
Example planning console

For more information on the Gantt chart and the task relationships and dependencies that you can build, see Gantt chart and Project task relationships and dependencies.

Note: The resources in the Assigned to column of the planning console can be constrained to be derived only from the allocated resource plans associated to the project or any of its tasks. The Derive assignee list from resource plan field controls the behavior on the project form.
Business rules

By default, the business rules are not triggered during an operation in the planning console. You can enable the business rules using the **Enable firing of Business Rules** property.

![Note](image)

**Note:** To enable this property, you must clear the **Enable Client Side Planning** check box.

You can also enable business rules when defining the columns for planning console using the **Fire BR on Save** field.

Client side planning console

Build your project structure quickly on the client side without having to save details in the server for each interaction in planning console. Enabling **Client side planning console** prevents any time lags that occur after you perform any actions in planning console, and improves the scheduling performance.

Automatic and manual projects

In an **automatic** project, any change to the dates, duration, or relationships of a project task automatically updates all the tasks in the entire project, including the project record, as necessary. The automatic project icon ( ) appears adjacent to the project name.

In a **manual** project, changes to the dates, duration, or relationships of a project task do not automatically update all tasks. So parent task dates do not reflect any changes made to dependents or child tasks. The only change that is made automatically is when a task date or duration change updates dates and duration of the project record. In a manual project, any update to actual start date does not update the planned end date of the project or project task. However, enabling the project property **Enable alter of planned date with Actual for Manual Project** updates the planned end date from actual start date and planned duration. The manual project icon ( ) appears adjacent to the project name.

You can specify if a project is automatic or manual in the **Calculation** field on the Project form. This field becomes read-only when the project starts.

Tutorial

A tutorial walk through is available in the console. It shows you all the features of the console and how to use them. Access the walk through within the help icon ( ).

Open the project planning console

Access the planning console to perform the planning for the project.

Role required: it_project_manager

- Open the planning console using any of the following methods:

<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>From project workspace</td>
<td>1. Open a project record in <strong>project workspace</strong>.</td>
</tr>
<tr>
<td></td>
<td>2. Click the <strong>Planning</strong> tab.</td>
</tr>
<tr>
<td>Option</td>
<td>Steps</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------</td>
</tr>
<tr>
<td>From a project record</td>
<td>1. Navigate to a project record in Details tab in project workspace.</td>
</tr>
<tr>
<td></td>
<td>2. Click the Planning Console related link.</td>
</tr>
<tr>
<td>From Project Workbench</td>
<td>1. Click the Project Workbench selection arrow on the workbench banner.</td>
</tr>
<tr>
<td></td>
<td>2. Select Planning Console from the list.</td>
</tr>
</tbody>
</table>

**Planning console tasks**

You can perform several tasks on the planning console that you can perform on lists and forms, such as creating project tasks and copying projects. You can also perform several tasks unique to the console.

**Planning console tasks**

<table>
<thead>
<tr>
<th>Task</th>
<th>How to perform the task</th>
</tr>
</thead>
<tbody>
<tr>
<td>General console settings</td>
<td></td>
</tr>
<tr>
<td>Display a project in the planning console</td>
<td>Select the project from the choice list in project workspace banner.</td>
</tr>
<tr>
<td>WBS hierarchy</td>
<td></td>
</tr>
<tr>
<td>Create a project task</td>
<td>Click the add task below icon (➕) on the row to create a new task.</td>
</tr>
<tr>
<td></td>
<td>You can also click an existing task to determine the insertion point</td>
</tr>
<tr>
<td></td>
<td>for the new task, and then click the add task above icon (➖) or the</td>
</tr>
<tr>
<td></td>
<td>add task below icon (➕).</td>
</tr>
<tr>
<td>Move a task up or down in the hierarchy</td>
<td>Click an existing task, and then click the move up (↑) or move down (↓) icons.</td>
</tr>
<tr>
<td>Task</td>
<td>How to perform the task</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Indent or unindent a task in the hierarchy</td>
<td>Click an existing task, and then click the unindent (←) or indent (→) icons.</td>
</tr>
<tr>
<td>Edit a task record</td>
<td>Right-click a task and select <strong>Edit</strong>. The Project Task form appears in the overlay. You can also edit a field directly in one of the columns in planning console. You can also edit project tasks that represent phases in the project workbench.</td>
</tr>
<tr>
<td>Edit the <strong>State</strong> field</td>
<td>Double-click the value in the <strong>State</strong> column to select a new state. The value of the <strong>State</strong> field also changes automatically when % complete is changed for a task.</td>
</tr>
<tr>
<td>Add an agile phase or a test phase</td>
<td>Right-click a project and select <strong>Add Agile Phase</strong> or <strong>Add Test Phase</strong>. The agile phase icon or test phase icons appear next to the task in the <strong>Name</strong> column. See phase icons.</td>
</tr>
</tbody>
</table>

**Note:**
- The **Add Agile Phase** option is available only for Agile and Hybrid projects. You must also have the Agile Development 2.0 plugin installed.
- You can add multiple agile phases and multiple test phases to a project.
- You can add only one test phase for a test plan in a project. You must have the Test Management plugin installed to view the **Add Test Phase** option.
- An agile phase cannot overlap another agile phase for an assignment group in a project.
- While creating a story, if a project has only one phase, the story is tagged to the phase.

| Open a test plan or story                     | Right-click a task (a task that represents a phase in the workbench) and then select **Manage Test Plan**. Select **View Stories** to view the stories list. If you have the scrum_product_owner role, select **View Stories** to navigate to the **Backlog** tab of the **Agile Board**. |

**Note:** The **View Stories** option is available only for Agile and Hybrid projects. You must also have the Agile Development 2.0 plugin installed.
<table>
<thead>
<tr>
<th>Task</th>
<th>How to perform the task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel a resource plan for a Closed project</td>
<td>Right-click the project and select <strong>Cancel Resource Plans</strong>. All past and future allocations for the selected resource plan are canceled. The option is available only for a project in any of the Closed state.</td>
</tr>
<tr>
<td>Complete a resource plan for a Closed project</td>
<td>Right-click the project and select <strong>Complete Resource Plans</strong>. All the requested and resource allocations for the resource plan post the completion date are deleted. The option to complete resource plans is available only for a project in any of the Closed state.</td>
</tr>
<tr>
<td>Add an external dependency between tasks of different projects</td>
<td>Right-click a task and select <strong>Add External Dependency</strong>. Select the project and task to which the dependency is added.</td>
</tr>
<tr>
<td>View the project name of external dependency</td>
<td>Point to the link icon (🔗) beside the external dependency task to display a hint which shows the name of the project to which the external dependency is added.</td>
</tr>
</tbody>
</table>
| Change time constraint for a task | Double-click a task under the **Constraint type** column and select **Start ASAP**, **Start on specific date**, **Start no earlier than**, or **Start no later than**.  
  • You can change the **Constraint type** for Automatic projects only.  
  • When you change the time constraint for a task from **Start on specific date** to **Start ASAP** or vice versa, the planned start date and planned end date of the task are recalculated accordingly.  
  • The option is not available for a parent task. If a task has child tasks, the option is available only for the child tasks.  
  • The **Constraint date** column displays the start date for all the constraint types other than **Start ASAP** tasks. This column is not available by default, you must add this column to the Planning Console.  
  • You cannot create a parent task with **Start no later than** or **Start on specific date** time constraint. When a new child task is added to a task with these time constraints, the time constraint for the parent task is converted to **Start ASAP**.  
  • You cannot change constraint type for projects with **Calculation** type set as Manual. |
<table>
<thead>
<tr>
<th>Task</th>
<th>How to perform the task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow task dates outside schedule</td>
<td>Right-click a project task and select <strong>Allow outside schedule</strong>. The selected task is allowed to start and end on a non-schedule day (outside regular project schedule) such as on a weekend. The Off schedule task icon appears next to the task in the <strong>Short description</strong> column. For example, if you use the project schedule Monday to Friday, 8 am to 5 pm and a project task of duration 2 days should start on Saturday, then an off-schedule task is allowed to be scheduled on Saturday and end on Sunday. Similarly, if a task of duration 3 days starts on Friday, then an off-schedule will end on Sunday as opposed to ending on Tuesday.</td>
</tr>
<tr>
<td></td>
<td>• The option is not available for a parent task. When a task is made off-schedule, its parent also becomes off-schedule. The project also behaves as out of schedule if any of the children is set to out of schedule. • Once a task is allowed outside schedule, the right-click option <strong>Follow schedule</strong> is available for the task. Click <strong>Follow schedule</strong> to follow the schedule for the task.</td>
</tr>
</tbody>
</table>
|                                        | **Note:**  
|                                          | • There is no difference between an off-schedule and on-schedule task if there is no schedule defined at the project.  
|                                          | • 1 day is 8 hours for a task in regular schedule and 24 hours for a task outside schedule.  |
| Convert a task to milestone            | Right-click a task and select **Convert to milestone**.  
|                                        | • You can convert a task to a milestone only until it is not in **Work in Progress** state. Once work in progress, the option appears as greyed out for the task.  
<p>|                                        | • The option is not available for a parent task. If a task has child tasks, the option is available only for the child tasks.  |</p>
<table>
<thead>
<tr>
<th>Task</th>
<th>How to perform the task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show or hide external dependencies</td>
<td>Click the more options icon (***), and then click the Hide External Dependencies switch.</td>
</tr>
<tr>
<td></td>
<td>When this option is enabled, the external dependencies are not displayed when you add an external dependency between two projects. However, the Dependency column in WBS section of the successor project still shows the value of external dependency.</td>
</tr>
<tr>
<td>Task</td>
<td>How to perform the task</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>Show external dependency notifications</td>
<td>Click the notification bell icon to display the notifications raised in the successor project. The notifications are triggered as a result of changes made in the predecessor project.</td>
</tr>
<tr>
<td>Save changes to the server</td>
<td>Click the save icon to commit changes made in planning console. The option is available only when Client Side Planning Console is enabled.</td>
</tr>
<tr>
<td>Expand or contract column width</td>
<td>Click the side of the column and drag it right or left.</td>
</tr>
</tbody>
</table>

- For a **soft dependency**, click **Accept** or **Reject** to accept or reject the changes in the notification.
- For a **hard dependency**, view the displayed notification to review the changes in the notification.
<table>
<thead>
<tr>
<th>Task</th>
<th>How to perform the task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show or hide columns in the planning console</td>
<td>Click the show or hide columns in gantt icon ( ), and then select or clear the check boxes for the columns available. Admin can customize which columns appear in this list. The selection is saved in the user preference. The next time you open the planning console, the same columns you selected will appear.</td>
</tr>
<tr>
<td>Select WBS levels to show</td>
<td>Click the show or hide columns in gantt icon ( ), and then select the level from the WBS Depth choice list.</td>
</tr>
<tr>
<td>Expand or collapse sublevels for any level</td>
<td>Click the arrow to expand or collapse any task that has one or more subtasks.</td>
</tr>
<tr>
<td>Gantt chart</td>
<td></td>
</tr>
<tr>
<td>View a summary of a task</td>
<td>Hover over a task.</td>
</tr>
<tr>
<td>Change the planned start or end dates of a task</td>
<td>Click the task, and then drag the left or right edge of the task bar.</td>
</tr>
<tr>
<td>Move a task to a new date</td>
<td>Click the task, and then drag the whole task bar to a new location.</td>
</tr>
<tr>
<td>Create a dependency between tasks</td>
<td>Find the successor task in the relationship and double-click the value in the Predecessor column and enter a value that specifies the relationship. See Predecessor dependencies in the planning console for examples. Alternatively, you can create a relationship between two tasks by connecting the ends of the corresponding task bars in the timeline view.</td>
</tr>
<tr>
<td>Task</td>
<td>How to perform the task</td>
</tr>
<tr>
<td>--------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Select a baseline</td>
<td>Click the more options icon (⋯) and then select a baseline from the baselines choice list.</td>
</tr>
<tr>
<td>Create a baseline</td>
<td>Click the more options icon (⋯) and then click <strong>Create new baseline</strong>. See <strong>Create baseline of a project</strong> for more information.</td>
</tr>
<tr>
<td>Compare schedule baselines</td>
<td>Click the more options icon (⋯) and then select a schedule baseline from the baselines choice list. Click the show or hide columns in gantt icon (⚙️) and then select the following columns to compare schedule baselines:</td>
</tr>
</tbody>
</table>
|                          | • Baseline start date  
                              | • Baseline end date  
                              | • Baseline variance                                                                                                                      |
| Display the critical path | Click the critical path icon (⚠️). See **Gantt chart** for more information on the critical path.                                                                                                                       |
| Show date change         | Click the more options icon (⋯) and then click the **Show Date Change** switch. When this option is enabled, the start and end dates of the task are displayed when you drag the task bar. |

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Task</th>
<th>How to perform the task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show duration change</td>
<td>Click the more options icon (***), and then click the <strong>Show Duration Change</strong> switch. When this option is enabled, the duration of the task is displayed when you drag either end of the task bar.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="1 days" /> ○  Thr, 4th Dec</td>
</tr>
<tr>
<td>Show weekends on the calendar</td>
<td>Click the more options icon (***), and then click the <strong>Show Weekends</strong> switch. The weekends appear as light-blue vertical bars in the Gantt chart.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Weekend" /></td>
</tr>
<tr>
<td>Task</td>
<td>How to perform the task</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Zoom the calendar in or</td>
<td>On the top of the calendar, click one of the time periods, such as the month, or day, and so on. Then select a <strong>Zoom Level</strong> from the calendar.</td>
</tr>
<tr>
<td>out</td>
<td></td>
</tr>
<tr>
<td>Open the tutorial</td>
<td>Click the more options icon (***), and then click <strong>Walkthrough</strong>.</td>
</tr>
<tr>
<td>Open list of keyboard</td>
<td>Click the more options icon (***), and then click <strong>Keyboard Shortcuts</strong>.</td>
</tr>
<tr>
<td>shortcuts</td>
<td></td>
</tr>
<tr>
<td>Other features or applications</td>
<td>Click the <strong>Planning Console</strong> selection arrow on the banner and select <strong>Project Workbench</strong>. For more information, see <strong>Project workbench</strong>.</td>
</tr>
<tr>
<td>Open the project workbench</td>
<td></td>
</tr>
<tr>
<td>Task</td>
<td>How to perform the task</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Open live feed</td>
<td>Click the more options icon &lt;br&gt;and then click <em>Show live feed.</em></td>
</tr>
<tr>
<td>Export project data in MPP, CSV, or XML format</td>
<td>Click the more options icon &lt;br&gt;and then click <em>Export Planning Console.</em> For more information, see <em>Export project data.</em></td>
</tr>
<tr>
<td>Print the gantt timeline</td>
<td>Click the <em>...</em> icon &lt;br&gt;and then click <em>Print.</em></td>
</tr>
</tbody>
</table>

**Note:**
- Printing on a smaller paper size may result in the gantt chart image being cut off. You may either zoom out using the gantt chart calendar, or increase paper size to print the gantt timeline for projects and tasks.
- If the colored bars in gantt chart area are not visible in Print preview, then select the option for background graphics in the Print dialog.

**Client side planning console**

During calculation of project schedule in the planning console, it is possible to build your project structure quickly on the client side (browser) without having to save details in the server for each interaction. It prevents any time lags that occur after you perform any actions in the planning console, and improves the scheduling performance.

For example, when a project manager changes dates on a project task in the planning console, recalculating the dates for the dependent tasks and the project can cause time lag if each interaction is saved to the server. Similarly, when a new task or a dependency is created, there can be a time lag before the new dates are displayed if they are saved on the server side each time.

When client side planning is enabled, the changes such as re-calculation of dates are not posted to the server immediately. All the changes in planning console are kept on client side until the user explicitly saves the changes to be committed to the server.

**Exceptions**

There are a few actions for which you must save your changes immediately to the server side before proceeding such as:
- Create baseline
- Copy project
- Copy partial project
- Add child tasks
- Add external dependency
- Edit Assigned to
- Edit Additional Assignees

In addition, if you enable custom business rules on any of the columns, those columns are also part of exceptions.

*Enable client side planning*
Enable client side planning in planning console to enable project scheduling at the client side.

Role required: pps_admin

Build your project structure quickly on the client side without having to save details in the server for each interaction in planning console.

1. Navigate to **Project Administration > Settings > Planning Console**.
2. In the Planning Console list, expand **Context: default** and select **Project[pm_project]**.
3. Select the **Enable Client Side Planning** check box to enable project scheduling at client side.

**Note:** To enable this check box, the project property **Enable firing of Business Rules on save from Planning Console** must be set to false.

**Gantt chart**

A Gantt chart on the planning console is a visual representation of a project timeline that shows start and end dates of tasks, and the dependencies between tasks.

Use Gantt charts to add and delete tasks, change task dates and dependencies, and assess the progress of the overall project.
Gantt charts

The critical path

The critical path is highlighted in red on the Gantt chart to differentiate critical path tasks from standard tasks in blue. Not all tasks are part of the critical path, only those tasks that directly affect the finish date. Use the critical path to determine which tasks are driving the finish date. If schedule adjustments are necessary, consider making resource or other changes to those tasks on the critical path.

The tasks that are not part of the critical path and can therefore be delayed are commonly called slack or float tasks. The Gantt chart shows the slack/float tasks by default, but calculations that deal with these tasks, such as how long they can be delayed without impacting the project, is not available.

Milestones

A milestone is a project task with a duration of 0. Use milestones to indicate important dates in a project. If necessary, create dependencies between tasks and milestones so that a task does not start until a milestone has been reached.
Color coding

The colors of the task bars on the Gantt chart are based on the percent complete and state of the task. The default color coding available for project and tasks is shown:

**Color coding of project tasks**

<table>
<thead>
<tr>
<th>Color</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Light blue bar</td>
<td>Task is pending or open.</td>
</tr>
<tr>
<td>Dark blue bar (full or partial)</td>
<td>The percentage complete is between 1% and 100%. The dark blue section indicates the percentage complete. The task can be in the Work in Progress state or Completed state.</td>
</tr>
</tbody>
</table>

**Note:** The colors of the task bars on the Gantt chart can be configured from portfolio or program workbench.

SDLC phases

Icons appear next to tasks to indicate what phase they belong to.

**Phase icons**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Phase</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄</td>
<td>Agile phase.</td>
</tr>
<tr>
<td>🔍</td>
<td>Testing phase.</td>
</tr>
</tbody>
</table>
Note: Tasks in the waterfall phase do not display an icon.

**Gantt chart options**
Use the Gantt chart to quickly change task attributes, such as start and end time, rather than opening every Task form and modifying field values one by one.

From a Gantt chart, you can modify the following task attributes:

### Modify tasks

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planned start date for project tasks</td>
<td>Move the task along the timeline to change the start time and to impose a <strong>Time constraint of Start on a specific date</strong>. You can also drag a task to change its start date if the task <strong>Time constraint</strong> is set to <strong>Start on a specific date</strong> (not <strong>Start ASAP</strong>) and the task has not yet started. The start date of a task cannot be modified if the task already started (has an actual start date), the task has already ended (has an actual end date), or the task time constraint is set to <strong>Start ASAP</strong>. You can also modify the dates in the Planned start date column on the console.</td>
</tr>
<tr>
<td>Planned start date for the project</td>
<td>Modify the dates in the Planned start date column on the console.</td>
</tr>
<tr>
<td>Planned end date</td>
<td>Drag the right edge of the task bar to extend the planned end date. You can extend the planned end date only for tasks that are not parent tasks and that have not yet ended.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>To edit or delete a dependency, double-click an existing dependency connector line between two tasks and update the settings in the Planned Task Relationship popup. The relationship Type for planned tasks is <strong>Predecessor of::Successor of</strong> and should not be changed.</td>
</tr>
<tr>
<td>Attribute</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Lag time and lead time | *Lag time* is an interval of time between the end of a predecessor task and the start of a successor task. The lag time delays the predecessor by an amount that you specify.  
*Lead time* is an interval of time that the predecessor task is allowed to start before it normally would. It is essentially a negative lag time. The value in the *Lag* field specifies both lag and lead time.  
To edit the *Lag* value, double-click a connector and update the settings in the Planned Task Relationship form. Enter a negative value to specify a lead time. |
| Resources              | To change a user resource for an existing task or add a resource to a new task, double-click the task bar and edit the *Assigned to* field in the Project Task form.                                                                 |

The Project Management application provides several properties that control how tasks are calculated and behave. See *Project property* for more information.

**Create a parent-child relationship on the planning console**

The WBS section of the planning console allows you to create parent-child relationships for new tasks or move around existing tasks in a new parent-child relationship. The position of a task in the hierarchy and the level of indentation determine the parent-child relationship it has with the tasks above or below it.

Role required: it_project_manager

In this example, the System Readiness Assessment task is a child of the Planning task because it is one level below the Planning task and is indented.

1. Click a task in the WBS section of the planning console to highlight it.
2. Click a combination of any of the following icons to create the task and move it or move the other tasks to create the required hierarchy:

### Creating parent-child relationships

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Add task above icon" /></td>
<td>Create a task above the highlighted task.</td>
</tr>
<tr>
<td><img src="image" alt="Add task below icon" /></td>
<td>Create a task below the highlighted task.</td>
</tr>
<tr>
<td><img src="image" alt="Indent icon" /></td>
<td>Makes the highlighted task a child of the task above it.</td>
</tr>
</tbody>
</table>

### Predecessor dependencies in the planning console

In the WBS section of the planning console, you can create dependencies between tasks by specifying a series of values.

The **Predecessor** column on the planning console can specify dependencies between tasks. The values that you put in this column must be in the following format:

\( \{\text{WBS\_number}\}\{\text{dependency\_type}\}+\{\text{lag\_time}\} \)

Where

- **WBS\_number** is the number of the predecessor task in the relationship.
- **dependency\_type** is one of the types of dependencies that the application supports.
- **lag\_time** is the amount of time, in days, to delay the start of the dependent task. This value can be positive or negative integers.

The values are entered without the curly braces { }. See the examples in the table.

**Note:** You can also edit tasks from the Gantt chart by clicking the relationship line. See Gantt chart options and Modify a project task dependency for details.

### Project task dependency values

<table>
<thead>
<tr>
<th>Dependency type</th>
<th>Example</th>
<th>Additional information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Finish to start</td>
<td>1.1fs+0</td>
<td>The task you are editing starts when task 1.1 is finished.</td>
</tr>
<tr>
<td>Start to start</td>
<td>1.1ss+0</td>
<td>Task 1.1 cannot finish until the task you are editing finishes.</td>
</tr>
<tr>
<td>Start to finish</td>
<td>1.1sf+0</td>
<td>Task 1.1 cannot start until the task you are editing finishes.</td>
</tr>
<tr>
<td>Finish to finish</td>
<td>1.1ff+0</td>
<td>The task you are editing cannot finish until task 1.1 finishes.</td>
</tr>
</tbody>
</table>

### Custom columns in the planning console

In addition to the regular columns that are provided in the base system, as the PPS admin, you can configure which columns appear in the planning console.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
You can define the columns that are available in the project planning console, program workbench, planning and tracking views in portfolio workbench, and the release management Gantt chart. From this list of defined columns, you can select the columns that you want to view in these planning console UIs at any time.

These tables are used for custom column configuration:

- **Planning Console [pm_console]**: Stores the definition for planning consoles such as Project and Portfolio.

- **Planning Console Display Column [pm_console_display_column]**: Stores the planning console display columns such as Short Description, WBS, and Priority.

  A console stored in [pm_console] has multiple display columns that are stored in [pm_console_display_column].

- **Planning Console Table [pm_console_table]**: Contains a list of tables which provide data to a console.

  A console sources the data from multiple tables. For example, Project console [pm_project] pulls data from pm_project and pm_project_task table. This list of tables is maintained in [pm_console_table].

- **Planning Console Column [pm_console_column]**: Maintains the columns that should be pulled from each table and the mapping of the column in pm_console_display_column.

**Add a custom column to the planning console**

Define the columns that you want to make available in the project planning console, portfolio workbench, program workbench, and the release management Gantt chart.

Role required: it_pps_admin

1. Navigate to **Project Administration > Settings > Planning Console**.
2. Add a custom display column for planning console.
   a) In the Planning Console list, select a console to which you want to add the custom column. For example, select **Project [pm_project]** to add a column to the project planning console.
   b) To create a display column for the selected console, click **New** in the **Planning Console Display Column** related list.
   c) On the Planning Console Display Column form, fill in the fields.

### Planning Console Display Column form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Label for the column to be displayed in the planning console.</td>
</tr>
<tr>
<td>Type</td>
<td>Data type of the column.</td>
</tr>
<tr>
<td>JSON Column</td>
<td>The JSON column name used internally by the Gantt chart when data is sent.</td>
</tr>
<tr>
<td>Order</td>
<td>Position at which the column appears in the planning console.</td>
</tr>
<tr>
<td>Include in Tooltip</td>
<td>Check box for the column to be shown in tooltip in timeline in the planning console.</td>
</tr>
</tbody>
</table>

Note: Leave blank. This field is auto-populated when you add a column for the display column in step 3.
### Field Table

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>Default width of the column in planning console.</td>
</tr>
<tr>
<td>Fire BR on Save</td>
<td>Option if the business rules should be triggered when the column is modified in the planning console.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The field is not visible on the form by default. Configure the form to add this field.</td>
</tr>
<tr>
<td>Trigger recalculation</td>
<td>Option if the recalculation of date and duration should be triggered when the column is modified in the planning console.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The field is not visible on the form by default. Configure the form to add this field.</td>
</tr>
</tbody>
</table>

### Instructions

**d)** Click **Submit**.

The column is added in the **Planning Console Display Column** `[pm_console_display_column]` table.

**3.** Map the planning console display column created in step 2 to a column in a table defined in **Planning Console Table** `[pm_console_table]`.

a) In the **Planning Console Display Column** related list, open the display column record.

b) To create a record of actual column in the **Planning Console Column** `[pm_console_column]` table, click **New** in **Planning Console Columns** related list.

c) On the **Planning Console Column form**, fill in the fields.

#### Planning Console Column form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Column</td>
<td>Display column created in the <strong>Planning Console Display Column</strong> <code>[pm_console_display_column]</code> table.</td>
</tr>
<tr>
<td>Console Table</td>
<td>Console table to be mapped to the display column.</td>
</tr>
<tr>
<td>Table</td>
<td>Actual table from where the data is pulled in the display column. The field is auto-populated when you select a Console Table. For example, select a table from <code>[pm_project]</code> or <code>[pm_project_task]</code> for a display column added in the Project planning console Project <code>[pm_project]</code>.</td>
</tr>
<tr>
<td>Column</td>
<td>Actual column in the <strong>Table</strong> from where data comes for the display column.</td>
</tr>
</tbody>
</table>
d) Click Submit.

The display column appears in the column filter list ( ) in the planning console.

### Project Diagnostics

Project Diagnostics enables you to detect corrupt data in a project such as task validity, dependencies, and relationships using diagnostic scans that execute diagnostic scripts. You can also fix corrupt data using fix scripts.

Data might become corrupt or invalid for various reasons, such as:

- Incorrect field mapping during project import
- Incorrect scheduling of tasks
- Incorrect dependency and relationship definitions

Project Diagnostics uses diagnostic scans and fix scripts to detect and fix corrupt data in your projects. It enables you to do the following action:

- Create and add diagnostic features
- Add diagnostic and fix scripts to fix corrupt or invalid project data
- Create Diagnostic scans and map related scripts
- Define fields for users to create specific filter conditions. The diagnostic scripts use the results of these filter conditions as input for detecting any corrupt or invalid data.

Project Diagnostics page provides the default scans described in the following table.

#### Project Diagnostics default scans

<table>
<thead>
<tr>
<th>Diagnostic Scan Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tasks with invalid top task</td>
<td>Lists the tasks that have an invalid top task. A task is considered to have an invalid top task if the value for the top task is set to Null or is mapped to a different task in the hierarchy.</td>
</tr>
<tr>
<td>Tasks with invalid top portfolio</td>
<td>Lists the tasks that have an invalid top portfolio. A task is considered to have an invalid top portfolio if it belongs to a different portfolio or is not associated with any portfolio.</td>
</tr>
<tr>
<td>Tasks with invalid top program</td>
<td>Lists the tasks that have an invalid top program. A task is considered to have an invalid top program if it belongs to a different program in the same portfolio or is not associated with any program.</td>
</tr>
<tr>
<td>Invalid relations</td>
<td>Lists the invalid relations in a project. A relation is considered to be invalid if the predecessor or successor is not a part of the project (unless it is an external relation), or if the predecessor or successor record does not exist in the system.</td>
</tr>
<tr>
<td>Validate parent tasks</td>
<td>Lists the tasks that have empty or invalid parents.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Diagnostic Scan Name | Description
--- | ---
Check for tasks with cyclic dependencies | Checks for any cyclic relations, which are not permitted, in a project. For example, suppose you have a project in which Task A is related to Task B. A reverse relation from Task B to Task A would be considered a cyclic dependency.
Recalculate project | Recalculates task dates in a project. **Warning:** Performing this action might change the dates in a project.
Check duplicate/redundant relationships | Lists tasks that have duplicate or redundant relations in the selected projects.
Cost plans with no start and end fiscal period | Checks and lists cost plans with no start and end fiscal period within the selected projects.
Validate project task constraints in project | Lists all tasks with invalid constraint types. For example, a task with Start no later than set as a parent or the **Constraint date** field is empty for a task with Start no earlier than and Start no later than constraint.
Validate tasks with invalid state | Lists all tasks with invalid WIP or Closed state based on actual dates.

**Use Project Diagnostics to detect corrupt project data**

Project Diagnostics uses the Application Diagnostics Tool to detect corrupt data in a project, such as tasks with invalid parents, tasks without top tasks, and invalid or cyclic relations in a project.

Role required: it_pps_admin

Project Diagnostics can also detect whether date calculations in a project appear to be incorrect, the planning console does not open for a project, or a few tasks or relationships do not appear in the planning console.

1. **Determine whether you want to run a diagnostic scan on a single project or multiple projects.**

<table>
<thead>
<tr>
<th>Scope</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>All Projects</strong></td>
<td>• Navigate to <strong>Project Administration &gt; Project Diagnostics.</strong></td>
</tr>
</tbody>
</table>
| **Single Project** | a. Navigate to **Project > Projects > All.**  
  b. Select the project.  
  c. On the Project form, click the **Project Diagnostics** related link. |

2. **On the Application Diagnostics Tool page, select a diagnostic feature.**

3. **Use the Feature Inputs fields to specify filter conditions.**

4. **From the **Diagnostics** section, run a single diagnostic scan or multiple scans on the projects matching the filter criteria.**

<table>
<thead>
<tr>
<th>Task</th>
<th>Steps</th>
</tr>
</thead>
</table>
| **Run multiple diagnostic scans** | a. Select the diagnostic scans that you want to run on the filtered projects.  
  b. Click **Run Diagnostics** at the top-right corner of the page. |
Run a specific diagnostic scan

- a. Select the single diagnostic scan that you want to run on the filtered projects.
- b. Click Run Diagnosis.

5. View the results of the scans.

Add your own diagnostic scans and fix scripts.

Create and add diagnostic features

Create and add diagnostic features, which consist of single or multiple diagnostic scans that execute mapped scripts to detect data corruption or invalid data.

Role required: adt_admin

1. Navigate to Application Diagnostics Tool > Features.
2. Click New.
3. On the form, fill in the fields.

**Diagnostics Feature form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the diagnostic feature. This name appears in the application to which the diagnostic feature belongs.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for activating the diagnostic feature.</td>
</tr>
<tr>
<td>Application</td>
<td>Search for and select the application with which you want to associate this diagnostic feature.</td>
</tr>
<tr>
<td>Roles</td>
<td>User roles that allow access to the diagnostic feature.</td>
</tr>
</tbody>
</table>
4. Define the fields available to users for specifying filter conditions in the **Diagnostics Inputs** section.

**Diagnostics Input fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Name of the label for the input fields.</td>
</tr>
<tr>
<td>Field Type</td>
<td>The <strong>Reference</strong> field type.</td>
</tr>
<tr>
<td>Table</td>
<td>Name of the table on which the query specified in the condition should run.</td>
</tr>
<tr>
<td>Key</td>
<td>An identifier for the user input condition. If a user specifies multiple conditions, this key acts as a unique identifier for each condition. You can use this key as the input for the <code>scanContext</code> section of the diagnostic script. For example, if you specify <code>projectFilter</code> as a key, the <code>scanContext</code> section of the diagnostic script would appear as follows: <code>var encodedQuery = scanContext.input.projectFilter;</code></td>
</tr>
</tbody>
</table>

The fields that you configure in the **Diagnostics Inputs** section appear in the **Feature Inputs** section of the Application Diagnostics Tool page, as shown in the following example.

**Feature Inputs**

- **Select Source Project**
  - **Choose field**
  - **Choose field**

- **Select Project**
  - **Choose field**
  - **Choose field**

- **Select Portfolio**
  - **Choose field**

5. Click **Submit**.
Create diagnostic scripts and add fix scripts to use with the diagnostic feature. For more information, see Add diagnostic and fix scripts.

**Add diagnostic and fix scripts**

Add diagnostic scripts to scan the data in your application for any corruption. You can also attach fix scripts to rectify the corrupt or invalid data identified by the diagnostic script.

**Role required:** adt_admin

The results of the filter conditions that you specify in a diagnostic feature are used as an input for the diagnostic script while executing. You can also use the result of one script in subsequent scripts.

1. Navigate to Application Diagnostics Tool > Scripts.
2. Click New.
3. On the form, fill in the fields.

**Diagnostic Scripts form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the diagnostic script. Use a name that clearly explains the objective of the script. The script name also enables you to identify the correct script while mapping the script to a feature when creating a diagnostic scan.</td>
</tr>
<tr>
<td>Description</td>
<td>Details describing the actions of the diagnostic script.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Diagnostic script</td>
<td>The code for the diagnostic script. The following example shows a diagnostic script to identify tasks with an invalid top portfolio.</td>
</tr>
</tbody>
</table>

```javascript
/*
- Inputs can be accessed from scanContext.input as per, the key specified in feature input table.
  eg. scanContext.input.projectSysID
- To pass variables from the one script to another script use varSpace in scanContext.
  eg. scanContext.varSpace.variable1 = '...';
*/
(function(scanContext) {
  try {
    var errorTasks = [];
    var encodedQuery = scanContext.input.projectFilter;
    var now_GR = new GlideRecord("pm_project");
    now_GR.addEncodedQuery(encodedQuery);
    now_GR.query();
    while (now_GR.next()) {
      var entitySysID = now_GR.getValue("sys_id");
      var projectData = new ProjectData(entitySysID);
      var projectTopTaskValidator = new ProjectTopTaskValidator(projectData);
      if (projectTopTaskValidator.tasksWithInvalidTopPortfolioPresent()) {
        var failedTasks = projectTopTaskValidator.getTasksWithInvalidTopPortfolio();
        if (failedTasks && failedTasks.length) {
          for (var i = 0; i < failedTasks.length; i++) {
            errorTasks.push(failedTasks[i].sys_id);
          }
        }
      }
```
4. Optional: Include a script for fixing the corrupt or invalid data identified by the diagnostic script.
   a) Select the Has Fix script check box.
   b) Click the Edit User Roles icon ( ) and choose the roles that can access the diagnostic script.
   c) In the Fix script section, add the code for the fix script.

5. Click Submit.

Create Diagnostic scans and map related scripts

Once you have created diagnostic features and scripts, map them to a diagnostic scan to check the health of data in your application. Use fix scripts to rectify any corrupt or invalid data that the diagnostic scan identifies.

In order to create a diagnostic scan, you must have already created diagnostic features and scripts. For more information, see Create and add diagnostic features and Add diagnostic and fix scripts.

Role required: adt_admin

You can map multiple scripts with each diagnostic scan and define the order of their execution.

1. Navigate to Application Diagnostics Tool > Diagnostics.
2. Click New.
3. On the form, fill in the fields.

### Diagnostics form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the diagnostic scan. This name appears in the application to which this diagnostic scan belongs.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for activating the diagnostic scan.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which this diagnostic scan appears in the application.</td>
</tr>
<tr>
<td>Feature</td>
<td>Diagnostic feature with which you want to associate this diagnostic scan.</td>
</tr>
<tr>
<td>Roles</td>
<td>Option for adding or removing user roles that can access the diagnostic scan.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Description</td>
<td>Details of the diagnostic scan. The description is displayed in the application to which the diagnostic scan belongs.</td>
</tr>
</tbody>
</table>

4. Click the Roles icon (🔗) and move the desired roles to the Selected list. The users with the selected roles can access the diagnostic script.

5. Search for and select diagnostic scripts to map with the diagnostic scan in the Diagnostics and Script Mappings section.

6. Click Submit.

- Create related link for navigating to the diagnostic features and scans in the application. For more information, see Create a UI action.
- Run diagnostic scan and view results. For an example of how the diagnostics scan work, see Use Project Diagnostics to detect corrupt project data.

**Work breakdown structure (WBS)**

The work breakdown structure (WBS) is a hierarchical representation of all the tasks in your project.

Use the WBS to get a quick overview of the entire project, including the tasks and subtasks nested in the project. The Gantt chart gives you a similar overview using graphical elements like lines and bars to show dependencies and lengths of tasks. The WBS is more data-driven, presenting a wide variety of task information in expandable rows.

You can view the WBS on the planning console, or as a related list on the Project or Project Task form. See Open the project planning console or Access the WBS as a related list.

When the WBS is viewed as a related list on the Project or Project task form, several important columns from the table appear by default.
### Important columns

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WBS</td>
<td>The number of the task in the WBS hierarchy. The first task in the hierarchy is assigned the number 1. Subtasks increment the number in the tenth place, such as 1.1 and 1.2. The numbers are read-only.</td>
</tr>
<tr>
<td>WBS Order</td>
<td>A number that represents the task in relation to its parent. The first subtask under a task has an WBS Order of 1, and the next task 2. If you edit a number, all tasks are moved accordingly after you refresh the list.</td>
</tr>
<tr>
<td>Number</td>
<td>The task ID number, which should not be changed.</td>
</tr>
</tbody>
</table>

Other useful information also appears by default, such as the description and percentage complete. You can personalize the list like any other list by clicking the personalize list icon and selecting the columns you want to view.

### Access the WBS as a related list

You can view the WBS as a related list on both the Project and Project Task forms.

**Role required: it_project_manager**

You can view the full WBS list by navigating to a Project form and clicking the Planning Console related link. See Planning console tasks for a list of the things you can do with the WBS on the planning console.

You can also view the WBS as a related list on the Project or Project Task form.

1. Navigate to a Project or Project Task form.
2. Right-click the header and select **View > WBS**.
   
   WBS List appears as a related list.
3. On the WBS, click the arrow icon to expand a task and view child tasks.

![Demo Project WBS](image)

**Teamspaces**

A *teamspace* appears as an application in the instance application navigator. The teamspace includes module links that come from the Project Portfolio Management applications, such as the Project, Idea, Demand, Program and Portfolio applications.

Use teamspaces to provide functional and data separation of these applications between different teams in your organization. The following is an example teamspace for a marketing team:

![Marketing TeamSpace](image)
Teamspace activation

You must activate a teamspace plugin to use the teamspace feature. Following teamspace plugins are available:

- Project Management TeamSpace 1 (com.snc.ppm_teamspace_1)
- Project Management TeamSpace 2 (com.snc.ppm_teamspace_2)
- Project Management TeamSpace 3 (com.snc.ppm_teamspace_3)
- Project Management TeamSpace 4 (com.snc.ppm_teamspace_4)
- Project Management TeamSpace 5 (com.snc.ppm_teamspace_5)

The teamspaces loaded with these plugins contain the same components, but the components have different prefixes. For example, teamspace 1 includes a project table named Teamspace_1 Project [tsp1_project] and teamspace 5 includes a project table named Teamspace_5 Project [tsp5_project].

You can enable any or all of these teamspaces and assign the teamspace specific roles to relevant users in the group that should use the teamspace.

Teamspace customization

You can customize the Project and Demand portions of a teamspace without affecting other teamspaces. This table summarizes what you can customize:

<table>
<thead>
<tr>
<th>Customization to Project or Demand within a teamspace</th>
<th>Supported?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data model changes, such as adding a field to the Project or Demand form.</td>
<td>Yes</td>
</tr>
<tr>
<td>Changes to business rules, UI actions, UI policies, security rules, data policies, and workflows.</td>
<td>Yes</td>
</tr>
<tr>
<td>Changes to shared roles, such as project_manager, demand_manager, and so on.</td>
<td>Yes</td>
</tr>
<tr>
<td>Form and list layouts, list controls, and related lists</td>
<td>Yes</td>
</tr>
<tr>
<td>Dictionary overrides</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Activate teamspaces

You can activate one or all teamspace plugins to use the teamspaces feature.

Role required: admin

You must activate a teamspace plugin to use the teamspace feature. Following teamspace plugins are available:

- Project Management TeamSpace 1 (com.snc.ppm_teamspace_1)
- Project Management TeamSpace 2 (com.snc.ppm_teamspace_2)
- Project Management TeamSpace 3 (com.snc.ppm_teamspace_3)
- Project Management TeamSpace 4 (com.snc.ppm_teamspace_4)
- Project Management TeamSpace 5 (com.snc.ppm_teamspace_5)

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

### Installed with teamspaces

The tables and roles that are installed with project teamspaces are prefixed with an abbreviation based on the name of teamspace.

### Tables

The tables are extended from the Project, Idea, and Demand base application tables.

#### Tables installed with teamspaces

<table>
<thead>
<tr>
<th>Tables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Idea [prefix_idea]</td>
<td>Stores ideas.</td>
</tr>
<tr>
<td>Demand [prefix_demand]</td>
<td>Stores demands.</td>
</tr>
<tr>
<td>Project [prefix_project]</td>
<td>Store projects.</td>
</tr>
<tr>
<td>Portfolio [prefix_portfolio]</td>
<td>Stores portfolios.</td>
</tr>
<tr>
<td>Project Task [prefix_project_task]</td>
<td>Stores project tasks.</td>
</tr>
<tr>
<td>Portfolio Goal [prefix_portfolio_goal]</td>
<td>Stores portfolio goals.</td>
</tr>
<tr>
<td>Portfolio Issues [prefix_portfolio_issue]</td>
<td>Stores portfolio issues.</td>
</tr>
<tr>
<td>Portfolio Project [prefix_portfolio_project]</td>
<td>Stores portfolio projects.</td>
</tr>
<tr>
<td>Project Template [prefix_project_template]</td>
<td>Stores project templates.</td>
</tr>
</tbody>
</table>

   **Note:** Project templates that are created in a teamspace area are not available in the main Project Management application any longer. They are only available to the teamspace in which they were created.

| Project Template Task [prefix_project_template_task] | Stores project template tasks. |
| Stakeholder Register [prefix_stakeholder_register]  | Stores the stakeholders.     |
| Program [prefix_pm_program]                          | Stores programs.             |
| Program Task [prefix_pm_program_task]               | Stores program tasks.        |

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Tables

<table>
<thead>
<tr>
<th>Program Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>prefix</code>pm_program_task project_status</td>
<td>Stories program task project status.</td>
</tr>
</tbody>
</table>

### Roles

#### Roles installed with teamspaces

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>prefix</code>demand_manager</td>
<td>Managers of the demand features for the teamspace.</td>
</tr>
<tr>
<td><code>prefix</code>demand_user</td>
<td>Users of the demand features for the teamspace.</td>
</tr>
<tr>
<td><code>prefix</code>project_manager</td>
<td>Managers of the project features for the teamspace.</td>
</tr>
<tr>
<td><code>prefix</code>project_portfolio_user</td>
<td>Users of the project portfolios for the teamspace.</td>
</tr>
<tr>
<td><code>prefix</code>project_user</td>
<td>Users of the project features for the teamspace.</td>
</tr>
<tr>
<td><code>prefix</code>program_manager</td>
<td>Managers of the program features for the teamspace.</td>
</tr>
<tr>
<td><code>prefix</code>portfolio_manager</td>
<td>Managers of the portfolio features for the teamspace.</td>
</tr>
</tbody>
</table>

The teamspace application uses the same **views** that are provided in the Project, Idea, and Demand base applications.

**Note:** Default client scripts that these base applications use are inherited by the extended tables in the teamspace application. If you created custom client scripts for any of the base applications, select the **Inherited** options on each Client Script form before you create the teamspace.

### Configure teamspace settings

Configure teamspace settings after you activate a teamspace plugin.

Role required: `it_pps_admin`

1. Navigate to **Project Administration > Settings > TeamSpaces.**
2. Click a teamspace name.
3. Change the teamspace name if necessary. Changing the name only changes the title that appears in the application menu. It does not modify the names of other components, such as table names or role names.
4. On the Tables, Roles, and Application Menu related lists, you can add or modify the tables, roles, and application modules for the teamspace.

The teamspace becomes available in the menu. The records that are assigned to the teamspace, such as projects, portfolios, demands, are automatically added to the teamspace.

Assign the teamspace roles to the users of that teamspace. Do not assign the general roles that come with the applications in the **Project Portfolio Suite.**
Project workbench

The project workbench provides a central location for creating and managing projects.

The workbench supports the Project Management and application life cycle management applications, allowing for a hybrid approach to project management. Project managers can create projects that combine both waterfall and agile methodologies and add waterfall, agile, and test phases to these projects.

The project workbench makes it easy to manage projects by presenting project information in two panes. The top pane displays a timeline with the project phases and milestones. The bottom pane displays details for the phase selected in the timeline. The project workbench provides real-time interaction between the timeline, the list view, and the visual task board.

The project workbench also supports the following features:

- **Project templates**: Project managers can quickly and easily create projects based on templates, which define the basic structure of a project.
- **Manual project calculation**: The workbench adds the capability of creating projects that use manual calculation. Project managers can also create auto calculation projects from the Project Management application.
- **Composite fields**: The field type combines information from two fields in a table to form a single field.

With the project manager role, you can use the project workbench to:

- Manage projects.
- Create and update project phases and milestones.
- Assign a group to an agile phase.
- Create and update project tasks, stories, and test cases.
- Attach test plans to a test phase.
- View and manage project details from a list view or visual task board.

The project workbench displays project information in two distinct areas. The top pane displays the project visualization, and the bottom pane displays phase details in a list view or visual task board. There is also a header above the workbench that includes several buttons and controls.

The project workbench scales to fit the available browser height. If necessary, scroll bars are added to display the workbench details.
Access the project workbench

Access the project workbench from the Project form or from the application navigator.

Role required: it_project_manager

- Access the project workbench in one of the following ways:

<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Planning Console</td>
<td>1. Open a project record in project workspace.</td>
</tr>
<tr>
<td></td>
<td>2. Click the Planning tab.</td>
</tr>
<tr>
<td></td>
<td>3. Click the Planning Console selection arrow on the banner and select Project Workbench.</td>
</tr>
</tbody>
</table>

| From a project record   | 1. Navigate to a project record in Details tab in project workspace.  |
|                         | 2. Click the Project Workbench related link.                          |

Note: If the project workbench opens with no associated sys_id or an incorrect sys_id, an error message appears. Select a project from the project choice list in project workspace banner.

Components of project workbench

The project workbench displays project information in two distinct areas. The top pane displays the project visualization, and the bottom pane displays phase details in a list view or visual task board. There is also a header above the workbench that includes several buttons and controls.

The project workbench scales to fit the available browser height. If necessary, scroll bars are added to display the workbench details.

Header

The header is a gray bar that runs across the top of the project workbench.

The first time a user accesses the project workbench from the Project menu, the header displays the following components:

After a project is opened, the header displays additional components, depending on the type of project selected:

- Back (←): takes the user to the Project form to view the project details.
- Select Project: displays the current project name. Click the down arrow to select a new project.
- Add phase icon (+): adds a phase or milestone to the timeline.
- Apply Template: opens a dialog box for setting a start date and adding a template to the project. This button appears for new or blank projects that have no phases.
- Manage Stories: under the Options icon (⋯) displays the story backlog for this project.
• **List:** under the Options icon ( ) displays additional details in list view about the currently selected phase. This button appears if a project has one or more phases.

• **VTB:** under the Options icon ( ) displays additional details in the Visual Task Board about the currently selected phase. This button appears if a project has one or more phases.

**Timeline**

The top pane of the project workbench displays the project timeline. The timeline uses monthly or quarterly markers to represent time. If the duration of a project is less than 500 days, these markers represent months and if the duration is greater than 500 days, these markers represent quarters.

The project timeline displays the following project information:

• Project name: the name assigned to the project. Point to the project name to see a message about the project date calculation method used for this project.

• Percentage complete: the percentage of the project that has been completed. This percentage is based on the duration and the percentage complete of the individual phases.

• Project start and end dates: the dates specified in the **Planned start date** and **Planned end date** fields for this project.

• Project phases: colored bars that represent the different phases of the project.

• Milestones: colored and dynamic circles on the timeline that represent important dates in the project life cycle.

**Phases in timeline**

A project phase is represented in the timeline by a horizontal bar. The bar is connected to the timeline by a thin vertical line that indicates the phase start date. The name of the phase appears just above the horizontal bar. Project phases are stacked in the timeline by start date, phase, and the earliest start date appearing at the top. If there are phases than can fit on the timeline, a scroll bar appears on the right side.

The color of the horizontal bar changes incrementally to reflect the completion percentage of the phase. The percentage completion is calculated based on the phase type:

• **Waterfall:** includes project tasks. The completion percentage is based on the number of project tasks that have been completed.

• **Agile:** includes stories. The completion percentage is based on the number of story points that have been completed.

• **Test:** includes test cases. The completion percentage is based on the number of test cases that have been completed.

The available phases depend on how Project Management is installed. When Project Management is installed as a standalone app, the project manager can only create and edit the Waterfall phase type. When Project Management is installed as part of the Project Portfolio Management (PPS), the project manager can create and edit all phase types (Waterfall, Agile, and Test).

When you point to a phase, the cursor changes from an arrow to a hand and a pop-up window displays the phase name and the start and end dates. Clicking a phase in the timeline displays the corresponding task information in the bottom pane of the project workbench.

**Note:**

• The **Add Agile Phase** option is available only for Agile and Hybrid projects. You must also have the Agile Development 2.0 plugin installed.
Milestones indicate important dates in a project and are represented along the timeline by colored circles. Three colors are available for milestones: green, yellow, and red. The project manager determines how the colors are used.

Pointing to a milestone changes the cursor from an arrow to a hand and displays a pop-up window with the short description and planned start date.

Click a milestone to update the milestone information. You can also drag a milestone along the timeline to change the date. Milestones can be dragged to any point on the timeline within the boundaries of the project start and end dates.

Detail view

The bottom pane of the project workbench displays detailed information for the phase currently selected in the timeline. The information displayed varies by the phase type selected:

- **Waterfall**: displays the project tasks associated with the phase.
- **Agile**: displays the stories assigned to the phase.
- **Test**: displays the test cases for the testing phase.

Information in the bottom pane can be displayed in list view or in a visual task board. The **List** and **VTB** buttons in the Project Workbench header control how this information is displayed.

Project calculation

When creating a project, the project manager can select the type of calculation to use: manual or automatic (default).

The project workbench displays help text that explains whether the current project is calculated automatically or manually. The help text appears when the project workbench page loads and also when the user points to the project name in the upper left corner.

For manual calculation:

- Dates on tasks do not automatically reflect any changes from dependent tasks.
- New projects created from the project workbench and projects created from demands are set to manual calculation by default. Projects created as manual can be changed to automatic.
- The project timeline reflects the earliest planned start date and latest planned end date based on the project tasks.
- The constraint type cannot be changed.
- Only **Start on specific date** constraint type is allowed for project tasks.

For automatic calculation:

- A task automatically reflects any changes from its dependent and child tasks.
- New projects created from the Project Management application are set to automatic calculation by default.
Project workbench actions

The project workbench allows project managers to manage all aspects of a project.

Open a project in the project workbench

The project manager can open an existing project in the project workbench.

Role required: it_project_manager

1. In the project workspace banner above the project workbench header, click the down arrow in the project selector box.
2. Select a project from the choice list.
   The selected project opens in the project workbench under Planning tab in project workspace.

Create a project task in the project workbench

Create a project task for a waterfall phase.

Role required: it_project_manager

While creating a project task in the project workbench, the time constraint type is defaulted based on the project type.

- For a manual project, the default constraint is Start On and cannot be changed.
- For an automatic project, the default constraint is Start ASAP and can be changed to Start On if required.
- When the constraint is Start ASAP, the Planned start date is disabled.
- When you create an agile phase and associate a sprint, the start date of the task is set from the sprint start date and the constraint becomes Start On automatically.

1. Click a waterfall phase in the project workbench timeline.
2. Click New in the detail view.
3. Fill out the Project Task form.
4. Click Submit.

Manage project stories in the project workbench

If Project Portfolio Management and Agile Development 2.0 are activated, the project manager can manage the stories in a project from the project workbench.

Activate Project Portfolio Management and Agile Development 2.0 plugins.

Role required: it_project_manager

Manage stories in your project using the Manage Stories option in the Project Workbench.

1. In the project workbench header, click the options icon ( ) and then click Manage Stories.
   The Backlog section of the Agile Board opens in a new tab.
2. Click a story to open the Story form in the pop-up window, or click New to create a new story.
3. Fill in the fields on the Story form.
4. Click Update or Submit.
Create a story in the project workbench
Create a story for an agile phase.

Role required: it_project_manager
1. Click an agile phase in the project workbench timeline.
2. Click New in the detail view.
3. Fill out the Story form.
4. Click Submit.

Create a test case in the project workbench
Specifying a test plan is optional when creating a test phase. However, before you add test cases to a test phase, you must specify a test plan.

Role required: it_project_manager
1. Click a test phase in the project workbench timeline.
2. Click New in the detail view.
3. Fill out the Test Case form.
4. Click Submit.

Investment Portal
Completing projects and demands on time within budget is a challenge. Investment Portal gives you a comprehensive view of project and demand financials, deadlines, and other important metrics in an intuitive user interface that makes project and demand management more efficient.

Tracking and managing your investments (both projects and demands) and then creating investment reports and sharing them through email is time consuming and inefficient. To generate a report you must obtain the status of projects and demands from project and demand managers, produce the report, and then email it.

With Investment Portal you can create an investment board through filter definition, and share it with other stakeholders. You can save time on new investments by creating, cloning, or modifying boards as needed. Filtering makes it easy to surface information on the fly and for reporting.

Here are a few examples showing how Investment Portal can make managing and reporting more efficient:

• If you are launching an application store, you can monitor overall program progress and surface projects that are creating bottlenecks.
• For a new business application you can review and edit the investment roadmap for the next few weeks, months, or years.
• For a key strategic initiative, you can review what was accomplished in the previous year and plan for the next eighteen months.

Investment Portal is divided into the following sections:

Banner icons
You can edit, copy, delete, bookmark, and share your investment board with other members and groups using the banner icons on the header of Investment Portal. See Track your key investments for more information.

Investment widgets
You can view important metrics like total cost, actual cost, and budget with investment widgets that can be configured.

Key tabs

You can track important aspects of your projects and demands in one location using the following tabs.

- **Overview**: A high-level summary of your projects and demands. The information in the grid is based on the project and demand form fields.
- **Timeline**: Key milestones in a Gantt view. Gantt view provides an overview of projects using graphical elements such as lines and bars to show dependencies and lengths of tasks.

  The Work Breakdown Structure (WBS) in the tab displays only key milestones.
- **Financials**: A detailed breakdown of project and demand costs in yearly, monthly, and quarterly formats, and based on cost plans associated to your projects and demands.

  The tab is displayed only to the user who has the it_project_manager role.

Viewing all your investment boards in one location

Display all your important investment boards in a single location using the My Investment views page.

When you open the Investment Portal module, you start in the My Investments Views page where you can:

- Create investment boards using filter conditions.
- View widgets on an investment board.
- Search for an investment board by the name or owner.
- View boards in different color bands based on the applied filter, such as portfolio or program. For example, the green color band on the card, in the following screen shot, indicates that the projects and demands are filtered by a portfolio.
- Drill down an investment board to review its projects and demands in terms of cost, schedule, and scope.

Tabs

Access investment boards more quickly by using tabs.

- **Recent**: Recently accessed investment boards.
- **Bookmarked**: Bookmarked investment boards.
- **Created by me**: Investment boards you own.
• **Shared to me:** Investment boards that are shared with you.

### Investment board

Key details of an investment board include:

- **Row 1:** Name, owner, and type of the board.
- **Row 2:** Some out-of-box investment metrics. The number of metrics displayed in this row is fixed, but you can configure which metrics are displayed,

![Example of an investment board](image)

### Create an investment board

View the projects and demands that are important to you by creating a personalized investment board using filter criteria you define.

Role required: `it_project_manager` or `it_project_user`

1. Navigate to **Project** > **Investment Portal**.
2. On the My Investment Views page, click **New**.
3. In the Create new window, fill in the fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the investment board.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Type</td>
<td>Level to filter projects and demands.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Portfolio</strong>: When selected, projects and demands matching that type are displayed.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Program</strong>: When selected, projects and demands matching that type are displayed.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Demands/Projects</strong>: When selected, demands and projects matching that type are displayed, and are not bound to any particular portfolio or program.</td>
</tr>
<tr>
<td>Portfolio</td>
<td>Name of the portfolio from which the projects and demands are filtered.</td>
</tr>
<tr>
<td></td>
<td>This option is available only when <strong>Type</strong> is <strong>Portfolio</strong>.</td>
</tr>
<tr>
<td>Program</td>
<td>Name of the program from which the projects and demands are filtered.</td>
</tr>
<tr>
<td></td>
<td>This option is available only when <strong>Type</strong> is <strong>Program</strong>.</td>
</tr>
<tr>
<td>Demand/Projects</td>
<td>Option to specify filter criteria for projects and demands.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: If no filter criteria is specified for demand, then no demands are retrieved. Similarly, if no filter criteria is specified for project, then no projects are retrieved.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: You can view a CSM column in an Investment Portal board, but you cannot add a filter on such columns in the board.</td>
</tr>
<tr>
<td>Active projects and demands</td>
<td>Check box to filter only active projects and demands.</td>
</tr>
<tr>
<td></td>
<td>This option is available only when <strong>Type</strong> is <strong>Portfolio</strong> or <strong>Program</strong>.</td>
</tr>
<tr>
<td>Create</td>
<td>Option to complete the creation of investment board.</td>
</tr>
</tbody>
</table>

Once your investment board is created, it opens up in the Investment Portal page.

**Note**: By default, the investment board contains those widgets that have **Include by default** check box selected. You can add or remove widgets from your investment board by using **Widget Configuration**.

**Track your key investments**

Track and analyze the cost, schedule, and scope of your investments in one place using Investment Portal.

Role required: **it_project_manager** or **it_project_user**

1. Navigate to **Project** > **Investment Portal**.
2. From the My Investment Views page, **create an investment report** and navigate to Investment Portal.
3. Use the following banner icons:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Home" /></td>
<td>Return to the My Investment Views page.</td>
</tr>
<tr>
<td><img src="image" alt="Bookmark" /></td>
<td>Add the board to the <strong>Bookmarked</strong> tab on the My Investment Views page.</td>
</tr>
<tr>
<td><img src="image" alt="Edit" /></td>
<td>Edit filter criteria of the board to further refine your list. This option is available to you only if you are the owner of the board.</td>
</tr>
<tr>
<td><img src="image" alt="Copy" /></td>
<td>Copy the filter criteria of the board to create another investment board.</td>
</tr>
<tr>
<td><img src="image" alt="Delete" /></td>
<td>Delete the board if it is no longer needed. This option is available to you only if you are the owner of the board.</td>
</tr>
</tbody>
</table>
| ![Users/Groups](image) | Share your board with default preferences and settings to other users or groups. This option is available only to the owner of the board. To share the board with other users:  
  a. Click the **User** list.  
  b. Click **Add members**.  
To share the board with other groups:  
  a. Click the **Groups** list.  
  b. Click **Add groups**.  

**Note:** When you share your board with a group, the only people who can view it are users with the roles `it_project_user` or `it_project_manager`. |

| Widget Configuration | Configure widgets on the investment board. You can:  
  • Show or hide widgets on the header.  
  • Select widgets from the list to display.  
Click **Save** to save the widget configuration on the board. |
4. Perform the following actions in the **Overview**, **Timeline**, and **Financials** tabs.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>To segregate data based on a group-level column</strong></td>
<td>Drag the column heading to this location. This option is available in both the <strong>Overview</strong> and <strong>Financials</strong> tabs.</td>
</tr>
<tr>
<td><strong>To view details of a project</strong></td>
<td>Right-click the name of the project and click <strong>View Project</strong>. This option is available in the <strong>Overview</strong> tab only.</td>
</tr>
<tr>
<td><strong>To view details of a demand</strong></td>
<td>Right-click the name of the demand and click <strong>View Demand</strong>. This option is available in the <strong>Timeline</strong> tab only.</td>
</tr>
<tr>
<td><strong>To view details of a cost plan</strong></td>
<td>Right-click the name of the cost plan and click <strong>View Cost Plan</strong>. This option is available in the <strong>Financials</strong> tab only.</td>
</tr>
<tr>
<td><strong>To view Planning tab on the Project Workbench</strong></td>
<td>Right-click the name of the project and click <strong>View Planning Console</strong>. This option is available in the <strong>Timeline</strong> tab only.</td>
</tr>
<tr>
<td><strong>To sort records</strong></td>
<td>Click the name of the column header. This option is available in both the <strong>Overview</strong> and <strong>Financials</strong> tabs.</td>
</tr>
<tr>
<td><strong>To pin or apply filter on a column</strong></td>
<td>Use the <strong>Menu</strong> icon over the column. This option is available in both the <strong>Overview</strong> and <strong>Financials</strong> tabs.</td>
</tr>
<tr>
<td><strong>To view details of the grid in a yearly, quarterly, and monthly format</strong></td>
<td>Click the <strong>Year/Quarter/Month</strong> option, which is available in both the <strong>Timeline</strong> and <strong>Financials</strong> tabs.</td>
</tr>
<tr>
<td><strong>To add a column in any tab</strong></td>
<td>Click the <strong>Configuration</strong> icon.</td>
</tr>
<tr>
<td><strong>a. Click Add column.</strong></td>
<td><strong>b.</strong> In the Add column window, fill in the fields:</td>
</tr>
<tr>
<td>1. In <strong>Name</strong>, specify a name for the column.</td>
<td>2. In <strong>Select Column Type</strong>, the <strong>Demand/Project</strong> value is selected by default.</td>
</tr>
<tr>
<td>3. In <strong>Demand column</strong>, specify the column to be rendered from the Demand table.</td>
<td></td>
</tr>
<tr>
<td>4. In <strong>Project column</strong>, specify the column to be rendered from the Project table.</td>
<td></td>
</tr>
<tr>
<td>5. In <strong>Cost Plan</strong>, specify the value to be rendered. This option appears only in the <strong>Financial</strong> tab.</td>
<td></td>
</tr>
</tbody>
</table>
Configure your investment metrics as widgets

Configure investment metrics based on your business requirements. These metrics appear as widgets on the Investment Portal page.

Role required: pps_admin

1. Navigate to Project Administration > Investment Portal Widgets.
2. Click New.
3. In the form, fill in the fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the widget you are configuring.</td>
</tr>
<tr>
<td>Order</td>
<td>The order in which your widgets appear on both your Investment Board and the Investment Portal page. Lower numbers are placed ahead of higher numbers. For example, a widget with an order set to 100 appears before a widget with an order set to 200.</td>
</tr>
</tbody>
</table>

To hide a column from any tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| To hide a column from any tab | a. Click the Configuration icon.  
b. Deselect the check box of the column to be hidden. |

Note: You can view a CSM column in an Investment Portal board, but you cannot add such columns in the board.

To reset to the default grid layout

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| To reset to the default grid layout | a. Click the Configuration icon.  
b. Click Reset to defaults. |

To generate a comma-separated values (.csv) report of the investment board

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| To generate a comma-separated values (.csv) report of the investment board | a. Click the Configuration icon.  
b. Click Export to csv. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aggregate type</td>
<td>Type of aggregation applied for the investment widget calculation: <strong>Sum, Average, Minimum, Maximum, and Count.</strong></td>
</tr>
<tr>
<td></td>
<td>For example, you are aggregating the actual cost of three projects, A, B, and C, surfaced by a filter. Actual costs are 1000 for project A, 2000 for project B, and 3000 for project C.</td>
</tr>
<tr>
<td></td>
<td>If sum is selected as the aggregate type, then the actual cost metric value would be 6000. If average is selected as the aggregate type, then the actual cost metric value would be 2000. If minimum is selected as the aggregate type, then the actual cost metric value would be 1000. If maximum is selected as the aggregate type, then the actual cost metric value would be 3000. If count is selected as the aggregate type, then the actual cost metric value would be 3.</td>
</tr>
<tr>
<td>Scripted</td>
<td>Check box to specify a script for the investment widget calculation.</td>
</tr>
<tr>
<td>Show Label</td>
<td>Check box to display either the label or the color indicator.</td>
</tr>
<tr>
<td></td>
<td>If you clear the check box, the <strong>Color</strong> field displays, which allows you to set the color.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to indicate that the investment widget is active.</td>
</tr>
<tr>
<td>Display on board</td>
<td>Check box to display the investment widget on your investment board.</td>
</tr>
<tr>
<td>Parent widget</td>
<td>Parent widget for this investment metric widget. A parent widget can have up to a maximum of three child widgets.</td>
</tr>
<tr>
<td>Include by default</td>
<td>Check box to show an active investment widget by default on:</td>
</tr>
<tr>
<td></td>
<td>• new boards</td>
</tr>
<tr>
<td></td>
<td>• existing boards that do not have widget selection configured</td>
</tr>
<tr>
<td></td>
<td>The check box is selected by default.</td>
</tr>
<tr>
<td></td>
<td>For more information on configuring widgets on an investment board, see <strong>Widget Configuration</strong>.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description about the investment widget.</td>
</tr>
</tbody>
</table>
Script

Script written for the dynamic calculation of investment widget. This field is displayed only when the **Scripted** check box is selected.

The following script returns a string containing the desired output to be displayed on widget. Five variables (which are programmatically introduced to the script) are available:

- `projectFilter`: Project filter of Investment Portal board.
- `demandFilter`: Demand filter of Investment Portal board.
- `projectClass`: Project class of Investment Portal board which is used during teamspaces value evaluation. It returns `tsp1_project` for Teamspace1 Portal Board.
- `demandClass`: Demand class of Investment Portal board which is used during teamspaces value evaluation. It returns `tsp1_demand` for Teamspace1 Portal Board.
- `boardSysId`: SysId of Investment Portal board. It provides access to more information on Investment Portal board when needed.

**Sample scripted widget for project cost**

```javascript
function totalProjectCost() {
  var totalCost = 0;
  if(!JSUtil.nil(projectClass) && !JSUtil.nil(projectFilter)) {
    var projectGa = new GlideAggregate(projectClass);
    projectGa.addEncodedQuery(projectFilter);
    projectGa.setGroup(false);
    projectGa.addAggregate('SUM', 'cost');
    projectGa.query();
    if(projectGa.next()) {
      if(projectGa.getAggregate('SUM', 'cost'))
        totalCost += parseFloat(projectGa.getAggregate('SUM', 'cost'));
    }
  }
  return PPMCurrencyHelper.defaultCurrencySymbol() + PPMCurrencyHelper.getFormattedAmount(totalCost);
}
```
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Project</strong></td>
<td></td>
</tr>
<tr>
<td>Project aggregate column</td>
<td>Aggregation is applied on the selected column of the Project [pm_project] table.</td>
</tr>
<tr>
<td>Project table</td>
<td>Table from which projects are being filtered.</td>
</tr>
<tr>
<td>Project filter</td>
<td>Criteria applied to filter projects from the Project table.</td>
</tr>
<tr>
<td><strong>Demand</strong></td>
<td></td>
</tr>
<tr>
<td>Demand aggregate column</td>
<td>Aggregation is applied on the selected column of the Demand [dmn_demand] table.</td>
</tr>
<tr>
<td>Demand table</td>
<td>Table from which demands are being filtered.</td>
</tr>
<tr>
<td>Demand filter</td>
<td>Criteria applied to filter demands from the Demand table.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Project import and export**

You can manage projects using both Microsoft Project and the ServiceNow Project Management application.

**Project Import**

Users with it_project_manager role can import projects and project tasks from Microsoft Project into ServiceNow Project Management.

Create a project or update an existing project by importing the project data from Microsoft Project into your ServiceNow instance. For more information, see Project import from Microsoft Project.

While importing a project into your ServiceNow instance, you can also specify the calculation method for calculating project dates. You can import the project tasks with different constraint types using Manual or Automatic calculation. For information about supported constraints and their conversion, see Project import from Microsoft Project.

You can create custom fields in your ServiceNow instance and map these fields with your Microsoft Project while importing a project. For more information, see Create custom field mapping for Microsoft Project file import.

You can import project tasks for multiple projects in one time using data files and transform maps. For more information, see Import project tasks for multiple projects.

Some calendar elements are not imported from Microsoft Project into Project Management. For information about calendar elements and schedules, see Calendars and schedules: Limitations.

**Project Export**

If you have the it_project_manager role, you can export project data. The project data, such as project tasks and task constraints, can be exported as an export file. Use this export file to import the projects into other ServiceNow instances.
If you are managing your projects using Microsoft Project, you can export your ServiceNow projects using the export functionality.

You can choose to export the project data in MPP, XML, or CSV file formats. For more information, see Project export to Microsoft Project.

If your project in the ServiceNow instance contains dates with any of the supported constraint types, then these constraints are also exported when you export the project and project tasks. For more information, see Project export to Microsoft Project.

Supported versions

Projects created in the following versions of Microsoft Project can be imported into the ServiceNow Project Management application.

- Microsoft Project 2003
- Microsoft Project 2007
- Microsoft Project 2010
- Microsoft Project 2013
- Microsoft Project 2016

Calendars and schedules: Limitations

Some calendar elements from Microsoft Project are not imported into the Project Management application.

- Project calendars
- User calendars
- Schedules

The imported project uses the default schedule of a Monday to Friday workday from 8 A.M. to 5 P.M. with an hour break for lunch, starting with the v3 application.

Project field mapping

During an import, values from Microsoft Project overwrite fields in project records.

<table>
<thead>
<tr>
<th>Microsoft Project fields</th>
<th>Project Management fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task Name</td>
<td>Short description. The field is overwritten only while you import the first time.</td>
</tr>
<tr>
<td>Note</td>
<td>Description</td>
</tr>
<tr>
<td>Start</td>
<td>Planned start date</td>
</tr>
<tr>
<td>Finish</td>
<td>Planned end date</td>
</tr>
<tr>
<td>Duration</td>
<td>Planned duration</td>
</tr>
<tr>
<td>Actual Start</td>
<td>Actual start date</td>
</tr>
<tr>
<td>Actual Finish</td>
<td>Actual end date</td>
</tr>
<tr>
<td>Actual Duration</td>
<td>Actual duration</td>
</tr>
<tr>
<td>% Complete</td>
<td>Percent complete (personalize the form to add this field)</td>
</tr>
<tr>
<td>Predecessor Lag</td>
<td>Lag time between predecessor and successor</td>
</tr>
<tr>
<td>Microsoft Project fields</td>
<td>Project Management fields</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>WBS</td>
<td>WBS</td>
</tr>
<tr>
<td>Critical</td>
<td>Critical path</td>
</tr>
<tr>
<td>Rollup</td>
<td>Rollup</td>
</tr>
<tr>
<td>Text10 (Field used for syncing purposes)</td>
<td>Task Sys_Id</td>
</tr>
<tr>
<td>Project Header Title</td>
<td>Project name</td>
</tr>
<tr>
<td>Project Header Subject (Field used for syncing purposes)</td>
<td>Top Task Sys_Id</td>
</tr>
<tr>
<td>Resource</td>
<td>Assigned to [assigned_to]</td>
</tr>
</tbody>
</table>

**Note:** During import, if there are multiple resources assigned to a task in Microsoft Project:
- The first resource is added to the Assigned to field.
- The rest of the resources are added to the Additional assignee list field.

<table>
<thead>
<tr>
<th>Resource Group</th>
<th>Assignment Group</th>
</tr>
</thead>
</table>

Create custom field mapping for Microsoft Project file import

Map custom fields from Microsoft Project to ServiceNow fields before importing a project.

Create custom fields in your ServiceNow instance before mapping them with Microsoft Project. For more information, see Add and customize a field in a table.

Role required: it_pps_admin

Map the custom fields that you create in your ServiceNow instance with custom fields in the Microsoft Project file you plan to import.

The supported data types for field mapping between Microsoft Project and ServiceNow instances are:

- True/False
- Calendar
- Date/Time
- Choice
- Color
- Currency
- Decimal
- Due Date
- Floating Point Number
- Date
- Date/Time
- Duration
- List
- Time
- HTML
- Integer
1. Navigate to **Project Administration > Project - MSP Import Field Mappings**.
2. Click **New**.
3. From the Table list, select the table in which you created the custom field.

<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you created a field in the project table</td>
<td>Select <strong>Project</strong> from the Table list.</td>
</tr>
<tr>
<td>If you created a field in the project task table</td>
<td>Select <strong>Project Task</strong> from the Table list.</td>
</tr>
</tbody>
</table>

4. In the **Microsoft Project Column** field, enter the name of the custom field in your Microsoft Project file that you want to map.
5. In the **Destination Column** list, select the custom ServiceNow field that you want to map to the Microsoft Project field while importing a project.
6. Click **Submit**.

- Import the Microsoft Project file. For more information, see [Import a Microsoft Project file with the Import module](#).
- Configure the Project form to add the custom fields that you want to see. For more information, see [Form configuration](#).

**Project import from Microsoft Project**

Import Microsoft project files into the ServiceNow Project Management application.

Users with the project manager role can import a project using:

- Import module
- Project form
- Planning Console

When you import a project as a new project or into an existing project, the projects are updated as follows:

- New project: A new record is created in the Project [pm_project] table. The tasks associated with the project are added to the Project Task [pm_project_task] table.
  
  Only the common or mapped fields are imported. Imported projects are brought into the instance with both Priority and Risk set to Low.

- Existing project: The instance checks the Text10 field in the top-level Microsoft Project task. If the Text10 field contains a recognizable sys_id, it means that the project was previously exported from a ServiceNow instance. In this case, the values from the project overwrite the values for the existing project.

You can also specify the schedule calculation type as **Automatic** or **Manual** for the imported tasks. When you import a project into the instance, project constraints are converted as follows:
• The time constraint for all imported tasks, when you select calculation type as **Manual**, is set to **Start on specific date** irrespective of their constraint type in Microsoft Project.

• The following constraint types are supported when you select calculation type as **Automatic**:
  - **Start on specific date**
  - **As soon as possible**
  - **Start no later than**
  - **Start no earlier than**

Tasks with other constraint types are converted to **Start on specific date**.

**Note:** The resource name in Microsoft Project should map to the name of the user in the instance.

*Import a Microsoft Project file with the Import module*

Use the Import module to import a Microsoft project file as a new project into the Project Management application.

Role required: it_project_manager

Before importing a Microsoft Project file into the ServiceNow instance, consider the following information.

• Microsoft Project project imported into a teamspace is only available to users who can access the teamspace.

• To import custom fields in your Microsoft project, create those custom fields in your ServiceNow instance first, and then create mapping between these fields before importing the project. For more information, see Create custom field mapping for Microsoft Project file import.

**Note:** You can also use the Scripted Extension Points for importing custom fields without creating and mapping the custom fields manually. Use the **MSProjectImportTaskFormatter** Extension Point to create a script include and map custom fields in Microsoft Project and ServiceNow. You can also use this Extension Point to modify the data while importing a project.

• If the calculation type is set as **Manual**, recalculation does not happen on project tasks when they are imported from the Microsoft Project file. Once the project is in the ServiceNow system, it would be treated as a manual project.

• Importing a Microsoft Project project with inter-project dependencies, does not import the shadow tasks.

• Only the subprojects (header and parent task) get imported into the ServiceNow instance, the child tasks are not imported.
While importing a Microsoft Project file into ServiceNow, the import fails:

- If the project with tasks was created in ServiceNow instance before the import.
- If you reimport a project that was imported from Microsoft Project file earlier and you create and add tasks in ServiceNow instance.

**Note:** To retain the project tasks that were created in the ServiceNow instance, you must export that project first into the Microsoft Project file. Then, reimport the file back into ServiceNow instance.

- If the task being deleted due to import has any of the related entities: Cost plan, Benefit plan, Resource plan, Time card, or Expense lines.
- If the values for lag or lead time dependencies are not in the supported format.
  - Positive lag time dependency values for days, hours, and minutes are allowed. Negative lag time dependencies are allowed only for days.
  - All other elapsed duration types from Microsoft Project such as emin, eday, eweek, emon, eyr, or % are not allowed for import.

1. Navigate to **Project > Projects > Import**.
2. Click **Choose File** to select a Microsoft Project (mpp) file.
3. To import the Microsoft project as a new project, select the **Create new project** option.
4. Optional: In the **Project name** field, specify a name for the new project.
5. To import the Microsoft project as a subset of an active, existing project:
   a) Select **Update an existing project**.
   b) Click the reference lookup icon (🔍) and select a project or task. Only active projects appear in the list.
6. Select one of the following options to specify the method for calculating schedule:
   - **Automatic**: Select this option to apply the scheduling engine while importing the project tasks. The supported constraint types are imported with same constraints applied to them while other constraint types are converted to **Start on specific date**.
   - **Manual**: Select this option to import all project tasks with **Start on specific date** constraint type irrespective of their constraint type in Microsoft Project.

   For more information about supported constraint types, see **Project import from Microsoft Project**.
7. Click **Import**.

- A project task that was imported in ServiceNow instance earlier and has associated time cards, resource plans, cost plan, benefit plan, or expense lines is retained on reimport even if it is deleted from Microsoft Project.
- Dates in the ServiceNow project remain same as the dates in the Microsoft Project file.
- In a ServiceNow project with subprojects, the following details change:
  - The WBS order of imported tasks is regenerated after import.
  - The **Planned Start Date** and **Planned End Date** of the parent project are rolled up.
  - The **State** of the parent project and tasks are rolled up.
  - The % Complete on the top task is rolled up.
Update a project using a Microsoft Project file

Import project data, from a Microsoft Project file, into an existing project in your ServiceNow instance using the Project form or Planning Console.

Create a project.

Role required: it_project_manager

1. Navigate to Project > Projects > All.
2. Open the project which you want to update.
3. Import the Microsoft Project file to update the selected project from any of the following screens:
   a) In the Project form, select Import from MS Project from the context menu.
   b) In the Planning Console, click the more actions icon (⋮) and select the Import from MS Project option.
4. In the Microsoft Project Import dialog box, select the Microsoft Project file and calculation type:
   a) Click Choose File to select a Microsoft Project (mpp) file.
   b) Select one of the following options to specify the method for calculating the schedule:
      - Automatic: Select this option to apply the scheduling engine while importing the project tasks. The supported constraint types are imported with the same constraints applied to them while other constraint types are converted to Start on specific date.
      - Manual: Select this option to import all project tasks with the Start on specific date constraint type irrespective of their constraint type in Microsoft Project.

For more information about the supported constraint types, see Project import from Microsoft Project.

5. Click Import.

- A project task that was imported in the ServiceNow instance earlier and has associated time cards, resource plans, cost plan, benefit plan, or expense lines is retained on reimport even if it is deleted from Microsoft Project.
- Dates in the ServiceNow project remain same as the dates in the Microsoft Project file.
- In a ServiceNow project with subprojects, the following details change:
  - The WBS order of imported tasks is regenerated after import.
  - The Planned Start Date and Planned End Date of the parent project are rolled up.
  - The State of the parent project and tasks are rolled up.
  - The % Complete on the top task is rolled up.

Import project tasks for multiple projects

Import project tasks for multiple projects from an external file system or data source using import sets and transform maps.

Role required: import_transformer, import_admin, or admin

1. Navigate to System Import Sets > Load Data.
2. Select the Existing table option.
3. From the Import set table list, select the Import planned task [imp_planned_task] option.
4. In the Source of the import field, select File, and then click Choose File to select the source Excel spreadsheet.
5. Optional: If required, specify the Work sheet and Header row number.
6. Click Submit
   The imported data is available in the selected Import Set table.
7. Optional: Create field mappings for custom columns.
   For more information, see Create field mappings.
8. Transform the data from the import set table to the target table.
   For more information, see Run an import.

**Project export to Microsoft Project**

If you are using Microsoft Project to manage project activities, you can export a project to Microsoft Project (mpp) file, an XML file, or a CSV file.

Users with the project manager role can export a project using:

- Export module
- Project form
- Planning Console

You can also specify the format in which you want to export project data, the available options are:

- **XML**: Suitable, if you want to import the project data into other ServiceNow instance.
- **CSV**: Suitable for exporting project data from Planning Console as is and viewing project data using other applications.
- **Microsoft Project**: Suitable, if you want to import the project data into Microsoft Project.

**Note:** The option for exporting project data in CSV and Microsoft Project format is available when exporting a project from Planning Console.

If tasks in your project contain any of the supported constraints, then the constraints are also exported when you export the project. This export of constraints helps you in maintaining project dates when you import the project to another ServiceNow instance. The following constraints are supported:

- **Start on specific date**: Mapped with Must start on constraint when exported to Microsoft Project.
- **As soon as possible**
- **Start no later than**
- **Start no earlier than**

**Note:** Shadow tasks and external dependencies are not exported when you export the project data.

**Export project data**

Export the project data using the Export module, Project form, or Planning Console. Save the export file to a folder on your system in the Microsoft Project (MPP), XML, or CSV format.

**Role required:** it_project_manager

Projects must use either the Project Management Schedule or the Default MS Project schedule before they can be exported.
The option for exporting the project data in MPP and CSV format is available when exporting a project from the Planning Console. Only the columns which are visible in the Planning Console are exported.

1. **Export the project data from any of the following options:**

<table>
<thead>
<tr>
<th>Location</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the Export module</td>
<td>a. Navigate to Project &gt; Projects &gt; Export.</td>
</tr>
<tr>
<td></td>
<td>b. Select a project From the Project to export list and click Export.</td>
</tr>
<tr>
<td>From the Project form</td>
<td>a. Navigate to Project &gt; Projects &gt; All.</td>
</tr>
<tr>
<td></td>
<td>b. Open the project that you want to export.</td>
</tr>
<tr>
<td></td>
<td>c. In the Project form, select Export to MS Project from the context menu.</td>
</tr>
<tr>
<td>From the Planning Console</td>
<td>a. Navigate to Project &gt; Projects &gt; All.</td>
</tr>
<tr>
<td></td>
<td>b. Open the project that you want to export.</td>
</tr>
<tr>
<td></td>
<td>c. In the Project form, click the Planning Console related link.</td>
</tr>
<tr>
<td></td>
<td>d. In the Planning Console, click the more actions icon ( ) and select the Export option.</td>
</tr>
<tr>
<td></td>
<td>e. In the Microsoft Project Export dialog box, select the file format.</td>
</tr>
<tr>
<td></td>
<td>f. Click OK.</td>
</tr>
</tbody>
</table>

2. Optional: A dialog box might prompt you to save the export file. Save the file as an XML file. If you are exporting the project from the Planning Console and selected the CSV option, you can save the file in CSV format.

   **Note:** Depending on your browser setting, the browser might automatically save the file to your Download folder.

- Use the MPP file to import the project data into a Microsoft Project.
- Use the XML file to import the project data into other ServiceNow instances or Microsoft Project.
- Use the CSV file to view project data using other applications.

### Export project tasks

The task being exported must be associated with a project that uses either the Project Management Schedule or the Default MS Project schedule.

**Role required:** it_project_manager

1. Navigate to Project > Projects > All.
2. Open the project.
3. Scroll to the Project Tasks related list and click a task number to open the Project Task form.
4. Right-click the form header and select Export Task to MS Project from the context menu.

   The task is exported to a folder on your system.
5. Open Microsoft Project to import the exported project task files. Refer to Microsoft product documentation for instructions.

Project reporting

Get an at-a-glance view of projects with reports, the portfolio dashboard, and project views. You can see information such as projects with slipped milestones, graphs of resources by project, and projects listed by percentage complete.

Note: Much of information available on reports, dashboards, and views is customizable. The examples below derive from default settings.

The application provides several global reports, both lists and charts, that show the status of projects at a glance. You can also create custom reports or create reports that can be viewed by certain groups. The following Project Management reports are available in the base system:

- Active Project Unassigned Tasks 30 Days: list report
- Projects (by priority): bar chart
- Projects (by priority): list report
- Projects (by risk): list report
- Projects (by risk): bar chart
- Projects (by state): list report
- Projects (by state): bar chart
- Active projects: list report
- Pending projects: list report
- Active Projects by Manager: bar chart

Close a project

Closing the project involves more than just changing the project state to closed.

Role required: it_project_manager

Post-project activities include viewing baselines and actual values to evaluate how much the project slipped from its original estimates. They also include following up on related incidents, problems, or changes that are linked to the project through the instance.

When you close a project, all project tasks are closed automatically. Normally, you should not reopen a project after it is closed. Updating the project state from Closed to Work In Progress, Pending, or Open is not allowed. If you still need to reopen a closed project, reopen an existing project task or add a new task to the project. This moves the project from Closed to Work in Progress state without affecting the other closed tasks.

You can cancel the associated future resource plans and complete the Allocated resource plans for a closed project.

1. Verify that the work is completed for all tasks in the project.
2. On the Project form, change the State field to one of the closed states:
   - Closed Complete the project is finished and all tasks are complete.
   - Closed Incomplete the project is finished, but tasks remain unfinished.
   - Closed Skipped the project was abandoned.

Alternatively, close every project task first, starting with the lowest-level child tasks. The closed states roll up to parent tasks, and when the highest-level parent tasks are all closed, the project state changes to closed. However, the default closed states for parent tasks and for the project is Closed.
Complete. Therefore, even if you change any or all project tasks to **Closed Incomplete** or **Closed Skipped**, the project state is changed to **Closed Complete**.

Also, change the **Phase** value to **Closing**. The project phase is for reference only and is not linked to or dependent on the **State** field.

3. After the project is complete, create a final baseline to see how closely the actual project values came to the estimated values.

**Note:** Baselines compare only planned start and end date values with actual start and end date values. Use reports to compare effort and cost.

For projects created from an incident, problem, or change, updating the project state does not automatically update the related incident, problem, or change request record. You must update the related record manually. For example, if the completion of a project also means that a related change can be closed, go to the change record and modify its **State** field. It is also a good idea to update the work notes field on the related record to include any relevant information about the project.

- **Cancel the resource plans** associated with the project if:
  - there is a corresponding resource plan in Confirmed, Planning, or Requested state. Or
  - there is a resource plan in Allocated state with start date later than the project end date.

- **Complete the resource plans** associated with the project if:
  - there is a corresponding resource plan in the Allocated state. And,
  - the resource plan start date is less than or equal to the project or task actual end date.

### View actual project costs

When you are using Project Portfolio Management with Financials, you can view actual project costs on cost plans and projects.

Role required: **it_project_manager**

An expense line has to be processed to be considered for actual cost. The actual cost is recorded against the creation date of the expense line, not the processed date. The expense lines are created only for approved time cards.

Actual costs for projects also roll up to portfolios in the same way.

1. Navigate to ***Project*** > ***Projects*** > ***All***.
2. Open the project for which you want to view the actual costs.
3. Click the **Cost Plans** related list.

### Actual project costs

Actual project costs come after you create expense lines for cost plans or after human resources use time cards to create expense lines.

The system captures actual project costs from expense lines:

- **Expense lines from cost plans**: You can create expense lines from a cost plan. Allows you to specify the amount and date when the expense was incurred. The actual amount incurred is included in the cost plan after the expense line is processed.

- **Expense lines from timecards**: Human resources can record time for project work by using time cards. When time cards are approved, the system generates expense lines. After the expense lines are processed, the actual costs are recorded for the project. If you provide a resource plan when creating
time cards, the cost plan name is derived from resource plan and cost is captured against the resource plan. If you do not provide a resource plan, the cost is captured against the project.

**Project and project task states**

In the base system, the states in project and project task inherit the states in Task table.

The states are grouped into different categories as shown below:

<table>
<thead>
<tr>
<th>State</th>
<th>Label</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>-5</td>
<td>Pending</td>
<td>Pending</td>
</tr>
<tr>
<td>1</td>
<td>Open</td>
<td>Open</td>
</tr>
<tr>
<td>2</td>
<td>Work in Progress</td>
<td>Work in Progress</td>
</tr>
<tr>
<td>3</td>
<td>Closed Complete</td>
<td>Closed</td>
</tr>
<tr>
<td>4</td>
<td>Closed Incomplete</td>
<td>Closed</td>
</tr>
<tr>
<td>7</td>
<td>Closed Skipped</td>
<td>Closed</td>
</tr>
</tbody>
</table>

The category information for the states is declared in dictionary override of State column in Planned task (planned_task) table in Attributes field. Planned task is the parent table for project and project task tables.

**View default project and project task state categories**

View category information for the default project and project task states. In the base system, the states in project and project task inherit the states in Task table.

Role required: admin

1. Navigate to Dictionary.
2. Update the filter with the following AND conditions:
   a) [Table] [is] [task]
   b) [Column name] [is] [state]
3. Run the filter.
4. Click the task table, and then choose planned_task table in Dictionary Overrides related list.

The Attributes field displays different states and the categories for a state as shown below. It also displays the default state value for each category.

`close_states=3;4;7, default_close_state=3, default_work_state=2, default_open_state=1, default_skipped_state=7`

**Customize a state for project or project task**

Add or modify a state of project or project task using dictionary override.

Role required: admin

As an example, the steps for adding custom states for Work in progress state category for Project task are described. In this example,

- the existing Work in Progress state is removed and following three new states are added:

<table>
<thead>
<tr>
<th>State</th>
<th>Label</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>Design</td>
<td>Work in Progress</td>
</tr>
<tr>
<td>State</td>
<td>Label</td>
<td>Category</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
<td>------------------</td>
</tr>
<tr>
<td>11</td>
<td>Development</td>
<td>Work in Progress</td>
</tr>
<tr>
<td>12</td>
<td>Testing</td>
<td>Work in Progress</td>
</tr>
</tbody>
</table>

- the default Work in Progress is kept as 10 (Design).

1. **Define** a new dictionary override for pm_project_task table under Task - State dictionary.
2. Specify the override attributes for the dictionary override in Attributes field as follows:
   ```
   close_states=3;4;7,default_close_state=3,default_work_state=10,default_open_state=1,default_skipped_state=7,default_pending_state=-5,pending_states=-5,open_states=1,work_in_progress_states=10;11;12
   ```

   - As specified in Step 2, the default_work_state is declared as 10 and the work_in_progress_states as 10, 11, and 12. Now whenever a project task changes to any of the new Work in Progress states, its parent also moves to corresponding Work in progress state.

   Suppose that a project task has two children records, and if the first child record moves to Development state, the parent also moves to Development state. Now if the second child record moves to Design state, the two children records under the project task are in two different work in progress states. In such cases, the parent record moves to the default work in progress state. In this case, the parent record moves to Design as the default_work_state is specified as 10 (Design).

- The project states can also be customized using the same steps.

**Project Management costing add-on**

The Project Management costing add-on connects the Project Management application to the Cost Management application to allow for estimating and tracking the costs associated with projects.

This plugin enables the following project costing features:

- Estimate group resource costs during project planning.
- Tracking the actual cost of each user resource for a project.
- Track actual project task costs from time cards and other project expenses.
- Allocate project costs to the business.
- Represent project costs to the CIs that the project affects.
- Rollups of actual task expenses to parent tasks and the project record.

The Project and Cost applications work together as shown in the diagram:
Project and Cost applications

The following properties are available with this plugin:

**Costing add-on properties**

<table>
<thead>
<tr>
<th>Description</th>
<th>Property Name</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>For planned tasks types, calculate the actual cost field using the total of expense lines for the task.</td>
<td>glide.cost_mgmt.calc_actual_cost</td>
<td>Default: true. This property is from Cost Management. When an expense line is created against any task of planned_tasktype and this property is true, the system gets a sum of the costs for all the expense lines and sets the total cost in the work_cost field.</td>
</tr>
<tr>
<td>When creating a task expense line should the system also create expense lines for the top task?</td>
<td>glide.cost_mgmt.process_task_top_task</td>
<td>Default: true</td>
</tr>
<tr>
<td>Enable project cost rollup (estimated and actual) - updating the cost of a project task updates the cost of its parent.</td>
<td>com.snc.project.rollup.cost</td>
<td>Default: true</td>
</tr>
</tbody>
</table>

The following business rules are added or modified with this plugin:
Costing add-on business rules

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Cost Rollup</td>
<td>Planned task [planned_task]</td>
<td>Default: true. This property is from Cost Management. When an expense line is created against any task of planned_tasktype and this property is true, the system gets a sum of the costs for all the expense lines and sets the total cost in the work_cost field.</td>
</tr>
<tr>
<td>Process Top Task Parent</td>
<td>[fm_expense_line]</td>
<td>Default: true</td>
</tr>
</tbody>
</table>

Activate project task email notifications

The following email notifications for the Project Management application are available by default, but are inactive. You must activate them manually.

Role required: admin

1. Navigate to System Notification > Email > Notifications.
2. Activate the following notifications:

<table>
<thead>
<tr>
<th>Notification</th>
<th>Table</th>
<th>Field</th>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project task assigned</td>
<td>pm_project_task</td>
<td>Assigned to</td>
<td>Inserted or updated</td>
<td>Sends an email notification when a task is assigned to a resource or the assigned resource is changed.</td>
</tr>
<tr>
<td>Project task started</td>
<td>pm_project_task</td>
<td>State</td>
<td>Changes to Work in Progress</td>
<td>Sends an email notification when the project task starts.</td>
</tr>
<tr>
<td>Project task commented</td>
<td>pm_project_task</td>
<td>Additional comments</td>
<td>Any changes occur</td>
<td>Sends an email notification when the comment field is updated.</td>
</tr>
</tbody>
</table>
Set up project notifications with the workflow tool

Use the workflow tool, for example, to set up a workflow that sends an email notification when the state of a project task becomes Work in Progress.

Role required: admin

1. Create a workflow with the following attributes:
   - **Name**: Notify assignee
   - **Table**: Project task [pm_project_task]
   - **If condition matches**: Run if no other workflows matched yet
   - **Condition**: State is Work in Progress and Assigned to is not empty

   **Note**: Do not modify other attributes in this example.

2. Add a single Notification activity between the Start and End activities. Drag the activity onto the connector line until it changes color. The attributes of the activity are similar to the following example:
   - **Name**: Notify assignee
   - **To**: ${assigned_to}
   - **Subject**: Project task ${number} has been activated and is assigned to you
   - **Message**: Project task ${number} has been activated and is assigned to you
     
     Number: ${number}
     Short description: ${short_description}
     Planned start date: ${start_date}
     Planned end date: ${end_date}
     Planned duration: ${duration}

Project Status app

The Project Status mobile app enables you to track the status of your projects, collaborate with stakeholders to resolve exceptions, and take timely actions regardless of your location.

You can use the Project Status features to do the following:
• View the latest status of your projects
• View the latest status report of your projects
• Review risks and decisions
• Collaborate with other stakeholders on a project
• Receive mobile notifications when the project status changes or other users add comments or notes

Activation information

The Project Status mobile application runs on the ServiceNow® mobile platform. To enable the Project Status app, activate the PPM Mobile plugin (com.sn_ppm_mobile) if you have the admin role.

Activate Mobile: Project Status

You can activate the Mobile: Project Status application from ServiceNow Store, earlier known as PPM Mobile (com.sn_ppm_mobile), if you have the admin role. Installing this application also activates related plugins if they are not already active.

Role required: admin

Mobile: Project Status activates the following related plugin if it is not already active.

<table>
<thead>
<tr>
<th>Plugin for PPM Mobile</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Portfolio Suite with Financials [com.snc.financial_planning_pmo]</td>
<td>Enables you to manage your demands, resources, portfolios and projects. It also helps you plan, track, and manage the cost and budget of projects and demands in a portfolio to strike a balance between investment and returns.</td>
</tr>
</tbody>
</table>

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Get started with Project Status app

Access project status and status reports on the Project Status mobile app to review your project status and collaborate with stakeholders regardless of your location.

• Download the ServiceNow Agent mobile application on an iOS platform from the Apple App Store or on an Android platform from the Google Play Store.
• Activate the PPM Mobile plugin.

Role required: admin

1. Open the mobile app and tap the plus icon (+).
2. Add a ServiceNow instance by tapping the plus icon (+) and then entering the instance address.
You do not need to include service-now.com at the end of the instance name.

3. Tap **Project Status** to get started with tracking your projects.

### View project details on the mobile app

You can view the status of a project and other project details such as financial data, status reports, risks, and decisions through the mobile app.

Role required: portfolio_manager or project_manager or program_manager

1. Navigate to the Project Status application on your mobile app.
2. Open a project for which you want to view the details using one of the following options.
   - Tap to open an applet and then tap on a project.
   - Tap on the **Search Projects** applet to find a specific project.
   - In the **Critical Projects** or the **Project in Red** lists, tap on a project.

3. Tap any field with a right arrow to view its details.

### View project status report

You can view the status of a project such as overall progress, executive summary, financial data, and RIDAC records through the mobile app.

Role required: portfolio_manager or project_manager or program_manager

1. Navigate to the Project Status application on your mobile app.
2. Open a project for which you want to view the project status report using one of the following options.
   - Tap to open an applet and then tap on a project.
   - Tap **My Projects** applet to view your projects.
   - Tap on the **Search Projects** applet to find a specific project.
   - In the **Critical Projects** or the **Project in Red** lists, tap on a project.

3. Tap the project card to view its status report.
   - The **Overall Status** tab displays the summary of project such as overall health of the project, executive summary, achievements, and key activities planned for the project.
   - The **Details** tab displays status and details of information related to schedule, scope, cost, and resources for the project.

### Create RIDAC (Risk, Issues, Decisions, Actions, and Request Changes) records

You can create Risk, Issues, Decisions, Actions, and Request Changes records for your project through the mobile app.

Role required: portfolio_manager or project_manager or project_user

Analyze the impact of the risks on the project and create RIDAC records to track risks, issues, and their probable resolution for planning future projects. For more information see, [RIDAC (Risk, Issue, Decision, Action, and Request Changes) record entries for a project](#).

1. Navigate to the Project Status application on your mobile app.
2. Open a project for which you want to create a RIDAC record using one of the following options.
   - Tap to open an applet and then tap on a project.
   - Tap **My Projects** applet to view your projects.
   - Tap on the **Search Projects** applet to find a specific project.
   - In the **Critical Projects** or the **Project in Red** lists, tap on a project.
3. Create a RIDAC record using one of the following options.
   - Tap the more action icon (⋮) and select one of the options:
     • New Risk
     • New Issue
     • New Decision
     • New Action
     • New Request Changes

4. Based on the option that you selected, fill in the fields on the form:

<table>
<thead>
<tr>
<th>RIDAC record</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Risk</td>
<td>Fill the fields on the Risk form. For more information, see Add risks for a project.</td>
</tr>
<tr>
<td>New Issue</td>
<td>Fill the fields on the Issue form. For more information, see Add issues for a project.</td>
</tr>
<tr>
<td>New Decision</td>
<td>Fill the fields on the Decision form. For more information, see Add decisions for a project.</td>
</tr>
<tr>
<td>New Action</td>
<td>Fill the fields on the Action form. For more information, see Add actions for a project.</td>
</tr>
<tr>
<td>New Request Changes</td>
<td>Fill the fields on the Request Changes form. For more information, see Create a request change.</td>
</tr>
</tbody>
</table>

5. Alternatively, open a RIDAC record and create a new RIDAC record.
   - a. Tap the RIDAC tab.
   - b. Tap the right arrow for a RIDAC record to view its details, tap the more action icon (⋮), and then tap New Risk, New Issue, New Decision, New Action, or New Request Changes option based on the selected record.
   - c. Fill in the fields on the form.

Collaborate with project stakeholders

Collaborate with the project manager and other stakeholders on a project to provide project updates, share documents, or send emails through the mobile app.

Role required: portfolio_manager or project_manager or project_user

1. Navigate to the Project Status application on your mobile app.
2. Open a project for which you want to view the details using one of the following options:
   - Tap to open an applet and then tap on a project.
   - Tap on the Search Projects applet to find a specific project.
   - In the Critical Projects or the Project in Red lists, tap on a project.
3. Collaborate with the project manager and other stakeholders on a project status report in any of the following ways:
   - Add activities to a project status report such as the ability to add work notes or comments, select and upload a picture, or attach photos and files.
a. Tap the **ACTIVITY** tab.

b. Tap the add activity icon (+) and select one of the options:

- Add Work Notes
- Add Additional Comments
- Open Camera
- Open Library
- Attach File

- Send an email to the project manager for additional details of the project.
  a. Tap the **DETAILS** tab.
  b. Tap the send email icon ( ).
  c. In the email application, compose the email, add addresses, and send.

  By default, the **To** field is populated with the email ID of the project manager. You can add other stakeholders.

When you add an activity or change the status in a project, the project manager receives a mobile notification. The project manager should have installed the Project Status app and enabled notifications to receive notifications on the mobile device.

**PPM Collaboration**

Collaborate with your project team on a common enterprise messaging platform such as Slack or Microsoft Teams using the PPM Collaboration application. Facilitate active and timely communication about the project among the project's team members, be involved in critical discussions on your project, and receive real-time updates on the project's status.

By using a project-specific channel on Slack, or a team on Microsoft Teams, decisions taken or updates made for the project would effectively reach all the team members. The team would have easy access to its past communication through the chat history and shared project documents all at one place. By doing so, the project manager and the team members can save the time spent on emails and other offline communication.

A project collaboration channel or team provides the following advantages for the project managers and the team members:

<table>
<thead>
<tr>
<th><strong>Project Manager</strong></th>
<th><strong>Team member</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>• Start your day with a detailed status of the project that you’re managing</td>
<td>• Communicate with the team members to resolve an issue you’re facing</td>
</tr>
<tr>
<td>• Using the status details, choose to follow up with relevant team members through your preferred mode of communication</td>
<td>• Receive status updates from the team members</td>
</tr>
<tr>
<td>• Open the project directly from the collaboration channel or team to drill down into further details</td>
<td>• Contribute to the discussions regarding the project</td>
</tr>
</tbody>
</table>
Project Manager | Team member
---|---
• Real-time updates on changes to milestones, risks, issues, decisions, actions, and change requests (RIDAC), and project financials.
• Automatic addition and removal of members of the collaboration channel or team based on who the project tasks are assigned to.

**Note:** PPM Collaboration is not supported for teamspaces.

**Install PPM Collaboration**

Install the PPM Collaboration (sn_ppm_collab) application from ServiceNow Store.

• Complete the following setup checklist for a smooth installation and configuration.

**Note:** If you are enabling collaboration with Slack, the Slack spoke v2 plugin must be activated. If you are enabling collaboration with Microsoft Teams, the Microsoft Teams Graph and Microsoft Azure AD spokes must be activated. Collaboration cannot be enabled for both Slack and Microsoft Teams for the same project.

<table>
<thead>
<tr>
<th>Setup tasks</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify that the PPM Standard (com.snc.financial_planning_pmo) plugin is activated.</td>
<td>Navigate to Subscription Management &gt; Subscriptions in your instance. The list displays the subscriptions that your organization has purchased.</td>
</tr>
<tr>
<td>Verify that the Slack spoke v2 (sn_slack_ah_v2) plugin is activated, for collaboration with Slack.</td>
<td></td>
</tr>
<tr>
<td>Verify that the Microsoft Teams Graph spoke (sn_msteams_ahv2) plugin is activated, for collaboration with Microsoft Teams.</td>
<td></td>
</tr>
<tr>
<td>Verify that the Microsoft Azure AD spoke (com.sn.azure_ad.spoke) plugin is activated, for collaboration with Microsoft Teams.</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Activation of the PPM Standard and Slack spoke plugins on production instances may require separate licenses. Contact ServiceNow Customer Support for details.

• Ensure that the PPM Collaboration application and all of its associated store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.

Role required: admin

1. Navigate to the ServiceNow Store.
2. In the ServiceNow Store, search for PPM Collaboration.
3. Click the application tile.
   You can view detailed information about the application. Consider reading the Other Requirements and Dependencies sections, as applicable.
4. Click Get and enter your Now Support login credentials.
5. Click Request Install.
6. In the **Instance Name** field, enter your details and click **Validate Instance**.
7. In the **Reason for the Instance** field, enter your details and click **Request**.
   You receive an email with detailed installation instructions.
8. Log in to the instance on which you want to install the PPM Collaboration application.
9. Select **System Applications > All Available Applications > All**.
10. Locate the application using the filter criteria and search bar, select it, and click **Install**.

The following components are installed with installation of the application:

- Roles
- Tables

For more information, see **Components installed with PPM Collaboration**.

- Setting up PPM collaboration for Microsoft Teams
- Setting up PPM collaboration for Slack

**Components installed with PPM Collaboration**
Roles and tables are installed with activation of the PPM Collaboration application.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see **Find components installed with an application**.

---

### Roles installed

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
</table>
| Collaboration user [SN_collab_common.collab_user] | Users with this role have read-only access to the Entity Channel table.  
This role is automatically assigned to project managers and task assignees. |
| Collaboration owner [SN_collab_common.collab_owner] | Users with this role have complete create, read, update, and delete access to the Entity Channel table.  
This role is automatically assigned to project managers. |

### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entity Channel [sn_collab_common_entity_channel]</td>
<td>Stores the list of IDs and names of the Slack channels that are created for the projects.</td>
</tr>
</tbody>
</table>

### Setting up PPM collaboration for Microsoft Teams

Integrate your ServiceNow instance with your organization's Microsoft Teams to enable collaboration of your projects in Microsoft Teams.

PPM Collaboration uses the Microsoft Teams Graph and Microsoft Azure AD spoke actions such as creating a team for your project, adding or removing your project team members, archiving the team when...
the project is closed, posting a message when a record is updated, and so on. To enable these spoke actions, you must integrate your ServiceNow instance with Microsoft Teams Graph and Microsoft Azure AD to authenticate ServiceNow requests. For more information, see the Set up Microsoft Teams Graph spoke and Set up Microsoft Azure AD spoke topics.

**Important:** When you activate the Microsoft Teams Graph and Microsoft Azure AD spokes, a Connection & Credential alias for Microsoft Teams Graph and Microsoft Azure AD is created by default with the IDs `sn_msteams_ahv2.Microsoft_Teams_Spoke` and `sn_azure_ad_spoke.AzureAD` respectively. The connection that is active (the Active field is set to `true`) in Connections related list of this alias uses this default ID to connect your ServiceNow instance to Microsoft Teams Graph and Microsoft Azure AD. Therefore, you can have multiple connections associated with this alias but ensure that only one connection is active at any given time.

### Setting up PPM collaboration for Slack

Integrate your ServiceNow instance with your organization’s Slack to enable collaboration of your projects in Slack.

PPM Collaboration uses the Slack spoke actions such as creating a channel for your project, adding or removing your project team members, archiving the channel when the project is closed, posting a message when a record is updated, and so on. To enable these spoke actions, you must integrate your ServiceNow instance with Slack to authenticate ServiceNow requests. For more information, see Set up Slack spoke.

**Important:** When you activate Slack spoke, a Connection & Credential alias for Slack is created by default with the ID `sn_slack_ah_v2.Slack`. The connection that is active (the Active field is set to `true`) in Connections related list of this alias uses this default ID to connect your ServiceNow instance to Slack. Therefore, you can have multiple connections associated with this alias but ensure that only one connection is active at any given time.

### Flows designed to synchronize projects with your collaboration tool

Understand the flows designed for the PPM Collaboration application so that you can edit the configurations as required.

#### PPM Collaboration flows

<table>
<thead>
<tr>
<th>Slack Flow [Name]</th>
<th>Microsoft Teams Flow [Name]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Slack [action_slack]</td>
<td>Action Teams [action_teams]</td>
<td>Posts a message to the project channel or team whenever an Action is created with priority 1-Critical or 2-High or if the priority of an existing Action is updated to 1-Critical or 2-High.</td>
</tr>
<tr>
<td>Add Assigned Users To Channel</td>
<td>Add Assigned Users To MS Group</td>
<td>Handles adding the users in the Assigned to or Additional Assignee list fields of the project tasks to the project channel or team.</td>
</tr>
<tr>
<td>[add_assigned_users_to_channel]</td>
<td>[add_assigned_users_to_ms_group]</td>
<td></td>
</tr>
<tr>
<td>Archive Project Channel</td>
<td>Archive MS Group [archive_group]</td>
<td>Handles archival of the project channel or team based on the count of number of days from which the project is moved to a closed state. This flow is set to run daily at 08:00 AM.</td>
</tr>
<tr>
<td>[archive_project_channel]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slack Flow [Name]</td>
<td>Microsoft Teams Flow [Name]</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Change Request Slack</td>
<td>Change Request Teams</td>
<td>Posts a message to the project channel or team whenever a Change request with priority 1-Critical or 2-High is created or if the priority of an existing Change request record is updated to 1-Critical or 2-High.</td>
</tr>
<tr>
<td>Daily Project Status Slack</td>
<td>Daily Project Status Teams</td>
<td>Triggers a message about the overall status of the project to the project channel or team everyday at 08:00 AM.</td>
</tr>
<tr>
<td>Decision Slack</td>
<td>Decision Teams</td>
<td>Posts a message to the project channel or team whenever a Decision with priority 1-Critical or 2-High is created or if the priority of an existing Decision is updated to 1-Critical or 2-High.</td>
</tr>
<tr>
<td>Issue Slack</td>
<td>Issue Teams</td>
<td>Posts a message to the project channel or team whenever an Issue with priority 1-Critical or 2-High is created or if the priority of an existing Issue is updated to 1-Critical or 2-High.</td>
</tr>
<tr>
<td>Milestone/KeyMilestone Slack</td>
<td>Milestone/KeyMilestone Teams</td>
<td>Posts a message to the project channel or team whenever a Milestone or a Key Milestone task is moved to the closed state.</td>
</tr>
<tr>
<td>Project Manager Changes Slack</td>
<td>Project Manager Changes MS Teams</td>
<td>Handles adding the new project manager as a member to the project channel or team. This flow also checks if the user who was the old project manager is assigned to any project tasks and if not assigned to any task, removes the user from the channel.</td>
</tr>
</tbody>
</table>
| Project Status Slack      | Project Status Teams         | Posts a message to the project channel or team in the following three scenarios:  
- **State** field is updated to Closed Complete, Closed Incomplete, or Close Skipped states  
- **Status** fields is updated  
- Project manager changes for this project |
| Risk Flow Slack           | Risk Flow Teams             | Posts a message to the project channel or team whenever a Risk with probability High or Absolute is created or if the probability of an existing risk is updated to High or Absolute. |

All the flows, except the subflows, are inactive by default. Enable the collaboration between PPM and Slack or Microsoft Teams for a specific action by activating these flows. You can view all these flows by navigating to **Flow Designer > Designer** and filtering the flows by the PPM collaboration application. For more information, see **Activate a flow**.

If you want to update the configuration for any of these flows, you can edit them. For example, if you want to update the time of daily status update from 8:00 AM to 9:00 AM, you can edit the Daily Project Status Slack [daily_project_status] or Daily Project Status Teams [daily_project_status_teams] flow. For more information, see **Edit a flow**.
Create a Microsoft team for your project

Create a Microsoft team for your project to start collaborating with your team and receive timely updates of the project.

Ensure that the project for which you want to create a team is active and not in a closed state.

Role required: it_project_manager

**Important:** You must be the designated project manager for this project in addition to having the it_project_manager role.

1. Navigate to **Project > Projects > All.**
2. Open the project for which you want to create a team.
   
   Ensure that you are the project manager for the project you open.
3. Enable collaboration for the project by clicking the **Enable MS Teams Collaboration** related link.

- A Microsoft team is created for the project. You can see the team's name in the success message on your project form.
- You and the administrator are added as owners in the team.
- Any assignees and additional assignees of active project tasks for this project are added as members to this team.

Assignees and additional assignees of project tasks that you create later will be automatically added as members to this team if you enable the Add Assigned Users To MS Group flow. However, new or existing stakeholders added to the project are not added as members to this channel.

**Note:** Users assigned to the tasks (assignee and additional assignee) from Planning Console will not be added automatically to the Microsoft team.

- Once a team is successfully created for a project, the **Enable MS Teams Collaboration** related link is removed from that project. Collaboration cannot be enabled for both Slack and Microsoft Teams for the same project. If you have clicked on the **Enable MS Teams Collaboration** related link for a project, and you click the **Enable Slack Collaboration** related link before the MS team is created, a message will be displayed specifying that MS Teams creation is in progress.

If you are unable to create a team, retry the procedure after sometime. If the issue persists, contact your system administrator.

Create a collaboration channel for your project

Create a Slack channel for your project to start collaborating with your team and receive timely updates of the project.

Ensure that the project for which you want to create a Slack channel is active and not in a closed state.

Role required: it_project_manager

**Important:** You must be the designated project manager for this project in addition to having the it_project_manager role.

1. Navigate to **Project > Projects > All.**
2. Open the project for which you want to create a Slack channel.
   
   Ensure that you are the project manager for the project you open.
3. Enable collaboration for the project by clicking the **Enable Slack Collaboration** related link.
• A channel in Slack is created for this project. You can see the channel's name in the success message on your project form.

• You and any existing assignees and additional assignees of active project tasks for this project are added as members to this channel.

Assignees and additional assignees of project tasks that you create later will be automatically added as members to this channel if you enable the Add Assigned Users To Channel flow. However, new or existing stakeholders added to the project are not added as members to this channel.

**Note:** Users assigned to the tasks (assignee and additional assignee) from planning console will not be added automatically to the Slack channel.

• Once a channel is successfully created for a project, the **Enable Slack Collaboration** related link is removed from that project. Collaboration cannot be enabled for both Slack and Microsoft Teams for the same project. If you have clicked on the **Enable Slack Collaboration** related link for a project, and you click the **Enable MS Teams Collaboration** related link before the Slack channel is created, a message will be displayed specifying that Slack channel creation is in progress.

If you are unable to create a channel, retry the procedure after sometime. If the issue persists, contact your system administrator.

**Notifications for project updates in your collaboration tool**

Receive updates related to your project on your Slack channel or Microsoft team. Analyze the delayed and overdue tasks, follow closure of milestones, and monitor changes to risk, issue, decision, action, and change request (RIDAC) items of your project.

Using the automatic project status updates on the project collaboration channel or team, project managers can take informed decisions about project planning, resource management, finance allocation. The team members can understand updates made to the project and actively collaborate on any delayed or overdue tasks.

**Note:** Project managers can reach out to their system administrators to configure the application settings for these notifications according to their preferences.

**Daily notification on project status**

A notification with the consolidated project status is sent to the project's channel daily at 8:00 AM which consists of the following information.

<table>
<thead>
<tr>
<th>Notification</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project overview</td>
<td>• A direct URL of the project. Clicking this URL opens the project in your ServiceNow instance.</td>
</tr>
<tr>
<td></td>
<td>• Name of the project.</td>
</tr>
<tr>
<td></td>
<td>• Planned start and end dates of the project.</td>
</tr>
<tr>
<td></td>
<td>• State of the project, for example, Work in Progress.</td>
</tr>
<tr>
<td></td>
<td>• Status of the project, for example, Green.</td>
</tr>
<tr>
<td></td>
<td>• Percentage of project completion.</td>
</tr>
<tr>
<td></td>
<td>• Any exceptions like estimation at completion is greater than total planned cost, planned end date is later than the approved end date, project not started on the start date, and project running late.</td>
</tr>
</tbody>
</table>
### Notification

<table>
<thead>
<tr>
<th>Notification</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project tasks due today</td>
<td>List of project tasks that have planned end date marked as today and are in the Work in Progress state. The list displays only five project tasks that are sorted alphabetically by their short description.</td>
</tr>
<tr>
<td>Overdue Tasks (Tasks not started on planned start date)</td>
<td>List of project tasks which have a planned start date before today but are not in either the Work in Progress or Closed states. The list displays only five project tasks that are sorted in an ascending order of the planned start dates so that you get high visibility into the tasks that are overdue for a longer period.</td>
</tr>
<tr>
<td>Delayed Tasks (Tasks not completed on planned end date)</td>
<td>List of project tasks which have a planned end date before today and are in the Work in Progress state. The list displays only five project tasks that are sorted in ascending order of the planned end dates so that you get high visibility into the tasks that have been delayed for a longer period.</td>
</tr>
<tr>
<td>Project tasks due within seven days</td>
<td>List of five of the following project tasks that have a planned end date within seven days from today. All these tasks are displayed in ascending order of their due dates so that you get high visibility into the tasks that are due soon.</td>
</tr>
</tbody>
</table>

- **Note:** Tasks that in Closed state are not displayed in the list.

  - High priority risks, issues, and action items
  - Milestone or key milestone tasks

### Notification regarding change of project manager

When there is a change in the manager of your project, an update is made to the Project manager field of the project record.

- A notification including the project URL is sent to your project channel on this update.
- New project manager is added as a member of the channel.
- If no project tasks are assigned to the old project manager, this user is removed as a member of the channel.

### Notification for other updates to the project

<table>
<thead>
<tr>
<th>Notification</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project's status</td>
<td>When an update is made to the Status or State fields of the project, a notification including the project URL is sent to your project channel.</td>
</tr>
</tbody>
</table>
You receive notifications in your project channel when a new RIDAC record is added to or an existing RIDAC record is updated in the project for the following scenarios. With every notification, you receive a direct URL to the corresponding record.

- **Risk**
  - New risk is created with the Probability field set to **High** or **Absolute**
  - The Probability field for an existing risk is updated to **High** or **Absolute**
- **Issue, Decision, Action, and Change request**
  - New record is created with the priority field set to **1-Critical** or **2-High**
  - Priority of an existing record is updated to **1-Critical** or **2-High**

Whenever a key milestone or milestone task is Closed Complete, Closed Incomplete, and Closed Skipped, you are notified about the closure and the user who closed it, with a direct URL to the milestone task.

### Archiving your project collaboration channel or team

Understand how your project Slack channel or Microsoft team is archived when your project is moved to a closed state.

### Moving the project to a closed state

When the project manager moves the project to Closed Complete, Closed Incomplete, or Closed skipped state, the following actions are triggered:

- A notification about project closure is sent to the channel or team immediately.
- The channel or team is archived within 15 days from the day the project is moved to a closed state.

  This duration of 15 days helps the project members to bring any pending communication to closure or share any pending project documentation.

  Project managers can contact their administrator to update this duration of 15 days to a value of their choice.

### Deletion of a project task

When a project task is deleted, the members in the corresponding Slack channel or Microsoft team are not removed automatically. To remove the members on deletion of a project task, you must enable the **Remove Users From Slack/Teams Channel** business rule. This business rule is created on the Project Task table and is not enabled by default. For more information, see Business rules.

### Deletion of the project channel or team

If the channel is deleted in the Slack application, or the team is deleted in the Microsoft Teams application, the PPM Collaboration application does not handle the deletion of the project's reference in the Entity Channel [sn_collab_common_entity_channel] table automatically. So, the project manager cannot see the **Enable Slack Collaboration** or **Enable MS Teams Collaboration** related link on the project form again.
If the project manager wants to create a channel or team again for this project, the administrator must manually delete the project's reference from the Entity Channel table. Then, the related link to enable collaboration appears on the project form.

**Virtual Agent for PPM**

ServiceNow® Virtual Agent for PPM enables project managers to get quick answers to business-related queries by interacting with a virtual agent through various messaging services.

Virtual Agent for PPM helps project managers view business-related information quickly in a single step rather than having to navigate through various lists. For example, you can get the list of all your project tasks that are overdue.

The base system provides the following predefined Virtual Agent topics (chatbot conversations):

- **Project and Task status**
  - All active projects
  - Projects with status red
  - Projects ending next week and % complete less than 60%
  - Overdue milestones/ key milestones
  - Overdue tasks
  - Delayed tasks

- **Resources**
  - Resource plans with actual hours greater than allocated hours
  - Unallocated resource plans starting next week
  - Unallocated resource plans with requested extension

- **Financials**
  - My active projects
  - Projects with EAC greater than planned cost
  - Projects with EAC greater than budget

- **RIDAC (Risk, Issue, Decision, Action, and Request Changes)**
  - Absolute and high probability risks due this week
  - Critical and high priority issues due this week
  - Critical and high priority action items due this week

- **Data quality**
  - Projects without business case
  - Projects without strategy
  - Projects without program or portfolio

A topic defines the dialog between the Virtual Agent (chat support bot) and user, which enables you to gather information for a specific business need. For more information, see Virtual Agent.

**Integration with messaging applications**

You can run Virtual Agent bot conversations for PPM using third-party messaging applications like Slack or Microsoft Teams.

Use the Virtual Agent integration app to configure the messaging apps for your instance.
For more information, see Virtual Agent integration with messaging apps.
For more information on integrating with Slack or Microsoft Teams, see Set up Virtual Agent notifications for Slack and Teams.

Install Virtual Agent for PPM

Install Virtual Agent for PPM from the ServiceNow store.

Role required: admin

To install Virtual Agent for PPM, activate the following plugins:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PPM Standard (com.snc.financial_planning_pmo)</td>
<td>Activates the PPM Standard basic plugin for the PPM (Project Portfolio Management) applications.</td>
</tr>
<tr>
<td>Glide Virtual Agent (com.glide.cs.chatbot)</td>
<td>Activates the Virtual Agent framework and other necessary plugins.</td>
</tr>
<tr>
<td>Virtual Agent for PPM (com.sn_ppm_va)</td>
<td>Activates a conversational bot platform for providing user assistance through conversations within a messaging interface for PPM.</td>
</tr>
</tbody>
</table>

1. Navigate to System Applications > All Available Applications > All.
2. Find the application using the filter criteria and search bar.
   You can search for the application by its name or ID. If you cannot find an application, you may have to request it from ServiceNow store.
   Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
3. Click Install.
4. In the Application installation dialog box, review the application dependencies.
   Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If there are any plugins or applications that need to be installed, you must install them before you can install Virtual Agent for PPM.
5. Optional: If demo data is available and you want to install it, click Load demo data.
   Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.
   
   Important: If you don’t load the demo data during installation, it's unavailable to load later.
6. Click Install.

Enable Virtual Agent for PPM

Enable Virtual Agent for PPM to start chatting with the Virtual Agent.

Role required: admin, virtual_agent_admin

The base system provides predefined Virtual Agent topics (chatbot conversations). To customize a topic, duplicate it and then edit it. See Virtual Agent Designer

1. Navigate to Collaboration > Virtual Agent > Designer > Topics.
2. Click the PPM Virtual Agent card to open it.
   • To use the provided topic with no changes, click Publish.
To duplicate the topic so you can customize it, click **Duplicate**. Enter a name for the duplicate topic and click **Save**.

**PPM Virtual Agent conversation flows**

Virtual Agent for PPM provides several predefined topic conversations to enable project managers to gather information on their business-related tasks.

The following predefined topic conversations are available to view if you have the `it_project_manager` role.

**Project and task status**

Project and task-related information like active projects, projects that are in the red state, projects due to end in the near future, and projects with overdue tasks and milestones. This information helps you track and plan projects per set milestones.

**Resources**

Resource-related information such as resource plans containing actual hours greater than allocated hours, or unallocated resource plans that are due to start in the coming week or have an extension requested. You can then manage resources and act on resource plans that are not progressing as planned.

**Financials**

Finance-related information such as projects where the estimate at completion amount is greater than the planned cost or projects where the estimate at completion amount is greater than the budget amount. This information helps you understand the financial performance of your projects.

**RIDAC**

RIDAC (Risks, Issues, Decisions, Actions, and Request Changes) related information like projects with absolute or high probability risks due in the coming week, or projects with critical or high probability issues and actions due in the current week. This information helps you analyze and identify patterns, trends, and probable resolution for planning future projects.

**Data quality**

Quality-related information like projects that do not have a business case, strategy, program, or portfolio assigned to them. This information helps you evaluate projects that are not aligned to any strategy, business case, program, or portfolio.

**Reusable PPM Virtual Agent topic blocks**

You can create and reuse topics blocks to simplify the topic authoring and maintenance process. Topic blocks enable you to reuse standard procedures across conversation topics.

The following predefined reusable topic blocks are available:

- Project Topic for PPM VA
- Specific Project Options
- Project Data Quality Topic for PPM VA
- Project Financials Topic for PPM VA
- Resource Topic for PPM VA
- RIDAC Topic for PPM VA

To view just the reusable topic functions, access the Topics page in Virtual Agent Designer and click the **Topic Blocks** tab. For detailed information, see **Reusable topic blocks**.
Resource Management

The ServiceNow® Resource Management application enables resource requesters, such as project managers or change managers, to create resource plans, request resources, and analyze resource availability and utilization.

Resource managers use the application to allocate resources to tasks. The Resource Management application can be used in conjunction with any task on the platform, including project tasks, incidents, problems, or changes.

Watch this four-minute video to learn about the purpose of Resource Management application, creating resource plans, requesting and allocating resources, and analyzing resource availability and capacity for maximum resource utilization.

With the Resource Management application:

- Resource requesters can create resource plans that specify group or user resources required by tasks. They can verify resource availability and make changes to their resource plans prior to requesting resources.
- Resource managers can view availability, existing allocations, and utilization for the requested resources and make allocations based on resource availability.
- Resource managers can perform what-if analysis by changing resource plan dates, resources, requested hours and proposed allocations to analyze impact on resource utilization and availability.

The Resource Management application is activated as part of the PPM Standard.

Resource management process

The resource plan is the key to understanding how resource management works.

A user with the resource_user role can be a resource requester. Project managers are used as resource requesters in many examples because they typically have the resource_user role.

A resource requester creates a resource plan to request user or group resources for tasks. Any type of task, such as a change request, a task in the Agile scrum process, or a project task can be added to a resource plan.

After a resource plan is submitted, a resource manager reviews the plan, confirms the resources, and finally allocates resources for the plan. If all parties agree, the resources begin work.

Resource Management properties

The Resource Management application provides several properties to control allocations, schedules, and other settings.

You need the PPS admin role to access the Resource properties.

To manage resource properties, navigate to Project Administration > Settings > Properties – Resource.
# Resource management properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum number of daily resource allocation records that should be considered in synchronous mode for confirmation and allocation.</td>
<td>Determines the maximum number of daily resource allocation records that should be considered in synchronous mode during confirmation and allocation. The property improves the system performance when the number of daily allocation records is more than the value set in the property. The default value is 2600 which implies that the number of daily records considered for confirmation or allocation in synchronous mode is 2600. The value is equivalent to confirming or allocating 10 users on a group resource plan for 1-year duration (260 working days) or 5 users for 2-year duration, and so on. If the group resource plan contains 11 users for 1-year duration, the number of daily records are 2860. Thus the confirmation and allocation of the resource plan in this case is in asynchronous mode. If you always want to confirm and allocate the resource plan in synchronous mode, set the value of the property to a higher number based on your requirements. <strong>Note:</strong> If the property <code>com.snc.resource_management.run_state_changes_async</code> is set to true, the confirmation and allocation of resource plans is always considered in asynchronous mode.</td>
<td>2600</td>
</tr>
<tr>
<td>Show Week/Month toggle on resource grid interface</td>
<td>Shows the toggle button for switching between week and month in the resource grid.</td>
<td>Yes</td>
</tr>
<tr>
<td>(com.snc.resource_management.show_week_month_toggle)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximum time duration in Resource Finder in months</td>
<td>The maximum duration for which the resource details should be shown in the resource finder.</td>
<td>24</td>
</tr>
<tr>
<td>(com.snc.resource_management.max_dur_resource_finder)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Use budget reference rates to calculate the Resource requested/allocated cost to derive hourly rate from Labor rate cards | **•** When the property is set to Yes, the budget reference rates [itfm_fx_rate] are used to calculate the resource requested or allocated cost.  
**•** When the property is set to No, exchange rates [fx_rate] are used to calculate the resource requested or allocated cost. For upgraded customers, the property is by default set to No. | Yes          |
| (com.snc.resource_management.use_budget_reference_rates)               |                                                                                                                                                                                                              |               |
| Maximum number of days for which a resource plan can be created.        | Restricts the maximum number of days for which a resource plan should be created.                                                                                                                                 | 3660          |
| com.snc.resource_management.plan.max_duration                           |                                                                                                                                                                                                              |               |

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Schedule Name</td>
<td>The schedule on the instance that the Resource Management application uses by default.</td>
<td>Resource Management Schedule</td>
</tr>
<tr>
<td>If resource_management reporting for a resource/group has value of percentage_allocation less than this value the color will be shown as green.</td>
<td>The value that determines when the availability of the resource is shown as green on the resource report. Green signifies that the resource is not being fully utilized and is probably available to have the work allocated.</td>
<td>50</td>
</tr>
<tr>
<td>If resource_management reporting for a resource/group has value of percentage_allocation less than this value and greater than the com.snc.resource_management.percentage_allocation_normal, then color will be shown as orange.</td>
<td>The value that determines when the availability of the resource is shown as orange on the resource report. Orange signifies the resource does not have much availability.</td>
<td>90</td>
</tr>
<tr>
<td>Average Daily FTE Hours/Hours Per Person Day</td>
<td>The average daily full-time equivalent in hours or number of hours per person day. This value is used as the equivalent of a full-time day if no value is specified in the Average Daily FTE Hours/Hours Per Person Day field on the user or group resource record.</td>
<td>8 (hours)</td>
</tr>
<tr>
<td>Calendar Event Duration (Minutes)</td>
<td>The default duration for a calendar event. Resource allocations use this property to create allocations. For example, a user is available for three blocks of time: two 30-minute blocks and one 60-minute block.</td>
<td>60 (minutes)</td>
</tr>
</tbody>
</table>

Note: Capacity is not derived from FTE, but from schedules. Both FTE and schedules must be in synchronization with each other.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Day of Week (Monday = 1, Sunday = 7)</td>
<td>Determines which day of the week is the first day. The resource workbench uses this value to calculate the week number.</td>
<td>1 (Monday)</td>
</tr>
<tr>
<td>com.snc.resource_management.first_day_of_week (com.snc.resource_management.first_day_of_week)</td>
<td>If the value of this property is set to 2 (Tuesday), the allocation is made and presented in the workbench in two blocks:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• From Wednesday October 14 to Saturday October 15.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Tuesday October 20.</td>
<td></td>
</tr>
<tr>
<td>Perform Resource Confirmation/Allocation/ Cancellation in asynchronous mode (com.snc.resource_management.run_state_changes_async)</td>
<td>Uses asynchronous mode when confirming, allocating, or canceling resource plans to improve application performance.</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Because resource confirmation and allocation create calendar events for each resource in a group, and also consider each resources schedule, the confirmation and allocation process can take an excessively long time to complete.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>In asynchronous mode, the application uses an event manager to handle errors that might occur when processing the state of the resource plan. If the property is enabled:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The state of the resource plan changes to Confirmation in Progress / Allocation in Progress / Cancellation in Progress.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If the confirmation, allocation, or cancellation does not work, the Confirm, Allocate, or Cancel UI actions appear so you can reprocess the action. If an allocation is only partially completed, you can click the Allocate UI action again to remove all previously created events for the plan and reprocesses the action.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Enable this property if you encounter errors or longer processing times when handling confirmations, allocations, or cancellations. This might occur if there are more than 25 members in a group or if the duration of the resource plan exceeds 6 months.</td>
<td></td>
</tr>
<tr>
<td>Comma separated list of resource event types which will be excluded from user's schedule to calculate available capacity and to avoid making resource allocations on the days having these events (time_off, meeting, etc.)</td>
<td>Specifies which events must be excluded for capacity calculations of the resources and when the system must not create events.</td>
<td>time_off</td>
</tr>
<tr>
<td>com.snc.resource_management.exclude_events_from_schedule</td>
<td>The events to be entered must be from the Category field in the time card table.</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td>Default value</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Show soft allocations in calendar for</td>
<td>Shows the following options:</td>
<td>Resource Managers</td>
</tr>
</tbody>
</table>
| com.snc.resource_management.calendar_show_soft_allocations | • **Resource Managers**: When selected, soft allocations can be seen in the calendar by the resource managers only.  
• **Everyone**: When selected, soft allocations can be seen in the calendar by all users who have the PPS Resource role. |               |
| Number of records fetched at a time in       | The number of records that are fetched in resource grid in one server call. | 30            |
| Resource Grid                                | For example, if there are 100 projects in an allocation board, when the user scrolls down, a call is made to fetch the next 30 projects. Similarly, when the user expands a project containing, say 100 resource plans, only 30 resource plans are fetched in the first call. Upon scrolling, the next 30 plans are fetched, and so on. |               |
| com.snc.resource_management.number_of_records_to_fetch_at_a_time |                                                                          |               |

**Resource plans**

Resource plans are the key element in resource management.

Resource requesters, such as project managers, create resource plans to ask for resources, track effort, and track costs. Resource managers modify and approve resource plans before the plans are used.

All resource plans for a task appear on the Resource Plan related list of the Project task form, where resource requesters can access them.

Watch this three-minute video to learn about the purpose and usage of resource plans.
Resource plan on the Project form

Resource plans progress through several states.

Resource plan states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planning</td>
<td>Planning is the default state when a resource requester creates a resource plan. Any plan in this state can be edited. Requested Allocations are created when a resource plan is in Planning state. When a resource requester asks for a change to a plan that was already submitted, the plan reverts to the Planning state.</td>
</tr>
<tr>
<td>State</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Requested</td>
<td>Resource requester submits a resource plan for resource managers review by clicking <strong>Submit</strong>. The resource plan then moves into the Requested state. Resource managers confirm and allocate resources or reject the plan, and finally close the plan. The resource requester can request a group, specific users in a group, or a specific user to work on the selected task. After you submit the plan for review, a resource manager can confirm, and then allocate some or all the requested users. If the task requires more than one user or groups, multiple resource plans can be created for the given task.</td>
</tr>
<tr>
<td>Rejected</td>
<td>Resource manager can reject a resource plan by clicking <strong>Reject</strong>. The resource plan then moves into the Rejected state. Rejected plans stay in that state until changes are made and the requester can re-request the resources.</td>
</tr>
<tr>
<td>Confirmed</td>
<td>After the plan is requested, the resource manager can block/confirm the resources for future projects and demands. The resource plan then moves into the Confirmed state. Only a resource manager can modify the plans in Confirmed state. Soft allocations are created when the resource plan moves to the Confirmed state.</td>
</tr>
<tr>
<td>Allocated</td>
<td>After the plan is confirmed, the resource manager can review the plans, view availability, change resource preferences and perform the resource allocation. The resource plan moves into the Allocated state. A resource manager can only cancel, complete, or modify it. Soft allocations are converted to hard allocations when the resource plan moves to the Allocated state. Note: You can also set a plan to the Allocated state directly from the Requested state using <strong>Confirm and Allocate</strong> option.</td>
</tr>
<tr>
<td>Completed</td>
<td>After all associated tasks and projects are complete or canceled, an Allocated resource plan can be completed. This deletes all the resource allocations for the resource plan post the completion date.</td>
</tr>
<tr>
<td>Canceled</td>
<td>A plan can be canceled if the allocations are no longer required. This removes all past and future allocations. A canceled resource plan can be brought back to the Planning state if it has no past allocations. Resource plans in Planning, Requested, Confirmed, or Allocated state can be canceled.</td>
</tr>
</tbody>
</table>
States in Resource Management
**Note:** When a resource requester wants to change a plan that was already submitted for review (in Requested or Confirmed state but not yet allocated), the requester can request a change. The plan then moves back to the Planning state.

Resource Management supports time zones, which are important in the My Calendar and Resource Workbench modules.

**Modifications in Confirmed or Allocated state**

Only a resource manager can modify a resource plan in the Confirmed or Allocated state.

- The effects of modification in header area on a resource plan form in Confirmed state are:
  - All soft allocations are deleted.
  - Requested allocations are re-created with changed values.
  - Resource plan moves back to the Requested state.

- The effects of modification in header area on a resource plan form in Allocated state are:
  - All resource allocations (soft and hard) are deleted.
  - Requested allocations are re-created with changed values.
  - Resource plan moves back to the Requested state.

The resource manager can also modify or delete the past dated resource allocations for Allocated resource plans if no actual hours are recorded for those resource allocation records. When a user submits a time card, upon approval of the time card, actual hours are updated for an allocation record.

**Note:** The resource plan does not move back to the Requested state if the changes are made to allocation records only.

**Request type**

You can request a resource plan using one of the following options:

- **Hourly:** The request is in terms of the number of hours the resources are necessary.
- **FTE:** The request is in terms of an equivalent value that represents full-time work. When the request type is FTE, planned hours are calculated as: Average Daily FTE * number of working days in resource plan * the FTE value. The average daily FTE hours are specified in User and Group records. If there is no value specified at User or Group record, the average daily FTE hours is taken from the Default Average Daily FTE property.

The number of working days is calculated based on the users schedule for a user resource or the default schedule for group resources. The default schedule is taken from the Default Schedule Name property.

For example, say that the average daily FTE for a group is 40 hours, the resource plan period is from September 1 to September 10, and the FTE is 0.5.

Assuming 8 working days during the plan period, planned hours = 40 * 8 * 0.5 = 160 hours.

**Note:** Capacity is not derived from FTE, but from schedules. Both FTE and schedules must be in synchronization with each other.
• **Person days**: The request is in terms of person days. When the request type is person days, planned hours are calculated as: \( \text{Total number of person days} \times \text{Average Daily FTE Hours/Hours Per Person Day} \).

For example, say the Average Daily FTE Hours/Hours Per Person Day for a group is 8 hours, and the person days is 3. Then, planned hours = \( 8 \times 3 = 24 \) hours.

**Resource plan costs**

Resource plan costs can be tracked directly in the resource plan record. Resource plan costs are divided into planned, allocated, and actual.

If the **Rate override** option in a resource plan is selected, the hourly rate for calculating the corresponding resource plan cost is derived from the rate specified in the **Resource rate** field.

If a **rate model** is associated to the project or demand, the hourly rate is derived from the rate model. Whenever the hourly rates in the associated rate model change, you must **recalculate the resource costs** of the resource plan to reflect the new rates.

If rate model is not available, the hourly rate for calculating the corresponding resource plan cost is derived from labor rate card.

Projects and Demands can have multiple resource plans. The aggregated costs for all resources plans roll up to the **Planned Cost** and **Allocated Cost** fields and the **Resource Cost** section of both projects and demands.

**Create a resource plan**

You can create a resource plan from the Resource Management application for any task such as demand, project, project task, incident, problem, or change. You can edit and adjust the plan until you submit it for approval.

Role required: resource_user or admin

1. Create a resource plan using one of the following options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
                                          b. Click the required allocation board.  
                                          c. In the Allocation workbench, click the **New Plan** located in the top-right corner. |
| From Resource tab in project workspace | a. Open a project record in project workspace.  
                                          b. On the **Resources** tab, click **New**. |
| From a project form                    | a. Navigate to Project > Projects > Project Workspace.  
                                          b. Open a project record.  
                                          c. In the **Resource Plan** related list, click **New**. |
Option | Description
--- | ---
**From a demand form**<br>a. Navigate to Demand > Demands > All.<br>b. Open a demand.<br>c. In the Resource Plans related list, click Manage.<br>d. On the Resource Plans page, click New.

**From a project task**<br>a. Navigate to Project > Projects > Project Workspace.<br>b. Open a project record.<br>c. Click the Details tab.<br>d. In the Project Tasks related list, open a task.<br>e. In the Resource Plan related list, click New.

**From an existing resource plan**<br>a. Open the resource plan record that you want to copy.<br>b. In the related links, click Copy Resource Plan.

> Note: When you create a resource plan from an existing resource plan, all fields are copied to the new resource plan. The new plan is created in the Planning state.

2. On the form, fill in the fields.

**Resource Plan form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Automatically generated identification number for the plan.</td>
</tr>
<tr>
<td>Resource type</td>
<td>Category of resource. To select a group, select Group. To select an individual user, select User. To select a resource by role, select Role.</td>
</tr>
<tr>
<td>Group</td>
<td>Specific group resource to associate with the plan.</td>
</tr>
<tr>
<td></td>
<td>If you select Role in the Resource type field, then the Group list contains groups only for the selected role.</td>
</tr>
<tr>
<td>User</td>
<td>Specific user resource to associate with the plan.</td>
</tr>
<tr>
<td></td>
<td>This field appears if you select User in the Resource type field.</td>
</tr>
<tr>
<td>Role</td>
<td>Specific resource role that you want to associate with the plan.</td>
</tr>
<tr>
<td></td>
<td>This field appears if you select Role in the Resource type field.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Members preference  | Specific members, any member, or all members from the selected group or role. The default is All members. This field appears only when the Group or Role option is selected in the Resource type field.  
• To request all members of a group or role, select All members. The requested time gets split among all members of the selected group or role proportionally depending on their capacity. Before making the hard allocation, if all members are not required, the resource manager can select only the desired members of the group or role.  
• To request specific members of a group or role, select Specific members, and then select members from the Members list. The requested time gets split among the selected members of the selected group or role proportionally depending on their capacity.  
• To select any member of a group or role, select Any member. Resources that are most available during the plan duration are requested first. Soft allocation is created only for these resources on confirmation.  
For more information about the effect of members preference on the calculation of hours for soft and hard allocations, see Resource allocation. |
<p>| Skills              | Specific skills the requested resources should possess to allocate them to the resource plan. This field appears if you select Group or Role in the Resource type field, and All members or Any member in the Members preference field. For more information, see Skills Management.                                                                                                                                                                                                                                             |
| Request type        | Type of request. To specify a request in hours, select Hours. To specify a request in full-time equivalents, select FTE.                                                                                                                                                                                                                                                                                                                                                                        |
| FTE                 | Number of units for the full-time equivalent selection. This field appears if you select FTE in the Request type field. For more information, see Resource plans.                                                                                                                                                                                                                                                                                                                                 |
| Planned hours       | Estimated number of work hours required to complete all resource plan work.                                                                                                                                                                                                                                                                                                                                                                                                                      |
| Name                | Descriptive name for the plan. If you do not enter a name, the name becomes the Number + Short description. If the short description for the task is empty, the plan number is used.                                                                                                                                                                                                                                                                                                          |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task</td>
<td>Task to which the plan applies. If the resource plan was created from a project task, the task number appears here.</td>
</tr>
<tr>
<td>Start Date</td>
<td>Start date for the resource plan. By default, this field shows the <strong>Planned start date</strong> of the associated project record or task record. Edit the default date, if necessary.</td>
</tr>
<tr>
<td>End Date</td>
<td>End date for the resource plan. By default, the date is derived from the <strong>Planned end date</strong> of the associated project record or task record. Edit the default date, if necessary.</td>
</tr>
<tr>
<td>Allocation spread</td>
<td>Type of hard allocation. The value in this field determines the manner in which the allocated hours are spread while creating hard allocations. Select either option:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Even</strong>: Create resource events for the resource by splitting the hours evenly across all working days for the allocation duration.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Front load</strong>: Create resource events for the resource by filling up all available slots of the resource from the start date of the allocation.</td>
</tr>
<tr>
<td></td>
<td>For example, if a resource is requested for 30 hours in Week 10:</td>
</tr>
<tr>
<td></td>
<td>• Selecting <strong>Even</strong> equally divides 30 hours to all weekdays, that is, 6 hours per day for a five-day work week.</td>
</tr>
<tr>
<td></td>
<td>• Selecting <strong>Front load</strong> first consumes all available hours on Monday, then move on to Tuesday, and so on, until all 30 hours are allocated. If the resource is not available for 30 hours in Week 10, Front load over-allocates by filling up the remaining hours from start date up to 24 hours per day.</td>
</tr>
<tr>
<td>State</td>
<td>State of the resource plan. The plan starts in the Planning state.</td>
</tr>
<tr>
<td>Rate override</td>
<td>Option for overriding the hourly rate derived from the rate model or the labor rate card.</td>
</tr>
<tr>
<td></td>
<td>When the option is selected,</td>
</tr>
<tr>
<td></td>
<td>• The planned, confirmed, and allocated costs of the resource plan is derived from the rate specified in the <strong>Resource Rate</strong> field.</td>
</tr>
<tr>
<td></td>
<td>• When the user submits the time card for the resource plan, the rate specified in the <strong>Resource Rate</strong> field is used to calculate the actual cost of the resource plan.</td>
</tr>
<tr>
<td></td>
<td>The option is enabled only if the resource plan is in the Planned state.</td>
</tr>
<tr>
<td></td>
<td>By default, the option is not selected.</td>
</tr>
</tbody>
</table>
## Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource rate</td>
<td>Hourly rate of resource that overrides the hourly rate returned from the rate model to calculate the planned and actual costs of the resource plan. This field appears when the Rate override option is selected.</td>
</tr>
</tbody>
</table>

**Note:** The Members Preference, Allocation spread, and State fields are not available by default on the form when opened from the resource grid. If required, you can configure these fields. If the resource plan is created from the list view, the fields are already available.

3. Click **Save** on the form header. The resource plan is saved and placed in the Planning state.
4. Review and if required update values in the following tabs:

### Resource Plan form tabs

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Resource Details</strong></td>
<td></td>
</tr>
</tbody>
</table>
| Resource type  | Type of resource selected during the creation of resource plan.  
  • The Members preference and Skills fields are displayed only if you select Group or Role in the Resource type field.  
  • The User field is displayed only if you select User in the Resource type field. |

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Request Details</strong></td>
<td></td>
</tr>
</tbody>
</table>
| Request type   | Type of request selected during the creation of resource plan.  
  • If you select FTE in the Request Type field, the FTE field is displayed.  
  • If you select Person Days in the Request Type field, the Person days field is displayed. |
| Confirmed/Allocated hours | Confirmed or allocated hours rolled up from resource allocations. |
| Actual hours   | Actual hours rolled up from time card entries. |

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planned cost</td>
<td>Amount in <strong>Planned hours</strong> multiplied by the hourly rate of the specified user or group resource. This amount is a first-draft estimate of the resource plan cost. The hourly rate is derived from one of the following sources:</td>
</tr>
<tr>
<td></td>
<td>• If the <strong>Rate override</strong> option is selected, the hourly rate specified in the <strong>Resource rate</strong> field is used.</td>
</tr>
<tr>
<td></td>
<td>• If a <strong>rate model</strong> is populated on the project or demand to which the resource plan is associated, the hourly rate is derived from the rate model.</td>
</tr>
<tr>
<td></td>
<td>• If the resource plan is assigned to a specific user and the time sheet policy of the user is set for multiple rate types, the planned cost is determined using the labor rate card with the default rate type. If the default rate type is inactive, the system rate is used to determine the planned cost.</td>
</tr>
<tr>
<td></td>
<td>• If the resource plan is assigned to a specific user and the time sheet policy of the user is not set for multiple rate types, the planned cost is determined using the labor rate card with no rate type. Otherwise, the system rate is used.</td>
</tr>
<tr>
<td></td>
<td>• If the hourly rate is in non-functional currency, budget reference rates are used.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Setting up rates for resources would provide more accurate forecast and plan costs for resource plans.</td>
</tr>
<tr>
<td></td>
<td>Planned cost is rolled up from Requested Allocations for plans in the Planning or Requested state and from Resource allocations for plans in the Confirmed or Allocated state. While requesting resources from a group, if a resource role is specified, the planned cost is calculated from the hourly rate of the specified role.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Confirmed/Allocated cost | Amount of confirmed or allocated hours multiplied by the hourly rate of the confirmed or allocated resources. Provides a more accurate estimation of the cost of the plan that is confirmed or allocated.  
  • If the Rate override option is selected, the hourly rate specified in the Resource rate field is used.  
  • If a rate model is populated on the project or demand to which the resource plan is associated, the hourly rate is derived from the rate model.  
  • If rate model is not available, labor rate card determines the hourly rate.  
  • If no labor card is found for the user, the hourly rate is taken from the following time card property: Default hourly rate used when processing time cards if we can’t get a rate from labor rate cards (in system currency). |
| Actual cost            | Based on the same time cards used for the Actual hours, the actual cost is calculated using the hourly rate of each user and the hours worked. Used to inform resource requesters and resource managers of actual costs based on the actual hours that user resources added on their approved time cards.  
  The hourly rate is derived as:  
  • If the Rate override option is selected, the hourly rate specified in the Resource rate field is used.  
  • If a rate model is populated on the project or demand to which the resource plan is associated, the hourly rate is derived from the rate model.  
  • If the time sheet policy of a user is set for multiple rate types, the actual cost is determined using the labor rate card with the default rate type.  
  • If the default rate type is inactive, the system rate is used to determine the actual cost.  
  • If the time sheet policy of a user is set for multiple rate types, the actual cost is determined using the labor rate card with no rate type. Otherwise, the system rate is used. |

Allocation Config
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allocation type</td>
<td>Type of resource distribution across the project that determines the type of allocation records. The value in this field determines how the planned hours are distributed across resource plan duration among requested resources:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Weekly</strong>: Create week-long allocations up to the end of the planned end date.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Monthly</strong>: Create month-long allocations up to the end of the planned end date. (Default value.)</td>
</tr>
<tr>
<td></td>
<td>• <strong>Plan Duration</strong>: Create one allocation for each user for the entire duration of the resource plan.</td>
</tr>
<tr>
<td>Allocation spread</td>
<td>Type of hard allocation selected during the creation of the resource plan.</td>
</tr>
<tr>
<td>Notes</td>
<td>Other correspondence and notes about the resource plan.</td>
</tr>
</tbody>
</table>

**Note**: If the assigned rate model is removed or replaced, or the hourly rates in the rate model are changed, the cost fields on the associated resource plans are not recalculated automatically. You must recalculate the resource costs of the resource plan to reflect new rates from the rate model.

However, if any of the fields affecting the cost are updated on the resource plan, the rate model is invoked for getting the hourly rates. For example, extending a resource plan by modifying the end date of the resource plan invokes the rate model as there can be new rates available.

- The resource plan is saved and placed in the Planning state.
- When the resource plan is created from resource grid, the plan appears as top row in the resource plan list of the project or demand. The plan has one of the following prefixes:
  - [G] for a resource plan created for a group.
  - [R] for a role resource plan created for a role.
  - [U] for a user resource plan created for a user.

The prefix is based on the type of resource selected in the **Resource type** field.
- The resource plan which is created last appears at the top in the resource plan list of the project or demand.
Use the following related links and lists:

**Resource Plan related links and lists**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Related Links</strong></td>
<td></td>
</tr>
<tr>
<td>Copy Resource Plan</td>
<td>Copies the opened resource plan into a new resource plan.</td>
</tr>
<tr>
<td>Resource Workbench</td>
<td>Opens the workbench. The link appears only for the resource manager for resource plans in Confirmed or Allocated state.</td>
</tr>
<tr>
<td>Update Cost Plan</td>
<td>If you are using Project Portfolio Management, resource plans automatically create cost plans for a project or demand. Whenever you update the resource plan, click <strong>Update Cost Plan</strong> to keep the cost plan up-to-date.</td>
</tr>
<tr>
<td>Note:</td>
<td>The cost plan associated to a resource plan is also automatically updated when the resource plan is updated.</td>
</tr>
<tr>
<td>Recalculate Resource Cost</td>
<td>Recalculates the resource costs of the resource plan whenever the hourly rates change in the rate model to keep the costs up-to-date.</td>
</tr>
<tr>
<td><strong>Related Lists</strong></td>
<td></td>
</tr>
<tr>
<td>Requested Allocations</td>
<td>List of requested allocations for the resource plan.</td>
</tr>
<tr>
<td></td>
<td>The number of requested allocation records created depends on the value of the Allocation type field. For example, if a resource is requested from January 1 to March 31, the following requested allocation records are created for each type:</td>
</tr>
<tr>
<td></td>
<td>• Monthly: 3 allocation records, one for each month.</td>
</tr>
<tr>
<td></td>
<td>• Weekly: 14 allocation records, one for each week with Monday being the first day of the week.</td>
</tr>
<tr>
<td></td>
<td>• Plan duration: Only 1 record for the entire planned duration.</td>
</tr>
<tr>
<td>Resource Allocations</td>
<td>List of resources allocated to the plan.</td>
</tr>
<tr>
<td>Resource Plan Logs</td>
<td>Lists any error or warnings that might occur during resource allocation.</td>
</tr>
</tbody>
</table>

*Create a resource plan using Resource Finder*

Search the resources and their availability using the **Resource Finder**, and create resource plans for the searched resources for a project or demand.

Role required: it_project_manager, it_demand_manager, or resource_manager
In the Resource Finder, you can search the resources by group, role, or user attributes. The Resource Plans page on a project and demand, and allocation workbench display the resource finder icon in the top right.

1. Open the Resource Plans page for a project or demand.

<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
</table>
| From a project | a. Navigate to **Project > Projects > Project Workspace.**  
b. Open a project record.  
c. In the **Resource Plan** related list, click **Manage** to open **Resources** tab. |
| From a demand | a. Navigate to **Demand > Demands > All.**  
b. Open a demand.  
c. In the **Resource Plans** related list, click **Manage** to open Resource Plans page. |
| From Allocation Workbench | a. Navigate to **Resource > Resource Workbench > Allocation Workbench.**  
b. In the Allocation Boards page, select the required allocation board to open its resource plans in Allocation Workbench |

2. Select the project or demand in the resource grid section and click the resource finder icon in the top right of the page. The Resource Finder section opens at the bottom of the page.

3. To search the resources by group, role, or user attributes, select the search criteria and click **Search.** The **Search by User attributes** option also contains the option for advanced search. Use **Advanced** search to build your own search criteria.

4. To view the availability of the resources for an extended duration, select an option in the date range selector.

   The resource property **Maximum time duration in Resource Finder in months** determines the maximum duration for which resource details should be shown in the resource finder.

5. In the result list, analyze the capacity, availability, utilization, overallocation, and actual hours of the resources for different time periods.

   By default only the **Availability** hours are displayed. To expand and view other columns, you can click the **Detailed View** icon, and select the columns from the **Configurations** list. All non-project events created for a user from the calender appear as Operational Work for the user in Resource Finder.

6. Filter resources by available, over-allocated, or all resources by clicking the **Filter** icon.

7. Select the resources you want to create resource plans for and click **Add New Plan.**

   - The resource plan is created in the Planning state with zero planned hours.
The resource plan appears as a row at the top in the resource plan list of the project or demand. Based on the type of resource selected in finder, the resource plan has one of the following prefixes:

- [G] for a resource plan created for a group.
- [R] for a role resource plan created for a role.
- [U] for a user resource plan created for a user.

**Note:** The resource plan which is created last appears at the top in the resource plan list of a project or demand.

- Update the planned hours for the resource plan using the resource grid.
- To view and update more details for the resource plan, click the information icon in the beginning of the resource plan row.
- You can now request the resource plan.

### Create an operational resource plan

Create an operational resource plan and allocate a certain portion of your team capacity for operational work, such as administration, meeting, or training.

**Role required:** resource_manager or admin

1. Navigate to **Resource > Resource Plans > Create New Operational Plan.**
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Automatically generated identification number for the operational resource plan.</td>
</tr>
<tr>
<td>Resource type</td>
<td>Resource category. To select a group, select the <strong>Group</strong> option. To select an individual user, select the <strong>User</strong> option. To select a resource by role, select <strong>Role</strong>.</td>
</tr>
<tr>
<td>Group</td>
<td>Group for which the operational resource plan is created. If you select <strong>Role</strong> in the <strong>Resource type</strong> field, then the choice list displays the groups for the selected role.</td>
</tr>
<tr>
<td>User</td>
<td>User for whom the operational resource plan is created. This option appears if you select <strong>User</strong> in the <strong>Resource type</strong> field.</td>
</tr>
<tr>
<td>Role</td>
<td>Specific <strong>resource role</strong> that you want to associate with the plan. This option appears if you select <strong>Group</strong> or <strong>Role</strong> in the <strong>Resource type</strong> field. If you select <strong>Group</strong> in the <strong>Resource type</strong> field, then the choice list displays the roles for the selected group.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Members preference</td>
<td>Specific members or all members from the selected group or role. The default is set to <strong>All members</strong>. This field appears only when the <strong>Group</strong> or <strong>Role</strong> option is selected in the <strong>Resource type</strong> field.</td>
</tr>
<tr>
<td></td>
<td>• If the <strong>All members</strong> option is selected, the resource plan includes all members of the selected group or role. Time is proportionally divided among the selected group or role members, depending upon their capacity. Before making the hard allocation, if all members are not required, as a resource manager, you can select only specific members from the group or role.</td>
</tr>
<tr>
<td></td>
<td>• If the <strong>Specific member</strong> option is selected, a request is made for the specified members. The requested hours are proportionately split among specified users of the group or role, based on their available capacity.</td>
</tr>
<tr>
<td>Skills</td>
<td>Specific skill(s) that you want to associate with the plan. This field appears only when the <strong>All members</strong> option is selected in the <strong>Members preference</strong> field.</td>
</tr>
<tr>
<td>Request type</td>
<td>Type of request: <strong>Hourly</strong> or <strong>% Capacity</strong>. To estimate the work in hours, select the <strong>Hourly</strong> option. To estimate the work in percentage of capacity, select the <strong>%Capacity</strong> option.</td>
</tr>
<tr>
<td>Planned hours</td>
<td>Estimated number of hours required to complete the operational work.</td>
</tr>
<tr>
<td>Confirmed/Allocated hours</td>
<td>Hours of a resource confirmed or allocated for operational work.</td>
</tr>
<tr>
<td>Actual hours</td>
<td>Hours spent on a planned operational task.</td>
</tr>
<tr>
<td>Name</td>
<td>Descriptive name for the operational resource plan.</td>
</tr>
<tr>
<td>Operational work type</td>
<td>Type of operational work: KTLO, Admin, Meeting, Training, Out of office, External labor, Time off, Appointment, and Phone call. The default is <strong>KTLO</strong>.</td>
</tr>
<tr>
<td>Rate model</td>
<td>Rate model assigned to the operational resource plan. The <strong>rate model</strong> is used to derive hourly rates for the resource plan.</td>
</tr>
<tr>
<td></td>
<td>If you change or remove the rate model assigned to an operational resource plan, the cost fields on the plan are re-calculated.</td>
</tr>
<tr>
<td>Start date</td>
<td>Date when the operational resource plan starts.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>End date</td>
<td>Date when the operational resource plan ends.</td>
</tr>
<tr>
<td>Allocation type</td>
<td>Resource distribution type that determines the type of allocation records. The value in this field determines how the planned hours are distributed across the resource plan duration, among requested resources. Select any of the following options:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Weekly</strong>: Creates week-long allocations up to the end of the planned end date.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Monthly</strong>: Creates month-long allocations up to the end of the planned end date. Monthly is the default value.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Plan Duration</strong>: Creates one allocation for each user for the entire duration of the resource plan.</td>
</tr>
<tr>
<td></td>
<td>For example, if a resource is requested from Jan. 1st to Mar. 31st, the following records are created for each type:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Monthly</strong>: 3 allocation records, one for each month.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Weekly</strong>: 14 allocation records, one for each week with Monday being first day of the week.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Plan Duration</strong>: Only 1 record for the entire duration of the resource plan.</td>
</tr>
<tr>
<td>Allocation spread</td>
<td>Type of allocation spread. The value in this field determines the manner in which the allocated hours are spread while creating hard allocations:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Even</strong>: Creates resource events for the resource by splitting the hours evenly across all the working days for the allocation duration.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Front Load</strong>: Creates resource events for the resource by filling up all the available slots of the resource from the start date of the allocation.</td>
</tr>
<tr>
<td></td>
<td>For example, if a resource is requested for 30 hours in week 10, then:</td>
</tr>
<tr>
<td></td>
<td>• Selecting <strong>Even</strong> equally divides 30 hours between all weekdays, which is 6 hours per day for a five-day work week.</td>
</tr>
<tr>
<td></td>
<td>• Selecting <strong>Front Load</strong> consumes all the available hours on Monday, moves on to Tuesday, and so on, until all the 30 hours are allocated. If the resource is not available for 30 hours in week 10, it over-allocates by filling up the remaining hours from the start date up to 24 hours per day.</td>
</tr>
<tr>
<td>State</td>
<td>A plan starts in the <strong>Planning</strong> state. The plan moves to the Requested state after its submission.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Planned cost          | Amount, in **Planned Hours**, multiplied by the hourly rate of the specified user or group resource. Planned cost is a first draft estimate of the resource plan cost. Planned cost is rolled up from Requested Allocations for plans in the Planning or Requested states and from resource allocations for plans in the Allocated state. The hourly rate is derived from one of the following sources:  
  - **Rate model**, if it is populated on the operational resource plan.  
  - Labor rate card, if rate model is not available.  
  - System property **com.snc.time_card.default_rate** if all the other conditions fail.                                                                                     |
| Confirmed/Allocated cost | Amount of confirmed or allocated hours multiplied by the hourly rate of the confirmed or allocated resources. Provides a more accurate estimation of the cost of the plan that is confirmed or allocated.  
  The hourly rate is derived from one of the following sources:  
  - **Rate model**, if it is populated on the operational resource plan.  
  - Labor rate card, if rate model is not available.  
  - System property **com.snc.time_card.default_rate** if all the other conditions fail.                                                                                     |
| Actual cost           | Amount of actual hours multiplied by the hourly rate of the specified resource.                                                                                                                                 |
| Notes                 | Additional correspondence and information.                                                                                                                                                                  |

**Related Links**

- **Copy Resource Plan**  
  Copies the opened resource plan to create a new resource plan.

**Related Lists**
### Request resources

After you create a resource plan, request resources from the resource manager.

**it_project_manager, resource_user**

#### Note: If the resource type in the resource plan is a group, you can request resources only if that group has active members.

1. Navigate to **Resource > Resource Plans > All**.
2. Open a resource plan that is in the Planning state.
3. Click **Request**.
   
   You can also request resources from the **Allocation Workbench**.

The resource plan moves to the Requested state and is ready for review by the resource manager.

### Confirm a resource plan

After the resource plan is requested, confirm or block the resources. The resource plan must be in the Requested state to be confirmed.

**Role required:** resource_manager

You can modify or cancel a resource plan that is in the Confirmed state.

For a resource plan with the resource type as group, you can confirm resources only if the specified group has active members.

#### Note: You can also confirm resource plans from the **Allocation Workbench**.

1. Navigate to **Resource > Resource Plans > Requested**.
2. Open the resource plan that you want to confirm and click **Confirm**.

The resource plan moves to the Confirmed state and soft allocations are created.
Confirm and allocate a resource plan

After the resource plan is requested, you can directly allocate the resources. To confirm and allocate, the resource plan must be in the Requested state.

Role required: resource_manager

A resource manager can modify or cancel a resource plan that is in the Allocated state.

If the resource type in a resource plan is a group, you can request resources only if that group has active members.

Note: You can also confirm and allocate resource plans from the Allocation Workbench.

2. Open the resource plan (Requested) that you want to confirm and allocate, and click Confirm and Allocate.

The resource plan moves directly to the Allocated state from the Requested state. Soft allocations are converted to hard allocations when the resource plan moves to the Allocated state.

Any errors or warnings during allocations are logged in the Resource Plan Logs related list on the Resource Plan form. The log is generated if a resource is allocated over 24 hours for a given day. You can review these logs to take correct actions for further resource allocation.

Request a change to a resource plan

To modify a resource plan after you have submitted it for review, request change to the plan.

Role required: resource_user

You can modify only resource plans that are in the Requested or Confirmed state. To modify the form fields of the plan, you first need to request a change to the resource plan. However, you can adjust the requested allocations directly on the plan without requesting for a change. These adjustments are rolled-up to the resource plan.

2. Open a resource plan that is in the Requested or Confirmed.
3. Click Request Change.

You can also request change from the Allocation Workbench.

The resource plan moves back to the Planning state and has the form fields enabled for modification.

Recalculate costs of a resource plan of a project or demand

Recalculate the resource costs of an individual resource plan of a project or demand whenever the hourly rates change in the associated rate model so that the costs are up to date.

Ensure the following setup:

• The project or demand must have an active rate model assigned.
• The resource plan must be in the Planned, Requested, Confirmed, or Allocated state.

Role required: resource_manager

To update costs of all the resource plans of a project or demand in one go, you can use the Recalculate Resource Costs option from the project form or demand form.

1. To open a resource plan of a project or demand, perform one of the following actions.
   • Navigate to Project > Projects > All, and open a project.
• Navigate to **Demand > Demands > All**, and open a demand.

2. From the **Resource Plans** related list, open a resource plan for which you want to recalculate the costs.


4. In the Recalculate Resource Costs dialog box, specify the recalculation period in the **Start date** and **End date** fields.
   - By default, the **Start date** field has the current date and the **End date** field has the end date of the resource plan.

5. To also recalculate the planned cost, select the **Include planned costs** option.
   - The **Include planned costs** option is available for a resource plan in the Confirmed or Allocated state.
   - The option is not selected by default.

6. Click **OK**.

   • Recalculates the selected resource costs based on the latest hourly rates derived from the rate model associated with the project or demand.
   • Updates the recalculated resource costs on the respective cost fields on the resource plan form and the **Resource Plans** related list of the associated project or demand.
   • Reflects the revised values on the respective cost fields of associated project or demand.

### Update cost plan related to a resource plan

If a resource plan is associated to a project, project task, or demand and has a related cost plan, then a requester or a resource manager can update the related cost plan after updating the resource plan.

**Role required:** resource_user or resource_manager or it_project_manager or it_demand_manager

If a resource plan does not have a related cost plan, the **Update Cost Plan** related link is not displayed for the resource plan.

1. Save the updates to the resource plan.

2. Click the **Update Cost Plan** related link.

   **Note:** The cost plan associated to a resource plan is automatically updated as soon as the **Planned cost** in the resource plan is updated. The planned cost on resource plan gets updated when there is a change in:
   - Planned hours
   - User
   - State
   - Start and end dates

The cost plan associated to the resource plan is updated. If allocated or confirmed hours are more than the planned hours in the resource plan, the cost plan is updated with higher of planned or confirmed and allocated hours.

### Complete a resource plan

After all associated tasks and projects are complete or canceled, a resource manager can move the resource plan to the **Complete** state, which closes it.

The resource plan to be completed must be in the Allocated state.

**Role required:** resource_manager
Project and demand managers can **complete resource plans from a project, project task, planning console, or demand.**

**Note:** You can also complete and close a resource plan from the Allocation Workbench.

1. Navigate to **Resource > Resource Plans > Allocated.**
2. Open the resource plan that you want to complete.
3. Verify all the information on the form.

**Note:** The **Actual Hours** and **Actual Cost** fields show the time spent on plan tasks and the resource costs. These fields are derived from time card information and cannot be edited on the resource plan.

4. Optional: Add notes.
5. Click **Complete.**
6. In the **Confirm** dialog box, select the completion date of the resource plan and click **Yes.**

By default, the system date or resource plan end date, whichever is earlier, is populated in **Completion Date.**

**Note:** The **Completion Date** cannot be earlier than the resource plan start date.

- The resource plan moves to the Completed state.
- If the completion date is earlier than the resource plan end date, the end date of the resource plan is updated with the completion date. If the completion date was entered later than the resource plan end date, the resource plan end date is retained.
- All the requested and resource allocations for the resource plan post the completion date are deleted. If there are any actual hours logged against an allocation, that allocation record is not deleted. But the allocated hours become zero and the actual hours are retained. The available and allocated hours for the resources are also updated in the aggregate tables.

Example 1: A resource plan of Allocation type **Monthly** from 1 November to 31 January is completed on 15 December. On completion,

- the resource allocation entry for January is deleted in [Resource_Allocation] table.
- the resource allocation end date for December is updated to the completion date of the resource plan.
- the entries in [Resource_Allocation_Daily] table for December post the completion date are deleted.

Example 2: If the same resource plan has Allocation type as **Planned Duration**, no allocations are deleted, and the end date of the allocation is updated to the completion date.

---

**Complete a resource plan from a project, planning console, or demand record**

If a project or a project task is marked Closed, the project manager can complete the associated Allocated resource plans. Similarly, the demand manager can complete the resource plans for a Closed or Deferred demand.

The resource plan to be completed must be in the Allocated state.

Role required: **it_project_manager** or **it_demand_manager**

When a project or a project task moves to Closed Complete, Closed Incomplete or Closed Skipped state, the system prompts a message on the project and project task forms, and in the planning console for completing the Allocated resource plans if

- there is a corresponding resource plan in the Allocated state. And,
- the resource plan start date is less than or equal to the project or task actual end date.

A similar message for completing the resource plans appears on the Demand form when a demand moves to Closed or Deferred state.

1. Open a project, task, or demand record in the Closed state.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open a Closed project record</td>
<td>a. Navigate to Project &gt; Projects &gt; Project Workspace.</td>
</tr>
<tr>
<td></td>
<td>b. Open the project record in the Closed state.</td>
</tr>
<tr>
<td></td>
<td>c. Click the Details tab to display the project form.</td>
</tr>
</tbody>
</table>

| Open a Closed project task record        | a. Navigate to Project > Projects > Project Workspace.                      |
|                                          | b. Open the required project record.                                       |
|                                          | c. In the Project Tasks related list, open the project task record in the Closed state. |

| Open a Closed project in Planning Console| a. Navigate to Project > Projects > Project Workspace.                      |
|                                          | b. Open the project record in the Closed state.                            |
|                                          | c. Click the Planning tab to display the project in planning console.      |

| Open a Closed or Deferred demand record  | a. Navigate to Demand > Demands > All.                                    |
|                                          | b. Open the demand record in the Closed or Deferred state.                |

The message for completing the associated resource plans appears at the top of the record.

⚠️ There are resource plans in 'Allocated' state. Click here to view and complete these plans.

Message for completing a resource plan

ℹ️ Note: In the Planning Console, irrespective of the Closed state of the project tasks, the message appears only when the project is in Closed state.
2. To open the list of resource plans to be completed, click the link in the message.

**Note:** In Planning Console, alternatively right-click the project and select **Complete Resource Plans**.

- The list contains only those resource plans for the record that should be completed.
- If the list is opened from the message link on a Project form, the resource plans for the project and project task are listed.
- If the list is opened from the message link on a Project task form, only the resource plans for the project task are listed.

3. In the list, select the resource plan to be completed, and click **Complete**.

4. In the **Confirm** dialog box, select the completion date of the resource plan and click **Yes**.

By default, the system date or resource plan end date, whichever is earlier, is populated in **Completion Date**.

**Note:** The **Completion Date** cannot be earlier than the resource plan start date.

- The selected resource plan moves to the Completed state.
- If the completion date is earlier than the resource plan end date, the end date of the resource plan is updated with the completion date. If the completion date was entered later than the resource plan end date, the resource plan end date is retained.
- All the requested and resource allocations for the resource plan that are past the completion date are deleted. If there are any actual hours logged against an allocation, that allocation record is not deleted. But the allocated hours become zero and the actual hours are retained. The available and allocated hours for the resources are also updated in the aggregate tables.

**Cancel a resource plan**

If a resource plan is no longer needed, you can cancel it which also cancels its past and future allocations.

The resource plan to be canceled must be in the Planning, Requested, Confirmed, or Allocated state.

Role required: resource_manager

Project and demand managers can also cancel resource plans from a project, project task, planning console, or demand.

**Note:** You can also cancel a resource plan from the **Allocation Workbench**.

1. Navigate to **Resource > Resource Plans > All**.
2. Open the resource plan record that you want to cancel.
3. On the form header, click **Cancel**.

- The resource plan moves into the Cancelled state.
- All past and future allocations for the resource plan are also canceled. If there are any actual hours logged against an allocation, that allocation is not deleted. But the allocated hours become zero and the actual hours are retained.

If you want to make changes and use the plan again, you can edit a canceled plan. To move the resource plan back to the Planning state, click **Re-plan**.
**Note:** A canceled resource plan can be brought back to the Planning state only if it has no past allocations.

*Cancel a resource plan from a project, planning console, or demand record*

If a project or a project task is marked Closed, the project manager can cancel the associated future resource plans. Similarly, the demand manager can cancel the future resource plans for a Closed or Deferred demand.

The resource plan to be canceled must be in Confirmed, Planning, or Requested state. An Allocated resource plan can be canceled if the resource plan start date is later than the project, task, or demand end date.

Role required: it_project_manager or it_demand_manager

When a project or a project task moves to Closed Complete, Closed Incomplete or Closed Skipped state, the system prompts a message on the project and project task forms, and in the planning console for canceling the resource plans if

- there is a corresponding resource plan in Confirmed, Planning, or Requested state. Or
- there is a resource plan in Allocated state with start date later than the project or task end date.

A similar message for canceling the resource plans appears on the demand form when a demand moves to Closed or Deferred state.

1. Open a project, task, or demand record in the Closed state.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Open a Closed project record</strong></td>
<td>a. Navigate to Project &gt; Projects &gt; Project Workspace.</td>
</tr>
<tr>
<td></td>
<td>b. Open the project record in the Closed state.</td>
</tr>
<tr>
<td></td>
<td>c. Click the Details tab to display the project form.</td>
</tr>
<tr>
<td><strong>Open a Closed project task record</strong></td>
<td>a. Navigate to Project &gt; Projects &gt; Project Workspace.</td>
</tr>
<tr>
<td></td>
<td>b. Open the required project record.</td>
</tr>
<tr>
<td></td>
<td>c. In the Project Tasks related list, open the project task record in the Closed state.</td>
</tr>
<tr>
<td><strong>Open a Closed project in Planning Console</strong></td>
<td>a. Navigate to Project &gt; Projects &gt; Project Workspace.</td>
</tr>
<tr>
<td></td>
<td>b. Open the project record in the Closed state.</td>
</tr>
<tr>
<td></td>
<td>c. Click the Planning tab to display the project in planning console.</td>
</tr>
</tbody>
</table>
Option | Description
--- | ---
Open a Closed or Deferred demand record | a. Navigate to **Demand > Demands > All.**
 | b. Open the demand record in the Closed or Deferred state.

The message for canceling the associated resource plans appears at the top of the record.

![Message for canceling a resource plan](attachment://message.png)

**Message for canceling a resource plan**

**Note:** In the Planning Console, irrespective of the Closed state of the project tasks, the message appears only when the project is in Closed state.

2. To open the list of resource plans to be canceled, click the link in the message.

**Note:** In the Planning Console, alternatively right-click the project and select **Cancel Resource Plans.**

- The list contains only those resource plans for the record that can be canceled.
- If the list is opened from the message link on a Project form, the resource plans for the project and project task are listed.
- If the list is opened from the message link on a Project task form, only the resource plans for the project task are listed.

3. In the list, select the resource plan to be canceled, and click **Cancel.**

- The selected resource plan moves to the Canceled state.
- All past and future allocations for the resource plan are canceled. If there are any actual hours logged against an allocation, that allocation is deleted. In this case, Allocated hours become zero and the actual hours are retained as is.

**Delete a resource plan**

Deleting a plan also deletes all associated resource allocations.

1. Navigate to **Resource > Resource Plans > All.**
2. Open a resource plan.
3. Click **Delete** on the form header. A confirmation message appears.

![Delete confirmation message](image)

4. Click **OK**. The resource plan and all associated allocations are removed.

**Extend a resource plan**

You can extend the date of an allocated resource plan and allocate resources for the extended period.

**Role required:** resource_manager

Assume that work on a project has started, but there is a need to extend the date of an allocated resource plan because the project has been extended. In this scenario, you can extend the date of the allocated resource plan. The new date by which the resource plan is extended does not have any impact on the existing allocated hours. While extending the resource plan, you can specify the new end date and the request type. Based on the request type selected, the required allocated hours are auto-filled.

For example, assume that you allocated 100 hours for 2 months, 50 hours for each month. Now, you want to extend the resource plan by one month. For the extended month, allocation records are created based on the request type selected.

1. Navigate to **Resource > Resource Plans > All**.
2. Open a resource plan.
3. Click **Extend Resource Plan**.
4. In the Extend resource plan dialog box, fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New end date</td>
<td>Date until which you want to extend the resource plan.</td>
</tr>
<tr>
<td>Request type</td>
<td>Type of request. Options include: FTE, Person Days, or Hours.</td>
</tr>
</tbody>
</table>
5. Click OK.

- The end date of the resource plan is updated.
- The Extension field displays the state as Allocated.
- For the extended period, allocation records are created based on the request type selected.
- Number of requested FTE or hours or person days is divided equally for each allocation period and is pre-filled in each allocation record.
- Extending the resource plan invokes the rate model for getting the hourly rates.

### Request extension of an allocated resource plan

As a project manager, you can request extension of an allocated resource plan.

Role required: it_project_manager, resource_user

Assume that a project, which has resources allocated, gets delayed by one month. As a project manager, you can request for the extension of the resource plan if you need resources for the period. This option is available only when the resource plan is in the Allocated state.

   
   If you are accessing the resource plan from the Allocation Workbench, navigate to Resource > Resource Workbench > Allocation Workbench, and open the allocation board whose resource plan you want to extend.

2. Open a resource plan.

3. Click Request Extension.

4. In the Request Extension window, fill in the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extend until</td>
<td>Date until which you want to extend the resource plan and request for resources.</td>
</tr>
<tr>
<td>Request type</td>
<td>Type of request. Options include: FTE, Person Days, or Hours.</td>
</tr>
<tr>
<td>FTE or Person days or Hours</td>
<td>Number of units to request resources. The field appears when you select one of the options in the Request type field. Based on the selected request type, specify the unit. For more information, see Request type.</td>
</tr>
<tr>
<td>Notes</td>
<td>Other correspondence and information about the resource plan that the project manager wants to communicate with the resource manager.</td>
</tr>
</tbody>
</table>

The end date of the resource plan is updated and the Extension field is set to Requested.

See Allocate resources for the extended period.
Allocate resources for the extended period

As a resource manager, you can allocate resources for the extended period.

Role required: resource_manager

After a project manager raises a request to extend the allocated resource plan, the resource manager receives a message at the top of the resource plan. The resource manager then reviews and allocates resources for the extended period.

2. Open the resource plan.
3. In Resource Allocations tab, double-click and update the value in the Requested Hours, FTE, or Person Days field in the empty resource allocation entry.
4. In the Extension list, select Completed.

Resources are allocated for the extended period.

Any errors or warnings during allocations are logged in the Resource Plan Logs related list on the Resource Plan form. The log is generated if a resource is allocated over 24 hours for a given day. You can review these logs to take correct actions for further resource allocation.

Time zones in resource plans

Time zones are important in resource management when the users and groups doing the resource tasks are located in different locations.

Users maintain their time in the My Calendar module and resource managers use the resource workbench or resource plan to assign tasks to various users.

All users are assigned a schedule. If a user schedule changes, all time calculations change automatically. The schedules can be floating or time zone-specific.

- A floating schedule is the same in any time zone. For example, if a resource manager in Amsterdam sets a floating schedule for 8:00A.M.–5:00P.M., a user in San Jose sees the schedule as 8:00 A.M.–5:00 P.M.
- When a schedule is defined in a specific time zone, users in different time zones see the schedule with their own time zone applied. For example, if the resource manager sets a time zone-specific schedule for 8:00 A.M.–5:00 P.M. in Amsterdam, the San Jose user sees the schedule as 11:00 P.M. of the previous day to 7:00 A.M. on the current day because the San Jose time zone is nine hours behind the Amsterdam time zone.

Associate a time card with a resource plan

If one resource is allocated to identically named tasks in two resource plans, use the following procedure to specify the resource plan the time card should be allocated to.

- A resource plan can be associated with a time card only if the resource plan contains hard allocations for the user.
- If a resource plan is not associated manually to a time card, then a resource plan is auto-associated. The auto-association is done based on the selected Task in the time card.

1. Navigate to the Time Cards > All.
2. Select a time card.
3. Configure the form to add the Resource plan field.
4. In Resource plan field, select the plan to which the time card should be allocated. Only resource plans that contain the selected task are listed.
5. Click **Update**.

### Create requested allocations for a resource plan

Requested Allocations are automatically created when a resource plan is submitted and is in Planning state. If required, resource requesters can create new requested allocations for a resource plan in Planning or Rejected state. Resource managers can create requested allocations for the plans in Requested state.

**Role required:** resource_user

A requested allocation does not have an allocation for a named resource. It only details the start date, end date, and the planned hours.
To specify the breakup of resource requirements for monthly or weekly Allocations types, you can modify the requested allocations. For example, you have requested 100 hours of a resource from January to February, but you want 20 hours in January and 80 hours in February. You can specify these details on the Requested Allocations form.

2. Open a resource plan.
3. In the Requested Allocations related list, click New.
4. On the form, fill in the fields.

**Requested Allocation form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start date</td>
<td>Start date for the requested allocation record.</td>
</tr>
<tr>
<td>End date</td>
<td>End date for the requested allocation record.</td>
</tr>
<tr>
<td>FTE</td>
<td>Number of units for the full-time equivalent selection for the requested allocation record. If a resource is requested as FTE, then the planned hours for each requested allocation record is calculated first. A total of all hours is then rolled up as planned hours on the resource plan. See Resource plans for an explanation of FTEs.</td>
</tr>
<tr>
<td>Resource plan</td>
<td>Resource plan number to which the requested allocation record is attached. This field automatically populates if the requested allocation record is accessed from a resource plan.</td>
</tr>
<tr>
<td>Planned hours</td>
<td>Number of hours to allocate to the requested allocation record. By default, the planned hours on the resource plan form are proportionally distributed among all the requested allocations based on the number of working days for each requested allocation record. However, it is possible to override the planned hours or the FTE.</td>
</tr>
</tbody>
</table>

**Note:** Capacity is not derived from FTE, but from schedules. Both FTE and schedules must be in synchronization with each other.
### Field Description

**Planned cost**

- Estimated cost of resource.
- \( \text{Planned cost} = \text{Planned hours} \times \text{hourly rate} \)

The hourly rate is derived from one of the following sources:

- **Resource rate** from the resource plan, if the Rate override option is selected.
- **Rate model**, if it is populated on the project or demand to which the resource plan is associated.
- Labor rate card for user resource plans.
- **Role rate** when resource is requested by resource role, if the role has a rate.
- Group hourly rate if role does not have a rate or if the role is null.
- System property `com.snc.time_card.default_rate` if all the other conditions fail.

Planned costs roll up to the **Planned cost** field on the resource plan.

---

5. To save the record and return to the resource plan, click **Submit**.

If a resource is requested from September 1 to Nov 30 for 360 hours, requested allocation records are created as follows:

**Case 1: Plan duration allocation type**

For a plan duration allocation type, the following requested allocation records would be created:

<table>
<thead>
<tr>
<th>Start date</th>
<th>End date</th>
<th>Planned hours</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sep 01 (Resource plan start)</td>
<td>Nov 30 (Resource plan end)</td>
<td>360</td>
</tr>
</tbody>
</table>

**Case 2: Monthly allocation type**

For a monthly allocation type, hours are proportionally distributed based on working days as follows:

- Total working days for the planned duration = 65
- Hours to allocate per working day = \( \frac{360}{65} = 4 \)

The following requested allocation records would be created:

<table>
<thead>
<tr>
<th>Start date</th>
<th>End date</th>
<th>No. of working days</th>
<th>Planned hours</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sep 01</td>
<td>Sep 30</td>
<td>22</td>
<td>22 \times 4 = 88</td>
</tr>
<tr>
<td>Oct 01</td>
<td>Oct 31</td>
<td>21</td>
<td>21 \times 4 = 84</td>
</tr>
<tr>
<td>Nov 01</td>
<td>Nov 30</td>
<td>22</td>
<td>22 \times 4 = 88</td>
</tr>
</tbody>
</table>
For a weekly allocation, requested allocation records created similar to monthly. Three allocation records, one for each month are created.

**Resource allocation**

After resource requesters create a resource plan, resource managers can confirm the resources to move the plan to the Confirmed state. Resource managers can then allocate resources to the plan and move it to the Allocated state.

Based on calendar and schedule information, resource managers view resource availability and select the resources under their management that can be confirmed and allocated to specific tasks.

**Soft and hard allocations**

When a resource plan moves to the Confirmed state, resource allocations corresponding to requested allocations are created automatically. The Booking type for these allocations is Soft. Soft allocations are like temporary allocations for the requested users and do not create any calendar events.

When the plan is moved to the Allocated state, the Booking type changes from Soft to Hard. For a hard booking, the resource is assigned to the plan and is not available for other plans during the allocated times. The booked time also appears on the user calendar. If the requested resource cannot be allocated for the entire allocation duration, the allocation record booking type remains as soft.

Any errors or warnings during allocations are logged in the Resource Plan Logs related list on the Resource Plan form. You can review these logs to take correct actions for further resource allocation.

**Note:** The resource property `com.snc.resource_management.allocation_interval_minutes` enables the creation of soft and hard allocations with a decimal value.

**Calculation of hours for soft allocations**

**Case 1: Proportional distribution**

For example, the requested allocation for a group with two resources when the Members preference value is set to All members or Specific members is as follows:

<table>
<thead>
<tr>
<th>Start date</th>
<th>End date</th>
<th>Planned hours</th>
</tr>
</thead>
<tbody>
<tr>
<td>October 03</td>
<td>October 07</td>
<td>40</td>
</tr>
</tbody>
</table>

The planned hours on the Resource Plan form are proportionally distributed among all the requested allocations based on number of working days for each requested allocation record.

<table>
<thead>
<tr>
<th>Resource</th>
<th>Resource time-off</th>
<th>Available capacity (hours)</th>
<th>Soft Allocation hours</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource 1</td>
<td>2 days</td>
<td>$3 \times 8 = 24$</td>
<td>$24 \times 0.625 = 15$</td>
</tr>
<tr>
<td>Resource 2</td>
<td></td>
<td>$5 \times 8 = 40$</td>
<td>$40 \times 0.625 = 25$</td>
</tr>
</tbody>
</table>

The following calculations are used:

- Total available capacity = Available capacity User 1 + Available capacity User 2 = 24 + 40 = 64 hours  

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
• Hours to allocate per hour of available capacity = Planned hours/total available capacity = 40/64 = 0.625 hours

**Note:** Multiple soft allocations could be created for one requested allocation for group resource plans.

**Case 2: Most available resource requested first**

For example, the requested allocation for a group with three resources when the Members preference value is set to Any member is as follows:

<table>
<thead>
<tr>
<th>Start date</th>
<th>End date</th>
<th>Planned hours</th>
</tr>
</thead>
<tbody>
<tr>
<td>October03</td>
<td>October 07</td>
<td>40</td>
</tr>
</tbody>
</table>

The system finds the most available resources in the specified time frame and creates soft allocations for these resources.

<table>
<thead>
<tr>
<th>Resource</th>
<th>Available hours</th>
<th>Soft Allocation hours</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource 1</td>
<td>24</td>
<td>10</td>
</tr>
<tr>
<td>Resource 2</td>
<td>30</td>
<td>30</td>
</tr>
<tr>
<td>Resource 3</td>
<td>20</td>
<td></td>
</tr>
</tbody>
</table>

Resource 2 is the most available resource. The system creates soft allocations for resource 2 first until it consumes all available hours from resource 2. The system then moves to the next most available resource, and so on. Once available hours for all resources are consumed, and the planned hours are still left over after allocating across all members (from most available to least available), the remaining hours are equally distributed among all resources.

**Calculation of hours for hard allocations**

**Case 1: Even spread**

Selecting **Even** as hard allocation spread type creates resource events for the resource by splitting the hours evenly across all working days.

The Smart Even Load allocation spread takes the availability of resources into account while allocating and only applies hours evenly where possible. If a resource is over-allocated for a day, it bypasses that day and resumes allocations to succeeding days until the resource plan is fulfilled.

For example, for a resource requested for 20 hours in a week, the even spread hard allocation is as follows:

<table>
<thead>
<tr>
<th>Day of the week</th>
<th>Monday</th>
<th>Tuesday</th>
<th>Wednesday</th>
<th>Thursday</th>
<th>Friday</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available hours</td>
<td>6</td>
<td>4</td>
<td>6</td>
<td>6</td>
<td>Time-off</td>
</tr>
<tr>
<td>Allocated hours</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>0</td>
</tr>
</tbody>
</table>

**Case 2: Front load**
Selecting **Front load** as the hard allocation spread type fills up all available resource slots from the start date of the allocation. Once the resource is fully allocated between start and end dates, the remaining hours are filled from the start date up to 24 hours.

For example, for a resource requested for 20 hours in a week, the front load spread hard allocation is as follows:

<table>
<thead>
<tr>
<th>Day of the week</th>
<th>Monday</th>
<th>Tuesday</th>
<th>Wednesday</th>
<th>Thursday</th>
<th>Friday</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available hours</td>
<td>6</td>
<td>4</td>
<td>6</td>
<td>6</td>
<td>Time-off</td>
</tr>
<tr>
<td>Allocated hours</td>
<td>6</td>
<td>4</td>
<td>6</td>
<td>4</td>
<td>0</td>
</tr>
</tbody>
</table>

**Event creation during hard allocation**

You can control the minimum unit for an event by modifying the Calendar Event Duration (minutes) ([com.snc.resource_management.allocation_interval_minutes property](#)). The default is 60 minutes.

**Example: 4 hours for 1 week, with an allocation interval of 60 minutes**

Create a 60-minute block from Monday through Thursday.

<table>
<thead>
<tr>
<th>Monday</th>
<th>Tuesday</th>
<th>Wednesday</th>
<th>Thursday</th>
<th>Friday</th>
</tr>
</thead>
<tbody>
<tr>
<td>60 mins</td>
<td>60 mins</td>
<td>60 mins</td>
<td>60 mins</td>
<td></td>
</tr>
</tbody>
</table>

**Example: 4 hours for 1 week, with an allocation interval of 30 minutes**

Create a 60-minute block from Monday through Wednesday and 30-minutes blocks for Thursday and Friday.

<table>
<thead>
<tr>
<th>Monday</th>
<th>Tuesday</th>
<th>Wednesday</th>
<th>Thursday</th>
<th>Friday</th>
</tr>
</thead>
<tbody>
<tr>
<td>30 mins+30 mins</td>
<td>30 mins+30 mins</td>
<td>30 mins+30 mins</td>
<td>30 mins</td>
<td>30 mins</td>
</tr>
</tbody>
</table>

**Time-off handling**

Resource events from a resource plan are not created for the days where the resource has marked time-off or engaged in other events (such as training and meetings). An administrator can manage the resource capacity and allocation with the property, [com.snc.resource_management.exclude_events_from_schedule](#), to specify:

- Which events must be excluded for capacity calculations. For example, if a resource has time-off between Monday and Wednesday, the weekly capacity for the resource is calculated as 16 hours (as opposed to 40 hours).
- When the system must not create allocations. For example, if a resource is in training on Friday, the resource is not allocated for a task on Friday.
Over-allocation

Over-allocated resources are allowed. Over-allocating resources creates overlapping events in the user calendar within the user's scheduled hours. However, a maximum of 24 total hours can be allocated in any given day. Overlapping events appear overlapped in the calendar in the weekly view. In the monthly view, overlapping events appear above or below another event.

For example, a user has a schedule that specifies the daily work day from 08:00 to 17:00. Event 1 is in the user's calendar from 08:00 to 14:00. If an additional five hours are added for the same day for Event 2, an event is created for the three hours of free time (14:00 to 17:00). An overlapping event is also created for the remaining two hours, starting at the beginning of the day (08:00 to 10:00).

Overlapping event from the monthly view
Overlapping event from the weekly view

Create a resource role
Define project-specific roles for team members based on their skills and competencies.
Role required: resource_manager
1. Navigate to Resource > Resources > Resource Roles.
2. Click New.
3. On the form, fill in the fields.

**Resource Role form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the resource role.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The resource role name must be unique. Do not create duplicate roles.</td>
</tr>
<tr>
<td>Hourly rate</td>
<td>Hourly rate for the resource role used for calculating the task cost based on time worked.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the resource role.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**User resources and group resources**

When allocating resources, a resource manager might need to add a user or a group. Work with an administrator to create users or groups of the type **pps_resource**.

**Resource Manager view**

The Resource Manager view in **Resource > Resources > Users** lists only the users who have the pps_resource role. In addition to some of the fields displayed in the User Administration > **Users** form, the Resource Manager View > Users form also displays the following fields, which are editable only by a user who has the resource_manager role:

- **Location**
- **Schedule**
- **Timesheet Policy**
- **Average Daily FTE Hours/Hours Per Person Day**

**Note:** Use the Update Resource Capacity related link to specify a date range. User capacity is populated in all aggregate tables based on the schedule of the user.

The Resource Manager view in **Resource > Resources > Groups** lists only the groups with the pps_resource role. Although resource managers have write access to several fields, the only fields that they should edit are **Average Daily FTE Hours/Hours Per Person Day** and **Hourly rate**.

**Update the resource capacity**

From the Resource Manager view, update the capacity of a user for a specific duration. Based on the schedule of the user and the specified duration, the capacity of the user is accordingly populated in all resource aggregate tables.

Role required: resource_manager

You can use the **Update resource capacity** related link in the following scenarios:

- If a user is newly added and you want to update the capacity for the user.
- If the schedule of an existing user is changed and you want to update the capacity of the user.

The seeded scheduled job that is used is **Update resource capacity**.
Capacity is generated for only the date range specified in the employment start date and employment end
date of the employee profile in the HR application when the Employee Profile plugin is installed. Capacity
and availability for terminated resources is automatically updated to 0 when you run the Resource
Termination Handler job when the termination date is after the date on which the job is run. If resources
are booked for a time period beyond the user's termination dates, those bookings are also updated to 0 in
the resource plan.

2. Click a User ID.
3. Click the Update Resource Capacity related link.
4. In the window, provide a start date and end date.

Note: You cannot select a start date that is before the employment start date or an end date
that is after the employment end date when the Employee Profile plugin is installed.

5. Click OK.

Update the resource aggregates
From the Resource Manager view, you can update the resource aggregates for a specific time frame.
Role required: admin
You can use the Update Resource Aggregates related link in the following scenarios:

- If you notice a discrepancy in aggregates and want to generate correct data.
- If you want to synchronize aggregates with the Resource Allocation Daily [resource_allocation_daily]
entries for a specific time frame.

2. Click a User ID.
3. Click the Update Resource Aggregates related link.
4. In the window, provide a start date and end date.
5. Click OK.

Create allocations
Resource managers can create allocations using the Resource Allocations related list.

2. Open a resource plan.
3. In the Resource Allocations related list, click New.
4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start date</td>
<td>Start date for the resource allocation. The start and end dates must fall within the dates of the resource plan.</td>
</tr>
<tr>
<td>End date</td>
<td>End date for the resource allocation.</td>
</tr>
<tr>
<td>Resource</td>
<td>Resource to be allocated. The lookup results are filtered by the group, role, or user selected on the resource plan.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Confirmed/Allocated hours</td>
<td>Number of hours that the system confirms or allocates to the resource when the resource plan is confirmed or allocated. Confirmed and allocated hours roll up to the Confirmed/Allocated hours field on the resource plan.</td>
</tr>
<tr>
<td>FTE</td>
<td>Number of units for the full-time equivalent selection. This option appears if you selected FTE for the Request type field on the resource plan.</td>
</tr>
<tr>
<td>Person Days</td>
<td>Number of units for the person days selection. This option appears if you selected Person Days for the Request type field on the resource plan.</td>
</tr>
<tr>
<td>Planned cost</td>
<td>Planned cost of the resource. Planned Cost = Planned hours * hourly rate The hourly rate is derived from one of the following sources:</td>
</tr>
<tr>
<td></td>
<td>• Resource rate from the resource plan, if the Rate override option is selected.</td>
</tr>
<tr>
<td></td>
<td>• Rate model, if it is populated on the project or demand to which the resource plan is associated.</td>
</tr>
<tr>
<td></td>
<td>• Labor rate card, if rate model is not available.</td>
</tr>
<tr>
<td></td>
<td>• System property com.snc.time_card.default_rate if all the other conditions fail.</td>
</tr>
<tr>
<td></td>
<td>Planned costs roll up to the Planned cost field on the resource plan. The field is not visible on the form by default. Configure the form to add this field if it is not visible.</td>
</tr>
</tbody>
</table>
### Field

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Confirmed/Allocated cost   | Cost of the resource.  
Confirmed/Allocated Cost = Confirmed/Allocated hours * hourly rate  
The hourly rate is derived from one of the following sources:  
• Resource rate from the resource plan, if the Rate override option is selected.  
• Rate model, if it is populated on the project or demand to which the resource plan is associated.  
• Labor rate card, if rate model is not available.  
• System property `com.snc.time_card.default_rate` if all the other conditions fail.  
Confirmed and allocated costs roll up to the Confirmed/Allocated cost field on the resource plan.  
The field is not visible on the form by default.  
Configure the form to add this field if it is not visible. |

5. Click **Submit** to save the record and return to the resource plan.

In the resource plan form, click **Confirm** or **Confirm and Allocate** to move the resource to the **Confirmed** or **Allocated** state.

### Reject a resource plan from the Resource Plan form

Resource managers can reject plans from the Resource Plan form or from the Resource Workbench.

**Note:** You can also perform this task from the allocation workbench.

2. Open the plan to reject.  
3. Optional: Add a description of the reason for the rejections in the **Notes** field.  
4. Click **Reject**.

### Capacity planning overview

Capacity Planning page provides resource managers with a comprehensive view of capacity, allocations, and utilization of resources. As a resource manager, you can use it to review resource capacity and existing allocations and then confirm resources to a demand or project.

**Note:** The capacity planning page is based on Service Portal which enables you to configure, customize, and extend it per your requirements and organizational workflow. See Service Portal for more information.

The Capacity Planning page is divided into following sections:

**Resource Plans**
The left pane displays the requested resource plans as cards based on the filter conditions. You can select more than one resource plan to review the capacity of the associated resources.

**Resource Forecast**

The section enables you to review the resource forecast of the selected resource plans in the following tabs:

- **Overview** tab: Displays the following items in the stacked bar chart.
  - the total capacity trend for the resources
  - requested hours (for the selected plan only)
  - confirmed hours (across all projects)
  - the allocated hours (across all projects)

Pointing to any of the sections on the bar chart shows its details.

- **% Utilization** tab: Displays the heat map for the percentage of utilization of resources including both hard and soft allocations and requested hours for the selected resource plans. The heat map helps resource managers understand how committed utilization would look if resources are allocated to resource plans in the requested state. If utilization is greater than 100%, resources are over allocated. The resource manager must ensure that percentage of utilization of all resources is within 100%.
Capacity Planning page example
Review capacity of the resources

Use capacity planning page to review the capacity and utilization trends of the resources associated with the requested resource plans.

Role required: resource_manager

2. To filter the list of displayed resource plans, click the filter icon in the Resource Plans section.
3. To view its resource forecast, select a resource plan in the Resource Plans section.
4. In the Resource Forecast section, review the resource capacity and utilization for the selected resource plans. The section shows the information in the following tabs:
   - **Overview** tab: Displays the following information in a stacked bar chart. Point to any of the sections on the bar chart to show its details.
     - **Requested**: Number of hours that the resource has been requested for the selected resource plans only.
     - **Confirmed**: Number of hours confirmed. The value considers all resource plans and the hours across all projects and demands for the group or user requested for selected resource plans.
     - **Allocated**: Number of hours that the resource is already committed. The value considers all resource plans and the hours on the user calendar. For example, hours allocated for operational work or meetings across all projects and demands for group or user requested for selected resource plans.
     - **Capacity**: Total capacity trend for the resources, which is derived from the user or group schedule. The group capacity is rolled up from the schedules of all the members.

   - **% Utilization** tab: Displays the heat map for the percentage of utilization of resources including both hard and soft allocations and requested hours for the selected resource plans.

5. To show or hide the respective bar or line in the graph, click an item in the legend below the graph.
6. To perform a What-If analysis, deselect the resource plans that you do not want to consider for capacity and utilization calculations. For example, if forecasted utilization is more than 100% and there are four resource plans that request a group, you can deselect one or more resource plans. The graph is updated to show capacity and utilization for the remaining plans. It helps you understand the impact of not allocating resources to the deselected plans.
7. To open and modify the display settings for the graph and heat map, click the Settings icon in the Resource Forecast section.
8. In the **Resource Forecast** section, use the following options to take an action on a resource plan:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Confirm</strong></td>
<td>Confirms the resources to the selected plan.</td>
</tr>
<tr>
<td></td>
<td>The selected resource plan moves to the Confirmed state. <strong>Soft allocations</strong> are created when the resource plan moves to the Confirmed state.</td>
</tr>
<tr>
<td><strong>Confirm and Allocate</strong></td>
<td>Allocates the resources to the selected plan directly without first confirming them.</td>
</tr>
<tr>
<td></td>
<td>The selected resource plan moves to the Allocated state. <strong>Hard allocations</strong> are created when the resource plan moves to the Allocated state.</td>
</tr>
<tr>
<td><strong>Reject</strong></td>
<td>Rejects the selected plan.</td>
</tr>
</tbody>
</table>

**Note:** You can select more than one resource plan to Confirm, Confirm and Allocate, or Reject.

---

### Allocation workbench

Use the allocation workbench to allocate your resources effectively to the requesting investments by evaluating resource capacity and availability.

### Allocation boards

Allocation boards group resources based on filters so that you can view and manage specific resources for investments. For example, you can create an allocation board by filtering on a specific program to group your resources requested or allocated to projects and demands of the program.

The Allocation Boards page shows all your allocation boards. You can **create a personalized allocation board** through a filter definition. Clicking a board name opens the allocation workbench with a list of projects and demands that match the allocation board filter type.

When you select a resource plan in the resource grid section, the availability details of the associated resources are displayed in the resource finder section. For example, if you select a group resource plan, the availability details of the group and its members are displayed in the resource finder section. You can expand and view other columns by clicking the **Detailed View** icon, and selecting columns from the **Configurations** list. When you change the selection, the results are automatically updated.

Watch this video to learn about the purpose and usage of the Resource Allocation Workbench.

---

### Header

Use various options on the workbench header to do the following actions.
## Allocation workbench options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date range selector</td>
<td>Shows projects and demands for the selected time range. For a new allocation board, the default period is set as the current date to six months. If you change these dates, the new range is saved as the board default for future board use.</td>
</tr>
<tr>
<td>Resource filter</td>
<td>Filters projects and demands in the resource grid by group, role, or user for the selected period.</td>
</tr>
<tr>
<td>State filter</td>
<td>Filters resource plans in the resource grid by state: (P) Planning, (R) Requested, (C) Confirmed, and (A) Allocated.</td>
</tr>
<tr>
<td>Week or Month view</td>
<td>Shows allocations in weekly or monthly format in both the resource grid and resource finder sections.</td>
</tr>
<tr>
<td>Hours, FTE, or Person days view</td>
<td>Shows allocations in hours, FTE, or person days format in both the resource grid and resource finder sections.</td>
</tr>
<tr>
<td>Resource Finder</td>
<td>Displays the resource finder section at the bottom of the workbench. Use the resource finder section to search resources and create a resource plan for them.</td>
</tr>
<tr>
<td>Configuration</td>
<td>Shows or hides the selected columns on the grid. Selecting the Planned Cost, Actual Cost, Cont/ Alloc Cost, or Resource Type columns pins them on the grid before the Details column group. Other columns are added in the Details column group in the collapsed state. To view the collapsed columns, click the expand icon ( ) on the Details column group.</td>
</tr>
<tr>
<td>Legend</td>
<td>Specifies the state of the resource plan using the Partial Allocated legend.</td>
</tr>
</tbody>
</table>
**Resource grid**

The resource grid lists all investments and the resources requested or allocated to them. In the grid view, you can perform the following tasks:

- Edit the planned, confirmed, and allocated hours inline without opening the record in a form.
- Request changes to submitted resource plans, or request an extension of an allocated resource plan.
- Confirm or allocate resource plans to a project or demand.
- Replace one user's allocation with another user
- Shift allocations of a user to a future date
- Move a resource plan and its allocations to a future date
- Complete, delete, or cancel resource plans.
- Group, hide, or show columns.

**Resource finder**

The bottom resource finder section of the allocation workbench is hidden by default. To make it visible, click the resource finder icon (🔍) at the top right. In the Resource finder, you can perform the following actions:

- Search for resources and view their availability and utilization. You can search resources by group, role, or user.
- Add or confirm resource plans for the current resources.
- Configure the **Actuals** column using **Detailed View**.
- Filter resources in the **Resource Finder** by available, overallocated, or all resources.

**Create an allocation board**

Create a personalized allocation board by defining filter criteria and manage your filtered resources in terms of their capacity, availability, and utilization.

Role required: resource_manager

An allocation board groups resources based on filter criteria. Clicking a board opens the list of resources under that criteria in the allocation workbench.

1. Navigate to **Resource > Resource Workbench > Allocation Workbench**.
2. On the Allocation Boards page, click **New**.
3. In the **Create new** window, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the allocation board.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Type</td>
<td>Level from which you want to filter resources.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Demands/Projects</strong>: When selected, resources are filtered from demands and projects.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Group</strong>: When selected, resources are filtered from a group.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Group manager</strong>: When selected, all resources with pps_resource role are filtered.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Portfolio</strong>: When selected, resources are filtered from a portfolio.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Program</strong>: When selected, resources are filtered from a program.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Resource Plan</strong>: When selected, resources are filtered through the filter criteria and are not bound to any particular group, role, manager, portfolio, or program.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Role</strong>: When selected, resources are filtered from a role.</td>
</tr>
<tr>
<td></td>
<td>• <strong>User manager</strong>: When selected, all resources with pps_resource role are filtered.</td>
</tr>
</tbody>
</table>

Depending on the value in **Type** field, a field appears to select the name of the record. For example, if **Type** is **Group**, a field **Group** appears where you can select the name of the group.

4. Click **Create**.

- Allocation board is created and you are navigated to the allocation workbench. The allocation workbench shows the resources based on the filter criteria defined by the allocation board.
- In the Allocation Boards page, the board is added and has a color band based on the applied **Type** filter.

**Manage resources by using the allocation workbench**

Use the allocation workbench to manage your resources effectively. You can review all resource requests in one place for your team. You can also see the available hours for requested users and efficiently allocate resources.

**Role required**: resource_manager

The allocation workbench resource grid provides a detailed breakdown of resource data. You can change the view and filter data.

If you confirm or allocate hours from the **Actions** menu, the per day capacity for a resource is 24 hours.

You can view and manage resource availability and utilization using the resource finder. To enable the resource finder, click the resource finder icon.

If you confirm or allocate hours from the resource finder section, the per day capacity for a resource is based on the resource's schedule.

If a warning is displayed while performing a task from the Allocation Workbench, you can navigate to detailed logs for that action on a new tab by clicking the hyperlink on the message. For example, while...
requesting extension of a resource plan, if a resource plan cannot be extended for all the requested hours,
a warning is displayed that specifies that a certain number of hours cannot be extended.

1. Navigate to **Resource > Resource Workbench > Allocation Workbench**.
2. On the Allocation Boards page, select the allocation board whose resource plans you want to manage.
3. Perform the following tasks in the resource grid. The available options change depending on the state of the resource plan.

<table>
<thead>
<tr>
<th>Task</th>
<th>Steps</th>
</tr>
</thead>
</table>
| Create a resource plan for a project or demand | a. Click a project or demand in the resource grid.  
   b. Click the **New Plan** button located in the top-right corner.                                                                                                                                                                                                 |
| Create a resource plan for a project or demand from selected resources | a. Click a project or demand in the resource grid.  
   b. In the resource finder section, search for and select the desired available resources.  
   c. Click the **Add New Plan** button.                                                                                                                                                                                                 |
| Request a resource plan                         | a. Click a resource plan in the resource grid.  
   b. Click the **Actions** icon (⋯), and select **Change State > Request**.                                                                                                                                                                                      |
| Confirm or allocate a resource plan             | a. Click a resource plan in the resource grid.  
   b. Click the **Actions** icon (⋯), and select **Change State > Confirm** or **Change State > Allocate**.                                                                                                                                                  |
<p>| Confirm or allocate resources for a requested group, role, or user resource plan for the whole period of the resource plan | See the Confirm or allocate resources from the Allocation Workbench topic.                                                                                                                                                                                                |
| Confirm or allocate resources for a group, role, or user resource plan for a specific period | See the Confirm or allocate resources from the Allocation Workbench topic.                                                                                                                                                                                                |</p>
<table>
<thead>
<tr>
<th>Task</th>
<th>Steps</th>
</tr>
</thead>
</table>
| Partially allocate a resource plan for specific periods | This option is available only for a Confirmed resource plan. You can allocate a resource plan for a specific period instead of allocating the resource plan for the full duration. For a group and role resource plan, you can partially allocate a plan at the user level. You can allocate resources in one of the following ways:  
  • To allocate a resource for all the periods updated in a row, click the **Actions** icon ( ) and select the **Allocate** option.  
  • To allocate a resource for a specific period:  
    a. In the resource grid section, right-click in the **Conf/Alloc** cell for the required period.  
    b. Select **Allocate**.  

The resource plan is partially allocated and the partially allocated icon ( ) is displayed in the **State** cell in the resource grid. |
| Delete a resource plan | a. Click a resource plan in the resource grid.  
 b. Click the **Actions** icon ( ), and select **Delete**. |
| Edit hours in the grid | a. In the resource grid section, double-click a resource plan or a specific resource row.  
 b. Edit the planned and allocated hours of the resource plan or a resource in the grid.  
 c. Move the pointer out of the cell to save. |
<p>| Replace a user with another user for a group, role, or user resource plan | See the <strong>Replace user in a resource plan</strong> topic. |
| Move a resource plan and its allocations to a future date for a group, role, or user resource plan | See the <strong>Move a resource plan</strong> topic. |
| Shift allocation of a user to a future date for a group or role resource plan | See the <strong>Shift allocations of a user</strong> topic. |</p>
<table>
<thead>
<tr>
<th>Task</th>
<th>Steps</th>
</tr>
</thead>
</table>
| Request all the resource plans for a project or demand | The **Request All** option is available when at least one of the listed resource plans under the project or demand is in the Planning state.  
   a. Click the **Actions** icon (●) on a project or demand row in the resource grid.  
   b. Select **Request All**. |
| Request a change to a submitted resource plan | The **Request change** option is available for a resource plan in the Requested or Confirmed state.  
   a. Click the **Actions** icon (●) on a resource plan row in the resource grid.  
   b. Select **Request Change**. |
| Request extension of an allocated resource plan | See the [Request extension of an allocated resource plan topic](#). |
| Complete a resource plan | After all the associated tasks and projects are complete or canceled, as a resource manager you can mark the resource plan complete and closed. The state of the plan changes to Complete.  
   a. Click the **Actions** icon (●) on a resource plan row in the resource grid.  
   b. Select **Complete**.  
   c. In the Confirm dialog box, select the **Completion date** option, and click **Yes**. |
| Cancel a resource plan | When a resource plan is no longer required, as a resource manager you can cancel it, which also cancels its past and future allocations.  
   a. Click the **Actions** icon (●) on a resource plan row in the resource grid.  
   b. Select **Cancel**. |
| View the resource allocations at user level | In the resource grid section, expand a resource plan entry. The user level allocations are listed only for group and role resource plans.  
   A negative value in a user row indicates that the user is over-allocated for that period. Click the value to see the resource over-allocation daily records of the user to see the specific over-allocated days. |
<table>
<thead>
<tr>
<th>Task</th>
<th>Steps</th>
</tr>
</thead>
</table>
| View the details of a project or a demand | a. Click the **Actions** icon ( ... ) on a project or demand row in the resource grid.  
   b. Select **View Project** for a project or select **View demand** for a demand. |

**Confirm or allocate resources from the Allocation Workbench**

Confirm or allocate resources for a group, role, or user resource plan for the entire period of the resource plan or a specific period of the resource plan from the Allocation Workbench.

Role required: resource_manager

The allocation period must be within the resource plan duration to confirm or allocate resources for a specific time period.

You can confirm resources only for a requested or confirmed resource plan.

You can allocate resources only for a partially allocated or allocated resource plan.

1. Navigate to **Resource > Resource Workbench > Allocation Workbench**.
2. On the Allocation Boards page, select the allocation board whose resource plans you want to manage.
3. Click a group, role, user resource plan in the resource grid.
   The resource finder shows all the resources in that resource plan.
4. In the resource finder section, check the availability of the resources.
5. Select the required resources.
6. Confirm or allocate resources.
   • For a specific period: Click the down arrow corresponding to **Confirm** or **Allocate**, and select **Confirm for specific period** or **Allocate for specific period**. Select the allocation period and click **Confirm** or **Allocate**.
   • For the whole period: Click **Confirm** or **Allocate**.

**Note:** Users already confirmed or allocated for a time period cannot be confirmed or allocated for the same time period again.

**Replace a user in a resource plan**

Replace a user with another user for a group, role, or user resource plan to accommodate situations like a user taking leave during a project.

Role required: resource_manager

This option is available only for a confirmed or allocated resource plan.

A user can be completely replaced only if no actuals are present in that period for the existing user.

1. Navigate to **Resource > Resource Workbench > Allocation Workbench**.
2. On the Allocation Boards page, select the allocation board whose resource plans you want to manage.
3. Click a group, role, or user resource plan in the resource grid.
4. Click the **Actions** icon ( ... ) on the user you want to replace, and select **Replace User**.
5. In the **User** field of the Replace Users window in the **To** section, select the new user to whom allocations need to be transferred.

6. Select the replace period.
   
   By default, the replace period starts from the current allocation week or month.
   
   The replace end period cannot be later than the resource allocation's end date, and the replace start period cannot be before the resource's allocation start period

7. Optional: Select the **Delete the original allocation in case of complete transfer** check box to delete the original user allocations if a complete transfer happens.
   
   If the new user is available for all the time periods and all the hours in the replace period, a complete transfer occurs

8. Click **Allocate** or **Confirm**.

When a user is replaced in a user resource plan, a new resource plan is created for the new user.

When the new user is not available for complete allocation, the maximum available allocations are transferred to the new user and the remaining allocations remain with the existing user.

*Move a resource plan*

Move a resource plan and its allocations to a future date for a group, role, or user resource plan.

Role required: resource_manager

This option is available only for a planning, requested, confirmed, or allocated resource plan.

1. Navigate to **Resource > Resource Workbench > Allocation Workbench**.
2. On the Allocation Boards page, select the allocation board whose resource plans you want to manage.
3. Click a group, role, user resource plan in the resource grid.
4. Click the **Actions** icon ( ) on the resource plan you want to move, and select **Move Resource Plan**.
5. In the **To** field of the Move Resource Plan window, select the time period to which the allocations need to be moved.
6. Click **Update**.

   The dates of the moved resource plan and its allocations are updated, and the state of the plan and booked resources are retained.

*Shift allocations of a user*

Shift allocation of a user to a future date for a group or role resource plan to accommodate situations where planned work for a specific user of a group or role resource plan needs to be shifted to a future time period.

Role required: resource_manager

1. Navigate to **Resource > Resource Workbench > Allocation Workbench**.
2. On the Allocation Boards page, select the allocation board whose resource plans you want to manage.
3. Click a group or role resource plan in the resource grid.
4. Click the **Actions** icon ( ) on the user you want to shift allocations for, and select **Shift Allocations**.
5. In the **From** field in the Shift allocations window, select the time period from which you want to shift the allocations.

   **Note:** The from period cannot be before the current allocation period.
6. In the **To** field, select the time period to which you want to shift the allocations. If the dates of the shifted resource allocations are beyond the resource plan end date, the resource plan is extended.

7. Click **Update**. The allocation cap per day is 24 hours. If a user is already booked for the shifted period, then the user is over-allocated for the shifted period.

**Note:** If actuals are posted for all the periods of resource allocation, then the **Shift Allocations** option is disabled in the **Actions** menu.

### Allocation workbench options

The header bar on the allocation workbench provides various options to change the view and filter data in the resource grid.

#### Allocation workbench options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date range selector</td>
<td>Shows projects and demands for the selected time range. For a new allocation board, the default period is set as the current date to six months. If you change these dates, the new range is saved as the board default for future board use.</td>
</tr>
<tr>
<td>Resource filter</td>
<td>Filters projects and demands in the resource grid by group, role, or user for the selected period.</td>
</tr>
<tr>
<td>State filter</td>
<td>Filters resource plans in the resource grid by state: (P) Planning, (R) Requested, (C) Confirmed, and (A) Allocated.</td>
</tr>
<tr>
<td>Week or Month view</td>
<td>Shows allocations in weekly or monthly format in both the resource grid and resource finder sections.</td>
</tr>
<tr>
<td>Hours, FTE, or Person days view</td>
<td>Shows allocations in hours, FTE, or person days format in both the resource grid and resource finder sections.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Resource Finder</td>
<td>Displays the resource finder section at the bottom of the workbench. Use the resource finder section to search resources and create a resource plan for them.</td>
</tr>
<tr>
<td>Configuration</td>
<td>Shows or hides the selected columns on the grid. Selecting the Planned Cost, Actual Cost, Conf/Alloc Cost, or Resource Type columns pins them on the grid before the Details column group. Other columns are added in the Details column group in the collapsed state. To view the collapsed columns, click the expand icon (►) on the Details column group.</td>
</tr>
<tr>
<td>Legend</td>
<td>Specifies the state of the resource plan using the Partial Allocated legend.</td>
</tr>
</tbody>
</table>

**Resource schedules**

Resource management uses a default schedule named Resource Management Schedule. The Resource Management Schedule has the following characteristics:

- Weekly on Weekdays
- Monday-Friday 8 A.M.-12 P.M.
- Monday-Friday 1 P.M.-5 P.M.

Administrators can change the default schedule and define custom schedules to meet resource management needs. Any schedule specified on a user record overrides the default resource management schedule.

If necessary, the administrator can create a hierarchy of schedules. This is useful if you want users to have a primary schedule such as M-F 8-5 and a secondary schedule such as Sat-Sun 8-5.

**Custom schedules for user resources**

The Context field in the Schedules related list on the User form determines the user work hours.

If there is no entry set as Resource Management in Context field, the Schedule field on the User form determines the user work hours.

If the Schedule field is empty, the schedule specified in the Default Schedule Name property is used.

If necessary, work with your administrator to create custom schedules. An administrator can change the default schedule for any user by editing the Schedule field on the User form. For example, after creating a custom schedule, the administrator can assign it to users. Any schedule specified on a user record overrides the schedule specified in the Default Schedule Name property.

**Specify the default resource management schedule**

A property defines the default schedule for resource management.

Role required: it_pps_admin
The base system uses Resource Management Schedule. An administrator can change the default schedule at any time. Navigate to System Scheduler > Schedules > Schedules for a list of available schedules.

1. Navigate to System Scheduler > Schedules > Schedules.
2. Find and remember the Name of the schedule you want to use.
4. In Default Schedule Name, enter the schedule name from step 2.

Resource events

A resource event is a block of time that a resource spends on a task.

Each time a resource manager makes an allocation, the system creates one or more resource events for that resource. The resource events appear on the user's personal calendar.

When a booking changes from soft to hard, resource events are created for the resource.

Resource events and schedules

Schedules classify time as work time and non-work time and can be associated with resources and with projects.

The My Calendar module shows the user's work schedule and non-work time.

When a resource manager makes an allocation, the following takes place automatically:

- The schedule associated with the specified resource is analyzed.
- The allocation type changes to Hard and calendar events are created for individual resources within the users schedule. The hours are spread depending upon the hard allocation spread type.

Use the Calendar Event Duration property to control the default minimum unit for an event. See Resource Management properties for examples.

Note: Over-allocation is allowed, starting with the Geneva release. However, no more than 24 hours can be allocated to a user during a given day. See Resource allocation for more information.

Resource event modifications

Resource events that are not part of a resource plan can be modified.

You can only modify events you created for yourself in the "My Calendar" module. If a resource manager added an event to your calendar, then only the resource manager can modify the event.

Resource managers can modify an event that is part of a resource plan by deleting the event and creating a new one. For example, a resource manager allocates a resource to a task on a resource plan and then wants to change the task work type to Phone Call. The resource manager must delete the event and then create another event with the work type set to Phone Call.

Modify a resource event that is part of a resource plan

You can modify a resource event that is part of a resource plan.

Role required: resource manager

2. Click a plan Number.
3. In the Resource Allocations related list, click an allocation Number.
4. Modify the fields on the form (see table).
A resource event

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the event.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Type</td>
<td>The type of event:</td>
</tr>
<tr>
<td></td>
<td>• Time off</td>
</tr>
<tr>
<td></td>
<td>• Appointment</td>
</tr>
<tr>
<td></td>
<td>• Meeting</td>
</tr>
<tr>
<td></td>
<td>• Phone call</td>
</tr>
<tr>
<td></td>
<td>• Task</td>
</tr>
<tr>
<td>When/To</td>
<td>The start and end date of event.</td>
</tr>
<tr>
<td>All day</td>
<td>If the event is an all-day event as specified by the schedule.</td>
</tr>
<tr>
<td>Repeats</td>
<td>If the event repeats Daily, Weekly, Monthly, or Does not repeat.</td>
</tr>
<tr>
<td>Task</td>
<td>The task associated with this event.</td>
</tr>
<tr>
<td>User</td>
<td>The user associated with the event.</td>
</tr>
</tbody>
</table>

**Modify a self-created resource event**

You can modify a resource event that you created.

Role required: none

1. Navigate to **Resource > Calendar > My Calendar**.
2. Double-click an event that has not been assigned to a resource plan.
3. Modify the event, as necessary.
4. Click **Update**.

**Change the resource event color**

Each event type is represented with a specific color. PPS admin can change the colors at any time.

Role required: **it_pps_admin**

1. Navigate to **Project Administration > Settings > Resource Event Colors**.
2. Click an **Event Type**.
3. Specify a different **Color**.
4. Click **Update**.

**Resource Management reports**

Resource Management reports provide resource requesters and resource managers with resource allocations, availability, and utilization.

You can generate reports for the following types of information:

**Availability**
Total time that the resources are available after both hard and soft allocations. Availability is capacity minus allocation.

**Forecasted Utilization**

Percentage of forecasted resource time utilization. It is calculated as sum of allocated and confirmed hours, divided by the total capacity.

**Committed Utilization**
Percentage of committed resource time utilization. It is calculated as allocated hours divided by the total capacity.

**Allocation**

Resource capacity, allocations, availability, and utilization.

**Allocation details**
A tabular breakdown of all allocation requests (soft bookings), committed allocations (hard bookings), and availability, and capacity

<table>
<thead>
<tr>
<th>Resource</th>
<th>Capacity Requested</th>
<th>Capacity Confirmed</th>
<th>Capacity Available</th>
<th>March 2020</th>
<th>April 2020</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alex Garcia</td>
<td>1.8</td>
<td>1.8</td>
<td>3.6</td>
<td>1.8</td>
<td>1.8</td>
</tr>
<tr>
<td>Carolee Norbertt</td>
<td>1.8</td>
<td>1.8</td>
<td>3.6</td>
<td>1.8</td>
<td>1.8</td>
</tr>
<tr>
<td>Scott P.</td>
<td>1.8</td>
<td>1.8</td>
<td>3.6</td>
<td>1.8</td>
<td>1.8</td>
</tr>
<tr>
<td>Alex Garcia (Team Member)</td>
<td>1.8</td>
<td>1.8</td>
<td>3.6</td>
<td>1.8</td>
<td>1.8</td>
</tr>
<tr>
<td>Yvon Dengue</td>
<td>1.8</td>
<td>1.8</td>
<td>3.6</td>
<td>1.8</td>
<td>1.8</td>
</tr>
<tr>
<td>Alexandra Restelli</td>
<td>1.8</td>
<td>1.8</td>
<td>3.6</td>
<td>1.8</td>
<td>1.8</td>
</tr>
<tr>
<td>Alex Garcia (Team Member)</td>
<td>1.8</td>
<td>1.8</td>
<td>3.6</td>
<td>1.8</td>
<td>1.8</td>
</tr>
</tbody>
</table>

View availability, utilization, and allocation reports

You can view resource reports that focus on resource availability, utilization, and allocations.

Role required: admin, resource_user, or resource_manager

2. Fill in the fields, as appropriate.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Type</td>
<td>The type of report that you want to view. You can select from the following options:</td>
</tr>
<tr>
<td></td>
<td>• Availability</td>
</tr>
<tr>
<td></td>
<td>• Forecasted Utilization</td>
</tr>
<tr>
<td></td>
<td>• Committed Utilization</td>
</tr>
<tr>
<td></td>
<td>• Allocation</td>
</tr>
<tr>
<td></td>
<td>• Allocation Details</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Entity Type</strong></td>
<td>The entity that you want to view the report for. You can select from the following options:</td>
</tr>
<tr>
<td></td>
<td>• <strong>User</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Group</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Demand</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Project</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Program</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Portfolio</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Other Task</strong></td>
</tr>
<tr>
<td><strong>User</strong></td>
<td>The user that you want to view the report for. This field is displayed only if you select <strong>User</strong> in the <strong>Entity Type</strong> field.</td>
</tr>
<tr>
<td><strong>Group</strong></td>
<td>The group that you want to view the report for. This field is displayed only if you select <strong>Group</strong> in the <strong>Entity Type</strong> field.</td>
</tr>
<tr>
<td><strong>Group by</strong></td>
<td>The option to filter the report for the selected group by <strong>Roles</strong> or <strong>Members</strong>. This field is displayed only if you select <strong>Availability</strong> or <strong>Forecasted Utilization</strong> or <strong>Committed Utilization</strong> in the <strong>Report Type</strong> field, and <strong>Group</strong> in the <strong>Entity Type</strong> field.</td>
</tr>
<tr>
<td><strong>Members</strong></td>
<td>The group member from the selected group that you want to view the report for. This field is displayed only if you select <strong>Group</strong> in the <strong>Entity Type</strong> field and <strong>Members</strong> in the <strong>Group by</strong> field.</td>
</tr>
<tr>
<td><strong>Role</strong></td>
<td>The resource role from the selected group that you want to view the report for. This field is displayed only if you select <strong>Group</strong> in the <strong>Entity Type</strong> field and <strong>Roles</strong> in the <strong>Group by</strong> field.</td>
</tr>
<tr>
<td><strong>Demand</strong></td>
<td>The demand that you want to view the report for. This field is displayed only if you select <strong>Demand</strong> in the <strong>Entity Type</strong> field.</td>
</tr>
<tr>
<td><strong>Project</strong></td>
<td>The project that you want to view the report for. This field is displayed only if you select <strong>Project</strong> in the <strong>Entity Type</strong> field.</td>
</tr>
<tr>
<td><strong>Program</strong></td>
<td>The program that you want to view the report for. This field is displayed only if you select <strong>Program</strong> in the <strong>Entity Type</strong> field.</td>
</tr>
<tr>
<td><strong>Portfolio</strong></td>
<td>The portfolio that you want to view the report for. This field is displayed only if you select <strong>Portfolio</strong> in the <strong>Entity Type</strong> field.</td>
</tr>
<tr>
<td><strong>Other Task</strong></td>
<td>The task (other than a demand, project, program, or portfolio) that you want to view the report for. This field is displayed only if you select <strong>Other Task</strong> in the <strong>Entity Type</strong> field.</td>
</tr>
</tbody>
</table>
### Option | Description
--- | ---
**Resource Plan** | The resource plan that you want to view the report for. This field is not displayed if you select **User** or **Group** in the **Entity Type** field.

**Start Date and End Date** | The start and end dates that you want to view the report for.

**Zoom Level** | The zoom level that you want to view the report for. You can select from the following options:
- **Weekly**: Displays data for each week during the selected time period.
- **Monthly**: Displays data for each month during the selected time period.

**Report Unit** | **Note**: This field is displayed only when **Availability**, **Allocations**, or **Allocation Details** is selected in the **Report Type** field:
- The unit in which capacity, availability, or allocation of a resource is displayed.
  - **Hours**: Displays the capacity, availability, or allocation of a resource in hours.
  - **FTE**: Displays the capacity, availability, or allocation of a resource in FTE.
  - **Person days**: Displays the capacity, availability, or allocation of a resource in person days.

3. **Click Run** to view the report.

### Edit a resource management report

Resource management reports show resource allocation details in different formats for different time periods. Configure and use these reports according to your business requirements.

**Role required**: resource_user or admin

1. **Navigate to Resource > Resource Reports > Reports-New**. The following reports are displayed:

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Resource — Group Allocation Details — Monthly (Hrs)</strong></td>
<td>Stack bar chart shows the breakdown of allocated time and available time of a group.</td>
</tr>
<tr>
<td><strong>Resource — Group Member Allocation Details — Monthly (Hrs)</strong></td>
<td>Pivot report shows capacity, availability, and allocated hours of all group members in a monthly time frame. The default filter is between today and the next two quarters. Select a group and run the report.</td>
</tr>
<tr>
<td><strong>Resource — Group Member Allocation Details — Weekly (Hrs)</strong></td>
<td>Pivot report shows capacity, availability, and allocated hours of all group members in a weekly time frame. The default filter is between today and the next two quarters. Select a group and run the report.</td>
</tr>
</tbody>
</table>
Report | Description
--- | ---
Resource — Project Member Allocation Details — Monthly (Hrs) | Pivot report shows the list of users allocated to a project on a monthly scale. The report shows allocated and actual hours of every user. Select a project and run the report.

Resource — Task wise — Group Member Allocation Details — Monthly (Hrs) | Pivot report shows the following information for every member of the group:
- All tasks (projects and other tasks) to which the member is allocated.
- Allocated time and actual time spent by the member on the allocated tasks, on monthly basis, for the next two quarters.

Resource — Task wise — Group Member Allocation Details — Weekly (Hrs) | Pivot report shows the following information for every member of the group:
- All tasks (projects and other tasks) to which the member is allocated.
- Allocated time and actual time spent by the member on the allocated tasks, on weekly basis, for the next two quarters.

2. To create a report, click Create a report.

My Calendar

Any user with the resource_user role can open My Calendar to view, add, and modify their planned work, actual work, operational work, administrative tasks, and personal activities.

After a user adds an event to the calendar, the time blocks for that event appear as red, indicating busy, on the resource console and the resource availability dashboard.

Resource managers view users’ calendars to determine who has open time to complete tasks, and can add tasks to any resource’s personal calendar. For every event that is created on a user’s calendar, a record is created in the User Calendar Event [user_calendar_event] table. Resource events are chunks of busy time for the user. Users and resource managers can sometimes modify these records. For more information, see Resource event modifications.

The calendar uses time zones. Time is displayed to users in their local time zone according to user preferences. For more information, see Time zones in resource plans.

**Note:** Although a user can add tasks, such as incidents, to their calendar, the user is not added to the task’s Assigned to field.

Change the resource event color

Each event type is represented with a specific color. PPS admin can change the colors at any time.

Role required: it_pps_admin

1. Navigate to Project Administration > Settings > Resource Event Colors.
2. Click an Event Type.
3. Specify a different Color.
4. Click Update.
Add events to your calendar

Users can add any kind of event to their calendar, including personal events and work-related events.

To create an event that repeats daily, weekly, or monthly, see Create repeatable events.


The calendar appears in the week view by default. The user work schedule appears in white and the off-duty schedule in gray.

2. Change the view as necessary:
   - Click the icon in the upper-left to change between monthly and weekly.
   - Click the forward or back arrows at the upper-right to change the day, week, or month. Click the calendar icon to select a specific date.

3. Click an empty white cell on the calendar.

The Add Event form appears.

4. Fill in the fields, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name for the event.</td>
</tr>
<tr>
<td>Type</td>
<td>Choose from the following items:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Time off</strong>: Personal time off.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Appointment</strong>: A type of administrative task.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Meeting</strong>: A work-related meeting.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Phone call</strong>: A work-related phone call.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Task</strong>: A task in the ServiceNow system, such as an incident or a change that you are assigned to.</td>
</tr>
<tr>
<td>When</td>
<td>Choose the start and end date and time, or select the All day option. Do not use this field to set repeatable events. For example, if you have a three-hour task you want to start on a Monday and end on the following Friday, do not use the When field. Instead, set a weekly Create repeatable events for Monday and Friday.</td>
</tr>
<tr>
<td>Repeats</td>
<td>Select the frequency that the activity repeats, or select Does not repeat.</td>
</tr>
<tr>
<td>Repeat every</td>
<td>Enter a number that represents the frequency. This field appears only if you selected Daily, Monthly, or Yearly.</td>
</tr>
<tr>
<td>Repeat on</td>
<td>Select the days of the week to repeat the activity. This field appears only if you selected Weekly.</td>
</tr>
</tbody>
</table>
### Create repeatable events

Events can be set to repeat on a regular schedule, such as every day, week, or month.

You can create events even if the timeslot is booked by some other event.

1. Navigate to **Resource Management > My Calendar**.
2. Click an empty white cell on the calendar.
3. Create an event with the following options:

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Repeating Task</td>
</tr>
<tr>
<td>Repeats</td>
<td>Daily</td>
</tr>
<tr>
<td>Repeat Until</td>
<td>Last day of the current year</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Repeat until</td>
<td>Select an end date. This field appears only if you selected <strong>Daily</strong>, <strong>Monthly</strong>, or <strong>Yearly</strong>.</td>
</tr>
<tr>
<td>Task</td>
<td>Click the reference lookup icon and select the task that needs to be done. This field appears only if you selected <strong>Task</strong> as the type of activity.</td>
</tr>
</tbody>
</table>

**Note:** This does not add you to the **Assigned to** field on the task form.

- When you add a calendar event, the resource aggregate daily, weekly, and monthly tables are updated.
- All the non-project events created for you from the calender appear as Operational Work for you in **Resource Finder**.
Repeating task

4. Click **Submit**.

View a user calendar

View the calendar of a user to check availability.

Role required: resource_manager

You can view a calendar for a specific user, and not for all users in a group.

1. Navigate to **Resource > Resources > Users**.
2. Do one of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the User list</td>
<td>Right-click a user name in the Users list and select <strong>View Calendar</strong>.</td>
</tr>
<tr>
<td>From the User form</td>
<td>Click a User record to open the User form, and then click the <strong>View Calendar</strong> related link.</td>
</tr>
</tbody>
</table>
Add events to a user calendar

Resource managers can add events to user calendars.

Role required: resource manager

1. Navigate to **Resource > Resources > Users**.
2. Do one of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the User list</td>
<td>Right-click a user name in the Users list and select <strong>View Calendar</strong>.</td>
</tr>
<tr>
<td>From the User form</td>
<td>Click a User record to open the User form, and then click the <strong>View Calendar</strong> related link.</td>
</tr>
</tbody>
</table>

The calendar for that user opens in a new window or tab.

3. Click an empty white cell on the calendar.

   The **Add Event** form appears.

4. Fill in the fields, as appropriate. For detailed field descriptions, see Add events to your calendar.

   - When you add a calendar event, the resource aggregate daily, weekly, and monthly tables are updated.
   - All the non-project events created for a user from the calender appear as Operational Work for the user in **Resource Finder**.

Delete events

You can delete events you created at any time.

You cannot delete any events added to your calendar by a resource manager.

1. Navigate to **Resource Management > My Calendar**.
2. Find the event to delete.

   Use the icons above the calendar to locate the appropriate day, week, or month.

3. Double-click the event.
4. Click **Delete**.
5. Click **OK**.

When you delete a calendar event, the resource aggregate daily, weekly, and monthly tables are updated accordingly.

Use Resource Diagnostics to detect corrupt resource data

The Resource Diagnostics feature uses the Application Diagnostics Tool to detect corrupt data for a resource, such as duplicate aggregates for users, or dailies without a top task.

Role required: pps_admin

1. Navigate to **Resource > Resource Diagnostics**.
2. On the Application Diagnostics Tool page, select **Resource Management**.
3. Select one or multiple diagnostic scans.
4. Click **Run Diagnostics**.
5. View results of the scan.

   It lists the duplicate aggregate for users or project-related resource allocation dailies without a top task, if any.
Add your own diagnostic scans and fix scripts.

Add diagnostic features for resource

Create diagnostic features to evaluate an application feature and organize various diagnostic scans for an application. The diagnostic features appear in the target application and lists all the diagnostic scans associated with the diagnostic feature for that application.

Role required: adt_admin

A diagnostic feature can consist of a single or multiple diagnostic scans. These diagnostic scans execute the scripts, that they are mapped with, to detect data corruption or invalid data. You can then create diagnostic scans with scripts and execute these scans to check resources for any corrupt or invalid data. If a fix script is associated with a scan, you can use it for fixing the corrupt or invalid data.

You can also define fields for users to create specific filter conditions. The diagnostic scripts use the results of these filter conditions as inputs for detecting any corrupt or invalid data.

You can check for the existing features under the Features module. If you don't find one matching your needs, create a diagnostic feature and associate it with an application.

1. Navigate to Application Diagnostics Tool > Features.
2. Click New.
3. On the Diagnostics Feature form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the diagnostic feature. This name appears in the application to which this diagnostic feature belongs.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for activating the diagnostic feature.</td>
</tr>
<tr>
<td>Application</td>
<td>Search for and select the application with which you want to associate this diagnostic feature.</td>
</tr>
<tr>
<td>Roles</td>
<td>Move desired roles to the Selected list. The users with the selected roles can access the diagnostic feature.</td>
</tr>
<tr>
<td>Description</td>
<td>Details of the diagnostic feature. The description is displayed in the application to which the diagnostic feature belongs. It enables the user to understand the diagnostic scans executed in the feature.</td>
</tr>
</tbody>
</table>

4. Define user input values for specifying filter conditions in the Diagnostics Inputs section. The fields in this section are displayed in the application as condition builder.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Name of the label for the input fields.</td>
</tr>
<tr>
<td>Field Type</td>
<td>Select Reference field type.</td>
</tr>
<tr>
<td>Table</td>
<td>Name of the table on which the query specified in the condition should run.</td>
</tr>
</tbody>
</table>
5. Click Submit.

Create diagnostic scripts and add fix scripts to use with the diagnostic feature. For more information, see Add diagnostics and fix scripts for resource.

### Add diagnostics and fix scripts for resource

Add existing or new diagnostic scripts to scan the data in your application for any corruption. You can also attach fix scripts to rectify the corrupt or invalid data identified by the diagnostic script.

**Role required:** adt_admin

You can create multiple diagnostic scripts to check various aspects of data. The results of the filter conditions, that you specify in a diagnostic feature, is used as an input for the diagnostic script while executing. You can also use the result of one script in subsequent scripts.

1. Navigate to Application Diagnostics Tool > Scripts.
2. Click New.

#### Diagnostics Scripts form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the diagnostic script. Use a name that clearly explains the objective of the script. The script name also enables you to identify the correct script while mapping the script to a feature when creating a diagnostic scan.</td>
</tr>
<tr>
<td>Description</td>
<td>Details of the diagnostic script. The description enables the user to understand the functions of the script.</td>
</tr>
<tr>
<td>Diagnostic script</td>
<td>The actual code for the diagnostic script.</td>
</tr>
</tbody>
</table>

4. Optional: If you want to include a script for fixing the corrupt or invalid data identified by the diagnostic script, select the Has Fix script check box.
5. Use Fix script Access Roles to move desired roles to the Selected list. The users with the selected roles can access the diagnostic script.
6. In the Fix script section, add the actual code for the fix script.
7. Click Submit.

### Create diagnostic scan and map scripts for resource

Create a diagnostics scan and map diagnostic feature with diagnostic and fix scripts. You can create a diagnostic scan to execute diagnostic scripts to check the health of data in your application. Use the fix scripts to rectify any corrupt or invalid data that the diagnostic scan identifies.

- **Role required:** adt_admin
- Create diagnostic features. For more information, see Add diagnostics features for resource.
- Create diagnostic and fix scripts. For more information, see Add diagnostics and fix scripts.
After creating diagnostic features, diagnostic scripts, and fix scripts, map the diagnostic features and scripts to create a diagnostic scan. You can map multiple scripts with each diagnostic scan and define the order of their execution.

1. Navigate to Application Diagnostics Tool > Diagnostics.
2. Click New.

**Diagnostics form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the diagnostic scan. This name appears in the application to which this diagnostic scan belongs.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for activating the diagnostic scan.</td>
</tr>
<tr>
<td>Order</td>
<td>The order in which this diagnostic scan appears in the application.</td>
</tr>
<tr>
<td>Feature</td>
<td>Search for and select the diagnostic feature with which you want to associate this diagnostic scan.</td>
</tr>
<tr>
<td>Roles</td>
<td>Move desired roles to the Selected list. The users with the selected roles can access the diagnostic scan.</td>
</tr>
<tr>
<td>Description</td>
<td>Details of the diagnostic scan. The description is displayed in the application to which the diagnostic scan belongs. It enables the user to understand the diagnostic scans.</td>
</tr>
</tbody>
</table>

4. Search for and select diagnostic scripts to map with the diagnostic scan in the Diagnostics and Script Mappings section.
5. Click Submit.

**Multicurrency in Project Management**

Use the multicurrency feature to execute a project or part of a project in a different geographic location that has a different local currency.

The feature helps you to view the cost details of the project in a currency that is different from your functional currency. The values in the project's cost plans, benefit plans, and corresponding cost fields of the project form are also converted to a currency that you specify as project currency. Therefore, you don't need to convert the project currency to the functional currency of the project when the project is executed at a location that uses a currency different than your functional currency.

**Activation information**

Activate the PPM Standard Multicurrency (com.snc.ppm_multicurrency) plugin to enable the multicurrency features in Project Management. Activating the plugin enables the project currency view in project, cost plans, and benefit plans forms. With the project currency view, you can manage your project financials and cost plans in multiple project currencies.

**Note:** Activating this plugin automatically activates PPM Standard (com.snc.financial_planning_pmo) plugin and therefore you get the option to switch between the default view and the project currency view.
Project currency view

In addition to the default view in the Project form, there is Project Currency view, which you can optionally enable to view the multicurrency fields. You can enable this view from the form context menu. The view appears only when you activate the PPM Standard Multicurrency (com.snc.ppm_multicurrency) plugin.

Unlike the Default view, the Project Currency view contains multicurrency-related fields.

You can designate a currency other than the functional currency as the processing Project Currency for a project. The Financials tab of the Project form has the Project currency field. You can select an active currency from the Currencies [fx_currency] table.

<i>Note:</i>

The Project currency field of a project becomes read-only field and locked down for updating the currency once you create a cost plan, cost plan breakdown, benefit plan, benefit plan breakdown, or an expense line for the project.

Specify project currency in Demand

In the Demand form, you can specify the project currency that you want to use for managing a project when you convert a demand to a project. The multicurrency feature is not available in Demand Management, therefore you can manage the demand only using your functional currency. For more information, see Create a demand.

Projects in Project Workspace

Track your projects in project currency in the Project Workspace. Create and monitor the cost plans and benefit plans for a project in project currency. For more information on project workspace, see Project workspace.

To view the cost component in project currency at the grid level and at the breakdown level, see Create and manage cost plans and benefit plans for a project.

Project status reports

To view the planned and actual cost status of your projects in project currency, open the overview and cost sections of project status reports.

Enable project currency view in project-related forms

Switch over to the project currency view to track the planned costs of a project in the selected project currency.

To manage your projects in local currency and to create a project from a demand, the project currency fields are added in the following tables that have cost details and financials tab:
## Tables with project currency fields

<table>
<thead>
<tr>
<th>Table name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand [dmn_demand] table</td>
<td>To create a project from a demand in project currency. Demand form does not have the project currency view. However, you can create a project from a demand by navigating to the <strong>Preferences</strong> tab and selecting a currency in the <strong>Project Currency</strong> field. To create a demand, see <a href="#">Create a demand</a>.</td>
</tr>
<tr>
<td>Project [pm_project] table</td>
<td>To navigate to the Project form, see <a href="#">Define a project</a>.</td>
</tr>
<tr>
<td>Cost Plans [cost_plan] table</td>
<td>To navigate to the Cost Plan form, see <a href="#">Create a project cost plan</a>.</td>
</tr>
<tr>
<td>Cost Plan Breakdown [cost_plan_breakdown] table</td>
<td>To navigate to the Cost Plan Breakdown form, see <a href="#">Update a cost plan breakdown</a>.</td>
</tr>
<tr>
<td>Benefit Plan [benefit_plan] table</td>
<td>If you open the project form in Project Currency view, then by default the project currency related fields appear in the Benefit Plans related list. To create a project benefit plan, see <a href="#">Create a project benefit plan</a>.</td>
</tr>
<tr>
<td>Benefit Plan Breakdowns [benefit_plan_breakdown] table</td>
<td>To update a benefit plan breakdown, see <a href="#">Update a benefit plan breakdown</a>.</td>
</tr>
<tr>
<td>Expense Line [fm_expense_line] table</td>
<td>Expense lines are part of project cost plans and stores cost associated with a specific resource. To navigate to the Expense line form, see <a href="#">Create an expense line</a>.</td>
</tr>
<tr>
<td>Project Funding [project_funding] table</td>
<td>Stores the project target and budget expense values for both capital and operating expenses for a single fiscal period.</td>
</tr>
</tbody>
</table>

1. Navigate to the respective form.
2. Right-click the context menu of the form.
3. Click **View**.
4. Select **Project Currency** from the list.

Refer to the form fields that are exclusive to the Project Currency view that you have selected. All the other form tabs and fields remain same both for the default view and the project currency view. Continue to enter values in the fields as you would for the default view.
Multicurrency fields in project-related forms

When you enable the Project Currency view in Project, Cost Plan, and Cost Plan Breakdown forms, you can observe multicurrency fields in the Financials section of the forms.

Financials tab of the Project form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project currency</td>
<td>Currency in which the project is to be implemented.</td>
</tr>
<tr>
<td>Total planned cost in project currency</td>
<td>Estimated cost of the project in project currency.</td>
</tr>
<tr>
<td>Planned capital in project currency</td>
<td>Capital expenditure (Capex) for the project.</td>
</tr>
<tr>
<td>Planned operating in project currency</td>
<td>Operational expenditure (Opex) for the project in project currency.</td>
</tr>
<tr>
<td>Budget cost in project currency</td>
<td>Budgeted cost in local currency for the project.</td>
</tr>
<tr>
<td>Actual cost in project currency</td>
<td>Actual cost of the project in local currency.</td>
</tr>
<tr>
<td>Estimate at completion in project currency</td>
<td>Sum of all actuals for past fiscal periods added to the functional cost for future fiscal periods in project currency.</td>
</tr>
<tr>
<td>Planned benefit in project currency</td>
<td>Planned benefit for the project in project currency.</td>
</tr>
<tr>
<td>Planned return in project currency</td>
<td>Difference between Planned benefit and Planned cost values.</td>
</tr>
<tr>
<td>Planned ROI %</td>
<td>Percentage calculated based on the values in the Planned return and Estimated cost fields.</td>
</tr>
<tr>
<td>Net present value in project currency</td>
<td>Present value of future cash in project currency based on the given annual interest rate.</td>
</tr>
<tr>
<td>Internal rate of return %</td>
<td>Annual interest rate required to achieve the net present value (NPV) of zero.</td>
</tr>
<tr>
<td>Estimate to completion in project currency</td>
<td>Sum of functional cost for all fiscal periods in project currency.</td>
</tr>
</tbody>
</table>
### Preferences tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status report currency</td>
<td>Currency in which the project status report is generated. If you have the Project currency view enabled in the Project form, then you have the choice to generate the project status report using any of the following currency options:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Functional currency</strong>: Currency obtained from the glide.system.locale property in which the project status report is created.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Project currency</strong>: Project status report is created in the local currency that is selected. If you select Project currency, you can view the planned cost and actual cost in the selected project currency.</td>
</tr>
<tr>
<td></td>
<td>To view the status report of the project, see View project status reports.</td>
</tr>
</tbody>
</table>

### Financials section of the Cost Plan form

#### Cost Plan form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project currency</td>
<td>Currency in which you can create the cost plan.</td>
</tr>
<tr>
<td>Cost in project currency</td>
<td>Value that is rolled up from the Entered cost field of all cost plan breakdowns.</td>
</tr>
<tr>
<td>Total actual cost in project currency</td>
<td>Value that is rolled up from the <strong>Actual cost</strong> field of all cost plan breakdowns in project currency.</td>
</tr>
<tr>
<td>Estimate at completion in project currency</td>
<td>Sum of all actuals for past fiscal periods added to the functional cost for future fiscal periods in project currency.</td>
</tr>
<tr>
<td>Estimate to completion in project currency</td>
<td>Sum of functional cost for all fiscal periods in project currency.</td>
</tr>
</tbody>
</table>

**Note:** Any change that you make to the unit cost, quantity, or fiscal period of a cost plan has the amounts recalculated in project currency. See Updates in cost plan and recalculation of cost in project currency.
Multicurrency fields in the Cost Plan Breakdown form

### Cost Plan Breakdown form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exchange rate for project currency</td>
<td>Rate in effect for the period corresponding to the cost plan breakdown in project currency.</td>
</tr>
<tr>
<td>Project currency</td>
<td>Local currency selected for the cost plan breakdown.</td>
</tr>
<tr>
<td>Cost in project currency</td>
<td>Breakdown amount in project currency.</td>
</tr>
<tr>
<td>Actual cost in project currency</td>
<td>Actual cost generated from processed expense lines in project currency.</td>
</tr>
<tr>
<td>Variance project currency</td>
<td>Difference between Cost in project currency and Actual cost in project currency.</td>
</tr>
<tr>
<td>Budget</td>
<td>Project budget amount entered for a fiscal year gets distributed equally into monthly breakdowns in functional currency.</td>
</tr>
<tr>
<td>Budget cost in project currency</td>
<td>Project budget amount entered for a fiscal year gets distributed equally into monthly breakdowns in project currency.</td>
</tr>
</tbody>
</table>

Financials section of the Benefit Plan form

### Benefit Plan form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project currency</td>
<td>Project currency that was selected in the project is populated.</td>
</tr>
<tr>
<td></td>
<td>Benefit plan attached to a project inherits the same currency as that of the project.</td>
</tr>
<tr>
<td>Benefit in project currency</td>
<td>Benefit incurred from project or demand in project currency.</td>
</tr>
</tbody>
</table>

Multicurrency fields in the Benefit Plan Breakdowns form

### Benefit Plan Breakdowns form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project currency</td>
<td>Currency that is selected in the Project form.</td>
</tr>
<tr>
<td>Benefit in project currency</td>
<td>Benefit incurred from project or demand in project currency.</td>
</tr>
<tr>
<td>Project currency exchange rate</td>
<td>Rate in effect for the period corresponding to the benefit plan breakdown in project currency.</td>
</tr>
</tbody>
</table>
**Multicurrency fields in the Expense Line form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project currency reference rate</td>
<td>Rate at which the entered currency is exchanged for project currency.</td>
</tr>
</tbody>
</table>

**Multicurrency fields in the Project Funding form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capital budget in project currency</td>
<td>Planned expense amount allocated for capital expenditure in the selected currency.</td>
</tr>
<tr>
<td>Operating budget in project currency</td>
<td>Operating expense amount in the selected currency.</td>
</tr>
<tr>
<td>Budget in project currency</td>
<td>Sum of Capex and Opex amounts. The total project funding budget amount rolls up to the <strong>Budget cost in project currency</strong> field.</td>
</tr>
<tr>
<td>Project currency</td>
<td>Currency in which the project is funded.</td>
</tr>
<tr>
<td>Exchange rate</td>
<td>Currency conversion based on the exchange rates between currencies.</td>
</tr>
<tr>
<td>Exchange rate date</td>
<td>Date on which the exchange rate is applied.</td>
</tr>
<tr>
<td>Exchange reference date</td>
<td>Budget Reference Rate from where the exchange rate is retrieved.</td>
</tr>
</tbody>
</table>

**Project currency in cost and benefit plans**

The currency fields in cost and benefit plans defaults to the project currency of the project.

**Entered currency field in cost and benefit plans**

The **Entered Currency** field of the cost plan defaults to the project currency of the project if multicurrency plugin is installed, irrespective of the views – default or functional currency. However, if multicurrency plugin is not installed, the **Entered currency** field of the cost plan defaults to the functional currency of the project.
Similarly, the **Entered Currency** field of the benefit plan defaults to the project currency of the project if multicurrency plugin is installed, irrespective of the views – default or functional currency. However, if multicurrency plugin is not installed, the **Entered Currency** field of the benefit plan defaults to the functional currency of the project.

**Updates in cost plan and recalculation of cost in project currency**

If the unit cost, quantity, or fiscal period of a cost plan are updated, then all the related amount fields in the cost plan, its breakdowns, and the project to which it is rolling up are recalculated in project currency.

**Changes in Unit cost, Quantity, and Recurring check box of a cost plan**

When you modify the **Unit cost** field, **Quantity** field, or **Recurring** check box of the Cost Plan form, the Total planned cost is recalculated in project currency. Similarly, the **Cost in project currency** in the Cost Plan Breakdown is also recalculated. Therefore, the values in the **Planned capital in project currency**, **Planned operating in project currency**, and the **Total planned cost in project currency** fields of the project are also recalculated.

**Changes in the fiscal period of a cost plan**

When you change the fiscal period, either the start or end dates in the Cost Plan form, the **Total planned cost** and the **Cost in project currency** of the cost plan are recalculated. Therefore, the Cost Plan Breakdown records may be added or removed. If the **Recurring** check box is not selected, then the **Cost in project currency** of each Cost Plan Breakdown record is recalculated. In line with this, the values in the **Planned capital in project currency**, **Planned operating in project currency**, and the **Total planned cost in project currency** fields of the project are also recalculated.

**Changes in the entered cost of a cost plan**

If you change the **Entered cost** in an individual Cost Plan Breakdown record, then the **Total planned cost** of the cost plan is recalculated in project currency. Therefore, the values in the **Planned capital in project currency**, **Planned operating in project currency**, and the **Total planned cost in project currency** fields of the project are also recalculated.

**Addition of breakdowns to a cost plan**

If you manually add cost plan breakdowns to a cost plan, then the **Total planned cost** of the cost plan is recalculated in project currency. Therefore, the values in the **Planned capital in project currency**, **Planned operating in project currency**, and the **Total planned cost in project currency** fields of the project are also recalculated.

**Track project budget in project currency**

Allocate budget to a project and enter amounts for capital expense budget (Capex) and operating expense (Opex) budget in project currency. The sum of the Capex and Opex budgets are calculated as total budget in project currency.

Role required: it_portfolio_manager

Allocate budget in a similar manner as you do with functional currency. For more information, see Allocate budget to a project.
Enable the project currency view of the Project form to allocate budget in project.

1. Click the Project Budget related link of the Project form.

Project Budget form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Currency</td>
<td>Currency in which budget is allocated for a project.</td>
</tr>
<tr>
<td></td>
<td>If you activate multicurrency plugin, then you have the option to budget in</td>
</tr>
<tr>
<td></td>
<td>project currency or functional currency.</td>
</tr>
<tr>
<td>Capex Budget in Project Currency</td>
<td>Planned expense amount allocated for capital expenditure in the selected</td>
</tr>
<tr>
<td></td>
<td>currency.</td>
</tr>
<tr>
<td>Opex Budget in Project Currency</td>
<td>Operating expense amount in the selected currency.</td>
</tr>
<tr>
<td>Total Budget in Project Currency</td>
<td>Sum of Capex and Opex amounts.</td>
</tr>
<tr>
<td></td>
<td>The total project funding budget amount rolls up to the <strong>Budget cost in</strong></td>
</tr>
<tr>
<td></td>
<td><strong>project currency</strong> <strong>field</strong>.</td>
</tr>
</tbody>
</table>

2. Click **OK**.

3. Click the Project Budget related list to update or view the record.

The project target and budget expense values for both capital and operating expenses for a single fiscal period is stored in the **Project Funding [project_funding]** table. When you update the project funding record, the amounts are converted to project currency.

**Platform multiple currencies vs Project multicurrency**

The Project Multicurrency features enable you to view the financial information of a project in a currency other than your functional currency. The ServiceNow® Platform also enables you to select a different currency while entering some cost and budget information for a project and demand.

**Project Multicurrency**

The multicurrency feature enables you to view your project's cost details in a currency that is different from your functional currency. When you activate the PPM Standard Multicurrency (com.snc.ppm_multicurrency) plugin, the values in the project's cost plans, benefit plans, and corresponding cost fields of the project form are converted to a currency that you specify as project currency.

The budget reference rate or daily exchange rate is used for conversion of values in different fields of the project form depending on the fields where the values are entered. The values are also rolled up and converted and then displayed in the read-only fields, for example the **Total planned cost** field. Activation of the multicurrency plugin adds new fields that display values in the selected project currency and to view these fields, you must switch to the Project Currency view.

**Project without multicurrency plugin enabled**

When you enter transactions in a currency that is different from your functional currency, Project Management converts the transaction amount to the functional currency.
The following Now Platform® currency fields on the project form enable you to select a currency other than your functional currency or view the calculated values in your functional currency after conversion. For more information about these fields, see Define a project.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total planned cost</td>
<td>Read-only field that displays the estimated cost of the project. The value of this field is calculated from the values of the <strong>Planned capital</strong> and <strong>Planned operating</strong> fields. If the currencies in <strong>Planned capital</strong> and <strong>Planned operating</strong> fields are different from functional currency, the daily conversion rate is used to convert the amount in your functional currency.</td>
</tr>
<tr>
<td>Planned capital</td>
<td>Capital expenditure (Capex) for the project. If no cost plans are associated with the project, the <strong>Planned capital</strong> field is editable. If the selected currency is different from the functional currency, the daily conversion rate is used to convert the amount into your functional currency and the value is used to calculate the value of the <strong>Total planned cost</strong> field. Note: This field becomes read-only when a cost plan is created. Also, the value from the cost plan overrides the value of this field.</td>
</tr>
<tr>
<td>Planned operating</td>
<td>Operational expenditure (Opex) for the project. If no cost plans are associated with the project, the <strong>Planned operating</strong> field is editable. If the selected currency is different from the functional currency, the daily conversion rate is used to convert the amount into your functional currency and the value is used to calculate the value of the <strong>Total planned cost</strong> field. Note: This field becomes read-only when a cost plan is created. Also, the value from the cost plan overrides the value of this field.</td>
</tr>
<tr>
<td>Budget cost</td>
<td>Read-only field that displays budgeted cost for this project. This field is automatically populated from the project budget breakdowns in the cost plan breakdown table. The value in this field is always displayed in functional currency.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Actual cost           | Actual cost of this project. You can select a currency different from your functional currency and enter a value until there are no cost plans associated with the project.  
This field becomes read only when a cost plan is created. When an expense line is processed for the project, the value for this field is overridden and rolled up from the expense lines.  
If the currency for the expense line is different from your functional currency, then the value from the expense line is converted to your functional currency using the daily exchange rate. |
| Estimate at completion| Read-only field that displays the sum of all acturals for past fiscal periods added to the planned cost for future fiscal periods.  
The value in this field is always displayed in functional currency.                                                                                   |
| Planned benefit       | Planned benefit for the project.  
This value is rolled up from the benefit breakdown of the project.  
You can also enter the value manually. Select a currency icon and enter a value.  
If the currency is different from your functional currency, the daily conversion rate is used to convert the amount in your functional currency and the value is used for the calculation of the value in the Planned return field. |
| Planned return        | Read-only field that displays the value derived from the difference between the Planned benefit and Total planned cost values.  
The value in this field is always displayed in functional currency.                                                                                   |
| Net present value     | Read-only field that displays the present value of future cash based on the given annual interest rate.  
The value in this field is always displayed in functional currency.                                                                                   |
| Estimate to completion| Read-only field that displays the sum of all planned costs for future fiscal periods.  
The value in this field is always displayed in functional currency.                                                                                   |

When you create a cost or benefit plan to capture your project's financial information, the currency that you select from the Entered currency list of the Cost plan or Benefit plan form determines the conversion into your functional currency.

© 2021 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
If the functional currency and the currency selected from the Entered currency list are different, the values entered in the **Planned capital**, **Planned operating**, and **Planned benefit** fields of the Project form are replaced by the values from the cost and benefit plan and are converted into the functional currency using the budget reference rate. The values in the **Total planned cost** and **Planned benefit** fields are also converted and are displayed in your functional currency.

**Demand Multicurrency**

The Paris release does not support the PPM multicurrency feature in Demand Management. All the financial information of your demand is displayed in the functional currency. On the Demand form, you can specify a currency that is different from your functional currency to be used as project currency after activating the PPM Standard Multicurrency (com.snc.ppm_multicurrency) plugin.

When you convert the demand to a project, the currency that you specify as project currency in the Demand form is used to display financial information in the **Project currency** fields of the Project form.

However, you can also use some Now Platform currency fields on the Demand form to enter cost-related information. These fields enable you to select a different currency and enter the values manually. The following platform currency fields on the Demand form enable you to select a different currency and display calculated values after roll-up and conversion.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Capital expense    | Capital expenditure (Capex) for the demand. You can select a currency different from your functional currency and enter a value manually.  
 If the selected currency is different from the functional currency, the daily conversion rate is used to convert the amount into your functional currency and the value is used to calculate the value of the **Total planned cost** field. |
| Operating expense  | Operational expenditure (Opex) for the demand. You can select a currency different from your functional currency and enter a value manually.  
 If the selected currency is different from the functional currency, the daily conversion rate is used to convert the amount into your functional currency and the value is used to calculate the value of the **Total planned cost** field. |

**Note:** This field becomes read-only when a cost plan is created. Also, the value from the cost plan overrides the value of this field.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total planned cost</td>
<td>Read-only field that displays the result calculated from the values in the <strong>Capital expense</strong> and <strong>Operating expense</strong> fields. If the currencies in <strong>Capital expense</strong> and <strong>Operating expense</strong> fields are different, the daily conversion rate is used to convert the amount in your functional currency.</td>
</tr>
<tr>
<td>Financial return</td>
<td>Read-only field that displays the result calculated based on values in the <strong>Total planned cost</strong> and <strong>Financial benefit</strong> fields. If the currency in <strong>Financial benefit</strong> fields is different, the daily conversion rate is used to convert and display the amount in your functional currency.</td>
</tr>
<tr>
<td>Financial benefit</td>
<td>Estimate of revenue if the demand is approved. This value is rolled up from the benefit breakdown of the demand. You can select a currency different from your functional currency and enter a value manually. If the selected currency is different from the functional currency, the daily conversion rate is used to convert the amount into your functional currency and the value is used to calculate the value in the <strong>Financial return</strong> field.</td>
</tr>
<tr>
<td>Capital budget</td>
<td>Read-only field that displays the total capital budget allocated to the demand across all fiscal years. The value is rolled up from the Capex budget of the demand.</td>
</tr>
<tr>
<td>Operating budget</td>
<td>Read-only field that displays the total operational budget allocated to the demand across all fiscal years. The value is rolled up from the Opex budget of the demand.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Net present value</td>
<td>Read-only field that displays the present value of future cash based on the given annual interest rate. Net present value (NPV) is calculated from total costs per year, financial benefit per year and the discount rate for the demand.</td>
</tr>
<tr>
<td>Demand Actual Cost</td>
<td>Read-only field that displays the total cost incurred while working on a demand and demand tasks.</td>
</tr>
</tbody>
</table>

**Note:** The value in this field is always displayed in functional currency.

The Entered currency list on the Cost and Benefit plan forms is a platform currency field. This field enables you to select a currency different from your functional currency. If the currency selected in the Entered currency field is different from your functional currency, the budget reference rate is used to convert the values into your functional currency and the converted value is used to calculate the values in the **Total planned cost** and **Financial return** fields.

When you enter the financial information manually, the values are converted into your functional currency using the budget reference rate or daily exchange rate. The following example explains the fields that you can use to manually enter values and their conversion.

For a demand with capital and operating expenses of 50,000 each, the functional currency is set as USD. You can enter the cost-related information using the **Financials** tab of the Demand form or use cost and benefit plans.

When you use the **Financials** tab to enter the cost and benefit information, the values are converted as follows:

- If the functional currency and manually selected currency are the same, the values entered in the **Capital expense**, **Operating expense**, and **Financial benefit** are not changed or converted. The
values from these fields are used to calculate the values for the **Total planned cost** and **Financial return** fields. The values of these fields are displayed in your functional currency.

<table>
<thead>
<tr>
<th>Details</th>
<th>Business Case</th>
<th>Financials</th>
<th>Assessment Data</th>
<th>Notes</th>
<th>Preferences</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Rate Model</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Capital expense</td>
<td>$</td>
<td>100,000.00</td>
<td>$</td>
<td>Capital budget</td>
<td>$100,000.00</td>
</tr>
<tr>
<td>Operating expense</td>
<td>$</td>
<td>50,000.00</td>
<td>$</td>
<td>Operating budget</td>
<td>$100,000.00</td>
</tr>
<tr>
<td>Total planned cost</td>
<td>$150,000.00</td>
<td></td>
<td></td>
<td>Discount Rate %</td>
<td>10</td>
</tr>
<tr>
<td>Financial return</td>
<td>$</td>
<td>500,000.00</td>
<td>$</td>
<td>Net present value</td>
<td>$500.00</td>
</tr>
<tr>
<td>Financial benefit</td>
<td>$</td>
<td>500,000.00</td>
<td>$</td>
<td>Internal rate of return %</td>
<td>0</td>
</tr>
<tr>
<td>ROI %</td>
<td></td>
<td></td>
<td></td>
<td>Demand Actual Cost</td>
<td>$0.00</td>
</tr>
</tbody>
</table>

- If the functional currency and manually selected currencies are different, in this case, the functional currency being USD, and GBP as selected currency, the values entered in the **Capital expense**, **Operating expense**, and **Financial benefit** fields are displayed in GBP, the currency that you selected.
The values from these fields are used to calculate the values for the **Total planned cost** and **Financial return** fields. The values of these fields are displayed in the currency that you selected.

- If you select CHF for the **Capital expense**, GBP as the **Operating expense** and **Financial benefit**, and USD as your functional currency, then the values of these fields are converted in your functional currency.
currency using the daily exchange rate. The converted values are used to calculate the values in the **Total planned cost** and **Financial return** fields and are displayed in your functional currency.

<table>
<thead>
<tr>
<th>Details</th>
<th>Business Case</th>
<th>Financials</th>
<th>Assessment Data</th>
<th>Notes</th>
<th>Preferences</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rate Model</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Capital expense</td>
<td>CHF</td>
<td>$50,000.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operating expense</td>
<td></td>
<td>$50,000.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total planned cost</td>
<td>$125,791,121</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Financial return</td>
<td>$40,838,241</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Financial benefit</td>
<td></td>
<td>$50,000.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ROI %</td>
<td></td>
<td>453</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

When you use Cost plans and Benefit plans to enter the cost and benefit information, the values from cost and benefit plans override the values entered in the various fields of the **Financials** tab of the Demand form. If the currency option selected from the Entered currency list of the cost and benefit plan is different from the functional currency, the values are converted into the functional currency using the budget reference rate as follows:

- If the functional currency and the currency selected from the Entered currency list are the same, the values entered in the **Capital expense**, **Operating expense**, and **Financial benefit** fields of the Demand form are replaced by the values from the cost and benefit plan and are not converted. The
values in the **Total planned cost** and **Financial return** fields also remain unchanged and are displayed in your functional currency.

<table>
<thead>
<tr>
<th>Cost Plan</th>
<th>Cost plan 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project/Demand</td>
<td>UNH2001136</td>
</tr>
</tbody>
</table>

### Financials

- **Total planned cost**: 1,000
- **Functional currency**: USD
- **Cost in functional currency**: 1,000
- **Total actual cost**: 0

The values entered in the cost and benefit plan are reflected on the Demand form as follows:
If the functional currency and the currency selected from the Entered currency list are the different, the values entered in the **Capital expense**, **Operating expense**, and **Financial benefit** fields of the Demand form are replaced by the values from the cost and benefit plan and are converted into the...
functional currency using the budget reference rate. The values are then used to calculate the values in the **Total planned cost** and **Financial return** fields and are displayed in your functional currency.

The values entered in the cost and benefit plan are reflected on the Demand form as follows:
Cost rollup in project currency

Cost rollup calculation in projects and sub-projects with different currencies varies with the budget reference rate. The rate at which the amount is converted depends on the conversion rate.

Convert amount entered in functional currency fields to project currency

When you create a project in functional currency of the Default view, you can manually enter or update the amount in the Planned capital, Planned operating, Actual cost, and Planned benefit fields. As you enter values in these fields, the amount is converted to project currency and stored in the corresponding project currency fields such as Planned cost in project currency, Planned operating in project currency, Actual cost in project currency, and Planned benefit in project currency fields.

Note: You can do so only if the project does not have a cost plan, benefit plan, or expense lines attached to it.

Roll up project financials from sub-projects to parent projects

Use the com.snc.project.multicurrency.rollup_if_different property for financial rollups when the sub-projects and parent project have different project currencies.
## Multicurrency cost rollup property behavior

<table>
<thead>
<tr>
<th>Property flag</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>True</td>
<td>If the property is set to True, then you can: 1. Associate a sub-project to a parent project, where both the projects have different project currencies. 2. Roll up the sub-project amounts to the parent project amounts. However, the accuracy of the rolled up amount in the parent project varies because of the currency variation. • If the project currencies of the parent project and the sub-project are the same, then the project currency amounts from the sub-projects to its parent and the top project are rolled up by adding up the amounts in the sub-project, and the rolled up amount is accurate. • If the project currencies of the parent project and the sub-project are different, then all the costs of the sub-projects are converted to the project currency of the parent or the top project, referencing the Budget Reference Rate. The rate at which the amount is converted depends on the exchange rates between the project currencies, and the specified time period at which the conversion is made. Hence, the rolled up amount is only an estimate or an approximate value.</td>
</tr>
<tr>
<td>False</td>
<td>If the property is set to False, then you can: 1. Associate any number of sub-projects to a parent project, where the project currencies are same or different. 2. Roll up only if the project currencies of the sub-project and the parent project match.</td>
</tr>
</tbody>
</table>

However, the behavior of `com.snc.project.multicurrency.rollup_if_different` property is different when flagged along with `com.snc.project.rollup.cost` property.

## Multicurrency cost rollup property in combination with functional currency property

<table>
<thead>
<tr>
<th>Properties flag</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>com.snc.project.rollup.cost</code> property is false</td>
<td>You can associate any sub-projects with parent project that have same or different project currency but the costs of sub-projects do not roll up to the parent project.</td>
</tr>
</tbody>
</table>
Illegal association of properties and possible errors

Following are the possible errors that may occur while making an illegal association:

| Property combinations for sub-project and parent project association |
|-------------------------------------------------|---------------------------------|----------------------------------------------------------------------------|
| com.snc.project.rollup.cost | com.snc.project.multicurrency.rollup_if_different | Behavior |
| False | Either true or false | Can associate sub-project to parent project even though project currency of sub-project and parent project is different but costs from sub-project to parent project cannot be rolled up. |
| True | False | Cannot associate sub-project to parent project if project currency of the sub-project and parent project is different. In such case of an association, an error message: System policy does not allow parent and child projects to have different project currency pops up. |

Quick start tests for PPM Standard Multicurrency

Validate that PPM Standard Multicurrency still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.


<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify cost in project currency on cost plan</td>
<td>Validate the calculation of cost line breakdown with budget reference rate and verify roll up to cost plan and also for the project in project currency.</td>
<td></td>
</tr>
</tbody>
</table>
Upgrade existing projects on activating multicurrency plugin

Execute the **PM upgrade project currency for active projects** and **PM upgrade project currency for inactive projects** scheduled jobs to upgrade your active and inactive projects, respectively, after you activate the multicurrency plugin. Select the scheduled jobs and run them on demand to upgrade your projects in project currency only when necessary.

**Role required:** admin or it_project_manager

1. Navigate to **System Definition > Scheduled Jobs**.
2. Click the **PM upgrade project currency for active projects**.
3. Click **Execute Now** to upgrade all your existing active projects to project currency.

   On execution of the job, all amounts in the cost-related fields of the Project, Project Task, Baseline, Cost Plan, Cost Plan Breakdown, Benefit Plan, Benefit Plan Breakdown forms are copied from functional currency to project currency fields. Once the values of functional currency fields are copied to the project currency fields project currency cannot be edited since the financial costs already exist.

4. To upgrade your inactive projects, click **PM upgrade project currency for inactive projects**.
5. Click **Execute Now**.

   On executing the scheduled job, the project currency value for all existing projects is set to the functional currency. The project currency in the Project Tasks, Baselines, Cost Plans, Cost Plan Breakdowns, Benefit Plans, Benefit Plan Breakdowns, Expense Lines forms is set to functional currency.

**Note:** The jobs may have performance impact depending on the number of projects and cost plans, hence run the jobs only when necessary.

Rate Models

Use a rate model to derive date-effective, criteria-driven hourly rates for calculating planned and actual resource costs for a project or demand.

Unlike labor rates, which are based on the user attribute only, a rate model can derive hourly rates based on up to ten attributes. These attributes can be selected from predefined entities such as projects, demands, users, and roles.

Rate lines

A rate model is a collection of multiple rate lines. A rate line is a unique combination of different criteria values that defines the hourly rate for a resource, group, or role for a specific date range. For the same set of criteria, you can create multiple rate lines with different rates for different date ranges provided that the dates don't overlap.
Rate model processing

To derive hourly rates from a rate model for the resource plans and time cards of a project or demand, associate the rate model with the project or demand.

**Note:** If a project or demand does not have an associated rate model, the default labor rate is used.

The rate model associated with a project or demand evaluates the rate lines to find and return the hourly rate that matches the requested criteria. The rates are derived from the rate model during resource planning or allocation, and during time card processing.

The rate is returned in the functional currency specified in the matching rate line.

Rate model processing flow diagram

The following video describes how to set up a rate model and the evaluation method to find and return the hourly rate for a request.

When a rate is requested, the rate model uses the following process.

1. Finds the rate lines in the requested date range and discards the remaining rate lines.
2. Evaluates the identified rate lines to find values matching the requested value in the first criteria column and discards the remaining rate lines.

If the requested value is empty, it checks for rate lines containing NULL.

If no exact match is found, it checks for the rate line having the value All other (*).

The evaluation is repeated for the other criteria columns in order of priority until all criteria columns are processed.

3. Returns the rate if one or more rate lines match the request.

- If a single rate line is found, the corresponding rate is returned.
- If multiple rate lines are found, the system determines the number of hours in the request that applies to each rate.
- For example, say the rate requested is for resource allocation from July 1 to July 30. The rate model has one rate from July 1 to July 15 and a different rate from July 16 to July 30 for the same set of criteria. The rate model applies the first rate to the requested hours for July 1–15 and the second rate to the requested hours for July 16–30.

If no rate lines match the request, then the request uses the default rate card.

Create or modify a rate model

Create or modify a rate model that can be linked to a project or demand to determine planned costs and actuals for their resource. The rate model provides date-effective, criteria-driven hourly rates for these investments.

Before you create a rate model:

- Choose the attributes to define the criteria in a rate model to derive hourly rates.
- Define the budget reference rates for the non-functional currency for the required time periods.

Role required: pps_admin or it_rate_model_admin

1. Create a rate model.

<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Project Administration</td>
<td>a. Navigate to Project Administration &gt; Rate Model &gt; All.</td>
</tr>
<tr>
<td></td>
<td>b. Click New.</td>
</tr>
</tbody>
</table>

2. On the form, fill in the fields.

Rate Model form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the rate model.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for indicating the status of the rate model. Only active rate models can be assigned to a project or demand.</td>
</tr>
</tbody>
</table>
### Define criteria of a rate model

Set the criteria of a rate model by adding attributes from a set of predefined entities to derive resource hourly rates based on the criteria.

**Role required:** pps_admin or it_rate_model_admin

A rate model consists of one or more rate lines. Each line contains a unique combination of criteria values and the hourly rate of a resource. You define the criteria by adding up to 10 attributes from the following entities:

- Project
- Project task
- Demand
- User
- Group
- Role
- Resource plan

You can select attributes of type String, Reference, Number, Boolean, and Choice.

1. Open a rate model by performing one of the following actions:
   - Navigate to **Project Administration > Rate Model > All.**
   - Navigate to **Time Sheets > Rate Model > All.**

2. In the **Rate Model Attributes** related list, click **New.**
3. On the form, fill in the fields.

**Rate Model Attributes form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entity</td>
<td>Entity from which the attribute is used to define the criteria.</td>
</tr>
<tr>
<td>Attribute</td>
<td>List of attributes from the selected entity to define the criteria.</td>
</tr>
<tr>
<td>Priority</td>
<td>Unique number that determines the order in which attributes in a rate model are evaluated to derive the hourly rate.</td>
</tr>
<tr>
<td></td>
<td>An attribute with the lowest priority is evaluated first.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Two attributes cannot have the same priority.</td>
</tr>
<tr>
<td>Name</td>
<td>User-friendly name for identifying the attribute. The default name populated is based on the selected entity and attribute.</td>
</tr>
<tr>
<td></td>
<td>For example, if you select Resource in the <strong>Entity</strong> field and Location in the <strong>Attribute</strong> field, then the default name is Resource/Location.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Create rate lines to define the hourly rates for resources.**

**Create a rate line**

In a rate model, create a rate line to define an hourly rate based on a set of criteria for a given date range.

Role required: pps_admin or it_rate_model_admin

Before creating or updating a rate line, note the following points:

- Rate lines with the same set of criteria values cannot have overlapping dates.
- A criteria field can be empty.
- All criteria fields on the form have a value **All other (*)** that, if selected, is considered by the rate model if no exact match exists for that criteria.
- To use a non-functional (non-default) currency in a rate line, ensure that the corresponding budget reference rate is available.

1. Open a rate model by performing one of the following actions:
   - Navigate to **Project Administration > Rate Model > All**.
   - Navigate to **Time Sheets > Rate Model > All**.

2. On the Rate Model form, click the **View Rate Lines** related link.

3. On the Rate Lines form, click **New**.
4. On the form, fill in the fields.

**Rate Lines form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rate Model</td>
<td>Rate model the rate line belongs to.</td>
</tr>
<tr>
<td>Start date</td>
<td>Start date of the time period in which the rate is applicable.</td>
</tr>
<tr>
<td>End date</td>
<td>End date of the time period in which the rate is applicable.</td>
</tr>
<tr>
<td>Criteria fields</td>
<td>Fields corresponding to the rate model attributes added to define the criteria. The number of fields may vary. For example, if you have added Group and Location as rate model attributes, they are available as fields on the form where you can specify their values.</td>
</tr>
<tr>
<td>Rate</td>
<td>Applicable rate and currency of the rate line. You can specify different currencies for different rate lines within a rate model. Rate lines with the same set of criteria values and currency must not have overlapping dates.</td>
</tr>
<tr>
<td>Rate type</td>
<td>Labor rate type applicable for the rate line. The field appears if the Rate type check box on the Rate Model form is selected.</td>
</tr>
<tr>
<td>Description</td>
<td>Short description for the rate line.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

Rate lines that represent resource hourly rates based on defined attributes are created.

**Export rate lines to a file**

Export rate lines to a Microsoft Excel or CSV file to quickly update or add new rate lines and import them back into the rate model.

Before exporting rate lines, define the criteria of the rate model by adding attributes to it. The downloaded export file includes columns corresponding to the selected attributes and the following default columns:

Role required: pps_admin or it_rate_model_admin.

Besides creating rate lines one at a time, you can add multiple rate lines into a rate model using the export and import rate lines functions.

- Rate Model
- Number
- Start Date
- End Date
- Currency
- Rate
• Rate Type

Note: The Rate Type column is available only if the Rate type check box is selected for the rate model.

The number of criteria columns depends on the number of attributes added in the rate model.

1. Open a rate model by performing one of the following actions:
   - Navigate to Project Administration > Rate Model > All.
   - Navigate to Time Sheets > Rate Model > All.

2. On the Rate Model form, click the View Rate Lines related link.

3. Click the more actions icon ( ) and then select the Export to CSV option.
   A dialog box might prompt you to save or open the export file. By default, the file has the same name as the rate model. However, you can specify a different file name. Save the file either as a CSV file or Microsoft Excel (.XLSX) file.

Note: Depending on your browser setting, the browser might automatically save the file to your Download folder.

4. Open the downloaded file using your preferred application. Enter new rate lines or update the existing ones and save the file either as a CSV file or Microsoft Excel (.XLSX) file.

All rate lines in the rate model are exported to the file. If there is no rate line in the rate model, the file is an empty template containing only the column names in the first row.

Import rate lines from the file into a rate model.

Import rate lines into a rate model

Use the import rate lines function to quickly add multiple rate lines from an export file into a rate model.

Set the glide.import_set_row.dynamically_add_fields system property to true.

Role required: pps_admin or it_rate_model_admin

After adding or updating rate lines in a file created using the export function, you can import the rate lines from the file into the rate model.

Note: Rate lines fail to import in the following circumstances:
   - Overlapping effective dates for the same set of criteria values.
   - Criteria values with no matching data in the system. For example, a rate line might have Business Analyst as the Role criteria but that role does not exist in the system.
   - Rates in non-functional (non-default) currency but no corresponding budget reference rates for the required period exist in the system.

1. Import rate lines from an import file into the rate model in one of the following ways:
   - Navigate to Project Administration > Rate Model > Import Rate Line.
   - Navigate to Time Sheets > Rate Model > Import Rate Line.
   - Navigate to Time Sheets > Rate Model > All, open a rate model record, and click the Import Rate Line related link.

2. Click Choose File to select the import file.
3. Optional: If you are importing from an Excel file containing multiple sheets, enter the sheet number that contains the data to import in the **Sheet number** field.

   **Note:** If you are importing from a CSV file, then the data from the last saved CSV file is considered for import irrespective of the specified sheet number.

4. Optional: If the import file has a header row, enter the row number that has the header information in the **Header row** field.

5. Click **Submit**.

6. Click **Run Transform** to import the data.
   For more information, see [Run an import](#).

   - New rate lines are appended to the rate lines list in the rate model.
   - Existing rate lines in the rate model are updated with the latest values.

**Domain separation in Project Portfolio Management**

This is an overview of domain separation and Project Portfolio Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

**Support level: Basic**

- There is business logic to ensure data goes into the proper domain for the application’s service provider use cases.
- In the application, the user interface, cache keys, reporting, rollups, aggregations, and so on, all consider domain at run time.
- The owner of the instance needs to be able to set up the application to function normally across multiple tenants.

Use case: As a service provider when I use chat to respond to a tenant-customer’s message, the client must be able to see my response.

**How domain separation works in Project Portfolio Management**

Project Portfolio Management is domain separation-compliant with the following limitations:

- All PPM entities such as project, demand, resource plan, and allocations are expected to be in the same domain. A project entity having tasks or resources from multiple domains is not supported.
- A parent entity and all child entities, such as a project record and its project tasks, are expected to be in the same domain.
- When you change the domain of a parent record, for example a project record, the domain of the child records are not changed.
- Only users belonging to the same domain, parent domain, or the top domain have the visibility into PPM entities of a domain.
- All system properties are in the global domain and are not specific to a domain. Planning console settings, however, are still domain-specific.
Quick start tests for Project Portfolio Management

Validate that Project Portfolio Management still works after you make any configuration change such as applying an upgrade or developing an application. Copy and customize these quick start tests to pass when using your instance-specific data.

Quick start tests require activating the PPM Standard - ATF Tests plugin (com.snc.financial_planning_pmo.atf).

### PMO: Financial Tests for verifying cost rollups and demand to project conversion test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>PMO: Verify cost plan roll up to project/demand and program</td>
<td>Validate the total planned cost rollup from project and demand to program.</td>
<td></td>
</tr>
<tr>
<td>PMO: Verify cost plan roll up to project/demand, program and portfolio</td>
<td>Validate the total planned cost rollup from project and demand to portfolio.</td>
<td></td>
</tr>
<tr>
<td>PMO: Verify financials of Project created from Demand - Simple Financials</td>
<td>Validate the financial tab fields of a project created from a demand.</td>
<td></td>
</tr>
<tr>
<td>PMO: Verify financials of Project created from Demand - With budget, cost plans, benefit plans</td>
<td>Validate the budget, cost plan, and benefit plan of a project created from a demand.</td>
<td></td>
</tr>
</tbody>
</table>

### PMO: Project Management tests for validating basic life cycle and project rollups test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Validate PPM Cycle from Ideation to demand to project closure</td>
<td>Validate the flow of creating an idea, converting the idea to a demand, and then converting the demand to a project.</td>
<td></td>
</tr>
<tr>
<td>Validation of State and Date Rollup for Automatic Project</td>
<td>Validate the date and state rollup from tasks for a project of type Automatic.</td>
<td></td>
</tr>
<tr>
<td>Validation of State and Date rollup for Manual Project</td>
<td>Validate the date and state rollup from tasks for a project of type Manual.</td>
<td></td>
</tr>
<tr>
<td>Validation of project percent complete when all tasks are Closed Incomplete</td>
<td>Validate the project percent complete when all the tasks are closed as Closed Incomplete.</td>
<td></td>
</tr>
<tr>
<td>Validate Project is not 100 percent complete if it has atleast one task as closed incomplete</td>
<td>Validate the project percent complete is not 100% when at least one of the tasks is closed as Closed Incomplete or Closed Skipped with task % complete less than 100%.</td>
<td></td>
</tr>
<tr>
<td>Test</td>
<td>Description</td>
<td>Release version</td>
</tr>
<tr>
<td>---------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
</tbody>
</table>
| Validate waterfall project does not show Agile Planning Board       | Validate that the waterfall projects cannot use the following:  
• Add stories or epics  
• Add agile phase  
• Access Agile board from the project                                                                                                              |                 |
| Validate dates are rolled up from existing projects to program      | Validate that the start and end dates of the project are rolled up to the program to which the project belongs.                                                                                               |                 |
| Validate dates are rolled up from new projects to program           | Validate that the start and end dates of a new project are rolled up to the program to which the project belongs.                                                                                              |                 |
| Add projects and demands with risks or issues to program            | Validate that the projects and demands with risks or issue records associated with them are added to the program.                                                                                             |                 |
| Add projects and demands with benefit plans to program              | Validate that the projects and demands with benefit plans associated with them are added to the program.                                                                                                       |                 |
| Add projects and demands with cost plans to program                 | Validate that the projects and demands with cost plans associated with them are added to the program.                                                                                                         |                 |
| Validate program dates on addition of existing demands              | Validate that the start and end date of the program are adjusted on addition of an existing demand.                                                                                                           |                 |
| Validate program dates on addition of new demands                   | Validate that the start and end date of the program are adjusted on addition of a new demand.                                                                                                                |                 |
| Validate program state rollup                                       | Validate that the program state is rolled up from state of all the projects in the program.                                                                                                                  |                 |

**Child Test Suite: Validation of Move Project Action**

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Validate Planned start date of a project can be shifted by using the Move project action</td>
<td>Validate that the Planned start date of a project in Planning or Open state can be updated to a later or earlier date than the current planned start date using the Move project related link.</td>
<td></td>
</tr>
<tr>
<td>Validate Move Project is disabled when Project is selected for execution</td>
<td>Validate that the Move Project option is not available if the Project is in Execution phase.</td>
<td></td>
</tr>
</tbody>
</table>
### Test Descriptions

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Validate Move Project functionality with sprint dates populated for an agile phase</td>
<td>Validate that the sprint start and end dates are cleared when the project is moved using the Move Project related link.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This test is available only when plugin (com.snc.sdlc.agile.2.0) is activated.</td>
<td></td>
</tr>
<tr>
<td>Validate Move Project functionality with external dependencies and related entities</td>
<td>Validate that the external dependencies and related entities are also shifted and redrawn when the project is moved using the Move Project related link.</td>
<td></td>
</tr>
<tr>
<td>Validate Move Project functionality with different project states</td>
<td>Validate that the Move Project does not work when the project is in Work In Progress or Closed Complete state.</td>
<td></td>
</tr>
</tbody>
</table>

### PMO: Resource Management tests for verifying the resource plan flows test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify user resource plan flow from Planned to Canceled state</td>
<td>Validate that the resource plan of a project can be moved to canceled state from planned state.</td>
<td></td>
</tr>
<tr>
<td>Verify group resource plan flow from Planned to Complete state</td>
<td>Validate that the resource plan of a project can be moved to complete state from planned state.</td>
<td></td>
</tr>
<tr>
<td>Verify role resource plan flow from Planned to Allocated state</td>
<td>Validate that the resource plan of a project can be moved to allocated state from planned state.</td>
<td></td>
</tr>
<tr>
<td>Verify aggregated cost of all resource plans roll up to the corresponding project or demand fields</td>
<td>Validate that the aggregated cost of all resource plans on a project or demand roll up to the Planned Cost and Allocated Cost fields and the Resource Cost section of respective projects and demands.</td>
<td></td>
</tr>
<tr>
<td>Verify Copy Resource plan option</td>
<td>Validate that the Copy Resource plan option creates an exact copy of the source resource plan in the Planning state</td>
<td></td>
</tr>
<tr>
<td>Verify resource plan aggregate roll up from project/demand to program</td>
<td>Validate that the aggregated cost of all resource plans on a project or demand roll up to the total planned cost of the associated program.</td>
<td></td>
</tr>
<tr>
<td>Test</td>
<td>Description</td>
<td>Release version</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td>-----------------</td>
</tr>
</tbody>
</table>
| Verify records on completion of a resource plan | Validate the changes in a resource plan on completion:  
• The state of the resource plan is updated to Completed.  
• If the completion date is earlier than the resource plan end date, the end date of the resource plan is updated with the completion date. If the completion date entered is later than the resource plan end date, the resource plan end date is retained.  
• All the requested and allocation records for the resource plan for the period after the completion date are deleted. If there are any actual hours logged against an allocation, that allocation is not deleted. For those allocation records, the allocated hours become zero and the actual hours are retained.  
• The available and allocated hours for resources are updated in the aggregate tables. | |
| Verify records on completion of a resource plan with Planned Duration as allocation type | Validate the following on completion of a resource plan with Planned Duration as allocation type:  
• The state of the resource plan is updated to Completed.  
• Allocations are not deleted.  
• End date of the allocation is updated to the completion date. | |
<p>| Verify the RP replan Capability | Validate that when a cancelled resource plan is re-planned, the state of the resource plan changes to Planning. | |
| Verify whether change in resource plan is reflected in corresponding cost plan | Validate that when a resource plan is updated, the corresponding cost plan is updated accordingly. For example, if the total planned cost is 500 USD, and the planned hours is 10, and you change the planned hours to 20, the total planned cost is updated to 1000 USD. | |</p>
<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
</table>
| Resource-Test the default population of resource plan start & end date | Validate the following on creating a user or group resource plan from the related list of a demand:  
- If a demand is created without a start date and end date, the user or group resource plan has task as demand and no start and end date.  
- If a demand is created with a start date and end date, the user resource plan has task as demand and the start date and end date as added for the demand. | |

Financial Management

Use the ServiceNow® Financial Management application to allocate, track, and report on expenses in your organization.

The application provides a workbench, which is a visual tool that you can use to extract expenses from your general ledger. You can also use it to process the expenses, and map them to the functions used by IT. Various reports are also available to help you know exactly how much of your expenditures are related to IT.

The Financial Management application is available starting with the Fuji release. The modules in the Financial Management application prior to the Fuji release are included with IT Cost Management.

Watch this five-minute video to learn more about financial planning, actual expenses, and budgeting.

How Financial Management Works

The Financial Management application uses these components:

- The general ledger: A list of your organizational expenses.
- The fiscal period: The time frame during which expenses were incurred. You can work with only one fiscal period at a time.
- The cost models: The underlying records that tell the application how to allocate expenses to the accounts in the hierarchy of segments.
- The allocation engine: The core of the application that uses your cost model to calculate expenses and determine how to allocate expenses.
- Financial reports and dashboards: Graphical representations of the expense allocations that show you where your expenses are coming from.

With the workbench, you can choose the fiscal period, build your cost model, and run the allocation engine. There are specific dashboards for Business Application Costing cost model that you can use to track key data relevant to your business applications.
Requirements

The following are required to use Financial Management:

- For all financial overview and dashboard reports to function properly, activate Report Charting v2 on your instance.
- If you are using Internet Explorer, use version 11 or later. You can also use any of the other generally supported web browsers.

Activate Financial Modeling

Use the Financial Modeling application to use its default cost models with its prescribed metrics and entities. The metrics and their related entities such as rollups, overrides, buckets, and allocations enable you to evaluate the cost and track your business expenses.

If you are a licensed ITSM professional user or a licensed Application Portfolio Management user, then you can use the Financial Modeling application.

Role required: admin

The following Financial Management plugins are no longer visible or available to be activated directly:

- Financial Charging (com.snc.service_charging).
- Financial Management For APM (com.snc.financial_management_for_apm).
- Financial Management For CSM (com.snc.financial_management_for_csm).
- Financial Management For FSM (com.snc.financial_management_for_fsm).
- Performance Analytics – Content Pack – Financial Management (com.snc.pa.fm).
- Performance Analytics – Content Pack – Financial Management for Field Service Management (com.snc.pa.fm.fsm).
- Performance Analytics – Content Pack – Financial Management for Application Portfolio Management (com.snc.pa.fm.apm).

If you want to activate the Financial Modeling application, you can do so in Paris by requesting Financial Management for SPM plugin (for licensed ITSM Professional users) or Financial Management for APM plugin (for licensed APM users). Some of the Financial Management features are limited if you are activating it through these plugins.

If you are a new customer in Paris, Financial Management is available as an add-on plugin to Application Portfolio Management (APM) and Service Portfolio Management (SPM). The plugin is available on zBoot when you subscribe APM or SPM.

Financial Management For APM (com.snc.financial_management_for_apm)

Enables integration of Financial Management with Application Portfolio Management providing preconfigured Business Application Costing cost model.

Financial Management For SPM (com.snc.financial_management_for_spm)

Enables integration of Financial Management with Service Portfolio Management providing preconfigured Service Offering Costing cost model. This plugin requires Financial Modeling and Service Owner Workspace plugins.
Performance Analytics — Content Pack — Financial Management for Application Portfolio Management (com.snc.pa.fm.apm) plugin

Enables Performance Analytics dashboards for Financial Management associated with Application Portfolio Management.

To purchase a subscription, contact your ServiceNow account manager. After purchasing the subscription, activate the plugin within the production instance.

You can evaluate the feature on a sub-production instance without charge by requesting it from the HI Customer Service System.

The Financial Management plugin is the basic plugin for the application. Budget plan data and forecast data are both included in demo data.

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Install Financial Modeling application and set up your data tables and define permissions for your users to perform the tasks.

### Installed with Financial Management

Several components are installed with the Financial Management application.

Demo data is available with Financial Management. The demo data provides sample hierarchy of segments information, allocations, and expenses.

### Tables installed with Financial Management

Financial Management adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actuals Log [itfm_actuals_run_log]</td>
<td>Logs of actuals generated and keys generated for the associated plan definition.</td>
</tr>
<tr>
<td>Base Statement Item Breakdown</td>
<td></td>
</tr>
<tr>
<td>[itfm_charge_item_breakdown]</td>
<td>Statement item breakdown definitions.</td>
</tr>
<tr>
<td>Bucket [itfm_bucket]</td>
<td></td>
</tr>
<tr>
<td>Bucket Account Allocation</td>
<td>Bucket assignment information.</td>
</tr>
<tr>
<td>[itfm_bucket_account_allocation]</td>
<td></td>
</tr>
<tr>
<td>Bucket Allocation Account</td>
<td>A reference link among buckets, accounts, and cost models.</td>
</tr>
<tr>
<td>[itfm_bucket_allocation_account]</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Budget [itfm_budget]</td>
<td>Final budgets.</td>
</tr>
<tr>
<td>Budget Definitions [itfm_plan_definition]</td>
<td>Parent table for budgeting that holds the metadata such as name, budget plan year span, forecast time span, ownership, and frequency of forecasting.</td>
</tr>
<tr>
<td>Budget Forecast [itfm_budget_forecast]</td>
<td>All budget forecasts.</td>
</tr>
<tr>
<td>Budget Forecast Items [itfm_bf_item]</td>
<td>All items on the budget forecast.</td>
</tr>
<tr>
<td>Budget Keys [itfm_plan_key]</td>
<td>The key used to identify forecasts and plans.</td>
</tr>
<tr>
<td>Budget Notes [itfm_budget_note]</td>
<td>Notes for budgets that you enter in the budget variance report.</td>
</tr>
<tr>
<td>Budget Override Categories [itfm_budget_override_categories]</td>
<td>Categories that you use to classify budget overrides.</td>
</tr>
<tr>
<td>Budget Period [itfm_budget_period]</td>
<td>Budget periods.</td>
</tr>
<tr>
<td>Budget Reference Rate Configuration [itfm_fx_config]</td>
<td>Exchange rate / fiscal period relationships.</td>
</tr>
<tr>
<td>Budget Reference Rates [itfm_fx_rate]</td>
<td>The exchange rates that budgets use.</td>
</tr>
<tr>
<td>Budget Segment Map [itfm_budget_segment_map]</td>
<td>A relationship between segments that budgets use and a budget key.</td>
</tr>
<tr>
<td>Budget Targets [itfm_budget_target]</td>
<td>All budget target values.</td>
</tr>
<tr>
<td>Budget Task [itfm_budget_task]</td>
<td>Budget tasks.</td>
</tr>
<tr>
<td>Business Unit [business_unit]</td>
<td>All business units.</td>
</tr>
<tr>
<td>Cleansing Condition [itfm_cleansing_condition]</td>
<td>Conditions that the application automatically generates when you clean data in the workbench.</td>
</tr>
<tr>
<td>Consumption Breakdown [itfm_charge_item_breakdown_cons]</td>
<td>Breakdown definitions for statement items that are based on a user-defined consumption table.</td>
</tr>
<tr>
<td>Consumption Statement Item [itfm_charge_item_cons]</td>
<td>Showback source definitions for statement items that are based on a user-defined consumption table.</td>
</tr>
<tr>
<td>Cost Allocation [itfm_account_allocation]</td>
<td>An all-around view of the allocations going to and from each account.</td>
</tr>
<tr>
<td>Cost Allocation [itfm_allocation]</td>
<td>All allocation lines that are processed from allocations. This table holds a more detailed level of allocation lines as compared to the Cost Allocation Aggregate table.</td>
</tr>
<tr>
<td>Cost Allocation Group [itfm_cost_allocation_group]</td>
<td>Groups that can be associated with allocations.</td>
</tr>
<tr>
<td><strong>Table</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>----------</td>
<td>----------------</td>
</tr>
<tr>
<td>Cost Allocation Rollup [itfm_rollup]</td>
<td>Rollups that the application creates when you use the workbench.</td>
</tr>
<tr>
<td>Cost Allocation Rollup Override [itfm_rollup_override]</td>
<td>Values that you can use to override allocation rollups.</td>
</tr>
<tr>
<td>Cost Allocation Runs Log [itfm_ca_run_log]</td>
<td>A log of all allocations that have been run.</td>
</tr>
<tr>
<td>Cost Model Breakdown [itfm_charge_item_breakdown_cm]</td>
<td>Breakdown definitions for statement items that are based on the Financial Modeling output.</td>
</tr>
<tr>
<td>Cost Model Statement Item [itfm_charge_item_cm]</td>
<td>Showback source definitions for statement items that are based on the financial modeling output.</td>
</tr>
<tr>
<td>Financial Data Source [itfm_data_source]</td>
<td>The source of the financial data: the staged general ledger or the cost plan breakdown.</td>
</tr>
<tr>
<td>Financial Data Source Field Map [itfm_data_source_field_map]</td>
<td>Individual fields mapped to the sources of financial data.</td>
</tr>
<tr>
<td>General Ledger Cleansed Data [itfm_gl_data_cleansed]</td>
<td>Expenses in the general ledger that is cleansed.</td>
</tr>
<tr>
<td>General Ledger Log [itfm_gl_log]</td>
<td>Log records that are created when expenses are added to the general ledger for a fiscal period.</td>
</tr>
<tr>
<td>General Ledger Staged Data [itfm_gl_data_staged]</td>
<td>Imported expenses that have not been cleansed or groomed.</td>
</tr>
<tr>
<td>Groomed General Ledger Data [itfm_gl_data_groomed]</td>
<td>Expenses in the general ledger that have been groomed.</td>
</tr>
<tr>
<td>Grooming Condition [itfm_grooming_condition]</td>
<td>Conditions that the application creates during the financial grooming process in the workbench.</td>
</tr>
<tr>
<td>ITCOA Definition [itfm_itcoa_definition]</td>
<td>Reference field mappings for cost models.</td>
</tr>
<tr>
<td>IT Shared Service [itfm_shared_service]</td>
<td>Services shared across the IT infrastructure.</td>
</tr>
<tr>
<td>IT Shared Service Type [itfm_shared_service_type]</td>
<td>Categories that are associated with IT shared services.</td>
</tr>
<tr>
<td>ITFM Session [itfm_session]</td>
<td>Saves session information for the workbench.</td>
</tr>
<tr>
<td>Plan Actuals [itfm_plan_actuals]</td>
<td>Actual items created based on budget definition from staged source expense lines.</td>
</tr>
<tr>
<td>Plan Actual Breakdowns [itfm_ai_breakdown]</td>
<td>Actual amount breakdowns of the item for each fiscal period.</td>
</tr>
<tr>
<td>Plan Core [itfm_plan_core]</td>
<td>Meta information such as name, original plan, budget currency of a plan. itfm_plan and itfm_plan_versions extend from the table.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Plan Item Breakdown [itfm_pi_breakdown]</td>
<td>Breakdowns of costs for a given plan item.</td>
</tr>
<tr>
<td>Plan Item Execution [itfm_plan_item_execution]</td>
<td>Unit cost and its validity of plan item.</td>
</tr>
<tr>
<td>Plan Items [itfm_plan_item]</td>
<td>Financial details such as account number, budgeted amount, forecast amount, actual amount, and attributes associated to asset, project, catalog, and contract.</td>
</tr>
<tr>
<td>Plan Template Column [itfm_plan_template_column]</td>
<td>Defines columns as template columns for budget definition.</td>
</tr>
<tr>
<td>Plan Versions [itfm_plan_versions]</td>
<td>Plans that are created during promotion of each plan.</td>
</tr>
<tr>
<td>Planning Data Source Field Map</td>
<td>Planning data source field map.</td>
</tr>
<tr>
<td>Reporting Entity [itfm_reporting_entity]</td>
<td>Reporting entity assigned to a user or group.</td>
</tr>
<tr>
<td>Segment Definition [itfm_ca_segment_map]</td>
<td>Segments specified in the hierarchy of segments.</td>
</tr>
<tr>
<td>Segment Relationship [itfm_itcoa_hierarchy]</td>
<td>Relationships between segments in the segment hierarchy as defined in the Data Definition stage of the workbench.</td>
</tr>
<tr>
<td>Service Catalog Breakdown</td>
<td>Breakdown definitions for statement items that are based on Service Catalog requests.</td>
</tr>
<tr>
<td>Service Catalog Statement Item</td>
<td>Showback source definitions for statement items that are based on Service Catalog requests.</td>
</tr>
<tr>
<td>Service Charge Line [itfm_charge_line]</td>
<td>Individual showback lines.</td>
</tr>
<tr>
<td>Service Charge Line Drilldown</td>
<td>Individual showback line drilldowns.</td>
</tr>
<tr>
<td>Service Charge Price Ratecard</td>
<td>Showback price rate card.</td>
</tr>
<tr>
<td>Showback Statement Line Definition</td>
<td>Showback statement line definitions.</td>
</tr>
<tr>
<td>Showback Statement Line Unit Cost Definition</td>
<td>Showback statement line unit cost definitions.</td>
</tr>
<tr>
<td>Sibling Rollup Relationship</td>
<td>Sibling segment rollup relationship definitions.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Statement Dispute [itfm_dispute]</td>
<td>Showback disputes.</td>
</tr>
<tr>
<td>Statement Item [itfm_charge_item]</td>
<td>Showback source definitions.</td>
</tr>
<tr>
<td>Statement Item Drilldown [itfm_chg_item_drilldown]</td>
<td>Statement item drilldown definitions.</td>
</tr>
<tr>
<td>Unit Cost Metrics [itfm_segment_unit_metrics]</td>
<td>Unit cost metric definitions.</td>
</tr>
<tr>
<td>Unit Costs [itfm_unit_cost]</td>
<td>Unit cost lines generated by cost allocation.</td>
</tr>
<tr>
<td>Weight Map Run Log [itfm_weight_map_run_log]</td>
<td>Weight map generation log.</td>
</tr>
<tr>
<td>Weight Maps [itfm_weight_map]</td>
<td>Weight relationships that the application uses to calculate weighted metrics.</td>
</tr>
</tbody>
</table>

The application also uses this table created by the Fiscal Calendar.

### Tables for the fiscal calendar

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fiscal period [fiscal_period]</td>
<td>Fiscal calendars and the periods used by fiscal calendars.</td>
</tr>
</tbody>
</table>

### User roles installed with Financial Management

Financial Management adds the following user roles.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>cost_transparency_admin</td>
<td>Has access to all Financial Modeling menus and modules.</td>
<td>• cost_transparency_analyst • cost_transparency_owner</td>
</tr>
<tr>
<td>cost_transparency_user</td>
<td>Has read-only access to general ledger and allocation records.</td>
<td>none</td>
</tr>
<tr>
<td>cost_transparency_analyst</td>
<td>Has access to the Financial Modeling module and the workbench.</td>
<td>cost_transparency_user</td>
</tr>
<tr>
<td>sn_itfm_read</td>
<td>Access to view FM APM dashboards provided by the base system and the underlying tables from where the data for the dashboards are retrieved.</td>
<td>• pa_viewer • cmdb_read</td>
</tr>
</tbody>
</table>

View Financial Management Application TCO dashboard, Costing for Business Applications dashboard, CIO dashboard.
<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>service_charging_analyst</td>
<td>• Can create, update, delete, and view charge items.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Can create, update, delete, and view charge item breakdowns.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Can create, update, delete, and view charge item drilldowns.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Can create, update, delete, and view showback statement definitions.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Can create, update, delete, and view showback statement line definitions.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Generate and publish the showback statements.</td>
<td></td>
</tr>
<tr>
<td>service_charging_owner</td>
<td>• View charge items.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Access the service charging console to review and set the pricing policies.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Review the charge item drilldown with the available breakdowns and drilldowns.</td>
<td></td>
</tr>
<tr>
<td>showback_user</td>
<td>• View the showback statements.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Accept the showback statements.</td>
<td></td>
</tr>
</tbody>
</table>

### Read-only roles for Financial Management

You can restrict the level of access of your users with a read-only role that enables them to view the Financial Management (FM) dashboards. Users with the read-only role can view FM reports and the underlying tables that provide data.

#### Plugin information

If you are a new customer, the Read only roles for PPM Standard (com.snc.pmo_read_roles) plugin is activated on zBoot. However, you also require Financial Management For APM (com.snc.financial_management_for_apm) plugin, which activates Performance Analytics – Content Pack – Financial Management for Application Portfolio Management (com.snc.pa.fm.apm) plugin. With this plugin you can access the FM APM dashboards.

#### Why read-only roles for FM?

Read only roles for Financial Management (sn_itfm_read) is available when Read only roles for PPM Standard plugin (com.snc.pmo_read_roles) is activated. Users with this role can access dashboards and view reports in Financial Management for Application Portfolio Management. To assign user roles, including read-only roles, see assign a role to a user.
Dashboards accessible to users with FM read role

Following are the dashboards available for users with the read-only role:

- Financial Management Application TCO dashboard
- Costing for Business Applications dashboard
- CIO dashboard

Tables accessible to users with FM read role

Following are the Financial Management tables that the users with the FM read role can access:

<table>
<thead>
<tr>
<th>FM tables</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
</tr>
<tr>
<td>Cost Allocation Aggregate</td>
</tr>
<tr>
<td>Cost Allocation</td>
</tr>
<tr>
<td>Financial Model</td>
</tr>
<tr>
<td>Bucket</td>
</tr>
<tr>
<td>Segment Definition</td>
</tr>
<tr>
<td>IT Shared Service</td>
</tr>
<tr>
<td>Cost Allocation Breakdown Aggregate</td>
</tr>
</tbody>
</table>

Domain separation and Financial Management

This is an overview of domain separation and Financial Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Support level: No support

- The domain field may exist on data tables, but there is no business logic to manage data.
- This level is not considered domain-separated.

For more information, see Application support for domain separation.

Financial Management for licensed APM users

If you are an Application Portfolio Management (APM) licensed user and using Financial Management, then the base system provides you with a Business Application Costing cost model that you can use to evaluate the cost of your business applications along with its prescribed metrics.

Business Application Costing cost model

You can navigate to the
Business application costing cost model

The specifications of the Business Application Costing cost model are:

- The cost bucket layer is tied to the ITFM bucket table [itm_bucket] and the cost buckets are specific to the model.
- IT shared service segment accounts are sourced from the IT shared service table [itm_shared_service].
- Business application segment accounts (the middle layer in this model) are sourced from the Business Application [cmdb_ci_business_app] table. This table is the source of accounts to the applications segment. Or, it can be Application [cmdb_ci_appl] table or other custom tables.
- The business unit layer is tied to the platform business unit table [business_unit].
- There is no data source to this cost model, which means that you should enter the spend information directly into the model and not come from the general ledger. Using the general ledger as a source of spend information is an optional feature that you can configure. See Prerequisites to modify data source of a cost model for more information.
Seeded IT Shared Services

**IT Shared Service: End User Compute**

IT Shared Service: Equip End Users is a cost collection container that holds any money spent on providing the end users with personal (not shared) devices, the software that runs on these devices, and the support associated with making and keeping those devices functioning. This container excludes major device upgrades, lease cycle turnover, and other replenishment-related costs, which are captured within the Facilitate Ongoing Change container.

**IT Shared Service: Database**

IT Shared Service: Facilitate Configuration Change is a cost collection container that holds money spent on supporting the ITSM Change, Release and Configuration Management processes. That is, any dollars spent on managing ongoing, daily, common, and ad-doc configuration changes. This includes activities like patching (non-security related), firmware updates, hardware/software configuration setting changes, installation, de-installation, and upgrade of hardware components, and general add, move, or change requests across the IT landscape. This container excludes major upgrades and changes across a large portion of the environment for which a project plan and/or funding would need to be secured.

**IT Shared Service: Network**

IT Shared Service: Facilitate Connectivity is a cost collection container that holds any money spent on providing all device network connectivity to the company, its computing and/or knowledge assets, the hardware and software to do it, and the support associated with making (and keeping) the access up. This includes all personal and enterprise devices. This container excludes monitoring hardware, software, and personnel costs, which are captured in the Monitor the Environment container.

**IT Shared Service: IT Management**

IT Shared Service: Management and Overhead is a cost collection container that holds any money spent on IT executive compensation, as well as one-time charge items that apply to the existence of IT operations, compliance or audit costs, and otherwise un categorised costs. This container excludes any costs captured or accounted for in any of the other IT process definitions.

**IT Shared Service: Data Center**

IT Shared Service: Monitor the Environment is a cost collection container that holds the money spent on supporting the ITOM Event Management process; that is, any dollars spent on monitoring the entire IT landscape. This includes endpoint connectivity speeds, endpoint application performance testing, hardware/software/network/storage threshold checking, and fault and event correlation management tools used by operations management personnel. This container excludes security specific and/or cloud monitoring services mentioned in other process areas.

**IT Shared Service: IT Operations**

IT Shared Service: Perform Upgrades/Maintenance is a cost collection container that holds money spent supporting the ITSM Change, Release and Configuration Management processes. That is, all dollars spent on managing major upgrades, either project planned and/or specifically funded. This includes activities such as widespread OS upgrades; hardware replacement cycle activities; and internal or third-party business or IT management software package release updates across the IT landscape. This container excludes ongoing, daily, common, and ad-doc configuration changes that only require a change ticket to be executed.

**IT Shared Service: Service Desk**

IT Shared Service: Provide Tech Support is a cost collection container that holds money spent supporting the ITSM Incident, Problem and Knowledge Management processes. That is, any dollars spent on providing technical support services to end users across the organization. This includes tier 1, 2, and 3 personnel, incident or problem management software, root cause analysis time, routine or ad-doc assistance (password resets, how to Q&A), and/or standard operating procedure guidance. This
container excludes actual configuration changes to end user and/or corporate assets performed by way of documented change tickets.

**IT Shared Service: Application**

IT Shared Service: Run Business Applications is a cost collection container that holds any dollars spent on ongoing personnel time to keep business applications operating. This includes resources dedicated to applications and excludes IT or infrastructure operation costs.

**IT Shared Service: Security & Compliance**

IT Shared Service: Secure the Environment is a cost collection container that holds money spent on supporting the Security Operations. That is, any dollars spent on providing information security across the corporate IT landscape. This includes individual user endpoint devices, cloud applications, cloud computing, and/or on-premise computing resource of all types in addition to all desktops, laptops, smart phones, network gear, servers, databases, and applications. This excludes the physical security costs associated with datacenters, and office space card readers.

**IT Shared Service: Storage**

IT Shared Service: Store and Manage Data is a cost collection container that holds any dollars spent on the underlying tools and foundational activities related to the management of structured and unstructured data (for example, encryption, backups, purging, archiving, migrations, and DR replication) and/or storage capacity (for example, reorganizations and excess capacity acquisition). It includes these types of activities and all the people power used to ensure the health of the data and storage landscape. This container excludes elements related to local storage on end user devices utilized by single individuals and specific activities, and allocated storage that can be related to specific applications or systems.

**IT Shared Service: Compute**

IT Shared Service: Supply Computing Power is a cost collection container that holds any dollars spent on providing foundational elements that exist, cost money to maintain, but may never actually be used such as disaster recovery facilities or contracts, hardware spares inventory, on-premises UPS systems, and generators. It also includes daily active data center costs related to things such as space, power, and cooling.

**ITFM prescribed metrics**

**Allocate to Application based on Active User Count**

The metric allocates shared service cost to applications based on the following weighted metric:

- The Business Application [cmdb_ci_business_app] table provides a list of all business applications.
The prescribed metric performs a sum of active users and weights the costs accordingly to the receiving applications by **Sys ID**.

### Allocate to Application based on Compute Power

The metric allocates shared service cost to applications based on the following weighting table:

- The CI Relationship \([\text{cmdb\_rel\_ci}]\) table provides a list of all relationships between configuration items.
- The prescribed metric performs a count of configuration items where the Child.Class = Server and weights the costs accordingly to the receiving applications.

### Allocate to Business Unit on Headcount

The metric allocates shared service cost to business unit based on the following weighting table:

- The User \([\text{sys\_user}]\) table provides a list of all system users and their related department.
- The Department \([\text{cmn\_department}]\) table provides a list of all departments and their related business unit.
- The prescribed metric performs a count on the number of users per business unit and weights the costs accordingly.
  - Filter criteria: Only count active users.
Dashboards for Business Application Costing cost model

There are three performance analytic dashboards that you can access with Business Application Costing cost model. They are:

- Application TCO dashboard.
- Business Application Costing dashboard.
- CIO Dashboard for Business Applications.

Configure business application costing cost model

Configure the business application costing cost model to allocate expenses and generate bucket cost lines for the fiscal periods to suit your requirements.

Role required: cost_transparency_analyst


   The field values in the Financial Model – Business Application form are pre-populated. You can choose to enter a model owner and user group for the Business Application Costing cost model. There is no data source for this cost model.

2. On the form, update the required fields.

   **Financial Model – Business Application Costing form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the cost model.</td>
</tr>
<tr>
<td>Description</td>
<td>Short description of the cost model.</td>
</tr>
<tr>
<td>Model Owner</td>
<td>User who owns the cost model.</td>
</tr>
<tr>
<td>Data Source</td>
<td>Source of data for the cost model.</td>
</tr>
<tr>
<td></td>
<td>This cost model has no data source, hence the field is non-editable.</td>
</tr>
<tr>
<td>User Group</td>
<td>Group of users who can access the cost model.</td>
</tr>
<tr>
<td>Include Sub-Bucket info</td>
<td>Option to show sub-bucket information. The <strong>Include Sub-Bucket info</strong> check box is available when <strong>Generate Controlled Cost Lines</strong> check box is selected. If selected, the generated cost lines and breakdown lines hold sub-bucket information.</td>
</tr>
</tbody>
</table>

3. Click Update.

4. To run cost allocations, click **Allocate Expenses** button.

   Use this option to run cost allocation from the cost model form and not necessarily from the workbench.

   a) Select the fiscal period in the Allocate Expense dialog box.

   b) Click OK.

   The allocation engine runs to generate cost allocations for the selected fiscal period. The engine does cleansing and bucketing. It allocates the expenses and creates allocation lines. However, if the cost model has no data source, the engine ignores the cleansing and bucketing stages and creates allocation lines.
5. To generate cost lines for leaf buckets associated to the cost model, click **Generate Bucket Cost** button.

   Use this option to generate bucket amount lines for this cost model that has no data source. Cost lines are generated for each leaf bucket that has no further sub-buckets. Even if there is no amount in the bucket, the amount lines are generated in the Groomed General Ledger Data [itfm_gl_data_groomed] table, populating zero in the **Amount** column. The table displays the bucket, sub-bucket, and amount associated with the cost model for the fiscal period that you selected.

   a) Select the fiscal period in the Generate Bucket Cost dialog box.
   b) Click **OK**.

      - If there is no amount in a bucket, the allocation engine still generates a groomed line with zero expense for the selected fiscal period of the cost model.
      - If there are pre-existing groomed lines with amounts in buckets for that fiscal period, then the engine does not overwrite those cost lines.

   You can edit the **Amount** column to enter the amount for each sub-bucket.

6. To view the bucket amounts, navigate to **Financial Modeling for APM > Bucket Amounts**.
   For more information, see [Create groomed lines for cost models with no data source](#).

7. To view the buckets associated to this cost model, navigate to **Financial Modeling for APM > Buckets**.
   For more information, see [Create an account bucket](#).

8. To access the dashboards available for this cost model, navigate to **Financial Modeling for APM > Financial Modeling for APM Dashboards**.

**Financial Management for licensed SPM users**

If you are a Service Portfolio Management (SPM) user and have activated Financial Management, then the base system provides you with a Service Offering Costing cost model. Use this cost model to evaluate the amount spent at each level of service. Financial Modeling allocates expenses and generates cost lines based on the level of service for a defined price.
Service Offering Costing cost model

The specifications of the Service Offering Costing cost model are:

- IT shared service segment accounts are sourced from the IT shared service [itfm_shared_service] table.
- Service Offering segment accounts are sourced from the Service Offering [service_offering] table.
- IT Shared Service segment rolls up to the Service Offering segment. However, there are no default rollup overrides.
- All sub-buckets are spread equally to all accounts in IT Shared Services provided by the base system setup.
• There is no data source to this cost model, which means that you should enter the spend information directly into the model and not come from the general ledger. Using the general ledger as a source of spend information is an optional feature that you can configure. See Prerequisites to modify data source of a cost model for more information.

• The expenses are allocated from IT Shared Services segment to the Service Offering segment by Equal method of the base system. By default, the allocation setup provided in the Allocation Setup stage is Equal rollup method. You can configure the rollup method, if needed, to match your specific requirements.

Seeded IT Shared Services

See the list of seeded IT Shared Services.

ITFM prescribed metrics

Allocate to Service Offering on Allocation Maps

The metric allocates shared service cost to service offering based on the following weighted metric:

Allocate to service offering on allocation maps

• The Service Offering Allocation Map [itfm_service_offering_allocation_map] provides a list of all service offering allocations. This intermediary table references IT shared services from IT shared service [itfm_shared_service] table and service offering from the Service Offering [service_offering] table.

• The prescribed metric performs a sum of shared services and weights the costs accordingly to the receiving service offerings.

Allocate to Service Offerings on related CIs

The metric allocates shared service cost to service offerings based on the following weighting table:
Allocate to service offering on allocation maps

- The CI Relationship [cmdb_rel_ci] table provides a list of all relationships between configuration items.
- The prescribed metric performs a count of configuration items and weights the costs accordingly to the receiving service offerings.

Allocate to Service Offerings on Total Subscribers

The metric allocates shared service cost to service offerings based on the following weighting table:

- The Service Offering [service_offering] table provides a list of all service offerings.
- The prescribed metric performs a sum of all subscribers and weights the costs accordingly to the receiving service offering by **Sys ID**.

Configure service offering costing cost model

Configure the service offering costing cost model to allocate expenses and generate bucket cost lines for services offered at each level.

Role required: cost_transparency_analyst

1. Navigate to **Financial Modeling for SPM > Service Offering Costing Model**.

   The field values in the Financial Model – Service Offering Costing form are pre-populated. You can choose to enter a model owner and user group for the Service Offering Costing cost model. There is no data source for this cost model.
On the form, update the required fields.

### Financial Model – Service Offering Costing form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the cost model.</td>
</tr>
<tr>
<td>Description</td>
<td>Short description of the cost model.</td>
</tr>
<tr>
<td>Model Owner</td>
<td>User who owns the cost model.</td>
</tr>
<tr>
<td>Data Source</td>
<td>Source of data for the cost model. This cost model has no data source, hence the field is non-editable.</td>
</tr>
<tr>
<td>User Group</td>
<td>Group of users who can access the cost model.</td>
</tr>
<tr>
<td>Include Sub-Bucket info</td>
<td>Option to show sub-bucket information. The Include Sub-Bucket info check box is available when Generate Controlled Cost Lines check box is selected. If selected, the generated cost lines and breakdown lines hold sub-bucket information.</td>
</tr>
</tbody>
</table>

3. Click **Update**.

4. To run cost allocations, click **Allocate Expenses** button.

Use this option to run cost allocation from the cost model form and not necessarily from the workbench.

   a) Select the fiscal period in the Allocate Expense dialog box.
   b) Click **OK**.

   The allocation engine runs to generate cost allocations for the selected fiscal period. The engine does cleansing and bucketing. It allocates the expenses and creates allocation lines. However, if the cost model has no data source, the engine ignores the cleansing and bucketing stages and creates allocation lines.

5. To generate cost lines for leaf buckets associated to the cost model, click **Generate Bucket Cost** button.

Use this option to generate bucket amount lines for this cost model that has no data source. Cost lines are generated for each leaf bucket that has no further sub-buckets. Even if there is no amount in the bucket, the amount lines are generated in the Groomed General Ledger Data [itfm_gl_data_groomed] table, populating zero in the **Amount** column. The table displays the bucket, sub-bucket, and amount associated with the cost model for the fiscal period that you selected.

   a) Select the fiscal period in the Generate Bucket Cost dialog box.
   b) Click **OK**.

   - If there is no amount in a bucket, the allocation engine still generates a groomed line with zero expense for the selected fiscal period of the cost model.
   - If there are pre-existing groomed lines with amounts in buckets for that fiscal period, then the engine does not overwrite those cost lines.

   You can edit the **Amount** column to enter the amount for each sub-bucket.

6. To view the bucket amounts, navigate to **Financial Modeling for SPM > Bucket Amounts**.

7. To view the buckets associated to this cost model, navigate to **Financial Modeling for SPM > Buckets**.
8. To view the list of all service offering allocations, navigate to Financial Modeling for SPM > Service Offering Allocation Maps.

9. Optional: Use the Allocate to Service Offering on Allocation Maps metric and allocate expenses using weighted method. Calculate spend per service offering based on the consumption data stored in the service offering allocation maps table.

   To configure the service offering allocation map table and allocate expenses using weighted method, see Allocate expenses using service offering allocation map.

Allocate expenses using service offering allocation map

You can allocate expenses based on the actual consumption of services offered using the weighted method. In the weighted rollup method the metric weights the amount by the account values. Use the service offering allocation maps table to store your actual consumption data of the cost for service offerings.

Role required: cost_transparency_analyst

Although the base system provides you with the default Equal method to roll up the expenses from the IT Shared Services segment to the Service Offering segment, you can also opt for Weighted rollup method. In this method, the expenses from the IT shared service segment are allocated to the service offering segment based on the consumption data that you have stored or entered in the Service Offering Allocation Map [itfm_service_offering_allocation_map] table. In this case, the expense is allocated based on the weightage of consumption. Therefore, cost is divided using Allocate to Service Offering on Allocation Maps metric and the Service Offering Allocation Map table that has the consumption data is used to weight the metric.

2. Click New.
3. On the form, fill in the fields.

   Service Offering Allocation Map form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allocation Weight</td>
<td>Expenses allocated based on a weighted calculation.</td>
</tr>
<tr>
<td>IT Shared Service</td>
<td>Segment from where the money is allocated.</td>
</tr>
<tr>
<td>Service Offering</td>
<td>Segment to which the money is rolled up.</td>
</tr>
</tbody>
</table>

4. Click Submit.

   For more information on the calculated spend per offering and to configure the estimated spend offering cost source, see Financial Management for Service Portfolio Management Premium.

Financial Modeling

With Financial Modeling, you can determine the allocation rules and run them automatically for all data in the future. There are several other components that you must set up before you can use the workbench to allocate expenses.

Start with associating data sources to cost models. Use data source to add additional columns for cleansing or bucket split by selecting the Used by cleansing option of the Financial Data Source Field Map record.

Fiscal calendars, which was under IT Financial Management, has been moved to Now Platform area. You can access the documentation for Fiscal calendars here.
**Financial data import**

Financial data resides in the General Ledger Staged Data table.

You can import financial data into the General Ledger Staged Data [itfm_gl_data_staged] table by using either of the following methods:

- Import sets
- Easy import

See Import sets.

**Attention:** Be sure that your fiscal calendar can be used with your financial data.

**General ledger**

The general ledger contains all expenses for your organization for all fiscal periods.

The general ledger contains these types of expenses:

- **Staged expenses** that you imported from your external source. Imported expenses are saved in the General Ledger Staged Data [itfm_gl_data_staged] table.
- **Cleansed expenses** that the workbench uses during the Data Cleansing stage. Changes to expenses during this stage are saved in the General Ledger Cleansed Data [itfm_gl_data_cleansed] table. Each time you add an expense to the General Ledger Staged Data table, a corresponding expense is created in this table.
- **Groomed expenses** that the workbench uses during the Bucketing stage. Changes to expenses during this stage are saved in the Groomed General Ledger Data [itfm_gl_data_groomed] table. This is also used for non-General Ledger expenses to hold the amounts manually entered through the workbench or to enter the amounts directly.

**View expenses in the general ledger**

You can view records in any of the general ledger tables and make changes if necessary.

Role required: cost_transparency_admin, cost_transparency_analyst

1. Navigate to **Financial Modeling > Workbench** and navigate to the review stage of the workbench.
2. Open the link in the number of **Groomed lines** that are generated in the **Others** section.
3. On the form, fill in the fields.
### Groomed General Ledger Data form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Auto-generated identification number for the general ledger data record.</td>
</tr>
<tr>
<td>State</td>
<td>The current state of the record:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Unallocated</strong>: Allocations for this expense are not allocated.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Allocated</strong>: This expense has been allocated.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Locked</strong>: The general ledger expense is locked so that its allocation lines cannot be reverted.</td>
</tr>
<tr>
<td>Account name</td>
<td>Name of the account.</td>
</tr>
<tr>
<td>Account number</td>
<td>Account number this expense applies to. This field is mandatory on the Cleansed General Ledger Data form to ensure that all cleansed expenses appear in an account in the Bucketing stage of the workbench.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the expense.</td>
</tr>
<tr>
<td>Amount</td>
<td>The amount of the expense.</td>
</tr>
<tr>
<td>Cleansed expense</td>
<td>A reference to the corresponding record in the General Ledger Cleansed Data table. The expense in the General Ledger Cleansed Data table that is automatically created when you create an expense in the General Ledger Staged Data table.</td>
</tr>
<tr>
<td>Staged expense</td>
<td>A reference to the corresponding record in the General Ledger Cleansed Data table.</td>
</tr>
<tr>
<td>Groomed expense</td>
<td>A reference to the corresponding record in the Groomed General Ledger Data table.</td>
</tr>
<tr>
<td>Grooming rule</td>
<td>The condition that the workbench uses to filter expenses that are put in buckets.</td>
</tr>
<tr>
<td>Currency</td>
<td>Currency that the expense is valued in. The currency is a three letter code defined in the Currency [fx_currency] table. If the value in this field does not match any code in the Currency table, dollar signs are displayed by default for all expenses. Make sure that your expenses in all general ledger forms are in the same currency as your system currency.</td>
</tr>
<tr>
<td>Document amount</td>
<td>Amount of the original expense document.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Document currency</td>
<td>Currency that the original expense document uses. As with the Currency field, the value in the field is a three letter code defined in the Currency table.</td>
</tr>
<tr>
<td>Bucket</td>
<td>[Groomed General Ledger Data form] Bucket that this expense is associated with.</td>
</tr>
<tr>
<td>Sub-bucket</td>
<td>[Groomed General Ledger Data form] Sub-bucket that this expense is associated with.</td>
</tr>
<tr>
<td>Cost center</td>
<td>Cost center this expense applies to.</td>
</tr>
<tr>
<td>Department</td>
<td>Department associated with this expense.</td>
</tr>
<tr>
<td>Fiscal period</td>
<td>[Groomed General Ledger Data form] Period during which this expense occurred.</td>
</tr>
<tr>
<td>Document date</td>
<td>Date on which the original expense document was issued.</td>
</tr>
<tr>
<td>Import set</td>
<td>The import set containing the data that you imported into the instance.</td>
</tr>
<tr>
<td>Location</td>
<td>The location of where the expense was incurred.</td>
</tr>
<tr>
<td>Vendor</td>
<td>The vendor record that is referenced from the Company [core_company] table.</td>
</tr>
<tr>
<td>Posting date</td>
<td>The date of when this expense was incurred.</td>
</tr>
<tr>
<td>Local amount</td>
<td>The amount represented in the local currency.</td>
</tr>
<tr>
<td>Local currency</td>
<td>The currency associated with the account.</td>
</tr>
<tr>
<td>Segments</td>
<td>Expense amounts for the segments that are defined in the hierarchy of segments.</td>
</tr>
<tr>
<td>Related Lists</td>
<td></td>
</tr>
<tr>
<td>Cost Allocations</td>
<td>[Groomed General Ledger Data form] Allocation lines created from this expense.</td>
</tr>
<tr>
<td>General Ledger Cleansed Data</td>
<td>[Groomed General Ledger Data form] The records in the General Ledger Cleansed Data table that created the groomed expense records after the expenses are put into buckets.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Financial data sources and field maps**

Financial data sources point to the actual raw expense data table used by financial modeling and financial planning.

In the Financial Management application, the data source helps to map the raw expense data and its fields to the transaction table fields.

You can use the General Ledger Staged Data table and General Budget Staged Data table for base system financial model activities. These tables can also be extended to create a custom source table for your financial model. You can model your financial activities using any data source or without any data source at all. If it is without any data source, then it is expected that the amounts would be manually
entered directly into the cost model. You can create more field maps and configure which fields are to be used for cleansing or split bucket, as and when required.

Financial planning uses data source to generate actuals. The segments used in budget model hierarchy must be a mandatory part of data source field maps to accurately map the actuals with the budget. It also helps in budget key generation.

Start working with the following data sources available with the application:

- GL Staged
- Cost Plan Breakdown (FM-PPS financial planning integration)

The following table lists the default field maps provided with each data source. You can change the default mapping to point to a different segment or column. For example, by default the Cost Center column is mapped to the Cost Center name [cmn_cost_center]. If the data in that column is the code in your case, then you can change to Cost Center code [cmn_cost_center]. You can create more field maps for the custom fields as required.

**Default data source field maps**

<table>
<thead>
<tr>
<th>Segment name</th>
<th>Transaction table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost Center</td>
<td>Cost Center [cmn_cost_center]</td>
</tr>
<tr>
<td>Location</td>
<td>Location [cmn_location]</td>
</tr>
<tr>
<td>Vendor</td>
<td>Company [core_company]</td>
</tr>
<tr>
<td>Department</td>
<td>Department [cmn_department]</td>
</tr>
<tr>
<td>Project</td>
<td>Project [pm_project]</td>
</tr>
</tbody>
</table>
Financial data source and its field maps
Create a financial data source

Database columns referring to raw expense details must be identified to create a new data source in Financial Management.

Role required: itfm_plan_analyst, admin, cost_transparency_admin

Data sources are available for both Financial Modeling and Financial Planning applications.

1. Navigate to **Financial Modeling > Data Sources > Setup**.
2. Click **New**.
3. On the form, fill in the fields.

**Financial Data Source form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name for the new data source record.</td>
</tr>
<tr>
<td>GL Account</td>
<td>Select the database column that refers to general ledger account expenses.</td>
</tr>
<tr>
<td>Amount</td>
<td>Select the database column that refers to actual expense amount.</td>
</tr>
<tr>
<td>Table</td>
<td>Select a database table with actual raw expense data.</td>
</tr>
<tr>
<td></td>
<td>The <strong>Table</strong> field shows the source from where the financial data is retrieved. The source of the Financial Modeling application is no longer confined to the General Ledger Staged table alone, but can point to any table with financial transaction information. Any table in the platform can be used as long as the mandatory column requirements of representing amount, account number and date are met.</td>
</tr>
<tr>
<td>Currency</td>
<td>Select the database column that refers to currency values for the expenses.</td>
</tr>
<tr>
<td>Posting date</td>
<td>Select the database column that refers to the date when the expense was incurred.</td>
</tr>
<tr>
<td>Condition</td>
<td>Apply conditions to filter records.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

Create field maps for the data source.

**Create a data source field map**

Field maps create a reference between the data source columns and transaction columns.

Role required: itfm_plan_analyst or cost_transparency_admin

The transaction table is associated to a segment. Define a relationship between the data source and transaction fields to enable flexible data cleansing and bucket split.

1. Navigate to **Financial Modeling > Data Sources > Setup**.
2. Click to open a data source record.
3. Click **New** in the **Financial Data Source Field Maps** tab to create a field map.
4. On the form, fill in the fields.
### Financial Data Source Field Map form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>Auto populates the data source for which the field map is created.</td>
</tr>
<tr>
<td>Datasource field</td>
<td>Column on the data source table for field mapping.</td>
</tr>
<tr>
<td>Cleansed Column</td>
<td>Defines the mapping between the Data source table column and the Cleansed table column. If the field is None, data from the Data source table column is not copied during cleansing. For the existing General Ledger Staged data source mappings are preconfigured.</td>
</tr>
<tr>
<td>Used by cleansing</td>
<td>Check box to make this field map reference available for cleansing in financial modeling.</td>
</tr>
<tr>
<td>Segment name</td>
<td>Segment to map the transaction table.</td>
</tr>
<tr>
<td>Mapped to transaction field</td>
<td>Column on the transaction table for field mapping.</td>
</tr>
<tr>
<td>Used for Bucket split</td>
<td>Check box to make the field map reference available for cost bucket split when using the Allocation Setup tab of the workbench.</td>
</tr>
</tbody>
</table>

5. **Click Submit.**

### Segments

Segments define the transaction table used in cost model hierarchy.

You can modify the default segments offered by the Financial Modeling application. You can also create new segments based on your requirement. If segments are enabled for cost allocation, they are available during building of cost model hierarchy.

#### Default segments

<table>
<thead>
<tr>
<th>Segment name</th>
<th>Transaction table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Unit</td>
<td>Business Unit [business_unit]</td>
</tr>
<tr>
<td>Department</td>
<td>Department [cmn_department]</td>
</tr>
<tr>
<td>Business Service</td>
<td>Service [cmdb_ci_service]</td>
</tr>
<tr>
<td>Business Capability</td>
<td>Business Capability [cmdb_ci_business_capability]</td>
</tr>
<tr>
<td>Business Application</td>
<td>Business Application [cmdb_ci_business_app]</td>
</tr>
<tr>
<td>Service Offering</td>
<td>Service Offering [service_offering]</td>
</tr>
<tr>
<td>Server</td>
<td>Server [cmdb_ci_server]</td>
</tr>
<tr>
<td>Cost Center</td>
<td>Cost Center [cmn_cost_center]</td>
</tr>
<tr>
<td>Location</td>
<td>Location [cmn_location]</td>
</tr>
</tbody>
</table>
Create a segment definition

Define segments to be used with cost and budget models.

Role required: budget_admin or cost_transparency_admin

You can create more than one segment in the same transaction table with different filter conditions. For example, create one segment for vendors in the core_company table where the Vendor field is true, and another segment for customers in the same table where the Vendor field is false.

1. Navigate to Financial Modeling > Administration > Segments.
   You can also create a new segment from the Segment Definition tab on the workbench.
2. Click New.
3. On the form, fill in the fields.

Segment Definition form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Segment name</td>
<td>Descriptive name for the new segment.</td>
</tr>
<tr>
<td>Transactional table</td>
<td>Database table for transaction data to associate with the segment.</td>
</tr>
<tr>
<td>Primary field</td>
<td>Field in the transactional table to serve as the primary source of information for the segment.</td>
</tr>
<tr>
<td>Used by Cost Allocation</td>
<td>Check box to make the segment available for financial modeling.</td>
</tr>
<tr>
<td>Used by Budgeting</td>
<td>Check box to make the segment available for financial planning.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions that can be set to filter the records.</td>
</tr>
<tr>
<td>Fiscal effective start</td>
<td>Fiscal start period to filter the records in allocation setup for that fiscal period. Used by Financial Modeling.</td>
</tr>
<tr>
<td>Fiscal effective end</td>
<td>Fiscal end period to filter the records in allocation setup for that fiscal period. Used by Financial Modeling.</td>
</tr>
</tbody>
</table>
4. Optional: Set a fiscal validity for the segment to include only valid records for allocation. To view all the accounts in all fiscal periods, specify the fiscal effective start and end date as 'none'.
   a) Example 1: Consider ‘server’ as a segment. To filter valid servers for allocation, set the fiscal start date as the install date and set the fiscal end date as the decommissioned date.
   b) Example 2: To view only active projects for a fiscal period, use active start and end dates in the projects table.

5. Click Submit.

**IT shared services**

IT shared services are business services that are IT related but are still shared and used across your organization.

Examples of IT shared services are user services like a help desk and voice network services like a call center. You can create business services for your organization and put them into broader, customizable categories like IT operations or security and compliance.

By default, the hierarchy of segments includes a segment for IT shared services. When expenses are associated with IT shared services, they roll up to business services by default. This allows you to allocate expenses to any IT shared service and see the effects of the expenses on business services and, ultimately, the business units that comprise your organization.

For a list of seeded IT shared services, see Prescriptive cost models for shared services and business applications.

**Create IT shared services**

Create IT shared services to set up the IT shared services segment in the hierarchy of segments.

Role required: cost_transparency_admin

Then you can create rollup rules to have expenses roll up to these shared services, which in turn roll up to business services by default. Then create service types to use with shared services.

2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the shared service.</td>
</tr>
<tr>
<td>Owner</td>
<td>The user in the group that owns the shared service.</td>
</tr>
<tr>
<td>Description</td>
<td>A detailed description of the shared service.</td>
</tr>
<tr>
<td>Group</td>
<td>The group that owns this shared service.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>Service type</td>
<td>The type of service that you are creating.</td>
</tr>
</tbody>
</table>

Create a service type

Create service types, which are used by IT shared services.

Role required: cost_transparency_admin

1. Open one of the IT shared service records.
2. Click the lookup icon in the Service type fields. The IT Shared Service Types list appears.
3. Click New.
4. Enter a name.
5. Click Submit.

Financial Management workbench

The Financial Management workbench provides financial administrators with a graphical interface to allocate expenses.

Access the workbench through the Financial Modeling > Workbench module.

When you use the workbench to allocate expenses, you pass through the following stages:

Workbench stages

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Note:
The data cleansing stage will not be available in the Workbench stages if you do not select a data source in the Financial Model form, as there is no financial data source to pull the expense lines from. In this case, you can enter the groomed lines directly in the sub-buckets.

The Workbench tab

- **Data Definition**: Select a fiscal period and cost model to work with. See The Data Definition stage.
- **Data Cleansing**: Remove unnecessary financial expenses and put similar expenses in the same segment. This cleansing stage gives you the opportunity to tidy up expenses in the general ledger. See The Data Cleansing stage.
- **Bucketing**: Group related expenses into customizable buckets. See The Bucketing stage.
- **Allocation Setup**: Assign the buckets to accounts and segments that comprise the hierarchy of accounts, and create rules that govern how segments relate to each other. See Allocation Setup stage.
- **Review**: Review the expense assignments you made, and then run the allocation engine to allocate expenses. See The Allocation Review stage.

The Cost Models tab

All cost models in the application. You can create a basic cost model from this tab and open, modify, or delete existing cost models. See The Cost Models tab.

The Configuration tab

General configuration settings, such as currency, the fiscal calendar, the main Financial Management report, and advanced actions that allow you to delete financial data. See The Configuration tab.

Browser requirements

If you are using Internet Explorer, use version 11 or later to use the workbench. You can also use any of the other generally supported web browsers.

The Data Definition stage

The Data Definition stage provides you with settings to set up the application, before you start to allocate expenses.

These sections are presented:

- **Working Set**: Select the fiscal period that you want to work with. Fiscal periods are automatically created based on the financial data that you import. As you progress through the workbench, only the expenses that were incurred during the fiscal period that you select here are available to you. You can also select a cost model you want to work with and clone one from the selected cost model.

  - Use the clone this cost model ( ) icon to clone a cost model from an existing one.
• Use the download ( )) icon to download the cost model for the purpose of uploading it to, or deploying it in another instance to do cost modeling in a different pre-production environment. You can later move the cost model to other production environments.

• When you open the workbench and if the fiscal period is not displayed with current one or when you switch between different cost models and the fiscal period is not refreshed, then click the refresh fiscal periods for cost models ( )) icon to display the current fiscal period.

• **Hierarchy of Segments**: View the segments in the hierarchy of segments and their positions in the hierarchy for the cost model you are dealing with.

• **Expense Summary**: See whether or not there are records in the staged and groomed general ledger tables, and if there are allocation lines.

---

**The data definition on the workbench**

**Choose a working set**

A working set refers to the set of expenses that you want to use in the workbench as you pass through all the stages.

Role required: cost_transparency_admin or cost_transparency_analyst
The working set consists of the fiscal period, which is the block of time on the fiscal calendar during which the expenses were incurred. Make sure you select the correct fiscal period. As you progress through the stages of the workbench, the expenses you work with are those that were incurred during the selected fiscal period only, not any other fiscal periods. The fiscal period you select is referred to as the working period, and is always visible on the upper-right side of all workbench pages.

- Select the fiscal period for the data that you want to work with from the Fiscal period choice list.

  The options in this choice list come from the fiscal calendar. If you do not see the fiscal period you want, you can make changes to the fiscal calendar.

Clone a cost model in the workbench

Use the preconfigured cost models or clone one from the base cost models for your financial model activities. By cloning you can map your financial data source to the cost model as per your business requirements without affecting the original cost model.

Role required: cost_transparency_admin or cost_transparency_analyst

**Note:**

This feature is available only when you own an ITBM Analyst license.

You can select a preconfigured basic cost model or clone a cost model from the Data Definition stage of the Workbench or from the Cost Models tab.

2. Do one of the following to access the basic cost model interface:
   - Select a cost model from the Cost Model choice list in the Working Set region of the Data Definition stage, and click the Clone this cost model icon.
   - Click the Cost Models tab, select the base cost model, and click the Clone Cost Model button or the Clone this cost model Action icon.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the cost model that you selected pre-populates in the field.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the cost model defaults.</td>
</tr>
<tr>
<td>Clone From</td>
<td>A cost model to clone the new one from.</td>
</tr>
</tbody>
</table>
### Field Description

**Data source**

The actual raw expense data table used for financial modeling activities. See Financial data sources and field maps. The base system options are:

- **Cost Plan Breakdown**: Maps to the raw expense data, where the actual cost and allocated cost are captured for a fiscal period in the cost plan breakdown \([\text{cost\_plan\_breakdown}]\) table.
- **General Ledger Staged**: Maps to the database column that refers to general ledger account expenses in the general ledger staged data \([\text{itfm\_gl\_data\_staged}]\) table.
- **No Data Source**: Option to manually enter the amounts in the cost model at the bucketing stage.

### 4. Click the **Clone Cost Model** button.

You can also create a cost model on the cost model form.

**Expense summary**

The Data Definition stage of the workbench shows a summary of the expenses in the application. Icons for each type of expense and for each fiscal period shows you the state of allocation records.

### Icons on the expense summary

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✗</td>
<td>Records do not exist.</td>
</tr>
<tr>
<td>✓</td>
<td>Record lines exist.</td>
</tr>
<tr>
<td>🔄</td>
<td>Records changed since allocations were last generated.</td>
</tr>
<tr>
<td>🔄</td>
<td>Errors occurred when the application was running allocations. If you see this icon, verify all your settings in the workbench and run the allocations again.</td>
</tr>
</tbody>
</table>

### The Expense Summary section

<table>
<thead>
<tr>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Period</strong></td>
<td>Each period in the fiscal calendar.</td>
</tr>
<tr>
<td><strong>Staged</strong></td>
<td>If records are in the General Ledger Staged Data ([\text{itfm_gl_data_staged}]) table.</td>
</tr>
<tr>
<td><strong>Cleansed</strong></td>
<td>If records are in the General Ledger Cleansed Data ([\text{itfm_gl_data_cleansed}]) table.</td>
</tr>
<tr>
<td><strong>Groomed</strong></td>
<td>If records are in the Groomed General Ledger Data ([\text{itfm_gl_data_groomed}]) table.</td>
</tr>
</tbody>
</table>
The Data Cleansing stage

The Data Cleansing stage allows you to clean up the expenses that you imported into the application. On the Data Cleansing page, the expenses that you imported appear in expense rows grouped by one of the following segments: vendors, cost centers, departments, and locations. Starting with Istanbul, data cleansing can be performed on custom fields. To enable custom field cleansing, select the check box for Used by cleansing under financial data source field map.

The summary section on the right pane provides a breakdown of the expenses that comprise each segment. From here, you can:

• Review the imported expenses
• Merge expense rows
• Map expenses to records in the selected segment

Data cleansing on the workbench
<table>
<thead>
<tr>
<th>Name</th>
<th>Amount</th>
<th>Merge Count</th>
<th>Mapped to Company</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alibaba</td>
<td>$23,024,62</td>
<td>None</td>
<td>Alibaba</td>
</tr>
<tr>
<td>&quot;ROK, INC.&quot;</td>
<td>$23,756,19</td>
<td>None</td>
<td>&quot;ROK, INC.&quot;</td>
</tr>
<tr>
<td>BAE Systems</td>
<td>$2,945,005,31</td>
<td>None</td>
<td>BAE Systems</td>
</tr>
<tr>
<td>Blue Jeans</td>
<td>$4,109,302,80</td>
<td>None</td>
<td>Blue Jeans</td>
</tr>
<tr>
<td>&quot;Branch, Inc.&quot;</td>
<td>$3,738,759,37</td>
<td>None</td>
<td>&quot;Branch, Inc.&quot;</td>
</tr>
<tr>
<td>Broadcom</td>
<td>$500,496,13</td>
<td>None</td>
<td>Broadcom</td>
</tr>
<tr>
<td>CA Technologies</td>
<td>$1,908,638,66</td>
<td>None</td>
<td>CA Technologies</td>
</tr>
<tr>
<td>&quot;CDW Direct, Ltd.&quot;</td>
<td>$300,335,63</td>
<td>None</td>
<td>&quot;CDW Direct, Ltd.&quot;</td>
</tr>
<tr>
<td>Cisco</td>
<td>$1,000,000,40</td>
<td>None</td>
<td>Cisco</td>
</tr>
<tr>
<td>DresdnerData</td>
<td>$986,801,62</td>
<td>None</td>
<td>DresdnerData</td>
</tr>
<tr>
<td>Diebold PA</td>
<td>$121,341,38</td>
<td>None</td>
<td>Diebold PA</td>
</tr>
<tr>
<td>Don data</td>
<td>$6,267,670,46</td>
<td>None</td>
<td>Don data</td>
</tr>
<tr>
<td>EDS</td>
<td>$1,194,373,80</td>
<td>None</td>
<td>EDS</td>
</tr>
<tr>
<td>Fujitsu</td>
<td>$905,126,38</td>
<td>None</td>
<td>Fujitsu</td>
</tr>
<tr>
<td>GoDaddy</td>
<td>$1,184,302,84</td>
<td>None</td>
<td>GoDaddy</td>
</tr>
<tr>
<td>HUI</td>
<td>$239,003,47</td>
<td>None</td>
<td>HUI</td>
</tr>
</tbody>
</table>
Review expenses before cleansing
You can view several additional details about the expenses that you imported into the application.

Role required: cost_transparency_admin or cost_transparency_analyst

1. Select a segment from the Attributes choice list and review the data (see table for column descriptions).

The data cleansing table

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the specific item in the selected segment, such as the name of the vendor or location.</td>
</tr>
<tr>
<td>Amount</td>
<td>Amount of the imported expense associated with the item in the segment.</td>
</tr>
<tr>
<td>Merge Count</td>
<td>Number of other expenses have been combined with the expense in that row. By default, the value for each record is None. When you merge expenses, the value changes to show the number of expenses merged.</td>
</tr>
<tr>
<td>Mapped to</td>
<td>If the application can find a match between the name of the specific item in the selected segment, such as the same vendor or cost center, already in your instance. If the application cannot find a matching record, a new one is created when you cleanse the data.</td>
</tr>
</tbody>
</table>

Each expense row is not a record in the system, but rather an aggregate view of the expenses in the General Ledger Staged Data table that contain the same value for a segment that you select.
For example, if you select the **Cost center** segment, each expense row is actually the sum of all the general ledger expenses that have the same cost center.

*Expenses in the data cleansing table*
2. You can do any of the following on the list of expenses that appear:
   • Filter the list of expense rows by typing text into the search field at the top-right of the list. The field searches the text in the Name column.
   • Click the expense amount in the Amount column to view the expense records in the General Ledger Staged Data table that comprise the row.
   • Click the delete icon (🗑️) on the left of the expense to ignore the row. The expenses that you ignore here are not carried over to the next stage to be assigned to buckets.

Merge expense rows by segment
Merging expenses means taking the expenses that are associated with one segment record.
Role required: cost_transparency_admin or cost_transparency_analyst
For example, you can take vendor ABC and associate expenses for this vendor with another segment record, like vendor XYZ. Effectively, you are changing the value for the Vendor field on the expenses from ABC to XYZ.
1. Click one or more expense rows to select them. These rows can be referred to as the source expenses.
2. Drag them onto another expense. This row can be referred to as the destination expense.
   The general ledger expense records for the source expenses are modified. The field that is modified is the segment you are currently working with, such as Vendor. The value for the field is changed to whatever value that field had on the destination expense.

Note: When you merge expenses, you are only modifying the segment value, such as the vendor or the cost center. You are not modifying the account numbers associated with the general ledger expenses that comprise the expense row.

3. Click the number of entries in the Merge Count column. The Merged Segments window appears.
4. To ignore a merged expense row, click the delete icon (🗑️) next to the entry in the Merged Segments window. The expense row reappears in the list of all expenses.

Map segment records to expense rows
The application attempts to map the expense row to an existing record in the segment that you selected and gives you the option of creating a new record in the segment's table, as long as the expense row segment field has a value.
Role required: cost_transparency_admin or cost_transparency_analyst
For example:
   • If you are cleansing data based on the Vendor segment, and the expense row's vendor is already in the Company [core_company] table, the Mapped to column shows Existing vendor.
   • If the expense's vendor does not exist in the Company table, the Mapped to column shows A new vendor will be created. This message tells you that when you finally cleanse the data, the application creates a record for the vendor in the Company table.
   • If the expense Vendor field is empty, the expense does not show up in any expense rows when Vendor is selected.

If a match is found, you can view the matching record and make changes by clicking the edit icon (📝) and modifying the form.
If no match is found and you want the system to create a record, simply leave the field as it is. Later, when you click Cleanse Data, the record is automatically created.
If no match is found and you do not want to create a record, you can manually associate an existing record with the expense:

1. Click the lookup icon next to the value in the Mapped to column.
2. Filter the list by typing keywords in the search field.
3. Select an existing record from the list.

**Associating a vendor with an expense**

**Cleanse data**
After you clean up the expenses on the Data Cleansing table, run the cleansing engine.

Role required: cost_transparency_admin or cost_transparency_analyst
• Click **Cleanse Data** on the right-hand pane.

The actual expense records you are manipulating in the Data Cleansing stage are in the General Ledger Staged Data table, but a replica of each expense record is also in the General Ledger Cleansed Data table. After you cleanse the data, changes are saved to the records in the General Ledger Cleansed Data table, not the General Ledger Staged Data table.

**The Bucketing stage**

The Bucketing stage allows you to assign expenses to groups called **buckets**.

A bucket can be any type of category that helps you organize expenses. Do not confuse buckets with segments. Buckets are customizable groups in which to put expenses before allocation. Segments, which are defined in the hierarchy, are parts of your organization to which you can allocate expenses.

On the Bucketing page, the expenses that you cleansed appear on the left pane, grouped by account number. The buckets into which you can group expenses appear in the middle pane. The summary section on the right pane provides a breakdown of how the expenses are assigned to buckets. If you do not see the correct data in the Accounts column, open the cleansed general ledger and verify that the records are correct.

In the Bucketing stage, you can:

• Create and modify buckets
• Create the filter conditions
• Create groomed lines for cost models with no data source
• Put the expenses from each account into the correct bucket
• Review bucket assignments and run the bucketing engine

**Bucketing on the workbench**
### Accounts

<table>
<thead>
<tr>
<th>Account Description</th>
<th>Total Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounting services</td>
<td>$880,675.89</td>
</tr>
<tr>
<td>Airfare</td>
<td>$783.67</td>
</tr>
<tr>
<td>Associated IT Costs - Business Expenses</td>
<td>$801.76</td>
</tr>
<tr>
<td>Associated IT Costs - Depreciation Expense</td>
<td>$3,203.24</td>
</tr>
<tr>
<td>Associated IT Costs - Facility Expenses</td>
<td>$64,267.40</td>
</tr>
<tr>
<td>Associated IT Costs - Other Expenses</td>
<td>$86,858.99</td>
</tr>
<tr>
<td>Associated IT Costs - Outside Services</td>
<td>$99,025.33</td>
</tr>
<tr>
<td>Associated IT Costs - Personnel Related</td>
<td>$0.00</td>
</tr>
</tbody>
</table>

### Buckets

#### Hardware

- **Total Amount:** $689,094.19
  - **Hardware Capital:** $41,462.02
  - **Hardware Expenses:** $683,010.87
  - **Hardware Maintenance:** $84,881.34

#### Labor

- **Total Amount:** $2,421,203.26
  - **Labor External:** $863,178.35
  - **Labor Internal Capital:** $468,819.89
  - **Labor Internal Expense:** $563,301.58

#### Services

- **Total Amount:** $783.67
  - **Services Cloud:** $323.87
  - **Services Vendor:** $459.80

#### Software

- **Total Amount:** $522,056.32
  - **Software License:** $48,434.47
  - **Software Maintenance:** $473,621.85

#### Other

- **Total Amount:** $42,371.41
  - **Other General Admin:** $216.10
  - **Other Miscellaneous:** $10,876.34
  - **Other Travel:** $63,408.91

#### Buckets Excluded from Cost Model

- **Total Amount:** $0.00

#### Skipped Other

- **Total Amount:** ($111,770.67)
View account details
The bucketing page shows all the cleansed data grouped by accounts on the left pane, and the existing buckets on the main pane. The buckets are presented with sub-buckets grouped within parent buckets.

Role required: cost_transparency_admin or cost_transparency_analyst

1. Click the gear icon (⚙️) next to Accounts.
2. Show or hide the accounts that are already assigned by clicking the Show accounts categorized in buckets toggle. You can assign expenses to buckets for unassigned accounts only.
3. Sort the accounts by selecting Name, Account, or Amount in the Sort by list.
4. Further sort the accounts by selecting Ascending or Descending from the Sort list.
5. View the records from the General Ledger Cleansed Data table that belong to an account by clicking the lines icon (≡). The records open in the list view in a new browser tab or browser window.

Create and modify buckets
You can create a bucket in the Bucketing stage of the workbench if you did not already do so with the standard Bucket form.

Role required: cost_transparency_admin or cost_transparency_analyst

• Click Create New Bucket on the top-right of the middle pane.

The Bucket form appears. The form is the same as the Bucket form that you can access from the Financials > Cost Model > Account Buckets. See Creating Buckets for more information.

Note: You can create buckets that are excluded from your cost model, meaning that they are not available for assignment to accounts and segments in the next stage: Allocation Setup. If you select the Exclude from cost model option on the Bucket form, the bucket appears at the bottom of the Bucketing page under Buckets Excluded from Cost Model.

Create bucket filter conditions
You can also create a condition to filter the data that goes into the bucket. These bucket filter conditions are also called grooming conditions, and they are the Advanced query conditions type.

Role required: cost_transparency_admin or cost_transparency_analyst

1. Click the filter icon in the bucket.
2. Fill in the form fields (see table).
3. Click **Submit**.

An example bucket filtering condition

**Fields for bucket filter conditions**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive name for the condition.</td>
</tr>
<tr>
<td>Priority</td>
<td>Value that determines when the filter is applied relative to other filters. If two filters have the same settings, the filter with a higher priority is applied.</td>
</tr>
<tr>
<td>Table</td>
<td>The table containing the expenses that are filtered when put into the bucket. By default, the General Ledger Cleansed Data [itfm_gl_data_cleansed] table is selected.</td>
</tr>
</tbody>
</table>
When you create a bucket filter, it appears in the **Advanced Conditions** tab above the donut chart in the right pane.

You can verify the filter conditions or make changes:

- Click the name of the condition to open the Advanced Condition form.
- Click the amount to open the list of general ledger expenses that match the filter.

The advanced filter condition icon also appears on the bucket:

*Create groomed lines for cost models with no data source*

If there is no data source for the cost model that you have selected in the Data definition stage of the Financial Management workbench, there is no cleansing process either.

**Role required:** cost_transparency_admin or cost_transparency_analyst

In the bucketing stage, there is no left pane with accounts. In such cases, you can create or edit the groomed lines in the Bucket Amount Line form by clicking the edit icon in the sub-buckets.
Note: If you are an Application Portfolio Management or Service Portfolio Management user, then Business Application Costing Model cost model and Service Offering Costing cost model do not have data source.

2. In the Bucketing stage, click the edit icon ( ) of a sub-bucket that you want to add the groomed lines to.
3. On the form, fill in the form fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amount</td>
<td>Amount of the sub-bucket.</td>
</tr>
<tr>
<td>Currency</td>
<td>Currency for the amount.</td>
</tr>
<tr>
<td>Description</td>
<td>Description for the bucket amount.</td>
</tr>
</tbody>
</table>

For a preconfigured Customer Service Management (CSM) cost model, the Account number, Cost center, Department, Account name, Location, and Vendor fields are not applicable.

If more than one groomed lines exist for a given sub-bucket, a list of groomed lines is displayed.

4. Click Submit.

Put expenses into buckets
After you set up the buckets, simply drag and drop expenses into buckets.

Role required: cost_transparency_admin or cost_transparency_analyst

1. In the Accounts pane, find the accounts you want to assign to buckets by typing the account name in the filter box or scrolling through the list.
2. In the Buckets pane, you can show or hide sub-buckets by clicking Collapse All.
3. Drag expenses from the Accounts pane to the relevant sub-bucket. The Total Amount value in the bucket and the Total Amount Assigned on the donut chart in the right pane change based on the assignment.
Putting an expense into a bucket
Review bucket assignments and run bucketing
After the data is in buckets, you can see the total amounts for each bucket and the individual general ledger expense records for each bucket.

Role required: cost_transparency_admin or cost_transparency_analyst

1. Click the information icon ( ) on any bucket to display summary information about the bucket.

2. Under Advanced Conditions, verify that the bucket filter condition is correct.
   a) Click the condition name to open the bucket filter condition form and make changes if necessary.
   b) Under Detailed Rows, click Show Details to show the expense records, which are saved in the General Ledger Cleansed Data [itfm_gl_data_cleansed] table, that are assigned to the bucket.
   c) To remove a bucket filter condition, click the delete icon ( ).

3. Under Accounts Assigned, verify that the correct accounts and all the expenses in them appear in the bucket.
   a) Click the account name to show the expense records from the General Ledger Cleansed Data table that are assigned to the bucket.
   b) To remove an account and all expenses that belong to the account from the bucket, click the delete icon ( ).
4. Under **Fields to Keep**, select the check boxes for fields you want to keep on the records in the bucket.

Bucket summary

5. Close the window when you are finished.
6. When the data is correct, click **Run Bucketing** on the right pane. When you run the bucketing engine, the data is saved in the Groomed General Ledger Data [ltfm_gl_data_groomed] table.

   The application deletes all existing allocation lines for the fiscal period you are working with when you click **Run Bucketing**.

**Allocation Setup stage**

The Allocate Setup stage enables you to assign expenses to accounts and segments.

On the Allocation Setup page, the sub-buckets that you created appear in the left pane, except for sub-buckets that you excluded from the cost model. The segments and their accounts appear in the middle pane, in the hierarchy that you defined in the data definition stage. The summary in the right pane provides a breakdown of how the expenses are assigned to accounts in each segment.

In the Allocation Setup stage, you can:

- View bucket contents and split buckets into smaller buckets, if necessary.
- Create and modify rollups to specify exactly how expenses are applied to higher-level segments in the hierarchy.
- Assign expenses to accounts.
- Review assigned expenses and revert bucket assignments if necessary.
- Filter the allocation setup segment account by amounts greater than, lesser than, or equal to a certain value.
- Configure the Display Records per segment pagination option in the Configuration tab to display 5, 10, 15, 25, or 50 accounts per page at the same time. The pagination option displays the selected number of accounts out of the total number of accounts in a segment per page. The right and left arrows help you to navigate to the next set of records until all the accounts in the segment are displayed.
- Similarly, view selected number of accounts on the lighter workbench page by setting up the pagination option in the Configuration tab.

**Setting up allocations on the workbench**
Basic allocation setup

This feature helps you to use allocation setup with ease especially while dealing with large accounts and allocation rules.

Configure basic allocation setup parameter to open the allocation setup UI in a lighter mode. Enabling basic allocation setup helps you to open the allocation setup page faster with minimal information, without having the UI loaded with the amount previews along with the accounts. Information in basic allocation setup is fetched only on demand.

Functionally, with basic allocation setup you can do all functions as in the regular allocation setup UI, where the primary purpose is to allocate bucket accounts and define rollup allocation rules. The icon indicators for buckets and rollups guide you when rules are defined in basic allocation setup.

With this parameter enabled, you cannot view the following details:

- The amount preview displayed in each of the accounts.
- The summary chart in the right pane.
- The See relationships link in the accounts. However, you can view the accounts that each account rolls up to, on demand, in the Accounts Rolling Up tab in accounts pop-up.

Missing money analysis

Note:

Missing money analysis is an extended and improved version of the allocation log functionality available before the Madrid release.

During the allocation setup stage, there is a possibility that the amount may not be rolled up correctly and the money may go missing during the process. The reasons can be due to errors in any of the following stages:

- Bucket Allocation
- Segment Rollup
- Account Rollup

Missing money logs provide details of why a part of the amount may be missing and fail to reach the target segment or account as per the allocation rules that have been set, and an actionable link to resolve issues.

To configure missing money logs, click the Configuration tab and toggle Missing Money Analysis to enable the logs. This action enables the Missing Money Logs (⚠️) icon in the allocation setup stage of the workbench.

Warning: Enabling the log may delay the loading of the allocation setup page.

Missing money logs are categorized into segment rollup errors, account rollup errors, and bucket allocation errors listed in the choice list to help identify the missing amount during allocation and to categorically point out the incorrect rules and allocation issues. The segregation helps to resolve allocation and rollup issues quickly, and track how the money went missing instead of reaching its target.

Clicking the Troubleshoot Errors/Warnings link opens up a web page that guides you to take necessary actions with steps that you can follow to resolve each error.
**View bucket contents**
You can modify what you see in the list of buckets in the Bucketing stage of the IT Finance workbench.

Role required: cost_transparency_admin or cost_transparency_analyst

1. Click the gear icon (⚙️) next to **Allocation Setup**.
2. Show or hide the buckets that are already assigned by clicking the **Show assigned buckets** toggle. You can assign the expenses in buckets to accounts for unassigned buckets only.
3. Sort the accounts by selecting **Name** or **Amount** in the **Sort by** list.
4. Further sort the accounts by selecting **Ascending** or **Descending** from the Sort list.

Click the information icon to view the records, which are saved in the General Ledger Cleansed Data [itfm_gl_data_cleansed] table, that belong to a bucket. The records open in the list view in a new browser tab or browser window.

**Split buckets**
Buckets contain groomed general ledger expenses. These expenses can be associated with items like a cost center, vendor, department, or location.

Role required: cost_transparency_admin or cost_transparency_analyst

You can only split buckets that are not yet assigned to accounts.

You can split the expenses in a bucket by any of the attributes such as cost center, vendor, department, or location. Starting with Istanbul release, you can use any custom attributes to split buckets. Use Financial Data Source Field Map for bringing additional attributes to split a bucket by enabling the **Used for Bucket split** option.

For example, if a bucket includes expenses for two different vendors, you can split the bucket into two smaller buckets, one for each vendor. Each split bucket contains the groomed general ledger expense associated with that vendor.

1. Open the **Allocation Setup** stage in the workbench.
2. In the **Allocation Setup** pane, click the split bucket icon (分配) for the bucket you want to split. The split bucket window appears, showing you the amount of money in the bucket.
3. From the **Split by** list, either select an attribute that is associated with the groomed general ledger expense or select **Percentage**.
   - If you select an attribute, the new buckets appear in the window with default names in the format [original bucket name] > [attribute name].
   - If you select **Percentage**, enter the percentages for the new buckets and give each bucket a name.
   - If you select **Weighted** split method, you have the choice to split the bucket amount to any segment in the hierarchy based on the available metric.

**Note:**
If the metric is **Total weight** configured, then you cannot split a bucket using that weighted metric.

After you split a bucket based on the **Weighted** method, you cannot split it further.

A preview of the split buckets appears in the window along with the expense amounts for each bucket.

4. Click **Split Bucket**.
5. The application creates new buckets and splits the expenses among them according to your settings. Buckets that are split appear with a folder icon.

6. To view a newly split bucket with the other buckets that were split along with it, click the folder icon.
To revert the bucket split, click **Unsplit Bucket**.

**Rollups for allocations**

A rollup is an allocation rule that specifies how a lower-level account in the segment hierarchy connects to other accounts above it in the hierarchy. Rollups allow you to allocate expenses to the lower-level account and have expenses automatically allocated to the higher-level accounts.

Rollups can be account-specific or segment-specific. Account-specific rollups specify how expenses roll up from one specific account to one or more accounts above it. Segment-specific rollups specify how expenses in all the accounts for a segment roll up to all the accounts in the segment above it, that is the parent level. You can also roll up segments to any segment preceding in the hierarchy, that is to the grandparent level.

Rollups specified for an individual account take precedence over the rollup specified for the segment. For example, if you create these two rollups:

- An account-specific rollup that allocates expenses in the email account in the business service segment to the IT account in the business unit segment.
• A segment-specific rollup that allocates expenses in the business service segment to the business unit segment.

Then the account-specific rollup allocates the expenses. The segment-specific rollup does not allocate any expenses.

Account-specific level rollup supports rolling to any parent or grandparent account in the hierarchy. You can roll up the expenses to any account up in the hierarchy, and not necessarily to the immediate parent in the hierarchy.

Rollups can not only be up in the hierarchy, you can also roll up amounts to accounts in the sibling segments.

Configure the rollup at the account level to any parent segment in the hierarchy, by selecting the **Parent Segment** in the Rollups popup.

**Total weight support for allocations using weighted metric**

If you use a weighted metric that is enabled with **total weight support**, then the metric calculates the allocation percentage accurately in the following total weight calculations:

• At segment level rollup, where **allocate to** metric is used and accounts do not have any rollup, the total percentages of all accounts in the segment add up to be less than 100%.
• At segment level rollup, where **allocate to** metric is used, the percentage of each account in the segment is calculated based on the consumption weight of the account.
• At account level rollup, where the account level rollup rule overrides the segment level rollup rule, the total percentage of all accounts adds up to be less than 100%.
• At account level rollup, the percentage of each account is calculated based on the consumption weight of the account.
• When allocating a bucket amount to a segment, the total percentage allocated to the segment adds up to be less than 100%.
• When allocating a bucket amount to a segment, the percentage allocated individually to each account in the segment is calculated based on the consumption weight of the account.

View accounts that roll up to an account

You can view the accounts that roll up to another account.

**Role required:** cost_transparency_admin or cost_transparency_analyst

1. Click the information icon ( ) on an account.

   The account summary window appears, showing you:
   • The total amount of money currently assigned to this account.
   • The buckets that contribute expenses to this account.
   • The method that this account uses to roll up to the parent segments.
   • The accounts that roll up to this account.
   • The accounts that this account rolls up to.

2. To see the buckets that are allocated directly to this account, click **Show allocated buckets**.

3. If you want to allocate one or more bucket amount (among all the buckets allocated to this account, as mentioned in step 2) to any specific account segment overriding the default rollups, then click
the **Bucket Rollups** tab. You can do such a bucket based rollup using the None, Equal, Manual, Weighted, or Scripted methods.

The other undefined buckets, which are not rolled up in this manner, follow the default rollup method.

Navigate to **Financial Modeling > Cost Models > Allocation Rollups Override** to view the **From Account Segment, To Account Segment**, rollup metric, and type details of such an allocation.
### Application Design Account

Total **$3,906,016.81**

### Allocated Buckets

<table>
<thead>
<tr>
<th>Show Details</th>
<th>Bucket</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>👍</td>
<td>Software Maintenance</td>
<td>$1,987,004.66</td>
</tr>
<tr>
<td>👍</td>
<td>Services Cloud</td>
<td>$693,812.47</td>
</tr>
<tr>
<td>👍</td>
<td>Software License</td>
<td>$1,225,199.68</td>
</tr>
</tbody>
</table>

Default Rollups: Bucket Rollups: Accounts Rolling Up

<table>
<thead>
<tr>
<th>Delete</th>
<th>Edit</th>
<th>Buckets</th>
<th>Rollup Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>✕</td>
<td></td>
<td>Services Cloud</td>
<td>Equal</td>
</tr>
<tr>
<td>✕</td>
<td></td>
<td>Software Maintenance</td>
<td>Equal</td>
</tr>
</tbody>
</table>

Add Bucket Rollup

---

**An example of bucket based rollup**
4. Click the **Accounts Rolling Up** tab if it is not selected.
   You can see the accounts that roll up, and the buckets that comprise the **Total** expenses for the account.

5. Click the information icon to view an account that rolls up or a bucket.

6. To sort the list, click the gear icon and choose the number of items per page and specify how to sort the items.

Create rollups from one account to another account
You can create rollups from one account in the segment hierarchy to another account in a segment above it.

Role required: cost_transparency_admin or cost_transparency_analyst

1. Click the hyperlink on the name of an account.
   The Account summary pop-up appears, showing you:
   - The total amount of money currently assigned to the account.
   - The buckets that contribute expenses to the account.
   - The method that the account uses to roll up to the parent segments.
   - The accounts that roll up to the account.
   - The accounts that the account rolls up to.

2. To see the buckets that are allocated directly to this account, click **Show allocated buckets** next to the **Total** value.

3. Click the **Rollups** tab if it is not selected.

4. Select a method from the **Rollup Method** choice list:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Segment’s default method</td>
<td>Expenses follow the default rollup rule for CI relationships that was created during the Data Definition stage. This is the default option for items in the CMDB that roll up to other items in the CMDB.</td>
</tr>
<tr>
<td>None</td>
<td>Expenses do not roll up to any parent accounts.</td>
</tr>
<tr>
<td>Equal</td>
<td>Expenses roll up to the parent accounts by the same percentage. Specify the parent accounts.</td>
</tr>
<tr>
<td>Manual</td>
<td>Expenses roll up to the parent accounts by a percentage that you specify. Enter the amounts in the <strong>Percentage</strong> fields.</td>
</tr>
<tr>
<td>Weighted</td>
<td>Expenses roll up to parent accounts using a weighted metric that exists. The metrics available are those that specify a rollup to the segment that the parent account belongs to. If a metric has the <strong>Enforce Relationship</strong> option selected, the segment to which the child account belongs is also considered. If a metric does not have the <strong>Enforce Relationship</strong> option selected, the segment of the child account is ignored.</td>
</tr>
<tr>
<td>Scripted</td>
<td>A script determines the rollup.</td>
</tr>
</tbody>
</table>

5. To link the account with an item above it, click **Add Rollup**.

6. Select a value in the **Parent Segment** choice list.

7. Select an account from the **Parent Account** choice list.

8. If you selected the manual rollup method, enter the amounts in the **Percentage** field.

9. Enter as many rollups as necessary. The percentages must add up to 100%. If you need to remove any of the accounts, click the delete icon (🗑️).
10. Click **Save Changes** after making your changes. The rollup rules appear in the right pane under the donut chart.

11. To see only those accounts that a selected account rolls up to, click the relationship icon on the account. Only the linked accounts appear. The color of the account that is assigned the expense is a randomly assigned color by the workbench. The color matches the account’s color on the donut chart.

The up arrow icon is indicative of rollups defined at segment or account level.

12. To show all accounts in the segment hierarchy again, click .

When you create a rollup, the system automatically updates the system metric that is used to manage the segment relationships in the hierarchy. This metric is created by the application during the Data Definition stage.

Create rollups from one segment to another

A segment can roll up to the segment above it in the hierarchy using a weighted metric.

Role required: cost_transparency_admin or cost_transparency_analyst

1. Click the information icon on a segment. The segment summary window appears, showing you the rollup method selected, if any.
2. In the **Rollup Method** choice list, select **Weighted**.
   a) Select the metric in the **Divide using metric** choice list. The metric automatically weights the amounts by the values in the **Value** column.
   b) To further change the amounts, modify the values in the **Percentage** column.

### Rollup example

<table>
<thead>
<tr>
<th>Account</th>
<th>Value</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Payroll</td>
<td>2</td>
<td>5.882353 %</td>
</tr>
<tr>
<td>PeopleSoft CRM</td>
<td>1</td>
<td>2.941176 %</td>
</tr>
<tr>
<td>PeopleSoft HRMS</td>
<td>1</td>
<td>2.941176 %</td>
</tr>
<tr>
<td>Bond Trading</td>
<td>2</td>
<td>5.882353 %</td>
</tr>
<tr>
<td>SAP Material Management</td>
<td>2</td>
<td>5.882353 %</td>
</tr>
<tr>
<td>SAP Labor Distribution</td>
<td>2</td>
<td>5.882353 %</td>
</tr>
<tr>
<td>PeopleSoft Supply Chain Management</td>
<td>1</td>
<td>2.941176 %</td>
</tr>
</tbody>
</table>
c) Click **Save Changes**.

3. In the **Rollup Method** choice list, select **Scripted**.
   a) On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Scope</td>
<td>Enabling the <strong>Account Scope</strong> check box executes the rollup script defined for each of the accounts at the segment level. Disabling the check box executes the default rollup defined at the segment level, thereby overriding the rollup defined for each account with the sys_id (FromAccountID). Instead of repeating similar rollup scripts for the accounts under a segment, you can provide the rollup scripts for individual accounts using the FromAccountID of each account. You can provide a default rollup for all the remaining accounts for which you have not provided the FromAccountID. You can provide all these rollups in a single script for execution.</td>
</tr>
<tr>
<td>Script</td>
<td>The script to rollup the accounts.</td>
</tr>
</tbody>
</table>

b) Click **Update**.

**Grouping segments by an attribute**

You can categorize the segment accounts using the group by attribute if there are thousands of segment accounts. The accounts roll up to the grouped segments, just as they roll up to a non-grouped segment, and the allocation lines are generated in the itfm_allocation_breakdown table. Rolling up to grouped segments helps in better performance.

*Edit rollup records*

You can view and edit records for segment rollups and account rollup if necessary.

**Role required:** cost_transparency_admin or cost_transparency_analyst

**Note:** As a good practice, use the workbench to create, modify, and delete rollups rather than modifying the scripts in the rollup records.

1. Navigate to **Financial Modeling > Cost Models > Allocation Rollups** to access the rollups that are created from one account to another.
2. Click a rollup name to open it.
3. Make modifications, if necessary.

**Bucket assignments**

Setting up an allocation means assigning the expenses in a bucket to an account in a segment or to several accounts in a segment.

The expenses in the bucket automatically roll up based on the allocation rules you created for rollups. When you assign expenses, the application creates an allocation rule with the prefix BCK:ALLC: in the name and gives it an order value of 10 more than the highest value, not including the values for the rules...
created for rollups. Rules that the application creates for rollups have a default value of 1,000,000. The application also creates a method that specifies the percentage allocated to the account.

Assign a bucket to a segment or an account
During the Allocation Setup stage in the workbench, you can assign expenses from buckets to accounts in the hierarchy.

Role required: cost_transparency_admin or cost_transparency_analyst

1. Drag a bucket to a specific account. You can also select multiple buckets and drag them to a specific account. If a bucket is allocated to an account, then the allocation method is always Allocate 100%.

   Alternatively, select one or multiple buckets. Click the Assign bucket icon

   that contains the expenses you want to assign to a single account or multiple accounts by performing the following steps:

   a) Under Allocate Method, select allocate to an account.
   b) Under Allocate To Segment, select a segment.
   c) Under Allocate to Account, select the segment account to which you want to assign all expenses in the selected buckets.
   d) On the other hand, to assign the selected buckets to multiple accounts, click Go with the default Multiple Accounts selected under Allocate To Account.

   The Create Allocation Rule window appears showing you a list of Selected Buckets along with the selected account or option to choose the accounts in the selected segment. If you do not want to allocate a bucket, select and delete the bucket.

2. Drag a bucket to a segment or click the Assign bucket icon

   to assign a bucket to a segment. You can assign a bucket to a segment one at a time. Multiple-bucket selection does not apply for segment assignment. If the bucket allocation is to a segment, then you must select the allocation method from the choice list:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equal</td>
<td>Expenses are assigned to the accounts by the same percentage.</td>
</tr>
<tr>
<td>Manual</td>
<td>Expenses are assigned to the accounts by a specified percentage. Enter the amounts in the Percentage fields.</td>
</tr>
<tr>
<td>Weighted</td>
<td>Expenses are assigned to the accounts using a weighted metric.</td>
</tr>
<tr>
<td></td>
<td>If the metric is configured with Total weight, you cannot split a bucket using that weighted metric.</td>
</tr>
</tbody>
</table>

Considerations

3. From the Divide among choice list, select a segment.

4. If you have selected a weighted method, select a preconfigured metric from the Divide using metric choice list. The only metrics that are available are those metrics that specify the parent and child segments.

5. Click Create.
6. To know how the bucket amount was distributed previously to the segments or an account, click the bucket name. The bucket opens up in a pop-up displaying a message on top. The message displays the allocation method by which the bucket amount has been distributed, and the name of the segment to which the amount has been assigned. If the assignment is by Allocate to account method, then the message also displays the account name and the percentage of allocation.

‘Facilities Data Center' bucket is distributed equally to ‘Business Unit' segment

Sample message of bucket assignment information

Review assigned expenses
Review the expenses assigned to accounts and verify the information is correct in the Total Amount Allocated section in the right pane.

Role required: cost_transparency_admin or cost_transparency_analyst

1. Click the information icon (ℹ️) on an account to view the allocation summary. The following information appears:
   • The total amount allocated.
   • The buckets that are assigned to the account.
   • The rollups to this account.
2. Click the information icon (ℹ️) next to the bucket to view the bucket summary.

unix200 Account

Total: $974,956.02

Allocated Buckets

<table>
<thead>
<tr>
<th>Bucket</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Services Cloud</td>
<td>100.0%</td>
</tr>
<tr>
<td>Services Cloud</td>
<td>100%</td>
</tr>
</tbody>
</table>

Rollups

Accounts that this account rolls up to

Rollup Method: Segment's default

Percentage divided: 100.000000%

<table>
<thead>
<tr>
<th>Account</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Securities Lending</td>
<td>100.000000%</td>
</tr>
</tbody>
</table>

An account summary window

*Verify the total amount allocated*

The donut chart on the right shows the assigned expenses for all segments.

Role required: cost_transparency_admin or cost_transparency_analyst
By default, the calculations in both the donut chart and the segment hierarchy include data from the new rules that you just created in the workbench, and any existing rules that you previously created. You can choose to turn off the preexisting rules, called **User Rules**, so that you see only the calculations from your newly created rules.

1. On the **Preview** tab, select a segment from the **Total Amount Assigned** choice list to view the allocation for that segment. The breakdown for each account appears below the donut chart.
2. To change whether or not the information in the donut chart is refreshed automatically when you make changes, click the gear icon (⚙️) on an account to view the allocation summary, and click the **Refresh Automatically** toggle.

![Image of donut chart with breakdown]

*The results of this chart may be altered by one or more advanced allocation rule conditions.*
3. Click the **User Rules** tab to view the allocation rules and rollups that you manually set up outside of the workbench.

On this tab, you can perform the following actions:

- Click a rule name to open the Cost Allocation Rule form for that rule.
- Click the preview icon ( (%) ) to preview the allocation for that rule in the allocation viewer.
- Click the **Show** check box to include allocation lines from existing, user-created rules in the calculations for assigned buckets. When you select this check box, the application includes existing allocation lines that are active on the accounts. The amounts that you see in the segments and in the donut chart are affected by the inclusion of these allocation lines. You should not select this option if you want the calculated values to show only what you assign from buckets.
- Click **See all rules** to see a list of all allocation rules in the application.

**Preview an allocation from a bucket**

You can preview a graphical representation of how the workbench allocates the expenses in the bucket by opening the allocation viewer.

Role required: cost_transparency_admin or cost_transparency_analyst

- To open the viewer, click the allocation preview icon

( (%) ) on the bucket.
Revert bucket assignments
Reverting bucket assignments means taking the expenses out of the segments and accounts and leaving it in the bucket. Reverting buckets also deletes existing allocation lines for the working fiscal period that are associated with this bucket.

Role required: cost_transparency_admin or cost_transparency_analyst

You can revert bucket assignments for a single bucket or all buckets.

Note: You can also revert expenses outside the workbench.

1. To revert bucket assignments for a single bucket, perform the following actions:
   a) Click the information icon on a bucket to open the account summary.
   b) Click Unallocate Bucket.

2. To revert bucket assignments for a single bucket and delete existing allocation lines for that working fiscal period, perform the following actions:
   a) Click the unassign bucket icon (↑) on the bucket.
   b) Click Yes on the confirmation window.
   c) You can also delete existing allocation lines for all fiscal periods by clicking click here on the confirmation window, and then clicking Delete.
3. To revert all bucket assignments, perform the following actions:
   a) Click the Gear icon (⚙️) next to Allocation Setup.
      a) Click Unassign All Buckets.
      b) Confirm the action.

The Allocation Review stage

The Allocation Review stage allows you to review the allocation setup before you process the allocations.

Allocation Setup Review

On the Review page, these summaries are available:

- **Bucketing**: The percentage of expenses that are assigned to buckets on the Bucketing stage.
- **Allocation Setup**: The percentage of buckets that are assigned to accounts in the segment hierarchy on the Allocation Setup stage.
- **Others**: Detailed allocation information, such as the expense amounts that are to be allocated to segments, the amount that was cleansed in the data cleansing stage, and the amounts in the unassigned buckets and assigned buckets.

Reviewing an allocation setup
You can trigger allocation runs for multiple cost models for various fiscal periods concurrently by queuing the allocation jobs to the allocation engine. This also allows multiple users on the same instance to queue their requested allocation runs. When the allocation engine has completed an allocation run, a confirmation message appears.

- The engine automatically picks up the next job in queue after the current job is complete.
- You can queue any number of allocation jobs for multiple cost models and fiscal periods.
• You can cancel a job (stop the engine) when the job is in progress thereby saving the engine runtime for the next job in queue.
• You can also dequeue a job from the jobs that are in queue by removing it from the queue, if you do not want to run it.

With this enhancement, you can view the last run details of the cost model and its breakdown details with links to allocations and unit costs.

• **View on Cost Analysis:** View the cost lines for analysis.
• **View Expense Lines:** If you had enabled the **Generate GL Expense Lines** check box in the Financial Model form for the cost model, then you can view the GL expense lines of the cost model after the allocation engine is run.

**Note:** This feature is only available to customers who own an ITBM Analyst license.

• **View Cost Lines:** View the cost allocation aggregates.
• **View Cost Line Breakdowns:** The cost allocation breakdown aggregates for the cost model. If the **Run On Demand Only** flag is set to true, then the allocation engine does not generate breakdown lines. To explicitly generate the breakdown lines, generate breakdown allocations in the **Breakdown Relationships** related list of the Financial Model form.
• **View Unit Costs:** View the unit costs.

You can also view the details of the current cost model that is in progress and the total number of allocation jobs in queue. Also, view the current job progress with the status of the current allocation run and its details.

View Cost Tree: View all the segment accounts contributing to the selected account in a hierarchical view. You can further drill, on each segment account, down in the hierarchy.

1. Click **View Cost Tree**.
2. Select a segment in the **Segment** choice list.
3. Select an account from the **Account** choice list.
4. Click **Go**.

**Allocate expenses with the workbench**
If any of this information looks incorrect, go back to a previous stage and make the necessary modifications.

Role required: cost_transparency_admin or cost_transparency_analyst

1. Verify your allocation settings on the **Configuration** tab.
2. Navigate to the **Review** stage of the workbench.
3. Choose what kind of allocation lines you want to generate:
4. Click **Allocate Expenses**.

The system allocates the expenses, creates allocation lines, and changes the **State** field on the general ledger record to **Allocated**. The values of all allocation lines created from the allocation add up to the value of the general ledger expense. If no rules apply to the general ledger expense, no allocation lines are created and the state of the general ledger record remains **Unallocated**.

**Note:** The system rounds allocation lines to two decimal places. An allocation totaling $100.495 is rounded up to $100.50. An allocation totaling $100.494 is rounded down to $100.49. If an allocation is rounded down to $0.00, the system does not create an allocation line.
The Cost Models tab

The **Cost Models** tab enables you to view all the existing cost models, clone a cost model from the existing cost models, and delete cost models that you do not need.

**Note:**
This feature is available only when you own an ITBM Analyst license.

A list of cost models appears on this tab. You can perform several actions from here:

- Clone a cost model from an existing cost model.
- View settings for each cost model.
- Delete cost models.
- Import and export cost models.
- Compare cost models.

Prescriptive cost models for shared services and business applications

L1 Costing – Shared Services provides a complete visibility of fully loaded IT infrastructure cost, infrastructure shared services showback, and lays foundation for future growth. L2 Costing – Business Applications provides cost of applications and end user, aligns applications to business units, furnishes cost information to support each business unit in business terms.

**Note:**
This feature is available only when you own an ITBM Analyst license.

**L1 Costing – Shared Services**

The specifications of the L1 Costing – Shared Services are:
L1 Costing – Shared Services

- The cost bucket layer is tied to the ITFM bucket table [itfm_bucket] and the cost buckets are specific to a model.
- IT shared service segment accounts (the middle layer in this model) are sourced from the IT shared service table [itfm_shared_service].
- The business unit layer is tied to the platform business unit table [business_unit].
L2 Costing – Business Applications

The specifications of the L2 Costing – Business Applications are almost the same as L1 Costing – Shared Services. However, there is an additional layer for applications. APM Business Application [cmdb_ci_business_app] table is the source of accounts to the applications segment. Or, it can be Application [cmdb_ci_appl] table or other custom tables.

Seeded IT Shared Services

IT Shared Service: Equip End Users

IT Shared Service: Equip End Users is a cost collection container that holds any money spent on providing the end users with personal (not shared) devices, the software that runs on these devices, and the support associated with making and keeping those devices functioning. This container excludes major device upgrades, lease cycle turnover, and other replenishment-related costs, which are captured within the Facilitate Ongoing Change container.
IT Shared Service: Facilitate Configuration Change

IT Shared Service: Facilitate Configuration Change is a cost collection container that holds money spent on supporting the ITSM Change, Release and Configuration Management processes. That is, any dollars spent on managing ongoing, daily, common, and ad-doc configuration changes. This includes activities like patching (non-security related), firmware updates, hardware/software configuration setting changes, installation, de-installation, and upgrade of hardware components, and general add, move, or change requests across the IT landscape. This container excludes major upgrades and changes across a large portion of the environment for which a project plan and/or funding would need to be secured.

IT Shared Service: Facilitate Connectivity

IT Shared Service: Facilitate Connectivity is a cost collection container that holds any money spent on providing all device network connectivity to the company, its computing and/or knowledge assets, the hardware and software to do it, and the support associated with making (and keeping) the access up. This includes all personal and enterprise devices. This container excludes monitoring hardware, software, and personnel costs, which are captured in the Monitor the Environment container.

IT Shared Service: Management and Overhead

IT Shared Service: Management and Overhead is a cost collection container that holds any money spent on IT executive compensation, as well as one-time charge items that apply to the existence of IT operations, compliance or audit costs, and otherwise uncategorised costs. This container excludes any costs captured or accounted for in any of the other IT process definitions.

IT Shared Service: Monitor the Environment

IT Shared Service: Monitor the Environment is a cost collection container that holds the money spent on supporting the ITOM Event Management process; that is, any dollars spent on monitoring the entire IT landscape. This includes endpoint connectivity speeds, endpoint application performance testing, hardware/software/network/storage threshold checking, and fault and event correlation management tools used by operations management personnel. This container excludes security specific and/or cloud monitoring services mentioned in other process areas.

IT Shared Service: Perform Upgrades/Maintenance

IT Shared Service: Perform Upgrades/Maintenance is a cost collection container that holds money spent supporting the ITSM Change, Release and Configuration Management processes. That is, all dollars spent on managing major upgrades, either project planned and/or specifically funded. This includes activities such as widespread OS upgrades; hardware replacement cycle activities; and internal or third-party business or IT management software package release updates across the IT landscape. This container excludes ongoing, daily, common, and ad-doc configuration changes that only require a change ticket to be executed.

IT Shared Service: Provide Tech Support

IT Shared Service: Provide Tech Support is a cost collection container that holds money spent supporting the ITSM Incident, Problem and Knowledge Management processes. That is, any dollars spent on providing technical support services to end users across the organization. This includes tier 1, 2, and 3 personnel, incident or problem management software, root cause analysis time, routine or ad-doc assistance (password resets, how to Q&A), and/or standard operating procedure guidance. This container excludes actual configuration changes to end user and/or corporate assets performed by way of documented change tickets.

IT Shared Service: Run Business Applications

IT Shared Service: Run Business Applications is a cost collection container that holds any dollars spent on ongoing personnel time to keep business applications operating. This includes resources dedicated to applications and excludes IT or infrastructure operation costs.

IT Shared Service: Secure the Environment
IT Shared Service: Secure the Environment is a cost collection container that holds money spent on supporting the Security Operations. That is, any dollars spent on providing information security across the corporate IT landscape. This includes individual user endpoint devices, cloud applications, cloud computing, and/or on-premise computing resource of all types in addition to all desktops, laptops, smart phones, network gear, servers, databases, and applications. This excludes the physical security costs associated with datacenters, and office space card readers.

**IT Shared Service: Store and Manage Data**

IT Shared Service: Store and Manage Data is a cost collection container that holds any dollars spent on the underlying tools and foundational activities related to the management of structured and unstructured data (for example, encryption, backups, purging, archiving, migrations, and DR replication) and/or storage capacity (for example, reorganizations and excess capacity acquisition). It includes these types of activities and all the people power used to ensure the health of the data and storage landscape. This container excludes elements related to local storage on end user devices utilized by single individuals and specific activities, and allocated storage that can be related to specific applications or systems.

**IT Shared Service: Supply Computing Power**

IT Shared Service: Supply Computing Power is a cost collection container that holds any dollars spent on providing foundational elements that exist, cost money to maintain, but may never actually be used such as disaster recovery facilities or contracts, hardware spares inventory, on-premises UPS systems, and generators. It also includes daily active data center costs related to things such as space, power, and cooling.

**ITFM prescribed metrics**

**Allocate to Business Unit based on Change Request volume based on CIs**

The metric allocates shared service cost to business unit based on the following weighting table:

- The Change Request [change_request] table provides a list of all change requests and their related configuration item.
- The CMDB [CMDB_ci] provides a list of all configuration items and their related department.
- The Department [cmn_department] table provides a list of all departments and their business unit.
The prescribed metric performs a count of change requests (for CIs) per business unit and weights the costs accordingly. Count number of CRs related to things requested by BUs (does not align with the allocations matrix) for the relevant fiscal period.

The weight table enforces lifespan on this metric.
- Duration start: Actual start.
- Duration end: Actual end.

**Allocate to Business Unit based on CI Count**

The metric allocates shared service cost to business unit based on the following weighting table:

- The CMDB [CMDB_ci] provides a list of all configuration items and their related department.
- The Department [cmn_department] table provides a list of all departments and their related business unit.
- The prescribed metric performs a count of configuration items per business unit and weights the costs accordingly.

**Allocate to Business Unit on Headcount**

The metric allocates shared service cost to business unit based on the following weighting table:

- The User [sys_user] table provides a list of all system users and their related department.
- The Department [cmn_department] table provides a list of all departments and their related business unit.
- The prescribed metric performs a count on the number of users per business unit and weights the costs accordingly.
  - Filter criteria: Only count active users.

**Allocate to Business Unit on Computer count**

The metric allocates shared service cost to business unit based on the following weighting table:

Allocate to Business Units on Computer count

- The Computer [cmdb_ci_computer] table provides a list of all computer names and their related department.
- The Department [cmn_department] table provides a list of all departments and their related business unit.
- The prescribed metric performs a count on the number of computers per business unit and weights the costs accordingly.

**Allocate to Business Unit on Change Request volume**

The metric allocates shared service cost to business unit based on the following weighting table:

Allocate to Business Unit on Change Request volume

- The Change Request [change_request] table provides a list of all change requests and who requested it.
• The Department [cmn_department] table provides a list of all departments and their related business unit.
• The prescribed metric performs a count of change requests per business unit and weights the costs accordingly.
  • The weight table enforces lifespan on this metric.
  • Duration start: Actual start.
  • Duration end: Actual end.

Allocate to Business Unit based on Incident volume

The metric allocates shared service cost to business unit based on the following weighting table:

Allocate to Business Unit based on Incident volume

• The Incident [incident.list] table provides a list of all incidents and their related callers.
• The Caller [users [ITIL view]] table provides a list of all departments and their related business unit.
• The prescribed metric performs a count of incidents per business unit (opened and closed within the period) and weights the costs accordingly.

Allocate to Business Application based on Compute Power

The metric allocates shared service cost to applications based on the following weighting table:

Allocate to Application based on Compute Power

• The CI Relationship [cmdb_rel_ci] table provides a list of all relationships between configuration items.
• The prescribed metric performs a count of configuration items where the Child.Class = Server and weights the costs accordingly to the receiving applications.

**Prescriptive cost models for business services and business capabilities**

Use the preconfigured business services and business capabilities cost models with their prescribed metrics for weight allocation. Understand the system requirements that each model supports, the allocation methods, and the datasets required to use them effectively.

**Note:**

This feature is available only when you own an ITBM Analyst license.

**Level 2 Costing — Business Services cost model**

**Level 2 Costing — Business Services cost model**
The cost model provides:

- Cost of Enabling the Business: The expenses of the IT to ensure that the business is aligned to transformational initiatives.
- Cost to support each Business Service in business terms: The cost to provide business services.

The cost model is recommended:

- At phase II or if you have previously invested in Financial Management.
- For showback in terms of core business functions or alignment to business capabilities.
- To provide insight into operational cost drivers.

Specifications of the Level 2 Costing — Business Services cost model:

- The cost bucket layer ties to the ITFM Bucket table [itfm_bucket]. Cost buckets are model specific.
- IT Shared Service segment accounts (the second layer in this model) are sourced from the IT Shared Service table [itfm_shared_service].
- Business Service segment accounts (the third layer in this model) are sourced from the Service table [cmdb_ci_service].
- The Business Unit layer ties to the Platform Business Unit table [business_unit].
Level 3 Costing — Business Capabilities cost model

The cost model provides:

- Cost of Enabling the Business: The expenses of the IT to ensure that the business is aligned to transformational initiatives.
- Cost to support each Business Capability in business terms: The cost of innovation.

The cost model is recommended:

- At phase II or if you have previously invested in Financial Management.
- For showback in terms of core business functions or alignment to business capabilities.

Specifications of the Level 3 Costing — Business Capabilities cost model
Model complexity of Level 3 Costing — Business Capabilities cost model

- The specifications are similar to that of the Level 2 Costing — Business Services cost model, aligned to business application. However, there is an extra layer for business capabilities. The accounts in this segment are sourced from the Business Capability [cmdb_ci_business_capability] table, which is a flat list.
- There is a prescribed scripted metric that aligns the actual capability associated with an application with the high-level business capability in the table.

Rollup methods

Use the following allocation methods to move the cost from the cost buckets to the upper layers of the model (IT Shared Services, Allocations, or Business Units).

<table>
<thead>
<tr>
<th>Rollup methods</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Does not allocate out to the next layer.</td>
</tr>
<tr>
<td>Rollup methods</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Equal</td>
<td>Equally splits the cost to each item it is related to.</td>
</tr>
<tr>
<td>Manual</td>
<td>Allocated by estimated or pre-calculated fixed percentages.</td>
</tr>
<tr>
<td>Weighted</td>
<td>Allocated based on actual usage. For example, allocate to BU based on change request volume, incident volume, or CI count or by a property of the object being allocated to, which is headcount.</td>
</tr>
</tbody>
</table>

The prescribed metrics support the **Weighted** rollup method, and source data directly from applications within the ServiceNow platform. For example:

- IT organizational structure: Business unit or department level.
- PPM or Time Card: Labor efforts charged to projects.
- CMDB: CI inventory with relationships, usage, and owner alignment.
- Asset Management: Asset inventory (end user and infrastructure) aligned to asset owners.
- IT Service Management: Volume related to Incident, Problem, and Change.
- IT Operations Management: Relationships and alignment to hardware and applications.
- Application Portfolio Management: Inventory of application hierarchy, associated business owner, and technology mapping.

**Prescribed metrics: IT Shared Services to Business Services**

Following are the descriptions of each metric with an explanation of the weighting methodology and their related tables within the ServiceNow system.

**Note**: If the related tables have incomplete data or if there are gaps in the data, then the calculated weighting percentages are affected.

The preconfigured cost model begins with equal weighting to the next segment. Prescriptive metrics are available for more mature solutions.

**Allocate to Business Service based on CI count**

The metric allocates shared service cost to business services based on the following weighting table:
Allocate to Business Service based on CI count

- The CI Relationship [cmdb_rel_ci] table provides a list of all CIs and their relationship to their parent CI such as dependency, use, runs on, and contained by.
- The Service [cmdb_ci_service] table provides a list of all business services that are the parent CIs.
- The prescribed metric performs a count of CIs per parent and weights the cost to the business services accordingly.

The weight table enforces lifespan on the following metric.
- Filters: Child.Class is not Business Service and Type is Depends on::Used by.
- Duration start: Actual start.
- Duration end: Actual end.

Allocate to Business Service based on compute power

The metric allocates shared service cost to business services based on the following weighting table:

- The CI Relationship [cmdb_rel_ci] table provides a list of all CIs and their relationship to their parent CI such as dependency, use, runs on, and contained by.
- The Service [cmdb_ci_service] table provides a list of all business services, which are the parent CIs.
• The prescribed metric performs a count of CIs per server (Child.Class) and weights the cost to the
  (parent) business services accordingly.

The weight table enforces lifespan on the following metric:
• Filters: Child.Class is Server and Type is Depends on::Used by.
• Duration start: Actual start.
• Duration end: Actual end.

Allocate to Business Service based on database count

The metric allocates shared service cost to business services based on the following weighting table:

Allocate to Business Service based on database count

• The CI Relationship [cmdb_rel_ci] table provides a list of all CIs and their relationship to their parent CI
  such as dependency, use, runs on, and contained by.
• The Service [cmdb_ci_service] table provides a list of all business services, which are the parent CIs.
• The prescribed metric performs a count of CIs per database (Child.Class) and weights the cost to the
  (parent) business services accordingly.

The weight table enforces lifespan on the following metric:
• Filters: Child.Class is Database and Type is Depends on::Used by.
• Duration start: Actual start.
• Duration end: Actual end.

Allocate to Business Service based on change request volume

The metric allocates shared service cost to business unit based on the following weighting table:
Allocate to Business Service based on change request volume

- The Change Request [change_request] table provides a list of all change requests and who requested it including the related business service.
- The Service [cmdb_ci_service] table provides a list of all business services.
- The prescribed metric performs a count of change requests per business service and weights the costs accordingly.

  The weight table enforces lifespan on the following metric:

  - Duration start: Actual start.
  - Duration end: Actual end.
  - Enforce lifespan selected on the weight table.

Allocate to Business Services based on incident volume

The metric allocates shared service cost to business unit based on the following weighting table:

Allocate to Business Services based on incident volume

- The Incident [incident.list] table provides a list of all incidents, their related callers, and the related business service.
- The Service [cmdb_ci_service] table provides a list of all business services.
• The prescribed metric performs a count of incidents per business service (opened and closed within the period) and weights the costs accordingly.
  • Duration start: Opened.
  • Duration end: Resolved.
  • Enforce lifespan selected on the weight table.

**Prescribed metrics: IT Shared Services to Business Applications**

**Allocate to Applications using active user count**

The metric allocates shared service cost to applications based on the following weighted metric:

- The Business Application [cmdb_ci_business_app] table provides a list of all business applications.
- The prescribed metric performs a sum of active users and weights the costs accordingly to the receiving applications by **Sys ID**.

**Allocate to Applications using database count**

The metric allocates shared service cost to applications based on the following weighted metric:

- The CI Relationship [cmdb_rel_ci] table provides a list of all CIs and their relationship to their parent CI such as dependency, use, runs on, and contained by.
• The Business Application [cmdb_ci_business_app] table provides a list of all business applications, which are the parent CIs.
• The prescribed metric performs a count of CIs per database (Child.Class) and weights the cost to the (parent) business application accordingly.
  • Filters: Child.Class is Database and Type is Depends on:::Used by.
  • Duration start: Actual start.
  • Duration end: Actual end.

Prescribed metrics: Business Applications to Business Capabilities

Following is the scripted metric to allocate to business capabilities:

```javascript
// Create a Scripted metric if you have complex logic to derive the weights for an Allocate to Segment.
//
// This Return Object is json:
// 1) key: The sys_id of the Allocate To segment's transaction table
// 2) value: the weight for the
//
// The API is called for each fiscal period and stored in weight Maps table which is in turn used in allocation.
// 'inputObject' is available in the script to have access to fiscal period and from Account id.
// The from account id is applicable only for "Allocate From" is part of metric setup where each entity in Allocate From table have their own weight distribution
// An 'inputObject' is injected during the evaluation of the script.
// It is an object of 2 key value pairs for fiscal period and allocate from account id.
function getTopCapability(capabilityId){
    var now_GR = new GlideRecord('cmdb_ci_business_capability');
    now_GR.get(capabilityId);
    if(now_GR.isValidRecord())
        return getParentCapabilityRecur(now_GR);
}

function getParentCapabilityRecur(capabilityGr){
    if(JSUtil.nil(capabilityGr.parent))
        return capabilityGr;
    else
        return getParentCapabilityRecur(capabilityGr.parent);
}

getScriptedWeightedMetric();
function getScriptedWeightedMetric(){
    var appId = inputObject.from_id; // where inputObject.from_id is one of the Business Applications Id from Allocate From segment (Business Applications)
    var relGr= new GlideRecord('cmdb_rel_ci');
    relGr.addEncodedQuery('parent.sys_class_name=cmdb_ci_business_capability^child.sys_class_name=cmdb_ci_business_app);
    relGr.addQuery('child',appId);
    relGr.query();
    var retObj={};
    while(relGr.next()){
        retObj[getTopCapability(relGr.parent).getUniqueValue()] = 1;
    }
    return retObj;
```
• The Business Capability [cmdb_ci_business_capability] table provides a list of all business capabilities and is part of Application Portfolio Management.
• The script, in essence, flattens the business capability list.

![Note]

**Note:** Everything should be related to its Level 0 Business Capability for Financial Modeling although applications within Application Portfolio Management may be assigned to lower-level capabilities.
Clone a cost model in the workbench

Use the preconfigured cost models or clone one from the base cost models for your financial model activities. By cloning you can map your financial data source to the cost model as per your business requirements without affecting the original cost model.

Role required: cost_transparency_admin or cost_transparency_analyst
Note:
This feature is available only when you own an ITBM Analyst license.

You can select a preconfigured basic cost model or clone a cost model from the Data Definition stage of the Workbench or from the Cost Models tab.

2. Do one of the following to access the basic cost model interface:
   - Select a cost model from the Cost Model choice list in the Working Set region of the Data Definition stage, and click the Clone this cost model icon.
   - Click the Cost Models tab, select the base cost model, and click the Clone Cost Model button or the Clone this cost model Action icon.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the cost model that you selected pre-populates in the field.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the cost model defaults.</td>
</tr>
<tr>
<td>Clone From</td>
<td>A cost model to clone the new one from.</td>
</tr>
<tr>
<td>Data source</td>
<td>The actual raw expense data table used for financial modeling activities. See Financial data sources and field maps. The base system options are:</td>
</tr>
<tr>
<td></td>
<td>• Cost Plan Breakdown: Maps to the raw expense data, where the actual cost and allocated cost are captured for a fiscal period in the cost plan breakdown [cost_plan_breakdown] table.</td>
</tr>
<tr>
<td></td>
<td>• General Ledger Staged: Maps to the database column that refers to general ledger account expenses in the general ledger staged data [itm_gl_data_staged] table.</td>
</tr>
<tr>
<td></td>
<td>• No Data Source: Option to manually enter the amounts in the cost model at the bucketing stage.</td>
</tr>
</tbody>
</table>

4. Click the Clone Cost Model button.

   You can also create a cost model on the cost model form.
View settings for each cost model
You can create a basic cost model from the Data Definition stage of the Workbench or from the Cost Models tab.

Role required: cost_transparency_admin or cost_transparency_analyst

1. Open the Cost Models tab on the workbench.
2. Click the name of the cost model to review.

A window appears with these tabs:

- **Buckets**: The account buckets currently associated with the cost model. A bucket can be associated with only one cost model.
- **Segments**: The segments that the cost model uses from the hierarchy of segments definition.
- **Hierarchy of Segments**: The segment hierarchy of the cost model.
- **Fiscal Period Data**: The expense summary for all fiscal periods.
An example cost model summary

3. Click Launch in Workbench to open the cost model in the Data Definition stage of the workbench, or click Cancel to close the window.
**Delete a cost model**
You can delete cost models if you no longer need them.

Role required: cost_transparency_admin or cost_transparency_analyst

- Perform one of the following steps:
  - Open the Cost Models tab on the workbench and click the delete icon.
  - Open the Cost Models tab on the workbench, select the check boxes next to the models to delete, and select the Delete action from the choice list.
  - Navigate to Financials > Cost Models, open the cost model record, and click Delete.

**Compare cost models**
You can compare any two cost models to see the differences in bucketed expenses, the hierarchy of segments, and allocation data for a fiscal period.

Role required: cost_transparency_admin or cost_transparency_analyst

Compare cost models if you want to see how the expenses in a potentially new cost model break down into allocations. The data shown in the cost model comparison is actual data from the bucketing stage and actual allocation data. If you did not yet complete the bucketing and allocation stages in the workbench, no data appears.

You can only compare two cost models at a time.

1. Open the Cost Models tab on the workbench.
2. Select the check boxes next to the cost models you want to compare.
3. Click Compare Cost Models. The Compare Cost Models window opens showing a side-by-side comparison of the two cost models.
4. Select a fiscal period.
5. Click any of the following items:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Buckets</td>
<td>The amounts in each bucket and sub-bucket. Click Collapse All or Show All to hide or show all the buckets.</td>
</tr>
<tr>
<td>Hierarchy</td>
<td>Hierarchy of segments.</td>
</tr>
<tr>
<td>Data</td>
<td>Allocation data for each segment that has costs allocated to it.</td>
</tr>
</tbody>
</table>

6. You can also change cost models by selecting a new model from the Current Cost Model or Proposed Cost Model choice lists on either side.

**Clone a cost model**
If you want to create a cost model based on an existing one, you can clone a cost model.

Role required: cost_transparency_admin or cost_transparency_analyst

- **Note:**
  This feature is available only when you own an ITBM Analyst license.

When you clone a cost model, all data related to cleansing conditions, allocations, buckets, hierarchy of segments and rollups are copied over to the new cost model. Allocation lines are not cloned. You still need to perform allocations to generate allocation lines and run reports on the new allocation data.

1. Open the Cost Models tab on the workbench.
2. Click the clone icon for the cost model you want to clone.
3. On the form, fill in the fields.

**Clone Cost Model form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the new cost model.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the new cost model.</td>
</tr>
<tr>
<td>Clone From</td>
<td>The cost model you are basing the new cost model on.</td>
</tr>
</tbody>
</table>

4. Click **Create**.

*Create breakdown relationship*

Define a breakdown relationship between required segments to view cost lines generated between the segments.

Role required: **cost_transparency_admin**

1. Navigate to **Financial Modeling > Cost Models > All**.
2. Click **New** in the Breakdown Relationships related list.
3. On the form, fill in the fields.

**Breakdown Relationship form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost Model</td>
<td>Cost model from the list.</td>
</tr>
<tr>
<td>X Segment</td>
<td>Segment name from the list.</td>
</tr>
<tr>
<td>Y Segment</td>
<td>Segment name from the list.</td>
</tr>
<tr>
<td>Run On Demand Only</td>
<td>Option to manually generate the cost line breakdowns on demand.</td>
</tr>
<tr>
<td></td>
<td>By default, the flag is set to false, which means</td>
</tr>
<tr>
<td></td>
<td>the allocation engine generates breakdowns for the related segments of the</td>
</tr>
<tr>
<td></td>
<td>cost model. If the flag is true, then the allocation engine will not</td>
</tr>
<tr>
<td></td>
<td>generate the cost line breakdowns.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

*Leftover calculation for breakdowns*

The cost lines generated for the amounts coming to the segment indirectly from other segments, which are not part of a breakdown relationship with the segment, or by direct bucket allocations to the segment are the leftovers.

If you want to calculate the leftovers for a breakdown, then set the system property `com.glide.financial_management.generate_breakdown_leftovers` to true.

**Run On Demand Only**
Use the option to generate the cost lines breakdowns on demand. This option helps in optimal usage of the allocation engine runtime.

5. To manually generate the cost lines for a breakdown, navigate to the Breakdown Relationships related list of the Financial Model form.
   a) Select the check box next to the breakdown and click Generate Breakdown Allocations action from the Action on selected rows list.
   b) Enter the fiscal period in the Generate Breakdown Allocations dialog box.
   c) Click OK.

6. To view the cost lines of the breakdown that you manually generated, navigate to the Review stage of the Financial Management workbench.

7. Click the View Cost Line Breakdowns link of the breakdown. You can view the cost lines in the Cost Allocation Breakdown list.

Generate controlled cost lines to view the cost lines of the amount aggregated at the account level.

The Configuration tab

The Configuration tab provides you with additional settings.

These sections are presented:

- **General Settings**: View the system currency in use for the application and control the level of detail on the allocation lines that the application creates.
- **Main Report Configuration**: Configure settings for the main Financial Management report that appears on the CIO Dashboard.
- **Advanced Actions**: Revert allocations for expenses or delete allocation lines.

Configure general settings

Configure the level of detail for allocation lines on the Configuration tab of the workbench.

Role required: cost_transparency_admin or cost_transparency_analyst

You can vary the level of detail that is available on allocation data. The application can keep track of Sys_IDs of segment values in the allocation line tables, which allows you to dot-walk on allocation reports. This might have a performance impact on your application, depending on the number of allocation lines you generate.

1. On the workbench, click the Configuration tab.

   The currency code for the base system currency is shown in the General Settings pane.

   **Note:**

   Until Kingston release, you can use `com.glide.financial_management.currency_code` property to get the currency code. The property was removed in London release. If you are an upgraded customer in London, you can still use this property. Currently, `glide.system.locale` is the functional currency.

   To get the currency code, use the new scriptable `SNC.FMCurrency().getGlobalCurrencyCode()` API irrespective of you being an upgraded or a new customer.

2. Enable the Basic Allocation Setup to open the allocation setup UI in a lighter mode.

3. Enable Missing Money Analysis to enable the log in the Allocation Setup page of the Workbench.

   Missing money analysis is an extended and improved version of the allocation log functionality that was available before the Madrid release.
4. **Display Records per segment** is a configuration setup that helps you to choose the number of accounts such as 5, 10, 15, 25, or 50 of a segment for display in the Allocation Setup page of the workbench, Allocation Setup page of lighter workbench, and the Cost Lines Analysis page.

*Configure main report settings*
Configure settings for your main financial report, including which cost models and fiscal periods are represented.

Role required: cost_transparency_admin or cost_transparency_analyst

The main financial report provides the basis for the Financial report on the CIO Dashboard and on other report overviews. The main setting you can configure for the main report is which cost model that the application uses to generate reports for each fiscal period. If you have the financial admin or analyst role, you can select the cost model in the report parameters of the default reports. If you have the financial user role, the cost model is determined by these settings.

1. On the workbench, click the **Configuration** tab.
2. Select a cost model from the **Main Cost Model** choice list. The main financial report includes this cost model when new fiscal periods are added.
3. Click **Update configurations**.
4. On the Cost Model Selection window, select the cost model for each fiscal period. The report uses this cost model to calculate and display the data that you see on the main financial report.
5. Click **Save**.

*Delete allocation lines*
On the **Configuration** tab of the workbench, you can delete the allocation lines for any fiscal period if you no longer need this data, or if you need to make changes to segments or fiscal periods that are already associated with allocation lines.

Role required: cost_transparency_admin or cost_transparency_analyst

1. Open the workbench and go to the **Configuration** tab.
2. Under **Advanced Actions**, next to **Delete Data For**, select the fiscal period.
3. Click **Delete**.
4. Confirm the action.

**Missing money logs factoring tips**
The error type and the possible causes and resolution tips help you to troubleshoot the errors easily.

*Note:* Missing money analysis is an extended and improved version of the allocation log functionality available prior to Madrid.

**Missing money logs and resolution**

<table>
<thead>
<tr>
<th>Category</th>
<th>Condition</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bucket Allocation</td>
<td>Bucket Data Validation: '{0}' is excluded: (1) but one of its sub-buckets is not: (2)</td>
<td>Either parent or child buckets ((Test Parent Bucket)/(Test Child Bucket)) are excluded from allocation</td>
<td>Contact ServiceNow Technical Support</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Category</th>
<th>Condition</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bucket Allocation</td>
<td>Bucket Allocation: '{0}' is allocated to an invalid segment</td>
<td>Bucket {Test Parent Bucket} is with corrupted target segment</td>
<td>Revert and reassign the bucket. 1. Click the error message to highlight the bucket. 2. To revert the bucket assignment, click the revert bucket assignment icon. 3. Assign a bucket to a segment or an account.</td>
</tr>
<tr>
<td>Bucket Allocation</td>
<td>Bucket Allocation: '{0}' is allocated to a segment {1} that is not associated with the current cost model</td>
<td>Bucket {Test Parent Bucket} is allocated to a segment that is NOT associated with the current cost model</td>
<td>Revert and reassign the bucket. 1. Click the error message to highlight the bucket. 2. To revert the bucket assignment, click the revert bucket assignment icon. 3. Assign a bucket to a segment or an account.</td>
</tr>
<tr>
<td>Bucket Allocation</td>
<td>Bucket Allocation: '{0}' is using a weighted allocation method, but no metric is specified</td>
<td>{Test Bucket} is using weighted allocation method, but metric is not specified</td>
<td>Revert and reassign the bucket. 1. Click the error message to highlight the bucket. 2. To revert the bucket assignment, click the revert bucket assignment icon. 3. Assign a bucket to a segment or an account.</td>
</tr>
<tr>
<td>Category</td>
<td>Condition</td>
<td>Cause</td>
<td>Action</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Bucket Allocation | Bucket Allocation: '{0}' is allocated using an invalid allocation method | {Test Bucket} is using weighted allocation method, but an invalid metric is used       | Revert and reassign the bucket.  
1. Click the error message to highlight the bucket.  
2. To revert the bucket assignment, click the revert bucket assignment (↑) icon.  
3. Assign a bucket to a segment or an account. |
| Bucket Allocation | Bucket Allocation: '{0}' is allocated to an unspecified account | {Test Bucket} is allocated to an unspecified account                                   | Revert and reassign the bucket.  
1. Click the error message to highlight the bucket.  
2. To revert the bucket assignment, click the revert bucket assignment (↑) icon.  
3. Assign a bucket to a segment or an account. |
| Bucket Allocation | Bucket Allocation: '{0}' is allocated to an invalid account               | {Test Bucket} is allocated to an invalid account                                        | Revert and reassign the bucket.  
1. Click the error message to highlight the bucket.  
2. To revert the bucket assignment, click the revert bucket assignment (↑) icon.  
3. Assign a bucket to a segment or an account. |
<table>
<thead>
<tr>
<th>Category</th>
<th>Condition</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
</table>
| Bucket Allocation| Bucket Allocation: '{0}' is missing mandatory manual allocation information | In the {Test Bucket} allocation, one of the manually allocated lines has missing information (Transaction Account or Transaction Segment or Percentage allocation) | Fill in the missing mandatory information such as the transaction account, transaction segment, percentage allocation.  
1. Click the link to navigate to the Bucket Allocation Account form.  
2. Enter the missing mandatory information such as the transaction Segment, transaction Account, and the Percentage in the respective fields.  
3. Click Update. |
| Bucket Allocation| Bucket Allocation: '{0}' is manually allocated to an invalid segment: '{1}' | {Test Bucket} is manually allocated and one of the allocated lines has an invalid segment {Test Segment} | Correct the segment information in the bucket allocation account.  
1. Click the link to navigate to the Bucket Allocation Account form.  
2. Select the segment from the Segment choice list.  
3. Click Update. |
| Bucket Allocation| Bucket Allocation: '{0}' is manually allocated to an invalid account {1} in the segment {2}. {3}% of amount is lost | {Test Bucket} is manually allocated to an invalid account {Test Account} in the segment {Test Segment}. {Amount}% of amount may be lost | Correct the account information in the bucket allocation account.  
1. Click the link to navigate to the Bucket Allocation Account page.  
2. Select the account from the Account choice list.  
3. Click Update. |
<table>
<thead>
<tr>
<th>Category</th>
<th>Condition</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
</table>
| Bucket Allocation | Bucket Allocation: '{0}' is manually allocated with a missing or invalid percentage value | {Test Bucket} is manually allocated with a missing or invalid percentage value | Correct the percentage in the bucket allocation account.  
1. Click the link to navigate to the Bucket Allocation Account page.  
2. Enter correct percentage in the Percentage field.  
3. Click Update. |
| Bucket Allocation | Bucket Allocation: '{0}': sum of the manual percentages is {1}% which is more than 100% | In the {Test Bucket} manual allocation, sum of the allocation percentages is 120% | Correct the allocation percentages in the bucket allocation accounts.  
1. Click the link to navigate to the Bucket Allocation Accounts list.  
2. Enter correct percentages in the Percentage column.  
3. Click the save (✔) icon or press Enter after each entry. |
| Bucket Allocation | Bucket Allocation: '{0}': sum of the manual percentages is {1}% which is less than 100% | In the {Test Bucket} manual allocation, sum of the allocation percentages is 70% | Correct the allocation percentages in the bucket allocation accounts.  
1. Click the link to navigate to the Bucket Allocation Accounts list.  
2. Enter correct percentages in the Percentage column.  
3. Click the save (✔) icon or press Enter after each entry. |
<table>
<thead>
<tr>
<th>Category</th>
<th>Condition</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
</table>
| Bucket Allocation       | Bucket Allocation: '{0}' manual allocation was chosen, but no accounts were specified | In the {Test Bucket} manual allocation, accounts have not been specified. | Revert and reassign the bucket.  
1. Click the error message to highlight the bucket.  
2. To revert the bucket assignment, click the revert bucket assignment icon.  
3. Assign a bucket to a segment or an account. |
| Bucket Allocation       | Bucket Split for '{0}': sum of the split percentages is {1} which is less than 100 | Bucket Split for {Test Bucket}: Sum of the split percentages is 70%   | Contact ServiceNow Technical Support                                      |
| Bucket Allocation       | Bucket Split for '{0}': sum of the split percentages is {1} which is more than 100 | Bucket split for {Test Bucket}: Sum of the split percentages is 120%  | Contact ServiceNow Technical Support                                      |
| Segment Rollup          | Segment Rollup: '{0}': target segment is not in Hierarchy: {1}            | The rollup of {Test Segment} segment has a corrupted target segment, which is not in the hierarchy. | Redefine the rollup for the segment.  
1. Click the error message to highlight the segment.  
2. Click the segment name.  
3. Select the right segment from the choice list in the segment rollup pop-up.  
4. Select the Rollup Method from the choice list.  
5. Click Save Changes. |
<table>
<thead>
<tr>
<th>Category</th>
<th>Condition</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Segment Rollup</td>
<td>Segment Rollup: '{0}': target segment has not been specified: (1)</td>
<td>The rollup of {Test Segment} segment has a corrupted target segment.</td>
<td>Redefine the rollup for the segment. 1. Click the error message to highlight the segment.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Click the segment name.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Select the right segment from the choice list in the segment rollup pop-up.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4. Select the Rollup Method from the choice list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5. Click <strong>Save Changes</strong>.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Category</th>
<th>Condition</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Segment Rollup</td>
<td>Segment Rollup: '{0}': target segment is not</td>
<td>The rollup of {Test Segment} segment has a corrupted target segment.</td>
<td>Redefine the rollup for the segment.</td>
</tr>
<tr>
<td></td>
<td>valid: {1}</td>
<td></td>
<td>1. Click the error message to highlight the segment.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Click the segment name.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Select the right segment from the choice list in the segment rollup pop-up.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4. Select the Rollup Method from the choice list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5. Click Save Changes.</td>
</tr>
<tr>
<td>Segment Rollup</td>
<td>Segment Rollup: '{0}': weighted rollup is</td>
<td>The rollup of {Test Segment} segment has a corrupted metric.</td>
<td>Redefine the rollup for the segment.</td>
</tr>
<tr>
<td></td>
<td>chosen, but no metric is specified</td>
<td></td>
<td>1. Click the error message to highlight the segment.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Click the segment name.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Select the right segment from the choice list in the segment rollup pop-up.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4. Select Weighted from the Rollup Method choice list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5. Click Save Changes.</td>
</tr>
<tr>
<td>Category</td>
<td>Condition</td>
<td>Cause</td>
<td>Action</td>
</tr>
<tr>
<td>----------------</td>
<td>-----------</td>
<td>----------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Segment Rollup</td>
<td>Segment Rollup: '{0}' rollup is using an invalid metric: {1}</td>
<td>The rollup of {Test Segment} segment has a corrupted metric.</td>
<td>Redefine the rollup for the segment.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1. Click the error message to highlight the segment.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Click the segment name.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Select the right segment from the choice list in the segment rollup pop-up.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4. Select Weighted from the Rollup Method choice list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5. Click Save Changes.</td>
</tr>
<tr>
<td></td>
<td>Segment Rollup: '{0}': rollup script contains syntax errors</td>
<td>The rollup script defined for {Test Segment} segment has syntax errors.</td>
<td>The rollup script must be syntactically corrected on the Segment Rollup Override form.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1. Click the link to navigate to the Cost Allocation Rollup form.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Correct the syntax of the script in the Script field.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Click Update.</td>
</tr>
<tr>
<td></td>
<td>Segment Rollup: '{0}': {1} argument is missing in rollup of script for target Account {2}</td>
<td></td>
<td>The rollup script must be syntactically corrected.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1. Click the link to navigate to the Cost Allocation Rollup form.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Correct the syntax of the script in the Script field.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Click Update.</td>
</tr>
<tr>
<td>Category</td>
<td>Condition</td>
<td>Cause</td>
<td>Action</td>
</tr>
<tr>
<td>--------------</td>
<td>----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Segment Rollup | Segment Rollup: '{0}': To transaction Segment is given empty/null for Scripted Rollup for to Account {1} | The rollup script defined for (Test Segment) segment has an invalid JSON return. One of the rollup values in JSON is Null. | The rollup script returns a JSON variable that must be corrected for a valid rollup value. Correct the script in the Cost Allocation Rollup form.  
1. Click the link to navigate to the Cost Allocation Rollup form.  
2. Correct the syntax of the script in the Script field.  
3. Click **Update**. |
| Segment Rollup | Segment Rollup: '{0}': To transaction Segment: {1} is invalid for Scripted Rollup for to Account {1} | The rollup script defined for (Test Segment) segment has an invalid JSON return. One of the rollup values in JSON is invalid. | The rollup script returns a JSON variable that must be corrected for a valid rollup value. Correct the script in the Cost Allocation Rollup form.  
1. Click the link to navigate to the Cost Allocation Rollup form.  
2. Correct the syntax of the script in the Script field.  
3. Click **Update**. |
| Segment Rollup | Segment Rollup: '{0}': To transaction Segment: {1} is not in hierarchy for Scripted Rollup for to Account {2} | The rollup script defined for (Test Segment) segment has an invalid JSON return. One of the rollup values in JSON is not in the hierarchy. | The rollup script returns a JSON variable that must be corrected for a valid rollup value. Correct the script in the Cost Allocation Rollup form.  
1. Click the link to navigate to the Cost Allocation Rollup form.  
2. Correct the syntax of the script in the Script field.  
3. Click **Update**. |
<table>
<thead>
<tr>
<th>Category</th>
<th>Condition</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
</table>
| Segment Rollup   | Segment Rollup: '{0}': To transaction Account ({1}) of Segment ({2}) does not exist for Scripted Rollup | The rollup script defined for (Test Segment) segment has an invalid JSON return. One of the rollup values (Account) in JSON does not exist. | The rollup script returns a JSON variable that must be corrected for a valid rollup value. Correct the script in the Cost Allocation Rollup form.  
1. Click the link to navigate to the Cost Allocation Rollup form.  
2. Correct the syntax of the script in the **Script** field.  
3. Click **Update**. |
| Segment Rollup   | Segment Rollup: '{0}': To transaction Account is null for Segment ({1}) does not exist for Scripted Rollup | The rollup script defined for (Test Segment) segment has an invalid JSON return. One of the rollup values (Account) in JSON is Null. | The rollup script returns a JSON variable that must be corrected for a valid rollup value. Correct the script in the Cost Allocation Rollup form.  
1. Click the link to navigate to the Cost Allocation Rollup form.  
2. Correct the syntax of the script in the **Script** field.  
3. Click **Update**. |
| Segment Rollup   | Segment Rollup: '{0}': To transaction Account: {1} ({2}) is invalid for Scripted Rollup for to Account {3} | The rollup script defined for (Test Segment) segment has an invalid JSON return. One of the rollup values (Account) in JSON is invalid. | The rollup script returns a JSON variable that must be corrected for a valid rollup value. Correct the script in the Cost Allocation Rollup form.  
1. Click the link to navigate to the Cost Allocation Rollup form.  
2. Correct the syntax of the script in the **Script** field.  
3. Click **Update**. |
<table>
<thead>
<tr>
<th>Category</th>
<th>Condition</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
</table>
| Segment Rollup   | Segment Rollup: '{0}' rollup is divided by no/invalid percent value for    | The rollup script defined for (Test Segment) segment has an invalid   | The rollup script returns a JSON variable that must be corrected to sum up to 100%. Correct the script in the Cost Allocation Rollup form.  
|                  | Scripted Rollup for to Account {1}                                        | JSON return. One of the rollup percentage values is invalid.         | 1. Click the link to navigate to the Cost Allocation Rollup form.  
|                  |                                                                           |                                                                       | 2. Correct the syntax of the script in the **Script** field.  
|                  |                                                                           |                                                                       | 3. Click **Update**.  |
|                  | Segment Rollup: '{0}' scripted rollup is divided by percent {1}% which   | The rollup script defined for (Test Segment) segment has an invalid    | The rollup script returns a JSON variable that must be corrected to sum up to 100%. Correct the script in the Cost Allocation Rollup form.  
|                  |  is more than 100%                                                       | JSON return. The sum of the rollup amount is 120%                     | 1. Click the link to navigate to the Cost Allocation Rollup form.  
|                  |                                                                           |                                                                       | 2. Correct the syntax of the script in the **Script** field.  
|                  |                                                                           |                                                                       | 3. Click **Update**.  |
|                  | Segment Rollup: '{0}' scripted rollup is divided by percent {1}% which    | The rollup script defined for (Test Segment) segment has an invalid    | The rollup script returns a JSON variable that must be corrected to sum up to 100%. Correct the script in the Cost Allocation Rollup form.  
|                  |  is less than 100%                                                      | JSON return. The sum of the rollup amount is 70%                      | 1. Click the link to navigate to the Cost Allocation Rollup form.  
|                  |                                                                           |                                                                       | 2. Correct the syntax of the script in the **Script** field.  
<p>|                  |                                                                           |                                                                       | 3. Click <strong>Update</strong>.  |</p>
<table>
<thead>
<tr>
<th>Category</th>
<th>Condition</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Rollup</td>
<td>Account Rollup: '{0}': target segment has not been specified: {1}</td>
<td>The rollup of ‘100 South Charles Street, Baltimore, MD’ account has a corrupted target segment.</td>
<td>Redefine the rollup for the account.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1. Click the error message to highlight the account.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Click the account name.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Delete the existing corrupt target segment by clicking the actions (行政部门) icon in the account rollup pop-up.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4. Click Add Rollup button and select the target segment in the To Segment choice list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5. Select the Rollup Method from the choice list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>6. Click Save Changes.</td>
</tr>
<tr>
<td>Account Rollup</td>
<td>Account Rollup: '{0}': target segment is not valid: {1}</td>
<td>The rollup of ‘100 South Charles Street, Baltimore, MD’ account has a corrupted target segment.</td>
<td>Redefine the rollup for the account.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1. Click the error message to highlight the account.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Click the account name.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Delete the existing corrupt target segment by clicking the actions (行政部门) icon in the account rollup pop-up.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4. Click Add Rollup button and select the target segment in the To Segment choice list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5. Select the Rollup Method from the choice list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>6. Click Save Changes.</td>
</tr>
<tr>
<td>Category</td>
<td>Condition</td>
<td>Cause</td>
<td>Action</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Account Rollup  | Account Rollup: '{0}': target segment is not in Hierarchy: {1}            | The rollup of '100 South Charles Street, Baltimore, MD' account has a target segment that is not in the hierarchy. | Redefine the rollup for the account. 1. Click the error message to highlight the account.  
2. Click the account name.  
3. Delete the existing corrupt target segment by clicking the actions (.double circle) icon in the account rollup pop-up.  
4. Click Add Rollup button and select the target segment that is in the hierarchy in the To Segment choice list.  
5. Select the Rollup Method from the choice list.  
6. Click Save Changes. |

© 2021 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Category</th>
<th>Condition</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
</table>
| Account Rollup| Account Rollup: '{0}': target segment is not in Hierarchy: {1} | The rollup of '100 South Charles Street, Baltimore, MD' account has a corrupted target account | Redefine the rollup for the account.  
1. Click the error message to highlight the account.  
2. Click the account name.  
3. Delete the existing corrupt target segment by clicking the actions (谤) icon in the account rollup pop-up.  
4. Click Add Rollup button and select the target segment in the To Segment choice list.  
5. Select the target account in the To Account choice list.  
6. Select the Rollup Method from the choice list.  
7. Click Save Changes. |
<table>
<thead>
<tr>
<th>Category</th>
<th>Condition</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Rollup</td>
<td>Account Rollup: '{0}': To transaction Account: (1) (2) is invalid</td>
<td>The rollup of '101 Broadway East, Seattle, WA' account rolls up to an invalid account.</td>
<td>Redefine the rollup for the account.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1. Click the error message to highlight the account.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Click the account name.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Delete the existing corrupt target segment by clicking the actions ( ) icon in the account rollup pop-up.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4. Click Add Rollup button and select the target segment in the To Segment choice list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5. Select a valid account in the To Account choice list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>6. Select the Rollup Method from the choice list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>7. Click Save Changes.</td>
</tr>
<tr>
<td>Category</td>
<td>Condition</td>
<td>Cause</td>
<td>Action</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Account Rollup</td>
<td>Account Rollup: '{0}': weighted rollup is chosen, but no metric is specified</td>
<td>The rollup of 'Development' account has a corrupt metric.</td>
<td>Redefine the rollup for the account.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1. Click the error message to highlight the account.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Click the account name.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Delete the existing target segment by clicking the actions ( ) icon in the account rollup pop-up.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4. Click Add Rollup button and select the target segment in the To Segment choice list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5. Select a valid account in the To Account choice list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>6. Select the Weighted metric in the Rollup Method choice list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>7. Select a valid metric in the Select Metric choice list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>8. Click Save Changes.</td>
</tr>
<tr>
<td>Category</td>
<td>Condition</td>
<td>Cause</td>
<td>Action</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Account Rollup</td>
<td>Account Rollup: '{0}': weighted rollup is chosen, but no metric is specified</td>
<td>Account Rollup: The rollup of 'Development' account has a corrupt metric.</td>
<td>Redefine the rollup for the account.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1. Click the error message to highlight the account.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Click the account name.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Delete the existing target segment by clicking the actions (lovak) icon in the account rollup pop-up.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4. Click Add Rollup button and select the target segment in the To Segment choice list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5. Select a valid account in the To Account choice list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>6. Select the Weighted metric in the Rollup Method choice list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>7. Select a valid metric in the Select Metric choice list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>8. Click Save Changes.</td>
</tr>
<tr>
<td></td>
<td>Account Rollup: '{0}' is manually divided by a missing or invalid percentage value</td>
<td>The sum rollup percentage of 'HR' is 70%.</td>
<td>Redefine the rollup to sum up to 100%</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1. Click the link to navigate to the Cost Allocation Rollup Overrides list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Enter percentage for each record so that the percentages of all records sum up to 100% in the Percent column.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Click the save (✓) icon or press Enter after each entry.</td>
</tr>
<tr>
<td>Category</td>
<td>Condition</td>
<td>Cause</td>
<td>Action</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Account Rollup</td>
<td>Account Rollup: '{0}' - sum of the manual percentage is (1)% which is more than 100%</td>
<td>The sum rollup percentage of 'HR' is 70%.</td>
<td>Redefine the rollup to sum up to 100%</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1. Click the link to navigate to the Cost Allocation Rollup Overrides list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Enter percentage for each record so that the percentages of all records sum up to 100% in the Percent column.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Click the save (✓) icon or press Enter after each entry.</td>
</tr>
<tr>
<td>Account Rollup</td>
<td>Account Rollup: '{0}' - sum of the manual percentage is (1)% which is less than 100%</td>
<td>The sum rollup percentage of 'HR' is 70%.</td>
<td>Redefine the rollup to sum up to 100%</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1. Click the link to navigate to the Cost Allocation Rollup Overrides list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Enter percentage for each record so that the percentages of all records sum up to 100% in the Percent column.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Click the save (✓) icon or press Enter after each entry.</td>
</tr>
<tr>
<td>Category</td>
<td>Condition</td>
<td>Cause</td>
<td>Action</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Account Rollup</td>
<td>Account Rollup: '{0}' is equally divided by a missing or invalid percentage value</td>
<td>'{0}' rollup override is equally divided by no/invalid percent value.</td>
<td>Redefine the rollup to sum up to 100%</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1. Click the link to navigate to the Cost Allocation Rollup Overrides list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Enter percentage for each record so that the percentages of all records sum up to 100% in the Percent column.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Click the save (✓) icon or press Enter after each entry.</td>
</tr>
<tr>
<td></td>
<td>Account Rollup: '{0}' is equally divided by percent {1}%, which is more than 100%</td>
<td>The rollup of '125 West South Street, Indianapolis, IN' account is more than 100% and may lead to unaccountable amounts.</td>
<td>Redefine the rollup to sum up to 100% on the Account Rollup Override form.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1. Click the link to navigate to the Cost Allocation Rollup Overrides list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Enter percentage for each record so that the percentages of all records sum up to 100% in the Percent column.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Click the save (✓) icon or press Enter after each entry.</td>
</tr>
<tr>
<td>Category</td>
<td>Condition</td>
<td>Cause</td>
<td>Action</td>
</tr>
<tr>
<td>---------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Account Rollup| Account Rollup: '{0}' is equally divided by percent (1)% which is less than 100%                                                                                                                        | The rollup of '125 West South Street, Indianapolis, IN' account is more than 100% and may lead to unaccountable amounts.                                                                               | Redefine the rollup to sum up to 100% on the Account Rollup Override form.  
1. Click the link to navigate to the Cost Allocation Rollup Overrides list.  
2. Enter percentage for each record so that the percentages of all records sum up to 100% in the Percent column.  
3. Click the save (✔) icon or press Enter after each entry. |
| Account Rollup| Account Rollup: '{0}': rollup script contains syntax errors                                                                                                                                              | The rollup script defined for the Facilitate Connectivity account has syntax errors.                                                                                                                  | The rollup script must be syntactically corrected on the account rollup override form.  
1. Click the link to navigate to the Cost Allocation Rollup Override form.  
2. Correct the syntax of the script in the Script field.  
3. Click Update. |
| Account Rollup| Account Rollup: '{0}': To transaction Segment {1} is given empty/null for Scripted Rollup Override for to Account {2}                                                                                 | The rollup script defined for the Facilitate Connectivity account has an invalid JSON return. One of the rollup values in JSON is null.       | The rollup script returns a JSON variable that must be corrected for a valid rollup value. Correct the script on the Account Rollup Override form.  
1. Click the link to navigate to the Cost Allocation Rollup Override form.  
2. Correct the rollup value in the Script field.  
3. Click Update. |
<table>
<thead>
<tr>
<th>Category</th>
<th>Condition</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
</table>
| Account Rollup    | Account Rollup: '{0}': To transaction Segment: {1} is invalid for Scripted Rollup Override for to Account {2} | The rollup script defined for the Facilitate Connectivity account has an invalid JSON return. One of the rollup values is Test Account, which is not a valid Business Unit. | The rollup script returns a JSON variable that must be corrected for a valid rollup value. Correct the script on the Account Rollup Override form.  
1. Click the link to navigate to the Cost Allocation Rollup Override form.  
2. Enter a valid rollupValue in the **Script** field.  
3. Click **Update**. |
| Account Rollup    | Account Rollup: '{0}': To transaction Segment: {1} is not in the hierarchy for Scripted Rollup Override for to Account {2} | The rollup script defined for the Facilitate Connectivity account has an invalid JSON return. One of the rollupToSegment is Test Segment, which is not in the hierarchy. | The rollup script returns a JSON variable that must be corrected for a valid rollupToSegment. Correct the script on the Account Rollup Override form.  
1. Click the link to navigate to the Cost Allocation Rollup Override form.  
2. Enter a valid rollupToSegment in the **Script** field.  
3. Click **Update**. |
| Account Rollup    | Account Rollup: '{0}': To transaction Account ({1}) of Segment ({2}) is given empty/null for Scripted Rollup Override | The rollup script defined for the Facilitate Connectivity account has an invalid JSON return. One of the rollup values is given empty/Null. | The rollup script returns a JSON variable that must be corrected for a valid rollup value. Correct the script on the Account Rollup Override form.  
1. Click the link to navigate to the Cost Allocation Rollup Override form.  
2. Enter a valid rollupValue in the **Script** field.  
3. Click **Update**. |
<table>
<thead>
<tr>
<th>Category</th>
<th>Condition</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Rollup</td>
<td>Account Rollup: '{0}': To transaction Account is null for Segment (1) for Scripted Rollup Override</td>
<td>The rollup script defined for the Facilitate Connectivity account has an invalid JSON return. One of the rollup values is given empty/Null.</td>
<td>The rollup script returns a JSON variable that must be corrected for a valid rollup value. Correct the script on the Account Rollup Override form.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1. Click the link to navigate to the Cost Allocation Rollup Override form.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Enter a valid rollupValue in the Script field.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Click <strong>Update</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Account Rollup</td>
<td>Account Rollup: '{0}': To transaction Account: (1) (2) is invalid for Scripted Rollup Override</td>
<td>Script returns invalid JSON. One of the rollup values is BlackBerry, which is not a valid Business Unit.</td>
<td>The rollup script returns a JSON variable that must be corrected for a valid rollup value. Correct the script on the Account Rollup Override form.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1. Click the link to navigate to the Cost Allocation Rollup Override form.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Enter a valid rollupValue in the Script field.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Click <strong>Update</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Account Rollup</td>
<td>Account Rollup: '{0}': rollup override is divided with no/invalid percent value for Scripted Rollup Override for to Account (1)</td>
<td>One of the percentage values, rollup amount, is given Null or invalid value for rollup value 'test account'.</td>
<td>Correct the rollup amount in the script on the Account Rollup Override form. Correct the script on the Account Rollup Override form.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1. Click the link to navigate to the Cost Allocation Rollup Override form.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Correct the rollupAmount in the script.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Enter a valid percentage value in the Script field.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4. Click <strong>Update</strong>.</td>
</tr>
<tr>
<td>Category</td>
<td>Condition</td>
<td>Cause</td>
<td>Action</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Account Rollup</td>
<td>Account Rollup: '{0}' rollup override is divided with no/invalid percent value for Scripted Rollup Override for to Account {1}</td>
<td>One of the percentage values is given Null or invalid for a missing rollup argument or rollup value.</td>
<td>Correct the rollup amount in the script on the Account Rollup Override form. Correct the script on the Account Rollup Override form. 1. Click the link to navigate to the Cost Allocation Rollup Override form. 2. Correct the rolloutAmount in the script. 3. Enter a valid percentage value in the Script field. 4. Click Update.</td>
</tr>
<tr>
<td>Account Rollup</td>
<td>Account Rollup: '{0}' scripted rollup is divided by percent {1}% which is more than 100%</td>
<td>The rollup script defined for the Facilitate Connectivity account has an invalid JSON return. The sum of the rolloutAmount is 120%.</td>
<td>The rollup script returns a JSON variable that must be corrected to sum up to 100%. Correct the script on the Account Rollup Override list. 1. Click the link to navigate to the Cost Allocation Rollup list. 2. Enter percentage for each record so that the percentages of all records sum up to 100% in the Percent column. 3. Click Update.</td>
</tr>
<tr>
<td>Category</td>
<td>Condition</td>
<td>Cause</td>
<td>Action</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Account Rollup        | Account Rollup: '{0}' scripted rollup is divided by percent (1)% which is less than 100% | The rollup script defined for the Facilitate Connectivity account has an invalid JSON return. The sum of the rollupAmount is 70% | The rollup script returns a JSON variable that must be corrected to sum up to 100%. Correct the script on the Account Rollup Override form.  
1. Click the link to navigate to the Cost Allocation Rollup list.  
2. Enter percentage for each record so that the percentages of all records sum up to 100% in the Percent column.  
3. Click Update. |
| Account Rollup        | Account Rollup: '{0}' has bucket-based rollup with invalid bucket          | Account Rollup: '{0}' has bucket-based rollup with invalid bucket     | Redefine the bucket rollup for the account.  
1. Click the error message to highlight the account.  
2. Click the account name.  
3. Click the Bucket Rollups tab.  
4. Delete the existing invalid bucket record by clicking the delete (Trash Can) icon.  
5. Click Add Bucket Rollup.  
6. Select the bucket from the Bucket choice list in the bucket rollup pop-up.  
7. Select the Rollup Method from the choice list.  
See View accounts that roll up to an account for more information.  
8. Click Save Changes. |
<p>| Account Rollup        | Account Rollup: '{0}' has bucket-based rollup where bucket has no parent | Account Rollup: '{0}' has bucket-based rollup where the bucket has no parent | Contact ServiceNow Technical Support. |</p>
<table>
<thead>
<tr>
<th>Category</th>
<th>Condition</th>
<th>Cause</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Rollup</td>
<td>Account Rollup: '{0}' has bucket-based rollup where bucket is not in the</td>
<td>Account Rollup: '{0}' has bucket-based rollup where the bucket is not</td>
</tr>
<tr>
<td></td>
<td>current cost model</td>
<td>in the current cost model</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Redefine the bucket rollup for the account.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. Click the error message to highlight the account.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Click the account name.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Click the <strong>Bucket Rollups</strong> tab.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. Delete the existing bucket record by clicking the delete (删除) icon.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5. Click <strong>Add Bucket Rollup</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6. Select a bucket that is in the current cost model from the <strong>Bucket</strong> choice list in the bucket rollup pop-up.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7. Select the <strong>Rollup Method</strong> from the choice list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See View accounts that roll up to an account for more information.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>8. Click <strong>Save Changes</strong>.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Category</th>
<th>Condition</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Rollup</td>
<td>Account Rollup: '{0}' has bucket-based rollup where bucket is not at the lowest split level</td>
<td>Account Rollup: '{0}' has bucket-based rollup where the bucket is not at the lowest split level</td>
<td>Redefine the bucket rollup for the account</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1. Click the error message to highlight the account.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Click the account name.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Click the Bucket Rollups tab.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4. Delete the existing bucket record by clicking the delete (.cancel) icon.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5. Click Add Bucket Rollup.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>6. Select a bucket that is at the lowest split level from the Bucket choice list in the bucket rollup pop-up.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>7. Select the Rollup Method from the choice list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>See View accounts that roll up to an account for more information.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>8. Click Save Changes.</td>
</tr>
<tr>
<td>Account Rollup</td>
<td>Account Rollup: '{0}' has bucket-based rollup divided manually for bucket '{1}' has a missing or invalid percentage value</td>
<td>Account '{0}' rollup override is manually divided with no/invalid percent value.</td>
<td>Redefine the rollup to sum up to 100%.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1. Click the link to navigate to the Cost Allocation Rollup Overrides list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Enter percentage for each record so that the percentages of all records sum up to 100% in the Percent column.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Click the save (.save) icon or press Enter after each entry.</td>
</tr>
<tr>
<td>Category</td>
<td>Condition</td>
<td>Cause</td>
<td>Action</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Account Rollup</td>
<td>Account Rollup: '{0}' has bucket-based rollup divided manually for bucket '{1}' with percent {2}% which is more than 100%</td>
<td>The sum rollup percentage of 'HR' is 70%.</td>
<td>Redefine the rollup to sum up to 100%.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1. Click the link to navigate to the Cost Allocation Rollup Overrides list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Enter percentage for each record so that the percentages of all records sum up to 100% in the Percent column.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Click the save (✔️) icon or press Enter after each entry.</td>
</tr>
<tr>
<td>Account Rollup</td>
<td>Account Rollup: '{0}' has bucket-based rollup divided manually for bucket '{1}' with percent {2}% which is less than 100%</td>
<td>The sum rollup percentage of 'HR' is 70%.</td>
<td>Redefine the rollup to sum up to 100%.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1. Click the link to navigate to the Cost Allocation Rollup Overrides list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Enter percentage for each record so that the percentages of all records sum up to 100% in the Percent column.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Click the save (✔️) icon or press Enter after each entry.</td>
</tr>
<tr>
<td>Category</td>
<td>Condition</td>
<td>Cause</td>
<td>Action</td>
</tr>
<tr>
<td>---------------</td>
<td>----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Account Rollup</td>
<td>Account Rollup: '{0}' has bucket-based rollup divided equally for bucket '{1}' with a missing or invalid percentage value</td>
<td>'{0}' rollup override is equally divided with no/invalid percent value</td>
<td>Redefine the rollup to sum up to 100%.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1.  Click the link to navigate to the Cost Allocation Rollup Overrides list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2.  Enter percentage for each record so that the percentages of all records sum up to 100% in the Percent column.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3.  Click the save (✓) icon or press Enter after each entry.</td>
</tr>
<tr>
<td>Account Rollup</td>
<td>Account Rollup: '{0}' has bucket-based rollup divided equally for bucket '{1}' with percent {2}% which is more than 100%</td>
<td>The rollup of '125 West South Street, Indianapolis, IN' account is more than 100% and may lead to unaccountable amounts.</td>
<td>Redefine the rollup to sum up to 100% on the Account Rollup Override form.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1.  Click the link to navigate to the Cost Allocation Rollup Overrides list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2.  Enter percentage for each record so that the percentages of all records sum up to 100% in the Percent column.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3.  Click the save (✓) icon or press Enter after each entry.</td>
</tr>
<tr>
<td>Category</td>
<td>Condition</td>
<td></td>
<td>Cause</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Account Rollup</td>
<td>Account Rollup: '{0}' has bucket-based rollup divided equally for bucket '{1}' with percent {2}% which is less than 100%</td>
<td>The rollup of '125 West South Street, Indianapolis, IN' account is less than 100% and may lead to unaccountable amounts.</td>
<td>Redefine the rollup to sum up to 100% on the Account Rollup Override form.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1. Click the link to navigate to the Cost Allocation Rollup Overrides list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Enter percentage for each record so that the percentages of all records sum up to 100% in the Percent column.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Click the save ( ✓ ) icon or press Enter after each entry.</td>
</tr>
</tbody>
</table>

**Cost models**

A cost model is a set of rules, methods, and metrics that tell the application how to allocate expenses to the accounts in the hierarchy.

Cost models are associated with allocations and reports. If you own an ITBM analyst license, then you can create several cost models and choose the one you want to run the allocation engine against.

Cost models have the following attributes which give you more control over your expense allocation:

- **User Group**: Associate a cost model to a user group of type ITFM. Anyone with the appropriate financial model role can access the cost model (with the associated user group), provided the user is also part of the user group. With this association, you can restrict users who can access the cost model.

- **Fiscal Period**: Associate a cost model to a fiscal unit. The Fiscal Period field in the Data Definition stage of the financial modeling is set based on the fiscal unit that you have selected in the cost model. Hence, you can perform financial model activities for different fiscal periods (month, quarter, or a period).

- **Data Source**: Define the staged lines source for the cost model. Optionally, you can opt not to define a data source, in which case you can create groomed lines directly or enter the amount directly into the buckets.

If you own an ITBM analyst license you can use the prescribed cost models that the base system provides, other than the cost models that you can create. See prescriptive cost models for shared services and business applications, and prescriptive cost models for business services and business capabilities for the following cost models:

- Level 1 Costing — Shared Services
- Level 2 Costing — Business Applications
- Level 2 Costing — Business Services
- Level 3 Costing — Business Capabilities
If you are using Application Portfolio Management (APM) or Service Portfolio Management (SPM), then you can use one of the following cost models that depends on the application that you use:

- Business Application Costing
- Service Offering Costing

Create a cost model from Cost Model form

You can create multiple cost models to process allocations. Use the Cost Model form to configure all possible settings available to the cost model.

**Note:**

This feature is available only when you own an ITBM Analyst license.

Role required: cost_transparency_admin

You can select a cost model in The Data Definition stage when you set up allocations. You can also clone a cost model in the workbench.

2. Click New.
3. Fill in the form fields (see table).

### Financial Model form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the cost model in accordance with its description, of up to 80 characters in length.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the cost model.</td>
</tr>
<tr>
<td>Used by Cost Allocation</td>
<td>Option to specify if the model is to be used for cost allocation.</td>
</tr>
<tr>
<td>Model Owner</td>
<td>The user who created the cost model.</td>
</tr>
<tr>
<td>Data Source</td>
<td>The source from where the data is taken.</td>
</tr>
</tbody>
</table>

**Data Source** field is editable until financial model actions are not done.

The application is preconfigured to point to the Budget Staged table as a data source for the Default Budget Cost Model as it is linked to ITFM Budget staged expenses.

You also have the option not to select a data source. In such a case, the Workbench stages will not have the data cleansing stage as there is no financial data source to pull the expense lines from. Amounts would then be keyed in manually at the bucketing stage.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose Segments for GL Expense Lines</td>
<td>The <strong>Choose Segments for GL Expense Lines</strong> field is available only when <strong>Generate Controlled Cost Lines</strong> check box is enabled. You can choose segments to generate the GL expense lines in the itfm_allocation table.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This feature is available only when you own an ITBM Analyst license.</td>
</tr>
<tr>
<td>Carry Fields in GL Expense Lines</td>
<td>Configure the data source fields that you want to carry over from the bucketing stage to the grooming and allocation stages.                                                                                               By default, the data source fields that are set <strong>Used for Bucket split</strong> as ‘true’ are carried over from the financial data source General Ledger Staged table.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This feature is available only when you own an ITBM Analyst license.</td>
</tr>
<tr>
<td>Used by Budgeting</td>
<td>Check box if the model is being used for budgets.</td>
</tr>
<tr>
<td>Fiscal Unit</td>
<td>Defines the fiscal unit to be a month, quarter, or a period based on the fiscal calendar.</td>
</tr>
<tr>
<td>Generate Controlled Cost Lines</td>
<td>(Recommended). Helps in performance and saves database space. Check box to generate minimal cost lines aggregated at the account level only, in the itfm_allocation_aggregate table. You can define specific breakdown relationship between the segments required for business. Additional breakdown lines are generated in the itfm_allocation_breakdown table between the segments.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Detailed cost lines can negatively impact the performance.</td>
</tr>
<tr>
<td>Include Sub-Bucket info</td>
<td>The <strong>Include Sub-Bucket info</strong> check box option is available when <strong>Generate Controlled Cost Lines</strong> check box is selected. If enabled, the generated cost lines and breakdown lines hold sub-bucket information.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>User Group</td>
<td>The user group selected is associated with the cost model. This restricts access to the cost model by other user groups that are not associated with the user group of type ITFM. Users with cost_transparency_analyst role can access default cost model and the cost model associated to his/her user group only. Users with cost_transparency_admin and system administrator roles can access all the cost models, including the default cost model. If the <strong>Used by Budgeting</strong> check box is enabled for the cost model, then users with appropriate budgeting role can view all the budget models. If the cost model is used for purposes of both budgeting and generating cost allocation lines, that is, if <strong>Used by Cost Allocation</strong> and <strong>Used by Budgeting</strong> check boxes are enabled, then all users can access the cost model.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

5. To run cost allocations, click **Allocate Expenses** button.

   Use this option to run cost allocation from the cost model form and not necessarily from the workbench.

   a) Select the fiscal period in the Allocate Expense dialog box.

   b) Click **OK**.

   The allocation engine runs to generate cost allocations for the selected fiscal period. The engine does cleansing and bucketing. It allocates the expenses and creates allocation lines. However, if the cost model has no data source, the engine ignores the cleansing and bucketing stages and creates allocation lines.

6. To download the cost model, click **Download Cost Model** button.

   You can download the cost model for uploading it to, or deploying it in another instance to do cost modeling in a different pre-production environment. You can later move the cost model to other production environments.

   With the ability to download the cost model you can also download all its related tables and the related elements such as segment definition and hierarchy, buckets, cleansing and grooming conditions, bucket allocations, rollups and rollup overrides, and consumption metrics.

7. To generate cost lines for leaf buckets associated to the cost model, click **Generate Bucket Cost** button.

   Use this option to generate bucket amount lines for this cost model that has no data source. Cost lines are generated for each leaf bucket that has no further sub-buckets. Even if there is no amount in the bucket, the amount lines are generated in the Groomed General Ledger Data [itfm_gl_data_groomed] table, populating zero in the **Amount** column. The table displays the bucket, sub-bucket, and amount associated with the cost model for the fiscal period that you selected.

   a) Select the fiscal period in the Generate Bucket Cost dialog box.
b) Click OK.
   • If there is no amount in a bucket, the allocation engine still generates a groomed line with zero expense for the selected fiscal period of the cost model.
   • If there are pre-existing groomed lines with amounts in buckets for that fiscal period, then the engine does not overwrite those cost lines.

You can edit the **Amount** column to enter the amount for each sub-bucket.

8. To create model hierarchy using the interactive user interface, click **Build segment hierarchy** related link. Add new segments to the hierarchy or remove segments from the cost model per your requirements.

9. To replace the top segment of the selected cost model that you want to clone:
   a) Click the **Clone Model and Replace Top Segment** related link.
   b) Select a segment from the choice list of the **Clone Model and Replace Top Segment** pop-up and click **OK**.

   You can replace the top segment in the cost model with another segment of your choice. Segments that have not been used in the cost model are available for you to choose to replace the top segment of the cost model. The replacing segment is from the available segments but has not been already used in the current cost model segment hierarchy. The selected segment replaces the existing top segment and will not be an addition to the existing segment levels in the hierarchy. Replacing the top segment enables you to configure the cost model specifically for the organizational structure of your enterprise.

   **Note:** The rules such as bucket assignments, rollups, rollup overrides, breakdown relationship, unit metrics, sibling relationship, and GL segment configured for the original segment become invalid for the replaced segment. Hence, you must set these rules for the replaced top segment.

The buckets that use this cost model are shown in the **Buckets related list.**

You can also create an account bucket.

Map a unit cost metric to a segment of a cost model to generate unit costs.

The breakdown relationship to explicitly generate breakdown cost lines in the `itfm_allocation_breakdown` table for a given segment-segment mapping are shown in the **Breakdown Relationships related list.**

You can also define a sibling relationship to roll up accounts at the sibling level.

**Generate controlled cost lines**

Cost lines, generated in the `itfm_allocation_aggregate` table, were a multi-model data. With this you can view cost split in any segment combination, which did not help in performance or save the database space. Generating controlled cost lines helps you to control the allocation lines that is required for your business needs.

Role required: cost_transparency_admin

1. Navigate to **Financial Modeling > Cost Models > All.**

2. Enable the **Generate Controlled Cost Lines** check box to generate cost lines of the amount aggregated at the account level in the `itfm_allocation_aggregate` table.

3. If you require the sub-bucket information of the generated lines, then select the **Include sub-Bucket Info** check box.

   The generated controlled cost lines are sufficient to plot single dimension charts along with the buckets.
4. Define breakdown relationship explicitly to view reports on relationship between two segments.

   The engine then generates the additional breakdown allocation lines in the itfm_allocation_breakdown table, which help to plot two-dimension chart between segments. For example, IT Shared Service contribution to Business Unit.

5. Select a segment in Choose Segments for GL Expense Lines to generate GL expense lines for the segment in the itfm_allocation table.

   Note:
   This feature is only available to customers who own an ITBM Analyst license.

**Generate unit costs**

Associate a unit cost metric with a segment of a cost model hierarchy to generate unit costs. The mapping helps to derive unit cost based on the allocation lines from the Financial Modeling application.

Role required: cost_transparency_admin or cost_transparency_analyst


2. To associate the unit cost metric to a segment or an account of a segment of the cost model, click open a cost model.

3. Click the Unit Cost Metrics related list.

4. Click New.

5. On the form, fill in the fields.

   **Unit Cost Metrics form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost Model</td>
<td>Cost model from the list.</td>
</tr>
<tr>
<td>Unit Cost Segment</td>
<td>The cost model segment for which the unit cost is to be generated.</td>
</tr>
<tr>
<td>Unit Cost Metric</td>
<td>Unit cost metric that has been defined in the consumption/weight table.</td>
</tr>
<tr>
<td>Unit</td>
<td>Unit of measure for the unit cost.</td>
</tr>
<tr>
<td>Transactional table</td>
<td>Segment transactional table, which cannot be edited.</td>
</tr>
<tr>
<td>Include Bucket Info</td>
<td>Option to enable the bucket information in unit costs.</td>
</tr>
<tr>
<td></td>
<td>By default, Include Bucket Info flag is set to False. If the flag is true,</td>
</tr>
<tr>
<td></td>
<td>then the bucket information is populated in the bucket column of the Unit</td>
</tr>
<tr>
<td></td>
<td>Cost [itfm_unit_cost] table.</td>
</tr>
<tr>
<td>Unit Cost Accounts filter</td>
<td>Accounts filtered based on a criteria. Unit costs are generated only for the filtered accounts.</td>
</tr>
</tbody>
</table>

6. Click Submit.

7. Select the unit cost metric and click Generate Unit Cost Metrics.

8. Select the fiscal period in the Generate Unit Cost Metrics pop-up that appears.

   The engine has run the allocations already for the fiscal periods that appear in the list.

9. Click OK.
10. To see the unit costs, navigate to **Financial Modeling > Cost Model Lines > Unit Costs.**

The unit costs are generated and populated in the Unit Cost table. The unit costs are generated for all the filtered accounts of the Unit Cost Segment in the Unit Cost Account column of the unit cost table.

Enabling **Include Bucket Info** check box gives you a visibility of the amount coming from different buckets. You can track the bucket-wise unit cost in the bucket and sub-bucket columns of the unit cost table.

The table also shows the total cost and quantity. Based on the enforced relationship of the metric, you can further drill down from the account unit cost.

**Define a sibling rollup relationship**

Define a relationship to roll up amounts to accounts in the sibling segments. You can roll up the expenses to any account in the hierarchy, not restricting to the immediate parent or grandparent in the hierarchy.

Role required: cost_transparency_admin or cost_transparency_analyst

1. Navigate to **Financial Modeling > Cost Models > All.**
2. Click the **Sibling Rollup Relationship** tab.
3. Click **New.**
4. On the form, fill in the fields.

<p>| Sibling Rollup Relationship form |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relation Name</td>
<td>Name that is generated for the sibling relationship that you define.</td>
</tr>
<tr>
<td>From Segment</td>
<td>The segment from which the relationship is created.</td>
</tr>
<tr>
<td>To Segment</td>
<td>The segment to which the relationship is established.</td>
</tr>
</tbody>
</table>

5. Click **Submit.**

**Prerequisites to modify data source of a cost model**

Clean the cost model of its existing data source and all the data collected and accumulated in the associated tables. Follow the steps to seamlessly change the data source.

**Steps to change the data source of a cost model**

1. Remove the following data from their respective tables:
   d. The groomed records for the cost model from the Groomed General Ledger Data [ltfm_gl_data_groomed] table.
   e. The cleansed records for the cost model from the General Ledger Cleansed Data [ltfm_gl_data_cleansed] table.
   f. The records from the Cost Allocation Runs Log [ltfm_ca_run_log] table for the cost model.
2. Modify the data source of the cost model.

**Choose a cost model**

You can choose one cost model that you want to use in the workbench as you pass through all the stages.

Role required: cost_transparency_admin

- Select the cost model for the data that you want to work with from the **Cost Model** choice list in the Data Definition stage.
  
  If you do not see the cost model you want, you can [create one](#).

**Cost model hierarchy**

All the accounts belong to segments, which are structured in a cost model hierarchy.

The cost model hierarchy makes it possible for you to roll up expenses from lower-level accounts and segments to higher-level accounts and segments. For example, assume that you use the default hierarchy, which has the business service segment under the business unit segment. This rollup enables you to have the expenses that are allocated to a business service, such as email, also apply to the business units that consume the email service, one of which is commonly IT.

**Note:** Using the workbench is the preferred method of modifying the hierarchy, rather than using the Segment Relationship form. When you use the workbench to modify the hierarchy, it automatically creates all the rules and methods.

**Build segment hierarchy**

**Note:** This feature is available only when you own an ITBM Analyst license.

You can use the **Build segment hierarchy** link in the Financial Model form to create model hierarchy easily using interactive user interface as in Financial Modeling workbench. Add new segments to the hierarchy or remove segments from the cost model per your requirements.

**Allocations**

When the Financial Management application allocates an expense, it breaks down the expense into detailed amounts of money called *allocations*.

The allocations are then associated to specific segments and accounts in the Hierarchy of Segments.

To allocate expenses, the application uses the following items, which comprise your **cost model**:

**Bucket allocations**

Allocation of a particular bucket to a segment or an account in a segment using allocation methods, using the rule to calculate the breakdown of the expense, either on an equal basis, manual, or weighted.

**Segment rollups**

Defines how the amount rolls up from one segment to another segment.

**Rollup overrides**

Amount from a particular account of a segment can roll up to any account or segment in the hierarchy.

**Allocation metrics**
Contain additional instructions that the application uses to allocate expenses based on a weighted calculation or on a script. A method can use one or more metrics.

When you use the workbench to assign expenses to accounts and segments, it creates all the rules, methods, and conditions automatically.

Users with the financial management administrator or financial analyst role can administer cost allocations through the workbench, which is the preferred method, or by using lists and forms.

### Chargebacks

The application supports "chargebacks", or negative amounts in general ledger expenses that can be used to transfer credits between segments for a shared cost. Chargeback expenses process fixed amount methods in the opposite way of other expenses. For example, a fixed amount type method that allocates $50 on a $100 dollar chargeback, shown as "-100" in the general ledger expense, applies a $50 credit as specified by the rule.

### Example Allocations

The demo data provided with the application provides good examples of different types of allocations. You can make several types of allocations, such as allocating:

- Storage costs based on consumption
- Private cloud costs based on usage of virtual machines
- Servers based on cost, CPUs, location, and so on
- Project management contract costs

### Account buckets

Account buckets help you categorize cleansed expenses before you assign the expenses to accounts and segments.

Buckets can be put in parent-child relationships so that several child buckets can refer to a single parent bucket.

Buckets must also be associated with one cost model, starting with the Geneva release.

**Create an account bucket**

You can create account buckets in the workbench, but you can also create them with the Bucket form.

Role required: cost_transparency_admin

1. Navigate to **Financial Modeling > Cost Models > Buckets**.
2. Click **New**.
3. Fill out the fields on the form as appropriate (see table).
4. Click **Submit**.

<table>
<thead>
<tr>
<th>Number</th>
<th>BUC000001</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Hardware</td>
</tr>
<tr>
<td>Bucket type</td>
<td>expenses</td>
</tr>
<tr>
<td><strong>Cost Model</strong></td>
<td>Default Cost Model</td>
</tr>
<tr>
<td>Exclude from cost model</td>
<td>off</td>
</tr>
<tr>
<td><strong>Allocation metric</strong></td>
<td></td>
</tr>
</tbody>
</table>

**The Bucket form**

**Bucket form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Auto-generated identification number for the bucket.</td>
</tr>
<tr>
<td>Name</td>
<td>Descriptive name for the bucket.</td>
</tr>
<tr>
<td>Bucket type</td>
<td>The type of bucket:</td>
</tr>
<tr>
<td></td>
<td>• Selector: a split bucket</td>
</tr>
<tr>
<td></td>
<td>• Expenses: standard buckets (non-split)</td>
</tr>
<tr>
<td>Cost Model</td>
<td>The cost model associated with this bucket.</td>
</tr>
<tr>
<td></td>
<td>Select the cost model. If you open the cost model record, the buckets</td>
</tr>
<tr>
<td></td>
<td>associated with it appear in the Buckets related list. These are the</td>
</tr>
<tr>
<td></td>
<td>buckets that are available to that cost model on the Workbench when you put</td>
</tr>
<tr>
<td></td>
<td>expenses into buckets.</td>
</tr>
<tr>
<td>Exclude from cost model</td>
<td>If the bucket is not used for allocations.</td>
</tr>
</tbody>
</table>
When you put expenses into buckets, you can also add new buckets and create conditions for buckets that filter the data that goes into the bucket.

### Grooming and cleansing conditions

Grooming conditions define how expenses are related to each other and to buckets when you make changes in the workbench, while cleansing conditions define how financial data is cleansed by segment.

#### Grooming conditions

The workbench creates three types of grooming conditions:

- **Data cleansing conditions**: Defines the expense combinations that you make during the Cleansing stage. For example, if you drag the expense entry for the Acme vendor onto the Acme Inc. vendor, the application creates a grooming rule that specifies to the workbench that all those expenses should be considered as belonging to the Acme Inc. vendor. The application does not actually add, delete, or modify the expense records in the General Ledger Cleansed Data table [itm_gl_data_cleansed].
- **Bucketing conditions**: Defines which expenses you added to buckets during the Bucketing stage.
- **Advanced query conditions**: Defines which expenses are allowed to be added to buckets during the Bucketing stage. The application creates data cleansing and bucketing conditions automatically when you use the workbench. The only type of grooming condition that you create manually, either through the form view or through the workbench, is the advanced query condition.

#### Cleansing conditions

The application creates cleansing conditions when you merge expenses in the cleansing stage of the workbench. You do not need to modify these cleansing conditions.

**Modify advanced query conditions**

You can modify existing advanced query conditions, which define how expenses are added to buckets.

Role required: cost_transparency_admin

**Note:** Grooming conditions are automatically created in the workbench.

1. Navigate to **Financial Modeling > Cost Models > Grooming Conditions**. The resulting list of records is filtered to show only advanced query conditions.
2. Click the grooming condition number to open it.
3. Modify the fields on the form as appropriate (see table).
4. Click **Update**.

![ITFM Grooming Condition - Hardware Expense by Account Names](image)

**Example grooming condition**

**Example grooming conditions**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Auto-generated identification number for the bucket.</td>
</tr>
<tr>
<td>Name</td>
<td>Descriptive name for the bucket.</td>
</tr>
<tr>
<td>Priority</td>
<td>A code for the bucket that the system uses to identify it. Enter any alphanumerical code. Bucket codes cannot have duplicates.</td>
</tr>
<tr>
<td>Description</td>
<td>If the bucket is not used for allocations.</td>
</tr>
<tr>
<td>Bucket</td>
<td>The buckets that use this bucket as a parent. To create a sub-bucket, click <strong>New</strong> and fill out the fields on the form. The fields are the same as on the <strong>Parent bucket</strong> field is visible.</td>
</tr>
<tr>
<td>Condition Type</td>
<td>The type of grooming condition. Select <strong>Advanced Query condition</strong>.</td>
</tr>
</tbody>
</table>
### Expense allocation

Expense allocation refers to the assignment of expenses to accounts in the hierarchy of segments. You can allocate expenses by applying rules to groomed expenses in the general ledger. The methods and metrics in the rules specify how the expenses are allocated. See Allocations for more information on how rules, methods, and metrics work.

### Reversions and Reallocations

After a groomed expense in the general ledger is allocated, it cannot be allocated again unless the original allocation is reverted. You should revert allocations if changes to allocation rules, methods, or metrics are made and the general ledger expenses must be reallocated according to the modifications. In addition, if you make changes to the hierarchy of segments, all expenses need to be reverted first.

**View allocation lines**

After you complete an allocation, you can view the allocation lines that the application created.

Role required: cost_transparency_admin

1. Open the allocation line that you want to modify through either of the following methods:
   - To access an allocation through the general ledger that created it:
     a) Navigate to Financial Modeling > General Ledger > Groomed Expenses.
     b) Open the expense that generated the allocation you are looking for.
     c) In the Cost Allocations related list, click the allocation number.

   - To access an allocation from a list of all allocations:
     a) Navigate to Financials > Cost Models > Allocation Lines.
     b) Click the allocation number.

2. Verify or change any of the editable fields on the form (see table).

---

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>The table containing the expenses that are filtered when put into the bucket. By default, the General Ledger Cleansed Data [itfm_gl_data_cleansed] table is selected. Do not change the table.</td>
</tr>
<tr>
<td>Advanced bucketing condition</td>
<td>The condition that determines the financial data that must meet the advanced query condition. Use the condition builder to create the filter.</td>
</tr>
</tbody>
</table>
3. **Click Update.**

![Allocation Line Example]

**An example allocation line**

---

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
## Cost Allocation form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amount</td>
<td>The amount of this allocation.</td>
</tr>
<tr>
<td>Fiscal period</td>
<td>The fiscal period this expense belongs in.</td>
</tr>
<tr>
<td>GL Entry</td>
<td>The groomed expense from which this allocation line was derived.</td>
</tr>
<tr>
<td>Final</td>
<td>If the allocation line was processed by a rule that is marked final or if no subsequent rule can process this allocation. Reports are run on final allocation lines.</td>
</tr>
<tr>
<td>Bucket</td>
<td>The bucket that the allocation belongs to. This bucket is taken from the expense during allocation.</td>
</tr>
<tr>
<td>Sub-bucket</td>
<td>The sub-bucket that the allocation belongs to. The sub-bucket is also taken from the expense during allocation.</td>
</tr>
<tr>
<td>[Dimensions]</td>
<td>The segments in the hierarchy of segments. The segments fields that contain values are the segments that you specified in the allocation methods that processed the allocation. If more than one method processes an allocation, all the allocated segments specified in all the methods contain a value. To make a change, click the lookup icon next for each dimension and select the relevant record.</td>
</tr>
</tbody>
</table>

---

### Delete allocation lines

On the Configuration tab of the workbench, you can delete the allocation lines for any fiscal period if you no longer need this data, or if you need to make changes to segments or fiscal periods that are already associated with allocation lines.

Role required: cost_transparency_admin or cost_transparency_analyst

1. Open the workbench and go to the Configuration tab.
2. Under Advanced Actions, next to Delete Data For, select the fiscal period.
3. Click Delete.
4. Confirm the action.

---

### Financial Management example allocations

The demo data that is available with the Financial Management application provides examples of cost allocations that you can use to model allocation rules, methods, and metrics.

#### Allocate by number of servers

This weighted allocation metric allocates to servers based on the server cost.

- **Metric name**: Servers by Server cost
- **Type**: weighted
Notice the following field values:

- **Weight table** is the Server table in the CMDB.
- **Reference to allocate to** is the field on the weight table that you are allocating to. In this case, you are allocating to individual servers that are identified by their sys_id.
- **Aggregate** takes the value of the **Aggregate count** field in the weight table, which in this case is **Cost**.
- **Aggregate count** is the cost of each server, which is identified on the server record.
Create weighted metrics to allocate expenses based on an aggregate value of a field on another table. You can also enforce a relationship between tables. A graphical representation of the weighted metric is available at the bottom.

**Name:** Servers by Server cost

**Allocation group:** ITOM

### Cost Allocation

Choose the primary segment to allocate to. Select Apply filter to add a filter condition.

- **Allocate to:** Server

### Weight Table

Select a table to weight the metric. Select Apply filter to add a filter condition.

- **Weight table:** Server [cmdb_ci_server]
- **Reference to allocate to:** Sys ID
- **Aggregate:** Value of
- **Aggregate field:** Cost

### Relationship

You can enforce one of these relationship types between the allocate from table and the allocate to table:

- A reference from the Allocate from table to the Allocate to table.
- A reference from the Allocate to table to the Allocate from table.
- A reference from an intermediary table to both the Allocate from and Allocate to tables.

### Allocation Metric Visualization

This is a visual representation of the relationship between the tables.
Metric weight maps

Weight maps are generated for each metric for every fiscal unit set in com.glide.fiscal_calendar.fiscal_unit property.

Weight map is JSON that holds the weighted breakups to allocate accounts for a metric. Allocation or rollup based on weighted metrics works only if correct weight map is generated for a given fiscal period.

The Preview Weight Map (also available from the application navigator) in the Weighted Metric Builder form shows how the weight is split across the accounts for a given fiscal period. The Weight Map Preview list view shows the total number of weights and the date and time the weight map was last generated. You can also view the percentage split for each account breakdown and generate or regenerate the weight map in the Preview Weight Maps user interface if the current weight map is not correct or has not generated.

Pre-generated weight maps for the fiscal period also helps in the performance of allocation workbench to avoid generating weight maps spontaneously while allocation page is still in the process of loading.

Following is an example to understand weight maps and percentage allocation if metric is used:
Metric Visualization
This is a visual representation of the relationship between the tables.

Cost Allocation
Choose the primary segment to allocate to. Select Apply filter to add a filter condition. Use Enforce Lifespan option to specify the fields that define start time and end time of a primary segment account. Without this option, the metric will by default consult Data Mart to retrieve transient primary segment accounts.

Weight Table
Select a table to weight the metric. Select Apply filter to add a filter condition. Use Enforce Lifespan option to specify the fields that define start time and end time of a weight table account. Without this option, the metric will by default consult Data Mart to retrieve transient weight table accounts.

Intermediary Segment
Select an intermediary segment.

Enforce Intermediary segment: [ ]
- Intermediary Segment: Department
- Intermediary segment reference to weight table: No Reference
- Aggregate: Count
Use cost analysis to view the allocation of amount

Use cost analysis for a specific cost model for a fiscal period to view the cost lines using a UI similar to allocation workbench. Cost analysis helps you to view the bucket amount, the amount allocated to accounts, and the rolled up amount across segments and accounts based on the cost lines generated by the allocation engine.

Role required: cost_transparency_admin or cost_transparency_analyst

You can view allocations made for the previous fiscal periods without any interference of allocation or rollup rules defined for the current cost model because cost analysis is based purely on cost allocation lines.

Cost analysis is an effective showback reporting tool that you can use to view the allocated costs. After running the allocation engine, analysts can use cost analysis to validate if the allocation rules have allocated the expected amount.
• Navigate to **Financial Modeling > Workbench**.
  
  You can also navigate to **Financial Modeling > Cost Analysis**.
The Cost Lines Analysis page has the following key features:

- The buckets, accounts, and their amount based on the generated cost lines.
- The consolidated buckets amount allocated to accounts.
- The segment level consolidated amount for all accounts in that segment.
- The bucket icon

and relationship icon

function in the same way as the Workbench page, but are based on generated cost lines.

- Allocation viewer

for accounts and buckets shows how the amount has been rolled up.

- Configure to display 5, 10, 15, 25, or 50 accounts in a page out of the total accounts per segment. The pagination option that you set in the Configuration tab displays the selected number of accounts of a segment in the Cost Lines Analysis page. The right and left arrows enable you to navigate to the next set of records until all the accounts in the segment are displayed.

Allocation metrics

Allocation metrics contain additional instructions that the application uses to allocate expenses based on a weighted calculation or on a script. Allocation methods use metrics to perform the allocation.

Following are the types of metrics that are available:

- **Weighted metrics** are calculations based on an aggregate value from a segment. Use weighted metrics to influence how much of an expense is allocated to a segment based on other records in the instance, such as the number of servers used by a segment or the value of depreciation on an asset. Users with the Finance Administrator role can create weighted metrics.

- **Scripted weighted metrics** are weighted metrics in script form.

- **Scripted methods** are calculations based on customizable scripts that use the allocation method API. These metrics were formerly called as scripted metrics.

- **System metrics** are metrics that the application creates automatically when you use the workbench. These metrics are read-only and accessible by users with the Finance Administrator role. See the Using the Workbench topics for more information.

**Note:** When you use the workbench to assign expenses to accounts and segments, it creates all the rules, methods, conditions, and so on automatically. Using the workbench is the preferred method of setting up allocations, rather than using lists and forms.

Starting with the Geneva release, fiscal periods are supported in metrics.

**View, modify, and validate fiscal periods**

After you generate a fiscal calendar, you can view fiscal period records, modify the start and end date, deactivate a fiscal period if necessary, and validate.

Role required: fiscal_calendar_user

1. Navigate to **System Definition > Fiscal Periods**.
2. Open any of the fiscal periods (see table for field descriptions) to view, modify, or deactivate.

**Fiscal period form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the fiscal period.</td>
</tr>
<tr>
<td>Start date time</td>
<td>Date the fiscal period starts.</td>
</tr>
<tr>
<td>End date time</td>
<td>Date the fiscal period ends.</td>
</tr>
<tr>
<td>Fiscal Type</td>
<td>[Read-Only] Type of period, either <strong>Year</strong> or <strong>Quarter</strong>.</td>
</tr>
</tbody>
</table>

3. Validate the fiscal periods to ensure that there are no gaps and that they match a valid style of calendar.
   a) To validate, return to the list view of fiscal periods and click **Validate Periods**.

**Create weighted allocation metrics**

You can create weighted metrics using an enhanced form or a standard form.

Role required: cost_transparency_admin

The enhanced form provides a visualization that helps you understand the relationships between the various components of the metric. Use the enhanced form that opens by default.

1. Navigate to **Financial Modeling > Consumption Metrics > Create Weighted Metric**.
2. On the form, fill in the fields.

A graphical representation of the weighted allocation appears in the Metric Visualization section. When you make changes to the form the graphic updates dynamically.
Metric Visualization
This is a visual representation of the relationship between the tables.

Cost Allocation
Choose the primary segment to allocate to. Select Apply filter to add a filter condition. Use Enforce lifespan option to specify the fields that define start time and end time of a primary segment account. Without this option, the metric will by default consult Data Mart to retrieve transient primary segment accounts.

Weight Table
Select a table to weight the metric. Select Apply filter to add a filter condition. Use Enforce lifespan option to specify the fields that define start time and end time of a weight table account. Without this option, the metric will by default consult Data Mart to retrieve transient weight table accounts.

Intermediary Segment
Select an intermediary segment. Select Apply filter to add a filter condition. Use Enforce lifespan option to specify the fields that define start time and end time of an intermediary segment account. Without this option, the metric will by default consult Data Mart to retrieve transient intermediary segment accounts.
## Weighted Metric form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive name of the metric.</td>
</tr>
<tr>
<td>Allocation group</td>
<td>Group associated with this metric. The default group is ITSM.</td>
</tr>
<tr>
<td>System metric</td>
<td>Metric created by the application in the workbench.</td>
</tr>
<tr>
<td>Refresh frequency</td>
<td>Frequency at which the data is refreshed.</td>
</tr>
<tr>
<td>Cost Allocation</td>
<td>Segment in the hierarchy to which allocations are processed. You can access fields in related tables and the reference to the chain of field names separated by dots can go on up to any number.</td>
</tr>
<tr>
<td>Apply filter (Cost Allocation)</td>
<td>Check box to display the condition builder. Specify the criteria that the selected Allocate to segment field must be met for this metric to apply. The fields available for the first part of the condition depend on the table you select for Allocate to. The condition builder supports dot walking, so you can select fields on another table.</td>
</tr>
<tr>
<td>Weight Table</td>
<td>The table used to weight the allocation amounts based on aggregations.</td>
</tr>
<tr>
<td>Weight table</td>
<td>The field on the weight table that refers to the Allocate from segment. This field is available when the Enforce relationship check box is selected. You can access fields in related tables and the reference to the chain of field names separated by dots can go on up to any number.</td>
</tr>
<tr>
<td>Reference to allocate from</td>
<td>The field on the weight table that refers to the Allocate to segment. You can access fields in related tables and the reference to the chain of field names separated by dots can go on up to any number.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Aggregate                        | The type of aggregation to perform on the records in the weight table. Select from the following options:  
  • **Count**: A count of the number of records in the weight table that meet the weight condition.  
  • **Value of**: The value of the selected field.  
  • **Sum**: The sum of the values in the table for the selected field.  
  • **Average**: The average of the values in the table for the selected field.  
  • **Min**: The minimum value in the table for the selected field.  
  • **Max**: The maximum value in the table for the selected field. |
| Aggregate field                  | The field on the weight table that is used for the aggregate calculation. This field is available when any aggregate other than **Count** is selected. |
| Apply filter (Weight Table)      | Check box to display the condition builder. If the condition must be met before the application can allocate expenses using the weight table. |
| Intermediary Segment             | Option to enforce intermediary segment. |
| Intermediary Segment             | Segment that is identified as intermediary segment, which is not included in cost model hierarchy. |
| Intermediary segment reference to weight table | Relationship of the intermediary segment with the Allocate to segment, defined and referenced in the weight table. |
| Aggregate                        | Type of aggregation performed on the records in the weight table. |
| Relationship                      | Limits the segments that this metric allocates to based on an existing relation to another segment. |
| Allocate from                    | The table from which allocations are processed. This field is available when the *Enforce relationship* check box is selected.  
  You can access fields in related tables and the reference to the chain of field names separated by dots can go on up to any number. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relation type</td>
<td>The type of relationship between the Allocate from table and the Allocate to table.</td>
</tr>
<tr>
<td></td>
<td>• Allocate from: A reference from the Allocate from table to the Allocate to table.</td>
</tr>
<tr>
<td></td>
<td>• Allocate to: A reference from the Allocate to table to the Allocate from table.</td>
</tr>
<tr>
<td></td>
<td>• Intermediary: A reference from an intermediary table to both the Allocate from and Allocate to tables.</td>
</tr>
<tr>
<td>Relationship field from</td>
<td>The field on the Allocate from table to allocate from. This field is available when the Enforce relationship check box and the Allocate from relationship type are selected.</td>
</tr>
<tr>
<td>Relationship field to</td>
<td>The field on the Allocate to table to allocate from. This field is available when the Enforce relationship check box and the Allocate to relationship type are selected.</td>
</tr>
<tr>
<td>Apply filter (Relationship)</td>
<td>Condition must be met before the application can do one of the following actions:</td>
</tr>
<tr>
<td></td>
<td>• Allocate expenses using the Allocate from table if you select the Allocate from relationship type</td>
</tr>
<tr>
<td></td>
<td>• Allocate expenses using the Intermediary table if you select the Intermediary relationship type</td>
</tr>
<tr>
<td></td>
<td>Then select this check box to display the condition builder.</td>
</tr>
<tr>
<td>Intermediary table</td>
<td>Table that is used between the Allocate from and Allocate to tables to connect them. This field is available when the Enforce relationship check box and the Intermediary relationship type are selected.</td>
</tr>
<tr>
<td>Intermediary table field from</td>
<td>The field on the intermediate table that maps to the Allocate from table. This field is available when the Enforce relationship check box and the Intermediary relationship type are selected.</td>
</tr>
<tr>
<td></td>
<td>You can access fields in related tables and the reference to the chain of field names separated by dots can go on up to any number.</td>
</tr>
<tr>
<td>Intermediary table field to</td>
<td>Field on the intermediate table that maps to the Allocate to table. This field is available when the Enforce relationship check box and the Intermediary relationship type are selected.</td>
</tr>
<tr>
<td></td>
<td>You can access fields in related tables and the reference to the chain of field names separated by dots can go on up to any number.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
Allocate from table condition filter | Criteria that the records in the Allocate from table must meet for this metric to apply. These fields are available when the Enforce relationship check box, the Allocate from relationship type, and Apply filter check box are selected.
Intermediate table condition filter | The criteria that the records in the intermediate table must meet for this metric to apply. This field is available when the Enforce relationship check box, the Intermediary relationship type, and Apply filter check box are selected.
Preview weight map | Weight Map is generated for the selected metric and the fiscal period. The preview lists the weight map review with total number of weights and the last generated date and time.
Fiscal period choice list | The fiscal period from the fiscal calendar.
Segment choice list | The account in the rollup segment.
Total Weight Table | Enforce allocation from total weight
Total weight table | Check box to enable enforce allocation from total weight.
Table from which the actual consumption values are retrieved.
Related Links | View standard form
Switches between the advanced form and the standard form.
Related Lists | Cost Allocation Methods
The allocation methods that this rule uses to break down expenses.
Cost Allocations | The allocation lines that this rule created.

**Note:** You cannot delete a rule that is referenced by a locked allocation line.

**Enforce allocation from total weight** is an allocation metric based on capacity. As an IT financial analyst, you can also allocate cost where the total capacity of a service is greater than the sum of what is consumed. To enable this option, you must select the Enforce allocation from total weight check box in the Total weight table section. Select a total weight table to calculate the total weight of metric based on the total consumption capacity. The weighted metric allocates cost based on the total number of available units of consumption.

**Note:** You can either enforce allocation relationship or enforce allocation from total weight. Enforce total weight if the total allocation is greater than the sum of the consumed values. Whereas, enforce allocation relationship works when the sum of all consumption values (of all individual entities) in the weight table adds up to a total capacity of 100%. For more information, see Total weight support for allocations using weighted metric.

**Intermediary Segment** option: Use this option when you have a segment with large number of accounts that add to numerous allocation lines. Nevertheless, the intermediary segment is still
considered for the amount to rollup through it for proper allocation. However, the segment identified as intermediary is not included in the hierarchy of cost model and its allocation lines are not generated.

The option to identify a segment as an intermediary segment is just to exclude the segment in the generation of multiple cost lines. However, you should create a metric based on the relationship between the intermediary segment and the Allocate to segment to include the segment for accurate amount rollup. Based on the relationship the allocation engine creates the weight, and based on the weight the allocation lines are generated for the intermediary segment.

You must create a cost allocation metric to process the weight of the intermediary segment that is referenced in the weight table. Two sets of weight maps are generated, one for the intermediary segment and another for the Allocate to segment.

3. Click Submit.

To preview the weight map that you created, click the Preview Weight Map button.

**Preview weight map**

You can preview a weight map to give you visibility of the generated metric weight map because it displays the accounts for the selected metric and the selected fiscal period with the percentage split for each account.

Role required: cost_transparency_admin or cost_transparency_analyst

The Allocation workbench displays the expense summary for all months, quarters, or periods when you run the allocation and the window becomes cluttered with data for all quarters. To overcome the UI page clutter, you can preview the weight map in its own page.

   a. Alternatively, you can navigate to Financial Modeling > Consumption Metrics > All Metrics.
   b. Click a cost allocation metric to open the Weighted Metric Builder.
   c. Click Preview Weight Map.

2. Select a metric from the Metric list in the left pane.
3. Select a fiscal period from the Fiscal Period list.
4. Click Generate.
   The right pane displays the generated date and time details, the accounts, their respective weights, the total weight, and the percentage split. You can regenerate the weight map to preview each month or a quarter of a fiscal period.
5. Click Generate or Generate All based on the metric that you have selected:
   • Click Generate to roll up an account of a segment to a segment above in the hierarchy. Based on the metric that you have selected the amount is divided between the accounts of that rolled up segment.
   • The Generate All button is enabled if you select a metric that defines rolling up of all the accounts individually in a segment using the Enforce Relationships option in the metric definition to one or more accounts of a segment above in the hierarchy.

**Create scripted allocation metrics**

You can create scripted metrics and methods using the standard Cost Allocation Metric form.

Role required: cost_transparency_admin

You can create weighted metrics in scripted form and scripted methods Allocation metrics for more information.

2. Click **New**.
3. Select **Scripted weighted metric** or **Scripted method** in the **Type** field.
4. Fill out the fields on the form as appropriate (see table).
5. Click **Submit**.

---

**Example scripted metric**

**Scripted metric form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive name of the metric.</td>
</tr>
<tr>
<td>Allocation group</td>
<td>The group associated with this metric. On the Cost Allocation Method form, the selection of the group limits the selection of the metric to only those metrics that use the group.</td>
</tr>
<tr>
<td>System metric</td>
<td>If this metric was created by the application in the workbench.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of script. Select <strong>Scripted method</strong> or <strong>Scripted weighted metric</strong> to make the <strong>Script</strong> field appear.</td>
</tr>
<tr>
<td>Script</td>
<td>The script to calculate the allocation.</td>
</tr>
<tr>
<td>Related List</td>
<td>Methods that use the metric. You can add methods to the related list or navigate to the method form and select the metric you just created.</td>
</tr>
</tbody>
</table>

**Note:** You cannot delete a rule that is referenced by a locked allocation line.
Financial Charging

Financial charging is an integral part of financial management that helps in reporting the financial aspects of a business service to various stakeholders in the organization that consume the service such as the business unit heads, department heads, or account heads.

Note: This feature is available only when you own an ITBM Analyst license.

Watch this four-minute video to learn more about Financial Charging in ServiceNow.

A business service is a set of interconnected applications and hosts configured to offer service either within or to an organization. Track the consumed business services and products offered within your organization and show the cost of the services as showback statements. The showback statement reports the services consumed in terms of their cost, for reporting to the business unit heads.

The showback statements provide consumption visibility and improve automation of the services offered. These statements also help the service owners handling the services to view the consumption data and formulate budgeting.

Showback statement reports the services consumed through the statement items that are records of the service consumption details and the cost of the service. These record details are stated as the statement items and are retrieved from various sources such as:

- **Consumption table**: The cost and the consumption volumes can be from any platform table that contains the consumption data.
- **Cost model**: The source of the cost data is the cost allocation lines from the Financial Modeling application.
- **Service catalog**: The cost and consumption volumes can be based on fulfilled catalog requests for a particular service catalog category or catalog items.

What to do next

Assign roles to your users. Set up the Financial Charging application to use the showback feature.

Financial charging application setup

There are several components of the Financial Charging application that you must set up before you can use the showback feature for a business service.

Note: This feature is available only when you own an ITBM Analyst license.

What to do next

As a first step you must define a service. Based on the service that you offer and the utilization of the service, the showback statement is generated for a fiscal period, as a report, for the business unit that utilized the service.

To measure the business services utilized and the resources used in terms of cost, the showback statement uses statement items. Statement items capture the source from where the cost details must be retrieved. Determine the type of the statement item, which in turn determines the source from where the cost data is retrieved.
Determine the statement item type

Determine the type of statement item as a first step to create a statement item. Or, you must determine the source from where the consumption or usage details and the cost of consumption data is retrieved.

Role required: service_charging_analyst

Note:
This feature is available only when you own an ITBM Analyst license.

Consumption Statement Item

The cost of the consumption statement item is generated every fiscal period from any platform table that contains the consumption data. Cost information could also come from the same table or can be applied from a rate card.

Cost Model Statement Item

The cost model statement item retrieves the allocated unit cost data from the Financial Modeling application.

Service Catalog Statement Item

You can derive the cost, consumption volumes, and consumption details of an item from the Requested Item (sc_req_item) table in service catalog.

1. Navigate to Financial Charging > Administration > Statement Items.
2. To create a statement item, click New, or click the name of an existing statement item that you want to edit in the Statement Items list.
3. Select the type of statement item you want to create.

Define a statement item depending on the source where your consumption data is available.

What type of Statement Item? form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Consumption Statement Item</td>
<td>Link to create a consumption statement item.</td>
</tr>
<tr>
<td>Cost Model Statement Item</td>
<td>Link to create a cost model statement item.</td>
</tr>
<tr>
<td>Service Catalog Statement Item</td>
<td>Link to create a service catalog statement item.</td>
</tr>
</tbody>
</table>

Define a consumption statement item

If your cost and business service usage details are sourced from an external consumption table, then you can source the consumption details of the consumption table for the statement item.

Role required: service_charging_analyst

Note:
This feature is available only when you own an ITBM Analyst license.

Business service consumption details can come from a table belonging to one or other platform applications or from an external consumption table, in which case the consumption details can be loaded on to the platform table. The consumption table gives you the daily or monthly consumption details of a
business service. Based on the usage, the cost of the service is computed using the unit cost and quantity consumed for a fiscal period.

For example, the monthly utility bill for household power consumption has details of the appliances that you run and the power consumed in Watts, calculated monthly and annually. Based on the unit price and the consumption quantity, the bill amount is generated.

1. Navigate to **Financial Charging > Administration > Statement Items**.
2. In the Statement Items list, click **New**.
3. In the What type of Statement Item? query form, click the **Consumption Statement Item** link.
4. On the form, fill in the fields.

### Consumption Statement Item form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the consumption statement item.</td>
</tr>
<tr>
<td>Consumption table</td>
<td>Source table that has the consumption data, which is configured as the statement item.</td>
</tr>
<tr>
<td>Consumption item</td>
<td>The item for which the consumption data is held in the consumption table.</td>
</tr>
<tr>
<td>Consumed date</td>
<td>The column in the consumption table that has the consumed date details.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to make the statement item active.</td>
</tr>
<tr>
<td>Business Service</td>
<td>Business service that uses the statement item as a configured item.</td>
</tr>
<tr>
<td></td>
<td>You can also define a service.</td>
</tr>
<tr>
<td>Fiscal unit</td>
<td>Fiscal unit should be a month, quarter, or a period based on the fiscal calendar for which the consumption data is generated.</td>
</tr>
<tr>
<td>Aggregate</td>
<td>Consumption table is queried based on the aggregate function you select.</td>
</tr>
<tr>
<td>Description</td>
<td>Short description of the statement item.</td>
</tr>
<tr>
<td>Consumption table filter</td>
<td>Filter to display the items that meet your conditions.</td>
</tr>
<tr>
<td>Amount</td>
<td>Select the criterion to determine the price.</td>
</tr>
<tr>
<td>Price basis</td>
<td>• Amount retrieves the data from the selected Amount field of the consumption table.</td>
</tr>
<tr>
<td></td>
<td>• Ratecard class is based on the pricing policy that is set for the statement item.</td>
</tr>
<tr>
<td></td>
<td>• Unit price is the cost per unit of the item.</td>
</tr>
<tr>
<td>Amount field</td>
<td>Amount data is taken from the selected field if the Price basis is amount.</td>
</tr>
<tr>
<td>Ratecard class</td>
<td>Rate card class.</td>
</tr>
<tr>
<td>Consumption table ratecard mapping field</td>
<td>Amount is derived based on the consumption table ratecard mapped field and the rate card item mapping field, if you select Ratecard class in the Price basis field.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Rate Card Item mapping field</td>
<td>Amount is derived based on the rate card item mapping field and consumption table ratecard mapping field, if you select <strong>Ratecard class</strong> in the <strong>Price basis</strong> field.</td>
</tr>
</tbody>
</table>
| Service Charging            | User who owns the business service and views the consumption statement items.  
As a service owner, you can manage the showback items. You can view the unit cost, cost recovery based on consumption, and set unit price, discount, or surcharge to the showback item. |
| Pricing policy              | Set the pricing policy for the statement item at the statement item level, statement item breakdown level, or at the item level.  
If you set the pricing policy at the statement item level, the price adjustment that you do as a service owner reflects the adjusted price at the statement item level. Similarly, for the statement item breakdown and the item levels, the price adjustment is reflected at the respective levels. |
| Pricing policy method       | Set the price adjustment based on a percentage of the average unit cost of the catalog item. Or, override the average unit cost by setting a price per unit for the item.  
**Note:** If the pricing policy is at the item level, then you can opt for the percentage-based pricing policy method. |

5. Click **Submit**.
6. To generate the charge lines for the consumption statement item, click **Generate Charge Lines**.  
a) To generate the charge lines, enter the fiscal period in the Generate charge lines dialog box.  
b) Click **OK**.
7. To save the updated record, click **Update**.
8. To delete a record, click **Delete**.

To create breakdown records for the consumption statement item, click **New** in the Consumption Breakdowns related list.

Create consumption breakdowns  
Create consumption breakdown records to make your showback report more detailed by reporting the expense line accounts that comprise the consumption statement item.  
Role required: service_charging_analyst

**Note:**  
This feature is available only when you own an ITBM Analyst license.
For example, a storage service invoice can provide the consumption details of individual items such as Tier I, Tier II, and Tier III storage. Each of these items provides the associated cost calculated that is based on the unit cost of each item.

1. Click **New** in the Consumption Breakdowns related list to create breakdown records for the consumption statement item.
2. Fill in the form fields.

### Consumption Breakdown form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the consumption breakdown.</td>
</tr>
<tr>
<td>Table</td>
<td>Defaults to the table from where the data is retrieved.</td>
</tr>
<tr>
<td>Condition</td>
<td>Filters data that fulfill the condition from the table.</td>
</tr>
</tbody>
</table>

3. Click **Submit** to save the record.

**Define a cost model statement item**

The cost of the item or service is derived from the allocation lines of financial modeling application. The statement item captures the cost from the segment accounts, specific accounts in a segment, or buckets in an account, which gives you the cost of the statement item for a fiscal period.

Role required: service_charging_analyst

**Note:**

This feature is available only when you own an ITBM Analyst license.

1. Navigate to **Financial Charging > Administration > Statement Items**.
2. Click **New** in the Statement Items list.
3. Click **Cost Model Statement Item** link in the What type of Statement Item? query form.
4. Fill in the form fields.

### Cost Model Statement Item form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the cost model statement item.</td>
</tr>
<tr>
<td>Cost model</td>
<td>The cost model used in the Financial Modeling application from which the cost data are retrieved for the statement item.</td>
</tr>
<tr>
<td>Unit cost metric</td>
<td>Calculates unit cost based on the weighted metric.</td>
</tr>
<tr>
<td>Segment</td>
<td>Segment for which cost is to be reported.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable the check box to make the cost model statement item active.</td>
</tr>
<tr>
<td>Business service</td>
<td>Business service that uses the statement item as a configured item.</td>
</tr>
</tbody>
</table>

You can also **define a service**.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fiscal unit</td>
<td>Defines the fiscal unit to be a month, quarter, or a period. Defaults based on the selected cost model.</td>
</tr>
<tr>
<td>Transactional table</td>
<td>Name of the transactional table that the segment refers to. Defaults based on the selected segment.</td>
</tr>
<tr>
<td>Description</td>
<td>Short description of the statement item.</td>
</tr>
<tr>
<td>Filter Criteria</td>
<td></td>
</tr>
<tr>
<td>Segment accounts filter</td>
<td>Filter conditions to report on the segment accounts that meet your conditions.</td>
</tr>
<tr>
<td>Buckets Filter</td>
<td>Filter condition to the buckets that allocate expenses to the accounts in the segment.</td>
</tr>
<tr>
<td>Sub Segment</td>
<td></td>
</tr>
<tr>
<td>Sub Segment</td>
<td>Secondary segment for the segment you selected. Sub segments are segments under the selected segment in the cost model hierarchy.</td>
</tr>
<tr>
<td>Transactional table</td>
<td>Name of the transactional table that the sub segment refers to. Defaults based on the selected sub segment.</td>
</tr>
<tr>
<td>Sub Accounts Filter</td>
<td>Filter conditions to report on the segment accounts that meet your conditions.</td>
</tr>
<tr>
<td>Service Charging</td>
<td></td>
</tr>
<tr>
<td>Service owner</td>
<td>User who owns the service and who views the consumption statement items. As a service charging owner, you can manage the showback items. You can view the unit cost, cost recovery based on consumption, and set unit price, discount, or surcharge to the showback item.</td>
</tr>
<tr>
<td>Pricing policy</td>
<td>Pricing policy can be set for the statement item at any of the following levels:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Statement item level</strong>: The price adjustment that you do in the console reflects at the statement item level.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Statement item breakdown level</strong>: Reflects the adjusted price at the statement item breakdown level.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Account level</strong>: The adjusted price is reflected at the account level in the expense lines.</td>
</tr>
</tbody>
</table>
5. Click Submit.
6. To generate charge lines for the cost model statement item, click Generate Charge Lines.
   a) To generate the charge lines, enter the fiscal period in the Generate charge lines dialog box.
   b) Click OK.

   The statement lines generated for showback are extension of the expense lines.

   7. To save the updated record, click Update.
   8. To delete a record, click Delete.

To create breakdown records for the cost model statement item, click New in the Cost Model Breakdowns related list.

Create cost model breakdowns
Create breakdowns for the cost model statement item providing more clarity by reporting the components that constitute the cost model statement item and the cost associated with each of these components.

Role required: service_charging_analyst

Note:
This feature is available only when you own an ITBM Analyst license.

For example, Electronic Messaging statement item can provide the breakdown details of its component services such as Data Network and Storage. Each of these items provides the associated cost calculated by the set unit cost of each item.

1. Click New in the Cost Model Breakdowns related list to create breakdown records for the cost model statement item that you created.
2. On the form, fill in the fields.

Cost Model Breakdown form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the cost model breakdown.</td>
</tr>
<tr>
<td>Statement item</td>
<td>Header under which the consumption details of the business service appear.</td>
</tr>
<tr>
<td>Table</td>
<td>Name of the transactional table the segment refers to.</td>
</tr>
<tr>
<td>Unit cost metric</td>
<td>Allocation metric that is used to calculate the unit cost.</td>
</tr>
<tr>
<td>Segment accounts filter</td>
<td>Filter applied to data in the segment accounts.</td>
</tr>
</tbody>
</table>
3. Click **Submit**.

**Define a service catalog statement item**

A business service can be represented by a service catalog category or a catalog item. When a service request from the service catalog is fulfilled, the price listed for the service in the service catalog item is captured as the cost of the statement item for a fiscal period.

Role required: service_charging_analyst

**Note:**

This feature is available only when you own an ITBM Analyst license.

1. Navigate to **Financial Charging > Administration > Statement Items.**
2. Click **New.**
3. Click **Service Catalog Statement Item.**
4. On the form, fill in the fields.

**Service Catalog Statement Item form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the service catalog statement item.</td>
</tr>
<tr>
<td>Business Service</td>
<td>Business service that uses the statement item as a configured item.</td>
</tr>
<tr>
<td></td>
<td>You can create a service.</td>
</tr>
<tr>
<td>Catalog</td>
<td>Catalog on which the statement item should be reported. Shows the list of</td>
</tr>
<tr>
<td></td>
<td>catalogs in the system.</td>
</tr>
<tr>
<td>Category</td>
<td>Catalog items under the selected Category that are used for reporting the</td>
</tr>
<tr>
<td></td>
<td>consumption details.</td>
</tr>
<tr>
<td>Catalog item</td>
<td>Catalog items under the selected Catalog and Category for which the</td>
</tr>
<tr>
<td></td>
<td>consumption is reported.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to make the service catalog statement item active.</td>
</tr>
<tr>
<td>Fiscal Unit</td>
<td>Fiscal unit should be a month, quarter, or a period based on the fiscal</td>
</tr>
<tr>
<td></td>
<td>calendar for which the statement item is generated.</td>
</tr>
<tr>
<td>Description</td>
<td>Short description of the statement item.</td>
</tr>
<tr>
<td>Service Charging</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Service owner</td>
<td>User who owns the business service and who views the service catalog statement items. A service owner can manage the showback items, view the unit cost, cost recovery based on consumption, and set unit price, discount, or surcharge to the showback item.</td>
</tr>
</tbody>
</table>
| Pricing policy      | Pricing policy can be for the statement item at any of the following levels:  
  - **Statement item level**: The adjusted price reflects at the statement item level.  
  - **Statement item breakdown level**: The adjusted price reflects at the statement item breakdown level.  
  - **Catalog item level**: The adjusted price reflects at the individual catalog item level in the expense lines. |
| Pricing policy method | Price adjustment based on a percentage of the average unit cost of the catalog item. Or, overriding the average unit cost by unit price pricing policy method. |

**Note:** If the pricing policy is at catalog item level, then you can opt for percentage-based pricing policy method.

5. Click **Submit**.
6. To generate charge lines for the service catalog statement item, click **Generate Charge Lines**.
   a) To generate the charge lines, enter the fiscal period.

**Note:**
Charge lines for a service catalog statement item are generated based on the preconfigured Opened (system property value is opened_at) date field in the Requested Items table. The dates of the requested items that fall within the fiscal period are considered for generating the charge lines. However, as a service charging analyst you can configure the system property (com.snc.showback.catalog.consumed_date) value to a date field of your choice in the Requested Items (sc_req_item) table.

b) Click **OK**.

7. To save the updated record, click **Update**.
8. To delete a record, click **Delete**.

To create breakdown records for the service catalog statement item, click **New** in the Service Catalog Breakdowns related list.

Create service catalog breakdowns
Create service catalog breakdowns by fragmenting the service catalog category of the business service to its catalog item components into a more detailed level.

Role required: service_charging_analyst
For example, the IT Services Consumables statement item can provide the breakdown details of its component consumables such as Tablets and Laptops. Each of these items can be further broken down to more details. Tablets can be Google nexus, iPads, and so on with the associated price used for each unit of the item.

1. Click **New** in the Service Catalog Breakdowns related list to create breakdown records for the service catalog statement item that you have created.
2. Fill in the form fields.

### Service Catalog Breakdown form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive name of the service catalog breakdown.</td>
</tr>
<tr>
<td>Statement item</td>
<td>Defaults to the type of the statement item.</td>
</tr>
<tr>
<td>Category</td>
<td>Catalog items under the selected category are used for reporting the consumption details.</td>
</tr>
<tr>
<td>Catalog item</td>
<td>Item under the selected Catalog and Category for which the consumption is reported.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

### Drill down within a statement item

You can drill down within a statement item to visualize a subset of its data.

Role required: service_charging_analyst

**Note:**

This feature is available only when you own an ITBM Analyst license.

Drill down within a statement item to see the entity or the key field that has the data retrieved from the source table. You can also see the basis on which the mapping is done to the particular field that has the relevant data to retrieve. You can also edit and change the drilldown method and use the weighted method. In such a case, the system uses the weighted metric to retrieve data from the source table.

1. Navigate to **Financial Charging > Administration > Statement Item Drilldowns**.
2. Click **New** to create a statement item or click the name of an existing statement item drilldown that you want to edit.
3. Click the type of statement item that you want to drill down.
4. Based on the type of statement item drilldown that you select, fill in the relevant form fields.

### Statement Item Drilldown form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the statement item drilldown.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Drilldown basis</td>
<td>Lower level access of the item based on the mapped field or the weighted metric method. For more information, see Allocation metrics.</td>
</tr>
<tr>
<td>Table</td>
<td>Source table that has the statement item information.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of the statement item, determined based on the source from where the information is retrieved. You cannot edit the field as you have already selected the type of statement item drilldown that you want to perform.</td>
</tr>
<tr>
<td>Mapping field</td>
<td>Maps to the field in the table which has the drilldown data.</td>
</tr>
<tr>
<td>Weighted Metric</td>
<td>Drilldown on calculations based on an aggregate value from a segment.</td>
</tr>
<tr>
<td>Cost model</td>
<td>Cost model for which the drilldown can be applied.</td>
</tr>
</tbody>
</table>

5. Click **Submit** to enter a record or **Update** if you have edited an existing record.

After you define the statement items, associate the statement items to the showback statements. You can use the showback statement to report consumed services to the business unit head, which displays the detailed service charge lines that the unit has utilized as a part of the business service. For example, Email service is a business service. When a business unit uses the email service, then the service charges for consuming the email services are reported as a showback statement to the business unit head or the department head.

**Define, generate, and publish a showback statement**

Showback tells the consumers what it costs a service organization such as IT to deliver services to them. Defining a showback statement helps to capture the reporting entity (for example, a business unit) to whom you want the showback statement to be reported to. The showback statement is a collection of charges representing the statement items (the services consumed by the business unit) and is generated for a fiscal period.

Role required: service_charging_analyst

<i>Note:</i>

This feature is available only when you own an ITBM Analyst license.

Showback statements provide the business unit a visibility of the services consumed and the charges associated with these services. It also brings an awareness and helps them to be judicious in using the business services and conscious of the cost factor associated with it.

You can create multiple showback statements based on the same Statement Item by drilling down to its lowest level. The showback statements can be for different reporting entities. For example, you can use a drilldown entity that has the source data on a Statement Item to create showback statements for different reporting entities such as a Cost Center, Business Unit, or Department.

1. **Navigate to Financial Charging > Administration > Showback Statement Definition.**
2. **Click New** to create a showback statement definition or click the name of an existing showback statement definition that you want to edit.
3. Fill in the form fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the showback statement definition.</td>
</tr>
<tr>
<td>Description</td>
<td>Description for the showback statement definition.</td>
</tr>
<tr>
<td>Reporting entity</td>
<td>Report generated to show the entity of its consumption details.</td>
</tr>
<tr>
<td>Reporting user field</td>
<td>Reporting entity head who sees the report.</td>
</tr>
<tr>
<td>Frequency</td>
<td>Fiscal frequency for which the report is generated.</td>
</tr>
<tr>
<td>Reporting user group field</td>
<td>User group who can see the report. All the members of the user group can see the report.</td>
</tr>
</tbody>
</table>

4. Click **Submit** to save the record or **Update** if you have edited an existing record.

5. Click **Generate** to generate the showback statement for the selected fiscal period.

The generated report is made available for viewing purpose to the reporting entity (business unit). The showback statement gives the information that the reporting entity has used the services mentioned in the statement lines.

As a financial analyst, you can generate the showback statement and publish it so that the showback user can view it.

As a designated showback user (normally a business unit owner or a business unit finance lead), you can view the published showback statements assigned to you or your unit. You can review and accept them or raise a dispute if there is discrepancy and resolve it with the service owner or service charging analyst through the task workflow.

6. Click **Publish**.
   a) Select the fiscal period in the **Fiscal Period** choice list of the Publish showback statement pop-up that opens up.
   b) Click **OK**.

   **Note:**
   The fiscal period for which you have generated and not yet published the showback statement is listed in the choice list. By publishing, the showback statement for the said fiscal period is available and the showback users can view it in My Showback Statements menu in the application navigator.

7. Click **Delete** to delete the record.

   Create statement lines for the Showback Statement by clicking the Showback Statement Line Definitions **New** button.

Monitor the showback statements in the service pricing console.
Service charging

As a service owner, you can use the Service Pricing Console to monitor the consumption of the services, the status of each statement item, and can set the pricing for the statement items.

**Note:**
This feature is available only when you own an ITBM Analyst license.

As a service charging analyst, you can analyze and research on the economic trends and conditions of the business and make necessary charging recommendations for the business service.

Monitor service charges in the service pricing console

As a service owner use the service pricing console to generate service charge lines, view the service charge lines, and set pricing policy. Setting the pricing policy generates the rate card, which captures the set price, surcharge or discount details.

Role required: service_charging_owner

**Note:**
This feature is available only when you own an ITBM Analyst license.

1. Navigate to **Financial Charging > Service Charging > Console.**
   
   Open the console to monitor all the details related to the statement items in the following panes:

   - **My Statement Items:** A list of all the statement items owned by the service owner appear on the left pane.
   2. Click the statement item on the left pane, the details of which you want to view.
   3. Click the **Fiscal Period** choice list to select a fiscal period.
   4. Click **Generate Lines** to generate charge lines for the statement item for the specified fiscal period.

   The Generate Charge Lines pop-up opens up.

   **Note:**
   You can view the list of service charge lines generated based on the statement item by navigating to **Financial Charging > Service Charging > Service Charge Lines.** These service charge lines are records that you can monitor on the console.

   5. Update the fiscal period for the period that you want to generate the charge lines.

   6. Click **Generate.**

   A message appears confirming that the Charge lines generation job has been scheduled successfully.

   The statement item details pane on the right displays all the details of the statement item.

   **Overview tab:**

   - **Pricing, cost, and charges:** The left pane displays the details of the pricing policy method and the pricing policy adopted for the statement item. It also shows the total cost of the statement item and the total charges that has been charged for the statement item.
   - **Costs** are the actual expenses by service. It is the amount that you incur in buying a product or a service.
   - **Price** is the amount that is determined for a product or a service based on cost factors involved in production, marketing, selling, and so on.
- **Charge** is the amount of money you are charged by the business service for the services or goods they provided.

- **Cost trend**: The spline chart shows the trend of the cost against the price over the different fiscal periods.
- **Charge lines**: The service charge lines are generated for statement item. Each service charge line lists the name of the product or the service used and the associated unit cost of the item computed with the quantity, giving you the total cost.

**Charge line column heads**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the statement item.</td>
</tr>
<tr>
<td>Average unit cost</td>
<td>Average cost of one unit of the statement item.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Number of items at the statement item and at the statement item breakdown level.</td>
</tr>
<tr>
<td>Total cost</td>
<td>Unit Cost * Quantity.</td>
</tr>
<tr>
<td>Price Adjustment (%)</td>
<td>Price adjustment is based on the pricing policy method that you defined in the statement item definition form. Adjust the price either on percentage or unit price by incrementing or decrementing a percentage of the Average Unit Cost. The adjusted price reflects as the Total Charges.</td>
</tr>
<tr>
<td>Unit Price</td>
<td>Sets a predefined unit rate for a service. It is determined for a quantity of service that is delivered or the cost of a single statement item.</td>
</tr>
<tr>
<td>Total Charges</td>
<td>Total amount of money charged for each business service, which is the adjusted price of the average unit cost.</td>
</tr>
</tbody>
</table>

7. **Click** **Set Pricing Policy** button.
   
    You can see more details of the statement item in the right pane of the console that opens up.

8. **Click** the statement item level or the statement item line level price adjustment box (based on the pricing policy that you have set) to adjust the price and arrive at the total charges.

9. **Click** **Set Price**.
   
    The price adjustment that you made reflects in the **Total Charges** field.
10. Click the Drilldown tab to view the drilldown details of the statement items at the drilldown entity level.

You can view the statement item breakdown or compare it with the other charge line item breakdowns to get better visibility on cost by breakdown.

Drilldown tab:
- **Drilldown**: Click Drilldown field to view the detailed data of statement item’s cost by breakdown for each drilldown entity on a chart.
- **Charge line item Breakdown**: Click Charge line item Breakdown field to view the charge line item breakdown by cost for each statement item breakdown.
- **Charge line item Breakdown accounts**: Click Charge line item Breakdown accounts field to view the accounts for each service charge line of the statement item breakdown.

The charges that you define are attached as a rate card to a statement item. As a service charging analyst and service charging owner, you can also define service charge price rate cards.

Create ratecards to fix price for your business service

Create a ratecard that lists prices for your business service or business service components. As a service owner, you can create a ratecard for a statement item, which represents the business service that you own. The ratecard is based on the pricing policy method attached to the statement item for a fiscal period.

Role required: service_charging_analyst, service_charging_owner

**Note:**
This feature is available only when you own an ITBM Analyst license.

The ratecard for a fiscal period defaults to the next fiscal period if you do not set a new pricing policy for the statement item before the charges of the next fiscal period are published.

1. Navigate to **Financial Charging > Service Charging > Service Charge Rate Cards**.
2. Click **New** to create a service charge price rate card or click a record that you want to edit.
3. Fill in the form fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Statement item</td>
<td>Select the statement item for which you want to create a rate card.</td>
</tr>
</tbody>
</table>
| Item table name             | • If it is a service catalog statement item, then the item table name is catalog item.  
                              | • If it is a cost model statement item, then the item table name is the transaction table name of the segment.  
<pre><code>                          | • If it is a consumption statement item, then the item table name is the consumption table. |
</code></pre>
<p>| Service charging type       | Defaults from the statement item. It can be percentage based or unit price based. |
| Fiscal period               | Period for which the rate card is valid.                                     |
| Statement item breakdown    | The breakdown line details of the statement item.                            |
| Item name                   | Refers to a record in the item table.                                        |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Percentage</td>
<td>A percentage of the average unit cost, which you can set at the statement item level, statement item breakdown level, or item level of the consumption based statement item or catalog based statement item; or, at the account level of the cost model based statement item.</td>
</tr>
<tr>
<td>Unit price</td>
<td>Set the unit price only for the item level pricing policy. The unit price represents the price displayed to the business users.</td>
</tr>
<tr>
<td>Short description</td>
<td>Meaningful short description for the rate card.</td>
</tr>
</tbody>
</table>

4. Click **Submit** or **Update**.

As a service charging analyst, you can view all the showback statements that are generated. The showback users can view the showback statements only when you publish the showback statements that you have generated.

**Showback statements**

Showback, an information technology strategy of financial charging, tracks the costs of IT hardware, software, cloud services, or any shared services that are used by a business unit.

**Note:**
This feature is available only when you own an ITBM Analyst license.

The costs are then consolidated and presented to the business unit, as a reporting invoice (showback statements), to show the quantum of services and products they have consumed over a fiscal period.

The HR business unit of an organization might request Attendance Management System business application to manage the attendance of their employees. The process of procuring the license, installing, and maintaining this application on twenty computers of the HR staff who process the attendance in the HR department incurs a cost. The IT department tracks this cost and reports the expense in the form of a showback statement to the HR business unit head.

**View all showback statements**

As a service charging analyst, you can view the list of all showback statements that are generated. You can determine the reporting entity or the user group that the report is intended for.

Role required: service_charging_analyst

Generate the showback statements, redetermine the total cost of the statement expense lines for the fiscal period, and publish the statements for the showback user to see. You can also create a showback statement.

1. Navigate to **Financial Charging > Showback > All Showback Statements**.
2. To create a showback statement, Click **New**.
3. To edit an existing showback statement record, click **New**.
4. On the form, fill in the fields.

**Showback Statement form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reporting entity</td>
<td>Business entity that availed the business service.</td>
</tr>
<tr>
<td>Fiscal period</td>
<td>Period for which the showback statement is generated.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Business unit head or department head who would see the showback statement.</td>
</tr>
<tr>
<td>State</td>
<td>Status of the showback statement.</td>
</tr>
<tr>
<td></td>
<td>• Draft: The report is in a draft stage.</td>
</tr>
<tr>
<td></td>
<td>• Published: The report has been published,</td>
</tr>
<tr>
<td></td>
<td>which means the reporting user and the users belonging to the reporting user</td>
</tr>
<tr>
<td></td>
<td>group with the showback user role can see the report.</td>
</tr>
<tr>
<td></td>
<td>• Disputed: The showback user has seen the report and has raised a dispute</td>
</tr>
<tr>
<td></td>
<td>as the user has a disagreement about the contents of the statement expense</td>
</tr>
<tr>
<td></td>
<td>line.</td>
</tr>
<tr>
<td></td>
<td>• Closed: When the showback user accepts the statement item, the statement</td>
</tr>
<tr>
<td></td>
<td>item moves to the Closed state.</td>
</tr>
<tr>
<td>Total cost</td>
<td>The total cost of all the statement expense lines.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group that the statement item is assigned to.</td>
</tr>
<tr>
<td>Short description</td>
<td>Meaningful short description for the showback statement.</td>
</tr>
<tr>
<td>Additional comments (User visible)</td>
<td>Comments or notes in complete sentences and paragraphs because users view these comments. The user gets a copy of all information saved in the field.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Work notes for internal communication only.</td>
</tr>
</tbody>
</table>

5. To save the showback statement, click **Submit**.
6. To save the edited record, click **Update**.
7. To acknowledge the expenses reported in the showback statement, click **Accept**.
8. To delete the record, click **Delete**.

Add statement expense lines and statement expense line details to the showback statement using the Showback Statement related list.

**Add statement expense line**

At the statement item breakdown level, add the number of units consumed, unit rate of the item, and the total cost of all items. Just as an invoice has printed line items, detailing the expense list, the statement item also has the expense details reported as statement expense lines in the showback statement.
Role required: service_charging_analyst

1. Click **New** in the Statement Expense Lines related list.
2. On the form, fill in the form fields.

**Statement Expense Line form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Showback statement</td>
<td>Defaults to the showback statement reporting entity.</td>
</tr>
<tr>
<td>Statement item</td>
<td>Select the statement item that is to be listed as the statement expense line from the choice list.</td>
</tr>
<tr>
<td>Volume</td>
<td>Number of items consumed (in units).</td>
</tr>
<tr>
<td>Cost</td>
<td>Calculated as Unit rate * Volume.</td>
</tr>
<tr>
<td>State</td>
<td>Status of the statement expense line.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Pending</strong>: Showback statement is not published, the statement expense line is in the Pending state. (The showback statement is in the Draft state.)</td>
</tr>
<tr>
<td></td>
<td>• <strong>Processed</strong>: The showback statement is published, statement expense lines are in the Processed state. (Showback statement is in Published state.)</td>
</tr>
<tr>
<td></td>
<td>• <strong>Disputed</strong>: If the statement recipient perceives the volume or unit rate of a statement expense line to be incorrect, then the recipient can raise a dispute. (If the statement expense line is disputed, the showback statement is also in a Disputed state.)</td>
</tr>
<tr>
<td></td>
<td>• <strong>Accepted</strong>: The showback user accepts the statement expense lines. (The showback statement is Closed.)</td>
</tr>
<tr>
<td>Statement item breakdown</td>
<td>Select the statement item breakdown that you want to be listed for the statement item.</td>
</tr>
<tr>
<td>Unit rate</td>
<td>Rate at which the reporting entity is charged for one unit of the item.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

**Add expense line details for the statement** expense line of the statement item.

*Add statement expense line details*

Adding expense line details is drilling down to one more level of the statement expense line. Add the number of units consumed, the unit rate at which the item is charged, and the total amount of the expense line at the item level, catalog item level, or account level.

Role required: service_charging_analyst

1. Click the Statement Expense Line related list.
2. Click **New**.
3. On the form, fill in the fields.

**Statement Expense Line Details form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Statement expense line</td>
<td>Select the statement expense line from the options list.</td>
</tr>
<tr>
<td>Unit rate</td>
<td>Rate at which the reporting entity is charged for one unit of the item.</td>
</tr>
<tr>
<td>Volume</td>
<td>Number of items consumed (in units).</td>
</tr>
<tr>
<td>Amount</td>
<td>Volume * Unit rate.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Generate showback statements for upcoming fiscal period**

As a service charging analyst, review the status log of all showback statements for the last fiscal period that the statements were generated for and the date that the showback statements were published on. You can also create a record or log of the last generated and published details of a showback statement, and generate the statement for the next fiscal period.

Role required: service_charging_analyst

1. Navigate to **Financial Charging > Showback > Generate Showback**.
2. Click **New** to create a showback run log or click the **Status** of an existing showback log record that you want to edit.
3. On the form, fill in the fields.

**Showback Run Log form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fiscal period</td>
<td>Select the statement expense line from the options list.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the showback statement.</td>
</tr>
<tr>
<td>Showback</td>
<td>Definition of the showback statement.</td>
</tr>
<tr>
<td>Last generated</td>
<td>Date on which the statement was last generated.</td>
</tr>
<tr>
<td>Published</td>
<td>Check box to indicate whether the statement has been published or not.</td>
</tr>
<tr>
<td>Published date</td>
<td>Date on which the statement was last published.</td>
</tr>
</tbody>
</table>

4. Click **Submit** if you have created a log or click **Update** if you have edited an existing log.
5. Click **Delete** to delete the record.
6. Click **Generate Statement** to generate a showback statement for a fiscal period.
   a) Select the showback statement in the **Showback Statement Definition** field of the Generate Showback Statement pop-up that appears.
   b) Select the fiscal period in the **Fiscal Period** field.
   c) Click **Generate**.

   Refresh the Showback Run Logs list to see the status of the showback statement change to Generated.

   **Note:**
   The **Published** column indicates whether the showback statements have been published or not by the status of true or false. If the status is false, it means that the showback is not yet published and available for the showback user to see.

   Review the generated showback statement and publish the statement for the showback user to see the report, by navigating to **Showback Statement Definition**.

After you publish the showback statement, the showback user can see the showback statement in **My Showback Statements**.

**View my showback statements as a showback user**

As a showback entity owner, you can view all the showback statements that are assigned to you. You can review statements and raise a dispute if there is discrepancy or accept them.

Role required: showback_user

**Note:**
This feature is available only when you own an ITBM Analyst license.

1. Navigate to **Financial Charging > My Showback Statements**.
2. View the list of showback statements that are assigned to you.
   - **Fiscal period**: Period that the showback statement is generated for.
   - **Total cost**: Cost of the service that you have been charged for.
   - **State**: Status of the showback statement.
   - **Assigned to**: Reporting entity user that utilized the service.

   If you have a disagreement to any or all the statement lines, you can raise a dispute.
3. To **raise a dispute**, use the **Raise a dispute** UI action from the Statement expense line of the showback statement or navigate to **My Open Disputes**.

**Raise a dispute**

As a showback user, if you disagree with any of the information on a statement expense line, then you can raise a dispute.

Role required: showback_user

**Note:**
This feature is available only when you own an ITBM Analyst license.

1. Navigate to **Financial Charging > My Open Disputes**.
2. In the Statement Disputes list, click **New** or click the Number in the Statement disputes list.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Sequential number for the dispute.</td>
</tr>
<tr>
<td>Statement expense line</td>
<td>Expense line from the choice list that you disagree with.</td>
</tr>
<tr>
<td>Opened by</td>
<td>Defaults to the user name who is raising the dispute.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Dispute assigned to the service charging owner, if it is related to pricing policy, unit rate, volume, or total cost. Assign the dispute to service charging financial analyst, if there is a disagreement with the showback statement.</td>
</tr>
<tr>
<td>Reason code</td>
<td>Appropriate reason code from the choice list.</td>
</tr>
<tr>
<td>State</td>
<td>Status for the dispute:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Open</strong>: The showback user raises a dispute.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Work in progress</strong>: The service charging owner or service charging analyst is working on the dispute.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Closed complete</strong>: The dispute is resolved and closed.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Closed incomplete</strong>: The dispute is not resolved, but closed.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Closed skipped</strong>: The disputed expense line is skipped and closed.</td>
</tr>
<tr>
<td>Reason</td>
<td>Description of the dispute.</td>
</tr>
<tr>
<td>Additional comments (Customer visible)</td>
<td>Comments or notes, in complete sentences and paragraphs, for the service charging owner and service charging analyst to understand and resolve the dispute easily.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Work notes for internal communication only.</td>
</tr>
<tr>
<td>Statement expense line details</td>
<td>Expense line of the showback statement that the dispute is raised for.</td>
</tr>
</tbody>
</table>

4. To complete the submission of the dispute, click **Submit** or to update an edited dispute, click **Update**.
5. If you have reviewed the resolution for the dispute that you raised earlier, click **Close**.
6. To delete the record, click **Delete**.

As a service charging owner, you can navigate to **My Open Disputes** to view the statement disputes raised by the showback user and resolve the disputes.

If the service charging owner is not available to resolve the issue, the service charging analyst, as a super user with special privileges, can resolve any open dispute in **My Open Disputes**.
View my statement items as a service owner

As a business service owner, you can view the list of statement items for which you are the service charging owner and you can generate the charge lines for a fiscal period.

Role required: service_charging_owner

Note:
This feature is available only when you own an ITBM Analyst license.

After the service charging analyst publishes the showback statements, you can review them for any disputes raised by the showback user and manage the statement expense lines. You can view the unit cost, cost recovery based on consumption, and set unit price, discount, or surcharge to the statement item.

1. Navigate to Financial Charging > My Statement Items.
2. View the list of statement items for which you are the service charging owner.
3. Review the statement item service charging details.
4. Click Generate Charge Lines.
5. In the Fiscal Period choice list of the Generate charge lines pop-up, select the fiscal period.
6. Click OK.

You can view the statement items in the business unit owner showback dashboard.

Financial analyst showback dashboard

As a financial analyst, you can use the Financial Analyst Showback dashboard central interface to view all the showback statements that are generated. The dashboard helps to analyze the cost of delivering services to the business and the recovery or showback of that cost.

Note:
This feature is available only when you own an ITBM Analyst license.

You can also navigate to Financial Charging > Showback > Dashboard to access this dashboard.

The data are retrieved from the ITFM_Charge_Expense_Line_Details table.

Last Period Total Cost
Shows the total cost of delivering services in the last period.

Last Period Total Charges
Shows the total amount charged for all business services, based on the adjusted prices.

Last Period Charge vs. Cost Variance
Shows the difference between the total charges and total costs for the last period.

YTD Charge vs. Cost Variance
Displays the difference between the total charges and total costs year to date.

Charge vs. Cost
Shows charges as bar charts versus the cost trend for the completed fiscal periods.

Last Period Total Cost Breakdown
Lists the total cost breakdown details of the statement item or business units for the last period.
Business unit owner showback dashboard

As a business unit owner, you can use the Business Unit Owner Showback dashboard interface to see the statement items assigned to the business unit owner, set the pricing policy, and view the last period cost.

Note:
This feature is available only when you own an ITBM Analyst license.

You can also navigate to Financial Charging > My Showback Dashboard to access this dashboard.

Last period cost
Displays the sum of the cost that is shown for all statement items by the business unit.

By statement item
Lists the statement items and the cost for a fiscal period.

Showback statements
Lists all the showback statements owned by the business unit owner.

Quick start test for Financial Management

Validate that Financial Management still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

Quick start tests require activating the Core - ATF Tests plugin (com.snc.financial_management.atf)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify FM Cost Allocation Flow</td>
<td>Verify the cost allocation flow in financial modeling.</td>
<td></td>
</tr>
</tbody>
</table>

To learn more about Financial Management, see Financial Management.

Financial Management Analytics and Reporting Solutions

Analytics and Reporting Solutions contain preconfigured dashboards. These dashboards contain actionable data visualizations that help you improve your business processes and practices.

Note: You can activate Performance Analytics solutions and in-form analytics on instances that have not licensed Performance Analytics to evaluate the functionality. However, to start collecting data you must license Performance Analytics.
Analytics and Reporting Solutions

Use the widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With these tools, you can get value from analytics and reporting solutions for your application with minimal setup. You can always create your own objects as well.

**Important:** Set up and test these on a non-production instance before enabling them in production.

**Note:** These widgets provide all the configuration records required to analyze default applications. Customize these records for use in your production environment. For more information, see Configure these widgets.

To enable the solution for Financial Management, an admin can navigate to Performance Analytics > Guided Setup. Click Get Started then scroll to the section for Financial Management. The guided setup takes you through the entire setup and configuration process.

To access the ITFM prescriptive dashboards, you require the Performance Analytics – Content Pack – Financial Management (com.snc.pa.fm) plugin. To get the cost data in the Total Expenses YTD widget, you also require Performance Analytics – Premium (com.snc.pa.premium) plugin.

The ITFM prescriptive dashboards are based on the prescriptive cost models that you have chosen for the financial model activities of your business enterprise.

Navigate to Financial Modeling Analyst: To track the total spend of business applications > ITFM Prescriptive Dashboards to access the prescriptive dashboards.

**Financial Management Application TCO dashboard**

Application total cost of ownership (TCO) dashboard provides a view into a business application and enables you to know the total amount spent on the application in the last fiscal period. You can also
compare its current cost of ownership with its cost incurred in the past fiscal period, thereby forecast its future expenses.
### End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Financial Modeling Analyst: To track the total spend of business applications. Administrator: To track the cost of application in addition to the cost of using and maintaining it.</td>
<td>cost_transparency_admin</td>
</tr>
<tr>
<td>Financial Modeling Analyst: To track the total spend of business applications. Analyst: To predict the future total cost of ownership of the application based on its past trend and determine the affordability of its ownership cost.</td>
<td>cost_transparency_analyst</td>
</tr>
</tbody>
</table>

### Indicators

**Total Expenses Fiscal Quarterly – Application Cost Model**

The indicator collects fiscal quarterly total cost data for the Business Applications and Business Unit based on the Level 2 Costing – Business Applications cost model.

**% Application cost for total spends**

Formula used to calculate the percentage of an application cost out of the total cost of all business applications.

**Average Cost Per User – Application**

Formula used to calculate the average cost of applications consumed by a user.

**Total Expenses Fiscal Quarterly Breakdowns – Application Cost Model**

The indicator collects fiscal quarterly breakdown data for the business applications and business unit of the Level 2 Costing – Business Applications cost model.

**Total Expenses Fiscal Quarterly Breakdowns – ITSS – Application Cost Model**

The indicator collects fiscal quarterly aggregated data that is rolled up from the IT Shared Services to the Business Applications of the Level 2 Costing – Business Applications cost model.

**Total Expenses Fiscal Quarterly Breakdowns – Application Cost Model**

The indicator collects fiscal quarterly cost allocation aggregated data. The data is rolled up from the Business Application to the Business Unit of the Level 2 Costing – Business Applications cost model.

### Breakdowns

- Business applications.

### Reports

The Application TCO dashboard includes the following reports:
<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Cost Trend</td>
<td></td>
<td>Displays the trend of cost allocation breakdown aggregate and average cost per user by quarterly fiscal period, with the amount and percentage calculation.</td>
</tr>
<tr>
<td>IT Shared Services – Buckets</td>
<td></td>
<td>Gives a tabular view of the bucket amounts allocated to all the accounts within the IT shared services segment in the last four quarters.</td>
</tr>
</tbody>
</table>

Financial Management Business Application Costing dashboard

Business Application Costing dashboard provides an executive view into the total expenses on business applications consolidated for a quarter and year-to-date. The dashboard provides visibility on the application cost to an extent that you can drill the data on top spenders down to the buckets that contribute to the application cost, and business units that use the applications.

The dashboard is based on the Business Applications Costing cost model. This cost model aligns business applications to business units and hence enables you to know the cost of applications that support each business unit.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Financial Modeling Analyst: To track the total spend of business applications. Administrator: To track the amount spent on a business application.</td>
<td>cost_transparency_admin</td>
</tr>
<tr>
<td>Financial Modeling Analyst: To track the total spend of business applications. Analyst: To predict the future cost of application based on its past trend, and determine whether to continue with the application or not.</td>
<td>cost_transparency_analyst</td>
</tr>
</tbody>
</table>

Indicators

**Total Expenses Fiscal Quarterly – Application Cost Model**
The indicator collects fiscal quarterly total cost data for the Business Applications and Business Unit of the Business Applications Costing cost model.

**Total Expenses Fiscal Quarterly Breakdowns – Application Cost Model**
The indicator collects fiscal quarterly cost allocation aggregated data, rolled up from the Business Application to the Business Unit of the level 2 cost model.

**Average Cost Per User – Application**
Average cost of applications consumed by a user.

Breakdowns

- Business unit.
- Business applications.
- Buckets – Application Cost.

Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Applications Cost with Drivers</td>
<td></td>
<td>Displays the amount that each account in the Business Application consumes from different buckets (cost pools).</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Average Enterprise Cost per CPU</td>
<td></td>
<td>Displays the trend of average unit cost per CPU.</td>
</tr>
<tr>
<td>Business Unit – Business Application</td>
<td></td>
<td>Gives a tabular view of the amount breakup spent by the business units on the applications for the last four quarters.</td>
</tr>
</tbody>
</table>
Financial Management CIO dashboard for Business Applications

The CIO dashboard measures the real-time performance of business applications and provides accurate, up-to-date data in a readily viewable form to support your decisions.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Financial Modeling Analyst: To track the total spend of business applications.</td>
<td>cost_transparency_analyst</td>
</tr>
<tr>
<td>Read only role for Financial Management: To view the dashboard and its reports.</td>
<td>sn_itfm_read</td>
</tr>
</tbody>
</table>

Indicators

**Total Expenses Fiscal Quarterly – Application Cost Model**
The indicator collects fiscal quarterly total cost data for the Business Applications and Business Unit of the Business Applications Costing cost model.

**Total Expenses Fiscal Quarterly Breakdowns – Application Cost Model**
The indicator collects fiscal quarterly cost allocation aggregated data, rolled up from the Business Application to the Business Unit of the Business Application Costing cost model.

**Average Cost Per User – Application**
Average cost of applications consumed by a user.

Breakdowns

- Business unit.
- Business applications.

Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Applications Cost with Drivers</td>
<td>Line chart</td>
<td>Displays the amount that each account in the Business Application consumes from different buckets (cost pools).</td>
</tr>
<tr>
<td>Labor Cost</td>
<td>Line chart</td>
<td>Displays the amount coming from the labor bucket that is allocated to Business Unit segment from the business application segment for each fiscal period.</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Labor Count</td>
<td></td>
<td>Unit quantity of labor bucket for each fiscal period.</td>
</tr>
<tr>
<td>Business Unit – Business Application</td>
<td></td>
<td>Tabular view of the amount breakup spent by the business units on the applications for the last four quarters.</td>
</tr>
<tr>
<td>Average Enterprise Cost per CPU</td>
<td></td>
<td>Displays the trend of average unit cost per CPU.</td>
</tr>
</tbody>
</table>

**Financial Management Level 1 Costing – Shared Services dashboard**

The Level 1 Costing – IT Shared Services dashboard provides an executive view into the total expenses consolidated for a quarter and year-to-date of top spenders. You can drill down to their business units or shared services. The dashboard gives visibility on the IT infrastructure cost, helps communicate to the business, the cost of shared services, and facilitates analyzing the trend for the future growth.

**Note:**

This feature is available only when you own an ITBM Analyst license.

Level 1 Costing – Shared Services dashboard is a simple dashboard with a single view into all expenses. It is modeled on L1 Costing – Shared Services cost model. It provides two breakdowns that you can drill into to get specific cost information.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Financial Modeling Analyst: To track the total spend of business applications. Administrator: To track the IT infrastructure cost. To generate reports that show how much each IT shared service in a business unit is spending.</td>
<td>cost_transparency_admin</td>
</tr>
<tr>
<td>Financial Modeling Analyst: To track the total spend of business applications. Analyst: To take critical business decisions based on the total spend reports of IT infrastructure cost.</td>
<td>cost_transparency_analyst</td>
</tr>
</tbody>
</table>

Indicators

**Total Expenses Fiscal Quarterly – Service Cost Model**

The indicator collects fiscal quarterly breakdown data for the IT Shared Services and Business Unit of the Level 1 Costing – Shared Services cost model.

**Total Expenses Fiscal Quarterly From Aggregates – Shared Services**

The indicator collects fiscal quarterly aggregated data, rolled up from the IT Shared Services to the Business Unit of the level 1 cost model.

Breakdowns

- Business Unit.
- IT Shared Services.

Reports

The Level 1 Costing – Shared Services dashboard includes the following reports:

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IT Shared Service Cost with Drivers</td>
<td></td>
<td>Displays the amount that each account in the IT shared services receives from different buckets (cost drivers).</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Average Enterprise Cost per Workstation</td>
<td></td>
<td>Displays the trend of average unit cost per workstation for the last four quarters.</td>
</tr>
<tr>
<td>Average Enterprise Cost per CPU</td>
<td></td>
<td>Displays the trend of average unit cost per CPU.</td>
</tr>
<tr>
<td>Business Unit – IT Shared Service</td>
<td></td>
<td>Gives a tabular view of the amount spent by all the IT shared services within each business unit for the last four quarters.</td>
</tr>
</tbody>
</table>

**Financial Management Level 2 Costing – Business Applications dashboard**

Level 2 Costing – Business Applications dashboard provides an executive view into the total expenses on business applications consolidated for a quarter and year-to-date. The dashboard provides visibility on the application cost to an extent that you can drill the data on top spenders down to the buckets that contribute to the application cost, and business units that use the applications.

<i>Note:</i>
This feature is available only when you own an ITBM Analyst license.

The dashboard is based on the Level 2 Costing – Business Applications cost model. This cost model aligns business applications to business units and hence you can know the cost of applications that support each business unit.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Financial Modeling Analyst: To track the total spend of business applications.</td>
<td>cost_transparency_admin</td>
</tr>
<tr>
<td>Administrator: To track the amount spent on a business application.</td>
<td></td>
</tr>
<tr>
<td>Financial Modeling Analyst: To track the total spend of business applications.</td>
<td>cost_transparency_analyst</td>
</tr>
<tr>
<td>Analyst: To predict the future cost of application based on its past trend, and</td>
<td></td>
</tr>
<tr>
<td>determine whether to continue with the application or not.</td>
<td></td>
</tr>
</tbody>
</table>

Indicators

**Total Expenses Fiscal Quarterly – Application Cost Model**

The indicator collects fiscal quarterly total cost data for the Business Applications and Business Unit of the Level 2 Costing – Business Applications cost model.

**Total Expenses Fiscal Quarterly Breakdowns – Application Cost Model**

The indicator collects fiscal quarterly cost allocation aggregated data, rolled up from the Business Application to the Business Unit of the level 2 cost model.

**Average Cost Per User – Application**

Average cost of applications consumed by a user.

Breakdowns

- Business unit.
- Business applications.
- Buckets – Application Cost.

Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Applications Cost with Drivers</td>
<td></td>
<td>Displays the amount that each account in the Business Application consumes from different buckets (cost pools).</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Average Enterprise Cost per CPU</td>
<td></td>
<td>Displays the trend of average unit cost per CPU.</td>
</tr>
<tr>
<td>Business Unit – Business Application</td>
<td></td>
<td>Gives a tabular view of the amount breakup spent by the business units on the applications for the last four quarters.</td>
</tr>
</tbody>
</table>

**Financial Management Level 2 Costing – Business Services dashboard**

Level 2 Costing – Business Services dashboard provides an executive view into the cost of enabling a business service and aligning it to the business capabilities of an enterprise. The dashboard provides visibility on the cost of supporting a business service and helps understand the cost of the business services driven by the business units.

**Note:**

This feature is available only when you own an ITBM Analyst license.

The dashboard is based on Level 2 Costing – Business Services cost model that aligns business services to business units. Therefore, you can track the service cost for each business unit.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Financial Modeling Analyst: To track the total spend of business applications. Administrator: To track the amount spent on a business service aligned to each business unit.</td>
<td>cost_transparency_admin</td>
</tr>
<tr>
<td>Financial Modeling Analyst: To track the total spend of business applications. Analyst: To predict the future total cost of business service based on its past trend. Requires to constantly realign the business service with the customer needs and the organizational goals.</td>
<td>cost_transparency_analyst</td>
</tr>
</tbody>
</table>

Indicators

**Total Expenses Fiscal Quarterly – Business Service Cost Model**

The indicator collects fiscal quarterly total cost data for the Business Services and Business Unit of the Level 2 Costing – Business Services cost model.

**Total Expenses Fiscal Quarterly Breakdowns – Business Service Cost Model**

The indicator collects fiscal quarterly cost allocation aggregated data that is rolled up from the Business Service to the Business Unit of the level 2 cost model.

Breakdowns

- Business unit.
- Business service.

Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Services with Drivers</td>
<td>Display</td>
<td>Displays the total amount spent on business services stacked by buckets from which the amount is allocated.</td>
</tr>
</tbody>
</table>
## Financial Management Level 3 Costing – Business Capabilities dashboard

Level 3 Costing – Business Capabilities dashboard provides an executive view into the total spend drilled down to the business units or business capabilities for a quarter and year-to-date. The dashboard provides visibility on the cost of supporting a business capability and helps communicate value in terms of the business functions aligned to the business capabilities.

### Note:

This feature is available only when you own an ITBM Analyst license.

The dashboard is based on Level 3 Costing – Business Capabilities cost model. The model aligns the actual capability that is associated with a business application with the high-level business capability.

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Enterprise Cost per Workstation</td>
<td></td>
<td>Displays the trend of average unit cost per workstation for the last four quarters.</td>
</tr>
<tr>
<td>Average Enterprise Cost per CPU</td>
<td></td>
<td>Displays the trend of average unit cost per CPU.</td>
</tr>
<tr>
<td>Business Unit – Business Service</td>
<td></td>
<td>Gives a tabular view of the amount breakup spent by the business units on the business services for the last four quarters.</td>
</tr>
</tbody>
</table>
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Financial Modeling Analyst: To track the total spend of business applications.</td>
<td>cost_transparency_admin</td>
</tr>
<tr>
<td>Administrator: To track the amount spent on a business capability aligned to each</td>
<td></td>
</tr>
<tr>
<td>business unit.</td>
<td></td>
</tr>
<tr>
<td>Financial Modeling Analyst: To track the total spend of business applications.</td>
<td>cost_transparency_analyst</td>
</tr>
<tr>
<td>Analyst: To predict the future total cost of business capability based on its past</td>
<td></td>
</tr>
<tr>
<td>trend. Requires to constantly realign the business capability with the changing</td>
<td></td>
</tr>
<tr>
<td>business trends and requirements.</td>
<td></td>
</tr>
</tbody>
</table>

Indicators

**Total Expenses Fiscal Quarterly – Business Capability Cost Model**
The indicator collects fiscal quarterly total cost data for the Business Capability and Business Unit of the Level 3 Costing – Business Capabilities cost model.

**Total Expenses Fiscal Quarterly Breakdowns – Business Capability Cost Model**
The indicator collects fiscal quarterly cost allocation aggregated data that is rolled up from the Business Capability to the Business Unit of the level 3 cost model.

**Average Cost Per User**
Formula used to calculate the average cost of business capabilities per user.

Breakdowns

- Business unit.
- Business capability.

Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Capabilities with Drivers</td>
<td><img src="image" alt="Bar Chart" /></td>
<td>Displays the total amount spent on business capabilities stacked by buckets (cost pools) from which the amount is allocated.</td>
</tr>
</tbody>
</table>
## Investment Funding

ServiceNow® enables you to plan and manage investments by allocating funds to investment entities such as Business Units, Products, Teams, and the like. Prioritize your investments based on business needs and strategic objectives of your organization.

You can use the Investment Funding features to do the following:

- Create investments for entities.
- Allocate funds to an investment to meet a business requirement or strategic objective.
- Request funds from one or more funding sources to achieve business goals.

### Investment entities and investments

An investment contains information about funds, costs, benefits, business case, and goals. Use investments to allocate or request funds to meet defined business goals. An investment is associated to an investment entity.

An investment entity is a transaction table for funding. For example, you can create investment entities for records such as Projects, Teams, Business Units, Epics, and Portfolios.

Keeping the investment and investment entity separate provides the following advantages:

- Your work activities are separate from the funding.
- You can fund the same entity for different periods until the investment goals are met.

### Generic investments

A generic investment is an investment on an entity without a transaction table. You can fund entities that are not part of traditional investments using generic entities.

---

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Enterprise Cost per CPU</td>
<td></td>
<td>Displays the trend of average unit cost per CPU.</td>
</tr>
<tr>
<td>Business Units -- Business Capabilities</td>
<td></td>
<td>Gives a tabular view of the amount spent on the business capabilities by the business units for the last four quarters.</td>
</tr>
</tbody>
</table>
For example, as the CEO of a company you might want to set aside some funds for a training or research initiative and there might not be a transaction table to enable such an entity. You could then create a generic entity to fund the investment.

**Top-down and bottom-up funding**

In top-down funding, you distribute funds to investments based on business goals or as part of a business strategy.

In bottom-up funding, you request funds for your investments from one or more funding sources.

Investment Funding enables you to manage funds for both funding approaches.

**Domain separation in Investment Funding**

Domain separation provides complete data isolation for domain-specific users. Investment Funding is compliant with domain separation at the **Data only** level.

**Activate Investment Funding**

Activate the Investment Funding plugin (com.snc.investment_planning) if you have the admin role. This plugin activates related plugins if they are not already active.

Role required: admin

Investment Funding activates these related plugins if they are not already active.

**Plugins for Investment Funding**

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fiscal Calendar</td>
<td>Enables you to generate and manage different kinds of fiscal calendars that are used in various financial applications.</td>
</tr>
<tr>
<td>[com.snc.fiscal_calendar]</td>
<td></td>
</tr>
<tr>
<td>Widgets</td>
<td>Enables widgets on the dashboard pages.</td>
</tr>
<tr>
<td>[com.snc.app.widgets]</td>
<td></td>
</tr>
<tr>
<td>Ag-Grid Components Plugin</td>
<td>Enables grid view.</td>
</tr>
<tr>
<td>[com.snc.app.grid]</td>
<td></td>
</tr>
<tr>
<td>Planned Task_v2</td>
<td>Enables task entities.</td>
</tr>
<tr>
<td>[com.snc.planned_task_v2]</td>
<td></td>
</tr>
</tbody>
</table>

To use Investment Funding to fund your projects and demands, activate the Investment Funding for PPM plugin.

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in **Request a plugin**.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

**Components installed with Investment Funding**

Several types of components are installed with activation of the Investment Funding (com.snc.investment_planning) plugin, including tables and user roles.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.

**Roles installed with Investment Funding**

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Investment admin</td>
<td>Creates investment entities and sets up preferences and fiscal calendar.</td>
<td>• fiscal_calendar_admin</td>
</tr>
<tr>
<td>[investment_admin]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Investment planner</td>
<td>Manages top investment, investment entities, and records associated with investment entities.</td>
<td>• investment_user</td>
</tr>
<tr>
<td>[investment_planner]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Investment user</td>
<td>Manages investments and funds.</td>
<td>• fiscal_calendar_user</td>
</tr>
<tr>
<td>[investment_user]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Users with this role can perform create, read, update, and delete operations on all cost and benefit plans.

**Tables installed with Investment Funding**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Case</td>
<td>Stores business cases for investments.</td>
</tr>
<tr>
<td>[business_case]</td>
<td></td>
</tr>
<tr>
<td>Fund Request</td>
<td>Stores fund request details.</td>
</tr>
<tr>
<td>[invst_funding_base_request]</td>
<td></td>
</tr>
<tr>
<td>Funding</td>
<td>Stores fund details.</td>
</tr>
<tr>
<td>[invst_funding_base_fund]</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>Funding Base</td>
<td>Base table for funding and requests.</td>
</tr>
<tr>
<td>[invst_funding_base]</td>
<td></td>
</tr>
<tr>
<td>Funding Base Breakdown</td>
<td>Stores the breakdown of funding base records.</td>
</tr>
<tr>
<td>[invst_funding_base_breakdown]</td>
<td></td>
</tr>
<tr>
<td>Investment Entity</td>
<td>Stores investment entity types.</td>
</tr>
<tr>
<td>[invst_funding_entity]</td>
<td></td>
</tr>
<tr>
<td>Funding State</td>
<td>Stores different states of a funding.</td>
</tr>
<tr>
<td>[invst_funding_state]</td>
<td></td>
</tr>
<tr>
<td>Investment</td>
<td>Stores investment details.</td>
</tr>
<tr>
<td>[invst_investment]</td>
<td></td>
</tr>
</tbody>
</table>

**Investment Funding administration**

The Investment Funding application requires you to do some initial administrative tasks for it to be fully functional.

**Fiscal calendar setup for Investment Funding**

The Fiscal calendar setup you choose determines the fiscal periods used by your organization to request or allocate funds.

Based on the fiscal calendar setup, you can then set the funding frequency that aligns with the funding cycles your organization uses, such as monthly or quarterly, for fund requests and allocations.

**Note:** Once you allocate or request funds for investments for a fiscal period, you cannot change to another fiscal calendar type.

For information about fiscal calendars, see Defining fiscal calendars.

For information about how to generate a fiscal calendar, see Generate a fiscal calendar.

**Set Investment Funding preferences**

As an administrator, you can set global defaults for Investment Funding preferences, which affect the funding behavior.

Role required: investment_admin

1. Navigate to **Investment Funding > Setup > Preferences**.
2. In the Funding frequency list, select a frequency of periods in which you can request or allocate funds to an investment.

   The list shows options based on the configured fiscal calendar.

   For example, if you set up the Standard fiscal calendar and you want to fund your investments quarterly, select Quarter.

   The default value is Quarter for the Standard fiscal calendar setup or Period for any other fiscal calendar setup.
3. Optional: In the **Number of editable past periods** field, enter a number to specify the number of past periods enabled for you to modify the allocated or requested fund.

   For example, if the funding frequency is Quarter and you enter 2 in the field, you can edit funds for the previous two quarters.

   The default value is 0 (editing of past period funding is not enabled).

4. Optional: Select the **Hide actuals in tree view** check box to hide the actual amount of an investment in the tree view cards.

5. Optional: Select the **Allow fund overallocation** check box to enable allocation of funds in addition to the received funds.

   The **Fund overallocation percent (%)** and **Allow fund overallocation at investment level** fields are enabled.

6. Optional: In the **Fund overallocation percent (%)** field, enter the percentage by which funds can be allocated in addition to the received funds.

   For example, if the received fund amount is $200,000, and you enter 10% in the **Fund overallocation percent** field, a total of $220,000 can be used for funding.

7. Optional: Select the **Allow fund overallocation at investment level** check box to enable source investment owners who have funded the investment and are not removed from the allocation to override the fund overallocation percent at investment level.

8. Click **Save**.

9. Select an option from the confirmation window that is displayed:
   - Update the overallocation preferences at the investment level for all existing investments
   - Update the overallocation preferences at the investment level for existing investments that have not overridden the overallocation percentage
   - Update the overallocation preferences at the investment level only for new investments

10. Click **Confirm**.

### Create an investment entity

Create an entity for investments through which you can receive or allocate funds.

**Role required:** investment_admin

1. Navigate to **Investment Funding > Setup > Investment Entities**.
2. Click **New**.
3. On the form, fill in the fields.

   **Note:** The **Entity** tab in the form is replaced by the **Owner** tab when the **Generic** option is selected.

   **Investment Entity form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of the investment entity.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for indicating the status of the investment entity. You can create investments only for active investment entities.</td>
</tr>
</tbody>
</table>
When the **Generic** option is not selected:

### Entity tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Transaction table on which funding is enabled.</td>
</tr>
<tr>
<td>Condition</td>
<td>Condition to filter data from the table enabled for funding.</td>
</tr>
<tr>
<td></td>
<td>For example, you could enable funding for the Project table and add a filter condition to list only projects that are in the Ready state.</td>
</tr>
<tr>
<td>Owner field</td>
<td>Any user field in the transaction table mapped to the investment owner field.</td>
</tr>
<tr>
<td></td>
<td>The user on the mapped field is automatically assigned as the investment owner when you are creating an investment.</td>
</tr>
<tr>
<td></td>
<td>For example, for a Project investment entity, you could map the Project manager field as the investment owner field.</td>
</tr>
</tbody>
</table>

When the **Generic** option is selected:

### Owner tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner table</td>
<td>User table mapped as the investment owner field.</td>
</tr>
<tr>
<td>Owner filter</td>
<td>Condition to filter users that are listed in the Owner field in the Investment form to select the investment owner.</td>
</tr>
<tr>
<td></td>
<td>For example, for a Project investment entity, you could create a filter to list only users with the Project manager role.</td>
</tr>
<tr>
<td></td>
<td>By default, the <strong>Active is true</strong> filter is set, which means that only active users are listed for selection.</td>
</tr>
</tbody>
</table>

4. Optional: Click the **Unlock fundable entities** icon to enable the selection of entities that can be funded by the current entity.

For example, a portfolio entity can fund a program, a program can fund a project, a project can request from a program, and a program can request from a portfolio.

5. Optional: Add the entities to the **Fundable entities** list.

If no value is selected, all entities are considered to be enabled for funding.

6. Click **Submit**.
• Create funding artifacts to create a business rule to synchronize investment and investment entity owners or to add a related link on the investment target form.
• Create a top-level investment or an investment for an investment entity.

Enable synchronization of investment and investment entity owners

Create a business rule for an investment entity that synchronizes the investment owner with the investment entity owner. If you update the name of the investment entity owner, the owner of the corresponding investment and the Viewable by field for the investment is automatically updated.

Role required: investment_admin

1. Navigate to Investment Funding > Setup > Investment Entities.
2. Open an entity for which you want to enable synchronization of owners.
3. On the form, click the Create Funding Artifacts related link.
4. In the dialog box, select the Create business rule to sync investment owner with investment entity owner option, and click OK.

A business rule is created for the investment entity that synchronizes the owner of the investment with the associated investment entity owner when you update the investment entity owner.

Access investments directly from an investment target

Create a related link to go directly to the My Funds page from an investment target.

Role required: investment_admin

1. Navigate to Investment Funding > Setup > Investment Entities.
2. Open an investment entity for which you want to create a related link.
3. On the form, click the Create Funding Artifacts related link.
4. In the dialog box, select the Create related link for requesting/funding on the form option, and click OK.
5. Click OK.

The Add/View Investments related link appears on the form of the investment target for direct navigation to the My Funds page.

Create a top-level investment

Create a top-level investment for the investment entity record for which you want to receive and allocate funds.

Role required: investment_planner

A top-level investment does not have a source investment or source investment entity. Once created, a top-level investment cannot be converted to a normal investment later.

1. Navigate to Investment Funding > Top level Investments.
2. Click New.
3. On the form, fill in the fields.

**New Top level Investment form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>For</td>
<td>Investment entity record to associate with the investment. To access the records associated with an entity, select an investment entity in the list on the left. The list on the right then displays the records associated with the selected entity. You can create only one top-level investment for an investment entity type-investment entity value pair.</td>
</tr>
<tr>
<td>Owner</td>
<td>User who will own the top-level investment. This field is set to the Owner field value determined while creating the selected investment entity.</td>
</tr>
<tr>
<td>Name</td>
<td>Unique name of the investment.</td>
</tr>
<tr>
<td>Top investment</td>
<td>Option that indicates that this is a top-level investment. This setting cannot be changed.</td>
</tr>
</tbody>
</table>

4. Click **Create**.

- **Add funds to the investment** to meet the business goals.
- **Create a business case** to define the business need of the investment.

**Fund a top-level investment**

Allocate funds to a top-level investment so that the investment owner can distribute funds further.

Role required: investment_planner

1. Navigate to **Investment Funding > Top level Investments**.
2. Open an investment to which you want to allocate funds.
3. On the **Details** tab, click **Add fund**.
4. On the form, fill in the fields.

**Add fund form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fiscal period</td>
<td>Fiscal period for which the fund is allocated to the investment.</td>
</tr>
<tr>
<td>Funded capex</td>
<td>Amount funded as a capital expense.</td>
</tr>
<tr>
<td>Funded opex</td>
<td>Amount funded as an operating expense.</td>
</tr>
</tbody>
</table>
5. Click **Submit**.

The top-level investment is funded with the specified amount for the selected period.

**Create an investment**

Create an investment to fund a target.

Role required: investment_user

1. Navigate to **Investment Funding > My Funds**.
2. Click **New**.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>For</td>
<td>Investment entity record to associate with the investment. To access the records associated with an entity, select an investment entity in the list on the left. The list on the right then displays the records associated with the selected entity.</td>
</tr>
<tr>
<td>Name</td>
<td>Unique name of the investment.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

- Add a business case to define the business needs of the investment.
- Request funds from a funding source.
- Allocate funds from your available funds.

**Add a business case for an investment**

Add a business case for an investment to define its business needs and goals.

Role required: investment_user

An investment can have only one business case.

When a business case is created on a demand or project record, the same is mapped to the corresponding investment record. And when a business case is created on an investment record, the same is mapped to the corresponding demand or project record. Cost plans and benefit plans associated with project or demand records are also mapped to the investment records.

1. Navigate to **Investment Funding > My Funds**.
2. Open an investment to add the business case.
3. On the **Details** tab, click the **Create Business case** related link.

   The related link is available only if a business case does not exist for the investment.
4. In the Add Business case dialog box, provide information in the fields based on your business needs and goals for the investment.

**Add Business case form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of the business case.</td>
</tr>
<tr>
<td>Investment type</td>
<td>Type of the investment.</td>
</tr>
<tr>
<td>Investment class</td>
<td>Investment class category assigned to the investment:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Run</strong>: Investment made to sustain the existing business.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Change</strong>: Investment made to implement a change in the business.</td>
</tr>
<tr>
<td>Business case tab</td>
<td>Description of the business case supporting the investment.</td>
</tr>
<tr>
<td>Description</td>
<td>Key enablers for the investment.</td>
</tr>
<tr>
<td>Enablers</td>
<td>Major barriers to the investment.</td>
</tr>
<tr>
<td>Assumptions</td>
<td>Assumptions made for the investment that help to determine the scope and risks, and fine-tune the time and cost estimates.</td>
</tr>
<tr>
<td>Scope</td>
<td>Scope of the investment, which includes a set of boundaries that define the extent of the investment.</td>
</tr>
<tr>
<td>In scope</td>
<td>Activities that are not in the scope of the investment.</td>
</tr>
<tr>
<td>Out of scope</td>
<td>Risks associated with the investment if it is carried out.</td>
</tr>
<tr>
<td>Risk of performing</td>
<td>Risks associated with the investment if it is not carried out.</td>
</tr>
<tr>
<td>Risk of not performing</td>
<td>Risks associated with the investment if it is not carried out.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Request funds for an investment**

Request funds from a funding source for your investment.

Role required: investment_user

You cannot request funds for a generic investment from any other generic investment.

You can request funds only from generic source investments that have allocated funds to your investment in the past.

You can request funds only in the funding frequency configured in the **Investment Funding Preferences**.

You can request funds from only those entities that were added in the **Fundable entities** field while creating the entity.

You can withdraw funding requests that are in the requested and planning state and are for past funding periods or non-editable funding periods.

1. Navigate to **Investment Funding > My Funds**.
2. Click an investment card to open the investment for which you need funds.

   If you want to open a different investment, access the drop-down menu next to the name of the currently displayed investment. Either search for another investment by entering its name in the **Search My Investments** field or choose it from the five most recently visited investments.
3. Click the **View/Request Funds** tab.
4. Select a working period and click **Apply**.
   The Request Funds list displays only funding sources that you previously requested funds from for your investment.
5. Click the **Add New Source** link to select the funding source.
6. In the **Select a Source** pane, select one or more source investments from the list, and then click **Add Selected**.
   The specified funding source is added in the Request Funds grid.
7. In the Request Funds grid, specify the amount in the **CapEx** and **OpEx** columns under **New/Modify Request** of the funding sources from which you want to request funds.
   The state of all updated funding sources changes to Draft or Planning, which is indicated by highlighted cells.
8. Click **Request**.
9. In the Confirm request dialog box, verify your requests and add a comment if required.
10. Click **Request**.
11. Optional: Right-click on a column on the **New/Modify Request** field and select **Withdraw** to withdraw a funding request.

- Funds are requested from the source investments sources for the specified period.
- The state of the fund request record changes to Requested.

### Plan fund allocations for investments

Plan your fund allocations if you are not yet ready to finalize the allocation of your funds.

**Role required:** investment_user

Keep investments in the planning stage if you are not yet ready to allocate the funds. For example, you might want to wait to determine whether you require additional funds to meet the needs of all your investments.

If you plan to allocate funds to an investment that are in addition to the received funds, a warning message is displayed in the **Totals** row indicating that you are overallocating, and the additional fund amount will be deducted from the buffer amount set in your funding preferences. For more information on setting up overallocation of funds, see the **Set Investment Funding preferences** topic. If you plan to allocate beyond the available fund plus the buffer amount, an error message indicates that new funds cannot be submitted for allocation.

You can plan fund allocations only according to the funding frequency configured in the **Investment Funding Preferences**.

1. Navigate to **Investment Funding > My Funds**.
2. Click an investment card to open an active investment that has funds that you plan to allocate to other investments.
   If you want to open a different investment, access the drop-down menu next to the name of the currently displayed investment. Either search for another investment by entering its name in the **Search My Investments** field or choose it from the five most recently visited investments.
3. Click the **Allocate Funds** tab.
4. Select a working period and click **Apply**.
   
   If you have allocated funds earlier or there are incoming fund requests, those investments are listed in the Allocate Funds list.
   
   You can filter for pending (planning and requested) investments by clicking the filter icon.

5. In the Allocate Funds list, select the incoming requests to which you are planning to allocate funds.

6. Click **Plan**.
   
   - Funds allocations are planned for the selected investments for the specified period.
   - The state of all updated investments changes to Planning, which is indicated by highlighted cells.
   - The amount remaining after planning your allocations is displayed in the **Left after planning** row.

Allocate funds to planned investments

Allocate funds to an investment

Allocate funds to investments based on your business goals and available funds.

Role required: investment_user

You can allocate funds only in the funding frequency configured in the **Investment Funding Preferences**.

If you allocated funds to an investment earlier, you can increase or decrease the funded amount by entering an amount greater or lesser than the existing amount. Entering a lesser value unfunds the investment by the difference amount.

If you allocate funds to an investment that are in addition to the received funds, a warning message is displayed in the **Totals** row indicating that you are overallocating, and the additional fund amount will be deducted from the buffer amount set in your funding preferences. For more information on setting up overallocation of funds, see the **Set Investment Funding preferences** topic. If you try to allocate beyond the available fund plus the buffer amount, an error message indicates that new funds cannot be submitted for allocation.

You can allocate funds to only those entities that are added in the **Fundable entities** field while creating the entity.

**Note:** For generic investments, you can allocate funds to investments that you own.

1. Navigate to **Investment Funding > My Funds**.

2. Click an investment card to open an active investment that has sufficient funds to allocate to another investment.
   
   If you want to open a different investment, access the drop-down menu next to the name of the currently displayed investment. Either search for another investment by entering its name in the **Search My Investments** field or choose it from the five most recently visited investments.

3. Click the **Allocate Funds** tab.

4. Select a working period and click **Apply**.
   
   If you have allocated funds earlier or there are incoming fund requests, those investments are listed in the Allocate Funds list.
   
   You can filter for pending (planning and requested) investments by clicking the filter icon.
5. Optional: Add more investments to the **Allocate Funds** list for allocating funds.
   a) Click **Add**.
   b) Optional: Click **New** to create a new entity record if you have sufficient privileges for the source entity.
   c) In the **Add** pane, select one or more investments from the list, and then click **Add Selected**.
      To include all the listed investments, click **Add All**.

6. In the **Allocate Funds** list, enter the amount under the **CapEx** and **OpEx** columns under **New Fund** for all investments to which you want to allocate funds.

   **Note:** For an incoming request, take into account the amount in the **New Request** column while entering amounts in the **CapEx** and **OpEx** columns under **New Fund**.

   The state of all updated investments changes to Planning, which is indicated by highlighted cells.

7. Click **Fund**.

8. In the Confirm Allocate Funds dialog box, verify your allocations and click **Fund**.

   While confirming fund allocations, you can view all the details of the quarters where funds are available for funding in one section, and the details of the quarters where funds are not available for funding in another section.

9. Optional: Right-click on a column on the grid and select **View Past Funding Details** to view the funding details of your child investments for the past fiscal periods.

   For more information, see the **View past funding details** topic.

   • Funds are allocated to selected investments for the specified period.
   • The state of funded investments changes to Funded.

### Enter actual spends for an investment

Enter actual spends for your investments to track fund utilization.

Role required: investment_user

You can use funds in your investments to execute business activities or allocate funds to other investments to meet business goals. You can record the amount spent as actual spends ("actuals") in the respective investment. Tracking actuals enables you to do the following:

• Track where and how you spent your funds.
• Add up to the parent investment actuals.

1. Navigate to **Investment Funding > My Funds**.
2. Open an investment for which you want to enter actuals.
   If you want to open a different investment, access the drop-down menu next to the name of the currently displayed investment. Either search for another investment by entering its name in the **Search My Investments** field or choose it from the five most recently visited investments.
3. Click the **View/Request Funds** tab.
4. Select a working period and click **Apply**.
5. In the Request Funds list, specify the actual amount spent under the **Actual CapEx** and **Actual OpEx** columns for your investments.

   **Note:** If you do not see the **Actual CapEx** and **Actual OpEx** columns in the list, click the configuration icon.
• The entered amount is updated as actual funds spent through the investment.
• The amount rolls-up to its parent investment, which in turn rolls-up until the top-level investment.

Reject a fund request

You can reject an incoming fund request based on your business priorities or if you do not have sufficient funds.

Role required: investment_user

1. Navigate to Investment Funding > My Funds.
2. Open an active investment.
   If you want to open a different investment, access the drop-down menu next to the name of the currently displayed investment. Either search for another investment by entering its name in the Search My Investments field or choose it from the five most recently visited investments.
3. Click the Allocate Funds tab.
4. Select a working period and click Apply.
5. Select an investment from the Allocate Funds grid.
6. Click the Allocate Funds drop-down list and select Reject.
7. Optional: Select an investment, and click Clear from the Allocate Funds drop-down list to remove the planning state funding requests that are for past funding periods or non-editable funding periods from your list.

Review the use of your funds

Review the flow of your funds from your investment to other investments to make an informed decision when you allocate or request funds.

Role required: investment_user

Reviewing the use of your funds enables you to see when an investment has not used funds, or whether the funds are still meeting the priorities of your business goals.

Note: The actual amount in your investment is the sum of the direct spends you entered and the total from all investments to which you had allocated funds. The correct actual amount is reflected only if the owners of those investments have entered the actual spends in their investments.

You can view the difference between funds received and actuals (underspent or overspent amount) in the tree view cards. If the funds received amount is greater than the amount in the fund, the underspent amount is displayed in green. If the funds received amount is lesser than the amount in the fund, the overspent amount is displayed in red.

You can configure which information should be displayed on the cards in the list view of Allocate Funds or View/Request Funds. For example, you can configure the list view to display only the Total Actuals amount.

Users that the investment owner adds in the Viewable by field can also review the investment details. The owner of an investment that funds a particular investment is automatically added to the field list for
that investment. For example, if a program investment receives funds from a portfolio investment, then the
owner of the portfolio investment is added to the Viewable by field for the program investment.

1. Navigate to Investment Funding > My Funds.
2. Click an investment card to open an active investment to review fund allocations.
   If you want to open a different investment, access the drop-down menu next to the name of the
currently displayed investment. Either search for another investment by entering its name in the
Search My Investments field or choose it from the five most recently visited investments.
3. On the Allocate Funds tab, click the tree view icon

   Your investment and the investments that you funded directly display as cards in a hierarchical view.
The number of child investments is displayed in the parent investment card. If there are more than 10
investment cards, you can access a compact card view.
4. Click an investment to view its fund allocation to other investments.
   As you drill down to child investment cards, the clickable menu in the top-right corner displays the
current level of the hierarchy.
5. Optional: Click the Actions menu and select View Investment to navigate to the investment grid.

View past funding details

View the past funding details of your investments.
Role required: investment_user

1. Navigate to Investment Funding > My Funds.
2. Click an investment card to open the investment for which you want to view the past funding details.
   If you want to open a different investment, access the drop-down menu next to the name of the
currently displayed investment. Either search for another investment by entering its name in the
Search My Investments field or choose it from the five most recently visited investments.
3. Click the Allocate Funds tab.
4. Right-click on a column on the grid, and select View Past Funding Details to view the funding details
   of your investments for past fiscal periods.
   If you are not the owner of the investment but have been added in the Viewable by field of the
   investment, you can view the investments in read-only mode.
   The graph displays the comparison between the total funds received and the total actuals for the fiscal
   periods in the past one year.

Domain separation in Investment Funding

Overview of domain separation in Investment Funding. Domain separation enables you to separate data,
processes, and administrative tasks into logical groupings called domains. You can then control several
aspects of this separation, including which users can see and access data.

Support level: Basic

• Business logic: Ensure that data goes into the proper domain for the application’s service provider use
cases.
• The application supports domain separation at run time. This includes domain separation from the user interface, cache keys, reporting, rollups, and aggregations.
• The owner of the instance must set up the application to function across multiple tenants.

Use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

Quick start tests for Investment Funding

Validate that Investment Funding still works after you make any configuration change such as applying an upgrade or developing an application. Copy and customize these quick start tests to pass when using your instance-specific data.

The quick start tests require activating the - ATF Tests plugin (com.snc.investment_planning.atf).

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
</table>
| Validation of top-down funding and unfunding      | • Validate that the correct amount is allocated from top investment to child investments while funding.  
• Validate that the correct amount is returned back to the top investment from the child investment while unfunding. |                |
| Validation of bottom-up funding                    | • Validate that the correct amount is requested by the child investment from the parent investment.  
• Validate that the correct amount is allocated back to the child investment from the parent investment. |                |

Time Card Management

The Time Card Management feature enables time card users such as task assignees to report and track their time for the assigned tasks.

Time Card Management works with the Task table to record time worked on various task types, such as projects, incidents, problems, and change requests.

With the Time Card Management feature:
• The time card users can record the time worked on a task using time cards and time sheets. They can submit their time cards and time sheets for approval.
• Time cards and time sheets are routed for approval based on the Non-project time approver and Project time approver fields in the user time sheet policy. User managers with time card approver role can also log time and submit the time sheet of their resources.
• The time card approvers can perform the following tasks:
  • Review and approve or reject the time cards in a submitted time sheet.
  • Recall the approved time sheets or time cards to return them to the users for corrections.
  • Use dashboards to view reports of time card and time sheet exceptions, and categorize time reported by the users.
  • Delegate another time card approver to process time sheets from your resources when you might not have time or will be unavailable. Note the following points for delegation:
    • You cannot delegate approval only for an individual resource.
    • The delegated time card approver cannot further delegate your time sheet approvals.

The project_manager and the resource_manager roles contain the timecard_approver role in the base system. However, the timecard_approver role can also be used independently without these roles.

• The time card admin can create and manage time sheet policies, and can also approve or reject by exception and process the time sheets. Time card admin can also create or edit time cards of any users if the time cards are in Pending or Rejected state.

Watch this five-minute video to learn about setup of the time tracking feature, entering time and approvals.

Note: The Time Card Management plugin is required to use time cards. Some of the procedures require the project management feature, which activates time cards automatically. For more information, see Project Management (com.snc.financial_planning_pmo).

Domain separation in Time Card Management

Domain separation provides complete data isolation for domain-specific users. Time card Management is domain separation compliant at the Data only level.

Activate Time Card Management

Administrators can activate the Time Card Management plugin (com.snc.time_card). The plugin also activates the Performance Analytics - Content Pack - Project Portfolio Suite Dashboards plugin (com.snc.pa.time_card). However, you need a Performance Analytics license to use the dashboards.

Role required: admin

Note: The Time Card Management plugin also gets activated as part of PPM Standard plugin (com.snc.financial_planning_pmo).

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.
Time sheet policies

Time sheet policies contain the policies to which a time sheet, or a time card must adhere.

By default, the Default time sheet policy is available with the system. As a Time card admin, you can create multiple time sheet policies based on different requirements and workflows in your organization. For example, specify a time sheet policy for each department or team and assign appropriate users to them.

Time sheet policies also provide an ability to specify appropriate approval workflow for project and non-project tasks.

A time sheet policy can be set as a default policy. The default policy is a global time sheet policy which applies to all the users who are not assigned to any other time sheet policy. Only one time sheet policy can be set as a default policy.

Navigate to Time Sheets > Administration > Time Sheet Policies to view the list of timesheet policies.

Create a time sheet policy

As a time card administrator, you can create a time sheet policy to define the requirements for time card users to record their time worked. The time card approvers must review and process time sheets under the applicable time sheet policy.

Role required: timecard_admin

1. Navigate to Time Sheets > Administration > Time Sheet Policies.
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of the policy.</td>
</tr>
<tr>
<td>Allow blank time cards</td>
<td>Option to enable submission of blank time cards for approval. By default, this option is not selected.</td>
</tr>
</tbody>
</table>
| Auto create time card on planned task update | Option to create a time card automatically when you update a planned task, if the following conditions are true:  
  • You are a time card user  
  • You are assigned to the task through Assigned to or Additional assignee list field  
  • The task is not in a pending state. By default, this option is not selected. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Auto fill time card with time worked entries      | Option to fill in time cards automatically when you enter time in the **Time worked** field on the Task form. If a time card does not exist for the task, one is created when the time worked is updated if the following conditions are true:  
  • You are a time card user.  
  • You are assigned to the task through the **Assigned to** or **Additional assignee list** field.  
  By default, this option is not selected.                                                                                                    |
| Auto create time cards every week                 | Option to **generate time cards automatically** every week through a scheduled job for all users assigned to the time sheet policy. The time cards are generated based on the planned task assignments and hard-allocated resource plans of the users.  
  By default, this option is selected.                                                                                                        |
| Update actual hours and cost in resource plan/ reports | Option to update actual hours and actual cost of the associated resource plan based on the hours entered in the approved time card.  
  When selected, you can associate a resource plan related to the selected task with the time card in the following ways:  
  • If the task has multiple resource plans, you can select the appropriate plan.  
  • If the task has one resource plan, that plan is selected by default.  
  The hours from the time card entry and the hourly resource rate are used to update the **Actual hours** and **Actual cost** values of the associated resource plan.  
  **Note:** If the task has no resource plan, the associated records update the corresponding project.  
  By default, this option is not selected.                                                                                                        |
| Allow recall                                       | Option to enable the recall action on a time sheet or time card after it is approved and processed.  
  By default, this option is selected.                                                                                                        |
| Recall period allowed (days)                       | Number of days within which you can recall a time sheet or time card.  
  This field appears when the **Allow recall** option is selected.  
  The default value is 30.                                                                                                                   |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Week starts on</td>
<td>Start day of the week for the time sheet. The default value is Sunday.</td>
</tr>
<tr>
<td>Maximum hours per day</td>
<td>Maximum number of hours that can be entered each day in a time sheet. If set to -1, the resource can enter a value from 0 through 24 for the hours worked each day. The default value is 24.</td>
</tr>
<tr>
<td>Maximum hours per week</td>
<td>Maximum number of hours allowed in a week in a time sheet. The value for total hours for a week in a time sheet is the sum of hours entered per day of that week. If set to -1, the total hours per week allowed is up to 168 (24 x 7) hours. The default value is 40.</td>
</tr>
<tr>
<td>Non-project time approver</td>
<td>Type of approval required when you submit a time card that has a non-project task assigned.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Auto</strong>: Time card is auto-approved when submitted.</td>
</tr>
<tr>
<td></td>
<td>• <strong>User Manager</strong>: Time card is routed to the user manager for approval when submitted. The user manager has the time card approver role and is also selected as the manager of the time card user on the User form.</td>
</tr>
<tr>
<td></td>
<td>• <strong>None</strong>: A user with the timecard_admin role can approve time cards when submitted.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Project time approver</td>
<td>Type of approval required when you submit a time card that has the project task.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Auto</strong>: Time card is auto-approved when submitted.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Project Manager</strong>: Time cards for a project task are routed to the respective project manager for approval when submitted. The project manager is picked from the task against which you are submitting time.</td>
</tr>
<tr>
<td></td>
<td>• <strong>User Manager</strong>: Time cards are routed to the user manager for approval when submitted.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Both</strong>: Time cards are routed to both the user manager and project manager for approval when submitted.</td>
</tr>
<tr>
<td></td>
<td>A time card remains in the Submitted state when only one of the approvers approves the time card.</td>
</tr>
<tr>
<td></td>
<td>• <strong>None</strong>: A user with the time_card admin role can approve time cards.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>• The project manager and the user manager can view only those time cards that are routed to them for approval.</td>
</tr>
<tr>
<td></td>
<td>• If the user manager or the project manager changes while the time card is still not approved, the system automatically updates the approver of the time card.</td>
</tr>
<tr>
<td></td>
<td>• If the name of the project manager or the user manager is not populated on the respective form, a user with the time_card admin role can approve time cards.</td>
</tr>
<tr>
<td>Allow multiple rate types</td>
<td>Option to provide a rate type in a time card to be used during expense line generation.</td>
</tr>
<tr>
<td></td>
<td>When this option is selected, the <strong>Rate type</strong> field displays on the Time Card form to enable the selection of a rate type.</td>
</tr>
<tr>
<td></td>
<td>For more information, see <strong>Rate type in labor rate card</strong>.</td>
</tr>
<tr>
<td>Default rate type</td>
<td>Rate type used by default for the time card.</td>
</tr>
<tr>
<td></td>
<td>If you select none, the Standard rate type option is used.</td>
</tr>
<tr>
<td></td>
<td>This field appears when the <strong>Allow multiple rate types</strong> check box is selected.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Default Policy</td>
<td>Option to set the time sheet policy as the default. The default policy is a global time sheet policy that applies to all users who are not assigned to any other time sheet policy. Only one time sheet policy can be set as the default. A time sheet policy set as the default policy cannot be deleted. You must first set another policy as the default policy.</td>
</tr>
</tbody>
</table>

4. Click Submit.
   - Set the time sheet policy as the default policy, if required.
   - Assign the time sheet policy to users.

**Set a time sheet policy as default policy**

As a time card administrator, you can set a time sheet policy as the default policy. The default policy is a global time sheet policy which applies to all the users who are not assigned to any other time sheet policy.

Role required: timecard_admin

Only one time sheet policy can be set as a default policy.

1. Navigate to Time Sheets > Administration > Time Sheet Policies.
2. Open the time sheet policy record.
3. Click the Set as default related link.

**Note:** The related link appears only for a time sheet policy which is not already set as the default policy.

The Default Policy option on the record form is selected to indicate that the current time sheet policy is set as the default policy. The Default Policy option on the earlier default time sheet policy is cleared.

You cannot delete a default time sheet policy. You must first mark another policy as the default policy to delete the current default policy.

**Assign a time sheet policy to a user**

As a time card administrator, you can assign a time sheet policy to a user.

Role required: timecard_admin

You can assign only one time sheet policy to a user.

1. Navigate to Time Sheets > Administration > Time Sheet Policies.
2. Open the time sheet policy record.
3. In the Users related list, click Edit.
4. On the Edit Members form, move the users to the User List.
5. Click Save.

The selected users appear on the Users related list. The time sheet policy is assigned to the selected users.
Create a project time category

A time card admin or a project manager can create subcategories to define specific activities in the projects. The time card users can use these project subcategories to report time for a specific activity in a project.

Role required: timecard_admin, it_project_manager

1. Navigate to Time Sheets > Administration > Project Time Categories.
2. Click New.
3. Fill in the fields.

<table>
<thead>
<tr>
<th>Project time category form fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Description</td>
</tr>
</tbody>
</table>

4. Click Submit.

Create a rate type

You can create rate types using the Rate Types feature.

Role required: timecard_admin

The rate type functionality is used to categorize different types of work. For example, Standard versus Overtime. It can also instruct down-stream, third-party product about the nature of the work performed.

For example:

- A user works extra time during the day and must differentiate standard time from overtime.
- A technician may be paid at a higher rate based on different types of work involved in the execution of a task.
- An appliance repair task may be billed at one rate for the first hour and a different rate for the remaining hours.
- A service call may last four hours during which specialized equipment is used for one hour. The company must capture the use of the specialized equipment for purposes ranging from additional billing to legal compliance or warranty tracking.

1. Navigate to Time Sheets > Administration > Rate Types.
2. Click New and fill the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Provide a suitable name for the rate type.</td>
</tr>
<tr>
<td>Description</td>
<td>(Optional) Summarize the purpose of the rate type.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Active</td>
<td>Deselect the check box to mark the rate type as inactive.</td>
</tr>
</tbody>
</table>

**Note:** Inactivating a rate type does not remove it from records where it exists. When time card processing encounters an inactive rate type on the time card, no matching labor rate card is found. In this case, the system rate is used for generating the expense line.

3. Click **Submit**.

- The rate type is displayed in the **Rate Types** list.
- The rate type if active is also displayed in the **Rate Type** field in the Labor Rate Cards form, Time Worked form, Time Card form, and Time Sheet Portal.

**Time Sheet Portal**

Time Sheet Portal categorizes and displays all your assigned tasks in a single view for a given week. The portal enables you to record time spent on tasks on a day-to-day basis and submit the time sheet in a single action.

Time Sheet Portal works with the Task table to record the time that you spend on various task types, such as projects, incidents, problems, and change requests. It provides a complete breakdown of the time you enter for the task, task categories, and days in a week. It enables you to:

- Generate time cards for assigned projects or project tasks.
- Copy time cards from a previous time sheet.
- Search and create a time card for a task that is not displayed in the assigned tasks list.
- Edit, delete, or add notes to a time card.
- Submit, approve, reject, and recall a time sheet.
- View notifications for the submitted, rejected, and recalled time sheets or time cards.

Time Sheet Portal comprises of the following sections:

**Header**

The Time Sheet Portal header:

- Displays a date range of the time sheet for the selected week and provides options to navigate to the time sheet of previous or next week.
- Provides a calendar along with the date range. Clicking a date in the calendar displays the time sheet for the week of the selected date.
- Provides a link to navigate to the time sheet for the current week when a different time sheet is being viewed.
• Provides an option under **My Time Sheet** that enables you to open and **edit the time sheets of your resources**. The option is available only for a user manager.

• Provides an option to view the time sheet in the Form view using time sheet form view icon ( ).

• Displays the notifications for the submitted, rejected, and recalled time sheets under the show notifications icon ( ). Each entry displays the number of time cards and their state. Click on a notification item to open the time sheet.
The **Tasks** tab displays your assigned tasks as cards. Each card provides information about a task, such as short description, state, last updated date and time, and priority. Tasks are derived from the following filter conditions:

- All your assigned incidents, problems, or change requests that are active.
- All your assigned incidents, problems, or change requests that are closed in the selected week.
- All tasks for which you are hard-allocated during the selected week.
- All your assigned projects or project tasks that are active during the selected week. Project or project tasks are derived from the following conditions:
  - A project or project task that has started and its actual start date is before the end of the selected week.
  - A project or project task has closed and its actual end date is after the week has begun.
  - When there are no actual dates for a project, planned dates of the project must occur within the selected week.
- All active stories assigned to you.
• All active scrum tasks assigned to you or closed in the selected week.
• All active test plans assigned to you.
• All active defect and enhancements assigned to you or closed in the selected week.

**Note:** If the Customer Service Management plugin (com.sn_customerservice) is activated, your assigned tasks that are active and closed in the selected week are also derived from the following tables:

- Case [sn_customerservice_case]
- Work Order [wm_order]
- Work Order Task [wm_task]

On the **Tasks** tab, you can perform the following operations:

• Type a keyword in the search field to view only cards with details that match the keyword.
• Sort cards in ascending or descending order based on priority, irrespective of the task type.
• View cards based on a category, such as projects, project tasks, incident, problem, change, defect, enhancement, test plans, and scrum tasks.
• **Create time cards** for assigned tasks.

**Note:** Time sheet policies apply when you create or edit a time card.
Group Tasks

The **Group Tasks** tab displays the tasks assigned to your **Assignment group**. The group tasks are displayed as cards in the tab. A card provides information about the task, such as short description, state, last updated date and time, and priority.
The **Other** tab displays cards used to log time for operational work, such as administration, meeting, and KTLO.

**Note:** The list of categories in the time card controls the list of cards displayed on the **Other** tab. If an administrator marks any of the categories as inactive in the time cards, those categories are not displayed on the **Other** tab.
The Time Sheet section:

- Displays the date range of the time sheet for the selected week.
- Indicates the state of the time sheet being viewed.
- Displays the total number of tasks and hours that you have entered for each day in a week. When you click a day in the time sheet, the column for that day is highlighted in both the Time Sheet and Logged Time Cards sections. The first day displayed in the Time Sheet section is based on the value specified in the Week starts on field in the users Time Sheet Policy. For example, if the Week starts on field is set to Friday, the Time Sheet section starts with Friday.
- Indicates the total number of hours that you entered in the time sheet. Time Sheet breakdown also displays a breakdown of user-entered hours in different work categories, such as project tasks, admin, meeting, follow on tasks, or change requests.
- Provides options that enable you to submit a time sheet and copy time cards from a previous time sheet. For an approver, options to approve or reject a submitted time sheet and recall a processed time sheet are available.
## Logged Time Cards

<table>
<thead>
<tr>
<th>Short description</th>
<th>Project time category</th>
<th>Rate type</th>
<th>Resource plan</th>
<th>Sun</th>
<th>Mon</th>
<th>Tue</th>
<th>Wed</th>
<th>Thu</th>
<th>Fri</th>
<th>Sat</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Admin</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>5</td>
</tr>
<tr>
<td>Sales Reques...</td>
<td>Develop...</td>
<td>None</td>
<td>RPLN00...</td>
<td>0</td>
<td>2</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>3</td>
<td>0</td>
<td>12</td>
</tr>
<tr>
<td>Security Revi...</td>
<td>None</td>
<td>None</td>
<td>RPLN002...</td>
<td>0</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td>0</td>
<td>20</td>
</tr>
<tr>
<td>Apply patch...</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>5</td>
</tr>
</tbody>
</table>

Each row in the Logged Time Cards section represents a time card entry for a given week. It has details such as icon for state of the time card, short description of the task, project time category, rate type, resource plan, and logged time. Each row of the time card contains options that enable you to edit, delete, or add notes to a time card. For more information, see [Create time cards and log time through Time Sheet Portal](#).

### Note:
- The **Rate type** column is visible only when the **Allow multiple rate types** option in the time sheet policy of the user is selected.
- The **Resource plan** column is visible only when the **Update actual hours and cost in resource plan/reports** option in the time sheet policy of the user is selected.

The icon beside the short description of a row indicates a time card state. The merge icon in a time card row indicates that a duplicate time card for the same task exists in the time sheet and provides option to merge them into a single time card.
When there are no time cards, the Logged Time Cards section displays the **Generate Time Cards** and **Copy from previous time sheet** buttons to create time cards.

**Add columns to the logged time card list**

Add columns in the logged time card list on the Time Sheet Portal to show additional information that you might require to log your time cards.

Role required: admin or sp_admin

1. Navigate to **Service Portal > Widget Instances**.
2. Click the preview time card header icon to open the Time Card Portal Main Container widget instance.
3. On the Instance form, update the code by providing values for the following column configurations in the **Additional options, JSON format** field.

<table>
<thead>
<tr>
<th>Column configuration</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>Name of the column in a table.</td>
</tr>
<tr>
<td>label</td>
<td>Column name to display in the logged time card list on the Time Sheet Portal. The configuration is mandatory if you are adding a column of a table other than the Time Card [time_card] table.</td>
</tr>
<tr>
<td>width_in_percent</td>
<td>Column width in percentage in the logged time card list.</td>
</tr>
</tbody>
</table>

**Note:** To add more than one column, separate each column configuration with a comma. The columns are added in the same order as you add them in the code.

4. Click **Update**.

The following sample code adds the **category** column of the Time Card [time_card] table with the column name **Category** and width of 10% in the logged time card list on the Time Sheet Portal.

```
{
    "tm_grid_options": {
        "displayValue": "Time card grid options",
        "value": {
            "header_fields": [
                {name:"category",label:'Category', width_in_percent: 10}
            ]
        }
    }
}
```
Create time cards and log time through Time Sheet Portal

After you create time cards in Time Sheet Portal, log time in the time cards.

Role required: timecard_user

1. Navigate to Time Sheets > Time Sheet Portal.
2. Create time cards in the Logged Time Cards section using any of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate time cards for assigned projects or project tasks</td>
<td>a. Click choice list next to Submit.</td>
</tr>
<tr>
<td></td>
<td>b. Select Generate Time Cards. The option also appears in the Logged Time Cards section when a user has no time cards for the selected week.</td>
</tr>
</tbody>
</table>

Note:
- If a time card exists for a project task during the selected week, a duplicate time card is not created.
- Time cards are generated only for those project tasks that are in progress or planned for the selected week.
- The Allow time card reporting on field on the project form determines the level at which the time cards are created for project tasks.

<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy time cards from a previous time sheet</td>
<td>a. Click choice list next to Submit.</td>
</tr>
<tr>
<td></td>
<td>b. Select Copy from previous Time Sheet. The option also appears in the Logged Time Cards section when a user has no time cards for the selected week.</td>
</tr>
</tbody>
</table>

Note:
- Time cards for all the project tasks that are in progress or planned in the current week are copied from the selected time sheet. If a time card for a project task exists, a duplicate time card is not created while copying.
- Time cards for all the non-task categories, such as meetings and trainings, are copied from the selected time sheet. If a time card for a non-task category exists, a duplicate time card is created while copying.
Option | Steps
---|---
Create a time card from the Tasks, Group Tasks, or Other tab | a. On the Tasks, Group Tasks, or Other tab, point to a task (card) that you want to create a time card for.  
b. Click Add to Time Sheet.  

| Note: Add to Time Sheet creates a time card with the default rate type of the user, if it exists. |

Create multiple time cards from the Tasks tab | a. On the Tasks tab, select multiple tasks that you want to create time cards for.  
b. Click Add selected to Time Sheet. |

Create a time card for unassigned task | a. In the Logged Time Cards section, click Add unassigned tasks to Time Sheet.  
b. Enter the task number or short description of the task you worked on during the selected week.  

Based on the Allow time card reporting on field settings in the Preferences tab of a project, the Add to Time Sheet and Add selected to Time Sheet options are displayed in Time Sheet Portal.

3. In the Logged Time Cards section, log time in a time card:
Option | Steps
---|---
Through inline editing | a. Select a row and press Enter. You can also double-click a row.  
b. Edit the values as required.  

Through time card form | a. Point to a row and click the more actions icon  
b. To open the Time Card form, click Open Form View.  
c. Enter hours on the time card form.  
d. Click Save.  

Add notes to time cards | a. Point to a row and click the more actions icon.  
b. To add a note, click Add Note.  

Submit time sheet through Time Sheet Portal
Once you update the time sheet with time worked for a given week, submit it for approval.  
Role required: timecard_user
When you submit a time sheet, time cards are verified against the assigned time sheet policy. If there is no time sheet policy assigned, time cards are verified against the default time sheet policy. Business rules prevent you from submitting a time sheet in case any violation is found.

1. Navigate to Time Sheets > Time Sheet Portal.
2. Click Submit.

The time sheet moves to the Submitted state.

### Approve or reject a time sheet through Time Sheet Portal

Review, approve, or reject a time sheet submitted by a time card user that you manage.

Role required: timecard_approver or timecard_admin

A user manager can review, approve, or reject the time sheets or time cards submitted by the time card users. The user manager has either of the required roles and is the one listed as the manager of the time card users.

During out-of-office time, the user manager can delegate another user with the required roles as the time sheet approver. For the specified time period, the delegated user also receives all the time sheets submitted by the time card users to process.

1. Navigate to Time Sheets > Time Sheet Portal.
2. Click the My Time Sheet list and select a time card user under My Resources.

The My Time Sheet list is available only for a user manager.

3. Select the appropriate time sheet period by navigating through the calendar.
4. Click Approve or Reject.

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
</table>
| Approve      | • Time sheets that have time cards with multiple approvers as defined by the time sheet policy, remain in the Submitted state. When all the approvers approve the respective time cards, then the time sheet moves to the Approved state.  
  • Time sheets that have time cards with a single approver move from the Submitted to the Approved state.  
  • A Time Card Daily record is created for each time card to record the time logged. |
| Reject       | • Time cards in the Submitted state are rejected automatically. Time cards in the Approved and Processed state remain unaffected.  
  • A notification about the rejected time sheet is sent to the associated time card user. The user can view the notification from the show notifications icon ( ).  
  
  The user can then modify the rejected time sheet and submit it again for approval. |
Log time and submit time sheets of your resources

As a user manager, you can log time and submit the time sheet of your resources.

A user manager must have time card approver role to create and edit time cards, and submit the time sheet of other time card users. The user manager has either of the required roles and is the one listed as the manager of the time card users.

Role required: timecard_approver

1. Navigate to Time Sheets > Time Sheet Portal.
2. Click My Time Sheet choice list and select the user for whom you want to approve or reject time sheet for under My Resources.

   The My Resources section lists the time card users reporting to you.

   Note: The choice list with My Time Sheet is available only for a user manager.

3. Create time cards and log time as required.
4. Click Submit.

   • The time sheet of the selected user moves to the Submitted state. The time sheet policy assigned to the time card user is used for validation when you submit the time sheet.
   • All the time cards associated with the time sheet are also submitted automatically and move to the Submitted state.
   • The Approve and Reject buttons appear in the Time Sheet section. The two buttons appear only for a user manager.

Once you have submitted the time sheet for your resource, you can click Approve or Reject to approve or reject it. Only the time cards that are routed to the user manager, are approved or rejected. The routing for approval happens based on the Non-project time approver and Project time approver fields in the time sheet policy of the time card user.

Time Sheets

A time sheet groups all the time cards for a user for the given week.

With time sheets:

• Time card users can submit all the time for their work week in a single step by using a time sheet.
• Time card approvers can approve all the time cards in a time sheet for a user in a single step by approving the time sheet. They do not need to approve multiple time cards for a given user individually.
• Track the activities of a time sheet, such as who submitted or approved a time sheet, in the Activities section on the Time Sheet form. This time sheet activity audit is useful for tracking when you delegate responsibility for your time card processing to another user. To track the activities, enable the State field of the Time Card [time_card] table for auditing the time card activities, if it is not already enabled. For more information, see Include a table field in auditing.

A time sheet can have any of the following states:

• Pending
• Submitted
• Approved
• Processed
• Rejected
• Recalled
Create a time sheet

As a time card user, you can create a time sheet to group all your time cards for the given week and submit them in a single step.

Role required: timecard_user

A user can create only one time sheet per week.

Note: When a user creates a time card for a week, a time sheet is also automatically created for that week.

1. Create the time sheet with one of these options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the time sheet menu</td>
<td>Navigate to Time Sheets &gt; My Time Sheets &gt; Current (This Week).</td>
</tr>
<tr>
<td></td>
<td>The time sheet form for the current week opens.</td>
</tr>
<tr>
<td>From the time sheet list</td>
<td>a. Navigate to Time Sheets &gt; My Time Sheets &gt; All &gt; New.</td>
</tr>
<tr>
<td></td>
<td>b. Click New.</td>
</tr>
</tbody>
</table>

2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Week starts on</td>
<td>Starting date of the week for which the time sheet is created.</td>
</tr>
<tr>
<td></td>
<td>Note: The time sheet policy Week starts on controls the start day of the week.</td>
</tr>
<tr>
<td>Total Hours</td>
<td>Number of hours the user has worked in that week. This field is automatically populated from the hours recorded for the associated time cards.</td>
</tr>
<tr>
<td>User</td>
<td>Name of the user for which time sheet is created.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the time sheet. All new time sheets begin as Pending.</td>
</tr>
<tr>
<td></td>
<td>Default states: Pending, Submitted, Approved, Processed, and Rejected.</td>
</tr>
<tr>
<td>Comments</td>
<td>Comments related to the time sheet.</td>
</tr>
<tr>
<td>Notes</td>
<td>Any additional information.</td>
</tr>
</tbody>
</table>

3. Click Submit.

Add time cards to the time sheet. You can use the related links and related list to add time cards. You can also add time cards using the Time Sheet Portal.
Time sheet form related links and lists

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Related links</strong></td>
<td></td>
</tr>
<tr>
<td>Generate Time Cards</td>
<td>Link to generate time cards for the assigned project tasks.</td>
</tr>
<tr>
<td>Copy from previous time sheet</td>
<td>Link to open the Copy Time Sheet window for you to copy the time cards from previous time sheets.</td>
</tr>
<tr>
<td>Time Sheet Portal</td>
<td>Link to open the Time Sheet Portal to view and manage the time sheet.</td>
</tr>
<tr>
<td><strong>Related lists</strong></td>
<td></td>
</tr>
<tr>
<td>Time Cards</td>
<td>List of the time cards that are part of the time sheet. To create a time card, click New.</td>
</tr>
</tbody>
</table>

Submit a time sheet

Once the time sheet is updated with time worked, you can submit the time sheet for the week to submit all the time cards for the week together.

Role required: timecard_user

When a user submits a time sheet, the time sheet policy assigned to the user is used for validation. If there is no time sheet policy assigned to the user, the default time sheet policy is used. Business rules prevent a user from submitting a time sheet in case any violation is found.

Note: You can also perform this task from the Time Sheet Portal.

1. Navigate to the time sheet using one of the following options:
   - To submit a time sheet in the Pending state, navigate to Time Sheets > My Time Sheets > Pending.
   - To submit the time sheet for the current week, navigate to Time Sheets > My Time Sheets > Current Time Sheet.
   - To submit a time sheet in the Rejected state, Time Sheets > My Time Sheets > Rejected. You can make required changes as suggested in the rejection comments to resubmit a rejected time sheet.

2. To submit in the Time Sheets list, open the time sheet.
3. Add comments, if required.
4. Click Submit Time Sheet.
   - The time sheet moves to the Submitted state.
   - All the time cards associated with the time sheet are also submitted automatically and move to the Submitted state.

Approve or reject a time sheet

As a user manager, you can view and approve or reject a time sheet to approve or reject all the time cards for a user for the given week in a single step.

Role required: timecard_approver or timecard_admin
A user manager is the one who has either of the required roles and is selected in the Manager field on User form of the time card user.

During out-of-office time, the user manager can delegate another user with the required roles as the time sheet approver. For the specified time period, the delegated user also receives all the time sheets submitted by the time card users to process.

1. Navigate to Time Sheets > Time Sheets > Pending Approval.
2. In the Time Sheets list, open the time sheet to approve or reject.
3. If required, add comments.
4. Click Approve or Reject.

- The time sheet moves to the Approved or Rejected state.

**Note:** If a time sheet is rejected, it gets listed in the notifications for the rejected time sheets under the show notifications icon on Time Sheet Portal.

- All the time cards associated with the time sheet are also approved or rejected automatically.
- If any time cards in the time sheet are pending approval by one of the approvers as defined by the time sheet policy, the time sheet remains in the Submitted state.

**Note:**
- You can also approve or reject the time cards within a time sheet selectively by selecting one or more time cards and approving or rejecting them.
- If a time sheet is rejected, all the associated time cards in the Submitted state are also rejected automatically. The time cards in the Approved and Processed state for the time sheet remain unaffected.
- If all the time cards in a time sheet are approved, the time sheet automatically moves to the Approved state.
- If a time card in a time sheet is in the Rejected state, then irrespective of the state of other time cards in the time sheet, the time sheet also moves to the Rejected state.

**Recall a processed time sheet**

You can recall an incorrect time sheet in the Approved or Processed state to return it to the submitter. The submitter can then make the necessary changes and resubmit the time sheet.

Role required: timecard_approver or timecard_admin
The recall option is available only if the **Allow recall** option is selected on the associated time sheet policy.

1. Navigate to the approved or processed time sheet you want to recall using one of the following options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>b. Click the My Time Sheet list and select a user under My Resources.</td>
</tr>
<tr>
<td></td>
<td>c. Navigate through the Calendar widget to select the time sheet.</td>
</tr>
<tr>
<td></td>
<td>The time sheet must be within the recall period specified in the time sheet policy.</td>
</tr>
</tbody>
</table>

| From the Time Sheet form        | a. Navigate to Time Sheets > Time Sheets > All.                                                   |
|                                 | b. Open the time sheet.                                                                           |
|                                 | The time sheet must be within the recall period.                                                  |

2. Click **Recall**.

- Changes the state of the time sheet and associated time cards to **Recalled**.
- Reverts the actual effort and resource hours in a project or demand created when time cards that have task types were approved.
- Creates negative expense lines to zero out the corresponding expense lines created when the time sheet was approved.
- Returns the time sheet to its submitter for modifications.

**Delegate time sheet approvals to another user**

You can delegate the responsibilities to process the time sheets of your resources to another user when you might not have time or will be unavailable.

**Role required:** timecard_admin or timecard_approver

The delegate must have the timecard_approver role.

1. Navigate to **Time Sheets > Delegate**.
2. In the Delegates list, click **New**.
3. On the form, fill in the fields.

**Delegate form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delegate</td>
<td>User to whom the approvals and tasks are delegated.</td>
</tr>
<tr>
<td>Starts</td>
<td>Start date of the delegation period.</td>
</tr>
<tr>
<td>Ends</td>
<td>End date of the delegation period.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>------------------------------------------------------------</td>
</tr>
<tr>
<td>Approvals</td>
<td>Option that enables time card approval delegation.</td>
</tr>
</tbody>
</table>

**Note:** The other options on the form (Assignments, CC notifications, and Meeting invitations) are not applicable for time sheet approval delegation.

4. Click **Submit**.

The approval delegation has the following effects during the specified period:

- Both you and the delegate receive notifications regarding approval activity.
- On the Time Sheet Portal, the delegate can see your resources under **Delegates** in the **My Time Sheet** list.
- Delegates can perform all the functions that you can do for your resources in the Time Sheet Portal: create and submit their time sheets, approve or reject the submitted time sheets, and recall the processed time sheets.

**Time cards**

Time cards are used to record the time worked on a task by a task assignee.

The time card management feature works with the Task table to record time worked on Projects, Incidents, Problems, and Change Requests.

Task assignees can record time worked in the **Time worked** field on a task record or enter hours directly into their time card. Some tables support automatic time card creation based on start and end date fields.

Track the activities of a time card, such as who submitted or approved a time card, in the Activities section on the Time Card form. This time card activity audit is useful for tracking when you delegate responsibility for your time sheet processing to another user. To track the activities, enable the **State** field of the Time Card [time_card] table for auditing the time card activities, if it is not already enabled. For more information, see Include a table field in auditing.

You can associate time cards for the project tasks and other task categories, such as meeting and training, with relevant resource plans.

When you approve a time card, the time logged in the time card is saved day-wise in the Time Card Daily [time_card_daily] table. Using daily time logged data, you can generate time card reports by days for any period irrespective of the time sheet period to which the time cards belong. For example, you can create monthly time card report that includes time cards from the first day to the last day of the month.

Time cards also have an optional approval mechanism for project managers to approve the time cards. Administrators and time card approvers can see all the time cards for the week. All users who are in a role that is responsible for working on tasks also can access their personal time cards. A time card can have any of the following states:

- Pending
- Submitted
- Approved
- Processed
- Rejected
- Recalled
Create a time card

You can create time cards to log time against the work you have done.

Role required: timecard_user

The Allow time card reporting on field on the project form determines the level at which the time cards for the project tasks can be created.

Time cards can be created automatically or manually.

- **Automatic**: Use the following options to automatically generate the time cards:
  - **By updating task**:
    - **Auto create time card on task update**
      Configure time cards to be created when a user updates a task record. The Auto create time card on task update setting in the assigned time sheet policy controls this behavior and is set to false by default.
    - **Auto fill time card with time worked entries**
      Configure time cards to be created when a user records Time worked. A time card is created if a time card does not exist for the task. The time sheet policy Auto fill time card with time worked entries controls this behavior and is set to false by default.

    In Project Task, Incident, Problem, and Change records, the Time worked field does not appear by default and must be configured on the form.
  - **By scheduled job**: Configure time cards for the project tasks to be generated automatically for users through a scheduled job. Only the admin can configure a scheduled job.

- **Manual**: Create a time card for each task and enter the time manually.

1. Create the time card using one of the following options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>b. Open the week on the Calendar for which you want to create the time card.</td>
</tr>
</tbody>
</table>

| From a Time sheet related list | a. Open the time sheet that you want to create the time card for. |
|--------------------------------| b. In the Time Cards related list, click New. |
From a Time sheet related link

- Open the time sheet for which you want to create the time card.
- Click any of the following related links:
  - Generate Time Cards: This option generates the time cards for all project tasks assigned to the user for the time sheet week. With this option, time cards are generated only for the project tasks that are in progress or planned in that week.
  - Copy from previous time sheet: This option copies all the time cards (for project and non-project tasks) from a selected time sheet.

Note:
When using the related links for creating time cards:
- If a time card exists for a project task for the time card week, a duplicate time card is not created.
- Time cards are generated only for those project tasks that are in progress or planned in that week.

2. On the form, fill in the fields.

Time card form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Week starts on</td>
<td>Starting date of the week of the time sheet.</td>
</tr>
<tr>
<td>Note:</td>
<td>The time sheet policy Week starts on controls the start day of the week.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the time card. All new time cards begin in the Pending state. Different states of a time card are Pending, Submitted, Approved, Processed, Rejected, and Recalled.</td>
</tr>
<tr>
<td>Category</td>
<td>Type of task for which the time card is created.</td>
</tr>
<tr>
<td>Task</td>
<td>Task that is associated to the time card.</td>
</tr>
<tr>
<td>Project time category</td>
<td>Type of activity in the project that time is reported for.  This field appears when you select Project/Project Task or Task work in the Category field.</td>
</tr>
<tr>
<td>User</td>
<td>Name of the user that the time card is created for.</td>
</tr>
</tbody>
</table>
### Field

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rate type</td>
<td>Rate type that is considered during the expense line generation. For more information, see Rate type in labor rate card.</td>
</tr>
</tbody>
</table>
| Resource Plan | Resource plan of the task associated with the time card. When the time card is approved, the hours from the time card entry and the hourly resource rate are used to update the Actual hours and Actual cost values of the associated resource plan. A resource plan is associated with the time card in the following ways:  
  - If the task has multiple resource plans, you can select the appropriate plan.  
  - If the task has one resource plan, that plan is selected by default.  |
| Remaining effort | Amount of work time left for the planned task. Remaining effort is the remaining effort in the planned task table and is calculated as:  
  \[ \text{Remaining effort} = \text{Planned effort} - \text{Actual effort} \]  |

**Note:** This field appears when the Allow multiple rate types option is selected in the assigned time sheet policy of the user.

**Note:** If the task has no resource plan, the associated record update the corresponding project.

**Note:** This field appears when the Update actual hours and cost in resource plan/reports option is selected in the assigned time sheet policy of the user.

**Note:** The field is not available on the Time Card form by default. Configure the form to add this field if required.

### 3. Click **Submit**.

- The time card is created for the selected time card period.
- If the time sheet for the week does not exist, a time sheet is created for the time card week.

After the time card is created, the hours for that task can be incremented automatically from the Time worked field in the task record. The time sheet policy Auto fill time card with time worked entries controls the way the time is updated in time cards. The policy is set to false by default. If automatic updates for time worked are not configured, the user must manually update the time card.
Copy time cards from a previous time sheet

Another option for creating time cards is to copy them from an existing timesheet, which copies all the time cards (for project as well as non-project tasks) from a selected time sheet.

Role required: timecard_user

You can also perform this task from the Time Sheet Portal.

1. Open the time sheet record that you want to create the time cards for.
2. Click the Copy from previous time sheet related link.
3. In the Select Time Sheet field, select a previous time sheet that you want to copy the time cards from.
4. Optionally, if you want to copy the time logged for the tasks in the previous time sheet, select the Copy time logged check box.
5. Click OK.

Time cards for project tasks

Time cards for all the project tasks that are in progress or planned in the current week are copied from the selected time sheet. If a time card for a project task exists, a duplicate time card is not created during copying.

Time cards for non-task category

Time cards for all non-task category such as meetings and trainings are copied from the selected time sheet. If a time card for a non-task category exists, a duplicate time card is created during copying.

Note:
- If the previous time sheet has rate types and the time sheet policy of the user allows rate types, then rate types are also copied into the current time sheet.
- If the previous time sheet has rate types, but the time sheet policy of the user no longer allows rate types, then rate types are not copied to the current time sheet.
- If the previous time sheet has a rate type that is inactive, that rate type is not copied. If necessary, the user can enter a different rate type before saving the individual time cards.

Auto-generate time cards

As an admin, you can configure a scheduled job to generate time cards automatically for project tasks assigned to time card users.

Role required: admin

In addition to the manual option Generate Time Cards, a scheduled job can be run to automatically generate the time cards for project tasks. A job can be scheduled to run every week, for example, on every Sunday to generate time sheets for all users for the next week. You can configure when to run the scheduled job based on the business process of the organization. By default, the scheduled job is turned off. For more information, see Schedule a script execution.

Note: The scheduled job auto-generates time cards only for those users who have the Auto create time cards every week option set to true in their assigned time sheet policy.

1. Navigate to System Definition > Scheduled Jobs.
2. In the Scheduled Jobs list, select Auto Generate Time Cards.
3. Configure the following parameters in the script as per the business requirements:
   - run for (CURRENT_WEEK, NEXT_WEEK, LAST_WEEK)
• Group Name (includeGroups, excludeGroups)

Note:
• If a time card exists for a project task for the time card week, a duplicate time card is not created.
• Time cards are generated only for those project tasks that are in progress or planned in that week.
• The **Allow time card reporting on** field on the project form determines the level that the time cards for the project tasks are created at.

The following example script is executed when a scheduled job is run to generate time cards for the current week for the **Database** and **Hardware** groups:

```javascript
// Clone this schedule job to run separately for different groups at different times
// One of the following values
// TimeCardConstants.CURRENT_WEEK
// TimeCardConstants.NEXT_WEEK
// TimeCardConstants.LAST_WEEK
var runFor = TimeCardConstants.CURRENT_WEEK;
// Comma separated group sys ids or group names. TimeSheet/TimeCards will be auto generated for time card users in the given groups.
var includeGroups = [Database, Hardware];
var excludeGroups = [];

var generator = new TimeCardGenerator();
generator.generateFromConfig(runFor, includeGroups, excludeGroups);
```

Submit a time card

As a time card user, once a time card for the week is updated with the time worked, you can submit the time card individually.

A time card in the Pending or Rejected state can be submitted.

Role required: timecard_user

When a user submits a time card, the **time sheet policy** assigned to the user is used for validation. If there is no time sheet policy assigned to the user, the default time sheet policy is used. Business rules prevent a user from submitting a time card in case any violation is found.

1. Navigate to:
   • **Time Sheets > My Time Cards > All**
   • The **Time cards** related list in a time sheet.

   **Note:** You can select multiple time cards to submit.

2. In the Time Card list, open the time card to submit.
3. Click **Submit Time Card**.

   • The time card moves to the Submitted state.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
The time card is submitted to an approver based on the values set in the **Project time approver** and **Non-project time approver** fields in the time sheet policy assigned to the user.

**Note:** If the project or user manager is changed after submitting the time card, the time card is automatically redirected to the new project or user manager for approval.

### Approve or reject a time card

As a time card approver, you can view and approve or reject a submitted time card.

**Role required:** timecard_approver or timecard_admin

You can view only those time cards that are submitted to you for approval or you have been delegated as the time card approver by one of the other user managers. The time sheet policy assigned to the user governs the approval process.

1. Navigate to **Time Sheets > Time Cards > Pending Approval**.
2. Select the time card to approve or reject.
3. Click **Approve** or **Reject**.

- The time card moves to the Approved or Rejected state.
- For an approved time card, a Time Card Daily record is created.

**Note:**
- A user manager can also approve the time cards within a time sheet by selecting one or more time cards and approving them. When all the time cards in a time sheet are approved, the time sheet automatically moves to the Approved state.

A user manager is one who is selected in the **Manager** field on User form of the time card user.
- If a time card is in the Rejected state, the associated time sheet also moves to the Rejected state irrespective of the state of other time cards in the time sheet.

**Note:** If a time sheet is rejected, it gets listed in the notifications for the rejected time sheets under notifications icon on Time Sheet Portal.

- If **Project time approver** is set to **Both** in the assigned time sheet policy, the time card is in the Submitted state only if both approvers approve it. If one of the approver rejects, the time card state is set to Rejected and the **Approved by** field is cleared, requiring approval of both approvers on resubmission.

### Recall a processed time card

You can recall an incorrect time card in the Approved or Processed state to return it to the submitter. The submitter can then make the necessary changes and resubmit the time card.

**Role required:** timecard_approver or timecard_admin

The recall option is available only if the **Allow recall** option is selected on the associated time sheet policy.

1. Navigate to **Time Sheets > Time Sheet Portal**.
2. Click the My Time Sheet list and select a user under My Resources.

3. Navigate through the Calendar widget to select the time sheet.
   The time sheet must be within the recall period specified in the time sheet policy.

4. To recall a time card, click the more actions icon ( ) and select the Recall option.
   - Changes the state of the time card to Recalled. The state of the associated time sheet also changes to Recalled until all time cards in the time sheet are approved or processed again.
   - Reverts the actual effort and resource hours in a project or demand created when the time card for a task type was approved.
   - Creates negative expense lines to zero out the corresponding expense lines created when the time card was approved.
   - Returns the associated time sheet to its submitter for modifications.

Map a time card category with operational work types

Map custom time card categories with operational work types so you can select only the operational resource plans that are associated with the user for a specific time card period and category while posting time.

Role required: pps_admin

By default, all base system time card categories are mapped with the base system operational work types. If mapping is not done for custom categories, the Resource Plan field displays all the operational resource plans associated with the user for that time period when you create a time card.

During time card creation, after you select a time card category and task or during time sheet submission for other category time cards, operational resource plans are populated for that category and task as described in the following table.

<table>
<thead>
<tr>
<th>Operational resource plans for tasks and categories</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Category</strong></td>
</tr>
<tr>
<td>Admin, External labor, Meeting, Phone call, Training, Out of office, Appointment, Time off, KTLO</td>
</tr>
</tbody>
</table>
### Category | Task | Resource Plan
--- | --- | ---
Custom | Any of the task/project/demand/project task/demand task | Displays the resource plans associated with the task, project, demand, project task, or demand task when a task is selected. If no resource plans are associated with the selected task, or no task is selected, then the mapped operational resource plan for that custom operational work type for that category is displayed. If mapping is not done, then all the operational resource plans are displayed.
Other category (custom and OOTB) from Time Sheet Portal | N/A | Displays the mapped operational resource plans. If mapping is not done, then all the operational resource plans are displayed.

1. Navigate to **Project Administration > Time Card Category Mapping**.
2. Click **New**.
3. From the **Time card category** menu, select the required time card category.
4. From the **Operational work type** menu, select the operational work type you want to map to the time card category you selected in the previous step.
5. Click **Submit**.

### Record time worked

The time card retrieves time accrued on a project or spent working on any record in the Task table from the **Time worked** field.

This field does not appear by default on the Project Task, Incident, Problem, and Change forms and must be added by personalizing the form. Time recorded in this field is used to populate an existing time card or to create a new time card if one does not exist. A **time sheet policy** controls this behavior.

**Note:**

When time worked is updated, a time card is created only if:

- the user is a time card user, AND
- the user is assigned to the task through **Assigned to** or **Additional assignee list** field.

The **Time worked** field has a counter that acts like a stopwatch for the duration of the time spent in the record. A button in the field can stop and start the counter. By default, the **Time worked** counter is enabled and begins recording the elapsed time when the record is opened. Stop the counter with the stop button and restart it with the play button.

Time counter started:
Time worked started

Time counter stopped:

Time worked stopped

If you are creating time cards from time worked entries, you can add the related list to display the time worked records on the time card form. You will also notice an informational message on the time card to let you know that changes to time worked records overrides values in the time card. This is displayed using a formatter, which can be added or removed by configuring the form.

Manage costs

When the cost management feature is enabled, time cards can be used to manage the cost of labor in the Cost Management application.

When a time card for a project task is approved, an expense line is generated for the corresponding labor cost associated with the project. If the project has a rate model associated, then the hourly rate for calculating labor cost for the expense lines is derived from the rate model. If no rate model is associated to the project, the rate listed in the Labor Rate Card is considered. If no Labor Rate Cards is applicable, the property `com.snc.time_card.default_rate` defines the default hourly rate.
Roles

The timecard_admin role enables users to approve, modify, and delete the time cards of other users.

Project Manager Dashboard

The Project Manager Dashboard provides the project managers with quick reports of time card exceptions, and category wise time reported for their projects. The dashboard displays time card reports only for the projects managed by a project manager.

The dashboard can be activated using the Performance Analytics - Content Pack - Project Portfolio Suite Dashboards plugin (com.snc.pps_dashboards). You require Performance Analytics license to use this dashboard.

The reports in the dashboard are filtered based on Project, and Date selected.

The project manager dashboard consists of these components:

Project time card exception count

It displays the total count of entries in Project time card exceptions report.

![Project time card exception count](image)

Project time card exceptions report

The Project time card exceptions report lists the users who did not submit their time cards, and the time cards which are not yet approved for the selected project and time range. The exception report is generated for the users who are assigned to a task in progress, or hard allocated to the project/task in that time range. The report displays the following data:

- **User**: The time card user assigned to the selected project, or hard allocated to the resource plan associated with the project. If there are more than one time cards for a user in a given date range which are not submitted or require approval, then multiple entries are listed for the user.
- **Week starts on**: Starting date of the time card week in the selected time range.
- **State**: State of the time card. Time card entries with state as Not Submitted are also listed if a time card is not created for the week.

The report is generated from the project_timecard_exception table. It requires the schedule job Project Time Card Exceptions to be running to get the up-to-date information.
### Project time card exceptions report

<table>
<thead>
<tr>
<th>Name</th>
<th>Date</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alyssa Biasotti</td>
<td>2017-05-14</td>
<td>Submitted</td>
</tr>
<tr>
<td>Alyssa Biasotti</td>
<td>2017-05-07</td>
<td>Submitted</td>
</tr>
<tr>
<td>Caitlin Reiniger</td>
<td>2017-04-23</td>
<td>Submitted</td>
</tr>
<tr>
<td>Caitlin Reiniger</td>
<td>2017-04-30</td>
<td>Submitted</td>
</tr>
<tr>
<td>Colin Altonen</td>
<td>2017-04-30</td>
<td>Not Submitted</td>
</tr>
<tr>
<td>Terrell Rodda</td>
<td>2017-04-23</td>
<td>Submitted</td>
</tr>
<tr>
<td>Alyssa Biasotti</td>
<td>2017-04-30</td>
<td>Not Submitted</td>
</tr>
<tr>
<td>Caitlin Reiniger</td>
<td>2017-04-30</td>
<td>Not Submitted</td>
</tr>
<tr>
<td>Freida Michelfelder</td>
<td>2017-04-30</td>
<td>Not Submitted</td>
</tr>
<tr>
<td>Terrell Rodda</td>
<td>2017-04-30</td>
<td>Not Submitted</td>
</tr>
</tbody>
</table>

### Total approved hours for project(s)

It displays the total approved hours in all project categories displayed in **Time by Project Time Category** report.
Total approved hours for project(s)

1,253

Total approved hours for projects

Time by Project Time Category report

The bar chart report displays the time approved against each project category for the users allocated to the selected project.
Use the Project Manager Dashboard

The Project Manager Dashboard shows the time card reports for the selected projects.

Role required: it_project_manager, timecard_admin

1. Navigate to Time Sheets > Project Manager Dashboard.
2. Select a project and date range from the Project and Date choice lists.
3. Review the displayed reports and take necessary actions, if required.
User Manager Dashboard

The User Manager Dashboard provides the user managers with reports of time sheet exceptions, and category wise time reported by the users.

The dashboard can be activated using the Performance Analytics - Content Pack - Project Portfolio Suite Dashboards plugin (com.snc.pps_dashboards). You require Performance Analytics license to use this dashboard.

The dashboard displays time sheet reports only for those time card users who have the Manager field on User form set to the current user.

The reports in the dashboard are filtered based on Date range, and User selected.

The user manager dashboard consists of these components:

Time sheet exception count

It displays the total count of entries in Time sheet exceptions report.

Time sheet exceptions report

The Time sheet exceptions report lists the users who did not submit/create their time sheets, and the time sheets which are not yet approved for the selected user, and time range. The report displays the following data:

- **User**: The time card user whose manager in User profile is the current user. If there are more than one time sheets for a user in a given date range which are not submitted or require approval, then multiple entries are listed for the user.
- **Week starts on**: Starting date of the time sheet week in the selected time range.
- **State**: State of the time card. Time sheet entries with state as Not Submitted are also listed if a time sheet is not created for the week.

The report is generated from the time_sheet_exception table. It requires the schedule job Time Sheet Exceptions to be running to get the up-to-date information.
Total approved hours

It displays the total approved hours in all categories displayed in Time by category report.
Total approved hours

485

Time by category report

The bar chart report displays the time approved against each category for the selected users whose manager in User profile is the current user.
Use the User Manager Dashboard

The User Manager Dashboard shows the time sheet reports for the users.

Role required: resource_manager, timecard_admin

The dashboard displays time sheet reports only for those time card users who have the Manager field on User form set to you.

1. Navigate to Time Sheets > User Manager Dashboard.
2. Select a date range and user from the Date and User choice lists.
3. Review the displayed reports and take necessary actions, if required.
Performance Analytics dashboard for Time Card Management

Analytics and Reporting Solutions contain preconfigured dashboards. These dashboards contain actionable data visualizations that help you improve your business processes and practices.

The Time Card Management and Time Sheet dashboards are included in the Project Portfolio Suite with Financials Dashboards. For more information, see Project Portfolio Management Analytics and Reporting Solutions.

Domain separation in Time Card

This is an overview of domain separation in Time Card. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Support level: Basic

- Business logic: Ensure that data goes into the proper domain for the application’s service provider use cases.
- The application supports domain separation at run time. This includes domain separation from the user interface, cache keys, reporting, rollups, and aggregations.
- The owner of the instance must set up the application to function across multiple tenants.

Use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

Mobile Time Sheets

The ServiceNow® Mobile Timesheets app enables time sheet users and managers to access their time sheets from a mobile device. Mobile Time Sheets is available on the Now Mobile app and is supported on iOS and Android devices.

Time sheet users can use Mobile Time Sheets to create, view, edit, enter notes, and submit their time cards from a mobile device. Time sheet project managers or user managers can view, approve, reject, or recall a time sheet or time card from a mobile device.

To access time sheets from your mobile device, you must first download the Now Mobile application on an iOS platform from the Apple App Store or on an Android platform from the Google Play Store.

Features

The Mobile Time Sheets app provides the following capabilities to time sheet users:

- Create a time sheet
- Create a time card
- Log hours on the time card
- Create notes
- Submit a time sheet
- Submit a time card
The Mobile Time Sheets app provides the following capabilities to resource or project managers:

- Approve or reject a time sheet
- Approve or reject a time card
- Recall a time sheet or time card
Install Mobile Time Sheets

Install the Mobile Time Sheets application from the ServiceNow Store website.

Role required: admin

1. Navigate to System Applications > All Available Applications > All.
2. Find the application using the filter criteria and search bar.
   You can search for the application by its name or ID. If you cannot find an application, you may have to request it from the ServiceNow store.
3. Click Install.
4. In the Application installation dialog box, review the application dependencies.
   If your application requires other applications, you need to install them first if they are not already installed.
   Installing your application also automatically installs dependent applications or plugins if they are not installed already.
5. If demo data is available and you want to install it, click **Load demo data**. Some applications include demo data, which are sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.

6. Click **Install**.

**Enabling the mobile experience for Mobile Time Sheets**

Enable the mobile experience for Mobile Time Sheets so users can fill out time sheets and user managers can approve or reject them from their mobile device.

Role required: admin

1. Install the Mobile Time Sheets application on your instance.
2. Download the Now mobile application on an iOS platform from the Apple App Store or on an Android platform from the Google Play Store.
   
   For more information on using this mobile app, see the [Now Mobile app](#) topic.
3. Add the instance that has Mobile Time Sheets installed to the Now Mobile application and log in to access the application data on your mobile device.

**Log in to an instance with a mobile app**

**Use Mobile Time Sheets in Now Agent**

You can configure your platform system to use Mobile Time Sheets in the Now Agent application. By default, Mobile Time Sheets can be viewed in the Now Mobile application.

Role required: admin

The Mobile Time Sheets app must be installed in your system.

1. Navigate to System Mobile > Navigation Bar.
2. Click **Now Mobile Nav**.
3. From the Navigation Tabs related list, delete the time sheet record.
5. Click **Now Agent**.
6. Create a new record for the time sheet in the Navigation Tabs related list.
7. Download and enable the Now Agent app. For more information, see the [Agent mobile app](#) topic.

**Create a time sheet from your mobile device**

Create a time sheet to group all your time cards for the given week and submit them in a single step from the Now Mobile application.

Role required: timecard_user

1. Log in to your instance in the Now Mobile application.
2. Tap the plus icon located on the top-right corner.
3. In the Week starts on field, select the starting date of the week for which the time sheet is being created.
4. Tap the forward icon.

Add time cards to the time sheet

**Search for a time sheet from time sheet lists**

Search for a specific time sheet from the time sheet lists by applying filters.
Role required: timecard_user

You can apply filters on the time sheet lists to search for a specific time sheet in the All Time Sheets, Rejected, and Recalled groups, or while copying time cards from a previous time sheet. You can apply one or more filters while searching for a time sheet.

1. Log in to your instance in the Now Mobile application.
2. Open the All Time Sheets, Rejected, or Recalled list.
3. Tap the Filters icon located on the top-right corner.
4. From the State menu, select the state of the time sheet, and tap the Back icon.
5. Enter the total range of hours in the From and To fields.
6. Select the week on which the time sheet starts.
7. Select the user assigned to the time sheet in the User field.
8. Select Apply.

Add a time card and log time through the Mobile Time Sheets application

Create time cards to log time from your mobile application for the work you have done.

Role required: timecard_user

The Allow time card reporting on field on the project form determines the level at which time cards for the project tasks can be created. For example, at the project level, if a user is assigned to multiple tasks in a project, then the time spent on all the tasks is recorded under one time card only; and at the project task level, separate time cards are created corresponding to each planned task.

1. Log in to your instance in the Now Mobile application.
2. Open a time sheet from the Timesheet tab.
3. Tap the action icon.
4. Add task-related or non-task related time cards.

<table>
<thead>
<tr>
<th>Time card type</th>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>All time cards for project and non-project tasks</td>
<td>Copy from previous time sheet</td>
</tr>
<tr>
<td>from a selected time sheet</td>
<td></td>
</tr>
<tr>
<td>Time cards for all project tasks assigned to the</td>
<td>Generate time cards</td>
</tr>
<tr>
<td>user for the time sheet week that are in progress or</td>
<td></td>
</tr>
<tr>
<td>planned in that week</td>
<td></td>
</tr>
<tr>
<td>Time card for assigned task</td>
<td>Add assigned task</td>
</tr>
<tr>
<td>Time card for unassigned task</td>
<td>Add unassigned task</td>
</tr>
<tr>
<td>Time card for operational work, such as administration, meeting, and KTLO</td>
<td>Add other</td>
</tr>
</tbody>
</table>

5. Optional: Find a specific time card once you have chosen to add a time card for an assigned or unassigned task.
   a) Tap the Filters icon located on the top-right corner.
   b) Enter the short description of the project in the Short description field.
   c) Enter the project number in the Number field.
   d) Enter the short description of the top task in the project in the Short description field.
   e) Select Apply.
6. Log time in a time card using either of two methods:
   • Tap a task on the time sheet and select **Edit**.
   • Swipe right on a task and select **Edit**.

7. Edit the hours as required.

8. Tap the forward icon.

**Submit a time card from your mobile device**

Once a time card for the week is updated with the time worked, you can submit the time card from your mobile application.

Role required: timecard_user

1. Log in to your instance in the Now Mobile application.
2. Open a time sheet.
   Cards that have not yet been submitted are in the Pending state. You can also submit cards that are in the Rejected state once you have fixed the issues that caused the rejection.
3. Submit a time card using one of the following methods:
   • Tap a task on the time sheet, select the actions menu, and then select **Submit timecard**.
   • Swipe right on a task and select **Submit**.
   • The time card moves to the Submitted state.
   • The time card is submitted to an approver based on the values set in the **Project time approver** and **Non-project time approver** fields in the time sheet policy assigned to the user.

**Note:** If the project or user manager is changed after submitting the time card, the time card is automatically redirected to the new project or user manager for approval.

**Submit a time sheet from your mobile device**

Once you have updated the time sheet with the time you worked, you can submit the time sheet for the week to submit all the time cards for the week together from your mobile application.

Role required: timecard_user

1. Log in to your instance in the Now Mobile application.
2. Open the time sheet you want to submit.
3. Tap the action icon.
4. Select **Submit Timesheet**.
   The time sheet is validated against the time sheet policy assigned to you or, if no time sheet policy is assigned, against the default time sheet policy.
   • If the time sheet meets the time sheet policy requirements, the time sheet is submitted. All the time cards associated with the time sheet are also submitted automatically and move to the Submitted state.
   • If the time sheet does not meet the time sheet policy requirements, a validation error is displayed. Resolve the issue indicated by the error message and resubmit the time sheet.
Approve or reject a time sheet or time card from your mobile device

As a user manager, you can approve or reject from your mobile device all time cards for a user in a given week in a single step by approving or rejecting a time sheet.

Role required: timecard_approver or timecard_admin

A user manager is the one who has either of the required roles. The manager who can accept or reject the time sheet is selected in the Manager field on the User form of the time card user.

A manager can delegate another user with the required roles as the time sheet approver. For the specified time period, the delegated user also receives all the time sheets submitted by time card users to process.

1. Log in to your instance in the Now Mobile application.
2. In the Time Sheets list, open the time sheet you want to approve or reject.
3. Approve or reject the time sheet or time card.
   • To approve the entire time sheet, tap the action icon, and select Approve Timesheet or swipe right on the time sheet in list view and select Approve.
   • To reject the entire time sheet, tap the action icon, and select Reject Timesheet or swipe right on the time sheet in list view and select Reject.
   • To approve a specific time card, swipe right on a task and select Approve.
   • To reject a specific time card, swipe left on a task and select Reject.

   • The time sheet moves to the Approved or Rejected state.
   • All time cards associated with the time sheet are also approved or rejected automatically.
   • Time cards that are of non-task type are in moved to the processed state.
   • If any time cards in the time sheet are pending approval by one of the approvers, the sheet remains in the Submitted state.
   • If a time card in a time sheet is in the Rejected state, the time sheet also moves to the Rejected state regardless of the state of any other time cards in the time sheet.

Recall a processed time sheet or time card from your mobile device

As a user manager, you can recall an incorrect time sheet or time card that is in the Approved or Processed state to return it to the submitter. The submitter can then make the necessary changes and resubmit the time sheet or time card.

Role required: timecard_approver or timecard_admin

1. Log in to your instance in the Now Mobile application.
2. From the timesheets list in the Team’s Approvals Required section, open the time sheet you want to recall or the one that contains the time card you want to recall.
3. Recall the time sheet or time card.
   • To recall the entire time sheet, tap the action icon, and select Recall Timesheet or swipe right on the time sheet in list view and select Recall.
   • To recall a specific time card, swipe right on a time card, and select Recall.
Enterprise Release Management

The ServiceNow® Enterprise Release Management application helps you to efficiently plan and manage enterprise releases, product releases, and deployment process.

Important:
This plugin is no longer available for activation. For similar functionality, you can activate the Release Management plugin (com.snc.release_management_v2) that enables you to manage the release life cycle. For details, see Activate Release Management.

If you are an existing user of Enterprise Release Management, you can continue to use the application.

With The ServiceNow®, you can:

• Manage the phase gate process; define the key aspects of an enterprise release, and plan the release activities in phases.
• Manage the marketing aspects of a release: Market release date, features developed in a release, and so on.
• Define the key aspects of a product release, maintain different versions of product releases, by that, track features released in each product version.
• Define a deployment pipeline for product builds.
  • Track the entry of builds in appropriate deployment phases (environments).
  • Create and execute test plans to check for any failures in builds.
  • Validate builds and complete build approvals.

States of a build

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entering Phase</td>
<td>When a build enters the first phase, the state of the build is set to Entering Phase. This state is meant to be used as a signal either through a custom business rule or as a way to query new builds for automated systems to know when an action must be taken.</td>
</tr>
<tr>
<td>Verification Pending</td>
<td>When tasks in entering phase are complete, the state of the build must be set to Verification Pending.</td>
</tr>
<tr>
<td>Verification Complete</td>
<td>When all the tests pass, deployment tasks are in the closed complete state, and approvals are done, the state of the build is automatically set to Verification Complete. This state is a signal for automation tools to perform any exiting phase tasks.</td>
</tr>
<tr>
<td>Exiting Phase</td>
<td>When verification tasks are complete, the state of the build must be set to Exiting Phase. In this state, the build is automatically moved to the next deployment phase defined by the Order field.</td>
</tr>
</tbody>
</table>
Transition of a build between states

Installed with Enterprise Release Management

Following components are installed as part of Enterprise Release Management.

- Enterprise Release Management Tables
- Enterprise Release Management Roles

Tables installed with Enterprise Release Management

Enterprise Release Management uses the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Build</td>
<td>Stores information about generated builds.</td>
</tr>
<tr>
<td>[sn_erm_build]</td>
<td></td>
</tr>
<tr>
<td>Build Phase</td>
<td>Stores information about build phases.</td>
</tr>
<tr>
<td>[sn_erm_build_phase]</td>
<td></td>
</tr>
<tr>
<td>Commit</td>
<td>Stores information about code commits.</td>
</tr>
<tr>
<td>[sn_erm_commit]</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Deployment Pipeline</td>
<td>Stores information about deployment pipeline used for production builds.</td>
</tr>
<tr>
<td>[sn_erm_deployment_pipeline]</td>
<td></td>
</tr>
<tr>
<td>Deployment Phase</td>
<td>Stores information about phases within a deployment pipeline.</td>
</tr>
<tr>
<td>[sn_erm_deployment_phase]</td>
<td></td>
</tr>
<tr>
<td>Deployment Task</td>
<td>Stores information about tasks within a deployment phase.</td>
</tr>
<tr>
<td>[sn_erm_deployment_task]</td>
<td></td>
</tr>
<tr>
<td>Deployment Task Template</td>
<td>Stores information about task templates within a deployment phase.</td>
</tr>
<tr>
<td>[sn_erm_deployment_task_template]</td>
<td></td>
</tr>
<tr>
<td>Enterprise Release</td>
<td>Stores the key aspects of an enterprise release.</td>
</tr>
<tr>
<td>[sn_erm_enterprise_release]</td>
<td></td>
</tr>
<tr>
<td>Enterprise Release Phase</td>
<td>Stores information about phases within an enterprise release.</td>
</tr>
<tr>
<td>[sn_erm_enterprise_release_phase]</td>
<td></td>
</tr>
<tr>
<td>Enterprise Release Task</td>
<td>Stores information about enterprise release tasks.</td>
</tr>
<tr>
<td>[sn_erm_enterprise_release_task]</td>
<td></td>
</tr>
<tr>
<td>M2m Build Phase Test Plan</td>
<td>Maps test plans to build phases.</td>
</tr>
<tr>
<td>[sn_erm_m2m_build_phase_test_plan]</td>
<td></td>
</tr>
<tr>
<td>M2m Deployment Phase Test Plan</td>
<td>Maps test plans to deployment phases.</td>
</tr>
<tr>
<td>[sn_erm_m2m_deployment_phase_test_plan]</td>
<td></td>
</tr>
<tr>
<td>M2m Product Release Task</td>
<td>Maps release tasks to products.</td>
</tr>
<tr>
<td>[sn_erm_m2m_product_release_task]</td>
<td></td>
</tr>
<tr>
<td>Product Release</td>
<td>Stores information about product releases.</td>
</tr>
<tr>
<td>[sn_erm_product_release]</td>
<td></td>
</tr>
</tbody>
</table>

**Roles installed with Enterprise Release Management**

Enterprise Release Management comprises the following roles.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deployment Pipeline Manager</td>
<td>Has read and write access to the Deployment Management feature.</td>
</tr>
<tr>
<td>[sn_erm.deployment_pipeline_manager]</td>
<td></td>
</tr>
<tr>
<td>Deployment Pipeline User</td>
<td>Has read-only access to the Deployment Management feature.</td>
</tr>
<tr>
<td>[sn_erm.deployment_pipeline_user]</td>
<td></td>
</tr>
<tr>
<td>Enterprise Release Manager</td>
<td>Has read and write access to the All Enterprises Releases feature.</td>
</tr>
<tr>
<td>[sn_erm.enterprise_release_manager]</td>
<td></td>
</tr>
<tr>
<td>Enterprise Release User</td>
<td>Has read-only access to the All Enterprises Releases feature, but can update the assigned tasks.</td>
</tr>
<tr>
<td>[sn_erm.enterprise_release_user]</td>
<td></td>
</tr>
<tr>
<td>Product Release Manager</td>
<td>Has read and write access to the Product Releases feature.</td>
</tr>
<tr>
<td>[sn_erm.product_release_manager]</td>
<td></td>
</tr>
</tbody>
</table>
Define an enterprise release

Define important aspects of an enterprise release, such as duration, short description, priority and if the phase is a milestone. Milestones require an approval for future phases to be able to move into the Work in Progress state.

Role required: Enterprise Release Manager [sn_erm.enterprise_release_manager]

1. Navigate to Enterprise Release Management > Enterprise Releases > All Enterprise Releases.
2. Click New.

**Enterprise Release form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>System-generated number with a configurable prefix.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority associated with the release.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the release.</td>
</tr>
<tr>
<td></td>
<td>• Draft: Entry stage where the release record is created, but may not have complete details of the scope.</td>
</tr>
<tr>
<td></td>
<td>• Scoping: Release scope is defined by breaking down the release activities into phases and by setting milestones.</td>
</tr>
<tr>
<td></td>
<td>• Work in Progress: Work on the release has begun.</td>
</tr>
<tr>
<td></td>
<td>• Testing/QA: Projects and tasks within the release are validated and checked if they have met the release acceptance criteria.</td>
</tr>
<tr>
<td></td>
<td>• Deploy/Launch: Release build is deployed.</td>
</tr>
<tr>
<td></td>
<td>• Closed Complete: Release build is delivered.</td>
</tr>
<tr>
<td></td>
<td>• On Hold: Release is put on hold for some reason. May be resumed in the future.</td>
</tr>
<tr>
<td></td>
<td>• Canceled: Release is canceled for some reason.</td>
</tr>
<tr>
<td>Percent complete</td>
<td>Percentage of work completed in the release. This calculation sums up the percentage complete values of all phases in this release.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the release.</td>
</tr>
<tr>
<td>Description</td>
<td>More verbose description of the release.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Information about milestones, impediments, or changes as the release progresses.</td>
</tr>
</tbody>
</table>

**Schedule tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planned start date</td>
<td>Intended date the release begins.</td>
</tr>
<tr>
<td>Planned end date</td>
<td>Intended date the release ends. After you add tasks, this field is calculated from the tasks.</td>
</tr>
<tr>
<td>Planned duration</td>
<td>Expected duration of the release. After you add tasks, this field is calculated from the duration of the tasks.</td>
</tr>
</tbody>
</table>
### Define an enterprise release phase

Plan and carry out the enterprise release work in phases. Define important aspects of the phase, such as duration, milestone, and assignment group.

Role required: Enterprise Release Manager [sn_erm.enterprise_release_manager]

1. Navigate to **Enterprise Release Management > Enterprise Releases > All Enterprise Releases**.
2. Select an enterprise release.
3. In the **Enterprise Release Phases** related list, click **New**.
4. On the form, fill in the fields.

#### Enterprise Release Phases form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>System-generated number with a configurable prefix.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| State                 | Current state of the release phase.  
  • Draft: Entry stage where the release record is created, but may not have complete details of the scope.  
  • Scoping: Release scope is defined by breaking down the release activities into phases and by setting milestones.  
  • Work in Progress: Work on the release has begun.  
  • Testing/QA: Projects or tasks within the release are validated and checked if they have met the release acceptance criteria.  
  • Deploy/Launch: Release build is deployed.  
  • Closed Complete: Release build is delivered.  
  • On Hold: Release is put on hold for some reason. May be resumed in the future.  
  • Canceled: Release is canceled for some reason. |
| Milestone             | Significant point in the release phase marking the overall progress.  
  Note: Work on a release phase does not start until the milestone defined in the previous release phase is achieved. |
| Assignment group      | Group that would work on the release phase activities. |
| Percent complete      | Percentage of work completed in the release phase. This calculation sums up the percentage complete values of all tasks within the release phase. |
| Short description     | Brief description of the release phase. |
| Description           | More verbose description of the release phase. |

### Schedule tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planned start date</td>
<td>Intended date the release phase begins.</td>
</tr>
<tr>
<td>Planned end date</td>
<td>Intended date the release phase ends. After you add tasks, this field is calculated from the tasks.</td>
</tr>
<tr>
<td>Planned duration</td>
<td>Expected duration of the release phase. After you add tasks, this field is calculated from the duration of the tasks.</td>
</tr>
<tr>
<td>Planned effort</td>
<td>Estimate of how much time it takes to complete the release phase. This calculation sums up planned effort values of all tasks in the release phase.</td>
</tr>
<tr>
<td>Remaining duration</td>
<td>Difference between planned duration and actual duration.</td>
</tr>
<tr>
<td>Actual start date</td>
<td>Date that this release phase began.</td>
</tr>
<tr>
<td>Actual end date</td>
<td>Date that this release phase ended.</td>
</tr>
</tbody>
</table>
Define a deployment pipeline

Define the deployment pipeline that builds of a product use to get into production.

Role required: Deployment Pipeline Manager [sn_erm.deployment_pipeline_manager] and Deployment Pipeline Viewer [sn_erm.deployment_pipeline_user]

**Note:** Deployment Pipeline Manager has both read and write access to the Deployment Pipeline form, whereas Deployment Pipeline Viewer has read-only access.

1. Navigate to Deployment Management > Deployment Pipelines.
2. Click New.
3. On the Deployment Pipeline form, fill the following fields:

   **Deployment Pipeline form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>System-generated number with a configurable prefix.</td>
</tr>
<tr>
<td>Name</td>
<td>Suitable name for the deployment pipeline.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Create a deployment phase

Create a deployment phase (environment) within the deployment pipeline. Define an ordered list of deployment phases through which the build moves.

Role required: Deployment Pipeline Manager [sn_erm.deployment_pipeline_manager]

1. Navigate to Deployment Management > Deployment Pipelines.
2. Click the Deployment Phases related list.
3. Click New.
4. On the Deployment Phase form, fill the following fields:

   **Deployment Phase form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Suitable name for the deployment phase.</td>
</tr>
</tbody>
</table>
ServiceNow    DocVersion    IT Business Management

Field | Description
--- | ---
Order | Order the list of phases in the deployment pipeline. Phases are executed in the sequence defined by the Order field.
Pipeline | Name of the deployment pipeline that is the parent of deployment phase.
Assignment group | Assignment group responsible for approving builds.

5. Click Submit.

Use the following related lists:

<table>
<thead>
<tr>
<th>Related list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test plans</td>
<td>Allows you to create a test plan.</td>
</tr>
<tr>
<td>Deployment Task Templates</td>
<td>Allows you to create a deployment task template.</td>
</tr>
<tr>
<td>Builds</td>
<td>Allows you to create a build.</td>
</tr>
</tbody>
</table>

Create a test plan within a deployment phase

Create a test plan within a deployment phase and run it on builds.

Role required: Deployment Pipeline Manager [sn_erm.deployment_pipeline_manager]

1. Navigate to Deployment Management > Deployment Pipelines > Deployment Phases.
2. Click the Test plans related list.
3. Click New.
4. On the Test Plan form, fill the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Description</td>
<td>Brief description of the test plan.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box for activating the test plan.</td>
</tr>
<tr>
<td>Owner</td>
<td>Owner of the test plan.</td>
</tr>
<tr>
<td>Test environment</td>
<td>Specific environment to be used for testing. A test environment must be created before it can be assigned to a test plan.</td>
</tr>
<tr>
<td>Instructions</td>
<td>Any specific instructions for this particular test plan.</td>
</tr>
</tbody>
</table>

5. Click Submit.
Create a deployment task template

Create a deployment task template within a deployment phase. The deployment task template auto-creates build tasks when the build moves to the Verification Pending state.

Role required: Deployment Pipeline Manager [sn_erm.deployment_pipeline_manager]

1. Navigate to Deployment Management > Deployment Pipelines > Deployment Phases.
2. Click the Deployment Task Templates related list.
3. Click New.
4. On the Deployment Task Template form, fill the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>System-generated name for the deployment task template.</td>
</tr>
<tr>
<td>Table</td>
<td>Tasks created by the deployment task templates reside in the Deployment Task [sn_erm_deployment_task] table. This field is read-only.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box for activating the deployment task template.</td>
</tr>
<tr>
<td>Note: If you clear the check box, the deployment task template remains inactive and does not create build tasks.</td>
<td></td>
</tr>
<tr>
<td>Application</td>
<td>Application refers to global scope. This field is read-only.</td>
</tr>
<tr>
<td>Note: Global scope is a special application scope that identifies applications developed prior to application scoping or applications intended to be accessible to all other global applications.</td>
<td></td>
</tr>
<tr>
<td>User</td>
<td>User who owns the template.</td>
</tr>
<tr>
<td>Deployment phase</td>
<td>Deployment phase in which the deployment task template is created.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the deployment task template.</td>
</tr>
<tr>
<td>Template</td>
<td>Filter criteria to create the deployment task template.</td>
</tr>
</tbody>
</table>

5. Click Submit.
Create a build

Create a build record using the Build form. You can also use the information on the Builds page to create a report.

Role required: Deployment Pipeline Manager [sn_erm.deployment_pipeline_manager]


   **Note:** You can also create builds from Builds related list in the Deployment Phase form.

2. Click New.
3. On the Build form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>System generated number with a configurable prefix.</td>
</tr>
<tr>
<td>Build ID</td>
<td>Unique identifier of the build.</td>
</tr>
<tr>
<td>Branch label</td>
<td>Label name of the branch where the code is committed. Branch label is human readable as well as machine readable.</td>
</tr>
<tr>
<td>Commit</td>
<td>(Optional) Code commit for which the build is generated.</td>
</tr>
<tr>
<td>Deployment phase</td>
<td>Deployment phase (environment) indicating the entry of a build.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>State</td>
<td>State of the build.</td>
</tr>
<tr>
<td></td>
<td>• When a build enters a particular phase in a deployment pipeline, it moves to the <strong>Entering Phase</strong> state. For example, activities in this state could be deploying code or building business rules that act on the build when it enters a deployment phase.</td>
</tr>
<tr>
<td></td>
<td>• Once all the activities in the <strong>Entering Phase</strong> state are complete, build moves to the <strong>Verification Pending</strong> state, where:</td>
</tr>
<tr>
<td></td>
<td>• Each deployment task template creates a deployment task.</td>
</tr>
<tr>
<td></td>
<td>• Test plans related to deployment phase are set to the In Progress state.</td>
</tr>
<tr>
<td></td>
<td>• Build approval request is sent to all the members of the approval group.</td>
</tr>
<tr>
<td></td>
<td>• Once all the activities in the <strong>Verification Pending</strong> state are complete, the build moves to the <strong>Verification In Progress</strong> state. When all test cases in the test plans are passed, all deployment tasks are <strong>Closed Complete</strong>, and the deployment approval is <strong>Approved</strong>, the build moves to the <strong>Verification Complete</strong> state.</td>
</tr>
<tr>
<td></td>
<td>• In the <strong>Verification Complete</strong> state, activity such as cleaning the environment is done.</td>
</tr>
<tr>
<td></td>
<td>• Once all the activities in the <strong>Verification Complete</strong> state are complete, the build moves to the <strong>Exiting Phase</strong> state. At this point, change the reference of the deployment phase to the next phase based on the order in the deployment pipeline.</td>
</tr>
<tr>
<td></td>
<td>• When any one of the test cases in the test plans is set to failed or any deployment task is marked <strong>Closed Incomplete</strong> or <strong>Closed Cancelled</strong> or the deployment approval is <strong>Rejected</strong>, the build moves to the <strong>Verification Failed</strong> state.</td>
</tr>
<tr>
<td></td>
<td>• When any of the build activities are kept on hold, the build moves to the <strong>Verification On Hold</strong> state.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Configuration item</th>
<th>Reference to the Configuration Item managed by Configuration Management Database.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Branch ID</td>
<td>Unique identifier of the branch where the code is committed. Branch ID is machine readable.</td>
</tr>
<tr>
<td>Build reference</td>
<td>Reference or source from where the build can be downloaded.</td>
</tr>
</tbody>
</table>

4. **Click Submit.**

Use the following related lists:
Create a commit

Create a commit record using the Commit form. You can also use the information on the Commits page to create a report.

Role required: Deployment Pipeline Manager [sn_erm.deployment_pipeline_manager]

1. Navigate to Enterprise Release Management > Deployment Management > Commits.
2. Click New.
3. On the Commit form, fill in the fields.

Build form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>System generated number with a configurable prefix.</td>
</tr>
<tr>
<td>Commit ID</td>
<td>Unique identifier generated in the source control system while committing code.</td>
</tr>
<tr>
<td>Message</td>
<td>Brief description about the code that is being committed.</td>
</tr>
<tr>
<td>Branch ID</td>
<td>Unique identifier of the branch where the code is committed.</td>
</tr>
</tbody>
</table>

4. Click Submit.
Define a product release

Define a planned release for a product. The content of the release is decided by the features and associated requests for change that it implements.

Role required: Product Release Manager [sn_erm.product_release_manager]

1. Navigate to Enterprise Release Management > Product Releases > All products.
2. Click New.
3. On the Product Release form, fill the following fields:

   **Product Release form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>System-generated number with a configurable prefix.</td>
</tr>
<tr>
<td>State</td>
<td>State of the product release.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the release.</td>
</tr>
<tr>
<td>Description</td>
<td>More verbose description of the release.</td>
</tr>
<tr>
<td>Product version</td>
<td>Used to track the features released in each product version.</td>
</tr>
<tr>
<td>Release type</td>
<td>Type of release: Major, Minor, Emergency, or Patch.</td>
</tr>
<tr>
<td>Media Library</td>
<td>Link to an entry (pointing to the deployment build) in the Definitive Media Library [dsl] table.</td>
</tr>
<tr>
<td>Planned start date</td>
<td>Intended date the product release begins.</td>
</tr>
<tr>
<td>Planned end date</td>
<td>Intended date the product release ends.</td>
</tr>
<tr>
<td>Actual start date</td>
<td>Date that this product release began.</td>
</tr>
<tr>
<td>Actual end date</td>
<td>Date that this product release ended.</td>
</tr>
</tbody>
</table>

4. Click Submit.

1. Use the Attach task related link.
2. Select a task and associate it with the product release.

   Based on the type of task selected, the task appears in the Enhancement, Defect, Epic, Story, or Problem related lists.

Agile Development

The ServiceNow® Agile Development application helps you deliver software projects more efficiently by managing and tracking software development life-cycles using an iterative, incremental, and flexible approach.

When you have multiple standalone tools for development, testing, and project tracking, there is a disconnect between enhancements and fixes, originating operations, change processes, and deployment. Agile Development pulls these software development life-cycle work-flows together into one system. Agile Development manages scrum or waterfall development, and helps you manage the backlog of tasks throughout the lifecycle, from inception through testing and deployment. Ultimately, you gain increased visibility into the entire software development lifecycle.
Following are the variants of Agile Development:

**Agile Development under Project Management**

See the documentation at Agile Development 2.0 integration with Project Portfolio Management for project-based agile development.

**Agile Development 1.0**

**Important:** Agile Development 1.0 plugin (com.snc.sdcl.scrum.pp) is no longer available for activation. Activate the Agile Development 2.0 plugin (com.snc.sdcl.agile.2.0) for enhanced agile capabilities to manage your software development efforts.

**Agile Development 2.0**

Agile Development 2.0 supports agile-based execution. It provides an agile software development environment for product-based or project-based efforts, using the scrum agile framework. Offers the flexibility to implement a pure agile approach over the entire life-cycle of a product, or a hybrid approach using agile methods within a traditional project structure. Watch this two-minute video for an introduction.

Capabilities are continually refined so that you can harness the power of agile to enhance your software development efforts. To match your service level with the Agile Development application that best meets your needs, consult the following information and table carefully.

**Note:** If you have Agile Development 1.0 and you upgrade to Agile Development 2.0, Agile Development 2.0 will replace Agile Development 1.0. If you are using Agile Development for the first time, you should install the Agile Development 2.0 plugin (com.snc.sdcl.agile.2.0).

### Agile Development variants — Notable differences

<table>
<thead>
<tr>
<th>Feature</th>
<th>Agile Development (Project Management)</th>
<th>Agile Development 2.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backlog</td>
<td>A story can be associated to only a project.</td>
<td>A personalized backlog can be created by defining filter criteria.</td>
</tr>
<tr>
<td>Release</td>
<td>A project story cannot be associated to a release.</td>
<td>A release is a definite timeline to execute prioritized stories from backlog.</td>
</tr>
<tr>
<td></td>
<td>• Project-based execution — It allows release backlog to be executed as one or more projects.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Non project-based execution — It allows release backlog to be executed by one or more assignment groups using their sprint schedules within a release timeline.</td>
<td></td>
</tr>
<tr>
<td>Theme and Epic</td>
<td>A story cannot be associated to a theme, or epic.</td>
<td>Backlog stories can be categorized by themes and epics.</td>
</tr>
</tbody>
</table>
### Migration from Agile Development 1.0 to Agile Development 2.0

Migrate from Agile Development 1.0 to Agile Development 2.0 for enhanced agile capabilities and features.

Apply the following migration steps on a non-production instance, verify if the migration is completed as intended, and then perform the migration steps on a production instance.

- Manage customizations.
- Delete customizations.
- Activate Agile Development 2.0.
- Complete the prerequisites for converting teams to groups
- Convert teams to groups
- Verify the conversion of teams to groups

### Manage customizations

You can take complete advantage of enhanced agile functionality by managing your customizations before upgrading to Agile Development 2.0.

As of any regular upgrade, if core platform artifacts such as form layout, adding of fields, removal of preconfigured fields, list layout, business rules, or client scripts, are customized in your environment, then changes made to any of these artifacts as part of the Agile Development 2.0 enhancements are not applied in your environment. You should delete all your customizations before upgrading to Agile Development 2.0, and selectively reapply customizations as needed after upgrade.

Following are the three possible scenarios:

#### No customizations

You do not have any customizations in your Agile Development implementation and want to use the Agile Development 2.0 functionality. In such a case, install the Agile Development 2.0 plugin (com.snc.sdlc.agile.2.0).

### Table: Feature Comparison

<table>
<thead>
<tr>
<th>Feature</th>
<th>Agile Development (Project Management)</th>
<th>Agile Development 2.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Team versus Assignment Group</td>
<td>Assignment Group is used.</td>
<td>Assignment Group is used to create an assignment group of type Agile Team. The confusion between when to use release team versus assignment group is eliminated. An existing release team can be converted into an assignment group.</td>
</tr>
<tr>
<td>Sprints</td>
<td>Sprints are assignment group-based. Each group can have its own sprint schedule.</td>
<td>Sprints are generated for Assignment Groups. Different groups can use different sprint schedules or all the groups can follow the same schedule. The Agile Board <strong>Sprint Planning</strong> tab is used to manage sprints.</td>
</tr>
<tr>
<td>Sprint Planning</td>
<td>The Sprint Planning Board is used.</td>
<td>The Sprint Planning tab on Agile Board is used.</td>
</tr>
<tr>
<td>Task Progress board and Story progress board</td>
<td>VTB (Visual Task Board) is used.</td>
<td>The Sprint Tracking tab on Agile Board is used.</td>
</tr>
</tbody>
</table>
**Minor customizations**

There are few minor customizations, but you want to use the Agile Development 2.0 functionality. In such a case, delete all customizations.

**Customizations require review**

There are a few customizations in your Agile Development implementation that are mapped to your business process. Though you want to use the Agile Development 2.0 functionality, you may want to review your customizations and decide whether to delete all the customizations or retain a few customizations. For such a case:

- A utility is provided which automatically detects the customized platform artifacts, such as list layout, form layout, business rules, that were enhanced as part of the Agile Development 2.0 enhancements. For details of this utility and list of all platform artifacts enhanced in Agile Development 2.0, see Review a utility customization.
- After analyzing, if you do not want to retain any of the customizations, then delete the customizations. If you want to retain a few, delete the customizations and reapply them after the upgrade.
- If you have created your own artifacts, such as business rules and UI policies, verify whether the artifacts work as intended after the upgrade.

**Delete customizations**

Take complete advantage of enhanced functionality by deleting all your customizations before upgrading to Agile Development 2.0.

Role required: admin

1. In the Navigation filter, enter `sys_properties.list`. The entire list of properties in the System Properties `[sys_properties]` table appears.
2. Click New.
3. On the form, fill in the fields as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>com.snc.sdlc.scrum.pp.delete_customer_updates</td>
</tr>
<tr>
<td>Description</td>
<td>Delete customizations in the Agile Development application from the Customer Update [sys_update_xml] table.</td>
</tr>
<tr>
<td>Type</td>
<td>true/false</td>
</tr>
<tr>
<td>Value</td>
<td>true</td>
</tr>
</tbody>
</table>

4. Click Submit.

All customizations would be deleted and the property also would be automatically deleted.

If the Agile Development 2.0 plugin (com.snc.sdlc.agile.2.0) has been installed before deleting the customizations, refresh the plugin by reinstalling it.
Convert teams to groups

Complete most of the migration steps by converting teams to groups.

Role required: admin

1. Navigate to Agile Development > Groups.

An empty list is displayed because there are no assignment groups with the type Agile Team. If there are any groups with the type Agile Team, a list of groups are displayed.

2. Click the Convert Release Teams to Groups related link.

The list of all release teams (scrum_pp_team) table that you had defined in the Agile Development plugin is displayed. If you have been defining teams for each release, multiple records are displayed for the team (team with the same name), one for each release. In the following screenshot, four records are displayed for the team Facilities Software Team, one for each release.
3. **Complete the prerequisites for converting teams to groups.** Since migration is performed on a non-production instance first, convert one team to a group, verify if the migration is done successfully for the team, and then perform the same procedure for rest of the teams.

In the preceding example, all the four records for the Facilities Software Team can be selected at once. Consider the Facilities Software Team team as a sample team.

4. Select all records of the sample team and click **Convert to Group**. All the teams are converted to an assignment group. If an assignment group exists with the same name, a new group is not created, but other migration activities are carried out for the group, for example, updating the group reference to the sprint and story table. Perform the following steps manually:

   - Update the group type to Agile Team.
   - If release team members and group members are different, synchronize the members between group and team.

**Complete the prerequisites for converting teams to groups**

Perform prerequisite steps to later ensure that the conversion of teams to groups is successful.

Role required: admin

The team being selected should have at least one sprint that is current. The current sprint should have a few completed and a few WIP stories. This is to verify that the sprint burndown is updated correctly post conversion. If you do not have such a team, you may select any team for conversion.

1. **Find out the sprints assigned to the team across all a release.**

   **Note:** Use this step to verify whether the assignment group is updated successfully across all the sprints.

   a. In the search panel in navigator, type `rm_sprint.list` to view the list of all sprints.
   
   b. Display the **Team** and **Assignment group** fields if not displayed.
   
   c. Apply the team name filter. The **Assignment group** field is empty.
   
   d. Capture the screen or export the list of all sprints. In the sample example, sprint 5 is the current sprint for the team being converted.
2. Find out the stories that are associated with the sprints of the team being converted.

**Note:** Use this step to verify that the assignment group is updated successfully across all stories.

a. In search panel in navigator, type `rm_story.list` to view the list of all stories.

b. Filter out the stories belonging to the sprints noted in the preceding step.

c. Display `Sprint.Team` and `Assignment group` fields in the list layout. The `Assignment group` field is empty.

d. Capture the screen or export this list.

e. Filter the story table to fetch the list of all stories belonging to sprints of the team being converted. Apply the following filter:

```
sprint.release_teamSTARTSWITH<name of the team>
```
3. Ignore this step if you do not use sprint burndown in your current Agile Development implementation.

**Note:** Use this step to verify whether the sprint burndown is updated successfully after an upgrade.

a. Open the current sprints (state = current) from the sprint form.
b. Click the **Burndown Chart** related link.
4. Ignore this step if you do not use release burndown in your current Agile Development implementation.
Screen capture the release burndown chart for the current release.

**Note:** Use this step to verify whether the release burndown is updated successfully after an upgrade.
5. Ignore this step if you do not use team velocity chart in your current Agile Development implementation.

**Note:** Use this step to verify whether the team velocity chart is updated successfully after an upgrade.

a. Click the **Velocity Chart** related link for the team.

**Note:** To view the list of all teams, type `scrum_pp_team.list` in navigator.

b. Capture the screen.

### Verify the conversion of teams to groups

Perform verification steps to ensure that the conversion of a team to an assignment group is successful.

Role required: admin

1. Navigate to **Agile Development > Groups**.
2. Verify that the team has been converted to an assignment group. If group appears here, it implies that the group type is already set to Agile Team.

3. Verify that the assignment group is updated across all the sprints of the team.
   It is the same sprint list that you have noted prior to conversion. This list must have the assignment group updated after conversion.
4. Verify that the stories associated with the sprints of team have been updated with the assignment group. Following is the list of stories that were noted prior to converting to group:
5. Review the sprint burndown of the sprint that was noted prior to conversion. It must be same as it did prior to conversion.
   a. Open the rm_sprint table (rm_sprint.list), or open the assignment group.
   b. Click the current sprint.
   c. Mark any WIP story as complete.
   d. Review the sprint burndown that is to be updated with the completed story.
6. Once the story is complete, the release burndown must also be updated correctly. For example, in the following screenshot, the burndown is updated correctly for the current release.
7. For Group Velocity:
   a. Navigate to Agile Development > Groups.
   b. Review the velocity of the group. It must be same as it did prior to conversion.
   c. Complete the current sprint. It must display the velocity of group for the completed sprint in addition to the sprints that were completed before conversion.
8. Once you verify the steps for one group, it is confirmed that the migration has completed successfully. You can repeat this procedure for all other teams one by one. This is a synchronous process, hence, you should perform these steps on one team at a time.

Appendix

Agile Development 2.0 offers a few enhancements over Agile Development 1.0. These enhancements can be divided into the following categories:

• Data model enhancements
• Usability enhancements
• Functionality enhancements

Data model enhancements

Agile Development 2.0 offers a few data model enhancements over Agile Development 1.0.

Use of the common platform construct — Assignment Group

To map an agile team (scrum team), Agile Development 1.0 uses a separate entity called the Release Team table (scrum_pp_team). This entity is associated to a release entity as displayed in the following screen shot.
All other tasks on platform such as incidents, problems, changes, projects rely on the assignment group entity to make assignments to a group. Group managers can run reports on an assignment group to gain insight into the work assigned to their groups.

To standardize the use of a group across platform even for scrum work such as stories and tasks, the standard construct Assignment Group is used as opposed to the standalone entity Release Team. Agile Development 2.0 uses assignment groups to map agile teams. An assignment group of type Agile Team is used for defining an agile team.
Agile team (group) need not be created for each release

With Agile Development 1.0, teams are to be created for each release and the teams are to be associated to each release. For example, if a scrum team called Team — Alpha works on multiple quarterly releases. You cannot create the team for one time and associate the team to any release, or release over release. Each time a new release is created, you must create a team with the same name and associate team to the release.

With Agile Development 2.0, groups are created independent of releases, and you can work on stories from multiple releases without recreating the group for every release.

Sprints can be created without a release

With Agile Development 1.0, creating a release is mandatory for creating sprints. Sprints cannot be created for a team independently. Agile Development 1.0 mandates the creation of a release for story execution via sprints. If there is no release, sprint cannot be populated on a story record.
In Agile Development 2.0, sprints are associated with Assignment Groups.

Team backlog can be maintained independent of release

Typically, a team can have an ongoing team backlog release after release, it can pull stories from its backlog, and execute them through sprints in the release.

With Agile Development 1.0, a team cannot be defined without defining a release. Hence, team backlog cannot be maintained independent of a release.

With Agile Development 2.0, an assignment group is not created within a release. It can be associated to the release, but not created within a release. Hence, an assignment group can maintain its own backlog.
Group backlog with Agile Development 2.0

Release — Group association in Agile Development 2.0

As there is no direct relation between a release and a group in Agile Development 2.0 (groups are independent and do not have to create groups for each release), the m2m_release_group_list table has been introduced. This table stores the association of a group with a release. This association is not used for sprint generation, but is used to derive the capacity of a release.

Specify the number of sprints for which the group works in a release. From the capacity of the team, the capacity of the release is derived.

<table>
<thead>
<tr>
<th>Team</th>
<th>Start Sprint</th>
<th>End Sprint</th>
<th>Points (each sprint)</th>
<th>Total Group Capacity For Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>A_Sprint 1</td>
<td>A_Sprint 3</td>
<td>30</td>
<td>90 (3*30)</td>
</tr>
<tr>
<td>B</td>
<td>B_Sprint 1</td>
<td>B_Sprint 4</td>
<td>40</td>
<td>160 (4*40)</td>
</tr>
</tbody>
</table>

Total Release Capacity = 90 + 160 = 250 points
Functionality enhancements

Agile Development 2.0 offers a few functionality enhancements over Agile Development 1.0.

Integration with Test Management 2.0

Agile Development 2.0 is integrated with Test Management 2.0. This integration allows you to define tests for your stories, and run the tests before a story is marked as complete.

Note: This integration is available from the London release.

Integration with Agile Development — Unified Backlog

Agile Development 2.0 is integrated with . This integration allows you to maintain a centralized backlog containing records of different task types, such as defects, problems, incident tasks, and stories. It facilitates in prioritizing and sequencing of different task type records in one location, saving you steps. It removes the overhead of converting records to stories.

Note: This integration is available from the London release.

Usability enhancements

Agile Development 2.0 offers a few usability enhancements over Agile Development 1.0.

Manage and groom your backlog

Flexible backlog definition

Agile Development 2.0 enables you to define backlogs. For example, you can create different backlogs by products or teams, or combine backlogs for one or more epics.
Backlog grooming

Agile Development 2.0 provides an advanced view for your backlog, where you can drag stories to rank them. Also, you can view backlogs by epics and get analytics about the overall backlog situation. For example, analytics of stories without acceptance criteria.
Enhanced sprint planning experience

Agile Development 2.0 provides a single view for your backlog and sprints. Drag stories from the backlog to sprints to perform sprint planning in an interactive manner.

Example of the Planning Board in Agile Development

Note: Though the Planning Board in Agile Development 1.0 has not been deprecated, you can use the Sprint Planning tab in Agile Development 2.0. For release planning, use the Backlog tab in which you can multi-select stories, and assign them to a release.
Assigning multiple stories to a release in Agile Development 2.0

Sprint Tracking

Agile Development 2.0 leverages the visual task boards feature to track the progress of stories in a sprint. It also provides the ability to create scrum tasks from the tracking view.
**Note:** The Task Progress Board UI does not appear as a tab in Agile Development 2.0. You may type Task Progress Bar in search panel in navigator to invoke the UI, for tracking the progress of scrum tasks.

Review a utility customization

Use the Agile_2.0 Upgrade_Diagnostics update set to analyze your customizations on the platform artifacts (such as form layout, list layout, business rules, and client scripts) that are modified as part of the Agile Development 2.0 enhancements. Delete the customizations prior to upgrade.

- **Role required:** admin
- **Download** the Agile_2.0 Upgrade_Diagnostics update set.

1. Click the **Retrieved Update Sets** module.
2. Click **Import Update Set from XML**.
3. Select and upload the update set.
4. Preview and commit the update set.
5. Navigate to **Agile Development 2.0 > Upgrade Diagnostics > View Diagnostics**.
   Displays all the artifacts from Agile Development 1.0 that have been modified on the instance and on Agile Development 2.0.
6. Click the file name of the artifact, or click the **View Update** link to review the latest update on the file. For example, in the following screenshot, a system script has been customized. Hence, further analysis is required to delete the customization, restore, or reapply the customization after an upgrade.

**Example of a customized system script**

*List of platform artifacts*
Post migration, you can review the list of artifacts that are modified in Agile Development 2.0.

- `sys_ui_list_control_3f85b6907f00000135a05e41c7547354`
- `sys_ui_list_control_3f8607b47f0000012aaff213c654be45`
- `sys_ui_list_control_6daa4a777f000001007607d32a0b44f0`
- `sys_ui_list_control_7d3d1f917f000001798fc58141419300`
- `sys_ui_list_control_aa8a1a8e7f000001432d0e1142a85c2d`
sys_ui_list_control_aa8a4bbe7f000000139552678204587f7,
sys_ui_list_control_aa8ace2f7f0000001514936314eb4c441,
sys_ui_list_control_aa8b47f57f0000001024db35639e9239d,
sys_ui_list_control_aa8b87c57f00000014da26c6926295c45,
sys_ui_list_control_aa8b1fe7f0000001566e2efad03b5d1d,
sys_ui_list_control_f2e3f8447f00000010e166f2131e4c51,
sys_ui_list_control_f2e421e9f7f00000015ecc4e84539ca3f,
sys_ui_list_control_f31a7ea3f7f000000111797ad94bfc17a7,
sys_ui_form_sections_6dd15dd77f000000146435a3f9ec1b5c2,
sys_ui_form_sections_6dd2cb2b7f00000016bc846fa867d9527,
sys_ui_form_sections_6dd47d6f7f0000001b43299d37b79da0,
sys_section_09c7f68d0a0a2c39447a64370c6851bb,
sys_section_09c9c4eb0a0a2c390ca461bae347c0c8,
sys_section_6da8bb7f7f000000119f52f9d2ba74f7e,
sys_section_6dc344847f00000017a3bada86eae0f4,
sys_section_6dc409c57f00000016dd1fecc461c7b9,
sys_section_6dd15e0a7f000000104ddce384e5f5457,
sys_section_6dd2c97f000000166662d74a4a176ec,
sys_section_6dd47d857f000000173b95cc64af46a4,
sys_section_8756880b7f000000147213f082349a57,
sys_section_87569f2d7f00000011c55615821ae434,
sys_section_8757b94d7f00000011c1ae8aa30062c20,
sys_section_87580cdb7f000000145ccf17762bcac315,
sys_section_a19b5086c1252a7b3632553561b5440c,
sys_section_a7ee48bfc1252a7377ac0507a9a6dc8,
sys_section_a8a5d967f000000109bd63883019d20,
sys_list_rm_epic_rm_epic_scrum,
sys_list_rm_epic_scrum_theme_scrum,
sys_list_rm_scrum_task_rm_story_scrum,
sys_list_rm_sprint_rm_release_scrum_scrum,
sys_list_rm_story_rm_epic_scrum,
sys_list_rm_story_rm_release_scrum_scrum,
sys_list_rm_story_rm_sprint_scrum,
sys_list_scrum_theme_scrum_group_permissions_scrum_theme_scrum,
sys_list_scrum_user_permissions_scrum_theme_scrum,
sys_list_scrum_release_scrum_scrum,
sys_list_sprint_scrum,
sys_list_epic_scrum,
sys_list_story_scrum,
sys_list_release_scrum_null,
sys_list_sprint_null,
sys_list_epic_null,
sys_list_story_null,
sys_related_rm_defect_scrum,
sys_related_rm_doc_scrum,
sys_related_rm_epic_scrum,
sys_related_rm_release_scrum_scrum,
• sys_app_module_7580e499ef41200099620fa3f8225675,
• sys_app_module_b17e9819ef41200099620fa3f8225692,
• sys_app_module_db7f1099ef41200099620fa3f822564e,
• sys_app_module_eb7dd019ef41200099620fa3f8225611,
• sys_ui_policy_6c5665c293030200ea933007f67ffbb18,
• sys_ui_policy_823c84a6ef271000a7450fa3f8225653,
• sys_ui_policy_128dc58293030200ea933007f67ffbb3,
• sys_ui_policy_49dc0ca093030200ea933007f67ffbo,c,
• sys_ui_policy_830b62d6877121003706db5eb2e3ec6d,
• sys_ui_policy_cb2b8826ef271000a7450fa3f82256b3,
• sys_ui_policy_d8476e96877121003706db5eb2e3eca3,
• sys_ui_policy_267d5c2aef271000a7450fa3f8225636,
• sys_ui_policy_63a823ecf3b1000a7450fa3f8225627,
• sys_ui_action_22ada00a93330200ea933007f67ffbd5,
• sys_ui_action_e89e773593030200ea933007f67ffbb7,
• sys_ui_action_f6ea06e2870321003706db5eb2e3ec7d,
• sys_ui_action_view_f9e0ee3393330200ea933007f67ffbb38,
• sys_ui_action_96bd90b2881321001a833df827bdee4a,
• sys_ui_policy_c4ac45a14733210084667eaeacb9a7150,
• sys_ui_policy_c5c37126ef202000a7450fa3f8225650,
• sys_ui_action_dd4398b937301000dadaa549dabed5b8,
• sys_script_client_3d260d7f1000a7450fa3f822564a2,
• sys_script_client_e0f86b85387321003706db5eb2e3ec6d,
• sys_script_client_cdf24c2493030200ea933007f67ffbo,9,
• sys_script_client_2cc257b0373321001a8326877e411f0d0,
• sys_script_235cc8092f03100598a5bb0657cfce,
• sys_script_3a06f6d59f322100598a5bb0657cfce,
• sys_script_6940d94ef902000a7450fa3f8225649,
• sys_script_2cc257b0373321001a8326877e411f0d0,
• sys_script_235cc8092f03100598a5bb0657cfce,
• sys_script_3a06f6d59f322100598a5bb0657cfce,
• sys_script_6940d94ef902000a7450fa3f8225649,
• sys_script_2cc257b0373321001a8326877e411f0d0,
• sys_script_235cc8092f03100598a5bb0657cfce,
Agile Development 2.0

The ServiceNow® Agile Development 2.0 application provides an agile software development environment for product-based or project-based efforts, using the Scrum framework. It offers you the flexibility to implement a pure agile approach over the entire life-cycle of a product, or a hybrid approach using agile methods within a traditional project structure.

Explore
- Upgrade to .
- Basics of Agile Development
- Agile Development process flow
- Domain separation in Agile Development 2.0
- ServiceNow® DevOps integration with Agile Development 2.0

Set up
- Activate Agile Development 2.0

Use
- Agile Board
- Backlog
- Sprint Planning
- Sprint Tracking

Develop
- Developer training
- Developer documentation
- Components installed with Agile Development 2.0
- Agile Development process data model

Troubleshoot and get help
- Ask or answer questions in the Business Management forum
- Search the HI Knowledge Base for known error articles
- Contact ServiceNow Technical Support

Domain separation in Agile Development 2.0

This is an overview of domain separation and how it works with Agile Development 2.0. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Support level: Basic

- Business logic: Ensure that data goes into the proper domain for the application’s service provider use cases.
- The application supports domain separation at run time. This includes domain separation from the user interface, cache keys, reporting, rollups, and aggregations.
- The owner of the instance must set up the application to function across multiple tenants.

Use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

How domain separation works in Agile Development 2.0.

- The entities in Agile 2.0 extend the functions of task, so they inherit the domain behavior of tasks. The new entries you create go into the domain of the user currently logged in.
- Agile Board honors domain separation and lists the groups that the user belongs to for Sprint Planning and Sprint Tracking pages. The backlog entries that display are in the same domain as those that the current user owns or shares with other users. The stories that display in Agile Board are limited to the domain of the current logged-in user.
Activate Agile Development 2.0

Activate the Agile Development 2.0 plugin (com.snc.sdlc.agile.2.0) if you have the admin role.

Role required: admin

- If you are upgrading from an earlier ServiceNow release version of Agile Development to Agile Development 2.0, read upgrade information before activating the plugin.
- The dashboards for Agile Development 2.0, if required, must be activated separately using the Performance Analytics – Content Pack – Project Portfolio Suite Dashboards plugin (com.snc.pps_dashboards). The Performance Analytics license is required to use the dashboards.

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Components installed with Agile Development 2.0

Several types of components are installed with activation of the Agile Development 2.0 plugin, including tables, user roles, and properties.

   Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Scrum admin [scrum_admin] | A scrum admin has full control on the Agile Development 2.0 application. | • rm_doc_admin  
• rm_epic_admin  
• rm_product_admin  
• rm_release_scrum_admin  
• rm_scrum_task_admin  
• rm_sprint_admin  
• rm_story_admin  
• rm_task_admin  
• rm_test_admin  
• scrum_user |
<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Scrum master [scrum_master]| A scrum master guides team members through a sprint and serves as a sounding board for issues that arise. A scrum master can move stories between a release backlog and a sprint. This user can create and manage:  
  - Epics  
  - Stories  
  - Sprints  
  - Team Members                                                                                                                                  | • scrum_sprint_planner  
  • scrum_story_creator  
  • scrum_user            |
| Scrum product owner [scrum_product_owner] | Users with this role are responsible for the business value of a project and for maintaining the product backlog. A product owner can move stories between the product backlog and releases. This user can create and manage:  
  - Themes  
  - Epics  
  - Stories  
  - Products  
  - Releases  
  - Teams                                                                                                                                            | • scrum_release_planner  
  • scrum_story_creator  
  • scrum_user            |
| Scrum release planner [scrum_release_planner] | Users with this role perform release planning activities. A release planner can create and manage:  
  - Themes  
  - Products  
  - Releases                                                                                                                                         | • scrum_story_creator  
  • scrum_user            |
| Scrum sprint planner [scrum_sprint_planner] | Users with this role manage the sprint process. A sprint planner can create and manage:  
  - Stories  
  - Sprints                                                                                                                                             | • scrum_story_creator  
  • scrum_user            |
<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Scrum story creator [scrum_story_creator] | Users with this role create the descriptive elements of a product. A story creator can create and manage:  
• Epics  
• Stories  
• Tasks |  
• rm_scrum_task_admin  
• scrum_user |
| Scrum story editor [scrum_story_editor] | Users with this role have edit access to the Story [rm_story] table.         |  
• rm_scrum_task_admin  
• scrum_user |
| Scrum team member [scrum_team_member]  | Users with this role are the scrum users who work on a story in a sprint. A team member can create a scrum task, perform updates to a story, and log enhancement requests or defect reports. |  
• rm_defect_admin  
• rm_enhancement_admin  
• rm_scrum_task_admin  
• scrum_story_creator  
• scrum_story_editor  
• scrum_user |
| Scrum task admin [rm_scrum_task_admin] | Scrum task administrator with access to the Scrum Task [rm_scrum_task] table. |  
• scrum_user |
| Scrum user [scrum_user]                | Basic scrum role that all other roles inherit. It confers read-only rights to the Agile Development application. A scrum user can view all agile elements, but cannot create, edit, or manage records of any type. |  
• cmdb_read  
• pa_viewer |

**Tables installed**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Assignment Group [m2m_product_group]</td>
<td>Stores relationship between products and groups.</td>
</tr>
<tr>
<td>Release Assignment Group [m2m_release_group]</td>
<td>Stores relationship between releases and groups.</td>
</tr>
<tr>
<td>Application Model [cmdb_application_product_model]</td>
<td>Represents whole product whose releases are being managed.</td>
</tr>
<tr>
<td>Release Product [m2m_product_release]</td>
<td>Represents all managed products.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Story Dependencies</td>
<td>Represents all related stories (prerequisite and dependent) to an existing story.</td>
</tr>
<tr>
<td>[m2m_story_dependencies]</td>
<td></td>
</tr>
<tr>
<td>Scrum task</td>
<td>Represents a discrete amount of work for a story carried out during a sprint.</td>
</tr>
<tr>
<td>[rm_scrum_task]</td>
<td></td>
</tr>
<tr>
<td>Release team member</td>
<td>Represents the list of users who are part of a release.</td>
</tr>
<tr>
<td>[scrum_pp_release_team_member]</td>
<td></td>
</tr>
<tr>
<td>Sprint team member</td>
<td>Represents the list of users who are part of a sprint.</td>
</tr>
<tr>
<td>[scrum_pp_sprint_team_member]</td>
<td></td>
</tr>
<tr>
<td>Team</td>
<td>Represents who completes scrum tasks and stories during releases and sprints.</td>
</tr>
<tr>
<td>[scrum_pp_team]</td>
<td></td>
</tr>
<tr>
<td>Team name</td>
<td>Represents the name of the scrum team.</td>
</tr>
<tr>
<td>[scrum_pp_team_name]</td>
<td></td>
</tr>
<tr>
<td>Theme</td>
<td>Represents either a tangible product (such as a trading application) or an abstract goal (such as performance tuning).</td>
</tr>
<tr>
<td>[scrum_theme]</td>
<td></td>
</tr>
<tr>
<td>Scrum release</td>
<td>Represents individual versions (releases) of the product. Each release contains a list of sprints with a time range in which the stories in those sprints must be completed.</td>
</tr>
<tr>
<td>[rm_release_scrum]</td>
<td></td>
</tr>
<tr>
<td>Sprint</td>
<td>Stores sprints, which are the backlog items to be addressed together during a given time period.</td>
</tr>
<tr>
<td>[rm_sprint]</td>
<td></td>
</tr>
<tr>
<td>Epic</td>
<td>Represents related stories or requirements that you have not yet transformed into stories.</td>
</tr>
<tr>
<td>[rm_epic]</td>
<td></td>
</tr>
<tr>
<td>Story</td>
<td>Represents self-contained pieces of work that can be completed within a sprint.</td>
</tr>
<tr>
<td>[rm_story]</td>
<td></td>
</tr>
<tr>
<td>Defect</td>
<td>Represents a deviation from the expected behavior of a product.</td>
</tr>
<tr>
<td>[rm_defect]</td>
<td></td>
</tr>
<tr>
<td>Documentation Task</td>
<td>Represents documentation tasks for the product.</td>
</tr>
<tr>
<td>[rm_doc]</td>
<td></td>
</tr>
<tr>
<td>Enhancement</td>
<td>Represents an improvement to an existing product.</td>
</tr>
<tr>
<td>[rm_enhancement]</td>
<td></td>
</tr>
<tr>
<td>SDLC release</td>
<td>Represents individual versions of the product.</td>
</tr>
<tr>
<td>[rm_release_sdic]</td>
<td></td>
</tr>
<tr>
<td>Testing Task</td>
<td>Represents testing tasks for the product.</td>
</tr>
<tr>
<td>[rm_test]</td>
<td></td>
</tr>
</tbody>
</table>
Properties installed with Agile Development 2.0
Properties are added with activation of Agile Development 2.0.

Agile Development 2.0 adds the following properties.

**Note:** All of these properties are located in the System Properties [sys_properties] table. To access the table, enter `sys_properties.list` in the navigation filter.

<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draw Burndown Chart ideal line as a linear straight line</td>
<td>Draws the burn down chart ideal line as a straight line.</td>
</tr>
</tbody>
</table>
| com.snc.sdlc.scrum.pp.burndown.ideal.linear                              | • Type: true|false  
• Default value: false                                                    |
| Stories in any one of the states specified in this comma separated list  | Specify the story states using a comma separated list that should be shown in the story progress board. The states in the progress board follow the same order as specified here. |
| com.snc.sdlc.scrum.pp.progress.story.states                               | • Type: integer  
• Default values in their order:  
  • -6: Draft  
  • 1: Ready  
  • 2: Work in progress  
  • -7: Ready for testing  
  • -8: Testing  
  • 3: Complete |
| Tasks in any one of the states specified in this comma separated list    | Specify the task states using a comma separated list that should be shown in the progress board. The states in the progress board follow the same order as specified here. |
| com.snc.sdlc.scrum.pp.progress.task.state                               | • Type: integer  
• Default values in their order:  
  • -6: Draft  
  • 1: Ready  
  • 2: Work in progress  
  • 3: Complete |
| Enable the Actual Hours field for scrum tasks                            | Enable the **Actual hours** field in the Scrum Task form. Displays actual hours of tasks on the task progress board. |
| com.snc.sdlc.scrum.pp.task_uses_actual_hours                             | • Type: true|false  
• Default value: true                                                     |
<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>The default sprint length (in days) used if the length cannot be calculated from the sprint.</td>
<td>Specify a default sprint duration that should be used when creating a sprint, if the sprint length cannot be calculated from the sprint.</td>
</tr>
<tr>
<td>com.snc.sdilc.scrum.pp.default_sprint_length</td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 14</td>
</tr>
</tbody>
</table>

**Agile Development process data model**

Agile Development uses these tables to manage the agile process, represent releases, and represent product backlog items to be included in a sprint.

**Agile development process relationship diagram**

The following diagram displays the Agile Development tables as well as their relationships to other tables.
Agile development relationship diagram

Basics of Agile Development

Scrum is one of the most popular methodologies of agile development with these agile development include a fixed sprint schedule; regular requirements testing; and commonly used roles.

Agile development is based on:

- A short, fixed schedule of cycles with adjustable scope, called sprints, to address rapidly changing development needs.
- A repeating sequence of events, milestones, and meetings.
• A practice of implementing and testing new requirements, called stories, to ensure that some work is release-ready after each sprint.
• Commonly used roles such as product owner, scrum master, and group member.

Watch this four-minute video to learn about product-based and project-based development in the Agile 2.0 application.

Scrum framework

The Scrum framework contains the following processes:

• **Personal Backlog**: Product owner defines a personalized backlog through filter criteria. Product owner has the privilege to define as many personalized backlogs as necessary. The definition of the personalized backlog is flexible and can be modified at any time.

• **Sprint Backlog**: Sprint backlog is a list of stories the group members have agreed to complete for a sprint. During sprint planning, the scrum master collaborates with the assignment group to decide which stories they can commit to deliver in the sprint. Typically, they commit to the top ranked stories first. The group decides which scrum tasks are necessary for each story. The product owner should be present to answer any questions.

• **Sprints**: Group members work to complete stories in the current sprint. During the daily stand-up meetings, group progress is tracked and members discuss the work completed the previous day, the planned work for the next day, and any blocking issues. The scrum master keeps the group members focused on completing the stories in the current sprint and tries to remove any impediments they face. At the end of the sprint, all the stories should be complete. Any incomplete stories are moved into an appropriate backlog, or sprint. A review meeting, known as a retrospective is conducted at the end of the sprint. It allows group members to discuss what went well and what did not, with the goal of improving future sprints.

• **Sprint planning**: Sprint planning begins as the scrum master moves stories from the personal backlog into the current sprint.

Scrum activities

The following are typical activities of the scrum process:

• **Sprint planning**: The scrum group members select the stories that they can commit to deliver during a sprint.

• **Daily scrum**: The scrum master meets briefly with group members each day to discuss progress, planned work, and any impediments (known as blockers).

• **Sprint reviews**: At the end of the sprint, the scrum master and group members discuss the work completed and demonstrate new features to the product owner.

• **Sprint retrospectives**: It is an opportunity for the scrum group to review the sprint, inspect itself, and discuss ways to improve the execution of future sprints.

Scrum Artifacts

• **Velocity chart**: A chart displaying the historical performance of a group, used to better estimate the amount of work the group can deliver in a future sprint.

• **Burn down chart**: A chart generated during a sprint that provides at-a-glance reporting of ideal sprint progress against actual sprint progress over time.
Units of work in Scrum methodology

- A **theme** is the highest level of the requirements hierarchy and describes a view of a tangible product (such as a trading application) or an abstract goal (such as performance tuning). A product owner breaks down a theme into one or more epics.
- An **epic** is a group of related user stories that together provide an increment of value to the business such as a new feature or a significant enhancement.
- A **story** is a brief statement of a product requirement or a business case. Typically, stories are expressed in plain language to help the reader understand what the software should accomplish. Product owners create stories. A scrum user then divides the stories into one or more scrum tasks.
- **Scrum tasks** are the discrete pieces of work required to complete a story.

For details on how Agile Development 2.0 can help you manage your efforts of product development, see [Agile Development process flow](#).

Using guided setup to implement Agile Development

Agile Development Guided Setup provides a sequence of tasks that help you configure Agile Development on your ServiceNow instance. To open Agile Development guided setup, navigate to Agile Development > Agile Development Guided Setup. For more information about using the guided setup interface, see [Using guided setup](#).

**Agile Development process flow**

Outlines the process flow for the Agile Development application from creating a product to the completion of a sprint.

The flow described here represents the common practice for creating and managing scrum records with the functionality provided in the base Agile Development. The flow is not intended to represent the only possible process.

Watch this six-minute video for an introduction to managing Agile development in the Agile 2.0 application.

**Task 1: Create a product**

A product is defined as a set of features or functionality offered to users. For example, *Time Entry* can be a module offered by IT and HR department to all employees to record time for the work they do. Each product can have an owner that maintains the set of enhancement requests (stories) for the product. These stories can be organized under epics and themes. A product can have a narrow focus with few user stories or a wider context with many user stories, each containing several tasks.

**Task 2: Create an agile group**

A group of type *Agile Team* can be created and group members can be added to it. For each group member, the default number of story points that a member completes in a sprint can be defined. At the group level, the sum of the group member story points determines the group capacity.

**Task 3: Create a release**

Some organizations have a fixed time frame to release stories or features, which is referred as a release. For example, a quarterly or six monthly releases. Releases are created by release or program...
management team and contain user stories, sometimes from multiple products that form the release backlog. A release has a start and end date during which several development iterations are completed.

**Task 4: Create a personalized backlog**

A personalized backlog can be created by defining filter criteria. For example, one personalized backlog can be a combination of stories, defects, and incidents while the other personalized backlog can be combination of stories and incidents. In a similar manner, you can create as many personalized backlogs as necessary.

**Task 5: Create a sprint**

A sprint is the time frame in which development team delivers one or more stories. A sprint can be of any length, but typically takes between one and four weeks to finish. The scrum master creates one or more sprints for the group. A release can have multiple sprints in it. All sprints within a release must fit within the release start and end dates.

The assignment group is expected to complete all stories to which it is committed within a sprint. At the same time, the group should also meet the acceptance criteria as defined in the story records. The scrum master expects that the stories are fully tested and potentially releasable. Usually, the committed stories for a specific sprint should not change during the sprint. However, the Agile Development application makes changes possible if necessary. Stories should be added or removed from a sprint only after a discussion with the group, scrum master, and product owner.

**Task 6: Plan the sprint**

Before a sprint starts, the group and scrum master decide on what stories from the backlog they can commit to complete within a sprint. The scrum master must make sure that the effort (story points) required to complete the stories matches the capacity of the group.

Stories for a sprint can be selected based on priority. To plan the sprint-related activities, use Sprint Planning.

A velocity chart is available to help in the estimation process. The velocity chart shows historical record for a group of the number of completed points, by sprint. This view gives the scrum master an idea of the general capacity of the group over time and produces more accurate sprint planning. Velocity charts are most meaningful when sprint duration and number of group members are constant. Use the velocity chart as guidance and not as a factual representation of what the group can produce in the next sprint.

**Task 7: Track a sprint progress**

The scrum master manages the sprint team efforts, provides progress reports, and removes any impediments that the team encounters. Team members update task and story records and conduct daily stand-up meetings (scrum meetings) to communicate their progress and concerns to the scrum master.

The scrum master can track the sprint progress using Sprint Tracking.

**Task 8: Track a release progress**

The product owner tracks the progress of the release and verify whether the assignment group is completing stories and on track to achieve the release goal.
**Agile development use cases**

Different organizations follow different methods to deliver backlog/stories. Some of the typical delivery methods are:

- **Release based delivery**
- **Project based delivery**

Agile Development 2.0 provides the ability to maintain a unified backlog for both types of delivery. You can maintain all your backlog in one place and associate backlog stories to a product or a project or both as desired. You can also select stories from backlog and execute them as a project.

In addition, it also supports the execution of **standalone project development**.

The following example shows how Agile Development 2.0 supports a unified backlog for both types of deliveries.
Agile development workflow use cases

**Release based development use case**

An example of release based agile development and delivery model is explained.

The usual activities involved in a release based agile development include the following:

- Maintain Product Backlog – Product owners maintain the product backlog. They continuously groom their backlogs by adding stories, prioritizing and estimating them.
- Release Planning – Organizations have definite release cycles such as quarterly release, bi-yearly release, yearly release. The product owners select the prioritized stories from the product backlog that should be completed in a given release to form *Release Backlog.*
• Sprint Planning – The scrum teams define their sprint schedule such as two weeks sprint or three weeks sprint. They work with product owner, and select stories from the release backlog that should be completed in each sprint to create *Sprint Backlog*.

The following illustration provides a high-level overview of the workflow in a release based agile development environment.
How to use Agile Development 2.0 for release based agile development

Steps to perform release based development:

1. **Manage product backlog**: Product owner maintains and grooms product backlog. Navigate to Agile Development > Backlog > All Stories.

2. **Release planning**: Navigate to Agile Development > Planning > Release planning, and click Assign to release/group to assign stories from product backlog to release backlog.
   
   Simultaneously, specify a group name to assign stories to the specified group.

3. **Backlog planning**: From release backlog, assign stories to groups that are planned to work in the release.

4. **Sprint planning**: The group members along with product owner and scrum master decide stories for each sprint using Sprint Planning. Navigate to Agile Development > Agile Board > Sprint Planning.

*Project based development use case*

An example of project based agile development and delivery model is explained.

The usual activities involved in a project based agile development include the following:

- **Maintain Product Backlog** – Product owners maintain the product backlog. They continuously groom their backlogs by adding stories, prioritizing and estimating them.

- **Project Backlog** – Product owners select the prioritized stories and assign them to one or more projects, which creates the *Project Backlog*. All product owners can create one or more projects and capture additional details such as required resources, cost, risk, strategic alignment. All these projects undergo portfolio prioritization process, and the selected projects are executed by the project teams.

  *Note*: Some organizations also define release cycles such as quarterly release, bi-yearly release, yearly release. They then move the stories from product backlog to the release backlog. In these cases, stories are assigned to the projects from the release backlog. For example, for SAP product, enhancements are delivered every quarter (quarterly release) and then projects are created to execute the release backlog.

- **Sprint Planning** – The project scrum teams define their sprint schedule such as two weeks sprint or three weeks sprint. They work with their project manager, and select stories from the project backlog that should be completed in each sprint to create *Sprint Backlog*.

The following illustration provides a high-level overview of the workflow in a project based agile development environment.
How to use Agile Development 2.0 for project based agile development

Steps to perform project based development:

1. **Manage product backlog**: Product owner maintains and grooms product backlog. Navigate to Agile Development > Backlog > All Stories.
2. **Release planning** [Optional step]: Navigate to Agile Development > Planning > Release planning, and click *Assign to release/group* to assign stories from product backlog to release backlog.

   **Note:** This step is required if the organization has a definite release cycle. In this case, after the release planning, one or more projects are created to execute the release backlog.

3. **Manage project backlog**: Navigate to Agile Development > Backlog > All Stories, or Release Backlog. Then click *Assign to project* to create a project or assign stories to an existing project from product/release backlog.

   Users can also open an existing project and associate stories to the project from the backlog. These stories are then executed as part of project execution.

4. **Group assignment**: The project manager can create one or more agile phases in the project, move stories under these agile phases, and assign groups to these phases. The assigned groups take care of executing these stories through sprints.

5. **Sprint planning**: The agile group members along with project manager, and scrum master perform sprint planning. Navigate to Agile Development > Planning > Sprint planning to open sprint planning board.

**Standalone project development use case**
An example of a standalone project development and delivery model is explained.

In this case, request *(demand)* for a new product or feature or system is raised. Demand managers capture the requirements in terms of stories. They also capture the other details for the demand such as resources required, cost, risks, and strategic direction. Such demands upon approval are converted into projects.

Project managers can choose pure agile or hybrid mode of project execution. In hybrid mode, the initial phases such as planning, and analysis are taken up as waterfall tasks, and then the execution is done as agile phase. The agile phase is assigned to an agile group. The agile group then completes the work by sprint execution.

The following illustration provides a high-level overview of the workflow for executing a standalone project development.
Project based agile development workflow example

How to use Agile Development 2.0 for standalone hybrid project development

Steps to execute a standalone hybrid project:

1. **Create demand**: Capture requirements at demand state in terms of user stories. Use Stories related list on demand form to create stories.

2. **Demand to Project conversion**: When the demand is converted to a project, the stories in demand move to the project so that the project team (assignment group) can execute them. During the conversion, an Agile phase is also created, and the stories are assigned to the agile phase.

3. **Sprint planning**: The agile group members along with project manager, and scrum master perform sprint planning. Navigate to Agile Development > Planning > Sprint planning to plan sprints.
Quick start tests for Agile Development 2.0

Validate that Agile Development 2.0 still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

DANGER: By default, the system property that is used to run automated tests is disabled to prevent you from accidentally running these tests on a production system. To avoid data corruption or an outage, run tests only on development, test, and other non-production instances. See Enable or disable executing Automated Test Framework tests.

Quick start tests require activating the plugin (com.snc.sdlc.agile.2.0) and the Agile Development 2.0 - ATF Tests plugin (com.snc.sdlc.agile.2.0.atf ).

### quick start test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify that global rank is populated when a story is created</td>
<td>Verify the global rank of a story after creation.</td>
<td></td>
</tr>
<tr>
<td>Verify that closing a sprint with active stories is prevented</td>
<td>Verify that a sprint with active stories cannot be closed.</td>
<td></td>
</tr>
<tr>
<td>Verify that sprints cannot overlap in the same group</td>
<td>Verify that sprints in the same group do not overlap.</td>
<td></td>
</tr>
<tr>
<td>Verify that sprint points are updated</td>
<td>Verify that changes to stories produce accurate sprint point totals.</td>
<td></td>
</tr>
<tr>
<td>Verify that only one sprint in a group can have the current state</td>
<td>Verify sprint statuses.</td>
<td></td>
</tr>
<tr>
<td>Verify sprint end date is after the sprint start date</td>
<td>Verify sprint start and end dates.</td>
<td></td>
</tr>
<tr>
<td>Verify that any update on story rolls up to Epic</td>
<td>Verify that adding, estimating, removing, deleting, updating, or cancelling a story updates the epic-level roll-ups correctly.</td>
<td></td>
</tr>
<tr>
<td>Verify changes to the scope of a current sprint do not alter the value of the Total Committed Points</td>
<td>Verify that the value of Total Committed Points does not change with change in the scope of a sprint after its state is changed to Current.</td>
<td></td>
</tr>
</tbody>
</table>
| Verify active flag is set false when Agile Story state is changed to Completed/Cancelled | Verify that active flag of an Agile story is set to the following:  
  • False, if the state is changed to Completed or Cancelled  
  • True, for all other states |                 |
<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
</table>
| Verify that updating the team/group capacity overrides the capacity on all the future sprints | Verify that any update to the **Group capacity** field of the assignment group results in the following changes to the **Group capacity** field of the various sprints associated with this assignment group:  
• For the sprints that are in the Draft and Planning state:  
  • The group capacity is updated to the new value.  
  • The **Group capacity** field is editable.  
• For the sprints in the Current, Complete, or Cancelled state:  
  • The group capacity remains the old value.  
  • The **Group capacity** field is read-only. | |

For the sprints in the Draft or Planning state, you can individually edit the group capacity of the sprint anytime later. This would not change the group capacity of the assignment group associated with this sprint.

### Agile Board

The Agile Board provides a landing page from where you can access the key areas of the standard scrum processes.

Information on the Agile Board is organized in the following tabs:

### Backlog

Plan and prioritize the stories in a personalized backlog using the **Backlog** tab:

• Create stories, epics, and themes.
• Reorder stories in the backlog using the drag feature. The story at the top of the backlog assumes higher priority with a lesser rank value. The story at the bottom of the backlog assumes lower priority with a higher rank value.
• Group stories by epic or the following categories: all stories, stories without estimation, and stories without acceptance criteria.
• Edit the existing filter criteria of the backlog.
• Type a keyword in the search box to view only stories whose details match with the keyword.
Sprint Planning

Plan and prioritize stories for a sprint or multiple sprints by assessing stories in the backlog using the Sprint Planning tab.
• Create, organize, monitor, start, and complete sprints.
• View current and future sprints in chronological order.
• View planned start and end dates, story points, percentage group velocity, number of story points (total, complete, and pending) for the current sprint.
• Assess stories in the backlog and drag them to sprints.
• Add stories to the backlog and set up their order of implementation. The story at the top of the backlog assumes higher priority with a lesser rank. The story at the bottom of the backlog assumes lower priority with a higher rank.
• Move unfinished stories from the completed sprint to the backlog or a future sprint.
<table>
<thead>
<tr>
<th>Group</th>
<th>CRM Engineering Team</th>
<th>Create Sprint</th>
<th>Create Story</th>
<th>Backlog</th>
<th>Sprint Planning</th>
<th>Sprint Tracking</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CRM SPINT 5</strong> 2018-10-13 - 2018-10-20</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Story points: 21 in total</td>
<td>Complete Sprint</td>
</tr>
<tr>
<td>Number</td>
<td>Short Description</td>
<td>Epic</td>
<td>Points</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>STR001042</td>
<td>Ability to adjust sales commissions</td>
<td>Executive Portal</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>STR001023</td>
<td>Supplier ranking tool</td>
<td>Supplier Portal</td>
<td>12</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>CRM SPINT 6</strong> 2018-10-27 - 2018-11-09</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Story points: 0</td>
<td>0% of group capacity</td>
</tr>
</tbody>
</table>
Sprint Tracking

The **Sprint Tracking** tab enables you to track the sprint progress in a board or list view.

Story board

Story board is built on visual task boards, which transform the navigation of lists and forms into an interactive graphical experience. The visual task board interface provides a graphic-rich environment suited for managing and collaborating records. To know more about the actions that can be performed in the board, see [visual task boards](https://servicenow.com). You can:

- Track all the stories of current sprint across lanes.
- Move a story from one lane to another, which in turn updates the state of the story.
- Filter stories based on search criteria.

![Visual Task Board](image)

Task board

Task board enables you to track all the scrum tasks of stories of the current sprint across lanes.

- Move scrum tasks from one lane to another, which in turn updates the state of the stories.
- Filter scrum tasks based on search criteria.
List

List displays scrum tasks and tests associated to stories in each sprint. In the List view, you can:

- Add scrum task and tests without leaving the context of the record.
- View the state, short description, and assignee of the scrum task without drilling down into details.
- View the short description and run result of a test.
- Assess scrum tasks and tests that are pending before the closure of current sprint.
Manage your product backlog

Manage your product backlog at a centralized location. A backlog is a prioritized list of stories related to a specific product, epic, release, and so on. The definition of a backlog is flexible and is set up by the product owner.

- Role required: scrum_product_owner
- Create a personalized backlog or have a backlog shared by the product owner.

1. Navigate to Agile Development > Agile Board > Backlog.
   If you have already created a personalized backlog, it would automatically appear in this tab. If you have not created a personalized backlog, then a welcome page appears that provides a link to create a backlog.

2. From the choice list at the top left corner, select the required backlog.

3. To create another backlog from the Backlog tab, click the Create Backlog icon.

4. To add a story to the backlog:
   a) Click Create Story.
   b) Specify the required details in the story form and click Submit. The story appears at the bottom of the backlog.
      On clicking an existing story number, a story form appears in which you can edit the story details.
      If you have read-only access, you can open the story form but cannot edit the story details.

5. To add a story to the backlog and simultaneously decide its order of implementation, perform these steps:
   a) Select a story in the backlog.
   b) Click Create Story.
   c) Specify the required details in the story form and click Submit. The story is created beneath the story that was selected in the backlog.
6. To open the triage board of a specific task type (such as problems or defects), view the total numbers of records in the triage boards of all task types, and the edit the filter definition of a triage board, click **Triage Board**.

   The **Triage Board** option is displayed only when the Agile Development 2.0 — Unified Backlog plugin is installed.

7. To move a triaged record from the **Backlog** tab to triage board, open the record in a form and click the **Move back to triage board** related link.

8. To create a theme, from the **Create Story** list, click **Create Theme**. For instance, the theme of a release is enhancing a product with some cosmetic changes.

9. To create an epic, from the **Create Story** list, click **Create Epic**.

10. To show or hide the Epics filter, click **Configuration**, and toggle **Show Epics Filter** on or off.

11. To personalize columns in the Backlog list, click .

12. To view the backlog in a standard platform list, click .

13. Click the cards to view more details in a specific category.

<table>
<thead>
<tr>
<th>Card</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stories in total</td>
<td>Displays the total number of stories in the backlog.</td>
</tr>
<tr>
<td>No story points</td>
<td>Displays the total number of records in the backlog without any story points.</td>
</tr>
<tr>
<td>No acceptance criteria</td>
<td>Displays the total number of records in the backlog without any acceptance criteria.</td>
</tr>
</tbody>
</table>

14. To edit the filter criteria of the backlog, click .

15. The **Epics** section lists epics that the stories of the backlog belong to. A maximum of 11 epics are displayed in this section. Epic completion is indicated by a blue progress bar. It is also indicated in terms of percentage.

   Select an epic. Only stories that belong to this epic appear in the Backlog section.

16. The **Backlog** section in a list displays all the active stories assigned to the team, but not assigned to any sprint. To arrange stories within the backlog, use either of the following options:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the drag feature</td>
<td>Point to a story and drag it to the required position.</td>
</tr>
<tr>
<td>Using the keyboard</td>
<td>See Arrange stories using the keyboard.</td>
</tr>
</tbody>
</table>

### Note:

- If the backlog contains more than 50 stories, then a pagination control appears at the bottom of the list enabling you to navigate to the first, last, previous, or next page in the list.
- Rearranging stories in the backlog adjusts the ranking of stories in the global_rank column in the Story [rm_story] table. When you move a story within a backlog, its rank changes relative to the stories within the same backlog. Thus, if the story exists in some other backlog, its ranking might change, but position in the backlog would remain the same.
- You require a specific role that provides access to a triaged record in the backlog. For example, to view a problem in the backlog, you must have the ITIL role. If you do not have access to any record, an error message appears.
17. To perform an action at once on a set of stories:
   • Select the required stories.
   • Click and select any of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to top</td>
<td>Moves stories to the top of the Backlog list.</td>
</tr>
<tr>
<td>Move to bottom</td>
<td>Moves stories to the bottom of the Backlog list.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Opens the Users list. Select the user to whom you want to assign the stories.</td>
</tr>
<tr>
<td>Assigned group</td>
<td>Opens the Groups list. Select the group to which you want to assign the stories.</td>
</tr>
<tr>
<td>Epic</td>
<td>Opens the Epic list. Select the epic to which the stories belong.</td>
</tr>
<tr>
<td>Product</td>
<td>Opens the Product list. Select the product to which the stories belong.</td>
</tr>
<tr>
<td>Project</td>
<td>Opens the Project list. Select the project to which the stories belong.</td>
</tr>
<tr>
<td>Project Phase</td>
<td>Opens the Project Phase list. Select the project phase to which the stories belong.</td>
</tr>
<tr>
<td>Release</td>
<td>Opens the Scrum releases list. Select the release in which the stories are scheduled for completion.</td>
</tr>
<tr>
<td>Theme</td>
<td>Opens the Theme list. Select the theme to be applied on the stories.</td>
</tr>
</tbody>
</table>

Create a personalized backlog
Create filters to define which stories appear in your backlog.
Role required: scrum_product_owner

1. Create a backlog using either of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the Backlog tab</td>
<td>Navigate to Agile Development &gt; Agile Board &gt; Backlog.</td>
</tr>
<tr>
<td></td>
<td>a. Click the Create Backlog icon.</td>
</tr>
<tr>
<td>From Personal Backlogs</td>
<td>Navigate to Agile Development &gt; Personal Backlogs.</td>
</tr>
</tbody>
</table>

2. In the Personal Backlog form, fill these fields:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Suitable name for the backlog.</td>
</tr>
<tr>
<td>Table</td>
<td>(Read-only) Stories reside in the Story [rm_story] table.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Visible to</td>
<td>Users with whom you want to share the backlog.</td>
</tr>
<tr>
<td>a.</td>
<td>Click the icon.</td>
</tr>
<tr>
<td>b.</td>
<td>Click the <strong>Lookup using list</strong> icon.</td>
</tr>
<tr>
<td>c.</td>
<td>In the Users form, select the users.</td>
</tr>
<tr>
<td>d.</td>
<td>Click the <strong>Lock</strong> icon.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Filter</th>
<th>Filter criteria applied on stories that appear in the backlog.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Default filter criteria: [Active] is [True], and [Sprint] is [Empty].</td>
</tr>
</tbody>
</table>

3. **Click Submit.**

Use the following related links:

**Personal Backlogs related links**

<table>
<thead>
<tr>
<th>Related list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to backlog planning</td>
<td>Displays the <strong>Backlog</strong> tab in Agile Board.</td>
</tr>
<tr>
<td>View the list of records</td>
<td>Displays stories matching the backlog filter criteria in a platform list.</td>
</tr>
</tbody>
</table>

**Arrange stories using the keyboard**

In the **Backlog** and **Sprint Planning** tabs, arrange stories using the keyboard.

Role required: scrum_ADMIN, scrum_MASTER, scrum_PRODUCT_OWNER, or scrum_SPRINT_PLANNER

1. To arrange a single story:

   a. Press the Tab key.

   b. After the desired story is highlighted, press the Tab key.

   c. After the icon is highlighted, press the Enter key.

   d. After the icon appears, use the up and down arrow keys.

   e. To fix the position of the story, press the Enter key.
2. To arrange multiple stories:
   a. Press the Tab key.
   b. After the desired story is highlighted, press the Enter key.
   c. To select multiple stories, use the up and down arrow keys.
      • To select consecutive stories, press the Shift and Enter Keys together.
      • To select alternative stories, press the Ctrl and Enter keys together.
   d. Press the Tab key.
   e. After the icon is highlighted, press the Enter key.
   f. After the icon appears, use the up and down arrow keys.
   g. To fix the position of the stories, press the Enter key.

Plan your sprint activities
Streamline your sprint planning and completion activities from the Sprint Planning tab.

- You must be a member of an agile group to access the Sprint Planning tab.
- You can perform only a specific set of actions on the Sprint Planning tab based on the role that is assigned to you. For more information, see Agile Development 2.0 roles in Components installed with Agile Development 2.0.
- Role required: scrum_admin, scrum_master, or scrum_sprint_planner

1. Navigate to Agile Development > Agile Board.
2. Select the Sprint Planning tab.
3. From the choice list at the top-left corner, select an assignment group for which you want to plan the sprint activities. The choice list displays all the teams to which you are added as a group member. The default assignment group is the team you have selected earlier or the first team in which you were added as a group member.
4. To create a sprint, use either of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the Sprint Planning tab</td>
<td>Using this option, only a single sprint is created at one time.</td>
</tr>
<tr>
<td></td>
<td>a. Click Create Sprint.</td>
</tr>
<tr>
<td></td>
<td>b. Specify the required details in the sprint form and click Submit.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>From the Group form</td>
<td>Using this option, a single or multiple sprints can be created at one time.</td>
</tr>
<tr>
<td>a.</td>
<td>Navigate to <strong>Agile Development</strong> &gt; <strong>Groups</strong>.</td>
</tr>
<tr>
<td>b.</td>
<td>Select the assignment group and click <strong>Create Sprints</strong>. If all groups follow the same sprint schedule, sprints can be generated for all groups. For generating sprints for multiple groups at once, select the required groups and click <strong>Create Sprints</strong>.</td>
</tr>
<tr>
<td>c.</td>
<td>In the form, specify the number of sprints to be created.</td>
</tr>
<tr>
<td>d.</td>
<td>Click <strong>Submit</strong>.</td>
</tr>
<tr>
<td>e.</td>
<td>Navigate to <strong>Agile Development</strong> &gt; <strong>Agile Board</strong> &gt; <strong>Sprint Planning</strong>.</td>
</tr>
<tr>
<td>f.</td>
<td>Select the assignment group.</td>
</tr>
</tbody>
</table>

Sprints display stories in the form of a list. If a sprint contains more than 50 stories, then pagination control appears at the bottom of the list enabling you to navigate to the previous, next, first, or last page in the list.

5. To edit a sprint:
   a. Click the name of the sprint.
   b. Update the sprint details in the pop-up window. You can also update the capacity of the assignment group by accounting for changes in team composition, holidays, or vacations. Until the sprint begins, you update the group capacity in the **Group capacity** field.

6. To add a story to the backlog:
   a) Click **Create Story**.
   b) Specify the required details in the story form.
   c) Click **Submit**.
   The story appears at the bottom of the backlog. When you click a story number, a story form appears in which you can edit the story details. If you have read-only access, you can open the story form but cannot edit the story details.

7. To add a story to the backlog or a sprint and simultaneously decide its order of implementation, perform these steps:
   a) Point to a story in the backlog or a sprint.
   b) Click **Create Story**.
   c) Specify the required details in the story form and click **Submit**.
   The story is created beneath the story that was selected in the backlog or a sprint.

8. To create a theme, click **Create Theme**. For example, the theme of a release is to enhance a product with certain cosmetic changes.

9. To create an epic, click **Create Epic**.

10. To personalize columns in a list, click 🔄.
11. The Backlog section in a list displays all the active stories assigned to the team, but not assigned to any sprint. Use either of the following options to arrange stories:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the drag feature</td>
<td>Move stories within the backlog, move stories from the backlog to any sprint, move stories from one sprint to another. Point to a story in the backlog and drag it to the required location.</td>
</tr>
<tr>
<td>Using the keyboard</td>
<td>Move stories only within a backlog or a sprint. See Arrange stories using the keyboard.</td>
</tr>
</tbody>
</table>

**Note:**
- If the backlog contains more than 50 stories, the pagination control appears at the bottom of the list enabling you to navigate to the previous, next, first, or last pages in the list.
- Rearranging stories in the backlog changes the ranking of stories. Ranks are stored in the global_rank column in the Story [rm_story] table. When you move a story within a backlog, its rank changes relative to the stories within the same backlog. Thus, if the story exists in some other backlog, its ranking might change but position in the backlog would remain the same.

12. To start a sprint, click **Start** that appears at right-corner of the first or top sprint. The **Sprint Tracking** tab appears.

13. To complete a sprint, click **Complete Sprint** that appears at right-corner of the first or top sprint. A dialog box appears to indicate the number of completed and incomplete stories in the sprint.
   a. Move incomplete stories, if any, to the backlog or a future sprint.
   b. Click **Complete**. The sprint disappears from the **Sprint Planning** tab and appears in the Sprint list as complete.

**Track your stories from the Board view**

Track the progress of the stories from your current sprint. View their transition from one state (lane) to another in a visual task board.

You must be a member of an agile group to access the board.

Role required: scrum_user or scrum_admin

1. Navigate to **Agile Development > Agile Board**.
2. Click the **Sprint Tracking** tab.
3. Track the progress of the stories for the current sprint by selecting the Story board view.
   From New York release, the Board view is available as Story board and Task board.
4. Optional: Change the state of a story by move the story from one lane to another.
   When the Agile Development — Unified Backlog plugin is installed, records from a triage board are also represented by stories on the board. When you move such a record to another lane, the state of the story changes, but the state of the original record remains the same. To change the state of the original record, open the record in the form and use the **Open original Record** related link.
5. Optional: Add a story to a specific lane.
   a) Click Add Card.
   b) On the form, fill in the fields and click Submit.

Track your tasks from the Board view

Track the progress of the scrum tasks of your stories for the current sprint. View their transition from one state (lane) to another in a visual task board.

You must be a member of an agile group to access the board.

Role required: scrum_user or scrum_admin

1. Navigate to Agile Development > Agile Board.
2. Click the Sprint Tracking tab.
3. Track the progress of scrum tasks of the stories for the current sprint by selecting the Task board view.
   From New York release, the Board view is available as Story board and Task board.
4. Optional: Change the state of a scrum task by moving the task from one lane to another.
5. Optional: Add a scrum task to a specific lane.
   a) Click Add Card.
   b) On the form, fill in the fields and click Submit.

Track your team’s work from the List view

Create, execute, track, and complete the scrum tasks and tests of a story from the List view.

• You must be a member of an agile group to access the Sprint Tracking List.
• Role required: scrum_user or scrum_admin.

1. Navigate to Agile Development > Agile Board.
2. Click the Sprint Tracking tab and select the List view.
3. You can break down a story into scrum tasks.
   a) From the Show list at the top right corner, select Scrum Tasks.
   b) Click Add Scrum Task.
   c) On the form, fill in the fields.

<p>| Scrum Task form |
|-----------------|--------------------------------------------------|
| Field          | Description                                      |
| Number         | System generated number for the story.           |
| Story          | Displays the story associated with the scrum task.|
| Priority       | Priority set for the task.                      |
| Actual hours   | After the task is complete, record the number of hours spent on the task. |
| State          | Current state of the scrum task. The default for a new task is Draft. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment group</td>
<td>Group to which the task belongs. This field is automatically populated from the Assignment group of story from which the task is created.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User working on the scrum task.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the scrum task.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the scrum task.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Notes to indicate progress or issues blocking the progress of the scrum task.</td>
</tr>
</tbody>
</table>

d) Click **Submit**.

**Note:** The user who has only the scrum_user role cannot create a scrum task.

4. Create a test for a story.

**Note:** The option to create a test is available only when **Test Management 2.0** is installed.

a. From the **Show** list at the top-right corner, select **Tests**.

b. Click **Add Test**. See **Create a test from the List view** for more information.

5. Run tests that are in the **Ready** state for a story.

a. Click the **Run** button on a story.

b. In the pop-up, select the environment on which the tests are to be run.

c. Click the **Lookup using list** icon.

d. Click **Run**. See **Run a test** for more information.

6. Personalize and view columns in a list by clicking the personalize icon.

**Create a test from the List view**
A test is a collection of conditions or steps used to determine whether a feature is working correctly. A test can also include an expected result, which determines whether the test passes or fails. Create a test, add steps to the test, and create and maintain different versions of the test.

- Role required: scrum_user or scrum_admin
- You can create a test from the List view only when the **Test Management 2.0** plugin is installed.
- You must be a member of an agile group.

1. Navigate to **Agile Development > Agile Board**.
2. Click the **Sprint Tracking** tab, and select the **List** view.
3. From the **Show** list at the top right corner, select **Tests**.
4. Click **Add Test**.
### 5. In the form, fill in the fields:

#### Test Version Form

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test</td>
<td>Unique name of the test.</td>
</tr>
<tr>
<td>Owner</td>
<td>Owner who created the test.</td>
</tr>
<tr>
<td>Version</td>
<td>Automatically generated version of the test.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the test.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Draft</strong>: State of the test when it is created.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Ready</strong>: State of the test when it is not editable. When the test has multiple versions, only one test will be in <strong>Ready</strong> state at any one time</td>
</tr>
<tr>
<td></td>
<td>• <strong>Retired</strong>: State of the test when it is no longer used.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description about the test.</td>
</tr>
<tr>
<td>Add Step</td>
<td>Button used to add step to a test.</td>
</tr>
<tr>
<td>Run</td>
<td>Button used to run steps, which is displayed only when the test is in the <strong>Ready</strong> state. See Run a test.</td>
</tr>
<tr>
<td>Update</td>
<td>Button used to update the details of a test version.</td>
</tr>
<tr>
<td>Ready</td>
<td>Button used to change the state of the test version to ready.</td>
</tr>
<tr>
<td>Create New Version</td>
<td>Button used to create another version of the test.</td>
</tr>
<tr>
<td>Delete</td>
<td>Button used to delete the test version.</td>
</tr>
<tr>
<td>Needs Verification</td>
<td>Icon used to change the order of a test step. Select the icon and drag a step to the required location.</td>
</tr>
<tr>
<td></td>
<td>Check box used to mark a test step for verification.</td>
</tr>
<tr>
<td>Fields</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Icon used to delete a test step.</td>
</tr>
</tbody>
</table>
Test version form example
View information in the following related lists:

<table>
<thead>
<tr>
<th>Related list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other versions</td>
<td>Displays all the versions of a test.</td>
</tr>
<tr>
<td>Test Results</td>
<td>Displays the run results of each test version.</td>
</tr>
<tr>
<td>Test Sets</td>
<td>Displays related tests in a test set.</td>
</tr>
</tbody>
</table>

**Run a test**

View the test scenario and execute all the steps of a test.

Role required: scrum_user

1. Navigate to **Agile Development > Agile Board**.
2. Click the **Sprint Tracking** tab and select the **List** view.
3. Click a test.
4. You can verify a story by running all of its tests at once. To do this, use the **Run** button at the right of the story.
5. In the pop-up, select the environment on which the test is to be run:
   a. Click **Lookup using list** icon.
   b. Click **Run**.
6. In the Test Execution pop-up, mark a step as passed, failed, or blocked using the following icons:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="icon.png" alt="Passed" /></td>
<td>Passed.</td>
</tr>
<tr>
<td><img src="icon.png" alt="Failed" /></td>
<td>Failed. In this state, options to add comments and attachments are available. Option to delete attachments is also available.</td>
</tr>
<tr>
<td><img src="icon.png" alt="Blocked" /></td>
<td>Blocked. In this state, options to add comments and attachments are available. Option to delete attachments is also available.</td>
</tr>
</tbody>
</table>

   - To select an icon, you can also use the **Tab** key. Press **Tab** and then press **Enter**.
   - To pause and work on the test at a later point in time, click **Pause**.
7. Click **Done**.

Test result is saved to the Test Result form. The latest test result of each test is displayed in the List view.

The overall status of the test is defined by statuses of the test steps:

- If all the test steps are passed, the status of the test is **Passed**.
- If at least one step of the test is not executed, the status of the test is **Not finished**.
- If at least one step of the test fails, the overall status of the test is **Failed**. This rule takes precedence over the previous rule.
- If at least one step of the test is blocked, the overall status of the test is **Blocked**. This rule takes precedence over the previous two rules.
View the test results
In the Test Result form, view the history of test runs and troubleshoot the test failures.

Role required: scrum_user

1. Navigate to Agile Development > Agile Board.
2. Click the Sprint Tracking tab and select the List view.
3. Click a test.
4. Click the Test Result related list, which displays test results related to that version of the test.
5. Click a test result to view its details in a form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Automatically generated number for the test result.</td>
</tr>
<tr>
<td>Result</td>
<td>Execution status of the test: Passed, Failed, or Blocked.</td>
</tr>
<tr>
<td>Execution environment</td>
<td>Environment on which the test is executed.</td>
</tr>
<tr>
<td>Run by</td>
<td>Name of the tester who executed the test plan.</td>
</tr>
<tr>
<td>Test</td>
<td>Test that is being run.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the test that is executed.</td>
</tr>
<tr>
<td>Updated</td>
<td>Date and time when the test result was recorded.</td>
</tr>
<tr>
<td>Test run</td>
<td>Name of the test run.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the test result.</td>
</tr>
</tbody>
</table>

The execution status of each step of the test is also indicated at the bottom of the form.

Managing your products in Agile Development 2.0

A scrum product is an arbitrary classification that represents an item under development. A product organizes themes, epics, and stories of similar functionality into a single context.

Create a product in Agile Development 2.0

Create a product to represent an functionality important to customers. A product can contain themes, epics, and stories that describe these enhancements from the perspective of a user.

Role required: scrum_product_owner, scrum_release_planner, scrum_admin

You create products first and then add themes, epics, or stories to create a backlog.

1. Create a product using one of these methods:

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>From a release record</td>
<td>Select the Products related list and click New.</td>
</tr>
<tr>
<td>From the Products list</td>
<td>a. Navigate to Agile Development &gt; Products.</td>
</tr>
<tr>
<td></td>
<td>b. Click New in the record list.</td>
</tr>
</tbody>
</table>

2. Fill in the fields.

<table>
<thead>
<tr>
<th>Product form Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the product.</td>
</tr>
</tbody>
</table>
3. Click **Submit**.

Add release, theme, epic, stories, and groups to associate with the product using the following related lists.

**Product form related list**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Short Description</strong></td>
<td>A description of the product that adequately explains the release, theme, epic, stories, and groups associated to it.</td>
</tr>
<tr>
<td><strong>Product owner</strong></td>
<td>Product owner for the product.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Related list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Releases</strong></td>
<td>Lists the releases associated with the product. Click <strong>New</strong> to create a release. Click <strong>Edit</strong> to add an existing release to the product.</td>
</tr>
<tr>
<td><strong>Themes</strong></td>
<td>Lists the themes that are part of the product. Click <strong>New</strong> to create a theme. Click <strong>Edit</strong> to add an existing theme to the product.</td>
</tr>
<tr>
<td><strong>Epics</strong></td>
<td>Lists the epics associated with the product. Click <strong>New</strong> to create an epic. Click <strong>Edit</strong> to add an existing epic to the product.</td>
</tr>
<tr>
<td><strong>Stories</strong></td>
<td>Lists the stories associated with the product. Click <strong>New</strong> to create a story. Click <strong>Edit</strong> to add an existing story to the product.</td>
</tr>
<tr>
<td><strong>Groups</strong></td>
<td>Lists the groups assigned to the product. Click <strong>Edit</strong> to assign an existing agile group to the product. You can associate one or more assignment groups (of type Agile Team) to a product. When you associate a product to a release, the groups assigned to the product are automatically added to the release too.</td>
</tr>
</tbody>
</table>
Create a theme in Agile Development 2.0

A scrum theme is the highest level of the story hierarchy. It describes a view of a tangible product or an abstract goal (such as performance tuning). A product owner further breaks down a theme into one or more epics.

Role required: scrum_product_owner, scrum_release_planner, scrum_admin

1. Create a theme using one of these methods:

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Agile Board</td>
<td>a. Navigate to Agile Development &gt; Agile Board.</td>
</tr>
<tr>
<td></td>
<td>b. Click the Backlog Planning or Sprint Planning tab.</td>
</tr>
<tr>
<td></td>
<td>c. Click Create Theme.</td>
</tr>
<tr>
<td>From the themes list</td>
<td>a. Navigate to Agile Development &gt; Themes.</td>
</tr>
<tr>
<td></td>
<td>b. Click New in the record list.</td>
</tr>
<tr>
<td>From a product record</td>
<td>Select the Themes related list and click New.</td>
</tr>
</tbody>
</table>

2. Fill in the fields, as appropriate.

<table>
<thead>
<tr>
<th>Theme form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Number</td>
<td>A system generated number for the theme.</td>
</tr>
<tr>
<td>Name</td>
<td>Name for the theme that states the high-level business case.</td>
</tr>
<tr>
<td>Product</td>
<td>Product with which this theme is associated. A theme cannot be associated</td>
</tr>
<tr>
<td></td>
<td>with more than one product at a time.</td>
</tr>
<tr>
<td>Short Description</td>
<td>A brief description of the theme.</td>
</tr>
<tr>
<td>Description</td>
<td>A detailed description about the theme.</td>
</tr>
</tbody>
</table>

3. Click Submit.

Theme is created and the form reopens with related lists.

Add epics, and stories to the theme using the following related lists.

<table>
<thead>
<tr>
<th>Theme form related list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Related list</td>
<td></td>
</tr>
<tr>
<td>Epics</td>
<td>Lists the epics associated with the theme. Click New to create an epic.</td>
</tr>
<tr>
<td>Stories</td>
<td>Lists the stories associated with the theme. Click New to create a story.</td>
</tr>
</tbody>
</table>
Create an epic in Agile Development 2.0

Group related user stories together using an epic. Epics organize the work to complete parts of a theme into smaller, more manageable pieces.

Role required: scrum_story_creator, scrum_admin

To organize epics, you can create a hierarchy of parent and child epics. You can associate an epic to a product, theme, or configuration item (an item or service that is affected). You can also define child epics.

1. Open the new epic form using one of the following methods:

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Agile Board</td>
<td>a. Navigate to Agile Development &gt; Agile Board.</td>
</tr>
<tr>
<td></td>
<td>b. Click the Backlog Planning or Sprint Planning tab.</td>
</tr>
<tr>
<td></td>
<td>c. Click Create Epic.</td>
</tr>
<tr>
<td>From the epics module</td>
<td>a. Navigate to Agile Development &gt; Epics.</td>
</tr>
<tr>
<td></td>
<td>b. Click New in the record list.</td>
</tr>
<tr>
<td>From a theme record</td>
<td>Select the Epics related list and click New.</td>
</tr>
<tr>
<td>From a product record</td>
<td>Select the Epics related list and click New.</td>
</tr>
</tbody>
</table>

You can also convert an existing active story into an epic. For details, see Related links and lists of a story.

2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>System-generated number for the epic.</td>
</tr>
<tr>
<td>Product</td>
<td>Product associated with this epic.</td>
</tr>
<tr>
<td></td>
<td>You can associate an epic with only one theme and one product at a time.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority set for the epic.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the epic. The default state is Draft.</td>
</tr>
<tr>
<td>Short Description</td>
<td>Brief description of the epic.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the epic.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Notes about the work done on the epic.</td>
</tr>
<tr>
<td>Total story count</td>
<td>Number of stories in the epic.</td>
</tr>
<tr>
<td>Completed count</td>
<td>Number of completed stories in the epic.</td>
</tr>
<tr>
<td>Percent complete by count</td>
<td>Percentage of completed work in the epic. Story count is used to calculate this value.</td>
</tr>
<tr>
<td>Total estimate</td>
<td>Sum of the estimates of all stories in the epic.</td>
</tr>
<tr>
<td>Completed estimate</td>
<td>Sum of the estimates of all the completed stories in the epic.</td>
</tr>
</tbody>
</table>
3. Click **Submit**.

Add child epics or stories to the epic:

- Associate a child epic by clicking **New** from the Child Epics related list.
- Add stories to this epic by clicking **New** from the Stories related list. For more information, see create a story.

An epic can have one or more stories, but a story can belong to only one epic at a time.

### Managing your releases in Agile Development 2.0

Releases contain user stories, sometimes from multiple products or projects, that form the release backlog. A product owner creates the releases.

A release is bounded by start and end times and is used to organize the effort of the assigned groups working on user stories. A release can use multiple assignment groups.

Typically, the product owners select the prioritized stories from the backlog to be completed in a given release. The set of stories in a release are referred as release backlog.

Agile Development 2.0 allows the release backlog to be executed in two ways:

- Project-based execution - Allows release backlog to be executed as one or more projects.
- Non project-based execution - Allows release backlog to be executed by one or more assignment groups using their sprint schedules within a release.

### Create a release

Create a release, and then select the prioritized stories to be completed in that release.

Role required: scrum_release_planner, scrum_admin

Before attempting to create a release, make sure that you have created the appropriate stories and scrum tasks and associated them with one or more products.

1. **Create a release using one of these methods:**

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>From a product record</td>
<td>Select the <strong>Releases</strong> related list and click <strong>New</strong>.</td>
</tr>
<tr>
<td>From the Releases list</td>
<td>a. Navigate to Agile Development &gt; <strong>Releases</strong>.</td>
</tr>
<tr>
<td></td>
<td>b. Click <strong>New</strong> in the record list.</td>
</tr>
</tbody>
</table>

2. Fill in the fields, as appropriate.

#### Release form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>A system generated number for the release.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the release. The default is <strong>Draft</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Total committed points</td>
<td>Displays the sum of all story points from the stories assigned to the release.</td>
</tr>
<tr>
<td>Release capacity</td>
<td>Sum of group capacity of all the assignment groups associated with the release. Group capacity of an assignment group for a release is calculated as: Group capacity * Number of sprints in the release for that group. Release capacity is updated only when the Start sprint and End sprint are populated for the groups in the Groups related list in the release record.</td>
</tr>
<tr>
<td>Planned start date</td>
<td>The estimated date for the release to start.</td>
</tr>
<tr>
<td>Planned end date</td>
<td>The estimated date for the release to end.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The scrum user assigned to the release. It must be a scrum user, such as a release planner or product owner, whose role allows rights to create and edit releases.</td>
</tr>
<tr>
<td>Short Description</td>
<td>A brief description of the release.</td>
</tr>
<tr>
<td>Description</td>
<td>A detailed description of the release.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Notes about the work being performed on the release.</td>
</tr>
</tbody>
</table>

3. **Click Submit.**

After a release record is created, perform release planning by selecting a product and moving stories from a product backlog to a release backlog. You can add products, stories, or groups using the following related lists.

**Release form related list**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Related list</td>
<td>Lists the products associated with the release. Click New to create a product. Click Edit to add an existing product to the release.</td>
</tr>
<tr>
<td>Products</td>
<td>Lists the stories associated with the release. The stories you add create the release backlog. Click New to create a story. Click Edit to add an existing story to the release.</td>
</tr>
<tr>
<td>Stories</td>
<td>Lists the stories associated with the release. The stories you add create the release backlog. Click New to create a story. Click Edit to add an existing story to the release.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Groups</td>
<td>Lists the groups assigned to the release. Click <strong>Edit</strong> to assign an existing agile group to the release. When you associate a product to a release, the groups assigned to the product are automatically added to the release. Select <strong>Start sprint</strong> and <strong>End sprint</strong> for which the group is assigned to the release. The <strong>Group capacity</strong> of the assignment group for a release is calculated as: Group capacity * Number of sprints in the release for that group.</td>
</tr>
</tbody>
</table>

### Managing your scrum stories and tasks in Agile Development 2.0

A story is a brief statement of a product requirement or a business case. The purpose of a story is to provide a high-level definition of a requirement, capturing the who, what, and why in a simple, concise way. A story should be small enough to be completed in one sprint.

The estimated effort required to complete a story is measured in story points, with more points being assigned to stories requiring more effort. Story points are arbitrary measurements of the effort (not necessarily the time) required to complete a story, based on the estimates of group members. The work required for a story can be broken down into discreet scrum tasks.

After creating stories and tasks, manage and track them to completion using the Sprint Board.

### How to write effective stories

Well-written stories are easy to understand by all developers and other team members, such as QA or documentation.

Stories enable the assignment group to accurately estimate the effort required to implement the work according to the definition of done. Definition of done is the exit criteria agreed to by the group, that determines when a story is complete.

A story has the following basic conditions:

- **Description**: The story description relates to a user persona, such as administrator, and either describes a business value or addresses a technical debt.
- **Acceptance criteria**: The story acceptance criteria are measurable and testable.

### Story descriptions

A good user story description identifies the following for meeting the stated requirement:

- the role of the user persona in the system
- the need expressed by the user persona
- the benefit to all stakeholders such as developers, users, and others

Typically, a story description is expressed as: "As a <role>, I want <goal or need>, so that <benefit>.”

### Examples of good story description

- **Description**: As a developer, I want to publish the current state of my application to an update set, so that I can deploy it to a production system.
• Description: As a customer, I want to receive notifications when comments are entered for an incident so that I am updated on the status.
• Description: As a change manager, I want to enable the assessment of risk for any given change by establishing a list of questions with multiple choice answers.

Example of bad story description

• Description: Notifications are sent when incidents are created.

This description is poor because:
• The description does not state who or what is sending the notifications, not in what form the notification takes, such as email.
• The description does not include any benefit information, so the business value is not clear.

It could be better written as:
• Description: As an incident creator, I want email notifications to be sent to a predefined set of interested parties when I create an incident, so that they can be informed when an incident affecting them is created.

Story acceptance criteria

Acceptance criteria define the boundaries of a user story, and are used to confirm when the software is working as intended, which means the story is completed. Acceptance criteria are an essential part of the ‘Definition of Done’ for a story.

Good acceptance criteria

Good acceptance criteria should include the following, where relevant:
• Usability: Be sure to include measures of usability in the acceptance criteria. Indicate how to answer the question: Is it easy to use? The key is to identify the right measurements and make sure each is quantifiable.
• Functionality: Identify specific user tasks, business processes, or functions that must be in place at the end of the project. A functional requirement might be: The user can choose from multiple sizes.
• Error handling: Enumerate error cases and how each should be handled. For example, if a user performs the steps in the wrong order, how will the software handle it?
• Performance: Test system performance from the perspective of an individual user. For example: Is the UI responsive?
• Stress tests: Describe how the system responds when it is under stress because there are many users, transactions, or queries. Acceptance criteria should define acceptable thresholds for stress testing. For example: Does the system respond within a 250-millisecond threshold when 100 users submit queries simultaneously?

Example of Good Acceptance Criteria

Description: As a customer, I want to order and pay for the book via a secure web-based form, so that my credit card information is safe.

Acceptance Criteria:
• All mandatory fields must be completed before a customer can submit a form.
• Information from the form is stored in the customer orders database.
• Payment can be made via Amex, Master Card, or Visa credit card.
• The system shall accurately calculate and apply sales tax.
• The system shall accurately calculate and apply shipping charges.
• The customer shall be able to verify the accuracy of the order.
• An acknowledgment email is sent to the customer submitting the form.
• Protection against spam is working.

**Example of Bad Acceptance Criteria**

Description: As a customer, I want to receive notifications when an incident is commented, so that I am updated on the status.

Acceptance Criteria: The appropriate people are notified when incidents are commented.

The acceptance criteria are poor because they do not give enough detail to test, for example, it is not clear who the appropriate people are.

The acceptance criteria could be better written as:

1. As an ESS user, create an incident.
2. Select *Notify interested parties*.
3. Save the incident.
4. Log in as an interested party.
5. Check that you have received an email for the logged incident.

**Create a story in Agile Development 2.0**

Create high-level definitions of your requirements in the form of stories. You can associate stories to a product or a project.

Role required: scrum_story_creator, scrum_admin

1. Navigate to the new story form in one of the following ways:

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Agile Board</td>
<td>a. Navigate to Agile Development &gt; Agile Board.</td>
</tr>
<tr>
<td></td>
<td>b. Click the Backlog Planning tab or the Sprint Planning tab.</td>
</tr>
<tr>
<td></td>
<td>c. Click Create Story.</td>
</tr>
<tr>
<td>From the stories module</td>
<td>a. Navigate to Agile Development &gt; Stories.</td>
</tr>
<tr>
<td></td>
<td>b. Click New.</td>
</tr>
<tr>
<td>From an enhancement record</td>
<td>a. Navigate to Agile Development &gt; Enhancements.</td>
</tr>
<tr>
<td></td>
<td>b. Open the required enhancement.</td>
</tr>
<tr>
<td></td>
<td>c. Right-click the header and select Create story.</td>
</tr>
</tbody>
</table>

The product owner reviews enhancement requests and decides which ones require stories.
### Option

#### From a defect record

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>a.</td>
<td>Navigate to Agile Development &gt; Defects.</td>
</tr>
<tr>
<td>b.</td>
<td>Open the defect record.</td>
</tr>
<tr>
<td>c.</td>
<td>Right-click the header and select Create story.</td>
</tr>
</tbody>
</table>

#### From a product, release, sprint, theme, or epic form

Select the Stories related list and click New.

### 2. Fill in the fields, as appropriate.

**Note:** Some of the fields on the story form may appear filled depending on the option that you used to create the story.

#### Story form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>System-generated number for the story.</td>
</tr>
</tbody>
</table>
| Theme          | Theme associated with the story.  
A theme can have one or more stories, but a story can belong to only one theme at a time.  
Select the theme for this story from a list of themes associated with the selected Product. |
| Epic           | Epic associated with the story.  
An epic can have one or more stories, but a story can belong to only one epic at a time.  
Select an epic for this story from the epics associated with the selected Product. |
| Type           | Type of story.  
Choose from options such as Development, Documentation, Spike (for example, research activity), and so on. |
| Classification | Type of development the story involves. The default is Feature.  
This field has no connection to the Defect and Enhancement fields in the Related Records tab. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>State of the story. Select one of the following:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Draft</strong>: In this state, the story requirements, such as the description and acceptance criteria, are still being drafted.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Ready</strong>: In this state, the story is marked as ready for pickup by the development team.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Work in Progress</strong>: In this state, the development team works on the story and records their changes in the work notes field.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Ready for Testing</strong>: In this state, the story is marked as ready for pickup by a tester.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Testing</strong>: In this state, the tester works on testing the story based on the requirements provided in the story.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Complete</strong>: In this state, the development and testing efforts on a story are complete.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Cancelled</strong>: In this state, a story has been cancelled.</td>
</tr>
<tr>
<td></td>
<td>The default state for a new story is <strong>Draft</strong>.</td>
</tr>
<tr>
<td>Points</td>
<td>Number of points indicating the estimated effort required to complete the story.</td>
</tr>
<tr>
<td></td>
<td>A larger point value indicates that the story requires a greater amount of effort.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority assigned to the story.</td>
</tr>
<tr>
<td></td>
<td>A product owner can use priorities to rank stories in the planning board.</td>
</tr>
<tr>
<td>Product</td>
<td>Product with which this story is associated.</td>
</tr>
<tr>
<td></td>
<td>This is a required field if the story is part of the product.</td>
</tr>
<tr>
<td>Release</td>
<td>Release with which this story is associated.</td>
</tr>
<tr>
<td></td>
<td>The release can be from the releases associated with the selected product.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Agile team to which the story belongs.</td>
</tr>
<tr>
<td>Sprint</td>
<td>Sprint with which this story is associated.</td>
</tr>
<tr>
<td></td>
<td>This field becomes active when an assignment group is selected for this story.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User who is working on the story.</td>
</tr>
<tr>
<td></td>
<td>Users on this list have appropriate scrum roles.</td>
</tr>
<tr>
<td>Demand</td>
<td>Demand with which this story is associated.</td>
</tr>
<tr>
<td></td>
<td>When the demand is converted to project, the demand stories move from demand to project.</td>
</tr>
<tr>
<td></td>
<td>When a demand is converted to a story, the reference to the demand is displayed here.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Project</td>
<td>The project with which this story is associated. This is a required field if the story is executed as part of a project.</td>
</tr>
<tr>
<td>Project phase</td>
<td>The name of the agile project phase with which this story is associated. This field becomes active when a Project is selected. If a project has only one phase, then the story automatically gets tagged to the only phase.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> An agile phase can have stories belonging to more than one group.</td>
</tr>
<tr>
<td>Blocked</td>
<td>An indicator to show that there are issues which prevent preventing the story from progressing.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the story.</td>
</tr>
<tr>
<td>Description</td>
<td>A detailed description of the story.</td>
</tr>
<tr>
<td>Acceptance criteria</td>
<td>The functional criteria or testing results required to move this story to the <strong>Complete</strong> state.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Notes about the work done for this story.</td>
</tr>
<tr>
<td>Defect</td>
<td><strong>Defect</strong> associated with the story. This is a reference field from the Defect [rm_defect] table. This is a required field if the story is created for a defect. Click the magnifier icon in this field to display the existing defects or to open a new defect. Only users with the feature_user role can open a defect. The admin must grant the feature_user role to all users who are expected to open defects in the Agile Development application. This is the only location in the Agile Development application where records from this table appear.</td>
</tr>
<tr>
<td>Enhancement</td>
<td>The <strong>enhancement</strong> associated with the story. This is a reference field from the Enhancement [rm_enhancement] table. This is a required field if the story is created for an enhancement. Click the magnifier icon in this field to display the existing enhancement requests or to open a new enhancement. Only users with the feature_user role can open an enhancement. The admin must grant the feature_user role to all users who are expected to open enhancement requests in the Agile Development application. This is the only location in the Agile Development application where records from this table appear.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

- The story is created and the form reopens with related links and lists.
The story is listed in the respective backlog list depending on the fields filled in the story form.

Create a story with the same details as this story using the **Insert** or **Insert and Stay** options from the story additional actions.

When you use **Insert and Stay**, the form of the newly created story remains open so that you can modify its details, create more stories with these details, or do both.

On Agile Board, the new story is positioned right below the original story and the global rank of the new story is set accordingly.

**Note:**
- Set the `glide.ui.task.insert` and `glide.ui.advance` properties to `true` to access these actions.
- These actions are not allowed on stories added from the triage board.

Use the related links and lists of the story to create **scrum tasks** for this story, or add dependencies of the current story to other stories. You can also convert this story into an epic, based on your requirements.

### Related links and lists of a story

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Related links</strong></td>
<td></td>
</tr>
<tr>
<td>Add Scrum Tasks</td>
<td>Enables you to add multiple tasks to the current story. The scrum tasks are listed Scrum Tasks related list of the story.</td>
</tr>
<tr>
<td>Convert into epic</td>
<td>Converts an active story into an epic and moves the story into Cancelled state. If the story that you created is too big, you can convert it into an epic and then break it down into multiple stories.</td>
</tr>
<tr>
<td></td>
<td>• If this story is already associated with an epic, then the newly created epic is added as a child epic to it. For example, STRY01, which is associated with EPIC01, is converted into EPIC02. Then, EPIC02 becomes a child epic to EPIC01. Otherwise, EPIC02 is created as a standalone epic.</td>
</tr>
<tr>
<td></td>
<td>• The default state of the newly created epic is Draft.</td>
</tr>
<tr>
<td></td>
<td>• The cancelled story is associated with the newly created epic.</td>
</tr>
</tbody>
</table>
Create a scrum task in Agile Development 2.0

Tasks are the discrete pieces of work required to complete a story. You can create one scrum task at a time or multiple scrum tasks at once.

Role required: scrum_story_creator, scrum_admin

Team members volunteer for tasks based on their skills and track the hours remaining daily. The time remaining is reflected in the sprint burndown chart. If the planned hours for a task exceed a period agreed to earlier, such as eight hours, the task can be split into additional tasks. A story is not completed until all its tasks are complete.

1. Create a task in one of these ways:

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>From a story form</td>
<td>Select the Scrum tasks related list and click New.</td>
</tr>
<tr>
<td>From a story or task progress board</td>
<td>• Click the add icon (+) in a story object.</td>
</tr>
<tr>
<td></td>
<td>• Or</td>
</tr>
<tr>
<td></td>
<td>• Right-click a story object, and select Add Scrum Task.</td>
</tr>
</tbody>
</table>

**Note:** You can generate multiple scrum tasks together to save time.

2. On the form, fill the fields.

<table>
<thead>
<tr>
<th>Scrum Task form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Number</td>
</tr>
<tr>
<td>Field</td>
</tr>
<tr>
<td>------------------</td>
</tr>
<tr>
<td>Story</td>
</tr>
<tr>
<td>Priority</td>
</tr>
<tr>
<td>Planned hours</td>
</tr>
<tr>
<td>Remaining hours</td>
</tr>
<tr>
<td>Actual hours</td>
</tr>
<tr>
<td>Type</td>
</tr>
<tr>
<td>State</td>
</tr>
<tr>
<td>Assignment group</td>
</tr>
<tr>
<td>Assigned to</td>
</tr>
<tr>
<td>Blocked</td>
</tr>
<tr>
<td>Short description</td>
</tr>
<tr>
<td>Description</td>
</tr>
<tr>
<td>Work notes</td>
</tr>
</tbody>
</table>

**Create multiple scrum tasks**
Create batches of scrum tasks at once to save time.

Role required: `scrum_story_creator`, `scrum_admin`

1. Create multiple scrum tasks using one of these methods:

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>From a story form</td>
<td>a. Open the story record for which you want to create the scrum tasks.</td>
</tr>
<tr>
<td></td>
<td>b. Click <strong>Add Scrum Tasks</strong> in the related links.</td>
</tr>
<tr>
<td>From all stories or release backlog</td>
<td>a. Select the story (or stories) in the list for which you want to create the scrum tasks.</td>
</tr>
<tr>
<td></td>
<td>b. Right-click, and select <strong>Add Scrum Tasks</strong>.</td>
</tr>
</tbody>
</table>
2. In the dialog box that appears, set the number of scrum tasks to create for each task type:
   - Analysis
   - Coding
   - Documentation
   - Testing

3. Click **OK**.

A batch of tasks of the selected types is created in **Scrum Tasks** related list in the selected story records.

**Note:** Scrum tasks created with this method are not yet complete and must be updated to become functional.

Open each scrum task record with a short description of **ToDo** and define the task.

**Managing your assignment groups in Agile Development 2.0**

Create and manage your agile groups easily using Agile Development 2.0.

An assignment group of type **Agile Team** can be **created** and group members can be **added** to it. For each group member, a default number of story points can be defined. At the group level, the sum of the group member story points determines the group capacity.

**Create an assignment group in Agile Development 2.0**

Create an assignment group of the type Agile Team so that you can assign these groups to a product or a release.

Role required: scrum_master, scrum_admin

1. Navigate to **Agile Development > Create Agile Group**.
2. Enter a descriptive group name in the **Name** field.
3. Enter a brief **Description** of the group.
4. Click **Submit**.
   - Assignment group is created and the form reopens with additional fields, related links, and related lists.
5. Fill in the fields, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manager</td>
<td>The manager of the group.</td>
</tr>
<tr>
<td>Group capacity (points)</td>
<td>The number of points a group can accommodate in each sprint.</td>
</tr>
<tr>
<td>Group email</td>
<td>Email address of the group.</td>
</tr>
<tr>
<td>Related Links</td>
<td></td>
</tr>
<tr>
<td>Create Sprints</td>
<td>Access the <strong>Create Sprints</strong> dialog box. Fill in the fields and then click <strong>OK</strong> to create multiple sprints for the current group. The new sprints are added to the <strong>Sprints</strong> related list of the group.</td>
</tr>
<tr>
<td>Sprint Planning</td>
<td>Access <strong>Sprint Planning</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Group Velocity</td>
<td>Access a chart which shows how story points in a group are allotted across sprints.</td>
</tr>
</tbody>
</table>

**Note:** This link is accessible only if you have upgraded from a previous release and do not have the Performance Analytics Content Pack for Agile 2.0 application.

**Related Lists**

<table>
<thead>
<tr>
<th>List</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Members</td>
<td>Lists the members of the group. Click <strong>Edit</strong> to add members to the agile group. The <strong>Average points per sprint</strong> field rolls up to derive the group capacity for a sprint.</td>
</tr>
</tbody>
</table>

| Sprints               | Lists the sprints for the group. Click **New** to add a sprint to the group. |

You can add members and sprints to the group using related lists.

**Add members to an assignment group**

Add team members who would work on the scrum stories and tasks to your assignment group.

Role required: scrum_master, scrum_admin

Only users with scrum_user role can be added to an agile group.

1. Navigate to **Agile Development > Groups**.
2. Open the desired group.
3. In the **Group Members** related list, click **Edit**.
4. Add the required scrum user.

The selected scrum user is listed in **Group Members** related list.

**Convert a release team to a group (only for existing customers having release teams)**

Convert an existing release team to an assignment group of type Agile Team so that you can assign them to a product or a release.

Role required: scrum_user, scrum_admin

Agile development 2.0 does not use **Release Team**. Existing users who have created release teams must convert the existing teams to assignment groups.

1. Navigate to **Agile Development > Groups**.
2. Click the **Convert Release Teams to Groups** related link.
3. Select the team that you want to convert to an assignment group.
4. Click **Convert to Group**.

- The release team is available as assignment group at **Agile Development > Groups**.
- The members of the release team are copied to the assignment group.
Enhancement requests in Agile Development 2.0

Users without scrum roles can create enhancement requests within the Agile Development application. A scrum product owner reviews these requests and decides whether to create one or more user stories.

From Enhancement module:

- Scrum users with scrum_story_creator role can
  - create a story for an enhancement.
  - edit and manage the stories and their backlogs from the Stories related list in the Enhancements form.
  - create enhancement requests.
- Users without scrum roles can create enhancement requests. However, they cannot see other Agile Development modules or the stories attached to the enhancement request.

Required Role

The administrator must grant the feature_user role to all users who are expected to open defect reports in the Agile Development application. No other role adds the feature_user role and the role does not embed inherited roles. Users with the feature_user role can only access the Enhancements module in the Agile Development application.

Create an enhancement request in Agile Development 2.0

Create an enhancement request from Agile Development.

Role required: feature_user, scrum_story_creator, scrum_admin

The administrator must grant the feature_user role to all users who are expected to create enhancement request in the Agile Development application.

1. Navigate to Agile Development > Enhancements.
2. Click New.
3. Fill in the fields, as appropriate.

Enhancement form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>A system generated number for the enhancement.</td>
</tr>
<tr>
<td>Priority</td>
<td>The priority assigned to the enhancement. A product owner can use priorities when creating stories.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the enhancement. The default is Draft.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>The group to which the enhancement belongs.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The user assigned to the enhancement.</td>
</tr>
<tr>
<td>Product</td>
<td>The product with which this enhancement is associated. The field is required if the enhancement is part of product.</td>
</tr>
<tr>
<td>Short Description</td>
<td>A brief description of the enhancement.</td>
</tr>
<tr>
<td>Description</td>
<td>A detailed description of the enhancement.</td>
</tr>
</tbody>
</table>
4. Click Submit.

The enhancement request is created and the form reopens with Stories related list. However, the platform conceals stories in the related list from users without a scrum role.

A scrum product owner can review the request and decide whether to create user stories for it.

**Reporting defects in Agile development 2.0**

Users with a special, non-scrum role can report defects within the Agile Development application.

A scrum product owner reviews these defects and decides whether to create user stories for them. Scrum users with the proper roles can edit and manage the stories and their backlogs from the Stories related list in the Defects form. A user without scrum roles who reports a defect cannot see other Agile Development modules or the stories attached to the defect.

**Required Role**

The administrator must grant the feature_user role to all users who are expected to report defects in the Agile Development application. No other role adds the feature_user role and the role does not embed inherited roles. Users with the feature_user role can only access the Enhancements and Defects modules in the Agile Development application.

**Report a defect**

Report a defect to track issues in Agile Development. You can then create a story from the defect.

Role required: feature_user, scrum_story_creator, scrum_admin

The administrator must grant the feature_user role to all users who are expected to report defects in the Agile Development application.

1. Navigate to Agile Development > Defects.
2. Click New.
3. Fill in the fields, as appropriate.

<table>
<thead>
<tr>
<th><strong>Defect form fields</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Number</td>
</tr>
<tr>
<td>Priority</td>
</tr>
<tr>
<td>State</td>
</tr>
<tr>
<td>Assignment group</td>
</tr>
<tr>
<td>Assigned to</td>
</tr>
<tr>
<td>Product</td>
</tr>
<tr>
<td>Short Description</td>
</tr>
</tbody>
</table>
4. Click **Submit**.

The defect record is created and the form reopens with **Stories** related list. However, the platform conceals stories in the related list from users without a scrum role.

A scrum product owner can review the defect and decide whether to **create user stories** for it.

### Mobile experience for Agile Development 2.0

Track and update the status of your stories and scrum tasks of the current sprint from your mobile device using the Agile Development v2 mobile app.

With the Agile Development v2 mobile app, you track sprints for the assignment groups that you are a part of. From your mobile device, you can do the following operations for the current sprint:

- View the status and details of stories and scrum tasks from the assignment groups that you are a part of.
- Edit and update the details of stories and scrum tasks.
- Create scrum tasks for a story.
- Add work notes and attachments to a story or scrum task.
- Collaborate with other stakeholders on a story or scrum task.
- Receive mobile notifications when notes are added to your story or scrum task.

### Install Agile Development v2

Install the Agile Development v2 mobile app (sn_agile_mobile) from **ServiceNow Store**.

**Role required:** admin

1. Navigate to **ServiceNow Store**.
2. In ServiceNow Store, search for Agile Development v2.
3. Click the application tile.
   
   You can view detailed information about the application.

   **Note:** Consider reading the Other Requirements and Dependencies sections, as applicable.

4. Click **Request App** and enter your Now Support login credentials.
5. Click **Buy**.
6. Enter the **Instance Name** and **Reason for the Instance**, and click **Validate Instance**.
7. Click **Request**.
   
   You receive an email with detailed installation instructions.
8. Log in to the instance on which you want to install the Agile Development.
9. Navigate to **System Applications > Applications**.
10. Locate the application, select it, and click **Install**.

Get started with Agile Development v2.
Get started with Agile Development v2

Access the Agile Development mobile app to track your sprints, stories, and tasks.

- Download the ServiceNow Agent mobile app from App Store (iOS) or Google Play Store (Android).
- Install Agile Development v2 on your ServiceNow instance.
- Role required: admin

1. Log in with your ServiceNow instance address on the ServiceNow Agent app on your mobile device in one of the following ways:

<table>
<thead>
<tr>
<th>Existing user</th>
<th>New user</th>
</tr>
</thead>
</table>
   | • If you installed the Agile Development v2 mobile app on an instance that you already use in the ServiceNow Agent app, refresh the app to see Agile 2.0 as an applet launcher.  
   | • If you installed the Agile Development mobile v2 app on a different instance:  
   | a. Log out by tapping **Settings > Log out.**  
   | b. Tap the add icon (➕) and log in with your new ServiceNow instance address.  
   | a. Enter the instance address in one of the following two ways:  
   | • Type the instance address in the instance address field.  
   | • If your administrator provided you with a QR code, tap the QR icon (🔍), and scan the QR code.  
   | b. Tap **Save and log in.**

2. Log in using your user name and password.

3. Tap the Agile Development v2 icon (Agile 2.0) to start tracking your sprints, stories, and scrum tasks.

Go to

- Managing stories on Agile Development v2 mobile app.
- Managing scrum tasks on Agile Development v2 mobile app.

Managing stories on Agile Development v2 mobile app

View, edit, and update the details of stories assigned for the current sprint on your mobile device.

On your mobile device, open the ServiceNow Agent app and navigate to Agile Development v2. Perform the following actions with the role of scrum_product_owner, scrum_team_member, or scrum_master.
Tracking stories on Agile Development v2

From your mobile device, track all stories of an assignment group including the stories that are assigned to you from multiple assignment groups.

All stories of an assignment group

1. In the Sprint Tracking applet, tap **See All**.
2. Tap the name of an assignment group to open it.
3. Tap **All Stories**.

Stories assigned to you from an assignment group
1. In the Sprint Tracking applet, tap **See All**.
2. Tap the name of an assignment group to open it.
3. Tap **My Stories**.

**Note:** The **My Stories** tab appears only to the users of role **scrum_team_member**.

---

---

**Request Update to Profile**

- **Points:** 5
- **Priority:** 4 - Low
- **Group:** Daniel Ocean

---

**Survey Questionnaire**

- **Points:** 8
- **Priority:** 1 - Critical
- **Group:** Daniel Ocean

---

**Performance Bonus Plan**

- **Points:** 10
- **Priority:** 4 - Low
- **Group:** Daniel Ocean

---

**My Stories**

---

**Work in progress**

---

**Blocked stories**
The Blocked Stories applet shows all stories that are blocked.

- To view all blocked stories as cards, swipe left in the applet.
- To view the list of all blocked stories, tap See All on the applet.

**Note:** The Blocked Stories applet appears only to the users of role scrum_master and scrum_product_owner.

Swipe left on a story record to find quick actions that enable you to add comments to the story or update its state.

Tap a story to view more details. For example, you can view the epic, acceptance criteria, description, and so on.

**Update a story on Agile Development v2**

Edit and update the details of your Agile Development 2.0 stories from your mobile device.

Role required: scrum_product_owner, scrum_team_member, or scrum_master

1. Navigate to a story from the Sprint Tracking or My Stories applet.
2. Tap the story to open it.

3. To update the story details:
   a. Tap **Details** and then tap **Edit**.
   b. Edit the fields that you want to update.
      You can edit the fields for state, short description, story points, assigned to, priority, and the sprint to which the story belongs.
   c. Tap **Submit**.

**Note:** If you update the sprint of the story to a future sprint, this story no longer appears in the app unless that sprint starts. Ensure that the state of the sprint is current.
4. To add work notes or attachments to the story:
   a. Tap **Activity** and then tap the add icon.
   b. Choose the activity that you want to perform. Available options include adding work notes, files, pictures, and so on.
Managing scrum tasks on Agile Development v2 mobile app

View, edit, and update the details of scrum tasks that were created for the stories of the current sprint on your mobile device.

On your mobile device, open the ServiceNow Agent app and navigate to Agile Development v2. Perform the following actions with the role of scrum_product_owner, scrum_team_member, or scrum_master.

Tracking scrum tasks on Agile Development v2

From your mobile device, track all scrum tasks of an assignment group including the scrum tasks assigned to you from multiple assignment groups.

<table>
<thead>
<tr>
<th>All scrum tasks of an assignment group</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. In the Sprint Tracking applet, tap <strong>See All</strong>.</td>
</tr>
<tr>
<td>2. Tap the name of an assignment group to open it.</td>
</tr>
<tr>
<td>3. Tap <strong>All Scrum Tasks</strong>.</td>
</tr>
</tbody>
</table>

Scrum tasks assigned to you from an assignment group

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
1. In the Sprint Tracking applet, tap **See All**.
2. Tap the name of an assignment group to open it.
3. Tap **My Scrum Tasks**.

**Note:** The **My Scrum Tasks** tab appears only to the users of role **scrum_team_member**.
The My Scrum Tasks applet shows all scrum tasks that are assigned to you for the current sprint, from all assignment groups.

- To view all scrum tasks as cards, swipe left in the applet.
- To view the list of all scrum tasks, tap See All on the applet.

Note: The My Scrum Tasks applet is visible only to the users of role scrum_team_member.

Swipe left on a scrum task record to find quick actions that enable you to add comments to it or update its state.

Tap a scrum task to view more details such as the task type, story, assigned to, description, activity, and so on.

Create a scrum task on Agile Development v2

Add a scrum task for a story from the mobile app.

Role required: scrum_product_owner, scrum_team_member, or scrum_master

1. Navigate to a story from the Sprint Tracking or My Stories applet.
2. Tap which story you want to add a new scrum task to.
3. Tap the more options icon (on iOS) or (on Android) and tap New Scrum Task.
4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Description</td>
<td>Brief description of the scrum task.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the scrum task.</td>
</tr>
<tr>
<td>Planned Hours</td>
<td>Estimated number of hours to complete the task. A typical scrum task takes between 4 and 12 hours. If the task requires more than 12 hours, consider breaking it down into multiple tasks.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority for the task.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of work involved.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the scrum task. The default state for a new scrum task is Draft.</td>
</tr>
</tbody>
</table>
5. Tap Submit

Note: Submit appears only if all the required fields are filled.

Update a scrum task on Agile Development v2

Edit and update the details of the scrum tasks of your stories from your mobile device.

Role required: scrum_product_owner, scrum_team_member, or scrum_master

1. Navigate to a scrum task from the Sprint Tracking or My Scrum Tasks applet.
2. Tap the scrum task which you want to update the details of.
3. To update the scrum task details:
   a. Tap **Details** and then tap **Edit**.
   b. Edit the fields that you want to update.
      You can edit the fields of state, task short description, description, assigned to, actual hours, and priority of the scrum task.
   c. Tap **Submit**.
4. To add work notes or attachments to the scrum task:
   a. Tap **Activity** and then tap the add icon.
   b. Choose the activity that you want to perform.
      Available options include adding work notes, files, pictures, and so on.

**Scrum Programs for Agile Development 2.0**

Plan and track the work of multiple teams that work together, either toward a common short-term outcome or on an ongoing basis.

The examples of short-term outcomes are a demand, project, epic, or a release. Teams that work together on a scrum program can:
• Work in synchronized or varied sprint cadences.
• Contribute to work outside of this common scrum program.

With the centralized Planning page for a scrum program on ServiceNow® Agile Development 2.0, you can:
• Assign work and compare the workload of multiple teams across sprints.
• Set, view, and adjust dependencies between stories across multiple teams.

Watch this short video for an overview of the Scrum Programs application.

Activate Scrum Programs

Activate the Scrum Programs (com.snc.sdlc.scrum_program) plugin to start planning your scrum programs in Agile Development 2.0.

Role required: admin

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Components installed with Scrum Programs

Understand the roles, tables, business rules, and UI macros that are installed when you activate the Scrum Programs plugin.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Roles installed with Scrum Programs

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Program manager [it_program_manager] | Users with this role have full control on all the scrum programs. | • program_manager  
• scrum_product_owner  
• scrum_master |

Note: The it_program_manager role is installed with the activation of Scrum Programs only if it is not already installed through the Project Portfolio Management plugin.
Tables installed with Scrum Programs

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>epic_backlog_definition</td>
<td>Stores the filter criteria that is used to create the epic backlogs.</td>
</tr>
<tr>
<td>scrum_program_m2m_group</td>
<td>Stores the relationship between a scrum program and its teams.</td>
</tr>
</tbody>
</table>

Business rules installed with Scrum Programs

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set global rank for epic</td>
<td>rank_configuration</td>
<td>Contains fix script to populate global rank for existing epics.</td>
</tr>
</tbody>
</table>

UI macros installed with Scrum Programs

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>program_planning_constants</td>
<td>Contains customizable TEAM_LIMIT and STORY_LIMIT properties. These properties limit the number of teams and stories that can be shown on the scrum program planning board.</td>
</tr>
</tbody>
</table>

The default value for the TEAM_LIMIT property is 15 and STORY_LIMIT property is 1000. You can change these values according to your preferences.

**Note:** Increasing the values might result in longer loading times and degraded performance of the scrum program planning board.

Create an epic backlog

Categorize epics of your scrum program into epic backlogs by defining a set of filters according to your preferences.

Role required: it_program_manager

1. Navigate to the Epic Backlog form in one of the following ways:

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the Epic Backlogs module</td>
<td>a. Navigate to Agile Development &gt; Epic Backlogs.</td>
</tr>
<tr>
<td></td>
<td>b. Click New.</td>
</tr>
</tbody>
</table>
2. In the **Name** field, enter a name of your choice for the epic backlog.
3. To set the desired filter conditions, click **Add Filter Condition** or **Add "OR" Clause**.
   For example, you can choose to filter your epics by the priority set for them.
   
   ![Note: The default filter condition is Task type is Epic and Active is true.]

4. Click **Submit**.

### Manage your epic backlogs

Create, update, and rearrange your epics by using a centralized view of epic backlogs on Agile Board.

Role required: it_program_manager, scrum_user

1. Navigate to **Agile Development > Agile Board**.
2. From the **Program** tab, select **Backlog**.
   - If an epic backlog exists, the page populates a list of epics that match the criteria of this backlog.
   - If you have no existing epic backlogs, see **Create an epic backlog**.
3. To switch between the available epic backlogs, select a backlog from the Backlog list.
4. To edit the selected backlog, click the edit icon (✏).
   
   ![Note: You must have the role of it_program_manager to perform this step.]

5. To add a new epic to the selected backlog, click **Create Epic**.
6. To filter the list of epics by product, select a product category from **Epics by product**.
   
   You can show or hide the **Epics by product** filter. Click the configuration icon (🗂️) and toggle **Show Products Filter** on or off.
7. To locate an epic from the backlog, using the short description or the epic number, use the search bar.
8. To edit the details of an epic, click the epic number.
9. To rearrange the epics based on their priority, do one of the following:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Use the mouse device to rearrange the epics** | a. Select the required epics.  
b. Drag the selection to the desired position and drop it. |
Use the keyboard to rearrange a single epic

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>a.</td>
<td>To highlight the context menu icon (≡) of the desired epic, press the <strong>Tab</strong> key and press the <strong>Enter</strong> key.</td>
</tr>
<tr>
<td>b.</td>
<td>Move the epic to the desired position by using the up and down arrow keys.</td>
</tr>
<tr>
<td>c.</td>
<td>To fix the position of the epic, press the <strong>Enter</strong> key.</td>
</tr>
</tbody>
</table>

Use the keyboard to rearrange a group of epics

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>a.</td>
<td>To highlight an epic, press the <strong>Tab</strong> key.</td>
</tr>
<tr>
<td>b.</td>
<td>To select the epic, press the <strong>Enter</strong> key.</td>
</tr>
<tr>
<td>c.</td>
<td>Navigate using the up and down arrow keys and do the following:</td>
</tr>
<tr>
<td></td>
<td>1. To select consecutive epics, press the <strong>Shift</strong> and <strong>Enter</strong> keys together.</td>
</tr>
<tr>
<td></td>
<td>2. To select random epics, press the <strong>Ctrl</strong> (for Windows) or <strong>Command</strong> (for Mac) key and the <strong>Enter</strong> key together.</td>
</tr>
<tr>
<td>d.</td>
<td>To highlight the context menu icon (≡) of an epic, press the <strong>Tab</strong> key and press the <strong>Enter</strong> key.</td>
</tr>
<tr>
<td>e.</td>
<td>Move the epics to the desired position by using the up and down arrow keys.</td>
</tr>
<tr>
<td>f.</td>
<td>To fix the position of the epics, press the <strong>Enter</strong> key.</td>
</tr>
</tbody>
</table>

You can also perform the following actions on a single epic or a group of epics:

a. Select the required epics.

b. Click the more options icon (•) of an epic and select any of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to top</td>
<td>Moves epics to the top of the Backlog list.</td>
</tr>
<tr>
<td>Move to bottom</td>
<td>Moves epics to the bottom of the Backlog list.</td>
</tr>
<tr>
<td>Product</td>
<td>Opens the Products list. Select the product to which the epics belong.</td>
</tr>
</tbody>
</table>
10. To view the backlog in a standard platform list, click the standard list view icon ( ).

Here is a sample view of the epic backlog in the Program tab of Agile Board:
Create a scrum program

Create a scrum program to plan sprints and track the progress of the multiple scrum teams that are working together.

Ensure that you have the information of the teams to be included in the program.

Role required: it_program_manager

1. Navigate to the Program form using one of the following ways:

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the Scrum Programs module</td>
<td>a. Navigate to <strong>Agile Development &gt; Scrum Programs.</strong></td>
</tr>
<tr>
<td></td>
<td>b. Click <strong>New.</strong></td>
</tr>
<tr>
<td>From Agile Board</td>
<td>a. Navigate to <strong>Agile Development &gt; Agile Board.</strong></td>
</tr>
<tr>
<td></td>
<td>b. From the <strong>Program</strong> tab, select <strong>Planning.</strong></td>
</tr>
<tr>
<td></td>
<td>c. Click <strong>Create Program.</strong></td>
</tr>
</tbody>
</table>

*Note:* You can create a scrum program from the **Planning** page of Agile Board but only if it is your first scrum program.

2. On the form, fill in the fields.

**Program form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planned start date</td>
<td>Start date of the program. Manually enter the date or pick from the calendar. The default date is the current day.</td>
</tr>
<tr>
<td>Planned end date</td>
<td>End date of the program. Manually enter the date or pick from the calendar.</td>
</tr>
<tr>
<td>Planned duration</td>
<td>Duration of the program in days and hours. This field auto-populates based on the start and end dates. The default duration of a scrum program is one day.</td>
</tr>
<tr>
<td>Program manager</td>
<td>Manager of the program.</td>
</tr>
<tr>
<td>Default Epic Backlog</td>
<td>Initial epic backlog that is applied to the planning page of the scrum program.</td>
</tr>
<tr>
<td>Program Name</td>
<td>Brief description of the program.</td>
</tr>
</tbody>
</table>

3. Click **Submit.**

Any user with the role **scrum_user** can view the created scrum programs.
Assign teams to a scrum program

Add teams to your scrum program to assign work and track the progress of the work. Ensure that the teams that work on this scrum program are created as agile groups. For the procedure to create an agile group and assign members to it, see Create an agile group in Agile Development 2.0.

Role required: it_program_manager

1. Navigate to Agile Development > Scrum Programs.
2. Open your scrum program record.
3. In the Teams related list, click Edit.
4. Move the desired teams from Collection to Teams List.
5. Click Save.

You can add a team to multiple scrum programs by following the same procedure. The teams that you add to a scrum program are displayed in its Teams related list.

Plan a scrum program.

Plan a scrum program

Plan work for sprints, using a centralized view on Agile Board, of multiple scrum teams that are working together on a scrum program.

- Create an epic backlog.
- Create a scrum program.
- Role required: scrum_sprint_planner

1. Navigate to Agile Development > Agile Board.
2. From the Program tab, select Planning.
3. From the Program list, select a scrum program that you want to plan.

A planning board displays all the teams that are working on the selected program, their sprint cadences, and sprint capacities.

- You can add teams to or update other information of the scrum program by clicking the edit icon.
- If your teams do not have sprints added to them, or you want to add more sprints, you can **add sprints from the planning board** directly.
- Click the team name to update its information such as the team members, group capacity, or description.
- Adjust the board view using the zoom in and zoom out icons.
- Navigate through the program timeline by scrolling horizontally or using the forward and back icons.
4. From the Backlog list, select an epic backlog and click the backlog icon to display the epics from the selected backlog.
   • See the list of epics and the number of unassigned stories for each epic in the selected backlog.
   • If you want to plan stories that are not associated with any epic, select **Stories without Epic** in the Backlog list.
   • Remove the backlog filter and see all stories for all teams by clicking the icon in the epic backlog picker.

5. To view the stories of an epic, select the epic from the backlog. In the backlog pane, you can do the following:
   • View the epic description and unassigned stories of this epic with their short descriptions and story points.
   • Edit an epic's information by clicking its name.
   • Add a new story to the selected epic by clicking **Create Story**.
6. To assign a story to a scrum team, drag a story card from the backlog list to a sprint of the team and drop it.

- You can reschedule the stories across teams and sprints by rearranging the story cards.
- To unplan a story, drag the story from the planning board and drop it in the epic backlog pane.

**Tip:** Plan a sprint efficiently by referring to the workload capacity bar under the sprint name which indicates the workload planned for the team versus the team’s capacity for that sprint. Hovering your cursor over the sprint name gives you additional details.

The **Assignment group** and the **Sprint** fields of the assigned stories match with the team and the sprint in which they are placed. The sprint capacity bar below the sprint name fills up depending on the stories that are scheduled for it.

**Add sprints from the program planning board**

Add sprints to your scrum teams directly from the scrum program planning board without having to navigate to another module.

Role required: scrum_sprint_planner

1. Navigate to **Agile Development > Agile Board**.
2. From the **Program** tab, select **Planning**.
3. From the Program list, select a scrum program that you want to plan.
4. Under the team name, click **Add sprints**.
5. On the form, fill in the fields.

Create Sprints form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the sprint for the team.</td>
</tr>
<tr>
<td>Starting Number</td>
<td>Number that you want the sprints to start with. For example, if it's your</td>
</tr>
<tr>
<td></td>
<td>team's first sprint, enter 1.</td>
</tr>
<tr>
<td>Start date</td>
<td>Start date of the team's sprint.</td>
</tr>
<tr>
<td>Duration (days)</td>
<td>Sprint duration of the team.</td>
</tr>
<tr>
<td>Number of Sprints</td>
<td>Number of sprints that you want to add to the team. For example, if you want</td>
</tr>
<tr>
<td></td>
<td>to add four sprints to the team, enter 4.</td>
</tr>
</tbody>
</table>

6. Click OK.

You can see new sprints for the team on the program planning board.

Add dependencies to stories

View dependencies between stories on the Planning page of Agile Board. Reschedule the stories of your scrum program based on the dependency arrows shown.

Role required: scrum_story_creator, scrum_story_editor

1. Navigate to a story form using one of the following ways:

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the Stories module</td>
<td>a. Navigate to Agile Development &gt; Stories.</td>
</tr>
<tr>
<td></td>
<td>b. Open the story to which you want to add dependencies.</td>
</tr>
<tr>
<td>From Agile Board</td>
<td>a. Navigate to Agile Development &gt; Agile Board.</td>
</tr>
<tr>
<td></td>
<td>b. From Program, click Planning.</td>
</tr>
<tr>
<td></td>
<td>c. Locate and open the story to which you want to add dependencies.</td>
</tr>
</tbody>
</table>

2. Add stories in the Prerequisite Stories or Dependent Stories related lists.

3. Click Save.

4. Click Update.

If the dependencies between stories and the sprint plan of the program are correct, the dependency lines appear in green on the Program planning board. Otherwise, they appear in red.

Manage your scrum program

Review workload between teams and replan work accordingly on the scrum program planning board.

- Plan a scrum program.
• Role required: scrum_sprint_planner

1. Navigate to **Agile Development** > **Agile Board**.
2. From the **Program** tab, select **Planning**.
3. From the Program list, select a scrum program that you want to review.

   A planning board displays all the teams that are working on the selected program, their sprint cadences, and sprint capacities.

   • You can add teams to or update other information of the scrum program by clicking the edit icon.

   • If your teams do not have sprints added to them, or you want to add more sprints, you can add sprints from the planning board directly.

   • Click the team name to update its information such as the team members, group capacity, or description.

   • Adjust the board view using the zoom in and zoom out icons.

   • Navigate through the program timeline by scrolling horizontally or using the forward and back icons.

4. To view the details of the sprint such as the period, total story points, and capacity available, point the cursor over the sprint name.

   On each story card of a sprint:

   • A circle indicates that it is not complete.

   • A green check mark indicates that it is complete.

5. To show or hide story dependency lines, click the story dependencies icon.

   For information on how to add dependencies to stories, see Add dependencies to stories.

6. To edit the details of an assigned or an unassigned story, double-click the story card.

7. To open all the stories of a scrum program in a standard list view, click the standard list view icon.

**Atlassian Jira Integration for Agile Development**

Enable bidirectional synchronization of records between Atlassian Jira and ServiceNow® Agile Development by integrating the two applications.

If the source of your work is in the ServiceNow platform while the progress of the work is tracked in Jira, you can perform integrated tracking of your product development efforts by integrating Agile Development with Jira.
For example, if you update a record in Jira, you can find that update in Agile Development. Similarly, if you update a record in Agile Development, you can find the same update in Jira.

When you synchronize Jira with Agile Development, you can:

- View available Jira projects and boards in Agile Development.
- Perform a bulk import of records from Jira to Agile Development.
- Perform single record updates between Jira and Agile Development.
- Avoid duplicating record update entries in Jira and Agile Development.
- Plan, track, and update your tasks from a single application.

Starting with version 1.1.1, Atlassian Jira Integration for Agile Development supports map configuration at the project level and not at the instance level. Also, the application supports the following project types associated with Jira Cloud:

- Classic
  - Scrum
  - Kanban
  - Bug tracking
- Next-gen
  - Scrum
  - Kanban

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Install Atlassian Jira Integration for Agile Development

Install the Atlassian Jira Integration for Agile Development (sn_agile_jira_int) application v2.0.1 from ServiceNow Store.

Ensure that the application and all of its associated store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.

Complete the following setup checklist for a smooth installation and configuration.

<table>
<thead>
<tr>
<th>Setup tasks</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify that Agile Development 2.0 (com.snc.sdlc.agile.2.0) is activated.</td>
<td>Navigate to Subscription Management &gt; Subscriptions in your instance. The list displays the subscriptions that your organization has purchased.</td>
</tr>
<tr>
<td>Verify that ServiceNow Integration Hub Starter Pack Installer (com.glide.hub.integrations) is activated.</td>
<td>Verify that Jira Spoke 2.6.8 (sn_jira_spoke) is activated.</td>
</tr>
<tr>
<td>Verify that Integrations - External Authentication Framework (com.glide.external.app) is activated.</td>
<td>Verify that Integrations - External Authentication Framework (com.glide.external.app) is activated.</td>
</tr>
</tbody>
</table>

Role required: admin
Note: Activation of the Agile Development 2.0, ServiceNow Integration Hub Starter Pack Installer, Jira Spoke, and Integrations - External Authentication Framework plugins on production instances may require separate licenses. Contact ServiceNow Customer Support for details.

1. Navigate to the ServiceNow Store.
2. In the ServiceNow Store, search for Atlassian Jira Integration for Agile Development.
3. Click the application tile. You can view detailed information about the application. Consider reading the Other Requirements and Dependencies sections, as applicable.
4. Click Get and enter your Now Support login credentials.
5. Click Request Install.
6. In the Instance Name field, enter your details and click Validate Instance.
7. In the Reason for the Instance field, enter your details and click Request.
   You receive an email with detailed installation instructions.
8. Log in to the instance on which you want to install the Atlassian Jira Integration for Agile Development application.
9. Select System Applications > All Available Applications > All.
10. Locate the application using the filter criteria and search bar, select it, and click Install.

The following components are installed with installation of the application:

- Roles
- Scheduled Jobs
- Tables

For more information, see Components installed with Atlassian Jira integration for Agile Development.

Components installed with Atlassian Jira integration for Agile Development

Several types of components are installed with activation of the Atlassian Jira integration for Agile Development application, including tables, user roles, and scheduled jobs.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jira integration admin [sn_jira_int.admin]</td>
<td>• Has complete access to the application</td>
<td>• sn_int_common.admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• sn_jira_int.user</td>
</tr>
<tr>
<td>Jira integration user [sn_jira_int.user]</td>
<td>• Sets up integration between Jira and Agile Development</td>
<td>• connection_admin</td>
</tr>
<tr>
<td></td>
<td>• Can create new or update the existing map configurations between Jira and Agile Development</td>
<td>• sn_int_common.user</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• credential_admin</td>
</tr>
</tbody>
</table>
Scheduled jobs installed

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Jira Issue</td>
<td>Imports issues and sprints from Jira automatically at a scheduled time.</td>
</tr>
<tr>
<td></td>
<td>This job is inactive by default.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Schedule a job to auto-import issues from Jira.</td>
</tr>
</tbody>
</table>

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachment Map</td>
<td>Stores the mapping of attachments to issues between Jira and Agile Development.</td>
</tr>
<tr>
<td>[sn_int_common_attachment_map]</td>
<td></td>
</tr>
<tr>
<td>Choice Map</td>
<td>Stores the list of workflow state mapping for Jira projects.</td>
</tr>
<tr>
<td>[sn_int_common_choice_map]</td>
<td></td>
</tr>
<tr>
<td>Event Type</td>
<td>Stores information of the type of webhook events such as create, update, or delete of a work item.</td>
</tr>
<tr>
<td>[sn_int_common_input_event_type]</td>
<td></td>
</tr>
<tr>
<td>External Identifiers</td>
<td>Stores the list of all Jira reference identifiers such as External ID, External Key, External Project, External URL, and so on.</td>
</tr>
<tr>
<td>[sn_int_common_external_identifiers]</td>
<td></td>
</tr>
<tr>
<td>External Project</td>
<td>Stores information of the Jira project such as project ID, the Jira instance of this project, project name, and so on.</td>
</tr>
<tr>
<td>[sn_int_common_project]</td>
<td></td>
</tr>
<tr>
<td>External system</td>
<td>Stores information of Jira application used for the integration.</td>
</tr>
<tr>
<td>[sn_int_common_external_system]</td>
<td></td>
</tr>
<tr>
<td>External System Version</td>
<td>Stores version information of Jira application used for the integration.</td>
</tr>
<tr>
<td>[sn_int_common_external_system_version]</td>
<td></td>
</tr>
<tr>
<td>Field Map</td>
<td>Stores the list of field mapping of different issue types for Jira projects.</td>
</tr>
<tr>
<td>[sn_int_common_field_map]</td>
<td></td>
</tr>
<tr>
<td>Jira Board</td>
<td>Stores the list of imported boards from Jira.</td>
</tr>
<tr>
<td>[sn_jira_int_board]</td>
<td></td>
</tr>
<tr>
<td>Jira Import Request</td>
<td>Stores the list of all import requests created to import projects, boards, and project style mappings from Jira.</td>
</tr>
<tr>
<td>[sn_jira_int_import_request]</td>
<td></td>
</tr>
<tr>
<td>Jira Instance</td>
<td>Stores the list of all Jira instances.</td>
</tr>
<tr>
<td>[sn_jira_int_instance]</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Jira Project</td>
<td>Stores the list of all imported projects from Jira.</td>
</tr>
<tr>
<td>[sn_jira_int_project]</td>
<td></td>
</tr>
<tr>
<td>Project Integration Settings</td>
<td>Stores the list of one-to-one relation between a Jira project, board, and an Agile assignment group.</td>
</tr>
<tr>
<td>[sn_agile_jira_int_import_settings]</td>
<td></td>
</tr>
<tr>
<td>Project Style Mapping</td>
<td>Store the list of map configuration templates per Jira project style.</td>
</tr>
<tr>
<td>[sn_jira_int_prj_style_mapping]</td>
<td></td>
</tr>
<tr>
<td>Table Map</td>
<td>Stores the list of table maps for Jira projects.</td>
</tr>
<tr>
<td>[sn_int_common_table_map]</td>
<td></td>
</tr>
<tr>
<td>Webhook Registry</td>
<td>Stores details of the registry callback path for webhooks registered in Jira to receive event updates.</td>
</tr>
<tr>
<td>[sn_int_common_webhook_registry]</td>
<td></td>
</tr>
</tbody>
</table>

**Setting up the integration between Jira and Agile Development**

Understand the setup process of Atlassian Jira Integration for Agile Development.

After you have the application installed in your ServiceNow instance, you can proceed to set up the integration, using the **sn_jira_int.user** role.

The setup process for the integration includes the following tasks:

1. Connect Agile Development with Jira.
2. Discover and import available projects and boards from Jira.
3. Enable import and export of issues and import issues in bulk from Jira projects to Agile Development.
4. Associate Jira projects with assignment groups in Agile Development.
5. Import sprints from Jira to Agile Development.
6. Enable a scheduled job to periodically import projects and issues from Jira.
7. Create custom map configurations for tables, fields, and workflow states between Jira and Agile Development.

**Connecting Agile Development to Jira**

Establish a connection between Agile Development and Jira using a Jira connection alias and a Jira instance.

When you connect Agile Development to Jira, a webhook is registered in Jira which receives the following event updates between Jira and Agile Development.

- Creating or updating projects.
- Creating, updating, or deleting information of epic, story, sprint, and any custom table maps and their fields.

*Create a Jira connection alias*

Create a Basic Auth credential and an HTTP(s) connection with a Jira connection alias to establish a connection with Jira.

Roles required:

- admin to create a connection and credential alias
• sn_jira_int.admin or sn_jira_int.user to create basic authorization credentials and HTTP(s) connection

1. **Create a Connection & Credential alias**
   - You can use the connection alias (sn_jira_int.Jira) is available by default.
   - You must create a connection alias for every Jira instance that you use.

2. **Create Basic authorization credentials.**
   Ensure that the user for whom the basic authorization credentials are created has access to all Jira projects.

3. **Create an HTTP(s) connection.**

**Create a Jira Instance**
Create a Jira instance record using the connection alias that you created.

Role required: sn_jira_int.admin or sn_jira_int.user

1. Navigate to **Agile Jira Integration > Jira Instances.**
2. Click **New.**
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the Jira instance. Enter a name of your choice.</td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Jira connection alias that you already created. Use the lookup ( ) option to select your connection alias.</td>
</tr>
<tr>
<td>Version</td>
<td>Jira version. Use the lookup ( ) option to select your Jira API version.</td>
</tr>
</tbody>
</table>

4. Click **Submit.**

**Connect to Jira**
Connect Jira to Agile Development to enable the integration.

Role required: sn_jira_int.user

1. Navigate to **Agile Jira Integration > Jira Instances.**
2. Open your Jira instance record.
3. Click **Connect.**

- If the connection is successful, the **State** field on the Jira Instance record shows Connected.
  - A webhook is now registered in Jira to receive update events.
- If the connection could not be established, the **State** field on the Jira Instance record shows Connection Failed. You can view the reason for the failure in the error message.

**Discover and import Jira projects and boards.**

**Discover and import Jira projects and boards**
Discover and import all available Jira projects and boards into Agile Development to start using the integration between the two applications.
- Connecting Agile Development to Jira.
- Role required: sn_jira_int.user

1. Navigate to Agile Jira Integration > Jira Instances.
2. Open your Jira instance record.
3. Click Discover Projects.

   This action creates requests to import Jira projects, map configuration for all these projects, and Jira Boards. You can view all the import requests in the Jira Import Requests related list and the initial state of all the requests would be Requested.

Once the status of each import request changes to Complete, you can see that the related lists of this Jira instance are populated as follows:

- Jira Projects: All available projects from Jira
- Jira Boards: All available boards from Jira
- Project Style Mappings: Map configuration for all the imported Jira projects according to the type of your Jira instance as follows:
  - The classic_on_prem project template contains the map configurations related to the Jira Server projects.
  - The classic project template contains the map configurations related to Jira Cloud Classic projects.
  - The next-gen project template contains the map configurations related to Jira Cloud Next-gen projects.

Once the status of the Create Mappings request changes to Completed, you can see the map configuration for each of the imported Jira project under the Mapping Config column of the Jira Projects related list. For more information on the default map configuration of work items, see Default mapping configuration.

Import your issues from Jira to Agile Development 2.0. For more information, see Importing issues and sprints from Jira to Agile Development.

**Default mapping configuration**

Understand the default field mapping configuration for work items of a project between Jira and Agile Development.

Mapping configuration is used to map records in Jira to Agile Development for a project. If the table map does not exist for an issue type in your Jira project, the issue cannot be imported and exported between Jira and the ServiceNow platform.

By looking at the default mapping configuration, you can understand how issue types in Jira are mapped to task types in Agile Development. You can also see how fields are mapped between the two applications. When you import the available issues and sprints of a Jira project, this data is stored in tables as defined in the project's map configuration.

From version 1.1.1 onwards, mapping configuration is generated per project and not at the instance level. You must update any custom maps that you previously configured to ensure that the import and export of work items is not impacted.

Here’s how you can view the default map configuration tables of your Jira project.

1. Navigate to Agile Jira Integration > Jira Instances.
2. Open your Jira instance record.
3. From the Jira Projects related list, open a Jira project.
4. From the Table Maps related list, open the record for Story or Epic.
The following table lists the default field map configuration for a story and epic.

<table>
<thead>
<tr>
<th>Map configuration</th>
<th>Field in Jira</th>
<th>Field in Agile Development</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Epic</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Epic Name</td>
<td>Short Description</td>
<td></td>
</tr>
<tr>
<td>Priority</td>
<td>Priority</td>
<td></td>
</tr>
<tr>
<td>Summary</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>Status</td>
<td>State</td>
<td></td>
</tr>
<tr>
<td><strong>Story</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Status</td>
<td>State</td>
<td></td>
</tr>
<tr>
<td>Sprint</td>
<td>Sprint</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>Priority</td>
<td>Priority</td>
<td></td>
</tr>
<tr>
<td>Epic Link</td>
<td>Epic</td>
<td></td>
</tr>
<tr>
<td>Summary</td>
<td>Short Description</td>
<td></td>
</tr>
<tr>
<td>Assignee</td>
<td>Assigned to</td>
<td></td>
</tr>
</tbody>
</table>

You can add or update the configuration for field, table, and choice maps of your projects between Jira and Agile Development according to your organizational preferences. For details, see Customizing map configuration for your Jira projects.

**Importing issues and sprints from Jira to Agile Development**

Understand the process of importing existing issues and sprints from Jira to Agile Development.

You can import existing issues from Jira projects as stories and epics, and existing sprint data from Jira boards as sprints to Agile Development 2.0. After importing the available data, any updates that you make to the epic, story, or sprint records will be synchronized automatically in both Jira and Agile Development 2.0.

**Importing issues**

From version 2.0.1, you can proceed to import issues from a Jira project directly after discovering projects from Jira. You do not have to create team integration settings. However, the imported issues are not associated to any assignment group in Agile Development 2.0. You can manually assign these issues to an assignment group later.

If you want your imported issues to be assigned to an assignment group automatically, you can create team integration settings for your Jira project by associating it to an Agile 2.0 assignment group and then proceed to import the issues. This setting ensures that any imported issues that belong to a Jira project are assigned to its associated assignment group.

**Importing sprints**

Importing sprint data from Jira boards require that the board has team integration settings that associate it to an Agile 2.0 assignment group. Sprint data of a Jira board is imported to its assignment group, only if these sprints have already started in Jira. Also, only the completed and current sprints of Jira are imported.
Team integration settings

From version 2.0.1, the Project Integration Settings module is available as Team Integration Settings. Team integration settings help you associate Jira projects and boards with Agile 2.0 assignment groups to facilitate the bidirectional synchronization of record updates.

Associating a Jira project to an assignment group allows the following:

• Enable import and export of all available stories and epics between this project and its associated group.
• View any new stories and epics or updates made to the existing stories and epics in both Agile Development and Jira.

Associating a Jira board to an assignment group allows the following:

• Import all completed and current sprints from this board into the associated group.
• View any completed and current sprints or updates made to them in both Agile Development and Jira.

To understand the workflow of the import and export of issues between Agile Development and Jira, see Importing and exporting issues between Agile Development and Jira.

Associate a Jira project and board with an assignment group in Agile Development

Associate your Jira projects and boards with assignment groups in Agile Development to enable import and export of all available issues between the associated project and assignment group.

• Discover and import Jira projects and boards.
• Create assignment groups in Agile Development. See Create an assignment group in Agile Development 2.0.
• Ensure that your Jira project has a defined mapping configuration.
• Role required: sn_jira_int.user

Create team integration settings to associate a Jira project and Jira board with an Agile 2.0 assignment group.

**Important:** You can associate an assignment group with only one project and board from Jira.

1. Navigate to Agile Jira Integration > Team Integration Settings.
2. Click New.
3. On the Team Integration Settings form, select the following:
   • A Jira project
   • A Jira board
   • An assignment group in Agile Development to which you want to associate the selected Jira project and board

   Selecting a Jira board in the form is optional. If you do not want to synchronize the sprint data of the board between Agile Development and Jira, you can skip selecting a Jira board.
4. Click Submit.

You can import or issues from this Jira project or sprints from this Jira board to the associated assignment group.

**Import issues from a Jira project to Agile Development 2.0**

Import available issues from a Jira project, with or without the team integration settings for this project, so that you can update existing records of Jira from Agile Development.

• Discover and import Jira projects and boards
• Role required: sn_jira_int.user

If your Jira project has team integration settings, then the imported issues are assigned to an assignment group according to the team integration settings. If your Jira project does not have team integration settings, then the imported issues are not associated to any assignment group.

**Note:** This task does not explain importing sprints. For information on how to import sprints from Jira, see Import sprints from Jira to Agile Development 2.0.

1. Navigate to Agile Jira Integration > Jira Instances.
2. Open your Jira instance record.
3. From the Jira Projects related list, open the project from which you want to import the issues.
4. Enable the import and export of issues by selecting the Enable Import and Enable Export options as applicable.
5. Click Import Issues.
6. Select a date range from which you want to import the issues from Jira.
7. Click Submit.

An import request of type Import Issues is created in the Jira Import Requests related list. Once the state of this request changes to Completed, you can view all the imported records in the Epics and Stories modules in Agile Development. The relationship between the stories and epics is retained as it is in Jira.

**Note:** Existing comments and attachments of issues are not imported from Jira during a bulk import.

---

**Import sprints from Jira to Agile Development 2.0**

Import sprints from a Jira board so that you can track progress of these sprints directly in Agile Development 2.0.

• Ensure that the Jira board from which you want to import the sprints has team integration settings. For more information, see Associate a Jira project and board with an assignment group in Agile Development.

• Role required: sn_jira_int.user

Import completed and current sprints of Jira board into Agile Development 2.0.

1. Navigate to Agile Jira Integration > Jira Instances.
2. Open your Jira instance record.
3. From the Jira Projects related list, open the project that is associated to a Jira board from which you want to import the sprints.
4. Enable the import and export of sprints by selecting the Enable Import and Enable Export options as applicable.
5. Click Import Issues.
6. Select a date range from which you want to import the sprints from Jira.
7. Click Submit.

An import request of type Import Sprints is created in the Jira Import Requests related list. Once the state of this request changes to Completed, you can view all the imported sprint data in the Sprints related list of the associated assignment group in Agile Development.

---

**Schedule a job to auto-import issues from Jira**

Schedule a job to auto-import issues and sprints periodically from Jira into Agile Development.
Role required: sn_jira_int.user

After you’ve configured the scheduled job, it imports issues from all the projects for which you’ve selected the **Enable import** option.

If you do not configure the scheduled job, you must manually import issues for the discovered projects.

1. Navigate to **System Definition > Scheduled Jobs**.
2. Open the Import Jira Issue job.
   
   The job is inactive by default.
3. Execute the job manually by clicking **Execute Now**.
4. Set the job to run at a scheduled time by selecting the **Active** check box.
   
   You can edit the details of the **Run** and **Time** fields according to your preference.
5. Click **Update**.

### Customizing map configuration for your Jira projects

Customize the field, table, or workflow state map configuration for your Jira projects. You can customize map configuration of a single project or multiple projects of the same project style.

**Note:** Only fields of type number, select, text, and date are supported for custom map configuration.

*Customize your table map configuration*

Map a custom table of your preference for a Jira project.

- Discover and import Jira projects and boards.
- Role required: sn_jira_int.user

Create a custom table map of your preference for your Jira project and configure its fields.

If you have a custom table that is applicable to all Jira projects of a specific project type, see **Apply custom map configuration to multiple Jira projects.**

1. Navigate to **Agile Jira Integration > Jira Instances**.
2. Open your Jira instance record.
3. From the Jira Projects related list, open a Jira project for which you want to customize the map configuration.
4. From the Table maps related list of the Jira project, click **New**.
5. On the form, fill in the fields.

**Table Map form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal Table</td>
<td>Table name in the ServiceNow platform.</td>
</tr>
<tr>
<td>Map configuration</td>
<td>Map configuration for this project. This field is auto-populated based on the project.</td>
</tr>
<tr>
<td>External Table</td>
<td>Table ID in Jira.</td>
</tr>
<tr>
<td>External Table Name</td>
<td>Display name of the table in Jira.</td>
</tr>
</tbody>
</table>

6. Save the table configuration.
7. From the Field Maps related list of your table map record, create new field maps for the following fields:

<table>
<thead>
<tr>
<th>Field in Jira</th>
<th>Field in Agile Development</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary of the issue</td>
<td>Short description</td>
</tr>
<tr>
<td>Description of the issue</td>
<td>Description</td>
</tr>
</tbody>
</table>

For information on how to configure field mapping for a table, see Customize your field map configuration. You can also create other field maps for your new table configuration.

1. Validate your new table map configuration by clicking Validate and fix mapping from your project form.

2. In the Table maps related list of your project, if the Valid column of your configuration shows:
   - true, validation of your map configuration is successful.
   - false, validation of your map configuration failed. Ensure that you enter correct values for all the fields and validate again.

3. Create a business rule to support export of this new table map configuration to Jira. For more information, see Create a business rule to apply a custom table map configuration.

4. If you want to support import and export of attachments for this new table map, see Allow import and export of attachments on a custom table.

5. If you want to enable display of fields that reference Jira identifiers in your custom table map, see Populate Jira project identifier reference fields for a custom table.

**Customize your field map configuration**

Map a field of your preference for a Jira project.

- Discover and import Jira projects and boards.
- Role required: sn_jira_int.user

If you have a custom field for a Jira project that you want to map with a field in Agile Development, you can create custom field map configuration that would apply only to this Jira project.

If you have a custom field that is applicable to all Jira projects of a specific project type, see Apply custom map configuration to multiple Jira projects.

1. Navigate to Agile Jira Integration > Jira Instances.
2. Open your Jira instance record.
3. From the Jira Projects related list, open a Jira project for which you want to customize the map configuration.
4. From the Table Maps related list, open the Sprint, Epic, or Story record to add a new field map configuration for that record.
5. From the Field Maps related list, click New.
6. On the form, fill in the fields.

**Field Map form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal Field</td>
<td>Field name in Agile Development.</td>
</tr>
</tbody>
</table>
Table Map
Table map in the ServiceNow platform, in which this field is created. This field is auto-populated based on the table map record you select.

Internal Table
Table in the ServiceNow platform. This field is auto-populated based on the table map record you select.

External Field
Field ID in Jira.

External Field Name
Display name of the field in Jira. Ensure that this field is added to the Jira project screen.

1. Validate your field map configuration by clicking Validate and fix mapping from your project form.
2. From the Table maps related list of your project, navigate to your new field map configuration. If the Valid column of your configuration shows:
   - true, validation of your map configuration is successful.
   - false, validation of your map configuration failed. Ensure that you enter the correct values for all fields and validate again.

Important: If your custom map configuration is invalid or if the custom field configured is not added to the default screen scheme of the issue, the export action does not work.

Customize your workflow state configuration
Create a custom workflow state map of your preference for a Jira project.
- Discover and import Jira projects and boards.
- Role required: sn_jira_int.user

Map a custom workflow state from Jira to Agile Development.
You can map a workflow state in Jira to multiple workflow states in Agile Development. In such cases, the state in Agile Development for an issue type depends on the choice order value that you provide for this state configuration.

For example, the In Progress state in Jira is mapped to multiple states such as Work in progress, Ready for testing, and Testing in Agile Development using a choice order of 10, 20, and 30.

So, when an In Progress issue from Jira is imported, the State field in Agile Development is set to Work in progress as it has the lowest choice order value.

You can also map multiple workflow states in Jira to a single workflow state in Agile Development.

1. Navigate to Agile Jira Integration > Jira Instances.
2. Open your Jira instance record.
3. From the Jira Projects related list, open a Jira project for which you want to customize the choice map configuration.
4. Open the workflow state map for this project.
   a) From the Table Maps related list, click Story.
   b) From the Field Maps related list, click Status.

5. From the Choice Maps related list, click New.

6. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal Choice</td>
<td>Value of the workflow state in Agile Development. This value is an integer.</td>
</tr>
<tr>
<td>External Choice</td>
<td>ID of the workflow state in Jira.</td>
</tr>
<tr>
<td>External Choice Name</td>
<td>Display name of the workflow state in Jira.</td>
</tr>
</tbody>
</table>

7. Click Update.

1. Validate your choice map configuration by clicking Validate and fix mapping from your project form.

2. From the Table maps related list of your project, navigate to your new choice map configuration. If the Valid column for your configuration shows:
   - true, validation of your map configuration is successful.
   - false, validation of your map configuration failed. Ensure that you enter correct values for all fields and validate again.

Apply custom map configuration to multiple Jira projects
Add a custom table or field, which is applicable to all your Jira projects of a specific type, to the map configuration template in the Now Platform®.

- Discover and import Jira projects and boards.
- Role required: sn_jira_int.user

1. Navigate to Agile Jira Integration > Jira Instances.
2. Open your Jira instance record.
3. From the Project Style Mappings related list, select the project template to which you want to add the custom field.
   For example, if the field that you want to add is applicable to all Jira projects of the type Classic, then select classic.
4. Add your custom table or field to the existing map configuration in the **Default Mapping** field.
   You can copy the contents of the **Default Mapping** field into a JSON viewer to view the contents in a format of your preference.
   For example, as shown in the following figures, you can add a new table for Defect [rm_defect] to map the Bug table from Jira or a new field in the existing Story [rm_story] table to map story points.

<table>
<thead>
<tr>
<th>Custom table map for Defects</th>
<th>Custom field map for Story Points</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>rm_defect</code>: {</td>
<td><code>rm_story</code>: {</td>
</tr>
<tr>
<td>&quot;name&quot;: &quot;Bug&quot;,</td>
<td>&quot;name&quot;: &quot;Story&quot;,</td>
</tr>
<tr>
<td>&quot;fields&quot;: {</td>
<td>&quot;fields&quot;: {</td>
</tr>
<tr>
<td>&quot;short_description&quot;: {</td>
<td>&quot;short_description&quot;: {</td>
</tr>
<tr>
<td>&quot;name&quot;: &quot;Summary&quot;</td>
<td>&quot;name&quot;: &quot;Summary&quot;</td>
</tr>
<tr>
<td>},</td>
<td>},</td>
</tr>
<tr>
<td>},</td>
<td>&quot;story_points&quot;: {</td>
</tr>
<tr>
<td>&quot;rm_epic&quot;: {</td>
<td>&quot;name&quot;: &quot;Story Points&quot;</td>
</tr>
<tr>
<td>}</td>
<td>},</td>
</tr>
<tr>
<td></td>
<td>&quot;description&quot;: {</td>
</tr>
<tr>
<td></td>
<td>&quot;name&quot;: &quot;Description&quot;</td>
</tr>
<tr>
<td></td>
<td>},</td>
</tr>
<tr>
<td></td>
<td>&quot;epic&quot;: {</td>
</tr>
<tr>
<td></td>
<td>&quot;name&quot;: &quot;Epic Link&quot;</td>
</tr>
<tr>
<td></td>
<td>},</td>
</tr>
</tbody>
</table>

If you’re adding a new field, ensure that the custom field configured is added to the default screen scheme of the issue.

5. Click **Update**.

Apply the custom project style map to all its related Jira projects.
1. Delete the existing map configuration of all the imported Jira projects.

   You can delete the map configuration of a project by making its **Mapping Config** field empty.

   **Tip:** From the Jira Projects related list, make a multiple select on the **Mapping Config** field of all the Jira project records and remove their value, making all these fields empty.

2. If you’ve created a new table map, create a business rule to apply this new table map configuration. For more information, see *Create a business rule to apply a custom table map configuration*.

3. Import these projects from Jira by clicking **Discover Projects**.

   This would import all the Jira projects with their map configuration as per the customized project style map.

   *Create a business rule to apply a custom table map configuration*

   Create a business rule to enable export from your new custom table map configuration to your Jira projects.

   Role required: admin or sn_jira_int.admin

   After you create a custom table map for a single or multiple Jira projects, create a business rule similar to Synch Story with Jira to support export of information from this new table map from Agile Development to Jira.

   1. Navigate to **System Definition > Business Rules**.
   2. From the list of available business rules, locate and open the Synch Story with Jira rule.
   3. From the context menu, perform an Insert and Stay operation on this business rule.

      If you have not enabled the **Insert and Stay** action in your ServiceNow instance, see *Allow insert options on records*.

   4. On the business rule form, edit the following fields.

      **Business rule form**

      | Field     | Description                                      |
      |-----------|--------------------------------------------------|
      | Name      | Unique name for the business rule.              |
      |           | For example, if your new table map is to map   |
      |           | defects, name this rule as Synch Defect with Jira.|
      | Table     | Select the table for which you’ve created the   |
      |           | custom map.                                     |
      |           | For example, Defect [rm_defect].                 |

   5. Click **Update**.

      *Allow import and export of attachments on a custom table*

      Enable import and export of attachments between Jira and Agile Development for a custom table that you added to the map configuration.

      Role required: admin or sn_jira_int.admin

      1. Navigate to **System Definitions > Business Rules**.
      2. From the list of business rules, locate and open the Sync Attachment to Jira rule.
3. In the When to run section of the form, include your custom table map by adding it to the filter conditions.
   For example, if the custom table that you added is Defect, do the following:
   a) Click Add "OR" Clause.
   b) Set the new clause to **Table name is rm_defect**.

4. Click **Update**.

*Populate Jira project identifier reference fields for a custom table*
Enable Jira identifier reference fields for your custom table that you added to the map configuration.

Role required: admin or sn_jira_int.admin

You can display references of ID, key, Jira project, and the project URL on your custom table form by adding this table to the Populate External Identifier Reference business rule.

1. Navigate to **System Definitions > Business Rules**.
2. From the list of business rules, locate and open the Populate External Identifier Reference rule.
3. In the When to run section of the form, include your custom table map by adding it to the filter conditions.
   For example, if the custom table that you added is Defect, do the following:
   a) Click Add "OR" Clause.
   b) Set the new clause to **Reference table is rm_defect**.

4. Click **Update**.

Configure the form layout or personalize the list layout of your custom table to display any or all of the following fields.
- External ID
- External Key
- External Project
- External URL

**Reset mapping configuration of Jira projects**
Reset the existing mapping configuration for multiple Jira projects to a default mapping configuration.

- Discover and import Jira projects and boards
- Role required: sn_jira_int.user

Apply a default mapping configuration to all or a few Jira projects. Any existing custom mapping configuration for these projects will be deleted after you reset the mappings.

If you've cleared the **Mapping Config** field or deleted the existing table maps for this project, resetting the mappings for this project will restore the mapping configuration to the default configuration.

1. Navigate to **Agile Jira Integration > Jira Instances**.
2. Open your Jira instance record.
3. Reset the mappings of multiple Jira projects using one of the following ways.

<table>
<thead>
<tr>
<th>Choice</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset mappings for a single project</td>
<td>a. From the Jira Projects related list, open the required project.</td>
</tr>
<tr>
<td></td>
<td>b. Click Reset Mappings.</td>
</tr>
<tr>
<td>Reset mappings of multiple projects that belong to different project styles</td>
<td>a. From the Jira Projects related list, select the required projects.</td>
</tr>
<tr>
<td></td>
<td>b. Click the Actions on selected rows list.</td>
</tr>
<tr>
<td></td>
<td>c. Click Reset Mappings.</td>
</tr>
<tr>
<td>Reset mappings of multiple projects that belong to the same project style</td>
<td>From the Project Style Mappings related list, open a project template.</td>
</tr>
<tr>
<td></td>
<td>For example, if you want to reset the mappings of Jira Cloud Classic projects, select classic.</td>
</tr>
<tr>
<td></td>
<td>a. Verify the mapping configuration in the Default Mapping field and update it if required.</td>
</tr>
<tr>
<td></td>
<td>b. Select the required projects from the list.</td>
</tr>
<tr>
<td></td>
<td>c. Click the Actions on selected rows list.</td>
</tr>
<tr>
<td></td>
<td>d. Click Reset Mappings.</td>
</tr>
</tbody>
</table>

Reset mappings of all projects that belong to the same project style

From the Project Style Mappings form, click Reset Mappings.

The mapping configuration of the projects is updated to as per the Default Mapping field in the Project Style Mappings form that the selected projects belong to.

**Importing and exporting issues between Agile Development and Jira**

Understand the workflow for the import and export of issues between Agile Development and Jira.

To export and import issues between Agile Development and Jira, you must complete the team integration settings for your Jira projects.

**Importing to Agile Development from Jira**

- When you create an issue of type epic in a Jira project, an epic is created for the assignment group according to the team integration settings that you configured.
- When you create an issue of type story in a Jira project, a story is created for the assignment group according to the team integration settings that you configured.
  - The relationship between the story and its epic is retained as it is in Jira.
  - The Assigned To field in the story displays the user from Jira, only if a user with the same email address is found in the ServiceNow platform.
- Only the fields that are defined in the field map are retained in the story or epic. For details of the default mapping configuration, see Default mapping configuration.
- When you add an attachment to an issue in Jira, the same attachment is added to the corresponding story or epic in Agile Development.
- When you add comments for an issue in Jira, they are updated in the **Work notes** field of the story or epic in Agile Development.
- When you delete an issue in Jira, the corresponding record is deleted in the ServiceNow platform.

**Note:** To delete records in the ServiceNow platform, set the **Can Delete** field to **true** in the Application access of the respective tables. For details, see Table design and runtime settings.

- When you start a sprint in Jira, a sprint is created for the assignment group in the ServiceNow platform, if the Jira board is configured in the team integration settings.
Exporting from Agile Development to Jira

- When you create an epic for an assignment group, it is exported to the project in Jira according to the team integration settings that you configured.
- When you create a story for an assignment group, it is exported to the project in Jira according to the team integration settings that you configured.
  - The relationship between the story and its epic is retained in Jira.
  - Any update to the **Assigned To** field in the ServiceNow platform is not exported to Jira.
- When you add an attachment to a story or an epic, the same attachment is added to the corresponding issue in Jira.
- When you add work notes to a story or an epic, they are updated in the corresponding issue in Jira as comments.

**Note:** For Jira Cloud projects, export of comments to the ServiceNow platform is not supported.

- When you update the assignment group of an existing story in the ServiceNow platform, the issue is recreated in the Jira project that is associated with the updated assignment group.
- When you create a sprint for an assignment group in the ServiceNow platform, it is exported to Jira only if you configured the Jira board in the team integration settings.

Troubleshooting issues of Jira integration with Agile Development

Resolve common issues that you might face while working with the integration of Jira and Agile Development.

<table>
<thead>
<tr>
<th>Issue</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The export action is not working.</td>
<td>• Review your custom map configuration.</td>
</tr>
<tr>
<td></td>
<td>If your custom map configuration is invalid or if the custom field</td>
</tr>
<tr>
<td></td>
<td>configured is not added to the default screen scheme of the issue,</td>
</tr>
<tr>
<td></td>
<td>export does not work.</td>
</tr>
<tr>
<td></td>
<td>• Ensure that the <strong>Enable Export</strong> check box is selected in the</td>
</tr>
<tr>
<td></td>
<td>project integration settings for this Jira project or board.</td>
</tr>
<tr>
<td></td>
<td>• Check if your Jira password has expired.</td>
</tr>
<tr>
<td>The sprint is not associated to the imported</td>
<td>Verify if the sprint is started in Jira. If the sprint that is</td>
</tr>
<tr>
<td>stories.</td>
<td>associated with the stories is a future sprint, then it is</td>
</tr>
<tr>
<td></td>
<td>not associated to the stories in Agile Development.</td>
</tr>
<tr>
<td></td>
<td>Sprint data from Jira is updated in Agile Development only if the</td>
</tr>
<tr>
<td></td>
<td>sprint is active in Jira.</td>
</tr>
<tr>
<td>The sprint is not imported into the ServiceNow</td>
<td>• Ensure that your sprint in Jira has dates.</td>
</tr>
<tr>
<td>platform.</td>
<td>• Ensure that the dates of a sprint in Jira does not overlap with</td>
</tr>
<tr>
<td></td>
<td>another sprint in the same assignment group in the ServiceNow</td>
</tr>
<tr>
<td></td>
<td>platform.</td>
</tr>
<tr>
<td>A value from a field in Jira is not populated in</td>
<td>Verify if the custom field map is configured.</td>
</tr>
<tr>
<td>the ServiceNow platform.</td>
<td></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Issue</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The value of <strong>Priority</strong> or <strong>State</strong> fields from Jira is not</td>
<td>Verify if the custom workflow state map is configured.</td>
</tr>
<tr>
<td>populated in the ServiceNow platform.</td>
<td></td>
</tr>
<tr>
<td>An update by a user in Jira is not updated in the ServiceNow</td>
<td>Ensure that the user credentials that are used to set up the</td>
</tr>
<tr>
<td>platform.</td>
<td>integration of Jira with Agile Development are not used to perform</td>
</tr>
<tr>
<td></td>
<td>record updates.</td>
</tr>
<tr>
<td>The issue is deleted in Jira and not deleted in the ServiceNow</td>
<td>Ensure that the <strong>Can Delete</strong> field in the Application access of the</td>
</tr>
<tr>
<td>platform.</td>
<td>respective tables is set to true.</td>
</tr>
<tr>
<td>Deleting a project or board in Jira does not result in any action in</td>
<td>After deleting the project or board in Jira, the Jira administrator</td>
</tr>
<tr>
<td>the ServiceNow platform.</td>
<td>must manually delete the associated stories in the ServiceNow platform.</td>
</tr>
<tr>
<td>Using rich text in Jira results in garbled text in the ServiceNow</td>
<td>The wiki text format that is used in Jira is not supported.</td>
</tr>
<tr>
<td>platform.</td>
<td></td>
</tr>
<tr>
<td>For a Next-gen Jira project, when a story is created for an epic in</td>
<td>In Jira, make a nominal update to the story which would send the epic</td>
</tr>
<tr>
<td>Jira, the relation between story and epic is not imported to the</td>
<td>relation along with this update to the ServiceNow platform.</td>
</tr>
<tr>
<td>ServiceNow platform.</td>
<td></td>
</tr>
<tr>
<td>For Jira cloud projects, comments are not imported to the ServiceNow</td>
<td>This is a known issue.</td>
</tr>
<tr>
<td>platform.</td>
<td></td>
</tr>
<tr>
<td>Sub tasks information is neither imported nor exported between Jira</td>
<td>To enable import of sub tasks from Jira to Agile Development, you must</td>
</tr>
<tr>
<td>and the ServiceNow platform.</td>
<td>manually configure custom mapping for this task type. For more</td>
</tr>
<tr>
<td></td>
<td>information, see <strong>Customize your table map configuration</strong>.</td>
</tr>
<tr>
<td>For a Next-gen Jira project, scrum tasks are not exported from the</td>
<td>The application supports only the import of sub tasks from Jira to</td>
</tr>
<tr>
<td>ServiceNow platform to Jira.</td>
<td>the ServiceNow platform but not the export of these tasks to Jira.</td>
</tr>
<tr>
<td>After discovering and importing projects, map configuration is not</td>
<td>Ensure that the user for whom the connection alias is created has</td>
</tr>
<tr>
<td>generated for a project.</td>
<td>access to all Jira projects.</td>
</tr>
<tr>
<td>The UI actions for Connect, Disconnect, and Validate and Fix result</td>
<td>This is a known issue. Retry the UI action.</td>
</tr>
<tr>
<td>in an error when using for the first time.</td>
<td></td>
</tr>
</tbody>
</table>

**Microsoft Azure DevOps Integration for Agile Development**

Enable bidirectional synchronization of records between Microsoft Azure DevOps with ServiceNow® Agile Development 2.0 by integrating the two applications.

For example, if you update a record in Azure DevOps, the update is reflected in Agile Development. Similarly, if you update a record in Agile Development, the update is reflected in Azure DevOps.

Integration of Azure DevOps with Agile Development enables you to do the following:

- View available Azure DevOps projects in Agile Development.
- Perform a bulk import of records from Azure DevOps to Agile Development.
- Perform single record updates between Azure DevOps and Agile Development.
- Avoid duplicating record update entries in Azure DevOps and Agile Development.
- Plan, track, and update your tasks from a single application.
Starting with version 1.3, Microsoft Azure DevOps Integration for Agile Development supports process-level map configuration allowing you to configure multiple processes to be synchronized with Agile Development.

**Request apps on the Store**

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

**Install Microsoft Azure DevOps Integration for Agile Development**

Install the Microsoft Azure DevOps Integration for Agile Development (sn_agile_ado_int) application version 1.3 from ServiceNow Store.

Complete the following setup checklist for a smooth installation and configuration.

<table>
<thead>
<tr>
<th>Setup tasks</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify that Agile Development 2.0 (com.snc.sdlc.agile.2.0) is activated.</td>
<td>Navigate to Subscription Management &gt; Subscriptions in your instance. The list displays the subscriptions that your organization has purchased.</td>
</tr>
<tr>
<td>Verify that ServiceNow Integration Hub Standard Pack Installer (com.glide.hub.integrations.standard) is activated.</td>
<td></td>
</tr>
<tr>
<td>Verify that Azure DevOps Boards Spoke 1.6.1 (sn_azure_dev_spoke) is activated.</td>
<td></td>
</tr>
</tbody>
</table>

Role required: admin

**Note:** Activation of the Agile Development 2.0, ServiceNow Integration Hub Standard Pack Installer, and Azure DevOps Board Spoke plugins on production instances may require separate licenses. Contact ServiceNow Customer Support for details.

1. Navigate to ServiceNow Store.
2. In the ServiceNow Store, search for Microsoft Azure DevOps Integration for Agile Development
3. Click the application tile.
   You can view detailed information of the application.
   **Note:** Consider reading the Other Requirements and Dependencies sections, as applicable.
4. Click Get and enter your Now Support login credentials.
5. Click Request Install.
6. In the Instance Name field, enter your details and click Validate Instance.
7. In the Reason for the Instance field, enter your details and click Request.
   You receive an email with detailed installation instructions.
8. Log in to the instance on which you want to install the Microsoft Azure DevOps Integration for Agile Development application.
10. Locate the application, select it, and click Install.

The following components are installed with installation of the application:
• Roles
• Scheduled Jobs
• Tables

For more information, see Components installed with Microsoft Azure DevOps integration for Agile Development.

Components installed with Microsoft Azure DevOps integration for Agile Development

Several types of components are installed with activation of the Microsoft Azure DevOps integration for Agile Development application, including tables, user roles, and scheduled jobs.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Azure DevOps integration admin [sn_ado_int.admin]</td>
<td>• Has complete access to the application</td>
<td>• sn_int_common.admin</td>
</tr>
<tr>
<td></td>
<td>• sn_int_common.admin</td>
<td>• sn_ado_int.user</td>
</tr>
<tr>
<td>Azure DevOps integration user [sn_ado_int.user]</td>
<td>• Sets up integration between Azure DevOps and Agile Development</td>
<td>• connection_admin</td>
</tr>
<tr>
<td></td>
<td>• Can create new or update the existing map configurations between Azure DevOps and Agile Development</td>
<td>• sn_int_common.user</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• credential_admin</td>
</tr>
</tbody>
</table>

Scheduled jobs installed

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discover Azure Project Job</td>
<td>Discovers new Azure DevOps projects at a scheduled time and imports them automatically.</td>
</tr>
<tr>
<td>Import Azure DevOps Teams Areas and Iterations</td>
<td>Imports teams, areas, and iterations from Azure DevOps automatically at a scheduled time.</td>
</tr>
<tr>
<td>Import Azure DevOps Work Items</td>
<td>Imports work items from Azure DevOps automatically at a scheduled time.</td>
</tr>
</tbody>
</table>

All the scheduled jobs are inactive by default. For more information, see Schedule jobs to import projects, teams, areas, and work items from Azure DevOps.
<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area Team M2M [sn_ado_int_m2m_area_team]</td>
<td>Stores the relationship between teams and areas.</td>
</tr>
<tr>
<td>Attachment Map [sn_int_common_attachment_map]</td>
<td>Stores the mapping of attachments to issues between Azure DevOps and Agile Development.</td>
</tr>
<tr>
<td>Azure DevOps Area [sn_ado_int_area]</td>
<td>Store the list of imported areas from Azure DevOps.</td>
</tr>
<tr>
<td>Azure DevOps Import Request [sn_ado_int_import_request]</td>
<td>Stores the list of all import requests created to import projects and process mappings from Azure DevOps.</td>
</tr>
<tr>
<td>Azure DevOps Instance [sn_ado_int_instance]</td>
<td>Stores the list of all Azure DevOps instances.</td>
</tr>
<tr>
<td>Azure DevOps Iteration [sn_ado_int_iteration]</td>
<td>Stores the list of imported iterations from Azure DevOps.</td>
</tr>
<tr>
<td>Azure DevOps project [sn_ado_int_project]</td>
<td>Stores the list of imported projects from Azure DevOps.</td>
</tr>
<tr>
<td>Azure DevOps Subscriptions [sn_ado_int_subscription]</td>
<td>Stores the subscription IDs of the event type for the webhooks registered in Azure.</td>
</tr>
<tr>
<td>Azure DevOps Team [sn_ado_int_team]</td>
<td>Stores the list of imported Azure DevOps tams.</td>
</tr>
<tr>
<td>Choice Map [sn_int_common_choice_map]</td>
<td>Stores the list of workflow state mapping for Azure DevOps projects.</td>
</tr>
<tr>
<td>Event Type [sn_int_common_input_event_type]</td>
<td>Stores information of the type of webhook events such as create, update, or delete of a work item.</td>
</tr>
<tr>
<td>External Identifiers [sn_int_common_external_identifiers]</td>
<td>Stores the list of all Azure DevOps reference identifiers such as External ID, External Key, External Project, External URL, and so on.</td>
</tr>
<tr>
<td>External Project [sn_int_common_project]</td>
<td>Stores information of the Azure DevOps project such as project ID, the Azure DevOps instance of this project, project name, and so on.</td>
</tr>
<tr>
<td>External System [sn_int_common_external_system]</td>
<td>Stores information of the Azure DevOps application used for the integration.</td>
</tr>
<tr>
<td>External System Version [sn_int_common_external_system_version]</td>
<td>Stores the API version information of the Azure DevOps application used for the integration.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Field Map [sn_int_common_field_map]</td>
<td>Stores the list of field mapping of different work items for Azure DevOps projects.</td>
</tr>
<tr>
<td>Process Mapping [sn_ado_int_process_mapping]</td>
<td>Store the list of map configuration templates per Azure DevOps process.</td>
</tr>
<tr>
<td>Table Map [sn_int_common_table_map]</td>
<td>Stores the list of table maps for Azure DevOps projects.</td>
</tr>
<tr>
<td>Team Integration Settings [sn_agile_ado_int_import_settings]</td>
<td>Stores the list of one-to-one relation between Azure DevOps project, team, and an Agile assignment group.</td>
</tr>
<tr>
<td>Webhook Registry [sn_int_common_webhook_registry]</td>
<td>Stores details of the registry callback path for webhooks registered in Azure DevOps to receive event updates.</td>
</tr>
</tbody>
</table>

### Setting up the integration between Azure DevOps and Agile Development

Understand the setup process of Azure DevOps Integration for Agile Development.

After you have the application installed in your ServiceNow instance, you can proceed to set up the integration, using the sn_ado_int.user role.

The setup process for the integration includes the following tasks:

2. Discover and import available projects from Azure DevOps.
3. Import area, teams, iterations into Agile Development from Azure DevOps.
4. **Set up the import and export between Agile Development and Azure DevOps.**
   a. Register webhooks for an Azure DevOps project.
   b. Associate Azure DevOps projects with assignment groups in Agile Development.
5. Bulk import work items and iterations into Agile Development.
   - Enable a scheduled job to auto-import issues from Azure DevOps.
6. Create custom map configurations for tables, fields, and workflow states between Azure DevOps and Agile Development.

### Connecting Agile Development and Azure DevOps

Establish a connection between Agile Development and Azure DevOps using a connection alias and an Azure DevOps instance.

*Create an Azure DevOps connection alias*

Create a Basic Auth credential and an HTTP(s) connection which will together be used as a connection alias to establish a connection with Azure DevOps.

Roles required:
- admin to create a connection and credential alias
• sn_ado_int.admin or sn_ado_int.user to create basic authorization credentials and HTTP(s) connection

1. Create a Connection & Credential alias
   • A connection alias (sn_ado_int.Azure_DevOps) is available by default.
   • You must create a connection alias for every Azure DevOps organisation that you use.

2. Create Basic authentication credentials.
3. Create Create an HTTP(s) connection #unique_863.

Create an Azure DevOps instance.

Create an Azure DevOps instance
Create an Azure DevOps instance record using the connection alias that you created. This instance is used to establish an integration between Agile Development and Azure DevOps.

Role required: sn_ado_int.admin or sn_ado_int.user

1. Navigate to Agile Azure DevOps Integration > Azure DevOps Instances.
2. Click New.
3. On the form, fill in the fields.

   **Azure DevOps Instance form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the Azure DevOps instance. Enter a name of your choice.</td>
</tr>
<tr>
<td>Connection Alias</td>
<td>Azure DevOps connection alias that you already created. Use the lookup (🔍) option to select your connection alias.</td>
</tr>
<tr>
<td>Version</td>
<td>Azure DevOps version. Use the lookup (🔍) option to select your Azure DevOps version.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Connect to Azure DevOps.

Connect to Azure DevOps
Connect Azure DevOps with Agile Development to enable the integration.

Role required: sn_ado_int.user

1. Navigate to Agile Azure DevOps Integration > Azure DevOps Instances.
2. Open your Azure DevOps instance record.
3. Click Connect.

If the State field on the Azure DevOps Instance record shows:

• **Connected**, the connection is successful.
• **Not connected**, the connection could not be established. You can view the reason for the failure in the error message.

Discover and import Azure DevOps projects.

Discover and import Azure DevOps projects
Discover and import all available Azure DevOps projects into Agile Development to start using the integration between the two applications.
• Connecting Agile Development and Azure DevOps.
• Role required: sn_ado_int.user

1. Navigate to **Agile Azure DevOps Integration > Azure DevOps Instances**.
2. Open your Azure DevOps instance record.
3. Click **Discover Projects**.

   This action creates requests to import Azure DevOps projects and process map configuration for all these projects. You can view all the import requests in the Azure DevOps Import Requests related list and the initial state of these requests would be **Requested**.

Once the status of each import request changes to **Complete**, you can see that the related lists of this Azure DevOps instance are populated as follows:

• **Azure DevOps Projects**: All available projects from Azure DevOps
• **Process Mappings**: Map configuration for all the imported Azure DevOps projects according to the process type.

   For example, default process types such as Agile, Basic, and CMMI or any custom process types that you defined for your Azure DevOps projects.

   For more information on the default map configuration of work items, see **Default map configuration**.

**Import areas, teams, and iterations from Azure DevOps.**

*Default map configuration*

Understand the default field map configuration, of different process types, between Azure DevOps and Agile Development.

By looking at the default map configuration for different process types, you can see how work item types in Azure DevOps are mapped in Agile Development. You can also see how fields are mapped between the two applications.

When you import available epics, stories, and issues from Azure DevOps, this data is stored in tables as defined in the process map configuration.

**Note:**

When you upgrade to version 1.3 of the application, map configuration is generated at the process level per process type and not at the instance level. You must update any custom maps that you previously configured to ensure that the import and export of work items is not impacted.

Here’s how you can view the default map configuration for different process types.

1. Navigate to **Agile Azure DevOps Integration > Azure DevOps Instances**.
2. Open your Azure DevOps instance record.
3. From the **Process Mappings** related list, open the record for a process map.

You can add or update the configuration for field, table, and choice maps between Azure DevOps and Agile Development. For details, see **Customizing your map configuration for Azure DevOps integration**.

**Import areas, teams, and iterations from Azure DevOps**

Import areas, teams, and iterations of your Azure DevOps projects. These details are used to import sprint data and associate your Azure DevOps projects with assignment groups in Agile Development.

• **Discover and import Azure DevOps projects**.
1. Navigate to Agile Azure DevOps Integration > Azure DevOps Instances.
2. Open your Azure DevOps instance record.
3. From the Azure DevOps Projects related list, open a project record.
4. Click Import Areas, Iterations and Teams.

Details of your import requests are available in the Azure DevOps Import Requests related list.

You can view all the imported teams, iterations, and areas in the Azure DevOps Teams, Azure DevOps Iterations, and Azure DevOps Areas related lists of this project.

Set up import and export between Agile Development and Azure DevOps.

Set up import and export between Agile Development and Azure DevOps

Configure the settings for the import and export actions of work items between Agile Development and Azure DevOps.

To enable synchronization of work items, register webhooks for your Azure DevOps projects and associate your Azure DevOps projects and teams with assignment groups in Agile Development.

Register webhooks for an Azure DevOps project

Register webhooks to subscribe to the events from your Azure DevOps projects.

- Discover and import Azure DevOps projects.
- Role required: sn_ado_int.user

1. Navigate to Agile Azure DevOps Integration > Azure DevOps Instances.
2. Open your Azure DevOps instance record.
3. From Azure DevOps Projects related list, open your project record.
4. Click Register Webhooks.

If the webhook registration is successful, the State field in the project form changes from Not Registered to Registered.

When you register webhooks in Azure DevOps, it receives the following event updates between Azure DevOps and Agile Development.

- Create a work item
- Update a work item
- Delete a work item
- Restore a work item
- Comment on a work item

For more information on synchronization of work items according to these webhook events, see Importing and exporting work items between Agile Development and Azure DevOps.

Associate Azure DevOps projects with assignment groups in Agile Development.

Associate Azure DevOps projects with assignment groups in Agile Development

Associate your Azure DevOps projects and teams with assignment groups in Agile Development to enable import and export of issues between the two applications.

- Import areas, teams, and iterations from Azure DevOps.
- Create assignment groups in Agile Development. See Create an assignment group in Agile Development 2.0.
- Role required: sn_ado_int.user

After you associate an Azure DevOps team with an assignment group, you can:
• Import all available stories and epics of this team into the associated group.
• View any new stories and epics or updates made to the existing stories and epics in both Agile Development and Azure DevOps.
• Import iterations as sprints in Agile Development.

1. Navigate to **Agile Azure DevOps Integration > Team Integration Settings**.
2. Click **New**.
3. In the Team Integration Settings form, select:
   • An Azure DevOps project.
   • A team of your Azure DevOps project.
   • An assignment group in Agile Development with which you want to associate the selected Azure DevOps team.
   
The value of the **Default Area** field auto-populates depending on the selected team.
4. Click **Submit**.
   
You can view the details of your settings in the Team Integration Settings in the Azure DevOps Project form.

**Note:** You can associate an assignment group with only one Azure DevOps team.

**Import work items from Azure DevOps to Agile Development.**

**Import work items from Azure DevOps to Agile Development**

Import work items and iterations of an Azure DevOps project into Agile Development to track and update the status of your work.

• Set up team integration settings for your Azure DevOps projects. For more information, see **Associate Azure DevOps projects with assignment groups in Agile Development**.

• Role required: sn_ado_int.user

1. Navigate to **Agile Azure DevOps Integration > Azure DevOps Instances**.
2. Open your Azure DevOps instance record.
3. From the Azure DevOps Projects related list, open a project record.
4. Enable import and export of work items by selecting the **Enable Workitems Import** and **Enable Workitems Export** options.
5. Enable synchronization of sprint data by selecting the **Sync Sprints** option.
6. Click **Import Work Items**.
7. Select a date and time range.
8. Click **Submit**.

Details of your import requests are available in the Azure DevOps Import Requests related list.

You can view all the imported work items and sprints in the Agile Development application.

• The relationship between the stories and epics stays as it is in Azure DevOps.
• The mapping of states of an iteration in Azure DevOps to sprints in Agile Development is as follows:

<table>
<thead>
<tr>
<th>State in Azure DevOps</th>
<th>State in Agile Development</th>
</tr>
</thead>
<tbody>
<tr>
<td>Past</td>
<td>Completed</td>
</tr>
<tr>
<td>Future</td>
<td>Draft</td>
</tr>
</tbody>
</table>
• Sprints are not created in Agile Development for the following conditions:
  • If the date fields of the iteration in Azure DevOps are empty.
  • If the iteration has a child iteration associated to it.
  • If the sprints have overlapping dates.
  • If two or more teams share a backlog iteration in Azure DevOps, a separate sprint record for each team is created in Agile Development.

Schedule jobs to import projects, teams, areas, and work items from Azure DevOps.

**Schedule jobs to import projects, teams, areas, and work items from Azure DevOps**

Schedule jobs to automatically import new projects, teams, areas, work items, and sprints periodically from Azure DevOps into Agile Development.

Role required: sn_ado_int.user

If you do not configure the scheduled job, you must manually discover projects and import areas and teams.

1. Navigate to **System Definition > Scheduled Jobs**.
2. Open one of the following jobs:
   • Discover Azure Project Job
   • Import Azure DevOps Teams Areas and Iterations
   • Import Azure DevOps Work Items

   These jobs are inactive by default.
3. To execute the job manually, click **Execute Now**.
4. To run the job at a scheduled time, select the **Active** check box.
   You can edit the details of the **Run** and **Time** fields according to your preference.
5. Click **Update**.
6. Repeat the procedure for the other two scheduled jobs.

**Customizing your map configuration for Azure DevOps integration**

Customize the table, field, or state map configuration between Azure DevOps and Agile Development according to your organizational preferences.

**Note:**

- Any modifications that you do to the existing map configuration of the process types would apply to all the Azure DevOps projects that use this process map.
- Only fields of type number, select, text, and date are supported for custom map configuration.

**Customize your table map configuration**

Create a custom table map and configure its fields for an Azure DevOps projects of a process type.

- Discover and import Azure DevOps projects.
• Role required: sn_ado_int.user

1. Navigate to Agile Azure DevOps Integration > Azure DevOps Instances.
2. Open your Azure DevOps instance record.
3. From the Process Mapping related list, open a process map for which you want to customize the map configuration.
4. From the Table maps related list, click **New**.
5. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal Table</td>
<td>Name of the table in Agile Development.</td>
</tr>
<tr>
<td>External Table</td>
<td>Table ID in Azure DevOps.</td>
</tr>
<tr>
<td>External Table Name</td>
<td>Display name of the table in Azure DevOps.</td>
</tr>
</tbody>
</table>

6. Save the table configuration.

7. From the Field Maps related list of your table map record, create new field maps to map the following fields.

<table>
<thead>
<tr>
<th>Field in Azure DevOps</th>
<th>Field in Agile Development</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title of the work item</td>
<td>Short description</td>
</tr>
</tbody>
</table>

For information on how to configure field mapping for a table, see Customize your field map configuration. You can also create other field maps for your new table configuration.

1. Validate your new table map configuration by clicking **Validate and fix mapping** from your process map form.

2. In the Table maps related list, if the Valid column of your configuration shows:
   • true, validation of your map configuration is successful.
   • false, validation of your map configuration failed. Ensure that you enter correct values for all fields and validate again.

3. Create a business rule to support export of this new table map configuration to Azure DevOps. For more information, see Create a business rule to apply a custom table map configuration.

Customize your field map configuration
Create a custom field map configuration to map a field of your preference for Azure DevOps projects of a process type.

• Discover and import Azure DevOps projects.
• Role required: sn_ado_int.user

1. Navigate to Agile Azure DevOps Integration > Azure DevOps Instances.
2. Open your Azure DevOps instance record.
3. From the Process Mapping related list, open a process map for which you want to customize the map configuration.
4. From the Table maps related list, open a record to create a field map configuration for that table map.
5. From the Field Maps relates list, click **New**.
6. On the form, fill in the fields.

**Field Map form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal Field</td>
<td>Field name in Agile Development.</td>
</tr>
<tr>
<td>Table Map</td>
<td>Table map in the ServiceNow platform, in which this field is created. This field is auto-populated based on the table map record you select.</td>
</tr>
<tr>
<td>External Field</td>
<td>Field ID in Azure DevOps.</td>
</tr>
<tr>
<td>External Field Name</td>
<td>Display name of the field in Azure DevOps.</td>
</tr>
</tbody>
</table>

7. Click **Submit**.

1. Validate your new table map configuration by clicking **Validate and fix mapping** from your process map form.
2. From the Table maps related list, navigate to your new field map configuration. If the Valid column of your configuration shows:
   - true, validation of your map configuration is successful.
   - false, validation of your map configuration failed. Ensure that you enter the correct values for all fields and validate again.

**Important:** If your custom map configuration is invalid or if the required fields are not mapped for that work item, the export action does not work.

**Customize your state map configuration**

Create a custom state map to map the workflow states of your preference for Azure DevOps projects of a process type.

- Discover and import Azure DevOps projects.
- Role required: sn_ado_int.user

You can map a state in Azure DevOps to multiple states in Agile Development. In such cases, the state in Agile Development for an issue type depends on the choice order value that you provide for this state configuration.

For example, when an work item from Azure DevOps that is in the **Active** state imported, the **State** field in Agile Development is set to **Work in progress** as it has the lowest choice order value.

You can also map multiple states in Azure DevOps to a single state in Agile Development.

1. Navigate to **Agile Azure DevOps Integration > Azure DevOps Instances**.
2. Open your Azure DevOps instance record.
3. From the Process Mapping related list, open a process map for which you want to customize the choice map configuration.
4. Open the workflow state map for this process type.
   a) From the Table Maps related list, click **User Story**.
   b) From the Field Maps related list, click **state**.
5. From the Choice maps related list, click **New**.
6. On the form, fill in the fields.

Choice Map form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal Choice</td>
<td>Value of the state in Agile Development. This value is an integer.</td>
</tr>
<tr>
<td>External Choice</td>
<td>Name of the state in Azure DevOps.</td>
</tr>
<tr>
<td>External Choice Name</td>
<td>Display name of the state in Azure DevOps.</td>
</tr>
</tbody>
</table>

7. Click Submit.

1. Validate your new table map configuration by clicking Validate and fix mapping from your process map form.
2. Navigate to your new choice map configuration. If the Valid column of your configuration shows:
   • true, validation of your map configuration is successful.
   • false, validation of your map configuration failed. Ensure that you enter the correct values for all fields and validate again.

Create a business rule to apply a custom table map configuration

Create a business rule to enable export from your new custom table map configuration to your Azure DevOps projects.

Role required: admin

After you create a custom table map for an Azure DevOps process type, create a business rule similar to Synch Story with Azure DevOps to support export of information using this new table map to Azure DevOps.

1. Navigate to System Definition > Business Rules.
2. From the list of available business rules, locate and open the Synch Story with Azure DevOps rule.
3. From the context menu
   
   Perform an Insert and Stay operation on this business rule.

   If you have not enabled the Insert and Stay action in your ServiceNow instance, see Allow insert options on records.
4. On the business rule form, edit the following fields.

Business rule form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the business rule.</td>
</tr>
<tr>
<td></td>
<td>For example, if your new table map is to map defects, name this rule as Synch Defect with Azure DevOps.</td>
</tr>
<tr>
<td>Table</td>
<td>Select the table for which you've created the custom map.</td>
</tr>
<tr>
<td></td>
<td>For example, Defect [rm_defect].</td>
</tr>
</tbody>
</table>

5. Click Update.
Allow import and export of attachments on a custom table
Enable import and export of attachments between Azure DevOps and Agile Development for a custom table that you added to the map configuration of a process type.

Role required: admin

2. From the list of business rules, locate and open the Sync Attachment to Azure rule.
3. In the When to run section of the form, include your custom table map by adding it to the filter conditions.
   For example, if the custom table that you added is Defect, do the following:
   a) Click Add "OR" Clause.
   b) Set the new clause to Table name is rm_defect.
4. Click Update.

Populate Azure DevOps identifier reference fields for a custom table
Enable Azure DevOps project identifier reference fields for your custom table that you added to the map configuration of a process type.

Role required: admin

You can display references of ID, key, Azure DevOps project, and the project URL on your custom table form by adding this table to the Populate External Identifier Reference business rule.

2. From the list of business rules, locate and open the Set external URL for Work Items rule.
3. In the When to run section of the form, include your custom table map by adding it to the filter conditions.
   For example, if the custom table that you added is Defect, do the following:
   a) Click Add "OR" Clause.
   b) Set the new clause to Reference table is rm_defect.
4. Click Update.

Configure the form layout or personalize the list layout of your custom table to display any or all of the following fields.
- External ID
- External Key
- External Project
- External URL

Generate a default map configuration between Azure DevOps and Agile Development
Generate a default mapping for an Azure DevOps process type if you want to reset the existing map configuration.

- Discover and import Azure DevOps projects.
- Role required: sn_ado_int.user

You can restore the default map configuration of an Azure DevOps process type by deleting the existing table maps and then creating mappings for this process type.

When you import available work items such as epics and stories from Azure DevOps, this data is stored in tables as defined in the map configuration of the project’s process type.
If the table map does not exist for a work item in your Azure DevOps process, this work item cannot be imported and exported between Azure DevOps and the ServiceNow platform.

1. Navigate to Agile Azure DevOps Integration > Azure DevOps Instances.  
2. Open your Azure DevOps instance record.  
3. From the Process Mapping related list, open a process map for which you want to generate the default map configuration.  
4. Click Create Mappings.

**Note:** If a table maps already exist for this process, the Create Mappings button is not displayed.

A request of the type Create Mappings is created and is visible in the Azure DevOps Import Requests related list of your Azure DevOps instance.

Once the state of the Create mappings request changes to Completed, you can see that the Mapping Config field of this Azure DevOps process is populated. Also, you can see the default map configuration in the Table Maps related list of this process.

**Importing and exporting work items between Agile Development and Azure DevOps**

Understand the workflow for the import and export of work items between Agile Development and Azure DevOps.

To enable import and export of work items between Agile Development and Azure DevOps, you must configure the settings.

**Importing to Agile Development from Azure DevOps**

- When you create a work item of type epic in Azure DevOps, an epic is created for the assignment group according to the team integration settings that you configured.
- When you create a work item of type story in Azure DevOps, a story is created for the assignment group according to the team integration settings that you configured.

  The relationship between the story and its epic is retained as it is in Azure DevOps.
- Only the fields that are defined in the field map configuration are retained in the story or epic. For the details of the default map configuration, see Default map configuration.
- When you add an attachment to a work item in Azure DevOps, the same attachment is added to the corresponding story or epic in Agile Development.
- For a new iteration in Azure DevOps, a corresponding sprint is created for the assignment group in the Agile Development, if Sync Sprints is enabled for that project.
- Only leaf level iterations are retained as sprints in Agile Development.
- When you delete a work item in Azure DevOps, the corresponding record is deleted in the Agile Development.
- When you delete an iteration in Azure DevOps, the corresponding sprint is deleted in the Agile Development.

  **Note:** To delete records in the Agile Development, set the Can Delete field to true in the Application access of the respective tables. For details, see Table design and runtime settings.

- When you restore a work item from recycle bin in Azure DevOps, a corresponding record is created in Agile Development according to its team integration settings.
Import workflow for
Import workflow for

Start → Area updated payload is received

Retrieve Area from payload

Is the Area default?
Exporting from Agile Development to Azure DevOps

- When you create an epic for an assignment group, it is exported as a work item to the area in Azure DevOps according to the team integration settings that you configured.

- When you create a story for an assignment group, it is exported as a work item to the area in Azure DevOps according to the team integration settings that you configured.

  The relationship between the story and its epic is retained in Azure DevOps.

- When you add an attachment to a story or an epic, the same attachment is added to the corresponding work item in Azure DevOps.

- When you update the assignment group of an existing story in the Agile Development, the work item is recreated for the Azure DevOps area that is associated with the updated assignment group.

- When you create a sprint for an assignment group in Agile Development, it is exported to Azure DevOps under its backlog iteration as per the team integration settings.

- When you delete a sprint for an assignment group in Agile Development, it unlinks the sprint selection from the team's iteration in Azure DevOps.
Update Assignment Group in the ServiceNow platform
Troubleshooting issues of Azure DevOps integration with Agile Development

Resolve common issues that you might face while working with the integration of Azure DevOps and Agile Development.

<table>
<thead>
<tr>
<th>Issue</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The export action is not working.</td>
<td>• Review your custom map configuration.</td>
</tr>
<tr>
<td></td>
<td>If your custom map configuration is invalid or if the required fields are not mapped for that work item, export does not work.</td>
</tr>
<tr>
<td></td>
<td>• Ensure that the Enable Export check box is selected for that project</td>
</tr>
<tr>
<td></td>
<td>• Check if your Azure DevOps password has expired.</td>
</tr>
<tr>
<td>An assignment group is not populated for a story or an epic.</td>
<td>This can happen if the team is not associated with an assignment group in Agile Development. Verify that project integration settings exist for your Azure DevOps team. If the area of a work item is mapped to multiple teams, the assignment group for that work item in Agile Development is empty. In such cases, you can manually select an assignment group for this work item.</td>
</tr>
<tr>
<td>A value from a field in Azure DevOps is not populated in Agile Development.</td>
<td>Verify if the custom field map is configured.</td>
</tr>
<tr>
<td>The value of Priority or State fields from Azure DevOps is not populated in Agile Development.</td>
<td>Verify if the custom state map is configured.</td>
</tr>
<tr>
<td>An update by a user in Azure DevOps is not updated in Agile Development.</td>
<td>Ensure that the user credentials that are used to set up the integration of Azure DevOps with Agile Development are not used to perform record updates.</td>
</tr>
<tr>
<td>The work item is deleted in Azure DevOps but not deleted in Agile Development.</td>
<td>Ensure that the Can Delete field in the Application access of the respective tables is set to true. For details, see Table design and runtime settings.</td>
</tr>
<tr>
<td>Deleting a project, team, or area does not result in any action in Agile Development.</td>
<td>After deleting the project, team, or area in Azure DevOps, the Azure DevOps administrator must manually delete the corresponding Azure DevOps project and its associated stories in Agile Development.</td>
</tr>
<tr>
<td>New Azure DevOps projects are not imported automatically.</td>
<td>Manually discover projects from the Azure DevOps instance record to immediately sync the project updates or schedule a job to discover and import these updates on a daily basis. For more details on the scheduled jobs, see Schedule jobs to import projects, teams, areas, and work items from Azure DevOps.</td>
</tr>
</tbody>
</table>
## Agile Development 2.0 — Unified Backlog

The ServiceNow® Agile Development — Unified Backlog application can be used to maintain a centralized backlog containing records of different task types, such as defects, problems, incident tasks, and stories. It facilitates prioritizing and sequencing of different task type records in one location, saving you steps. It removes the overhead of converting records to stories.

The flow described below represents the common practice of creating and managing records using the Agile Development — Unified Backlog along with the Agile Development 2.0.

### Set up a triage board

Set up a triage board by defining filter criteria. View records of a specific task type on your triage board. For example, you can create one triage board for defects and another for incidents. Records are dynamically updated in the triage boards.

### Triage records

Triage the records and add them to the Backlog tab. From the Backlog tab, you can open the triage board of a specific task type, view the total numbers of records in the triage boards of all task types, and edit the filter definition of a triage board.

### Assign records

After a record is added to the Backlog tab, you can estimate points and assign the record to a group using the Points, and Assignment group fields in the Story Information tab of the record.

After the record is assigned to a group, a user with the scrum_sprint_planner role can add the record to a sprint from the Sprint Planning tab or from the Sprint field in the Story Information tab of the record.

### Work with the records in a board view

Records from a triage board are represented by stories on the Sprint Tracking, Board view. When you move such a record to another lane, the state of the story changes, but the state of the original triaged

<table>
<thead>
<tr>
<th>Issue</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Imported work items (epics and stories) of a project have no assignment group associated with them.</td>
<td>Ensure that you have team integration settings for this project. For more information, see Associate Azure DevOps projects with assignment groups in Agile Development. The assignment group associated to any imported work item of an Azure DevOps project is based on the team integration settings of that project. If the project does not have any team integration setting, the imported work item will have an empty assignment group.</td>
</tr>
<tr>
<td>Changes made to iterations in Azure DevOps are not reflecting immediately in Agile Development.</td>
<td>Manually import iterations from the Azure DevOps project record or schedule a job to discover and import these updates on a daily basis. For more details on the scheduled jobs, see Schedule jobs to import projects, teams, areas, and work items from Azure DevOps.</td>
</tr>
<tr>
<td>The UI actions for Connect, Disconnect, and Validate and Fix result in an error when using for the first time.</td>
<td>This is a known issue. Retry the UI action.</td>
</tr>
</tbody>
</table>
record remains the same. To change the state of the original record, open the record in the form and use the Open original record related link.

**Activate Agile Development — Unified Backlog**

You can activate the Agile Development — Unified Backlog plugin (com.snc.sdlc.agile.multi_task) if you have the admin role.

- Role required: admin
- The Agile Development — Unified Backlog plugin requires the Agile Development plugin to be installed.

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

**Set up a triage board**

Set up your own triage board by defining filter criteria and view records that are important to your product, such as problems, incident tasks, defects, or change requests. For example, you can create one triage board for defects and another for incidents.

- Role required: scrum_product_owner.
- Ensure that you own a backlog.

1. Navigate to Agile Development > Agile Board > Backlog.
2. Click the Triage Board link.
3. Click Set up Triage Board.

**Note:** When setting up a triage board, it is recommended not to remove these default conditions: active is true > agile story is empty. Active is true ensures that the tasks on your Triage Board are still relevant. Agile story is empty ensures that the task is not already present in some other backlog.

4. On the Triage Definition form, fill in these fields:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Suitable name for the triage board.</td>
</tr>
<tr>
<td>Table</td>
<td>Table from which you want to filter records.</td>
</tr>
<tr>
<td>Filter</td>
<td>Filter criteria to be applied on the selected table.</td>
</tr>
</tbody>
</table>

5. Click Submit.
   - The triage definition appears in the Triage Definitions related list in Personal Backlog.

1. Select the required triage definition. For example, you select the Problems triage definition.
2. Click the View Triage Board related link.
3. To add a new record to the triage definition, click **New**.
4. To move a record from the triage board to the **Backlog** tab, click **Add to backlog**.

**Performance Analytics Content Pack for Agile 2.0**

Improve your Agile processes and practices using preconfigured dashboards with data visualizations from Performance Analytics Content Pack for Agile 2.0.

**Enabling the Performance Analytics Solution**

Use the Performance Analytics widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With solutions, you can get value from Performance Analytics for your application with minimal setup.

---

**Note:** Solutions include some dashboards that are inactive by default. You can activate these dashboards to make them visible to end users according to your business needs.

To use this Analytics and Reporting Solution, you must be entitled to use Performance Analytics with Agile Development 2.0. For more information about entitlements to Performance Analytics, see **Activate your Performance Analytics subscription**.

To enable the solution for Agile Development 2.0, an admin can navigate to **Performance Analytics** > **Guided Setup**. Click **Get Started** then scroll to the section for Performance Analytics Content Pack for Agile 2.0. The guided setup takes you through the entire setup and configuration process.

This Out-of-the-box Performance Analytics Solution is available from the ServiceNow Store. To enable this solution, an admin navigates to **System Applications** > **Search ServiceNow Store**. When the landing page for the ServiceNow Store opens, search for Performance Analytics Content Pack for Agile 2.0. When you have found the Solution, follow the instructions in the Store. The ServiceNow Store has its own documentation.

**Install Performance Analytics Content Pack for Agile 2.0**

Install the Performance Analytics Content Pack for Agile 2.0 application from ServiceNow Store.

- Activate the Agile Development 2.0 (com.snc.sdlc.agile.2.0) plugin.
- Activate the Performance Analytics (com.snc.pa) plugin.

**Role required:** admin

---

**Note:**

- To verify that plugins and applications are installed and activated, navigate to **Subscription Management** > **Subscriptions** in your instance. The list displays the subscriptions your organization has purchased.
- Activation of the Agile Development 2.0 and Performance Analytics plugins on production instances may require separate licenses. Contact ServiceNow Support for details.

1. Navigate to **ServiceNow® Store**.
2. Search for Performance Analytics Content Pack for Agile 2.0.
3. Click the application tile. You can view detailed information about the application you are installing.

   ![Note](Consider reading the Other Requirements and Dependencies sections, as applicable.)

4. Click **Get** and enter your Now Support login credentials.
5. Click **Request Install**.
6. In the **Instance Name** field, enter your details and click **Validate Instance**.
7. In the **Reason for the Instance** field, enter your details and click **Request**. You receive an email with detailed installation instructions.
8. Log in to the instance you want to install Performance Analytics Content Pack for Agile 2.0 on.
9. Navigate to **System Applications > Applications**.
10. Locate the application, select it, and click **Install**.

You can access the Agile Development 2.0 dashboard from **Agile Development > Dashboards**.

- Start the [Scrum] Daily Data Collection job. For more information, see **Enable daily data collection**.
- Remove the **Analytics** tab from Agile Board by deleting the following line of code from the **agile_board_header** UI macro:

```html
<li><a ui-sref="agileDashboard({})" ng-attr-aria-current="\{main.state.is('agileDashboard') ? 'page' : undefined\}"
    ng-class="\{active: main.state.is('agileDashboard')\}"
    ng-click="main.onNavHeaderClick($event);">${HTML: gs.getMessage('Analytics')}</a></li>
```

- Navigate to **System UI > UI actions** and set the following UI actions to FALSE:
  - Burndown chart on the Sprint table (rm_sprint)
  - Burndown chart on the Scrum release table (rm_release_scrum)
  - Group Velocity on the Group table (sys_user_group)
- If the Performance Analytics - Content Pack - Project Portfolio Suite Dashboards (com.snc.pps_dashboards) plugin is active, set the Product Owner Dashboard and Scrum Master Dashboard to inactive state.

**Enable daily data collection**

Enable scheduled data collection to begin collecting scores on new data automatically. Data collection jobs automatically collect scores for automated indicators and breakdowns.

Role required: pa_admin or admin

**Note:** Historical data collection is not supported for the underlying indicators of the [Scrum] Daily Data Collection job.

1. Navigate to **Performance Analytics > Data Collector > Jobs**.
2. Find and open the [Scrum] Daily Data Collection job.
   a) Scroll down to the Job parameters section.
   b) Set the Run as field to pa_admin, pa_data_collector or admin roles.
   c) Verify that the time zone in the Run As tz field is appropriate for your organization.
      This timezone is used for the following:
      • Database queries created for this job
      • Indicator conditions such as [[Created][on][Today]]
   d) Enable the scheduled run of the job by selecting the Active checkbox.

4. Click Update.

**Using Solution Library for Agile 2.0 dashboards**

Upgrade to the latest layout of Agile 2.0 dashboards using Solution Library.

Existing users who upgraded to the latest version 1.1 of Performance Analytics Content Pack for Agile 2.0 can install the latest layout of the dashboards from Solution Library.

For example, if you are upgrading from version 1.0.2 or earlier of the application, then install the following dashboards from Solution Library to access the latest layout:

- Agile 2.0 Epic Dashboard
- Agile 2.0 Sprint Dashboard
- Agile 2.0 Prior Sprint Dashboard
- Agile 2.0 Release Dashboard
- Agile 2.0 Team Dashboard

For more information, see Use Solution Library to install a dashboard.

**Note:** For users on the Paris release, the Install and Upgrade buttons are not visible on the Solution Library content form. For information on resolving this issue, see Allow PA Solution Library for Store apps.
Agile 2.0 Epic Dashboard

Visually analyse the progress of the stories of an epic over a given period using the Epic Dashboard.
### Epic Summary

<table>
<thead>
<tr>
<th>Total Story Count</th>
<th>Missing Estimates</th>
<th>Stories Completed</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>24</strong></td>
<td><strong>0</strong></td>
<td><strong>6</strong></td>
</tr>
</tbody>
</table>

#### Epic Burnup

- **Points:**
  - 0
  - 1k
  - 2k

- **Dates:**
  - 22 Jun
  - 6 Jul
  - 20 Jul
  - 3 Aug
  - 17 Aug
  - 31 Aug
  - 14 Sep

**Legend:**
- **Completed**
- **Scope**

#### Epic Cumulative Flow Diagram

- **Stories:**
  - 0
  - 5
  - 10
  - 15

- **Dates:**
  - 10 Jun
  - 11 Jun
  - 12 Jun
  - 13 Jun
  - 14 Jun
  - 15 Jun
  - 16 Jun
  - 17 Jun

**Legend:**
- Ready
- Work in Progress
- Ready for Testing
- Testing
- Completed

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
## Cycle Time tab

The Agile 2.0 Epic Dashboard provides the following information:

- Displays the number of stories that are complete, and number of stories that are missing estimates for an epic.
- Displays the number of stories of the epic in their current state and their progress.
- Indicates the scope changes, if any, and trends of those scope changes.
- Indicates the pace at which the team is working on stories in the epic.
- Forecasts when the epic is likely to be completed based on scope change and completion rate trends.
- Shows time elapsed for the stories of an epic to go from an in-progress state to a completed state.

Canceled stories are not included in any of this data.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
<th>Benefits</th>
</tr>
</thead>
</table>
| Scrum master: Needs clear visibility into real-time progress of team stories and the changes in scope for the epic to complete the epic on time. | scrum_user    | • View current states and time in each state for the stories of the epic  
• View epic burnup trend  
• Estimate epic completion dates  
• Identify outlier stories that took longer than expected |

Indicators

**Scrum: Sum of story points of all stories in epics**
Generates the scope series in the Epic Burnup report, which indicates the size of the epic.

**Scrum: Sum of story points of completed stories in epics**
Generates the completed series in the Epic Burnup report, which indicates the amount of work that has been completed in the epic.

**Scrum: Count of all stories in the current epic**
Generates the area series the Epic Cumulative Flow Diagram report, which indicates the number of stories of the current epic by state.

Breakdowns

- Scrum: Epic
- Scrum: State

Widgets

**Total Story Count**
Indicates the total number of stories in the epic.

**Stories Completed**
Indicates the number of stories in the epic that are complete.

**Missing Estimates**
Indicates the number of stories in the epic that are missing estimates.
Reports

If you are upgrading from version 1.0.2 or earlier of Performance Analytics Content Pack for Agile 2.0, then install this dashboard from Solution Library to upgrade its layout and access the following reports:

- Epic Cumulative Flow Diagram
- Story Cycle Time

For more information, see Using Solution Library for Agile 2.0 dashboards.

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epic Summary</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Epic Burnup</td>
<td>Line</td>
<td>Shows the epic burnup trends. You can estimate when the epic is likely to be completed. The Epic Burnup report comprises the following series that can be hidden or displayed based on your preference:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Scope</strong>: Indicates the size of the epic.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Scope Forecast</strong>: Predicts the possibility of scope change for the future dates, which is based on historical data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Completed</strong>: Indicates the amount of work in the epic that is complete.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Completed Forecast</strong>: Predicts the burnup for the future dates. It indicates whether you can complete the epic on time. This prediction is based on historical data.</td>
</tr>
<tr>
<td>Note:</td>
<td></td>
<td>The point at which the Completed Forecast series intersects with or crosses the Scope Forecast series is a predictor for when the epic might be completed. If the Completed Forecast series and the Scope Forecast series do not appear to ever intersect, it is a warning that scope is being added faster than work is being completed.</td>
</tr>
<tr>
<td>Epic Cumulative Flow Diagram</td>
<td>Area</td>
<td>Monitor the progress of all the stories of your epic between its actual start and end dates. View the number of stories in each state by their arrival to a state, time in this state, and its departure from this state. The Epic Cumulative Flow Diagram report comprises the following areas that can be hidden or displayed based on your preference:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Ready</strong>: Indicates the number of stories of the epic that are ready to start work on.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Work in Progress</strong>: Indicates the number of stories of the epic that are in development.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Ready for Testing</strong>: Indicates the number stories of the epic that are ready for testing.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Testing</strong>: Indicates the number of stories of the epic that are currently being tested.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Complete</strong>: Indicates the number of stories that are complete.</td>
</tr>
<tr>
<td>Note:</td>
<td></td>
<td>Stories in Ready and Cancelled states are not included.</td>
</tr>
<tr>
<td>Cycle Time</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Story Cycle Time</td>
<td>Bubble chart</td>
<td>Identify the time taken for each story in the epic to move from an in-progress state to completion. Each bubble on the graph represents a story.</td>
</tr>
</tbody>
</table>
Agile 2.0 Sprint Dashboard

Track the progress of your stories in the current sprint and forecast sprint completion using the Sprint Dashboard.

The Agile 2.0 Sprint Dashboard:
• Displays details of the sprint such as percentage of work that is complete, time elapsed, and total number of stories that are missing estimates.
• Displays the number of stories of the sprint in their current state and their progress.
• Indicates the scope changes, if any, and trends of those scope changes.
• Indicates the way the team needs to progress on stories to achieve the sprint goal.
• Forecasts data showing the likelihood of completing the sprint as planned.

End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
<th>Benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scrum master and sprint planner: Need visibility into scope changes,</td>
<td>scrum_user</td>
<td>• Analyse the sprint burnup and burndown trends</td>
</tr>
<tr>
<td>completed and remaining work for a sprint to adjust plans to complete the sprint</td>
<td></td>
<td>• Analyse the scope change for the sprint</td>
</tr>
<tr>
<td>on time.</td>
<td></td>
<td>• View current states and analyse the time in each</td>
</tr>
<tr>
<td></td>
<td></td>
<td>state for the stories of the sprint</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Estimate sprint completion dates</td>
</tr>
</tbody>
</table>

Indicators

Scrum: Sum of story points of all stories in the current sprint
Generates the scope series in the Sprint Burndown and Burnup reports. The scope series indicates the amount of work (in story points) that is planned for the sprint.

Scrum: Sum of story points of active stories in the current sprint
Generates the completed series in the Sprint Burndown and Burnup reports. The completed series indicates the amount of work (in story points) completed in the sprint.

Scrum: Time elapsed in sprint
Calculates the time to be displayed in the Time Elapsed widget.

Scrum: Count of all stories in the current sprint
Generates the area series in the Sprint Cumulative Flow Diagram report. It indicates the number of stories in the current sprint.

Scrum: Percent Completed by Points
Calculates the amount of work (in percentage) completed for the sprint. The value is the result of the following formula:

\[ \frac{\text{[Scrum: Sum of story points of completed stories in current sprint]}}{\text{[Scrum: Sum of story points of all stories in the current sprint]}} \times 100 \]
Breakdowns

- Scrum: Sprint
- Scrum: Current Sprint
- Scrum: State

Widgets

Scope
Indicates the amount of work in story points that is planned for the sprint. This widget lets you see at a glance how much work must be completed to achieve the sprint goal. It also lets you drill down to detail on the stories planned into the sprint.

Percent Completed
Indicates the percentage of work that has been completed in the sprint using story points. This widget lets you see at a glance how much work has been completed in the sprint. Together with the adjacent Time Elapsed widget, these widgets let you easily see whether you are completing work at a rate consistent with achieving the sprint goal on schedule.

Time Elapsed
Indicates the percentage of time that has elapsed between the start date and planned end date of the sprint. Together with the adjacent Percent Completed widget, these widgets let you easily see whether you are completing work at a rate consistent with achieving the sprint goal on schedule.

Committed Points
Indicates the committed scope (in number of story points) of the sprint. Together with the adjacent Scope widget, these widgets let you see difference between the scope committed at the start of the sprint and the current scope of the sprint.

Note: This widget is not visible by default. You can add it from Reports to your dashboard. For more information, see Edit a responsive dashboard.

Missing Estimates
Indicates the total number of stories in the sprint that are missing estimates. It is required that you use estimates for the other indicators, widgets, and reports on this dashboard to be meaningful.

Tip: If you do not estimate stories, enter a “1” in the Story Points field. The other indicators, widgets, and reports will then effectively function by count.

Blocked Work
Indicates the amount of work (in story points) in the sprint that is blocked.

Reports

If you are upgrading from version 1.0.2 or earlier of Performance Analytics Content Pack for Agile 2.0, then install this dashboard from Solution Library to upgrade its layout and access the following reports:
• Sprint Burnup
• Sprint Cumulative Flow Diagram

For more information, see Using Solution Library for Agile 2.0 dashboards.

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| Sprint Burndown    | Line | Indicates the scope changes, if any, and trends of those scope changes. Indicates the ideal pace of work, how much work is remaining, and if the scope is likely to be completed before the end of the sprint. The Sprint Burndown report comprises the following series that can be hidden or displayed based on your preference:  
  • **Scope**: Indicates the amount of work that is planned for the sprint.  
  • **Scope Forecast**: Predicts the possibility of scope change for the future dates, which is based on historical data.  
  • **Ideal Burndown**: Indicates how the team needs to progress on stories to complete the sprint on time.  
  • **Remaining**: Indicates the amount of work left for completion in the sprint. If the actual burndown is above the ideal burndown, it implies that there is more work left than originally estimated. The team is running behind the schedule of the sprint. If the actual burndown is below the ideal burndown, it implies that there is less work left than originally estimated. The team is running ahead of the schedule of the sprint.  
  • **Remaining Forecast**: Predicts the burndown for the future dates. It indicates whether you can complete the sprint on time. The prediction is based on historical data. |
<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sprint Burnup</td>
<td>Line</td>
<td>Shows the sprint burnup trend indicating scope changes. Forecast future changes in scope and the trend of work completion. The Sprint Burnup report comprises the following series that can be hidden or displayed based on your preference:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Scope</strong>: Indicates the amount of work that is planned for the sprint.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Scope Forecast</strong>: Predicts the possibility of scope change for the future dates, which is based on historical data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Completed</strong>: Indicates the amount of work completed in the sprint.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Completed Forecast</strong>: Predicts the burnup for the future dates. It indicates whether you can complete the sprint on time. The prediction is based on historical data.</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Sprint Cumulative Flow Diagram | Area        | Monitor the progress of all the stories of your sprint between its actual start and end dates. View the number of stories in each state by their arrival to a state, time in this state, and its departure from this state. The Sprint Cumulative Flow Diagram report comprises the following areas that can be hidden or displayed based on your preference:  
  • **Ready**: Indicates the number of stories in the sprint that are ready to start work on.  
  • **Work in Progress**: Indicates the number of stories in the sprint that are in development.  
  • **Ready for Testing**: Indicates the number of stories in the sprint that are ready to be tested.  
  • **Testing**: Indicates the number of stories in the sprint that are currently being tested.  
  • **Complete**: Indicates the number of stories in the sprint that are complete.  

**Note**: Stories in Ready and Cancelled states are not included in this report.

You can customize the Burnup, Burndown, and Cumulative Flow Diagram reports. For more information, see [Customizing Agile 2.0 dashboard reports](#).
Agile 2.0 Prior Sprint Dashboard

Prior Sprint Dashboard provides data visualization on scope, actual burndown and burnup, and forecast trends of previous sprints. Analyze the data and plan the work for upcoming sprints.

Note: Canceled stories are not included in any of this data.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
<th>Benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scrum master and sprint planner: Need visibility into actual changes in scope and forecast trends of the previous sprints.</td>
<td>scrum_user</td>
<td>• Analyze sprint burndown and burnup trends</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Use the data to plan for upcoming sprints</td>
</tr>
</tbody>
</table>

Indicators

The following are the indicators which are used to generate the data for the reports of this dashboard.

Scrum: Sum of story points of all stories in the current sprint
Generates the scope series in the Sprint Burndown and Sprint Burnup reports.

Scrum: Sum of story points of active stories in the current sprint
Generates the completed series in the Sprint Burndown and Sprint Burnup reports.

Breakdowns

The following are the breakdowns used by the indicators.
- Scrum: Sprint
- Scrum: Prior Sprint

Widgets

Committed points
Indicates the committed scope (in number of story points) of the sprint.

Stories Completed
Indicates the total number of stories that were completed in the previous sprint.

Completed
Indicates the amount of work (in story points) that was completed in the previous sprint.

Missing Estimates
Indicates the total number of stories in the previous sprint that were missing estimates.
Reports

If you are upgrading from version 1.0.2 or earlier of Performance Analytics Content Pack for Agile 2.0, then install this dashboard from Solution Library to upgrade its layout and access the Sprint Burnup report. For more information, see Using Solution Library for Agile 2.0 dashboards.

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sprint Burndown</td>
<td>Line</td>
<td>Indicates the scope changes, if any, and trends of those scope changes. Indicates the ideal pace of work, how much work is remaining, and if the scope is likely to be completed before the end of the sprint. The Sprint Burndown report comprises the following series that can be hidden or displayed based on your preference:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Scope</strong>: Indicates the amount of work that is planned for the sprint.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Ideal Burndown</strong>: Indicates how the team needs to progress on stories to complete the sprint on time.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Remaining</strong>: Indicates the amount of work left for completion in the sprint. If Remaining is above the Ideal Burndown, it implies that there is more work left than originally estimated. The team is running behind the schedule of the sprint. If Remaining is below Ideal Burndown, it implies that there is less work left than originally estimated. The team is running ahead of the schedule of the sprint.</td>
</tr>
</tbody>
</table>

Analyze the burndown trends and accordingly plan the workload for an upcoming sprint.
<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sprint Burnup</td>
<td>Line</td>
<td>Shows the previous sprint burnup trend indicating scope changes. Analyze future changes the trend of team’s work completion.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The Sprint Burnup report comprises the following series that can be hidden or displayed based on your preference:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Scope</strong>: Indicates the amount of work that is planned for the sprint.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Completed</strong>: Indicates the amount of work completed in the sprint.</td>
</tr>
</tbody>
</table>

You can customize the Burnup and Burndown reports. For more information, see Customizing Agile 2.0 dashboard reports.
Agile 2.0 Release Dashboard

Track the progress of your stories and analyse scope changes in the current release using Agile 2.0 Release Dashboard.
**Cycle Time tab**

The dashboard:

- Displays important details of the release such as percentage of work that is complete, time elapsed, and total number of stories that are missing estimates.
- Displays the number of stories of the release in their current state and their progress.
- Indicates the scope changes, if any, and trends of those scope changes.
- Indicates the pace at which the team is completing stories that are planned for the release.
- Forecasts data showing the likelihood of completing the release as planned.
- Shows time elapsed for the stories of a release to go from an in-progress state to a completed state.

**Note:** Canceled stories are not included in any of this data.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
<th>Benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product owner: Needs visibility into scope changes, team’s pace, and real-time progress of the stories for the release.</td>
<td>scrum_user</td>
<td>• Track progress of your stories that are planned for a release</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Resolve any bottlenecks to deliver the release on time</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Identify outlier stories that took longer than expected</td>
</tr>
</tbody>
</table>

Indicators

**Scrum: Sum of story points of completed stories in the active releases**

Generates the Completed series in the Release Burndown and Burnup reports. These series indicate the amount of work in story points that has been completed for the release.

**Scrum: Sum of story points of active stories in the current releases**

Generates the scope series in the Release Burndown and Release Burnup reports. The scope series indicates the amount of work in story points that is planned for the release.

**Scrum: Time elapsed in the release**

Calculates the time to be displayed in the Time Elapsed widget.

**Scrum: Count of all stories in the current release**

Generates the area series in the Release Cumulative Flow Diagram report, which indicates the number of stories of the current release by state.

Breakdowns

- Scrum: Release
- Scrum: State

Widgets

**Percent Completed**

Indicates the percentage of work (in story points) that has been completed in the release. This widget lets you see at a glance how much work has been completed in the release. Together with the adjacent Time Elapsed widget, these widgets let you easily see whether you are completing work at a rate consistent with achieving the release goal on schedule.

**Scope**
Indicates the amount of work in story points that is planned for the release. This widget lets you see at a glance how much work must be completed to achieve the releaser goal. It also lets you drill down to detail on the stories planned into the release.

**Time Elapsed**

Indicates the percentage of time that has elapsed between the start date and planned end date of the release. Together with the adjacent Percent Completed widget, these widgets let you easily see whether you are completing work at a rate consistent with achieving the Release goal on schedule.

**Blocked Work**

Indicates the total number of stories in the release that are missing estimates. It is required that you use estimates for the other indicators, widgets, and reports on this dashboard to be meaningful.

**Note:** If you do not estimate stories, enter a "1" in the *Story Points* field. The other indicators, widgets, and reports will then effectively function by count.

**Blocked Work**

Indicates the number of stories in the release that are missing estimates.

**Reports**

If you are upgrading from version 1.0.2 or earlier of Performance Analytics Content Pack for Agile 2.0, then install this dashboard from Solution Library to upgrade its layout and access the following reports:

- Release Cumulative Flow Diagram
- Story Cycle Time

For more information, see Using Solution Library for Agile 2.0 dashboards.

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Release Summary</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Release Burnup     | Line   | Analyse the burnup trends, and estimate when the release work is likely to be completed. The release burnup report comprises the following series that can be displayed or hidden based on your preference:  

  - **Scope**: Indicates the amount of work that is planned for the release.
  - **Scope Forecast**: Predicts the possibility of scope change for the future dates; this prediction is based on historical data.
  - **Completed**: Indicates the amount of release work that is complete.
  - **Completed Forecast**: Predicts the burnup for the future dates in the release. If it crosses the Scope Forecast series, it indicates whether you can deliver the release on time.

  **Note:** The point at which the Completed Forecast series intersects with or crosses the Scope Forecast series is a predictor for when the release might be completed. If the Completed Forecast series and the Scope Forecast series do not appear to ever intersect, it is a warning that scope is being added faster than work is being completed. |
<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| Release Burndown              | Line      | Indicates the scope changes, if any, and trends of those scope changes. It also indicates the ideal pace of work, how much work is remaining, and if the scope likely to be completed before the end of the sprint. The Release Burndown report comprises the following that can be hidden or displayed based on your preference:  
  - **Scope**: Indicates the amount of work that is planned for the release.  
  - **Scope Forecast**: Predicts the possibility of scope change for the future dates in the release. This prediction is based on historical data.  
  - **Ideal Burndown**: Indicates how the team needs to progress on stories to deliver the release on time.  
  - **Remaining**: Indicates the amount of work that is completed. If Remaining is above the ideal burndown, it implies that there is more work left than originally estimated. The team is running behind the schedule of the release. If the Remaining is below the ideal burndown, it implies that there is less work left than originally estimated. The team is running ahead of the schedule of the release.  
  - **Completed Forecast**: Predicts the burndown for the future dates in the release. It indicates whether you can deliver the release on time. |
| Release Cumulative Flow Diagram| Area      | Monitor the progress of all the stories of your release between its actual start and end dates. View the number of stories in each state by their arrival to a state, time in this state, and its departure from this state.  
  The Release Cumulative Flow Diagram report comprises the following areas that can be hidden or displayed based on your preference:  
  - **Ready**: Indicates the number of stories in the release that are ready to start work on.  
  - **Work in Progress**: Indicates the number of stories in the release that are in development.  
  - **Ready for Testing**: Indicates the number stories in the release that are ready to be tested.  
  - **Testing**: Indicates the number of stories in the release that are currently being tested.  
  - **Complete**: Indicates the number of stories in the release that are complete.  
  Note: Stories in Ready and Cancelled states are not included. |
<p>| Cycle Time                    |           |                                                                                                                                                                                                             |</p>
<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Story Cycle Time</td>
<td>Bubble chart</td>
<td>Identify the time taken for each story in the release to move from an in-progress state to completion.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Each bubble on the graph represents a story. The height of the bubble shows how long that story took to move from an in-progress state to completion. Each of the story bubbles are relative to each other based on their story points. Hovering your mouse cursor over a bubble displays the following details about that story:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Story points</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Date the story is moved to completion</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Total cycle time (in days) of the story</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Number of days that the story was in the Work in progress state</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Number of days that the story was in the Ready for testing state</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Number of days that the story was in the Testing state</td>
</tr>
<tr>
<td></td>
<td></td>
<td>From the Story State section towards the right of the report, you can filter the report to view the cycle time of the stories for the selected states. The chart displays the cycle time for each story as the cumulative sum of all duration of the selected states.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If there are too many stories at any area of the chart and the bubbles appear crowded on the report, you can zoom in that particular area of the report for a clearer view.</td>
</tr>
</tbody>
</table>

You can customize the Burnup, Burndown, and Cumulative Flow Diagram reports. For more information, see Customizing Agile 2.0 dashboard reports.
Agile 2.0 Prior Release Dashboard

Prior Release Dashboard provides data visualization on scope, actual burnup and burndown, and forecast trends of previous releases. Analyze the data and plan the work for upcoming releases.

Note: Canceled stories are not included in any of this data.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
<th>Benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product owner: Needs visibility into actual changes in scope and forecast trends of the previous releases.</td>
<td>scrum_user</td>
<td>Analyze trends for the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Scope changes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Previous releases</td>
</tr>
</tbody>
</table>

Indicators

Scrum: Sum of story points of completed stories in the active releases

Scrum: Sum of story points of all stories in active releases
Generates the scope series in the Release Burndown and Release Burnup reports.

Breakdowns

• Scrum: Release
• Scrum: Prior release

Widgets

Stories Completed
Indicates the total number of stories that were completed in the previous release.

Completed
Indicates the amount of work (in story points) that was completed in the previous release.

Missing Estimates
Indicates the total number of stories in the release that are missing estimates.
## Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| Release Burnup       | Line | Analyze the burnup trends of a previous release. The prior release burnup report comprises the following series that can be hidden or displayed based on your preference:  
  - **Scope**: Indicates the amount of work that was planned for the release.  
  - **Completed**: Indicates the amount of release work that is complete for this release. |

| Release Burndown     | Line | Shows the scope and rate of scope change, the ideal rate for work completion, and the actual rate of work completion. Analyze the burndown trends and accordingly plan the workload for an upcoming release.  
  The prior release burnup report comprises the following series that can be hidden or displayed based on your preference:  
  - **Scope**: Indicates the amount of work that was planned for the release.  
  - **Ideal Burndown**: Indicates how the team had to progress on stories to deliver the release on time.  
  - **Remaining**: Indicates the amount of work that is completed.  
  
  If the actual burndown (Remaining) is above the ideal burndown, it implies that the team was running behind the schedule of the release. If the actual burndown (Remaining) is below the ideal burndown, it implies that the team was running ahead of the schedule of the release. |
You can customize the Burnup and Burndown reports. For more information, see Customizing Agile 2.0 dashboard reports.
Agile 2.0 Team Dashboard

Team Dashboard provides a visualization of the team's progress on stories over a given period. It provides team predictability charts and helps you plan the team's capacity for the upcoming sprints. In addition, it provides details of all the team members.
Work item progress tab
Sprint Performance tab
### Team Members Tab

<table>
<thead>
<tr>
<th>Name</th>
<th>Role</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mark Andrews</td>
<td>Sr. Software Engineer</td>
<td>(empty)</td>
</tr>
<tr>
<td>John Rawls</td>
<td>Development Manager</td>
<td>(empty)</td>
</tr>
<tr>
<td>System Administrator</td>
<td>System Administrator</td>
<td>(empty)</td>
</tr>
<tr>
<td>Problem Coordinator A</td>
<td>(empty)</td>
<td>(empty)</td>
</tr>
<tr>
<td>Andrew Jackson</td>
<td>(empty)</td>
<td>(empty)</td>
</tr>
</tbody>
</table>
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
<th>Benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Team member: Needs visibility into team's predictability and progress in completing stories</td>
<td>scrum_user</td>
<td>• View progress of the team by work items</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Analyze the time taken for stories to move from one state to another</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Analyze sprint performance of the team</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Analyze trends in sprint variance of the team comparing completed work to expected capacity and committed work</td>
</tr>
</tbody>
</table>
Indicators

**Scrum: Scrum: Average Story State Duration**
Generates data that is displayed in the Average Cycle Time per State report.

**Scrum: Story State Duration**
Generates data that is displayed in the Time in State report.

**Scrum: Total stories in a sprint**
Generated data that is displayed in the Active Stories by State report.

Breakdowns

- Scrum: Group
- Scrum: State

Reports

The Team Dashboard reports are segregated into the following three tabs:

- Work item progress: Reports of Active Stories by State, Time in State, and Average Cycle Time per State
- Sprint Performance: Reports of Velocity History and Sprint Variance
- Team Members: List of all the members of the team

ℹ️ **Note:** For existing customers who upgrade to the latest version, the list of the team members appears in both the Work item progress and Team Members tabs but only one of these locations would display the accurate information. You can remove this widget from the Work item progress tab to avoid this issue. For more information on how to remove a widget, see Edit a responsive dashboard.

If you are upgrading from version 1.0.2 or earlier of Performance Analytics Content Pack for Agile 2.0, then install this dashboard from Solution Library to upgrade its layout and access the following reports:

- Velocity History
- Velocity by Type
- Sprint Variance
- Story Cycle Time

For more information, see Using Solution Library for Agile 2.0 dashboards.

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work item progress</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active Stories by State</td>
<td>Bar</td>
<td>View the total number of stories in each state of a story, for example, testing, work in progress, and testing.</td>
</tr>
<tr>
<td>Time in State</td>
<td>Stacked bar chart</td>
<td>View the time in hours that the team spends in each state of a story.</td>
</tr>
<tr>
<td>Average Cycle Time per State</td>
<td>Line</td>
<td>View how the work in progress is trending over time and what are the most significant cycle times.</td>
</tr>
<tr>
<td>Sprint Performance</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Velocity History</td>
<td>Grouped bar chart</td>
<td>Gain an insight on the overall velocity of the team for the past 10 sprints. Understand if the team is achieving a stable, predictable velocity, and is meeting the commitments. The Team Velocity History report comprises the following series per sprint that can be hidden or displayed based on your preference:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Team Capacity</strong>: Indicates the team capacity (in story points) for the sprint.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Committed Story Points</strong>: Indicates the number of story points committed by the team for the sprint.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Completed Story Points</strong>: Indicates the number of story points completed by the team for the sprint.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Average Completed Points</strong>: Indicates the average number of story points completed by the team for the sprint.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Linear (Actual)</strong>: Indicates if the amount of completed work is trending up, trending down, or relatively stable over sprints.</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Velocity by Type    | Stacked bar chart   | Analyze the way your team’s velocity changes over time and compare the team’s strategic workload with operational or other types of workload. The bar charts have two stacks that show the sum of the story points of the following types of completed stories: • Regular stories  
• Stories added to the unified backlog from the items in the triage board  
Clicking any bar would take you to its corresponding sprint details.  
Data displayed in this report is of the past 10 sprints with the earliest sprint on the left.  

**Note:** This report is not available by default. You can add it from Scrum custom charts to your dashboard. For more information, see Edit a responsive dashboard. |
| Sprint Variance     | Grouped bar chart   | Analyze the percentage variance of the team compared to the capacity and committed points, for the past 10 sprints. The Team Sprint Variance report comprises the following series per sprint that can be hidden or displayed based on your preference:  
• **Completed to Capacity:** Indicates the percentage of completed work compared to the expected capacity for the sprint.  
• **Completed to Committed:** Indicates the percentage of completed work compared to the committed work of the team for the sprint. |
<p>| Team Members        | List                | View the details of all team members.                                                                                      |
| Cycle Time          |                     |                                                                                                                                                                                                                     |</p>
<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Story Cycle Time</td>
<td>Bubble chart</td>
<td>Identify the time taken for each story, which the team has worked on, to move from an in-progress state to completion.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Each bubble on the graph represents a story. The height of the bubble from the x-axis shows how long that story took to move from an in-progress state to completion. The size of the story bubbles are relative to each other based on their story points.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can compare the cycle times of stories with different story points and analyze the trend in the time taken by the team to complete them. Identify the stories that took longer to complete and analyze the reasons so that you can chart an action plan to reduce the team’s cycle time in the future.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Hovering your mouse cursor over a bubble displays the following details about that story:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Story points</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Date the story is moved to completion</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Total cycle time (in days) of the story</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Number of days that the story was in the <strong>Work in progress</strong> state</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Number of days that the story was in the <strong>Ready for testing</strong> state</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Number of days that the story was in the <strong>Testing</strong> state</td>
</tr>
<tr>
<td></td>
<td></td>
<td>From the Story State section towards the right of the report, you can filter the report to view the cycle time of the stories for the selected states. The chart displays the cycle time for each story as the cumulative sum of all duration of the selected states.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If there are too many stories at any area of the chart and the bubbles appear crowded on the report, you can zoom in that particular area of the report for a clearer view.</td>
</tr>
</tbody>
</table>
Customizing Agile 2.0 dashboard reports

Customize the Burnup, Burndown, and Cumulative Flow Diagram reports of your dashboards according to the custom states of your scrum stories.

• Configure indicators to reflect your customizations.
  
  For example, if there are any new states introduced to the scrum story table, then the corresponding indicators and indicator sources for the story table that rely on the State field must be updated as well.

  For more information, see Customize indicators of your dashboard reports.

• Update or clone UI scripts for modifications to use your own indicators.

  Add customizations by overriding methods in empty implementation (Impl) classes of UI scripts such as ScrumAreaChartImpl, ScrumVelHistoryImpl.

  For more information, see Update UI scripts to use your indicators.

Customize indicators of your dashboard reports

Configure indicators to reflect your customizations on the Agile 2.0 dashboards.

Role required: admin or pa_admin

1. Navigate to Performance Analytics > Indicators > Automated Indicators.
2. Search for and open the required indicator.
   
   For example, if you want to customize the Sprint Burnup report, open Scrum: Sum of story points of completed stories in current sprint from the list of indicators.
3. In the Additional conditions section, modify the conditions according to your preferences.
4. Click Update.

Update UI scripts to use your indicators

Customize UI scripts by overriding methods in empty implementation (Impl) classes.

Role required: admin

1. Navigate to System UI > UI Scripts.
2. Search for and open the required UI script.
   
   For example, if you want to customize the Sprint Cumulative Flow Diagram report, open ScrumAreaChartImpl from the list of UI scripts.
3. Overwrite the base implementation according to your preferences.
4. Click Update.

Work Progress Status for Agile Teams

The Work Progress Status for Agile Teams application provides you with indicators such as estimated completion date and progress status (green, yellow, red) for all your Agile Development 2.0 epics.

As a product owner or a team lead, these indicators help you understand if your Agile team could complete the epics’ work by the planned end dates so that you can adjust your plans accordingly. As a team member working on stories of an epic, these status indicators help you understand your contribution to the overall work and your progress so that you can review your work strategy if necessary.

Note: You must enter a value for the Planned end date field for an Agile Development 2.0 epic for these work progress status indicators to populate.
Install Work Progress Status for Agile Teams

Install the Work Progress Status for Agile Teams (sn_scrum_progress) application from ServiceNow Store.

- Activate the Agile Development 2.0 (com.snc.sdlc.agile.2.0) plugin.
- Install Performance Analytics Content Pack for Agile 2.0.

Tip: To verify that plugins and applications are activated and installed, navigate to Subscription Management > Subscriptions in your instance. The list displays the subscriptions your organization has purchased.

Note: Activation of Agile Development 2.0 and Performance Analytics Content Pack for Agile 2.0 on production instances may require separate licenses. Contact ServiceNow Support for details.

Role required: admin

1. Navigate to ServiceNow® Store.
2. Search for Work Progress Status for Agile Teams.
3. Click the application tile.
   You can view detailed information about the application you are installing.

   Note: Consider reading the Other Requirements and Dependencies sections, as applicable.

4. Click Get and enter your Now Support login credentials.
5. Click Request Install.
6. In the Instance Name field, enter your details and click Validate Instance.
7. In the Reason for the Instance field, enter your details and click Request.
   You receive an email with detailed installation instructions.
8. Log in to the instance you want to install Work Progress Status for Agile Teams on.
10. Locate the Epic Progress Status for Agile 2.0 application, select it, and click Install.

If you haven’t already, start the [Scrum] Daily Data Collection job. For more information, see Enable daily data collection.

Reviewing progress status for Agile Development 2.0 epics

Understand if your work would be completed by the planned end dates by reviewing progress status of your Agile Development 2.0 epics.

Navigate to Agile Development 2.0 > Epics and filter the epics for your team.

The Status column of the epics list shows a Green, Yellow, or Red indicator for each epic to indicate the following:

- Green: Your epic is on track to be complete by the planned end date.
- Yellow: Your epic is off track and your plan of execution must be reviewed.
- Red: Your epic is not progressing well and might be at risk of not being complete by the planned end date.

The estimated completion date displays a date with the likelihood of the epic's completion.
<table>
<thead>
<tr>
<th>Number</th>
<th>Planned end date</th>
<th>State</th>
<th>Percent complete by estimate</th>
<th>Status</th>
<th>Estimated completion date</th>
</tr>
</thead>
<tbody>
<tr>
<td>EPIC010208</td>
<td>2020-07-21 01:24:01</td>
<td>Work in progress</td>
<td>67%</td>
<td>Green</td>
<td>2020-07-19</td>
</tr>
<tr>
<td>EPIC010209</td>
<td>2020-07-21 01:24:01</td>
<td>Work in progress</td>
<td>67%</td>
<td>Green</td>
<td>2020-07-19</td>
</tr>
<tr>
<td>EPIC010210</td>
<td>2020-07-21 01:24:01</td>
<td>Work in progress</td>
<td>67%</td>
<td>Green</td>
<td>2020-07-19</td>
</tr>
<tr>
<td>EPIC010211</td>
<td>2020-07-21 01:24:01</td>
<td>Work in progress</td>
<td>67%</td>
<td>Green</td>
<td>2020-07-19</td>
</tr>
<tr>
<td>EPIC010212</td>
<td>2020-07-21 01:24:01</td>
<td>Work in progress</td>
<td>55%</td>
<td>Yellow</td>
<td>2020-07-25</td>
</tr>
<tr>
<td>EPIC010213</td>
<td>2020-07-21 01:24:01</td>
<td>Work in progress</td>
<td>55%</td>
<td>Yellow</td>
<td>2020-07-25</td>
</tr>
<tr>
<td>EPIC010214</td>
<td>2020-07-21 01:24:01</td>
<td>Work in progress</td>
<td>55%</td>
<td>Yellow</td>
<td>2020-07-25</td>
</tr>
<tr>
<td>EPIC010215</td>
<td>2020-07-21 01:24:01</td>
<td>Work in progress</td>
<td>55%</td>
<td>Yellow</td>
<td>2020-07-25</td>
</tr>
<tr>
<td>EPIC010216</td>
<td>2020-07-21 01:24:01</td>
<td>Work in progress</td>
<td>55%</td>
<td>Yellow</td>
<td>2020-07-25</td>
</tr>
<tr>
<td>EPIC010217</td>
<td>2020-07-21 01:24:01</td>
<td>Work in progress</td>
<td>55%</td>
<td>Yellow</td>
<td>2020-07-25</td>
</tr>
<tr>
<td>EPIC010218</td>
<td>2020-07-21 01:24:01</td>
<td>Work in progress</td>
<td>55%</td>
<td>Yellow</td>
<td>2020-07-25</td>
</tr>
<tr>
<td>EPIC010219</td>
<td>2020-07-21 01:24:01</td>
<td>Work in progress</td>
<td>55%</td>
<td>Yellow</td>
<td>2020-07-25</td>
</tr>
<tr>
<td>EPIC010220</td>
<td>2020-07-21 01:24:01</td>
<td>Work in progress</td>
<td>55%</td>
<td>Yellow</td>
<td>2020-07-25</td>
</tr>
<tr>
<td>EPIC010221</td>
<td>2020-07-17 01:24:01</td>
<td>Work in progress</td>
<td>55%</td>
<td>Red</td>
<td>2020-07-25</td>
</tr>
<tr>
<td>EPIC010222</td>
<td>2020-07-17 01:24:01</td>
<td>Work in progress</td>
<td>55%</td>
<td>Red</td>
<td>2020-07-25</td>
</tr>
<tr>
<td>EPIC010223</td>
<td>2020-07-17 01:24:01</td>
<td>Work in progress</td>
<td>55%</td>
<td>Red</td>
<td>2020-07-25</td>
</tr>
<tr>
<td>EPIC010224</td>
<td>2020-07-17 01:24:01</td>
<td>Work in progress</td>
<td>55%</td>
<td>Red</td>
<td>2020-07-25</td>
</tr>
<tr>
<td>EPIC010225</td>
<td>2020-07-17 01:24:01</td>
<td>Work in progress</td>
<td>55%</td>
<td>Red</td>
<td>2020-07-25</td>
</tr>
<tr>
<td>EPIC010226</td>
<td>2020-07-17 01:24:01</td>
<td>Work in progress</td>
<td>55%</td>
<td>Red</td>
<td>2020-07-25</td>
</tr>
<tr>
<td>EPIC010227</td>
<td>2020-07-17 01:24:01</td>
<td>Work in progress</td>
<td>55%</td>
<td>Red</td>
<td>2020-07-25</td>
</tr>
<tr>
<td>EPIC010228</td>
<td>2020-07-17 01:24:01</td>
<td>Work in progress</td>
<td>55%</td>
<td>Red</td>
<td>2020-07-25</td>
</tr>
<tr>
<td>EPIC010229</td>
<td>2020-07-17 01:24:01</td>
<td>Work in progress</td>
<td>55%</td>
<td>Red</td>
<td>2020-07-25</td>
</tr>
</tbody>
</table>
The [Scrum] daily data collection job helps generate the burnup report for your epics. Using the data generated for these epic burnup reports, an estimated completion date is determined for each of your epics. You can see that this date is the intersection of Completed and Scope forecast series in the respective epic burnup reports.

Based on this estimated completion date, the progress status for your epics is determined. Progress status for an epic is calculated only under the following conditions:

- Planned end date is populated in the epic.
- Percentage completion of the epic is a value greater than 0.

The color of the progress status indicator is determined using the following conditions:

- Green: Estimated completion date is on or before the planned end date.
- Yellow: Estimated completion date is beyond the planned end date by a deviation of 1% to 14%.
- Red: Estimated completion date is beyond the planned end date by a deviation of 15% or more.

**Scaled Agile Framework (SAFe)**

The ServiceNow® Scaled Agile Framework (SAFe) application helps you apply lean and agile principles to your large enterprise enabling you to develop and deliver software products with fewer defects in the shortest viable lead time.

In addition, SAFe:

- Gives you a broader, high-level perspective as well as the ability to manage development processes throughout all levels of your organization.
- Facilitates collaboration and streamlines the planning and monitoring of activities across business units, departments, and teams.

**Note:** SAFe and Scaled Agile Framework are registered trademarks of Scaled Agile, Inc, and ServiceNow is a Scaled Agile, Inc. Platform Partner.

**Configurations of SAFe**

ServiceNow provides applications that support two different configurations of SAFe: Essential SAFe and Portfolio SAFe. The sections below explain the features of each configuration, and will help you choose the right configuration for your organization.

**Essential SAFe**

With Essential SAFe, you can apply lean and agile principles to your Agile Release Trains and teams, and develop and deliver work with fewer defects in the shortest viable lead time.

**Portfolio SAFe**

With Portfolio SAFe, you can align your organizational goals and strategies with your portfolios, and apply lean and agile principles to seamlessly manage and deliver your portfolio work.

**Domain separation in Scaled Agile Framework (SAFe)**

This is an overview of domain separation and the Scaled Agile Framework (SAFe) application. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called
domains. You can then control several aspects of this separation, including which users can see and access data.

**Support level: Basic**

- Business logic: Ensure that data goes into the proper domain for the application’s service provider use cases.
- The application supports domain separation at run time. This includes domain separation from the user interface, cache keys, reporting, rollups, and aggregations.
- The owner of the instance must set up the application to function across multiple tenants.

Use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

**Essential SAFe**

With Essential SAFe, you can apply lean and agile principles to your Agile Release Trains and teams, and develop and deliver work with fewer defects in the shortest viable lead time.

Essential SAFe is the most basic configuration of SAFe that works in two levels for both product managers and team members. At the Agile Release Train (ART) level, product managers can capture and prioritize features in a centralized backlog, and monitor the progress of features in a visual task board.

At the Team level, team members can implement stories that are decomposed from features. To learn more about the levels, see the SAFe Board section below.

To start using the features of Essential SAFe, install the Agile - Scaled Agile Framework - Essential SAFe plugin (com.snc.sdlc.safe).
Watch this five-minute video for an overview of Essential SAFe.

How Essential SAFe helps you deliver better software more efficiently

SAFe Board

The table below provides an overview of how you can access the key levels of Essential SAFe on SAFe Board.

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
</table>
| Agile Release Train (ART) | As a product manager, you can plan and monitor activities across teams within an ART by accessing the ART level on the Scaled Agile Framework (SAFe) > SAFe Board. In addition, you can:  
  • manage the ART backlog in a centralized location.  
  • define a program increment and identify the features that need to be completed within that program increment.  
  • perform big room planning.  
  • track all the features of the ART and view their transition from one state (lane) to another, in a visual task board. |
| Team                   | As a team member, you can plan and monitor activities within the team by accessing the Team level on the Scaled Agile Framework (SAFe) > SAFe Board. In addition you can:  
  • manage the team backlog in a centralized location.  
  • streamline sprint planning and completion activities.  
  • track all stories and view their transition from one state (lane) to another, in a visual task board. |

Activate Essential SAFe

Activate the Agile - Scaled Agile Framework - Essential SAFe plugin (com.snc.sdlc.safe) if you have the admin role.

Role required: admin

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following
**Components installed with Essential SAFe**

Several types of components are installed with activation of the Agile - Scaled Agile Framework - Essential SAFe plugin (com.snc.sdlc.safe), including tables and user roles.

**Roles installed**

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| SAFe admin [safe_admin]             | • Edits, creates, and deletes SAFe ART, epics, features, stories, and program increments.  
• Has read-only access to SAFe teams. | • safe_art_user  
• safe_scrum_master  
• safe_product_owner |
| SAFe scrum product owner [safe_product_owner] | • Maintains the team backlog and can edit, create, and delete SAFe stories.  
• Has read-only access to SAFe ART, teams, epics, and features.  
• Has read-only access to SAFe program increments. | safe_story_creator |
| SAFe ART user [safe_art_user]      | • Maintains the ART backlog and can edit, create, and delete SAFe epics, features, stories, and program increments.  
• Edits SAFe teams.  
• Has create and edit access to SAFe ART. | safe_story_creator |
| SAFe scrum master [safe_scrum_master]  | • Edits, and deletes SAFe stories.  
• Edits SAFe teams.  
• Has read-only access to SAFe ART, epics, features, and program increments. | safe_story_creator |
<p>| SAFe scrum user [safe_scrum_user]   | Can view all elements of SAFe, but cannot create, edit, or manage records of any type. | None |</p>
<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| SAFe scrum story creator safe_story_creator | • Edits, creates, and deletes SAFe stories.  
• Has read-only access to SAFe ART, teams, epics, features, and program increments. | safe_story_editor                |
| SAFe scrum story editor safe_story_editor | • Arranges stories within the team backlog using the drag and drop feature.  
• Edits SAFe stories.  
• Has read-only access to SAFe ART, teams, epics, features, and program increments. | safe_scrum_user, rm_scrum_task_admin |

### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAFe epic sn_safe_epic</td>
<td>Information about epics.</td>
</tr>
<tr>
<td>SAFe feature sn_safe_feature</td>
<td>Information about features.</td>
</tr>
<tr>
<td>Agile Release Train sn_safe_program</td>
<td>Information about ART.</td>
</tr>
<tr>
<td>Program Increment sn_safe_program_increment</td>
<td>Information about program increments.</td>
</tr>
<tr>
<td>SAFe ART team sn_safe_program_m2m_group</td>
<td>Relationships between groups and ART.</td>
</tr>
<tr>
<td>SAFe ART Member sn_safe_program_member</td>
<td>Information about members within an ART.</td>
</tr>
<tr>
<td>SAFe ART Sprint sn_safe_program_sprint</td>
<td>Sprint schedules of teams within the ART.</td>
</tr>
<tr>
<td>SAFe ART VTB Board sn_safe_program_vtb_board</td>
<td>Records displayed on the ART level, Board tab.</td>
</tr>
<tr>
<td>SAFe Scrum Task sn_safe_scrum_task</td>
<td>Information about SAFe scrum tasks.</td>
</tr>
<tr>
<td>SAFe Sprint sn_safe_sprint</td>
<td>Information about sprints.</td>
</tr>
<tr>
<td>Test</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Essential SAFe: Feature tests</td>
<td>Verify feature global rank updates.</td>
</tr>
<tr>
<td></td>
<td>For a SAFe feature, verify that:</td>
</tr>
<tr>
<td></td>
<td>• The actual start date is populated after the state is changed to Implementation, Validation on Staging, or Deployment.</td>
</tr>
<tr>
<td></td>
<td>• The actual end date is populated after the state is changed to <strong>Released</strong> or <strong>Cancelled</strong>.</td>
</tr>
<tr>
<td></td>
<td>• The active flag is set to:</td>
</tr>
<tr>
<td></td>
<td>• <strong>False</strong>, if the state is changed to <strong>Released</strong> or <strong>Cancelled</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>True</strong>, for all other states.</td>
</tr>
<tr>
<td>Essential SAFe: Program increment tests</td>
<td>Verify program increment date overlapping.</td>
</tr>
<tr>
<td>Essential SAFe: Sprint tests</td>
<td>Verify the generation of ART sprints and team sprints as well as updates to sprint points and dates.</td>
</tr>
<tr>
<td>Test</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Verify that any update to the <strong>Group capacity</strong> field of the assignment group results in the following changes to the <strong>Group capacity</strong> field of the various sprints associated with this assignment group:</td>
</tr>
<tr>
<td></td>
<td>• For the sprints that are in the <strong>Draft</strong> or <strong>Planning</strong> states:</td>
</tr>
<tr>
<td></td>
<td>• The group capacity is updated to the new value.</td>
</tr>
<tr>
<td></td>
<td>• The <strong>Group capacity</strong> field is editable.</td>
</tr>
<tr>
<td></td>
<td>• For the sprints in the <strong>Current</strong>, <strong>Complete</strong>, or <strong>Cancelled</strong> states:</td>
</tr>
<tr>
<td></td>
<td>• The group capacity remains the old value.</td>
</tr>
<tr>
<td></td>
<td>• The <strong>Group capacity</strong> field is read-only.</td>
</tr>
<tr>
<td>For the sprints in the <strong>Draft</strong> or <strong>Planning</strong> state, you can individually edit the group capacity of the sprint anytime later. This would not change the group capacity of the assignment group associated with this sprint.</td>
<td></td>
</tr>
<tr>
<td>Essential SAFe: Story tests</td>
<td>Verify story global rank updates.</td>
</tr>
<tr>
<td></td>
<td>Verify that active flag of the SAFe story is set to:</td>
</tr>
<tr>
<td></td>
<td>• <strong>False</strong>, if the state of the state is changed to Completed or Cancelled.</td>
</tr>
<tr>
<td></td>
<td>• True, for all other states.</td>
</tr>
<tr>
<td></td>
<td>Verify that adding, estimating, removing, deleting, updating, or cancelling a SAFe story updates the SAFe feature-level and then the epic-level roll-ups correctly.</td>
</tr>
<tr>
<td></td>
<td>Verify that adding, updating, or deleting the feature on a SAFe story updates the Epic field on the SAFe story form.</td>
</tr>
<tr>
<td>Essential SAFe: Team tests</td>
<td>Verify team association with an ART.</td>
</tr>
<tr>
<td>Test</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>Essential SAFe: Epic tests</td>
<td>For a SAFe epic, verify that: • The actual start date is populated after the state is changed to Implementation. • The actual end date is populated after the state is changed to Complete. • The active flag is set to: • False, if the state is changed to Released or Cancelled states. • True, for all other states.</td>
</tr>
</tbody>
</table>

**SAFe entities**

Learn about the various SAFe entities that are used to successfully plan, track, and deliver your software products.

**Epic**

Epic in SAFe is the largest unit of work, which can be continuously worked through multiple program increments. Epic captures business hypotheses and is prioritized and assessed using the WSJF (Weighted Shortest Job First is used to prioritize and sequence jobs to produce optimum business value) score.

An epic is further decomposed into features for implementation and delivery by SAFe ARTs.

**Feature**

A SAFe feature is equivalent to an epic in Agile Development. It must be small enough for completion within a program increment cycle. It is prioritized and sequenced in an ART backlog based on its global ranking. A feature is further decomposed into user stories for implementation and delivery by SAFe teams.

**Story**

A SAFe story is a brief statement encapsulating a product requirement or business case written in user-centric language. A story must be small enough for completion in one sprint. The estimated effort required to complete a story is measured in story points. More points are assigned to a story requiring more effort. Story points are arbitrary measurements of the effort (not necessarily the time) required to complete a story, based on the estimates from the SAFe team members.

**Agile Release Train**

Agile Release Train (ART) comprises a set of teams working towards a single solution.

**Program Increment**

A program increment is set period during which teams in an ART collaborate and produce to achieve agreed-upon goals. A program increment in SAFe is similar to a sprint in Agile Development, typically spanning 8–12 weeks. The most common form of program increment comprises four development sprints followed by one innovation and planning sprint.
SAFe team

SAFe team is an autonomous, cross-functional team containing members possessing different skill-sets who work in collaboration to achieve a common goal.

Sprint

Program Increments in SAFe are further segmented into sprints for teams involved in it, and are measured in terms of weeks.

Define an epic in SAFe

Create an epic within SAFe. An epic is the largest unit of work that has one common objective such customer request, or business requirement. An epic is further decomposed into features for implementation and delivery by SAFe agile release trains (ARTs).

Role required: safe_art_user or safe_admin

1. Create an epic using either of the following options:

   Option | Steps
   --- | ---
   From the Backlog tab | a. Navigate to Scaled Agile Framework (SAFe).
   | b. From the list, select the ART level.
   | c. From the adjacent list, select the required ART value.
   | d. Select the Backlog tab.
   | e. From the Create list, select Create Epic. The epic is displayed in the Backlog tab with the state as Backlog.

   From the Epics module | a. Navigate to Scaled Agile Framework (SAFe) > Epics.
   | b. Click New. The epic is displayed in the Epics list and Backlog tab with the state as Funnel.

   From the Portfolios module | a. Navigate to Scaled Agile Framework (SAFe) > Portfolios.
   | b. In the SAFe epics related list, click New.

2. In the form, fill in the fields:

   SAFe Epic Form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>System-generated number for the epic.</td>
</tr>
<tr>
<td>Enabler</td>
<td>Check box identifying the epic as an enabler. Enablers do not add direct business value but help lay a foundation for future work. For example, an enabler epic might be an investigation into the architecture used to build features.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>State</td>
<td>State of the epic:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Funnel</strong>: Created from <a href="https://www.scaledagileframework.com">Scaled Agile Framework (SAFe)</a> &gt; Epic.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Review</strong>: Under review considering parameters like WSJF score and WIP limited.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Analysis</strong>: Approved or rejected based on parameters like WSJF score refinement, cost estimation, alternatives, and WIP limited.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Backlog</strong>: Approved and assigned to an ART. In this state, the ART level user segments the epic into features.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Implementation</strong>: Epic is being implemented.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Done</strong>: Implementation is complete.</td>
</tr>
<tr>
<td>Color</td>
<td>Color attributed to the epic. Epic colours help you visually identify and group features by their epic on the ART's backlog page of the SAFe board.</td>
</tr>
<tr>
<td>WSJF Score</td>
<td>Weighted Shortest Job First (WSJF) score is used to prioritize and sequence jobs to produce optimum business value. A job with the highest WSJF score receives the highest priority for implementation. A job can refer to an epic, feature, or any business capability.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the epic.</td>
</tr>
<tr>
<td>Description</td>
<td>A more detailed description of the epic.</td>
</tr>
<tr>
<td>Weighted shortest job first score</td>
<td></td>
</tr>
<tr>
<td>User-business Value</td>
<td>Business value of the job based on parameters like impact on revenue or other solutions in the market offering similar capabilities.</td>
</tr>
<tr>
<td>Time criticality</td>
<td>Impact on the business when deadlines are missed. For example, how projected revenue gains are reduced over time when deadlines are shifted.</td>
</tr>
<tr>
<td>Risk reduction</td>
<td>Analyze how much risk this epic can help you avoid by answering questions such as:</td>
</tr>
<tr>
<td></td>
<td>• Does the job add value to the business in other ways?</td>
</tr>
<tr>
<td></td>
<td>• Does the job bring in new business opportunities?</td>
</tr>
<tr>
<td></td>
<td>• Does the job reduce the risk for a future delivery?</td>
</tr>
<tr>
<td>Job size</td>
<td>Estimated duration for completion of the job.</td>
</tr>
<tr>
<td>Total story count</td>
<td>Number of active stories in the epic.</td>
</tr>
<tr>
<td></td>
<td>This field is not displayed by default. Configure the field in the form layout.</td>
</tr>
<tr>
<td>Completed count</td>
<td>Number of stories that have been completed in the epic.</td>
</tr>
<tr>
<td></td>
<td>This field is not displayed by default. Configure the field in the form layout.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Percent complete by count</td>
<td>Percentage of work that has been completed in the epic. Value is calculated by story count. This field is not displayed by default. Configure the field in the form layout.</td>
</tr>
<tr>
<td>Total estimate</td>
<td>Sum of estimates of all the active stories in the epic. This field is not displayed by default. Configure the field in the form layout.</td>
</tr>
<tr>
<td>Completed estimate</td>
<td>Sum of estimates of all the completed stories in the epic. This field is not displayed by default. Configure the field in the form layout.</td>
</tr>
<tr>
<td>Percent complete by estimate</td>
<td>Percentage of work that has been completed in the epic. Value is calculated by story estimate. This field is not displayed by default. Configure the field in the form layout.</td>
</tr>
<tr>
<td>Missing estimates</td>
<td>Number of stories without estimation points. This field is not displayed by default. Configure the field in the form layout.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

**Define a feature in SAFe**

Create a feature in SAFe and break it down into smaller user stories for implementation and delivery by SAFe teams.

Role required: safe_art_user or safe_admin

1. Create a feature using any of the following options:

   **From the Backlog tab**
   
   
   b. From the list, select ART.
   
   c. From the adjacent list, select your agile release train (ART).
   
   d. From the Create list, select Create Feature. The feature is displayed in the Backlog tab with the state as **Backlog**.

   **From the Feature module**
   
   
   b. Click **New**.
Option | Steps
--- | ---
**From the Epics module** | a. Navigate to **Scaled Agile Framework (SAFe) > Epics**.  
b. Click any epic.  
c. In the SAFE Features related list, click **New**.

**From the Agile Release Trains module** | a. Navigate to **Scaled Agile Framework (SAFe) > Agile Release Trains**.  
b. Click any agile release train.  
c. In the SAFe Features related list, click **New**.

You can also convert an active SAFe story into a SAFe feature. For details, see Related links and lists of a SAFe story.

2. On the form, fill in the fields.

**SAFe Feature Form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>System-generated number for the feature.</td>
</tr>
<tr>
<td>Enabler</td>
<td>Option that identifies a feature as an enabler. An enabler does not bring any business value but helps in laying the foundation for future work. For example, you can use an enabler to investigate the architecture that is used to build stories.</td>
</tr>
<tr>
<td>Color</td>
<td>Color that you attribute to the feature. Feature colours help you visually identify and group stories by their feature on the team's backlog page of the SAFe board.</td>
</tr>
</tbody>
</table>
| WSJF score     | Weighted Shortest Job First (WSJF) score that you use to prioritize and sequence jobs to produce an optimum business value.  
<pre><code>             | A job with the highest WSJF score receives the highest priority for implementation. A job can be an epic, feature, or any business capability. |
</code></pre>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>State of the feature. Select one of the following:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Funnel</strong>: In this state, you can create features from approved ideas.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Analysis</strong>: In this state, the product management team reviews the features and considers the acceptance criteria, benefit hypothesis, technical feasibility, and scope estimates.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Backlog</strong>: In this state, you can prioritize approved features and assign them to an ART.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Implementation</strong>: In this state, you can break down a feature into stories that you can later assign to a team.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Validation on staging</strong>: In this state, you can integrate the feature in the system and present it to the product management team for approval and feedback.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Deployment</strong>: In this state, the deployment testing of feature is complete.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Released</strong>: In this state, you are ready to release the feature to the end users and assess the benefit hypotheses.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Cancelled</strong>: In this state, a feature has been canceled.</td>
</tr>
<tr>
<td>SAFe epic</td>
<td>Epic to which the feature belongs.</td>
</tr>
<tr>
<td>Agile release train</td>
<td>Agile release train to which the feature belongs.</td>
</tr>
<tr>
<td>Program increment</td>
<td>Program increment in which the feature is scheduled for completion.</td>
</tr>
<tr>
<td>SAFe team</td>
<td>Team that is primarily responsible for the delivery of the feature.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the feature.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the feature.</td>
</tr>
<tr>
<td>Weighted shortest job first score</td>
<td>Estimate of the business value of the job from this feature. Consider the impact on revenue or other solutions in the market that offer similar capabilities.</td>
</tr>
<tr>
<td>User-business Value</td>
<td>Estimated impact on the business when deadlines are missed. For example, consider how shifting deadlines can reduce the projected revenue gain.</td>
</tr>
<tr>
<td>Time criticality</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Risk reduction | Analysis of how much risk this feature can help you avoid. Answer questions such as the following:  
- Does the job add value to the business in other ways?  
- Does the job bring in new business opportunities?  
- Does the job reduce the risk for a future delivery? |
| Job size      | Estimated duration for completion of the job.                                |
| Notes         | Work notes that indicate the progress of the feature at various stages in its life cycle. |

3. Click **Submit**.

Use the SAFe stories related list to view and add stories to the feature.

**Split a SAFe feature**

Split a SAFe feature into two separate features so that you can track complete and incomplete stories. You can move the feature with the incomplete stories to your backlog or to a future program increment (PI) so that you can maintain accurate metrics of the previous sprints and PIs.

Role required: safe_art_user or safe_admin

If your SAFe feature has incomplete stories at the end of a PI, you can split this feature into two features.

The completed stories of the original feature move to a new feature whose state is set to **Released**.

**Note:** To split a SAFe feature, you must have at least one complete and incomplete story each.

1. Navigate to **Scaled Agile Framework (SAFe) > SAFe Board**.
2. From the list at the top-left corner, select the level as **ART** and select your agile release train.
3. Click the **Backlog** tab.
4. Select the **List** view.
5. From your current PI section, locate the SAFe feature that has incomplete stories and click its number to open its form.

You can click **Complete** to get the list of incomplete features.
6. On the feature form, click the **Move completed stories to new feature** related link.
   - The updated feature form shows only those stories that are incomplete.
   - The new feature contains the completed stories from the original feature.
   - The **Original feature** field on the new feature references to the original feature that you've split.

**Note:** Configure your feature form layout to view this field.

- 
  - 
  - 

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Schedule the feature that has incomplete stories to your backlog or a new PI of your choice.

**Define a story in SAFe**

Create high-level definitions of your requirements in the form of stories in SAFe.

Role required: safe_sprint_planner, safe_art_user, safe_scrum_master, safe_story_editor, safe_team_member, or safe_admin

1. Create a story using either of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the Story module</td>
<td>a. Navigate to Scaled Agile Framework (SAFe) &gt; Stories.</td>
</tr>
<tr>
<td></td>
<td>b. Click New.</td>
</tr>
<tr>
<td>From the SAFe stories related list</td>
<td>a. Navigate to Scaled Agile Framework (SAFe) &gt; Feature.</td>
</tr>
<tr>
<td></td>
<td>b. Click any feature.</td>
</tr>
<tr>
<td></td>
<td>c. Click the SAFe Stories related list and click New.</td>
</tr>
</tbody>
</table>

2. In the form, fill in the fields:

**SAFe Story Form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>System-generated number for the story.</td>
</tr>
<tr>
<td>Feature</td>
<td>Feature to which the story belongs.</td>
</tr>
<tr>
<td>SAFe epic</td>
<td>Epic to which the story belongs.</td>
</tr>
<tr>
<td>SAFe sprint</td>
<td>Sprint in which the story is scheduled for completion.</td>
</tr>
<tr>
<td>Points</td>
<td>Number of points indicating the estimated effort required to complete the story. A larger point value indicates that a greater amount of effort is required.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>State</td>
<td>State of the story. Select one of the following:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Draft</strong>: In this state, the story requirements, such as the description and acceptance criteria, are still being drafted.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Ready</strong>: In this state, the story is marked as ready to be picked up by the development team.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Work in Progress</strong>: In this state, the development team works on the story and records their changes in the work notes field.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Ready for Testing</strong>: In this state, the story is marked as ready to be taken up by a tester.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Testing</strong>: In this state, the tester works on testing the story based on the requirements provided in the story.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Complete</strong>: In this state, the development and testing efforts on a story are complete.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Cancelled</strong>: In this state, a story has been cancelled.</td>
</tr>
</tbody>
</table>

The default state for a new story is **Draft**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAFe team</td>
<td>Team to which the story is assigned.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User to which the story is assigned.</td>
</tr>
<tr>
<td>Enabler</td>
<td>Check box identifying the story as an enabler. Enablers do not add direct business value but help lay a foundation for future work.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the story.</td>
</tr>
<tr>
<td>Description</td>
<td>A more detailed description of the story.</td>
</tr>
<tr>
<td>Acceptance criteria</td>
<td>The functional criteria or testing results required to move the story to the state of <strong>Complete</strong>.</td>
</tr>
<tr>
<td>Notes</td>
<td>Work notes indicating the progress of the story at various stages in its life cycle.</td>
</tr>
</tbody>
</table>

3. **Click Submit.**

- Create a story with the same details as this story using the **Insert** or **Insert and Stay** options from the story additional actions

When you use **Insert and Stay**, the form of the newly created story remains open so that you can modify its details, create more stories with these details, or do both.

On SAFe Board, the new story is positioned right below the original story and the global rank of the new story is set accordingly.

**Note:**
- Set the glide.ui.task.insert and glide.ui.advance properties to **true** to access these actions.
- These actions are not allowed on stories added from the triage board.
Use the following related links and lists to create scrum tasks or add dependencies to this story. You can also convert this story into a SAFe feature, based on your requirements:

**Related links and lists of a SAFe story**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Related links</td>
<td></td>
</tr>
<tr>
<td>Convert into feature</td>
<td>Converts an active story into a feature and moves the story into the <strong>Cancelled</strong> state.</td>
</tr>
<tr>
<td></td>
<td>If the story that you created is too big, you can convert it into a feature and then break it down into multiple stories.</td>
</tr>
<tr>
<td></td>
<td>• The default state of the newly created feature is <strong>Funnel</strong>.</td>
</tr>
<tr>
<td></td>
<td>• The cancelled story is associated with the newly created feature.</td>
</tr>
<tr>
<td>Copy Story</td>
<td>Copies the details of an existing active story, along with its tests and tasks, to a new story.</td>
</tr>
<tr>
<td></td>
<td>The default state of the newly created story is <strong>Draft</strong>.</td>
</tr>
<tr>
<td></td>
<td>This action is not allowed on stories added from the triage board.</td>
</tr>
</tbody>
</table>

**Related lists**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAFe scrum tasks</td>
<td>Decompose the story into scrum tasks.</td>
</tr>
<tr>
<td>Prerequisites Stories</td>
<td>Add stories to be completed before the current story.</td>
</tr>
<tr>
<td>Dependent Stories</td>
<td>Add stories that are dependent on the current story.</td>
</tr>
<tr>
<td>Tests</td>
<td>Add existing tests to the story.</td>
</tr>
</tbody>
</table>

**Add dependencies to your SAFe stories**

Set dependencies to your SAFe story by adding prerequisite and dependent stories to it. Using the SAFe Planning board, you can distinguish these dependencies between stories during your big room planning and replan the stories as required.

Role required: safe_story_creator

Prerequisite stories are the stories that must be completed before the current story can be completed. Dependent stories are the stories that depend on the completion of the current story.

1. Navigate to a story by using any of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the Stories module</td>
<td>a. Navigate to Scaled Agile Framework (SAFe) &gt; Stories.</td>
</tr>
<tr>
<td></td>
<td>b. Click the story that you want to add dependencies to.</td>
</tr>
</tbody>
</table>
### Option: From the SAFe planning board

2. Click [Planning](https://www.servicenow.com/safe).
3. Select your agile release train (ART) and program increment (PI).
4. Click the [Stories](https://www.servicenow.com/safe) view.
5. On the planning board, locate and open the story that you want to add dependencies to.

2. In the Prerequisite Stories or Dependent Stories related lists, add stories according to the dependencies.

3. **Click Save.**

4. **Click Update.**

If you’re on the SAFe planning board, click the dependencies icon ( görüntü) to show or hide dependency lines between stories:

- If the dependencies are between two stories that are present on the board, you can see dependency lines between them. The colour of the dependency lines indicate the way you’ve scheduled the stories.
  - **Green:** A prerequisite story is scheduled in a sprint prior to that of its dependent story.
  - **Yellow:** A prerequisite story is scheduled in the same sprint as its dependent story.
  - **Red:** A prerequisite story is scheduled in a sprint after its dependent story. Review the dependency and reschedule the story as required.

- If the dependencies are between two stories of which one is not present on the board, you can see a coloured border on the story card.
  - Border on the left of the story card indicates that it has a prerequisite story associated with it.
  - Border on the right of the story card indicates that it has a dependent story associated with it.

- If none of the stories have a prerequisite or dependent story associated with them, the dependencies icon is not visible.

### Define an Agile Release Train

From SAFe, define an Agile Release Train (ART) which is a group of agile teams working towards a single solution.

Role required: safe_admin

1. **Create an agile release train using either of the following options:**
   
<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
</table>
<pre><code>                                     | b. Click [New](https://www.servicenow.com/safe). |
                                     | b. In the Agile release trains related list, click [New](https://www.servicenow.com/safe). |
</code></pre>
2. Enter a suitable name for the agile release train and click **Submit**.

Use the following related lists:

<table>
<thead>
<tr>
<th>Related list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Members</td>
<td>Add or remove members from the Agile Release Train. Members are on the ART, but are not part of any specific agile team. For example, business owner, product manager, release train engineer, or system architect.</td>
</tr>
<tr>
<td>Teams</td>
<td>Teams that are part of the Agile Release Train.</td>
</tr>
<tr>
<td>SAFe features</td>
<td>View or add features to the Agile Release Train.</td>
</tr>
<tr>
<td>Program increments</td>
<td>View or add program increments.</td>
</tr>
</tbody>
</table>

**Define a program increment in SAFe**

With SAFe, define a program increment (PI). A program increment is typically 8–12 weeks long, during which an ART delivers incremental value in the form of working, tested software and systems.

**Role required:** safe_admin

1. Navigate to the program increment form using either of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the Program Increment Planning tab</td>
<td>a. Navigate to Scaled Agile Framework (SAFe) &gt; SAFe Board.</td>
</tr>
<tr>
<td></td>
<td>b. From the list, select ART.</td>
</tr>
<tr>
<td></td>
<td>c. From the adjacent list, select the required ART value.</td>
</tr>
<tr>
<td></td>
<td>d. Click the Backlog tab.</td>
</tr>
<tr>
<td></td>
<td>e. Click Create Program Increment.</td>
</tr>
<tr>
<td>From the Program Increment related list</td>
<td>a. Navigate to Scaled Agile Framework (SAFe) &gt; Agile Release Trains.</td>
</tr>
<tr>
<td></td>
<td>b. Click any Agile Release Train.</td>
</tr>
<tr>
<td></td>
<td>c. In the Program Increments related list, click New.</td>
</tr>
</tbody>
</table>

2. On the form, fill in the fields:

   **SAFe Program Increment form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>System-generated number for the story.</td>
</tr>
<tr>
<td>Agile release train</td>
<td>ART to which the PI belongs.</td>
</tr>
<tr>
<td>Sprint length</td>
<td>Duration of each of the sprints in the PI.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PI Capacity</td>
<td>Expected PI capacity; usually the aggregate of the group capacity of each team for each sprint in the PI. Helps determine the load of planned features as compared to your expected PI capacity</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the PI.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the PI. The default state is Draft.</td>
</tr>
<tr>
<td>Planned start date</td>
<td>Intended start date of the PI.</td>
</tr>
<tr>
<td>Number of sprints</td>
<td>Number of sprints included in the program increment.</td>
</tr>
</tbody>
</table>

The sprints for the teams in the PI are determined from the values provided for **Sprint length**, **Planned start date**, and **Number of sprints**.

3. **Click Submit**.

Access the following related lists:

<table>
<thead>
<tr>
<th>Related list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAFe features</td>
<td>List of features that are scheduled for completion in a program increment.</td>
</tr>
<tr>
<td>SAFe stories</td>
<td>View, add, modify, or remove stories that are scheduled for completion in a program increment.</td>
</tr>
<tr>
<td>SAFe sprints</td>
<td>View, add, modify, or remove sprints in a program increment.</td>
</tr>
</tbody>
</table>

**Define a SAFe team**

From SAFe, create an agile team and associate it to an ART.

Role required: admin

1. Navigate to **Scaled Agile Framework (SAFe) > SAFe Teams**.
2. **Click New**.
3. In the form, fill in the fields:

**Group form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Suitable name for the group.</td>
</tr>
<tr>
<td>Manager</td>
<td>Designated servant leader of the team.</td>
</tr>
<tr>
<td>Group capacity (points)</td>
<td>Total capacity of the team per sprint measured in story points.</td>
</tr>
<tr>
<td>Group email</td>
<td>Email distribution list of the group.</td>
</tr>
<tr>
<td>Description</td>
<td>Suitable description for the group.</td>
</tr>
</tbody>
</table>
4. Click **Submit**.

Use the following related lists:

<table>
<thead>
<tr>
<th>Related list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Members</td>
<td>Add or remove members from the group.</td>
</tr>
<tr>
<td>Stories</td>
<td>Add or edit stories assigned to the group.</td>
</tr>
<tr>
<td>Sprints</td>
<td>View or add sprints for the group.</td>
</tr>
</tbody>
</table>

**SAFe Board — ART level**

As a product manager, you can plan and monitor activities across teams within your agile release train (ART) by accessing the ART level on the SAFe Board.

The ART level includes the following tabs:
- Board
- Backlog
- Planning

**Board**

The **Board** tab enables you to track all the features of your agile release train in a single view. Board is built on visual task boards, which transform the navigation of lists and forms into an interactive graphical experience. The visual task board interface provides a graphic-rich environment for managing and collaborating. To learn more about the actions that can be performed in the board, see visual task boards.

You can move a feature from one lane to another, which in turn updates the state of the feature. For example, when you move a feature from the Analysis lane to the Backlog lane, the state of the feature updates to Backlog.
The Backlog tab enables you to manage your ART backlog, and pre-plan the next program increment on the level of features.

A program increment is a time frame in which various agile teams work in collaboration to deliver a substantial amount of work towards the end of the program increment cycle. Program increment in SAFe is equivalent to a sprint in Agile Development, typically spanning 8–12 weeks. The most common form of program increment comprises four development sprints followed by one innovation and planning sprint.
Planning

The **Planning** tab facilitates a detailed planning of the upcoming program increment. It allows ART members to discuss the features in the program increment, break them down into stories, and pre-plan the
sprints needed to complete the program increment. The **Planning** tab surfaces the dependencies between stories and dependencies between features, which helps in the planning process.
Track features in a board

Track the progress of features in the ART. View their transition from one state (lane) to another.  
Role required: safe_admin or safe_art_user

1. Navigate to Scaled Agile Framework (SAFe) > SAFe Board.  
2. From the choice list at the top left corner, select the level as ART.  
3. Select the Board view.  
4. Move a feature to the required state by dragging and dropping the feature card.  
5. Optional: Add a feature to a specific state:  
   a) Click Add Card.  
   b) On the form, fill in the fields and submit it. For more information on the Feature form fields, see Define a feature in SAFe.

Manage your ART backlog

Manage, evaluate, prioritize, and sequence features in your agile release train (ART) backlog. The ART backlog lists only the active features that are not assigned to any program increment.  
Role required: safe_admin or safe_art_user

- Create features, epics, and group features by epics.  
- View features prioritized in the backlog based on their Weighted Shortest Job First (WSJF) scores. Features also have color bands based on their WSJF scores.  
- Manually arrange the features in a backlog considering their WSJF scores as a baseline. The feature at the top of the backlog assumes higher priority, while the feature at the bottom assumes lower priority.

1. Navigate to Scaled Agile Framework (SAFe) > SAFe Board.  
2. From the choice list at the top left corner, select the level as ART.  
3. Click the Backlog tab.  
4. To add a feature to the bottom of the backlog, click Create Feature.  
   You can select an existing feature in the backlog and click Create Feature. This action adds a new feature beneath the feature that you selected in the backlog.  
5. To update a feature, click the feature and edit the details in the feature form.  
6. Use the search box to search for features by their short descriptions using a key word.  
7. The Features by SAFe epic section lists epics that are assigned to your agile release train (ART). It does not list epics that do not contain features. A maximum of 10 epics are displayed in this section. Select an epic. Only features that belong to this epic appear in the Backlog section.  
8. To add an epic to the Features by SAFe epic section:  
   a) Click the Create Feature list.  
   b) Click Create Epic.  
   c) Specify the required details in the form and click Submit.  
9. To arrange features within the backlog, use either of the following options:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drag and drop</td>
<td>Select a feature and drag it to the required position.</td>
</tr>
</tbody>
</table>
Using the keyboard

To arrange a feature:

a. Press the Tab key.

b. After the desired feature is highlighted, press the Tab key.

c. After the icon is highlighted, press the Enter key.

d. After the icon appears, use the up and down arrow keys.

e. To fix the position of the feature, press the Enter key.

If the backlog contains more than 50 stories, then a pagination control appears at the bottom of the list enabling you to navigate to the first, last, previous, or next page in the list.

10. To view records in a standard list, click.

11. To personalize columns in a list, click

12. To perform any action on a set of features:

   - Select the required features.
   - Click

   and select any of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to top</td>
<td>Features are placed at the top of the program increment.</td>
</tr>
<tr>
<td>Move to bottom</td>
<td>Features are placed at the bottom of the program increment.</td>
</tr>
<tr>
<td>Agile Release Train</td>
<td>From the Agile Release Trains list, select the Agile Release Train to which you want to assign features.</td>
</tr>
<tr>
<td>SAFe Epic</td>
<td>From the SAFe Epics list, select the epic to which the features belong.</td>
</tr>
<tr>
<td>Program Increment</td>
<td>From the Program Increments list, select the program increment during which the features are scheduled for completion.</td>
</tr>
</tbody>
</table>

Schedule features for your program increments

Define a program increment (PI) and plan the features scheduled for completion within that PI.

Role required: safe_art_user or safe_admin
• Create features for PIs.
• View current and future program increments either in a list view or on a Visual Task Board (VTB).
• Assess features in the backlog and move them to a PI.

Use the SAFe program list view
Use the SAFe program list view to create, organize, track, start, and complete your program increments (PIs).

1. Navigate to Scaled Agile Framework (SAFe) > SAFe Board.
2. From the list at the top-left corner, select the level as ART and select your ART.
3. Click the Backlog tab.
4. Select the List view.
5. To create a PI, click Create Program Increment.
   Fill the required fields in the PI form.
6. To schedule a feature, drag the feature in the Backlog section and drop it in the required PI.
7. To personalise and view columns on a list, click ↗.
8. To start the first PI, click Start that appears in its section.
   The Planning tab opens.
9. To complete a PI, click Complete that appears in its section.
   A dialog box appears to indicate the number of completed and incomplete stories, features, and sprints. Move incomplete features to a future program increment, or mark features and remaining sprints as Complete.

Use the SAFe program roadmap view
Use the SAFe program roadmap view to track program increments (PIs) of your agile release train (ART) and plan features for future PIs.

Role required: safe_admin or safe_art_user

1. Navigate to Scaled Agile Framework (SAFe) > SAFe Board.
2. From the list at the top-left corner, select the level as ART and choose your ART.
3. Click the Backlog tab.
4. Select the Roadmap view.
5. Schedule a feature by dragging the feature from the No Program increment lane and drop it in the required program increment lane.
   You can reschedule features from one PI lane into the other by rearranging the feature cards.
6. Add a feature directly to a PI lane by clicking Add Card at the bottom of the list in the lane.
   You can also click the more options icon ^ and click Add card.
7. Hide a PI lane by clicking the more options icon

... and click Hide lane.

Plan your program increments using the SAFe planning board

Plan your SAFe program increments (PIs) and track the progress of stories and features in an interactive planning board. Using the planning board, you can create and assign stories to teams, add and view story dependencies, track stories by sprints, and replan these stories if required.

One of the following roles is required:

• safe_scrum_user to view the Planning tab
• safe_story_creator to create stories

1. Navigate to Scaled Agile Framework (SAFe) > SAFe Board.
2. Click Planning.
3. From the list on the top-left of the screen, select ART and select your agile release train.
4. From the PI list, select a PI.

You can adjust the view of the planning board by using the zoom in (+) and zoom out (−) icons.
5. Plan stories of the PI for your agile release train (ART).
   a) Select the Stories tab.
   b) Click the feature backlog icon ( ).

   From the feature backlog, you can view the list of features for the selected PI. From this list, you can also see the number of active but unplanned and unassigned stories for these features.

   The Backlog column on the planning board displays the stories that are assigned to the team but not to any sprint.

c) Assign a story to a team by dragging the story card from the backlog pane and dropping it in the required sprint or in the Backlog column of the team.

   Tip: Plan a sprint efficiently by referring to the workload capacity bar, under the sprint name, which indicates the workload planned for the team versus the team's capacity for that sprint. Hovering your cursor over the sprint name gives you additional details.

d) Optional: Add a new story for this feature by clicking Create Story in the backlog pane.

e) Add dependencies between the planned stories.

   Dependencies that you add between stories automatically apply to the features of the stories.

   Click the dependencies icon ( ) to show or hide dependencies between the stories.

   • If the dependencies are between two stories that are present on the board, you can see dependency lines between them. The colour of the dependency lines indicate the way you've scheduled the stories.
     - Green: A prerequisite story is scheduled in a sprint prior to that of its dependent story.
     - Yellow: A prerequisite story is scheduled in the same sprint as its dependent story.
• Red: A prerequisite story is scheduled in a sprint after its dependent story. Review the dependency and reschedule the story as required.

• If the dependencies are between two stories of which one is not present on the board, you can see a coloured border on the story card.
  • Border on the left of the story card indicates that it has a prerequisite story associated with it.
  • Border on the right of the story card indicates that it has a dependent story associated with it.

• If none of the stories have a prerequisite or dependent story associated with them, the dependencies icon is not visible.

For more information on how to add dependencies between stories, see Add dependencies to your SAFe stories.

6. Filter the stories on the PI planning board by a feature to focus on the planning of only that feature.
   a) From the Feature list, select a feature.

   The feature backlog ( ) shows only stories of the selected feature.

7. Update the group capacity of a team's sprint by clicking the sprint name.

   Group capacity is the projected capacity of the group, in story points, for each sprint. If the group capacity of a sprint is zero, you can't view the details of the sprint load and capacity.

   ![](image)

   Note: You can update the sprint details only with the safe_scrum_master role.

8. Track the progress of features of the PI from the Features tab.

9. Filter records on the planning board by entering the keyword in the Search field and press the Enter key.

10. Optional: View records in a standard platform list by clicking the standard list icon.

SAFe Board — Team level

As a team member, you can plan and monitor activities within your team by accessing the Team level on the SAFe Board.

The Team level includes the following tabs:

• Backlog
• Sprint Tracking

Backlog

The Backlog tab enables you to plan and prioritize stories for a sprint or multiple sprints by assessing stories in the backlog.

In addition, you can:

• Create stories.
• Reorder stories in the backlog using the drag feature. The story at the top of the backlog assumes higher priority with a lesser rank value. The story at the bottom of the backlog assumes lower priority with a higher rank value.
• Filter stories by a feature.
• Type a keyword in the search box to view only stories whose details match with the keyword.
• Create, organize, monitor, start, and complete sprints.
• View current and future sprints in chronological order.
• View these key aspects of a sprint: planned start and end dates, number of story points (total, complete, and pending) for the current sprint.
• Assess stories in the backlog and drag them to sprints.
• Move unfinished stories from the completed sprint to the backlog or a future sprint.

**Note:** To see the backlog of your team on SAFe Board, ensure that your team is:
• Of the group type SAFe Team, with the role safe_scrum_user assigned to the team members
• Added to Agile Release Trains
<table>
<thead>
<tr>
<th>Number</th>
<th>Short Description</th>
<th>Feature</th>
<th>Points</th>
</tr>
</thead>
<tbody>
<tr>
<td>SFSTRY001183</td>
<td>Validate CC info is correct</td>
<td></td>
<td>3</td>
</tr>
<tr>
<td>SFSTRY001128</td>
<td>Persist user's searched cities</td>
<td></td>
<td>3</td>
</tr>
<tr>
<td>SFSTRY001166</td>
<td>Validate City is valid</td>
<td></td>
<td>3</td>
</tr>
<tr>
<td>SFSTRY001124</td>
<td>Validate AAA discount code</td>
<td></td>
<td>3</td>
</tr>
</tbody>
</table>
Sprint Tracking

The Sprint Tracking tab provides the following views:

Story board

Story board is built on visual task boards, which transform the navigation of lists and forms into an interactive graphical experience. The visual task board interface provides a graphic-rich environment suited for managing and collaborating records. To know more about the actions that can be performed in the board, see visual task boards. In addition, you can:

- Track all the stories of the current sprint across lanes.
- Move stories from one lane to another, which in turn updates the state of the stories.
- Filter stories based on search criteria.

Task board

Task board enables you to track all the scrum tasks of stories of the current sprint across lanes.

- Move scrum tasks from one lane to another, which in turn updates the state of the scrum tasks.
• Filter scrum tasks based on search criteria.

List

List displays scrum tasks and tests associated to stories in each sprint. You can:

• Add scrum task and tests without leaving the context of the record.
• View the state, short description, and assignee of the scrum task without drilling down into details.
• View the short description and run result of a test.
• Assess scrum tasks and tests that are pending before the closure of current sprint.
Manage your team backlog

Manage, evaluate, prioritize, and sequence stories in your team backlog.

- Role required: scrum_product_owner, scrum_master, safe_product_owner, or safe_scrum_master
- Program, to which the team belongs, must contain an active program increment.
- The tab displays only the sprints of the current program increment.

1. Navigate to Scaled Agile Framework (SAFe) > SAFe Board.
2. From the choice list at the top-left corner, select the level as Team.
3. Select the Backlog tab.
4. To add a story to the backlog:
   a) Click Create Story.
   b) Specify the required details in the story form and click Submit. The story appears at the bottom of the backlog.

5. To add a story to the backlog and simultaneously decide its order of implementation, perform these steps:
   a) Select a story in the backlog.
   b) Click Create Story.
   c) Specify the required details in the story form and click Submit.
      The story is created beneath the story that was selected in the backlog.

6. The Records by SAFe feature section lists features that the records of the backlog belong to.
   Select a feature. Only records that belong to this feature appear.

7. To open the triage board of a specific task type (such as problems or defects), view the total numbers of records in the triage boards of all task types, edit the filter definition of a triage board, or create another triage definition, click Triage Board.

Note: Triage Board link is displayed only when the Agile — Scaled Agile Framework — Unified Backlog plugin (com.snc.sdlc.safe.multi_task) is installed.
8. To view records in a standard platform list, click

9. To personalize columns in a list, click

10. To move a triaged record from the Backlog tab to Triage Board:
    a. Open the record in a form.
    b. Click the **Move back to triage board** related link.

11. The Backlog section lists active stories assigned to the team, but not assigned to any sprint. Use either of the following options to arrange stories:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the drag feature</td>
<td>This option can be used to move stories within the backlog, move stories from the backlog to any sprint, or move stories from one sprint to another. Point to a story in the backlog and drag it to the required location.</td>
</tr>
<tr>
<td>Using the keyboard</td>
<td>This option can be used to move stories only within a backlog or a sprint. See Arrange stories using the keyboard.</td>
</tr>
</tbody>
</table>

12. To perform an action on a set of stories:
    - Select the required stories.
    - Click
    - and select any of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to top</td>
<td>Stories are placed at the top of the sprint.</td>
</tr>
<tr>
<td>Move to bottom</td>
<td>Stories are placed at the bottom of the sprint.</td>
</tr>
<tr>
<td>Feature</td>
<td>From the SAFe Features list, select the feature to which the stories belong.</td>
</tr>
<tr>
<td>Sprint</td>
<td>From the Sprints list, select the sprint in which the stories are scheduled for completion.</td>
</tr>
<tr>
<td>SAFe Team</td>
<td>From the Groups list, select the team to which you want to assign the stories.</td>
</tr>
</tbody>
</table>

**Perform sprint planning**
Perform sprint planning by evaluating stories in the backlog, selecting stories for the sprint, and estimating work effort for the stories.

Role required: scrum_master

The tab displays only the sprints of the *current* program increment.

In SAFe, the main portion of sprint planning occurs during the Big Room Planning process. The team backlog and the sprint planning portion of it is designed for refinement sessions. Though the overall plan
of each sprint of a program increment already exists, the team still has sprint planning sessions every two weeks to add any missing stories and adjust the initial plan.

1. Navigate to **Scaled Agile Framework (SAFe) > SAFe Board.**
2. From the choice list at the top left corner, select the level as **Team.**
3. Select the **Backlog** tab.
4. To add a story to the sprint and simultaneously decide its order of implementation, perform these steps:
   a) Point to a story in the sprint.
   b) Click **Create Story.**
   c) Specify the required details in the story form and click **Submit.**
      The story is created beneath the story that was selected in the backlog or a sprint.

5. To personalize columns in a list, click

6. To start a sprint, click **Start** that appears at right corner of the first or top sprint.
7. To complete a sprint, click **Complete Sprint** that appears at right corner of the first or top sprint.
   A dialog box appears indicating the number of completed and incomplete stories in the sprint. Move incomplete stories, if any, to the backlog or a future sprint. Click **Complete.**

**Track your SAFe tasks from the Board view**

Track the progress of your SAFe stories and scrum tasks. View their transition from one state (lane) to another in a visual task board.

Role required: safe_scrum_user or safe_admin

1. Navigate to **Scaled Agile Framework (SAFe) > SAFe Board.**
2. From the list at the top-left corner, select the level as **Team.**
3. Click the **Sprint Tracking** tab.
4. To track the progress of stories of the current sprint, select the **Story board** view.
   a. To change the state of a story, move the story from one lane to another.
   b. To add a story to a specific lane:
      1. Click **Add Task.**
      2. In the form, fill in the fields.
      3. Click **Submit.**

5. To track the progress of scrum tasks of stories of the current sprint, select the **Task board** view.
   a. To change the state of a scrum task, move the scrum task from one lane to another.
   b. To add a scrum task to a specific lane:
      1. Click **Add Task.**
      2. In the form, fill in the fields.
      3. Click **Submit.**
Track your SAFe team work from the list view

Create, execute, track, and complete the scrum tasks and tests of a SAFe story from the list view.

Role required: safe_scrum_user or safe_admin

1. Navigate to Scaled Agile Framework (SAFe) > SAFe Board.
2. From the list at the top left corner, select the level as Team.
3. From the adjacent list, select the required team value.
4. Click the Sprint Tracking tab, and select the List view.
5. To breakdown a story into scrum tasks:
   a. From the Show list at the top right corner, select Scrum Tasks.
   b. Click Add Scrum Task.
   c. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>System generated number for the SAFe story.</td>
</tr>
<tr>
<td>SAFe story</td>
<td>SAFe story that is associated with the scrum task.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority set for the scrum task.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of effort required to complete the scrum task.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the scrum task. Denotes the progress of the scrum task.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User to whom the scrum task is assigned.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the scrum task.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the scrum task.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Work notes indicating the progress of the scrum task at various stages in its life cycle.</td>
</tr>
</tbody>
</table>

d. Click Submit.

6. To create a test for a SAFe story:

   Note: The option to create a test is available only when Test Management 2.0 is installed.

   a. From the Show list at the top-right corner, select Tests.
   b. Click Add Test. For more information, see Create a test for a SAFe story.

7. To run tests that are in the Ready state for a SAFe story:
   a. Click the Run button on a story.
   b. In the pop-up, select the environment on which the tests are to be run, and click Run. For more information, see Run a test for a SAFe story.
8. To personalize columns in a list, click

Create a test for a SAFe story
Create a test, add steps to the test, and create and maintain different versions of the test. A test is a collection of conditions or steps used to determine whether a SAFe story is working correctly. A test can also include an expected result that determines whether the test passes or fails.

- Role required: safe_scrum_user or safe_admin
- You can create a test from the List view only when the Test Management 2.0 plugin is installed.

1. Navigate to Scaled Agile Framework (SAFe) > SAFe Board.
2. From the list at the top left corner, select the level as Team.
3. From the adjacent list, select the required team value.
4. Click the Sprint Tracking tab, and select the List view.
5. From the Show list at the top right corner, select Tests.
6. Click Add Test.
7. In the form, fill in the fields:

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test</td>
<td>Unique name of the test.</td>
</tr>
<tr>
<td>Owner</td>
<td>Owner who created the test.</td>
</tr>
<tr>
<td>Version</td>
<td>Automatically generated version of the test.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the test.</td>
</tr>
<tr>
<td></td>
<td>- Draft: State of the test when it is created.</td>
</tr>
<tr>
<td></td>
<td>- Ready: State of the test when it is not editable. When the test has multiple versions, only one test will be in the Ready state at any one time.</td>
</tr>
<tr>
<td></td>
<td>- Retired: State of the test when it is no longer used.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description about the test.</td>
</tr>
<tr>
<td>Add Step</td>
<td>Button used to add step to a test.</td>
</tr>
<tr>
<td>Run</td>
<td>Button used to run steps, which is displayed only when the test is in the Ready state.</td>
</tr>
<tr>
<td>Update</td>
<td>Button used to update the details of a test version.</td>
</tr>
<tr>
<td>Ready</td>
<td>Button used to change the state of the test version to ready.</td>
</tr>
<tr>
<td>Create New Version</td>
<td>Button used to create another version of the test.</td>
</tr>
<tr>
<td>Delete Test</td>
<td>Button used to delete the test version.</td>
</tr>
</tbody>
</table>

Icon used to change the order of a test step. Select the icon and drag a step to the required location.
View information in the following related lists:

<table>
<thead>
<tr>
<th>Related list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other versions</td>
<td>Displays all the versions of a test.</td>
</tr>
<tr>
<td>Test Results</td>
<td>Displays the run results of each test version.</td>
</tr>
<tr>
<td>Test Sets</td>
<td>Displays related tests in a test set.</td>
</tr>
</tbody>
</table>

**Run a test for a SAFe story**

View the test scenario and execute all the steps of a test for verifying a SAFe story.

Role required: safe_scrum_user or safe_admin

1. Navigate to [Scaled Agile Framework (SAFe) > SAFe Board].
2. From the list at the top left corner, select the level as [Team].
3. From the adjacent list, select the required team value.
4. Click the [Sprint Tracking] tab, and select the [List] view.
5. From the list, select [Tests].
6. Verify a story by running all of its tests at one time. Click the [Run] button on a story.
7. In the pop-up, select the environment on which the test has to be run.
8. In the Test Execution pop-up, mark a step as passed, failed, or blocked using the following icons:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Passed" /></td>
<td>Passed.</td>
</tr>
<tr>
<td><img src="image" alt="Failed" /></td>
<td>Failed. In this state, options to add comments and attachments are available. Option to delete attachments is also available.</td>
</tr>
<tr>
<td><img src="image" alt="Blocked" /></td>
<td>Blocked. In this state, options to add comments and attachments are available. Option to delete attachments is also available.</td>
</tr>
</tbody>
</table>

**Note**: If a test step is blocked, you will not be able to proceed and verify the remaining steps of the test.

- To select an icon, you can also press **Tab** and then press **Enter**.
- To pause and work on the test at a later point in time, click **Pause**.

9. Click **Done**.

The test result is saved to the Test Result form. The latest test result of each test is displayed in the List view.
The overall status of the test is defined by statuses of the test steps:

- If all the test steps are passed, the status of the test is **Passed**.
- If at least one step of the test is not run, the status of the test is **Not finished**.
- If at least one step of the test fails, the status of the test is **Failed**. This rule takes precedence over the previous rule.
- If at least one step of the test is blocked, the status of the test is **Blocked**. This rule takes precedence over the previous two rules.

**Troubleshoot test failures**
View the history of test runs. Troubleshoot and rectify the test failures in SAFe.

Role required: safe_scrum_user or safe_admin

1. Navigate to **Scaled Agile Framework (SAFe) > SAFe Board**.
2. From the list at the top left corner, select the level as **Team**.
3. Click the **Sprint Tracking** tab and select the **List** view.
4. Click a test within a story.
5. Click the **Test Result** related list.
   Test results related to that version of the test are displayed.
6. Click a test result to view its details in a form.

**Test Result form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Automatically generated number for the test result.</td>
</tr>
<tr>
<td>Result</td>
<td>Run status of the test: <strong>Passed</strong>, <strong>Failed</strong>, or <strong>Blocked</strong>.</td>
</tr>
<tr>
<td>Execution environment</td>
<td>Environment on which the test is run.</td>
</tr>
<tr>
<td>Run by</td>
<td>Name of the tester who runs the test plan.</td>
</tr>
<tr>
<td>Test</td>
<td>Test that is run.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the test that is run.</td>
</tr>
<tr>
<td>Updated</td>
<td>Date and time when the test result was recorded.</td>
</tr>
<tr>
<td>Test run</td>
<td>Name of the test run.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the test result.</td>
</tr>
</tbody>
</table>

The execution status of each step of the test is also indicated at the bottom of the form.

**Portfolio SAFe**

With Portfolio SAFe, you can align your organizational goals and strategies with your portfolios, and apply lean and agile principles to seamlessly manage and deliver your portfolio work.

Portfolio SAFe works at three levels for portfolio managers, product managers, and team members. At the Portfolio level, portfolio managers can capture and prioritize epics in a centralized backlog, and monitor the progress of epics in a visual task board. An epic is the largest unit of work that has one common objective such as a customer request or business requirement.
At the ART level, product managers can capture, prioritize, and monitor features that are decomposed from epics. At the Team level, team members can implement stories that are decomposed from features. To learn more about the levels, see the SAFe Board section below.

To start using the features of Portfolio SAFe, install the Agile - Scaled Agile Framework - Portfolio SAFe plugin (com.snc.sdnc.portfolio_safe).
SAFe Board

The table below provides an overview of how you can access the key levels of Portfolio SAFe on SAFe Board.

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Portfolio</strong></td>
<td>As a portfolio manager, you can plan and monitor activities within a portfolio by accessing the <strong>Portfolio</strong> level on the <strong>Scaled Agile Framework (SAFe) &gt; SAFe Board</strong>. In addition, you can:</td>
</tr>
<tr>
<td></td>
<td>• manage the portfolio backlog in a centralized location.</td>
</tr>
<tr>
<td></td>
<td>• track all the epics of the portfolio and view their transition from one state (lane) to another, in a visual task board.</td>
</tr>
<tr>
<td><strong>Agile Release Train (ART)</strong></td>
<td>As a product manager, you can plan and monitor activities across teams within an ART by accessing the <strong>ART</strong> level on the <strong>Scaled Agile Framework (SAFe) &gt; SAFe Board</strong>. In addition, you can:</td>
</tr>
<tr>
<td></td>
<td>• manage the ART backlog in a centralized location.</td>
</tr>
<tr>
<td></td>
<td>• define a program increment and identify the features to be completed within that program increment.</td>
</tr>
<tr>
<td></td>
<td>• perform big room planning.</td>
</tr>
<tr>
<td></td>
<td>• track all the features of the ART and view their transition from one state (lane) to another, in a visual task board.</td>
</tr>
<tr>
<td><strong>Team</strong></td>
<td>As a team member, you can plan and monitor activities within the team by accessing the <strong>Team</strong> level on the <strong>Scaled Agile Framework (SAFe) &gt; SAFe Board</strong>. In addition you can:</td>
</tr>
<tr>
<td></td>
<td>• manage the team backlog in a centralized location.</td>
</tr>
<tr>
<td></td>
<td>• streamline sprint planning and completion activities.</td>
</tr>
<tr>
<td></td>
<td>• track all stories and view their transition from one state (lane) to another, in a visual task board.</td>
</tr>
</tbody>
</table>

Activate Portfolio SAFe

Activate the Agile - Scaled Agile Framework - Portfolio SAFe plugin (com.snc.sdlc.portfolio_safe) if you have the admin role.

Role required: admin

**Note:** When you install the Agile - Scaled Agile Framework - Portfolio SAFe plugin, the Agile - Scaled Agile Framework - Essential SAFe plugin (com.snc.sdlc.safe) is automatically installed.

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Components installed with Portfolio SAFE

Several types of components are installed with activation of the Agile - Scaled Agile Framework - Portfolio SAFE plugin (com.snc.sdlc.portfolio_safe), including tables and user roles.

Roles installed

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| SAFe admin [safe_admin]     | • Edits, creates, and deletes SAFe ART, epics, features, stories, and program increments.  
                                 • Has read-only access to SAFe teams. | • safe_art_user  
                                 • safe_scrum_master 
                                 • safe_product_owner |
| SAFe portfolio user [sn_portfolio_safe.safe_portfolio_user] | Maintains the portfolio backlog and can edit, create, and delete SAFe epics, features, and stories. | safe_art_user |
| SAFe scrum product owner [safe_product_owner] | • Maintains the team backlog and can edit, create, and delete SAFe stories.  
                                 • Has read-only access to SAFe ART, teams, epics, and features.  
                                 • Has read-only access to SAFe program increments. | safe_story_creator |
| SAFe ART user [safe_art_user] | • Maintains the ART backlog and can edit, create, and delete SAFe epics, features, stories, and program increments.  
                                 • Edits SAFe teams.  
                                 • Has read-only access to SAFe ART. | safe_story_creator |
<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| SAFe scrum master [safe_scrum_master] | • Edits, and deletes SAFe stories.  
• Edits SAFe teams.  
• Has read-only access to SAFe ART, epics, features, and program increments. | safe_story_creator              |
| SAFe scrum user [safe_scrum_user] | Can view all elements of SAFe, but cannot create, edit, or manage records of any type. | None                            |
| SAFe scrum story creator [safe_story_creator] | • Edits, creates, and deletes SAFe stories.  
• Has read-only access to SAFe ART, teams, epics, features, and program increments. | safe_story_editor               |
| SAFe scrum story editor [safe_story_editor] | • Arranges stories within the team backlog using the drag and drop feature.  
• Edits SAFe stories.  
• Has read-only access to SAFe ART, teams, epics, features, and program increments. | safe_scrum_user, rm_scrum_task_admin |

### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAFe epic [sn_safe_epic]</td>
<td>Information about epics.</td>
</tr>
<tr>
<td>SAFe feature [sn_safe_feature]</td>
<td>Information about features.</td>
</tr>
<tr>
<td>Agile Release Train [sn_safe_program]</td>
<td>Information about ART.</td>
</tr>
<tr>
<td>Program Increment [sn_safe_program_increment]</td>
<td>Information about program increments.</td>
</tr>
<tr>
<td>SAFe ART team [sn_safe_program_m2m_group]</td>
<td>Relationships between groups and ART.</td>
</tr>
<tr>
<td>SAFe ART Member [sn_safe_program_member]</td>
<td>Information about members within an ART.</td>
</tr>
</tbody>
</table>
Define a portfolio

From SAFe, define a portfolio which is a group of ARTs working towards a single solution.

Role required: sn_portfolio_safe.safe_portfolio_user

1. Navigate to **Scaled Agile Framework (SAFe) > Portfolios.**
2. Click **New.**
3. In the form, fill in the fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the portfolio.</td>
</tr>
<tr>
<td>Portfolio manager</td>
<td>Manager to whom the portfolio is assigned.</td>
</tr>
<tr>
<td>Description</td>
<td>More detailed description of the portfolio.</td>
</tr>
</tbody>
</table>

- Define an Agile Release Train
- Define an epic in SAFe
SAFe Board—Portfolio level

As a portfolio manager, you can plan and monitor activities within your portfolio by accessing the Portfolio level on the SAFe Board.

The Portfolio level includes the following tabs:

• Board
• Backlog

Board

The Board tab enables you to track all the epics of your portfolio in a single view. Board is built on visual task boards, which transform the navigation of lists and forms into an interactive graphical experience. The visual task board interface provides a graphic-rich environment for managing and collaborating.

In addition, you can move an epic from one lane to another, which in turn updates the state of the epic. To learn more about the actions that can be performed in the board, see visual task boards.

Backlog

The Backlog tab enables you to manage your portfolio backlog, which comprises epics.
Track your epics

Using the Board tab, track all epics of your portfolio and view their transition from one state (lane) to another.

Role required: sn_portfolio_safe.safe_portfolio_user

1. Navigate to Scaled Agile Framework (SAFe) > SAFe Board.
2. From the choice list at the top left corner, select the level as Portfolio.
3. Select the Board view.
4. Move an epic to the required state by dragging and dropping the epic card.
5. Optional: Add an epic to a specific state:
   a) Click Add Card.
   b) On the form, fill in the fields and submit it. For more information on epic fields, see Define an epic in SAFe.

Manage your portfolio backlog

Manage, evaluate, prioritize, and sequence epics in your portfolio backlog.

Role required: sn_portfolio_safe.safe_portfolio_user

1. Navigate to Scaled Agile Framework (SAFe) > SAFe Board.
2. From the choice list at the top left corner, select the level as Portfolio.
3. Click the Backlog tab.
4. To add an epic at the bottom of the backlog:
   a) Click Create Epic.
b) Specify the required details in the form and click Submit.

5. To add an epic while simultaneously deciding its order of implementation in the backlog:
   a) Select an epic in the backlog.
   b) Click Create Epic.
   c) Specify the required details in the form and click Submit.
      The epic is created beneath the epic that was selected in the backlog.

6. To search for epics by their short descriptions, type a word in the search box and press Enter.

7. The Backlog section lists all active epics. To arrange epics within the backlog, use either of the following options:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the drag feature</td>
<td>Point to an epic and drag it to the required position.</td>
</tr>
<tr>
<td>Using the keyboard</td>
<td></td>
</tr>
<tr>
<td>a. Press the Tab key.</td>
<td></td>
</tr>
<tr>
<td>b. After the desired epic is highlighted, press the Tab key.</td>
<td></td>
</tr>
<tr>
<td>c. After the icon is highlighted, press the Enter key.</td>
<td></td>
</tr>
<tr>
<td>d. After the icon appears, use the up and down arrow keys.</td>
<td></td>
</tr>
<tr>
<td>e. To fix the position of the epic, press the Enter key.</td>
<td></td>
</tr>
</tbody>
</table>

If the backlog contains more than 50 epics, then a pagination control appears at the bottom of the list enabling you to navigate to the first, last, previous, or next page in the list.

8. To view the backlog as a standard platform list, click View Standard List.

9. To perform any action on a set of epics:
   • Select the required epics.
   • Click
     ✰✰✰✰✰

     and select any of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to top</td>
<td>Epics are placed at the top of the backlog section.</td>
</tr>
<tr>
<td>Move to bottom</td>
<td>Epics are placed at the bottom of the backlog section.</td>
</tr>
</tbody>
</table>

SAFe — Unified Backlog

SAFe — Unified Backlog allows you to maintain a centralized backlog containing records of different task types, such as defects, problems, incident tasks, and stories. It facilitates in prioritizing and sequencing
different task type records in one location, saving you steps. It also removes the overhead of converting records to stories.

The flow described below represents the common practice of creating and managing records using SAFe — Unified Backlog along with Essential SAFe.

**Setting up a triage board**

You can set up a triage board by defining filter criteria, and view records of a specific task type on the triage board. For example, you can create one triage board for defects and another for incidents. Records are dynamically updated in all triage boards.

**Triaging and assigning records**

You can move records from a triage board to the Backlog tab. In the Backlog tab, you can estimate points and assign the record to a user using the Points, and Assignment fields in the Story Information tab of the record. You can open the triage board of any specific task type, view the total numbers of records in the triage boards of all task types, or edit the filter definition of a specific triage board.

**Working with the triaged records in the Board view**

As you work with stories, work with the triaged records (represented by stories) in the Sprint Tracking tab, Board view. When you move a triaged record from one lane to another, the state of its wrapper story changes, but the state of the original triaged record remains the same. To change the state of the original triaged record, you would need to open the record in a form and update the state.

**Activate SAFe — Unified Backlog**

You can activate the Agile — Scaled Agile Framework — Unified Backlog plugin (com.snc.sdli.safe.multi_task) if you have the admin role.

Agile - Scaled Agile Framework — Unified Backlog activates these related plugins if they are not already active.

### Plugins for Agile - Scaled Agile Framework — Unified Backlog

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agile - Scaled Agile Framework - Essential SAFe [com.snc.sdli.safe]</td>
<td>Enables you to apply lean and agile principles to your Agile Release Trains and teams, and develop and deliver work with fewer defects in the shortest viable lead time.</td>
</tr>
</tbody>
</table>

1. **Navigate to** System Applications > All Available Applications > All.
2. **Find the plugin using the filter criteria and search bar.**
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. **Click Install**, and then in the Activate Plugin dialog box, click Activate.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.
Set up a triage board in SAFe

Set up your own triage board by defining filter criteria, and view records that are important to your team, such as problems, incident tasks, defects, or change requests. For example, you can create one triage board for defects and another for incidents.

Role required: safe_admin

1. Navigate to Scaled Agile Framework (SAFe) > SAFe Board.
2. Select the Backlog tab.
3. Select Triage Board.
4. On the form, fill in the fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Suitable name for the triage board.</td>
</tr>
<tr>
<td>Table</td>
<td>Table from which you want to filter records.</td>
</tr>
<tr>
<td>Filter</td>
<td>Filter criteria to be applied on the table for refinement of records.</td>
</tr>
</tbody>
</table>

**Note:** When setting up a triage board, do not to remove these default conditions:

- **Active is true**: This condition ensures that the tasks on your Triage Board are relevant.
- **Agile story is empty**: This condition ensures that the task is not present in some other backlog.

5. Click Submit.
   A triage definition is created.

1. Select the triage definition.
2. To add a record to the triage definition, click New.
3. To move a record from the triage board to the Backlog tab, click Add to Backlog.

Performance Analytics Content Pack for Essential SAFe

Improve your SAFe processes and practices using Performance Analytics Content Pack for Essential SAFe that contains preconfigured dashboards with data visualizations.

Enabling the Performance Analytics Solution

Use the Performance Analytics widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With solutions, you can get value from Performance Analytics for your application with minimal setup.

**Note:** Solutions include some dashboards that are inactive by default. You can activate these dashboards to make them visible to end users according to your business needs.
To use this Analytics and Reporting Solution, you must be entitled to use Performance Analytics with Essential SAFe. For more information about entitlements to Performance Analytics, see Activate your Performance Analytics subscription.

To enable the solution for Essential SAFe, an admin can navigate to Performance Analytics > Guided Setup. Click Get Started then scroll to the section for Performance Analytics Content Pack for Essential SAFe. The guided setup takes you through the entire setup and configuration process.

This Out-of-the-box Performance Analytics Solution is available from the ServiceNow Store. To enable this solution, an admin navigates to System Applications > Search ServiceNow Store. When the landing page for the ServiceNow Store opens, search for Performance Analytics Content Pack for Essential SAFe. When you have found the Solution, follow the instructions in the Store. The ServiceNow Store has its own documentation.

Install the Performance Analytics Content Pack for Essential SAFe

Install the Performance Analytics Content Pack for Essential SAFe application from the ServiceNow Store, and start using the dashboards for ARTs, PIs, epics, sprints, and teams.

- Activate the Essential SAFe (com.snc.sdlc.safe) plugin.
- Activate the Performance Analytics (com.snc.pa) plugin.

Role required: admin

Note:
- To verify that plugins and applications are installed and activated, navigate to Subscription Management > Subscriptions in your instance. The list displays the subscriptions your organization has purchased.
- Activation of the Essential SAFe and Performance Analytics plugins on production instances may require separate licenses. Contact SupportServiceNow for details.

1. Navigate to the ServiceNow® Store.
2. Search for Performance Analytics Content Pack for Essential SAFe.
3. Click the application tile.
   You can view detailed information about the application you are installing.

   Note: Consider reading the Other Requirements and Dependencies sections, as applicable.

4. Click Get and enter your Now Support login credentials.
5. Click Request Install.
6. In the Instance Name field, enter your details and click Validate Instance.
7. In the Reason for the Instance field, enter your details and click Request.
   You receive an email with detailed installation instructions.
8. Log in to the instance you want to install the Performance Analytics Content Pack for Essential SAFe application on.
10. Locate the application, select it, and click Install.

You can access the Essential SAFe dashboard from Sclaed Agile Framework (SAFe) > Dashboards. Start the [SAFe] Daily Data Collection job. For more information, see Enable daily data collection.
Enable daily data collection

Enable scheduled data collection to begin collecting scores on new data automatically. Data collection jobs automatically collect scores for automated indicators and breakdowns.

Role required: pa_admin or admin

Note: Historical data collection is not supported for the underlying indicators of the [SAFe] Daily Data Collection job.

1. Navigate to Performance Analytics > Data Collector > Jobs.
2. Find and open the [SAFe] Daily Data Collection job.
   a) Scroll down to the Job parameters section.
   b) Set the Run as field to pa_admin, pa_data_collector or admin roles.
   c) Verify that the time zone in the Run As tz field is appropriate for your organization.
      This timezone is used for the following:
      • Database queries created for this job
      • Indicator conditions such as [[Created][on][Today]]
   d) Enable the scheduled run of the job by selecting the Active checkbox.
4. Click Update.

Using Solution Library for Essential SAFe dashboards

Upgrade to the latest layout of Essential SAFe dashboards using Solution Library.

Existing users who upgraded to the latest version of Performance Analytics Content Pack for Essential SAFe can install the latest layout of the dashboards from Solution Library.

For example, if you are upgrading from version 1.0.1 or earlier of the application, install the following dashboards from Solution Library to access the latest layout:

• SAFe Feature Dashboard
• SAFe Epic Dashboard
• SAFe Sprint Dashboard
• SAFe PI Dashboard
• SAFe ART Dashboard
• SAFe Team Dashboard

For more information, see Use Solution Library to install a dashboard.

Note: For users on the Paris release, the Install and Upgrade buttons are not visible on the Solution Library content form. For information on resolving this issue, see Allow PA Solution Library for Store apps.
SAFe Feature Dashboard

The SAFe Feature Dashboard provides a visualization of the changes in scope and the progress of the stories in the feature over a given period.
### Feature Summary tab

<table>
<thead>
<tr>
<th>Stories</th>
<th>Scope</th>
<th>Stories Missing Estimates</th>
<th>Blocked Work</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>30</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>
Cycle Time tab

End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAFe ART user: View the amount of work that has been completed in a feature. Gauge whether the feature can be completed on time.</td>
<td>SAFe_scrum_user</td>
</tr>
</tbody>
</table>
Indicators

**SAFe: Sum of story points of all stories in the feature**
Generates the completed line in the Feature Burnup report.

**SAFe: Sum of story points of completed stories in feature**
Generates the scope line in the Feature Burnup report.

Widgets

**Stories**
Indicates the total number of stories in the feature.

**Scope**
Indicates the scope of the feature which is in story points. This widget lets you see at a glance how much work must be completed in a feature.

**Stories Missing Estimates**
Indicates the number of stories in the feature that are missing estimates.

**Blocked Work**
Indicates the amount of work (in story points) in the feature that is blocked.

Reports

If you are upgrading from version 1.0.2 or earlier of Performance Analytics Content Pack for Essential SAFe, then install this dashboard from Solution Library to upgrade its layout and access the following reports:
- Feature Burnup
- Story Cycle Time

For more information, see Using Solution Library for Agile 2.0 dashboards.

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stories By State</td>
<td>Bar</td>
<td>At a single glance, understand the overall progress of a feature seeing all of its stories grouped by state.</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Feature Burnup</td>
<td>Line</td>
<td>Indicates the scope changes, if any, and trends of those scope changes. You can estimate when the feature is likely to be completed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The Feature Burnup report comprises the following series that can be hidden or displayed based on your preference:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Scope</strong>: Indicates the size of the feature, as the sum of story points defined in this feature.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Scope Forecast</strong>: Predicts the possibility of scope change for the future dates, which is based on historical data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Completed</strong>: Indicates the amount of work (in story points) in the feature that is complete.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Completed Forecast</strong>: Predicts the burnup for the future dates. It indicates whether you can complete the feature on time. This prediction is based on historical data.</td>
</tr>
</tbody>
</table>

**Note**: The point at which the Completed Forecast series intersects with or crosses the Scope Forecast series is a predictor for when the feature might be completed. If the Completed Forecast series and the Scope Forecast series do not appear to ever intersect, it is a warning that scope is being added faster than work is being completed.
Identify the time taken for each story in the feature to move from an in-progress state to completion.

Each bubble on the graph represents a story. The height of the bubble from the x-axis shows how long that story took to move from an in-progress state to completion. The size of the story bubbles are relative to each other based on their story points.

Hovering your mouse cursor over a bubble displays the following details about that story:

- Story points
- Date on which the story is moved to completion
- Total cycle time (in days) of the story
- Number of days that the story was in the **Work in progress** state
- Number of days that the story was in the **Ready for testing** state
- Number of days that the story was in the **Testing** state

From the Story State section towards the right of the report, you can filter the report to view the cycle time of the stories for the selected states. The chart displays the cycle time for each story as the cumulative sum of all duration of the selected states.

If there are too many stories at any area of the chart and the bubbles appear crowded on the report, you can zoom in that particular area of the report for a clearer view.
You can customize the Burnup report. For more information, see Customizing Essential SAFe dashboard reports.
SAFe Epic Dashboard

The SAFe Epic Dashboard provides a visualization of how the features of an epic are progressing over a given period of time.
Cycle Time tab

The SAFe epic dashboard displays such as total number of features that are complete, and number of stories that are missing estimates. It also indicates the pace at which the ART members are completing the features in the epic.

End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAFe ART user: View the progress of every feature in the epic.</td>
<td>safe_scrum_user</td>
</tr>
</tbody>
</table>
Indicators

**SAFe: Sum of story points of all stories in epics**
Generates the scope series in the Epic Burnup report.

**SAFe: Sum of story points of completed stories in epics**
Generates the complete series in the Epic Burnup report. This series indicates the amount of work that has been completed in the epic.

**SAFe: Count of all stories in current epic**
Generates the area series the Epic Cumulative Flow Diagram report, which indicates the number of stories of the current epic by state.

Breakdowns

- SAFe: Epic
- SAFe: State

Widgets

**Features**
Indicates the total number of features in the epic.

**Features Released**
Indicates the number of features in the epic that have been completed.

**Stories Missing Estimates**
Indicates the number of stories in the epic that are missing estimates.

Reports

If you are upgrading from version 1.0.2 or earlier of Performance Analytics Content Pack for Essential SAFe, then install this dashboard from Solution Library to upgrade its layout and access the following reports:

- Epic Burnup
- Epic Cumulative Flow Diagram
- Story Cycle Time

For more information, see Using Solution Library for Agile 2.0 dashboards.
<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feature Progress</td>
<td>Horizontal bar</td>
<td>View the progress of every feature in an epic.</td>
</tr>
<tr>
<td>Epic Burnup</td>
<td>Line</td>
<td>Shows the epic burnup trends. You can estimate when the epic is likely to be completed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The Epic Burnup report comprises the following series that can be hidden or displayed based on your preference:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Scope</strong>: Indicates the size of the epic.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Scope Forecast</strong>: Predicts the possibility of scope change for the future dates, based on historical data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Completed</strong>: Indicates the amount of work in the epic that is complete.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Completed Forecast</strong>: Predicts the burnup for the future dates. It indicates whether you can complete the epic on time. This prediction is based on historical data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong>: The point at which the Completed Forecast series intersects with the Scope Forecast series is a predictor for when the epic might be completed. If the Completed Forecast series and the Scope Forecast series do not ever intersect, it is a warning that scope is being added faster than work is being completed.</td>
</tr>
<tr>
<td>Epic Cumulative Flow Diagram</td>
<td>Area</td>
<td>Monitor the progress of all the stories of your epic between its actual start and end dates. View the number of stories in each state by their arrival to a state, time in this state, and its departure from this state.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The Epic Cumulative Flow Diagram report comprises the following areas that can be hidden or displayed based on your preference:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Ready</strong>: Indicates the number of stories of the epic that are ready to start work on.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Work in Progress</strong>: Indicates the number of stories of the epic that are in development.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Ready for Testing</strong>: Indicates the number stories of the epic that are ready to be tested.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Testing</strong>: Indicates the number of stories of the epic that are currently being tested.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Complete</strong>: Indicates the number of stories that are complete.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong>: Stories in Ready and Cancelled states are not included in this report.</td>
</tr>
<tr>
<td>Cycle Time</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Story Cycle Time      | Bubble chart| Identify the time taken for each story in the epic to move from an in-progress state to completion. Each bubble on the graph represents a story. The height of the bubble represents how long that story took to move from an in-progress state to completion. The size of the story bubbles are relative to each other based on their story points. Hovering your mouse cursor over a bubble displays the following details:  
  - Story points  
  - Date on which the story is moved to completion  
  - Total cycle time (in days) of the story  
  - Number of days that the story was in the **Work in progress** state  
  - Number of days that the story was in the **Ready for testing** state  
  - Number of days that the story was in the **Testing** state  
From the Story State section towards the right of the report, you can filter the report to view the cycle time of the stories for the selected states. The chart displays the cycle time for each story as the cumulative sum of all duration of the selected states.  
If there are too many stories at any area of the chart and the bubbles appear crowded on the report, you can zoom in that particular area of the report for clearer view.  
You can customize the Burnup and Cumulative Flow Diagram reports. For more information, see [Customizing Essential SAFe dashboard reports](#).
SAFe Sprint Dashboard

Track the progress of your SAFe stories in the current sprint and forecast sprint completion using the Sprint Dashboard.

The dashboard:

- Displays important details of the sprint such as percentage of work that is complete, time elapsed, and total number of stories that are missing estimates.
- Displays the number of stories of the sprint in their current state and their progress.
- Indicates the scope changes, if any, and trends of those scope changes.
- Indicates how the team needs to progress on stories to achieve the sprint goal.
• Forecasts data showing the likelihood of completing the sprint as planned.

**Note:** Canceled stories are not included in any of this data.

### End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
<th>Benefits</th>
</tr>
</thead>
</table>
| SAFe scrum master: Reviews the sprint burndown trends. Resolves any bottlenecks and targets to complete the sprint on time. | safe_scrum_user         | • Analyse the scope changes for the sprint  
• View current states and analyse the time in each state for the stories of the sprint  
• Estimate sprint completion dates |

### Indicators

**SAFe: Sum of story points of all stories in the current sprint**

Generates the scope series in the Sprint Burndown report. The scope series indicates the amount of work in story points that is planned for the sprint.

**SAFe: Sum of story points of active stories in the current sprint**

Generates the actual burndown series in the Sprint Burndown report. The actual burndown series indicates the amount of work left (in story points) for completion.

**SAFe: Sum of story points of completed stories in current sprint**

Generates the percentage of stories completed for the current sprint.

**SAFe: Time elapsed in sprint**

Calculates the time to be displayed in the Time Elapsed widget.

**SAFe: Count of stories in the current sprint**

Generates the area series in the Sprint Cumulative Flow Diagram report. It indicates the number of stories in the current sprint.

### Breakdowns

- SAFe: Sprint
- SAFe: Current Sprint
- SAFe: State
Widgets

Scope
Indicates the amount of work in story points that is planned for the sprint. This widget lets you see at a glance how much work must be completed to achieve the sprint goal. It also lets you drill down to detail on the stories planned into the sprint.

Percent Completed
Indicates the percentage of work that has been completed in the sprint using story points. This widget lets you see at a glance how much work has been completed in the sprint. Together with the adjacent Time Elapsed widget, these widgets let you easily see whether you are completing work at a rate consistent with achieving the sprint goal on schedule.

Time Elapsed
Indicates the percentage of time that has elapsed between the start date and planned end date of the sprint. Together with the adjacent Percent Completed widget, these widgets let you easily see whether you are completing work at a rate consistent with achieving the sprint goal on schedule.

Committed Points
Indicates the committed scope (in number of story points) of the sprint. Together with the adjacent Scope widget, these widgets let you see difference between the scope committed at the start of the sprint and the current scope of the sprint.

Note: This widget is not visible by default. You can add it from Reports to your dashboard. For more information, see Edit a responsive dashboard.

Blocked Work
Indicates the amount of work (in story points) in the sprint that is blocked.

Stories Missing Estimates
Indicates the total number of stories in the sprint that are missing estimates. It is required that you use estimates for the other indicators, widgets, and reports on this dashboard to be meaningful.

Note: If you do not estimate stories, enter a "1" in the Story Points field. The other indicators, widgets, and reports will then effectively function by count.

Reports
If you are upgrading from version 1.0.2 or earlier of Performance Analytics Content Pack for Essential SAFe, then install this dashboard from Solution Library to upgrade its layout and access the following reports:

- Sprint Burnup
- Sprint Cumulative Flow Diagram

For more information, see Using Solution Library for Agile 2.0 dashboards.
<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| Sprint Burndown | Line   | Indicates the scope changes, if any, and trends of those scope changes. Indicates the ideal pace of work, how much work is remaining, and if the scope is likely to be completed before the end of the sprint. The Sprint Burndown report comprises the following series that can be hidden or displayed based on your preference:  
  • **Scope**: Indicates the amount of work that is currently planned for the sprint. This can vary if stories are added to or removed from the sprint after it is started.  
  • **Scope Forecast**: Predicts the possibility of scope change for the future dates based on historical changes in the current sprint.  
  • **Ideal Burndown**: Indicates how the team needs to progress on stories to complete the sprint on time.  
  • **Remaining**: Indicates the amount of work left for completion in the sprint. If the actual burndown (Remaining) is above the ideal burndown, it implies that there is more work left than originally estimated. The team is running behind the schedule of the sprint. If the actual burndown (Remaining) is below the ideal burndown, it implies that there is less work left than originally estimated. The team is running ahead of the schedule of the sprint.  
  • **Remaining Forecast**: Predicts the burndown for the future dates based on historical changes in the current sprint. |
<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| Sprint Burnup | Line   | Shows the sprint burnup trend indicating scope changes. Forecasts future changes in scope and the trend of work completion. The Sprint Burnup report comprises the following series that can be hidden or displayed based on your preference:  
  - **Scope**: Indicates the amount of work that is planned for the sprint.  
  - **Scope Forecast**: Predicts the possibility of scope change for the future dates, which is based on historical data.  
  - **Completed**: Indicates the amount of work completed in the sprint.  
  - **Completed Forecast**: Predicts the burnup for the future dates. It indicates whether you can complete the sprint on time. The prediction is based on historical data. |
<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| Sprint Cumulative Flow Diagram | Area   | Monitor the progress of all the stories of your sprint between its actual start and end dates. View the number of stories in each state by their arrival to a state, time in this state, and its departure from this state. The Sprint Cumulative Flow Diagram report comprises the following areas that can be hidden or displayed based on your preference:  
  • **Ready**: Indicates the number of stories in the sprint that are ready to start work on.  
  • **Work in Progress**: Indicates the number of stories in the sprint that are in development.  
  • **Ready for Testing**: Indicates the number stories in the sprint that are ready to be tested.  
  • **Testing**: Indicates the number of stories in the sprint that are currently being tested.  
  • **Complete**: Indicates the number of stories in the sprint that are complete.  

**Note**: Stories in Ready and Cancelled states are not included in this report.  

You can customize the Burnup, Burndown, and Cumulative Flow Diagram reports. For more information, see [Customizing Essential SAFe dashboard reports](#).
SAFe Prior Sprint Dashboard

The SAFe Prior Sprint Dashboard provides data visualization on scope, actual burnup and burndown, and forecast trends of previous sprints. Analyze the data and plan the work for upcoming sprints.

Note: Canceled stories are not included in any of this data.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
<th>Benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAFe scrum master: Analyze data on scope, actual burnup and burndown, and forecast trends of previous sprints.</td>
<td>SAFe_scrum_user</td>
<td>• Analyze sprint burndown and burnup trends</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Use the data to plan for upcoming sprints</td>
</tr>
</tbody>
</table>

Indicators

**SAFe: Sum of story points of all stories in the current sprint**
Generates the scope series in the SAFe Sprint Burndown report.

**SAFe: Sum of story points of active stories in the current sprint**
Generates the actual burndown series in the SAFe Sprint Burndown report.

Breakdowns

- SAFe: Sprint
- SAFe: Prior Sprint

Widgets

**Committed points**
Indicates the committed scope (in number of story points) of the sprint.

**Stories**
Indicates the total number of stories that were completed in the previous sprint.

**Completed**
Indicates the amount of work (in story points) that was completed in the previous sprint.

**Stories Missing Estimates**
Indicates the total number of stories in the previous sprint that were missing estimates.

Reports

If you are upgrading from version 1.0.2 or earlier of Performance Analytics Content Pack for Essential SAFe, then install this dashboard from Solution Library to upgrade its layout and access the Sprint Burnup report. For more information, see Using Solution Library for Agile 2.0 dashboards.
<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sprint Burndown</td>
<td>Line</td>
<td>Shows the scope and rate of scope change, the ideal rate for work completion, and the actual rate of work completion. Analyze the burndown trends and accordingly plan the workload for an upcoming sprint.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The Sprint Burndown report comprises the following series that can be hidden or displayed based on your preference:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Scope</strong>: Indicates the amount of work that is planned for the sprint.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Ideal Burndown</strong>: Indicates how the team needs to progress on stories to complete the sprint on time.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Remaining</strong>: Indicates the amount of work left for completion in the sprint.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If Remaining is above the Ideal Burndown, it implies that there is more work left than originally estimated. The team is running behind the schedule of the sprint.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the Remaining is below Ideal Burndown, it implies that there is less work left than originally estimated. The team is running ahead of the schedule of the sprint.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Analyze the burndown trends and accordingly plan the workload for an upcoming sprint.</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Sprint Burnup | Line | Shows the previous sprint burnup trend indicating scope changes. Analyze future changes the trend of team’s work completion. The Sprint Burnup report comprises the following series that can be hidden or displayed based on your preference:  
  • **Scope**: Indicates the amount of work that is planned for the sprint.  
  • **Completed**: Indicates the amount of work completed in the sprint. |

You can customize the Burnup and Burndown reports. For more information, see [Customizing Essential SAFe dashboard reports](#).
SAFe PI Dashboard

The SAFe PI Dashboard allows you to track the progress of your features in the current program increment (PI).
Cycle Time tab

The SAFe PI dashboard provides the following details:

- Displays important details of the PI such as percentage of work that is complete, time elapsed, and total number of stories that are missing estimates.
- Displays the number of stories of the PI in their current state and their progress.
- Indicates the scope changes, if any, and trends of those scope changes.
- Indicates the pace at which the ART members are completing features that are planned for the PI.
- Forecasts data showing the likelihood of completing the PI as planned.
- Shows time elapsed for the stories of the PI to go from an in-progress state to a completed state.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAFe ART user: Track the progress of your stories that are planned for the PI.</td>
<td>safe_scrum_user</td>
</tr>
<tr>
<td>Resolve any bottlenecks and target to complete the PI on time.</td>
<td></td>
</tr>
</tbody>
</table>

Indicators

**SAFe: Count of all stories in the current PI**
Generates the area series the PI Cumulative Flow Diagram report, which indicates the number of stories of the current PI by state.

**SAFe: Sum of story points of all stories in the current PI**
Generate the scope series in the PI Burndown report. This series indicates the amount (in story points) of work planned for the PI.

**SAFe: Sum of story points of completed stories in the current PI**
Generates the actual burndown series in the PI Burndown report, and the completed series in the PI Burnup report. These series indicate the amount of work (in story points) that has been completed for the PI.

**SAFe: Sum of story points of active stories in the current PI**
Generates the scope series in the PI Burndown and PI Burnup reports. The scope series indicates the amount of work (in story points) that is planned for the PI.

**SAFe: Time elapsed in the PI**
Calculates the time to be displayed in the Time Elapsed widget.

Breakdowns

- SAFe: PI
- SAFe: State

Widgets

**Scope**
Indicates the amount of work in story points that is planned for the PI. This widget lets you see at a glance how much work must be completed to achieve the PI goal. It also lets you drill down to detail on the stories that are planned for completion in the PI.

**Percent Completed**
Indicates the percentage of work that has been completed in the PI using story points. This widget lets you see at a glance how much work has been completed in the PI. Together with the adjacent Time Elapsed widget, these widgets let you easily see whether you are completing work at a rate consistent with achieving the PI goal on schedule.
**Time Elapsed**
Indicates the percentage of time that has elapsed between the start date and planned end date of the PI. Together with the adjacent Percent Completed widget, these widgets let you easily see whether you are completing work at a rate consistent with achieving the PI goal on schedule.

**Features**
Indicates the total number of features that are planned for completion in the PI.

**Features Released**
Indicates the total number of features in the PI that have been completed.

**Stories Missing Estimates**
Indicates the total number of stories in the PI that are missing estimates. It is required that you use estimates for the other indicators, widgets, and reports on this dashboard to be meaningful.

**Note**: If you do not estimate stories, enter a "1" in the Story Points field. The other indicators, widgets, and reports will then effectively function by count.

**Blocked Work**
Indicates the amount of work (in story points) in the PI that is blocked.

**Reports**
If you are upgrading from version 1.0.2 or earlier of Performance Analytics Content Pack for Essential SAFe, then install this dashboard from Solution Library to upgrade its layout and access the following reports:
- PI Cumulative Flow Diagram
- Story Cycle Time

For more information, see Using Solution Library for Agile 2.0 dashboards.

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PI Burndown</td>
<td>Line</td>
<td>Indicates the scope changes, if any, and trends of those scope changes. Shows how much work is remaining, and if the scope is likely to be completed on time. The PI Burndown report comprises the following series that can be hidden or displayed based on your preference:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <strong>Scope</strong>: Indicates the amount of work that is planned for the PI.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <strong>Scope Forecast</strong>: Predicts the possibility of scope change for the future dates in the PI. This prediction is based on historical data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <strong>Ideal Burndown</strong>: Indicates how the ART members need to progress on stories to deliver the PI on time.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <strong>Remaining</strong>: Indicates the amount of work completed in the PI.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <strong>Remaining Forecast</strong>: Predicts the burndown for the future dates in the PI, indicating whether you can deliver the PI on time.</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| PI burnup                     | Line               | Analyse the burnup trends, and estimate when the PI work is likely to be complete. The PI burnup report comprises the following series that can be hidden or displayed based on your preference:  
  - **Scope**: Indicates the amount of work that is planned for the PI.  
  - **Scope Forecast**: Predicts the possibility of scope change for the future dates based on historical data.  
  - **Completed**: Indicates the amount of work in the PI that is complete.  
  - **Completed Forecast**: Predicts the burnup for the future dates in the PI. It indicates whether you can complete the PI on time.  
  
  **Note**: The point at which the Completed Forecast series intersects with or crosses the Scope Forecast series is a predictor for when the PI might be completed. If the Completed Forecast series and the Scope Forecast series do not appear to ever intersect, it is a warning that scope is being added faster than work is being completed. |
| PI Feature Progress           | Horizontal bar     | Analyse the progress of every feature of the PI, by viewing the count of the stories segregated by their state.                                                                                                                                                                                                                                                                                                                                                           |
| Velocity by Sprint            | Bar                | View the velocity of the ART members across PIs. Understand if the ART members are achieving a stable, predictable velocity over sprints, and meeting the commitments.                                                                                                                                                                                                                                                                                           |
| PI Cumulative Flow Diagram    | Area               | Monitor the progress of all the stories of your PI between its actual start and end dates. View the number of stories in each state by their arrival to a state, time in this state, and its departure from this state.  
  The PI Cumulative Flow Diagram report comprises the following areas that can be hidden or displayed based on your preference:  
  - **Ready**: Indicates the number of stories of the PI that are ready to start work on.  
  - **Work in Progress**: Indicates the number of stories of the PI that are in development.  
  - **Ready for Testing**: Indicates the number stories of the PI that are ready to be tested.  
  - **Testing**: Indicates the number of stories of the PI that are currently being tested.  
  - **Complete**: Indicates the number of stories that are complete.  
  
  **Note**: Stories in Ready and Cancelled states are not included in this report.                                                                                                                                                                                                                                                                                                                                                                                                       |
<p>| Cycle Time                    |                    |                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                               |</p>
<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| Story Cycle Time    | Bubble chart       | Identify the time taken for each story in the PI to move from an in-progress state to completion. Each bubble on the graph represents a story. The height of the bubble from the x-axis shows how long that story took to move from an in-progress state to completion. The size of the story bubbles are relative to each other based on their story points. Hovering your mouse cursor over a bubble displays the following details about that story:  
• Story points  
• Date on which the story is moved to completion  
• Total cycle time (in days) of the story  
• Number of days that the story was in the Work in progress state  
• Number of days that the story was in the Ready for testing state  
• Number of days that the story was in the Testing state  
From the Story State section towards the right of the report, you can filter the report to view the cycle time of the stories for the selected states. The chart displays the cycle time for each story as the cumulative sum of all duration of the selected states. If there are too many stories at any area of the chart and the bubbles appear crowded on the report, you can zoom in that particular area of the report for a clearer view. |

You can customize the Burnup, Burndown, and Cumulative Flow Diagram reports. For more information, see Customizing Essential SAFe dashboard reports.
## SAFe Prior PI Dashboard

The SAFe Prior PI Dashboard provides data visualization on scope, actual burndown, and forecast trends of previous program increments. Analyze the data and plan the work for upcoming program increments.

<table>
<thead>
<tr>
<th>Features Released</th>
<th>Completed</th>
<th>Stories Missing Estimates</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>34</td>
<td>5</td>
</tr>
</tbody>
</table>

### PI Burndown

![PI Burndown Chart]

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
**End user and roles**

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAFe ART user: Analyze the scope, burndown, and forecast trends of previous program increments.</td>
<td>safe_scrum_user</td>
</tr>
</tbody>
</table>

**Indicators**

**SAFe: Sum of story points of completed stories in the active PIs**
Generates the actual burndown series in the PI Burndown report, and the completed series in the PI Burnup report.

**SAFe: Sum of story points of all stories in active PIs**
Generates the scope series in the PI Burndown and PI Burnup reports.

**Breakdowns**
SAFe: Prior PI

**Widgets**

**Features**
Indicates the total number of features that were planned for completion in the previous PI.

**Completed**
Indicates the total number of features that were completed in the previous PI.

**Stories Missing Estimates**
Indicates the total number of stories in the previous PI that were missing estimates.

**Reports**

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PI Burnup</td>
<td>Line</td>
<td>Analyze the burnup trends of the previous PI.</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PI Burndown</td>
<td>Line</td>
<td>View the scope and rate of scope change, the ideal rate for work completion, and the actual rate of work completion. Analyze the burndown trends and accordingly plan the workload for an upcoming PI.</td>
</tr>
<tr>
<td>PI Velocity Chart</td>
<td>Bar</td>
<td>View the velocity of the ART members for the previous PI and plan the workload for an upcoming PI.</td>
</tr>
</tbody>
</table>

You can customize the Burnup and Burndown reports. For more information, see [Customizing Essential SAFe dashboard reports](#).
SAFe ART Dashboard

The SAFe Agile Release Train (ART) Dashboard provides a visualization of how the ART members are progressing on features over a given period. It provides an insight on the overall velocity of the ART members and helps you plan the work for the upcoming program increments.

ART Summary tab
Cycle Time tab

End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAFe ART user: View how the ART members are progressing on features.</td>
<td>safe_scrum_user</td>
</tr>
</tbody>
</table>
If you are upgrading from version 1.0.2 or earlier of Performance Analytics Content Pack for Essential SAFe, then install this dashboard from Solution Library to upgrade its layout and access the Story Cycle Time report. For more information, see Using Solution Library for Agile 2.0 dashboards.

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feature Progress</td>
<td>Horizontal bar</td>
<td>View the progress of all the features that the ART members are working on.</td>
</tr>
<tr>
<td>Velocity by PI</td>
<td>Bar</td>
<td>View the velocity of the ART across various PIs. Understand if the ART is achieving a stable, predictable velocity.</td>
</tr>
<tr>
<td>Cycle Time</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Story Cycle Time</td>
<td>Bubble chart</td>
<td>Identify the time taken for each story in the ART to move from an in-progress state to completion. Each bubble on the graph represents a story. The height of the bubble from the x-axis shows how long that story took to move from an in-progress state to completion. The size of the story bubbles are relative to each other based on their story points. Hovering your mouse cursor over a bubble displays the following details about that story: • Story points • Date on which the story is moved to completion • Total cycle time (in days) of the story • Number of days that the story was in the Work in progress state • Number of days that the story was in the Ready for testing state • Number of days that the story was in the Testing state From the Story State section towards the right of the report, you can filter the report to view the cycle time of the stories for the selected states. The chart displays the cycle time for each story as the cumulative sum of all duration of the selected states. If there are too many stories at any area of the chart and the bubbles appear crowded on the report, you can zoom in that particular area of the report for a clearer view.</td>
</tr>
</tbody>
</table>
SAFe Team Dashboard

Visually analyze how a team is progressing on stories over a given period of time. The SAFe Team Dashboard provides an insight on the overall velocity of the team and helps you plan the team's capacity for the upcoming sprints. In addition, it provides details of all the team members.
Work item progress tab
Sprint Performance tab
### Team Members tab

<table>
<thead>
<tr>
<th>User</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paul Martin (Project Mgr)</td>
<td>Project Manager</td>
</tr>
<tr>
<td>Elmo Gabouer</td>
<td>(empty)</td>
</tr>
<tr>
<td>Adela Cervantsz (SAFe Portfolio Manager)</td>
<td>(empty)</td>
</tr>
<tr>
<td>Brian Marshall (BRM)</td>
<td>Business Relationship Manager</td>
</tr>
<tr>
<td>Megan Burke (Portfolio Mgr)</td>
<td>Inside Sales</td>
</tr>
<tr>
<td>Christine Fairchild (it finance manager)</td>
<td>IT Finance Manager</td>
</tr>
</tbody>
</table>

### Cycle Time tab
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAFe scrum master: View how your team is progressing on stories.</td>
<td>safe_scrum_user</td>
</tr>
</tbody>
</table>

Indicators

**SAFe: Scrum: Average Story State Duration**

Generates data that is displayed in the Average Cycle Time per State report.
SAFe: Story State Duration

Generates data that is displayed in the Time in State report.

Breakdowns

- SAFe: State
- SAFe: Team

Reports

The Team Dashboard reports are segregated into the following three tabs:

- Work item progress: Reports of Active Stories by State, Time in State, and Average Cycle Time per State
- Sprint Performance: Reports of Velocity History and Sprint Variance
- Team Members: List of all the members of the team

**Note:** For existing customers who upgrade to the latest version, the list of the team members appears in both the Work item progress and Team Members tabs but only one of these locations would display the accurate information. You can remove this widget from the Work item progress tab to avoid this issue. For more information on how to remove a widget, see Edit a responsive dashboard.

If you are upgrading from version 1.0.2 or earlier of Performance Analytics Content Pack for Essential SAFe, then install this dashboard from Solution Library to upgrade its layout and access the following reports:

- Velocity History
- Velocity by Type
- Sprint Variance
- Story Cycle Time

For more information, see Using Solution Library for Agile 2.0 dashboards.

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work item progress</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Active Stories By</td>
<td>Bar</td>
<td>View the total number of stories in each state of a story, for example, testing, work in progress, and testing.</td>
</tr>
<tr>
<td>State</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Time in State</td>
<td>Stacked bar chart</td>
<td>View the time in hours that the team spends in each state of a story.</td>
</tr>
<tr>
<td>Average Cycle Time per State</td>
<td>Line</td>
<td>View how the work in progress is trending over time and what are the most significant cycle times.</td>
</tr>
<tr>
<td>Sprint performance</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Velocity History</td>
<td>Grouped bar chart</td>
<td>Gain an insight on the overall velocity of the team for the past 10 sprints. Understand if the team is achieving a stable, predictable velocity, and is meeting the commitments.</td>
</tr>
</tbody>
</table>

The Team Velocity History report comprises the following series per sprint that can be hidden or displayed based on your preference:

- **Team Capacity**: Indicates the team capacity (in story points) for the sprint.
- **Committed Story Points**: Indicates the number of story points committed by the team for the sprint.
- **Completed Story Points**: Indicates the number of story points completed by the team for the sprint.
- **Average Completed Points**: Indicates the average number of story points completed by the team for the sprint.
- **Linear (Actual)**: Indicates if the amount of completed work is trending up, trending down, or relatively stable over sprints.
<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| Velocity by Type    | Stacked bar chart | Analyze the way your team's velocity changes over time and compare the team's strategic workload with operational or other types of workload. The bar charts have two stacks that show the sum of the story points of the following types of completed stories:  
  - Regular stories  
  - Stories added to the unified backlog from the items in the triage board  
  Clicking any bar would take you to its corresponding sprint details.  
  Data displayed in this report is of the past 10 sprints with the earliest sprint on the left.  
  Note: This report is not available by default. You can add it from Scrum custom charts to your dashboard. For more information, see Edit a responsive dashboard. |
| Sprint Variance     | Grouped bar chart | Analyze the percentage variance of the team compared to the capacity and committed points, for the past 10 sprints. The Team Sprint Variance report comprises the following series per sprint that can be hidden or displayed based on your preference:  
  - Completed to Capacity: Indicates the percentage of completed work compared to the expected capacity for the sprint.  
  - Completed to Committed: Indicates the percentage of completed work compared to the committed work of the team for the sprint. |
| Team Members        | List          | View the details of all team members.                                                                                                                                                                         |
### Title: Story Cycle Time

#### Type: Bubble chart

#### Description:

Identify the time taken for each story, which the team has worked on, to move from an in-progress state to completion.

Each bubble on the graph represents a story. The height of the bubble from the x-axis shows how long that story took to move from an in-progress state to completion. The size of the story bubbles are relative to each other based on their story points.

You can compare the cycle times of stories with different story points and analyze the trend in the time taken by the team to complete them. Identify the stories that took longer to complete and analyze the reasons so that you can chart an action plan to reduce the team's cycle time in the future.

Hovering your mouse cursor over a bubble displays the following details about that story:

- **Story points**
- **Date on which the story is moved to completion**
- **Total cycle time (in days) of the story**
- **Number of days that the story was in the Work in progress state**
- **Number of days that the story was in the Ready for testing state**
- **Number of days that the story was in the Testing state**

From the Story State section towards the right of the report, you can filter the report to view the cycle time of the stories for the selected states. The chart displays the cycle time for each story as the cumulative sum of all duration of the selected states.

If there are too many stories at any area of the chart and the bubbles appear crowded on the report, you can zoom in that particular area of the report for a clearer view.
Customizing Essential SAFe dashboard reports

Customize the Burnup, Burndown, and Cumulative Flow Diagram reports of your dashboards according to the custom states of your SAFe stories.

- Configure indicators to reflect your customizations.
  
  For example, if there are any new states introduced to the SAFe story table, then the corresponding indicators and indicator sources for the story table that rely on the **State** field must be updated as well.
  
  For more information, see [Customize indicators of your Essential SAFe dashboard reports](#).

- Update or clone UI scripts for modifications to use your own indicators.
  
  Add customizations by overriding methods in empty implementation (Impl) classes of UI scripts such as SafeAreaChartImpl and SafeVelHistoryImpl.
  
  For more information, see [Update UI scripts to use your indicators for Essential SAFe dashboards](#).

Customize indicators of your Essential SAFe dashboard reports

Configure indicators to reflect your customizations in Essential SAFe dashboards.

**Role required:** admin or pa_admin

1. Navigate to **Performance Analytics > Indicators > Automated Indicators**.

2. Search for and open the required indicator.

   For example, if you want to customize the SAFe Burnup report, open SAFe: Sum of story points of all stories in the feature in current sprint from the list of indicators.

3. In the Additional conditions section, modify the conditions according to your preferences.

4. Click **Update**.

Update UI scripts to use your indicators for Essential SAFe dashboards

Customize UI scripts by overriding methods in empty implementation (Impl) classes.

**Role required:** admin

1. Navigate to **System UI > UI Scripts**.

2. Search for and open the required UI script.

   For example, if you want to customize the SAFe Sprint Cumulative Flow Diagram report, open SAFeAreaChartImpl from the list of UI scripts.

3. Overwrite the base implementation according to your preferences.

4. Click **Update**.

Work Progress Status for SAFe

The Work Progress Status for SAFe application provides you with indicators such as estimated completion date and progress status (green, yellow, red) for all your SAFe epics and features.

As a product owner or a team lead, these indicators help you understand if your SAFe team could complete the work by the planned end dates so that you can adjust your plans accordingly. As a team member working on SAFe stories, these status indicators help you understand your contribution to the overall work and your progress so that you can review your work strategy if necessary.

**Note:** You must enter a value for the **Planned end date** field for a SAFe feature or epic for these work progress status indicators to populate.
Install Work Progress Status for SAFe

Install the Work Progress Status for SAFe (sn_safe_progress) application from ServiceNow Store.

- Activate Essential SAFe.
- Install the Performance Analytics Content Pack for Essential SAFe.

**Tip:** To verify that plugins and applications are activated and installed, navigate to Subscription Management > Subscriptions in your instance. The list displays the subscriptions your organization has purchased.

**Note:** Activation of Essential SAFe and Performance Analytics Content Pack for Essential SAFe on production instances may require separate licenses. Contact ServiceNow Support for details.

Role required: admin

1. Navigate to ServiceNow® Store.
2. Search for Work Progress Status for SAFe.
3. Click the application tile.
   You can view detailed information about the application you are installing.

   **Note:** Consider reading the Other Requirements and Dependencies sections, as applicable.

4. Click Get and enter your Now Support login credentials.
5. Click Request Install.
6. In the Instance Name field, enter your details and click Validate Instance.
7. In the Reason for the Instance field, enter your details and click Request.
   You receive an email with detailed installation instructions.
8. Log in to the instance you want to install Work Progress Status for Agile Teams on.
10. Locate the Work Progress Status for SAFe application, select it, and click Install.

If you haven't already, start the [SAFe] Daily Data Collection job. For more information, see Enable daily data collection.

Reviewing progress status for SAFe features and epics

Understand if your work would be completed by the planned end dates by reviewing progress status of your SAFe features and epics.

Navigate to Scaled Agile Framework (SAFe) > Epics or Scaled Agile Framework (SAFe) > Features and filter the records for your team.

The Status column of the list shows a Green, Yellow, or Red indicator for each record to indicate the following:

- Green: Your work is on track to be complete by the planned end date.
- Yellow: Your work is off track and your plan of execution must be reviewed.
- Red: Your epic or feature is not progressing well and might be at risk of not being complete by the planned end date.

The estimated completion date displays a date with the likelihood of the epic's or feature's completion.
### SAFe epic progress status

<table>
<thead>
<tr>
<th>Number</th>
<th>Short description</th>
<th>State</th>
<th>WSJF score</th>
<th>Planned end date</th>
<th>Percent complete by estimate</th>
<th>Status</th>
<th>Estimated completion date</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>Redesign Frontend</td>
<td>Implementation</td>
<td>3</td>
<td>2020-08-25 11:09:53</td>
<td>89%</td>
<td>Green</td>
<td>2020-08-21</td>
</tr>
<tr>
<td>002</td>
<td>Ad Platform</td>
<td>Implementation</td>
<td>7,8</td>
<td>2020-08-20 11:09:53</td>
<td>93%</td>
<td>Green</td>
<td>2020-08-18</td>
</tr>
<tr>
<td>003</td>
<td>Tailored Ads</td>
<td>Implementation</td>
<td>2,62</td>
<td>2020-08-13 11:09:53</td>
<td>75%</td>
<td>Yellow</td>
<td>2020-08-18</td>
</tr>
<tr>
<td>004</td>
<td>Hotel Listings</td>
<td>Implementation</td>
<td>11</td>
<td>2020-09-09 11:09:53</td>
<td>24%</td>
<td>Red</td>
<td>2020-09-23</td>
</tr>
</tbody>
</table>

### SAFe feature progress status

<table>
<thead>
<tr>
<th>Number</th>
<th>Short description</th>
<th>State</th>
<th>WSJF score</th>
<th>Planned end date</th>
<th>Percent complete by estimate</th>
<th>Status</th>
<th>Estimated completion date</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>Mobile homepage</td>
<td>Native mobile</td>
<td>Mobile Platform</td>
<td>3</td>
<td>Implementation</td>
<td>66%</td>
<td>Yellow</td>
</tr>
<tr>
<td>002</td>
<td>Basic Components</td>
<td>Government Library</td>
<td>Bucking Platform</td>
<td>11</td>
<td>Implementation</td>
<td>66%</td>
<td>Green</td>
</tr>
<tr>
<td>003</td>
<td>Search by City</td>
<td>Hotel Listings</td>
<td>Bucking Platform</td>
<td>10.5</td>
<td>Implementation</td>
<td>66%</td>
<td>Red</td>
</tr>
<tr>
<td>004</td>
<td>Search by Price</td>
<td>Hotel Listings</td>
<td>Bucking Platform</td>
<td>9</td>
<td>Implementation</td>
<td>67%</td>
<td>Green</td>
</tr>
<tr>
<td>005</td>
<td>Search by Hotel</td>
<td>Hotel Listings</td>
<td>Bucking Platform</td>
<td>10.5</td>
<td>Implementation</td>
<td>66%</td>
<td>Green</td>
</tr>
</tbody>
</table>
The [SAFe] daily data collection job helps generate the burnup report for your epics and features. Using the data generated for these epic burnup reports, an estimated completion date is determined. You can see that this date is the intersection of Completed and Scope forecast series in the respective burnup reports.

Based on this estimated completion date, the progress status for your SAFe epics and features is determined. Progress status is calculated only under the following conditions:

- Planned end date is populated for the SAFe epic and feature.
- Percentage completion of the epic is a value greater than 0.

The color of the progress status indicator is determined using the following conditions:

- Green: Estimated completion date is on or before the planned end date.
- Yellow: Estimated completion date is beyond the planned end date by a deviation of 1% to 14%.
- Red: Estimated completion date is beyond the planned end date by a deviation of 15% or more.

**Test Management applications**

The ServiceNow® Test Management application streamlines the management of testing processes to help you deliver software products more efficiently and with fewer errors.

There are two versions of Test Management: Test Management 1.0 and Test Management 2.0. While Test Management 2.0 offers many enhancements, including integration with Agile Development 2.0 and Scaled Agile Framework (SAFe), the original Test Management 1.0 may have specific capabilities that are useful for your organization. The information and table below will help you make an informed decision for your organization.

**Differences between Test Management 1.0 and Test Management 2.0**

Test Management 1.0 covers user acceptance testing. It does not include some key data model structures like test versions, test runs, or test results. In addition, you cannot structure test plans in Test Management 1.0.

Test Management 2.0 includes data model structures that match industry standards. It provides you with an intuitive user interface called the Test Board from which you can structure test plans and plan the phases of your testing effort.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Test Management 1.0</th>
<th>Test Management 2.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integration with Project Portfolio Management</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Integration with Agile Development 2.0</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Integration with Scaled Agile Framework (SAFe)</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>Test version</td>
<td>You cannot create and maintain multiple versions of a test.</td>
<td>You can create and maintain multiple versions of a test.</td>
</tr>
<tr>
<td>Test relation</td>
<td>You can associate a test to one test suite only.</td>
<td>You can associate a test to multiple test sets, test plans, and test cycles.</td>
</tr>
<tr>
<td>Feature</td>
<td>Test Management 1.0</td>
<td>Test Management 2.0</td>
</tr>
<tr>
<td>------------------------------</td>
<td>----------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Time duration                | You can create a test plan describing how a product or a feature is to be tested. | • You can create a test plan describing how a product or a feature is to be tested and the time frame in which the test plan must be run.  
• You can further decompose a test plan into test cycles, test cycles into test execution sets, and specify a time range for their execution. |
| Traceability of test runs and test results | You can:  
• run a single test at a time.  
• view the test result. | You can:  
• run a single test at a time.  
• view which version of test has been run.  
• view the test result. |

**Note:**
- If you are an existing Test Management user on a release prior to London, you are using Test Management 1.0 activated through the Test Management (com.snc.test_mgmt) plugin. See the Test Management 1.0 documentation for more information.
- If you are a new user, you can activate the Test Management 2.0 (com.snc.test_management.2.0) plugin as it provides enhanced testing capabilities. See the Test Management 2.0 documentation for more information.

**Domain separation in Test Management**

This is an overview of domain separation and Test Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

**Support level: Basic**

- **Business logic:** Ensure that data goes into the proper domain for the application’s service provider use cases.
- The application supports domain separation at run time. This includes domain separation from the user interface, cache keys, reporting, rollups, and aggregations.
- The owner of the instance must set up the application to function across multiple tenants.

**Use case:** When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.
Test Management 1.0

The ServiceNow® Test Management 1.0 provides a tool for manual software testing.

Note: For Test Management 1.0, install the Test Management (com.snc.test_mgmt) plugin.

Test Managers

Test managers can use this application to manage all phases of the testing process.
- Create and maintain the test repository by creating test suites, test cases, and tests.
- Enable test execution by creating test plans, adding test cases, and assigning testers to test cases.
- Initiate the testing process and monitor the progress.
- Evaluate test results and complete the test plan sign-off form.
- View testing reports on the Test Management dashboard.

Testers

Testers can use this application to:
- Perform tests and record test results.
- Update test case status.
- Report defects and retest, as necessary.

Test Management key terms

Key terms describe the terminology used in Test Management.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test suite</td>
<td>A repository of test cases. Test cases in a test suite can be copied over to a test plan.</td>
</tr>
<tr>
<td>Test case</td>
<td>A collection of related tests. A test case is saved as part of a test suite and can be added to a test plan. Each test case within a test plan has an assigned tester.</td>
</tr>
<tr>
<td>Test</td>
<td>A collection of conditions or steps used to determine whether a feature is working correctly. A test also includes an expected result, which is used to determine if the test case passes or fails.</td>
</tr>
<tr>
<td>Test plan</td>
<td>The tasks for how a product or a feature is to be tested. A test plan includes one or more test cases and can also specify a test environment. The test manager uses the test plan to assign and execute test cases and to track the testing progress.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Test environment</td>
<td>The instance where testing should be performed, specified as a URL. A test environment is an optional parameter that the test manager can associate with a test plan.</td>
</tr>
<tr>
<td>Test execution</td>
<td>The process of performing tests. The test manager assigns testers to test cases in a test plan; testers perform the tests in the assigned test cases.</td>
</tr>
<tr>
<td>Guided test execution</td>
<td>An automated notification process for performing tests. The test manager assigns testers to test cases in a test plan and initiates testing from the Test Plan form. Testers receive notification to begin testing using the Assessments engine.</td>
</tr>
</tbody>
</table>

**Components installed with Test Management**

Several types of components are installed with activation of the Test Management plugin, including tables and user roles.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

**Roles installed**

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test manager [tm_test_manager]</td>
<td>Manages test plans and test suites (metadata). Has all privileges within test management, including planning, execution, and administration.</td>
<td>• tm_tester</td>
</tr>
<tr>
<td>Tester [tm_tester]</td>
<td>Executes test cases and tests.</td>
<td>• feature_user</td>
</tr>
</tbody>
</table>

**Tables installed**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test Case [tm_test_case]</td>
<td>Stores the test cases.</td>
</tr>
<tr>
<td>Test Case Instance [tm_test_case_instance]</td>
<td>Extends the Planned Task table.</td>
</tr>
<tr>
<td>Test Suite [tm_test_suite]</td>
<td>Stores the test suites.</td>
</tr>
</tbody>
</table>
### Test Management process flow

The tasks associated with manual software testing can be divided into categories.

**Test setup**

The test manager builds the test repository by creating test suites, test cases, and tests.

**Test initiation**

The test manager initiates the testing process and monitors the progress on the Test Plan form.

**Test execution**

The test manager creates a test plan to test a specific product or feature, adds test cases, and assigns a tester to each test case. If desired, the test manager can also define a test environment.

**Testing**

Testers perform the tests in their assigned test cases, record the test results, and update the status of each test. If necessary, the testers indicate the reason for a failed or blocked test.

**Sign-off**

Stakeholders review the test results and any open issues and then decide whether the test plan sign-off form can be completed.

Except for completing the test plan sign-off form, there is no required order for performing these testing tasks. Each task can be independently performed.

### Activate Test Management

To activate the Test Management (com.snc.test_mgmt) plugin you must have an admin role.

---

**Note:**

There are two ways to activate the Test Management plugin:

- As an individual application
1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in **Request a plugin**.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise they will receive the following error: **Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>**.

### Test manager tasks

The test manager (tm_test_manager) is responsible for setting up and monitoring the manual testing process.

You can perform the following tasks with the test manager role:

- Create and maintain the test repository, including test suites, test cases, and tests.
- Create test plans.
- Define test environments, if desired.
- Add test cases to a test plan.
- Assign a tester to each test case.
- Notify testers to begin testing.
- Monitor the testing process.
- Evaluate test results.
- Complete the test sign-off form.

### Test suites

A test suite is made up of one or more test cases that are grouped for execution purposes.

The test manager creates and updates test suites, test cases, and tests.

Navigate to **Test Management > Test Repository > Test Suites** to display a list of test suites. Click the desired suite to display the Test Suite form, which lists all test cases included in the suite.

**Create a test suite**

A test suite is made up of one or more test cases that are grouped for execution purposes.

1. Navigate to **Test Management > Test Repository > Test Suites**.
2. Click **New**.
3. Fill in the fields (see table).
4. Click **Submit**.

#### Test Suite form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The automatically assigned test suite number. For example, TMTS0001002.</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the test suite.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active</td>
<td>Check box for activating the test suite. Active test suites are displayed in the Test Suite field on the Add Test Cases from Test Suite dialog box.</td>
</tr>
<tr>
<td>Owner</td>
<td>The owner of the test suite.</td>
</tr>
<tr>
<td>Description</td>
<td>A detailed description of the test suite.</td>
</tr>
<tr>
<td>Related links</td>
<td></td>
</tr>
<tr>
<td>Add to Test Plan</td>
<td>Adds the test suite and all associated test cases and tests to a test plan. Select the Test Plan in the dialog box.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Create duplicate</td>
<td>Creates a copy of the current test suite with the <strong>Test Suite Name</strong> you enter in the dialog box.</td>
</tr>
</tbody>
</table>
Copy a test suite
Create a test suite by copying an existing test suite.

1. Navigate to Test Management > Test Repository > Test Suites.
2. Open the desired test suite.
3. Click the Create duplicate related link.
4. Enter a new Test Suite Name in the dialog box.
5. Click OK.

Add a test case to a test suite
The test manager can add a test case to a test suite.

1. Navigate to Test Management > Test Repository > Test Suites.
2. Open the desired test suite.
3. In the Test Cases related list, click New.
4. In the form, fill in the fields.

   Test Case form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Automatically assigned test case number.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box for activating the test case.</td>
</tr>
<tr>
<td>Test Suite</td>
<td>Test suite to which the test case is added.</td>
</tr>
<tr>
<td>Short Description</td>
<td>Detailed description of the test case.</td>
</tr>
<tr>
<td>Prerequisites</td>
<td>Any conditions that must be met before the test case is executed.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Test cases
A test case is made up of one or more individual tests.

The test manager creates and updates test suites, test cases, and tests.

Navigate to Test Management > Test Repository > Test Cases to display a list of test cases. Click a test case to display the Test Case form, which lists all tests included in the test case.

Create a test case
A test case is made up of one or more individual tests.

1. Navigate to Test Management > Test Repository > Test Cases.
2. Click New.
3. Fill in the fields (see table).
4. Click Submit.

   Test Case form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The automatically assigned test case number.</td>
</tr>
<tr>
<td></td>
<td>For example, TMTC0001005.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box for activating the test case.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Test Suite</td>
<td>The test suite this test case belongs to. A test suite is made up of one or more test cases.</td>
</tr>
<tr>
<td>Short Description</td>
<td>A brief description of the test case.</td>
</tr>
<tr>
<td>Prerequisites</td>
<td>Any conditions that must be met before the test case is executed.</td>
</tr>
<tr>
<td>Related links</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Add to Test Plan</td>
<td>Adds the test suite and all associated test cases and tests to a test plan. Select the <strong>Test Plan</strong> in the dialog box.</td>
</tr>
</tbody>
</table>
**Add a test to a test case**
The test manager can add a test to a test case.

1. Navigate to **Test Management > Test Repository > Test Cases**.
2. Open the desired test case.
3. In the **Tests** related list, click **New**.
4. Fill in the fields (see table).
5. Click **Submit**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The automatically assigned test number. For example, TMT0001009.</td>
</tr>
<tr>
<td>State</td>
<td>The state of the test:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Draft</strong>: the test is not ready to be performed.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Ready</strong>: the test is ready to be performed.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Inactive</strong>: the test is no longer active.</td>
</tr>
<tr>
<td>Order</td>
<td>The order in which the test is performed, relative to other tests in this test case.</td>
</tr>
<tr>
<td>Test</td>
<td>The name of the test.</td>
</tr>
<tr>
<td>Expected result</td>
<td>The expected result of the test.</td>
</tr>
<tr>
<td>Detailed description</td>
<td>A detailed description of what is being tested.</td>
</tr>
<tr>
<td>Related links</td>
<td></td>
</tr>
<tr>
<td>Create duplicate</td>
<td>Creates a copy of the test.</td>
</tr>
</tbody>
</table>

**Update the status of a test case**
The status of the individual tests in a test case does not affect the status of the overall test case. Setting the status of the test case is a manual operation.

1. Navigate to **Test Management > Test Repository > Test Plans**.
2. Open the desired test plan.
3. In the **Test Cases** related list, click the desired test case.
4. Select the status in the **Execution Status** field.
   - **Passed**: all tests assigned to this test case have a status of **Passed**.
   - **Failed**: one or more of the tests assigned to this test case have a status of **Failed**.
   - **Blocked**: one or more of the tests assigned to this test case have a status of **Blocked**.
   - **Retest**: a defect resulting from a failed test has been closed or canceled and the test is ready to be run again.
5. Click **Update** or **Save**.
The test results are updated in the test plan.

**Delete a test case**
Deleting a test case also deletes the tests associated with the test case.

1. Navigate to **Test Management > Test Repository > Test Cases**.
2. Open the desired test case.
3. Click **Delete**.
4. Click **OK** to confirm the deletion.

   The test case is removed from the list and the associated tests are deleted.

**Tests**

A test is made up of conditions, variables, or steps that are used to determine whether a feature is working correctly. A test also includes an expected result, which is used to determine whether the test passes or fails.

The test manager creates and updates test suites, test cases, and tests.

To display a list of tests within a test case, navigate to **Test Management > Test Repository > Test Cases** and select the desired test case. The **Tests** related list displays all tests assigned to the test case. Click a test to display the Test form.

Create a test

Create a test to see if your features are working correctly.

1. Navigate to **Test Management > Test Repository > Test Cases**.
2. Open the desired test case.
3. In the Tests related list, click **New**.
4. Fill in the fields (see table).
5. Click **Submit**.

**Test form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The automatically assigned test number. For example, TMT0001009.</td>
</tr>
<tr>
<td>State</td>
<td>The state of the test:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Draft</strong>: the test is not ready to be performed.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Ready</strong>: the test is ready to be performed.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Inactive</strong>: the test is no longer active</td>
</tr>
<tr>
<td>Order</td>
<td>The order in which the test is performed, relative to other tests in this test case.</td>
</tr>
<tr>
<td>Test</td>
<td>The name of the test.</td>
</tr>
<tr>
<td>Expected result</td>
<td>The expected result of the test.</td>
</tr>
<tr>
<td>Detailed description</td>
<td>A description of what is being tested.</td>
</tr>
<tr>
<td>Related links</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>Create duplicate</td>
<td>Creates a copy of the test.</td>
</tr>
</tbody>
</table>

**Copy a test**

You can create a new test by copying an existing test.

1. Navigate to **Test Management > Test Repository > Test Cases**.
2. Open the desired test case.
3. Open the desired test in the Tests related list.
4. Click the **Create Duplicate** related link to create a copy of the test with a unique test number.
5. Make any necessary changes to the fields on the new test suite.
6. Click **Update**.

### Test plans

A test plan describes how a product or a feature is to be tested.

Navigate to **Test Management > Test Execution > Test Plans** to display the Test Plans list. This list shows the current test plans, along with the percentage of the test cases completed and test case status. Click a test plan number to display the Test Plan form. This form displays the information included in a test plan, such as the assigned test cases and the test environment.

**Create a test plan using Test Management**

A test plan describes how a product or a feature is to be tested.

1. Navigate to **Test Management > Test Execution > Test Plans**.
2. Click **New**.
3. Fill in the fields (see table).
4. Save the test plan:
   - **Submit**: returns to the Test Plans list.
   - **Save**: remains on the Test Plan form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Description</td>
<td>A brief description of the test plan.</td>
</tr>
<tr>
<td>Owner</td>
<td>The owner of the test plan.</td>
</tr>
<tr>
<td>Test environment</td>
<td>The specific environment to be used for testing. A test environment must be created before it can be assigned to a test plan. From the Test Plan form, users can see the details of the assigned test environment, including the URL, by pointing to the information icon next to the Test environment field.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box for activating the test plan. Active test plans appear in the Test Plan field on the Add Suites to Test Plan dialog box.</td>
</tr>
<tr>
<td>Instructions</td>
<td>Any specific instructions for this particular test plan.</td>
</tr>
<tr>
<td>Project</td>
<td>The name of the associated project. This field appears on the Test Plan form if the Test Management PPM Integration plugin has been activated as part of the Project Portfolio Suite.</td>
</tr>
<tr>
<td>Project Phase</td>
<td>The name of the associated project phase in the Project Workbench. This field appears on the Test Plan form if the Test Management PPM Integration plugin has been activated as part of the Project Portfolio Suite.</td>
</tr>
<tr>
<td>Related links</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Add Test Cases from Test Suite</td>
<td>Adds to the test plan all test cases from the test suite you select in the dialog box.</td>
</tr>
<tr>
<td>Notify Tester</td>
<td>Creates assessments with the testing details for each tester assigned to the test cases in this test plan. Testers can find this information by navigating to Self-Service &gt; My Tests or Self-Service &gt; My Assessments.</td>
</tr>
<tr>
<td>Cancel test execution</td>
<td>Cancels the test execution that was created with the Notify Tester related link. After the test manager clicks this related link, it toggles to Notify Tester.</td>
</tr>
<tr>
<td>View Task Board</td>
<td>Opens the Visual Task Board for the test plan and displays the assigned test cases in lanes organized by test case state.</td>
</tr>
<tr>
<td>Save as Test Suite</td>
<td>Saves the test cases and tests in a test plan as a new test suite, making them available to be added to other test plans. Enter a new Test Suite Name in the dialog box.</td>
</tr>
<tr>
<td>Copy Test Plan</td>
<td>Makes a copy of the current test plan. Enter a new Test Plan Name in the dialog box and click OK.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Sign-off Test Plan</td>
<td>Displays the Sign-off Test Execution page.</td>
</tr>
</tbody>
</table>

**Test Plan form**

Display test plan execution start and end dates

To see date information on the Test Plan form, add the following optional date fields.

Right-click the form header and select **Configure > Form Layout** to add the following fields:

- **Planned start date**: the projected start date for the test plan. The planned start date can be the current date or a future date. The default for this field is the current date. To change the planned start date, click the calendar icon and select a new date.
- **Planned end date**: the projected end date for the test plan. The planned end date must be after the planned start date. The default for this field is one day after the planned start date. To change the planned end date, click the calendar icon and select a new date.

- **Actual start date**: the actual start date for the test plan. The actual start date can be on or before the planned start date.

- **Actual end date**: the actual end date for the test plan. The actual end date can be before the planned start date but not before the actual start date.

---

**Add a new test case to a test plan**

The test manager can add a new test case to a test plan.

1. Navigate to **Test Management > Test Execution > Test Plans**.
2. Open the desired test plan.
3. In the **Test Cases** related list, click **New**.
4. Fill in the fields (see table).
5. Click **Submit**. The new test case is added to the **Test Cases** related list.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The automatically assigned test case number. For example, TMTC0001005.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box for activating the test suite. Active test suites are displayed in the <strong>Test Suite</strong> field on the Add Test Cases from Test Suite dialog box.</td>
</tr>
<tr>
<td>Test Suite</td>
<td>The test suite this test case belongs to. A test suite is made up of one or more test cases.</td>
</tr>
<tr>
<td>Short Description</td>
<td>A brief description of the test case.</td>
</tr>
<tr>
<td>Prerequisites</td>
<td>Any conditions that must be met before the test case is executed.</td>
</tr>
<tr>
<td>Related links</td>
<td></td>
</tr>
<tr>
<td>Add to Test Plan</td>
<td>Adds the test case and associated tests to the test plan you select in the dialog box.</td>
</tr>
</tbody>
</table>

---

**Notify testers to start testing**

If you are using guided test execution, you can notify testers to start testing from the Test Plan form.

Clicking the **Notify Tester** related link creates assessments for each of the testers assigned to the test cases in the test plan. The assessments engine sends an email to the testers to alert them about the assigned assessment. Testers can find the assessments by navigating to **Self-Service > My Tests** or **Self-Service > My Assessments**.

1. Navigate to **Test Management > Test Execution > Test Plans**.
2. Open the desired test plan.
3. If necessary, use the **Assigned to** field to assign testers to the test cases in the **Test Cases** related list.
4. Click the **Notify Tester** related link.
5. Enter a date in the **Testing end date** field in the dialog box and click **OK**. 
   This date is used as the due date for the assessment.
   
   A message indicates that testing has been kicked off and the assigned testers have been notified. The **Notify Tester** related link on the Test Plan form toggles to the **Cancel test execution** related link.
   
   If the test plan is assigned to a project, the **Testing start date** is validated against the test phase start and end dates.

6. Click **OK**.
   
   After clicking this link, it toggles to **Cancel test execution**.

**Create a test environment**

A test environment defines the setup to be used when conducting the tests in a test plan.

A test plan can specify the software version or the operating system to be used. The Test Environment form includes the type of environment and can also include a URL.

1. Navigate to **Test Management > Test Execution > Test Environments**.
2. Click **New**.
3. Fill in the fields (see table).
4. Click **Submit**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The automatically assigned test number. For example, TMTE0001001.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the test environment.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of environment:</td>
</tr>
<tr>
<td></td>
<td>• Development</td>
</tr>
<tr>
<td></td>
<td>• Production</td>
</tr>
<tr>
<td></td>
<td>• QA</td>
</tr>
<tr>
<td></td>
<td>• User Acceptance Testing (UAT)</td>
</tr>
<tr>
<td></td>
<td>• Staging</td>
</tr>
<tr>
<td></td>
<td>• Support</td>
</tr>
<tr>
<td>URL</td>
<td>URL of the test environment.</td>
</tr>
</tbody>
</table>
Assign testers to test cases

The test manager can assign the test cases in a test plan to users with the tester (tm_tester) role and to business users.

The test manager can assign a tester to a test case in one of two ways:

• from the Test Plan form
• from the visual task board

Testers can choose to perform testing from the Test Plan or Test Case form, a visual task board, or using the guided test execution feature. Business users can only perform testing using guided test execution.

Assign testers from the Test Plan form

The test manager can assign a tester to a test case from the Test Plan form.

1. Open the desired test plan.
2. In the Test Cases related list, open the desired test case.
3. Select a user in the Assigned to field.
4. Click Update.

Assign testers from the visual task board

The test manager can assign a tester to a test case from the visual task board.

1. Open the desired test plan.
2. Click the View Task Board related link.
   The task board includes lanes for test case status. A card for each test case appears in the appropriate lane.
3. Click a card to open the test case form.
4. Select a user in the Assigned to field.
The Activity field is updated with the selected user.

5. Close the card.

**Guided test execution**

Guided test execution uses the Assessments application to notify testers about assigned test cases.

Any user can perform tests using the guided testing feature. The tester (tm_tester) role is not required. An assessment metric category is created for each tester in a test plan.

The test manager assigns testers to test cases, clicks the Notify Tester related link on the Test Plan form, and assigns an end date for the testing. Testers can navigate to Self-Service > My Tests or Self-Service > My Assessments to view assigned test cases and complete testing by the specified date.

Any changes to the test plan, test case, or tests are automatically updated in the assessment. As the tester progresses through the assessment, the test plan and test case are updated when the tester submits results.

The test manager can cancel the guided test execution at any time by clicking the Cancel test execution related link on the Test Plan form.

**Initiate guided test execution**

The test manager can initiate guided test execution from the Test Plan form.

1. Navigate to Test Management > Test Execution > Test Plans.
2. Open the desired plan.
3. If necessary, use the Assigned to field to assign testers to the test cases in the Test Cases related list.
4. Click the Notify Tester related link.
5. Enter a date in the Testing end date field in the dialog box and click OK.
   
   This date is used as the due date for the assessment.
   
   If the test plan is assigned to a project, the Testing start date is validated against the test phase start and end dates.
   
   A message indicates that testing has been kicked off and the assigned testers have been notified.
   
   The Notify Tester related link on the Test Plan form toggles to Cancel test execution.

**Cancel guided test execution**

If necessary, a test manager role can cancel the guided testing process after it has started and restart it if appropriate.

1. Navigate to Test Management > Test Execution > Test Plans.
2. Open the desired plan.
3. Click the Cancel test execution related link.
4. Click OK in the Cancel Execution dialog box.

   A message indicates that the test plan execution has been canceled and the metric type that was created for the test plan is deleted.

   The Cancel test execution related link on the Test Plan page toggles to Notify testers to start testing.

**Monitor the progress of testing**

The test manager can track the testing progress for test plans, test cases, and individual tests.

The Test Plans list shows the following information for each test plan:

- Percent complete
• Test cases failed
• Test cases passed
• Total number of test cases

The *Percent complete* field is calculated using this formula: (number of cases passed + number of cases failed) / total number of test cases

The *Test Cases* related list on the Test Plan form shows the following information for each test case:

• Tests passed
• Tests failed
• Test case execution status

The *Tests* related list on the Test Case form shows the following information for each test:

• Expected result
• Actual result
• Test status

**Test plan sign-off**

The Test Plan Sign-off form provides a way to record approval of the test plan.

This form provides an overview of the test case results, open test cases, and any open issues as of the current date. It displays the following information:

• A count of how many test cases passed, failed, are blocked, or are not tested.
• A list of the open test cases.
• A list of open defects and open issues (tests that are blocked, failed, or not executed).
• Sign-off details, including sign-off history.

**Note:** The test plan sign-off form is available on IE10 and later versions, as well as all other supported browsers.

Multiple sign-offs can be required for one test plan, and a test plan can be signed off even if it has failed test cases. Each sign-off takes a snapshot of the test plan in its current state, saves the snapshot as a PDF, and attaches the file to the test plan. This snapshot captures all test cases, including test cases with a status of failed or unexecuted, as well as open defects.

**Test Plan Sign-off Form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test Case Results</td>
<td></td>
</tr>
<tr>
<td>Passed</td>
<td>The number of cases that have passed.</td>
</tr>
<tr>
<td>Failed</td>
<td>The number of cases that have failed.</td>
</tr>
<tr>
<td>Blocked</td>
<td>The number of cases that are blocked.</td>
</tr>
<tr>
<td>Not Tested</td>
<td>The number of cases that have not yet been tested.</td>
</tr>
<tr>
<td>Open Test Cases</td>
<td></td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the test case.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Execution Status** | The status of the test case:  
  • Unexecuted  
  • In progress  
  • Passed  
  • Failed  
  • Blocked  
  • Retest  
  
  **Priority** | The priority that the test manager assigns to an open test case. If possible, you should close open test cases with a higher priority before test cases with a lower priority.  

  **Assigned to** | The tester assigned to the test case.  

  **Open Defects** | The number associated with a defect identified by the test plan. Testers can report a defect from a failed test.  

  **Short description** | A brief description of the defect.  

  **State** | The current state of the defect:  
  • Draft  
  • Scoping  
  • Awaiting approval  
  • Work in progress  
  • Testing/QA  
  • Deploy/launch  
  • Closed complete  
  • On hold  
  • Canceled  

  **Opened by** | The name of the user who opened the defect.  

  **Priority** | The priority assigned to the defect.  

  **Sign Off** | Any additional comments to be included in this test plan.  

  **Comments** | The user who signs off on the test plan.  

  **Sign-off By** | The date on which the test plan is signed off. This field defaults to the system date but can be set to any date.  

  **Sign-off Date** | The name of the user who previously signed off on the test plan.  

  **Sign Off History** | The date on which the test plan was previously signed off.  

  **Sign-off Date** | Any additional comments that were included in the previous sign-off.  

  **Comments** |
Test Plan Sign-off Form

Passed: 0  Failed: 1  Blocked: 0  Not Tested: 0

Open Test Cases as of 2014-12-10

All > Test Plan = Wed 12/10 > Execution Status IN (Unexecuted, In progress, Failed, Blocked, Rtest)

<table>
<thead>
<tr>
<th>Short description</th>
<th>Execution Status</th>
<th>Priority</th>
<th>Assigned to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Testing Status field</td>
<td>Failed</td>
<td>4 - Low</td>
<td>TMT0001002</td>
</tr>
</tbody>
</table>

Insert a new row...

No Open Defects as of 2014-12-10

Sign Off

Comments

Sign-off By: System Administrator

Sign-off Date: 2014-12-10

Submit
Complete the test plan sign-off form
The test manager uses the sign-off form to record approval of the test plan.

1. Navigate to Test Management > Test Execution > Test Plans.
2. Open the desired test plan.
3. Click the Sign-off Test Plan related link.
4. Enter any additional information in the Comments field.
5. If needed, select a different user in the Sign-off By field.
6. If needed, select a date in the Sign-off Date field.
7. Click Submit.

Test Management dashboard

View test plan reports on the Test Management dashboard.

The Test Management dashboard displays several test plan reports. For each report, you can select an individual test plan or you can select all active test plans for an overview of all testing.

To access the dashboard, navigate to Test Management > Overview. Then make the desired selection from the Select a Test Plan field. The data in the report updates automatically.

Test Management Dashboard Reports

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overall Test Coverage</td>
<td>Displays the test case distribution by execution status:</td>
</tr>
<tr>
<td></td>
<td>• Passed</td>
</tr>
<tr>
<td></td>
<td>• Failed</td>
</tr>
<tr>
<td></td>
<td>• Blocked</td>
</tr>
<tr>
<td></td>
<td>• In progress</td>
</tr>
<tr>
<td></td>
<td>• Unexecuted</td>
</tr>
<tr>
<td>Test Coverage By Component Tags</td>
<td>This report employs the tagging feature, which you can use to assign tags to test cases. Then use this report to display the test case distribution based on the assigned tags. For each tag, the different colors represent the execution status:</td>
</tr>
<tr>
<td></td>
<td>• Passed</td>
</tr>
<tr>
<td></td>
<td>• Failed</td>
</tr>
<tr>
<td></td>
<td>• Blocked</td>
</tr>
<tr>
<td></td>
<td>• In progress</td>
</tr>
<tr>
<td></td>
<td>• Unexecuted</td>
</tr>
<tr>
<td>Defect Distribution By Component Tags</td>
<td>This report employs the tagging feature, which you can use to assign tags to test cases. Then use this report to display test case defects based on the assigned tags. For each tag, the different colors represent the defect priority:</td>
</tr>
<tr>
<td></td>
<td>• Critical</td>
</tr>
<tr>
<td></td>
<td>• High</td>
</tr>
<tr>
<td></td>
<td>• Moderate</td>
</tr>
<tr>
<td></td>
<td>• Low</td>
</tr>
</tbody>
</table>
Pending Test Cases By Assignee

Number of test cases pending for each assigned tester.

Test Management Dashboard

Tester tasks

After the test manager creates test plans and assigns test cases, testers can perform tests and update test case status.

Users with the tester (tm_tester) role can use the Test Management application to perform the following tasks:

- Perform the tests in a test case and record the results.
- Update the test status.
- Report a defect if a test fails.
• Report a blocking issue if a test is blocked.
• Retest as necessary.
• Update the test case status.

Any user can be assigned to a test case and can perform the tests within that test case using the guided test execution feature.

You can perform tests in one of these ways:
• Using the Test Case form
• Using the visual task board
• Using guided test execution

Perform tests using the Test Case form

Users with the tester role can perform tests using the Test Case form.

Role required: tm_tester

1. Navigate to Test Management > Test Execution > Test Plans.
2. Click the assigned test case in the Test Cases related list.
3. Set the Execution Status field on the Test Case form to In progress and click Save.
4. In the Tests related list, open the first test.
   The test order is determined by the number in the Order field.
5. Set the Status field for the test to In progress.
6. Right-click the form header and click Save.
7. Perform the steps outlined in the Detailed description field.
8. Record the result in the Actual result field.
9. Compare the actual result to the expected result and update the test status in the Status field to one of the following:
   • Passed
   • Failed
   • Blocked
10. Click Update.
11. Repeat steps 4-10 for the remaining tests in the test case.
12. After all of the tests are complete, update the test case status.

Perform tests using the visual task board

With the visual task board you can perform tests using a bulletin board-type graphical interface.

Role required: tm_tester

1. Navigate to Test Management > Test Execution > Test Plans.
2. Click the Show Visual Task Board related link.
3. Open the assigned test case by clicking the test case number on the card.
4. Set the Execution Status field on the Test Case form to In progress and click Save.
5. In the Tests related list, open the first test.
   The number in the Order field determines the test order.
6. Set the Status field for the test to In progress.
7. Right-click the form header and click Save.
8. Perform the steps outlined in the Detailed description field.
9. Record the result in the **Actual result** field.

10. Compare the actual result to the expected result and update the test status in the **Status** field to one of the following values:
   - Passed
   - Failed
   - Blocked

11. Click **Update**.

12. Repeat steps 5–11 for the remaining tests in the test case.

13. After all tests are complete, update the test case status.

---

**Perform tests using guided test execution**

When the test manager initiates guided testing, the testers assigned to the test cases in the test plan are notified by email and can begin testing.

Role required: tm_tester

1. Navigate to **Self-Service > My Tests** or **Self-Service > My Assessments**.
   - A card with the test plan name and assignment information appears on the page.
2. Click the **Start Testing** button to display a list of assigned test cases and the tests included in each case.
3. Perform each of the tests in the test case by following the individual test steps.
4. Record a result for each of the tests: **Failed**, **Passed**, or **Blocked**.
5. Record an overall result for the test case at the bottom of the list: **Failed**, **Passed**, or **Blocked**.
6. Click **Submit** or **Save**.

---

**Update the test case status**

After performing all tests in a test case, update the test case status.

Set the **Execution Status** on the Test Case form to one of the following values.

- **Passed**: all tests assigned to this test case have a status of **Passed**.
  - The result is updated on the Test Plan form in the **Test Cases** related list.
- **Failed**: one or more of the tests assigned to this test case have a status of **Failed**.
  - The result is updated on the Test Plan form in the **Test Cases** related list.
  - The **Report Defect** link appears next to the **Execution Status** field on the Test Case form. If necessary, click this link to create a defect. For more information, see Report a Defect from a Failed Test.
  - To link an existing defect to the test case, click the **Assign Defect** related link. For more information, see Assign A Defect to a Test Case. When you link a defect to a test case, a reference to the test case is stored in the defect record. The Test Case form displays a related list of defects and the defect record displays a related list of test cases.
- **Blocked**: one or more of the tests assigned to this test case have a status of **Blocked**.
  - The **Blocked Reason** field is displayed on the Test Case form. Enter a reason why the test case is blocked before saving or updating the form.
- **Retest**: a defect resulting from a failed test has been closed or canceled and the test is ready to be run again.
The status of a test does not affect the status of the test case. Setting the status of the test case is a manual operation.

**Report a defect from a failed test**

If necessary, the tester can report a defect related to a **Failed** test status.

The **Report Defect** link is available only if **Agile Development** plugin is installed.

1. On the Test form, click one of the following links:
   - The **Report Defect** link next to the **Status** field.
   - The **Report defect** related link.

2. Fill in the fields on the Report Defect form (see table).

3. Click **Submit**.

### Report Defect Form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Automatically assigned defect number. For example, DFCT0010002.</td>
</tr>
<tr>
<td>Configuration item</td>
<td>Associated configuration item, if applicable to this defect.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group assigned to fix the defect.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Individual assigned to fix the defect.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority of the defect, from 1 (critical) to 5 (planning).</td>
</tr>
<tr>
<td>State</td>
<td>The current state of the defect:</td>
</tr>
<tr>
<td></td>
<td>• Draft</td>
</tr>
<tr>
<td></td>
<td>• Scoping</td>
</tr>
<tr>
<td></td>
<td>• Awaiting Approval</td>
</tr>
<tr>
<td></td>
<td>• Work in Progress</td>
</tr>
<tr>
<td></td>
<td>• Testing/QA</td>
</tr>
<tr>
<td></td>
<td>• Deploy/Launch</td>
</tr>
<tr>
<td></td>
<td>• Closed/Complete</td>
</tr>
<tr>
<td></td>
<td>• On hold</td>
</tr>
<tr>
<td></td>
<td>• Canceled</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief explanation of the defect.</td>
</tr>
<tr>
<td>Description</td>
<td>More detailed explanation of the defect.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Work notes</td>
<td>Any comments, notes, or other information that would be helpful to the individuals fixing the defect.</td>
</tr>
</tbody>
</table>

**Assign a defect to a test case**

After reporting a defect from a failed test, you can assign the defect to a test case.

The Report Defect link is available only if the Agile Development plugin is installed.

1. From the Test form, click the **Assign Defect to Test Case** related link.
2. Select a defect from the **Assign Defect to Test Case** dialog box.
3. Click **OK**.

The defect appears on the Test Plan form in the **Test Plan Defects** related list.
Test Management 2.0

The ServiceNow® Test Management 2.0 application streamlines the management of testing processes to help you deliver software products more efficiently and with fewer errors. You can create multiple versions of a test and integrate with Agile Development 2.0.

To learn about the different versions of Test Management and to choose the version that helps you meet your testing requirements, see Test Management applications.

<table>
<thead>
<tr>
<th>Explore</th>
<th>Set up</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test Management 2.0 overview</td>
<td>Activate Test Management 2.0</td>
<td>Test Board</td>
</tr>
<tr>
<td>General testing</td>
<td>Quick start tests for Test Management 2.0</td>
<td></td>
</tr>
<tr>
<td>Sprint testing</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Develop

- Developer training
- Developer documentation
- Installed with Test Management 2.0

Troubleshoot and get help

- Ask or answer questions in the Business Management community
- Search the HI Knowledge Base for known error articles
- Contact ServiceNow Technical Support

Test Management 2.0 overview

Test Management 2.0 helps you deliver software products more efficiently and with fewer defects by managing and streamlining testing processes for both testers and managers. You can create multiple versions of a test and integrate with Agile Development 2.0.

To learn about the different versions of Test Management and to choose the version that helps you meet your testing requirements, see Test Management applications.

<table>
<thead>
<tr>
<th>User</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tester</td>
<td>Can run tests and report defects on a software product by:</td>
</tr>
<tr>
<td></td>
<td>• Creating tests and test sets.</td>
</tr>
<tr>
<td></td>
<td>• Performing tests and recording test results.</td>
</tr>
<tr>
<td></td>
<td>• Updating status of tests.</td>
</tr>
<tr>
<td></td>
<td>• Reporting defects and retesting, if needed.</td>
</tr>
<tr>
<td>Test Manager</td>
<td>Can set up and monitor the manual testing process of a software product by:</td>
</tr>
<tr>
<td></td>
<td>• Creating and maintaining tests and test sets.</td>
</tr>
<tr>
<td></td>
<td>• Evaluating the tests, test steps, and test sets created by testers.</td>
</tr>
<tr>
<td></td>
<td>• Facilitating test execution by creating test plans, fragmenting a test plan into test cycles, and test cycles into test execution suites.</td>
</tr>
<tr>
<td></td>
<td>• Initiating a testing process by assigning tests to testers and then monitoring overall progress.</td>
</tr>
<tr>
<td></td>
<td>• Assessing test results and closing a test plan.</td>
</tr>
</tbody>
</table>
Key terminology

The following section describes the key terms used in Test Management 2.0.

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test</td>
<td>A collection of conditions or steps used to determine whether a feature is working correctly. A test can also include an expected result, which is used to determine if the test case passes or fails. You can use the Tests module to create and maintain different versions of a test.</td>
</tr>
<tr>
<td>Test set</td>
<td>A collection of related tests. A test can be a part of one or more test sets. You can use the Test Sets module to create a test set and group related tests into that test set.</td>
</tr>
<tr>
<td>Test plan</td>
<td>Plan describing how a product or a feature is to be tested and the time frame in which it must be executed. A test plan can be further broken into test cycles, and test cycles into test execution suites. You can use the Test Plans module to create test plans.</td>
</tr>
<tr>
<td>Runs</td>
<td>Detailed report of tests results, such as start time and end time of test execution, environment details, result of test execution. You can use the Run module to view the test results.</td>
</tr>
</tbody>
</table>

Activate Test Management 2.0

Activate the Test Management 2.0 plugin (com.snc.test_management.2.0) if you've the admin role.

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise they will receive the following error: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.
Installed with Test Management 2.0

Several types of components are installed with activation of the Test Management 2.0 plugin (com.snc.sdlc.test_management), including tables, and user roles.

Roles installed

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tester</td>
<td>Can create tests, and group similar tests to a test set.</td>
<td>None</td>
</tr>
<tr>
<td>[sn_test_management.test_manager]</td>
<td>Can create tests, group similar tests into test sets, manage test plans, and view the run results.</td>
<td>sn_test_management.test_manager</td>
</tr>
</tbody>
</table>

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task Test</td>
<td>Associates tests to multiple scrum tasks.</td>
</tr>
<tr>
<td>[sn_test_management_m2m_task_test]</td>
<td>Associates tests to multiple test sets.</td>
</tr>
<tr>
<td>[sn_test_management_m2m_test_set_test]</td>
<td>Extends the Planned Task table.</td>
</tr>
<tr>
<td>Steps</td>
<td>Stores details of test steps.</td>
</tr>
<tr>
<td>[sn_test_management_step]</td>
<td>Stores details of step results.</td>
</tr>
<tr>
<td>Test</td>
<td>Stores details of tests.</td>
</tr>
<tr>
<td>[sn_test_management_test]</td>
<td>Stores the linking of tests to testers.</td>
</tr>
<tr>
<td>Test Execution Assignment</td>
<td>Stores details of test cycles.</td>
</tr>
<tr>
<td>[sn_test_management_test_cycle]</td>
<td>Stores details of test environments.</td>
</tr>
<tr>
<td>Test Environment</td>
<td>Stores details of test execution suites.</td>
</tr>
<tr>
<td>[sn_test_management_test_execution_suite]</td>
<td></td>
</tr>
</tbody>
</table>
### Quick start tests for Test Management 2.0

Validate that Test Management 2.0 still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

Quick start tests require activating the `plugin (com.snc.test_management.2.0)`, and the `- ATF Tests plugin (com.snc.test_management.2.0.atf)`.

#### Test Management 2.0: Test version test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create test version should create test</td>
<td>Validate test creation and version.</td>
<td></td>
</tr>
<tr>
<td>Should be able to mark test version as ready when it contains verification steps</td>
<td>Validate test state when test has verification steps.</td>
<td></td>
</tr>
<tr>
<td>Should not be able to mark test version as ready when it does not contain verification step</td>
<td>Validate test state when test does not have verification steps.</td>
<td></td>
</tr>
<tr>
<td>Marking a test version as ready should retire other test version in ready state</td>
<td>Validate test state when marking test ready.</td>
<td></td>
</tr>
</tbody>
</table>

#### Test Management 2.0: Test results rollup test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>When test run closed, should update execution suite progress</td>
<td>Validate execution state progress.</td>
<td></td>
</tr>
<tr>
<td>Should not be able to assign a test not in ready state</td>
<td>Validate test assignment.</td>
<td></td>
</tr>
</tbody>
</table>
### General testing

You can use Test Management 2.0 for general testing such as testing a phase in a release, testing a set of features or products before their market launch, or perform release readiness testing on integration and accessibility (for new software).

General testing comprises the following steps:

1. Creating tests.
2. Creating test sets, and grouping similar tests into a test set.
3. Using the Test Board feature to create a test plan.
4. Structuring the test plan in the Test Board, **Planning** tab.
   - Breaking down the test plan into test cycles to plan and schedule the phases of the testing effort.
   - Breaking down the test cycles into test execution sets to schedule tests, and assign users to run those tests.
5. Running tests and viewing the test run results.

### Create a test

Create a test specifying conditions or steps to determine whether a feature is working correctly.

Role required: sn_test_management.tester or sn_test_management.test_manager

1. Create a test using either of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Test Management 2.0</td>
<td>a. Navigate to Test Management 2.0 &gt; Tests.</td>
</tr>
<tr>
<td></td>
<td>b. To create a test, click <strong>New</strong>.</td>
</tr>
<tr>
<td>From Agile Development 2.0</td>
<td>a. Navigate to Agile Development 2.0 &gt; Agile Board.</td>
</tr>
<tr>
<td></td>
<td>b. Click the <strong>Sprint Tracking</strong> Tab.</td>
</tr>
<tr>
<td></td>
<td>c. Select the <strong>List</strong> view.</td>
</tr>
<tr>
<td></td>
<td>d. From the <strong>Show</strong> list at the top right corner, select <strong>Tests</strong>.</td>
</tr>
<tr>
<td></td>
<td>e. Click <strong>Add Test</strong>.</td>
</tr>
</tbody>
</table>

2. In the form, fill in the following fields:

<table>
<thead>
<tr>
<th>Test Version form</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Test</td>
</tr>
<tr>
<td>Owner</td>
</tr>
<tr>
<td>Field</td>
</tr>
<tr>
<td>---------------------</td>
</tr>
<tr>
<td>Version</td>
</tr>
<tr>
<td>State</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Short description</td>
</tr>
<tr>
<td>Add Step</td>
</tr>
<tr>
<td>Run</td>
</tr>
<tr>
<td>Update</td>
</tr>
<tr>
<td>Ready</td>
</tr>
<tr>
<td>Create New Version</td>
</tr>
<tr>
<td>Delete</td>
</tr>
<tr>
<td><img src="#" alt="Icon" /></td>
</tr>
<tr>
<td>Needs Verification</td>
</tr>
<tr>
<td><img src="#" alt="Icon" /></td>
</tr>
</tbody>
</table>
3. Click **Submit**.
Test version form example
To add a test to a test set:

1. Select the test from the Test list.
2. Click Add to Test Set.

Create a test set

Group related tests into a test set. Test sets help you find tests by category or tag.

Role required: sn_test_management.tester or sn_test_management.test_manager

1. Navigate to Test Management 2.0 > Test Sets.
2. Click New.
3. Enter a name for the test set and click Submit.

You must add tests to the test set.

1. Navigate to Test Management 2.0 > Tests.
2. Select the required tests.
3. Click Add to Test Set.
4. In the Select Test Set window, search for the required test set and click Add.

Test Board

Test Board gives you a comprehensive view of your test plans and enables you to manage test plans more efficiently.

In Test Board, you can:

- Aggregate all your test plans and view them as cards at a single location. Each card displays key details of your test plan such as the start and end date, percentage of tests that have passed, percentage of tests that have failed, percentage of tests that have been blocked, and number of days left for completion.
- Search for specific test plans by defining filter conditions such as name, duration, or owner.
- Track, manage, and complete your test plans from a single interface, which saves you time and effort.

1. Define how a product or feature must be tested by creating a test plan.
2. Structure your test plan in the Planning tab. Break down your test plan into test cycles to plan and schedule the phases of testing effort. Further break down your test cycles into test execution sets, schedule the tests, and assign users to run those tests.
3. Monitor the progress and completion of your test plans.
Aggregated view of test plans in Test Board

Planning tasks

You can structure a test plan in the Test Board **Planning** tab, which provides the following capabilities:

**Test plan work item hierarchy**

The Test plan work item hierarchy presents a wide variety of test plan information in expandable rows. It provides a quick overview of the test plan, with test cycles and test execution suites nested within the test plan.

In addition, you can:

- Modify the attributes (such as start and end time) of the test plan, test cycles, and test execution suites rather than opening each form and modifying the field values one by one.
- Add or delete test cycles and test execution suites, adjust their start and end dates, and then assess the overall progress of the test plan.
- Configure the columns displayed in the Test plan work item hierarchy.

**Gantt chart**

The Gantt chart provides a visual representation of the timeline of the test plan and its child tasks using a blue task bar. The length of the task bar pertaining to the test plan increases and decreases depending on the adjustments you make to the duration of its child tasks. You can also manually increase or decrease the duration by dragging the edge of the task bar to the required location.
Test plan work item hierarchy and Gantt chart on the Planning tab

Create a test plan using Test Board
Define how to test a product or feature by creating a test plan.

Role required: sn_test_management.test_manager

1. Navigate to Test Management 2.0 > Test Board.
2. Click Create Test Plan.
3. In the form, fill in the fields:

<table>
<thead>
<tr>
<th>Test Plan form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Planned start date</td>
</tr>
</tbody>
</table>

4. Click OK.
   The Details tab opens.
5. Provide, review, and edit the test plan details.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planned end date</td>
<td>Planned date and time for ending the test plan execution.</td>
</tr>
<tr>
<td>Duration</td>
<td>Estimated duration of test plan. This is the difference between the planned start date and the planned end date.</td>
</tr>
<tr>
<td>Number</td>
<td>Automatically generated unique ID number for the test plan.</td>
</tr>
<tr>
<td>Owner</td>
<td>Owner who created the test plan.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the test plan.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Pending</strong>: Test plan is not yet ready to be performed.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Open</strong>: Test plan is ready to be performed.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Work in progress</strong>: Test plan is currently being performed.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Closed complete</strong>: Test plan has been closed after completion.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Closed incomplete</strong>: Test plan has been closed without completion.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Closed skipped</strong>: Test has been closed without being performed.</td>
</tr>
</tbody>
</table>

**Description**
Description of the test plan.

**Note:** The Progress section displays the overall status of the test plan indicating the percentage of tests in the test plan that have passed, failed, or been blocked.

---

**Add and modify test cycles and test execution suites**
Add and modify test cycles and test execution suites from a single user interface without having to switch between multiple user interfaces and forms.

**Role required:** sn_test_management.test_manager

1. Navigate to **Test Management 2.0 > Test Board**.
2. Select the test plan.
3. Select the **Planning** tab.
4. Add or modify test plans and test execution suites in the Test plan work item hierarchy.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>To add a test cycle</strong></td>
<td>a. Select a test plan.</td>
</tr>
<tr>
<td></td>
<td>b. Right-click and select <strong>Add Test Cycle</strong>, or click the add icon (+).</td>
</tr>
<tr>
<td><strong>To edit a test cycle in a form</strong></td>
<td>a. Select the test cycle.</td>
</tr>
<tr>
<td></td>
<td>b. Right-click and select <strong>Edit</strong>.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| To delete a test cycle with its test execution suites | a. Select the test cycle.  
   b. Right-click and select Delete. |
| To add a test execution suite | a. Select a test cycle.  
   b. Right-click and select Add Execution Suite, or click the add icon ( + ). |
| To edit a test execution suite in a form | a. Select the test execution suite.  
   b. Right-click and select Edit. |
| To add tests to a test execution suite | a. Select the test execution suite.  
   b. Right-click and select Add tests. |
| To add test sets to a test execution suite | a. Select the test execution suite.  
   b. Right-click and select Add test sets. |
| To hide or display columns | a. Click the gear icon ( ).  
   b. Select or deselect the required check box. The column preferences are saved. |

5. View the summary or adjust the duration of a task in the Gantt chart:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To view the summary of a task</td>
<td>Point to a task.</td>
</tr>
<tr>
<td>To change the planned start or end dates of a task</td>
<td>Click the task, and drag the left or right edge of the task bar to the required date.</td>
</tr>
<tr>
<td>To move a task to a new date</td>
<td>Click the task, and drag the whole task bar to a new date.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>To zoom the calendar in or out</td>
<td>On the top of the calendar, click one of the time periods such as the month, or day. Then, select a <strong>Zoom Level</strong> from the calendar.</td>
</tr>
</tbody>
</table>

**Zoom Level**

<table>
<thead>
<tr>
<th>Day</th>
<th>Week</th>
<th>Month</th>
<th>Quarter</th>
<th>Year</th>
<th>Auto Fit</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Date Selector**

<table>
<thead>
<tr>
<th>September 2018</th>
</tr>
</thead>
<tbody>
<tr>
<td>Su  Mo  Tu  We  Th  Fr  Sa</td>
</tr>
<tr>
<td>2    3    4    5    6    7    8</td>
</tr>
<tr>
<td>9    10   11   12   13   14   15</td>
</tr>
<tr>
<td>16   17   18   19   20   21   22</td>
</tr>
<tr>
<td>23   24   25   26   27   28   29</td>
</tr>
<tr>
<td>30</td>
</tr>
</tbody>
</table>

When the zoom level in calendar is selected as **Auto Fit**, the Gantt view fits in one page so that you can view the entire timeline for the test plan without using the scrollbar.

---

**Define a custom column in the Planning tab**

Define a custom column to display information important to you in the Test plan work item hierarchy section of the **Planning** tab. For example, define a column to view the percentage of test plan that has been completed.

Role required: admin

1. Navigate to **Test Management 2.0 > Settings > Planning Console**.
2. Click the gear icon (⚙️) at the top right corner of the page.
3. In the System Settings window:
   a. Select the Developer section.
   b. In the **Application** list, select **Test Management** and then close the window.
4. In the **Planning Console Display Columns** related list, click **New**.
5. In the Planning Console Display Column form, provide a label and other details for the column.
6. Click **Submit**.

After you create a column, associate the column to the required table.

**Create a short test plan**

Create a short test plan when the testing effort is minimal and you do not want to go through the overhead of creating a test plan and a test cycle for a test execution suite.

Role required: sn_test_management.test_manager

1. Navigate to **Test Management 2.0 > Test Execution Suites**.
2. In the form, fill in the fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the test execution suite.</td>
</tr>
<tr>
<td>Planned start date</td>
<td>Planned date and time for starting the test execution suite.</td>
</tr>
<tr>
<td>Planned end date</td>
<td>Planned date and time for ending the test execution suite.</td>
</tr>
<tr>
<td>Planned duration</td>
<td>Estimated duration for the test execution suite. This duration is the difference between the planned start date and the planned end date.</td>
</tr>
<tr>
<td>Number</td>
<td>Automatically generated number for the test execution suite.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the test execution suite.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group working on test execution suite.</td>
</tr>
<tr>
<td><strong>Progress</strong></td>
<td></td>
</tr>
<tr>
<td>Percent complete</td>
<td>Percentage of test execution suites that have been completed. Value is calculated automatically.</td>
</tr>
<tr>
<td>Percent passed</td>
<td>Percentage of test execution suites that have passed. Value is calculated automatically.</td>
</tr>
<tr>
<td>Percent failed</td>
<td>Percentage of test execution suites that have failed. Value is calculated automatically.</td>
</tr>
<tr>
<td>Percent blocked</td>
<td>Percentage of test execution suites that were blocked. Value is calculated automatically.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

- To add tests to the test execution suite, click **Add tests**. From the **Tests** list, select the required tests, and click **Add to Execution Suite**.
- To add test sets to the test execution suite, click **Add test sets**. From the **Test Sets** list, select the required test sets, and click **Add to Execution Suite**.
- In the **Test execution assignments** related list, select the test and assign it to a user.

**Run your test assignments**

Run your test assignments and capture the results.
Role required: sn_test_management.tester

1. Navigate to Test Management 2.0 > Tests Assigned to me.
2. Select the required tests and click Run.

**Note:** Only the tests that are in the Ready state can be run.

3. In the pop-up, select the execution environment on which the tests must be run.
4. In the Test Execution pop-up, mark a step as passed, failed, or blocked using the following icons:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Passed icon]</td>
<td>Passed.</td>
</tr>
<tr>
<td>![Failed icon]</td>
<td>Failed. In this state options to add comments and attachments are available.</td>
</tr>
<tr>
<td>![Blocked icon]</td>
<td>Blocked. In this state options to add comments and attachments are available.</td>
</tr>
</tbody>
</table>

You can also use the Tab key to select an icon. Press Tab and press Enter.

5. Click Done. Test results are saved to the Test Result form.

The test has one of the following statuses:

- If all the test steps are passed, the status of the test is **Passed**.
- If at least one step of the test is not run, the status of the test is **Not finished**.
- If at least one step of the test fails, the overall status of the test is **Failed**. This rule takes precedence over the previous rule.
- If at least one step of the test is blocked, the overall status of the test is **Blocked**. This rule takes precedence over the previous two rules.

View all the test results in the Test Management 2.0 > Test Runs.

**Sprint testing**

You can use Test Management 2.0 with Agile Development 2.0 to test the work of a scrum team sprint-by-sprint.

Sprint testing comprises the following steps:

1. Creating tests for the stories in sprints.
2. Running tests, verifying the test results, and closing stories.

**Test Management 2.0 integration with Agile Development 2.0**

With the integration of Test Management 2.0 and Agile Development 2.0, you can perform sprint testing from Agile Development 2.0 > Agile Board > Sprint Tracking.

- Find what tests are to be run for the sprint.
- Create tests for the stories in sprints.
- Maintain multiple versions of a test.
• Run a single version of a test at one time.
• View which version of test has been run.
• Review the history of test results.
• Close stories.

Create a test for a story

Create a test, add steps to the test, and create and maintain different versions of the test. A test is a collection of conditions or steps used to determine whether a story is working correctly. A test can also include an expected result, which determines whether the test passes or fails.

• Role required: scrum_user or scrum_admin
• You can create a test from the List view only when Agile Development 2.0 is installed along with Test Management 2.0.
• You must be a member of an agile group.

1. Navigate to Agile Development > Agile Board.
2. Click the Sprint Tracking tab, and select the List view.
3. From the Show list at the top right corner, select Tests.
4. Click Add Test.
5. In the form, fill in the fields:

<table>
<thead>
<tr>
<th>Test Version form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Test</td>
<td>Unique name of the test.</td>
</tr>
<tr>
<td>Owner</td>
<td>Owner who created the test.</td>
</tr>
<tr>
<td>Version</td>
<td>Automatically generated version of the test.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the test.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description about the test.</td>
</tr>
<tr>
<td>Add Step</td>
<td>Button used to add step to a test.</td>
</tr>
<tr>
<td>Run</td>
<td>Button used to run steps, which is displayed only when the test is in the Ready state. See Run your tests from the List view.</td>
</tr>
<tr>
<td>Update</td>
<td>Button used to update the details of a test version.</td>
</tr>
<tr>
<td>Ready</td>
<td>Button used to change the state of the test version to ready.</td>
</tr>
<tr>
<td>Create New Version</td>
<td>Button used to create another version of the test.</td>
</tr>
<tr>
<td>Delete</td>
<td>Button used to delete the test version.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>[Icon]</td>
<td>Icon used to change the order of a test step. Select the icon and drag the step to the required location.</td>
</tr>
<tr>
<td>Needs Verification</td>
<td>Check box used to mark a test step for verification.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Icon used to delete a test step.</td>
</tr>
</tbody>
</table>
Test Version form example
View information in the following related lists:

<table>
<thead>
<tr>
<th>Related list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other versions</td>
<td>Displays all the versions of a test.</td>
</tr>
<tr>
<td>Test Results</td>
<td>Displays the run results of each test version.</td>
</tr>
<tr>
<td>Test Sets</td>
<td>Displays related tests in a test set.</td>
</tr>
</tbody>
</table>

**Run your tests from the List view**

View the test scenario, execute all the steps of the test, and review the test result.

Role required: scrum_user

1. Navigate to **Agile Development > Agile Board**.
2. Click the **Sprint Tracking** tab and select the **List** view.
3. Click a test.
4. You can verify a story by running all of its tests at once. To do this, use the **Run** button at the right of the story.
5. In the pop-up, select the environment on which the test is to be run:
   a. Click **Lookup using list** icon.
   b. Click **Run**.
6. In the Test Execution pop-up, mark a step as passed, failed, or blocked using the following icons:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Passed" /></td>
<td>Passed.</td>
</tr>
<tr>
<td><img src="image" alt="Failed" /></td>
<td>Failed. In this state, options to add comments and attachments are available. Option to delete attachments is also available.</td>
</tr>
<tr>
<td><img src="image" alt="Blocked" /></td>
<td>Blocked. In this state, options to add comments and attachments are available. Option to delete attachments is also available.</td>
</tr>
</tbody>
</table>

- To select an icon, you can also use the **Tab** key. Press **Tab** and then press **Enter**.
- To pause and work on the test at a later point in time, click **Pause**.
7. Click **Done**.

Test result is saved to the Test Result form, and the latest test result of each test is displayed in the List view.

The overall status of the test is defined by statuses of the test steps:

- If all the test steps are passed, the status of the test is **Passed**.
- If at least one step of the test is not run, the status of the test is **Not finished**.
- If at least one step of the test fails, the overall status of the test is **Failed**. This rule takes precedence over the previous rule.
- If at least one step of the test is blocked, the overall status of the test is **Blocked**. This rule takes precedence over the previous two rules.
Migration from Test Management 1.0 to Test Management 2.0

Migrate your test data from Test Management 1.0 to Test Management 2.0, and start using Test Management 2.0 for its enhanced testing capabilities and features.

Apply the following migration steps on a non-production instance, verify if the migration is completed as intended, and then perform the migration steps on a production instance.

Activate plugins

Activate the Test Management 2.0 (com.snc.test_management.2.0) and Test Management 2.0 — Data Migration (com.snc.test_migration_v1_v2) plugins.

Migrate data

The migration process allows you to move test suites, test cases, and tests.

Note:

- Test plans cannot be migrated due to significant change of data model.
- Test suites, test cases, and tests that are migrated to Test Management 2.0 will not be removed from Test Management 1.0.

Test cases that are migrated to Test Management 2.0 are converted to test versions in the following manner:

<table>
<thead>
<tr>
<th>Test Management 1.0: Test case</th>
<th>Test Management 2.0: Test version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Description</td>
<td>Short Description</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain</td>
</tr>
<tr>
<td>Test Suite</td>
<td>Creates a relationship between test and test set</td>
</tr>
<tr>
<td>Prerequisites</td>
<td>Link to the old test case</td>
</tr>
</tbody>
</table>
Tests that are migrated to Test Management 2.0 are converted to test steps in the following manner:

<table>
<thead>
<tr>
<th>Test Management 1.0: Test</th>
<th>Test Management 2.0: Test step</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>Order</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain</td>
</tr>
<tr>
<td>Detailed description</td>
<td>Link to the old test</td>
</tr>
<tr>
<td>Test</td>
<td>Step</td>
</tr>
<tr>
<td>Test data</td>
<td>Link to the old test</td>
</tr>
<tr>
<td>Expected result</td>
<td>Verification step</td>
</tr>
</tbody>
</table>

Test suites that are migrated to Test Management 2.0 are converted to test sets in the following manner:

<table>
<thead>
<tr>
<th>Test Management 1.0: Test Suite</th>
<th>Test Management 2.0: Test set</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name</td>
</tr>
<tr>
<td>Owner</td>
<td>Owner</td>
</tr>
</tbody>
</table>
Add custom fields to migration

You have added custom fields to the tables of Test Management 1.0, and want to move the fields to the corresponding custom columns in Test Management 2.0. In such a case, include the custom fields into migration by overriding the mapping information in the script include `TestMigrationTableMapping`. The default mapping is provided in the script include `TestMigrationTableMappingBase`.

Convert test suites

Convert test suites with underlying test cases to test sets and tests.

Convert test suites

Convert test suites in Test Management 1.0 to test sets in Test Management 2.0. Start using Test Management 2.0 for its enhanced testing capabilities and features.

- Role required: admin
- Install the Test Management 2.0 — Data Migration plugin (com.snc.test_migration_v1_v2).

1. Navigate to Test Migration > Migrate Test Suites.
   - A list of test suites available in Test Management 1.0 are displayed.
2. Select the required test suites and convert to them to test sets.

Appendix — Test Management 2.0

Test Management 2.0 offers a few enhancements over Test Management 1.0.
These enhancements can be divided into the following categories:

- Functionality enhancements
- Data model enhancements
- Usability enhancements

Functionality enhancements in Test Management 2.0

Test Management 2.0 offers a few functionality enhancements over Test Management 1.0.

Integration with Agile Development 2.0

Test Management 2.0 is integrated with Agile Development 2.0. This integration provides embedded testing capabilities for scrum teams. Test Management 2.0 enables you to create tests for stories of the sprint, and also track the execution and completion of those tests. As a scrum
master or a product owner, you gain an insight of the stories that are tested and are to be closed.
Data model enhancements in Test Management 2.0

Test Management 2.0 offers a few data model enhancements over Test Management 1.0.

Enhanced traceability

Each test in Test Management 2.0 can have multiple versions. When a test version is in the state Ready, it can be run but cannot be edited. Every test result is associated with a specific run and a specific version of
the test. Due to this logic, you can always be sure of the content of the test when a specific test result was
More flexible approach to organize tests

Unlike Test Management 1.0, where test cases can be placed in only one test suite, in Test Management 2.0 tests can be placed in multiple test sets. Test sets are free-form collections of tests. Tests can be grouped into test sets using any logic: by product, by component, or by release.

Test plan defines the time frame

A test plan in Test Management 2.0 captures the time frame during which the tests are to be run. In addition, a test plan can be broken down into smaller planning windows, test cycles, for more precise planning, such as user acceptance testing, and integration testing. Further test cycles can be broken down into test execution suites, which are
similar to sprints in testing. A test execution suite defines when a test must be run and by whom.

**Usability enhancements in Test Management 2.0**

Test Management 2.0 offers a few usability enhancements over Test Management 1.0.

Create and track the execution of tests for stories of the sprint in the **Sprint Tracking** tab in Agile Board. In addition, you can:

- View the test result of each test.
• Run all the tests for a story at one time.
Agile Team

Current Sprint

- Story 001: As a program level user, I want to be able to drag and drop features within my backlog, so that I can rank them
  - Story 002: The user with the 'program_user' role should be able to drag and drop features in the backlog
  - Story 003: The user without the 'program_user' role should not be able to drag and drop features in the program backlog

- Story 004: As a keyboard-only user, I want to be able to drag and drop features using keyboard, so that I can rank them
  - Story 005: The user should be able to move features around using keyboard
  - Story 006: The user should be able to exit the drag and drop mode by pressing escape

- Story 007: As a program level user, I want to be able to create new features, so that I can break down epics into features
  - Story 008: As a user, I want to see a list of epics that are linked to my program, so that I can review my backlog epic by epic

- Story 009: My email is not working

Status:
- Run: Ready for testing
- Passed
- Failed
- Work in progress
- Open
Easier way to create tests

Test Management 2.0 provides a new user experience for creating tests.

- Test steps can be created without leaving the context of test form.
- Entire test scenario can be created at one time. Type in the step description, and press Enter to proceed to the next step.
• You need not create an extra record to capture expected results. Expected results can be captured as another test step that is marked as a verification step.
Enhanced user experience for running tests

Test Management 2.0 provides a new user interface for running tests. The interface opens in a small browser window, which can be placed side by side with the system that is being tested. You can go through multiple tests at one time, without having to relaunch the window. Whenever a step is marked as failed or blocked, you can add a comment and attachment to record your observation.
Visual approach of structuring test plans

Test Management 2.0 provides a designated user interface, Test Board, for creating and structuring test plans. As a test manager, you can create a test plan, test cycles, and test execution suites and define the time frame for their execution. The names of the test cycles and execution suites can be edited inline, without leaving the page. Test execution suites can then be filled with tests, and those tests can be assigned to testers.

The test plan work hierarchy item in the Test Board provides a visual representation of the timeline of the test plan and its child tasks using a blue task bar. The length of the task bar pertaining to the test plan increases and decreases depending on the adjustments you make to the duration of its child tasks. You
can also manually increase or decrease the duration by dragging the edge of the task bar to the required
**Business Planning Portal**

A business plan consists of a business goal and a plan to achieve that goal. Business planning involves various entities of a business such as goals, business units, business capabilities, capability map, enterprise strategies, and business unit strategies. As a business planner you can manage these entities from the business planning portal.

To access the business planning portal, the Business Planner (com.snc.apm.business_planner) plugin must be activated. This plugin is installed only when any one of the other ITBM plugins is already installed.

To access all the entities related to business planning, goals, business units, enterprise strategy, business unit strategy, capabilities, and capability map have been consolidated in the **Business Planner** module.

**Business planning portal for the business planner**

A business planner with the business_planner role can do various tasks from the business planning portal such as to view, create, and update the business entities to achieve the business goals. In addition, the Business Planner can view the Capability Map.

**Note:** The role of a business planner involves only planning and managing the entities to achieve the business goal and does not deal with the business applications or technologies that support the business.
BUSINESS PLANNING

- 154 No of capabilities
- 5 Strategies
- 14 Business Units
- 22 No of goals

Recent Activity
- Mar 23, 2021
  - Created goal
    You have created goal Increase standards Compliance by M6 by FY11
- Created goal
  - You have created goal Decrease Capex by $10,000,000 by FY20
- Created goal
  - You have created goal Increase Cloud Applications by 20 by FY20
- Created strategic objective
  - You have created strategic objective Performance to compliance requirements
- Created strategic objective
  - You have created strategic objective Reinvent supply chain technology
The business planning portal helps the business planner to view and create goals, business unit, capabilities, and strategies.

**No. of capabilities**
Displays the number of capabilities that have been created. Click to view the list of capabilities defined for the business enterprise. Create a business capability if the existing capabilities do not conform to your business plan.

If you have installed APM, then the **Map** link is available. Click **Map** to launch the capability map.

**Strategies**
Displays the number of objectives that have been created. Click to view the list of strategic objectives that align with your business plans. Click to create a business unit strategy or an enterprise strategy to fulfil a new business plan. You can also assign strategies to a goal.

- Enterprise strategy is at a higher level and business unit strategies can be assigned at its child level.
- Business unit strategy is at a lower level and an enterprise strategy or a business unit strategy can be assigned as a parent strategy.

**Business Units**
A business unit is a segment of an enterprise that represents a specific business function. View the existing number of business units in your organization. Click to create a business unit to define its functions.

**No. of goals**
View the number of goals created to achieve a business plan. You can relate goals to many enterprise and business unit strategies. Similarly, more than one enterprise and business unit strategies can be related to more than one goal. Click a goal from the list to update its status and assign a task to it. You can also create a goal.

**Recent Activity**
View the recent goals, strategic objectives, and business units that you had created.

**Business units**
Business units are parts of your organization that are in charge of certain operations, such as Finance, HR, IT, and so on.

Business units typically comprise departments and are associated with a company. By default, the Hierarchy of Segments includes a segment for business units, departments, and vendors, which are companies with the **Vendor** option selected. With the segment setup, you can allocate expenses to specific business units, departments, or vendors, or have expense allocations roll up to them. You can configure both departments and companies as part of user management.

**Create business units**
Create a business unit to define your organizational functions. A business unit is also necessary to set up the top-most segment in the hierarchy of segments to create rollup rules and have expenses roll up to these business units.

Role required: business_planner

1. Navigate to **Organization > Business Units**.
2. Click **New**.
3. Fill out the fields on the form (see table).
4. Click **Save**.

**Business Unit form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the business unit.</td>
</tr>
<tr>
<td>Company</td>
<td>The company, if any, associated with this business unit. You can choose any company, including those that do not have the <strong>Vendor</strong> field selected.</td>
</tr>
<tr>
<td>Business Unit Head</td>
<td>Person who heads the business unit.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the business unit.</td>
</tr>
<tr>
<td>Parent</td>
<td>Refers to another business unit. The <strong>Parent</strong> field makes the business unit as a hierarchy element.</td>
</tr>
<tr>
<td>Hierarchy level</td>
<td>Number or text to indicate the level of the business unit.</td>
</tr>
<tr>
<td>Related List</td>
<td></td>
</tr>
<tr>
<td>Departments</td>
<td>Departments that comprise this business unit. Add as many departments as necessary.</td>
</tr>
</tbody>
</table>

**Create an enterprise strategy**

As a business planner you can manage the business entities such as goals, business units, business enterprise strategies, and business unit strategies. Create an enterprise strategy to orient your business plan towards your goal.

Role required: user_admin, business_planner

To understand how your organizational strategies are performing, see the **Strategic Spend Tracking for PPM dashboard** topic. It provides comprehensive visualization to help you understand how the planned costs, actual costs, and benefits for projects aligned to your organization's strategies trend over time.

1. Navigate to **Business Planner > Enterprise Strategy**.
   You can also navigate to **Organization > Enterprise Strategy**.
2. Click **New** or open a record.
3. Fill in the form fields.

**Enterprise Strategy form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>A short title describing the enterprise strategy.</td>
</tr>
<tr>
<td>Number</td>
<td>System assigned enterprise number.</td>
</tr>
<tr>
<td>Assigned To</td>
<td>Person to whom the enterprise strategy is assigned.</td>
</tr>
<tr>
<td>From Date</td>
<td>Date from which the enterprise strategy is valid.</td>
</tr>
<tr>
<td>To Date</td>
<td>Date until which the enterprise strategy remains valid.</td>
</tr>
<tr>
<td>Type</td>
<td>Select a type of organization strategy that this strategy aligns to.</td>
</tr>
</tbody>
</table>
Use the **Business Unit Strategies** related list to create a strategy for a business unit and associate the business unit strategy to the enterprise strategy, to another business unit, or to another business unit strategy.

### Create a business unit strategy

As business units are segments of an enterprise that are in charge of certain operations such as Finance, HR, IT, and so on, each of these business units can have a strategy that aligns with the enterprise or with another business unit.

Role required: user_admin, business_planner

1. Navigate to **Business Planner > Business Unit Strategy**.
   
   You can also navigate to **Organization > Business Unit Strategy**.

2. Click **New** or open a record.

3. Fill in the form fields.

   **Business Unit Strategy form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>A short title describing the enterprise strategy.</td>
</tr>
<tr>
<td>Number</td>
<td>System assigned enterprise number.</td>
</tr>
<tr>
<td>Assigned To</td>
<td>Person to whom the enterprise strategy is assigned to.</td>
</tr>
<tr>
<td>From Date</td>
<td>Date from which the enterprise strategy is valid.</td>
</tr>
<tr>
<td>To Date</td>
<td>Date until which the enterprise strategy remains valid.</td>
</tr>
<tr>
<td>Business Unit</td>
<td>The business unit for which the strategy is being created.</td>
</tr>
<tr>
<td>Strategy</td>
<td>Strategic objectives of the organization that the business unit strategy complies to.</td>
</tr>
<tr>
<td>Type</td>
<td>Select a type of organization strategy that this strategy aligns to.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable the check box to make the enterprise strategy active.</td>
</tr>
<tr>
<td>Description</td>
<td>Short description about the enterprise strategy.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

View the strategic objectives that you have created in the business planning portal. The records of business planning strategic objectives give you a clear visibility as to their status, to whom they are assigned to, the period of validity, and their type.
Cost Management

The ServiceNow® Cost Management application tracks configuration item costs. The costs can be allocated to business units and used in reports.

The previous name of this application was Financial Management. In this release, other financial management applications are available: see Financial Management and Finance Service Automation.

Cost management enables these features:

• Using rate cards.
• Defining configuration item (CI) costs.
• Tracking one-time costs for CIs.
• Processing recurring CI costs to generate expense lines.
• Distributing bulk costs to multiple expense line sources.
• Tracking costs related to tasks and projects.
• Aggregating configuration item costs and charging the total cost to a business service or application.
• Allocating expense lines to business units with flexible allocation rules.
• Tracking planned and actual budget costs by cost center.

Cost Management Options

Use the following cost management options to plan and control business costs.

• Create rate cards to properly track configuration item, contract, task, and labor costs.
• Create expense lines and expense allocation rules.
• Aggregate configuration item costs and apply the total cost to a business service or application using relationship paths.
• Create distribution costs and distribution cost rules to divide costs between a group of records.

Cost Management components

Several components are installed with the Cost Management application.

Demo data is available with Cost Management. The demo data provides sample budgets, distribution costs, expense allocations, contract rate cards, and rate card costs.

Tables

Cost Management adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allocation Unit [allocation_unit]</td>
<td>Tracks capacity and usage for a business service. Stores reference to business service, total, allocated, and remaining units of capacity.</td>
</tr>
<tr>
<td>Budget [fm_budget]</td>
<td>Tracks planned and total expense allocation amounts for a collection of cost centers.</td>
</tr>
<tr>
<td>Budget Cost Center [fm_budget_cost_center]</td>
<td>Associates one or more cost centers to a budget.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>CI Cost Center Relationship</td>
<td>Associates a cost center to a business service that it consumes and the number of units it uses. This is used to calculate the number of allocated units to update the allocation unit record.</td>
</tr>
<tr>
<td>CI Rate Card [fm_ci_rate_card]</td>
<td>Links configuration items and costs. A classification can also be defined to allow for multiple rate cards for a group of CIs.</td>
</tr>
<tr>
<td>CI Rate Cards [fm_ci_rate_card_cmdb_ci_m2m]</td>
<td>Associates configuration items to a rate card.</td>
</tr>
<tr>
<td>Contract Rate Card</td>
<td>Provides detailed price information for a contract and enables you to generate recurring expenses automatically.</td>
</tr>
<tr>
<td>Distribution Cost</td>
<td>Represents costs which can be divided among a group of records. For example, the cost of power at a datacenter which can be divided among the CIs in the datacenter.</td>
</tr>
<tr>
<td>Distribution Cost Rule [fm_distribution_cost_rule]</td>
<td>Determines how the costs are distributed to CIs.</td>
</tr>
<tr>
<td>Distribution Units</td>
<td>Stores the number of units to associate to configuration items linked to the current rate card.</td>
</tr>
<tr>
<td>Expense Allocation</td>
<td>Associates the value of an expense to a target reference. The value is generated from an expense line by processing allocation rules. The target is the record that is responsible for that expense amount. Common targets are cost centers, departments, companies, groups, and users.</td>
</tr>
<tr>
<td>Expense Allocation Rule [fm_expense_allocation_rule]</td>
<td>Determines how to process an expense line into an expense allocation. The logic starts by defining a table and condition to run against. Expenses linked to the selected table will be evaluated by this rule. If the condition is met, an allocation of a defined percentage is created for the reference defined by the allocation field value. Advanced scripts can also be used to define custom allocation generation.</td>
</tr>
<tr>
<td>Financial Management Log [fm_log]</td>
<td>Logs financial management information for tracking and to asset with debugging. Extends the system log table.</td>
</tr>
<tr>
<td>Labor Rate Card [fm_labor_rate_card]</td>
<td>Defines hourly labor rates for expense line generation based on functional roles.</td>
</tr>
<tr>
<td>Rate Card [fm_rate_card]</td>
<td>Associates configuration items to a rate card.</td>
</tr>
<tr>
<td>Rate Card [fm_recurring_rate_card]</td>
<td>Represents a collection of recurring costs.</td>
</tr>
<tr>
<td>Rate Card Cost [fm_ci_rate_card_cost]</td>
<td>Associates a recurring CI cost to a rate card so that it is applied to all CIs associated with the rate card.</td>
</tr>
<tr>
<td>Rate Card Users [clm_m2m_rate_card_user]</td>
<td>Associates users to a rate card.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Relationship Path [fm_relationship_path]</td>
<td>Defines the relationship between configuration items, such as parent records and child records.</td>
</tr>
<tr>
<td>Task Rate Card [fm_task_rate_card]</td>
<td>Stores records that define task costs.</td>
</tr>
</tbody>
</table>

**Properties**

Cost Management adds the following properties.

**Properties**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.time_card.default_rate</td>
<td>Sets a default hourly rate to use if no labor rate cards apply to the user.</td>
</tr>
<tr>
<td>glide.cost_mgmt.calc_actual_cost</td>
<td>Sums all task expense lines and adds the total to the Work cost field on the task record when an expense line is created for any task with a Type of Planned task.</td>
</tr>
<tr>
<td>glide.cost_mgmt.debug</td>
<td>Enables debugging of cost management processing. All logging events are recorded in the Financial Management Log [fm_log] table. This should only be enabled during initial testing or when troubleshooting because it can generate a large number of log records.</td>
</tr>
<tr>
<td>glide.cost_mgmt.process_task_cis</td>
<td>Creates expense lines to affected configuration items when creating a task expense line. The default value is false.</td>
</tr>
<tr>
<td>glide.cost_mgmt.service_allocation.method</td>
<td>Defines if business service to cost center allocation costs should be calculated based on total units or allocated units.</td>
</tr>
</tbody>
</table>

**User Roles**

Cost Management adds the following user roles.

**User Roles**

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains Roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Financial User (financial_mgmt_user)</td>
<td>None</td>
<td>Can read allocation units and expense allocations. Can create, read, write rate cards and expense lines. Can create, read, write, and delete fixed assets, depreciation, distribution costs.</td>
</tr>
<tr>
<td>Role</td>
<td>Contains Roles</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Financial Admin</td>
<td>financial_mgmt_user</td>
<td>Can create, write, and delete allocation units, fixed assets, depreciation, rate cards, distribution costs, expense lines, and expense allocations.</td>
</tr>
</tbody>
</table>

**UI Policies**

Cost Management adds the following UI policies.

**UI Policies**

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control flat rate vs bill rate fields</td>
<td>[fm_task_rate_card]</td>
<td>Hides the Task rate field and displays the Default labor rate field on the Task Rate Cards form if the Use time worked check box is selected.</td>
</tr>
<tr>
<td>Hide if define condition disabled</td>
<td>[fm_ci_rate_card]</td>
<td>Displays the Table and Condition fields on the CI Rate Cards form if the Define condition check box is selected.</td>
</tr>
<tr>
<td>Hide parent class if all enabled</td>
<td>[fm_relationship_path]</td>
<td>Hides the Parent class field on the Relationship Paths form if the All parent classes check box is selected.</td>
</tr>
<tr>
<td>Hide recurring fields for one time cost</td>
<td>[fm_distribution_cost]</td>
<td>Hides the End date and Interval fields on the Distribution Costs form if the Recurring check box is cleared.</td>
</tr>
<tr>
<td>Hide relationship type if all enabled</td>
<td>[fm_relationship_path]</td>
<td>Hides the Relationship type field on the Relationship Paths form if the All relationships check box is selected.</td>
</tr>
<tr>
<td>Hide Show Advanced Field</td>
<td>[fm_distribution_cost_rule]</td>
<td>Hides the Table and Condition fields on the Distribution Cost Rules form and displays the Script field if the Advanced check box is selected.</td>
</tr>
<tr>
<td>Hide table field</td>
<td>[fm_labor_rate_card]</td>
<td>Hides the Table field on the Labor Rate Cards form at all times.</td>
</tr>
<tr>
<td>Modify value field rules on distribution method</td>
<td>[fm_contract_rate_card]</td>
<td>Changes the Value field from read-only to mandatory on the Contract Rate Cards form if the Distribute cost field is set to Allocate and distribute cost based on value.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show script field if advanced</td>
<td>[fm_expense_allocation_rule]</td>
<td>Displays the Script field on the Expense Allocation Rules form if the Advanced check box is selected.</td>
</tr>
</tbody>
</table>

### Client Scripts

Cost Management adds the following client scripts.

#### Client Scripts

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculate Tax Cost - Base cost</td>
<td>[fm_rate_card]</td>
<td>On the contract rate card record, calculates the tax cost and total cost based on changes to the base cost.</td>
</tr>
<tr>
<td>Calculate Tax Cost - Sales tax</td>
<td>[fm_rate_card]</td>
<td>On the contract rate card record, calculates the total cost if the Sales tax option is selected.</td>
</tr>
<tr>
<td>Calculate Tax Cost - Tax rate</td>
<td>[fm_rate_card]</td>
<td>On the contract rate card record, calculates the tax cost and total cost based on changes to the tax rate.</td>
</tr>
<tr>
<td>Set Rate Card End Date</td>
<td>[fm_contract_rate_card]</td>
<td>On the contract rate card record, sets the rate card end date to the contract end date if the contract has an end date.</td>
</tr>
</tbody>
</table>

### Business rules

Cost Management adds the following business rules.

#### Business rules

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculate Totals with Tax</td>
<td>[fm_recurring_rate_card]</td>
<td>Updates the Tax rate, Tax cost, and Total cost fields when Sales tax, Base cost, or Tax rate field values change.</td>
</tr>
<tr>
<td>Create expense from approved time card</td>
<td>[time_card]</td>
<td>Creates an expense line after a time card is approved.</td>
</tr>
<tr>
<td>fm_calcBudgetValues</td>
<td>[fm_budget]</td>
<td>Updates remaining budget amount when planned or actual values change.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>fm_Disable rate card costs</td>
<td>[fm_ci_rate_card]</td>
<td>Disables all rate card costs when a rate card is disabled.</td>
</tr>
<tr>
<td>fm_InsertBudget</td>
<td>[fm_budget]</td>
<td>Shows a message with the next budget number when a new record is inserted.</td>
</tr>
<tr>
<td>fm_Populate Month Field</td>
<td>[fm_expense_allocation]</td>
<td>Fills in the Month field based on the Expense date field.</td>
</tr>
<tr>
<td>fm_processExpenseAllocation</td>
<td>[fm_expense_line]</td>
<td>Processes expense allocation rules when an expense line is created for pending items.</td>
</tr>
<tr>
<td>fm_Set default next process</td>
<td>[fm_ci_rate_card_cost]</td>
<td>Sets the default next process date for a new configuration item rate card cost.</td>
</tr>
<tr>
<td>fm_Set default next process</td>
<td>[fm_distribution_cost]</td>
<td>Sets the default next process date for a new distribution cost.</td>
</tr>
<tr>
<td>fm_updateAllocationAvailable</td>
<td>[allocation_unit]</td>
<td>Recalculates the number of available units when the number of allocated units is updated.</td>
</tr>
<tr>
<td>fm_updateAllocationUnits</td>
<td>[fm_cmdb_rel_cc]</td>
<td>Recalculates the number of allocated units for a business service.</td>
</tr>
<tr>
<td>Next process date validation</td>
<td>[fm_contract_rate_card]</td>
<td>If the next process date for the contract rate card is after the start date, this business rule sets the next date to the start date.</td>
</tr>
<tr>
<td>Prevent more than one allocation per ci</td>
<td>[allocation_unit]</td>
<td>Prevents more than one allocation per configuration item.</td>
</tr>
<tr>
<td>Process CI Relationships</td>
<td>[fm_expense_line]</td>
<td>Processes parent related items and generates expense lines for configuration item source expenses. Processes task cost into affected configuration item expense lines for task source expenses.</td>
</tr>
<tr>
<td>Process Task Rate Cards</td>
<td>[task]</td>
<td>Processes task rate cards when a task is set to inactive.</td>
</tr>
<tr>
<td>Update Contract</td>
<td>[fm_contract_rate_card]</td>
<td>Rolls costs from rate card to contract. Updates the contract total cost, tax cost, tax rate, and base cost when total cost, tax cost or tax rate values change.</td>
</tr>
<tr>
<td>Update Planned Task Actual Cost</td>
<td>[fm_expense_line]</td>
<td>Calculates the total actual costs from related expense lines for planned task source expenses.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Verify rate card's start and end dates | [fm_contract_rate_card] | Validates that the rate card start date is specified and is not after the end date. This business rule also:  
• Validates that the rate card start date is not before the contract start date and that the rate card end date is not after the contract end date.  
• Sets the rate card end date to the contract end date if a value is not entered and the contract has an end date. |

### Cost Management roles

Cost Management uses roles that are also used by financial management.

<table>
<thead>
<tr>
<th>Role title</th>
<th>Role name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Financial Admin</td>
<td>financial_mgmt_admin</td>
<td>Financial administrators manage financial processes in the system.</td>
</tr>
<tr>
<td>Financial User</td>
<td>financial_mgmt_user</td>
<td>Financial users participate in financial processes and have limited access to functionality.</td>
</tr>
</tbody>
</table>

A user with the user_admin or admin role can assign the appropriate roles.

### Activate Cost Management

Administrators can activate the Cost Management plugin.

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.

   You can search for the plugin by its name or ID. If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in [Request a plugin](#).
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise they will receive the following error: **Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>**.

### Cost overview module

The Cost Overview module displays various cost management reports.  
It gives financial administrators and other users a summary view of key cost management information.  
The Cost Overview is a type of homepage.
Only users with certain roles have access to the Cost Overview module. See Cost overview module roles for more information.

Cost overview module roles

Only certain roles can customize Cost Overview modules. In addition to viewing, roles with access can refresh, add, delete, and rearrange reports.

<table>
<thead>
<tr>
<th>Role</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>admin</td>
<td>View, customize</td>
</tr>
<tr>
<td>asset</td>
<td>View, customize</td>
</tr>
<tr>
<td>financial_mgmt_admin</td>
<td>View</td>
</tr>
<tr>
<td>financial_mgmt_user</td>
<td>View</td>
</tr>
<tr>
<td>procurement_user</td>
<td>View</td>
</tr>
<tr>
<td>sam</td>
<td>View</td>
</tr>
</tbody>
</table>

Use the Cost Overview module

If your role has access, follow these steps to use the Cost Overview module.

1. Navigate to Cost > Cost Overview.
2. Click elements within the reports to obtain more information.
Cl rate cards

A configuration item (CI) rate card is a group of recurring configuration item costs associated with multiple configuration items. Rate cards make it easier to enter and track costs that are the same across multiple configuration items.

Rate cards usually follow a framework in which all costs are recorded and allocated. For example, the contract costs of a specific model server in a New York datacenter could be different than the same server model running in a Madrid datacenter. Each model would have a separate rate card detailing the costs.

Users with the Financial Admin (financial_mgmt_admin) and Financial User (financial_mgmt_user) roles can manage CI rate cards.

Create a Cl rate Card

You can add a Cl rate card that specifies an hourly rate and associate a rate code.

1. Navigate to Cost > Costs > Cl Rate Cards.
2. Click New.
3. Fill in the fields, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>[Read-only] The Cl rate card identification number. Automatically assigned.</td>
</tr>
<tr>
<td>Define condition</td>
<td>Check box that indicates whether to use the Condition field to filter configuration items for the rate card.</td>
</tr>
<tr>
<td>Name</td>
<td>The Cl rate card name.</td>
</tr>
<tr>
<td>Summary type</td>
<td>The Cl rate card category: Grow Business, Run Business, or Transform Business. Categorizing can be useful for reporting.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that indicates whether the rate card is available for use. Clear the check box to disable the rate card and deactivate all associated rate card costs.</td>
</tr>
<tr>
<td>Table</td>
<td>The table to query with conditions for configuration items. This field is available if Define condition is selected.</td>
</tr>
<tr>
<td>Condition</td>
<td>The condition to query on the specified Table. This field has a condition count widget to preview what records are captured by the conditions. This field is available if Define condition is selected.</td>
</tr>
<tr>
<td>Short Description</td>
<td>A brief description of the rate card</td>
</tr>
</tbody>
</table>

Add a condition to a Cl rate Card

If you are adding a condition to a Cl rate card, use the Update Cl List related link to create the relationship between the configuration item or items and the rate card.

1. Navigate to Cost > Costs > Cl Rate Cards.
2. Select a rate card.
3. Select Define condition.
4. Create the Condition.
5. Right-click the header bar and select **Save**.
6. In **Related Links**, click **Update CI List**.

![Update CI List](image)

**Update CI List**

7. Click one of the choices.
   - **Replace**: removes any existing items that do not match the condition and adds all remaining items from the condition results.
   - **Merge**: keeps existing items and adds all remaining items from the condition results.
8. Click **Return to rate card**.

**CI rate card costs**

CI rate card costs generate expense lines for configuration items on the associated rate card. Costs associated with rate cards are stored in the Rate Card Cost (\textit{fm\_ci\_rate\_card\_cost}) table. Each cost is applied to every configuration item associated with the rate card when the costs are processed. Expense Line is active by default.

**Add a CI rate card cost**

You can add a rate card cost to the CI rate card.

1. Navigate to **Cost > Costs > CI Rate Cards**.
2. Select a rate card.
3. In the **Rate Card Costs** related list, click **New**.
4. Enter a **Start date**.
5. Fill in the fields, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>[Read-only] The rate card cost identification number. Automatically assigned.</td>
</tr>
<tr>
<td>Rate card</td>
<td>The identification number of the rate card to which this rate card cost is associated.</td>
</tr>
<tr>
<td>Name</td>
<td>The rate card cost name.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that indicates whether to enable cost processing for this cost.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the rate card cost. The description is used to identify the processed cost on an expense line record.</td>
</tr>
<tr>
<td>Start date</td>
<td>The date the cost should start being processed.</td>
</tr>
<tr>
<td>End date</td>
<td>The date the cost should stop being processed.</td>
</tr>
<tr>
<td>Interval</td>
<td>The frequency at which the rate card cost recurs.</td>
</tr>
<tr>
<td>Recurring</td>
<td>Check box that indicates whether the cost is a repeating cost. Also sets generated expense lines to show as recurring. If this check box is cleared, no further expenses are generated automatically.</td>
</tr>
<tr>
<td>Sales tax</td>
<td>Check box that indicates whether to apply sales tax to the cost.</td>
</tr>
<tr>
<td>Tax rate</td>
<td>The tax rate to apply to the cost.</td>
</tr>
<tr>
<td>Order</td>
<td>Used by task rate cards.</td>
</tr>
<tr>
<td>Last processed</td>
<td>[Read-only] The date and time this cost was last processed.</td>
</tr>
</tbody>
</table>
### Remove a rate card cost

You can remove a rate card cost on the CI Rate Card form.

1. Navigate to **Cost > Costs > CI Rate Cards.**
2. Select a rate card.
3. In the **Rate Card Costs** related list, click a **Number.**
4. Click **Delete.**

### Disable a rate card cost

To prevent a cost from processing, clear the **Active** option. Use the option to make a rate card cost permanently inactive or to temporarily skip a cost from processing.

1. Navigate to **Cost > Costs > CI Rate Cards.**
2. Select a rate card.
3. In the **Rate Card Costs** related list, click a **Number.**
4. Clear the **Active** check box.

### Modify a rate card cost

Configuration item costs often change over time as facilities or vendor rates change.

Expense lines are the snapshot of a given interval's costs, so changing the cost does not affect already generated expense lines. When costs change, either modify the cost amount or disable the current cost and create a new cost to represent the cost going forward. The changes are processed in the next generated expense line. To keep historical records of costs, create new costs rather than modifying existing ones and set the end date of the disabled cost to show that the cost agreement expired.

1. Navigate to **Cost > Costs > CI Rate Cards.**
2. Select a rate card.
3. Click a rate card cost **Number.**
4. Modify the fields, as necessary.

### Aggregate CI costs

Expense lines can be aggregated to apply all configuration item expenses to a parent business service or application with relationship paths.

Define relationship paths from a child configuration class to one or many parent classes. If a path does not match one of the relationship path record criteria, the path is not viewed as a relationship when determining expense aggregations. See **CI relationships.**
Enable relationship aggregation

The Process Last Month CI Costs scheduled job processes costs of configuration items. To start aggregating expenses to parents, identify the relationships to use for aggregation. Because there are many options for CMDB relationships, using all available paths for aggregation is generally not efficient.

You can have multiple relationships for each child class. For example, to enable only certain relationships or parent classes, create a new record for each type and class combination paired with the child class.

When an expense line is generated from a configuration item cost, the parents of the configuration item are evaluated. The parent class and relationship type are compared to the list of relationship path records to see if there is a match to use for aggregation. If there is a match, an expense line is generated for the parent configuration item. The process repeats for all parents until there are either no parent relationships or the relationships in place do not meet the criteria defined in the relationship path records.

1. Navigate to Cost > Administration > Relationship Paths.
2. Click New.
3. Fill in the fields, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Check box that indicates whether the relationship path is enabled.</td>
</tr>
<tr>
<td>Child class</td>
<td>The child configuration item class. This class is the source of the expense generated during configuration item cost processing.</td>
</tr>
<tr>
<td>All parent classes</td>
<td>Check box that indicates whether relationships to all parent classes are processed.</td>
</tr>
<tr>
<td>Parent class</td>
<td>A valid parent CI class for the selected child class. Available only if All parent classes is not selected.</td>
</tr>
<tr>
<td>All relationships</td>
<td>Check box that indicates whether all relationship types between the child and parent classes are processed.</td>
</tr>
<tr>
<td>Relationship type</td>
<td>The type of relationship to process between the child and parent classes. Available only if All relationships is selected.</td>
</tr>
</tbody>
</table>

When a configuration item has multiple parents that have valid relationship paths, the amount aggregated to each parent is split to prevent over-aggregation of a item cost. When evaluating parent relationships to active relationship paths, the aggregation counts the total number of valid relationships. The expense line amount from the child configuration item is evenly divided among the number valid paths and that amount is used when creating the inherited expense line for the parent.

Task and labor rate cards

In Cost Management, task rate cards and labor rate cards capture operating costs by generating expense lines representing the cost of performing a task

- Task rate cards are templates used to define the type of task and the method of calculating the associated costs.
- Labor rate cards are templates used to define worker’s labor rates when calculating task cost based on time worked.
Manage a labor rate card

The labor rate card associates a rate code with a labor rate.

1. Navigate to **Cost > Labor Rate Cards**.
2. Create or edit a record (see table for details).

<table>
<thead>
<tr>
<th>Field</th>
<th>Input Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>String field summarizing the purpose of the rate card.</td>
</tr>
<tr>
<td>Rate code</td>
<td>For reference use only, if you want to align rates with an external system.</td>
</tr>
<tr>
<td>Rate type</td>
<td>The rate type that is used to determine if the labor rate card matches with the rate type on the time card.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box which determines if the rate card will be actively used.</td>
</tr>
<tr>
<td>Hourly rate</td>
<td>Identifies the hourly rate to be applied to task time worked entries if the worker meets the condition defined.</td>
</tr>
<tr>
<td>Condition</td>
<td>Defines a filter on the user table to determine whether the task time worked user applies to this rate card. This field uses the Condition Count Widget to preview what records would be returned by the conditions.</td>
</tr>
</tbody>
</table>

**Rate type in labor rate card**

The rate type functionality is used to categorize different types of work. For example, Standard versus Overtime.

The Labor Rate Card form contains options to specify rate type, specify hourly rate for the rate type, and specify users for whom the labor rate card is applicable. A single user can be associated with multiple labor rate cards that contain different rate types.

Assume that a user logs time against a task and selects the rate type Standard in the Time Cards form. Upon approval, the expense line (cost) for the time card is derived by matching the user and rate type on the time card to a labor rate card assigned to that user, and that has the same rate type. When the user has multiple labor rate cards with the same rate type, the expense line is generated based on the labor rate card that has the lowest value in the **Order** field. When there is no labor rate card associated with the user and rate type, the default hourly rate found in the **Time Sheets > Administration > Time Sheet Policy** form is used (**com.snc.time_card.default_rate** property).

**Note:** A user can enter a rate type only if it is permitted by the users Time Sheet Policy.

Manage a task rate card

Task rate cards are rate cards associated with records in a task table.

1. Navigate to **Cost > Costs**.
2. Create or edit a record (see table for details).

<table>
<thead>
<tr>
<th>Field</th>
<th>Input Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>String field summarizing the purpose of the rate card.</td>
</tr>
</tbody>
</table>
### Process task rate cards

The business rule Process Task Rate Cards runs when tasks close and checks to see if any task rate cards apply. If they do, an expense line is created according to the rate card.

The process flow of the "Process Task Rate Cards" business rule is:

1. Task closes.
2. Business rule runs.
3. Query active task rate cards in order looking for a matching condition.
4. Qualifying rate card not using time worked.
   a. Generate expense line linked to the task using the task rate value.
5. Qualifying rate card using time worked.
   a. Get task time worked entries for the task grouped by user (worker).
   b. For each user, check to see if they match conditions in any of the labor rate cards.
      1. Labor rate card found, generate expense line using the time worked and labor rate.
      2. Labor rate card not found, generate expense line using the default labor rate from the task rate card.
Budgets and cost centers

Budgets allow tracking of planned and actual IT spending. Budgets are defined for a given time period for one or more cost centers.

Note: Functionality described here requires the Cost Management plugin.

Cost Centers are used to represent a business entity. All expense allocations assigned to the budget's cost center during the budget period will be used to calculate the budget's actual expense allocations. It is also possible to assign a cost center to a budget from the cost center record. The cost center form will have a budgets related list.

Manage cost centers

How users can define cost centers.

1. Navigate to Cost > Config > Cost Center.
2. Select a Cost Center to edit or select New.

Manage a budget

Cost management provides budgets for you to plan expenses for a certain time period.

1. Navigate to Cost > Config > Budgets.
2. Select a Budget to edit or select New.
3. Fill in the form (see table)

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>System generated record number.</td>
</tr>
<tr>
<td>Name</td>
<td>String field for the name of the budget.</td>
</tr>
<tr>
<td>Start</td>
<td>Date field defining the beginning of the budget period.</td>
</tr>
<tr>
<td>End</td>
<td>Date field defining the end of the budget period.</td>
</tr>
<tr>
<td>Planned</td>
<td>Currency field representing the planned amount of expenses for the associated cost centers during the budget period. This value is inputted or imported.</td>
</tr>
<tr>
<td>Actual</td>
<td>Currency field representing the actual amount of expenses for the associated cost centers during the budget period. This is a calculated field using the list of expense allocations for the cost centers.</td>
</tr>
<tr>
<td>Remaining</td>
<td>Currency field representing the amount of planned minus actual expenses. This is a calculated field.</td>
</tr>
</tbody>
</table>
Cost centers related records

The cost center table is not new to this plugin, however this plugin does add new related list to the cost center form.

- **Budgets**: This related list displays the budgets that this cost center is a member of.
- **CI Cost Center Relationships**: This list is used to define how much of a business service capacity the cost center is consuming. See Allocation Based on Usage.
- **Expense Allocations**: This list is a defined related list designed to show all of the expense allocation records with this cost center as the target.

Manage budget cost centers

You create cost centers and associate budgets and expense allocations with them.

1. Open an existing budget from the Cost > Config > Budgets module.
2. Make sure the Cost Centers related list is displayed.
3. Use the Edit to add or remove existing cost centers from the budget.
4. Use the New button to create a new cost center record.

Using distribution costs and rules

Distribution Costs are costs which can be divided among a group of records.

For example, the cost of power at a datacenter which can be divided among the CIs in the datacenter.

Distribution Rules determine how the Distribution Costs are divided among the CIs.

Defining Distribution Costs

To define new distribution costs, navigate to Financial Management > Cost Management > Distribution Costs, and select New. Populate the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Input Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>A system-generated unique identifier for the Distribution Cost.</td>
</tr>
<tr>
<td>Name</td>
<td>A human-readable identifier for the cost.</td>
</tr>
<tr>
<td>Amount</td>
<td>The amount of the cost, with a currency list. To add a new currency, use the Edit link.</td>
</tr>
</tbody>
</table>
### Defining Distribution Rules

To define new distribution rules, navigate to **Financial Management > Admin > Distribution Cost Rules**, and select **New**.

Populate the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Input Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique name for the rule.</td>
</tr>
<tr>
<td>Active</td>
<td>Determines if the rule is actively used.</td>
</tr>
<tr>
<td>Advanced</td>
<td>If checked, the distribution rule will be determined by script. If not checked, it will be determined by table and conditions.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the rules and any notes on its use.</td>
</tr>
<tr>
<td>Script</td>
<td>If <strong>Advanced</strong> is true, the script which will determine the rule's behavior.</td>
</tr>
<tr>
<td>Table</td>
<td>If <strong>Advanced</strong> is false, a list list of tables to find the records to distribute the cost to.</td>
</tr>
<tr>
<td>Field</td>
<td>Input Value</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Condition</td>
<td>If Advanced is false, a condition builder to determine which records will receive the distributed cost, on the table determined by the Table field. Cost amount will be distributed evenly across the records identified by the table and condition values. This field uses the Condition Count Widget to preview what records would be returned by the conditions.</td>
</tr>
</tbody>
</table>

Once submitted, the Distribution Costs related list will appear to determine which costs will be distributed according to the rules.

**Scripted distribution**

Scripted distributions allow for custom distribution amounts, versus the evenly split distributions when using table and condition filters.

To enable scripted processing on a distribution rule:

- Check the advanced field check box, this will display the script field.
- Build the script using the following concepts:
  - Query for target records and data to use for calculating the allocation amount.
  - Create expense line records using the DistExpenseLine API.

As noted in the default script, when the advanced field is enabled, the following variables are available during the script processing:

- *distCost* - GlideRecord for the distribution cost, allowing access to all fields.
- *distCostAmount* - cost amount in the system currency.

To create an expense line record, use the DistExpenseLine API

```java
/* Available variables:
 *  * distCost - GlideRecord for the distribution cost
 *  * distCostAmount - cost amount in system currency
 *  *
 *  * To create an expense line record use the DistExpenseLine API
 *  *  var DistExpense = new DistExpenseLine(distCost);
 *  *  DistExpense.createExpense(expenseSourceGlideRecord, amount, description);
 *  *  createExpense returns true if expense was inserted;
 */

/*
 * Sample Script to distribute a cost to departments based on number of active users in each department
 */
var deptUsers = new GlideRecord("sys_user");
depthUsers. addActiveQuery();
depthUsers. addQuery("department","!=",");
depthUsers. query();
var totalUsers = deptUsers. getRowCount();

//get the count of users for each department var deptUsers = new GlideAggregate("sys_user");
depthUsers. addActiveQuery();
depthUsers. addQuery("department","!=",");
```

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
deptUsers. groupBy ( "department" ) ;
depthUsers. addAggregate ( "COUNT" ) ;
depthUsers. query ( ) ;

//for each department calc amount and create expense line while (deptUsers. 
next ( ) ) { var dept  = deptUsers. department. getRefRecord ( ) ; var 
depthCount  = deptUsers. getAggregate ( "COUNT" ) ; var deptAmount  = 
distCostAmount  / deptCount ;

    //create expense line var DistExpense  = new DistExpenseLine
    (distCost ) ;
    DistExpense. createExpense (dept , deptAmount , distCost. name + "-
    + distCost. distribution_rule. getDisplayValue ( ) ) ; }

Processing Distribution Costs

A scheduled job called Process FM Costs automatically processes distribution costs daily.

Use business services with expenses

Manage the relationships between business services and their expenses with allocation units and cost centers.

Define a cost center

Cost centers are a commonly used reference between financial systems and IT. Cost center records represent business entities, and have a related list of CI Cost Center Relationships that measure the cost center’s consumption of business services.

1. Navigate to Cost > Config > Cost Center.
2. Select a record to edit or select New.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique name for the cost center.</td>
</tr>
<tr>
<td>Account Number</td>
<td>An account number associated with the cost center, if one exists.</td>
</tr>
<tr>
<td>Code</td>
<td>A code associated with the cost center, if one exists.</td>
</tr>
<tr>
<td>Location</td>
<td>A reference to the location of the cost center.</td>
</tr>
<tr>
<td>Manager</td>
<td>A reference to the user who manages the cost center.</td>
</tr>
<tr>
<td>Valid from</td>
<td>The date that the cost center is valid from.</td>
</tr>
<tr>
<td>Valid to</td>
<td>The date that the cost center is valid to.</td>
</tr>
</tbody>
</table>

Related List: CI Cost Center Relationships

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service</td>
<td>A reference to a Business Service.</td>
</tr>
<tr>
<td>Cost Center</td>
<td>The cost center to apply the relationship to. If reached through the related list, it should already be related to the appropriate cost center.</td>
</tr>
<tr>
<td>Allocation Percentage</td>
<td>Feature not yet implemented.</td>
</tr>
</tbody>
</table>
### Field

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allocation Type</td>
<td>A choice list. Should be <strong>Units</strong>.</td>
</tr>
<tr>
<td>Allocation Units</td>
<td>The number of units that the cost center is using. This is measured using the same type of unit used to define the total capacity of the business service in the allocation unit record. This number will be used to update the number of allocated units in the allocation unit record. It will also be used to determine the amount of expenses to allocate to the cost center based on the percentage of business service used versus the total capacity.</td>
</tr>
</tbody>
</table>

### Default allocation rule

For every expense line generated for a business service, the default allocation rule Process Svc-CC Relationships will attempt to process the expense and create allocations for each cost center that is consuming the service.

The amount of the expense allocation is calculated by dividing the number of units the cost center is consuming by the total number of units for the business service. This calculation method is referred to as "all unit" allocation as it uses the total unit capacity to determine the allocation percentage.

Refer to the demo walk-through for a detailed example.

For a given business service expense line, it is typical that less than 100% of the expense would be allocated using this method not all units have been allocated to cost centers. The unallocated expenses could be considered IT overhead. Some organizations prefer to show 100% expense allocation regardless of how many units are in use. This method is referred to as "allocated unit" since the percent of allocation calculated by dividing the number of units the cost center is consuming by total number of allocated units from all cost centers.

<table>
<thead>
<tr>
<th>Allocation calculation method</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>all_units</td>
<td>Service supports 100 units but only has 50 units allocated, and cost center ABC is allocated 25 units. This method will result in an allocation cost of $25/100$, or 25% of the total cost of the service. 50% of the expenses (from the 50 unallocated units) will not be allocated.</td>
</tr>
<tr>
<td>allocated_units</td>
<td>Service supports 100 units but only has 50 units allocated, and cost center ABC is allocated 25 units. This method will result in an allocation cost of $25/50$, or 50% of the total cost of the service. 100% of the expenses will be allocated, showing full cost recovery.</td>
</tr>
</tbody>
</table>

This is a system wide setting that can be configured by navigating to **Financial Management > Properties** module and selecting an option from the choice list.

### Define an allocation unit

Allocation unit records define the capacity and usage of a business service.

1. Navigate to **Cost > Config > Allocation Units**.
2. Select a record to edit or select **New**.

<i>Note:** Selecting the name of the configuration item will display the CI record, not the Allocation Units.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Item</td>
<td>Select the Business Service to define allocation units for.</td>
</tr>
<tr>
<td>Total Units</td>
<td>The total number of units of expense available to allocate. A unit is a generic measurement which can represent anything. Should match the cost center relationship unit. What units represent can be recorded in the <strong>Unit Type</strong> field. Using the <strong>Total units</strong> option may result in unallocated expenses if there are unallocated business service units. Using the <strong>Allocated unit</strong> option always results in 100% expense allocations.</td>
</tr>
<tr>
<td>Allocated Units</td>
<td>How many of the total units are allocated. Populated by script.</td>
</tr>
<tr>
<td>Available Units</td>
<td>How many of the total units are unallocated. Populated by script.</td>
</tr>
<tr>
<td>Updated</td>
<td>When the units were last updated.</td>
</tr>
<tr>
<td>Unit Type (added by configuring the form)</td>
<td>Used to record what the units represent (e.g. seats, licenses, Gigabytes, etc.).</td>
</tr>
</tbody>
</table>

**Cost Management Demo Data**

The demo data available with Cost Management provides samples of the data types to illustrate its use. Demo data should be loaded only in a development or test instance to prevent conflict with production data.

**High-Level Data Review**

The Cost Overview module has a number of commonly requested reports.
The business service owner would like to know how much it costs to maintain the service over some period of time. This requires gathering the dependent CI costs and representing them at the business service level. For CI costs to roll up to business services, relationships must exist between CIs and services.

The demo data contains a number of services that have costs from their dependent CIs. In the Cost Overview homepage, the Business Service Cost 12 Month report shows an overview of this information:
Expense allocation rules costs allow you to allocate costs to one or more business entities such as a user, group, department, company, or cost center. The purpose of the allocation is to represent the cost that the business is responsible for. This is not considered charge-back or billing, but could be used as a source for billing. The primary purpose of expense allocation is to represent the consumer of the process that has incurred some expense.

The following diagram shows the distribution of expenses to cost centers.
Budget Overview

The amount of money allocated to cost centers can be tracked against a planned budget. A budget represents a collection of cost centers, a duration, and the amount of money that is expected to be allocated to the cost centers during that period. The administration budget contains three cost centers and has incurred $173,610.83 so far during this period.
Budget Demo

Cost sources

There are several ways to generate expense lines for objects in the system.

These are generally classified as one of three types:

- CI costs
- Task costs
- Custom generated costs - these are not covered in the demo data, refer to the ExpenseLine API for more information.

CI Rate Cards

A CI rate card is a template that defines costs for a particular type of CI. This example uses only server-related costs. Since there are only a few different server models and the costs are the same for each model, CI rate cards can define a template of costs for each model.

Following is the Sun E20K Servers NY rate card:
Cost Demo CI Rate card

It represents the common costs and CIs in the UNIX servers in the NY datacenter, regardless of what the server is used for.
The related lists contain information on how this rate card is used. The **Configuration Items** related list display the each of the servers that will use this rate card. This list of items can be managed manually with the **Edit** button or with the **Update CI List** related link. The rate card condition for this rate card is **Table=Unix Server**. Clicking the **Update CI List** related link shows two things:

- CIs that are a member of the rate card but do not match the condition.
- CIs that match the condition but are not a member of the rate card.

To "true-up" the rate card, use the **Replace** or **Merge** button.

![Rate card condition items not yet in rate card](image)

**Cost Demo update CI rate card**

In this case, there are two extra UNIX servers that are not in the rate card. Use the **Merge** button to add them. The rate card now shows nine items.

**Note:** Counts may vary if there are additional CIs in the instance.

The **Rate Card Costs** related list displays the recurring costs that all of the servers will incur, in this case on a monthly basis.

Adding the **Expense Line** related list to the CI Rate Card form shows the list of expense lines that have been generated from this rate card's costs. Here are the expenses for the Server backup services for two of the servers:
Cost Demo CI Rate Card

**Distribution Costs**

For more generic bulk costs that are generated by multiple CIs, distribution costs can represent the broader costs where individual CI rate cards do not apply. Navigate to **Financial Management > Distribution Costs** to view a few examples.

Select **Datacenter Facilities (amort)** from the list:

Cost Demo distribution cost

In this example, the datacenter's power costs for a month have been amortized and represented as a monthly recurring distribution cost.

This bulk cost should be distributed to all servers evenly to enable reporting on costs per server and cost center. This is accomplished with the **Distribution Rule** listed on the cost's form. To view the distribution cost, click the reference icon for the **All Installed Servers** rule in the **Distribution rule** field:
Cost Demo Distribution cost rule

This rule takes the $5,500 and distributes it to each of the servers that match the rule condition. The condition here is All servers with install status of installed. The "View Condition Results related link displays the current records matching the condition.

Task Costs

Task-related activity can also generate expense lines to track the costs associated with processing tasks. The primary method of generating task-related costs is to use Task Rate Cards.

Task Rate Cards

A task rate card is a condition-based record that the system uses to determine how to calculate the costs of a task.

To view an example, navigate to Financial Management > Task Rate Card and select Incident P1:
Cost Demo Incident rate card

Rate cards are processed whenever a task is closed. This processing is triggered by a business rule. The rate card contains the following information:

- When an incident with priority 1 - Critical is closed, it generates an expense line for $150.
- This is a flat rate defined for each P1 incident.

The Expense Line related list displays the list of expenses that have been created by this rate card.

Return to the Task Rate Card list and open the Change Request (emergency) rate card:

Cost Demo Change Request

This rate card for emergency change requests demonstrates an example of creating a task cost based on the amount of time it took to work the task, instead of the flat rate model in the incident rate card.

- The Use time worked flag in the rate card tells the system to use the task time worked records associated with the task when determining the task cost.
• Processing this rate will:
  • Query the list of task time worked records for the task.
  • Attempt to resolve an hourly rate for the user in the task time worked record, or use the default rate of $250/hr defined in the rate card.
  • Generate an expense line for each time worked entry.

The Expense Lines related list shows the expenses generated from this rate card.

**Labor Rate Cards**

Labor rate cards are a way to define common patterns for hourly worker rates so rates don't need to be managed for each individual in the system.

To view the sample rates, navigate to **Financial Management > Labor Rate Cards** and select the Development rate card:

![Image of Labor Rate Card](image)

**Cost Demo Development Labor Rate**

The conditions state that for users in the Development department, time worked costs will use $100 as the hourly rate.

**CI relationships**

To get reports that represent the total costs for a business service, there must be some association between the service and the CIs that make up the service. This is done with CI relationships.

1. Navigate to **Financial Management > Business Services**.
2. Select Retail.
3. View the business service map.

Cost Demo Retail Bsm

This view shows that the dbaix901nyc server is a dependency of the Retail Adding Points, Retail POS, and Retail business services. So whenever the server incurs a cost, it should be represented at each of the business services.

As seen above, the dbaix901nyc server is a member of the Sun E20K Servers NY CI rate card, so the expenses already exist for the server.

To view them:

a. Navigate to Financial Management > CI Rate Cards.

b. Select Sun E20K Servers NY.

c. View the Expense Line related list.

d. Filter the related list for short description contains dbaix901nyc.

The server's expenses are now visible:
Cost Demo Serverexp

This example contains one direct expense (inherited = false), and three inherited expenses that have been generated from other direct expenses. These inherited expenses are based on CI relationships, which allow for reporting at any business service level.

For more information on expense aggregation, see Enabling Relationship Aggregation.

Allocating expenses

Expenses can also be allocated to a business entity that is responsible for the expense.

This is not considered charge-back or billing but could be used as a source for billing. The primary purpose of expense allocation is to represent the consumer of the process that has incurred some expense. This can be accomplished by defining expense allocation rules.

Simple Example

This example demonstrates allocating every server-related expense line to the department responsible for the server.

To view the example:

2. Remove the list filter to view inactive rules as well as active ones.
3. Select the Server - Department rule.

The rule states that for every expense line associated (Expense source field) with a server that has one of the selected statuses, generate an expense location record for 100% of the expense amount and assign the allocation to the server's department.

To view expense allocations, add the Expense Allocation related list to the form. The Target field is the business unit that the expense is allocated to.
Complex Example

A more common example would be to allocate the costs of a business service to the business consumers. Since cost centers are generally used when referring to business finances, this example allocates business service costs to each cost center that is consuming the service and bases the amount allocated on the amount of the service the cost center consumes.

To view the example, navigate to Financial Management > Business Services and select Retail. Switch to the Cost view to gain access to additional related lists.

The Allocation Units record defines the amount of capacity that this service provides. In this case, the Retail service can support 50 locations (units), of which 45 are allocated. A unit is a generic concept that can represent something that makes sense for that business service. This record uses units to represent allocation. The objective is to use the unit count and the cost center unit count to determine a percentage of total to calculate the allocation amount.

Cost Demo Retail Allocation Units

The CI Cost Center Relationships list shows which cost centers are using the service and how many units they are using. This information is used to determine how much of the service expenses to allocate to each cost center. For example, the Trading department is using 10 of the 50 allocated units, so they will be allocated 20% of all Retail expenses. There’s also an option to allocate based on the total (10 or 45).
To see how the expense lines are allocated, select an entry in the Expense Lines related list and add the Expense Allocation related list to the Expense Line form.

The following is an expense from the dbaix901nyc server for $2,500. Two expense allocations are generated from the expense. The Trading cost center was allocated $500 (20%) of the expense based on the CI cost center relationship seen earlier.
Cost Demo Retail Example

This type of business-service-to-cost-center allocation is accomplished through the **Process Svc-CC Relationships** expense allocation rule. This is an advanced rule that uses script to determine the allocation logic.

**Budgets and cost centers example**

The most common business entity to associate financial information to is the cost center.

The example above showed how cost centers can be allocated expenses based on service usage. This example will use that information to compare with a defined budget for the cost centers.

A budget is a placeholder for an amount of planned spending for one or more cost centers. To view an example, navigate to **Financial Management > Budgets** and select the **Investments** budget:
Cost Demo Budget

This budget has a defined start and end date, planned amount, and actual amount. In the Cost Center related list, Trading is a member.

For all expense allocations assigned to the Trading cost center during the budget time periods, the allocations will be totaled to populate the actual budget field. The related expense allocation records can also be viewed in the Expense Allocations related list.

Budget related records

In addition to the Budget record, Budgets are related to additional records. These records can be viewed as related lists on the Budget form.

- Cost Centers - This related list displays the cost centers that are a member of this budget.
- Expense Allocations - This list is a defined related list designed to show all of the expense allocation records during the budget time period for all of the budget's cost centers.
Domain separation and Cost Management

This is an overview of domain separation and Cost Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Support level: No support

- The domain field may exist on data tables, but there is no business logic to manage data.
- This level is not considered domain-separated.

For more information, see Application support for domain separation.
Index

Special Characters
(P)roject Portfolio Suite with Financials
PPM Standard 196, 198, 198, 207, 480
project and portfolio funding 480

A
Activate APM 26
activate test management 2.0 1348
add portfolios 41
Agile
convert teams to groups 251
Convert to Group 251
Agile Development 1017, 1045
activate 1046
activate Agile Development 2.0 1046
add group members 1099
Agile Board 1064
Agile development process flow 1054
Agile groups 1098
backlog planning dashboard 1070
basics 1052
basics of Agile Development 1052
Convert release teams to groups 1099
create a group 1098
create a product 1083
create a release 1087
create a scrum tasks 1097
create a story 1091
create a task 1096
create a test plan sprint tracking 1078, 1363
create a theme 1085
create an agile group 1098
create an enhancement 1100, 1101
create an epic 1086
Create backlog 1072
create multiple scrum tasks for a story 1097
create scrum tasks 1096
create scrum tasks for multiple stories 1097
defect report
creating 1101
defect reports 1101
defects 1101
enhancement
creating 1100
enhancement requests 1100, 1100
epic
creating 1086
group
Convert release teams to groups 1099
creating 1098
group members 1099
groups
add group members 1099
how to write stories 1089
installed components
plugins 198
tables 200
user roles 207
Manage groups 1098
Manage Products 1083
Manage Releases 1087
Manage stories 1089
Manage stories and tasks 1089
Manage tasks 1089
product
creating 1083
Products 1083
Project based agile development 1059
Project based agile development example 1059
Project based agile development use case 1059
properties 1050
release
creating 1087
Release based agile development 1057
Release based agile development example 1057
Release based agile development use case 1057
scrum activities 1052
scrum artifacts 1052
scrum framework 1052
scrum key terms 1052
Scrum Products 1083
Scrum Releases 1087
scrum task
creating 1096
scrum tasks
creating 1097
sprint planning dashboard 253, 1074
Sprint Tracking Board 1076, 1077
sprint tracking list 1077
sprint tracking test result form 1083
sprint tracking test steps validation 1082, 1367
Standalone project agile development 1061
Standalone project development example 1061
Standalone project development use case 1061
stories 1089
creating 1091
story acceptance criteria 1089
story descriptions 1089
theme
creating 1085
use cases 1056
well-written scrum stories 1089
workflow use cases 1056
Agile Development 2
defect reports 1101
enhancement requests 1100
Agile Development 2.0 1045
activate 1046
Agile development process flow 1054
groups 1098
installed components
properties 1050
Manage stories and tasks 1089
properties 1050
properties installed with agile development 2.0 1050
releases 1087
Scrum Process Flow 1054
Agile Development process data model 1051
allocate resources
extended period 653
allocated resource plan
request extension 652
allocating
requested
allocations 654
resource
allocations 663
resources 657
Allocation lines 867
allocation unit
define 1410
allocation workbench 672
allocations
requested
related list 654
resource
related list 663
Analytics and Reporting Solutions 193
APM administrator 38
APM reports 178, 193
Application (business) service 156
Application 360 dashboard 99
Application architecture 35
Application assessment 70
Application assessment dashboard 100
Application Backlog view 148
epic 150
application category 39
application category group 39
Application certifications 45
Application classification attributes 38
application families 40
Application indicator scores 94
Application indicators 77
Application landscape dashboard 65
Application performance 94
application portfolio management
application indicators 71
application score profile 92
Application portfolio management 99, 101
Bubble chart 98
decisions 101
goals 101
program 104
Application Portfolio Management
application inventory
assessment framework 23
Application relations 54
Application risks 54
Application roadmap 59
application score profile 89
Application scores 94
Application service 61, 62, 111, 156, 157
Application setup
Financial charging 894
Application strategy 94, 101
Approve ARB 70
architecture review 69
architecture review board 70
architecture review requests 70
arrange stories 1073
Assessment indicators 70
Assessment instances 73
associate time card
resource plan 653
Audit engagements 54
Audit profile 55

B
big room planning 1240
board stories 1249
Breakdown relationship 831
bubble chart
move and resize a demand 307
view an artifact 293
view demand summary 293
Bubble chart 94, 94
Budget allocation 702
Budget initiation 358
Budget period 357
Business application 55, 56, 59, 113, 156, 169
Application Portfolio Management 50
Business Application Costing 738
Business Application Costing cost model 738
Business Application Costing Model 743
Business Application Lifecycle Management 67, 69
Business Application Lifecycle Management services 66
Business application risks 164
Business application similarity solution 17
Business applications 41, 117
Business architecture 35
Business capabilities 117
Business capability 111, 112, 113, 121, 127, 131
Business category 15
Business entities 1387, 1388
Business management 13
Business personas 116
Business planner 1384
Business planning 1384
Business planning portal 1384
business process
business capabilities 40
Business process 111
business rules 28
Business rules 32
Business service 894
business services
use with expenses 1409
Business stakeholder 33
Business stakeholder plugin 13
business stakeholder role for PPM 213
Business unit owner showback dashboard 916
Business unit strategy 1388
By business application 139
By Business Application view 142
By product classification 139
By Product Classification view 144
By software model 139
By Software Model view 146

C

calendar 590
Capability based planning 116
Capability map 121, 127, 131
Capability-based planning 117
Capacity Planning  review 668
capacity resource 662
Certification instances 41
Certification schedules 41
Certifications tasks 45
Certifications task 45
change management 526, 528, 529
Change planned start date of a project 502
CI costs
aggregate 1401
CI rate card
add condition 1398
create 1398
CI rate card cost
add 1400
disable 1401
modify 1401
remove 1401
CI rate card costs 1400
CI rate cards 1398
CI relationship 112, 113, 169
CI relationship editor 156
Client scripts 28, 32
CMDB CI 54
cmdb CI relationship 170
CMDB query builder 193
CMDB Query Builder 178
Compare baselines 290, 470
Compare baselines of a project 290
Compare baselines of a demand 290
Compare baselines of a project 470
Compare financial baselines 290, 470
composite fields 308, 536
Configuration item 111
configure investment metrics 586
Configure risk bubble 163
Consumption breakdowns 897
Consumption statement item 895, 895, 897
Consumption table 895
Controlled cost lines 866
cost center
define 1409
Cost indicators 77, 83
Cost lines 831
cost management 601, 1389
activating 1395
cost overview module 1395
Cost Management
budget related records 1427
budgets 1405
cost centers 1405
cost centers related records 1406
installed 1389
manage a budget 1405
manage a budget's cost centers 1406
manage cost centers 1405
Cost Management Demo Data 1411, 1415, 1421, 1423, 1426
cost model 868
Cost model 83
Allocation lines 898
Cost model breakdowns 900
Cost model statement item 895, 898, 900
Cost models
groomed lines 777
cost overview module 1395
using 1396
Cost overview module 1396
Cost plan 360
Create a demand 103
create investment report 582
create SAFe feature 1222
create SAFe program 1229
create SAFe program increment 1230
create SAFe story 1226
create SAFe teams 1231
create test 1351
create test sets 1355

D

Dashboards 737
Data certification 41
Data domain 167
data source 868
Data source
field maps
create 757
Database catalog 167, 168, 170
default allocation rule 1410
define financials in project workspace 444
demand
assessing 265
creating 268
deleting 307
Draft state 306
reset 306
resource plan, create 629
resource plan, create using resource finder 637
resource plan, search resources using resource finder 637
viewing 292
demand actions 41
Demand form 695
demand management
assessment category
creating 311
cancel a resource plan 649
configure 314
create demand benefit plan 283
demand workbench 314
demands
cost plan 285
create benefit plan 283
Demand management
allocate budget to a program 289
create and manage resources plans 287
Demand budget 289
manage resources 287
Manage the resources for a demand 287
Demand Management 254
demand workbench 258, 260, 260
ideation 308
installed components
plugins 198
tables 200
user roles 207
key terms 254
life cycle 261
planning 255, 310
process flow 257
reset to Draft 306
setting up 310
stakeholder registry
populating 311
using 261, 265, 268, 282, 292, 307
demand enhancing 294
demand workbench 258
bubble chart 260
list view 260
Demand workbench
bubble chart 293, 293, 307
create a qualified demand 279
list view 279
Demands 103, 110
Depends on::Used by 170
deployment task template
create 1013
Desired state audit 48
Discovery 167
Distribution Costs and Rules 1406, 1407
Domain separation
Project Portfolio Management 725
Drilldown statement item 903

E
Enable client side planning console 552
Engagements 56
enterprise deployment build
create 1014
enterprise deployment build commit
create 1016
enterprise deployment phase
create 1011
enterprise deployment pipeline
create 1011
enterprise release
create 1008
manage 1005
Enterprise Release Management
installed components
tables 1006
enterprise release phase
create 1009
Enterprise strategies 1387
Entity 55, 56
epic in SAFe 1220
export project using planning console 596
export project using project form 596

F
Financial analyst showback dashboard 915
financial baseline 290
Financial charging 894
Application setup 894
Statement item 895
financial management
roles 1395
Financial management
application cost model 83
cost analysis
allocation 881
Financial Management 730, 731
account buckets 870
creating 870
activating 198
advanced query conditions
modifying 872
allocate setup
assigning expenses 796
bucket assignments 795
creating rollups for a segment 793
creating rollups for an account 792
previewing an allocation from a bucket 801
putting expenses into buckets 783
reverting bucket assignments 802
reviewing assigned expenses 797
rollups 788
splitting buckets 786
viewing accounts that roll up 789
viewing bucket contents 786
viewing total amount allocated 798
allocation metrics 884
allocation review 803
allocating expenses 805
allocations 869
bucketing 773
creating bucket filter conditions 775
creating buckets 775
putting expenses into buckets 778
reviewing bucket assignments 781
running the bucketing engine 781
viewing account details 775
budgets
account code expenses 358
creating targets 358
reference rates 211
business units 1386
creating 1386
cleansing conditions 872
configuration tab 832
deleting allocation lines 833, 876
Configuration tab
general settings 832
main report 833
cost models 862
  clone cost model 764, 825
  cloning 830
  comparing 830
  creating 863
  creating basic 830
  viewing settings 827
Cost Models tab 806
data cleansing 766, 772
  mapping segment records 770
  merging expense rows 770
  reviewing expenses 768
data definition 762
  choosing a cost model 869
  choosing a working set 763
  expense summary 765
data sources 754
  create 757
Error logs
  troubleshooting tips 833
expense allocations 874
  viewing allocation lines 874
general ledger 750
  viewing expenses 750
grooming conditions 872
  importing financial data 750
installed components 732
  tables 732
  user roles 736
IT shared services 760, 761
  creating 760
rollups
  view and edit records 795
scripted metrics
  creating 892
segment definitions
  create 759
  segments 758
service type
  creating 761
  weighted metrics
  creating 885
workbench 761
Financial Management dashboards 737
Financial modeling 777, 867
  application setup 749
Financial Modeling
  cost model hierarchy 869
Financial Modeling for APM 743
Financial Modeling for SPM 747
Financial planning workbench 355
Financial workbench 358
fiscal calendar
  view fiscal periods 884
Fiscal period 110
Forecast period 357
Forecast plan 357

G
Gantt chart 552
  edit a task 555
GRC 54
GRC risks 56
Groomed lines
  cost models 777
  group
  resources 662
Guided plan 105
Guided program 110
guided test execution 1337
  canceling 1337
  initiating 1337
  notifying testers 1334
  performing tests 1344
ideation
  view idea stages 308
Identify opportunities 110
Indicator scores 84
Indicator sourcing 90
Indicators 77
Information object 169, 170
Information objects 168
Information portfolio 166, 167
Integrate with service catalog 17
Internal lifecycle 152
investment management 581
investment portal 580
IT application owner 45
IT shared services 806
ITFM prescribed metrics 806
L
L1 Costing – Shared Services 806
L2 Costing – Business Applications 83, 806
labor rate card
  manage 1403
  labor rate cards 1402
Landscape view 35
Level 2 Costing – Business Services cost model 814
Level 3 Costing – Business Capabilities cost model 814
Lifecycle phase 152
Load TPM risk parameters 164
Logical data 168
M
Manage business applications
  Application portfolio management
  CMDB 50
Manage capability hierarchy 131
Metric category results 73
Move a project start date 502
Move planned start date of a project 502
Move project 502
Multicurrency 695
Multicurrency fields 698
My Calendar 688
  add events to another user's calendar 692
  add events to your calendar 689
  create repeatable events 690
  delete events 692
My open disputes 913

O
  operational resource plans
    create 639
Organization extension plugin 13

P
  PA dashboards 33
  PA indicators 84
  PA jobs 84
  plan approval
    request 643
  Plan program increment 1238
  Plan view 355
  planning console
    add custom columns 557, 558
    cancel a resource plan 649
    custom columns 557
    Enable client side planning console 552
    Enable project scheduling at client side 552
  Planning workbench 355, 358, 360
  plugins
    cost management 1395
  Plugins 28
  Portal
    Time Sheet 963
  Portfolio budget object configuration 364
  Portfolio budget plan 360
  Portfolio management
    portfolio manager dashboard 399, 399
    portfolio workbench 338, 340, 341
    projects and demands view 343
    selecting fiscal period and setting targets 351
    selecting projects and demands 351, 386
    track portfolio 372
    track portfolio view 373
  Portfolio manager dashboard 399
  access the dashboard 399
  Portfolio planning
    scenario planning 384
    selecting fiscal period and setting targets 384
  Portfolio planning workbench
    track portfolio 398
  Portfolio scenario planning
    track portfolio 398
  portfolio workbench
    create a budget plan 354
    create a forecast plan 371
    forecast a plan 369
    repromote a budget plan 359
    repromote a forecast plan 372
  Portfolio workbench 338, 341
  access the workbench 340
  external dependencies 353, 393
  planned start date 352
  projects and demands view 343
  selecting fiscal period and setting targets 351
  selecting projects and demands 351, 386
  timeline view 352, 353, 393
  track portfolio 372
  track portfolio view 373
  portfolios 334
    status list 338
PPM 360
  PPM Standard 196, 198, 198, 207, 480
    capturing actual project costs 377, 599
  Predictive Intelligence for Application Portfolio Management 15, 16
  Preview weight map
    Weight map preview 892
  process flow
    demand management 257
  Product model lifecycle
    Hardware model lifecycle 152
    Software model lifecycle 152
  product release
    create 1017
  Profile 55
  profile indicators 89
  program backlog 1237
  program level 1232
  program management
    program
      creating 404
      program tasks
        creating from a project 408
  Program management
    allocate budget to a program 409
    Program budget 409
    program manager dashboard 419, 420
    program workbench 415, 418
  Program Management 402
  installed components
    tables 200
    program management dashboard 400, 401, 420, 422
    program manager dashboard 400, 401, 419, 420, 422
    access the dashboard 420
  Program navigation 105
  program workbench 415
  Program workbench
    access the workbench 418
  progress 537
  project
    operational plan, create 639
    resource plan, create 629
    resource plan, create using resource finder 637
    resource plan, search resources using resource finder 637
  project calendars 590
  project card
    Configure the displayed parameters 435, 435
    information displayed 435
  Project currency 702
  Project currency view 696
  Project diagnostics 561
project export
  module 596
project exporting 596
Project form 695
project management 596
  accessing as a related list 569
  add custom columns planning console 557, 558
  basics 426
  benefit plan breakdowns 479
  cancel a resource plan 649
  checklists 530
    creating 531
    saving as a template 531
  closing a project 598
  copying a project 467, 467
    changing default values 525
  cost plan breakdowns 475
  cost rollups 518
  costing add-on 601
  create project benefit plan 476
  customize project and project task states 600
  customize project states 600
  exporting 589, 597
  external dependencies 532
  external dependency
    notifications 531
    types 533
  importing 589, 597
  linking changes to project tasks 529
  links to change requests 526, 528
  milestones 526
  notifications
    activating project task notifications 603
    setting up with the workflow tool 604
  parent-child tasks 515
  planning console
    create external dependency 534
    Enable client side planning console 552
  portfolio
    creating a budget plan 354
    creating a forecast plan 371
    forecast a plan 369
    repromote a budget plan 359
    repromote a forecast plan 372
  portfolios 334, 338
    creating 336
  progress 538
  project and project task states 600
  project files
    importing 590, 593
  project planning console 538, 541
    opening 540
  project states 600
  project task states 600
  project tasks 510, 526, 528
    copying 524
    creating 519, 524, 524, 524, 526
    creating from a project 520
    external dependency notifications 531
    from an incident, problem, or change 523
    inserting a row 524
  project task creator 524
  using templates 525
  view notifications 531
  project templates 508, 510, 510, 510
  projects
    baseline 468
    create benefit plan 476
    create external dependency 534
    creating 449, 473
    define 449
    expense line 480
    external dependency 532
    project change request 499
    status report 481
    types of external dependencies 533
    updating 537, 538
  reporting 598
  resources
    task resources 532
  schedules 473
  staring a project 536
  task dependencies 511, 512, 512, 513, 515, 557
  task relationships 511, 516, 516, 556
  task rollups 517
  Task time constraints 512
  templates 504
    adding an attachment 506
    create 505
  Time constraints 516
  track 538
  UI page 467
  update a cost plan break down 476
  view default project and project task states 600
  view default project states 600
  view default project task states 600
  WBS 568, 569
    task dependencies 557
  work breakdown structure 568, 569
  Project management
    allocate budget to a program 489
    Analytics tab 438
    Configure teamspace settings 573
    define a project 442
    installed with teamspaces 572
    manage resources 443
    My Projects Space 435
    new project 508
      opening 483
      planning console 442
      Project budget 489
      project card 435
      project form 506
      project status report 483
      project workbench 442, 574, 576, 576, 578, 579, 579,
        579, 579, 580, 580
      project workspace 431, 435, 435, 438, 438, 442, 442,
        442, 443, 449, 508
      Status Report 449
      teamspaces 570
      view project summary 438
  Project Management 423, 423
    creating cost type definitions 489
Gantt chart 555
installed components
plugins 198
  tables 200
user roles 207
properties 429
project planning console 538
  Client side planning console 551
  opening 540
  Project schedules at client end 551
Project Portfolio Management
  Domain separation 725
  overview 194
Project Portfolio Suite
  agile projects 246
  installed components
  tables 200
  overview 194
  waterfall projects 244
Project Portfolio Suite with Financials 196
  installed components 198
  plugins 198
  tables 200
user roles 207
installed related lists 212
viewing actual project costs 377, 599
project schedules 590
project task
  cancel a resource plan 649
  operational plan, create 639
  resource plan, create 629
  resource plan, create using resource finder 637
  resource plan, search resources using resource finder 637
project templates
  add a configuration item 510
  configuration 508
  delete a configuration item 510
  modify a configuration item 510
Project workbench 574
  access the workbench 576
  apply a template 506, 508
  create a project task 579
  create a story 580
  create a test case 580
  manage project stories 579
  open a project 579
  project calculation 578
  project detail view 576
  project milestones 576
  project phases 576
  project timeline 576
  project workspace 508
  using the workbench 579
workbench header 576
project workspace
  Configure the parameters 435
  create and manage resources plans 443
  Define a project in project workspace 442
  Manage the resources for a project 443
  Plan a project using planning console 442
  project workbench 442
Status Report 449
  Track a project 442
  Track a project using project workbench 442
  View project status reports 449, 449
Project workspace
  access the project workspace 435
Projects 110
  exporting 596
Publisher lifecycle 152

R
Rate Model
  installed components
user roles 207
Ratecards 908
Read only roles for Application Portfolio Management 33
Read only roles for PPM 213
Read-only roles 737
Recall a processed time sheet 978
Recall a time card 986
Recall time card that is approved or processed 986
Recall time sheet that is approved or processed 978
Recalled 978, 986
Regenerate application score 94
related list
  requested
resource allocations 654
resource allocations 663
relationship aggregation
  enable 1402
reporting
  project management 598
Reporting entity 909
Request business application 66
requested
  allocations
  related list 654
resource
  allocations
  related list 663
resource allocation workbench 672
resource event
  modify 680
  resource plan
    modify 680
resource event color
  change 682, 688
resource events 680
  schedules 680
resource management 620, 643
  process 620
resource plan, close 645
resource plan, complete 645
resource plan, delete 650
resource plan, reject 665
resource plan, request a change 644
resource plan, update cost plan 645
resource plans 624
  time zones, resource plan 653
Resource Management
installed components
plugins 198
tables 200
user roles 207
properties 620
reports 685
Resource Management Reports 682
Resource Management Reports New 687
resource plan
allocate 644
cancel 648
change, request a 644
close 645
complete 645
confirm 643
confirm and allocate 644
delete 650
extend 651
reject, resource plan form 665
update 645
resource plans
copy 629
create 629
create resource plan using resource finder 637
resource management 624
search resources resource plan using resource finder 637
time zones 653
resource role
create 661
Resource Schedules 679, 679
custom schedules 679
resource workbench
Capacity Planning 665
Manage resources with allocation workbench 672
Resource workbench
Allocation workbench 669
resources
allocating 657
group 662
resource plan, allocate 644
resource plan, cancel 648
resource plan, confirm 643
resource plan, confirm and allocate 644
resource role, create 661
user 662
viewing a user calendar 691
Retire business application 66
Risk 55
Risk at business application level 159
Risk at software model level 159
Risk evaluation 163
Risk parameter 158
Risk statement 56
roadmap 59
Roadmap 35
Rollup relationship
sibling 868
S
SAFe entities 1219
SAFe overview 1211
scenario planning
track tab 398
Schedule job 94
Scheduled job 164, 193
scheduled jobs 90
Scheduled jobs 28, 31
score calculation 90
Scoresheet breakdowns 84
Scripted audit 48
scrum 1017
SDLC integration with PPS 250
add group members 251
assign a group to a project 252
assign group capacity 251
create a group 250
create a sprint 251
create multiple sprints 252
create stories 252
manage stories 252
track progress 253
SDLC Scrum Process
integration with PPS 250
Segments 867
self-created resource event modify 682
Self-Service
Submit idea 263
Service Catalog
Submit idea 263
Service catalog breakdowns 902
Service catalog category 901
Service Catalog category 66
service catalog requests 67
Service catalog statement item 895, 901, 902
Service charge lines 906
Service charging 906
Service charging analyst 906, 912
Service charging owner 915
service offering allocation map 749
Service offering costing 747
Service Offering Costing cost model 744
Service owner 906
Service Portfolio Management 749
domain separation 310
Service pricing console 906, 906
Set goal 110
Showback dashboard 915, 916
Showback statement
Statement items 904
Showback statements 909, 912
Showback user 913
Sibling accounts
rollup 868
Similarity solution 15
similarity solution for APM 16
software model 157
Software model 158
Software model risks 164
Software model suggestions engine 62
Software models 61
solution 226, 916
Solutions 998
Source applications 77
SPM cost model 744
Statement disputes 913
Statement expense line details 911
Statement expense lines 910
Statement item type 895
Statement items 915
status report 483
Suggested software models 62
Suggestion engine 61
survey assessments 73
System administrator 45

T

Tables 28, 28
task rate card 
    manage 1403
task rate cards 1402
    process 1404
Task table
    activate time cards 956
    copy time cards 984
    time cards 955, 980, 981, 988, 989
    time sheet policies 957
    time sheets 975
Task view 355
tasks 541
team backlog 1247
team level 1242
team level sprint planning 1248
Teams spaces 570
    installed with 572
    settings 573
Technology lifecycle 137
Technology Portfolio Management 132, 137
Technology risk 127, 159
Technology risks 132, 137
test
    copy a test 1330
    create a test 1329
test case
    add a test 1328
    create a test case 1324
    delete a test case 1328
    update test case status 1328
test cases 1324
test environments
    creating test environments 1335
test execution suite 1361
test management 1321, 1324, 1324, 1324, 1328, 1328, 1328, 1329, 1330, 1331, 1333, 1334, 1334, 1335, 1337, 1344
    activate 1320
    assign defect 1344, 1346
    assigning testers 1336, 1336, 1336
    canceling guided test execution 1337
    dashboard 1341
    initiating guided test execution 1337
    integration with PPS 249
    key terms 1318
    monitor testing progress 1337
    overview 1318
    process flow 1320
    test cases 1324
    test manager 1321
    test plan sign-off 1338
    test plans 1331
    test status 1345
    test suites 1321
tester 1343, 1343
tester tasks 1342
testing sign-off 1341
tests 1329
Test Management
    installed components
        plugins 198
        tables 200
        user roles 207
Test Management 2.0 1347
test management landing page 1347
test management overview 1316
test plan
    add a test case 1334
    create a test plan 1331
    display execution dates 1333
test plan enterprise release
    create 1012
test plans 1331, 1357
    sign-off 1338
test suite
    add a test case 1324
    copy a test suite 1324
    create a test suite 1321
test suites 1321
tests 1329
Time card
    submit time card 985
time card management 955
time cards 955
time sheet policies 957
Time card management
    approve time sheet 977
    assign time sheet policy to a user 961
    create project time category 962
    create time sheet 976
    create time sheet policy 957, 975
    project manager dashboard 990
    reject time sheet 977
    set time sheet policy as default policy 961
    submit time sheet 977
time cards 980
Time Sheet Portal 963
time sheets 975
use the project manager dashboard 993
use the user manager dashboard 997
user manager dashboard 994
Time Card Management
    installed components
        plugins 198
tables 200
user roles 207

time cards
approve time card 986
create project time category 962
reject time card 986
time sheet policies 957
time sheets 975

Time cards
Time Sheet Portal 972

Time Cards
auto generate time cards 984
create time cards 981
scheduled job 984
time sheet portal
approve time sheet for your resources 975
submit a time sheet for your resources 975

Time Sheet Portal
Create time cards 972
log time 972
submit time sheet 973
time sheets
approve time card 986
approve time sheet 977
approve time sheet for your resources 975
assign time sheet policy to a user 961
create time sheet 976
create time sheet policy 957
reject time card 986
reject time sheet 977
set time sheet policy as default policy 961
submit a time sheet for your resources 975
submit time card 985
submit time sheet 977
time cards 980

Time sheets
project manager dashboard 990
user manager dashboard 994

time Sheets
copy time cards 984
create time cards 981

Timeline view 137
TPM timeline 139
TPM timeline view 142, 144, 146
TPM view 148
Track a demand using baselines 290
Track a project performance using baselines 470
track features 1237
track investments 583
Triage Board
Create backlog 1168

Type
Rate 962, 1403

U

UI policies 28, 31
unified backlog 1167
Unit cost 867
Unit cost metrics 867
update aggregate capacity 663

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.